Contents

Confluence Documentation Home ..................................................... 9
Confluence 101 .............................................................................. 9
Start your trial ............................................................................. 10
Create some content .................................................................... 11
Add users and set permissions ................................................... 17
Share and collaborate .................................................................. 19
Customise the look and feel ....................................................... 21
Next Steps .................................................................................... 24
Confluence User's Guide ............................................................... 24
Getting Started with Confluence .................................................. 26
About Confluence ......................................................................... 26
Dashboard ...................................................................................... 27
Page in View Mode ....................................................................... 28
Confluence Glossary ..................................................................... 30
Keyboard Shortcuts ....................................................................... 34
Using Confluence on a Mobile Device ......................................... 38
Creating Content .......................................................................... 41
Using the Editor ........................................................................... 43
    Quick Reference Guide for the Confluence Editor .................... 47
    Working with Text Effects ....................................................... 55
    Working with Links ............................................................... 57
    Working with Anchors ......................................................... 61
    Displaying Images .................................................................. 64
    Working with Tables ............................................................. 68
    Using Symbols, Emoticons and Special Characters ................. 70
    Using Autocomplete ............................................................. 71
    Working with Page Layouts and Columns and Sections .......... 76
    Working with Macros ............................................................ 78
    Working with Drafts .............................................................. 252
Creating Beautiful and Dynamic Pages ....................................... 256
Working with Templates ............................................................... 258
    Adding a Template .................................................................. 260
    Creating a Page using a Template ........................................ 266
    Editing a template ............................................................... 267
    Deleting a Template ............................................................. 268
Working with Blueprints .............................................................. 269
    Decisions Blueprint ............................................................. 272
    File List Blueprint .............................................................. 273
    Meeting Notes Blueprint ..................................................... 275
    Product Requirements Blueprint ...................................... 276
    Shared Links Blueprint ....................................................... 278
    JIRA Report Blueprint ......................................................... 279
    Retrospectives Blueprint .................................................... 282
    Creating a blueprint style report ......................................... 284
Working with the Office Connector ............................................. 290
    Office Connector Prerequisites ......................................... 290
    Displaying Office Files in Confluence .................................. 292
    Importing a Word Document into Confluence ..................... 294
    Editing an Office Document from Confluence ....................... 297
    Editing an Office Spreadsheet from Confluence ................... 300
    Editing an Office Presentation from Confluence .................. 303
   Installing the Firefox Add-On for the Office Connector .......... 307
Importing Content Into Confluence ............................................ 315
    Importing Pages from Disk ................................................ 316
Sharing Content ........................................................................... 317
Network Overview ....................................................................... 317
Likes and Popular Content ............................................................... 319
User Status Updates .................................................................. 321
Using Mentions ......................................................................... 323
Emailing a Page ......................................................................... 325
Commenting on pages and blog posts ........................................ 326
Printing Confluence Pages .......................................................... 328
Exporting Confluence Pages and Spaces to Other Formats ......... 328
  Exporting Confluence Pages and Spaces to HTML .................. 328
  Exporting Confluence Pages and Spaces to PDF ....................... 330
  Exporting to a Word document ................................................. 342
  Exporting Confluence Pages and Spaces to XML ..................... 343
Managing Changes and Notifications and Tasks ....................... 344
  Watching Pages, Spaces and Blogs ......................................... 345
  Managing Watchers ................................................................ 347
  Subscribing to Email Notifications of Updates to Confluence Content ........................................... 348
  Subscribing to RSS Feeds within Confluence ......................... 350
    Using pre-specified RSS feeds ............................................. 352
    Using the RSS Feed Builder ................................................ 352
    Subscribing to a Network RSS Feed ..................................... 354
  Managing Notifications in Confluence .................................... 355
  Working with Tasks ................................................................ 358
Finding Content ........................................................................ 360
Searching Confluence ................................................................. 363
  Confluence Search Syntax ...................................................... 369
  Confluence Search Fields ....................................................... 372
  Searching the People Directory .............................................. 375
Organising Content ................................................................... 377
  Working with Pages .............................................................. 377
    Moving a Page .................................................................... 378
    Copying a Page ................................................................... 380
    Renaming a Page ................................................................ 381
    Deleting a Page ................................................................... 381
    Viewing All Pages in a Space .............................................. 383
    Changing the Sequential Order of Pages ............................... 384
    Managing Orphaned Pages ................................................... 385
    Managing Undefined Pages .................................................. 386
    Using the Documentation Theme ......................................... 386
    Viewing Page Information .................................................... 389
    Viewing Recently Visited Content ....................................... 390
    Page History and Page Comparison Views ......................... 391
    Using a WebDAV Client to Work with Pages ....................... 394
  Working with Blog Posts ......................................................... 394
  Working with Spaces ............................................................. 396
    Viewing All Confluence Spaces .......................................... 398
    Creating a Space .................................................................. 400
    Setting Up your Personal Space .......................................... 401
    Administering a Space ......................................................... 403
    Editing Space Details .......................................................... 404
    Deleting a Space ................................................................ 405
    Backing Up and Restoring a Space ....................................... 405
    Archiving a Space ................................................................ 405
    Viewing Space Activity ....................................................... 407
    Viewing Recently Updated Content ..................................... 408
  Working with Mail Archives .................................................... 408
    Adding a Mail Account ......................................................... 409
    Deleting Mail ...................................................................... 410
    Fetching Mail ..................................................................... 411
    Importing Mail .................................................................... 411
    Managing Mail Accounts ..................................................... 412
  Working with Confluence Labels .............................................. 413
    Adding Labels ..................................................................... 414
    Using Labels to Categorise Spaces ...................................... 416
Removing Labels .................................................. 417
Using Label Macros to Categorise Wiki Content ................. 418
Viewing Labels and Labelled Content ............................ 419
Viewing Personal Labels ........................................ 422
Working with Favourites ......................................... 422
Working with Attachments ........................................ 424
Using Drag-and-Drop in Confluence ............................ 425
Attaching Files to a Page ...................................... 426
Attachment Versions ............................................ 428
Deleting an Attachment ......................................... 428
Displaying a List of Attachments ............................... 429
Downloading Attachments ....................................... 432
Editing Attachment Properties ................................ 432
Embedding Multimedia Content ................................ 433
Embedding PowerPoint Presentations in a Page ............... 436
Moving an Attachment ......................................... 436
Viewing Attachment Details ................................... 437
Customising Confluence ......................................... 438
Personal Customisations ....................................... 438
User Profile Overview ......................................... 439
Choosing your Home Page ..................................... 449
Customising your Personal Dashboard .......................... 450
Customising the Look and Feel of a Confluence Space ....... 451
  Applying a Theme to a Space ................................. 452
  Configuring a Sidebar ........................................ 462
  Changing a Space’s Logo .................................... 463
  Customising Space Layouts .................................. 464
  Editing a Space’s Colour Scheme ............................ 466
  Styling Confluence with CSS ................................ 468
Requesting Add-ons ............................................. 474
Giving People Access to Content ................................ 475
Page Restrictions ................................................ 476
Site Administrators and their Permissions ....................... 480
  Contacting Confluence Administrators ....................... 480
Space Administrators and their Permissions .................... 481
  Space Permissions Overview ................................ 482
    Assigning Space Permissions ............................... 483
Users and Groups ................................................ 486
  Searching for Users .......................................... 487
Working with JIRA in Confluence ................................ 489
Working with JIRA Agile in Confluence ......................... 491
Advanced and Special Uses of Confluence ....................... 492
Working with Confluence Markup .............................. 492
  Confluence Storage Format .................................. 493
  Confluence Wiki Markup ..................................... 505
Working with Confluence Gadgets ............................... 513
  Adding a Confluence Gadget to a JIRA Dashboard .......... 514
  Configuring Confluence Gadgets for Use in Other Applications 519
  Confluence Gadgets ........................................... 522
  Adding JIRA Gadgets to a Confluence Page .................. 528
Developing Technical Documentation on Confluence Wiki ..... 529
  Creating your Technical Documentation Space ................ 529
  Using Templates in Technical Documentation ................ 535
  Re-using Content in Technical Documentation ................ 536
  Managing the Life Cycle of your Technical Documentation .... 541
  Providing PDF Versions of your Technical Documentation .... 545
  Exporting and Printing Technical Documentation ............. 550
  Essential Confluence Features for Technical Documentation ...... 554
Confluence Add-ons for Technical Documentation ................ 563
Further Reading about Developing Technical Documentation on Confluence ........................ 569
Using Confluence as a Knowledge Base ........................ 570
Developing an Intranet on Confluence Wiki ..................... 571
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confluence Administrator's Guide</td>
<td>577</td>
</tr>
<tr>
<td>Getting Started as Confluence Administrator</td>
<td>579</td>
</tr>
<tr>
<td>Managing Confluence Users</td>
<td>581</td>
</tr>
<tr>
<td>Adding and Inviting Users</td>
<td>582</td>
</tr>
<tr>
<td>Deleting or Deactivating Users</td>
<td>586</td>
</tr>
<tr>
<td>Searching For and Administering Users</td>
<td>588</td>
</tr>
<tr>
<td>Editing User Details</td>
<td>590</td>
</tr>
<tr>
<td>Resetting the Login Count for a User</td>
<td>591</td>
</tr>
<tr>
<td>Changing Usernames</td>
<td>592</td>
</tr>
<tr>
<td>Restoring Passwords To Recover Admin User Rights</td>
<td>593</td>
</tr>
<tr>
<td>Managing Site-Wide Permissions and Groups</td>
<td>597</td>
</tr>
<tr>
<td>Global Groups Overview</td>
<td>597</td>
</tr>
<tr>
<td>Adding or Removing Users in Groups</td>
<td>598</td>
</tr>
<tr>
<td>Global Permissions Overview</td>
<td>600</td>
</tr>
<tr>
<td>Setting Up Public Access</td>
<td>604</td>
</tr>
<tr>
<td>Configuring User Directories</td>
<td>605</td>
</tr>
<tr>
<td>Configuring the Internal Directory</td>
<td>607</td>
</tr>
<tr>
<td>Connecting to an LDAP Directory</td>
<td>608</td>
</tr>
<tr>
<td>Connecting to an Internal Directory with LDAP Authentication</td>
<td>628</td>
</tr>
<tr>
<td>Connecting to Crowd or JIRA for User Management</td>
<td>634</td>
</tr>
<tr>
<td>Connecting to JIRA 4.2 or Earlier for User Management</td>
<td>645</td>
</tr>
<tr>
<td>Managing Multiple Directories</td>
<td>646</td>
</tr>
<tr>
<td>Managing Nested Groups</td>
<td>648</td>
</tr>
<tr>
<td>Synchronising Data from External Directories</td>
<td>652</td>
</tr>
<tr>
<td>Diagrams of Possible Configurations for User Management</td>
<td>654</td>
</tr>
<tr>
<td>User Management Limitations and Recommendations</td>
<td>659</td>
</tr>
<tr>
<td>Requesting Support for External User Management</td>
<td>663</td>
</tr>
<tr>
<td>Disabling the Built-In User Management</td>
<td>665</td>
</tr>
<tr>
<td>Managing Add-ons or Plugins</td>
<td>666</td>
</tr>
<tr>
<td>Writing User Macros</td>
<td>666</td>
</tr>
<tr>
<td>User Macro Template Syntax</td>
<td>669</td>
</tr>
<tr>
<td>Example User Macro - Hello World</td>
<td>674</td>
</tr>
<tr>
<td>Example User Macro - Colour and Size</td>
<td>675</td>
</tr>
<tr>
<td>Example User Macro - NoPrint</td>
<td>676</td>
</tr>
<tr>
<td>Example User Macro - Formatted Panel</td>
<td>677</td>
</tr>
<tr>
<td>Customising your Confluence Site</td>
<td>679</td>
</tr>
<tr>
<td>Changing the Look and Feel of Confluence</td>
<td>680</td>
</tr>
<tr>
<td>Customising the Confluence Dashboard</td>
<td>680</td>
</tr>
<tr>
<td>Changing the Site Logo</td>
<td>682</td>
</tr>
<tr>
<td>Customising Colour Schemes</td>
<td>684</td>
</tr>
<tr>
<td>Working with Themes</td>
<td>686</td>
</tr>
<tr>
<td>Customising Site and Space Layouts</td>
<td>688</td>
</tr>
<tr>
<td>Customising a Specific Page</td>
<td>693</td>
</tr>
<tr>
<td>Customising the Login Page</td>
<td>694</td>
</tr>
<tr>
<td>Modify Confluence Interface Text</td>
<td>694</td>
</tr>
<tr>
<td>Customising the eMail Templates</td>
<td>696</td>
</tr>
<tr>
<td>Changing the Default Behaviour and Content in Confluence</td>
<td>696</td>
</tr>
<tr>
<td>Administering Site Templates</td>
<td>697</td>
</tr>
<tr>
<td>Importing Templates</td>
<td>697</td>
</tr>
<tr>
<td>Changing the Site Title</td>
<td>699</td>
</tr>
<tr>
<td>Choosing a Default Language</td>
<td>699</td>
</tr>
<tr>
<td>Configuring the Administrator Contact Page</td>
<td>700</td>
</tr>
<tr>
<td>Configuring the Site Home Page</td>
<td>702</td>
</tr>
<tr>
<td>Configuring the What's New Dialog</td>
<td>703</td>
</tr>
<tr>
<td>Customising Default Space Content</td>
<td>704</td>
</tr>
<tr>
<td>Customising the Getting Started Guide on the Dashboard</td>
<td>705</td>
</tr>
<tr>
<td>Editing the Site Welcome Message</td>
<td>707</td>
</tr>
<tr>
<td>Integrating Confluence with Other Applications</td>
<td>709</td>
</tr>
<tr>
<td>Linking to Another Application</td>
<td>709</td>
</tr>
<tr>
<td>Configuring Workbox Notifications</td>
<td>709</td>
</tr>
<tr>
<td>Integrating JIRA and Confluence</td>
<td>714</td>
</tr>
<tr>
<td>Installing Confluence and JIRA Together</td>
<td>715</td>
</tr>
</tbody>
</table>
## Confluence 5.6 Documentation

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up Trusted Communication between JIRA and Confluence</td>
<td>716</td>
</tr>
<tr>
<td>Registering External Gadgets</td>
<td>721</td>
</tr>
<tr>
<td>Configuring the Office Connector</td>
<td>724</td>
</tr>
<tr>
<td>Managing your Confluence License</td>
<td>728</td>
</tr>
<tr>
<td>Managing Confluence Data</td>
<td>730</td>
</tr>
<tr>
<td>Database Configuration</td>
<td>730</td>
</tr>
<tr>
<td>Database JDBC Drivers</td>
<td>731</td>
</tr>
<tr>
<td>Database Setup for Oracle</td>
<td>732</td>
</tr>
<tr>
<td>Database Setup for SQL Server</td>
<td>739</td>
</tr>
<tr>
<td>Database Setup For MySQL</td>
<td>743</td>
</tr>
<tr>
<td>Database Setup for PostgreSQL</td>
<td>749</td>
</tr>
<tr>
<td>Embedded HSQLDB Database</td>
<td>754</td>
</tr>
<tr>
<td>Migrating to Another Database</td>
<td>758</td>
</tr>
<tr>
<td>Configuring Database Character Encoding</td>
<td>762</td>
</tr>
<tr>
<td>Configuring database query timeout</td>
<td>766</td>
</tr>
<tr>
<td>Troubleshooting External Database Connections</td>
<td>767</td>
</tr>
<tr>
<td>Improving Database Performance</td>
<td>768</td>
</tr>
<tr>
<td>Surviving Database Connection Closures</td>
<td>771</td>
</tr>
<tr>
<td>Site Backup and Restore</td>
<td>772</td>
</tr>
<tr>
<td>Production Backup Strategy</td>
<td>773</td>
</tr>
<tr>
<td>Configuring Backups</td>
<td>775</td>
</tr>
<tr>
<td>Manually Backing Up the Site</td>
<td>778</td>
</tr>
<tr>
<td>Restoring a Site</td>
<td>779</td>
</tr>
<tr>
<td>Restoring a Space</td>
<td>781</td>
</tr>
<tr>
<td>Restoring a Test Instance from Production</td>
<td>782</td>
</tr>
<tr>
<td>Restoring Data from other Backups</td>
<td>783</td>
</tr>
<tr>
<td>Retrieving File Attachments from a Backup</td>
<td>784</td>
</tr>
<tr>
<td>Troubleshooting failed XML site backups</td>
<td>786</td>
</tr>
<tr>
<td>Attachment Storage Configuration</td>
<td>798</td>
</tr>
<tr>
<td>Configuring Attachment Size</td>
<td>800</td>
</tr>
<tr>
<td>Confluence Data Model</td>
<td>801</td>
</tr>
<tr>
<td>Finding Unused Spaces</td>
<td>806</td>
</tr>
<tr>
<td>Data Import and Export</td>
<td>807</td>
</tr>
<tr>
<td>Configuring a Confluence Environment</td>
<td>808</td>
</tr>
<tr>
<td>Confluence Home and other important directories</td>
<td>808</td>
</tr>
<tr>
<td>Application Server Configuration</td>
<td>811</td>
</tr>
<tr>
<td>Configuring URL Encoding on Tomcat Application Server</td>
<td>811</td>
</tr>
<tr>
<td>Managing Application Server Memory Settings</td>
<td>812</td>
</tr>
<tr>
<td>Switching to Apache Tomcat</td>
<td>813</td>
</tr>
<tr>
<td>Java Policy Settings for Enterprise or Webhosting Environments</td>
<td>815</td>
</tr>
<tr>
<td>Web Server Configuration</td>
<td>816</td>
</tr>
<tr>
<td>Configuring Web Proxy Support for Confluence</td>
<td>816</td>
</tr>
<tr>
<td>Running Confluence behind Apache</td>
<td>818</td>
</tr>
<tr>
<td>Starting Confluence Automatically on System Startup</td>
<td>828</td>
</tr>
<tr>
<td>Start Confluence Automatically on Linux</td>
<td>828</td>
</tr>
<tr>
<td>Start Confluence Automatically on Windows as a Service</td>
<td>833</td>
</tr>
<tr>
<td>Configuring Confluence</td>
<td>835</td>
</tr>
<tr>
<td>Viewing System Information</td>
<td>836</td>
</tr>
<tr>
<td>Live Monitoring Using the JMX Interface</td>
<td>836</td>
</tr>
<tr>
<td>Tracking Customisations Made to your Confluence Installation</td>
<td>838</td>
</tr>
<tr>
<td>Viewing Site Statistics</td>
<td>839</td>
</tr>
<tr>
<td>Viewing System Properties</td>
<td>841</td>
</tr>
<tr>
<td>Configuring the Server Base URL</td>
<td>841</td>
</tr>
<tr>
<td>Configuring the Confluence Search and Index</td>
<td>842</td>
</tr>
<tr>
<td>Configuring Indexing Language</td>
<td>842</td>
</tr>
<tr>
<td>Configuring Quick Navigation</td>
<td>843</td>
</tr>
<tr>
<td>Content Index Administration</td>
<td>843</td>
</tr>
<tr>
<td>Enabling OpenSearch</td>
<td>846</td>
</tr>
<tr>
<td>Rebuilding the Ancestor Table</td>
<td>846</td>
</tr>
<tr>
<td>Setting Up Confluence to Index External Sites</td>
<td>846</td>
</tr>
<tr>
<td>Setting Up an External Search Tool to Index Confluence</td>
<td>847</td>
</tr>
<tr>
<td>Configuring Mail</td>
<td>847</td>
</tr>
</tbody>
</table>

*Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring a Server for Outgoing Mail</td>
<td>847</td>
</tr>
<tr>
<td>Setting Up a Mail Session for the Confluence Distribution</td>
<td>849</td>
</tr>
<tr>
<td>Configuring the Recommended Updates Email Notification</td>
<td>849</td>
</tr>
<tr>
<td>The Mail Queue</td>
<td>850</td>
</tr>
<tr>
<td>Configuring Character Encoding</td>
<td>851</td>
</tr>
<tr>
<td>Troubleshooting Character Encodings</td>
<td>853</td>
</tr>
<tr>
<td>Other Settings</td>
<td>856</td>
</tr>
<tr>
<td>Configuring a WebDAV client for Confluence</td>
<td>856</td>
</tr>
<tr>
<td>Configuring HTTP Timeout Settings</td>
<td>861</td>
</tr>
<tr>
<td>Configuring Number Formats</td>
<td>861</td>
</tr>
<tr>
<td>Configuring Shortcut Links</td>
<td>862</td>
</tr>
<tr>
<td>Configuring Time and Date Formats</td>
<td>863</td>
</tr>
<tr>
<td>Enabling the Remote API</td>
<td>863</td>
</tr>
<tr>
<td>Enabling Threaded Comments</td>
<td>863</td>
</tr>
<tr>
<td>Enabling Trackback</td>
<td>864</td>
</tr>
<tr>
<td>Installing a Language Pack</td>
<td>864</td>
</tr>
<tr>
<td>Installing Patched Class Files</td>
<td>865</td>
</tr>
<tr>
<td>Configuring System Properties</td>
<td>866</td>
</tr>
<tr>
<td>Recognised System Properties</td>
<td>873</td>
</tr>
<tr>
<td>Working with Confluence Logs</td>
<td>879</td>
</tr>
<tr>
<td>Configuring Logging</td>
<td>880</td>
</tr>
<tr>
<td>log4j Logging Levels</td>
<td>883</td>
</tr>
<tr>
<td>Troubleshooting SQL Exceptions</td>
<td>883</td>
</tr>
<tr>
<td>Configuring Confluence Security</td>
<td>884</td>
</tr>
<tr>
<td>Confluence Security Overview and Advisories</td>
<td>885</td>
</tr>
<tr>
<td>Confluence Cookies</td>
<td>886</td>
</tr>
<tr>
<td>Configuring Secure Administrator Sessions</td>
<td>889</td>
</tr>
<tr>
<td>Using Fail2Ban to limit login attempts</td>
<td>890</td>
</tr>
<tr>
<td>Securing Confluence with Apache</td>
<td>891</td>
</tr>
<tr>
<td>Managing External Referrers</td>
<td>894</td>
</tr>
<tr>
<td>Best Practices for Configuring Confluence Security</td>
<td>897</td>
</tr>
<tr>
<td>Hiding the People Directory</td>
<td>898</td>
</tr>
<tr>
<td>Configuring Captcha for Spam Prevention</td>
<td>899</td>
</tr>
<tr>
<td>Hiding External Links From Search Engines</td>
<td>899</td>
</tr>
<tr>
<td>Configuring Captcha for Failed Logins</td>
<td>900</td>
</tr>
<tr>
<td>Configuring XSRF Protection</td>
<td>902</td>
</tr>
<tr>
<td>User Email Visibility</td>
<td>903</td>
</tr>
<tr>
<td>Anonymous Access to Remote API</td>
<td>903</td>
</tr>
<tr>
<td>Running Confluence Over SSL or HTTPS</td>
<td>904</td>
</tr>
<tr>
<td>Connecting to LDAP or JIRA or Other Services via SSL</td>
<td>909</td>
</tr>
<tr>
<td>Configuring RSS Feeds</td>
<td>910</td>
</tr>
<tr>
<td>Preventing and Cleaning Up Spam</td>
<td>911</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>913</td>
</tr>
<tr>
<td>Configuring the Whitelist</td>
<td>917</td>
</tr>
<tr>
<td>Performance Tuning</td>
<td>918</td>
</tr>
<tr>
<td>Cache Performance Tuning</td>
<td>921</td>
</tr>
<tr>
<td>Cache Statistics</td>
<td>924</td>
</tr>
<tr>
<td>Memory Usage and Requirements</td>
<td>925</td>
</tr>
<tr>
<td>Requesting Performance Support</td>
<td>927</td>
</tr>
<tr>
<td>Access Log Scripts</td>
<td>931</td>
</tr>
<tr>
<td>Troubleshooting Slow Performance Using Page Request Profiling</td>
<td>931</td>
</tr>
<tr>
<td>Identifying Slow Performing Macros</td>
<td>934</td>
</tr>
<tr>
<td>Compressing an HTTP Response within Confluence</td>
<td>935</td>
</tr>
<tr>
<td>Garbage Collector Performance Issues</td>
<td>936</td>
</tr>
<tr>
<td>Cluster Troubleshooting</td>
<td>936</td>
</tr>
<tr>
<td>Data Collection Policy</td>
<td>939</td>
</tr>
<tr>
<td>Confluence Installation and Upgrade Guide</td>
<td>940</td>
</tr>
<tr>
<td>System Requirements</td>
<td>941</td>
</tr>
<tr>
<td>Server Hardware Requirements Guide</td>
<td>942</td>
</tr>
<tr>
<td>Example Size and Hardware Specifications From Customer Survey</td>
<td>946</td>
</tr>
<tr>
<td>Running Confluence in a Virtualised Environment</td>
<td>947</td>
</tr>
<tr>
<td>Confluence Installation Guide</td>
<td>948</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Installing Confluence</td>
<td>949</td>
</tr>
<tr>
<td>Installing Confluence on Windows</td>
<td>949</td>
</tr>
<tr>
<td>Installing Confluence on Linux</td>
<td>956</td>
</tr>
<tr>
<td>Change listen port for Confluence</td>
<td>962</td>
</tr>
<tr>
<td>Installing the Confluence EAR-WAR Edition</td>
<td>963</td>
</tr>
<tr>
<td>Installing Java for Confluence</td>
<td>966</td>
</tr>
<tr>
<td>Installing Confluence Data Center</td>
<td>967</td>
</tr>
<tr>
<td>Installing Confluence Data Center Moving to Confluence Data Center</td>
<td>969</td>
</tr>
<tr>
<td>Upgrading Confluence Data Center Upgrading Confluence Data Center</td>
<td>971</td>
</tr>
<tr>
<td>Upgrading Confluence Data Center Adding and Removing Data Center Nodes</td>
<td>973</td>
</tr>
<tr>
<td>Creating a Dedicated User Account on the Operating System to Run Confluence</td>
<td>976</td>
</tr>
<tr>
<td>Confluence Setup Guide</td>
<td>977</td>
</tr>
<tr>
<td>Configuring JIRA Integration in the Setup Wizard</td>
<td>984</td>
</tr>
<tr>
<td>Upgrading Confluence</td>
<td>991</td>
</tr>
<tr>
<td>Upgrading Beyond Current Licensed Period</td>
<td>994</td>
</tr>
<tr>
<td>Confluence Post-Upgrade Checks</td>
<td>995</td>
</tr>
<tr>
<td>Upgrading Confluence EAR-WAR Distribution</td>
<td>996</td>
</tr>
<tr>
<td>Migration from Wiki Markup to XHTML-Based Storage Format</td>
<td>100</td>
</tr>
<tr>
<td>Migration of Templates from Wiki Markup to XHTML-Based Storage Format</td>
<td>100</td>
</tr>
<tr>
<td>Upgrading Confluence Manually</td>
<td>100</td>
</tr>
<tr>
<td>Supported Platforms</td>
<td>101</td>
</tr>
<tr>
<td>End of Support Announcements for Confluence</td>
<td>101</td>
</tr>
<tr>
<td>Supported Platforms FAQ</td>
<td>102</td>
</tr>
<tr>
<td>Migrating Confluence Between Servers</td>
<td>102</td>
</tr>
<tr>
<td>From Confluence Evaluation through to Production Installation</td>
<td>102</td>
</tr>
<tr>
<td>Migrating from Confluence Cloud to Confluence Server</td>
<td>102</td>
</tr>
<tr>
<td>Confluence Release Notes</td>
<td>103</td>
</tr>
<tr>
<td>Confluence Release Summary</td>
<td>103</td>
</tr>
<tr>
<td>Upgrade Notes Overview</td>
<td>103</td>
</tr>
<tr>
<td>Getting Help and Support</td>
<td>103</td>
</tr>
<tr>
<td>Confluence Resources</td>
<td>104</td>
</tr>
<tr>
<td>Confluence SharePoint Connector</td>
<td>104</td>
</tr>
<tr>
<td>Support Policies</td>
<td>104</td>
</tr>
<tr>
<td>Bug Fixing Policy</td>
<td>104</td>
</tr>
<tr>
<td>New Features Policy</td>
<td>104</td>
</tr>
<tr>
<td>Patch Policy</td>
<td>104</td>
</tr>
<tr>
<td>Troubleshooting Problems and Requesting Technical Support</td>
<td>104</td>
</tr>
<tr>
<td>Content Anonymiser for Data Backups</td>
<td>105</td>
</tr>
<tr>
<td>Enabling Detailed SQL Logging</td>
<td>105</td>
</tr>
<tr>
<td>Generating a Heap Dump</td>
<td>105</td>
</tr>
<tr>
<td>Generating a Thread Dump</td>
<td>105</td>
</tr>
<tr>
<td>Generating a Thread Dump Externally</td>
<td>105</td>
</tr>
<tr>
<td>Getting Java Crash Log File</td>
<td>105</td>
</tr>
<tr>
<td>Profiling using the YourKit Plugin</td>
<td>105</td>
</tr>
<tr>
<td>Contributing to the Confluence Documentation</td>
<td>105</td>
</tr>
<tr>
<td>Confluence Documentation in Other Languages</td>
<td>105</td>
</tr>
</tbody>
</table>
Confluence Documentation Home

Getting started
Confluence 101
About Confluence
Creating Content
Getting Started as an Admin
Getting support

Popular topics
Confluence release notes
Installing Confluence
Importing content
Managing users
Working with spaces

Customising Confluence
Customising the colour scheme
Changing the logo
Choosing your home page
Applying a theme to a space
Working with Blueprints

Can’t find what you want?
- Search for a page – the search field shows results from this space only.
- Ask a question at Atlassian Answers or search the Knowledge base
- Browse all topics in the sidebar – press [ to show/hide the sidebar.
- View the site map for the user’s guide or administrator’s guide.

Confluence 101
We're delighted that you've decided to try Confluence. This tutorial will help you evaluate Confluence for your organisation.

We'll guide you through:
- starting your trial
- creating a space and some useful content
- adding users and assigning permissions
- collaborating with other users, and
- changing the look and feel of Confluence and other customisation.

It should take you about 30 minutes to work through this tutorial so let's get started.
Start your trial

First you need to set up a trial. If you already have Confluence you can skip this step.

Set up your Confluence Trial

Signing up for a Confluence Cloud trial will provide you with a fully-functional Confluence site hosted in the cloud, which is free for one month. The signup process requires a credit card, but you will not be charged in the first month and can cancel at any time.

2. Read the Trial FAQ. Don't skip this step, the FAQ has important information on what you are signing up for.
3. Click *Start Free Trial*.
4. Follow the prompts to set up your trial.

Tips when signing up:
- 10 users is enough for this tutorial, and you can always add more later.
- You won’t need any other applications. This guide only covers Confluence.
- You can choose to keep your site after your trial. Keep this in mind when picking a site address.

That's it! It will take about 10 minutes for your trial to be provisioned. You will receive an email when Confluence is ready. The trial is free for the first month and you can cancel any time.
If you can’t use Confluence Cloud, you can install the trial version of Confluence Server instead. Go to http://www.atlassian.com/software/confluence/try/ and choose Start Free Trial.

**Installing Confluence on Windows**

To install the Confluence Server trial on Windows:

1. Download the Confluence Windows Installer file for 32-bit or 64-bit Windows.
2. Run the installer, choose an installation directory, a home directory, and a port (‘8090’ will do). We recommend you choose to install Confluence as a service.
3. Confluence will start automatically when the installer finishes. The installer will also add Windows ‘Start’ menu shortcuts which you can use to start and stop Confluence.
4. To access Confluence, go to your web browser and type this address: http://localhost:8090/
5. The Setup Wizard will guide you through the process of setting up your Confluence server and creating an administrative user.

Refer to our full installation instructions for more information.

**Installing Confluence on Linux**

To install the Confluence Server trial on Linux:

1. Download the Confluence Linux 64-bit / 32-bit Installer (.bin) file.
2. Open a Linux console and change directory (`cd`) to the `.bin` file’s directory.
3. Execute the `.bin` file to start the console wizard.
4. Follow the prompts. The console wizard will install Confluence onto your operating system and will start Confluence automatically when the wizard finishes.
5. To access Confluence, go to http://<computer_name_or_IP_address>:<HTTP_port_number> (where `<computer_name_or_IP_address>` is the name or IP address of the computer on which Confluence is installed and `<HTTP_port_number>` is the HTTP port number specified during installation.
6. The Setup Wizard will guide you through the process of setting up your Confluence server and creating an administrative user.

Refer to our full Installation instructions for more information.

**Installing Confluence on Mac (evaluators only)**

Installing Confluence as a production system on a Mac is not supported, however for the purposes of evaluating, you should be able to install Confluence Server locally on your Mac.

---

**Create some content**

Your trial is set up and you’re ready to go. You have administrator permissions for your Confluence Cloud trial.

Throughout this tutorial we will highlight whether a feature is available to all users or requires specific permissions.
1. Only Administrators can do this

2. Space Administrators can do this

We’ll point out where there are differences between Confluence Cloud and Confluence Server with this icon ⚠.

In this step you will create a space, create some pages and add content to a page, including images, links and macros.

Create a space

Let's jump in with both feet and create a space. Spaces are where you create pages, blogs and collaborate with your team.

In this example you will create a space for a team working together on a project. It will be used for gathering requirements, recording meeting notes, making decisions and sharing files.

1. Choose Create Space > Blank Space.

2. Enter a name for your space, for example 'Project Space'.
3. Confluence creates a space key for you - this forms part of the space URL.
4. Choose Create.

Your space appears with some sample content on the homepage. It’s as easy as that. You can have as many spaces as you need.

Later in this tutorial you will look at customising the look of your space, but for now, let's create some content.

Create some content

Pages are where you create your content. You can create a blank page, a blog post, or use a blueprint to solve the blank page problem.

In this example you will use the Meeting Notes blueprint to create some meeting notes in our new project space.

To create meeting notes:
1. In your project space choose Create.

![Create button](image)

2. Choose Meeting Notes and Create.
3. The meeting notes page appears, enter some content.
4. Choose Save.

Confluence creates a link for all the meeting notes in your space on the Sidebar.

Blueprints provide you with ways to create common content quickly. The best way to learn about them is to try some out. They contain instructions and wizards to guide you through the process.

Create a blank page

Next let's create a new blank page to record some background about our project. New pages are created as a child of the current page, so we will return to the homepage first.

1. Go back to the space homepage (hint use the space name link or logo in the sidebar).
2. Choose Create > Blank page.
3. The blank page appears, name the page 'Project Background' and Save.

In the next step we will take a closer look at the editor and the types of content you can add to your pages.

Edit the content of a page

In this example you will edit your new 'Project Background' page and add some content.

To edit an existing page:

1. Go to the page you just created - you can use the sidebar or search to get to a page.
2. Choose Edit (or use the keyboard shortcut E).
3. The editor appears - now get editing!

Our aim in this example is to use the editor tools to create a page that looks like this. Click the image for a bigger view.
Headings and text

Add some text to your page and try out the heading styles and other formatting. In the example above we added headings for Purpose, The Team and Useful Links.

Confluence uses styles, so you will notice there is no Font or Size tools. This keeps your Confluence content looking nice and consistent.

To apply a style, highlight the text and choose a style (for example paragraph, or heading) from the style drop down menu on the toolbar.

Images

Now let's attach an image to your page. In this example we will add a photo of our project team.

1. Choose Insert (+) > Image.
2. Browse for an image file on your computer.
3. Choose Insert.

Your image appears on the page. When you select the image the Image the Properties toolbar appears. This toolbar allows you to:

- Change the size of the image on your page (in our example we chose 300px, users can click to see the full size version).
- Add a border.
- Add an effect (in our example we chose Properties > Effects and selected the 'Taped' effect).
- Add a title and alt text.

Images are attached to your page, like attachments to an email. You can also search for images attached to other pages, or use images from the web.

Links

Creating links is easy in the Confluence editor. You can link to external sites, other confluence pages and spaces, recently viewed pages, attachments, anchors in your text - you name it!

Let's add Useful Links heading to our page, then add a link to the Meeting Notes index page that we created earlier.

To add a link to another Confluence page:

1. Type Useful Links, select it then choose Heading 2 from the style dropdown menu on the toolbar.
2. Enter down to a new line and choose Link on the editor toolbar.
3. Choose Search.
4. Type the name of the page you want to link to (meeting notes) - the quick search will appear as you type.
5. Choose the page from the list.
6. Enter the link text (if you want it to be something other than the page name).
7. Choose Insert.

You can also make images a link - select the image and choose Link from the image properties toolbar.

Page layouts

The example page had content in two columns. This was achieved by modifying the page layout.

Try it now:

1. Choose the Page Layout button on the editor toolbar.
2. A section is added to your page, dotted lines indicate the section boundaries.
3. Choose one of the 2 column layouts from the toolbar to apply it to the section.
4. Your existing content will appear in the left column, leaving the right column free to add more content.

You can add as many sections as you need, and each section can have a different column layout. For this example, you only need one section.

Macros

To provide some in-page navigation, based on the headings on your page, you can add a Table of Contents
Macro. This is great for long pages with many headings.

To add the table of contents macro:

1. Place your cursor in the right hand column you created in the previous step.
2. Choose **Insert > Table of Contents**.
3. Customise your table of contents using the options provided.
4. Choose **Insert**.

Save your page. Your page should now have some headings, an image, a link to another Confluence page and a table of contents.

More about Macros

Macros extend what's possible on a Confluence page. There are macros for navigation, for special formatting, for reporting and adding media - there are even macros that integrate with other Atlassian products like JIRA.

To add a macro to a page:

1. Edit your page.
2. Choose **Insert > Other Macros**.
3. Choose a macro from the macro browser - you can use the categories or search field to help you find a macro.
4. Enter any parameters the macro might need.
5. Choose **Insert**.

The macro appears as a placeholder in the editor. Select the placeholder to edit or remove the macro. Once you save your page you will see the macro content in all its glory.

Check out these great macro examples:

Display web content like videos, Twitter feeds and slideshows...

The Widget Connector macro allows you to display a wide range of web content on your Confluence page such as video, twitter feeds, slideshows. In this example we will add a YouTube video.

To add a YouTube video to your page the fast way:

1. Go to YouTube and grab the URL for the video (hint: use the 'Share' option, not the page URL).
2. Paste the URL on to your page.
3. Confluence recognises the URL and adds the Widget Connector macro for you.

You can add more than just videos, you can content from Twitter, Flickr, SlideShare, Scribid, Vimeo and many more.

A Confluence demonstration video is shown here - using the Widget Connector macro.

Embed a document or presentation...

The View File macros allow you to display PDF and Office documents that are attached to your page.

To use the macro the fast way:

1. Grab a PDF or Office document that is saved on your computer.
2. Drag it into the editor.
3. Watch while Confluence attaches the file to your page and adds the macro.

A Powerpoint macro showing a sample presentation attached to this page is shown here:
Add a dynamic list of JIRA issues...

The JIRA macro allows you to display a list of JIRA issues. Use the wizard or your own JQL query to populate the Macro with issues.

You'll need JIRA linked to Confluence to use this macro.

We won't be using the macro in this example, but here is an example from our Release Notes showing what the macro looks like. Click to see the larger version.

```
PAGES VS BLOGS

Before you move on, let's talk about the difference between a blog, a blueprint and a blank page.
```
Blogs are pages that play by blog rules. Blog posts cannot be restricted or moved, they are visible to other users as soon as you post, and have their own watch and notification settings. Blog posts appear under the 'Blogs' link on the sidebar, whereas pages appear under 'Pages' on the sidebar.

Blueprints are pages that are created from special templates, and are designed to make it easy for you to add common types of content to your pages. Many blueprints appear under their own link on your space sidebar.

Add users and set permissions

Confluence is designed to help you collaborate with your team. You can easily add users, invite users, or allow new users to sign themselves up.

In this step, you will invite a user to come and try Confluence, and then manually add a user.

You need to be an Administrator to add users.

Let's try it now. To invite a user:

1. Go to the Cog icon and choose User Management.
2. Choose the Invite Users tab.
3. Enter an email address of a colleague or friend, customise the message then Send.

To add a user:

1. Choose the Add Users tab.
2. Enter a username, full name and email address.
   If you are creating a 'dummy' user, deselect the Send an email... checkbox to manually set a password for your user.
3. Choose Add.

That's it, you've now added one user, and invited another to join you in Confluence. Now you need to think about permissions.

Permissions and Groups

Permissions control what a user can do in individual spaces and across the whole confluence site.

Users hold permissions as individuals (for example over content they have created) and by being a member of a group.

There are a number of default groups in Confluence:

<table>
<thead>
<tr>
<th>Users or Groups</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>users or confluence-users</td>
<td>These are your typical users. They can add spaces, create content and collaborate.</td>
</tr>
<tr>
<td>administrators</td>
<td>These are your admins. They can access the Confluence Administration console and create new users.</td>
</tr>
<tr>
<td>system-administrators</td>
<td>These are the Atlassian administrators who look after your Cloud instance.</td>
</tr>
<tr>
<td>anonymous</td>
<td>These are users who are not logged in. You can choose to grant them permissions for your site.</td>
</tr>
</tbody>
</table>
There are a couple of differences between Confluence Cloud and Confluence Server. Your 'users' group may be called 'users' or 'confluence-users' and in Cloud some admin functions are restricted.

Create a new group

In this example you will create a new group called 'project-team' and add your new users. You need to be an administrator to add a group.

To create the group and add users:

1. Go to the Cog icon and choose Confluence Admin.
2. Scroll down and choose Groups > Add Group.
3. Enter a group name, for example 'project-team'.
4. Choose Save.
5. Choose Add Members.
6. Enter names of the users you wish to add to the group and choose Add.

Your group has been created. Next you can grant some permissions to the group.

Grant space permissions to a group

In a previous step you created a new space. As the creator, you have Space Admin permissions for that space. Let's grant some permissions to the 'project-team' group. This will allow the team to do things like access the Space Tools console, apply restrictions and remove content.

1. Go back to your new space (hint - the Confluence logo takes you back to the dashboard, or Spaces on the toolbar takes you to a list of spaces).
2. Choose Space Tools in the sidebar.
3. Choose Edit Permissions.
4. Enter the name of your new group ('project-team') in the grant permissions field under 'Groups' and choose Add.
5. Select all the permissions you wish to grant to the group including Space Admin.
6. Scroll down and choose Save all.

Now any user added to the ‘project-team’ group will be able to access Space Tools, and administer the space.

You need to be a space administrator to grant permissions using this method. Most commonly the space administrator is the user who created the space. Members of the administrators group can also do this via > General Configuration > Space Permissions.

Anonymous Users

Confluence supports anonymous users. You are probably an anonymous user in our Confluence site right now.

Anonymous access is turned off by default. Once Anonymous access is turned on across your site, you can decide what permissions you would like to grant anonymous users in each space.

You may decide to make only some spaces accessible to anonymous users.

Share and collaborate

Confluence has some great collaboration features. Let's try some of them out.

Most of these features are available to all users.

Like

You can like pages, blog posts and comments just as in your favourite social networking sites. Show people you care, run crazy 'can we get to 100 likes' challenges, how you use it is up to you!

Comment

You can add comments to pages and blog posts. This is a great way to get people communicating. The full editor is available in the comments field, so you can use bullets, add images, tables - if you can do it in a page, you can more than likely do it in a comment.

Let's add a comment to the meeting notes page you created earlier.

1. Go to your meeting notes page (hint, use the Meeting Notes blueprint shortcut in the sidebar).
2. Scroll down and enter a comment in the comment field.
3. Choose Save.

Comments are also threaded, so you can make your comment a direct reply to another comment. The Quote style in the editor also allows you to indicate where you are quoting another user.

Watch

Want a way to know when someone edits or comments on a page? You can watch it. This is a great way to monitor fast moving information.

Let's watch the meeting notes page you created earlier.

1. Go to your meeting notes page.
2. Choose Watch.
3. Choose to watch just this page or all pages in the space.
You will receive notifications by email and in your workbox when the page is edited or a comment is added. The workbox is located on the toolbar and shows all your recent notifications and tasks. You can customise how you want to be notified in your profile settings.

By default you will automatically be set to watch all pages you create. To stop watching, choose the Watch button and deselect Watch page.

Watching is particularly great for Blogs. You can choose to watch all blogs in a space, and even build an RSS feed to use in your favourite RSS reader.

**Share and Mention**

What if you have created a page and need a user to be notified about it? There are a couple of ways you can do this.

First you could share the page with the user. To share a page:

1. Go to a page choose Share.

2. Enter the name or email address of a user, autocorrect will provide suggestions as you type.
3. Enter a message and Share.

The user will receive an email and a notification in their workbox.

Another way to notify a user about a page or blog post is to mention them on the page or in a comment.

1. Go to a page and choose Edit.
2. Type @ followed by part of the user's name, for example @josh - autocorrect will search for the user.
The user will be notified in their workbox and by email.

Some blueprints use mentions out of the box. For example when you enter a stakeholder in the decision blueprint they are automatically added to the page as a @Mention and notified.

Want to get really tricky? Mention someone in a task, and that task will automatically be added to their task list in the workbox.

Restrict

Sharing is wonderful, but sometimes you may want to make a page only visible to some users, or only visible to you. In other instances you may want users to view and comment on, but not edit a page.

In this example you will restrict editing of the homepage in your project space to members of the 'project-team' group.

You can only apply restrictions to your own pages, unless you have 'Restrict Page' permissions in that space.

1. Go to the space homepage and choose Tools > Restrictions.
2. Choose Restrict editing of this page.
3. Enter a group name or username, for example ‘project-team’ - autocomplete will search for the user or group.

Page Restrictions

4. Choose Save.

A padlock icon appears on the page to indicate that the page has restrictions.

You can also access the restrictions from a button in the editor and from the padlock icon.

Customise the look and feel

Now for the fun stuff - let's look at how you can customise Confluence to suit your organisation or team.

Site look and feel

It is very simple to change the look and feel of your site. You can make your Confluence site match your corporate colours, make it neon pink, add photos of puppies. It's up to you!

You need to be an administrator to do this. You will also need an image file like this one, or you could use your organisation's logo to see how it looks.
To change the site logo:

1. Go to Confluence Administration (hint, go to General Configuration).
2. Choose Site Logo under Look and Feel in the sidebar.
3. Browse for your file and Save.

Confluence detects the colours in your logo and changes the colour scheme to match. In the example below we uploaded a green logo.

To reset or further edit the colour scheme:

1. Go to Confluence Administration.
2. Choose Colour Scheme.
3. Choose Edit to further refine or reset the colour scheme.

Space look and feel

Let's start small and set a logo for your project space. To do this you will need an image file. Space logos are circular, so consider this when choosing an image.

You need space administrator permissions to customise a space.

To change the space logo:

1. Go to your project space, you can select it from the Spaces dropdown in the header.
2. Choose Space Tools > Configure Sidebar (hint, it's on the sidebar).
3. Choose the Edit (pencil) icon next to the space name.
4. Browse for the image you want to set as the space logo.
5. A preview appears, drag and resize the image until you are happy with the preview - don't forget, only the part of the image in the circle will appear in the space logo.
6. Choose **Save**.

The logo appears in the sidebar. This logo also appears whenever your space is listed on the dashboard or in the Spaces directory. It's a great way to differentiate your spaces.

So what else can you do in your space? You can:

- **Customise the homepage** - the space homepage is just an ordinary Confluence page, you can add images, links, macros.
- **Add shortcuts to the sidebar** - these can be links to external sites, other spaces, pages within this space - how you use it is up to you and your team.
- **Change the colour scheme** - in Space Tools > Look and Feel you can change the colours of the header, menus and headings. Make it red, make it green, make it tangerine.
- **Change the theme** - in Space Tools > Look and Feel you can turn on the Documentation theme if you want your space to have a more structured sidebar (like you see right now in the Confluence documentation).

⚠️ A number of third party themes are also available from the Atlassian Marketplace. These are not supported by Atlassian and not available for Confluence Cloud customers.

**Add-ons**

Add-ons, also known as plugins, allow you to extend the functionality of your Confluence site. A small selection of add-ons are available for Confluence Cloud.

To view the add-ons for your instance:

1. Go to ![Add-ons](#).
2. Choose a category from the drop down, for example **User Installed**.

Some add-ons are included in your Cloud subscription, and others are commercial and require paid subscriptions to use.

⚠️ In Confluence Server you can go directly to the Atlassian Marketplace to find add-ons to download and install. Some of these add-ons are supported by Atlassian and others are provided by third parties on a free or commercial basis.

**Personal Customisation**

You can customise your personal Confluence experience too. The **User Profile** menu provides access to a range of personal customisation options.
Some you might want to try include:

- Choose Profile > Picture to upload a photo of yourself.
- Choose Settings > Password to change your password.
- Choose Settings > Email to set your notification preferences.

All users can access and customise their profile.

Next Steps

So that’s it - we hope this guide has helped you get a feel for Confluence.

Your Cloud trial is free for one month and then you have a couple of options:

- **Keep this Cloud instance**
  You don’t need to do anything if you want to keep your Cloud instance. When the evaluation expires your credit card will be charged and you can continue using Confluence Cloud.

- **Cancel your Cloud trial**
  Decided not to continue? You can cancel at any time during the first month.
  To cancel your Cloud trial:
  1. Go to my.atlassian.com.
  2. Navigate to your Confluence Cloud Evaluation.
  3. Choose Cancel Subscription.

- **Switch to Confluence Server**
  If you want the greater flexibility that comes with hosting your own Confluence instance, you can cancel your Cloud trial and switch to Confluence Server. Refer to the Confluence Installation Guide for information about installing Confluence.

  If you want to keep the content you created in your Cloud instance see Migrating from Confluence Cloud to Confluence Server.

  If you were evaluating Confluence Server (installable trial) you might find the information on Migrating to Another Database useful.

More information

Want more information about the concepts covered in this guide? Refer to the full documentation:

Create spaces and content

- Creating Content
- Working with Spaces
- Working with Pages

Share and Collaborate

- Sharing Content
- Managing Changes and Notifications and Tasks

Users and Permissions

- Managing Confluence Users
- Giving People Access to Content
- Restricted Functions in Atlassian OnDemand
- Getting Started as Confluence Administrator

Customise Confluence

- Customising the Look and Feel of a Confluence Space
- Changing the Look and Feel of Confluence
- Personal Customisations

Feedback

Tell us what you think about this evaluator’s guide. Did it help you get a feel for Confluence?

Take our 5 minute survey...
Confluence User's Guide

About the Confluence User's Guide

This guide covers features and functions that are available to Confluence users and space administrators.

For information on administering your Confluence site, including customising your site, refer to the Confluence Administrator's Guide.

This guide assumes that you are using the Confluence default theme. If your Confluence site has been customised the header may look different, and menu items appear in different locations to the examples given in this guide.

- Getting Started with Confluence
  - About Confluence
  - Dashboard
  - Page in View Mode
  - Confluence Glossary
  - Keyboard Shortcuts
  - Using Confluence on a Mobile Device
- Creating Content
  - Using the Editor
  - Creating Beautiful and Dynamic Pages
  - Working with Templates
  - Working with Blueprints
  - Working with the Office Connector
  - Importing Content Into Confluence
- Sharing Content
  - Network Overview
  - Likes and Popular Content
  - User Status Updates
  - Using Mentions
  - Emailing a Page
  - Commenting on pages and blog posts
  - Printing Confluence Pages
  - Exporting Confluence Pages and Spaces to Other Formats
- Managing Changes and Notifications and Tasks
  - Watching Pages, Spaces and Blogs
  - Managing Watchers
  - Subscribing to Email Notifications of Updates to Confluence Content
  - Subscribing to RSS Feeds within Confluence
  - Managing Notifications in Confluence
  - Working with Tasks
- Finding Content
  - Searching Confluence
  - Searching the People Directory
- Organising Content
  - Working with Pages
  - Working with Blog Posts
  - Working with Spaces
  - Working with Mail Archives
  - Working with Confluence Labels
  - Working with Favourites
  - Working with Attachments
- Customising Confluence
  - Personal Customisations
  - Customising the Look and Feel of a Confluence Space
  - Requesting Add-ons

Downloads

Download the Confluence documentation in PDF format.

Other Resources

Confluence Administrator's Guide
Confluence Knowledge Base
Atlassian Answers
Getting Started with Confluence

<table>
<thead>
<tr>
<th>Getting to know Confluence</th>
</tr>
</thead>
<tbody>
<tr>
<td>The dashboard</td>
</tr>
<tr>
<td>Page layout</td>
</tr>
<tr>
<td>Spaces in Confluence</td>
</tr>
<tr>
<td>Other users</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Personalising Confluence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing your password</td>
</tr>
<tr>
<td>Updating your user profile</td>
</tr>
<tr>
<td>Creating your personal space</td>
</tr>
<tr>
<td>Choosing the home page you see when you log in</td>
</tr>
<tr>
<td>Customising the dashboard for yourself</td>
</tr>
<tr>
<td>Getting notifications about changes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Things to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Content</td>
</tr>
<tr>
<td>Adding a space</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>More helpful things</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard shortcuts</td>
</tr>
<tr>
<td>Confluence glossary</td>
</tr>
<tr>
<td>About Confluence</td>
</tr>
</tbody>
</table>

Take me back to the Confluence User's Guide.

About Confluence

Confluence is a wiki. You can use it to collaborate on writing and sharing content with your team. Your team can be as small or as big as you like. It could encompass the whole world. Your content can be as simple or as rich as you like. It can be just words, or you can add images, diagrams, activity streams, web service integration and more.

In a nutshell, a wiki is a piece of software that runs on a server. It publishes web pages that you can read via a web browser such as Mozilla Firefox,
Google Chrome or Microsoft Internet Explorer. The thing that makes wiki pages different from other web pages is the **edit button**. Provided that you have the right permissions, you can edit the page, save your changes, and the updates will be visible to other people immediately.

Confluence provides extra functionality that transforms it into a social collaboration platform:

- Add a **space** for your team, then add a **page** or **comment** on someone else's page.
- Share content by writing a **blog post**, sharing a **link** or calling someone's attention to a page via **@mentions**. Form a **social network** and tell people what you are doing via a **status update**.
- Add **images**, **picture galleries**, **videos** and more.

**Dashboard**

The dashboard is the front page of a Confluence site. It provides an overview of the site, gives access to the spaces that you have permission to view, and displays a few different lists of the most recently updated content.

You can go to the dashboard from anywhere in your site by choosing the **site logo** at the top left of the page. This might be the Confluence logo, or may be a customised logo set by your Confluence Administrator.

**Overview of the dashboard**

The dashboard is divided into these sections:

- **Welcome message**: The information that appears in the top left section of the dashboard. Confluence Administrators can **customise this message**.
- **Get started**: A quick-start guide for administrators. This section of the dashboard is visible to Confluence administrators and system administrators only.
  
  It is not configurable via the web interface, but you can update or remove it by **editing the site layout**.
- **Spaces, Pages, Network**: Tabs displaying your **favourite** content and people, displayed in the lower left section of the dashboard.
  
  - **Spaces** displays the **spaces** you have marked as favourites, followed by all the spaces that you have permission to view.
  - **Pages** displays the **pages** you have marked as favourites.
  - **Network** displays the **users** that you are following (or who are following you).
- **Recent activity**: Tabs on the right-hand side of the dashboard, displaying recently-updated content:
  
  - **Popular** displays content that has been recently created, liked or commented on. See **below** for more details.
  - **All Updates** displays updates from all spaces that you have permission to view.
  - **Favourite Spaces** displays updates from your **favourite** spaces.
  - **Network** displays updates made by the **users** that you are following (or who are following you).
  - **Space Categories** displays updates from spaces in the **category** you have selected from the list.

**On this page:**

- **Overview of the dashboard**
- More about popular content
- **Notes**

**Related pages:**

- Getting Started with Confluence
- Confluence User’s Guide

**Screenshot: The dashboard**
More about popular content

The ‘Popular’ tab on the dashboard displays recent activity of the following types:

- Pages, blog posts and comments that people have recently **liked**.
- Pages and blog posts that people have recently **commented** on, and threaded comments that people have recently replied to.
- Pages and blog posts that have recently been **created**.

‘Recent’ means any activity in the last seven days.

A **bold** link means that you have not yet visited the page.

The activities are listed in order of popularity, with the most popular at the top. Likes, comments and content creations are scored equally. Activity that involves people in your network ranks higher than activity not involving your network. The most recent activity ranks higher than earlier activity.

Notes

- If you have the right permission, you can add a new space from the dashboard. Choose **Create Space** at the top right of the dashboard, or on the ‘Spaces’ tab.
- By default, the dashboard is the home page for the Confluence site. However, you can set any other page in Confluence as your home page via your user profile settings.
- If your site has a custom homepage, the site logo will take you to the homepage not the dashboard. You can still access the dashboard by invoking a URL like this one `https://yoursite.com/wiki/dashboard.action`. See Configuring the Site Home Page for more details.
- Users can customise the dashboard for themselves.
- Are you looking for a way to build an **RSS feed**? Choose Help > **Feed Builder**.
- Are you looking for a list of the **people** in your site? Choose **People** on the header.
- Administrators can customise the global dashboard that all users see.

**Page in View Mode**

The images below show the menus and other controls on a typical Confluence page using the default theme. The sidebar is on the left of each page. On the right is the body of the page.
Sidebar

The sidebar helps you to see where you are in the space, and helps you to find pages and other content in the space. The sidebar contains shortcut links to important pages in your space. Space administrators can access options to configure the sidebar and other parts of the space. At the bottom of the sidebar is a contextual navigation section, which adapts depending on the page or blog post that you are viewing. See Finding Content.

Application Navigator

Use the application navigator for quick and easy access to applications that are linked to your site, for example JIRA. Confluence Administrators can add links to the application navigator, for example external websites.

Dashboard / Home Page

Choose the site logo to access to the site home page. By default, the dashboard is the home page of your Confluence site. Your Confluence Administrator may have set a different homepage for your site.

Spaces

Use the Spaces menu to access your recently viewed spaces and the Space Directory which contains a list of all the spaces that you have permission to view.

People

Choose this option to see the people directory, showing all the users of your Confluence site.

Create

Create pages, blog posts, and other content types in Confluence.

Search

Type text into this box to see a list of matching pages. Select a page to go directly to it, or press Enter to use the full Confluence search. See Searching Confluence.

Help

Go to the documentation for help and support, view a list of keyboard shortcuts, or access other help options from this menu.
| **Administration** | The cog icon gives access to the site administration menu. If you are a Confluence administrator or a system administrator, you can access user and add-on management, and other site administration options here. (Note that the space administration options are in the sidebar, not in the administration menu.) |
| **Workbox** | View and respond to notifications collected from Confluence page watches, shares and mentions. See Managing Notifications in Confluence. |
| **User** | After you have logged in, your profile picture will appear at top right of the page. When you choose your profile picture, the user menu drops down with options to log out, access your user profile, or view your editing history, personal labels and page watches. You can also retrieve drafts of pages you are editing. |
| **Tools** | Perform miscellaneous actions relating to the page. |
| **Like** | Let people know that you like this page. |
| **Edit** | Edit the current page. (Shortcut: press e on your keyboard.) |
| **Watch** | Add yourself as a watcher of the page, to receive notifications of changes. |
| **Share** | Email a link to the current page to another Confluence user or email address. |
| **Labels** | View and edit labels (tags) attached to the current page. (Shortcut: press l on your keyboard.) |
| **Add a comment** | Click in the text box to begin writing a comment. (Shortcut: press m on your keyboard.) |
| **Title and breadcrumbs** | The title is the page name. The breadcrumbs show the position of the page in relation to its parent pages in the space. |
| **Byline** | Shows the original author and the most recent editor of the page, and the date of the most recent edit. |
| **Byline icons** | A small padlock indicates page restrictions. A paperclip indicates that the page has attachments. Both icons are clickable, leading to the 'Page Information' and 'Attachments' pages, respectively. |

**Confluence Glossary**

**Administration Console**

The Administration Console is the interface for the global administration of Confluence.

Only administrators can access the Administration Console.

**Administrators**

The Confluence permission scheme allows the following main levels of administrator permissions:

- System Administrator – full administrative access to Confluence.
- Confluence Administrator – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.

Please refer to the overview of global permissions for details of the functions which each level of administrator can perform.

**CamelCase**

CamelCase is a form of markup commonly used in wikis where words compounded together LikeThis without spaces are used to create links.

In Confluence, Camelcasing can be turned on from the Administration Console.
**Change Comment**

A change comment is a short description entered during the edit of a page to record the changes being made in the edit.

**Child Pages**

Creating child pages is a means of hierarchically organising content in Confluence. A child page can only have one parent page.

**Comments**

A comment may be a remark, question, or any other additional information you wish to add to a page pertaining to the topic the page covers. You can comment on any page or news item in Confluence.

**Confluence Administrators**

The Confluence permission scheme allows the following main levels of administrator permissions:

- System Administrator – full administrative access to Confluence.
- Confluence Administrator – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.

Please refer to the [overview of global permissions](#) for details of the functions which each level of administrator can perform.

**Custom Decorators**

Decorator files are used to define layouts in Confluence. They are vmd files and require knowledge of the language, **Velocity**, to edit.

**Dashboard**

The dashboard is the front page of a Confluence site. It provides an overview of the site, access to all spaces, and displays a list of the most recently updated content within them.

**Form Field Markup**

Form field markup is a specialised markup used when creating page templates in Confluence 4.2 and earlier. It is no longer needed, because the template editor offers form fields as an option in the editor toolbar.

**Global Administrators**

A global administrator is the same as a system administrator.

**Global Spaces**

Known as Site Spaces, these spaces contain content on any theme or topic of your choice.

For more information about site spaces and personal spaces, see [Working with Spaces](#).

**Hover Profile**

The hover profile is the pop-up you see when the mouse pointer pauses over a Confluence user’s name. Use the hover profile to follow the user, visit their profile, and more.

**JIRA**

JIRA is Atlassian's award winning Issue tracking and project management application.

Visit Atlassian's website to learn more about JIRA.

**Labels**

Labels are user-defined tag words assigned to pages to categorise content in Confluence.
Macros
A macro is a command wrapped inside curly braces {...} used to perform programmatic functions and generate more complex content structures in Confluence.

Blog Posts
A blog post may be a journal entry, status report or any other timely information pertaining to a space.

Notifications
A notification is an email message sent to you updating you of changes to pages and spaces you choose to 'watch'.

Orphaned Pages
An orphaned page is a page without any incoming links.

Pages
Pages are the primary means of storing information in Confluence and are the building blocks of spaces.

Parent Page
A parent page is a page that has one or more child pages. It may itself be a child of another page.

People Directory
The People Directory contains a list of all users in your Confluence site. Each user's name links to their personal space.

Permalink
A permalink is the url used to link to specific content items like comments.

Personal Spaces
Personal spaces belong to particular users, and rather than being listed on the Dashboard, are available from the People Directory.

For more information about global spaces and personal spaces, see Working with Spaces.

RSS Feeds
An RSS feed is a format for delivering summaries of regularly changing web content. RSS is read by RSS newsreader programs.

You will need an RSS reader to subscribe to feeds within Confluence.

Confluence acts as an RSS reader for feeds from sites outside of Confluence.

RSS Reader
An RSS reader is a specialised RSS program (also called aggregator) that displays the contents of RSS feeds for you. To subscribe to RSS feeds within Confluence, you will need an RSS reader.

Site Administrators
The Confluence permission scheme allows two levels of administrator permissions:

- System Administrator – full administrative access to Confluence.
- Confluence Administrator – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.

Please refer to the overview of global permissions for details of the functions which each level of administrator can perform.
**Site Spaces**
Site spaces contain content on any theme or topic of your choice. Previously known as global spaces.
For more information about site spaces and personal spaces, see Working with Spaces.

**System Administrators**
The Confluence permission scheme allows two levels of administrator permissions:
- System Administrator – full administrative access to Confluence.
- Confluence Administrator – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.

Please refer to the overview of global permissions for details of the functions which each level of administrator can perform.

**Space Administrators**
A space administrator is a user with the 'Space Admin' permission for the space. A user with this permission can perform a host of functions relating to the management of a space and has complete access to the space regardless of any other control settings or permissions.

Permissions for a space are only assigned and modified by space administrators.

**Spaces**
A space is an area within Confluence, containing your pages, blog posts and other content. You can think of each space as a sub-site, or mini-site, each with its own home page.

There are two types of spaces: site spaces and personal spaces - see Working with Spaces.

**Templates**
A template is a pre-defined page that can be used as a prototype when creating pages. Templates are useful for giving pages a common style or format.

**Themes**
Themes are pre-defined 'look and feel' styles which are configured from the administration menu and can be applied across Confluence or to a single space.

**Thumbnails**
As of Confluence 4.0, all images on the page that aren't links are displayed as thumbnails: when you click on an image the full-size image is displayed in a pop-up.

**Tiny links**
A tiny link is the shortened url of a page which is useful when sending links to the page, for example, via email.

**Trackback**
Trackback is a mechanism by which two sites can stay informed each time one site refers to the other by means of trackback 'pings'.

In Confluence, Trackback is enabled from the Administration Console.

**Trackback Autodiscovery**
Trackback autodiscovery is a block of code that can be placed in a web-page to describe where trackback pings should be sent for that page. You can read the technical specification for autodiscovery here.

When Trackback is enabled, Confluence uses Trackback Autodiscovery to ping pages that are linked to, and to advertise its own pages as being able to receive pings.
Undefined Links
An undefined link is a link to a page that has not yet been created. Clicking on the page link allows you create the page.

User Profile
Every user account in Confluence is linked to a profile that contains user related information and options to configuring user preferences.

Watching
When you watch a page, you receive an email notification whenever that page has been modified. When you watch a space, you receive an email notification whenever content is added or modified in that space.

Wiki
Pioneered by Ward Cunningham, and named after the Hawaiian word for 'quick', a wiki is a website that makes it easy for anyone to contribute pages, and link them together.

Wiki Markup
This is the markup used in some macros and the site welcome message. You can also insert wiki markup into the editor using Insert > Markup.

Related Topics
Take me back to Confluence User's Guide

Keyboard Shortcuts
Confluence provides a number of keyboard shortcuts that you can use to speed up your editing and viewing. This page describes the keyboard shortcuts for the English language. The shortcut keys (letters of the alphabet) may be different in other languages.

Confluence can display a list of available keyboard shortcuts. There are a few ways to see this keyboard shortcuts dialog:

- Choose the help icon at top right of the screen, then choose Keyboard Shortcuts.
- When viewing a page, press Shift+?
- In the editor, choose the question mark icon on the editor toolbar.

The keyboard shortcuts dialog shows the following information:

- General – global, page and blog post shortcuts.
- Editor – text editing and formatting shortcuts.
- Editor Autoformatting – wiki markup and autoformatting shortcuts.

On this page:

- Keyboard shortcuts
  - All screens
  - Editor
  - Tables in the editor
  - Autocomplete in the editor
  - View screen
  - Workbox
  - Disabling and re-enabling keyboard shortcuts
- Notes

Related pages:

- Using Autocomplete
- Confluence User's Guide

Keyboard shortcuts
The first section below describes the keyboard shortcuts that are available on all Confluence screens. Subsequent sections describe the shortcuts specific to each type of screen.

Notes:

- If you are using Chrome or Firefox on OS X, you may use 'Cmd' or 'Control' in the shortcuts below. Safari users may only use 'Control'.
- We have used capital letters (for example, 'A') instead of lower case ('a') to represent keys on the keyboard. Do not press the Shift key unless this guide explicitly mentions it.

All screens

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>/</td>
<td>Enable the quick search</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Submit (where a form is active). Editor -- save the Confluence page. Outside the editor -- save the browser page.</td>
</tr>
<tr>
<td>G then D</td>
<td>Go to the dashboard</td>
</tr>
<tr>
<td>G then S</td>
<td>Browse the current space</td>
</tr>
<tr>
<td>G then G</td>
<td>Position cursor in the search box. See Searching Confluence.</td>
</tr>
<tr>
<td>?</td>
<td>Open the Keyboard Shortcut help</td>
</tr>
<tr>
<td>[</td>
<td>Toggle the sidebar.</td>
</tr>
</tbody>
</table>

Editor

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctr+0</td>
<td>Apply the paragraph style.</td>
</tr>
<tr>
<td>Ctr+(1–6)</td>
<td>Apply a heading level (of the number chosen) to the current line.</td>
</tr>
<tr>
<td>Ctr+7</td>
<td>Apply the preformatted style.</td>
</tr>
<tr>
<td>Ctr+8</td>
<td>Apply the block quote style.</td>
</tr>
<tr>
<td>Ctrl+Shift+A</td>
<td>Open the Macro Browser.</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Make the selected text bold.</td>
</tr>
<tr>
<td>Ctrl+Shift+B</td>
<td>Format text as a bulleted list.</td>
</tr>
<tr>
<td>Ctrl+Shift+D</td>
<td>Insert wiki markup. (Opens the Wiki Markup dialog.)</td>
</tr>
<tr>
<td>Ctrl+Shift+E</td>
<td>Preview the page you are editing.</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Open the Find and Replace toolbar.</td>
</tr>
<tr>
<td>Ctr+I (letter I, not number 1)</td>
<td>Make the selected text italic.</td>
</tr>
<tr>
<td>Ctrl+Shift+J</td>
<td>Insert a JIRA issue. (Opens the Insert JIRA Issue dialog.)</td>
</tr>
<tr>
<td>Ctrl+K</td>
<td>Insert a link. (Opens the Insert Link dialog.)</td>
</tr>
<tr>
<td>Ctrl+Shift+K</td>
<td>See a list of suggested pages or other locations to link to from your page. More about autocomplete...</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Insert an image. (Opens the Insert Image dialog.)</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Ctrl+Shift+M</td>
<td>See a list of suggested images, documents and other files to embed in your page. <a href="#">More about autocomplete...</a></td>
</tr>
<tr>
<td>Ctrl+Shift+N</td>
<td>Format text as a numbered list.</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save the page you are editing.</td>
</tr>
<tr>
<td>Ctrl+Shift+S</td>
<td>Format text with a strike through.</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Make the selected text underlined.</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Revert an action that was undone.</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo the most recent action.</td>
</tr>
<tr>
<td>Tab</td>
<td>Indent current line (only in bulleted lists and numbered lists).</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>'Outdent' current line (only in bulleted lists and numbered lists).</td>
</tr>
<tr>
<td>Shift+Enter</td>
<td>Force a line break without a paragraph break. This is a line break with no extra space.</td>
</tr>
<tr>
<td>[ then ]</td>
<td>Add a task.</td>
</tr>
<tr>
<td>Ctrl+Shift+F</td>
<td>Hide the tools at the top and bottom of the page, giving you a much larger editing area (a full-screen editor).</td>
</tr>
</tbody>
</table>

**Tables in the editor**

<table>
<thead>
<tr>
<th>Windows</th>
<th>Action</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+c</td>
<td>Copy the current table row, or the selected rows.</td>
<td>Cmd+Shift+c</td>
</tr>
<tr>
<td>Ctrl+Shift+i</td>
<td>Insert a table. (Opens the Insert Table dialog.)</td>
<td>Cmd+Shift+i</td>
</tr>
<tr>
<td>Ctrl+Shift+v</td>
<td>Paste the table rows from your clipboard, placing them above the current row.</td>
<td>Cmd+Shift+v</td>
</tr>
<tr>
<td>Ctrl+Shift+x</td>
<td>Cut the current table row, or the selected rows.</td>
<td>Cmd+Shift+x</td>
</tr>
<tr>
<td>Alt+Up Arrow</td>
<td>Add a row above the current row.</td>
<td>Alt+Up Arrow</td>
</tr>
<tr>
<td>Alt+Down Arrow</td>
<td>Add a row below the current row.</td>
<td>Alt+Down Arrow</td>
</tr>
</tbody>
</table>

**Autocomplete in the editor**

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>]</td>
<td>See a list of suggested pages or other locations to link to from your page.</td>
</tr>
<tr>
<td>!</td>
<td>See a list of suggested images, multimedia files and documents to embed in your page.</td>
</tr>
<tr>
<td>{</td>
<td>See a list of suggestions as you begin typing a macro name.</td>
</tr>
<tr>
<td>@</td>
<td>See a list of suggested users to mention.</td>
</tr>
<tr>
<td>//</td>
<td>Insert a date using the date picker. The date picker can also be triggered by typing a date in the format dd/mm/yyyy or dd-mm-yyyy.</td>
</tr>
</tbody>
</table>

See more about using [autocomplete](#).
### View screen

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Create a blog post.</td>
</tr>
<tr>
<td>C</td>
<td>Create a child page of your current page.</td>
</tr>
<tr>
<td>E</td>
<td>Edit a page or blog post, or return to Edit mode when previewing.</td>
</tr>
<tr>
<td>K</td>
<td>Open the Link To dialog.</td>
</tr>
<tr>
<td>L</td>
<td>Add or edit labels.</td>
</tr>
<tr>
<td>M</td>
<td>Add a comment to a page or blog post.</td>
</tr>
<tr>
<td>S</td>
<td>Share the current page</td>
</tr>
<tr>
<td>T</td>
<td>View attachments.</td>
</tr>
<tr>
<td>V</td>
<td>Return to page view (only if you are viewing page attachments).</td>
</tr>
<tr>
<td>W</td>
<td>Add or edit watchers.</td>
</tr>
</tbody>
</table>

### Workbox

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>g then n</td>
<td>Open the Confluence workbox.</td>
</tr>
<tr>
<td>j</td>
<td>Move down to the next entry in the notification list.</td>
</tr>
<tr>
<td>k</td>
<td>Move up to the previous entry in the notification list.</td>
</tr>
<tr>
<td>n</td>
<td>Move down to the next notification for a particular page or blog post.</td>
</tr>
<tr>
<td>p</td>
<td>Move up to the previous notification for a particular page or blog post.</td>
</tr>
<tr>
<td>Enter</td>
<td>Open the selected notification.</td>
</tr>
<tr>
<td>u</td>
<td>Return to the notification list after opening a particular notification.</td>
</tr>
</tbody>
</table>

See more about managing notifications.

Disabling and re-enabling keyboard shortcuts

Keyboard shortcuts are enabled by default. You can disable general keyboard shortcuts for your personal editing sessions. This setting will not affect other Confluence users. You cannot disable the editor keyboard shortcuts.

**To disable or re-enable general keyboard shortcuts:**

1. Log in to Confluence.
2. Open the keyboard shortcuts dialog, by doing one of the following:
   - Choose the help icon at top right of the screen, then choose Keyboard Shortcuts.
   - When viewing a page, press Shift+?
   - In the editor, choose the question mark icon on the editor toolbar.
3. Choose the General tab.
4. Select or clear the Enable General Shortcuts check box as required.

### Notes

- **Note about supported web browsers:** Please ensure that you are using one of the web browsers supported by Confluence. If you are using an unsupported browser or browser version, some features
may not work correctly. Check the Supported Platforms page to find the list of supported web browsers and browser versions on this page.

- The keyboard shortcuts dialog also displays the trigger characters for the Confluence autocomplete feature. See Using Autocomplete.
- Confluence keyboard shortcuts are consistent with JIRA keyboard shortcuts.

Using Confluence on a Mobile Device

When you access a Confluence page on a mobile device, Confluence will display an optimised version of the page. Confluence chooses the mobile or desktop interface based on your device.

On your supported mobile device, you can:

- View the Confluence dashboard, pages, blog posts, and user profiles.
- Add or reply to a comment on a page or blog post.
- Like a page, blog post or comment.
- Watch a page or blog post.
- See your notifications and tasks.

You cannot add or edit pages or blog posts, or edit existing comments, using the mobile interface.

The dashboard – the first thing you see

Screenshot: The dashboard in Confluence mobile

Choose a tab to see:

- Popular content – what people like in your wiki.
- Recent blogs – the latest blog posts.
- Network – updates by people in your network.

Tap the links to view the full content of a page, blog post or comment.

Searching for content and people

Tap the menu icon to open the menu panel on the left of the page. Then type text or a person’s name in the Search box. The mobile interface offers the quick navigation search, which returns matches on page title only. (See Searching Confluence.) To use the full search, switch to desktop mode.

Screenshot: The menu in Confluence mobile
Viewing pages, blog posts and comments

Tap a link on the dashboard or on any other page. Confluence will display the linked page, blog post or comment.

You can:

- View the content, tap a link to move to another page, and interact with the page using the standard functionality supported by mobile browsers.
- Like or unlike a page, blog post or comment.
- Watch or stop watching a page or blog post.
- Add or reply to a comment.

Viewing people’s profiles

Search for a person's name, then view that person's user profile. Tap the options to phone, SMS or email a colleague directly from your mobile device.

Following up on notifications

You can view and respond to your notifications on your phone or other mobile device. Tap the menu icon to open the menu panel on the left of the page. Choose Notifications, and tap a notification to see its details. You can reply, watch or like via the inline actions. Tap Open to open the page or blog post in a new page. For full details, see Managing Notifications in Confluence.

Screenshot: Notifications in Confluence mobile
Viewing tasks

You can view and manage your tasks on your phone or other mobile device too. Tap the menu icon to open the menu panel on the left of the page. Choose Tasks then tap a task to see its details.

_Screenshot: Tasks in Confluence mobile_

More things you may need to know

**Some macros may not appear**

Confluence macros are not yet fully supported in Confluence mobile. If you view a page that contains an unsupported macro, you will see a message inviting you to click through to the desktop version of the page.
You can swap from mobile to standard Confluence and back again

You can swap from the mobile view to the standard view of a page at any time. Choose the menu icon then choose Switch to desktop version.

You can also swap from the desktop view to the mobile view, if you are on a mobile device. Choose the option Switch to Confluence Mobile at the top of the window.

Administrators can disable Confluence mobile on your site

The mobile functionality is provided by a plugin called the 'Confluence Mobile Plugin'. To remove the functionality from your site, you can disable the plugin.

Confluence mobile is a web interface, not a native app

Atlassian does not supply a native mobile application that you can download and install onto your mobile device. Confluence mobile is a web-based user interface that Confluence displays when it detects a mobile client.

See Supported Platforms for supported mobile browsers.

Creating Content

Do you want to add a page or a blog post? Choose the Create option in the Confluence header.

Pages and blog posts are created within spaces, so you will need the ‘Add Pages’ or ‘Add Blog’ permission for the space. A space administrator can give you these permissions. See Giving People Access to Content.

Adding a page or a blog post

You can add pages and blog posts via the 'Create' dialog.

To create content:

1. Go to a space and choose Create in the Confluence header (or use shortcut key c).
2. Choose the type of content you want to create. You can create a blank page, a blog post, or a page based on a template or blueprint.
3. Choose Next.
4. The Confluence editor will open. Add your content in the editor pane, or update the default content supplied by the template.
5. Choose Save.

You can also select a space from the Create dialog to create a page in a different space to the one you are currently viewing.

Space administrators can customise the items that are visible in the Create dialog. If any items are hidden you will see a Show more link. See Working with Templates for more information.
On this page:

- Adding a page or a blog post
- Location of the new page
- Using an undefined link to create a page later
- Other ways to create a page

Related pages:

- Using the Editor
- Creating Beautiful and Dynamic Pages
- Adding a Template
- Working with Blueprints
- Finding Content
- Organising Content
- Confluence User's Guide

Location of the new page

When you create a new page, that page will be a child of another page, in the space that you selected in the 'Create' dialog. The parent page depends on where you are when you create the page.

<table>
<thead>
<tr>
<th>Your location when creating the page</th>
<th>Location of new page</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are viewing a page in the same space where you will put the new page – that is, the space that you</td>
<td>A child of the page you are currently</td>
</tr>
<tr>
<td>select in the 'Create' dialog.</td>
<td>viewing.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>You are viewing any other Confluence screen. For example:</td>
<td>A child of the home page in the space you select in the</td>
</tr>
<tr>
<td>- You are on the dashboard.</td>
<td>'Create' dialog.</td>
</tr>
<tr>
<td>- You are on the 'Pages' view of a space.</td>
<td></td>
</tr>
<tr>
<td>- You are viewing a blog post.</td>
<td></td>
</tr>
<tr>
<td>- You are viewing a page in a space, and choose to add your new page in a different space.</td>
<td></td>
</tr>
</tbody>
</table>

The space sidebar in the default theme has useful links to your pages, blog posts, and other parts of the space.
For more about the sidebar and the location of pages, see Finding Content.

Using an undefined link to create a page later

You may want to insert a link pointing to a Confluence page that does not yet exist, but which you intend to create later. This type of link is called an undefined link.

**To add an undefined link for later creation of a page:**

1. Edit the page in which the link should appear.
2. Type '[' to trigger autocomplete, and type the name of the undefined page. Alternatively, type the text first, then select the text and type '['.
3. Choose Insert Link to Create Page.

When you save the page, Confluence colours the undefined link red. When someone clicks the link, the new page opens in edit mode. That person can then enter the page name, add content and save the page, as usual.

Other ways to create a page

You can display a button on a page, which offers people the option of creating a page based on a given template. See Create from Template Macro.

You can import content from other Confluence sites, other wikis, Microsoft Word, and HTML pages. See Importing Content Into Confluence.

The Confluence APIs allow programmatic and scripted creation of pages. See our developer documentation.

Using the Editor

The Confluence editor is the tool that you will use to create and edit Confluence pages, blog posts and comments. You can enter content as you would in a Word document, apply formatting, and embed other content and files into the page.

Looking for a quick start? See the Quick Reference Guide for the Confluence Editor.

To begin an editing session, choose Edit at the top of a page (or press E on the keyboard).

A note about permissions: To edit a page, you need the 'Add Pages' permission for the space. See space permissions. Someone may also apply page restrictions that may prevent you from editing the page.

An editing session

You start an editing session whenever you:

- Create a new page or blog post, or add a comment.
- Edit an existing page, blog post or comment.

While in an editing session, you can also:

- Name, or rename, a page or blog post. Note that renaming has effects that you should consider.
- Add a comment describing the changes you made.
- Choose whether or not people watching the page get notified of the change you made.
- Add labels to the page.

Confluence automatically saves drafts of your page as you work. If another user begins editing the same page as you, Confluence will display a message, and will try to merge the changes when you save your page.

Choose Cancel (at the bottom of the page) if you want to end the session without saving any changes.

The session ends when you choose Save.

When you create a new page you can choose the location where the page should be saved. You can also move a page after it has been saved, to make it a child page of a different page, or to move it to another space.

To see changes between different versions of the page, look at the history of the page.
The editor

Screenshot: The Confluence editor

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page title</td>
<td>Type the name of the page. This name is used in links to the page.</td>
</tr>
<tr>
<td><strong>Page content</strong></td>
<td>Add the words, images and other content that forms the content of the page.</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Editor toolbar</strong></td>
<td>Use these tools to format and colour content, create lists and tables, indent and align text, and insert other content into the page, such as symbols, links, images, multimedia files and macros. The toolbar also provides the find and replace option, help, and full-screen editing options.</td>
</tr>
<tr>
<td><strong>Restrictions</strong></td>
<td>Control who can view or edit the page. See Page Restrictions.</td>
</tr>
<tr>
<td><strong>Attachments</strong></td>
<td>View, and manage, the attached files on the page.</td>
</tr>
<tr>
<td><strong>Labels</strong></td>
<td>Add labels to a page, to categorise the page content.</td>
</tr>
<tr>
<td><strong>Change comment</strong></td>
<td>Type a comment that describes the changes you have made.</td>
</tr>
<tr>
<td><strong>Notify watchers</strong></td>
<td>Select this option to prompt Confluence to send an email notification of your changes to people who are watching the page.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>See how your changes will appear, without saving the page.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Save the changes you have made to the page. (Keyboard shortcut: Ctrl+S).</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>End the editing session, without saving any changes.</td>
</tr>
</tbody>
</table>

**Toolbars**

From the toolbar you can:

- Apply paragraph styles and character formatting (such as bold, italics, superscript).
- Choose colour for text.
- Create numbered and bulleted lists.
- Set the indenting and alignment for text and images.
- Create links to other pages, attachments, anchors and external resources.
- Add tables, and add, remove, cut and paste rows and columns, highlight cells, rows and columns, and merge and split cells.
- Insert other content into the page, such as images, multimedia, attachments, symbols and markup.
- Use macros to add other types of content, such as a list of JIRA issues or a table of contents.
- Add layouts and columns and sections to your page.
- Find and replace content within the page that you are editing.
- Hide the tools at the top and bottom of the page, giving you a much larger editing area (a full-screen editor).

**Note:** The full-screen editing option is available in Firefox, Chrome and Safari. It is not supported in Internet Explorer. The editor remembers your full-screen preference the next time you edit a page.

**Screenshot:** The editor toolbar
Embedding content in the page

Choose **Insert** on the editor toolbar to include any of the following types of content on your page:

- An image.
- A link to another Confluence page or external URL, or a link to an attachment or image.
- An emoticon or symbol, or a horizontal line.
- A macro. Choose either a specific macro, or **Other Macros**, from the **Insert** menu.

Things to help you work faster

**Autoformatting**

You can type **Confluence wiki markup** directly into the editor to have Confluence auto-format your text as you type. To learn more, choose ? on the editor toolbar and choose the **Editor Autoformatting** tab. See also See the **Quick Reference Guide for the Confluence Editor**.

**Autocomplete**

When editing a page or blog post, you can enter a trigger character to show a list of suggested links, media files or macros to add to your page. This feature is called ‘autocomplete’ and provides you with a fast editing solution if you prefer to use key strokes rather than pointing and clicking with the mouse.

Quick summary of autocomplete:

<table>
<thead>
<tr>
<th>Type</th>
<th>To see suggested:</th>
</tr>
</thead>
<tbody>
<tr>
<td>[]</td>
<td>pages and blog posts</td>
</tr>
<tr>
<td>!</td>
<td>multimedia files</td>
</tr>
<tr>
<td>{}</td>
<td>macros</td>
</tr>
<tr>
<td>@</td>
<td>mentions</td>
</tr>
</tbody>
</table>

For details, see **Using Autocomplete**.

**Autoconvert for pasted links**

When you paste URLs into Confluence, the editor will analyse what you are pasting and automatically convert it into something that will display well in Confluence. Examples include:
- YouTube videos
- JIRA issue queries
- Google Maps
- Confluence pages, blog posts, comments, user statuses, user profiles.
- Shared screenshot links from Skitch
- And more.

**Drag-and-drop for external images and files**

You can drag a file from a location outside Confluence, and drop it directly into the editor. For example, try it with images, video files, audio files, Office documents, and PDF files. The contents of the file will be embedded into the page or blog post. Please refer to the following pages for more information:

- **Using Drag-and-Drop in Confluence** – Using Confluence’s drag-and-drop feature, including details about its requirements and configuration.
- **Displaying Images** – Embedding images onto a Confluence page or blog post.
- **Embedding Multimedia Content** – Embedding videos, audio files and other multimedia files onto a Confluence page or blog post.
- **Displaying Office Files in Confluence** – Embedding Office and PDF files onto a Confluence page or blog post.

**Drag-and-drop within the editor**

Working within the editor panel, you can drag an image or a macro from one location on the page and drop it into a different location on the page. Hover your cursor over the image or the macro placeholder. The cursor changes to a drag-and-drop icon and you can click the image or macro and drag it to a new location.

If you want to abandon the drag-and-drop action, press Escape. The image/macro will return to its original position.

**Note:** For the drag-and-drop of images and macros in the editor, Confluence supports the following browsers: Chrome, Firefox, and Internet Explorer 10 (desktop mode).

**Keyboard shortcuts**

To see the keyboard shortcuts available, choose ? on the editor toolbar.

Finding and replacing text

Click the find / replace icon on the toolbar, or use the keyboard shortcut Ctrl+F (Windows) or Cmd+F (Mac OS). Search matches are highlighted in yellow. You can step through the results one by one, replace the matching text strings one by one, or replace all matching strings at once. This find and replace feature works only within the current page.

Enabling and disabling autocomplete and autoformatting

You can enable or disable the editor’s autocomplete and autoformatting functions, by editing the settings in your user profile.

In summary:

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Choose Editor under ‘Your Settings’ in the left-hand panel.

For more details, see Editing User Settings.

Quick Reference Guide for the Confluence Editor

This page is a quick-reference guide to using the Confluence editor. The aim is to give you enough information about the editor’s features for you to experiment yourself, rather than describing every possible shortcut key, autocomplete feature or toolbar option.

This guide is for people who want to use the autocomplete, autoformatting and keyboard shortcuts provided by the editor. If you prefer to use the toolbar options, the editor itself should be mostly self-explanatory.
Introductory tips

1. **Jump in and start using the Confluence editor.** The editor toolbar contains the most important buttons you’ll need for creating and editing content.

2. **Use the keyboard shortcuts.** For example, type these characters in the editor panel:
   - Type `[` (square bracket) to insert a link.
   - Type `!` (exclamation mark) to insert an image or other media.
   - Type `{` (curly bracket) to insert a macro.
   These characters will trigger the autocomplete functionality, prompting you with a list of suggestions to finish off the entry. For more shortcuts, click the help icon on the editor toolbar.

3. **See how to undo the autocomplete and autoformatting actions.** To undo something that autocomplete or autoformatting has done, press **Ctrl+Z** (Windows) or **Cmd+Z** (Mac).

---

### On this page:
- Introductory tips
- Seeing it in action
- Using the most common formats and features
  - Formatting text
  - Using symbols
  - Linking text
  - Using lists
  - Using tables
  - Using macros
  - Displaying images and multimedia
- Enabling and disabling autocomplete and autoformatting

### Related pages:
- Using Autocomplete
- Using the Editor
- Confluence User's Guide

---

**Seeing it in action**

This short video shows the autoformatting and autocomplete features of the editor.

**See the video on YouTube.**

This video shows how to add macros, links and images by wiki markup alone. Type the macro, including its parameters and the closing curly bracket. Add a link, such as an anchor link, and end it with a square bracket. Insert an image or other embedded object, enclosed between exclamation marks. As soon as you close the macro, link, or embedded image, Confluence will convert it to rich text format and add it to the page.

**See the video on YouTube.**

**Using the most common formats and features**

Below is a list of the most commonly used editor features, and the related keyboard shortcuts.

### Formatting text

<table>
<thead>
<tr>
<th>Formatting text</th>
<th>What to do</th>
<th>Windows keyboard shortcuts (For Mac OS X, replace ‘Ctrl’ with ‘Cmd’)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading levels</td>
<td>Type the heading level and a full stop. Autoformat will convert the line to the appropriate heading immediately. You can continue typing your heading text immediately. Example: h2.</td>
<td>Ctrl + 1 to 6</td>
</tr>
<tr>
<td>Bold text</td>
<td>Type an asterisk &quot;*&quot;, your text, then another asterisk. Confluence autoformat will convert the text to bold immediately. Example: <em>Surf's Up</em></td>
<td>Ctrl + b</td>
</tr>
<tr>
<td>Italic text</td>
<td>Type an underscore &quot;_&quot;, your text, then another underscore. Confluence autoformatting will convert the text to italics immediately. Example: <em>Surf's Up</em></td>
<td>Ctrl + i</td>
</tr>
<tr>
<td>Underlined text</td>
<td>Type a plus sign '+' , your text, then another plus sign '+'. Confluence autoformatting will convert the text to underlined immediately. Example: +Surf's Up+</td>
<td>Ctrl + u</td>
</tr>
<tr>
<td>Monospace text</td>
<td>Type two curly braces {{, your text, then another two curly braces }}. Confluence autoformat will convert the text to monospace immediately. Example: {{Surf's Up}}</td>
<td>None</td>
</tr>
<tr>
<td>Left, centre and right alignment</td>
<td>Click the left, centre and right alignment buttons on the editor toolbar: <img src="https://example.com/image.png" alt="Alignment buttons" /></td>
<td>None</td>
</tr>
<tr>
<td>Line break</td>
<td>Press Shift + Enter to force a line break without a paragraph break. This is a line break with no extra space.</td>
<td>Shift + Enter</td>
</tr>
<tr>
<td>Quotation</td>
<td>Use the <em>Quote</em> style – select ‘Quote’ from the style dropdown menu or use the keyboard shortcut. Example:</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Quote Style" /></td>
<td></td>
</tr>
<tr>
<td>Colour</td>
<td>Click the colour options on the editor toolbar. Example:</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Colour Options" /></td>
<td></td>
</tr>
</tbody>
</table>

### Using symbols

<table>
<thead>
<tr>
<th>Adding symbols and emoticons</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tick or check mark</td>
<td>Type a forward slash in round brackets. Autocomplete will convert it as you type. Example:</td>
<td>( + / + )</td>
</tr>
<tr>
<td></td>
<td><code>( / )</code></td>
<td></td>
</tr>
<tr>
<td>Smiley</td>
<td>Type the globally-recognised markup for a smiley face (colon and round bracket), a wink (semicolon and round bracket), and so on. Autocomplete will convert it as you type. Example:</td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>: )</code></td>
<td>: + )</td>
</tr>
</tbody>
</table>

### Linking text

<table>
<thead>
<tr>
<th>Linking text</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linking to a Confluence page</td>
<td>Type a square bracket <code>[</code> and start typing the page name to see the suggested pages to link to. Press the arrow keys to select the page you want. Example:</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Alternatively, use <strong>wiki markup entirely</strong>. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• This works if you have 'Autoformatting' enabled in the editor settings in your user profile.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Example:</strong> [Modern Girl</td>
<td>Modern Girl song lyrics]</td>
</tr>
<tr>
<td>Linking text to a web page</td>
<td>Type a square bracket <code>[</code> and select <strong>Insert Web Link</strong>, then paste the URL into the link dialog. Example:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Alternatively, use <strong>wiki markup entirely</strong>. Type the link, including the alias and the URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• This works if you have 'Autoformatting' enabled in the editor settings in your user profile.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Example:</strong> [Modern Girl</td>
<td><a href="http://www.example.com/song">http://www.example.com/song</a>]</td>
</tr>
<tr>
<td>Linking to a page that does not yet exist</td>
<td>Type a square bracket <code>[</code> and the name of the non-existent page, then select <strong>Insert Link to Create Page</strong>. Example:</td>
<td></td>
</tr>
</tbody>
</table>

![Link suggestions](image)

Alternatively, use **wiki markup entirely**. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: [Future of the Modern Girl]

| Linking to an attachment | Type a square bracket `[` and start typing the attachment name to see the suggested attachments to link to. Press the arrow keys to select the item you want. Example: |

![Link suggestions](image)

Alternatively, use **wiki markup entirely**. Type the link, including the alias (if required), the caret character `^` and the attachment name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: [^attachment name]

| Linking to an anchor | **To create the anchor:** Add an anchor macro using wiki markup. Confluence will convert the macro to rich text format and add it to the page. For example, to create an anchor named 'index', type the following: `{anchor:index}` |

**To create the link:** Use **wiki markup** too. Type the link, including the alias (if required), the hash character `#` and the anchor name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: [Index|#index]

---

**Using lists**
### Using lists

<table>
<thead>
<tr>
<th>Using lists</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
</table>
| Adding a bullet list | Type an asterisk ‘*’ followed by a space. Autoformat will convert the line to a bulleted list. You can continue typing your text immediately. Example:  

```
My list:
  • bullet item
```

To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line. | Ctrl + Shift + b |
| Adding a numbered list | Type a hash or pound ‘#’ followed by a space. Autoformat will convert the line to a numbered list. You can continue typing your text immediately. Example:  

```
My list:
  1. bullet item
```

To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line. | Ctrl + Shift + n |

---

### Using tables

<table>
<thead>
<tr>
<th>Using tables</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
</table>
| Adding a table | Type a series of pipe characters ‘|’ then press Enter. Autoformat will convert the pipes to a table. Example – to create a table with three columns:  

```
|   |   |   |
```

None |  

---

### Using macros

<table>
<thead>
<tr>
<th>Adding macros</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
</table>
Adding a macro to your page.

Type ‘{’ and start typing the macro name to see a list of macros that match your text. Press the arrow keys to select the macro you want. Example:

```
{blogposts:content=titles|author=jsmith}
```

Alternatively, use **wiki markup entirely**. Type the macro, including its parameters and the closing curly bracket. As soon as you close the macro, Confluence will convert it to rich text format and add it to the page. This means that you can skip the macro browser.

- This works if you have ‘Autoformatting’ enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- **Example:** `{blogposts:content=titles|author=jsmith}`

**Displaying images and multimedia**

<table>
<thead>
<tr>
<th>Displaying images</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display an image attached to the page</td>
<td>Type an exclamation mark ‘!’ and start typing the image name to see the suggested images to insert onto the page. Press the arrow keys to select the item you want. <strong>Example:</strong></td>
<td></td>
</tr>
</tbody>
</table>

```
!NoMatterWhat.png|align=right!
```

Alternatively, use **wiki markup entirely**. Type the wiki markup for the image insertion, including the exclamation marks, the space and/or page name (if different from the current page) and the image name, as well as any other allowed parameters. As soon as you type the closing exclamation mark, Confluence will convert the image to rich text format and add it to the page. This means that you can skip the image browser.

- This works if you have ‘Autoformatting’ enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing exclamation mark manually.
- **Example:** `!NoMatterWhat.png|align=right!`...
### Embedding multimedia files

**What to type**

<table>
<thead>
<tr>
<th>Embedding a video, movie or audio file into a page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type an exclamation mark ‘!’ and select 'Insert Other Media'. Example: ![media suggestions](media suggestions.png)</td>
</tr>
<tr>
<td>Or type '{' and start typing the macro name 'Multimedia'. Example: ![macro suggestions](macro suggestions.png)</td>
</tr>
</tbody>
</table>

**Keyboard shortcut (Windows)**

- `!`

---

**Enabling and disabling autocomplete and autoformatting**

You can enable or disable the editor's autocomplete and autoformatting functions, by editing the settings in your user profile.

In summary:

1. Choose **your profile picture** at top right of the screen, then choose **Settings**.
2. Choose **Editor** under ‘Your Settings’ in the left-hand panel.

For more details, see [Editing User Settings](#).

**Working with Text Effects**

The Confluence editor supports most text effects available in standard text editing applications.

**Applying paragraph styles**

Choose a paragraph style from the editor toolbar, or click in the paragraph and use one of the **keyboard shortcuts** `Ctrl+(0–8)`.

*Screenshot: Choosing paragraph styles from the editor toolbar*
Applying character formats

To apply a character format, select the text and click one of the editor toolbar buttons, or use a keyboard shortcut. Some formats are available from the 'More' menu.

Screenshot: Text formatting buttons on the editor toolbar

<table>
<thead>
<tr>
<th>Format</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Italics</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Underline</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>Strikethrough</td>
<td>Ctrl+Shift+S</td>
</tr>
<tr>
<td>Superscript</td>
<td>none</td>
</tr>
<tr>
<td>Subscript</td>
<td>none</td>
</tr>
<tr>
<td>Monospace</td>
<td>none</td>
</tr>
</tbody>
</table>

Choose Clear Formatting from the 'More' menu to remove all formatting.

Applying colours to text
To apply a colour to text, select the text and choose the colour option in the editor toolbar. To see the available colours, choose the dropdown arrow next to the colour option.

*Screenshot: Picking colours from the editor toolbar*

### Aligning text

You can align text to the left, right or centre of a content block. Select the text and click the appropriate alignment option on the editor toolbar.

*Screenshot: Left, centre and right alignment options on the editor toolbar*

### Indenting text

You can move text to the left or right by a predefined sequence of indentations. Confluence determines the size of the indentation. Select the text and click the left or right indentation option on the editor toolbar.

*Screenshot: Left and right indentation options on the editor toolbar*

### Working with Links

You can create links to pages, blog posts, anchors, attachments, external websites, JIRA issues and more. Links can be text or images, and can be added in many different ways.

Links to pages within your Confluence site are relative, which means that you can move pages and rename pages without breaking links.

This page explains the most common ways to create links.

#### Inserting a text link

To insert a link on a page:

1. Select some text or position your cursor where you want to insert the link.
2. Choose **Link** on the toolbar or use the *keyboard shortcut Ctrl+K*.
3. Select a page, blog post or attachment, or enter an external URL (see below for how to link to particular types of content).
4. Enter or modify the link text - this is the text that will appear on the page. If this field is left blank, the page name or URL will be used as the link text.
5. Choose **Insert**.

Alternatively you can type `[` followed by the page or attachment name. **Autocomplete** will suggest matching items for you.

You can also paste a URL directly onto your page. Confluence will automatically create the link, and if the URL is for a page in the current site, the page name will be set as the link text.
On this page:
- Inserting a text link
- Inserting an image link
- Modifying a link
- Removing a link
- Linking to specific types of content
- Linking to Confluence pages from other websites
- Linking to comments
- Using shortcut Links
- Trackback

Related pages:
- Working with Anchors
- Inserting JIRA Issues
- Confluence User's Guide

Inserting an image link

To link from an image:
1. Select an image on your page.
3. Select a page, blog post or attachment, or enter an external URL (see below for how to link to particular types of content).
4. Choose Insert.

Modifying a link

To modify a link:
1. Select the link text or image.
2. Choose Edit from the link properties toolbar.
3. Modify the link and choose Save.

Removing a link

To remove a link:
1. Select the link text or image
2. Choose Unlink from the properties toolbar.

Linking to specific types of content

Confluence supports many methods for creating links. Some of the common ones are listed here.
<table>
<thead>
<tr>
<th>Type of link</th>
<th>Ways to do this</th>
</tr>
</thead>
</table>
| Link to a page | Choose **Link > Search** then enter part of the page name.  
Choose **Link > Recently viewed** and select a page from the list.  
Type [] and enter part of the page name then select the page from the list.  
Paste the URL of the page onto your page (Confluence will automatically create the link). |
| Link to a page in another space | Choose **Link > Search** enter part of the page name and select **All Spaces** from the drop down.  
Choose **Link > Advanced** then enter the space key followed by the page name `space key:mypage`.  
Type [] and enter part of the page name then select the page from the list.  
you can hover over each suggestion to see which space the page is from). |
| Link to a blog post | Choose **Link > Search** and enter part of the blog post name.  
Type [] and enter part of the blog post name then select the blog post from the list. |
| Link to an attachment or image on this page | Choose **Link > Attachment** then upload or select an attachment from the list.  
Type [] and enter part of the attachment file name then select the attachment from the list. |
| Link to an attachment on another page | Choose **Link > Search** and enter part of the attachment name.  
Type [] and enter part of the attachment file name then select the attachment from the list.  
you can hover over each suggestion to see which space the page is from). |
| Link to a website | Choose **Link > Web Link** then enter the website URL.  
Type or paste the URL onto the page (Confluence will automatically create the link). |
| Link to an email address | Choose **Link > Web Link** then enter the email address.  
Type or paste the email address onto the page (Confluence will automatically create a 'mailto:' link). |
| Link to an anchor on a page | Choose **Link > Advanced** then enter the anchor name in one of the formats below.  
For an anchor on this page: `#anchor name`.  
For an anchor on another page in this space: `page name#anchor name`.  
For an Anchor on another page in another space: `spacekey:page name#anchor name`.  
See **Working with Anchors** for more information on using anchors. |
| Link to a heading on a page | Choose **Link > Advanced** then enter the heading in one of the formats below.  
Heading text is case sensitive and must be entered without spaces.  
For a heading on this page: `#MyHeading`.  
For a heading on another page in this space: `Page Name#MyHeading`.  
For a heading on another page in another space: `spacekey:Page Name#MyHeading`.  
Be aware that these links will break if you edit the heading text. Consider using the **Table of Contents** macro or an **Anchor** instead. |
<table>
<thead>
<tr>
<th>Purpose</th>
<th>Link syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to a comment on a page</td>
<td>Go to the comment, right click the Date at the bottom of the comment and copy the link. Paste the link directly onto your page or choose Link &gt; Web Link and paste in the URL. Type [# then enter the Comment ID ('12345' in this example): [#12345]</td>
</tr>
<tr>
<td>Link to an undefined page (a page that does not exist yet)</td>
<td>Choose Link &gt; Advanced then enter the new page name (a page will be created on click). Type [ then enter the new page name then choose Insert link to create page. See Managing Undefined Pages for more information on undefined pages.</td>
</tr>
<tr>
<td>Link to a personal space or user profile</td>
<td>Choose Link &gt; Search then enter the user's name and select their personal space homepage or their profile from the list. Type [ then enter the user's name and select their personal space homepage or their profile from the list.</td>
</tr>
<tr>
<td>Link to a JIRA issue (where Confluence is connected to JIRA)</td>
<td>Paste the JIRA issue URL - Confluence will automatically create a JIRA Issue macro.</td>
</tr>
</tbody>
</table>

**Linking to Confluence pages from other websites**

The best way to link to a Confluence page from outside Confluence, for example on a website or in an email message, is to use the tiny link which is a permanent URL. This ensures that the link to the page is not broken if the page name changes.

To access the permanent URL for a page:

1. View the page you wish to link to.
2. Choose Tools > Link to this page.
3. Copy the Tiny Link.
4. Use the tiny link in your website or email message.

You do not need to use the tiny link to link to pages within your Confluence site. Confluence automatically updates links when you rename or move a page to another space.

If you want to link to specific content such as anchors, headings or comments you need to use the following link syntax. Note that there are no spaces in the page name, anchor name or heading text.

In the examples below, the anchor name is 'InsertLinkAnchor' and the heading text is 'Insert a link'.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Link syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to an anchor (from an external website)</td>
<td><a href="http://myconfluence.com/display/spacekey/pagename#pagename-anchormname">http://myconfluence.com/display/spacekey/pagename#pagename-anchormname</a></td>
</tr>
<tr>
<td>Example from this page:</td>
<td><a href="https://confluence.atlassian.com/display/DOC/Working+with+Links#Workingwit">https://confluence.atlassian.com/display/DOC/Working+with+Links#Workingwit</a></td>
</tr>
<tr>
<td>Link to a heading (from an external website)</td>
<td><a href="http://myconfluence.com/display/spacekey/pagename#pagename-headingtext">http://myconfluence.com/display/spacekey/pagename#pagename-headingtext</a></td>
</tr>
<tr>
<td>Example from this page:</td>
<td><a href="https://confluence.atlassian.com/display/DOC/Working+with+Links#Workingwit">https://confluence.atlassian.com/display/DOC/Working+with+Links#Workingwit</a></td>
</tr>
<tr>
<td>Link to a comment (from an external website)</td>
<td><a href="http://myconfluence.com/display/spacekey/pagename?focusedCommentId=comment">http://myconfluence.com/display/spacekey/pagename?focusedCommentId=comment</a></td>
</tr>
<tr>
<td>Example from this page:</td>
<td><a href="https://confluence.atlassian.com/display/DOC/Working+with+Links?focusedCom">https://confluence.atlassian.com/display/DOC/Working+with+Links?focusedCom</a></td>
</tr>
</tbody>
</table>
Some things to note when linking to anchors from a website or email message:

- The page name is repeated in the URL, after the # sign. The second occurrence of the page name is concatenated into a single word, with all spaces removed.
- There is a single dash (hyphen) between the concatenated page name and the anchor name.
- The anchor name in the full URL is concatenated into a single word, with all spaces removed.
- The anchor name is case sensitive. You must use the same pattern of upper and lower case letters as you used when creating the Anchor.

### Linking to comments

You can add a link to a comment by using the comment URL (a permanent link), or by using wiki markup to link to the Comment ID.

To find out the comment URL and comment ID:

1. Go to the comment you wish to link to.
2. Choose the Date at the bottom of the comment and examine the URL.

The number after 'comment-' is the Comment ID. An example is shown here.

https://confluence.atlassian.com/display/DOC/Working+with+Links?focusedCommentId=368640803#comment-368640803

You can use wiki markup directly in the editor to link to a comment. Enter [$ followed by the Comment ID, for example [$12345] where '12345' is the Comment ID.

### Using shortcut Links

If you have configured shortcut links on your Confluence site, then you can link to an external site using a shortcut link that looks like this:CONF-17025@jira.

Our Confluence site (where this documentation is housed) is configured to allow shortcut links to our JIRA site, using the shortcut @jira. So the shortcut link CONF-17025@jira produces this link.

To add a shortcut link using the 'Insert Link' dialog:

1. Choose Link > Advanced and enter or paste the shortcut link into the Link field. Shortcut links are case-insensitive.
2. Modify or enter link text - this is the text that will appear on the page.
3. Choose Insert.

You can also type `[' and choose Insert Web Link > Advanced to enter a shortcut link.

See Configuring Shortcut Links for more details.

### Trackback

Trackback enables two sites can stay informed each time one site refers to the other using trackback 'pings'.

In Confluence, Trackback can be enabled by a site administrator in the Administration Console. When Trackback is enabled, any time you link to an external webpage that supports Trackback Autodiscovery, Confluence will send a Trackback ping to that page to inform it that it has been linked to.

Confluence pages also support Trackback Autodiscovery, and when Trackback is enabled, can receive trackback pings sent by other sites.

To see who has sent a Trackback ping to a Confluence page:

1. Go to the page.
2. Choose Tools > Page Information.

Any Trackback pings the page has received will be listed under the page's Incoming Links.

Confluence incoming trackback pings only work with referenced pages that are public (anonymously viewable).

Working with Anchors
Anchors are used to enable links to a specific location on a page. Anchor links can be especially useful when navigating between sections of a long document, or when you want to link to a segment of a page instead of the top of the page.

Anchors are invisible to the reader when the page is displayed.

There are two steps to using an anchor:

1. Create an anchor on the page.
2. Create a link to the anchor.

**Creating an anchor**

Use the Anchor macro to mark the location you want to link to.

1. **Add the Anchor macro to a page.**
   a. In the Confluence editor, choose **Insert > Other Macros**.
   b. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).**

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

2. **Specify the name of your anchor.** For example, ‘bottom’ or ‘important information’. See the ‘Anchor Name’ parameter described below.

**On this page:**
- Creating an anchor
- Creating a link to an anchor
- Notes

**Related pages:**
- Working with Links

### Macro options (parameters)

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets **example**.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anchor Name</td>
<td>None</td>
<td>This is the anchor name that you will use when creating the link.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The anchor name can include spaces. Confluence will remove the spaces automatically when building a URL that points to this anchor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The anchor name is case sensitive. You must use the same pattern of upper and lower case letters when creating the link as you used when creating the Anchor macro.</td>
</tr>
</tbody>
</table>

### Creating a link to an anchor

You can link to an anchor from:

- A page on the same Confluence site. The link may be on the same page as the anchor, another page in the same space, or a page in another space on the same Confluence site.
- Another web page or another Confluence site, using a specifically formatted URL.

**To link to an anchor from within the same Confluence site:**

1. Select some text or position your cursor where you want to insert the link.
2. Choose **Link** on the toolbar or press **Ctrl+K**.
3. Choose **Advanced** and enter the anchor name in the **Link** field following the format below.
Anchor location | Link syntax for anchor | Examples
--- | --- | ---
Same page | #anchor name | #bottom
 |  | #important information
Page in same space | page name#anchor name | My page#bottom
 |  | My page#important information
Page in different space | spacekey:page name#anchor name | DOC:My page#bottom
 |  | DOC:My page#important information

The anchor name is case sensitive. You must use the same pattern of upper and lower case letters as you used when creating the Anchor macro.

4. Enter or modify the **Link Text** - this is the text that will appear on the page. If this field is left blank, the page name or URL will be used as the link text.

5. Choose **Insert**.

_Screenshot: The 'Advanced' option in the link dialog_

![Insert Link](image)

To link to an anchor from another web page or another Confluence site:

Use a full URL in the following format:

<table>
<thead>
<tr>
<th>Link syntax</th>
<th>Examples</th>
</tr>
</thead>
</table>

Notes about the full URL:

- The page name is repeated in the URL, after the # sign. The second occurrence of the page name is concatenated into a single word, with all spaces removed.
- There is a single dash (hyphen) between the concatenated page name and the anchor name.
- The anchor name in the full URL is concatenated into a single word, with all spaces removed.
- The anchor name is case sensitive. You must use the same pattern of upper and lower case letters as you used when creating the Anchor macro.

**Notes**
• **Table of contents on page:** Consider using the Table of Contents Macro to generate a list of links pointing to the headings on the page. The list of links will appear on the page, and will be automatically updated each time someone changes the wording of a heading.

• **Linking to headings:** You can link directly to the headings of a page. See Working with Links. However, if someone changes the wording of a heading, those direct links will be broken. Use the Anchor macro to ensure a lasting link within the body of a page.

• **Site welcome message:** If you are adding an anchor to a page that you are using in the site welcome message, you can only link to that anchor from another page. Internal links within that page will not work.

• **Templates:** When you are previewing a template, a link to an anchor is displayed as a 'broken' link. However, when you create a page using the template the resulting page will have the correct link.

### Displaying Images

You can display an image on a Confluence page when:

- The image is attached to the page.
- The image is attached to another page in the same Confluence site, even if in another space.
- The image is on a remote web page.

Once the image is displayed on the page, you can:

- Move the image to a new position on the page by dragging or cut and paste.
- Change how the image appears on the page.
- Add a title and alt text for the image.
- **Link from an image** to another page.

#### Displaying an image attached to the page

There are several methods for attaching image files to a page. Once you have attached an image to a page, there are different methods for choosing where on the page the image should appear:

**Using the 'Insert Image' dialog**

Once an image is attached to the page, you can edit the page to choose where the image should appear.

**On this page:**

- Displaying an image attached to the page
- Displaying an image attached to a different page
- Displaying an image from a remote web page
- Controlling the image appearance
- Setting other image attributes
- Displaying a gallery of images
- Image file formats
- Notes

**Related pages:**

- Deleting an Image
- Working with Links
- Working with Attachments
- Choosing a Profile Picture
- Confluence User's Guide

### To position an attached image on the page:

1. While editing the page, position the cursor where you want to place the image.
2. Choose **Insert > Image** and choose the **Attached Images** tab.
3. Select the required image and choose **Insert** (or just double-click the image).

**Using autocomplete**

Once an image is attached to the page, you can use autocomplete while editing the page to choose where the image should appear.

### To position an attached image on the page:

1. While editing the page, position the cursor where you want to place the image.
2. Trigger the autocomplete function by typing '!'.
3. Choose the image from the list that appears.

**Using drag-and-drop**

Depending on the browser you are using, you can attach and position an image in one step. While you are editing a page, simply drag-and-drop an image file on to the page. The image is attached to the page and is placed at the current cursor position.

**Displaying an image attached to a different page**

You can display an image that is attached to a different page of the same Confluence site, as long as you know the name of the image. This approach can make it easier to manage and reuse your images by allowing you to keep them all in the same place.

To display an image attached to a different page:
1. While editing the page, position the cursor where you want to place the image.
2. Choose Insert > Image and choose the Search tab.
3. Enter the name of the image.
4. Choose whether to search the current space or All Spaces and choose Search.
5. Select the required image from the search results and choose Insert.

Alternatively, you can cut and paste the image from another page (the image will still only be attached to the original page).

**Displaying an image from a remote web page**

You can display an image from a remote web page on your Confluence page, without needing to attach it to your page. You need to know the URL for the image, not for the web page it appears on. Note that you should have permission to use that image on your page.

To display an image located on a web page:
1. While editing the page, position the cursor where you want to place the image.
2. Choose Insert > Image and choose From the Web.
4. Choose Preview to check that the URL and image are correct.
5. Choose Insert.

Alternatively, you can simply cut and paste the image from a web page.

**Controlling the image appearance**

When editing the page, select the image to show the image properties panel. The panel allows you to set the display size, add a border and effects and link the image to other pages.

To set the size of the image, do one of the following:
- Choose one of the size 'preset' buttons (the image width in pixels is displayed to the left).
- Choose the image size text and enter a new image width in pixels (you can specify a size between 16px and 900px).

Images are displayed as thumbnails.

To add a border to the image:
- Choose Border in the image properties panel.

To add a hyperlink to the image:
- Choose Link in the image properties panel.

To align an image:
- Select the image and choose the paragraph alignment buttons on the editor toolbar.
- If you choose the left or right alignment, the text will wrap around the image. The text does not wrap for
To add effects to an image:

- Choose Properties > Effects in the image properties panel.
- Select an effect and choose Save.

Note: The Instant Camera effect only works with Latin character languages, due to a lack of handwriting style fonts in multi-byte languages.

To add a caption to an image:

- Choose Effects in the image properties panel and choose the Instant Camera image effect.
- Save the page.
- Choose Tools > Attachments to go to the 'Attachments' view of the page.
- Choose Properties next to the image file.
- Add a comment to the attachment. The text in your comment will appear as the image caption.

You will need to re-enter the comment each time you upload a new version of the image.

Screenshot: The image properties panel beneath an image
Setting other image attributes

You can add a title and alt text to your image in the image properties panel. The image title displays when the user hovers over the image or views the full size image. The alt text is used by screen readers and when the image cannot be shown.

To add a title and alt text:

- Choose Properties > Title in the image properties panel.
- Enter a title and alt text and choose Save.

Other attributes can also be set by using the Insert > Wiki Markup function from the editor toolbar, then using the syntax described in Confluence Wiki Markup.

Displaying a gallery of images

See the Gallery Macro.

Image file formats

You can attach image files of any format to a page. Confluence supports the following image formats in the Gallery macro and when displaying an image on a page:

- gif
- jpeg
- png
- bmp (depending on browser support)

Notes

Displaying image effects can be resource intensive. Confluence limits the threads that are dedicated to displaying image effects so that it does not impact your whole instance. If a thread is not available, Confluence will display the image without the effect.

The following knowledge base article provides information if you need to adjust the number of threads - Image effects are not displayed in Confluence 5.5 or later.

Deleting an Image
This page describes how to remove an image from a page. You may want to remove the image from the content of the page, but leave the image available in Confluence. Or you may want to remove the image from Confluence entirely.

Removing an image from the content of a page

A Confluence page can display one or more images, as described in Displaying Images.

To remove an image from the content of a page:

1. Edit the page.
2. Select the image. The image properties panel will appear, letting you know that the image is selected.
3. Press the Delete key on your keyboard.
4. Save the page.

The image will no longer appear as part of the page content. If the image file was originally uploaded as an attachment on the current page or another page, the image is still available in Confluence. If you want to remove the attachment, follow the steps below.

Removing an image attachment from Confluence

To remove an image file from Confluence, you must remove the attachment. See Deleting an Attachment.

Note: A page can display an image that is attached to another page. If you remove an image that is used on a page, readers will see an error message on that page.

Example error message that appears when image attachment is removed:

Related pages:
- Displaying Images
- Working with Attachments
- Confluence User's Guide

Working with Tables

Confluence pages can include multi-row and multi-column tables. You can highlight cells, rows and columns in different colours. When viewing the page, people can sort the table by clicking the column headers.

Inserting a table

To create a table:

1. While editing the page, place your cursor at the point where you want to insert the table.
2. Choose Table on the toolbar.
3. A dropdown menu will appear, showing a table with a variable number of rows and columns. Click in a cell to set the number of columns and rows for your table.
4. Add content and more rows and columns as needed. See below for guidelines on what you can do with your table in the editor.

Screenshot: Inserting a table with 3 rows and 3 columns
What you can do with your table in the editor

While editing a page, place your cursor inside a table to see the table toolbar.

Using the table toolbar you can:

- Insert an empty row above the current one.
- Insert an empty row below the current one.
- Remove the current row.
- Cut the current row and copy it to the clipboard.
- Copy the current row to the clipboard.
- Paste the row from the clipboard to the current row.
- Insert an empty column to the left of the current one.
- Insert an empty column to the right of the current one.
- Remove the current column.
- Merge the selected cells.
- Split the selected merged cells.
- Mark a row as a table header. The cells in the row will be highlighted in grey and the text will be bold.
- Mark a column as a table header. The cells in the column will be highlighted in grey and the text will be bold.
- Highlight cells with a background colour.
- Remove the table.

Shortcut keys

<table>
<thead>
<tr>
<th>Windows</th>
<th>Action</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+c</td>
<td>Copy the current table row, or the selected rows.</td>
<td>Cmd+Shift+c</td>
</tr>
<tr>
<td>Ctrl+Shift+i</td>
<td>Insert a table. (Opens the Insert Table dialog.)</td>
<td>Cmd+Shift+i</td>
</tr>
<tr>
<td>Ctrl+Shift+v</td>
<td>Paste the table rows from your clipboard, placing them above the current row.</td>
<td>Cmd+Shift+v</td>
</tr>
<tr>
<td>Ctrl+Shift+x</td>
<td>Cut the current table row, or the selected rows.</td>
<td>Cmd+Shift+x</td>
</tr>
<tr>
<td>Alt+Up Arrow</td>
<td>Add a row above the current row.</td>
<td>Alt+Up Arrow</td>
</tr>
<tr>
<td>Alt+Down Arrow</td>
<td>Add a row below the current row.</td>
<td>Alt+Down Arrow</td>
</tr>
</tbody>
</table>
For more editor keyboard shortcuts, see Keyboard Shortcuts.

**Sorting the table in view mode**

When readers view a table on a page, they can sort the table by clicking the sort icons in the header row.

*Screenshot: A colourful, sortable table*

Using Symbols, Emoticons and Special Characters

You can add various symbols and special characters to Confluence pages. You can also use them in other places that display content, such as blog posts, comments, the dashboard welcome message and the configuration panels offered by the Documentation theme.

**Inserting symbols and special characters**

**To add a symbol to your page:**

1. Edit the page.
2. Choose Insert > Symbol. This will display the 'Insert Custom Character' window.
3. Choose a symbol to insert it.

**On this page:**
- Inserting symbols and special characters
- Inserting emoticons
- Preventing emoticons from appearing

**Related pages:**
- Quick Reference Guide for the Confluence Editor
- Confluence Wiki Markup
- Confluence User’s Guide

*Screenshot: Available symbols*
Inserting emoticons

There are two ways to add an emoticon, or smiley, to your page.

By choosing an emoticon from those available:

1. Choose Insert > Emoticon.
2. Choose an emoticon to insert it.

By typing a character combination:

You can insert emoticons by typing commonly-used character combinations. For example, the following code appears as an emoticon when the page is rendered.

`;)

The above example creates this emoticon: 😊

This table shows the emoticons (and other icons) available in Confluence, and the character combinations that create them:

<table>
<thead>
<tr>
<th>Image</th>
<th>Notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>😊</td>
<td>:)</td>
</tr>
<tr>
<td>😐</td>
<td>:</td>
</tr>
<tr>
<td>😌</td>
<td>:D</td>
</tr>
<tr>
<td>😎</td>
<td>(y)</td>
</tr>
<tr>
<td>😉</td>
<td>(n)</td>
</tr>
<tr>
<td>😏</td>
<td>(i)</td>
</tr>
<tr>
<td>😐</td>
<td>(l)</td>
</tr>
<tr>
<td>😐</td>
<td>(+)</td>
</tr>
<tr>
<td>😐</td>
<td>(-)</td>
</tr>
<tr>
<td>😐</td>
<td>(?)</td>
</tr>
<tr>
<td>😐</td>
<td>(on)</td>
</tr>
<tr>
<td>😐</td>
<td>(off)</td>
</tr>
<tr>
<td>😐</td>
<td>(*)</td>
</tr>
<tr>
<td>😐</td>
<td>(*r)</td>
</tr>
<tr>
<td>😐</td>
<td>(*g)</td>
</tr>
<tr>
<td>😐</td>
<td>(*b)</td>
</tr>
<tr>
<td>😐</td>
<td>(*y)</td>
</tr>
</tbody>
</table>

Preventing emoticons from appearing

To undo the conversion of a character combination into an emoticon, press Ctrl+Z (Windows) or Cmd+Z (Mac).

To prevent Confluence from converting text to emoticons automatically, disable ‘Autoformatting’ in your user profile. See Editing User Settings.

The Confluence knowledge base has an article on disabling emoticons for the Confluence site as a whole.

Using Autocomplete

When using the Confluence editor, you can type a trigger character or press a keyboard shortcut to see a list of suggested links, files or macros to add to your page, or to mention another user (and automatically notify them of
Summary of autocomplete

<table>
<thead>
<tr>
<th>What you want to do</th>
<th>Trigger character</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a link on your page</td>
<td>[</td>
<td>Ctrl+Shift+K</td>
<td>See a list of suggested pages or other locations to link to from your page. More...</td>
</tr>
<tr>
<td>Display an image, video, audio file or document on your page</td>
<td>!</td>
<td>Ctrl+Shift+M</td>
<td>See a list of suggested images, multimedia files and documents to embed in your page. More...</td>
</tr>
<tr>
<td>Add a macro on your page</td>
<td>{</td>
<td>None</td>
<td>See a list of suggestions as you begin typing a macro name. More...</td>
</tr>
<tr>
<td>Notify another user by email that you have mentioned them on your page</td>
<td>@</td>
<td>None</td>
<td>See a list of suggested users to mention. More...</td>
</tr>
</tbody>
</table>

On this page:
- Summary of autocomplete
- Using autocomplete for links
- Using autocomplete for images, videos, audio files and documents
- Using autocomplete for macros
- Using autocomplete for mentions
- Cancelling autocomplete
- Enabling and disabling autocomplete
- Ignoring autocomplete

Related pages:
- Working with Links
- Using Images
- Working with Macros
- Keyboard Shortcuts
- User Profile Overview
- Confluence User's Guide

Using autocomplete for links

Type '[', or press Ctrl+Shift+K, to see a list of suggested pages or other locations to link to from your page. You can link to pages, user profiles, images, documents and other file attachments.

To autocomplete a link:

1. Edit the page.
2. Click where you want to insert a link and do one of the following:
   - Type '[' and then the first few characters of the page title, user's name, image name or file name.
   - Type the first few characters of the page title, user's name, image name or file name (or select relevant text) and then press Ctrl+Shift+K.
3. Click the relevant link from the list of suggestions.

If the item you need is not in the list, either:
- Choose Search for 'xxx' to continue looking for the page within Confluence, or
- Choose Insert Web Link to insert a link to an external web page using the link browser.

Screenshot: Autocomplete for a link
Using autocomplete for images, videos, audio files and documents

You can use the autocomplete as a fast way of embedding images, videos, audio files and documents into your page. Type an exclamation mark or press Ctrl+Shift+M to see a list of suggested images, multimedia files and documents to display on your page. You can use autocomplete to embed the following file types:

- Images – any format that Confluence supports. See Displaying Images.
- Videos, audio files and all multimedia formats that Confluence supports. See Embedding Multimedia Content.
- Office documents supported by the Confluence Office Connector: Word, Excel and PowerPoint.
- PDF files.

Autocomplete works most efficiently for files that are already attached to the Confluence page. See Attaching Files to a Page.

To embed an image, video, audio file or document:

1. Edit the page.
2. Click where you want to insert the image, video, audio file or document and do one of the following:
   - Type '!' and then the first few characters of the image, file or document name.
   - Type the first few characters of the name of the image, file or document (or select relevant text) and then press Ctrl+Shift+M.
3. Choose the relevant file from the list of suggestions.

If the item you need is not in the list, either:

- Choose Open Image Browser to find images and documents using the image browser, or
- Choose Insert Other Media to embed videos, audio and other multimedia files using the macro browser. Insert the ‘Multimedia’ macro to display your multimedia file.

Screenshot: Autocomplete for an image or document
Using autocomplete for macros

Type '{' to see a list of suggested macros to add to your page.

Autocomplete provides access to all available macros in your Confluence site, including any user macros that your administrator has added and made visible to all.

ℹ️ You need to know the name of macro. Autocomplete for macros will only match the name of the macro, not the description.

To autocomplete a macro using '{':

1. Edit the page.
2. Click where you want to insert the macro.
3. Type '{' and then the first few characters of the macro name.
4. Choose the relevant macro from the list of suggestions.
5. Configure the macro by completing the form fields as prompted.

If the macro you need is not in the list, choose Open Macro Browser in the list of suggestions to continue looking for the macro in the macro browser. See Working with Macros.

Screenshot: Autocomplete for a macro

Using autocomplete for mentions

You can use autocomplete to automatically notify another Confluence user that you have mentioned them in a page, blog post, or comment. Type '@' and part of the person's name, to see a list of suggested users.

Note: Use the person's full name. Autocomplete will recognise users' full names only, not their usernames.
To mention someone using '@':

1. In the editor, type '@' then the first few characters of the person's name or username.
2. Choose the user's name from the list of suggestions.

Screenshot: Autocomplete for mentions

Cancelling autocomplete

The autocomplete starts automatically when you press the trigger characters. You may want to close the autocomplete menu or escape from autocomplete once it has started.

There are a few different ways to stop the autocomplete once it has started:

- Press the escape key, 'Esc', on your keyboard.
- Click somewhere else in the editor panel.
- Press an arrow key to move out of the autocomplete area.
- For the link autocomplete only: enter a right-hand square bracket, like this: ]

Enabling and disabling autocomplete

You can turn off the triggering of autocomplete by the '[' and ']' characters. This will prevent the autocomplete from starting automatically when you press one of the trigger characters. You can also turn it back on again.

Notes:

- This setting does not affect the keyboard shortcuts for autocomplete (Ctrl+Shift+K and Ctrl+Shift+M). Even if the trigger characters are disabled, you can still use the keyboard shortcuts for autocomplete.
- This setting affects only you. Other people using Confluence can enable or disable the setting on their user profiles independently.
- Note that autocomplete is enabled by default.

To enable or disable the autocomplete trigger characters:

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Choose Editor under 'Your Settings' in the left-hand panel.
3. Choose Edit.
4. Either:
   - Disable autocompletion by selecting Disable Autocomplete.
   - Enable autocompletion by clearing Disable Autocomplete.
5. Choose Submit.

Screenshot: User settings for the editor
Ignoring autocomplete

You can add macros, links and images by wiki markup alone. Type the macro, including its parameters and the closing curly bracket, add a link, such as an anchor link, and end it with a square bracket. Insert an image or other embedded object, enclosed between exclamation marks. As soon as you close the macro, link, or embedded image, Confluence will convert it to rich text format and add it to the page.

More information about mouse-free macros, links and images:

- Quick Reference Guide for the Confluence Editor
- Video

Working with Page Layouts and Columns and Sections

There are two ways to modify the layout of a Confluence page. You can:

- use Page Layouts to add sections and columns, or
- use macros to add sections and columns.

Page layouts provides a simple, visual representation of your page layout in the editor, while the macros are more flexible and allow for greater complexity in your layout.

Using page layouts

The Page Layouts tool allows you to structure your page using horizontal sections and vertical columns. By adding multiple sections with different column configurations you can build quite complex layouts very easily.

On this page:

- Using page layouts
- Using the Section and Column macros

Screenshot: Editor view of a page showing three sections with different column configurations.
Start by adding a horizontal section to your page.

**To add a section:**

1. Choose the Page Layout button on the editor toolbar.
2. The Page Layout toolbar appears. Choose Add Section.

The new section appears below your current content. The boundaries of the section are indicated by dotted lines. These are not visible when you view the page.

**To change the column layout in a section:**

1. Place your cursor in the section you wish to change.
2. Choose a layout from the Page Layout toolbar (for example two column, three column).

Any text, images or macros in your section are not lost when you change the column layout. When you decrease the number of columns, Confluence will move your content to the left. When you increase the number of columns, Confluence will add blank columns to the right of your existing content.

**To move a section to another part of the page:**

1. Place your cursor in the section you wish to move.
2. Choose the Move up or Move down buttons.

The section and all of its content will be moved above or below other sections on the page.

**To delete a section:**

1. Place your cursor in the section you wish to remove.
2. Choose Remove section.

The section and all of its content will be removed.

**Notes about Page Layouts**

- **Column width** - The width of the columns are fixed. If you need more than three columns, or columns of a specific width, you should use the Section and Column macros described below.
- **Very wide tables.** The width of each column is set to a percentage of the page width. The icons in the drop down menu indicate the relative widths for each layout. In most cases, Confluence will adapt the width of the columns to fit the width of the page. If a column includes a large table, the content may not fit into the width of the page. You will see a horizontal scroll bar when viewing the page.

**Using the Section and Column macros**

You can use the Section and Column macros to add a set of columns to the page. The Section macro defines an area that will contain the columns. You can have as many sections as you like. Within each section, you can have as many columns as you like.

The Section and Column macros are useful if you want to define a specific percentage or pixel width for each column.

**To add a section and some columns to a page:**
In the Confluence editor, choose **Insert > Other Macros**.  
Find the **Section** macro, select it and insert it onto the page.  
Choose **Insert > Other Macros** again.  
Find and insert the **Column** macro.  
Add your content to the column.  
Insert as many columns as you like within the section.

**Screenshot: A section and two columns in the editor**

When you see the page in view mode, the above layout is displayed like this:  
Content for column 1 goes here  
Content for column 2 goes here

### Macro parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

**Parameters of the Section macro**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Border</td>
<td>false</td>
<td>Select this option to draw a border around the section and columns.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Without a Column macro, the border will not be displayed correctly.</td>
</tr>
</tbody>
</table>

**Parameters of the Column macro**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Width</td>
<td>100% of the page width, divided equally by the number of columns in the section.</td>
<td>Specify the width of the column, in pixels (for example, 400px) or as a percentage of the available width (for example, 50%).</td>
</tr>
</tbody>
</table>

**Notes about sections and columns**

- All content within your section must be enclosed within a Column macro, otherwise the section layout will not work as expected.  
- You can put tables inside columns.

---

**Working with Macros**
Using a macro, you can add extra functionality or include dynamic content on a page. For example, the Attachments macro will list a page's attachments in the page itself, so that readers do not have to visit the Attachments tab.

**Adding a Macro to your Page**

**Including Macros with the Macro Browser**

**To add a macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Macro Parameters**

Many macros allow you to include optional parameters to control the macro's output.

With the Attachments Macro, for instance, you have two optional parameters allowing you to:

- Specify the file formats of the attachments displayed.
- Choose whether or not you want old versions of the attachments displayed.

**Macro Placeholders**

Macro placeholders are displayed in the editor where you have added a macro to the page.

When editing a page, you can:

- Double-click a macro placeholder (or click the placeholder and choose **Edit**) to open the macro dialog window, where you can edit the macro's parameters.
- Select a macro placeholder to cut, copy and paste the macro.

**On this page:**

- Adding a Macro to your Page
- Confluence macros
- Creating your own macros
- Getting more macros from The Marketplace

**Confluence macros**

Below is a list of the macros currently bundled with Confluence. Click a macro name for details of the usage, including optional parameters and examples.

- Activity Stream Macro
- Anchor Macro
- Attachments Macro
- Blog Posts Macro
- Change-History Macro
- Chart Macro
- Cheese Macro
- Children Display Macro
- Code Block Macro
- Column Macro
- Content by Label Macro
- Content by User Macro
- Content Report Table Macro
- Contributors Macro
- Contributors Summary Macro
- Create from Template Macro
• Create Space Button Macro
• Excerpt Include Macro
• Excerpt Macro
• Expand Macro
• Favourite Pages Macro
• Gadget Macro
• Gallery Macro
• Global Reports Macro
• HTML Include Macro
• HTML Macro
• IM Presence Macro
• Include Page Macro
• Info Macro
• JIRA Chart Macro
• JIRA Issues Macro
• JUnit Report Macro
• Labels List Macro
• Livesearch Macro
• Loremipsum Macro
• Multimedia Macro
• Navigation Map Macro
• Network Macro
• Noformat Macro
• Note Macro
• Office Excel Macro
• Office PowerPoint Macro
• Office Word Macro
• Page Index Macro
• Page Properties Macro
• Page Properties Report Macro
• Page Tree Macro
• Page Tree Search Macro
• Panel Macro
• PDF Macro
• Popular Labels Macro
• Profile Picture Macro
• Recently Updated Dashboard Macro
• Recently Updated Macro
• Recently Used Labels Macro
• Related Labels Macro
• RSS Feed Macro
• Search Results Macro
• Section Macro
• Space Attachments Macro
• Space Details Macro
• Space Jump Macro
• Spaces List Macro
• Status Macro
• Table of Contents Macro
• Table of Content Zone Macro
• Task Report Macro
• Tip Macro
• User List Macro
• User Profile Macro
• User Status List Macro
• View File Macro
• Warning Macro
• Widget Connector Macro

Creating your own macros

Users with System Administrator permissions can create user macros - see Writing User Macros.
If you want to create something more complex, you can develop your own plugin - see Writing Confluence Plugins.

**Getting more macros from The Marketplace**

You can find a wide range of Atlassian and third party macros at The Marketplace. These are distributed as add-ons and can be installed by a Confluence Administrator.

**Activity Stream Macro**

The Activity Stream macro is a specific instance of the Gadget macro. It inserts an Activity Stream gadget onto your page. For instructions, see Activity Stream Gadget.

**Related pages:**
- Activity Stream Gadget
- Gadget Macro
- Confluence User's Guide

**Anchor Macro**

Allows you to link to a specific part of a page. For more information on using anchors see Working with Anchors.

**Code Examples**

The following examples are provided for advanced users who want to edit the underlying markup for a Confluence page.

**Macro name:** anchor

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="anchor">
  <ac:parameter ac:name=""/>here</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
{anchor:here}
```

**Attachments Macro**

Displays a list of attachments on a given page. For more information see Displaying a List of Attachments.

**Code examples**

The following examples are provided for advanced users who want to edit the underlying markup for a Confluence page.

**Macro name:** attachments

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>old</td>
<td>No</td>
<td>false</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• false - Displays only the latest version of each attachment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• true – Displays all versions of each attachment, including the old versions.</td>
</tr>
</tbody>
</table>
| patterns | No | (None) | A comma-separated list of regular expressions, used to filter the attachments by file name. Note that the parameter values must be regular expressions. For example:
- To match a file suffix of 'jpg', use .*jpg (not *.jpg).
- To match file names ending in 'jpg' or 'png', use .*jpg,.png |
| sortBy | No | date | Available values:
- date
- size
- name
- createdate |
| page | No | The page on which the macro exists. | Page name, used to display attachments from another page. |
| sortOrder | No | The default sort order is determined by the sortBy type:
- Reverse chronological for 'date'.
- Largest to smallest for 'size'.
- Alphabetical for 'name'. | Available values:
- ascending
- descending |
| labels | No | (None) | A comma-separated list of labels. Confluence will show only attachments that have all the labels specified. (The match is an AND, not an OR.) |
| upload | No | false | Determines whether the list of attachments will include options allowing users to browse for, and attach, new files. |
| preview | No | true | Determines whether a preview of the attached file appears when the item is expanded. |

Storage format example

```xml
<ac:structured-macro ac:name="attachments">
  <ac:parameter ac:name="old">false</ac:parameter>
  <ac:parameter ac:name="patterns">.*png,.*jpg</ac:parameter>
  <ac:parameter ac:name="sortBy">name</ac:parameter>
  <ac:parameter ac:name="page">
    <ac:link>
      <ri:page ri:content-title="My page about chocolate"/>
    </ac:link>
  </ac:parameter>
  <ac:parameter ac:name="sortOrder">descending</ac:parameter>
  <ac:parameter ac:name="labels">chocolate,cookies</ac:parameter>
  <ac:parameter ac:name="upload">false</ac:parameter>
</ac:structured-macro>
```

Wiki markup example
Blog Posts Macro

The Blog Posts macro allows you to display blog posts on a Confluence page. Clicking on a title takes you to the blog post.

Using the Blog Posts Macro

To add the Blog Posts macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Type to Display (content)</td>
<td>No</td>
<td>titles</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• titles — Display only the title of each blog post.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• excerpts — Display a short excerpt from each blog post. If the post</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>contains an Excerpt macro, the Blog Posts macro will display the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>content defined in the Excerpt macro. If the post does not contain</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>an Excerpt macro, the Blog Posts macro will display the first few</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>sentences of the post.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• entire — Display the whole content of each blog post.</td>
</tr>
<tr>
<td>Time Frame (time)</td>
<td>No</td>
<td>no limit</td>
<td>Specify how far back in time Confluence should look for the blog posts</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>to be displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• m — Minutes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• h — Hours, so '12h' displays blog posts created in the last twelve hours.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• d — Days, so '7d' displays blog posts created in the last seven days.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• w — Weeks</td>
</tr>
<tr>
<td>Restrict to these Labels (label)</td>
<td>No</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Filter the results by label. The macro will display only the blog posts which are tagged with the label(s) you specify here.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>You can specify one or more label values, separated by a comma or a space.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of -badpage you will get only content which is not labelled with 'badpage'.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• To indicate that the results must match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of +superpage,+goodpage you will get only content which has at least two labels, being 'superpage' and 'goodpage'.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Restrict to these Authors (author)</th>
<th>No</th>
<th>None</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter the results by author. The macro will display only the blog posts which are written by the author(s) you specify here.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Restrict to these Spaces (spaces)</th>
<th>No</th>
<th>@self, i.e. the space which contains the page on which the macro is coded</th>
</tr>
</thead>
<tbody>
<tr>
<td>This parameter allows you to filter content by space. The macro will display only the pages which belong to the space(s) you specify here.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>You can specify one or more space keys, separated by a comma or a space.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of -BADSPACE you will get only content which is not in the BADSPACE.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special values:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• @self — The current space.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• @personal — All personal spaces.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• @global — All site spaces.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• @favorite — The spaces you have marked as favourite.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• @favourite — The same as @favorite above.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• @all — All spaces in your Confluence site.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• * — The same as @all above.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~<a href="mailto:jbloggs@example.com">jbloggs@example.com</a>.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum Number of Blog Posts (max)</th>
<th>No</th>
<th>15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the maximum number of results to be displayed. Note that the results are sorted first, and then the maximum parameter is applied.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Sort By

<table>
<thead>
<tr>
<th>Sort By (sort)</th>
<th>No</th>
<th>creation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Specify how the results should be sorted. If this parameter is not specified, the sort order defaults to descending order (newest first) based on the creation date.

Values:
- **title** — Sort alphabetically by title.
- **creation** — Sort by the date on which the content was added.
- **modified** — Sort by the date on which the content was last updated.

### Reverse Sort

<table>
<thead>
<tr>
<th>Reverse Sort (reverse)</th>
<th>No</th>
<th>false</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Select to change the sort from descending to ascending order (oldest first). Use this parameter in conjunction with the **Sort By** parameter. This parameter is ignored if the **Sort By** parameter is not specified.

In storage format and wikimarkup a value of `true` changes the sort order.

### Code examples

The following examples are provided for advanced users who want to edit the underlying markup for a Confluence page.

**Macro name**: blog-posts

**Macro body**: None.

**Storage format example**

```xml
<ac:structured-macro ac:name="blog-posts">
  <ac:parameter ac:name="content">titles</ac:parameter>
  <ac:parameter ac:name="spaces">
    <ri:space ri:space-key="ds"/>
  </ac:parameter>
  <ac:parameter ac:name="author">
    <ri:user ri:userkey="12345678912345678912345678912345"/>
  </ac:parameter>
  <ac:parameter ac:name="time">4w</ac:parameter>
  <ac:parameter ac:name="sort">creation</ac:parameter>
  <ac:parameter ac:name="max">10</ac:parameter>
  <ac:parameter ac:name="labels">chocolate,cookies</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
(blog-posts:content=titles|spaces=@self,ds|author=jsmith|time=4w|reverse=true|sort=creation|max=10|label=chocolate,cookies)
```

### Change-History Macro

The Change-History macro shows the history of updates made to a page: version number, author, date and comment. It displays the information inline.

**Screenshot**: The Change-History macro in Confluence
To add the Change-History macro to a page:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Note:** There are no parameters for this macro.

**Code examples**

The following examples are provided for advanced users who want to edit the underlying markup for a Confluence page.

**Macro name:** change-history

**Macro body:** None.

**Parameters:** None.

**Storage format example**

```html
<ac:structured-macro ac:name="change-history"/>
```

**Wikimarkup example**

```markdown
{change-history}
```

**Chart Macro**

The Chart macro allows you to display a chart based on tabular data. When you add the macro to a page, you:

- supply the data to be charted by the macro as a table in the placeholder of the macro.
- edit the macro parameters in the Macro Browser to configure the format of the chart.

**Screenshot 1: A table of data in the Chart macro placeholder**
<table>
<thead>
<tr>
<th>Weeks</th>
<th>Issues Burndown</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/07/2011</td>
<td>81</td>
</tr>
<tr>
<td>11/07/2011</td>
<td>68</td>
</tr>
<tr>
<td>18/07/2011</td>
<td>67</td>
</tr>
<tr>
<td>25/07/2011</td>
<td>66</td>
</tr>
<tr>
<td>01/08/2011</td>
<td>65</td>
</tr>
<tr>
<td>08/08/2011</td>
<td>65</td>
</tr>
<tr>
<td>15/08/2011</td>
<td>64</td>
</tr>
<tr>
<td>22/08/2011</td>
<td>44</td>
</tr>
<tr>
<td>29/08/2011</td>
<td>24</td>
</tr>
<tr>
<td>05/09/2011</td>
<td>0</td>
</tr>
</tbody>
</table>

Screenshot 2: The resulting chart
On this page:

- Using the Chart Macro
- Parameters
- Examples
  - Pie Chart
  - Bar Chart
  - 3D Bar Chart
  - Time Series Chart
  - XY Line Chart
  - XY Area Chart
  - Area Charts
  - Gantt Chart
- Code examples
  - Chart type parameters
  - Chart display parameters
  - Chart title and label parameters
  - Chart data parameters
  - Chart colour parameters
  - Chart axis parameters
  - Pie chart Parameters
  - Chart attachment parameters
  - Wiki markup example

Using the Chart Macro

To add the Chart macro to a page:

1. Edit the page and use autocomplete to add the Chart macro. (Type '{chart}'.)
2. Enter your chart data as one or more tables in the body of the macro placeholder. (See the screenshot above.)
3. Click the macro placeholder and choose Edit.
4. Select a chart type using the Type parameter (see below).
5. Choose other parameter settings in the macro browser, as described below.
6. Click Refresh in the 'Preview' area, to check that the chart appears as you expect.
7. Click Save to add the chart to your page.
8. Click Save again when you are ready to save the page.

Parameters

Chart Type Parameters | Display Control Parameters | Title and Label Parameters | Data Specification Parameters | Colour Parameters | Axis Parameters | Pie Chart Parameters | Attachment Parameters
Chart Type Parameters

These parameters determine the type of chart to display and the way the chart looks.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Type      | pie     | The type of chart to display. XY charts have numerical x- and y-axes. The x values may optionally be time-based (see the Time Series parameter).  
Standard — pie, bar, line, area  
XY Plots — xyArea, xyBar, xyLine, xyStep, xyStepArea, scatter, timeSeries  
Other — gantt |
### Display Control Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>300</td>
<td>The width of the chart in pixels.</td>
</tr>
<tr>
<td>Height</td>
<td>300</td>
<td>The height of the chart in pixels.</td>
</tr>
<tr>
<td>Display rendered data</td>
<td>false</td>
<td>Sets whether to display the rendered body of the macro (usually the data tables). By default, the chart data table isn't rendered.</td>
</tr>
<tr>
<td>Image format</td>
<td>png</td>
<td>The image format to be used for the chart.</td>
</tr>
</tbody>
</table>

### Title and Label Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Title</td>
<td>none</td>
<td>The title of the chart.</td>
</tr>
<tr>
<td>Chart Subtitle</td>
<td>none</td>
<td>A subtitle for the chart, using a smaller font than for Title.</td>
</tr>
<tr>
<td>Horizontal-axis Label</td>
<td>none</td>
<td>The label for the x-axis (domain).</td>
</tr>
<tr>
<td>Vertical-axis Label</td>
<td>none</td>
<td>The label for the y-axis (range).</td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
<td>Show a legend or key.</td>
</tr>
</tbody>
</table>

### Data Specification Parameters

The data for the chart is taken from tables found when the macro body is rendered. These options control how this data is interpreted. By default, numeric and date values are interpreted according to the Confluence global default language (locale) formats. If conversion fails, other languages defined in Confluence will be tried. Additional conversion options can be specified using the parameters below.
### Tables

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>all first level tables</td>
<td>Comma separated list of table ids and/or table numbers (starting at 1) contained within the body of the macro that will be used as the data for the chart. If data tables are embedded in other tables, then table selection will be required. This occurs when more complex formatting is done (for example using section and column macros).</td>
<td></td>
</tr>
</tbody>
</table>

### Columns

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>all columns</td>
<td>Comma separated list of column labels and/or column titles and/or column numbers for tables used for chart data. This applies to all tables processed. Columns are enumerated starting at 1. Column label is the text for the column in the header row. Column title is the (html) title attribute for the column in the header row.</td>
<td></td>
</tr>
</tbody>
</table>

### Content Orientation

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| horizontal | • vertical — data table columns will be interpreted as series.  
• horizontal — data tables rows will be interpreted as series. |

### Time Series

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>false</td>
<td>• true — the x values in an XY plot will be treated as time series data and so will be converted according to date formats.</td>
<td></td>
</tr>
</tbody>
</table>

### Date format

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confluence language defined date formats</td>
<td>For time series data, the date format allows for additional customization of the conversion of data to date values. If a Date format is specified, it will be the first format used to interpret date values. Specify a format that matches the time series data. See simple date format.</td>
<td></td>
</tr>
</tbody>
</table>

### Time Period

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>The time period for time series data. Defines the granularity of how the data is interpreted. Valid values are: Millisecond, Second, Minute, Hour, Day, Week, Month, Quarter, Year.</td>
<td></td>
</tr>
</tbody>
</table>

### Language

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| none | Use in combination with the Country parameter to form a locale. These additional number and date formats will be used for data conversion before the default languages.  
Valid values are 2 character ISO 639-1 alpha-2 codes. |

### Country

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
<td>Use in combination with the Language parameter to form a locale. Valid values are 2 character ISO 3166 codes.</td>
<td></td>
</tr>
</tbody>
</table>

### Forgive

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| true | • true — the macro tries to convert numeric and date values that do not totally match any of the default or user-specified formats.  
• false — enforce strict data format. Data format errors will cause the chart to not be produced. |

### Colour Parameters

Colours are specified using hexadecimal notation or HTML colour names.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Colour</td>
<td>White</td>
<td>Background of the chart.</td>
</tr>
<tr>
<td>Border Colour</td>
<td>no border</td>
<td>Border around the chart.</td>
</tr>
<tr>
<td>Colours</td>
<td>Comma-separated list of colours used to customise category, sections, and series colours.</td>
<td></td>
</tr>
</tbody>
</table>

### Axis Parameters

Depending on the chart type, the range and domain axis may be customised. These values are automatically generated based on the data but can be overridden by specifying one or more more of these parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Range Minimum Value</td>
<td>none</td>
<td>Range axis lower bound.</td>
</tr>
<tr>
<td>Range Maximum Value</td>
<td>none</td>
<td>Range axis upper bound.</td>
</tr>
<tr>
<td>Range Axis Tick Unit</td>
<td>none</td>
<td>Range axis units between axis tick marks.</td>
</tr>
<tr>
<td>Range Axis Label Angle</td>
<td>none</td>
<td>Angle for the range axis label in degrees.</td>
</tr>
<tr>
<td>Domain Axis Lower Bound</td>
<td>none</td>
<td>Only applies to XY plots. Domain axis lower bound. For a date axis, this value must be expressed in the date format specified by the Date format parameter.</td>
</tr>
<tr>
<td>Domain Axis Upper Bound</td>
<td>none</td>
<td>Only applies to XY plots. Domain axis upper bound. For a date axis, this value must be expressed in the date format specified by the Date format parameter.</td>
</tr>
<tr>
<td>Domain Axis Tick Unit</td>
<td>none</td>
<td>Only applies to XY plots. Domain axis units between axis tick marks. For a date axis, this value represents a count of the units specified in the Time Period parameter. The Time Period unit can be overridden by specifying a trailing character: y (years), M (months), d (days), h (hours), m (minutes), s (seconds), u (milliseconds).</td>
</tr>
<tr>
<td>Domain Axis Label Angle</td>
<td>none</td>
<td>Only applies to XY plots. The angle for the domain axis label, in degrees.</td>
</tr>
<tr>
<td>Category Label Position</td>
<td>none</td>
<td>Placement of the axis label text for categories.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• up45 — 45 degrees going upward</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• up90 — 90 degrees going upward</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• down45 — 45 degrees going downward</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• down90 — 90 degrees going downward</td>
</tr>
<tr>
<td>Date Tick Mark Position</td>
<td>start</td>
<td>Placement of the date tick mark.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• start — tick mark is at the start of the date period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• middle — tick mark is in the middle of the date period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• end — tick mark is at the end of the date period.</td>
</tr>
</tbody>
</table>

Pie Chart Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Attachment      | none    | The name and location with which the chart image will be saved as an attachment. The user must be authorised to add attachments to the page specified.  
  - page^attachmentName.png — the chart is saved as an attachment to the current page.  
  - space:page^attachmentName.png — the chart is saved as an attachment to the page name provided.  
  - space:page^attachmentName.png — the chart is saved as an attachment to the page name provided in the space indicated. |
| Attachment Version | new | Defines the the versioning mechanism for saved charts.  
  - new — creates new version of the attachment.  
  - replace — replaces all previous versions of the chart. To replace an existing attachment, the user must be authorized to remove attachments for the page specified.  
  - keep — only saves a new attachment if an existing export of the same name does not exist. An existing attachment will not be changed or updated. |
| Attachment Comment | none | Comment used for a saved chart attachment. |
| Thumbnail       | false | true — the chart image attachment will be shown as a thumbnail. |

**Attachment Parameters**

These are advanced options that can be used for chart versioning, to enable automation and to improve performance. Use these options carefully! Normally, the chart image is regenerated each time the page is displayed. These options allow for the generated image to be saved as an attachment and have subsequent access re-use the attachment. This can be useful especially when combined with the Cache Plugin to improve performance. Depending on the options chosen, chart images can be versioned for historical purposes.

**Examples**

**Pie Chart**

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>pie</td>
<td></td>
</tr>
<tr>
<td>Chart Title</td>
<td>Fish Sold 2011</td>
<td>Fish Type 2011</td>
</tr>
<tr>
<td></td>
<td>Herring</td>
<td>9,500</td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
<td>Salmon</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2,900</td>
</tr>
</tbody>
</table>
### Bar Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>bar</td>
<td></td>
</tr>
<tr>
<td><strong>Chart Title</strong></td>
<td>Fish Sold</td>
<td></td>
</tr>
<tr>
<td><strong>Show Legend</strong></td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

**Fish Type** | 2010 | 2011  
---|---|---|
Herring       | 9,500 | 8,300  
Salmon        | 2,900 | 4,200  
Tuna          | 1,500 | 1,500  

### 3D Bar Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>bar</td>
<td></td>
</tr>
<tr>
<td><strong>Show in 3D</strong></td>
<td>true</td>
<td></td>
</tr>
<tr>
<td><strong>Opacity</strong></td>
<td>50</td>
<td></td>
</tr>
<tr>
<td><strong>Show Legend</strong></td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

**Revenue** | 2009 | 2010 | 2011  
---|---|---|---|
Revenue      | 12.4 | 31.8 | 41.1  
Expense      | 43.6 | 41.8 | 31.1  

**Fish Sold 2011**

- **Herring** (9,500 – 68%)
- **Salmon** (2,900 – 21%)
- **Tuna** (1,500 – 11%)
## Time Series Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Tables in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>Month</strong></td>
<td><strong>Revenue</strong></td>
</tr>
<tr>
<td></td>
<td>1/2011</td>
<td>31.8</td>
</tr>
<tr>
<td></td>
<td>2/2011</td>
<td>41.8</td>
</tr>
<tr>
<td></td>
<td>3/2011</td>
<td>51.3</td>
</tr>
<tr>
<td></td>
<td>4/2011</td>
<td>33.8</td>
</tr>
<tr>
<td></td>
<td>5/2011</td>
<td>27.6</td>
</tr>
<tr>
<td></td>
<td>6/2011</td>
<td>49.8</td>
</tr>
<tr>
<td></td>
<td>7/2011</td>
<td>51.8</td>
</tr>
<tr>
<td></td>
<td>8/2011</td>
<td>77.3</td>
</tr>
<tr>
<td></td>
<td>9/2011</td>
<td>73.8</td>
</tr>
<tr>
<td></td>
<td>10/2011</td>
<td>97.6</td>
</tr>
<tr>
<td></td>
<td>12/2011</td>
<td>113.7</td>
</tr>
</tbody>
</table>

## XY Line Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>Revenue</strong></td>
<td><strong>Expense</strong></td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>41.1</td>
<td>31.8</td>
</tr>
</tbody>
</table>

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### XY Area Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>xyArea</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Show Legend</strong></td>
<td><strong>true</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Revenue</strong></th>
<th><strong>Expense</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>41.1</td>
<td>31.1</td>
</tr>
<tr>
<td>31.8</td>
<td>41.8</td>
</tr>
<tr>
<td>12.4</td>
<td>43.6</td>
</tr>
</tbody>
</table>

### Area Charts Example 1

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>area</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Show Legend</strong></td>
<td><strong>true</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td><strong>300</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td><strong>300</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Opacity</strong></td>
<td><strong>50</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Satisfaction</strong></th>
<th><strong>2009</strong></th>
<th><strong>2010</strong></th>
<th><strong>2011</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>20</td>
<td>23</td>
<td>34</td>
</tr>
<tr>
<td>Satisfied</td>
<td>40</td>
<td>34</td>
<td>23</td>
</tr>
<tr>
<td>Dissatisfied</td>
<td>25</td>
<td>26</td>
<td>25</td>
</tr>
<tr>
<td>Very</td>
<td>15</td>
<td>17</td>
<td>18</td>
</tr>
</tbody>
</table>
Example 2

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>area</td>
<td></td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Stacked Values</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Satisfaction</th>
<th>2009</th>
<th>2010</th>
<th>2011</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>12</td>
<td>23</td>
<td>31</td>
</tr>
<tr>
<td>Satisfied</td>
<td>1</td>
<td>34</td>
<td>36</td>
</tr>
<tr>
<td>Dissatisfied</td>
<td>4</td>
<td>6</td>
<td>22</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>2</td>
<td>7</td>
<td>12</td>
</tr>
</tbody>
</table>

Gantt Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>gantt</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>Columns</td>
<td>„1,2,3,4“</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Plan</th>
<th>Start</th>
<th>End</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage 1</td>
<td>6/25/2013</td>
<td>7/10/2013</td>
<td>30%</td>
</tr>
<tr>
<td>Stage 2</td>
<td>7/13/2013</td>
<td>11/28/2013</td>
<td>40%</td>
</tr>
</tbody>
</table>
### Code examples

The following examples are provided for advanced users who want to edit the underlying markup for a Confluence page.

**Macro name:** chart

**Macro body:** Accepts rich text, consisting of tables that hold the chart’s data.

This macro recognizes a large number of parameters, listed here by type for convenience. [See all parameters...](#)

**Chart type parameters**

These parameters determine the type of chart to display and how the chart looks.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| type | No | pie | The type of chart to display. XY charts have numerical x- and y-axes. The x values may optionally be time-based. See the timeSeries parameter. Available values:  
  - *Standard charts* – pie, bar, line, area  
  - *XY plots* – xyArea, xyBar, xyLine, xyStep, xyStepArea, scatter, timeSeries  
  - *Other charts* – gantt |
| orientation | No | vertical | The display orientation. Applies to area, bar and line charts. Available values:  
  - vertical – y-axis is vertical  
  - horizontal – x-axis is vertical |
| 3D | No | false | Show in three dimensions. Applies to area, bar and line charts. |
| stacked | No | false | Stacked values. Applies to area and bar charts. |
| showShapes | No | true | Applies to line charts. Shapes are shown at each data point. |
### Chart display parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>No</td>
<td>300</td>
<td>The width of the chart in pixels.</td>
</tr>
<tr>
<td>height</td>
<td>No</td>
<td>300</td>
<td>The height of the chart in pixels.</td>
</tr>
</tbody>
</table>
| dataDisplay   | No       | false   | Determines whether to display the body of the macro, consisting of the data table. By default, the chart data table is not displayed. Available values:  
  - false – the data is not displayed.  
  - true or after – the data is displayed after the chart.  
  - before – the data is displayed before the chart. |
| imageFormat   | No       | png     | The image format to be used for the chart. Available values:  
  - png  
  - jpg |

### Chart title and label parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>The title of the chart.</td>
</tr>
<tr>
<td>subTitle</td>
<td>No</td>
<td>(None)</td>
<td>A subtitle for the chart.</td>
</tr>
<tr>
<td>xLabel</td>
<td>No</td>
<td>(None)</td>
<td>The label for the x-axis (domain).</td>
</tr>
<tr>
<td>yLabel</td>
<td>No</td>
<td>(None)</td>
<td>The label for the y-axis (range).</td>
</tr>
<tr>
<td>legend</td>
<td>No</td>
<td>false</td>
<td>Determines whether to show a legend (key) for the chart.</td>
</tr>
</tbody>
</table>

### Chart data parameters

The data for the chart is taken from tables found in the macro body. The parameters below control how this data is interpreted. By default, numeric and date values are interpreted according to the Confluence global default language (locale) formats. If conversion fails, other languages defined in Confluence will be tried. You can specify additional conversion options using the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tables</td>
<td>No</td>
<td>All first level tables</td>
<td>You can supply a comma-separated list of table IDs and/or table numbers (starting at 1) contained within the body of the macro that will be used as the data for the chart. If data tables are embedded in other tables, then table selection will be required. This occurs when more complex formatting is done (for example using section and column macros).</td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>columns</strong></td>
<td>No</td>
<td>All columns</td>
<td>You can supply a comma-separated list of column labels and/or column titles and/or column numbers for tables used for chart data. This applies to all tables processed. Columns are enumerated starting at 1. Column label is the text for the column in the header row. Column title is the HTML title attribute for the column in the header row.</td>
</tr>
</tbody>
</table>
| **dataOrientation** | No | horizontal | The content orientation. By default, the data tables will be interpreted as columns (horizontally) representing domain and x values. Available values:  
  - *vertical* — data table columns will be interpreted as series.  
  - *horizontal* — data tables rows will be interpreted as series. |
| **timeSeries** | No | false | If 'true', the x values in an XY plot will be treated as time series data and so will be converted according date formats. |
| **dateFormat** | No | Confluence language defined date formats | For time series data, the date format allows for additional customisation of the conversion of data to date values. If a dateFormat is specified, it will be the first format used to interpret date values. Specify a format that matches the time series data. See simple date format. |
| **timePeriod** | No | day | The time period for time series data. Defines the granularity of how the data is interpreted. Available values: millisecond, second, minute, hour, day, week, month, quarter, year |
| **language** | No | (None) | Use in combination with the country parameter to form a locale. These additional number and date formats will be used for data conversion before the default languages. Available values are the two-character ISO 639-1 alpha-2 codes. |
| **country** | No | (None) | Use in combination with the language parameter to form a locale. Valid values are the two-character ISO 3166 codes. |
| **forgive** | No | true | Determines whether the macro will forgive (allow) some data formatting errors. Available values:  
  - *true* — the macro tries to convert numeric and date values that do not totally match any of the default or user-specified formats.  
  - *false* — the macro enforces strict data formatting. If there are data format errors, the chart will not be produced. |

**Chart colour parameters**

Colours are specified using hexadecimal notation or HTML colour names.
### Parameter | Required | Default | Description  
--- | --- | --- | ---  
bgColor | No | White | Background colour of the chart.  
borderColor | No | No border | Colour of the border around the chart.  
colors | No | A comma-separated list of colours used to customise the colours of categories, sections, and series.  

### Chart axis parameters

Depending on the chart type, the range and domain axis may be customised. These values are automatically generated based on the data but can be overridden by specifying one or more more of these parameters.

| Parameter | Required | Default | Description  
--- | --- | --- | ---  
rangeAxisLowerBound | No | (None) | Minimum value for the range axis.  
rangeAxisUpperBound | No | (None) | Maximum value for the range axis.  
rangeAxisTickUnit | No | (None) | Range axis units between axis tick marks.  
rangeAxisLabelAngle | No | (None) | Angle for the range axis label in degrees.  
domainAxisLowerBound | No | (None) | Only applies to XY plots. Domain axis lower bound. For a date axis, this value must be expressed in the date format specified by the `dateFormat` parameter.  
domainAxisUpperBound | No | (None) | Only applies to XY plots. Domain axis upper bound. For a date axis, this value must be expressed in the date format specified by the `dateFormat` parameter.  
domainAxisTickUnit | No | (None) | Only applies to XY plots. Domain axis units between axis tick marks. For a date axis, this value represents a count of the units specified in the `timePeriod` parameter. The `timePeriod` unit can be overridden by specifying a trailing character: y (years), M (months), d (days), h (hours), m (minutes), s (seconds), u (milliseconds).  
domainAxisLabelAngle | No | (None) | Only applies to XY plots. The angle for the domain axis label, in degrees.  
categoryLabelPosition | No | (None) | Placement of the axis label text for categories. Available values:  
  - `up45` — 45 degrees going upward  
  - `up90` — 90 degrees going upward  
  - `down45` — 45 degrees going downward  
  - `down90` — 90 degrees going downward  
dateTickMarkPosition | No | `start` | Placement of the date tick mark. Available values:  
  - `start` — tick mark is at the start of the date period.  
  - `middle` — tick mark is in the middle of the date period.  
  - `end` — tick mark is at the end of the date period.  

### Pie chart Parameters
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| pieSectionLabel      | No       | Show only the pie section key value | Format of pie section labels. The format uses a string with special replacement variables:  
- `%0%` is replaced by the pie section key.  
- `%1%` is replaced by the pie section numeric value.  
- `%2%` is replaced by the pie section percent value.  
Example 1: To display something like 'Independent = 20':  
```
%0% = %1%
```
Example 2: To display something like 'Independent (20%)':  
```
%0% (%2%)
```
| pieSectionExplode    | No       | No exploded sections | A comma-separated list of pie keys that are to be shown exploded. Note: requires jFreeChart version 1.0.3 or higher. |

**Chart attachment parameters**

These are advanced options that can be used for chart versioning, to enable automation and to improve performance. Use these options carefully! Normally, the chart image is regenerated each time the page is displayed. These options allow for the generated image to be saved as an attachment and have subsequent access to re-use the attachment. This can be useful especially when combined with the Cache plugin to improve performance. Depending on the options chosen, chart images can be versioned for historical purposes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| attachment | No       | (None)  | The name and location where the chart image will be saved as an attachment. The user must be authorised to add attachments to the page specified.  
Available syntax for this parameter:  
- `^attachmentName.png` — the chart is saved as an attachment to the current page.  
- `page name^attachmentName.png` — the chart is saved as an attachment to the page name provided.  
- `spacekey:page name^attachmentName.png` — the chart is saved as an attachment to the page name provided in the space indicated. |
| attachmentVersion | Yes | new | Defines the the versioning mechanism for saved charts. Available values:  
|                  |     |     |   - new — creates new version of the attachment.  
|                  |     |     |   - replace — replaces all previous versions of the chart.  
|                  |     |     |   To replace an existing attachment, the user must be authorised to remove attachments for the page specified.  
|                  |     |     |   - keep — only saves a new attachment if an existing export of the same name does not exist. An existing attachment will not be changed or updated.  
| attachmentComment| No  | (None) | Comment used for a saved chart attachment.  
| thumbnail        | No  | false | If true, the chart image attachment will be shown as a thumbnail (small, expandable) image.  

Storage format example

Below is a simple example of a pie chart. See more examples in Storage Format Examples for Chart Macro.
Wiki markup example

Below is a simple example of a pie chart. See more examples in Wiki Markup Examples for Chart Macro.
**Confluence Storage Format Examples for Chart Macro**

This page is an extension of the documentation for the Chart Macro. This page contains additional examples for the Chart macro.

**Pie chart**

Here is a simple example of a pie chart.

Storage format

{chart:type=pie|title=Fish Sold}

<table>
<thead>
<tr>
<th>Fish Type</th>
<th>2004</th>
<th>2005</th>
</tr>
</thead>
<tbody>
<tr>
<td>Herring</td>
<td>9,500</td>
<td>8,300</td>
</tr>
<tr>
<td>Salmon</td>
<td>2,900</td>
<td>4,200</td>
</tr>
<tr>
<td>Tuna</td>
<td>1,500</td>
<td>1,500</td>
</tr>
</tbody>
</table>

(chart)
<ac:structured-macro ac:name="chart">
  <ac:parameter ac:name="title">Fish Sold</ac:parameter>
  <ac:parameter ac:name="type">pie</ac:parameter>
  <ac:rich-text-body>
    <table>
      <thead>
        <tr>
          <th>Fish Type</th>
          <th>2004</th>
          <th>2005</th>
        </tr>
      </thead>
      <tbody>
        <tr>
          <td>Herring</td>
          <td>9,500</td>
          <td>8,300</td>
        </tr>
        <tr>
          <td>Salmon</td>
          <td>2,900</td>
          <td>4,200</td>
        </tr>
        <tr>
          <td>Tuna</td>
          <td>1,500</td>
          <td>1,500</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:structured-macro>
Fish Sold

Resulting chart

- 2004 (1,500 - 50%)
- 2005 (1,500 - 50%)

Bar chart

Here is a simple example of a bar chart.

Storage format
<ac:macro ac:name="chart">
<ac:parameter ac:name="title">Fish Sold</ac:parameter>
<ac:parameter ac:name="type">bar</ac:parameter>
<ac:rich-text-body>
<table>
<thead>
<tr>
<th>Fish Type</th>
<th>2004</th>
<th>2005</th>
</tr>
</thead>
<tbody>
<tr>
<th>Herring</th>
<td>9,500</td>
<td>8,300</td>
</tr>
<tr>
<th>Salmon</th>
<td>2,900</td>
<td>4,200</td>
</tr>
<tr>
<th>Tuna</th>
<td>1,500</td>
<td>1,500</td>
</tr>
</tbody>
</table>
</ac:rich-text-body>
</ac:macro>
Resulting chart

Time series chart

Here is an example of a time series chart.

Storage format

```xml
<ac:structured-macro ac:name="chart">
    <ac:parameter ac:name="timePeriod">Month</ac:parameter>
    <ac:parameter ac:name="dataOrientation">vertical</ac:parameter>
    <ac:parameter ac:name="rangeAxisLowerBound">0</ac:parameter>
    <ac:parameter ac:name="dateFormat">MM/yyyy</ac:parameter>
    <ac:parameter ac:name="type">timeSeries</ac:parameter>
    <ac:parameter ac:name="domainaxisrotateticklabel">true</ac:parameter>
    <ac:rich-text-body>
        <table>
            <tbody>
                <tr>
                    <th>Month</th>
                    <th>Revenue</th>
                </tr>
                <tr>
                    <td>1/2005</td>
                    <td>31.8</td>
                </tr>
                <tr>
                    <td>2/2005</td>
                    <td>41.8</td>
                </tr>
                <tr>
                    ...<td>3/2005</td>
                    ...<td>...</td>
                </tr>
            </tbody>
        </table>
    </ac:rich-text-body>
</ac:structured-macro>
```
<table>
<thead>
<tr>
<th>Date</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>4/2005</td>
<td>33.8</td>
</tr>
<tr>
<td>5/2005</td>
<td>27.6</td>
</tr>
<tr>
<td>6/2005</td>
<td>49.8</td>
</tr>
<tr>
<td>7/2005</td>
<td>51.8</td>
</tr>
<tr>
<td>8/2005</td>
<td>77.3</td>
</tr>
<tr>
<td>9/2005</td>
<td>73.8</td>
</tr>
<tr>
<td>10/2005</td>
<td>97.6</td>
</tr>
<tr>
<td>11/2005</td>
<td>51.3</td>
</tr>
<tr>
<td>Month</td>
<td>Expenses</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
</tr>
<tr>
<td>1/2005</td>
<td>41.1</td>
</tr>
<tr>
<td>2/2005</td>
<td>43.8</td>
</tr>
<tr>
<td>3/2005</td>
<td>45.3</td>
</tr>
<tr>
<td>4/2005</td>
<td>45.0</td>
</tr>
<tr>
<td>5/2005</td>
<td>44.6</td>
</tr>
<tr>
<td>Month</td>
<td>Percentage</td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>6/2005</td>
<td>43.8</td>
</tr>
<tr>
<td>7/2005</td>
<td>51.8</td>
</tr>
<tr>
<td>8/2005</td>
<td>52.3</td>
</tr>
<tr>
<td>9/2005</td>
<td>53.8</td>
</tr>
<tr>
<td>10/2005</td>
<td>55.6</td>
</tr>
<tr>
<td>11/2005</td>
<td>61.2</td>
</tr>
<tr>
<td>12/2005</td>
<td>63.7</td>
</tr>
</tbody>
</table>
Resulting chart

**XY line chart**

Here is an example of an XY line chart.

Storage format
<table>
  <tr>
    <th></th>
    <th>12</th>
    <th>14</th>
    <th>23</th>
  </tr>
  <tr>
    <td>Revenue</td>
    <td>41.1</td>
    <td>31.8</td>
    <td>12.4</td>
  </tr>
  <tr>
    <td>Expense</td>
    <td>31.1</td>
    <td>41.8</td>
    <td>43.6</td>
  </tr>
</table>
Resulting chart

**XY bar chart**

Here is an example of an XY bar chart.

*Storage format*
<table>
  <tbody>
    <tr>
      <th></th>
      <th>2005</th>
      <th>2006</th>
      <th>2007</th>
    </tr>
    <tr>
      <td>Revenue</td>
      <td>41.1</td>
      <td>31.8</td>
      <td>12.4</td>
    </tr>
    <tr>
      <td>Expense</td>
      <td>31.1</td>
      <td>41.8</td>
      <td>43.6</td>
    </tr>
  </tbody>
</table>
Resulting chart

**XY area chart**

Here is an example of an XY area chart.
Storage format
<table>
  <tr>
    <th></th>
    <th>12</th>
    <th>14</th>
    <th>23</th>
  </tr>
  <tr>
    <td>Revenue</td>
    <td>41.1</td>
    <td>31.8</td>
    <td>12.4</td>
  </tr>
  <tr>
    <td>Expense</td>
    <td>31.1</td>
    <td>41.8</td>
    <td>43.6</td>
  </tr>
</table>
Here are two examples of area charts.

Storage format for area chart 1

```xml
<ac:structured-macro ac:name="chart">
  <ac:parameter ac:name="height">300</ac:parameter>
  <ac:parameter ac:name="legend">true</ac:parameter>
  <ac:parameter ac:name="width">300</ac:parameter>
  <ac:parameter ac:name="opacity">50</ac:parameter>
  <ac:parameter ac:name="type">area</ac:parameter>
  <ac:parameter ac:name="dataDisplay">true</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th>Satisfaction</th>
          <th>2002</th>
          <th>2003</th>
          <th>2004</th>
        </tr>
        <tr>
          <td>Very satisfied</td>
          <td>20</td>
          <td>23</td>
          <td>34</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:structured-macro>
```
<table>
<thead>
<tr>
<th>Satisfied</th>
<th>40</th>
<th>34</th>
<th>23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disatisfied</td>
<td>25</td>
<td>26</td>
<td>25</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>15</td>
<td>17</td>
<td>18</td>
</tr>
</tbody>
</table>
Resulting area chart 1

<table>
<thead>
<tr>
<th>Satisfaction</th>
<th>2002</th>
<th>2003</th>
<th>2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>20</td>
<td>23</td>
<td>34</td>
</tr>
<tr>
<td>Satisfied</td>
<td>40</td>
<td>34</td>
<td>23</td>
</tr>
<tr>
<td>Dissatisfied</td>
<td>25</td>
<td>26</td>
<td>25</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>15</td>
<td>17</td>
<td>18</td>
</tr>
</tbody>
</table>

Storage format for area chart 2

```xml
<ac:structured-macro ac:name="chart">
  <ac:parameter ac:name="stacked">true</ac:parameter>
  <ac:parameter ac:name="height">300</ac:parameter>
  <ac:parameter ac:name="legend">true</ac:parameter>
  <ac:parameter ac:name="width">300</ac:parameter>
  <ac:parameter ac:name="type">area</ac:parameter>
  <ac:parameter ac:name="dataDisplay">true</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th>Satisfaction</th>
          <th>2002</th>
          <th>2003</th>
          <th>2004</th>
        </tr>
        <tr>
          <td>Very satisfied</td>
          <td>20</td>
          <td>23</td>
          <td>34</td>
        </tr>
        <tr>
          <td>Satisfied</td>
          <td>40</td>
          <td>34</td>
          <td>23</td>
        </tr>
        <tr>
          <td>Dissatisfied</td>
          <td>25</td>
          <td>26</td>
          <td>25</td>
        </tr>
        <tr>
          <td>Very dissatisfied</td>
          <td>15</td>
          <td>17</td>
          <td>18</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:structured-macro>
```
<table>
<thead>
<tr>
<th>Category</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>12</td>
<td>23</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>Satisfied</td>
<td>1</td>
<td>34</td>
<td>36</td>
<td></td>
</tr>
<tr>
<td>Disatisfied</td>
<td>4</td>
<td>6</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>Very disatisfied</td>
<td>2</td>
<td>7</td>
<td>12</td>
<td></td>
</tr>
</tbody>
</table>
Wiki Markup Examples for Chart Macro

This page is an extension of the documentation for the Chart Macro. This page contains additional examples for the Chart macro.

Pie chart

Here is a simple example of a pie chart.

Wiki markup

\{
\text{chart}:type=pie|title=Fish Sold
\\| Fish Type | 2004 | 2005
\\| Herring | 9,500 | 8,300
\\| Salmon | 2,900 | 4,200
\\| Tuna | 1,500 | 1,500
\}\
### Bar chart

Here is a simple example of a bar chart.

Wiki markup

```wiki
{chart:type=bar|title=Fish Sold}
|| Fish Type || 2004 || 2005 ||
|| Herring | 9,500 | 8,300 |
|| Salmon | 2,900 | 4,200 |
|| Tuna | 1,500 | 1,500 |
{chart}
```

### Time series chart

Here is an example of a time series chart.

Wiki markup

```wiki
{chart:
```
Here is an example of an XY line chart.
Wiki markup
**Resulting chart**

*XY bar chart*

Here is an example of an XY bar chart.

Wiki markup

```wikimarkup
{chart:type=xybar|opacity=60}
<table>
<thead>
<tr>
<th></th>
<th>2005</th>
<th>2006</th>
<th>2007</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>41.1</td>
<td>31.8</td>
<td>12.4</td>
</tr>
<tr>
<td>Expense</td>
<td>31.1</td>
<td>41.8</td>
<td>43.6</td>
</tr>
</tbody>
</table>
{chart}
```

**Resulting chart**

*XY area chart*
Here is an example of an XY area chart.

**Wiki markup**

```wiki
{chart:type=xyarea}
<table>
<thead>
<tr>
<th></th>
<th>12</th>
<th>14</th>
<th>23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>41.1</td>
<td>31.8</td>
<td>12.4</td>
</tr>
<tr>
<td>Expense</td>
<td>31.1</td>
<td>41.8</td>
<td>43.6</td>
</tr>
</tbody>
</table>
{chart}
```

**Resulting chart**

**Area chart**

Here are two examples of area charts.

**Wiki markup for area chart 1**

```wiki
{chart:type=area|dataDisplay=true|legend=true|width=300|height=300|opacity=50}
<table>
<thead>
<tr>
<th></th>
<th>2002</th>
<th>2003</th>
<th>2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>20</td>
<td>23</td>
<td>34</td>
</tr>
<tr>
<td>Satisfied</td>
<td>40</td>
<td>34</td>
<td>23</td>
</tr>
<tr>
<td>Dissatisfied</td>
<td>25</td>
<td>26</td>
<td>25</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>15</td>
<td>17</td>
<td>18</td>
</tr>
</tbody>
</table>
{chart}
```
### Resulting area chart 1

<table>
<thead>
<tr>
<th>Satisfaction</th>
<th>2002</th>
<th>2003</th>
<th>2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>20</td>
<td>23</td>
<td>34</td>
</tr>
<tr>
<td>Satisfied</td>
<td>40</td>
<td>34</td>
<td>23</td>
</tr>
<tr>
<td>Disatisfied</td>
<td>25</td>
<td>26</td>
<td>25</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>15</td>
<td>17</td>
<td>18</td>
</tr>
</tbody>
</table>

### Wiki markup for area chart 2

```wiki
{chart: type=area|dataDisplay=true|legend=true|width=300|height=300|stacked=true}
<table>
<thead>
<tr>
<th>Satisfaction</th>
<th>2002</th>
<th>2003</th>
<th>2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>12</td>
<td>23</td>
<td>31</td>
</tr>
<tr>
<td>Satisfied</td>
<td>1</td>
<td>34</td>
<td>36</td>
</tr>
<tr>
<td>Disatisfied</td>
<td>4</td>
<td>6</td>
<td>22</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>2</td>
<td>7</td>
<td>12</td>
</tr>
</tbody>
</table>
{chart}
```
Cheese Macro

The Cheese macro simply displays the words "I like cheese!" You can use this macro to test the Confluence macro functionality.

To add the Cheese macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Note: There are no parameters for this macro.

Code examples

The following examples are provided for advanced users who want to edit the underlying markup for a Confluence page.

Macro name: cheese

Macro body: None.

Parameters: None

Storage format example

```xml
<ac:structured-macro ac:name="cheese"/>
```

Wiki markup example

```
{cheese}
```

Children Display Macro

Use the Children Display macro to list the child pages of a page and the further descendants (children's children). By default, the macro displays links to the child pages as shown in the screenshot below. People viewing the page will see only the links for pages that they have permission to view.

Screenshot: The Children Display macro in Confluence

This is the Children Display macro

- Step 1 - download the game
- Step 2 - Play
- Step 3 - share your favourite nerd
- Sample page
- Games as a communication medium

Using the Children Display macro
To add the Children Display macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Example

This list of child pages is generated by a Children Display macro on this page:

- Child Page 1
- Child Page 2

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Descendants (all)</td>
<td>false</td>
<td>Choose whether to display all the parent page's descendants. If true shows the complete tree of pages underneath the parent page, regardless of Depth of Descendants</td>
</tr>
<tr>
<td>Parent Page (page)</td>
<td>current</td>
<td>Specify the page to display children for, from either the current space or a different space. Enter:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- '/' — to list the top-level pages of the current space, i.e. those without parents.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 'pagename' — to list the children of the specified page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 'spacekey:' — to list the top-level pages of the specified space.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 'spacekey:pagename' — to list the children of the specified page in the specified space.</td>
</tr>
<tr>
<td>Number of Children (first)</td>
<td>none</td>
<td>Restrict the number of child pages that are displayed at the top level.</td>
</tr>
<tr>
<td>Depth of Descendants (depth)</td>
<td>none</td>
<td>Enter a number to specify the depth of descendants to display. For example, if the value is 2, the macro will display 2 levels of child pages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This setting has no effect of Show Descendants is enabled.</td>
</tr>
<tr>
<td>Heading Style (style)</td>
<td>none</td>
<td>Choose the style used to display descendants.</td>
</tr>
<tr>
<td>Include Excerpts (excerpt)</td>
<td>false</td>
<td>Display excerpts for the child pages, if they exist.</td>
</tr>
<tr>
<td>Sort Children By (sort)</td>
<td>Manual if manually ordered, otherwise alphabetical</td>
<td>Optional. Choose:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- creation — to sort by content creation date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- title — to sort alphabetically on title</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- modified — to sort of last modification date.</td>
</tr>
</tbody>
</table>
### Reverse Sort (reverse)

| true  | Use with the **Sort Children By** parameter. When set, the sort order changes from ascending to descending. |

#### Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** children

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="children">
  <ac:parameter ac:name="reverse">true</ac:parameter>
  <ac:parameter ac:name="sort">creation</ac:parameter>
  <ac:parameter ac:name="style">h4</ac:parameter>
  <ac:parameter ac:name="page">
    <ac:link>
      <ri:page ri:content-title="Home"/>
    </ac:link>
  </ac:parameter>
  <ac:parameter ac:name="excerpt">true</ac:parameter>
  <ac:parameter ac:name="first">99</ac:parameter>
  <ac:parameter ac:name="depth">2</ac:parameter>
  <ac:parameter ac:name="all">true</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
{children:reverse=true|sort=creation|style=h4|page=Home|excerpt=true|first=99|depth=2|all=true}
```

**Child Page 1**

- Grandchild

**Child Page 2**

This page is used to test the `{children}` macro.

**Related Topics**

- **Children Display Macro**
- **Code Block Macro**

The Code Block macro allows you to display source code in your document with the appropriate syntax highlighting. The code block displays on the page as shown below:

```
public static void main(String[] args) {
    System.out.println("Hello World!");
}
```

**Using the Code Block Macro**

**To add the Code Block macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.
**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

You type the code block directly into the macro placeholder in the editor. Note that any white space contained in the placeholder is not manipulated in any way by the Code Block macro. This is to provide the writer with flexibility over code indentation.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Syntax highlighting</strong></td>
<td>java</td>
<td>Specifies the language (or environment) for syntax highlighting. The default language is Java but you can choose from one of the following languages/environments:</td>
</tr>
</tbody>
</table>
| (language)                    |         | • actionscript3  
|                               |         | • bash  
|                               |         | • csharp (C#)  
|                               |         | • coldfusion  
|                               |         | • cpp (C++)  
|                               |         | • css  
|                               |         | • delphi  
|                               |         | • diff  
|                               |         | • erlang  
|                               |         | • groovy  
|                               |         | • html/xml  
|                               |         | • java  
|                               |         | • javafx  
|                               |         | • javascript  
|                               |         | • none (no syntax highlighting)  
|                               |         | • perl  
|                               |         | • php  
|                               |         | • powershell  
|                               |         | • python  
|                               |         | • ruby  
|                               |         | • scala  
|                               |         | • sql  
|                               |         | • vb  
| **Title**                     | none    | Adds a title to the code block. If specified, the title will be displayed in a header row at the top of the code block.  
|                               |         | **Collapsible** (collapse)  
|                               | false   | If selected, the code macro’s content will be collapsed upon visiting or refreshing the Confluence page. Clicking the expand source link allows you to view this content. If false, the code macro's content is always displayed in full.  
| **Show line numbers**         | false   | If selected, line numbers will be shown to the left of the lines of code.  
| (linenumbers)                 |         | **First line number** (firstline)  
|                               | 1       | When Show line numbers is selected, this value defines the number of the first line of code.  

*Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Theme Default

Specifies the colour scheme used for displaying your code block. Many of these themes are based on the default colour schemes of popular integrated development environments (IDEs). The default theme is Confluence (also known as Default), which is typically black and coloured text on a blank background. However, you can also choose from one of the following other popular themes:

- DJango
- Emacs
- FadeToGrey
- Midnight
- RDark
- Eclipse
- Confluence

Configuring the Code Block macro

You can configure the Code Block macro to use a specific language and theme by default and also upload new languages. You need Confluence Administrator permissions to change the default theme and language and System Administrator permissions to upload new languages.

To set the default appearance of code blocks in your site:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Configure Code Macro.
3. Select a Default Theme and Default Language.
4. Choose Save.

All new code blocks will use the default theme and language unless you specify otherwise. Existing code blocks will be unchanged.

To add an additional language:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Configure Code Macro.
3. Choose Add a new language.
4. Locate your language file and enter a Name for the new language (this will appear when selecting the language).
5. Choose Add.

Language files must be correctly formatted JavaScript files and adhere to the Custom Brush syntax. You can find some examples of language files here.

To disable or remove a user-installed language:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Manage Add-ons.
3. Go to User-installed Add-ons and locate the add-on for your uploaded language - it will appear like this ‘Custom Code Macro Highlighting for...’
4. Choose Uninstall or Disable.

The language will no longer appear in the Code Macro.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** code

**Macro body:** Accepts plain text.

**Storage format example**

The following example shows all parameters and a body:
Below are three examples of the Code Block macro with various optional parameters used.

<table>
<thead>
<tr>
<th>Description</th>
<th>Markup</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code block macro with a body and no optional parameters</td>
<td><code>&lt;ac:structured-macro ac:name=&quot;code&quot;&gt;</code></td>
<td>this is my code</td>
</tr>
<tr>
<td></td>
<td><code>   &lt;ac:plain-text-body&gt;&lt;![CDATA[&lt;b&gt;This is my code&lt;/b&gt;]]&gt;&lt;/ac:plain-text-body&gt;</code></td>
<td></td>
</tr>
<tr>
<td>Code block macro with a body and the optional language parameter defined</td>
<td><code>&lt;ac:structured-macro ac:name=&quot;code&quot;&gt;</code></td>
<td>this is my code</td>
</tr>
<tr>
<td></td>
<td><code>   &lt;ac:plain-text-body&gt;&lt;![CDATA[&lt;b&gt;This is my code&lt;/b&gt;]]&gt;&lt;/ac:plain-text-body&gt;</code></td>
<td></td>
</tr>
<tr>
<td>Code block macro with a body and optional title, line numbers and language parameters defined</td>
<td><code>&lt;ac:structured-macro ac:name=&quot;code&quot;&gt;</code></td>
<td>this is my code</td>
</tr>
<tr>
<td></td>
<td><code>   &lt;ac:parameter ac:name=&quot;title&quot;&gt;This is my title&lt;/ac:parameter&gt;</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>   &lt;ac:parameter ac:name=&quot;linenumber&quot;&gt;true&lt;/ac:parameter&gt;</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>   &lt;ac:plain-text-body&gt;&lt;![CDATA[&lt;b&gt;This is my code&lt;/b&gt;]]&gt;&lt;/ac:plain-text-body&gt;</code></td>
<td></td>
</tr>
</tbody>
</table>

Wiki markup example

```
{code:title=This is my title|theme=FadeToGrey|linenumbers=true|language=html/xml|firstline=0001|collapse=true}
This is my code
{code}
```

Column Macro

Used with the Section macro to define columns on a page. See Working with page layouts and columns and
sections.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** column

**Macro body:** Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>No</td>
<td>100% of the page width, divided equally by the number of columns in the section.</td>
<td>The width of the column. Can be specified either in pixels (for example, 400px) or as a percentage of the available page width (for example, 50%).</td>
</tr>
</tbody>
</table>

**Storage format example**

```xml
<ac:structured-macro ac:name="column">
    <ac:parameter ac:name="width">100px</ac:parameter>
    <ac:rich-text-body>
        <p>This is the content of <strong>column 1</strong>.</p>
    </ac:rich-text-body>
</ac:structured-macro>
```

**Wiki markup example**

```
{column:width=100px}
This is the content of *column 1*.
{column}
```

**Content by Label Macro**

The Content by Label macro displays links to pages, blog posts and attachments that have been tagged with specific labels.

**A working example**

Below is a working example of the Content by Label macro, displaying content with the label 'LDAP'.

- [Getting 'Exception when Adding LDAP group' For User Authentication Only](Confluence Knowledge Base)
  ldap
- [LDAP Users Unable to Access Their User Profile Functionality](Confluence Knowledge Base)
  ldap
- [Debugging LDAP Connection Properties](Confluence Knowledge Base)
  ldap
- [Error Performing LDAP Search Filter Due to Incomplete Base DN](Confluence Knowledge Base)
  ldap
- [LDAP Queries Fail with 'Address already in use' Error](Confluence Knowledge Base)
  ldap

46 related results

**Using the Content by Label Macro**
To add the Content by Label macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Spreading up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label(s)</strong> (labels)</td>
<td>None</td>
<td>Filter by label(s). The macro will display only the content tagged with the label(s) specified here. See also the Operator parameter below.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This parameter is required. Specify one or more labels, separated by a comma or a single space.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of <code>-badpage</code> you will get only content which is not labelled with 'badpage'.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To indicate that the results must match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of <code>+superpage,+goodpage</code> you will get only content which has at least two labels, being 'superpage' and 'goodpage'.</td>
</tr>
<tr>
<td>Author(s) (author)</td>
<td>None</td>
<td>Filter by author. The macro will display only the content created or updated by the author(s) specified here.</td>
</tr>
<tr>
<td>Include this Content Type Only (type)</td>
<td>all</td>
<td>Filter by content type. The macro will display only the content of the type specified here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify one or more content types, separated by a comma or a space.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To exclude content of a given content type, put a minus sign (-) immediately in front of that content type. For example: If you specify a content type of <code>-blogpost</code> you will get pages and all other content except for blog posts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• page – Pages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• blogpost or news – Blog posts, also known as news items.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• attachment – Attachments</td>
</tr>
<tr>
<td>Show Labels for Each Page (showLabels)</td>
<td>true</td>
<td>Show or hide labels in the results.</td>
</tr>
<tr>
<td>Show Space Name for Each Page (showSpace)</td>
<td>true</td>
<td>Show or hide spaces in the results.</td>
</tr>
<tr>
<td><strong>List Title</strong>&lt;br&gt;(title)</td>
<td>None</td>
<td>Add a title or heading to the list.</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td><strong>Maximum Number of Pages</strong>&lt;br&gt;(max)</td>
<td>15</td>
<td>Limit the maximum number of results to be displayed. Note that the results are sorted first, and then the maximum parameter is applied.</td>
</tr>
<tr>
<td><strong>Display Excerpts</strong>&lt;br&gt;(excerpt)</td>
<td>false</td>
<td>Include excerpts from each page listed. Note that you must have defined excerpts on each of those pages, by adding the excerpt macro to the page. Only the first few lines of the excerpt for each page are displayed.</td>
</tr>
<tr>
<td><strong>Restrict to these Spaces</strong>&lt;br&gt;(spaces)</td>
<td>@all</td>
<td>Filter by space. The macro will display only the content which belongs to the space(s) specified here. Specify one or more space keys, separated by a comma or a space.</td>
</tr>
<tr>
<td>• To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of -BADSPACE, you will get only content which is not in the BADSPACE.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE, you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Operator</strong>&lt;br&gt;(operator)</td>
<td>OR</td>
<td>The operator to apply when matching content against the labels specified in the Label(s) parameter:</td>
</tr>
<tr>
<td>• OR – Display content with any of the non-prefixed labels.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• AND – Display content with all of the specified non-prefixed labels.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Sort By</strong>&lt;br&gt;(sort)</td>
<td>modified</td>
<td>Specify how the results should be sorted. Values:</td>
</tr>
<tr>
<td>• title — Sort alphabetically by title.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• creation — Sort by the date on which the content was added.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• modified — Sort by the date on which the content was last updated. Note: If this parameter is not specified, the sort order defaults to descending, based on the last modification date (latest first). To change the sort order from ascending to descending, use the Reverse Sort parameter.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Reverse Sort (reverse) | false | Select **Reverse Sort** to change the sort from descending to ascending. Use this parameter in conjunction with the **Sort By** parameter. **Reverse Sort** is ignored if **Sort By** is not specified.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** contentbylabel

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="contentbylabel">
  <ac:parameter ac:name="spaces"/>
  <ac:parameter ac:name="author">admin,smaddox</ac:parameter>
  <ac:parameter ac:name="title">My labelled pages</ac:parameter>
  <ac:parameter ac:name="showLabels">false</ac:parameter>
  <ac:parameter ac:name="reverse">true</ac:parameter>
  <ac:parameter ac:name="sort">creation</ac:parameter>
  <ac:parameter ac:name="max">10</ac:parameter>
  <ac:parameter ac:name="excerpt">true</ac:parameter>
  <ac:parameter ac:name="labels">chocolate,cake</ac:parameter>
  <ac:parameter ac:name="showSpace">false</ac:parameter>
  <ac:parameter ac:name="type">page</ac:parameter>
  <ac:parameter ac:name="operator">AND</ac:parameter>
</ac:structured-macro>
```

**Wikimarkup example**

```
{contentbylabel:spaces=@personal,@self|author=admin,smaddox|title=My labelled pages|showLabels=false|reverse=true|sort=creation|max=10|excerpt=true|labels=chocolate,cake|showSpace=false|type=page|operator=AND}
```

**Content by User Macro**

The Content by User macro generates a tabulated list of the content items, throughout the Confluence installation, that have been created by a specified Confluence user. The list includes all current pages, comments and spaces created by the user. Each item in the table is linked to its corresponding page, page comment or space dashboard.

Note that items for page comments contain a link to the page, followed by a second link to the comment itself, with these separated by a greater-than sign (>).

**Using the Content by User macro**

**To add the Content by User macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**
Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>yes</td>
<td>none</td>
<td>The Confluence username for a person who has created content. Parameter is unnamed in wikimarkup.</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** content-by-user

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="content-by-user">
  <ac:parameter ac:name="">
    <ri:user ri:userkey="12345678912345678912345678912345"/>
  </ac:parameter>
</ac:structured-macro>
```

**Wikimarkup example**

```
{content-by-user:jsmith}
```

Content Report Table Macro

The Content Report Table macro displays a set of pages and blog posts in tabular format, based on the labels specified in the macro parameters.

**A working example**

Below is a working example of the Content Report Table macro, displaying content with the label 'LDAP'.

```
Error rendering macro 'content-report-table' : In template Confluence.Templates.User.userLinkUrl: When evaluating "contextPath()": Error while computing function "contextPath()": null
```

**Using the Content Report Table Macro**

**To add the Content Report Table macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label(s) (labels)</td>
<td>No</td>
<td>None</td>
</tr>
<tr>
<td>Space(s) (spaces)</td>
<td>Yes</td>
<td>(All spaces)</td>
</tr>
<tr>
<td>Maximum Number of Pages (maxResults)</td>
<td>No</td>
<td>20</td>
</tr>
</tbody>
</table>

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** content-report-table

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="content-report-table">
   <ac:parameter ac:name="spaces">
      <ri:space ri:space-key="DOC"/>
   </ac:parameter>
   <ac:parameter ac:name="labels">LDAP</ac:parameter>
   <ac:parameter ac:name="analytics-key">meeting-notes</ac:parameter>
   <ac:parameter ac:name="maxResults">5</ac:parameter>
</ac:structured-macro>
```

**Wiki markup**

Wiki markup is not available for this macro. You cannot add this macro via wiki markup.

**Contributors Macro**

The Contributors macro displays a list of Confluence users who have made a contribution of some type to a page. It can also be used to list watchers of the page.

The scope of this macro can be extended to include the immediate children or descendants of the specified page. The list of contributors can be based on people who have:

- authored or edited the page(s)
- contributed comments or added labels to the page(s), or
- are simply watching the page(s).
**Screenshot: Example list of Contributors**

This is the Contributors macro
- Rach Admin
- Josh User
- Sophie Staunton

In this example, the **Display Format** parameter has been set to **list**.

**Using the Contributors Macro**

**To add the Contributors macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete**: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro**: Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contribution Type</strong></td>
<td>authors</td>
<td>Filters by either the type of contribution made to a page (and optionally its descendant pages), or the watches on the page. Contribution types are:</td>
</tr>
<tr>
<td><strong>(include)</strong></td>
<td></td>
<td>- authors - includes people who created or have edited the page(s)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- comments - includes people who have added comments to the page(s)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- labels - includes people who have added labels to the page(s)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- watches - includes people who are watching the page(s).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can specify one or more contribution types, separated by commas.</td>
</tr>
<tr>
<td><strong>Sort By</strong></td>
<td>count</td>
<td>Specifies the criteria used to sort contributors. Sort criteria are:</td>
</tr>
<tr>
<td><strong>(order)</strong></td>
<td></td>
<td>- <strong>count</strong> - sorts people based on the total number of contributions to the page(s)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>name</strong> - sorts people into alphabetical order</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>update</strong> - sorts people based on the date of their last contribution to the page(s).</td>
</tr>
<tr>
<td><strong>Reverse Sort</strong></td>
<td>false</td>
<td>Reverses the sort order of contributors in the list. Must be used in conjunction with the <strong>Sort By</strong> parameter.</td>
</tr>
<tr>
<td><strong>(reverse)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Maximum Number of</strong></td>
<td>no limit</td>
<td>Limits the number of contributors in the list. If a number is not specified, all contributors are included.</td>
</tr>
<tr>
<td><strong>Contributors</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>(limit)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display Format (mode)</td>
<td>inline</td>
<td>Sets how the list of contributor’s names is formatted:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- inline — a comma-separated list</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- list — a bullet list</td>
</tr>
<tr>
<td>Show Anonymous Contributions?</td>
<td>false</td>
<td>Sets whether to include those who contributed anonymously to a page.</td>
</tr>
<tr>
<td>(showAnonymous)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Count? (showCount)</td>
<td>false</td>
<td>Sets whether to show the number of times each person made a contribution</td>
</tr>
<tr>
<td></td>
<td></td>
<td>of the specified Contribution Type.</td>
</tr>
<tr>
<td>Show Last Contribution Time?</td>
<td>false</td>
<td>Sets whether to show the last time each person made a contribution of the</td>
</tr>
<tr>
<td>(showLastTime)</td>
<td></td>
<td>specified Contribution Type.</td>
</tr>
<tr>
<td>Page Name (page)</td>
<td>current</td>
<td>Specifies the page to use when generating the list of contributors. If</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Page Name and Space(s) are left blank, the current page is assumed.</td>
</tr>
<tr>
<td>Label(s) (labels)</td>
<td>none</td>
<td>Filters the list of contributors to those who created the specified labels</td>
</tr>
<tr>
<td></td>
<td></td>
<td>from a page. You can specify one or more labels, separated by commas.</td>
</tr>
<tr>
<td>Space(s) (spaces)</td>
<td>current</td>
<td>Specifies the space key of the Confluence space that contains the page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>set in Page Name or alternatively, specifies the spaces to search. Space</td>
</tr>
<tr>
<td></td>
<td></td>
<td>keys are case-sensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This parameter also takes special values, including:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- @global — All site spaces.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- @personal — All personal spaces.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- @all — All spaces in your Confluence site.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can specify one or more space keys or special values,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>separated by commas.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If no Page Name and Label(s) are specified, all pages from the specified</td>
</tr>
<tr>
<td></td>
<td></td>
<td>set of spaces are included.</td>
</tr>
<tr>
<td>Content Type (contentType)</td>
<td>both pages</td>
<td>Restricts the content type to use when generating the list of contributors:</td>
</tr>
<tr>
<td></td>
<td>blogposts</td>
<td>- pages — pages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- blogposts — blog posts</td>
</tr>
<tr>
<td>Blog Post Date (publishDate)</td>
<td>none</td>
<td>Specifies the publish date for a blog post. The date format required is:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>YYYY/MM/DD.</td>
</tr>
<tr>
<td>Include Page Hierarchy (scope)</td>
<td>specified</td>
<td>Specifies additional pages to include when generating the list of</td>
</tr>
<tr>
<td></td>
<td>page only</td>
<td>contributors:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- children — just the child pages of the specified page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- descendants — all descendants of the specified page.</td>
</tr>
<tr>
<td>Show Selected Pages (showPages)</td>
<td>false</td>
<td>Sets whether to show a list of the pages used to generate the list of</td>
</tr>
<tr>
<td></td>
<td></td>
<td>contributors.</td>
</tr>
<tr>
<td>Custom &quot;None Found&quot; Message</td>
<td>default</td>
<td>Specifies the message to be used to override the default message that is</td>
</tr>
<tr>
<td>(noneFoundMessage)</td>
<td>message</td>
<td>displayed when no contributors are found.</td>
</tr>
</tbody>
</table>

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: contributors

Macro body: None.

Storage format example

This example specifies a content type of blog posts:

```xml
<ac:macro ac:name="contributors">
  <ac:parameter ac:name="limit">10</ac:parameter>
  <ac:parameter ac:name="spaces">ds,@personal</ac:parameter>
  <ac:parameter ac:name="reverse">true</ac:parameter>
  <ac:parameter ac:name="labels">chocolate,cake</ac:parameter>
  <ac:parameter ac:name="showPages">true</ac:parameter>
  <ac:parameter ac:name="noneFoundMessage">Oh dear, no contributors found</ac:parameter>
  <ac:parameter ac:name="showCount">true</ac:parameter>
  <ac:parameter ac:name="contentType">blogposts</ac:parameter>
  <ac:parameter ac:name="include">authors,comments,labels,watches</ac:parameter>
  <ac:parameter ac:name="mode">list</ac:parameter>
  <ac:parameter ac:name="showAnonymous">true</ac:parameter>
  <ac:parameter ac:name="order">update</ac:parameter>
  <ac:parameter ac:name="showLastTime">true</ac:parameter>
  <ac:parameter ac:name="publishDate">2012/06/30</ac:parameter>
</ac:macro>
```

Wikimarkup example

This example specifies a content type of blog posts:

```wikimarkup
{contributors:limit=10|spaces=ds,@personal|reverse=true|labels=chocolate,cake|showPages=true|noneFoundMessage=Oh dear, no contributors found|showCount=true|contentType=blogposts|include=authors,comments,labels,watches|mode=list|showAnonymous=true|order=update|showLastTime=true|publishDate=2012/06/30}
```

This example specifies a content type of pages:

```wikimarkup
{contributors:limit=10|spaces=ds,@personal|reverse=true|scope=descendants|labels=chocolate,cake|showPages=true|noneFoundMessage=Oh dear, no contributors found|showCount=true|contentType=pages|include=authors,comments,labels,watches|mode=list|showAnonymous=true|order=update|page=ds:Advanced Topics|showLastTime=true}
```

Contributors Summary Macro

The Contributors Summary macro displays a table of contribution-based statistics for a set of pages. These statistics can be grouped according to individual pages or individual contributors.

The default scope for this macro is an individual page, but this can be extended to include the immediate children or descendants of a specified page. The statistics cover the following types of contributions:

- edits to the page(s)
- comments added to the page(s)
- labels added to the page(s)
- people watching the page(s)

A simple example of the Contributors Summary macro is shown in the screenshot below. It lists statistics for the number of times each contributor has edited, added comments and added labels to this page.
Screenshot: Example Contributors Summary table of statistics

In this example, all default parameter settings are used. For more information about this macro's parameters, refer to the Parameters section below.

Using the Contributors Summary Macro

To add the Contributors Summary macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group By</td>
<td>contributors</td>
<td>Specifies the basis for grouping contribution-based statistics:</td>
</tr>
<tr>
<td>(groupby)</td>
<td></td>
<td>- contributors — group by the people who have contributed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- pages — group by the pages used to find contributors.</td>
</tr>
</tbody>
</table>
| **Columns to Display (columns)** | edits, comments, labels | Sets the columns that should appear in the table. The statistics or type of information presented depends on the basis for grouping set with the **Group By** parameter. Statistics may be calculated for:
- *edits* — the number of times each contributor has edited the page(s) or the number of edits made to each page.
- *edited* — a list of the pages edited by each contributor or a list of contributors who have edited each page.
- *comments* — the number of times each contributor has added comments to the page(s) or the number of comments on each page.
- *commented* — a list of pages to which each contributor has added comments or a list of contributors who have commented on each page.
- *labels* — the number of times each contributor has added labels to the page(s) or the number of labels on each page.
- *labeled* — a list of pages to which each contributor has added labels or a list of contributors who have added a label to each page.
- *labellist* — a list of labels either added by each contributor or on each page.
- *watches* — the number of pages being watched by each contributor/person or the number of contributors/people watching each page.
- *watching* — a list of pages being watched by each contributor/person or a list of contributors/people watching each page.
- *lastupdate* — the last time each contributor made an update or when each page was last updated. Valid updates can include edit, comment or label modifications to a page.

One or more columns can be used. |
| **Sort By (order)** | edits | Sets the criterion used for sorting items in the table. The items sorted depend on the basis for grouping set with the **Group By** parameter. Sort criteria are:
- *edits* — sorts items in the table based on the total number of edits made, either by a contributor or to a page.
- *name* — sorts items in the table in alphabetical order, either by contributor or page name.
- *editTime* — sorts items in the table based on when the contributor last edited a page (or a specified set of pages) or when the page was last edited.
- *update* — sorts items in the table based on when the contributor last made any contribution to a page (or a specified set of pages) or when the page last had any contribution made to it. |
| **Reverse Sort (reverse)** | false | Reverses the sort order of items in the table, as specified using the **Sort By** parameter. (Used only in conjunction with the **Sort By** parameter.) |
| **Maximum Number of Items (limit)** | no limit | Limits the number of contributors or pages in the table to the value specified. If no number is specified, all items are included. |
| **Show Anonymous Contributions?**<br>(showAnonymous) | false | Includes individuals who have made anonymous contributions to a page. |
| **Show Zero Counts?**<br>(showZeroCounts ) | false | Sets whether contributors or pages are included for which a calculated statistic is zero. |
| **Page Name**<br>(page) | current | Sets the page for which to calculate the contribution-based statistics. If no values for **Page Name** and **Space(s)** are specified, the current page is assumed. |
| **Label(s)**<br>(labels) | none | Restricts the contribution-based statistics to the specified labels only. You can specify one or more labels, separated by commas. |
| **Space(s)**<br>(spaces) | current | Specifies the space key of the Confluence space which contains the specified page name or alternatively, specifies a scope of spaces to search. Space keys are case-sensitive. This parameter also takes special values, including: |
| | | • @global — All site spaces. |
| | | • @personal — All personal spaces. |
| | | • @all — All spaces in your Confluence site. |
| | | You can specify one or more space keys or special values, separated by commas. |
| | | If no Page Name and Label(s) are specified, all pages from the specified set of spaces are included. |
| **Content Type**<br>(contentType) | both pages and blog posts | Restricts page types to either pages (pages) or blog posts (blogposts). If no value is specified in the Macro Browser, both pages and blog posts are included. |
| **Blog Post Date**<br>(publishDate) | none | Specifies the publish date for a blog post. The date format required is: YYYY/MM/DD. |
| **Include Page Hierarchy**<br>(scope) | specified page only | Includes either the immediate children or all descendants of the specified page. If no value is indicated in the Macro Browser, only the specified page is included. |

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** contributors-summary

**Macro body:** None.

Storage format example

This example specifies a content type of blog posts:
This example specifies a content type of pages:

```xml
<ac:structured-macro ac:name="contributors-summary">
  <ac:parameter ac:name="limit">10</ac:parameter>
  <ac:parameter ac:name="spaces">
    <ri:space ri:space-key="ds"/>
    <ri:space ri:space-key="@personal"/>
  </ac:parameter>
  <ac:parameter ac:name="reverse">true</ac:parameter>
  <ac:parameter ac:name="showAnonymous">true</ac:parameter>
  <ac:parameter ac:name="order">update</ac:parameter>
  <ac:parameter ac:name="labels">chocolate,cake</ac:parameter>
  <ac:parameter ac:name="columns">edits,comments,labels,lastupdate</ac:parameter>
  <ac:parameter ac:name="groupby">pages</ac:parameter>
  <ac:parameter ac:name="contentType">pages</ac:parameter>
  <ac:parameter ac:name="showZeroCounts">true</ac:parameter>
  <ac:parameter ac:name="publishDate">2012/06/07</ac:parameter>
</ac:structured-macro>
```

Wiki markup example

This example specifies a content type of blog posts:

```
{contributors-summary:limit=10|spaces=ds,@personal|reverse=true|showAnonymous=true|
order=update|labels=chocolate,cake|columns=edits,comments,labels,lastupdate|groupby=
pages|contentType=blogposts|showZeroCounts=true|publishDate=2012/06/07}
```

This example specifies a content type of pages:

```
{contributors-summary:limit=10|spaces=ds,@personal|reverse=true|showAnonymous=true|
scope=descendants|order=update|page=ds:Advanced
Topics|labels=chocolate,cake|columns=edits,comments,labels,lastupdate|groupby=pages |
contentType=pages|showZeroCounts=true}
```
Create from Template Macro

The Create from Template macro displays a button on a page, linked to a specific template. When someone clicks the button, the macro opens the editor, ready to add a new page, and adds content to the page based on the given template.

When adding the macro to the page, you can specify a blueprint or a user-created template in the macro. You will also specify the name of the button displayed, and the space in which the new page will appear.

Example

Screenshot: A page with three buttons, all displayed by the ‘Create from Template’ macro

Using the Create from Template Macro

To add the Create from Template macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button Text</td>
<td></td>
<td>‘Create from Template’</td>
<td>The description that people will see when viewing this macro on the page.</td>
</tr>
<tr>
<td>Template Name</td>
<td>None</td>
<td>None</td>
<td>Select the template or blueprint to base the new page on. Only global and user-created templates for the current space appear (unless you have specified a different space in the ‘Space Key’ field).</td>
</tr>
<tr>
<td>Template Title</td>
<td>Blank</td>
<td>Blank</td>
<td>Specify a default title for pages created using this macro (optional). You can include @currentDate, @spaceName and @spaceKey variables in the title.</td>
</tr>
<tr>
<td>Space Key</td>
<td></td>
<td>The space where the current page is located</td>
<td>Supply the unique space identifier (space key), to determine where the new page will be created when someone uses this macro to create a page.</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a
Macro name: create-from-template

Macro body: None.

Parameters for storage format differ from those available in the macro browser as follows.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>templateId</td>
<td>Required for user-created templates</td>
<td>(None)</td>
<td>The ID of a user-created template. This is the unique identifier that Confluence assigns when you create a template. To find the ID of a template, edit the template in your browser. The template ID is given in the URL parameter named entityId.</td>
</tr>
<tr>
<td>blueprintModuleCompleteKey</td>
<td>Required for blueprints</td>
<td>(None)</td>
<td></td>
</tr>
<tr>
<td>templateName</td>
<td>Yes</td>
<td>(None)</td>
<td>The ID of a user-created template (for example, com.atlassian.confluence.plugins:file-list-blueprint) or the qualified name of the add-on that defines the blueprint.</td>
</tr>
<tr>
<td>buttonLabel</td>
<td>Yes</td>
<td>'Create from Template'</td>
<td>The description that people will see when viewing this macro on the page.</td>
</tr>
<tr>
<td>spaceKey</td>
<td>Yes</td>
<td>The unique space identifier, to determine where the new page will be created when someone uses this macro to create a page.</td>
<td></td>
</tr>
</tbody>
</table>

Title | No | (None) | The title for pages created using this macro. You can include variables like @currentDate, @spaceName and @spaceKey. This title will override any title specified in a blueprint. |

Storage format example

This example specifies a user-created template:

```xml
<ac:structured-macro ac:name="create-from-template">
  <ac:parameter ac:name="templateId">299630593</ac:parameter>
  <ac:parameter ac:name="buttonLabel">Blitz test</ac:parameter>
  <ac:parameter ac:name="spaceKey">
    <ri:space ri:space-key="DOCTHEME"/>
  </ac:parameter>
  <ac:parameter ac:name="templateName">299630593</ac:parameter>
</ac:structured-macro>
```

This example uses a blueprint:
The Create Space Button macro displays a create space icon that links to the ‘Create Space’ page. To see this icon, viewers need the ‘Create Space’ permission which is assigned by a site administrator.

Using the Create Space Button macro

To add the Create Space Button macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type \ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon Size</td>
<td>large</td>
<td>Specify whether to use large or small icon. Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• large</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• small</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: create-space-button

Macro body: None.

The following additional parameters are available in storage format and wikimarkup.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### width

| width | No | Natural size of icon (1:1 pixel ratio) | The width of the icon to be displayed, specified in pixels. Confluence will stretch or shrink the width of the icon to the number of pixels specified. Note: This parameter is not available via the macro browser. |

### height

| height | No | Natural size of icon (1:1 pixel ratio) | The height of the icon to be displayed, specified in pixels. Confluence will stretch or shrink the height of the icon to the number of pixels specified. Note: This parameter is not available via the macro browser. |

### Storage format example

```xml
<ac:structured-macro ac:name="create-space-button">
  <ac:parameter ac:name="size">small</ac:parameter>
  <ac:parameter ac:name="height">50px</ac:parameter>
  <ac:parameter ac:name="width">50px</ac:parameter>
</ac:structured-macro>
```

### Wikimarkup example

```
{create-space-button:size=small}
{create-space-button:height=50px|width=50px}
```

### Excerpt Include Macro

The Excerpt Include macro is used to display 'excerpted' (that is, a segment of) content from one page in another.

Before you can use this macro, the excerpt must have been defined using the Excerpt macro. Note that you can have more than one Excerpt Include macro on a page (although you can have only one Excerpt macro on a page).

### Example

The paragraph below shows an example of an Excerpt Include macro, containing content from an excerpt which we have defined on the page. On the Excerpt Include macro below, we have set the options to show both the title of the page and the panel surrounding the content.

### Using the Excerpt Include Macro

**To add the Excerpt Include macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.
Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Containing the Excerpt (default-parameter)</td>
<td>none</td>
<td>Type the name of the page that contains the excerpt to be displayed. You can use an excerpt from a page in the same space or another space in the same wiki. When you type the name of the page into the Excerpt Include macro dialog, Confluence will offer a list of matching pages, including those from other spaces. Alternatively, you can type the space key followed by a colon (:) and the page name, like this: SPACEKEY:Page name. This parameter is unnamed in wikimarkup.</td>
</tr>
<tr>
<td>Remove Surrounding Panel (nopanel)</td>
<td>false</td>
<td>Determines whether Confluence will display a panel around the excerpted content. The panel includes the title of the page containing the excerpt, and the border of the panel. By default, the panel and title are shown.</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** excerpt-include

**Macro body:** None.

**Storage format example**

```xml
<ac:macro ac:name="excerpt-include">
  <ac:parameter ac:name="nopanel">true</ac:parameter>
  <ac:default-parameter>My page name</ac:default-parameter>
</ac:macro>
```

**Wikimarkup example**

```
{excerpt-include:My page name|nopanel=true}
```

Excerpt Macro

The Excerpt macro is used to mark a part of a page's content for re-use. Defining an excerpt enables other macros, such as the Excerpt Include and Blog Posts macros, to display the marked content elsewhere.

You can only define one excerpt per page. In other words, you can only add the Excerpt macro once to a page.

Using the Excerpt Macro

**To add the Excerpt macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.
Speeding up macro entry with autocomplete: Type \ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

To add reusable content to the macro:

1. Add your content inside the Excerpt macro placeholder.
2. Choose the macro placeholder to see the options panel, and select the option to Display on new line or Display inline. The default is to display the content of the macro on a new line. If you choose the inline option, the content of the macro will form part of the same paragraph as the text preceding and following it. Note that this option affects only the page that contains the Excerpt macro. It does not affect any pages where the content is reused.

Screenshot: The Excerpt macro placeholder and options panel

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Excerpted Content (hidden)</td>
<td>false</td>
<td>Controls whether the page content contained in the Excerpt macro placeholder is displayed on the page. Note that this option affects only the page that contains the Excerpt macro. It does not affect any pages where the content is reused.</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: excerpt

Macro body: Accepts rich text.

The following additional parameter is available in storage format and wikimarkup. It performs the same function as the options panel in the editor.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>atlassian-macro-output-type</td>
<td>No</td>
<td>Determines whether the content of the Excerpt macro body is displayed on a new line or inline. Available values: BLOCK – Displays the content of the macro on a new line. INLINE – Displays the content of the macro as part of the same paragraph as the text preceding and following it. Note that this option affects only the page that contains the Excerpt macro. It does not affect any pages where the content is reused.</td>
<td></td>
</tr>
</tbody>
</table>

**Storage format example**

```html
<ac:structured-macro ac:name="excerpt">
  <ac:parameter ac:name="hidden">true</ac:parameter>
  <ac:parameter ac:name="atlassian-macro-output-type">BLOCK</ac:parameter>
  <ac:rich-text-body>
    <p>This is the <strong>text</strong> I want to reuse in other pages. This text is inside an Excerpt macro.</p>
  </ac:rich-text-body>
</ac:structured-macro>
```

**Wikimarkup example**

```
{excerpt:hidden=true|atlassian-macro-output-type=BLOCK}
This is the *text* I want to reuse in other pages. This text is inside an Excerpt macro.
{excerpt}
```

**Expand Macro**

The Expand macro displays an expandable/collapsible section of text on your page.

Here is an example:

Expand me...

This text is hidden until you expand the section.

**Using the Expand Macro**

**To insert the Expand macro into a page using the macro browser:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets example.
| Title | Click here to expand... | Defines the text that appears next to the expand/collapse icon. |

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** expand

**Macro body:** Accepts rich text.

**Storage format example**

```
<ac:structured-macro ac:name="expand">
  <ac:parameter ac:name="title">Expand me...</ac:parameter>
  <ac:rich-text-body>
    <p>This text is hidden until you expand the section.</p>
  </ac:rich-text-body>
</ac:structured-macro>
```

**Wikimarkup example**

```
{expand:This is my message}
This text is _hidden_ until you expand it.
{expand}
```

**Notes**

- **Text is expanded in PDF and HTML exports.** When you export the page to PDF or HTML, the text between the macro tags is expanded so that readers can see it in the PDF and HTML versions of the page.
- **Nesting your Expand macros.** You can put one Expand macro inside another, and Confluence will correctly show and hide the contents of all Expand macros, including the nested ones.

**Favourite Pages Macro**

Use the Favourite Pages macro to display a list of your favourite pages.

The output of the Favourite Pages macro appears as in the following screenshot.

**Screenshot: The Favourite Pages Macro in Confluence**

| This is the Favourite Pages macro |

| Favourite Pages |

Displaying pages recently added to your favourites list.

- Why I loved Angry Nerds (Angry Nerds)
- Which nerd are you? (Angry Nerds)
- Our new logo (Angry Nerds)

**Using the Favourite Pages Macro**

To insert the favourite pages macro into a page using the Macro Browser:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of
suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

There are no parameters for this macro.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** favpages

**Macro body:** None.

**Parameters:** None.

Storage format example

```
<ac:structured-macro ac:name="favpages"/>
```

Wiki markup example

```
{favpages}
```

**Gadget Macro**

Gadgets are small applications that can offer dynamic content. They are typically served from a web application server and can be re-used in many other web applications. In Confluence, use the Gadget macro to add gadgets to pages or blog posts.

Confluence comes bundled with a few of its own gadgets that you can add to your pages or blog posts. The Confluence gadgets are listed in Confluence Gadgets. However, you can access additional gadgets in this list if your Confluence Administrator has:

- Installed additional gadgets in Confluence (typically as a Confluence plugin) or
- Registered gadgets served from an external web application or website (such as those from a JIRA installation or iGoogle).

Unlike other macros, the name of each gadget macro is unique and follows the convention "<gadget-name> macro", where `<gadget-name>` is the name supplied by the gadget itself.

**Inserting gadgets into a Confluence page or blog post**

**To add a gadget to a page:**

1. Edit your page or blog post.
2. Choose **Insert > Other Macros**.
3. Click **External Content** to see a list of gadgets configured for use in your Confluence installation.
   (Some Confluence macros like the JIRA Issues, RSS Feed, and Widget Connector macros also appear in this category because they can also access external content.)
4. Click the desired gadget to access its parameters and properties.
   Almost all gadgets allow you to set basic parameters (**listed below**), which appear on the right of the macro dialog. Each gadget may also have its own set of parameters, which appear on the left of the macro dialog.
5. Set the parameters to your requirements.
6. Click **Refresh** to preview your changes.
7. Click **Insert** to add the gadget to the page.

**Editing gadgets on a Confluence page or blog post**
To edit an existing gadget on a page or blog post:

1. Edit your page or blog post.
2. Click the Gadget macro placeholder and choose Edit (or double-click the placeholder).
3. Set the gadget's parameters to your requirements.
4. Click Refresh to preview your changes.
5. Save the gadget.

Standard gadget parameters

Almost all gadgets allow you to set basic parameters (listed below), which appear on the right of the macro dialog. Each gadget may also have its own set of parameters, which appear on the left of the macro dialog.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>450 pixels</td>
<td>Set the width of the gadget, using one of the following conventions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Width in pixels, using px or plain numbers. For example, 500px or 500</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- A percentage of the page width, using %. For example, 50%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Automatic resizing of the gadget to fit 100% of the page width: auto</td>
</tr>
<tr>
<td>Border</td>
<td>true</td>
<td>Places a thin grey border around the gadget.</td>
</tr>
</tbody>
</table>

Contents of a Gadget macro

In the addition to the standard parameters, the gadget macro contains 'parameter-like' content, which represents specific property settings that are particular to each gadget. Hence they are not documented here. Typically, this content would only be changed by customising the gadget's default properties using the macro browser.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** gadget

**Macro body:** None.

The following additional parameters are available in storage format and wikimarkup.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>url</td>
<td>Yes</td>
<td>(none)</td>
<td>This is the location of the gadget specification (XML file).</td>
</tr>
<tr>
<td>preferences</td>
<td>No</td>
<td>(Gadget-dependent)</td>
<td>Specific property settings that are particular to each gadget.</td>
</tr>
</tbody>
</table>

**A note about editing a gadget's properties (preferences) in markup:** It is possible to edit the values of these properties directly in the wiki markup or storage format. However, this will allow the entry of invalid values. If a gadget property supports a certain set of values, the macro browser will restrict the user to selecting only valid values for that property. For that reason, we recommend that you use the macro browser to edit a gadget's properties.

Storage format example

This example shows the Confluence Page gadget:
Gallery Macro

The Gallery macro displays a collection of thumbnail images in a table, based on the images attached to a Confluence page. When viewing the page, a user can click a thumbnail image to zoom into a screen-sized image and then view the images as a slide show.

Overview:

- The images shown in the gallery are taken from the files attached to the Confluence page. You can also specify a different page where the attachments are located. For information about attaching images to a page, see Attaching Files to a Page.
- The captions below the images are drawn from the comments on the attachments. For information about adding comments to attachments, see Attaching Files to a Page.
• By default, the gallery will include all the images attached to the page. You can also exclude or include images using parameters.
• You can sort your images into a particular order.
• You can specify a title for the gallery and also configure how many columns you want for the table in which your images are displayed.

Illustration: Live example of the Gallery macro

Using the Gallery macro

To insert the Gallery macro onto a page:
1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

The full list of parameters is shown in the following table. If the name of an attached file or page contains a comma, you can refer to it in the relevant parameters below by enclosing it in single or double quotes, for example "this,that.jpg", theother.png

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gallery Title (title)</td>
<td>Nothing</td>
<td>Specify a title for your gallery.</td>
</tr>
<tr>
<td>Number of Columns (columns)</td>
<td>4</td>
<td>Specify the number of columns for your table.</td>
</tr>
<tr>
<td>Images to Exclude (exclude)</td>
<td>No exclusions. Include all the pictures on the page.</td>
<td>The gallery will ignore any pictures specified. You can specify more than one picture, separated by commas. Note: The filename and filetype for this parameter are case-sensitive. For example, 'my picture.PNG' will not be recognised as 'my picture.png'.</td>
</tr>
<tr>
<td>Include these Images Only (include)</td>
<td>Include all the pictures on the page.</td>
<td>If you specifically include one or more pictures, the gallery will show only those pictures. You can specify more than one picture, separated by commas. Note: The filename and filetype for this parameter are case-sensitive. For example, 'my picture.PNG' will not be recognised as 'my picture.png'.</td>
</tr>
<tr>
<td>Exclude Images with these Labels (excludeLabel )</td>
<td>No exclusions. Include all the pictures on the page.</td>
<td>The gallery will ignore any pictures that have the specified label. You can specify more than one label, separated by commas. For information on labelling the attachments, see Adding Labels.</td>
</tr>
<tr>
<td>Include Images with these Labels Only (includeLabel )</td>
<td>None. The images are not filtered by label.</td>
<td>Filters the images to display, based on a list of labels. If you wish to enter more than one label, separate the labels with commas. Confluence will show only images that have all the labels specified. (The match is an AND, not an OR.) For information on labelling the attachments, see Adding Labels.</td>
</tr>
<tr>
<td>Use Images in these Pages (page)</td>
<td>If no page is specified, the gallery macro displays the images attached to the page on which the macro is used.</td>
<td>Specify the title of the page which contains the images you want displayed. You can specify more than one page name, separated by commas. To specify a page in a different space, use the following syntax: SPACEKEY:Page Title</td>
</tr>
</tbody>
</table>
### Sort Images By (sort)

None. The sort order is unspecified and therefore unpredictable.

Specify an attribute to sort the images by. Sort order is ascending, unless you select the Reverse Sort parameter (see below). Options are:
- name – file name.
- comment – comment linked to the attached file.
- date – date/time last modified.
- size – size of the attached file.

### Reverse Sort (reverse)

Off. Sort order is ascending

Used in combination with the Sort Images By parameter above. Use Reverse Sort to reverse the sort order, from ascending to descending.

Available values in storage format and wikimarkup:
- true – Sort order is descending.
- false – Sort order is ascending.

### Image file formats

You can attach image files of any format to a page. Confluence supports the following image formats in the Gallery macro and when displaying an image on a page:
- gif
- jpeg
- png
- bmp (depending on browser support)

### Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** gallery

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="gallery">
  <ac:parameter ac:name="title">My holiday pictures</ac:parameter>
  <ac:parameter ac:name="reverse">true</ac:parameter>
  <ac:parameter ac:name="sort">size</ac:parameter>
  <ac:parameter ac:name="page">My pagel, ds:Welcome to Confluence</ac:parameter>
  <ac:parameter ac:name="excludeLabel">badlabel1, badlabel2</ac:parameter>
  <ac:parameter ac:name="columns">3</ac:parameter>
  <ac:parameter ac:name="exclude">badpicture.png</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```wiki
{gallery:title=My holiday pictures|reverse=true|sort=size|page=My pagel, ds:Welcome to Confluence|excludeLabel=badlabel1, badlabel2|columns=3|exclude=badpicture.png}
```

### Global Reports Macro

The Global Reports macro displays a list of links to some reports about content on your site.

These reports include a list of new or updated pages, orphan pages, undefined pages, and RSS feeds for new
Using the Global Reports Macro

**To add the Global Reports macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Width of Table</strong> (width)</td>
<td>99%</td>
<td>Specify the width of the table in which the links are displayed, as a percentage of the window width.</td>
</tr>
</tbody>
</table>

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** `global-reports`

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="global-reports">
  <ac:parameter ac:name="width">50%</ac:parameter>
</ac:structured-macro>
```

**Wikimarkup example**

```wikimarkup
{global-reports:width=50%}
```

**HTML Include Macro**

The HTML Include macro allows you to include the contents of an external HTML file (a webpage) in a Confluence page.
**Using the HTML Include Macro**

To insert the HTML Include macro into a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML Page's URL (url)</td>
<td>Yes</td>
<td>None</td>
<td>The URL of the page to include.</td>
</tr>
</tbody>
</table>

**Enabling the HTML Include Macro**

The HTML Include macro is disabled by default. You’ll need Confluence Administrator or System Administrator permissions to enable this macro.

⚠️ Enabling these macros can make your Confluence site vulnerable to cross-site scripting attacks. You should only turn on these macros if you trust all your users not to attempt to exploit them. We strongly recommend leaving this macro disabled if you allow self-signed up or anonymous users to create content.

**To enable the HTML Include macro:**

1. Go to > Add-ons.
2. Select System from the drop down and search for the Confluence HTML Macros add-on.
3. Expand the add-on and enable the html-include (html-include-xhtml) module.

Administrators can also choose to use the whitelist to restrict URLs that can be displayed in the HTML Include macro.

**Troubleshooting**

- Administrators can define a whitelist of trusted URLs. If a URL is not in the whitelist, you will see an error message in the HTML Include macro.
- You can only use the HTML Include macro for pages with absolute links. If you use the macro to include an HTML page that has relative links, you will see a ‘Page Not Found’ error. See [CONF-6567](https://conf.atlassian.com/browse/CONF-6567) - HTML Include macro should rewrite relative links to point to remote site OPEN.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** html-include

**Macro body:** None.

Storage format example
The HTML macro allows you to add HTML code to a Confluence page.

**HTML macros are disabled by default**
The HTML macro will only be available if it has been enabled by an administrator. Enabling these macros can make your Confluence site vulnerable to cross-site scripting attacks.

**Using the HTML Macro**

To add the HTML macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

There are no parameters for this macro.

Enter the HTML code into the body of the macro placeholder.

**Enabling the HTML Macro**

The HTML macro is disabled by default. You'll need Confluence Administrator or System Administrator permissions to enable this macro.

Enabling these macros can make your Confluence site vulnerable to cross-site scripting attacks. You should only turn on these macros if you trust all your users not to attempt to exploit them. We strongly recommend leaving this macro disabled if you allow self-signed up or anonymous users to create content.

**To enable the HTML macro:**

1. Go to Add-ons.
2. Select System from the drop down and search for the Confluence HTML Macros add-on.
3. Expand the add-on and enable the html (html-xhtml) module.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** html

**Macro body:** Text, consisting of HTML code.

**Parameters:** None.

Storage format example
The IM Presence macro indicates graphically when a contact is signed into an Instant Messaging (IM) service. The IM Presence macro appears as a small icon on the page.

**Using the IM Presence Macro**

To add the IM Presence macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID/Screen Name</td>
<td>Identify the user by their ID, account name or screen name.</td>
</tr>
</tbody>
</table>
| Service (service)           | aim – AOL Instant Messenger  
gtalk – Google Talk              
icq – ICQ                         
jabber – Jabber                  
msn – MSN Instant Messenger  
sametime – IBM Lotus Sametime  
skype – Skype. Note: Skype requires ‘Show my status on the web’ to be checked under ‘Privacy’ preferences  
skypeme – Skype                  
wildfire – Openfire Server       
yahoo – Yahoo! Messenger        |
| Show User ID (showid) | Shows or hides the User ID of the contact.                                |
Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: im

Macro body: None.

Storage format example

```xml
<ac:structured-macro ac:name="im">
  <ac:parameter ac:name="showid">false</ac:parameter>
  <ac:parameter ac:name="service">skype</ac:parameter>
  <ac:parameter ac:name="">MySkypeName</ac:parameter>
</ac:structured-macro>
```

Wiki markup example

```
{im:MySkypeName|service=skype|showid=false}
```

Include Page Macro

You can use the Include Page macro to display the contents of one Confluence page or blog post in another page or blog post.

Using the Include Page Macro

To add the Include Page macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Page to Include | None    | This is the name of the Confluence page or blog post that you want to include in the current page. Start typing a page title, and Confluence will suggest matching pages from the current space and other spaces. Alternatively you can specify the page as follows:  
  - If the page or blog post is located in another space, add the space key and a colon in front of the page name. For example, DOC:My page name. The space key is case sensitive.  
  - To include a blog post, specify the date as well as the title of the blog post. For example: /2010/12/01/My blog post.  
  - You can include pages from personal spaces using ~username as the space key, where 'username' is the person's username. For example, ~jsmith:My page name. |
The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** include

**Macro body:** None.

**Storage format example**

```
<ac:structured-macro ac:name="include">
<ac:parameter ac:name=""></ac:parameter>
<ri:page ri:content-title="My chocolate page" ri:space-key="DOC"/>
</ac:structured-macro>
```

**Wiki markup example**

```
{include:DOC:My chocolate page}
```

**Notes**

- If you want to include part of a page rather than the whole page, use the Excerpt and Excerpt Include macros.
- To display a page’s contents, you need 'View' permission for that page. Similarly, people who view the page will need 'View' permissions for the embedded page as well as the page into which it is embedded. See space permissions or contact your Confluence space administrator for more information.
- If you want to embed an external page into a Confluence page, you need the HTML Include Macro.

**Sample Include Page**

Start of sample page content


End of sample page content

**Info Macro**

The Info macro allows you to highlight helpful information on a Confluence page. It creates a blue-coloured box surrounding your text, as shown below.

```
Info Macro Example
This text is rendered inside the info macro.
```

**Using the Info Macro**

**To add the Info macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.
Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional Title (title)</td>
<td>none</td>
<td>The title of the information box. If specified, the title text will be displayed in bold next to the icon.</td>
</tr>
<tr>
<td>Show Information Icon (icon)</td>
<td>true</td>
<td>If &quot;false&quot;, the icon will not be displayed.</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** info

**Macro body:** Accepts rich text.

**Storage format example**

The following example shows all parameters and a body:

```xml
<ac:structured-macro ac:name="info">
  <ac:parameter ac:name="icon">false</ac:parameter>
  <ac:parameter ac:name="title">This is my title</ac:parameter>
  <ac:rich-text-body>
    <p>This is <em>important</em> information.</p>
  </ac:rich-text-body>
</ac:structured-macro>
```

Below are some examples of the Info macro with various optional parameters used.

<table>
<thead>
<tr>
<th>Description</th>
<th>Markup</th>
<th>What you will get</th>
</tr>
</thead>
</table>
| Info macro with a body defined and no optional parameters | `<ac:structured-macro ac:name="info">
  <ac:rich-text-body>
    <p>This is <em>important</em> information.</p>
  </ac:rich-text-body>
</ac:structured-macro>` | This is important information.                                           |
| Info macro with with a body and an optional Title parameter defined | `<ac:structured-macro ac:name="info">
  <ac:parameter ac:name="title">This is my title</ac:parameter>
  <ac:rich-text-body>
    <p>This is <em>important</em> information.</p>
  </ac:rich-text-body>
</ac:structured-macro>` | This is my title
This is important information. |
Info macro with a body and optional Title and Icon parameters defined

```
<ac:structured-macro ac:name="info">
  <ac:param ac:name="icon">false</ac:param>
  <ac:param ac:name="title">This is my title</ac:param>
  <ac:rich-text-body>
    <p>This is _important_ information.</p>
  </ac:rich-text-body>
</ac:structured-macro>
```

Wiki markup example

```
{info:title=This is my title|icon=false}
This is _important_ information.
{info}
```

JIRA Chart Macro

JIRA is Atlassian's issue tracking and project management system. By adding the JIRA Chart macro to a Confluence page, you can display information about JIRA issues and projects as pie charts.

Before you can use this macro, your Confluence and JIRA sites must be connected via Application Links. People viewing the page will see charts for publicly accessible issues from the JIRA site. If your JIRA site has restricted viewing (that is, people need permission to view issues) then they will need to authenticate before seeing the charts. This macro is compatible with JIRA 5.x and later.

Adding the JIRA Chart macro to a page

To add a JIRA chart to your page:

1. In the editor choose Insert > Other macros > JIRA Chart.
2. Choose the type of report you want to create (for example Pie, Created vs Resolved)
3. Select your JIRA server.
   - If you have multiple JIRA instances linked to Confluence the drop down will default to the primary application link.
4. Search for issues - you can enter the query in JQL or paste a JIRA URL directly into the search field.
5. Choose Preview to generate the chart.
6. Choose Display Options to further control how your chart appears.
7. Choose Insert.

To find out more about searching for issues see Displaying issues via a JIRA Query Language (JQL) search.

On this page:
- Adding the JIRA Chart macro to a page
- Pie chart
- Created vs Resolved chart
- Two Dimensional Chart
- Disabling the JIRA Chart macro
- Notes
- Code examples

Screenshot: The JIRA Chart Macro in the macro browser
Pie chart can be used to report on issue status, priority, assignee and more.

To further control how this chart appears on your page, choose Display options:

- **Chart by** - select the JIRA field you want to segment the pie chart by such as:
  - Status
  - Fix version
  - Assignee name
  - Priority
  - Component
  - Issue type
- **Width** - define the total width of the chart area. You can enter values in pixels, percent or leave blank to auto fit.
- **Show border** - add a border around the chart area
- **Show chart information** - include a text summary under the chart with the total issues count and chart by value.

Created vs Resolved chart

Created vs Resolved charts can be used to show the difference between the number of issues created versus the number of issues resolved over time.

To further control how this chart appears on your page choose Display options:

- **Period** - choose a time frame to report by (week, month, quarter etc).
- **Days previously** - the total number of days to report on (counting back from today).
- **Cumulative totals** - choose to progressively add totals or report individual values for each period.
- **Show unresolved trend** - add a subplot showing unresolved issues over time.
- **Show versions** - indicate version release dates as a vertical line on the chart.
- **Width** - define the total width of the chart area. Enter values in pixels, percent or leave blank to auto fit.
Two Dimensional Chart

Two Dimensional Charts can be used to show issue statistics in a matrix. You can configure the X and Y axes to display these issue fields:

- Status
- Priority
- Assignee
- Fix version
- Component
- Issue type.

For example you could use the chart to show issue types by status (as shown above).

To configure the chart axes choose Display options:

- **X Axis** - the issue field to display on the X axis (columns).
- **Y Axis** - the issue field to display on the Y axis (rows).
- **Rows to display** - the maximum number to display in the chart.

Disabling the JIRA Chart macro

The functionality is provided by an add-on (plugin) called 'JIRA Macros'. This macro is also used for the JIRA Issues macro. To make the macro unavailable on your site, you can disable the add-on. See Disabling and enabling add-ons.

Notes

**HTTPS**: The JIRA Chart macro can access a JIRA site running under SSL provided the Confluence server is configured to accept the JIRA SSL certificate. See Connecting to LDAP or JIRA or Other Services via SSL.

**Authentication**: If the query includes issues that require authentication (issues that are not visible to anonymous users in JIRA), users will be prompted to authenticate to view charts on the Confluence page. In order to search for issues in the macro browser you may need to authenticate. With JIRA 5.x you will be able to search for unrestricted issues as an anonymous user, however with JIRA 6.x you must be authenticated to search for any issues.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name**: jirachart

**Macro body**: None.

The following parameters are available in storage format. Note that some parameters are only available for specific chart types.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Chart type</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>chartType</td>
<td>all</td>
<td>Yes</td>
<td>Pie</td>
<td>Type of chart to display. Chart types include:</td>
</tr>
</tbody>
</table>

- pie
- createdvsresolved
- twodimensional
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>showinfo</td>
<td>all</td>
<td>No</td>
<td>False</td>
<td>Displays text information about the data below the chart. Includes the Total value and the Chart By value.</td>
</tr>
<tr>
<td>jql</td>
<td>all</td>
<td>Yes</td>
<td></td>
<td>JQL query for the chart to display.</td>
</tr>
<tr>
<td>width</td>
<td>all</td>
<td>600</td>
<td>(blank)</td>
<td>This is the total width of the chart area. Width can be entered in pixels, percent or left blank to fit to the available space.</td>
</tr>
<tr>
<td>border</td>
<td>all</td>
<td>No</td>
<td>False</td>
<td>Displays a border around the chart area.</td>
</tr>
<tr>
<td>statType</td>
<td>pie</td>
<td>Yes</td>
<td></td>
<td>The JIRA field to segment the pie chart by:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• statuses - displays a breakdown of issues by Status.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• allFixfor - breakdown of issues by chart by all Fix Versions (useful if issues have more than one fix version).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• assignees - breakdown of issues by the Assignee name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• priorities - breakdown of issues by Priority.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• components - breakdown of issues by Component.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• issuetype - breakdown of issues by Issue Type.</td>
</tr>
<tr>
<td>periodName</td>
<td>createdvsresolved</td>
<td>Yes</td>
<td></td>
<td>Time frame to report by. Options are hourly, daily, weekly, monthly, quarterly and yearly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>There is a limit to the number of days the report can generate for each period. For example you can report hourly for a maximum of ten days, and report daily for a maximum of 300 days.</td>
</tr>
<tr>
<td>daysprevious</td>
<td>createdvsresolved</td>
<td>Yes</td>
<td>False</td>
<td>Number of days, counting backwards from today, to include in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note that maximum days limits might apply depending on the Period you have chosen.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Category</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
<td>----------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>isCumulative</td>
<td>createdvsresolved</td>
<td>No</td>
<td>False</td>
<td>If true, the chart will progressively add data. If false, the chart will show individual values for each period.</td>
</tr>
<tr>
<td>showUnresolvedTrend</td>
<td>createdvsresolved</td>
<td>No</td>
<td>False</td>
<td>Include a subplot showing unresolved issues trend.</td>
</tr>
<tr>
<td>versionLabel</td>
<td>createdvsresolved</td>
<td>No</td>
<td>None</td>
<td>Indicate version release dates with a vertical line. Values include major, all and none.</td>
</tr>
<tr>
<td>xstattype</td>
<td>twodimensional</td>
<td>Yes</td>
<td>Status</td>
<td>JIRA field for the X axis (columns) of the chart. These are the same issue fields that are available in the statType parameter (status, priority, assignee, etc).</td>
</tr>
<tr>
<td>ystattype</td>
<td>twodimensional</td>
<td>Yes</td>
<td>Assignee</td>
<td>JIRA field for the Y axis (rows) of the chart. These are the same issue fields that are available in the statType parameter (status, priority, assignee, etc).</td>
</tr>
<tr>
<td>numberToShow</td>
<td>twodimensional</td>
<td>No</td>
<td>5</td>
<td>Maximum number of rows to include in the chart.</td>
</tr>
</tbody>
</table>

**Storage format example - Pie Chart**

Example chart by Issue Type - note that Confluence will insert the server and serverId parameters, based on settings in Application Links:

```xml
<ac:structured-macro ac:name="jirachart">
  <ac:parameter ac:name="chartType">pie</ac:parameter>
  <ac:parameter ac:name="statType">issuetype</ac:parameter>
  <ac:parameter ac:name="showinfor">true</ac:parameter>
  <ac:parameter ac:name="jql">project%20%3D%20CONF%20and%20fixVersion%20in%20('5.3')</ac:parameter>
  <ac:parameter ac:name="width">600</ac:parameter>
  <ac:parameter ac:name="server">JAC</ac:parameter>
  <ac:parameter ac:name="serverId">144880e9-a353-312f-9412-e5028e8166fa</ac:parameter>
  <ac:parameter ac:name="border">true</ac:parameter>
</ac:structured-macro>
```

**Storage format example - Created vs Resolved**

Example chart - note that Confluence will insert the server and serverId parameters, based on settings in Application Links:
Storage format example - Two Dimensional Chart

Example chart - note that Confluence will insert the server and serverId parameters, based on settings in Application Links:

```
<ac:structured-macro ac:name="jirachart">
  <ac:parameter ac:name="chartType">twodimensional</ac:parameter>
  <ac:parameter ac:name="ystattype">issuetype</ac:parameter>
  <ac:parameter ac:name="sortBy" />
  <ac:parameter ac:name="isAuthenticated">true</ac:parameter>
  <ac:parameter ac:name="jql">project%20%3D%20CONF%20and%20Component%20%3D%20Documentation</ac:parameter>
  <ac:parameter ac:name="width" />
  <ac:parameter ac:name="server">JAC</ac:parameter>
  <ac:parameter ac:name="numberToShow">10</ac:parameter>
  <ac:parameter ac:name="sortDirection" />
  <ac:parameter ac:name="serverId">144880e9-a353-312f-9412-ed528e8166fa</ac:parameter>
  <ac:parameter ac:name="xstattype">statuses</ac:parameter>
</ac:structured-macro>
```

JIRA Issues Macro

**JIRA** is the issue tracking and project management system supplied by Atlassian. By adding the JIRA Issues macro to a Confluence page, you can display one or more issues from a JIRA site. You can also choose to create an issue in JIRA, at the time of adding the macro to the Confluence page.

Before you can use this macro, your Confluence and JIRA sites must be connected via Application Links. People viewing the page will see the publicly accessible issues from the JIRA site. If your JIRA site has restricted viewing (that is, people need permission to view issues) then they will need to authenticate before seeing the restricted issues. See more about restricted JIRA issues [below](#).

**What you can do with the JIRA Issues macro**

Using the JIRA Issues macro, you can:

- Display a table of JIRA issues on your page, based on the results of a search using JIRA Query Language (JQL).
- Display a table of JIRA issues on your page, using a JIRA URL.
- Display a single issue from the JIRA site, or a subset of selected issues from your JIRA search results.
- Display a count of issues from the JIRA site.
- Create new issues in JIRA and display the issues on your page without leaving Confluence.

Adding and updating the JIRA Issues macro – an overview

Quick guide to using the macro on a Confluence page:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

### Screenshot: Example of JIRA issues macro on a Confluence page

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Updated</th>
<th>P</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-30894</td>
<td>User is not prompted before overwriting changes of another user if attempting to save after an editor error is thrown</td>
<td>Oct 22, 2013</td>
<td></td>
<td>↑</td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-30886</td>
<td>TableOfContents Macros navigation is not working in Firefox 23 x / 24 x and Opera 12.16</td>
<td>Sep 24, 2013</td>
<td></td>
<td>↓</td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-30683</td>
<td>Left panel overlaps custom banner in Chrome</td>
<td>Sep 23, 2013</td>
<td></td>
<td>↓</td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-30590</td>
<td>Dashboard popular stream won't render when it contains content from an anonymous user</td>
<td>Sep 19, 2013</td>
<td></td>
<td>↑</td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

4 issues  ⚙ Refresh

Displaying issues via a JIRA Query Language (JQL) search

You can use the macro to display a table of JIRA issues on your page, based on the results of a search using JIRA Query Language (JQL).

JQL is a simple query language, similar to SQL, which works in JIRA. A basic JQL query consists of a **field**, followed by an **operator** (such as = or >), followed by one or more **values or functions**.

**Examples:**

- The following query will find all issues in the 'TEST' project:

  ```jql
  project = "TEST"
  ```

- The following query will find all issues in the ‘documentation’ component of the ‘CONF’ project:

  ```jql
  project = CONF and component = documentation
  ```

For more information about JQL syntax, see the JIRA documentation: Advanced Searching.

**To display a table of issues based on a JQL search:**

1. Insert the JIRA Issues macro onto your Confluence page, as described above.
2. Choose a JIRA server next to the **Search** button.
3. If prompted, log in to the JIRA server.
4. Enter the JQL query into the **Search** box.
5. Choose **Search**.
6. If you want to customise the display, choose **Display options** and adjust the columns and number of issues that will appear in your table of issues.

7. Choose **Insert**.

**Screenshot: Display options in the JIRA Issues macro browser.**

![Display options](image)

**Displaying issues via a JIRA URL**

You can paste any of the following JIRA URLs into the JIRA Issues macro. Confluence will immediately convert the URL to a JQL search.

- Any URL for a JIRA issue search or filter.
- A URL for a single issue.
- The URL of the XML view of a JIRA search.

**Auto-convert:** You can paste a JIRA URL directly into the Confluence editor (without calling up the macro browser). Confluence will automatically convert the URL into a JIRA Issues macro.

**Displaying a single JIRA issue, or selected JIRA issues**

**To display a single JIRA issue**, choose one of the following methods:

- Paste the URL of the issue directly onto the Confluence page. (There is no need to use the macro browser.) Confluence will auto-convert the link to a JIRA Issues macro.
- Or: Add the JIRA issues macro to the page as described **above**, and choose **Recently Viewed** to see the JIRA issues you have visited recently. Select an issue and choose **Insert**.
- Or: Add the JIRA issues macro to the page as described **above**, and past the issue URL into the search box in the macro browser.
- Or: Add the JIRA issues macro to the page, define your search criteria in the macro browser via JQL as described **above**, then select the check box next to the issue in the search results, within the macro browser.

You can display a single issue in a simple format with only its description and status, or in table form.
To display a subset of JIRA issues from your search results:

1. Add the JIRA issues macro to the page.
2. Define your search criteria in the macro browser via JQL, as described above.
3. Select the check boxes next to the required issues in the search results, within the macro browser.

Screenshot: Selecting a subset of issues to display

Displaying a count of issues

You can choose to display the number of issues returned by your search, rather than a table of issues. The JIRA Issues macro will display a count of issues, linked to the search in JIRA.

Screenshot: The JIRA Issues macro displaying an issue count on a Confluence page

To display an issue count:

1. Add the JIRA issues macro to the page.
2. Define your search criteria in the macro browser via JQL, as described above.
3. Choose Display options, then choose Total issue count next to 'Display options' in the macro browser.
4. Choose Insert.

Creating a new JIRA issue in the editor

While editing a Confluence page, you can create an issue in JIRA and display it on your Confluence page, without leaving the Confluence editor.

To insert an issue into JIRA:
1. Add the JIRA Issues macro to the page, as described above.
2. Choose Create New Issue.
3. Supply the information about your JIRA server, project, and issue, as prompted.
4. Choose Insert.

Confluence will send a request to JIRA, to add the issue to the JIRA site. Confluence will also display the resulting JIRA issue on the Confluence page.

Limitations

The JIRA Issues macro will notify you if it is unable to create an issue in the selected project. This may be because the project has a required field, field configuration or other customisation that is not supported by the JIRA Issues macro. In this situation you will need to create the issue directly in JIRA.

Configuring Application Links to display restricted JIRA issues

Before you can use this macro, your Confluence and JIRA sites must be connected via Application Links.

If the JIRA site allows anonymous viewing of issues, you must configure an application link, but there is no need to configure any incoming or outgoing authentication between JIRA and Confluence. People viewing the Confluence page will see the publicly accessible issues from the JIRA site.

If your JIRA site has restricted viewing, or if some JIRA projects or issues are restricted to viewing by certain people, then people will need to log in before seeing the restricted issues.

In such a case, the outgoing authentication in the Confluence Application Links determines how the JIRA Issues macro handles restricted issues:

- If the outgoing authentication is set to Trusted Applications, people can see restricted issues in JIRA if their username is the same in JIRA and Confluence, and if they have permission in JIRA to see the issue.
- If the outgoing authentication is set to OAuth, people may need to choose Login & Approve, to gain access to the JIRA server and restricted issues.
- If the outgoing authentication is set to Basic Access, people can see the JIRA issues that are visible to the user account configured in JIRA’s outgoing authentication setting.

Rendering HTML from JIRA

Formatted fields from JIRA can be displayed in Confluence if you set up a Confluence-to-JIRA application link. Otherwise, such formatted fields will be escaped within the output of the JIRA issues macro. This is to prevent the possibility of malicious HTML being served by an untrusted JIRA server. The most likely field where you will notice this is in the description field.

This example shows how a description column may be displayed in JIRA:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is</td>
</tr>
<tr>
<td>• the description</td>
</tr>
<tr>
<td>• of my issue</td>
</tr>
</tbody>
</table>

If there is no application link between JIRA and Confluence, the description will appear in the JIRA issues macro like this:

<p>This is<ul><li>the description</li><li>of my issue</li></ul></p>

Disabling the JIRA Issues macro

The functionality is provided by an add-on (plugin) called ‘JIRA Macros’. To make the macro unavailable on your site, you can disable the add-on. See Disabling and enabling add-ons.

Notes

HTTPS: The JIRA Issues macro can access a JIRA site running under SSL provided the Confluence server is configured to accept the JIRA SSL certificate. See Connecting to LDAP or JIRA or Other Services via SSL.
Custom fields can be added as columns to the table simply by using the name of the field with no quotes. Earlier versions of the macro required you to use the custom field id, e.g. customfield_10100.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** jiraissues  
**Macro body:** None.

Note: A number of additional parameters that are not available via the macro browser are available in storage format and wikimarkup.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>
| anonymous      | No       | false   | If this parameter is set to 'true', JIRA will return only the issues which allow unrestricted viewing. That is, the issues which are visible to anonymous viewers, as determined by JIRA's viewing restrictions. If this parameter is omitted or set to 'false', then the results depend on how your administrator has configured the communication between JIRA and Confluence. By default, Confluence will show only the JIRA issues which the user is authorised to view.  
**Note:** This parameter is available only if you insert the macro via wiki markup or by editing the storage format of the page. The graphic user interface (macro browser) for the JIRA Issues macro does not offer this parameter. |
| baseurl        | No       | The value of the 'url' parameter | If you specify a 'baseurl', then the link in the header, pointing to your JIRA site, will use this base URL instead of the value of the 'url' parameter. This is useful when Confluence connects to JIRA with a different URL from the one used by other users. |
| columns        | No       | By default, the following columns are shown:  
• type  
• key  
• summary  
• assignee  
• reporter  
• priority  
• status  
• resolution  
• created  
• updated  
• due | A list of JIRA column names, separated by semi-colons (;). You can include any columns recognised by your JIRA site, including custom columns. See the JIRA documentation for a list of names. |
<p>| count          | No       | false   | If this parameter is set to 'true', the issue list will show the number of issues in JIRA. The count will be linked to your JIRA site. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cache</td>
<td>No</td>
<td>on</td>
<td>The macro maintains a cache of the issues which result from the JIRA query. If the 'cache' parameter is set to 'off', the relevant part of the cache is cleared each time the macro is reloaded. (The value 'false' also works and has the same effect as 'off'.)</td>
</tr>
</tbody>
</table>
| height     | No       | 480 (if render mode is dynamic) | The height in pixels of the table displaying the JIRA issues. Note that this height specification is ignored in the following situations:  
- If the 'renderMode' parameter (see below) is set to 'static'.  
- When the JIRA issues are displayed in a PDF or Word document, in an email message or in an RSS feed. |
| renderMode | No       | static | If the value is 'dynamic', the JIRA Issues macro offers an interactive display which people can manipulate as follows:  
- Click the column headers to sort the output.  
- Drag and drop the columns into a different order.  
- Temporarily remove a column from the display.  
- View a page of issues at a time, for faster response times.  
A value of 'static' will disable the dynamic display features. |
| title      | No       | JIRA Issues | You can customise the title text at the top of the JIRA issues table with this parameter. For instance, setting the title to 'Bugs-to-fix' will replace the default 'JIRA Issues' text. This can help provide more context to the list of issues displayed. |
| url        | Yes      | none   | The URL of the XML view of your selected issues in JIRA Issue Navigator.  
**Note:** If the URL in the 'url' parameter does not contain a `tempMax` argument, then the value of `tempMax` will default to 500. If your JIRA server is version 3.12 or earlier, this means that the JIRA Issues macro will return a maximum of 500 issues. If your JIRA server is version 3.13 or later, a value of 500 means that the JIRA Issues macro will return a maximum of 500 issues per page. |
| width      | No       | 100%   | The width of the table displaying the JIRA issues. Can be indicated either as a percentage (%) or in pixels (px).  
**Note:** This parameter is available only if you insert the macro via wiki markup or by editing the storage format of the page. The graphic user interface (macro browser) for the JIRA Issues macro does not offer this parameter. |
Storage format example

Example using a URL that points to the XML view of a JIRA search:

```xml
<ac:structured-macro ac:name="jiraissues">
  <ac:parameter ac:name="anonymous">true</ac:parameter>
  <ac:parameter ac:name="columns">type;key;summary</ac:parameter>
  <ac:parameter ac:name="url">
    <ri:url ri:value="http://jira.atlassian.com/sr/jira.issueviews:searchrequest-xml/temp/SearchRequest.xml?jqlQuery=project+%3D+CONF+AND+%28summary+%7E+jiraissues+OR+description+%7E+jiraissues+OR+comment+%7E+jiraissues%29+AND+tempMax=10"></ri:url>
  </ac:parameter>
</ac:structured-macro>
```

Example using JQL – note that Confluence will insert the `server` and `serverId` parameters, based on settings in Application Links:

```xml
<ac:structured-macro ac:name="jira">
  <ac:parameter ac:name="columns">key,summary,type,created,assignee,status</ac:parameter>
  <ac:parameter ac:name="server">Atlassian JIRA</ac:parameter>
  <ac:parameter ac:name="serverId">144880e9-a111-333f-9412-ed999a999fa</ac:parameter>
  <ac:parameter ac:name="jqlQuery">project = CONF AND component = documentation AND resolution = unresolved</ac:parameter>
</ac:structured-macro>
```

Wikimarkup example

```wikimarkup
{jiraissues:anonymous=true|url=http://jira.atlassian.com/sr/jira.issueviews:searchrequest-xml/temp/SearchRequest.xml?jqlQuery=project+%3D+CONF+AND+%28summary+%7E+jiraissues+OR+description+%7E+jiraissues+OR+comment+%7E+jiraissues%29+AND+tempMax=10|columns=type;key;summary|title=My List of Issues}
```

JUnit Report Macro

The JUnit Report macro displays a summary of JUnit test results from a directory accessible by the Confluence server. JUnit is a unit testing framework which allows programmers to ensure that individual units of Java source code are functioning correctly.

For security reasons JUnit test result files can only be imported from a specified location in the Confluence server's file system. We recommend administrators create a folder in their Confluence home directory, add the system property `confluence.junit.report.directory` and specify the location for JUnit test result files to be imported from. JUnit Test result files cannot be imported from the server until this system property is set.

The JUnit Report macro appears as shown in the screenshot below.

**Screenshot: The JUnit Report macro in Confluence**

<table>
<thead>
<tr>
<th>Test</th>
<th>Time</th>
<th>Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>MoneyTest</td>
<td>100%</td>
<td>00:03:391</td>
</tr>
<tr>
<td>testAdd</td>
<td></td>
<td>00:03:0</td>
</tr>
</tbody>
</table>
Note: When generating reports from the JUnit Report macro, set the Apache Ant formatter to ‘XML’.

Using the JUnit Report macro

To add the JUnit Report macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL of the test result XML file (url)</td>
<td>Must</td>
<td>None</td>
<td>URL of a particular test result XML file. Is overridden by the Directory of your test result files parameter if you use both. Example, from a Confluence instance: <a href="http://yourConfluence.com/download/attachments/">http://yourConfluence.com/download/attachments/</a>&lt;page id&gt;/file.xml For Confluence installations without anonymous user access, you can specify login credentials as part of this parameter in the form of URL parameters: • os_username — The username of a Confluence user with permission to access the JUnit test results. • os_password — The password of the Confluence user specified in the os_username parameter.</td>
</tr>
<tr>
<td>Directory (URL) of your test result files (directory)</td>
<td>Must</td>
<td>None</td>
<td>URL of a directory containing your test result files. This must be a directory and not the XML file itself. Overrides the URL of the test result XML parameter if you use both. Example, file:///C:/TEMP/ Example, for a network drive: http://<em>host</em>/<em>path</em></td>
</tr>
<tr>
<td>Report Detail (reportdetail)</td>
<td>No</td>
<td>all</td>
<td>Detail for the report. Can be all, fixture, summary or failuresonly.</td>
</tr>
<tr>
<td>Debug (debug)</td>
<td>No</td>
<td>None</td>
<td>Shows the content of failures, as well as the error messages.</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: junitreport

Macro body: None.

Storage format example
Wiki markup examples

Loading JUnit reports from a local drive:

```
{junitreport:directory=file:///C:/TEMP/}
```

Loading JUnit reports from a network drive:

```
{junitreport:url=http://*host*/*path*}
```

Loading JUnit reports from a Confluence site:

```
{junitreport:url=http://yourConfluenceInstance.com/download/attachments/<page id>/file.xml}
```

Loading JUnit reports from a Confluence site that requires authentication:

If your Confluence site is not accessible by anonymous users, specify login credentials with the `os_username` and `os_password` URL parameters (as part of the macro's `url` parameter). In this case, we are specifying a username of 'admin' and a password of 'secret'.

```
{junitreport:url=http://yourConfluenceInstance.com/download/attachments/<page id>/file.xml?os_username=admin&os_password=secret}
```

Labels List Macro

The Labels List macro displays a list of all labels within the current space. Each label in the list links to a page that displays all pages in the current space that contain that label.

Using the Labels List macro

To add the Labels List macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.
Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrict to this Space Key (spaceKey)</td>
<td>No</td>
<td>Current space</td>
<td>The key of the space whose labels you want to display.</td>
</tr>
<tr>
<td>Excluded label(s) (excludedLabels)</td>
<td>No</td>
<td>Blank</td>
<td>The labels that you do not want to appear in the list.</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** listlabels

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="listlabels">
  <ac:parameter ac:name="spaceKey">
    <ri:space ri:space-key="DOC"/>
  </ac:parameter>
  <ac:parameter ac:name="excludedLabels">not-this-label</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
{listlabels:spaceKey=DOC}
```

Livesearch Macro

The Livesearch macro allows you to add a search box to a Confluence page. When users enter a search term into the search box, Confluence will dynamically display matching results as they type.

Using the Livesearch macro

**To add the Livesearch macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrict to this Space Key (spaceKey)</td>
<td>all spaces</td>
<td>Specify a space key to limit the search to the given space. Case-sensitive.</td>
</tr>
<tr>
<td>Restrict to label(s) (labels)</td>
<td></td>
<td>Specify labels to limit the search to content with that label. If unspecified will search all content regardless of label.</td>
</tr>
<tr>
<td>Size (size)</td>
<td>medium</td>
<td>Choose a medium or large search field size.</td>
</tr>
<tr>
<td>Placeholder text (placeholder)</td>
<td></td>
<td>Specify the placeholder text to appear in the search field, for example 'Search this space'</td>
</tr>
<tr>
<td>Type (type)</td>
<td>all</td>
<td>Specify the content types to be included in the search - choose from pages, blogs, comments, space descriptions, or all content types.</td>
</tr>
<tr>
<td>Additional (additional)</td>
<td>space name</td>
<td>Display the space name, a page excerpt or nothing under the search result.</td>
</tr>
</tbody>
</table>

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** livesearch

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="livesearch">
    <ac:parameter ac:name="additional">page excerpt</ac:parameter>
    <ac:parameter ac:name="placeholder">Search this space</ac:parameter>
    <ac:parameter ac:name="labels">myLabel</ac:parameter>
    <ac:parameter ac:name="spaceKey">
        <ri:space ri:space-key="SS"/>
    </ac:parameter>
    <ac:parameter ac:name="type">page</ac:parameter>
    <ac:parameter ac:name="size">large</ac:parameter>
</ac:structured-macro>
```

**Wikimarkup example**

```wikimarkup
{livesearch:spaceKey=DOC|size=large|placeholder=Search this space}
```

**Loremipsum Macro**

The Loremipsum macro displays paragraphs of pseudo-Latin text ([more information](https://confluence.atlassian.com/pages/overview/livesearch.html)). You can use this macro to generate more-or-less meaningless text for demonstration purposes in pages showing a draft layout or arrangement of page elements. The text is deliberately non-meaningful so that it does not influence the viewer's perception of the page arrangement or design.

A basic example of the Loremipsum text:

Using the Loremipsum macro

To add the Loremipsum macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Paragraphs</td>
<td>3</td>
<td>Determines the amount of pseudo-Latin (space-filler) text to display.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The macro will display a maximum number of 30 paragraphs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter is unnamed in storage format and wikimarkup.</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: loremipsum

Macro body: None.

Storage format example

```xml
<ac:structured-macro ac:name="loremipsum">
  <ac:parameter ac:name="">2</ac:parameter>
</ac:structured-macro>
```

Wikimarkup example

```wikimarkup
(loremipsum:2)
```

Multimedia Macro

Displays videos, animations and more, sourced from a file attached to a Confluence page and displayed on your page. See Embedding Multimedia Content for more information.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.
Macro name: multimedia

Macro body: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>page</td>
<td>No</td>
<td>Current page</td>
<td>Name of the page to which the multimedia file is attached.</td>
</tr>
<tr>
<td>space</td>
<td>No</td>
<td>Current space</td>
<td>Space key of the page that has the multimedia file attached.</td>
</tr>
<tr>
<td>name</td>
<td>Yes</td>
<td>None</td>
<td>File name of the multimedia file, which is attached to a Confluence page.</td>
</tr>
<tr>
<td>width</td>
<td>No</td>
<td>If not specified, the browser will determine the width based on the file type.</td>
<td>Width of the movie window to be displayed on the page. By default, this value is specified in pixels. You can also choose to specify a percentage of the window's width, or any other value accepted by HTML.</td>
</tr>
<tr>
<td>height</td>
<td>No</td>
<td>If not specified, the browser will determine the height based on the file type.</td>
<td>Height of the movie window to be displayed on the page. By default, this value is specified in pixels. You can also choose to specify a percentage of the window's height, or any other value accepted by HTML.</td>
</tr>
<tr>
<td>autostart</td>
<td>No</td>
<td>false</td>
<td>If the parameter is set to true then the video or audio file will start playing as soon as the page is loaded. If this option is set to false then the file will not play until the user clicks the icon or image on the page.</td>
</tr>
</tbody>
</table>

Storage format example

```xml
<ac:structured-macro ac:name="multimedia">
  <ac:parameter ac:name="width">500</ac:parameter>
  <ac:parameter ac:name="name">
    <ri:attachment ri:filename="Ninjas.MOV"/>
  </ac:parameter>
</ac:structured-macro>
```

Wikimarkup example

```
{multimedia:space=DOC|page=My macros|name=ninjas.swf|autostart=true}
```

Navigation Map Macro

The Navigation Map macro displays a navigable map of the pages tagged with a given label.

Using the Navigation Map Macro

To add the Navigation Map macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>none</td>
<td>Specify the label associated with the pages you want to show in the navigation map.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This parameter is unnamed in storage format and wikimarkup.</td>
</tr>
<tr>
<td>Map Title (title)</td>
<td>none</td>
<td>Specify a title for the navigation map.</td>
</tr>
<tr>
<td>Number of Cells Per Row (wrapAfter)</td>
<td>5</td>
<td>Specify the number of cells in a row</td>
</tr>
<tr>
<td>Cell Width (Pixels) (cellWidth)</td>
<td>90 px</td>
<td>Specify the cell width</td>
</tr>
<tr>
<td>Cell Height (Pixels) (cellHeight)</td>
<td>60 px</td>
<td>Specify the cell height</td>
</tr>
<tr>
<td>Navigation Map Theme (theme)</td>
<td>Confluence</td>
<td>Define a theme for the navmap.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you want to create your own navmap 'look and feel' (for example, one with rounded corners), you need to add a customised navmap macro theme file to the WEB-INF/classes/templates/macros directory. The file name convention to use is navmap-mytheme.vm. Use the name of your choice for the mytheme part of the file name, which is also the value you use for this parameter. Hence, if your theme was called navmap-roundededges.vm, use the value of roundededges for this parameter.</td>
</tr>
</tbody>
</table>

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name: navmap**

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="navmap">
  <ac:parameter ac:name="wrapAfter">4</ac:parameter>
  <ac:parameter ac:name="title">My map name</ac:parameter>
  <ac:parameter ac:name="cellHeight">50px</ac:parameter>
  <ac:parameter ac:name="theme">navmap-mytheme.vm</ac:parameter>
  <ac:parameter ac:name="cellWidth">80px</ac:parameter>
  <ac:parameter ac:name="">mylabel</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```xml

```
Network Macro

The Network macro displays a list of network activity on a Confluence page or blog post. You can specify the user whose network activity you wish to show. These interactions include the users that the specified user is following or users who are following the specified user. The Network macro shows each listed user by their profile picture. It also provides a choice of two themes and the ability to limit the number of users in the list.

Screenshot: Network macro

Using the Network macro

To add the Network macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Current user’s username</td>
<td>The username of the Confluence user whose network interactions you wish to show. If no username is specified, then current user's (that is, your) network interactions are shown.</td>
</tr>
</tbody>
</table>
| Mode      | following | Determines which users are listed, with respect to the specified user:  

- following – those who the user is following.  
- followers – those who are following the user.  

This parameter is unnamed in storage format and wikimarkup. |
| Theme     | full | Determines how the user's network is displayed:  

- full – shows a large version of user's profile pictures and, if the following mode is set, provides an entry field function to follow more users.  
- tiny – shows only the small version of user's profile pictures. |

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Maximum Results (max)

No limit imposed up to a maximum of 30

Restricts the number of users displayed. If the number of users exceeds the specified maximum, then a **Show All** link is provided. This link leads to the specified user's Network view, showing the complete list of network interactions.

Disabling the Network macro

The Network macro is provided by the 'network' module in the 'Profile Macros' plugin. To remove the macro from your site, you can disable the module in the plugin. See [Disabling and enabling add-ons](#).

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** network

**Macro body:** None.

**Storage format example**

```html
<ac:structured-macro ac:name="network">
  <ac:parameter ac:name="username">
    <ri:user ri:userkey="12345678912345678912345"/>
  </ac:parameter>
  <ac:parameter ac:name="max">10</ac:parameter>
  <ac:parameter ac:name="theme">full</ac:parameter>
  <ac:parameter ac:name="">followers</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
{network:followers|username=admin|max=10|theme=full}
```

Noformat Macro

The Noformat macro displays a block of text in monospace font with no other formatting.

**Using the Noformat Macro**

**To add the Noformat macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:**  Type `|` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

Enter the content that is to be unformatted into the body of the macro placeholder.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (**example**).
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Panel (nopanel)</td>
<td>False</td>
<td>Removes the panel around the content.</td>
</tr>
</tbody>
</table>

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** noformat

**Macro body:** Accepts plain text.

**Storage format example**

```xml
<ac:structured-macro ac:name="noformat">
  <ac:parameter ac:name="nopanel">true</ac:parameter>
  <ac:plain-text-body><![CDATA[http://www.example.com]]></ac:plain-text-body>
</ac:structured-macro>
```

**Wiki markup example**

```
{noformat:nopanel=true}http://www.example.com{noformat}
```

**Note Macro**

The Note macro displays a block of text in a yellow highlighted box. This is useful for emphasising important information.

**Example:**

![My note](http://www.example.com)

**Using the Note Macro**

**To add the Note macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Add the text of the note to the body of the macro placeholder.**

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
Optional Title
(title)
none
If specified, the title is displayed in bold next to the icon.

Show Exclamation Mark Icon
(icon)
true
- true – displays the warning icon
- false – the icon is not displayed

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: note

Macro body: Accepts rich text.

Storage format example

```xml
<ac:structured-macro ac:name="note">
  <ac:parameter ac:name="icon">false</ac:parameter>
  <ac:parameter ac:name="title">My title</ac:parameter>
  <ac:rich-text-body>
    <p>This is the content of my note.</p>
  </ac:rich-text-body>
</ac:structured-macro>
```

Wiki markup example

```wiki
{note:icon=false|title=My title}
This is the content of my note.
{note}
```

Office Excel Macro

The Office Excel macro displays the content of an Excel spreadsheet on a wiki page. First attach the spreadsheet to a Confluence page, then use the macro to display the content. When viewing the page, people will see the content of the spreadsheet, without needing to have Office installed.

For details, see the View File Macro.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: viewxls

Macro body: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Yes</td>
<td>(None.)</td>
<td>The file name of the Excel spreadsheet to be displayed. The document must be attached to a page on your Confluence site.</td>
</tr>
<tr>
<td>page</td>
<td>No</td>
<td>The page containing the macro</td>
<td>The name of a Confluence page to which the Excel spreadsheet is attached.</td>
</tr>
<tr>
<td>col</td>
<td>No</td>
<td>Last column with content</td>
<td>The number of the last column you want displayed, starting from '0' as the first column.</td>
</tr>
<tr>
<td>-------------</td>
<td>----</td>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>

**Hint for reducing the size of the spreadsheet:** Use the col and row parameters to reduce the size of the spreadsheet displayed on the wiki page. This is especially useful to prevent the display from showing empty cells. This will also help to prevent 'out of memory' errors.

<table>
<thead>
<tr>
<th>row</th>
<th>No</th>
<th>Last row with content</th>
<th>The number of the last row you want displayed, starting from '0' as the first row.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>grid</th>
<th>No</th>
<th>true</th>
<th>Determines whether the macro will show borders around the cells in the spreadsheet.</th>
</tr>
</thead>
</table>

Accepted values:
- true – Shows borders.
- false – Does not show borders.

<table>
<thead>
<tr>
<th>sheet</th>
<th>No</th>
<th>The most-recently viewed worksheet</th>
<th>The name of the worksheet that you want displayed.</th>
</tr>
</thead>
</table>

**Storage format example**

```xml
<ac:structured-macro ac:name="viewxls">
    <ac:parameter ac:name="col">E</ac:parameter>
    <ac:parameter ac:name="name">
        <ri:attachment ri:filename="Spreadsheet.xls"/>
    </ac:parameter>
    <ac:parameter ac:name="sheet">Sheet1</ac:parameter>
    <ac:parameter ac:name="row">5</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
{viewxls:col=5|row=5|page=Docs|name=My document.xls|grid=false|sheet=mysheet}
```

**Office PowerPoint Macro**

The Office PowerPoint macro displays the content of a PowerPoint presentation on a wiki page. First attach the presentation to a Confluence page, then use the macro to display the content. When viewing the page, people will see the content of the presentation, without needing to have Office installed.

For details, see the View File Macro.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** viewppt

**Macro body:** None.
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Yes</td>
<td>(None.)</td>
<td>The file name of the PowerPoint presentation to be displayed. The document must be attached to a page on your Confluence site.</td>
</tr>
<tr>
<td>page</td>
<td>No</td>
<td>The page containing the macro</td>
<td>The name of a Confluence page to which the PowerPoint presentation is attached.</td>
</tr>
<tr>
<td>height</td>
<td>No</td>
<td></td>
<td>The height of the macro display, specified in pixels (for example: 10 px, or just 10) or as a percentage (for example: 20%) of the window's height.</td>
</tr>
<tr>
<td>width</td>
<td>No</td>
<td></td>
<td>The width of the macro display, specified in pixels (for example: 10 px, or just 10) or as a percentage (for example: 20%) of the window's height.</td>
</tr>
<tr>
<td>slide</td>
<td>No</td>
<td>All slides, starting with the first, as a slide show</td>
<td>The number of the slide that you want displayed on the Confluence page, where the first slide is numbered zero. Instead of a slide show, the page will display just the single slide, represented as a JPEG image.</td>
</tr>
</tbody>
</table>

Storage format example

```xml
<ac:structured-macro ac:name="viewppt">
  <ac:parameter ac:name="height">250</ac:parameter>
  <ac:parameter ac:name="width">250</ac:parameter>
  <ac:parameter ac:name="name">
    <ri:attachment ri:filename="101_samplepresentation.pptx"/>
  </ac:parameter>
</ac:structured-macro>
```

Wiki markup example

```
{viewppt:height=20%|page=Docs|width=20%|name=My document.ppt|slide=4}
```

Office Word Macro

The Office Word macro displays the content of a Word document on a wiki page. First attach the document to a Confluence page, then use the macro to display the content. When viewing the page, people will see the content of the document, without needing to have Office installed.

For details, see the View File Macro.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** viewdoc

**Macro body:** None.
<table>
<thead>
<tr>
<th>name</th>
<th>Yes</th>
<th>(None.)</th>
<th>The file name of the Word document to be displayed. The document must be attached to a page on your Confluence site.</th>
</tr>
</thead>
<tbody>
<tr>
<td>page</td>
<td>No</td>
<td>The page containing the macro</td>
<td>The name of a Confluence page to which the Word document is attached.</td>
</tr>
</tbody>
</table>

Storage format example

```xml
<ac:structured-macro ac:name="viewdoc">
  <ac:parameter ac:name="name">
    <ri:attachment ri:filename="Chocolate.doc"/>
  </ac:parameter>
</ac:structured-macro>
```

Wiki markup example

```
{viewdoc:page=Docs|name=My document.doc}
```

Page Index Macro

The Page Index macro creates a hyperlinked alphabetical index of all page titles within the current space.

The top section of the index contains a cell for each letter of the alphabet, with cells for numbers and symbols. Each cell indicates how many pages are in the corresponding list.

The lower section contains lists of page titles followed by the first few sentences of content on that page.

Each letter, number or symbol in the top section is hyperlinked to the corresponding cell in the lower section. Each page title in the lower section is hyperlinked to the page in the space.

Screenshot: Page Index macro (partial view)

![Space Index](image)

**Space Index**

<table>
<thead>
<tr>
<th>0-9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

- A
  - 25 reasons people like Confluence
    - Integration with JIRA Great product Its a wiki User experience design
- B
  - Blog Ideas
    - Do users need to be told left side / right side of screen Macros and what you can do with them
- C
  - Confluence hints and tips
    - What hints and tips do you share with other Confluence users?
- D
- E
- F
- G
  - Games as a communication medium
    - Can we use games as a communication medium?
Using the Page Index macro

To add the Page Index macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

This macro accepts no parameters.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: index

Macro body: None.

Parameters: None.

Storage format example

```xml
<ac:structured-macro ac:name="index"/>
```

Wiki markup example

```
(index)
```

Page Properties Macro

The Page Properties and Page Properties Report macro work together to enable you to show summary information from one page on another page. You can see examples of these two macros in action in the Decisions Blueprint and Product Requirements blueprints.

This macro was previously known as the Metadata Details macro.

Adding the Page Properties macro to a page

The Page Properties macro uses key value pairs. The body of the macro must be set up correctly for your information to appear in the Page Properties Report.

To add the Page Properties macro to a page:

1. In the editor, choose Insert > Other Macros > Page Properties.
2. In the macro body create a two column table and remove the header row.
3. In the left column list your 'keys' - these will be the column headings in your report table.
4. In the right column list the value for each key - these will populate the rows in your report table.
5. Add a label to your page - you will need to specify this label in the page properties report macro.
6. Save your page.
Don't forget to add a label to your page, or your page will not appear in the Page Properties Report macro.

Next you need to add the **Page Properties Report macro** to another page.

*Screenshot: Page Properties macro in the editor. Deadline, Current Status and Team will be column headings in the report.*

*Screenshot: The example above as it appears in the Page Properties Report*
Using multiple Page Properties macros on one page

You can add multiple Page Properties macros on a single page, and choose whether to include all or only specific macros in the report. You might use multiple macros because you want the information in the macro to display in context with the rest of the page, or because you want to be able to report on individual Page Properties macros separately.

The Page Properties macro includes an optional ID parameter that can be used to identify specific Page Properties macros.

To show the contents of all Page Properties macros in the report:

- Add a label to the page containing the Page Properties macros.
- Specify this label in the Page Properties Report macro.

To show the contents of selected Page Properties macros in the report:

- Add a label to the page containing the Page Properties macros.
- Specify an ID in the Page Properties macro that you want to report on.
- Specify both the label and ID in the Page Properties Report macro.

**Note:** The Page Properties Report macro can only accept one page label, and one ID.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Properties ID</td>
<td>(None)</td>
<td>Optional ID used to identify a particular Page Properties macro on a page. Specify this ID in the Page Properties Report to include summary information from macros with this ID only.</td>
</tr>
<tr>
<td>Hidden</td>
<td>False</td>
<td>Determines whether the data in the Page Properties macro will be displayed on the current page. This setting does not affect the display of the detail in the Page Properties Report macro.</td>
</tr>
</tbody>
</table>

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** `details`

**Macro body:** Accepts rich text.

Storage format example

The following example contains two pieces of data - Owner and Date.
<ac:structured-macro ac:name="details">
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <td>Owner</td>
          <td>Rach Admin</td>
        </tr>
        <tr>
          <td>Date</td>
          <td>1 May</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:structured-macro>

Notes

- You cannot use text formatting or macros in the left column as the data in this column is used to populate the column headings in your Page Properties Report macro.
- If your table has a header row, this row will be ignored by the Page Properties Report macro. You should remove the header row.
- It is not possible to reference the metadata using the metadata key from within the page, or anywhere else on a Confluence page.

Page Properties Report Macro

The Page Properties and Page Properties Report macro work together to enable you to show summary information from one page on another page. You can see examples of these two macros in action on the Decision and Product Requirements blueprints.

This macro was previously known as the Details Summary macro.

Adding the Page Properties Report macro to a page

To add the Page Properties Report macro to a page:

1. In the editor, choose Insert > Other Macros > Page Properties Report.
2. Enter the Label you want to report on - this is the label added to pages containing the Page Properties macro.
3. Restrict the report by ID, space or specify column headings or sort order - see the Parameters table below for more details.
4. Choose Insert.

Note: If your report is empty, check:

- You have specified the label correctly and the label appears on pages containing the Page Properties macros.
• The Page Properties macros on each page are configured correctly.

Screenshot: Page Properties Report

Reporting on specific Page Properties macros

You can add multiple Page Properties macros on a page, and choose whether to include all or only specific macros in the report. The Page Properties macro includes an optional ID parameter that can be used to identify specific Page Properties macros.

To show the contents of:

- **All Page Properties macros** in the report - specify just the label for the page.
- **Selected Page Properties macros** in the report - specify both the label for the page and the ID of the particular Page Properties macro.

**Note:** The Page Properties Report macro can only accept one page label, and one ID.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>(None)</td>
<td>Identifies the label to be used in the Page Properties Report. The report will show data from all pages in the current space containing a Page Properties macro with the same label.</td>
</tr>
<tr>
<td>Page Properties ID</td>
<td>(None)</td>
<td>If not specified, the report will show data from all Page Properties macros on a page, where there are multiple macros. Specify an ID to include only data from Page Properties macros with the same ID.</td>
</tr>
<tr>
<td>Restrict to spaces</td>
<td>(None)</td>
<td>If not specified, the report will only show data from the current space. You can specify a comma separated list of space keys, or use @all to show data from all spaces.</td>
</tr>
<tr>
<td>Title column heading</td>
<td>Title</td>
<td>The heading to display on the first column in the report table. This column contains links to pages displayed by the report. The default column heading is 'Title'.</td>
</tr>
<tr>
<td>Columns to show</td>
<td>(None)</td>
<td>If not specified, the report will show all columns. You can specify a comma separated list of columns to include. If your column heading includes commas, use double quotes around the column name. If your column heading includes quotes, use double quotes. For example, A column, &quot;My &quot;new&quot; column, yes&quot;, Third column</td>
</tr>
</tbody>
</table>
### Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** detailssummary

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="detailssummary">
  <ac:parameter ac:name="id">status-dev</ac:parameter>
  <ac:parameter ac:name="sortBy">Created</ac:parameter>
  <ac:parameter ac:name="label">status</ac:parameter>
</ac:structured-macro>
```

### Page Tree Macro

The Page Tree macro displays a dynamic, hierarchical list of pages starting from a specified parent (root) page. It can act as a table of contents or a list of related topics. When viewing the page tree, your reader can click a link to view the relevant page. The page's current position is highlighted in the page tree.

**Note:** The Page Tree macro is used in the Confluence Documentation theme, to create a navigation panel showing a table of contents for your space. Read the instructions on Configuring the Documentation Theme.

**Using the Page Tree Macro**

**To add the Page Tree macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

Click **Refresh** in the Macro Browser to see the effect of changes to the macro parameters.

**Macro Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Root Page (root)                  | The home page of the space | Specify the parent page for the page tree. The tree will include all children of the given page, plus their children and grand-children etc. The tree will not include the root page itself. Specify the page title or a special value as follows:  
  - Your page title — to specify a page name for the parent or root of the tree. The tree will include all children and grand-children of the specified root. The tree will not include the specified root page itself.  
  - '@home' — will include all pages under the home page of the space (default).  
  - '@self' — will include all pages under the current page.  
  - '@parent' — will include all pages under the parent of the current page, including the current page.  
  - '@none' — will include all pages in the space, including orphaned pages and the home page. |
| Sort Pages By (sort)              | position | Specify the order to display the pages in the tree. This sort order is for display purposes only. It does not permanently re-arrange the page order. The value may be one of the following:  
  - bitwise — sort alphabetically, for example: title1, title10, title2.  
  - creation — sort by date of creation.  
  - modified — sort by order of date last modified.  
  - natural — sort in 'natural' alphabetical order, for example: title1, title2, title10.  
  - position — sort by the default Confluence sorting rules. If your pages have been ordered manually, this sort will respect the defined order. Otherwise the pages will be displayed in the 'natural' alphabetical order, such as: title1, title2, title10. |
| Include Excerpts in Page Tree (excerpt) | false | Select if you want the page tree to show excerpts from each page. The excerpts must be defined on each page by the Excerpt macro. |
| Reverse Order (reverse)           | false | Select to show the pages in reverse (descending) natural order. Must be used in combination with the Sort Pages By parameter. |
| Include Search Box above Page Tree (searchBox) | false | Select if you want to include a search box above the page tree. The search box allows your readers to search within the page tree for the specified value. |
| Show Expand/Collapse Links (expandCollapseAll) | false | Select if you want to display the 'expand all' and 'collapse all' links at the top of your page tree. Your readers can click these links to open or close all branches of the tree at once.  
Available values in wikimarkup and storage format:  
  - true — Show the 'expand all' and 'collapse all' options.  
  - false — Do not show the options. |
| Start Depth (startDepth)          | 1       | Enter any number greater than 0 to set how many levels of children the tree should show when it opens for the first time. |

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name**: pagetree

**Macro body**: None.
Storage format example

```xml
<ac:structured-macro ac:name="pagetree">
  <ac:parameter ac:name="reverse">false</ac:parameter>
  <ac:parameter ac:name="sort">natural</ac:parameter>
  <ac:parameter ac:name="root">
    <ac:link>
      <ri:page ri:content-title="Page Name"/>
    </ac:link>
  </ac:parameter>
  <ac:parameter ac:name="startDepth">3</ac:parameter>
  <ac:parameter ac:name="excerpt">true</ac:parameter>
  <ac:parameter ac:name="searchBox">true</ac:parameter>
  <ac:parameter ac:name="expandCollapseAll">true</ac:parameter>
</ac:structured-macro>
```

Wiki markup example

```wiki
{pagetree:root=Page Name|sort=natural|excerpt=true|reverse=false|startDepth=3|expandCollapseAll=true|searchBox=true}
```

Sample Page Tree

This page is a sample, used to demonstrate the Pagetree macro.

For more information, take a look at the main page on the [Page Tree Macro](#).

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>`{pagetree:root=@parent</td>
<td>expandCollapseAll=false}`</td>
</tr>
</tbody>
</table>

Another Sample Page Tree

We’re using this page to demonstrate the Pagetree macro.

For more information, take a look at the main page on the [Page Tree Macro](#).

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>`{pagetree:root=@parent</td>
<td>expandCollapseAll=true}`</td>
</tr>
</tbody>
</table>

Sample Page Tree 2

This is another sample page, used to demonstrate the Pagetree macro.

For more information, take a look at the main page on the [Page Tree Macro](#).

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>`{pagetree:root=@parent</td>
<td>expandCollapseAll=true}`</td>
</tr>
</tbody>
</table>

Page Tree Search Macro

Using the Page Tree Search macro, you can add a search box to your Confluence page. When a viewer enters a search term, Confluence will search a hierarchy of pages starting from a specified parent (root) page and return the search results.

You can also add a search box as part of a dynamic page tree, which looks like a table of contents. See the [Page Tree macro](#).
Using the Page Tree Search macro

To add the Page Tree Search macro to a page:
1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters
Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of Root Page</td>
<td>none</td>
<td>The name of the root page whose hierarchy of pages will be searched by this macro. If this not specified, the root page is the current page.</td>
</tr>
<tr>
<td>(root)</td>
<td></td>
<td>Note: Unlike the Page Tree macro, the Page Tree Search macro does not accept the special values that start with an @ sign, such as @home or @self.</td>
</tr>
</tbody>
</table>

Code examples
The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: pagetreesearch

Macro body: None.
Storage format example

```xml
<ac:structured-macro ac:name="pagetreesearch">
  <ac:parameter ac:name="root">My page name</ac:parameter>
</ac:structured-macro>
```

Wikimarkup example

```
{pagetreesearch:root=My page name}
```

Panel Macro

The Panel macro displays a block of text within a customisable panel, like a text box.

Handy hint: You can use panels within columns, in table cells and in the sections defined by page layouts.

Here is an example of a Panel macro:

```
<table>
<thead>
<tr>
<th>My Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>A formatted panel.</td>
</tr>
</tbody>
</table>
```

Using the Panel macro

To add the Panel macro to a page:
1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.
Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Title (title)</td>
<td>none</td>
<td>The title of the panel. If specified, this title will be displayed in its own title row.</td>
</tr>
<tr>
<td>Border Style (borderStyle)</td>
<td>solid</td>
<td>The style of the panel's border. Accepted values are solid, dashed and other valid CSS border styles.</td>
</tr>
<tr>
<td>Border Colour (borderColor)</td>
<td></td>
<td>The colour of the panel's border. Colours can be specified as HTML colour names or hexadecimal codes.</td>
</tr>
<tr>
<td>Border Pixel Width (Value Only) (borderWidth)</td>
<td></td>
<td>The width of the panel's border (in pixels).</td>
</tr>
<tr>
<td>Background Colour (bgColor)</td>
<td></td>
<td>The background colour of the panel. Colours can be specified as HTML colour names or hexadecimal codes.</td>
</tr>
<tr>
<td>Title Background Colour (titleBGCColor)</td>
<td></td>
<td>The background colour of the title row of the panel. Colours can be specified as HTML colour names or hexadecimal codes.</td>
</tr>
<tr>
<td>Title Text Colour (titleColor)</td>
<td></td>
<td>The colour of the text in the title row of the panel. Colours can be specified as HTML colour names or hexadecimal codes.</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: panel

Macro body: Accepts rich text.

Storage format example

```xml
<ac:structured-macro ac:name="panel">
   <ac:parameter ac:name="bgColor">#72bc72</ac:parameter>
   <ac:parameter ac:name="titleBGCColor">#00a400</ac:parameter>
   <ac:parameter ac:name="title">My title</ac:parameter>
   <ac:parameter ac:name="borderStyle">dashed</ac:parameter>
   <ac:parameter ac:name="borderColor">blue</ac:parameter>
   <ac:parameter ac:name="titleColor">white</ac:parameter>
   <ac:rich-text-body>
      <p>A formatted panel</p>
   </ac:rich-text-body>
</ac:structured-macro>
```

Wiki markup example
PDF Macro

The PDF macro displays the content of a PDF document on a page. First attach the document to a Confluence page, then use the macro to display the document.

For details, see the View File Macro.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** viewpdf

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Yes</td>
<td>(None.)</td>
<td>The file name of the PDF document to be displayed. The document must be attached to a page on your Confluence site.</td>
</tr>
<tr>
<td>page</td>
<td>No</td>
<td>The page containing the macro</td>
<td>The name of a Confluence page to which the PDF document is attached.</td>
</tr>
</tbody>
</table>

Storage format example

```
<ac:structured-macro ac:name="viewpdf">
  <ac:parameter ac:name="name">
    <ri:attachment ri:filename="My_document.pdf"/>
  </ac:parameter>
</ac:structured-macro>
```

Wiki markup example

```
{viewpdf:page=Docs|name=My_document.pdf}
```

Popular Labels Macro

The Popular Labels macro displays the most popular labels used throughout your Confluence site or within a space. A popular label is a label that has been added to many pages.

Using the Popular Labels Macro

To add the Popular Labels macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.
Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Labels to Display (count)</td>
<td>100</td>
<td>Specifies the total number of labels to display in the heatmap.</td>
</tr>
<tr>
<td>Restrict Labels to this Space Key (spaceKey)</td>
<td>none</td>
<td>Restricts the list of popular labels to the specified space.</td>
</tr>
</tbody>
</table>
| Style of Labels (style)                       | list    | • list – displays the popular labels as a bulleted list, ordered by popularity (highest first).
|                                              |         | • heatmap – displays the popular labels using different font sizes for each label depending on the label's popularity, ordered by label names. |

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: popular-labels

Macro body: None.

Storage format example

```xml
<ac:structured-macro ac:name="popular-labels">
    <ac:parameter ac:name="count">20</ac:parameter>
    <ac:parameter ac:name="spaceKey">
        <ri:space ri:space-key="ds"/>
    </ac:parameter>
</ac:structured-macro>
```

Wikimarkup example

```
{popular-labels:style=heatmap|count=20|spaceKey=ds}
```

Profile Picture Macro

The Profile Picture macro displays a user's profile picture on a page.

- When viewing the page, mouse-over the picture to see the Hover Profile for the user.
- When editing the page, click on the picture and choose View User Profile to see the profile for the user.
The Profile Picture macro is useful for such tasks as creating Team Pages that show all members of a project team.

Using the Profile Picture Macro

**To add the Profile Picture macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>none</td>
<td>The username, or real name, of a Confluence user.</td>
</tr>
</tbody>
</table>

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** profile-picture

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="profile-picture">
  <ac:parameter ac:name="User">
    <ri:user ri:userkey="12345678912345678912345"/>
  </ac:parameter>
</ac:structured-macro>
```

**Wiki markup**

Wiki markup is not available for this macro. You cannot add this macro via wiki markup.

Recently Updated Dashboard Macro

The Recently Updated Dashboard macro displays a list of the most recently changed content within Confluence. It is similar to the Recently Updated macro but is intended for use on the Confluence dashboard.

**Using the Recently Updated Dashboard macro**

**To add the Recently Updated Dashboard macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.
**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Space(s)</strong> (spaces)</td>
<td>The space which contains the page on which the macro is added</td>
<td>Filter content by space. The macro will display only the pages etc which belong to the space(s) you specify here. You can specify one or more space keys, separated by commas. &quot;*&quot; means all spaces.</td>
</tr>
<tr>
<td><strong>Include these Content Types Only</strong> (types)</td>
<td>all types</td>
<td>Filter content by type. You can specify one or more types, separated by commas. Available types are: page, blogpost or news, spacedesc, attachment, comment, mail, userinfo.</td>
</tr>
<tr>
<td><strong>Label(s)</strong> (labels)</td>
<td>none</td>
<td>Filter content by label. The macro will display only the pages etc which are tagged with the label(s) you specify here. You can specify one or more labels, separated by commas. Note: If there are no pages matching any of the specified labels, then Confluence will ignore the labels and will list all recently updated pages, as well as showing a message, “These labels don't exist and were ignored: xxx”. This unexpected behaviour is noted in issue <a href="https://jira.atlassian.com/browse/CONF-13860">CONF-13860</a> recently-updated-dashboard macro doesn't return an empty result when no pages match the specified label(s) OPEN</td>
</tr>
<tr>
<td><strong>User(s)</strong> (users)</td>
<td>all users</td>
<td>Filter by username of the user who updated the content. The macro will only display content created and updated by the user(s) you specify here. You can specify one or more usernames separated by commas.</td>
</tr>
<tr>
<td><strong>Width of Table</strong> (width)</td>
<td>100%</td>
<td>Specify the width of the macro display, as a percentage of the window width.</td>
</tr>
<tr>
<td><strong>Show User Profile Pictures</strong> (showProfilePic)</td>
<td>false</td>
<td>Select whether profile pictures of the users who updated the content are displayed.</td>
</tr>
</tbody>
</table>

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** recently-updated-dashboard

**Macro body:** None.

Storage format example
Recently Updated Macro

The Recently Updated macro displays a list of the most recently changed content within Confluence.

Using the Recently Updated Macro

**To add the Recently Updated macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author(s) by username (author)</td>
<td>None specified. That is, display all content</td>
<td>Filter the results by author. The macro will display only the pages etc which were last modified by the author(s) you specify here. You can specify multiple users.</td>
</tr>
</tbody>
</table>
### Space(s)

This parameter allows you to filter content by space. The macro will display only the pages etc which belong to the space(s) you specify here.

You can specify one or more space keys, separated by a comma or a space.

- To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of `-BADSPACE` you will get only content which is not in the BADSPACE.
- To indicate that the results **must** come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of `+GOODSPACE` you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)

**Special values:**
- `@self` — The current space.
- `@personal` — All **personal** spaces.
- `@global` — All **site** spaces.
- `@favorite` — The spaces you have marked as **favourite**.
- `@favourite` — The same as `@favorite` above.
- `@all` — All spaces in your Confluence site.
- `*` — The same as `@all` above.

When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as `~jbloggs` or `~jbloggs@example.com`.

### Label(s)

Filter the results by label. The macro will display only the pages etc which are tagged with the label(s) you specify here.

You can specify one or more label values, separated by a comma or a space.

- To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of `-badpage` you will get only content which is not labelled with 'badpage'.
- To indicate that the results **must** match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of `+superpage,+goodpage` you will get only content which has at least two labels, being 'superpage' and 'goodpage'.

The labels parameter only applies to the **page** and **blog** content types.

### Width of Table

Specify the width of the macro display, as a percentage of the window width.
<table>
<thead>
<tr>
<th><strong>Include these Content Types Only (types)</strong></th>
<th>All types</th>
<th>This parameter allows you to filter content by content type. The macro will display only the content of the type you specify here. You can specify one or more types, separated by a comma or a space. To exclude content of a given content type, put a minus sign (-) immediately in front of that content type. For example: If you specify a content type of -blogpost you will get pages and all other content except for blog posts. Available values:</th>
</tr>
</thead>
</table>
| | | \- page — *Pages.*  
| | | - blogpost or news — *Blog posts*, also known as news items.  
| | | - comment — *Comments* on pages and blog posts.  
| | | - attachment — *Attachments.*  
| | | - status — *Status updates* made by other users. |
| **Maximum Number of Results (max)** | 15 | Specify the maximum number of results to be displayed. If this parameter is omitted, then a maximum of 15 results are displayed. The theoretical maximum value that this parameter can accept is 2 to the power of 31, minus 1 (or 2147483647), though this has been limited to 200 in the code, for performance reasons. More details are [here](#). |
| **theme (theme)** | concise | Choose the appearance of this macro:  
| | | - concise — the default list, showing the names of pages which were updated or commented on, the users who made the page modifications and time when the modifications occurred.  
| | | - social — lists recent modifications in reverse chronological order, but groups them by user into short time segments. A 'sub' list appears within each user's time segment, showing the names of pages which they updated or commented on and time when these modifications occurred.  
| | | - sidebar — lists recent updates in reverse chronological order, showing the names of pages which were updated or commented on and time when the page modifications occurred. This theme does not show authorship. |
| **Show User Profile Pictures (showProfilePic)** | false | Specify `showProfilePic=true` to display the profile pictures of the users who updated the content. |
| **Hide Title (hideHeading)** | False | Determines whether the macro hides or displays the text 'Recently Updated' as a title above the list of content. Only available in wikimarkup and storage format. Accepted values:  
| | | - true — Title is hidden.  
| | | - false — Title is shown. |

**Notes**

- The *Recently Updated Dashboard* macro is similar to this macro, but is intended for display on the Confluence dashboard.  
- If you would like to change the wording displayed by the Recently Updated macro, please refer to the document on modifying the Confluence interface text.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.
**Macro name:** recently-updated

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="recently-updated">
   <ac:parameter ac:name="spaces">
      <ri:space ri:space-key="ss"/>
   </ac:parameter>
   <ac:parameter ac:name="author">
      <ri:user ri:userkey="12345678912345678912345"/>
   </ac:parameter>
   <ac:parameter ac:name="users"/>
   <ac:parameter ac:name="max">10</ac:parameter>
   <ac:parameter ac:name="width">50%</ac:parameter>
   <ac:parameter ac:name="theme">sidebar</ac:parameter>
   <ac:parameter ac:name="labels">choc</ac:parameter>
   <ac:parameter ac:name="types">page</ac:parameter>
</ac:structured-macro>
```

**Wikimarkup example**

```
(recently-updated:spaces=ds|author=admin|max=10|hideHeading=true|width=50%|theme=si
debar|showProfilePic=true|labels=choc|types=page)
```

Recently Used Labels Macro

The Recently Used Labels macro displays a list of the labels that have been most recently added to a page, blog post or attachment. You can define the number of labels to be displayed and the scope (the current space, your personal space or site spaces, also known as 'global' spaces).

**Using the Recently Used Labels macro**

**To add the Recently Used Labels macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters of this macro**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (**example**).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of Labels to Display</strong> (count)</td>
<td>10</td>
<td>Specifies the total number of labels to display in the list.</td>
</tr>
</tbody>
</table>
### Scope for Retrieving Labels (scope)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>global</td>
<td></td>
<td>Specifies the scope of labels to be displayed in the list. Valid values include:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>global</strong> — covers all site spaces (non-personal) in the Confluence installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>space</strong> — the current space.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>personal</strong> — your own personal space.</td>
</tr>
</tbody>
</table>

### List Style (style)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>list</td>
<td></td>
<td>• <strong>list</strong> — displays the list of labels horizontally.</td>
</tr>
<tr>
<td>table</td>
<td></td>
<td>• <strong>table</strong> — includes additional information such as the page to which the label was added and the user who added it.</td>
</tr>
</tbody>
</table>

### Table Title (title)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
<td></td>
<td>Adds a title to the top of the list in table style. Titles are only visible when the List Style parameter has been set to table.</td>
</tr>
</tbody>
</table>

## Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** recently-used-labels

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="recently-used-labels">
  <ac:parameter ac:name="title">My title</ac:parameter>
  <ac:parameter ac:name="scope">space</ac:parameter>
  <ac:parameter ac:name="style">table</ac:parameter>
  <ac:parameter ac:name="count">20</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
(recently-used-labels:title=My title|scope=space|style=table|count=20)
```

## Related Labels Macro

The Related Labels macro lists all labels from every page which has one or more labels in common with the current page.

### Using the Related Labels Macro

**To add the Related Labels macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

### Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Restrict to these Labels (labels) | none | Specify the labels for which you want to view related labels. For example, documentation, my:stuff.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** related-labels

**Macro body:** None.

**Storage format example**

```html
<ac:structured-macro ac:name="related-labels">
  <ac:parameter ac:name="labels">choc,cake</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
{related-labels:labels=choc,cake}
```

RSS Feed Macro

The RSS Feed macro embeds an RSS feed on a page. It can display the contents of external feeds, or of internal feeds generated by Confluence. To display blog posts or to list recently updated pages in a space, use the Feed Builder to create an internal feed, then render it using this macro.

**CAUTION:** Including unknown HTML inside a webpage is dangerous. HTML inside an RSS feed can contain active scripting components. This means that it would be possible for a malicious attacker to present a user of your site with script that their web browser would believe came from you. Such code could be used, for example, to steal a user's authentication cookie and give the attacker their Confluence login password.

The RSS Feed macro may be disabled by your Confluence administrator. Also, your Confluence administrator can define a whitelist of trusted URLs. You will see an error message on the Confluence page, if the included URL is not in the whitelist.

**Using the RSS Feed macro**

**To add the RSS Feed macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
| **RSS Feed URL**  
  *(url)* | none | The URL of the RSS feed link you want to show. |
| **Maximum Number of Entries**  
  *(max)* | 15 | Limit the number of entries displayed. |
| **Show Item Titles Only**  
  *(showTitlesOnly)* | false | Show only the titles of the news items, not the content. |
| **Show Name/Title of RSS Feed**  
  *(titleBar)* | true | Hide the feeds title bar. |

How up to date is the feed?

By default, the RSS Feed macro caches the feed results for 60 minutes before fetching the data again. If you wish to change the default caching, use the Cache macro to define how often the RSS Feed macro fetches the feed updates. You will need to install the Cache plugin onto your Confluence site.

What happens to a page containing a disallowed URL?

Your Confluence Administrator can set up a whitelist of allowed URLs. If this is the case, you may see an error on the pages which contain the RSS Feed macro.

A user can add the RSS Feed macro or the HTML-include macro to a Confluence page. The macro code includes a URL from which the content is drawn. When the page is displayed, Confluence will check the URL against the whitelist. If the URL is not allowed, Confluence will display an error message on the page.

The error message says that Confluence "could not access the content at the URL because it is not from an allowed source" and displays the offending URL. If the person viewing the page is a Confluence Administrator, they will also see a link to the Administration page where they can configure the URL whitelist.

Here is an example of the error message, including the link shown only to Confluence Administrators:

```plaintext
Could not access the content at the URL because it is not from an allowed source.
http://feathers.wordpress.com
Configure whitelist >>
```

Here is an example of the error message, but without the link.

```plaintext
Could not access the content at the URL because it is not from an allowed source.
http://Feathers.wordpress.com
You may contact your site administrator and request that this URL be added to the list of allowed sources.
```

Authentication

Private feeds from external sites

RSS feeds which require authentication cannot be accessed using the RSS Feed macro.

Accessing internal HTTPS feeds

This applies only to Confluence instances which have enabled HTTPS for all content. If your site is fully HTTPS, the RSS Feed macro cannot access internal feeds. To enable the RSS Feed macro to access internal feeds without affecting your HTTPS setup, enable local-only HTTP access:

1. Shut down Confluence.
2. Consult the SSL guide to enable HTTP access to Confluence. You'll want to ensure that you have an HTTP connector and an SSL connector, both commented in. This means that Confluence will be accessible via both HTTP and HTTPS. However, you should not have a redirect port, nor rules in web.xml
to redirect all traffic.

3. Instead of using web.xml to redirect traffic, insert a firewall rule to redirect all HTTP requests not from the Confluence server to the equivalent HTTPS URL. This ensures that users will only be able to access Confluence via HTTPS, as intended. If you have still left HTTP access for attachments enabled (to avoid the IE download bug) you must selectively enable those URLs as well.

4. Modify your Confluence RSS Feed macro feed link to use the HTTP URL, and restart Confluence.

Enabling the RSS Feed macro

The RSS Feed macro is disabled by default.

To enable the RSS Feed macro:

1. Go to < Add-ons.
2. Select System from the drop down and search for the Confluence HTML Macros add-on.
3. Expand the add-on and enable the rss (rss-xhtml) module.

Code examples

Macro name: rss

Macro body: None.

Storage format example

```xml
<ac:structured-macro ac:name="rss">
  <ac:parameter ac:name="max">10</ac:parameter>
  <ac:parameter ac:name="showTitlesOnly">true</ac:parameter>
  <ac:parameter ac:name="url">
    <ri:url ri:value="http://myblog.com/feed"/>
  </ac:parameter>
  <ac:parameter ac:name="titleBar">false</ac:parameter>
</ac:structured-macro>
```

Wikimarkup example

```
{rss:max=10|showTitlesOnly=true|url=http://myblog.com/feed|titleBar=false}
```

Search Results Macro

The Search Results macro searches your Confluence site based on search terms specified in the macro parameters, and displays the results on the wiki page.

Using the Search Results macro

To add the Search Results macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
| **Search Terms**<br>**(query)** | none | The search terms which this macro will use to generate its results. You can refine your search query by using operators such as 'AND' and 'OR'. For example: `my_query1 AND my_query2` For more information, take a look at the documentation on the Confluence search syntax. |
| **Maximum Number of Results**<br>**(maxLimit)** | 10 | Set a limit to the number of search results displayed. |
| **Restrict to this Space Key** | all | Start typing the space name to find the space, or specify the key of the space you want to search in. Note that the key is case sensitive. |
| **Content Type**<br>**(type)** | all | Specify the content type. The content types are: `page`, `comment`, `blogpost`, `attachment`, `userinfo` (the content of user profiles only) and `spacedesc` (the content of space descriptions only). |
| **Last Modified**<br>**(lastModified)** | all | Specify a period of time in weeks, days, hours and/or minutes, to see the content modified within that time frame. These are the values you can use: |
| | | - `w` = weeks |
| | | - `d` = days |
| | | - `h` = hours |
| | | - `m` = minutes |
| | For example: |
| | - `2h 35m` |
| | - `3d 30m` |
| **Restrict to this Username**<br>**(contributor)** | all | Specify the username of a Confluence user, to show only content created or updated by that user. |

**Notes**

**Permissions:** When a user views the page containing the Search Results macro, the search results will show only pages and other content types for which the user has 'View' permission.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** `search`

**Macro body:** None.

Storage format example
Wiki markup example

{\{search:lastModified=3w|query=choc|contributor=admin|maxLimit=10|type=page|spacekey=ds\}]

Section Macro

Used with the Column macro to define columns on a page. See Working with page layouts and columns and sections.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: section

Macro body: Rich text, consisting of one or more Column macros.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>border</td>
<td>No</td>
<td>False</td>
<td>If the value is true, the columns in this section will have a dashed border.</td>
</tr>
</tbody>
</table>

Storage format example

The following example shows a section and column macro together.
Wiki markup example

```
{(section:border=true)
(column:width=100px)
This is the content of *column 1*.
{(column)
This is the content of *column 2*.
{(column)
{(section)
```

Space Attachments Macro

Displays a list of attachments belonging to the current space. See Displaying a List of Attachments for more information on using this and other attachment macros.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name**: space-attachments

**Macro body**: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>
| showFilter     | No       | true    | Determines whether or not the filter panel is shown. If you select this option, people viewing the page will be able to filter the list of attachments by file type (extension) and by label. Accepted values:  
- true – Macro displays the filter panel.  
- false – Macro does not display the filter panel. |
| space          | No       | Current space. | Determines the Confluence space containing the attachments that the macro will display. |

Storage format example
Space Details Macro

The Space Details macro displays the details of a Confluence space, including the space name, description, and more.

Using the Space Details macro

To add the Space Details macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width of Table (width)</td>
<td>100%</td>
<td>The width of the space details table, specified as a percentage (%) of the page width.</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: space-details

Macro body: None.

Storage format example

```
<ac:structured-macro ac:name="space-details">
  <ac:parameter ac:name="width">50%</ac:parameter>
</ac:structured-macro>
```

Wiki markup example

```
{space-details:width=50%}
```
Space Jump Macro

This page describes the Space Jump macro, which is provided with the Documentation theme. You can use space jumping to link from a page in one space to a page with the same name in another space, without knowing the name of the page when you create the link.

⚠️ Advance warning of plans to merge Documentation theme with the default theme
This is an advance notice that we plan to merge the functionality of the Confluence Documentation theme with the Confluence default theme. We do not yet have a specific date for this plan, and we are interested in your feedback. The new default theme, introduced with Confluence 5.0, includes a sidebar with contextual navigation. Our plan is to include features from the Documentation theme in the default theme, and then remove the Documentation theme from Confluence.

If you are interested in this change and would like to give us feedback, please add a comment on this blog post: Advance warning of plans to merge Documentation theme with the default theme. We are especially interested to know which features of the Documentation theme you use and value the most.

The Space Jump macro inserts a link onto the page. When the reader clicks the link, they will jump to a page that has the same name in another space. You specify the space when you insert the Space Jump macro.

Example: We use the Space Jump macro to put a standard message at the top of our archive spaces, telling people that they're reading an old version of the documentation and letting them jump quickly to the same page in the latest documentation. See the words 'this page in the current documentation' in the screenshot below.

Screenshot: One way of using the Space Jump macro

This documentation relates to an earlier version of Confluence.
View this page in the current documentation or visit the current documentation home.

Configuring the Documentation Theme

Using the Space Jump macro

To add the Space Jump macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>None</td>
<td>The space key that contains a page with the same page title that you want the link to jump to. Space keys are case-sensitive.</td>
</tr>
<tr>
<td>Alias</td>
<td>None</td>
<td>The text to display as the hyperlinked text. If you do not supply an alias, Confluence will display the page name.</td>
</tr>
</tbody>
</table>
Notes

What happens if there is no page with the same name in the target space?

For the space jump to work, the target space must contain a page with the same name as the page that renders the Space Jump macro. If the target space does not contain such a page, you will see a broken link. Confluence handles this in its usual manner: the link is coloured red. If you click the link, Confluence offers to create the page for you.

Can I use the Space Jump macro in any space?

Yes. You can use the Space Jump macro in any space, even if that space is not currently using the Documentation theme. Provided that the Documentation theme plugin and its components are installed and enabled on your Confluence site, the Space Jump macro is available in any space.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** spacejump

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="spacejump">
  <ac:parameter ac:name="alias">My Space</ac:parameter>
  <ac:parameter ac:name="space">
    <ri:space ri:space-key="SS"/>
  </ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
{spacejump:alias=my link|space=ds}
```

Spaces List Macro

The Spaces List macro displays a list of spaces, similar to the list of spaces seen on the dashboard.

**Using the Spaces List macro**

**To add the Spaces List macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

**Parameter** | **Required?** | **Default** | **Description** |
|---------------|---------------|------------|-----------------|

*Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
<table>
<thead>
<tr>
<th>Scope of spaces</th>
<th>no</th>
<th>all</th>
<th>The view from which spaces are listed. Available options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>• all – All spaces in the Confluence installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• category – Spaces grouped according to space categories.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• favourite – Spaces which you have added to your favourites list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• new – New spaces which have been created within the last 7 days.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This parameter is unnamed in wikimarkup and storage format.</td>
</tr>
<tr>
<td>Width of List (width)</td>
<td>no</td>
<td>100%</td>
<td>The width of the spaces list, specified as a percentage (%) of the window width.</td>
</tr>
</tbody>
</table>

Notes

There is a bug in this macro that prevents people from selecting a space category. For details, please refer to this issue: [CONF-26597 - Changing category in Space List macro generates wrong URL](#) [RESOLVED]

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** spaces

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="spaces">
  <ac:parameter ac:name="width">80%</ac:parameter>
  <ac:parameter ac:name="">favourite</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
{spaces:favourite|width=80%}
```

Status Macro

The Status macro displays a coloured lozenge (a rounded box) that is useful for reporting project status. You can choose the colour of the lozenge and the text that appears inside the lozenge. The macro also displays its current status in the editor, and you can change the status directly in the editor.

**ALL GOOD!**

**Screenshot:** Click on the Status macro lozenge to change the status.

Using the Status macro

**To add the Status macro to a page using the Macro Browser:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.
Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colour (colour)</td>
<td>Grey</td>
<td>The colour of the lozenge. The following colours are available: Grey, Red, Yellow, Green and Blue.</td>
</tr>
<tr>
<td>Title (title)</td>
<td>The colour that you select.</td>
<td>The text that will appear inside the lozenge. If you do not specify any text, the title will be the colour of the lozenge, that is ‘Grey’, ‘Red’, ‘Yellow’, ‘Green’ or ‘Blue’.</td>
</tr>
<tr>
<td>Use outline style (subtle)</td>
<td>False</td>
<td>The style of the lozenge and its border. The default style lozenge is a solid background colour with white text. The outline style lozenge is white with a coloured border and coloured text as shown here <strong>ALL GOOD!</strong></td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** status

**Macro body:** None.

Storage format example

```
<ac:structured-macro ac:name="status">
    <ac:parameter ac:name="colour">Green</ac:parameter>
    <ac:parameter ac:name="title">On track</ac:parameter>
    <ac:parameter ac:name="subtle">true</ac:parameter>
</ac:structured-macro>
```

Wiki markup example

```
{status:colour=Green|title=On track|subtle=true}
```

Table of Contents Macro

The Table of Contents macro scans the headings on the current Confluence page to create a table of contents based on those headings. This helps readers find their way around lengthy pages, by summarising the content structure and providing links to headings.

Using the Table of Contents macro

**Hint:** For quick access from the editor toolbar, choose Insert > Table of Contents.

**To add the Table of Contents macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.
**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Macro parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Output Type       | list    | - list — produces a typical list-type table of contents.  
| (type)            |         | - flat — produces a horizontal menu-type series of links. |
| Display Section   | clear   | Select the check box to apply outline numbering to your headings, for example:  
| Numbering         |         | 1.1, 1.2, 1.3. |
| (outline)         |         | |
| List Style        | disc    | Select the style of bullet point for each list item. You can use any valid CSS style. For example:  
| (style)           |         | - none — no list style is displayed  
|                   |         | - circle — the list style is a circle  
|                   |         | - disc — the list style is a filled circle. This is the typical bullet list, and is used for this example list.  
|                   |         | - square — the list style is a square  
|                   |         | - decimal — the list is numbered (1, 2, 3, 4, 5)  
|                   |         | - lower-alpha — the list is lower-case, alphabetised (a, b, c, d, e)  
|                   |         | - lower-roman — the list style is lower roman numerals (i, ii, iii, iv, v, vi)  
|                   |         | - upper-roman — the list style is upper roman numerals (I, II, III, IV, V, VI) |
| Heading Indent    |         | Sets the indent for a list according to CSS quantities. Entering 10px will successively indent heading groups by 10px. For example, level 1 headings will be indented 10px and level 2 headings will be indented an additional 10px. |
| (indent)          |         | |
| Separator         | brackets| This parameter applies to flat lists only. You can enter any of the following values:  
| (separator)       |         | - brackets — Each item is enclosed by square brackets: [ ].  
|                   |         | - braces — Each item is enclosed by braces: { }.  
|                   |         | - parens — Each item is enclosed by parentheses: ( ).  
|                   |         | - pipe — Each item is separated by a pipe:  
<p>|                   |         | - anything — Each item is separated by the value you enter. You can enter any text as a separator, for example &quot;***&quot;. If using a custom separator, be aware that text displays exactly as entered, with no additional white space to further separate the characters. |
| Minimum Heading   | 1       | Select the highest heading level to start your TOC list. For example, entering 2 will include levels 2, and lower, headings, but will not include level 1 headings. |
| Level (minLevel)  |         | |
| Maximum Heading   | 7       | Select the lowest heading level to include. For example, entering 2 will include levels 1 and 2, but will not include level 3 headings and below. |
| Level (maxLevel)  |         | |</p>
<table>
<thead>
<tr>
<th><strong>Include Headings</strong> <em>(include)</em></th>
<th>Filter headings to include according to specific criteria. You can use wildcard characters. See Sun’s Regex documentation for examples of constructing regular expression strings.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exclude Headings</strong> <em>(exclude)</em></td>
<td>Filter headings to exclude according to specific criteria. You can use wildcard characters. See Sun’s Regex documentation for examples of constructing regular expression strings.</td>
</tr>
<tr>
<td><strong>Printable</strong> <em>(printable)</em></td>
<td>checked</td>
</tr>
<tr>
<td><strong>CSS Class Name</strong> <em>(class)</em></td>
<td>If you have custom TOC styles in your CSS style sheet, use this parameter to output the TOC inside <code>&lt;div&gt;</code> tags with the specified class attribute.</td>
</tr>
<tr>
<td><strong>Absolute URL</strong> <em>(absoluteURL)</em></td>
<td>By default, the links in the TOC are relative URLs pointing to the current page. If checked, the links in the TOC will be full URLs. This setting is useful when you are including a page with a Table of Contents in another page, and want to control where the links should take the user.</td>
</tr>
</tbody>
</table>

**Examples**

The examples below are based on this table of contents:

```
• Places
  • Favourite Places
  • Unknown Places
• Foods
  • Favourite Foods
  • Unknown Foods
• Things
  • Favourite Foods
  • Unknown Foods
```

**Filtered Table of Contents**

This example filters the headings to include those that contain 'Favourite', but excludes headings which end with 'Things'. The list is styled with Roman numerals.

<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>List Style</td>
<td>upper-roman</td>
</tr>
<tr>
<td>Include Headings</td>
<td>Favourite.*</td>
</tr>
<tr>
<td>Exclude Headings</td>
<td>.*Things</td>
</tr>
</tbody>
</table>

The resulting table of contents is:

I. Favourite Places  
II. Favourite Foods

**Flat List**

This example filters all headings to render a flat list of 'Unknowns' enclosed in square brackets (the default list...
The resulting table of contents is:

[ Unknown Places ] [ Unknown Foods ] [ Unknown Foods ]

Notes

- When you use a Table of Contents macro in a template, you will see an error when you preview the template itself. But the Table of Contents macro works on the pages that people create from the template — the table of contents shows up after they have saved the page. (This is probably because the template is not defined as a page, and the Table of Contents macro works for pages only.)

- Due to an outstanding issue in the Table of Contents macro (CONF-10619), the macro browser's Refresh function does not render any parameter modifications. Currently, the rendering of parameter value modifications to the Table of Contents macro occurs only after the page is saved.

- **Using HTML heading markup with the Table of Contents macro**
  The Table of Contents macro cannot handle HTML heading markup on its own. Hence, if you use the HTML and HTML Include macros to render HTML heading markup in a Confluence page, the Table of Contents macro will not create a contents list out of these headings. (For more information about this issue, please refer to TOC-93.) However, if you insert an HTML anchor into each HTML heading on your page (based on the following syntax), the Table of Contents macro will incorporate these headings into your contents list.

```html
<h2><a name="pagename-headingname"> Heading Name </a></h2>
```

The syntax for the anchor name is the page name and heading name separated by a hyphen. Remove all spaces and convert all text to lower case. Convert all punctuation marks to their URL-encoded equivalent.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** toc

**Macro body:** None.

**Storage format example**

This example shows a list-type table of contents.
This example shows a flat table of contents.

```
<ac:structured-macro ac:name="toc">
  <ac:parameter ac:name="maxLevel">2</ac:parameter>
  <ac:parameter ac:name="minLevel">2</ac:parameter>
  <ac:parameter ac:name="class">bigpink</ac:parameter>
  <ac:parameter ac:name="exclude">[1//2]</ac:parameter>
  <ac:parameter ac:name="type">flat</ac:parameter>
  <ac:parameter ac:name="outline">true</ac:parameter>
  <ac:parameter ac:name="separator">pipe</ac:parameter>
  <ac:parameter ac:name="include">.*</ac:parameter>
</ac:structured-macro>
```

Wiki markup example

This example shows a list-type table of contents.

```
{toc:printable=true|style=square|maxLevel=2|indent=5px|minLevel=2|class=bigpink|exclude=[1//2]|type=list|outline=true|include=.*}
```

This example shows a flat table of contents.

```
{toc:printable=true|maxLevel=2|minLevel=2|class=bigpink|exclude=[1//2]|type=flat|outline=true|separator=pipe|include=.*}
```

Table of Content Zone Macro

You can use the Table of Content Zone macro to mark out a section (zone) within the page from which to create a table of contents. You can style the headings as a flat list, and place the list of links at the top and bottom of the section or page, to provide navigation bars similar to web navigation.

Using the Table of Content Zone macro

**To add the Table of Content Zone macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**
Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>location (location)</td>
<td>both</td>
<td>Specifies where in the zone the output list is displayed: top, bottom, or both, which encloses the page zone content.</td>
</tr>
</tbody>
</table>
| Output Type (type)            | list    | Specifies the layout for the table of contents:  
  - list – produces a vertical list, typical of a TOC.  
  - flat – produces a horizontal menu-type series of links, for example: [Heading 1] [Heading 2] [Heading 3]. |
| Display Section Numbering (outline) | false | Select to apply outline numbering to your headings, for example: 1.1, 1.2, 1.3. |
| List Style (style)            | none    | Specifies the style of bullet point for each list item. You can use any valid CSS style. For example:  
  - none — no list style is displayed  
  - circle — the list style is a circle  
  - disc — the list style is a filled circle. This is the typical bullet list, and is the one we’re using for this example list  
  - square — the list style is a square  
  - decimal — the list is numbered (1, 2, 3, 4, 5)  
  - lower-alpha — the list is lower-case, alphabetised (a, b, c, d, e)  
  - lower-roman — the list style is lower roman numerals (i, ii, iii, iv, v, vi)  
  - upper-roman — the list style is upper roman numerals (I, II, III, IV, V, VI) |
| Heading Indent (indent)       | brackets | Sets the indent for a list output type, according to CSS quantities. Entering “10px” will successively indent list heading levels by 10px. For example, h1 headings will be indented 10px and h2 headings will be indented an additional 10px. |
| Separator (separator)         | brackets | Only applies to the flat output type. Specifies the display style of the links. You can enter any of the following values:  
  - brackets — Each item is enclosed by square brackets: [ ].  
  - braces — Each item is enclosed by braces: { }.  
  - parens — Each item is enclosed by parentheses: ( ).  
  - pipe — Each item is separated by a pipe:  
  - anything — Each is separated by the value you enter. You can enter any text as a separator, for example "***". If using a custom separator, be aware that text displays exactly as entered, with no additional white space to further separate the characters. |
| Minimum Heading Level (minLevel) | 1 | Select the largest heading level to start your TOC list. For example, 2 will list h2, h3, and h4 headings, but will not include h1 headings. |
| Max Heading Level (maxLevel)  | 7 | Select the smallest heading level to include in the TOC. For example, 2 will list h1 and h2, but will not include h3 and below. |
Include Headings (include) Filter the included headings according to specific criteria. You can use wildcard characters. See Sun's Regex documentation for examples of constructing regular expression strings.

Exclude Headings (exclude) Exclude headings according to specific criteria. You can use wildcard characters. See Sun's Regex documentation for examples of constructing regular expression strings.

Printable (printable) true By default, the TOC is set to print. If you clear this parameter, the TOC will not be visible when you print the page.

CSS Class Name (class) If you have a custom TOC in your CSS style sheet, you can use this parameter to output the TOC with the specified "class" attribute.

Examples

The examples are based on a page with the following headings:

- Places
  - Favourite Places
  - Unknown Places
- Foods
  - Favourite Foods
  - Unknown Foods
- Things
  - Favourite Foods
  - Unknown Foods

Filtered Table of Contents

This example will filter all headings to include those that contain "Favourite", but will exclude any heading which ends with the word "Things". The list is styled with upper-case Roman numerals.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Type</td>
<td>list</td>
</tr>
<tr>
<td>List Style</td>
<td>upper-roman</td>
</tr>
<tr>
<td>Include Headings</td>
<td>Favourite.*</td>
</tr>
<tr>
<td>Exclude Headings</td>
<td>.*Things</td>
</tr>
</tbody>
</table>

Screenshot: Filtered TOC ‘zone’ headings

I. Favourite Places
   II. Favourite Foods

Flat List

This example will filter all headings to render a flat list of "Unknowns" enclosed in square brackets.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Type</td>
<td>flat</td>
</tr>
<tr>
<td>Separator</td>
<td>brackets</td>
</tr>
</tbody>
</table>
Notes

- Due to an outstanding issue in the Table of Content Zone macro (CONF-10619), the Macro Browser's Ref refresh function does not render any parameter modifications. Currently, the rendering of parameter value modifications to the Table of Content Zone macro occurs only after the page is saved.
- Using HTML heading markup with the Table of Content Zone macro — The Table of Content Zone macro cannot handle HTML heading markup on its own. Hence, if you used the HTML and HTML Include macros to render HTML heading markup in a Confluence page, the Table of Content Zone macro will not create a contents list out of these headings. (For more information on about this issue, please refer to TOC-93.)

However, if you insert an HTML anchor into each HTML heading on your page (based on the following syntax), the Table of Content Zone macro will incorporate these headings into your contents list.

```
<h2><a name="pagename-headingname"></a>Heading Name</h2>
```

The syntax for the anchor name is the page name and heading name separated by a hyphen. Remove all spaces and convert all text to lower case. Convert all punctuation marks to their URL-encoded equivalent.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: toc-zone

Macro body: Accepts rich text.

Storage format example

```
<ac:structured-macro ac:name="toc-zone">
  <ac:parameter ac:name="printable">false</ac:parameter>
  <ac:parameter ac:name="maxLevel">2</ac:parameter>
  <ac:parameter ac:name="minLevel">2</ac:parameter>
  <ac:parameter ac:name="location">top</ac:parameter>
  <ac:parameter ac:name="type">flat</ac:parameter>
  <ac:parameter ac:name="outline">true</ac:parameter>
  <ac:parameter ac:name="separator">pipe</ac:parameter>
  <ac:rich-text-body>
    <p>Only headings within this block are included in the table of contents.</p>
  </ac:rich-text-body>
</ac:structured-macro>
```

Wiki markup example
Tip Macro

Using the Tip macro, you can highlight a helpful tip on a Confluence page. The macro creates a green-coloured box surrounding your text as shown below.

Tip Macro Example
This text is displayed inside the tip macro.

Using the Tip macro

To add the Tip macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional Title</td>
<td>none</td>
<td>The title of the tip. If specified, it will be displayed in bold next to the icon.</td>
</tr>
<tr>
<td>Optional Title</td>
<td>none</td>
<td>The title of the tip. If specified, it will be displayed in bold next to the icon.</td>
</tr>
<tr>
<td>Show Tip Icon</td>
<td>true</td>
<td>If cleared, the icon will not be displayed.</td>
</tr>
<tr>
<td>Show Tip Icon</td>
<td>true</td>
<td>If cleared, the icon will not be displayed.</td>
</tr>
</tbody>
</table>

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

Macro name: tip

Macro body: Accepts rich text.
Storage Format example
Wiki markup example

{tip:icon=false|title=My title}
This is my hint.
{tip}

User List Macro

The User List macro displays a list of users registered in Confluence, based on their group membership.

Using the User List macro

To add the User List macro to a page:
1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group(s) (groups)</td>
<td>none</td>
<td>Specify the group name. Specify multiple groups separated by a comma, or use * to show all users in Confluence.</td>
</tr>
<tr>
<td>Display Online/Offline Users (online)</td>
<td>All registered users</td>
<td>List online or offline users. Leave blank to show all users, irrespective of status.</td>
</tr>
</tbody>
</table>

Accepted values:
- Unspecified — The macro will show all registered users.
- true — The macro will show only online users.
- false — The macro will show only offline users.

See below for information on how to configure this macro to display online / offline users.

Configuring the User List macro

In order to use the Display Online / Offline Users parameter to indicate whether users are currently logged in...
to Confluence, you will need to enable the User Log In Listener component in the add-on that provides this macro. You'll need Confluence Administrator permissions to do this.

To enable the Display Online/Offline Users filter in the User List macro:

1. Go to [Add-ons](#).
2. Select [System](#) from the drop-down and search for the [User Lister](#) add-on.
3. Expand the add-on and enable the [User Log In Listener](#) module.
4. Restart Confluence for the change to take effect.

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** userlister

**Macro body:** None.

**Storage format example**

```
<ac:structured-macro ac:name="userlister">
    <ac:parameter ac:name="groups">confluence-users</ac:parameter>
    <ac:parameter ac:name="online">false</ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
{userlister:groups=confluence-users|online=false}
```

**User Profile Macro**

The User Profile macro displays a short summary of a given Confluence user's profile. This is the same summary that appears in a [Hover Profile](#), which appears whenever you mouse over a user's name in the Confluence interface.

**Screenshot: Example of the User Profile macro**

![User Profile Macro Example](image)

**Using the User Profile macro**

**To add the User Profile macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**
Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username (user)</td>
<td>none</td>
<td>The username of the Confluence user whose profile summary you wish to show.</td>
</tr>
</tbody>
</table>

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** profile

**Macro body:** None.

**Storage format example**

```html
<ac:structured-macro ac:name="profile">
  <ac:parameter ac:name="user">
    <ri:user ri:userkey="12345678912345678912345678912345"/>
  </ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
{profile:user=admin}
```

**User Status List Macro**

The User Status List macro displays a history of a given Confluence user’s status updates. This is the same history that appears in the user’s Status Updates view.

**Screenshot: Example output of the User Status List macro**

```
“Time to look at networks
   Clear · Delete · Feb 15, 2013
```

```
“Updating my profile picture
   Delete · Feb 15, 2013
```

```
“Making Confluence sing...
   Delete · Feb 15, 2013
```

**Using the User Status List macro**

**To add the User Status List macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.
Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>none</td>
<td>The username of the Confluence user whose history of status updates you wish to show.</td>
</tr>
<tr>
<td>(username)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notes

Hint: If you wish to list status updates made by more than one user, you can use the Recently Updated macro with the following parameter values:

- Include these Content Types Only: status
- Author(s) by username: The user(s) whose status updates you want to include in the list. If you leave this field blank, the status updates of all users will be included.

Code examples

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** status-list

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="status-list">
  <ac:parameter ac:name="username">
    <ri:user ri:userkey="12345678912345678912345678912345"/>
  </ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```
{status-list:username=admin}
```

View File Macro

The View File macros allow you to embed an Office or PDF document into your Confluence page. First attach the document to a page and then use one of the View File macros to display the document's content.

When people view the page, they will see the content of the Office or PDF document. They do not need to have Office installed in order to see the content of an Office document. If they do have Office installed, people will be able to open the document for editing in their Office application.

For a full list of Office Connector prerequisites and limitations, please refer to:

- Office Connector Prerequisites
- Office Connector Limitations and Known Issue

For an overview of all Office Connector features, please refer to Working with the Office Connector.

**Displaying an Office or PDF Document in Confluence**

To display an Office or PDF document in a page, use one of the following View File macros in the macro browser:
To add one of the View File macros to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters for the Office and PDF macros**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Macro</th>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All View File macros</td>
<td>Page Name</td>
<td></td>
<td>Enter a page name, if you wish to display a document which is attached to another Confluence page.</td>
</tr>
<tr>
<td></td>
<td>File Name</td>
<td>none</td>
<td>The file name of the Office or PDF document to be displayed. The document must be attached to a page on your Confluence site.</td>
</tr>
<tr>
<td>Office Excel</td>
<td>Show Grid?</td>
<td>true</td>
<td>Select to show grid lines around each cell of the Excel spreadsheet. Clear to hide these grid lines.</td>
</tr>
<tr>
<td></td>
<td>Worksheet Name</td>
<td></td>
<td>The name of the worksheet that you want displayed.</td>
</tr>
<tr>
<td></td>
<td>Last Row</td>
<td></td>
<td>The number of the last row you want displayed, starting from '0' as the first row.</td>
</tr>
<tr>
<td></td>
<td>Last Column</td>
<td></td>
<td>The number of the last column you want displayed, starting from '0' as the first column.</td>
</tr>
</tbody>
</table>

**Hint for reducing the size of the spreadsheet:** Use the Last Column and Last Row parameters to reduce the size of the spreadsheet displayed on the wiki page. This is especially useful to prevent the display from showing empty cells. This will also help to prevent 'out of memory' errors.

| Office PowerPoint         | Height        |         | Specify the height of the display, in pixels (default) or as a percentage of the window's height. |
|                          | Slide Number  | none    | Specify the number of the slide that you want displayed on the Confluence page, where the first slide is numbered zero. Instead of a slide show, the page will display just the single slide, represented as a JPEG image. If not specified, all slides display as a slideshow. |
|                          | Width         |         | Specify the width of the display, in pixels (default) or as a percentage of the window's width. |
You can launch your Office application and edit Office documents displaying in the view file macros directly from your Confluence page.

- **Word** and **Excel** - choose the **Edit Document** link above the content
- **PowerPoint** - choose the edit icon on the viewer.

You will find more information and other methods for editing attached Office documents in **Editing an Office Document from Confluence**.

**Troubleshooting**

Problems? Please refer to our guide to the **Office Connector limitations and known issues**.

**Code examples**

Refer to the page for each macro to see storage format and wikimarkup examples.

- **Office Excel Macro**
- **Office PowerPoint Macro**
- **Office Word Macro**
- **PDF Macro**
- **Warning Macro**

The Warning macro is useful for highlighting a warning on a Confluence page. The macro creates a red-coloured box surrounding your text as shown below.

**Example of a Warning Macro**

This text appears inside the Warning macro.

Using the Warning macro

**To add the Warning macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Optional Title</strong></td>
<td>none</td>
<td>The title of the warning note. If specified, will be displayed in bold next to the icon.</td>
</tr>
<tr>
<td><strong>Show Warning Icon</strong></td>
<td>true</td>
<td>If &quot;false&quot;, the icon will not be displayed.</td>
</tr>
</tbody>
</table>

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** warning

**Macro body:** Accepts rich text.
Storage format example
Wiki markup example

{warning:icon=false|title=This is my title}
This is _important_ information.
{warning}

Widget Connector Macro

The Widget macro, or Widget Connector, allows you to embed certain multimedia content from other web sites into your Confluence page.

It supports the following content:

- Gadgets and other widgets: Google Gadgets, Widgetbox.
- Videos: YouTube, MySpace Video, Yahoo Video, Dailymotion, Episodic, Vimeo, Metacafe, blip.tv, Viddler.
- Photos and images: Flickr, Skitch.com.
- Micro-blogging: Twitter, FriendFeed, BackType.
- Documents and presentations: SlideShare, SlideRocket, Scribd, presentations on Google Docs. **Note:** The integration with Google Docs is currently broken. Please refer to CONF-24927 for details of the issue.
- Calendars: Google Calendar.
- Forms and online databases: Wufoo HTML Form Builder and Wufoo Reports.
- Support and customer satisfaction: Get Satisfaction.

There are live examples of many of these on the widget examples page. If you wish to extend the functionality of this plugin, please see Extending the Widget Connector.

On this page:

- Using the Widget Connector
- Parameters
- Examples of macro sources
- Troubleshooting
- Code examples
  - Storage format example
  - Wiki markup example

Related pages:

- Working with Macros
- Confluence User's Guide

Using the Widget Connector

**To add the Widget Connector to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.
To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Site's Widget URL (url)</td>
<td>This is the URL provided by the external web site for embedding content from that web site onto another web page.</td>
</tr>
<tr>
<td>Pixel Height (Value Only) (height)</td>
<td>Specify the height of the display, in pixels.</td>
</tr>
<tr>
<td>Pixel Width (Value Only) (width)</td>
<td>Specify the width of the display, in pixels.</td>
</tr>
</tbody>
</table>

Examples of macro sources

Google Gadgets

You need to find the URL for the Google Gadget you want to display.

Here is one way to find a gadget's URL:

1. Go to the Google Gadgets directory.
2. Find the gadget you want then click its name, such as 'Spider'.
3. The gadget's summary page will open. Copy the URL from your browser's address bar. The URL looks something like this one:


You can also use the URL of the 'add gadget' page. The page is called 'Add "gadgetx" to your iGoogle page':

1. There are a couple of ways to get to the 'add gadget' page:
   - Click a '+Google' button underneath the gadget when displayed on a page somewhere.
   - Or click 'Add Stuff' on your iGoogle page.
2. Copy the URL from your browser's address bar. The URL would look something like this one:

   http://www.google.com/ig/ade?synd=open&source=ggyp&moduleurl=abowman.googlepages.com/spider.xml

Widgetbox widgets

You will need to find the URL for the Widgetbox widget you want to display.

Here is one way to find a widget's URL:

1. Ensure you are logged in to Widgetbox and that you are viewing the Widgetbox Gallery.
2. Find the widget you want then click its name, such as 'cyber-pet'.
3. The widget's summary page will open. Within the Get Widget section, click the Atlassian Confluence icon. The Widgetbox Add to Confluence dialog box appears, containing the URL required for the Widget Macro.

   If you cannot see this icon, click the more... link to reveal it.
4. In the Widgetbox Add to Confluence dialog box, click **Copy**.
5. Copy the URL from your browser's address bar. The URL looks something like this one:

   ![URL example](http://widgetbox.com/confluence/b8327e33-c8eb-4a38-b842-fba866ffdd28)

**YouTube**

You will need to find the URL for the YouTube video that you want to display.

To find a YouTube video's URL:

1. Go to [YouTube](https://www.youtube.com) and search for the video you want.
2. Click the title of the video, such as 'Wikis in Plain English'.
3. The video's summary page will open on YouTube. Choose **Share**.
4. Choose **Options**, located under the video's URL.
5. Choose **Long link**, then copy the long URL. It looks something like this:

   ![URL example](http://au.youtube.com/watch?v=-dnL00TdmLY)

**Note:** You must use the long YouTube URL. The shortened URL (like this one: `http://www.youtu.be/<video_key>`) does not work in the widget connector. If you are unable to view the video in some browsers, use `https:` rather than `http` in your link.

**MySpace Videos**

You will need to find the URL for the MySpace video that you want to display.

To find a MySpace video's URL:

1. Go to [MySpace Video](http://vids.myspace.com) and search for the video you want.
2. Click the title of the video, such as 'Glacier Creek Confluence Time Lapse'.
3. The video's summary page will open. Copy the URL from your browser's address bar. The URL looks something like this one:

   ![URL example](http://vids.myspace.com/index.cfm?fuseaction=vids.individual&videoid=3376248&searchid=20c789f6-1ae9-459a-bfec-75efcf2847c)

**Yahoo Video**

You will need to find the URL for the Yahoo video that you want to display.

To find a Yahoo video's URL:

1. Go to [Yahoo Video](https://video.yahoo.com) and search for the video you want.
2. Click the title of the video, such as 'Wiki Technology Trend: Past, Now and Future'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this:

   ![URL example](http://video.yahoo.com/watch/423158/2424140)

   If you are unable to obtain a unique URL from your browser's address bar, click the envelope (Share) icon on the lower section of the video screen and copy the contents of the **Link** field.

**Dailymotion Video**

You will need to find the URL for the Dailymotion video that you want to display.

To find a Dailymotion video's URL:
1. Go to Dailymotion and search for the video you want.
2. Click the title of the video, such as 'Wiki Technology Trend: Past, Now and Future'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this:

   ![URL Example](http://www.dailymotion.com/user/spacevidcast/video/x7zevj_spacevidcast-2009-promo-video_tech)

   If you are unable to obtain a unique URL from your browser’s address bar, click **Menu** at the lower right section of the video screen, select **URL & Embed Code** and copy the contents of the **Link** field.

**Episodic**

You will need an **Episodic** user account if you want to create and distribute videos via Episodic.

To embed an Episodic video onto a Confluence page:

1. Find the video and copy the URL from the address bar of your browser. The URL looks something like this:

   ![URL Example](http://app.episodic.com/shows/13/episodes/493)

2. Paste the URL into the **Web Site's Widget URL** box in the Macro Browser.

**Vimeo**

You will need to find the URL for the Vimeo video that you want to display.

To find a Vimeo video's URL:

1. Go to Vimeo and search for the video you want.
2. Click the title of the video, such as 'The Wiki Show - Allison the Russian High Kicker'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:

   ![URL Example](http://www.vimeo.com/909808)

**Metacafe**

You will need to find the URL for the Metacafe video that you want to display.

To find a Metacafe video's URL:

1. Go to Metacafe and search for the video you want.
2. Click the title of the video, such as 'Wikis In Plain English (How To)'
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:

   ![URL Example](http://www.metacafe.com/watch/679493/wikis_in_plain_english_how_to/)

**blip.tv**

This integration is currently broken. Please refer to **CONF-27266** for details of the issue.

**Viddler**

This integration is currently broken. Please refer to **CONF-27267** for details of the issue.
Flickr

You can embed a slide show of photos from Flickr by supplying a URL that specifies one of the following:

- Photos with a specific tag.
- Photos belonging to the photostream of a specific Flickr user.
- A set of photos as defined by the Flickr user.
- A user's photostream starting at a specific photo.

If you want to do something else, we suggest that you try any Flickr URL. It should work.

Below are some examples of the Widget macro code for embedding Flickr images.

**Flickr Photos with a Specific Tag**

This URL displays a slide show of Flickr photos that are tagged with the word 'Atlassian': http://www.flickr.com/photos/tags/atlassian/

**Flickr Photos from a Specific User**

This URL displays a slide show of photos from the Flickr photostream of user 'Atlassian': http://www.flickr.com/photos/atlassian/

**Flickr Photos from a Specific Set**

This URL displays a slide show of Flickr photos from the set 'Melbourne Cup - November 2008' created by user 'Atlassian': http://www.flickr.com/photos/atlassian/sets/72157608657271078/

**A Specific Flickr Photo**

This URL displays a slide show of photos from the Flickr photostream of the user 'Atlassian', starting with a specific photo: http://www.flickr.com/photos/atlassian/3003538919/

Skitch.com

You will need to find the URL for the Skitch image that you want to display.

To embed a Skitch image onto a Confluence page:

2. Find the image and copy the URL from the address bar of your browser. The URL looks something like this:

   http://skitch.com/atlassian/411g/example-image

**Note:** Skitch is now integrated with Evernote, as described in this blog post from The Next Web: Evernote is bringing Skitch into its core service, Skitch.com will be archived. As a result, private images on Skitch.com are no longer accessible and will not work in the Confluence widget connector. Existing public images on Skitch.com will remain available.

Twitter

**Note:** Due to a recent change to the Twitter API, the process for displaying Tweets has changed. The following instructions relate to v 2.1.6 of the Widget Connector plugin. Earlier versions of the Widget Connector no longer display tweets correctly.

To embed a single tweet:

1. In Twitter, navigate to the tweet you wish to embed and choose Details to display just that tweet in your browser.
2. Copy the page URL (the URL should be in the following format, https://twitter.com/atlassian/status/346976521250037760).
3. In Confluence, paste the URL into the Widget Connector.
4. The single tweet will display, like the one below.
To embed a dynamic list of tweets:

1. In Twitter, create a **Widget** (go to **Settings > Widgets**).
2. Configure the widget to display the tweets you wish to embed (for example, a user timeline, list of tweets or hashtag search).
3. Save the widget, then copy the page URL (the URL should be in the following format, `https://twitter.com/settings/widgets/354381809263472640/edit`)
4. In Confluence, paste the URL into the Widget Connector.
5. The list of tweets will display, like the one below.

### FriendFeed

To display the latest messages from a FriendFeed user, add the user's FriendFeed link as the URL in the Widget macro. For example:

### BackType

To display the latest blog or website comments from a BackType user, add the user's BackType widget link as the URL in the Widget macro. For example:

### SlideShare

You will need to find the URL for the SlideShare presentation that you want to display.

To find a SlideShare presentation's URL:

1. Go to SlideShare and search for the presentation you want.
2. Click the title of the presentation, such as 'Using JIRA & Greenhopper for Agile Development'.
3. The presentation's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:
You will need to find the URL for the SlideRocket presentation that you want to display.

To find a SlideRocket presentation's URL:

1. Log in to SlideRocket and go to your library of presentations.
2. Copy the 'web link' for the presentation you want to display. This will give you a URL that looks something like this one:

   http://app.sliderocket.com/app/FullPlayer.aspx?id=132f9db7-b0fb-4f51-b974-36652774971b

3. Paste the URL into the Widget macro code on your Confluence page.

Scribd

You will need to find the URL for the Scribd presentation that you want to display.

To find a Scribd presentation's URL:

1. Go to Scribd and search for the presentation you want.
2. Click the title of the presentation, such as 'My Sea Friends Coloring Book'.
3. The presentation's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:


4. Paste the URL into the Widget macro code on your Confluence page.

Google Docs Presentations

This integration is currently broken. Please refer to 👤 CONF-24927 for details of the issue.

Google Calendar

You can embed a Google Calendar into your page and to do this, you will need to add the URL for the Google Calendar that you want to display.

To find the URL for a Google Calendar:

1. Log in to Google Calendar.
2. In the calendar list on the left side of the page, ensure the appropriate calendar is selected, click the down-arrow button next to the calendar name and then select the Calendar settings option. (Alternatively, if available, click the Manage Calendars link at the bottom of the calendar list and then click the name of the appropriate calendar.)
3. In the Calendar Address section, click the HTML button. A pop-up message with your calendar's public URL appears.
4. Copy the URL from this pop-up message. The URL looks something like this:

   http://www.google.com/calendar/embed?src=somebody%40example.com&ctz=Australia/Sydney

5. Paste the URL into the Widget macro code on your Confluence page.

Wufoo HTML Form Builder
To display an HTML form built in the Wufoo HTML Form Builder, add the form's link as a URL to the Widget Macro. For example:

http://examples.wufoo.com/forms/contact-form/

Wufoo Reports
To display a Wufoo Report built using the Wufoo Report Manager, add the report's link as a URL to the Widget Macro. For example:

http://examples.wufoo.com/reports/example-satisfaction-survey-report/

Get Satisfaction social support application
To display a feedback form for a Get Satisfaction community, add the community or company link as a URL to the Widget Macro. For example:

http://getsatisfaction.com/atlassian

Troubleshooting
If the URL given in the Widget Connector macro does not work, the macro displays an icon and the base URL. For example, the following code:

http://example.com/invalid

will result in an image like the one below:

![example.com](image)

Code examples
The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** widget

**Macro body:** None.

**Storage format example**

```xml
<ac:structured-macro ac:name="widget">
  <ac:parameter ac:name="height">480</ac:parameter>
  <ac:parameter ac:name="width">640</ac:parameter>
  <ac:parameter ac:name="url">
    <ri:url ri:value="http://youtube.com/watch?v=23pLByj_q5U"/>
  </ac:parameter>
</ac:structured-macro>
```

**Wiki markup example**

```xml
<ac:structured-macro ac:name="widget">
  <ac:parameter ac:name="height">480</ac:parameter>
  <ac:parameter ac:name="width">640</ac:parameter>
  <ac:parameter ac:name="url">
    <ri:url ri:value="http://youtube.com/watch?v=23pLByj_q5U"/>
  </ac:parameter>
</ac:structured-macro>
```
**Widget Connector Examples**

This page contains working examples of some services currently supported by the Widget Connector. This page lets you preview what each widget will look like and see how to interact with it. For detailed usage, see [Widget Connector Macro](#).

**Flickr**

- http://www.flickr.com/photos/tags/atlassian
- http://www.flickr.com/photos/atlassian/
- http://www.flickr.com/photos/atlassian/sets/72157608657271078/
- http://www.flickr.com/photos/atlassian/3003538919/
**Google Docs**
This integration is currently broken. Please refer to `CONF-24927` for details of the issue.

**YouTube**

http://au.youtube.com/watch?v=-dnL00TdmLY

**Note:** You must use the long YouTube URL, available under **Share > Options**. For detailed instructions, see the user’s guide to the widget macro.

**MySpace**


**Vimeo**

http://www.vimeo.com/909808

**BlipTV**
This integration is currently broken. Please refer to `CONF-27266` for details of the issue.

**Viddler**
This integration is currently broken. Please refer to `CONF-27267` for details of the issue.

**Skitch**
Skitch is now integrated with Evernote, as described in this blog post from *The Next Web: Evernote is bringing Skitch into its core service*. Skitch.com will be archived. As a result, private images on Skitch.com are no longer accessible and will not work in the Confluence widget connector. Existing public images on Skitch.com will remain available.

**Twitter**

http://twitter.com/mcannonbrookes

**search.twitter.com**

http://search.twitter.com/search?q=AtlassianDragons

**FriendFeed**

http://friendfeed.com/myname

**SlideShare**

http://www.slideshare.net/jleyser/using-jira-greenhopper-for-agile-development-presentation

**SlideRocket**

http://app.sliderocket.com/app/FullPlayer.aspx?id=132f9db7-b0fb-4f51-b974-36652774971b

**Scribd**


**Wufoo**

http://examples.wufoo.com/forms/contact-form/
Example of widget error message

This is an example of the error message you will see, if the Widget connector cannot find the URL or service specified.

http://example.com/invalid

Task Report Macro

Use the Task Report macro to display a list of tasks on a page. Filter the tasks by space, page, user, label, created date and more.

See Working with Tasks for more information on creating and assigning tasks. You can also use the Task Report blueprint, which will create a page and add this macro for you.

Using the Task Report macro

To add the Content Report Table macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Task Report macro showing incomplete tasks, on pages with the label 'meeting-notes'.

<table>
<thead>
<tr>
<th>Description</th>
<th>Due date</th>
<th>Assignee</th>
<th>Task appears on</th>
</tr>
</thead>
<tbody>
<tr>
<td>@Leah Admin to schedule a follow up meeting</td>
<td></td>
<td>Leah Admin</td>
<td>2014-03-25 Meeting notes</td>
</tr>
<tr>
<td>@Ewan User to finish creating the new project space by 10 Mar 2014</td>
<td>10 Mar 2014</td>
<td>Ewan User</td>
<td>2014-03-25 Meeting notes</td>
</tr>
<tr>
<td>@Josh User add designs to the project space's file list by 02 Apr 2014</td>
<td>02 Apr 2014</td>
<td>Josh User</td>
<td>2014-03-29 Meeting notes</td>
</tr>
</tbody>
</table>

Parameters

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space(s) and Page(s)</td>
<td>No</td>
<td>None</td>
<td>Filter by the task location. The macro will only display tasks in the pages or spaces specified. You can enter a combination of spaces and pages.</td>
</tr>
<tr>
<td><strong>Label(s)</strong> (labels)</td>
<td>No</td>
<td>None</td>
<td>Filter by Label. The macro will only display tasks on pages with this label. You can enter multiple labels, separated by a comma.</td>
</tr>
<tr>
<td>----------------------</td>
<td>----</td>
<td>------</td>
<td>-----------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Assigned to</strong> (assignee)</td>
<td>No</td>
<td>None</td>
<td>Filter by Assignee. The macro will only display tasks assigned to the users specified.</td>
</tr>
<tr>
<td><strong>Created by</strong> (creator)</td>
<td>No</td>
<td>None</td>
<td>Filter by Creator. The macro will only display tasks created by the users specified.</td>
</tr>
<tr>
<td><strong>Created after</strong> (createddateFrom)</td>
<td>No</td>
<td>None</td>
<td>Filter by created date. The macro will only display tasks created on or after the date specified. Date must be entered as dd-mm-yyyy.</td>
</tr>
<tr>
<td><strong>Task status</strong> (status)</td>
<td>No</td>
<td>None</td>
<td>Show complete, incomplete or all tasks.</td>
</tr>
<tr>
<td><strong>Number of tasks to display</strong> (pageSize)</td>
<td>No</td>
<td>20</td>
<td>The number of tasks to display on each page of results in the table. Choose from 10, 20 or 40.</td>
</tr>
<tr>
<td><strong>Display columns</strong> (columns)</td>
<td>No</td>
<td>description,duedate,assignee,location</td>
<td>Columns to include in the table. Available columns include description, duedate, assignee, location, completedate and labels.</td>
</tr>
<tr>
<td><strong>Sort by</strong> (sortBy)</td>
<td>No</td>
<td>Due date</td>
<td>Sort tasks by due date, assignee or page title. Select the Reverse Sort check box to sort the table in reverse order.</td>
</tr>
</tbody>
</table>

**Code examples**

The following examples are provided for advanced users who want to inspect or edit the underlying markup for a Confluence page.

**Macro name:** tasks-report-macro

**Macro body:** None.

**Storage format example**

Note: The spaceAndPage multi-pick parameter populates the spaces and pages parameters.
Working with Drafts

A draft is a 'snapshot' of unsaved page content, which Confluence creates automatically at regular intervals while you are editing a page or blog post. This can minimise the loss of work if your Confluence site experiences a problem, since you can retrieve the page content from your last saved draft.

How do drafts work in Confluence?

At regular intervals, Confluence automatically saves a draft of the page you are editing. If a network failure or system error prevents you from saving your page, you can retrieve its last saved draft and continue working on the page from the last saved draft.

Drafts are created while you are adding and editing a page or blog post. Each new draft replaces the previously saved draft. By default, Confluence saves a draft of your page once every thirty seconds. However, an administrator can configure how often drafts are saved. In addition, whenever you edit a page and then move to another screen, Confluence will automatically save a draft.

When you edit the page again, Confluence will let you know that a version of the page you are editing was not saved and will give you the option to resume editing it.

Each time Confluence saves a draft, it displays a message and the time of the last save near the Save button on the edit screen.

More about drafts:

- A user only has access to the drafts of pages they have been working on and whose content has not yet been saved.
A user cannot create a draft explicitly.

A user's drafts are listed in the 'Drafts' tab of their profile.

Once a user has resumed editing a draft, or chosen to discard it, the draft is removed from their drafts tab.

**Viewing drafts**

Your drafts are listed on the Drafts tab of your user profile.

**To see your drafts:**

Choose your profile picture at top right of the screen, then choose Drafts.

**Viewing your unsaved changes**

While editing a page or blog post, you can view any 'unsaved' changes you have made since the last automatically saved draft, by clicking view change (near the Save button).

**Screenshot: Segment of the unpublished changes window**

Configuring the Time Interval at which Drafts are Saved

By default, Confluence saves a draft of your page once every thirty seconds. Confluence administrators can configure how often drafts are saved.

As a Confluence administrator, you can set the time interval at which drafts are saved as follows:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Click Further Configuration in the left-hand panel.
3. Edit the setting for Draft Save Interval.

**Concurrent Editing and Merging Changes**

Sometimes, two or more people may edit a page at the same time. When this happens, Confluence will do its best to ensure that nobody's changes are lost.

**How will I know if someone else is editing the same page as I am?**

If another user is editing the same page as you, Confluence will display a message above your edit screen letting you know who the other user is and when the last edit was made.

**Screenshot: Notification of Simultaneous Page Editing**
What happens if two of us are editing the same page and the other user saves before I do?

If someone else has saved the page before you, when you click ‘Save’, Confluence will check if there are any conflicts between your changes and theirs. If there are no conflicting changes, Confluence will merge the changes.

If there are conflicts, Confluence will display them for you and give you the option to:

- **Continue editing** - you can continue to edit the page, useful if you want to manually merge the changes.
- **Overwrite** - this will replace the other person's edits with yours.
- **Cancel** - this will discard your changes and exit the editor, keeping the other person's edits.

**Example Scenario**

For example, Alice and Bob both edit the same page at the same time.

If Alice clicks save before Bob, Bob is now effectively editing an out-of-date version of the page. When Bob clicks save, Confluence will examine his changes to see if any overlap with Alice’s. If the changes do not overlap (i.e. Alice and Bob edited different parts of the page), Bob's changes will be merged with Alice's automatically.

If Bob’s changes overlap with Alice's, Confluence will display an error message to Bob showing where Alice has changed the page, and giving Bob the options to overwrite Alice's changes with his own, to re-edit the document to incorporate Alice's work, or to cancel his own changes entirely, maintaining Alice’s changes.

Resuming the Editing of a Draft

If you have typed some content into a Confluence page or blog post, Confluence will save a draft of it, even if you were not able to successfully save the page or blog post, or add a title to it.

**There are two ways to resume editing an unsaved page or blog post:**

A. Using your drafts view. To resume editing a draft from this view:

1. Choose your profile picture at top right of the screen, then choose Drafts.
2. Choose Resume Editing next to the appropriate draft to resume editing that draft.

**Note:** If you had not yet entered a page title, the draft will be listed with the title ‘Untitled’.

B. If you had created a new page or blog post but did not save it, then when you next add a page or blog post in that space, Confluence will ask you if you want to resume editing the page that was not saved. If you click resume editing, the draft and its unsaved content will be restored, allowing you to continue editing it.

**Related pages:**

- **Working with Drafts**

**Screenshot: Resume Editing**

A version of this page you were editing at Feb 14, 2013 16:39 was saved as a draft. Do you want to view the change, resume editing or discard it?

What happens if I am editing the draft of a page that has since been updated?

When this happens, Confluence will display a message informing you that you are editing an outdated page. If there are no conflicts between the two versions, Confluence will give you the option to Merge and Resume editing.

If there are any conflicts, Confluence will give you the option to View the Conflict or to Discard your changes.

**Recording Change Comments**

A 'change comment' is a short description that summarises the changes made to a page during an editing
session. Change comments are a useful way of keeping track of the history of a page. A change comment is not the same as a comment added to a page. Refer to Commenting on pages and blog posts for information about that type of comment.

Note that once a change comment has been added and the page has been saved, it is not possible to update or remove the change comment.

**On this page:**
- Entering a Change Comment
- Viewing a Change Comment
- Viewing a History of Change Comments

**Related pages:**
- Viewing Page Information
- Page History and Page Comparison Views
- Confluence User's Guide

**Entering a Change Comment**

You can enter change comments in the field located below the edit screen:

*Screenshot: Entering change comments*

**Viewing a Change Comment**

To see the most recent change to a page and any change comment that may have been entered, choose the edited date on the byline. You can also go to Tools > Page History to see change comments for all versions.

*Screenshot: History of change comments on Info view*

**Viewing a History of Change Comments**

The change comments for a page are recorded under the 'Recent Changes' section of the page's 'Info' view and in the page's 'History' view.

*Screenshot: History of change comments on Info view*
Creating Beautiful and Dynamic Pages

Confluence has a number of features that help you build attractive pages to engage your readers and give them the opportunity to interact with up-to-date information. This page summarises those features and provides links to detailed instructions.

**Adding visual appeal**

**Pictures, photographs and screenshots.** Confluence pages can display images from your Confluence site and from other websites. To put an image into Confluence, you can upload it and attach it to a page or blog post, then display it on any page, blog post or comment. Alternatively, display an image from a remote location via the web address (URL). See .

**Galleries.** Use the Gallery Macro to display a set of images. When viewing the page, people can click any of the pictures to zoom in and view the images as a slide show.

**People.** Add a Profile Picture Macro to show a picture of a Confluence user, or a User Profile Macro to show a summary of the person's profile as well as their avatar.

**Multimedia.** You can display movies, animations and videos, and embed audio files on your Confluence page. For example, Confluence supports Adobe Flash, MP3, MP4, and various other movie formats. See Embedding Multimedia Content.

**Social video and image sharing.** The Widget macro displays live content from social sites such as YouTube and other video sharing sites, and Flickr fo
Displaying presentations and documents

Display your Office documents and other presentations directly in Confluence.

- Attach your Office documents to a Confluence page then display them on the page, using the View File Macro. This works for Excel spreadsheets, PowerPoint presentations and Word documents.
- Display PDF files in Confluence too, also with the View File Macro.
- Use the Widget Connector Macro to show slide decks hosted on SlideShare and other online presentation sites.

Pulling in content from your issue tracker

Many project teams and customers have useful information on a JIRA issue tracker. Rather than copying and pasting it onto your Confluence page, you can display it directly from the source, thus ensuring that the information shown in Confluence is always up to date.

Link to a feature request in your issue tracker, or display a list of fixed issues – useful for release notes and project planning. See the JIRA Issues Macro.

Telling a story in pictures

A number of Confluence add-ons provide sophisticated tools for creating diagrams and mockups.

For example:
Varying the structure of your pages

You can build up a custom layout by using the page layout tool to add sections and columns to your page. See the detailed guidelines to Working with Page Layouts and Columns and Sections.

Do you need to display tabular data, which your readers can sort when viewing the page? See Working with Tables.

Use other macros to highlight and format sections of your page:

- Panel
- Tip
- Info
- Note
- Warning
- Code block
- Noformat

Integrating your content with social media

People share information on various social sites. You can make Confluence a focal point where people collect their shared information and see what is happening in the areas that matter to them.

Use the Widget Connector macro:

- Show a live stream of tweets from a Twitter user, or tweets matching a Twitter search.
- Display a video from YouTube or other online movie sites.
- Share photographs from Flickr.
- Display slide decks hosted on SlideShare and other online presentation sites.
- See what else the Widget Connector macro can do.

Showing activity streams

Make your Confluence pages dynamic and interactive with:

- An activity stream showing updates and comments on Confluence and other linked applications. See Working with Confluence Gadgets.
- An RSS feed from within Confluence or an external site. See Subscribing to RSS Feeds within Confluence.
- A list of recent blog posts from within Confluence. See Blog Posts Macro.

**Working with Templates**

When you add a new page, you do not have to write the content from scratch. Instead, you can base your new
page on a template. A template is a Confluence page with predefined content. Some templates are provided by blueprints or add-ons, others are defined by Confluence users.

Some examples of where templates are useful:

- A software development project may have a template for use cases.
- A systems administration space may have a template for defining what information is kept about each server.

Global templates and space templates

In Confluence, there are two places to store your page templates:

- **Space templates**: These page templates are available in a specific space only. People who have space administrator permission can define templates via the space administration screen.
- **Global templates**: These page templates are available in every space on the site. People who have Confluence Administrator permission can define the global templates via the Confluence Administration Console.

System administrators can also download predefined templates.

On this page:

- Creating a template
- Using a template
- Templates provided by blueprints
- Promoting templates in the Create dialog
- System templates

Related pages:

- Adding a Template
- Administering Site Templates
- Importing Templates
- Creating a Page using a Template
- Confluence User's Guide

Creating a template

You can write your template using the Confluence editor. You can also add special variables to the page, if you want to include fields that the author will complete when adding the page. See Adding a Template for more information.

Using a template

Page templates are used only when adding a page. It is not possible to apply a template to an already-existing page. Once a page has been added using a template, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.

See Creating a Page using a Template for more information.

Templates provided by blueprints

A blueprint is a page template with added functionality to help you create, manage and organise content in Confluence.

Confluence ships with some predefined blueprints.
You can also download additional blueprints from the Atlassian Marketplace. You can customise the blueprint templates to suit your individual needs, disable particular blueprints or even develop your own blueprints.

See Working with Blueprints.
Promoting templates in the Create dialog

Space administrators can choose to promote specific templates and blueprints in the Create dialog. Promoting items can help ensure consistency in a space by encouraging users to create particular types of content over blank pages.

The promoted templates or blueprints will appear at the top, with all other content types, including Blank Page and Blog Post collapsed under them. To view the other types of content available choose the Show more link.

To promote a template or blueprint:

1. Go to Space Tools > Content Tools.
   - If your space is using the Documentation theme choose Browse > Space Admin > Templates.
2. Choose Promote next to the templates or blueprints you want to appear in the Create dialog.

   Remember: by promoting a blueprint or template you will be hiding all other items, including blank page and blog post, under the Show more link.

System templates

Confluence also provides 'system templates' containing content like the site welcome message and default space content. See Administering Site Templates.

Adding a Template

A template is a predefined page that can be used as a framework when creating new pages. Templates are useful for setting a common style or format for a page.

In Confluence, there are two places to store your page templates:

- **Space templates:** These page templates are available in a specific space only. People who have space administrator permission can define templates via the space administration screen.

- **Global templates:** These page templates are available in every space on the site. People who have Confluence Administrator permission can define the global templates via the Confluence Administration Console.

Adding a space template

Space templates are available in one space only.

To add a template for a space:

1. Go to the space and choose Space tools > Content Tools on the sidebar.
2. Choose Templates > Create new template.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The ‘Space Admin’ option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose Templates from the space administration options.
3. Choose Create new template.

The ‘Create Template’ screen will appear. Add content as described below.
Adding a global template

Global templates are available in all spaces in your Confluence site.

To add a global template:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Global Templates and Blueprints in the left-hand panel.
3. Choose Add New Global Template.

The 'Create Template' screen will appear. Add content as described below.

Using the template editor

This illustration shows the template editor with an image, some text, styling, and variables.
The resulting form when the template contains variables

This screenshot shows the form displayed when someone creates a page based on the template containing the above variables. (See Creating a Page using a Template.)
Adding content to your template

Add a name for your template.

Enter text into the body of the template, and use the editor toolbar to apply styles, layout and formatting. You can add links and macros. In general, you can use the Confluence editor in the same way as on a page. In addition, you can add variables which will produce a form for data collection when someone adds a page based on the template.

Below are some points of special interest in templates.

Labels

Choose Labels to add one or more labels to the template. These labels will be included in all pages created using this template.

Images and other attachments

You can't attach an image or other file to a template. Instead, attach the file to another page, and insert it into the body of the template.

For example:

- You can attach an image to a page and then choose **Insert > Image** to embed the image into the template.
- You can attach a PDF to a page and then choose **Insert > Other Macros > PDF** to embed the PDF into the template.

### Variables used as form fields

You can add variables to your template, to act as form fields. When someone creates a page based on the template, Confluence will display a text entry box for each field. The user can enter data into each field, and the data is inserted onto the new page.

Every variable must have a unique name. If you add the same variable more than once in the same template, Confluence will make sure that they have the same value when the user saves the page. This is useful if you need the same information in more than one place in the page.

**To insert a variable into a template:**

1. Place your cursor on the template where you want the variable to appear.
2. Choose **Template > New Variable** from the editor toolbar. Alternatively, you can choose the name of an existing variable if you want the same variable to appear more than once in the template.
3. Enter the variable name.
4. Press **Enter**. By default this will create a single-line text input field.
5. To change the variable type, click the variable placeholder. The variable's property panel will appear. Choose one of the variable types: **Text**, **Multi-line Text** or **List**. See below for a description of each type.

**Speeding up variable entry with autocomplete:** Type $ and the variable name, then press Enter, to add a new variable or to select an existing variable from a list of suggestions. The suggestions are drawn from variables already defined in this template.

These are the types of variable available:

<table>
<thead>
<tr>
<th>Variable type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Text</strong></td>
<td>Creates a single-line text input field. <em>Screenshot: A template variable called $purpose and its property panel</em></td>
</tr>
<tr>
<td><strong>Multi-line text</strong></td>
<td>Creates a text box that allows more than one line of text. By default, the text area is 5 rows depth and 100 characters wide. You can change the size by typing over the digits in the variable property panel. <em>Screenshot: A multi-line variable and its property panel</em></td>
</tr>
</tbody>
</table>
| **List**      | Creates a dropdown list. You must specify the values that will appear in the dropdown list. The values:  
   - Must be separated by commas.  
   - Can include letters, numbers, special characters, and spaces.  
   - Cannot include commas (except as the list separation character). *Screenshot: A list variable and its property panel* |

### Instructional text

Instructional text allows you to add placeholder content to a template. This text is only visible in the editor and disappears when the author of the page begins typing.

**To insert instructional text into a template:**

1. Place your cursor on the template where you want the instructional text to appear.
2. Choose **Template > Instructional Text** on the editor toolbar.
3. Begin typing - the instructional text appears in italics with a shaded background to distinguish it from
normal paragraph text.

You can also change the placeholder type from 'text' to other types, including some that trigger an action such as a user mention or creating a JIRA issue.

The following instructional text types are available:

<table>
<thead>
<tr>
<th>Instructional text type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Creates a line of text that is only visible in the editor. Instructional text disappears when the user begins typing.</td>
</tr>
<tr>
<td>User Mention</td>
<td>Creates a line of text that is only visible in the editor. When clicked it triggers the @mentions dialog.</td>
</tr>
<tr>
<td>JIRA Issue</td>
<td>Creates a single link of text that is only visible in the editor. When clicked it triggers the JIRA Issues macro dialog. Users can then search for or create a new issue.</td>
</tr>
</tbody>
</table>

Adding a description to your template

The template description displays in the 'Create' dialog and is useful for explaining the purpose of a template to users.

To add a description to a template:

- Go to the space or global templates page (as described above).
- Choose the Edit icon in the ‘Description’ column.
- Enter your description and save.

Converting an existing page to a template

If you would like to convert an existing page to a template, you can copy the content from the page and paste it into the template editor. There is no automated way of doing this.

Please note the section above about images and other attachments in templates.

Notes

- You cannot insert variables via the 'Insert wiki markup' option in the editor toolbar.
Page templates are used only when adding a page. It is not possible to apply a template to an already-existing page. Once a page has been added using a template, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.

When you use a Table of Contents macro in a template, you will see an error when you preview the template itself. But the Table of Contents macro works on the pages that people create from the template – the table of contents shows up after they have saved the page. (This is probably because the template is not defined as a page, and the Table of Contents macro works for pages only.)

The editor for templates is available only in Confluence 4.3 and later. Please refer to the earlier documentation for a description of the wiki markup editor templates.

Confluence also provides ‘system templates’ containing content like the site welcome message and default space content. See Administering Site Templates.

Creating a Page using a Template

You can create a page based on a global template (available to all spaces) or a space template (available only to that space). Before reading this page, make sure that someone has already created a template on your Confluence site.

Information copied from the template to the page

When you create a page based on a template, Confluence will copy the following content and information from the template to the new page:

- Labels
- Text and styles
- Layouts and formatting
- Macros
- Embedded images and other files. Note that you cannot attach an image or other file to a template. But if the template displays an image or file from another page, the new page will display that image or file too.

Form fields displayed by the template

If the template author included variables in the template, Confluence will display a form prompting you to supply values for the variables when you add the page.

To create a page based on a template:

1. Choose Create on the header
2. Select a space and the template you want to use and choose Next
3. If the template contains variables, you will now see a form. Type the relevant information into the form fields, and choose Next.
4. Now you will see a new page based on the template. If you added information in the form fields, the page content will include that information.
5. Type a name for the page where you see 'New Page'.
6. Add more content or make any other changes required.
7. Choose Save.

Screenshot: Form showing template variables when creating a page from a template
Page templates are used only when adding a page. It is not possible to apply a template to an already-existing page. Once a page has been added using a template, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.

Editing a template

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format. This page is about changing an existing template.

**Note:** Page templates are used only when adding a page. It is not possible to apply a template to an already-existing page. Once a page has been added using a template, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.

In Confluence, there are two places to store your page templates:

- **Space templates:** These page templates are available in a specific space only. People who have space administrator permission can define templates via the space administration screen.
- **Global templates:** These page templates are available in every space on the site. People who have Confluence Administrator permission can define the global templates via the Confluence Administration Console.

Confluence also provides 'system templates' containing content like the site welcome message and default space content. See Administering Site Templates.
To edit a space template:

1. Go to the space and choose Space tools > Content Tools on the sidebar.
2. A list of templates for the space displays. Choose Edit next to the template that you want to modify.
3. Make changes, or add new content, as you would when adding a template.
4. Choose Save.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose Templates from space administration options.
3. A list of templates for the space displays. Choose Edit next to the template that you want to modify.
4. Make changes, or add new content, as you would when adding a template.
5. Choose Save.

To edit a global template:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Global Templates and Blueprints in the left-hand navigation panel.
3. A list of templates for the Confluence site displays. Choose Edit next to the template that you want to modify.
4. Make changes, or add new content, as you would when adding a template.
5. Choose Save.

For more information on editing the content of a template, including adding macros, variables and instructional text see - Adding Content to a Template.

Deleting a Template

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format. This page is about deleting an existing template, at space level or at site (global) level.

Templates are used only when adding a page. Once a page has been added, the template is no longer linked to the page. You can therefore delete the template without affecting any existing pages.

You need to be a space administrator to delete a space template, and you need Confluence Administrator permissions to delete a global template.

Note: Deleted templates cannot be restored.

To delete a space template:

1. Go to the space and choose Space tools > Content Tools on the sidebar.
2. A list of templates for the space displays. Choose Delete next to the template that you want to delete.
3. Confirm the deletion when prompted.

If your space uses the Documentation Theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose Templates from the space administration options.
3. A list of templates for the space displays. Choose Delete next to the template that you want to delete.
4. Confirm the deletion when prompted.
To delete a global template:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Global Templates and Blueprints in the left-hand navigation panel.
3. A list of templates for the Confluence site displays. Choose Delete next to the template that you want to delete.
4. Confirm the deletion when prompted.

Working with Blueprints

What is a blueprint?

A blueprint is a set of page templates with added functionality to help you create, manage and organise content in Confluence more easily.

Create meeting notes, shared file lists and requirements documentation out of the box. Customise the blueprint templates to suit your individual needs. You can even develop your own blueprints.

On this page:
- Creating content using a blueprint
- Customising blueprint templates
- Promoting blueprints in the Create dialog
- Adding more blueprints
- Disabling a blueprint
- Full list of blueprints

Related pages:
- Working with Templates
- Confluence User's Guide
- Requesting Add-ons

Creating content using a blueprint

You create a page from a blueprint in the same way as other pages in Confluence. All blueprints are different and most contain instructions to guide you.

To create a page from a blueprint in the current space:

1. Choose Create on the header.
2. Choose a blueprint from the 'Create' dialog.
3. Choose Create.
4. The editor will open, a prompt to enter information, or the page will appear, depending on the blueprint selected. You can now follow the instructions built in to the blueprint to add content.

The first time a blueprint is used in a space, Confluence creates an index page and adds a shortcut to your sidebar (if you are using the default theme). The index shows information from your blueprint pages, for example the meeting notes index displays a list of all meeting notes pages in the space.

Screenshot: Index page for the Meeting Notes blueprint
If you are using the Documentation theme, your blueprint index pages will appear in the sidebar as children of the homepage.

**Screenshot: Index page for the File List blueprint with the Documentation theme applied to the space**

Customising blueprint templates

Blueprints are made up of templates that can be customised for an individual space or the whole site. This means you can adapt the content of the blueprint pages to suit your specific needs. For example, you might update the Meeting Notes blueprint templates to include a heading for apologies.

If you have **space administrator permissions**, you can customise blueprint templates for the spaces you are an administrator of. You must be a Confluence Administrator to customise blueprint templates for a whole site. See **Administering Site Templates** for more information.

To customise a blueprint template for a space:

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose **Edit** beside the blueprint template you wish to edit.
3. Make your changes to the template and choose **Save**.

Editing a blueprint template is very similar to editing a page template except:

- You should be careful not to remove any macros that the blueprint page or index page may use to store and display information.
- You cannot remove a blueprint template or change the template name.

To reset a blueprint template back to the default:

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose **Reset to default** beside the blueprint template you wish to reset.
See Working With Templates and Administering Site Templates for more information on templates.

As with user created space and site templates, editing a blueprint template will not change existing pages, but any new blueprint pages will be based on the updated template.

Promoting blueprints in the Create dialog

Space administrators can choose to promote specific templates and blueprints in the Create dialog. Promoting items can help ensure consistency in a space by encouraging users to create particular types of content over blank pages.

The promoted templates or blueprints will appear at the top, with all other content types, including Blank Page and Blog Post collapsed under them. To view the other types of content available choose the Show more link.

**To promote a template or blueprint:**

1. Go to Space Tools > Content Tools.
   - If your space is using the Documentation theme choose Browse > Space Admin > Templates.
2. Choose Promote next to the templates or blueprints you want to appear in the Create dialog.

Remember: by promoting a blueprint or template you will be hiding all other items, including blank page and blog post, under the Show more link.

Adding more blueprints

You can find more blueprints for Confluence in the Atlassian Marketplace. Blueprints are managed using add-ons (also known as plugins).

See Requesting Add-ons for information on how you can search for new blueprint add-ons and send a request to your System Administrator.

If you are a System Administrator, see Managing Add-ons or Plugins for information on how to install new blueprint add-ons.

You can also develop your own blueprints. See our developer documentation on Writing a Blueprint.

Disabling a blueprint

You may want to disable particular blueprints. For example, you may not want to see the Product Requirements blueprint in the Create dialog in a HR or Social space. If you are a Confluence Administrator you can also disable particular page and space blueprints for the whole site.

**To disable a blueprint in a space:**

- Go to the space and choose Space tools > Content Tools on the sidebar.
- Choose Disable next to the blueprint you wish to disable in that space.

You can re-enable the blueprint at any time.

**To disable a blueprint across a whole site:**
• Choose the cog icon, then choose General Configuration under Confluence Administration. You need Confluence Administrator permissions to do this.
• Choose Global Templates and Blueprints.
• Choose Disable next to the page or space blueprint you wish to disable.

The blueprint will not appear in the ‘Create’ or ‘Create Space’ dialogs.

Full list of blueprints

Here’s the full list of blueprints that are bundled with Confluence.

<table>
<thead>
<tr>
<th>Page blueprints</th>
<th>Space blueprints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting notes</td>
<td>Documentation space</td>
</tr>
<tr>
<td>File list</td>
<td>Team space</td>
</tr>
<tr>
<td>Decision</td>
<td>Knowledge base space</td>
</tr>
<tr>
<td>How-to article</td>
<td></td>
</tr>
<tr>
<td>Troubleshooting article</td>
<td></td>
</tr>
<tr>
<td>JIRA report</td>
<td></td>
</tr>
<tr>
<td>Product requirements</td>
<td></td>
</tr>
<tr>
<td>Retrospective</td>
<td></td>
</tr>
<tr>
<td>Share a link</td>
<td></td>
</tr>
<tr>
<td>Task report</td>
<td></td>
</tr>
</tbody>
</table>

Decisions Blueprint

The Decisions blueprint helps you make decisions and record the outcomes with your team.

The first time you use the Decisions blueprint in a space, Confluence will create an index page and add a shortcut on your space sidebar (if you are using the default theme). The index acts as your Decision Register and lists all the decisions in that space.

Related pages:
• Working with Blueprints
• File List Blueprint
• Meeting Notes Blueprint
• Product Requirements Blueprint

To use the Decisions blueprint:
• Create a Decisions blueprint page (choose Create > Decision)
• Enter information about the decision and stakeholders - the blueprint will prompt you.

Screenshot: Decision Register showing a series of Decision pages.

<table>
<thead>
<tr>
<th>Decision</th>
<th>Status</th>
<th>Owner</th>
<th>Stakeholders</th>
<th>Due date</th>
<th>Outcome</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is our target launch date?</td>
<td>IN PROGRESS</td>
<td>Leah Admin</td>
<td>@Sophie User</td>
<td>14 Jun 2013</td>
<td></td>
</tr>
<tr>
<td>What tools should we use?</td>
<td>NOT STARTED</td>
<td>Josh User</td>
<td>Ewan User, @Leah Admin</td>
<td>21 Jun 2013</td>
<td></td>
</tr>
<tr>
<td>What should we call the project?</td>
<td>DECIDED</td>
<td>Leah Admin</td>
<td>Leah Admin, @Sophie User</td>
<td>03 Jun 2013</td>
<td>Blue Sky Project</td>
</tr>
<tr>
<td>Where should we track the project?</td>
<td>DECIDED</td>
<td>Rach Admin</td>
<td>Rach Admin, Rach Admin</td>
<td>07 Jun 2013</td>
<td>Confluence and JIRA</td>
</tr>
</tbody>
</table>

Screenshot: Editing a Decision page.
The Decisions blueprint uses these Confluence features:

- **Page Properties** and **Page Properties Report** macro - content that you enter within the page properties macro can appear on the index page.
- **Mentions** - add a user as a stakeholder, owner or @mention them on the page and they will be notified in their workbox.

**Customising this blueprint**

You can customise the templates that are used by the Decisions blueprint - see **Customising the blueprint templates**.

You might choose to edit the **index** page in a space to change the columns to be displayed by the Page Properties Report macro.

You might choose to edit the **page template** to add some headings or instructional text to the background section, or even add rows to the Page Properties macro, for example a row for the date the decision was made.

To find out more about using instructional text in a template see - Instructional text.

**File List Blueprint**

The File List blueprint helps you to create lists of files to share with your team. Great for organising documents, images and presentations.

The first time you use the File List blueprint in a space, Confluence will create an index page and add a shortcut to your space sidebar (if you are using the default theme). The index page lists the latest File List pages in that space. You can have as many File List pages as you need.

**Related pages:**

- Working with Blueprints
- Meeting Notes Blueprint
- Product Requirements Blueprint

**To use this blueprint:**

- Create a File List page (choose **Create > File List**).
- Drag files from your desktop or choose Browse to attach files to the page.
- Attachments appear on the page. Expand each attachment to preview the file or see attachment details.

In this example three File List pages have been created to store project related presentations, images and
customer feedback. Confluence looks after the versioning of the files, so there is no need to use the document file name to mark version numbers.

Screenshot: Index page showing File List pages.

Screenshot: A File List page.
Customising this blueprint

You can customise the templates that are used by the File List blueprint - see Customising blueprint templates.

The File List blueprint template uses the attachments macro. You could customise the macro to change the sort order or hide features such as version history and the upload attachment fields. To find out more about the attachments macro see Displaying a List of Attachments.

You can also edit the Content Report Table macro used on the Index page to specify the number of pages you want to display.

Meeting Notes Blueprint

The Meeting Notes blueprint helps you to plan your meetings and share notes and actions with your team.

The first time you use the Meeting Notes blueprint in a space, Confluence will create an index page and add a shortcut on your space sidebar (if you are using the default theme). The index page lists the latest Meeting Notes pages in that space.

To use the Meeting Notes blueprint:

- Create a Meeting Notes blueprint page (choose Create > Meeting Notes).
- Enter goals, agenda items, @mention attendees - the instructional text will prompt you.
- Save your page and get ready to attend your meeting.
- During or after your meeting edit the page and enter your notes, action items and @mention users to assign them to tasks.

Related pages:
- Working with Blueprints
- File List Blueprint
- Product Requirements Blueprint

Screenshot: Index showing three Meeting Notes pages.

Screenshot: A blank Meeting Notes page showing instructional text.
The Meeting Notes blueprint uses some cool Confluence features:

- **Instructional text** - this handy text prompts you to enter information and disappears when you start typing or view the page.
- **Mentions** - @mention a user on the page and they will be notified in their workbox.
- **Task lists** - @mention a user in a task to assign them - the task will appear as a personal task in their workbox.

**Customising this blueprint**

You can customise the templates that are used by the Meeting Notes blueprint - see Customising the blueprint templates.

You might choose to edit the headings or add additional headings, or change the instructional text that prompts users to enter information to suit your context. To find out more about using instructional text in a template see - Instructional text.

You can also edit the Content Report Table macro used on the Index page to specify the number of pages you want to display.

**Product Requirements Blueprint**

The Product Requirements blueprint helps you to define, scope and track requirements for your product or feature.

The first time you use the Product Requirements blueprint in a space, Confluence will create an index page and add a shortcut on your space sidebar (shortcut only available in the default theme). The index lists all the Product Requirements pages in that space, and displays a summary of the information on each page (such as status and owner). You can have as many Product Requirements pages as you need.
To use the Product Requirements blueprint:

- Create a Product Requirements blueprint page (choose Create > Product Requirements)
- Enter information about your product or feature - the instructional text will prompt you.
- Mention team members and other contacts.

Screenshot: Index showing a series of Product Requirements pages and summary information.

Screenshot: Editing a Product Requirements page.
The Product Requirements blueprint uses these Confluence features:

- **Page Properties** and **Page Properties Report** macro - content that you enter within the page properties macro can appear on the index page.
- **Instructional text** - this handy text prompts you to enter information or create a JIRA issue and disappears when you start typing or view the page.
- **Mentions** - @mention a user on the page and they will be notified in their workbox.

**Customising this blueprint**

As no two products or projects are alike, you can customise the templates that are used by the Product Requirements blueprint - see **Customising the blueprint templates**.

You might choose to edit the **index** page in a space to change the columns to be displayed by the Page Properties Report macro.

You might choose to edit the **page template** to:

- edit the headings or add additional headings
- change the instructional text that prompts users to enter information to suit your context
- add or remove rows within the Page Properties macro.

To find out more about using instructional text in a template see - **Instructional text**.

**Shared Links Blueprint**

The Shared Links blueprint helps you take content from the web and share it with your team.
You can use Shared Links to share and collaborate on web content, or to create a centralised repository of useful links.

The first time you use the Shared Links blueprint in a space, Confluence will create an index page and add a shortcut on your space sidebar (if you are using the default theme). The index lists all the shared links in that space.

**Related pages:**
- Working with Blueprints
- Decisions Blueprint
- File List Blueprint
- Meeting Notes Blueprint
- Product Requirements Blueprint

**To use the Shared Links blueprint:**
- Choose Create > Share a link.
- Enter the URL of the web content you want to share.
- Choose Create.

You can also:
- include topics to help categorise your links - these are added as labels to your page.
- share the link immediately with another user or group - users will receive a notification.
- add a comment to start the discussion.

To make sharing links even faster, you can add a Share on Confluence button to your browser's toolbar. Click this button and the webpage you are currently viewing will be added as a shared link!

**To add the Share on Confluence button to your browser:**
- Choose Create > Share a link.
- Drag the Share on Confluence button to your browser toolbar.

Now when you want to share a link on Confluence, you can choose the Share on Confluence button in your browser, and follow the prompts.

*Screenshot: Share a link from the Create dialog.*

---

**JIRA Report Blueprint**

The JIRA Report blueprint helps you create easy to read reports to communicate the progress of your JIRA projects and releases.
You can choose from a Change Log report that generates a list of JIRA issues or a Status Report that includes charts to visually communicate your progress.

The first time you use the JIRA Reports blueprint in a space, Confluence will create an index page and add a shortcut on your space sidebar (if you are using the default theme).

To use the JIRA Report Blueprint your Confluence and JIRA sites must be connected via Application Links.

On this page:
- Creating a Change Log
- Creating a Status Report
- Customising this blueprint

Related pages:
- Working with Blueprints
- JIRA Issues Macro
- JIRA Chart Macro

Creating a Change Log

The Change Log report displays a list of issues from JIRA. This list can be static or dynamic, automatically updating as the status of your issues change in JIRA.

To create a static Change Log:
- Choose Create > JIRA Reports.
- Select a Report Type.
- Select your JIRA server.
- Choose a Project and Fix Version to report on.
- Choose Create.

A report page will be created with some sample text, and a list of all issues for the project and fix versions selected - organised by issue type. This list of issues is static, it will not be updated when the issues in JIRA are updated, and is visible to users who do not have JIRA access or permissions to view that project.

Screenshot: Creating a Change Log in simple mode.

Screenshot: Static list of JIRA Issues displaying in the Change Log.
To create a dynamic change log:

- Choose Create > JIRA Reports.
- Select a Report Type.
- Choose Advanced.
- Enter a JQL query or paste in the URL of a JIRA search. Find out about using JQL in the JIRA Documentation.
- Choose Create.

A report page will be created with sample text and a JIRA issues macro that is configured to show your issues. The macro is dynamic and will update when the issues in JIRA are updated. For more information on how to further change the information displayed, refer to the JIRA Issues macro.

Screenshot: Dynamic list of JIRA Issues displaying in the Change Log.

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>Type</th>
<th>Updated</th>
<th>Priority</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-31163</td>
<td>Cursor doesn't appear in editor in Chrome 30</td>
<td>☑️</td>
<td>Oct 21, 2013</td>
<td></td>
<td>❑ Resolved</td>
</tr>
<tr>
<td>CONF-29057</td>
<td>Automatically embed WuFoo forms and Reports in Confluence when pasting a URL</td>
<td>☑️</td>
<td>Oct 18, 2013</td>
<td></td>
<td>❑ Resolved</td>
</tr>
<tr>
<td>CONF-27451</td>
<td>Login should say &quot;Log in&quot;</td>
<td>☑️</td>
<td>Oct 02, 2013</td>
<td></td>
<td>❑ Resolved</td>
</tr>
</tbody>
</table>

3 issues  Refresh

Creating a Status Report

The Status Report displays the progress of a JIRA project and fix version in pie charts by status, priority, component and issue type. The Status Report uses the JIRA Chart macro, and is dynamic.

To create a status report:

- Choose Create > JIRA Reports.
- Select Status Report.
- Select your JIRA server.
- Choose a Project and Fix Version to report on or enter a JQL query or JIRA URL.
- Choose Create.

A report page will be created with sample text and a series of pie charts, using the JIRA Chart macro. The macro is dynamic and will update when the issues in JIRA are updated. For more information refer to the JIRA Chart macro.

As with the Change Log, you can switch to Advanced mode and use JQL or paste in a JIRA URL to search for issues to display in the report.

Screenshot: Excerpt from the Status Report.
Customising this blueprint

You can customise the templates that are used by this blueprint. The Change Log uses the **Snapshot JIRA Report Template** (for static list of issues) and the **Dynamic JIRA Report Template**, and the Status Report uses the **Status Report Template**. See Customising the blueprint templates. Variables represent the JIRA Issues and JIRA Chart Macros - while these cannot be edited, they can be moved around the page or deleted if you do not want every chart to be included.

You might choose to edit the page template to modify the format of the page, change some headings or modify the instructional text. To find out more about using instructional text in a template see - **Instructional text**.

Retrospectives Blueprint

Retrospective blueprints help you track team successes and opportunities after projects or at the end of a sprint. Use this blueprint to document what went well, what needed improvement, and assign actions for the future.

**Related pages:**

- Working with Blueprints
- File List Blueprint
- Meeting Notes Blueprint

Using Retrospective blueprints

Here's how to use this blueprint for your next retrospective:

1. Create a Retrospective from the **Create** button in the header.
   The Run a Retrospective dialog appears with today's date populated in the title.
2. Add teammates and participants.
3. Click **Create**. Your new Retrospective blueprint loads.

The Retrospective blueprint uses the following Confluence features:

- **Page Properties** and the **Page Properties Report** macro make content listed within the macro visible on the index page.
- **Instructional text** prompts you to enter information and disappears when you start typing or view the page.
- **Mention** a user on the page to notify them in their workbox.

**Customising this blueprint**

Every team conducts retrospective meetings differently. You can customise the Retrospectives blueprint template to match your team’s culture and practices. You can:

- Edit headings and pre-populated text.
- Add instructional text to capture specific information.
- Add additional sections and content.
Creating a blueprint style report

Using a combination of templates and macros you can make a wide range of reports for managing anything from customer interviews, product requirements to IT service catalogues and more. In this tutorial we will guide you through the process of creating a blueprint style report.

In this example we will create a multi-team status report. Here’s the scenario we will use for this tutorial.

The Design, Development and QA teams working on the Blue Sky Project need to produce a short status update page each week, containing the focus area for the week, contact person, risks and overall status for each team. They like the way the Product Requirements blueprint works and want to be able to manage their status updates in a similar way.

What do each of the players want out of this report?

- **Project Lead** wants an at a glance report that shows only the status for each team.
- **Team Leads** want a summary report, including the focus areas and risk, just for their team.
- **All team members** want it to be easy to create the new page each week.
- **Management Team** want to see all the details for a week on one page, and do not want to have to look at a different page for each team.

With this scenario in mind, this tutorial will guide you through how to:

1. Create a status update template containing a separate page properties macro for each team's section of the report.
2. Create a high level status report, showing just the status of all teams.
3. Create a summary report for each team.
4. Add a button that can be used to create a new report page each week.

⚠️ You'll need Space Administrator permissions to complete some of the steps in this tutorial.

### 1 Create a status update template

First we will create a page template and add the Page Properties macros.

1. Go to **Space Admin > Content Tools > Templates**.
2. Choose **Create Template**.
3. Give the template a name (in this example the template will be called 'Status Update')
4. Add the skeleton of your status report to the page.

    > Here's what ours looks like...
5. Add a Label to the template (in this example we will add 'status-update' as the label).

Now we will add a Page Properties macro to record the status of the Design team.

1. Add the Page Properties macro to the page (Choose Insert > Other Macros > Page Properties).
2. In the macro body create a two column table and remove the heading row.
3. In the left column enter the column headings for your report, these are known as metadata 'keys' (in this example we will add 'Design Focus', 'Design Status', 'Design Contact' and 'Design Risks').
4. In the right column, leave the cells blank, or enter some instructional text to prompt your users (Choose Template > Instructional Text). We've also added a status macro.
5. Edit the Page Properties macro, and enter a Page Properties ID for this macro (in this example we will use 'status-update-design') this will allow us to report on the status of just the Design team later on.

Repeat this process for the Development and QA teams, remembering to specify a different ID for each macro (we used 'status-update-dev' and 'status-update-qa').

Here's what ours looks like...
Finally, add any other headings, instructional text or content to your template and **Save**. You can enter a **Description** for your template - this appears in the Create dialog.

### 2 Create a report showing the high level status of each team

Next we will create an index page, just like you see in many blueprints.

1. In your space create a new blank page - this will be our ‘Status Report - all teams’ page, showing just the status of each team.
2. Add the Page Properties Report macro to the page (Choose **Insert > Other Macros > Page Properties Report**).
3. Enter the **Label** to report on (in this example it will be ‘status-update’, the label we added to the template page earlier)
4. Leave the **Page Properties ID** field blank - we want to report on all the macros on the page.
5. In the **Columns to Show** field, list the ‘keys’ from each macro that you want to include in the report (in this example we only want to show the values of ‘Design Status’, ‘Dev Status’, ‘QA Status’).
   
   ![Macro Browser](image)

   *See how this looks in the macro browser...*
6. Choose Save to add the macro to the page.

Now we will add a button to the page to allow team leads to easily create new status update pages from the template we created earlier.

1. Add the Create from Template macro to the page (Choose Insert > Other Macros > Create from Template)
2. Enter the text for the button (in this example we will call the button 'Create a new status update')
3. Select the template from the Template Name drop down (in this example our template was called 'Status Update')
4. Specify the title of any pages to be created - this is a great way to keep your titles consistent (in this example we will call the page 'Status update week ending @Date' which will append the current date when the page is created - as in the meeting notes blueprint)
5. Choose Insert.
6. Add any other content, links or images to the page and Save.
7. Add a shortcut to the page on the sidebar (Choose Space Tools > Configure Sidebar > Add Link).

3 Create a separate report for each team

Now we will create some index pages that show a more detailed summary for each team. We'll start with the Design team.

1. Create a new blank page - this will be the 'Design Status Report' index page, showing just information for that team.
3. Enter the Label (the page label is once again 'status-update', the label we added to the template)
4. Enter the Page Properties ID that was specified in the Page Properties macro in the template (in this example it was 'status-report-design') - this allows us to report on just information in that macro.
5. Leave the Columns to Show field blank this time, we want to show all columns from this Page Properties macro.
   - See how this looks in the macro browser...
6. Choose **Save** to add the macro to the page.
7. Add any other content, links or images to the page and **Save**.
8. Add a shortcut to the page on the sidebar (Choose **Space Tools > Configure Sidebar > Add Link**)

Create a new page and repeat this process for each team, remember to specify a different Page Properties ID each time (in this example 'status-report-dev' and 'status-report-qa').

If your Design, Dev and QA teams have their own team spaces, this summary report could even be created in their team spaces. Just be sure to specify the space where the Status Updates pages are created in the **Restrict to spaces** field, to make sure the macro can find the pages to report on.

4 **Create your first status update page**

That’s it - choose **Create > Status Update** or use the **Create a new status update** button to make your first status update page. Just like a blueprint, but 100% made by you.

Here’s how our finished pages look.

*Team Leads and the management team still have a single page for the weekly status update.*
The Project Lead can see the status of each team, each week, at a glance in the All Teams status report.

Each team can see their focus, risks and status at a glance in their status report.
Remember, these concepts don't just apply to status updates - you can use them for any purpose at all. Tell us about how you've made your own blueprint style reports in comments.

**Working with the Office Connector**

The Office Connector is bundled with Confluence 2.10 and later. It allows you to:

- Import an Office document into Confluence format
- Attach an Office document to a Confluence page and display its content in Confluence, without converting the content.
- Edit the attached document in the Office application, directly from the Confluence page.

Please be aware that source code is currently not available for the Confluence Office Connector.

**Table of Contents**

- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector

**Related Topics**

- View File Macro
- Confluence User's Guide
- Configuring the Office Connector
- Office Connector Prerequisites

The page describes the software and setup you need to use the Office Connector.

**System Administrators** can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector and discuss any configuration problems with your administrator.

**Overall prerequisites**

- The WebDAV plugin must be enabled, because the Office Connector uses WebDAV to transfer information to and from Office documents. The WebDAV plugin is bundled with Confluence, and can be enabled or disabled by the System Administrator. If necessary, refer to the instructions on enabling plugins and configuring the WebDAV options.
• Ensure that your Confluence server's base URL is set correctly (see Configuring the Server Base URL to find out how to check this). When a user edits a Confluence page in Word and then uploads the page back to the Confluence server, the base URL determines where the document will be saved. If the base URL is incorrect, the documents may be saved to a different Confluence server.

**Prerequisites for viewing Office and PDF files in Confluence**

If you want to use the View File macro, or to view Office files attached to a Confluence page, you need the setup described below. Browsers and Flash Player

You can use any browser to view an Office file on a page or attachment view, provided that you have installed Adobe Flash Player version 9 or later. You do not need to have an Office application installed on your computer in order to view Office files in Confluence.

**File Types**

Confluence can display files compatible with Microsoft Office 97-2013, and PDF files, of the following types:

- .doc and .docx
- .xls and .xlsx
- .ppt and .pptx
- .pdf

**Prerequisites for importing Word documents into Confluence**

- Document import can import Microsoft Word documents of the file types .doc and .docx. These must be valid Word 97-2013 format documents.

**Prerequisites for editing Office files directly from Confluence**

The Office Connector allows you to edit Office files embedded in a Confluence page or in the attachments list for a page.

To make use of these editing capabilities, you will need the setup described below.

**Browsers**

- If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first time the add-on is required. You will find instructions in Installing the Firefox Add-On for the Office Connector.

  **Note: No Chrome support.** Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: CONF-23322.

**Operating Systems**

Editing Microsoft Office files in Mac OSX is not supported. Please refer to this issue for more information CONF-17250.

**Office editors**

To edit Office files, you will need to have Microsoft Office or OpenOffice installed (see the configuration matrix
If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See *Installing the Firefox Add-On for the Office Connector*.

If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in OpenOffice when using Internet Explorer.

### Configuration matrix

You need one of the following software combinations to edit Office files from your Confluence page.

<table>
<thead>
<tr>
<th>Software</th>
<th>Operating System</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Office 2013</td>
<td>• Windows 7 • Windows 8</td>
<td>• Internet Explorer 11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Firefox – latest stable version</td>
</tr>
<tr>
<td>Microsoft Office XP, 2003, 2007, 2010</td>
<td>• Windows 7 • Windows Vista • Windows XP (Service Pack 2 or 3)</td>
<td>• Internet Explorer supported versions • Firefox – latest stable version</td>
</tr>
<tr>
<td><strong>OpenOffice 2.x – 3.x</strong></td>
<td>• Windows 7 • Windows Vista • Windows XP (Service Pack 2 or 3) • OS X • Linux</td>
<td>• Firefox – latest stable version • Internet Explorer supported versions (Windows Platforms only)</td>
</tr>
</tbody>
</table>

Note: The only known supported Office editor for Linux is OpenOffice. But in theory it should work with any WebDAV-aware application.

If you experience problems editing documents using the Office Connector (using an application, operating system and browser combination above) please [raise an issue](https://confluence.atlassian.com/doc/raise-an-issue) and tell us as much as you can about your operating system, application version, document version (if its different to the version of Office / Open Office you're using to open the document) and browser.

### Displaying Office Files in Confluence

Confluence can display Office files that are attached to a page. If you have an Office application installed, you will also be able to edit these Office files in your Office application.

These are two of the ways that Confluence can interact with Office files. For an overview of all Office Connector features, please refer to *Working with the Office Connector*.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to *Configuring the Office Connector* in the *Confluence Administration Guide* and discuss any configuration problems with your administrator.

---

**Prerequisites**

If you want to use the View File macro, or to view Office files attached to a Confluence page, you need the setup...
You can use any browser to view an Office file on a page or attachment view, provided that you have installed Adobe Flash Player version 9 or later. You do not need to have an Office application installed on your computer in order to view Office files in Confluence.

File Types

Confluence can display files compatible with Microsoft Office 97-2013, and PDF files, of the following types:

- .doc and .docx
- .xls and .xlsx
- .ppt and .pptx
- .pdf

**Attaching and displaying Office files and PDF files**

There are two ways to do this in Confluence:

- Attach Office files to a page and display them in a Confluence page using the View File or Attachments macros.
- Attach an Office or PDF file to a page and embed its contents onto the page by simply dragging and dropping it into the editor window.

**To attach and display Office files in Confluence using macros:**

1. Attach the Office file(s) to a Confluence page:
   - View the Confluence page on which you want to display your document.
   - Choose Tools > Attachments.
   - Browse for your Office files and upload them to the Confluence page. Refer to detailed instructions in Attaching Files to a Page.
2. Now you have two options for displaying the attached document:
   - You can embed the document into the Confluence page, using one of the Office Word, Office Excel, Office PowerPoint or View PDF macros. These macros can be found using the macro browser. Refer to the detailed instructions in the View File macro topic.
   - You can display a list of page attachments using the Attachments macro. People viewing the page will be able to click the View link to see the Office or PDF document in Confluence.

**To attach and display an Office file on a Confluence page using 'drag and drop':**

- Drag the Office file from your computer and drop it into the editor window. Only one file can be dragged and dropped at a time. The appropriate View File macro placeholder will appear in the position where you dragged the file. However, the contents of the file will be rendered in full when you preview, or save and view, the page. Older browser versions may not support drag and drop - refer to Using Drag-and-Drop in Confluence.

**Viewing and Editing the Attached Office Files**

If an Office document is attached to a Confluence page, you can view the attached Office document from within Confluence. View the Office document in one of the following ways:

- View the list of attachments for a specific Confluence page, then click View next to the Office document on the Attachments page. (See Viewing Attachment Details.)
- View a list of attachments displayed on a page via the Attachments macro, then click View next to the Office document in the list of attachments. (See Displaying a List of Attachments.)
- View a Confluence page which has the Office document embedded in the page via the View File macro. (See View File Macro.)

Any Confluence user who has an Office application installed will also be able to launch their Office editor from within Confluence:

- Editing an Office Document from Confluence.
- Editing an Office Presentation from Confluence.
- Editing an Office Spreadsheet from Confluence.
Troubleshooting

Problems? Please refer to our guide to the Office Connector limitations and known issues.

Importing a Word Document into Confluence

The Office Connector in Confluence allows you to import a Word document into Confluence, so that the document's content is copied onto one or more Confluence pages.

This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator.

The simplest way to import a Word document is to import the entire content of the document into a single wiki page. By default, the content of the document will be created as a new wiki page.

More advanced options allow you to import the content into a new page, to split a single document into more than one wiki page, and to resolve conflicts in the titles of your pages.

These options are described below.

Prerequisites

Prerequisites for the Office Connector's document import feature:

- Document import can import Microsoft Word documents of the file types .doc and .docx. These must be valid Word 97-2013 format documents.

For a full list of Office Connector prerequisites and limitations, please refer to:

- Office Connector Prerequisites
- Office Connector Limitations and Known Issues

On this page:

- Prerequisites
- Importing a Word Document
- Splitting a Word Document into Multiple Wiki Pages

Related pages:

- Exporting to a Word document
- Working with the Office Connector
- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector
- Confluence User's Guide

Importing a Word Document

The simplest way to import a Word document is to import the entire content of the document into a single wiki page.

This method will replace any existing content on the wiki page.

To import a Word document onto a single wiki page:

1. Create a page in Confluence (see Creating Content) or go to an existing page whose content you want
replaced. View the page in view mode (not edit mode).

2. Choose **Tools > Import Word Document.**

3. Click **Browse** and find the Word document on your local drive or network.

4. Click the **Open** or **Upload** button provided by your browser. The path and file name of the document will now appear in the text box on the Office Connector import screen.

5. Click **Next** on the Office Connector import screen. The import document options screen will display.

6. The import document options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root page title</td>
<td>The title of the wiki page that will contain the information from your imported document.</td>
</tr>
<tr>
<td>Import as a new page in the current space</td>
<td>A new wiki page will be created with the page title specified above.</td>
</tr>
<tr>
<td>Replace &lt;pagename&gt;</td>
<td>The contents of the existing page will be replaced. The page will be renamed to the page title specified above.</td>
</tr>
<tr>
<td>Delete existing children of &lt;pagename&gt;</td>
<td>The existing child pages of the page you are replacing will be deleted.</td>
</tr>
<tr>
<td>Rename imported pages if page name already exists</td>
<td>Assign new names to any new page which would otherwise have a duplicate name. The content of existing pages will remain unchanged.</td>
</tr>
<tr>
<td>Replace existing pages with imported pages of the same title</td>
<td>If imported pages have titles equal to existing pages, then the content of the Word document will overwrite the content on the existing page. Page history will be preserved.</td>
</tr>
<tr>
<td>Remove existing pages with the same title as imported pages</td>
<td>If imported pages have titles equal to existing pages, then the existing pages will be deleted. This will remove the page history as well as the content.</td>
</tr>
<tr>
<td>Split by heading</td>
<td>The content of the Word document will be split over multiple wiki pages. If you don’t want to split your document into multiple wiki pages, leave the default <strong>Don’t split</strong> option selected. For more information on splitting your document, please see below.</td>
</tr>
</tbody>
</table>

7. Click **Import.**

When the upload has finished, the content of the Word document will have been transformed into Confluence page content. You can now view and edit this page in the usual way. There is no connection between the original Word document and this wiki page.

*Screenshot: Empty page ready for import*

*Screenshot: Selecting Word document to import*
Splitting a Word Document into Multiple Wiki Pages

When importing a Word document, you can split a single document into more than one wiki page, based on the heading styles in the document.

By default, the page names will be the same as the heading text. This may result in a conflict, if a page already
exists with the same title. You can instruct the importer how to handle such conflicts.

To import a Word document into multiple wiki pages:

1. Import a Word document as described above. On the import document options screen, choose how to split your document in the ‘Split by heading’ field:
   - ‘Split by heading’ — If you want to split the content under each heading in your document into separate child pages, select the desired heading level to split by. A preview of the page hierarchy that will be created by the split will be displayed under ‘Document Outline’. Each bullet point in the ‘Document Outline’ represents a new page after import into Confluence.
2. Click ‘Import’ to import your document.
3. When the upload has finished, the content of the Word document will have been transformed into Confluence page content. You can now view and edit this page in the usual way. There is no connection between the original Word document and this wiki page.

Screenshot: Splitting a single Word document into multiple wiki pages

Editing an Office Document from Confluence

When viewing a page with an attached Office document, you can launch your Office editor directly from Confluence. This allows you to edit a Word document from within Confluence and save it back to Confluence.

This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector and discuss any configuration problems with your administrator.

Prerequisites for Editing an Attached Office Document

The Office Connector allows you to edit Office files embedded in a Confluence page or in the attachments list for a page.

To make use of these editing capabilities, you will need the setup described below.

Browsers

- If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first
time the add-on is required. You will find instructions in Installing the Firefox Add-On for the Office Connector.

- **Note: No Chrome support.** Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: CONF-23322.

## Operating Systems

Editing Microsoft Office files in Mac OSX is not supported. Please refer to this issue for more information CONF-17250.

### Office editors

To edit Office files, you will need Microsoft Office or OpenOffice installed (see the configuration matrix below).

- If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See Installing the Firefox Add-On for the Office Connector.
- If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in OpenOffice when using Internet Explorer.

## Configuration matrix

You need one of the following software combinations to edit Office files from your Confluence page.

<table>
<thead>
<tr>
<th>Software</th>
<th>Operating System</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Office 2013</td>
<td>Windows 7</td>
<td>Internet Explorer 11</td>
</tr>
<tr>
<td></td>
<td>Windows 8</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td>Microsoft Office XP, 2003, 2007, 2010</td>
<td>Windows 7</td>
<td>Internet Explorer supported versions</td>
</tr>
<tr>
<td></td>
<td>Windows Vista</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td></td>
<td>Windows XP (Service Pack 2 or 3)</td>
<td></td>
</tr>
<tr>
<td>OpenOffice 2.x – 3.x</td>
<td>Windows 7</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td></td>
<td>Windows Vista</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows XP (Service Pack 2 or 3)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OS X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Linux</td>
<td></td>
</tr>
</tbody>
</table>

Note: The only known supported Office editor for Linux is OpenOffice. But in theory it should work with any WebDAV-aware application.

If you experience problems editing documents using the Office Connector (using an application, operating system and browser combination above) please raise an issue and tell us as much as you can about your operating system, application version, document version (if its different to the version of Office / Open Office you’re using to open the document) and browser.
On this page:

- Prerequisites for Editing an Attached Office Document
- Editing an Office Document in your Office Application
- Troubleshooting

Related pages:

- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector
- Confluence User's Guide.

Editing an Office Document in your Office Application

To edit an Office document in your Office application:

1. There are two ways to do this:

   - From an Office document embedded on a page:
     a. Go to a Confluence page with an Office document embedded on it.
     b. Choose **Edit Document** above the embedded document.

   ![Screenshot: Page with an embedded Word document showing the 'Edit Document' link](image)

   - From an Office document in a list of attachments:
     - If an Office file is **attached to a Confluence page**, you can edit this file directly in your compatible Office application, in one of the following ways:
• View the list of attachments for a specific Confluence page, then click **Edit in Office** next to the Office file on the Attachments page. (See Viewing Attachment Details.)
• View a list of attachments displayed on a page via the Attachments macro, then click **Edit in Office** next to the Office file in the list of attachments. (See Displaying a List of Attachments.)

2. A window will pop up, asking you to confirm that you want to open this document.

   **Screenshot: Confirmation window in Firefox**

   ![Confirmation window in Firefox](image)

   **Screenshot: Confirmation window in Internet Explorer**

   ![Confirmation window in Internet Explorer](image)

3. Click ‘OK’. Now you may be asked to log in to your Confluence server.
4. Enter your Confluence username and password, then choose ‘OK’.
5. The Office document will open in your Office application.
6. Make the necessary changes, then save the document. It will be saved back into Confluence.

**Troubleshooting**

Problems? Please refer to our guide to the Office Connector limitations and known issues.

**Editing an Office Spreadsheet from Confluence**

When viewing a page with an attached Office document, you can launch your Office editor directly from Confluence. This allows you to edit an Excel spreadsheet from within Confluence and save it back to Confluence.

This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.
Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector and discuss any configuration problems with your administrator.

On this page:

- Prerequisites for Editing an Attached Office Spreadsheet
- Editing an Office Spreadsheet in your Office Application
- Troubleshooting

Related pages:

- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector

Prerequisites for Editing an Attached Office Spreadsheet

The Office Connector allows you to edit Office files embedded in a Confluence page or in the attachments list for a page.

To make use of these editing capabilities, you will need the setup described below.

Browsers

- If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first time the add-on is required. You will find instructions in Installing the Firefox Add-On for the Office Connector.
- Note: No Chrome support. Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: CONF-23322.

Operating Systems

Editing Microsoft Office files in Mac OSX is not supported. Please refer to this issue for more information CONF-17250.

Office editors

To edit Office files, you will need to have Microsoft Office or OpenOffice installed (see the configuration matrix below).

- If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See Installing the Firefox Add-On for the Office Connector.
- If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in
OpenOffice when using Internet Explorer.

**Configuration matrix**

You need one of the following software combinations to edit Office files from your Confluence page.

<table>
<thead>
<tr>
<th>Software</th>
<th>Operating System</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Office 2013</td>
<td>Windows 7</td>
<td>Internet Explorer 11</td>
</tr>
<tr>
<td></td>
<td>Windows 8</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td>Microsoft Office XP, 2003, 2007, 2010</td>
<td>Windows 7</td>
<td>Internet Explorer supported versions</td>
</tr>
<tr>
<td></td>
<td>Windows Vista</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td></td>
<td>Windows XP (Service Pack 2 or 3)</td>
<td></td>
</tr>
<tr>
<td>OpenOffice 2.x – 3.x</td>
<td>Windows 7</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td></td>
<td>Windows Vista</td>
<td>Internet Explorer supported versions</td>
</tr>
<tr>
<td></td>
<td>Windows XP (Service Pack 2 or 3)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OS X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Linux</td>
<td></td>
</tr>
</tbody>
</table>

Note: The only known supported Office editor for Linux is OpenOffice. But in theory it should work with any WebDAV-aware application.

If you experience problems editing documents using the Office Connector (using an application, operating system and browser combination above) please [raise an issue](#) and tell us as much as you can about your operating system, application version, document version (if its different to the version of Office / Open Office you’re using to open the document) and browser.

**Editing an Office Spreadsheet in your Office Application**

To edit an Office spreadsheet in your Office application:

1. There are two ways to do this:

   - **From an Office spreadsheet embedded on a page:**
     a. Open a Confluence page with an Office document embedded on it.
     b. Choose **Edit Document** above the embedded content.

     *Screenshot: The title bar showing 'spreadsheet.xls' above an embedded Excel spreadsheet*

   - **From an Office spreadsheet in a list of attachments:**
     - If an Office file is attached to a Confluence page, you can edit this file directly in your compatible Office application, in one of the following ways:
       - View the list of attachments for a specific Confluence page, then click **Edit in Office** next to the Office file on the Attachments page. (See Viewing Attachment Details.)
       - View a list of attachments displayed on a page via the Attachments macro, then click **Edit in Office** next to the Office file in the list of attachments. (See Displaying a List of Attachments.)
2. A window will pop up, asking you to confirm that you want to open this document.

Screenshot: Confirmation window in Firefox

```plaintext
Warning!
The following location is going to be opened on your computer:

By the program:
C:\Program Files\Microsoft Office\OFFICE11\EXCEL.EXE

This poses a security risk. If you didn't initiate this action or you don't trust the source of the file, please click Cancel.

OK  
Cancel
```

Screenshot: Confirmation window in Internet Explorer

```plaintext
File Download
Some files can harm your computer. If the file information looks suspicious or you do not fully trust the source, do not open the file.

You are opening the following file:

File name: spreadsheet.xls
From: extronet.atlassian.com

OK  
Cancel
```

3. Click 'OK'. Now you may be asked to log in to your Confluence server. Enter your Confluence username and password, then click 'OK'.
4. The Office spreadsheet will open in your Office application.
5. Make the necessary changes, then save the spreadsheet. It will be saved back into Confluence.

Troubleshooting

Problems? Please refer to our guide to the Office Connector limitations and known issues.

Editing an Office Presentation from Confluence

When viewing a page with an attached Office document, you can launch your Office editor directly from Confluence. This allows you to edit a PowerPoint presentation from within Confluence and save it back to Confluence.

This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector and discuss any configuration problems with your administrator.

Prerequisites for Editing an Attached Office Presentation
The Office Connector allows you to edit Office files embedded in a Confluence page or in the attachments list for a page.

To make use of these editing capabilities, you will need the setup described below.

**Browsers**

- If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first time the add-on is required. You will find instructions in [Installing the Firefox Add-On for the Office Connector](#).
- **Note: No Chrome support.** Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: CONF-23322.

**Operating Systems**

Editing Microsoft Office files in Mac OSX is not supported. Please refer to this issue for more information CONF-17250.

**Office editors**

To edit Office files, you will need to have Microsoft Office or OpenOffice installed (see the configuration matrix below).

- If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See [Installing the Firefox Add-On for the Office Connector](#).
- If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in OpenOffice when using Internet Explorer.

**Configuration matrix**

You need one of the following software combinations to edit Office files from your Confluence page.

<table>
<thead>
<tr>
<th>Software</th>
<th>Operating System</th>
<th>Browser</th>
</tr>
</thead>
</table>
| Microsoft Office 2013 | • Windows 7  
• Windows 8 | • Internet Explorer 11  
• Firefox – latest stable version |
• Windows Vista  
• Windows XP (Service Pack 2 or 3) | • Internet Explorer supported versions  
• Firefox – latest stable version |
| OpenOffice 2.x – 3.x | • Windows 7  
• Windows Vista  
• Windows XP (Service Pack 2 or 3)  
• OS X  
• Linux | • Firefox – latest stable version  
• Internet Explorer supported versions  
(Windows Platforms only) |

Note: The only known supported Office editor for Linux is OpenOffice. But in theory it should work with any WebDAV-aware application.

If you experience problems editing documents using the Office Connector (using an application, operating system and browser combination above) please [raise an issue](#) and tell us as much as you can about your operating system, application version, document version (if its different to the version of Office / Open Office you’re using to open the document) and browser.
Editing an Office Presentation in your Office Application

To edit an Office presentation in your Office application:

1. There are two ways to do this:

   - From an Office presentation embedded on a page:
     a. Open a Confluence page with an Office presentation embedded on it.
     b. Click the 'Edit' icon on the bottom frame of the slide show.
1. From an Office document in a list of attachments:
   - If an Office file is attached to a Confluence page, you can edit this file directly in your compatible Office application, in one of the following ways:
     - View the list of attachments for a specific Confluence page, then click Edit in Office next to the Office file on the Attachments page. (See Viewing Attachment Details.)
     - View a list of attachments displayed on a page via the Attachments macro, then click Edit in Office next to the Office file in the list of attachments. (See Displaying a List of Attachments.)

2. A window will pop up, asking you to confirm that you want to open this document.

   Screenshot: Confirmation window in Firefox
3. Click 'OK'. Now you may be asked to log in to your Confluence server. Enter your Confluence username and password, then click 'OK'.
4. The presentation will open in your Office application.
5. Make the necessary changes, then save the presentation. It will be saved back into Confluence.

**Troubleshooting**

Problems? Please refer to our guide to the Office Connector limitations and known issues.

**Installing the Firefox Add-On for the Office Connector**

If you are using Firefox as your browser, you will need to install an add-on into Firefox (the Firefox WebDAV Launcher) in order to use some features of the Office Connector. You will be prompted to install the add-on the first time you try to use a function which requires it.

For an overview of all Office Connector features, please refer to Working with the Office Connector.

**Note about supported web browsers:** Please ensure that you are using one of the web browsers supported by Confluence. If you are using an unsupported browser or browser version, some features may not work correctly. Check the Supported Platforms page to find the list of supported web browsers and browser versions on this page.
Installing the Firefox Add-On

You will be prompted to install the add-on the first time you try to use a function which requires it. The add-on is required for editing a wiki page in Office, or for editing an Office document which is displayed on a wiki page.

1. When you choose an option which requires the Firefox add-on, you will see a popup window like this one:

2. Click 'OK'. Some browsers may now ask you to confirm the download with a message bar across the top of the page, beneath the browser's address bar.

   • You may see a message like the one shown here:
Click 'Allow'.

- Or you may see a similar message with an 'Edit Options' button like this:

  ![Edit Options Button](image)

  If you see the above message, click 'Edit Options'. You will then see an 'Allowed Sites' window like this:

  ![Allowed Sites Window](image)

  This window lets you tell Firefox that your Confluence server is allowed to install add-ons into Firefox. The 'Address of web site' box should already contain the address of your Confluence server.

  - Click the 'Allow' button to add your Confluence server to the list.
  - Go back to your Confluence page and try to edit your Office document again, e.g. by clicking 'Edit in Word' again. Now you will see the option to install the add-on.

3. A 'Software Installation' window will appear, asking you to confirm the installation. The window will look something like the one below, but the URL will be the address of your own Confluence server:
4. Click 'Install Now'. The installation will happen and a window will pop up asking you to restart Firefox:

5. Make sure you have saved all your Confluence pages and any other work in your browser, then restart Firefox.

6. If Firefox asks you to confirm the restart, confirm it.

7. Firefox will close all the browser windows and will then start up again. You will see a window confirming that a new add-on has been installed, like this:
Configuring the Add-On

After you have installed the add-on into Firefox, you will need to configure it. Basically, you will associate a desktop application (editor) with each relevant file type. This tells the Office Connector which application to launch when it encounters a link to an editable file. The configuration is slightly different for each operating system, as described below.

Configuring the Add-On in Windows

The add-on can will automatically configure itself on Windows via the system registry. The first time you edit a new file type, the add-on will look up the default editor for that file type and make that the permanent setting.

If you want to override the registry settings, or if for some reason the automatic configuration is not working, you can configure the Firefox add-on manually.

1. In Firefox, go to the 'Tools' menu and select 'WebDAV Launcher Options', as shown in this screenshot:
2. A 'WebDAV Launcher Options' window will appear, allowing you to associate a specific file type (file extension) with a desktop application (editor). The window looks like this one:

![WebDAV Launcher Options Window]

3. In the 'File Extension' box, enter the extension for a particular file type. For example, you may want to associate the 'doc' file extension with Microsoft Word 2003 or earlier. To do this, you would type 'doc' in the File Extension text box.

**If you use or have recently upgraded to Office 2007**

In addition to the original Office 2003 file extensions (that is, 'doc', 'ppt' and 'xls'), you should additionally configure the WebDAV launcher to handle the new Office 2007-specific file extensions for Microsoft Word ('docx'), Microsoft Excel ('xlsx') and PowerPoint ('pptx').

Screenshot: Configuring the WebDAV Launcher - adding the 'doc' file extension.
4. Enter the 'Application Path' — Use one of the following methods to specify the associated application for editing the given file type:

- Click the 'Auto' button to load the associated application from the Windows registry.
- Alternatively, you can click the 'Browse' button to find the application on your computer.
- Or you can manually type in the path to the application's executable file.

Screenshot: Configuring the WebDAV Launcher - adding the 'Application Path' for the 'doc' file extension.

If you use or have recently upgraded to Office 2007

Follow the instructions in this step to add the path to the relevant Office 2007 application for the Office 2007 file extension you configured above. For example, if you had a typical
5. Click the 'Add' button. The file extension association will be added to the list. For example, in the picture below you can see that the 'doc' extension has been associated with 'C:\Program Files\Microsoft Office\OFFICE11\WINWORD.EXE'. This is the path to the Microsoft Word 2003 executable on a specific Windows machine.

Screenshot: Configuring the WebDAV Launcher - configuration of the 'doc' file extension complete.

**Configuring the Add-On in Mac OS X**

The configuration procedure is similar to Windows, as shown above. Note that there is no 'Auto' button in Mac OS X.

**Configuring the Add-On in Linux**

The only known supported Office editor for Linux is OpenOffice. (See Office Connector Prerequisites.)

There is no automatic configuration on Linux. You will need to associate each file type with your Office editor in Firefox. Note that there is no 'Auto' button in Linux.

The configuration procedure is similar to Windows, as shown above.

For both Ubuntu and OpenSUSE, the configuration will look something like this:

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Application Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>doc and docx</td>
<td>/usr/bin/oowriter</td>
</tr>
<tr>
<td>ppt and pptx</td>
<td>/usr/bin/ooimpress</td>
</tr>
<tr>
<td>xls and xlsx</td>
<td>/usr/bin/oocalc</td>
</tr>
</tbody>
</table>

**Security Risks**

Please be aware that there are security risks in installing this add-on to Firefox. Internet Explorer is exposed to the same risks, because it can directly open Office documents. By installing the add-in into Firefox, you are exposing Firefox to the same risks.
Summary of the risks:

- Office documents can contain macro viruses. Before opening an Office document, make sure that you trust the source of the document.
- There are known flaws in the Office file formats and Microsoft Office that an attacker can exploit to gain control of your machine. Microsoft has fixed the known exploits in the latest Service Packs for all Microsoft Office versions. But new exploitations may arise at any time. Again, be sure that you trust the source of a document before opening it.

The add-on tries to reduce the risk by supporting the following:

- **Same origin policy** — The add-on can only open documents from the same host that initiated the action.
- **Digital signature** — The add-on is digitally signed. When you install the add-on please verify that it is signed by Benryan Software Inc.

- **Prompt the user for confirmation** — You will always be warned before a file is opened. Please read these warnings carefully before opening a file. The warning tells you the complete URL of the file as well as the complete application path of the application opening the file.

### Information about this Firefox Add-On

<table>
<thead>
<tr>
<th>Add-on name:</th>
<th>WebDAV Launcher</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description:</td>
<td>Adds the ability to launch a WebDAV URL directly in a WebDAV-aware client.</td>
</tr>
<tr>
<td>Latest version:</td>
<td>See the WebDAV Launcher add-on page at Mozilla</td>
</tr>
<tr>
<td>Compatible with:</td>
<td>All versions of Firefox, up to and including the latest stable version.</td>
</tr>
<tr>
<td>Author:</td>
<td>Atlassian Pty Ltd</td>
</tr>
</tbody>
</table>

### Related Topics

Working with the Office Connector

### Importing Content Into Confluence

This page describes how to get text, pages, images and other content into Confluence, by converting the content from another storage format and importing it.
into the Confluence wiki.

**Importing content from other Confluence sites**

For content originating from other Confluence sites, you can:

- Import an entire Confluence site into a new site.
- Import a space from one Confluence site into another. Page history, attachments, and page content will be preserved and you will be able to do multiple pages at once. The drawbacks are that it may be inconvenient if the Confluence versions differ, and you cannot have a duplicate space key on the destination instance.

See [Restoring a Site](#) and [Restoring a Space](#) for more information.

**Importing content from a Microsoft Word document**

The Office Connector in Confluence allows you to import a Word document into Confluence. The document's content is copied onto one or more Confluence pages. See [Importing a Word Document into Confluence](#).

**Importing web content**

Here are some options for importing or displaying web content on a Confluence page:

- Use the [Widget Connector Macro](#) to display videos, slide shows, twitter chats, documents and more, sourced from other web sites and displayed on your Confluence page.
- Embed an external web page into Confluence with the [HTML Include macro](#).
- Use HTML code in a page with the [HTML macro](#).

**Importing other non-wiki content**

Importing non-wiki markup into Confluence requires a conversion process:

- Text with basic formatting can be pasted directly into the editor. This includes simple Word documents or web pages.
- Confluence pages saved to disk can be imported from disk.
- Files can be uploaded in bulk using the [Confluence WebDav Plugin](#).
- Full featured customisation is available using the [Confluence remote APIs](#).

**Importing Pages from Disk**

Confluence allows you to import text files from a directory on the Confluence server, and convert them into Confluence pages. Each file will be imported as a separate Confluence page with the same name as the file.

Notes:

- The text file may contain plain text, HTML or [Confluence Storage Format](#).
- You need to be logged in as a [System Administrator](#) to import text files.
- You can import pages from disk into site spaces, but not into personal spaces. Please see [Working with Spaces](#) for information about differences between site spaces and personal spaces.

**Related pages:**

- Importing Content Into Confluence
- Confluence User's Guide

⚠️ **The information on this page does not apply to Confluence Cloud.**

**To import text files:**

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose **Import**.
3. Type the your directory path into the **Import directory** box.
4. Select **Trim file extensions** to remove file extensions from the page titles when converting the files to Confluence pages. Note that the Confluence pages will take their titles from the files' names (including their extensions). To avoid having page titles with a suffix like `.txt` check this box.
5. Select **Overwrite existing pages** if you want to replace existing Confluence pages that have the same page title as one you are importing.
6. Choose **Import**.

If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen. *Note:* The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose **Import** from the space administration options.
3. Follow the steps above.

Confluence will place the new pages at the root of the space.

**Screenshot: Importing text files**

You can use this action to import text files from a directory on the Confluence server.

These text files become pages in Confluence, with the following features:

- The page title is taken from the filename
- The content is the entire page body

**Import directory**  
**Trim file extensions**  
**Overwrite existing pages**  

**Import**  
**Cancel**

**Sharing Content**

Confluence provides a number of ways for you to notify other people about content that may be of interest to them:

- You can share a page link with them.
- You can mention a user when you write a page, blog post or comment. Mentioning a user automatically emails a notification to them about that content.
- You can broadcast a message that appears in Confluence activity streams.
- You can like a page, blog post or comment. The author will receive a notification. If enough people like the content, it will appear in the list of popular content on the dashboard and in the recommended updates email message.

Other users can also find out about changes to content in Confluence by watching pages and spaces.

You may also be interested in exporting Confluence content to other formats such as XML, HTML, Microsoft Word and PDF.

**Related pages:**
- Creating Content
- Managing Changes and Notifications and Tasks
- Organising Content
- Confluence User's Guide

**Network Overview**

The ‘network’ feature provides notifications on the activity of users that you choose to follow. This compares with Confluence's other content tracking features, which provide notifications on specified types of content updates, made by any user.
The types of activities tracked by the network feature include:

- Additions or edits to pages or blog posts
- Comments added to a page or blog post or edits to existing comments
- Updates to a user's User Status Updates
- Updates to a user's User Profile

**On this page:**
- Accessing Your Network View
- Following Another User
- Stop Following a User
- Notes

**Related pages:**
- Network Macro
- Subscribing to a Network RSS Feed
- Subscribing to Email Notifications of Updates to Confluence Content
- Confluence User's Guide

### Accessing Your Network View

**To see your network view:**

- Choose your profile picture at top right of the screen, then choose Network.
  (Alternatively, choose More in the 'Network' section of your profile sidebar.)

You can access another user's Network view using the Hover Profile.

**Screenshot: Example of the Network view**

---

### Following Another User

You can follow another user by using either the Hover Profile or your Network view.

**To follow a user with the Hover Profile:**

1. Open the user's hover profile popup:
   - Log in to Confluence, if you have not already done so.
   - Note: If a Confluence Administrator has granted the 'View User Profiles' permission to anonymous users, you can access people's hover profile popups without logging in. However, the hover profile
features available to anonymous users are restricted.

- Move your mouse pointer over a user's linked name or profile picture. The hover profile popup will appear.

2. Choose Follow.

To follow a user from your Network view:

1. Choose your profile picture at top right of the screen, then choose Network.
   (Alternatively, choose More in the 'Network' section of your profile sidebar.)
2. Enter the first few characters of the name (or username) of the user you wish to follow in the Following field and choose the user from the list of suggestions.
3. Choose Follow.

If you now refresh or revisit your Network view, the profile picture(s) of the user(s) you just followed will appear within the 'Following' list on the right. Additionally, their tracked activities will start appearing in the 'Recent Activity' list on this page.

Stop Following a User

To stop following a user by using the Hover Profile:

1. Open the user's hover profile popup:
   - Log in to Confluence, if you have not already done so.
   - Note: If a Confluence Administrator has granted the 'View User Profiles' permission to anonymous users, you can access people's hover profile popups without logging in. However, the hover profile features available to anonymous users are restricted.
   - Move your mouse pointer over a user's linked name or profile picture. The hover profile popup will appear.
2. Choose Stop Following.

You can also stop following a user by going to their Profile view.

If you now refresh or revisit your Network view, the profile picture(s) of the user(s) you just stopped following are removed from the 'Following' list on the right. Additionally, their tracked activities will stop appearing in the 'Recent Activity' list on this page.

Notes

Once you are following a user, you can see their activity in a number of ways:

- Your Network view: your Network view shows all the tracked activities that you have permission to view for all the users that you are following. In the same way, people who follow you will be able to see all your Confluence-based activities on their network views, provided they have permission to view the content. See below for instructions on accessing your network view.
- RSS feeds: you can subscribe to any Confluence user's network RSS feed and receive summaries on the activities of other users they are following in their network. See Subscribing to a Network RSS Feed.
- Email notifications: you can request email notifications of any activity in your network. See Subscribing to Email Notifications of Updates to Confluence Content.

Note that it is not possible to stop another user from following you. If you are interested in the ability to block followers, please watch CONF-16285 for updates on the feature request.

Likes and Popular Content

Has someone written a good blog post or page on Confluence? Or has someone added a comment that you agree with? Click the Like button to let them know. 🙌 Like

Confluence has like buttons on every page, blog post and comment. If enough people like a page or post, it will show on the dashboard's 'Popular' tab. The information in the 'Recommended Updates' email message is based on the number of people who have liked the content.

Liking a page, blog post or comment

Click the Like button to let people know that you agree with or enjoy a page, blog post or comment. Click Unlike to remove your name from the list of people who like the content.

You can also see:
• Up to three names of people in your network who have most recently liked the content.
• A link showing the number of people who have liked the comment. For example, 19 people like this. Click the link to see the names. At the top of the list are people in your network, sorted with the most recent likes first. Then follow other people, also sorted chronologically with the most recent first.

On this page:
• Liking a page, blog post or comment
• Effects of liking content
• Disabling the 'like' feature
• Disabling notifications when your content is 'liked'

Related pages:
• Dashboard
• Subscribing to Email Notifications of Updates to Confluence Content
• Network Overview

Screenshot: The Like button at the bottom of a page and on comments

18 Comments

John Sloat
The examples were great.
Reply • Like

Bill Arconati
@charles, you're right. Sounds like he's going for the world.
Reply • Like

John Massar
Now that's an idea.
Reply • Like

Effects of liking content

When you like a page, blog post or comment:

• The author of the content receives a notification.
• People in your network receive a notification. They will receive the notification only if they do not already know about the content. Let's assume Arthur is in your network. Arthur will not receive a notification if:
  • Someone else in his network has already liked the content.
  • Arthur himself has already liked the content.
  • Arthur has already commented on it.
  • In the case of a threaded comment, Arthur has already replied to the comment.
• If enough people like the content, it will appear on the 'Popular' tab of the dashboard.
• Similarly, if the content is popular enough it will appear in the 'Recommended Updates' summary sent out.

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Disabling the 'like' feature

The functionality is provided by a plugin called the 'Confluence Like Plugin'. To remove the 'like' functionality from your site, you can disable the plugin. See Disabling or Enabling a Plugin.

Disabling notifications when your content is 'liked'

There are two ways to turn the 'someone likes your page' notifications off:

1. Open an email notification of a like, and click Manage Notifications
2. Go to <your confluence URL>/plugins/likes/view-notifications.action

User Status Updates

You can use your 'user status' to broadcast a short message, which other users can see on various activity streams in Confluence. These short messages could include:

- A description about what you are working on.
- A question you may want answered quickly.
- A hyperlink that you share immediately with other users.
- Any other message you may want to share quickly with other users.
- Another person's Confluence username, in the format [~username], to send that person an email message about your status.

Your 'Status Updates' view shows a history of updates you have made to your status. Your latest status message is shown on the profile popup that appears when people hover over your username, and in various other places in Confluence.

On this page:

- Setting or updating your status
- Mentioning another person in your status update
- Viewing status updates
- Clearing your current status
- Deleting a status update
- More about user status updates
- Enabling and disabling status updates

Related pages:

- User Profile Overview
- User Status List Macro
- Confluence User's Guide

Setting or updating your status

To set or update your status:

1. Log in to Confluence.
2. Choose your profile picture at top right of the screen, then choose Update Status. The 'What are you working on' dialog will open.
3. Enter a short message (140 characters maximum) that describes your current status or what you are working on.
4. Choose Update to publish your new or updated status.

Screenshot: User status
Mentioning another person in your status update

You can include another person's Confluence username in your status update, using square brackets and the tilde sign in the format [~username]. Confluence will send that person an email message containing your status update. For example, let's assume another Confluence user has the username 'charlie'. You could put this message in your status update, and Charlie will receive an email message:

Enjoying all the blog posts that [~charlie] has written recently!

Note: Mentions in status updates do not appear as notifications in the Confluence workbox.

Viewing status updates

To view your status updates:

- Choose your profile picture at top right of the screen, then choose Status Updates.

You can also view another user's status by going to their profile.

Screenshot: Status updates view

Clearing your current status

Clearing a message is not the same as deleting it. If you clear a message, it is still shown in your status updates view until it is deleted.

To clear your current status:

1. Choose your profile picture at top right of the screen, then choose Status Updates.
2. Choose **Clear** in the status message at the top of the page.

*Screenshot: Clearing your current status message*

Deleting a status update

**To delete your current or a previous status message:**

1. Choose **your profile picture** at top right of the screen, then choose **Status Updates**.
2. Choose **Delete** next to the appropriate status message. Your status updates view will be refreshed and the message you deleted will be removed from the list.

More about user status updates

There are a number of activity streams in Confluence that show different types of status updates. These include:

- The 'Recently Updated' list on the **Confluence Dashboard**, which shows all status updates (when the **All** tab is selected).
- Your **Network page**, which shows the status updates of Confluence users you are following.
- The **Network page** of Confluence users who are following you, which shows your status updates.
- The **Recently Updated** and **Recently Updated Dashboard** macros, which shows all status updates (provided that these macros' space parameters have been set to '@all').

Enabling and disabling status updates

The functionality is provided by a plugin called 'User Status'. To remove the status updates functionality from your site, you can disable the plugin. See **Disabling or Enabling a Plugin**.

You can also set the Confluence site permissions to determine which users can use status updates. By default, users will not have permission to use this feature. See **Global Permissions Overview**.

**Using Mentions**

When you mention a user on a page, Confluence sends that person a notification by email and in their workbox.

Mentions (often known as @mentions) are great for drawing users attention to a page or comment, assigning tasks and clarifying responsibilities.

There are two ways to mention someone, using autocomplete, or via the **Insert menu in the editor**.

**Using autocomplete to mention someone**

**To mention someone using '@':**

1. In the editor, type '@' then the first few characters of the person's name or username.
2. Choose the user's name from the list of suggestions.

*Screenshot: Autocomplete for mentions*
Using the Insert menu to mention someone

**To add a user mention via the editor toolbar:**

1. In the editor choose **Insert > User Mention.** Confluence will add an '@' sign to the page, and display a dropdown list of suggested users for you to choose from.
2. Start typing the person's name or username, to refine the list of suggestions.
3. Choose the person from the list of names.

*Screenshot: The user mention option in the editor toolbar*
Seeing your mentions in the Confluence workbox

When someone mentions you, you will receive a notification in the Confluence workbox. See Managing Notifications in Confluence.

Notes

- **Disabling the user mention feature.** The functionality is provided by a plugin called the 'Confluence Mentions Plugin'. To remove the user mention functionality from your site, you can disable the plugin. See Disabling or Enabling a Plugin.
- **Mentioning groups.** It is not possible to mention a group and then have the email sent to the entire group. You can only mention individual users. There is a feature request to allow mentions for groups: 
  
  "CONF-23015 - Extend 'Mentions' to work with groups as well" OPEN

- **Mentioning people in status updates.** See User Status Updates.
- **Linking to a user profile.** You can use a square bracket ‘@’ and a person's name to trigger Confluence autocomplete and link to a person's user profile or personal space. Confluence will send the person a notification just as if you had used @mention (unless the administrator has disabled the user mention feature).

Emailing a Page

You can share a Confluence page or blog post by emailing a link to recipients of your choice. The recipients can be Confluence users or any email addresses.

To share a link to a Confluence page or blog post by email:

1. Go to the page or blog post you wish to share.
2. Choose Share.
   
   Note: The Share button will only visible if your Confluence administrator has configured an outgoing mail server for your Confluence site.
3. Enter a username, group or email address - autocomplete will suggest matching users and groups.
4. Select the appropriate user, group or email address from the dropdown. Repeat this process to add multiple recipients to the list.
5. Enter an optional message into the Note box.
6. Choose Share to send the link via email.

In addition to an email, Confluence users will also receive a notification in their Confluence workbox. See Managing Notifications in Confluence.
Notes

To remove a recipient from the list, choose the delete icon to the right of the recipient.

Commenting on pages and blog posts

A comment is a remark, question, or any other additional information you wish to add to a page or blog post. People can use comments to interact with each other on your Confluence site.

You can add a comment to any page or blog post, provided that you have the 'Add Comments' permission in the space. You can also show that you agree with or enjoyed someone else's comment, by liking it.

Comments are displayed at the bottom of the page, below the page content. They appear in one of two views, configured globally by a site administrator:

- **Threaded** – This view shows the comments in a hierarchy (tree) of responses. The replies are indented to indicate the relationships between the comments.
- **Flat** – This view displays all the comments in a single list and does not indicate the relationships between comments.
Adding a comment

You can add a comment on pages and blog posts in Confluence. To add a comment, you need the 'Add Comments' permission. See Space permissions.

To add a new comment:

1. Type your comment in the comment field at the bottom of the page.
2. Choose Preview to see how your comment will appear.
3. By default, Watch this page is ticked. This means that you will start receiving notifications about this page. Uncheck this if you do not want to watch the page.
4. Choose Save.

You can also highlight any text on a page, and choose the Quote in Comment button that appears near your selection. This will add the highlighted text into the comment field, apply the Quote style, and leave the cursor in the comment field ready to type a comment. If you do not see a popup when you highlight text, check that Text Select is enabled in your profile settings.

To respond to a comment:

1. Choose Reply located below the text of a comment.
2. Type in your response.
3. Choose Save.

To reply to comments, your Confluence site must display comments in threaded view.

Editing a comment

To edit a comment, you need the ‘Add Comments’ permission. See Space permissions. Space administrators can edit all comments within their space. The date on a comment always indicates the time the comment was last edited.

To edit a comment:

1. Go to the comment and choose Edit.
2. Make changes to the comment just as if you were adding a comment.
3. Choose Save.

 Deleting a comment

To delete a comment from a page, you need the ‘Remove Comments’ permission. See Space permissions. Deleted comments cannot be restored.

To delete a comment:

1. Go to the page that contains the comment.
2. Choose Delete at the bottom of the comment box.

If you do not have ‘Remove Comments’ permission, you are able to delete your own comments, but only if there are no replies to the comment.
Linking to a comment

You can link directly to a comment on a page. See Working with Links for more information on linking to comments.

Disabling comments

To prevent all users from adding comments in a space, remove the 'Add Comments' permission from the 'confluence-users' or 'users' group, anonymous users and all other users and groups. See Space permissions. The option to add comments will no longer appear on pages or blog posts. You need to be a space administrator to change the space permissions.

There is no permission that controls comments across the entire site.

Notes

- You can choose Tools > Watch to receive an email notification whenever anyone edits the page or adds a comment to the page.
- Your profile picture will appear next to each comment that you have added. (This is true if your space uses the Confluence Default theme.)
- On blog posts only, an 'Author' lozenge will appear on any comments made by the original author of the post.
- Comments are not auto-saved. See feature request: [CONF-12978 - Add auto-save/draft feature for comments](https://jira.atlassian.com/browse/CONF-12978)
- It is not possible to delete all comments for a page simultaneously.
- Individual users can choose to disable the Text Select popup that is used to enable quote in comment. See Editing User Settings.
- There is no option in the default Confluence user interface, to change the order of comments. For example, it is not possible to show the most recent comments at the top. Here are some options to investigate:
  - Answers and comments on this question on Atlassian Answers.
  - Available themes on Atlassian Marketplace.

Printing Confluence Pages

You can print one or more Confluence pages:

- To print a single page, use your browser's 'Print' option.
- Confluence allows you to export a single page, single blog post, part of a space, or an entire space into a single PDF file. See Exporting Confluence Pages and Spaces to PDF.

Exporting Confluence Pages and Spaces to Other Formats

You can convert a part of, or the entire contents of a space to various formats, including Microsoft Word, HTML, PDF and XML. This is called 'exporting' the space.

What would you like to do?

- Exporting Confluence Pages and Spaces to HTML
- Exporting Confluence Pages and Spaces to PDF
- Exporting to a Word document
- Exporting Confluence Pages and Spaces to XML

Related topics

- Working with Spaces
- Confluence User's Guide

Exporting Confluence Pages and Spaces to HTML

In Confluence, you can export part of, or the entire contents of, a space into a zipped archive of HTML files. This is useful if you want convert your space into a static website.

To use the space export functionality, you need the 'Export Space' permission. See the guide to [space permissions](#).

To export pages to HTML:

1. Go to the space and choose Space tools > Content Tools on the sidebar.
2. Choose **Export**. This option will only be visible if you have the 'Export Space' permission.

3. Select **HTML** then choose **Next**.

4. Decide whether you need to customise the export:
   - Select **Normal Export** to produce an HTML file containing all the pages that you have permission to view.
   - Select **Custom Export** if you want to export a subset of pages, or to exclude comments from the export.

5. Select the **Include Comments** check box if you want to include comments for the pages you are exporting.

6. Select the pages you want to export.
   - You have the option to **Select All** or **Deselect All** pages.
   - When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.

7. Choose **Export**. This will create a zipped archive of HTML files.

8. When the export process has finished, download the zipped archive as prompted, and extract the files into a folder.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**.
2. Choose **HTML Export** from the left menu.
3. Follow the steps above to export the Space.

---

**Related pages:**

- Exporting Confluence Pages and Spaces to PDF
- Exporting Confluence Pages and Spaces to XML
- Confluence User’s Guide

---

**Screenshot: Selecting pages to export**

**Export HTML Options**

Export content within this space as HTML.

- **Normal Export**
  
  Generates a HTML file of all pages and blog posts in this space, including comments and attachments.

- **Custom Export**
  
  Generates a HTML file of selected pages based on options that you choose from below.

**Includes:**

- **Include comments**

**Choose pages to export:**

- **Select All**
- **Deselect All**

- **Crowd Documentation**
  - **Crowd 101**
  - **Crowd Administration Guide**
    - **Getting Started**

---

**Notes**
In the zip file, page attachments are placed in individual folders with names in the following format: 
`...\download\attachments\xxxxxx`
where `xxxxxx` is the page ID of the page containing the attachments.

- By default, the ‘Space Details’ page is exported as `index.html` and displays the space’s details as well as a list of all available pages within it.
- Blog posts are not included in the HTML export. See the feature request: CONF-14684.
- To customise the HTML output, you will need to modify the file `confluence-x.y.z-jar/com/atlassian/confluence/pages/Page.htmlexport.vm`. To learn how to repackage this file, see How to Edit Files in Confluence JAR Files.

### Exporting Confluence Pages and Spaces to PDF

This page explains how you can export individual Confluence pages, blog posts, entire spaces or selections of pages into a single PDF file.

#### Exporting single pages

You can export a Confluence page to PDF. This option exports a single page and is available to all users who have permission to view the page.

- Go to a page in the space and choose **Tools > Export to PDF**. Follow the prompts to export the page.

Note that the export of a single page to PDF applies any PDF stylesheet customisations, but does not apply any PDF layout customisations. To make your PDF layout customisations apply to a single page exported to PDF, use the ‘multiple page’ method described below to export that single page only. See Customising Exports to PDF.

#### Exporting a blog post

You can export a Confluence blog post to PDF. This option exports a single blog post and is available to all users who have permission to view the page.

- Go to a blog post and choose **Tools > Export to PDF**. Follow the prompts to export the page.

Blog posts can only be exported individually. Blogs cannot be exported at the space level.

#### Exporting multiple pages or the entire space

Using Confluence's space export functionality, you can convert multiple pages or an entire space to PDF.

To use the space export functionality, you need the ‘Export Space’ permission. See the guide to space permissions.

To export a space or selected pages to PDF:

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose Export. This option will only be visible if you have the ‘Export Space’ permission.
3. Select **PDF** then choose **Next**
4. Decide whether you need to customise the export:
   - Select **Normal Export** to produce a PDF file containing all the pages that you have permission to view.
   - Select **Custom Export** if you want to export a subset of pages.
5. Select the pages you want to export.
   - You have the option to **Select All** or **Deselect All** pages.
   - When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.
6. Choose **Export**.
7. When the export process has finished, download and save the PDF file as prompted.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**
2. Choose **PDF Export** from the left menu.
3. Follow the steps above to export the Space.
Customising the appearance of PDF exports

You can add a title page, a table of contents and customised headers and footers to the PDF output. For more advanced customisations, you can apply Cascading Style Sheet (CSS) modifications. These customisations are specific to each space. You need the ‘Space Administrator’ permission to be able to apply these customisations. For more information, see Customising Exports to PDF.

Notes

- Comments on the page are not exported to the PDF file.
- Only image attachments that have been inserted into a page are included when exporting to PDF.
- To export a PDF containing international text, you need to install a Unicode font in Confluence.
- Blog posts can be individually exported, but are not included when you export a space to PDF.
- If you have ‘Space Administrator’ permissions, the link to customise the PDF Stylesheet is provided at the top of the page tree, as shown in the screenshot above.
- Confluence's PDF export feature is designed to handle a wide variety of content. However, on rare occasions the PDF Export process may fail due to an unrecognised customisation. If that happens the PDF export screen will indicate the title of the page in which the problem occurred, to help you diagnose the cause of the failure.

Customising Exports to PDF

Confluence administrators and space administrators can customise the PDF exports for individual spaces.

Please note:

- PDF customisations are unique to each space.
- PDF customisation only applies to space exports (not single page exports via Tools > Export to PDF)
- Confluence's PDF customisations use a combination of HTML and CSS (Cascading Style Sheets).
- To achieve a particular requirement in the exported PDF file, you make changes in one or both of the following:
  - The PDF Layout, where HTML is used to define the structure of the exported content, including features such as the title page, headers and footers.
  - The PDF Stylesheet, where CSS is used to define the style of elements in the exported content, such as page size and margins, font, colour, and list numbering.

For further customisations, see the Advanced PDF Export Customisations page.

Customising the PDF Layout

You can add your own HTML to customise the title page, page headers and page footers in the PDF output.

Setting a global PDF layout

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose PDF Layout. You can enter HTML and CSS that will be rendered on the PDF title page, as well as page headers and footers.
Setting the PDF layout at space level

1. Go to the space and choose Space tools > Look and Feel on the sidebar. You’ll need Space Admin permissions to do this.
2. Choose PDF Layout.
3. Choose Edit.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose PDF Layout in space administration options.
3. Choose Edit.

You can customise the HTML that is generated for the following areas when the space is exported to PDF:

- PDF Space Export Title Page – title page.
- PDF Space Export Header – page headers.
- PDF Space Export Footer – page footers.

Enter your customisations into each text box as required. The PDF layout section accepts HTML code. You can include inline CSS in the HTML too.

You can adjust the appearance of the PDF pages by customising the CSS in the PDF Stylesheet screen.

To get started, download the default CSS rules for the PDF stylesheet - confluencedefaultpdf.css. Any rule defined in this file can be customised and added to the PDF Export Stylesheet section. Your customisations override any default CSS rule. If no customisations are defined, the default CSS rules will be applied.

By default, the export does not include a title page, headers or footers. You can define these in the PDF layout.

To customise the PDF Stylesheet:

Setting a global PDF Stylesheet

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Look and Feel > PDF Stylesheet. The following screen allows you to enter and save CSS code.
that will render content on each page.

Setting a space PDF stylesheet

1. Go to the space and choose Space tools > Look and Feel on the sidebar. You'll need Space Admin permissions to do this.
2. Choose PDF Stylesheet.
3. Choose Edit.
4. Enter your customisations.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose PDF Stylesheet in the space administration options.
3. Choose Edit.
4. Enter your customisations.

The PDF Export Stylesheet field accepts Cascading Style Sheets (CSS) rules. The 'PDF Export Stylesheet' page shows the current (e.g. customised) contents of your PDF stylesheet.

Example Customisations

This section provides examples of typical customisations that you can add. See also Advanced PDF Customisations.

Page Size

The default page size is based on the location of your Confluence server. For example, if this server is located in the US then the default paper size of your PDF export will be US Letter (8.5 inches wide by 11 inches long). If the server is located in Australia, the default paper size will be A4 (210 mm wide by 297 mm long). More information about paper sizes can be found on Wikipedia.

To modify the page size to A4, edit the PDF Stylesheet to add a size property to the CSS@page rule, like this:

```css
@page
{
/*The A4 paper size is 210 mm wide by 297 mm long*/
size: 210mm 297mm;
}
```

Page Orientation: Landscape or Portrait

To change the page orientation of your PDF document, simply reverse the order of the values declared in the @page rule's size property. The first and second values of this property represent the width and height of the page, respectively.

For example, to generate PDF space exports in A4-sized landscape orientation, your @page rule might look like this:

```css
@page
{
/*A4-sized pages in landscape orientation are 297 mm wide by 210 mm long*/
size: 297mm 210mm;
}
```

Page Margins
To set all margins to 15 mm, with a paper size of A4, edit the CSS @page rule in the PDF Stylesheet, like this:

```css
@page 
{
  size: 210mm 297mm;
  margin: 15mm;
}
```

To set the margins independently, edit the @page rule as follows:

```css
@page 
{
  margin-top: 2.54cm;
  margin-bottom: 2.54cm;
  margin-left: 1.27cm;
  margin-right: 1.27cm;
}
```

To set margins to provide a gutter for binding a printed document, use the :left and :right pseudo-classes, as follows:

```css
@page :left 
{
  margin-left: 4cm;
  margin-right: 3cm;
}
@page :right 
{
  margin-left: 3cm;
  margin-right: 4cm;
}
@page :first 
{
  margin-top: 10cm /* Top margin on first page 10cm */
}
```

Note the use of the :first pseudo-class in the example above to define distinct margins for a cover or title page.

**Page Breaks**

By default, Confluence pages are exported without page breaks, so that shorter pages will appear on the same PDF page.

To make each Confluence page appear on a separate page in the PDF file, add the following rule in the PDF Stylesheet:
Title Page

You can add a title page to your PDF document by adding HTML to the Title Page section of the PDF Layout screen. The following example creates the title page and adds a title:

```html
div class="fsTitlePage">
  <img src="/download/attachments/590719/titlepage.png" />
  <div class="fsTitle">Planning for Confluence 4.0</div>
</div>
```

Use CSS rules in the PDF Stylesheet to control the appearance of the title page and the title text:

```css
.fsTitlePage
{
  margin-left: auto;
  margin-top: 50mm;
  margin-right: auto;
  page-break-after:always
}

.fsTitle
{
  font-size: 42px;
  font-weight: bold;
  margin: 72px 0 4px 0;
  text-align:center;
}
```

Adding an Image to the Title Page

In the example above, the title page includes an image called 'titlepage.png', centred in the middle of the page. The "590719" in the src attribute is the ID number of the page to which the image is attached.

Follow these instructions to include an image on your title page:

1. Attach the image to a Confluence page.
2. View the list of attachments on that page, then right-click the image and copy its location.
3. Paste the link into the appropriate src="" attribute in your PDF Stylesheet, as shown above.
4. Edit the image URL so that it is relative, by removing the first part of the URL before /download/....

Table of Contents

By default, a table of contents will be generated after the title page, or at the beginning of the PDF document if no title page is defined in the PDF Layout. To see the default CSS rules applied to the table of contents, download the default CSS rules (confluencedefaultpdf.css) and examine the specific rules with toc in their name.
To make changes to the appearance of the table of contents, define CSS rules in the PDF Stylesheet.

Disabling the Table of Contents

To prevent the table of contents from being generated in your PDF document, add the `div.toc-macro` rule to the PDF Stylesheet and set its `display` property to `none`:

```css
div.toc-macro
{
  display: none;
}
```

Changing the Leader Character in the Table of Contents

The leader character is used to link a heading in the table of contents with its page number. By default, the leader character is the '.' (dot) character. Leader values of `dotted`, `solid` and `space` are allowed. You can also use a string, for example `leader(". . . ")`.

To change the leader character to a solid line, modify the `leader()` value on the `content` property of the CSS rule as follows:

```css
span.toclead:before
{
  content: leader(solid);
}
```

Headers and Footers

You can add headers and footers to your PDF pages using the 'Header' and 'Footer' sections of the PDF Layout screen. By default, headers and footers only apply to a space export and not to exports of single pages (however, see Advanced PDF Export Customisations). The following example adds a simple copyright notice.

```html
Copyright © 2013, Atlassian Pty Ltd.
```

Page Numbering

To add page numbering, you need to combine customised HTML in the PDF Layout with customised CSS in the PDF Stylesheet.

1. **PDF Layout HTML**: In the Footer section (or the Header section), use an empty span element with a unique ID, for example `pageNum`, to act as a place holder for the page number.

   ```html
   <span id="pageNum"/>
   ```

2. **PDF Stylesheet CSS**: Create the following CSS selector rule for the empty span:

   ```css
   span.pageNum
   ```
Analysing the above CSS selector rule in more detail:

- The #pageNum rule selects the HTML element with the specified ID of "pageNum", which is the span element we created for the header or footer.
- The :before part of the selector is a pseudo class that allows the insertion of content before the span element is processed.
- The counter(page) is a function that returns the current page number as its content.
- The content property tells the CSS processor that dynamic content (that is, an incrementing page number) is to be inserted at the span tag.

Wrapping Long Words

In order to break long words or words that are not separated by whitespace, add a selector to the PDF stylesheet containing the word-wrap property with a value of break-word:

```
CSS - PDF Stylesheet

div
{
  word-wrap: break-word;
}
```

General Formatting

You can use the stylesheet to customise the output of just about anything else that will influence the look and feel of the final document. This includes fonts, tables, line spacing, macros, etc. The export engine works directly from the HTML output produced by Confluence. Therefore, the first step in customising something is to find a selector for the HTML element produced by Confluence or the Confluence macro. Then add a CSS rule to the PDF stylesheet. Your customisation will appear in the PDF export.

Notes

- **Demotion of heading elements: h1, h2, and so on.** Due to the hierarchical manner in which a space is exported, Confluence will modify the heading elements to generate a uniform appearance for the entire space export. This means that headings will be demoted. This will affect the application of custom PDF Stylesheets. It is possible to calculate the amount by which a heading will be demoted in order to have the correct CSS styling applied. A heading will be demoted by the value of its depth in the export tree. A page at the first level will be demoted by 1 (all <h1> elements will become <h2> elements, and so on). A page at the second level will be demoted by 2, and so on.

- **Atlassian support for PDF customisation is limited.** We support the mechanism for customising the PDF layout with HTML and CSS, and we will help if the mechanism is broken or does not work as we say it should in our published examples. But, since custom HTML and CSS offer potentially limitless possibilities, Atlassian will not support issues that are caused by or related to PDF customisations.

Related Topics

Advanced PDF Export Customisations

Advanced PDF Export Customisations

This page provides information about ‘advanced’ PDF export customisations. These expand upon the regular
customisations described in Customising Exports to PDF.

The information below is for advanced users. Customisations are not supported by Atlassian. Be aware that the advanced customisations described below require knowledge of certain parts of Confluence, and of CSS and HTML. This documentation is intended for advanced users. Some of the suggestions below are moderately complex, or irregular in nature. If you are having trouble understanding them we strongly suggest you ask an expert. We do not support any of the customisations described below. This means that the Atlassian support engineers will not be able to help you with these modifications.

On this page:
- Header and Footer
  - Adding Headers and Footers to Single Page Exports
  - Adding Images to Headers and Footers
- Incorporating Other Fonts
- Adding a Dynamic Title to the Title Page
- Hiding Text from the PDF Output
- Indexing
- Notes

Related pages:
- Customising Exports to PDF
- Confluence User’s Guide

Header and Footer

Adding Headers and Footers to Single Page Exports

By default, custom headers and footers set up in the PDF Layout screen (see Customising Exports to PDF), only apply to space exports and not to exports of single pages. However, it is possible to add CSS rules to your PDF Stylesheet that produce headers and footers in single page exports as well as space exports.

For custom headers, define @top-left, @top-center and @top-right rules within your @page rule. These rules apply respectively to content that appears on the left-hand side, centre and right-hand side of your page’s header area.

For custom footers, define @bottom-left, @bottom-center and @bottom-right rules within your @page rule.

For example, the following rules add a document title at the centre of the header and a page number at the centre of the footer:

```css
@page
{
  @top-center
  {
    content: "Document Title Goes Here";
    font-family: ConfluenceInstalledFont, Helvetica, Arial, sans-serif;
    font-size: 8pt;
  }
  @bottom-center
  {
    content: "Page " counter(page);
    font-family: ConfluenceInstalledFont, Helvetica, Arial, sans-serif;
    font-size: 8pt;
  }
  /* Any other page-specific rules */
}
```

Notes:
• The **font-family** and **font-size** properties ensure that the header and footer text is rendered in the same default font style used for the body text, based on the default CSS rules.

• It is not possible to use this method to insert images (stored as attachments within your Confluence instance) into the headers and footers of single page exports.

**Adding Images to Headers and Footers**

To insert an image into the header or footer, add HTML to the Header or Footer section of the PDF Layout screen.

The following example uses an HTML `img` element with `src` attribute to add an image to the left of the header. The `src` attribute refers to an image attached to a Confluence page. The image element is usually placed within a `div` element container.

HTML - PDF Layout: Header Section

```html
<div style="margin-top:10mm">
  <img src="/download/attachments/12346/header-image.png"/>
</div>
```

In the example above, the header includes an image called 'header-image.png'. The "12346" in the `src` attribute is the ID number of the page to which the image is attached.

Follow these instructions to include an image on your page:

1. Attach the image to a Confluence page.
2. View the list of attachments on that page, then right-click the image and copy its location.
3. Paste the link into the appropriate `src=""` attribute in your PDF Stylesheet, as shown above.
4. Edit the image URL so that it is relative, by removing the first part of the URL before `/download/...`

**Notes:**

• This example uses an inline CSS property `margin-top` in the `style` attribute to force the image away from the top of the page by 10mm. This comes in handy when your header image is large enough to touch or spill over the top of the page.

• Likewise, for footers, you can use the `margin-bottom:XXmm` property to force an image away from the bottom of the page by ‘XX‘ mm.

• Very large images can spill over into the body of a page or alter the position of text or other elements used within a header or footer. In such situations, it is recommended that you reduce the size of the image and then attach it to your Confluence page again. If you prefer to keep the image size and want to move the content lower instead, you can do so by configuring the `margin-top` properties in the `@page C SS` rule.

• By default, a header or footer image is aligned to the left-hand side of the page. However, you can align this image to the centre or right-hand side of a page by adding either the `text-align:center` or `text-align:right` properties to your `style` attribute. For example, to align the header image to the right-hand side of the page, your `style` attribute would look similar to this: `style="margin-top:10mm; text-align:right"`.

**Incorporating Other Fonts**

By default, Confluence provides Times New Roman, Helvetica or Courier fonts for use in PDF exports. You can use your own fonts for PDF exports by declaring them in a `@font-face` CSS rule in your PDF Stylesheet.

The following CSS rule example shows how to declare the Consolas font and apply it to some elements for your PDF export:
Adding a Dynamic Title to the Title Page

When you export an arbitrary set of pages from Confluence, you may like to have a corresponding title added to the cover (or title) page automatically. This can be done (in a somewhat irregular way) by using the top level item from the default table of contents as the title. This method relies on having the exported pages structured as sub-pages of the top-level page. In other words, the pages to be exported should consist of a page (at the top-level) and all of its child pages. The result is that the title that appears on the cover page changes depending on the top-level page that is used for the export.

The CSS below moves, and styles, the top-level TOC item for use as the title on the cover page, and turns off the leader and page number normally associated with this item in the TOC.
Hiding Text from the PDF Output

This section describes a way to hide text from your PDF export. In other words, you can have text on the Confluence page that will not appear in the PDF export.

There are three steps:

1. Follow the instructions to define the NoPrint user macro. *Not applicable to Confluence Cloud.*
2. Use the NoPrint macro to mark some text on a Confluence page.
3. Add the following CSS to your PDF stylesheet to make the PDF export recognise the NoPrint macro:

```css
.noprint
{
  display: none;
}
```

Indexing

To obtain an index at the end of the exported PDF file, consider using the Scroll Wiki PDF Exporter plugin that is produced by K15t Software GmbH.

Notes
If styling is not working as expected, it is useful to look at the intermediary HTML source to which the CSS is applied. This intermediary HTML is created whenever you create an HTML export that contains multiple pages, and is stored in the temp directory in Confluence's home directory. For example:

```html
<confluence-home>/temp/htmlexport-20110308-154047-1/export-intermediate-154047-2.html
```

**Creating PDF in Another Language**

To export a Confluence page written in a language other than English, you will need the necessary font for that language.

**Uploading a Font File to Confluence**

1. Find the appropriate font file:
   - **Windows users:** All font files in Windows are stored in a directory called:
     ```
     C:\WINDOWS\Fonts
     ```
   - **Unix users:** All font files in Unix are stored in:
     ```
     /usr/share/fonts
     ```
   - Microsoft True Type core fonts such as Verdana can be downloaded from this page: http://corefonts.sourceforge.net/

2. Copy the font file into a temporary folder, for example a folder on your desktop.

3. Choose the cog icon, then choose General Configuration under Confluence Administration, then choose PDF Export Language Support.

4. Upload the file you copied in step 2.

5. Choose Install.

**Notes**

- The only font files supported are true type fonts and true type collections. The accepted file extensions are *.ttf and *.ttc.
- Confluence can only store one font file at any one time. Please create a collection to install more than one *.ttf files.
- We recommend that you use Unicode font Verdana for correct character encoding and exporting to PDF.
- If the font file size is bigger than your current attachment size limit, you will not be able to upload it. Please increase the attachment size limit temporarily and re-upload again. An improvement of the error messaging is tracked at CONF-24706 - Provide better error message when trying to upload a custom PDF font which is bigger than current attachment size limit RESOLVED

- To make use of an installed font in your PDF Export style sheet (CSS) refer to it by the font-family ConfluenceInstalledFont.

**Exporting to a Word document**

Confluence allows you to export a single page into a Word document. By default, this will create a Word document with the same name as the Confluence page. This is useful for emailing content to people who do not have access to Confluence.

Anyone who has permission to view the page will be able to export it to Word.
To export a page to a Word document:
Go to the page and choose Tools > Export to Word.

Useful plugins

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

This plugin provides extended functionality for exporting Confluence pages to Microsoft Word: Scroll Office.

Exporting Confluence Pages and Spaces to XML

You can export part of, or the entire contents of, a Confluence space into a zipped archive of XML files and attachments. This is useful if you want to make a backup of the space, or import the space into another Confluence site, or use the data from the space in another application.

To export a space or pages to XML, you need the 'Export Space' permission. See Space Permissions.

Notes:

- See Restoring a Space for notes on restrictions when importing a space.
- If you are doing the export for backup purposes, consider another means of backup. See Production Backup Strategy

To export pages or an entire space to XML:

1. Go to the space and choose Space tools > Content Tools on the sidebar.
2. Choose Export
   Note: This option will only be visible if you have the 'Export Space' permission.
3. Select XML then choose Next.
4. Decide whether you need to customise the export:
   - Select Full Export to produce an XML file containing all the pages in the space, including those that you do not have permission to view.
   - Select Custom Export if you want to export a subset of pages, or to exclude comments from the export.
5. Select Include Comments if you want to include comments made on the pages you are exporting.
6. Select the pages you want to export.
   - You have the option to Select All or Deselect All pages.
   - When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.
7. Choose Export. This will create a zipped archive of XML files and attachments.
8. When the export process has finished, download and save the zipped archive file as prompted.

If your space uses the Documentation theme:

2. Choose XML Export from the left-hand panel.
3. Follow the steps above to export the space.

On this page:

Related pages:

- Exporting Confluence Pages and Spaces to PDF
- Exporting Confluence Pages and Spaces to HTML
- Working with Spaces
- Confluence User's Guide
- Restoring a Space

Screenshot: Exporting a space
Notes

If you are running Confluence behind Apache HTTP Server and are facing timeout errors, please consider creating the export directly from Tomcat, instead of going through Apache. This will speed up the process and prevent timeouts.

**Managing Changes and Notifications and Tasks**

Confluence provides several ways in which you can watch for changes to single pages, entire spaces, and all spaces on the site. You can also follow the updates made by specific people. You can only track updates to content that you have permission to see.

Making yourself a watcher of pages or spaces

You can watch a page, blog post or space that you have permission to view. Confluence will then send you an email notification whenever someone adds or updates content on, or adds a comment to, that page or space. See [Watching Pages, Spaces and Blogs](#).

If you have space administrator permissions, you can manage watchers of pages and spaces.

Requesting other notifications

You can configure Confluence to send you various digest reports via email. See [Subscribing to Email Notifications of Updates to Confluence Content](#).

---

**Export XML Options**

Export content within this space as XML.

- **Full Export (includes pages not visible to you)**
  Generates a XML file of all pages and blog posts (including ones not visible to you) in this space, including comments and attachments.

- **Custom Export**
  Generates a XML file of selected pages based on options that you choose from below.

**Includes:**

- Include comments

**Choose pages to export:**

Select All · Deselect All

- Crowd 101
- Crowd Administration Guide
- Getting Started

Select All · Deselect All

Export

---

Related pages:

- Page History and Page Comparison Views
- Viewing Space Activity
- Working with Tasks

---

*Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Tracking updates by specific people

You can also follow the activity of people who interest you (see Network Overview) and receive a notification when someone follows you (see Subscribing to Email Notifications of Updates to Confluence Content).

Managing your notifications

There are two ways to manage notifications in Confluence:

- You can manage your email notification settings via the options in your user profile. See Subscribing to Email Notifications of Updates to Confluence Content.
- The Confluence workbox displays all notifications collected from Confluence page watches, shares and mentions. See Managing Notifications in Confluence.

Using Confluence RSS feeds

You can build RSS feeds to monitor content changes in Confluence.

- Create a customised RSS feed using the RSS Feed Builder.
- Subscribe to one of the pre-specified feeds generated by Confluence.

Watching Pages, Spaces and Blogs

You can 'watch' a Confluence page, blog post or space. Confluence will then send you a notification by email whenever anyone updates the watched content.

You will receive email notifications for:

- Edits (unless the author clears the 'Notify watchers' check box).
- Deletions.
- Attachments, including new versions or deletions of an existing attachment.
- Comments, including new comments, edits of existing comments or deletions of existing comments.

By default, Confluence will assign you as a watcher of any page or blog post that you create or edit. This behaviour is called 'autowatch'. You can control autowatch.

There is no daily digest for email notifications. You will receive an email notification every time someone makes a change.

You will not receive email notifications for content changes due to the output of a macro, because the page content itself has not been edited.

You need 'View' permission for the page, blog post or space to receive notifications.

On this page:

- Watching a page or blog post
- Watching an entire space
- Watching for new blog posts in a space
- Watching all spaces on the site
- Watching for all new blog posts on the site
- Managing watches from your user profile
- Managing watches from the email message
- Setting autowatch and other notification options

Related pages:

- Managing Watchers
- Subscribing to Email Notifications of Updates to Confluence Content
- Managing Changes and Notifications and Tasks
- Updating Email Address
- Confluence User’s Guide

Watching a page or blog post

To start watching a page or blog post:

1. Log in to Confluence, if you have not already done so.
2. Go to the page or blog post.
3. Choose **Watch** and select the relevant check box.

To stop watching the page or post, deselect the relevant check box.

**Watching an entire space**

You can choose to watch all the pages and blog posts in a particular space.

The quickest way is to use the **Watch** option on a page or blog post, as described above.

To stop watching the space, deselect the relevant check box.

Alternatively, choose **Pages** in the space sidebar, then choose **Watch this space** at the top right.

If your space uses the Documentation theme, choose **Browse > Space Operations**. Then choose **Watch this space** in the left-hand menu.

**Watching for new blog posts in a space**

You can choose to receive a notification whenever someone adds a blog post in the space. You will not receive notification of updates to or deletions of blog posts, nor of comments on the blog posts.

To watch for new posts:

1. Log in to Confluence, if you have not already done so.
2. Go to a blog post in the space.
3. Choose **Watch** and select **Watch all blog posts in this space**.

To stop watching for new blog posts, deselect the relevant check box.

Alternatively, choose **Blog** in the space sidebar, then choose **Watch this blog** at the top right.

If your space uses the Documentation theme, choose **Browse > Space Operations**. Then choose **Watch this blog** in the left-hand menu.

**Watching all spaces on the site**

You can receive notifications about changes to the content of pages, blog posts and comments from all spaces on a Confluence site.

To start watching for content changes across the whole site:

1. Choose your profile picture at top right of the screen, then choose **Settings**.
2. Choose **Email**.
3. Choose **Edit** then choose **Subscribe to daily updates**.
4. Choose **Submit**.

**Managing watches from your user profile**

The ‘**Watches**’ page in your user profile displays a list of all pages and spaces you are currently watching.

To manage your watches:

1. Choose your profile picture at top right of the screen, then choose **Watches**.
2. Choose **Stop Watching** for any unwanted spaces or pages.
Managing watches from the email message

The email notifications that you receive from Confluence have some useful links at the bottom of the email message. The links in each message vary, depending on the context. In general, the links allow you to view the page online, reply to a comment, and so on.

In particular with respect to setting your notification preferences, you will see one or more of the following links:

- **Stop watching page** – Click this link to stop watching the page that triggered the email notification.
- **Stop watching space** – Click this link to stop watching the space that triggered the email notification.
- **Stop following this user** – Click this link to stop following the user whose update triggered the email notification.
- **Manage Notifications** – Click this link to go to the email settings page in your user profile.

**Screenshot: Example email notification footer showing links**

Setting autowatch and other notification options

By default, Confluence will assign you as a watcher of any page or blog post that you create or edit. This behaviour is called ‘autowatch’. You can turn autowatch on or off, and set other notification options, in the email settings section of your user profile. See Setting User Settings.

**Managing Watchers**

If you are a **space administrator** for a space, you can manage the watchers for all pages and blog posts in that space. This means that you can:

- View a list of the watchers of a page or blog post.
- View a list of the watchers of the space that contains the page or blog post.
- Add users as watchers of the page or blog post.
- Remove existing watchers of the page or blog post.

You cannot remove watchers of the space.

**Related pages:**

- Watching Pages, Spaces and Blogs
- Subscribing to Email Notifications of Updates to Confluence Content
- Managing Changes and Notifications and Tasks
- User Profile Overview
- Confluence User's Guide.

**To manage the watchers of a page or blog post:**

1. Go to the page or blog post for which you want to manage the watchers.
2. Choose **Watch > Manage Watchers**.
3. The ‘Manage Watchers’ screen will appear. The left-hand column shows the users watching the page or blog post. The right-hand column shows the users watching the space.
   - To remove an existing page watcher, choose the icon (trash can) next to the user’s name.
   - To add a user as a watcher of the page, type their username and choose **Add**.

**Screenshot: Managing watchers**
Subscribing to Email Notifications of Updates to Confluence Content

You can 'watch' a page, blog post or space. Confluence will then send you a notification by email whenever anyone adds or updates content on that page or space. You can also subscribe to daily email reports and other notifications of various updates, as described below.

You will only receive notifications for content that you have permission to view. Users that have been disabled by an administrator will not receive email notifications.

Subscribing to email notifications

You can subscribe to the following email summary reports:

- A daily report of updates to all spaces that you have permission to view.
- An immediate report of all blog posts added or changed, in all spaces that you have permission to view.
- An immediate report of all updates made by the people you are following, in all spaces that you have permission to view.
- An immediate report when someone follows you.
- A daily or weekly report of recommended updates, in all spaces that you have permission to view.

To edit your email notification settings:

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Click Email in the left-hand panel.
3. Click Edit.

Below is an explanation of all the email settings is explained below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Content</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscribing to email notifications</td>
<td>- Autowatch</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Subscribe to daily updates</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Subscribe to all blog posts</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Subscribe to network</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Subscribe to new follower notifications</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Notify on my actions</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Show changed content</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Subscribe to recommended updates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notes for administrators</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------------------------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>Managing Changes and Notifications and Tasks</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subscribing to RSS Feeds within Confluence</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Profile Overview</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Editing User Settings</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Confluence User's Guide</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Option:</strong> Do you want Confluence to automatically add you as a watcher on each page or blog post that you add or update? If you are a watcher of a page or a post, you will receive notification of future changes.</td>
<td>• Pages and blog posts that you create, edit or comment on.</td>
<td>(Not applicable)</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Subscribe to daily updates</strong></td>
<td>Receive email reports showing changes to content in all spaces that you have permission to view. <strong>Note:</strong> <em>Daily email reports do not include information about attachments on a page or blog post that are added, edited or deleted.</em></td>
<td>• Pages and blog posts that are added, edited or deleted. • Comments on a page or blog post that are added, edited or deleted. • Updates by users who have changed their personal profile.</td>
<td>Daily</td>
</tr>
<tr>
<td><strong>Subscribe to all blog posts</strong></td>
<td>Receive email notifications for changes to blogs in your Confluence installation that you have permission to view.</td>
<td>• Blog posts added, edited or deleted.</td>
<td>Immediately</td>
</tr>
<tr>
<td><strong>Subscribe to network</strong></td>
<td>Receive email notifications for changes to content by all users that you are following, which you have permission to view.</td>
<td>• Pages being added, edited or deleted. • Blog posts being added, edited or deleted. • Comments being added, edited or deleted. • Status updates by the user.</td>
<td>Immediately</td>
</tr>
<tr>
<td><strong>Subscribe to new follower notifications</strong></td>
<td>Receive an email message when anyone chooses to follow you.</td>
<td></td>
<td>Immediately</td>
</tr>
<tr>
<td><strong>Option:</strong> Do you want to receive email notifications for your own changes? <strong>Note:</strong> If you have not subscribed to any email notifications and are not watching any pages/spaces, then selecting 'Notify on my actions' will not do anything.</td>
<td>• All pages and spaces that you are watching. • This affects all subscriptions set.</td>
<td>(Not applicable)</td>
<td></td>
</tr>
</tbody>
</table>
### Show changed content

**Option:** Do you want your notifications to include details of the changes made to the content?

- If you do not select this option, your notifications will include only the title of the page, and any comment the author made when updating the page.
- If you do select this option, your notifications will show the differences between the current and previous versions of the page. See [Page History and Page Comparison Views](#).

**Edits to pages and blog posts.**

(Not applicable)

### Subscribe to recommended updates

Receive an email message showing the top content that is relevant to you from spaces that you have permission to view.

How do you set the frequency of the mail message? A link in the email message allows you to choose daily or weekly notifications.

How do you enable and disable the notification? You can turn off the notification by clicking a link in the email message. You can also turn the notification on or off by setting the 'Subscribe to recommended updates' option in your user profile.

Confluence chooses the content to display, based on:

- Pages and blog posts that people have recently liked.
- Pages and blog posts that people have recently commented on.
- Pages and blog posts that have recently been created.

'Recent' means any activity that occurred since the last recommended updates message was sent to you.

The activities are listed in order of popularity, with the most popular at the top. Likes, comments and content creations are scored equally. Activity that involves people in your network ranks higher than activity not involving your network. Content in your favourite spaces also ranks higher than content in other spaces.

The recommended updates summary does not include any content that you created yourself, and it gives a lower ranking to content that you have participated in, for example by adding a comment or updating the page.

If there is no activity to report, Confluence will not send the email message.

### Daily (weekdays at 1pm) or weekly

<table>
<thead>
<tr>
<th>Notes for administrators</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable Confluence to send email notifications, a System Administrator must configure an email server. See <a href="#">Configuring a Server for Outgoing Mail</a>.</td>
</tr>
<tr>
<td>Confluence Administrators can set the default options for the recommended updates notification. Choose the cog icon, then choose <em>General Configuration</em> under Confluence Administration. Click <em>Recommended Updates Email</em> in the left-hand panel. See <a href="#">Configuring the Recommended Updates Email Notification</a>.</td>
</tr>
</tbody>
</table>
Subscribing to RSS Feeds within Confluence

An RSS feed is a format for delivering summaries of regularly changing web content. Subscribing to an RSS feed allows you to stay informed of the latest content from sites that you are interested in.

RSS is not designed to be read in a regular web browser. Specialised RSS newsreader programs can check RSS files every so often, and tell you what's new on a site. Your reader may be on a website, an add-on to your browser, part of your email program, or a stand-alone program.

Confluence generates its own RSS feeds for tracking updates to content within Confluence. You will need an RSS reader which can grab the RSS feeds from Confluence and display them for you.

Confluence's RSS macro allows you to display the contents of an RSS feed on a Confluence page. The feeds may come from a Confluence feed generator or from external sites. In this way, Confluence can act as an RSS reader.

For a technical description of RSS, read Mark Pilgrim's "What is RSS?" article on XML.com.

Confluence RSS feeds

RSS feeds allow you to track updates to content within Confluence. You will need an RSS newsreader to read a feed.

You can create a customised RSS feed using the RSS Feed Builder or subscribe to one of the pre-specified feeds generated by Confluence.

What would you like to do?

- Create and subscribe to customised RSS feeds using the RSS Feed Builder – Create a customised RSS feed. For example, you can filter your feed using a label, specify the number of items and days to include in your feed, and so on.
- Subscribe to pre-specified RSS feeds – Generate an RSS feed automatically in a minimal number of steps.
- Subscribe to a feed of any Confluence user's network – Track the activities of users the selected person is following.

On this page:
- Confluence RSS feeds
- RSS newsreaders
- Removing an RSS feed

Related pages:
- Managing Changes and Notifications and Tasks
- RSS Feed Macro

RSS newsreaders

The following are some popular RSS readers for various operating systems. You can find a more comprehensive list on Google's open directory.

Windows

- SharpReader
- NewsGator
- Syndirella
- FeedDemon
- NewzCrawler

Mac OS X

- Safari
- NetNewsWire
- NewsFire
- Shrook
Multi-platform

- **NewsMonster** (Runs in the Mozilla web browser)
- **Radio Userland** (Windows and MacOS)
- **AmphetaDesk** (Windows, Unix, Mac OS X)

Removing an RSS feed

There is no need to try to delete or remove an RSS feed built by the Confluence RSS feed builder.

Explanation: The feeds generated by the RSS Feed Builder are dynamically generated via the parameters included in the feed URL (address). For example, take a look at the following feed URL:

```
http://confluence.atlassian.com/createrssfeed.action?types=page&sort=modified&showContent=true...
```

The above feed URL will generate a list of pages ("types=page"), sorted by the modification date and showing the page content. The feed is generated at the time when the URL is fetched and there is no RSS feed information stored on the database. For that reason, there is no need to remove anything.

Using pre-specified RSS feeds

This page tells you how to get hold of an RSS feed which Confluence has predefined for you.

**To subscribe to predefined RSS feeds for a particular space:**

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose **RSS Feeds**.
3. Copy and paste the link for one of the feeds into your RSS newsreader:

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**
2. Choose **RSS Feeds** in the space operations options.
3. Copy and paste the link for one of the feeds into your RSS newsreader.

Feeds include:

- Pages
- Blog
- Mail
- Comments
- Attachments
- All content

**To subscribe to predefined RSS feeds for a particular page (where available):**

Note that the word 'page' here means a part of the Confluence user interface, rather than a page that contains Confluence content. For example, your **Network** view offers an RSS feed.

1. Go to the page.
2. Locate the following icon, which is available in the top-right corner of certain pages:
3. Copy and paste the icon’s link into your RSS newsreader.

**Related pages:**

- Using the RSS Feed Builder
- Managing Changes and Notifications and Tasks
- RSS Feed Macro
- Confluence User's Guide

**Notes**

If you want to customise your Confluence RSS feed (for example, use a label to filter your feed), use the RSS Feed builder instead of the above instructions.

Using the RSS Feed Builder
Using the RSS feed builder, you can create customised RSS feeds to subscribe to changes within Confluence. Wondering what an RSS feed is? See more information about RSS Feeds.

**Building an RSS feed**

Follow the steps below to build your feed, choosing the type of content and the time period you want to monitor.

**To create a customised RSS feed:**

1. Choose the help icon at top right of the screen, then choose **Feed Builder**.
2. Select the content types you want in your feed.
   
   Check **Mail** if you want to know when the email archive is updated. (See the overview of mail archives in Confluence.)

3. Select one or more spaces from the list.
4. Click **Advanced Options** to set the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Feed Name</strong></td>
<td>The default name is based on the name of your Confluence installation. For example, 'Extranet RSS Feed'.</td>
</tr>
<tr>
<td><strong>With these labels</strong></td>
<td>Enter one or more labels separated by spaces or commas. Confluence returns all content (of the selected types) that matches one or more of the labels. See the hint below about using labels to customise your feeds.</td>
</tr>
<tr>
<td><strong>Exclude these spaces</strong></td>
<td>Exclude specific spaces from those already selected.</td>
</tr>
<tr>
<td><strong>Sorted by</strong></td>
<td>Sort content by either the date or creation or the date they were last updated.</td>
</tr>
<tr>
<td><strong>Limit to</strong></td>
<td>Specify the number of items returned in your feed.</td>
</tr>
<tr>
<td><strong>Within the last</strong></td>
<td>Specify how old items returned can be.</td>
</tr>
<tr>
<td><strong>Include content for pages</strong></td>
<td>Specify whether the entire page is displayed in the feed.</td>
</tr>
</tbody>
</table>

5. Choose **Create RSS Feed**.
6. Drag or copy the link into your RSS reader.

**On this page:**
- Building an RSS feed
- Hints
- Notes

**Related pages:**
- Managing Changes and Notifications and Tasks
- Subscribing to RSS Feeds within Confluence
- Confluence User's Guide

**Hints**
- **Separate feeds.** Try building separate feeds, one for pages only and one that includes comments as well. This allows you to monitor only pages if you are short of time, and to read the comments when you have more time.
• **Labels to customise your feed.**

You can use the RSS feed builder to track updates to labelled pages and comments on those pages. Here is an idea for customising your RSS feed by using your own personal label(s). This is useful if you want to track updates to specific pages or blog posts, and you do not want to deal with emails. You can use this method as an alternative to watching pages.

- Build an RSS feed that returns pages, blog posts and comments labelled with a personal label, such as 'my:feed'.
- Each time you want to 'watch' a page, just label it with 'my:feed'.
- All updates and comments will automatically come through your RSS feed.

**Notes**

• **Removing an RSS feed:**

There is no need to try to delete or remove an RSS feed built by the Confluence RSS feed builder. Explanation: The feeds generated by the RSS Feed Builder are dynamically generated via the parameters included in the feed URL (address). For example, take a look at the following feed URL:

```
http://confluence.atlassian.com/createrssfeed.action?types=page&sort=modified&showContent=true...
```

The above feed URL will generate a list of pages ('types=page'), sorted by the modification date and showing the page content. The feed is generated at the time when the URL is fetched and there is no RSS feed information stored on the database. For that reason, there is no need to remove anything.

• **Feed authentication options:** Confluence can offer you the option of an anonymous feed or a feed that requires authentication.
  - An **anonymous** feed will show only the content that is visible to anonymous users. The feed URL does not contain the &os_authType parameter mentioned below. This feed is useful only if your Confluence site allows anonymous access. If a feed is anonymous, you only get anonymously-viewable content in the feed regardless of whether you are a Confluence user or not.
  - An **authenticated** feed requires you to log in to Confluence before you can retrieve the content. The feed URL contains the following parameter: &os_authType=basic.
  - The option to choose between an anonymous and an authenticated feed is currently not available on the feed builder screen. The feed builder offers only authenticated feeds. See CONF-21601 for details and a workaround.

**Subscribing to a Network RSS Feed**

You can create an RSS Feed from any user's **network** view, allowing you to receive summaries on the activities of users they are following in their network. The types of activities tracked in these RSS feed summaries include:

- Additions or edits to pages or blog posts
- Comments added to a page or blog post or edits to existing comments
- Updates to a user's status updates
- Updates to a user's profile

**Subscribing to a user’s network feed**

**To subscribe to a user’s network RSS feed:**

1. Locate the RSS icon, which is available from the top-right of:
   - The 'Recent activity of the users you are following' section of your network page, or
   - The 'Activity of followed users' section of another user’s network page.
2. Copy and paste the icon's link into your RSS newsreader.
Customising your network RSS feed

Confluence does not provide a way of customising a network RSS feed via the user interface. However, you can modify the maximum number of results and type of content displayed in these feeds by directly editing the RSS feed link in your RSS newsreader.

To modify the maximum number of results displayed in your RSS feed:

1. Edit the RSS feed link in your RSS newsreader.
2. Change the value of the max parameter from its default value of 40 to a value of your choice. Example:
   http://confluence.atlassian.com/feeds/network.action?username=MYNAME&max=60&publicFeed=false&os_authType=basic&rssType=atom
3. Save the modified link in your RSS newsreader.

To modify the type of content displayed in your RSS feed:

1. Edit the RSS feed link in your RSS newsreader.
2. Append the parameter contentType to the end of the link, followed by an equals sign (=) and then add the appropriate content type value of your choice:
   - USER_STATUS — restricts the RSS feed to user status updates.
   - PAGE — restricts the RSS feed to page additions or updates.
   - BLOG — restricts the RSS feed to blog post additions or updates.
   - ATTACHMENT — restricts the RSS feed to attachment additions or updates.
   - COMMENT — restricts the RSS feed to comment additions or updates.
   Content type values are case-sensitive. Ensure that each parameter is separated from the other by an ampersand (&). Example:
   http://confluence.atlassian.com/feeds/network.action?username=ggaskell&max=40&publicFeed=false&os_authType=basic&rssType=atom&contentType=USER_STATUS
3. Save the modified link in your RSS newsreader.

Notes

It is not possible to filter for more than one type of content by adding multiple values to the contentType parameter.

Managing Notifications in Confluence

This page is about the notification-and-task dialog, known as the Confluence 'workbox', which drops down when you choose the icon on the Confluence page header.

Do you want to manage your notification email messages instead? See Subscribing to Email Notifications of Updates to Confluence Content.

Managing your notifications in the Confluence workbox

The workbox displays all notifications collected from Confluence page watches, shares, mentions, and tasks. If your Confluence site is linked to a JIRA issue tracker, you will also see JIRA notifications in your workbox.

You can view your notifications and convert them to personal tasks. Use the inline actions to reply to comments, like a comment or page, or watch a page. Follow the links in a notification to open the relevant page or blog post. With JIRA integration, you can watch or unwatch issues, comment on issues, or follow the link to open the issue...
in JIRA.

The workbox displays your notifications and your personal tasks in separate tabs.

**To manage your notifications:**

1. Choose the workbox icon 📦 in the Confluence page header.
   - A number may appear on the workbox icon, indicating the number of unread notifications waiting for your attention.
   - You can use the keyboard shortcut: Type `g` then `n`. (When in the Confluence editor, click outside the editor pane before pressing the keyboard shortcut keys.)

2. Choose the notifications icon: 📧

3. Choose a notification from the list, to see the notification details. Now you can do the following:
   - Choose a link or **Open** to open the related page, blog post, or comment. The page will open in a new tab in your browser.
   - Choose **Like** or **Unlike** to let people know that you like, or have stopped liking, a page, blog post, or comment.
   - Choose **Watch** or **Stop Watching** to receive notifications, or stop receiving notifications, about a page or blog post.
   - Choose **Reply** to respond to a comment inline, within the workbox.
   - Choose the ‘add task’ icon ☑️ to flag a notification as a task. The notification will remain in the notification list too.

---

**On this page:**
- Managing your notifications in the Confluence workbox
- Which notifications are included?
- Keyboard shortcuts
- Managing notifications with Confluence mobile
- Notes

**Related pages:**
- Configuring Workbox Notifications
- Subscribing to Email Notifications of Updates to Confluence Content
- Watching Pages, Spaces and Blogs
- Likes and Popular Content

---

Screenshot: Your Confluence notifications in the workbox
Which notifications are included?

The workbox displays a notification when someone does one of the following in Confluence:

- **Shares** a page or blog post with you.
- **Mentions** you in a page, blog post, comment or task.
- Comments on a page or blog post that you are watching.
- **Likes** a page or blog post that you are watching.

The workbox does **not** show notifications triggered because you are watching a space. Only watches on pages and blog posts are relevant here.

The notification in your workbox appears as 'read' if you have already viewed the page or blog post.

If your Confluence site is linked to JIRA, you will also see the following JIRA notifications in your workbox:

- Comments on issues that you are watching.
- Mentions.
- Shares of issues, filters and searches.

Keyboard shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>g then n</td>
<td>Open the Confluence workbox.</td>
</tr>
<tr>
<td>j</td>
<td>Move down to the next entry in the notification list.</td>
</tr>
<tr>
<td>k</td>
<td>Move up to the previous entry in the notification list.</td>
</tr>
<tr>
<td>n</td>
<td>Move down to the next notification for a particular page or blog post.</td>
</tr>
</tbody>
</table>
Managing notifications with Confluence mobile

You can view and respond to your notifications on your phone or other mobile device too. See Using Confluence on a Mobile Device for more about mobile platforms.

Notes

- Read notifications are automatically deleted after 2 weeks.
- Unread notifications are automatically deleted after 4 weeks.
- You cannot delete your notifications yourself.
- If a new notification arrives while you have workbox open, the count appears on the workbox icon but the notification is not added to the workbox. You need to close workbox and re-open it to see the new notification.
- The ability to receive notifications from JIRA or another Confluence site is available in Confluence 4.3.3 and later. To receive JIRA notifications, you need JIRA 5.2 or later.
- Administrators can enable and disable the workbox on your Confluence site. They can also connect a JIRA site or another Confluence site, so that notifications from those sites appear in your workbox too. See Configuring Workbox Notifications.
- The Confluence workbox is provided by a set of plugins. To remove the personal notifications and tasks functionality from your site, you can disable the following plugins. See Disabling or Enabling a Plugin for instructions. Disabling these plugins will disable the entire workbox. It is not possible to disable only tasks or only notifications:
  - Workbox - Common Plugin
  - Workbox - Host Plugin
  - Workbox - Confluence Provider Plugin
- If you want to re-enable the plugins, do so in the following order: Common Plugin, Host Plugin, Confluence Provider Plugin.
- There is no option to disable the workbox for an individual user.
- The workbox is not available in Confluence Data Center (clustered). The plugin will be installed and enabled, but it will detect that the site is in clustered mode and will not display the dialog.

Working with Tasks

Keep track of the things that need to get done with tasks. With the ability to
give each task an assignee and due date, and plenty of ways to see your tasks, you can make sure nothing slips through the cracks in your project or team.

Creating a task

Tasks are created on pages. For example, you might add tasks under action items on a meeting notes page, or in a project planning page - anywhere you need a lightweight task management solution.

To create a task:

1. In the editor choose the Task list button or use the keyboard shortcut \[
2. Start typing your task - use @ to assign the task to someone or // to choose a due date.

The first person you mention in a task is the assignee. You can mention more people in the task, but the first person mentioned will be the assignee - you can even assign tasks to yourself.

Note: If you assign a task to someone who does not have permissions to view the page or space, they won't see the task.

Keeping track of tasks

There are a number of ways to keep track of tasks assigned to you, or tasks you've created for others.

On a page

The simplest way to see a task is on the page it was originally created on, for example in a meeting notes page.

It is easy to see if a task is complete, who it is assigned to, and when it is due. If a task is nearing, or has passed its due date, the colour of the date will change (red for overdue, orange for due in the next 7 days).

In your profile

The tasks page in your profile gives you a place to see all the tasks relevant to you in one place. Easily keep track of the status of tasks assigned to you, and tasks you've created and assigned to others.

To view the tasks page, go to Profile > Tasks.

Use the filters to show tasks that were assigned to you or created by you and toggle between complete or incomplete tasks.
In a Task Report

If you're looking for a more custom view of tasks, the Task Report blueprint is a great way to track tasks assigned to a specific team or project.

To create a task report:

1. Choose Create > Task Report
2. Select the type of report:
   - Assigned to my team for tasks assigned to particular people
   - In my project for tasks that appear in a specific space or page, or
   - Custom for a wide range of filtering options, including by date or page label.
3. Follow the prompts to create the report.

This blueprint uses the Task Report macro. You can also choose to use this macro on an existing page, for example, on a project or team space homepage. See Task Report Macro for more about using this macro.

Notes

- The date picker can be triggered by typing // or by typing a date in the format dd/mm/yyyy or dd-mm-yyyy. Typing other date formats in the editor will not trigger the date picker.
- Personal Tasks (created in the Workbox in older versions of Confluence) do not appear in the Tasks view or Task Report. To migrate any incomplete personal tasks, go to Workbox > Personal Tasks and follow the prompts.
- The existing wiki markup based Tasklist Macro has been removed from the macro browser. If you have a Tasklist macro on a page it will continue to work, but you will be unable to add new Tasklists using this macro.

Finding Content

Where does a page or blog post go when you create it, and how can you find it again? How can you find content that is most relevant to your team or project, or search for pages that cover the topic you are interested in?

Hint for space administrators: Help your team members and colleagues find important pages and other content, by adding links to the space's sidebar. See Configuring a Sidebar.

A space is an area within Confluence, containing your pages, blog posts and other content. You can think of each space as a sub-site, or mini-site, each with its own home page.

Finding pages and blog posts

These are the quickest ways to find your content:

- Use the links in the sidebar to find your pages, blog posts, and other parts of the space. See more details below.
- Type the page name or key words into the search box at the top right of the Confluence screen. See Searching Confluence.
- Go to the pages view for a list of pages in the space. You can see recently updated pages or browse through a hierarchical (tree) view. See Viewing All Pages in a Space.

More about the sidebar

The sidebar appears on the left of every page in spaces that use the default Confluence theme. You can:

- Choose a different type of content, or perform various operations, via the links on the sidebar.
• Use the contextual navigation options that appear at the bottom of the sidebar, based on the type of content you are viewing.
• Collapse or expand the sidebar.
• Access the sidebar options via slide-out menus even when the sidebar is collapsed.
• Configure the links that appear in the 'Shortcut links' section, if you are a space administrator.

On this page:
• Finding pages and blog posts
• More about the sidebar
• Collapsing the sidebar
• Where does Confluence put your pages and blog posts?
• Can you change the location of a page or blog?
• Can you change the location of a blog post?

Related pages:
• Creating Content
• Organising Content
• Giving People Access to Content
• Using the Documentation Theme
• Confluence User's Guide

Screenshot: Sidebar in the default theme with 'Child Pages' navigation.

<table>
<thead>
<tr>
<th>Section or option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to the space home page</td>
<td>This link appears next to the space logo at the top of the sidebar. It takes you to the home page for this space. Clicking on the space logo will also take you to the home page for the space.</td>
</tr>
<tr>
<td>Pages and Blog</td>
<td>This section can contain the links to the following locations:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Pages</strong>: An index of all pages in the space. See Viewing All Pages in a Space. Note that space administrators can hide the 'Pages' link.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Blog</strong>: An index of all blog posts in the space. See Working with Blog Posts. Note that space administrators can hide the 'Blog' link.</td>
</tr>
<tr>
<td></td>
<td>• Other links added by add-ons.</td>
</tr>
</tbody>
</table>
Space shortcuts

This area contains links to important pages and other locations for your project or team. Space administrators can add and remove links here. See Configuring a Sidebar.

Space Tools

The ‘Advanced’ option gives access to space administration and advanced operations like space exports and space watches.

Configure sidebar

The ‘Configure sidebar’ option is available to space administrators for setting up shortcut links, changing the space name and logo, and other configuration options. See Configuring a Sidebar.

Contextual navigation

The links in this area change, depending on the section of the space that you are viewing.

- For pages, you will see the full page tree or child pages (if any) of the current page - depending on the navigation display option selected for the space.
- For blogs, you will see links to blog posts in the current month, and an expandable list of previous months.

Collapsing the sidebar

Advanced users will find it useful to collapse the sidebar and gain more space on the page.

- Grab and drag the border, choose the >> button or use the keyboard shortcut [ to collapse and expand the sidebar.
- Access the sidebar options via slide-out menus even when the sidebar is collapsed.

Where does Confluence put your pages and blog posts?

When you create a new page, that page will be a child of another page, in the space that you selected in the ‘Create’ dialog. The parent page depends on where you are when you create the page.

<table>
<thead>
<tr>
<th>Your location when creating the page</th>
<th>Location of new page</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are viewing a page in the same space where you will put the new page – that is, the space that you select in the ‘Create’ dialog.</td>
<td>A child of the page you are currently viewing.</td>
</tr>
</tbody>
</table>
You are viewing any other Confluence screen. For example:

- You are on the dashboard.
- You are on the 'Pages' view of a space.
- You are viewing a blog post.
- You are viewing a page in a space, and choose to add your new page in a different space.

A child of the home page in the space you select in the 'Create' dialog.

A blog post is part of a chronological sequence of posts, linked from the space's 'Blog' index page.

Can you change the location of a page or blog?

Yes. See Moving a Page.

Can you change the location of a blog post?

You can move a blog post to another space, but you cannot change its location within a space.

**Searching Confluence**

Quick guide to searching in Confluence:

1. Use the search box at the top right of your Confluence screen. It offers you a quick navigation aid as well as a full site search.
2. You can search for administrative actions via the quick navigation aid too.
3. You can search Confluence directly from your browser’s search box. Just add your Confluence site as a search provider using the dropdown menu in your browser’s search box.
4. While editing a page or a blog post, you can find and replace text on the page. See Using the Editor.

Using the quick navigation aid to find content and administrative actions

When you enter text into the Confluence search box, the quick navigation aid automatically offers a dropdown list of pages, administrative options, and other items. The items are matched by page name to your search query. You can choose one of the offered items or ignore them altogether.

**To use the quick navigation aid to find content:**

1. Start typing your query into the search box located at the top right-hand corner of every screen. Confluence matches titles as you type, showing a quickly-adjusting dropdown list of pages, blog posts, personal profiles, attachments and so on. Press the Enter key if you want to bypass the quick navigation aid and perform a full search, as described below.
2. To see the space to which an item belongs, let your mouse pointer hover over the item in the dropdown list.
3. Use the up- and down-arrows on your keyboard to move up and down the list of matching titles and select an item.
4. Press the Enter key to open the selected item.
5. If you do not find what you are looking for, click **Search for** at the bottom of the list to do a full search. This has the same effect as pressing Enter immediately after typing your search query. The full search is described below.

**To use the quick navigation aid to get to administration functions:** Start typing what you want to do into the Confluence search box. The matching administrative functions will appear with a cog icon at the top of the dropdown search results.

**Even faster via 'GG':** Press ‘G’ twice on your keyboard then continue typing the search term.

_Screenshot: The quick navigation aid showing titles matching the query 'st'_

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Here is more information about how the quick navigation feature works:

- Confluence will truncate any titles that are too long to be displayed.
- The matching items are grouped by type so that you can quickly find the type you want. Confluence shows a maximum of 3 administrative items, 6 pages and/or blog posts, 2 attachments, 3 people and 2 spaces. If no matches are found in a particular category, then that category does not appear in the list.
- Items are ordered with the most recent updates first.
- When the matching item is a person's name, their profile picture appears next to their name in the list.
- The part of the title that is matched by the search query is highlighted in bold text.
- Your Confluence Administrator can enable or disable the quick navigation feature using the Confluence Administration Console.

Notes about finding administrative options via the search box:
- Pressing 'GG' puts your cursor into the search box.
- The ‘GG’ combination is familiar to JIRA users, because the same shortcut opens the JIRA administration search dialog.
- System administration, Confluence administration and space administration options may appear in the
search results.

- Confluence permissions determine the administrative options that appear in the search results. You will only see the options that you have permission to perform.

### On this page:

- Using the quick navigation aid to find content and administrative actions
- Performing a full search
- Filtering your search results
- Searching for labels
- Searching the content of attachments
- Search options when using the Documentation theme
- Advanced search syntax
- Searching Confluence from your browser's search box
- Useful plugins

### Related pages:

- Confluence Search Syntax
- Confluence Search Fields
- Search Results Macro
- Livesearch Macro
- Page Tree Macro (includes an optional search box)
- Viewing Labels and Labelled Content
- Searching the People Directory
- Confluence User's Guide

#### Performing a full search

When you perform a full search, Confluence will search all content in all spaces (site and personal), mail, personal profiles, attachments and the space description. The results will appear on a new screen.

#### To use the full search:

1. Type your query into the search box located at the top right-hand corner of every screen (or type it into the text box at the top of the Search screen).
2. Press the Enter key. (This means that you will ignore the dropdown list of titles offered by Confluence’s quick navigation aid, described above.)
3. The search screen appears, as shown below. If any Confluence pages or items match your search query, the search screen shows a list of the matching items.
4. Click an item's title to open the Confluence page or other item.

*Screenshot: Search results page*
On the right of the screen you will see a text block for each item that matched the search criteria, with the following information for each item:

- An icon representing the content type (user profile, space, page, blog post, etc).
- The title or name of the content item, linked to the item.
- The most relevant few lines of content from within the item. Any words that match your search query are highlighted within the content.
- The space to which the item belongs, displayed on the last line of the item’s text block.
- The date when the content item was last modified.

You will see only search results which you have permission to view.

On the left of the screen are further options which allow you to tailor or filter your search results. See below.

Filtering your search results

The search screen, pictured above, appears when you do your first search. By default, Confluence will search all content across your Confluence site, including all spaces, mail archives, attachments and all other content types.
On the left of the screen are options which allow you to tailor (filter) the search results.

Define your filter criteria:

- **Type** – Restrict your search results to a particular content type (pages, blog posts, comments, etc).
- **Last modified** – Restrict your search results to content updated within a particular period of time (within the previous 24 hours, within a week, within a month, or within a year).
- **Space** – Restrict your search results to a particular space, or to your favourite spaces, site spaces or personal spaces. You can also set an option to include archived spaces. (See Archiving a Space.)
- **By** – Restrict your search results to content last modified by a particular person. You can start typing the person's username or part of their name into the text box as follows:
  - Type the username (for example: ‘jsmith’).
  - Or start typing the person's first name (for example: ‘john’)
  - Or their last name (for example: ‘smith’).
  - Or another part of their name, such as a middle name.
  Confluence will offer you a list of possible matches. Use your mouse to select the person you want, then press the Enter key to filter the search results.

More information about the user-matching filter:

- The user-matching filter is not case sensitive. You can enter upper or lower case letters and will receive the same results.
- When looking for users to match the name you entered, Confluence divides a person's name into logical units corresponding to first name, middle name (one or more) and last name. It matches the letters of each unit in the name you entered against the letters of each unit in the user directory. For example, you can enter 'jo sm' to look for John Smith. The search is triggered after you have entered at least two letters.
- For each part of the name, you need to enter at least two letters. For example, if you enter just 'john s', the filter will look for users called 'john' and will ignore the 's'. Similarly, if you enter 'j smith' you will see everyone with the name 'smith' even if their first name does not start with a 'j'.
- You are not forced to use the auto-complete list. You can just type 'jsmith' or 'jo sm' and filter on that without choosing a match from the dropdown list. Confluence will warn you if there is more than one user corresponding to the name you have entered.

**Searching for labels**

Use the 'labelText:' prefix to search specifically for content that has a specific label. The table below gives examples of search terms that you can enter into Confluence's search box, and the search results that you can expect.

<table>
<thead>
<tr>
<th><strong>Searching for ...</strong></th>
<th><strong>Returns content that ...</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>recipe labelText:chocolate</td>
<td>contains the word 'recipe' or has the label 'chocolate'</td>
</tr>
<tr>
<td>recipe AND labelText:chocolate</td>
<td>contains the word 'recipe' and has the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake OR labelText:chocolate</td>
<td>has the label 'cake' or the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake AND labelText:chocolate</td>
<td>has both labels 'cake' and 'chocolate'</td>
</tr>
</tbody>
</table>
The 'labelText:' prefix is an example of a search field. See more about Confluence Search Fields.

Searching the content of attachments

When you search Confluence, by default the search will include the content of the following types of attachments:

- Word
- Text
- PowerPoint
- Excel
- PDF
- HTML

To search the content of other attachment types, you will need to use an attachment content extractor plugin. For more information, take a look at the following:

- Existing extractor plugins which you can install on your Confluence site. See this search on Atlassian Marketplace.
- Guidelines on developing your own attachment content extractor plugin. See our developer documentation on extractor plugins.

Search options when using the Documentation theme

When using the Documentation theme, the Confluence search offers a few options as described below.

Using the search box at the top right of the page:

- By default, the main Confluence search is configured to search the entire Confluence site.
  - You will see the words 'Search Confluence' in the search box at top right of the page.
  - The Confluence search will look for matches in the entire Confluence site. This is the default behaviour for other themes too.
- A space administrator can configure the Documentation theme to restrict the search to the current space.
  - You will see the words 'Search this space' in the search box at top right of the page.
  - The search will return results from the current space only.
  - You can override the search restriction. Enter 'all:' and your search term to search the entire site. For example, enter the following into the search box at top right of the page to search the entire site for 'technical writing':

    all: technical writing

Using the search box in the left-hand panel:

- By default, the Documentation theme's left-hand panel includes a search box. Enter your search term there, to restrict the search to the current space. Specifically, this will search only the pages that are children of the space's home page.
- If your administrator has restricted the main search to the current space, there will not be a search box in the left-hand panel.

For screenshots and a full description, see Using the Documentation Theme.

Advanced search syntax

See Confluence Search Syntax for more ways to refine the text you enter into the search box.

Additionally, see Confluence Search Fields for special parameters you can use in the search box to search on various metadata.

Searching Confluence from your browser's search box
If you are using Firefox or Internet Explorer 7 or later, you can add your Confluence site as a search provider, using the dropdown menu next to the browser’s search box.

The example below shows the ‘Extranet’ Confluence site offered for inclusion as a search engine in the browser’s search box.

Screenshot: Adding your Confluence site to your browser’s search box

Information about OpenSearch:

- Confluence supports the autodiscovery part of the OpenSearch standard, by supplying an OpenSearch description document. This is an XML file that describes the web interface provided by Confluence’s search function.
- Any client applications that support OpenSearch will be able to add Confluence to their list of search engines.
- Your Confluence Administrator can enable or disable the Open Search feature using the Confluence Administration Console.

Useful plugins

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

This plugin extends the Confluence search, so that you can search for macro parameter names and values: the Confluence Macro Indexer plugin.

Confluence Search Syntax

This page describes the special words and punctuation marks you can use to refine your search.

**Matched phrase search**

Use double quotes to search for content that contains the phrase 'cheese one', or a phrase where 'cheese' and 'one' are the major words:

"cheese one"

**Note:** Confluence will ignore common words (stop words), including 'and', 'the', 'or', and more, even if they are included within double quotes. See the default list of stop words used by Confluence’s search engine, Lucene, in the Lucene documentation.

For example:

1. Searching for "cheese one" returns only pages in which 'one' appears as the first word (other than stop words) after 'cheese'. So it will return 'cheese for one' or 'cheese to one' or 'cheese one'. It does not return 'one cheese' or 'cheese flamingo one'.
2. Searching for "the one" returns all pages containing 'one' because 'the' is a stop word.

If you would like to override Lucene's tokenisation and stemming, please cast your vote on this improvement request: CONF-14910.

**OR search**

To search for content that contains one of the terms, 'chalk' or 'cheese', use the operator OR in capital letters:

```
chalk OR cheese
```

**AND search**

To search for content that contains both the terms 'chalk' and 'cheese', use the operator AND in capital letters:

```
chalk AND cheese
```

**NOT search**

To search for content that contains 'chalk' but NOT 'cheese', use the operator NOT in capital letters:

```
chalk NOT cheese
```

**Excluded term search**

To search for content that contains 'chalk' and 'butter' but not 'cheese':

```
chalk butter -cheese
```

**Grouping search**

To search for content that must contain 'chalk' but can contain either 'cheese' or 'butter', use brackets to group the search terms:
(cheese OR butter) AND chalk

**Title search**

To search for content with 'chalk' in its title, where *title* is the field keyword.

```plaintext
title:chalk
```

**Wildcard searches**

**Single character**

To search for 'butter' or 'batter' you can use a question mark as a wildcard:

```plaintext
b?tter
```

To search for 'chicken' or 'chickpea' you can use an asterisk as a wildcard:

```plaintext
chick*
```

You can use wildcards anywhere within a word, even at the very beginning:

```plaintext
*chick
```

**Multiple characters**

To search for 'chick' or 'chickpea':

```plaintext
c*c*
```

You can also combine search characters to get the exact word. For example the search term below will return 'chick' but not 'chickpea':

```plaintext
c*c?
```

**Proximity searches**

Use a tilde character followed by a number, to find two words within a certain number of words of each other.

For example, the following search will return 'Octagon blog post':

```plaintext
"octagon post"~1
```

The following search is not valid:

```plaintext
"octagon post"~0
```
Range search

Use the operator 'TO', in capital letters, to search for names that fall alphabetically within a specified range:

[adam TO ben]

Note: You cannot use the AND keyword inside this statement.

Fuzzy search

Use a tilde character to find words spelled similarly.

To search for octagon, if unsure about spelling:

octogan~

Combined search

You can also combine various search terms together:

o?tag* AND past~ AND ("blog" AND "post")

Searching for macros

You can search Confluence content for anywhere a macro is used. To do this, just add macroName: to your search and append the macro name after the column. For example, search for all excerpt-include macros:

macroName:excerpt-include*

For more information about macroName and other search fields, see Confluence Search Fields.

Searching for labels

Use the 'labelText:' prefix to search specifically for content that has a specific label. The table below gives examples of search terms that you can enter into Confluence's search box, and the search results that you can expect.

<table>
<thead>
<tr>
<th>Searching for ...</th>
<th>Returns content that ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>recipe labelText:chocolate</td>
<td>contains the word 'recipe' or has the label 'chocolate'</td>
</tr>
<tr>
<td>recipe AND labelText:chocolate</td>
<td>contains the word 'recipe' and has the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake OR labelText:chocolate</td>
<td>has the label 'cake' or the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake AND labelText:chocolate</td>
<td>has both labels 'cake' and 'chocolate'</td>
</tr>
</tbody>
</table>

The 'labelText:' prefix is an example of a search field. See more about Confluence Search Fields.

Confluence Search Fields

This page gives an overview of the Apache Lucene search fields used in Confluence.

Searching for content in specific fields

Confluence data is stored in fields which can be specified in the search. To search a specific field, type the name
of the field followed by a colon `:` and then the term you are looking for.
Preliminary examples:

```plaintext
title:"Some Title"
```

```plaintext
labelText:chalk
```

The field specification applies only to the term directly preceding the colon. For example, the query below will look for "Some" in the title field and will search for "Heading" in the default fields.

```plaintext
title:Some Heading
```

---

**Confluence search fields**

Below are the fields which can be searched, listed by content type.

### Personal Information

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>fullName</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>title</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>labelText</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>modified</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>contentBody</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

### Pages

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Blog**

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>title</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>spacekey</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>labelText</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>modified</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>contentBody</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>macroName</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>The name of a macro used in the blog</td>
</tr>
</tbody>
</table>

**Attachments**

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>filename</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>title</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>comment</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>spacekey</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>modified</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
</tbody>
</table>
**More examples**

**Searching for labels**

Use the 'labelText:' prefix to search specifically for content that has a specific label. The table below gives examples of search terms that you can enter into Confluence's search box, and the search results that you can expect.

<table>
<thead>
<tr>
<th>Searching for ...</th>
<th>Returns content that ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>recipe labelText:chocolate</td>
<td>contains the word 'recipe' or has the label 'chocolate'</td>
</tr>
<tr>
<td>recipe AND labelText:chocolate</td>
<td>contains the word 'recipe' and has the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake OR labelText:chocolate</td>
<td>has the label 'cake' or the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake AND labelText:chocolate</td>
<td>has both labels 'cake' and 'chocolate'</td>
</tr>
</tbody>
</table>

The 'labelText:' prefix is an example of a search field. See more about [Confluence Search Fields](#).

**Useful plugins**

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on [add-on support](#).

This plugin extends the Confluence search, so that you can search for macro parameter names and values: the [Confluence Macro Indexer plugin](#).

**Searching the People Directory**

The people directory displays a list of people who are authorised to log in to your Confluence site.

The people directory includes anybody who has logged into Confluence or who has had a user account created...
for them in Confluence.

The people directory does not include users who can log into Confluence using external user management if they have never yet logged in.

Viewing the people directory

Choose People at the top of the screen.

Searching for people

To search for a particular person, type their first name and/or last name into the search box and choose Search.

- To see everyone who uses your Confluence site, choose All People.
- To see just those people who have set up a personal space, choose People with Personal Spaces.

Following people’s activities

Confluence's network features allow you to 'follow' (that is, keep track of) other people's activities in your Confluence site. For more information, please refer to Network Overview. You can use the hover profile feature in the people directory to start following other people.

- To start following someone, move your mouse over their name or profile picture and choose Follow in their profile popup.
- To stop following someone, move your mouse over their name or profile picture and choose Stop Following in their profile popup.

Once you start following another person, their activities will start appearing in your network view.

On this page:

- Viewing the people directory
- Searching for people
- Following people’s activities
- Notes

Related pages:

- Setting Up your Personal Space
- Editing your User Profile
- Choosing a Profile Picture
- Confluence User's Guide

Notes

- The people directory uses the hCard microformat for simple integration with a variety of microformat-enabled tools. hCard is an open data format for representing people, companies, organisations, and places. Read more about microformats and hCard.
- By default, deactivated users (disabled user accounts) are excluded from the people directory. You can
include them by adding the `showDeactivatedUsers` parameter to the URL. For example:

```
http://my.confluence.com/dopepeopledirectorysearch.action?showDeactivatedUsers=true
```

- By default, externally deleted users (for example, users deleted from an LDAP repository) are excluded from the people directory. You can include them by adding the `showExternallyDeletedUsers` parameter to the URL. For example:

```
http://my.confluence.com/dopepeopledirectorysearch.action?showExternallyDeletedUsers=true
```

- The Confluence administrator can hide the people directory. If it is hidden, you will not see the People Directory option.

### Organising Content

Confluence provides a number of ways for organising and structuring content in the wiki:

- **Spaces** allow you to group content according to major categories.
- **Pages** are used for discrete topics, and can be structured into page trees to show the relation between them.
- **Favourites** are particular pages or spaces that have been bookmarked by a user, to make them easy to find again.
- **Labels** are user-defined tags that are added to related pages in order to categorise them in some way.
- **Attachments** to a page can include images, multimedia, Office and PDF files, and provide a way to include other forms of content in the wiki.
- The **sidebar** is a good place to display important links for your team or project.
- **Email** can be collected and archived within each space, to manage all mail related to a project.

**Related pages:**

- Changing the Sequential Order of Pages
- Creating Content
- Searching Confluence
- Confluence User's Guide

### Working with Pages

Pages are the primary means of storing and sharing information in Confluence. Pages are contained within spaces.

- Use **spaces** to organise your wiki content into your primary logical groups. For example, you could have a space per team, per product, or per department.
- Use **pages** to organise your content into lower-level groups. For example, you could have a page for a particular team activity, or for a feature in a product, or for a chapter in a book. Add more child pages to contain lower-level details if necessary.

Things you can do with pages in Confluence:

- Create a new page from anywhere within the site.
- Write content using the editor.
- Rename a page.
- Copy a page.
- Delete a page or remove a specific version of a page.
- Move pages and organise them hierarchically while editing a page or while viewing the space's Tree view.
- Navigate within and between spaces through flexible linking.
- Collaborate via comments on a page.
- Control access through page security restrictions.
- Monitor page updates and other activity through page notifications.
Moving a Page

This guide describes how to change a page’s location. You can:

- Change the default location of a new page.
- Move an existing page to a different space.
- Move an existing page to a different parent page within the same space.
- Reorder pages that are children of the same parent.

When you move a page, attachments and comments will be moved with the page. All child and descendent pages will also be moved.

Notes about permissions:

To move a page, you need the following permissions:

- ‘Add’ permission on the page you are moving, and
- ‘View’ permission on the page’s parent page. So if you are moving the page to a different parent, you need ‘View’ permission on the new parent.

To move a page into a different space, you also need:

- ‘Delete’ permission on the space you are moving from, and
- ‘Add’ permission on the space you are moving to.

If the page has page restrictions, and you want to keep the page restrictions in the new location, you will also need ‘Restrict’ permission on the space you are moving to. Alternatively, remove the page restrictions before performing the move.

On this page:

- Setting the location of a new page
- Moving a page to a different space
- Moving a page within a space
- Notes

Related pages:

- Moving an Attachment
- Copying a Page
- Deleting a Page
- Changing the Sequential Order of Pages
- Overview of Pages
- Confluence User’s Guide

Setting the location of a new page

While you are creating a new page, you can set the page’s location before saving the page.

To set the location for a new page:

1. While editing the page, choose Location.
2. Use the tabs on the left of the ‘Set Page Location’ dialog to help you find the new space and parent page for your page. They determine the location of your page. The ‘Current location’ and ‘New location’ breadcrumb trails at the bottom of the dialog indicate the current parent page and new parent page.
3. If you want to move a page to a different position amongst the child pages, select Reorder. (When you
choose **Move** in the next step, you will be able to reorder the page.)

4. **Choose Move.**

5. If you are reordering the child pages, position the pointer in the list to set the new position for the page and choose **Reorder.**

**Screenshot: Setting the location of a new page**

---

**Moving a page to a different space**

You can move a page, along with its child pages, to a different space. Confluence will automatically adjust all links to the moved pages, to point to the pages in the new space.

**To move a page to another space in your Confluence site:**

1. Go to the page and choose **Tools > Move.**
2. Use the tabs on the left to help you find the new space and parent page for your page. They determine the location of your page. The 'Current location' and 'New location' breadcrumb trails at the bottom of the dialog indicate the current parent page and new parent page.
3. If you want to move a page to a different position amongst the child pages, select **Reorder.** (When you choose **Move** in the next step, you will be able to reorder the page.)
4. Choose **Move.**
5. If you are reordering the child pages, position the pointer in the list to set the new position for the page and choose **Reorder.**

**Moving a page within a space**

You can move a page to a different position in the page tree. This allows you to:

- Move a single page, or a family of pages, to a different parent within the space.
- Reorder pages that are children of the same parent.

All links to the page are maintained. When you move a parent page, the entire hierarchy of child pages will move too.
To move a page:

1. Go to the space and choose **Space tools > Reorder pages** on the sidebar. If your space is using the Documentation theme choose **Browse > Pages**.
2. Expand the branches to locate the page you want to move.
3. Drag the page to a new position in the tree.
4. While dragging the page, you see one of the following:
   - A thin line between existing pages - this indicates the potential new position for the page. Release the mouse button when the page is where you want it.
   - A wide highlight over one or more existing pages - this indicates that you can drop the page into a page family. Release the mouse button to add the page to the family. The page will appear either in alphabetical sequence or as the last page in the family, depending on the family's **sequential order**.

**Notes**

- The new position of the page is saved as soon as you release the mouse button.
- To cancel the move, press the 'Esc' key before releasing the mouse button.
- When completing the New Parent Page field in the Set Page Location dialog you need to select the page suggested by Confluence's autocomplete. Just typing or pasting the page name (or using your browser's field autocomplete) will not work.

Copying a Page

You can copy a page, to create a duplicate of the page content. You will need to rename the page, because a page name must be unique within a space.

You need 'Create Pages' permission, which is assigned by a space administrator from the Space Administration screens. See **space permissions** or contact a space administrator for more information.

To copy a page:

1. Go to a page in the space and choose **Tools > Copy**. Confluence will open a copy of the page in the editor. By default, Confluence will name the page 'Copy of <<original page name>>.'
2. Rename the page and make any other changes required in the body of the page.
3. If you need to move the new page to a different space or a different parent, you can edit the **Location**. Refer to the instructions on moving a page.
4. Click **Save**.

**Related pages:**

- Working with Pages
- Moving a Page
- Confluence User's Guide

**Screenshot: Copying a page**

![Copy of Sample Page](image)

**Notes**

- Copying a page will duplicate all of the original page's attachments and labels, but will not copy comments from the original page.
- This method of copying a page does not copy the child pages. Please add your vote to issue **CONF-2814** if you’d like to see this improvement.
- You can copy an entire space, including all pages in the space (parents and children) — refer to these instructions on copying a space.
- Consider using WebDAV to move or copy a page hierarchy from one space to another, provided that none of the page names already exist in the target space.

Renaming a Page

To rename an existing page, you require 'Edit Pages' permission which is assigned by a space administrator from the Space Administration screens. See Space permissions or contact a space administrator for more information.

To rename a page:

1. Go to a page in the space, and click Edit at the top to view the page in 'Edit' mode.
2. Change the page title as required.
3. Click Save.

Related pages:
- Working with Pages
- Confluence User’s Guide

Notes

- Confluence will automatically update all internal links to point to your new page title. This only works for relative links that use the relative link syntax, for example [Renaming a Page].
- In macros, page links will not be updated. You need to update these manually.
- Links from external sites will be broken, unless they use the permanent URL - see Working with Links.

Deleting a Page

By default, when you delete a page in Confluence, this will delete all versions of the page. To do that, you need the 'Delete Pages' permission. See Space permissions. If someone has applied page restrictions to the page, the restrictions may prevent you from deleting the page too.

If you want to delete a specific version of a page, you need to be a space administrator.

Deleting all versions of a page

To delete a page:

Go to the page and choose Tools > Delete. Confirm the action as prompted.

Note: The 'Delete' option will only appear if you have permission to delete this page.

Deleting a specific version of a page

To delete just one version of a page:

1. Go to the page and choose Tools > Page History.
2. Choose Delete next to the version you want to delete, and confirm the action as prompted.

Deleting a page and all its children

If the page you are deleting has any child pages, the child pages will move to the root of the space. The child pages will not be deleted, but they will lose the parent-child relationship with the deleted page.
**Hint:** If you need to remove a parent page and a large number of child pages:

- Create a temporary new space.
- Move the parent page to the new space. The child pages will move too.
- Remove the space.

**Notes**

- When you delete a page, Confluence moves it to the trash. Space administrators can recover pages from the trash. For important notes about what happens when you restore deleted pages, see [Restoring a Deleted Page](#).
- Purge the trash to delete the page permanently.
- When you delete a version of a page, the version is not stored in the trash. The deletion of a version is therefore permanent and cannot be undone.
- Attachments attached to a deleted page will remain in the database (allowing potential retrieval) until the trash is purged. When the trash is purged, all attachments on that page are permanently removed.
- When you delete a version of a page, the version numbers of the later versions will change accordingly. For example, if a page has four versions and you delete version 2, then version 3 will become version 2 and version 4 will become version 3.

**Purging Deleted Pages**

When a user deletes a page from a Confluence space, the page is not permanently removed. Instead, Confluence places the deleted page into the 'Trash'. The page will remain in 'Trash' until a space administrator purges the page.

Purging deleted pages permanently clears them from 'Trash'.

You need to be a space administrator to purge deleted pages for a space.

**Related pages:**

- [Deleting a Page](#)
- [Restoring a Deleted Page](#)
- [Confluence User's Guide](#)

**To purge deleted pages:**

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose **Trash**
3. A list of deleted pages and blog posts for the space displays. Choose **Purge** for a specific page or **Purge All** to permanently clear all deleted pages and news items.

If your space is using the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen. **Note:** The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose **Trash** from the space administration options
3. A list of deleted pages and blog posts for the space displays. Choose **Purge** for a specific page or **Purge All** to permanently clear all deleted pages and news items.

**When the trash is purged, all attachments on purged pages are permanently removed as well.**

**Restoring a Deleted Page**

When you restore a page, you are moving it from 'Trash' to the root of the space.

You need to be a space administrator to restore deleted pages.

**Related pages:**

- [Deleting a Page](#)
- [Purging Deleted Pages](#)
- [Confluence User's Guide](#)

**To restore a deleted page:**

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose **Content Tools > Trash**
3. A list of deleted pages and blog posts for the space displays. Choose **Restore** for the page you wish to restore.

If your space is using the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen. *Note:* The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose **Trash** from the space administration options.
3. A list of deleted pages and blog posts for the space displays. Choose **Restore** for the page you wish to restore.

To find the page after you have restored it, choose **Pages** to go to the root of the space. (The page is not restored to its original position in the page hierarchy.)

**Notes**

- If a new page has already been created in that space with the same name as the deleted page, you will be given an option to rename the page before it is restored.
- If the page had any child pages before it was deleted, Confluence moved the child pages to the root of the space when the page was deleted. The parent-child relationship will **not** be automatically restored when you restore the page.

**Viewing All Pages in a Space**

All Confluence pages are contained within a space. You can use the Pages view to see a list of recently updated pages and all pages within a space.

**To access the Pages view:**

1. Go to a page in the space and choose **Pages** in the sidebar.
   Or, if you are using the Documentation theme, choose **Browse > Pages** at the top of the screen.
2. Recently updated pages and a hierarchical (tree) view of all pages in the space display.

**Related pages:**

- Moving a Page
- Changing the Sequential Order of Pages
- Working with Pages
- Confluence User’s Guide

**Screenshot: The pages view in the default theme**

If you are using the Documentation theme, you can choose between Recently Updated, Alphabetical and Tree view of the pages in your space.

**Screenshot: Tree view in the Documentation theme**

---

*Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Changing the Sequential Order of Pages

Confluence allows you to present your pages in any order (sequence) you choose. The position of a page is reflected in the following places:

- The navigation area of the space sidebar. (See Finding Content.)
- The pages Tree on the 'Pages' view in the space.
- Pages exported to PDF, HTML and XML.
- The Page Tree macro.
- The Children macro.

Alphabetical versus manual order

By default, Confluence will present your pages in alphabetical order. When you move a page to a different position, the order becomes manual for the affected page family. When we say 'page family' we mean the immediate children of the parent page, not including the grand-children.

When ordering pages alphabetically, Confluence applies a more sophisticated 'natural' order rather than a straight alphabetical order. The natural order handles numeric values correctly when doing string comparisons.

Now let's consider what happens when you add a page to a page family, by creating a new page or by moving or copying a page into the family:

- If the page family's order is alphabetical, the new page will appear in alphabetical order too.
- If the page family's order is manual, the new page will appear at the bottom of the list of pages in the family.

On this page:
- Alphabetical versus manual order
- Changing the page order manually
- Changing the page order to alphabetical

Related pages:
- Finding Content
- Working with Pages
- Confluence User's Guide

Changing the page order manually

To change the order of pages in the space:

1. Go to the space and choose Space tools > Reorder pages on the sidebar.
   If your space is using the Documentation theme choose Browse > Pages.
2. Expand the branches of the tree to find the page family you wish to sort.
3. Drag each page to a new position in the tree.

When you drag a page to a new position, the order of the page family changes to Manual. Newly added pages will not be sorted alphabetically, but will appear at the bottom of the list.

**Changing the page order to alphabetical**

If the pages in a page family have been ordered manually, you can change the page order back to alphabetical.

**To set the page order to alphabetical:**

1. Go to the space and choose **Space tools > Reorder pages** on the sidebar. If your space is using the Documentation theme choose **Browse > Pages**.
2. Expand branches of the tree to find the page family you wish to sort.
3. Choose the **Sort Alphabetically (A-Z)** icon beside the parent page.

The **Sort Alphabetically (A-Z)** icon only appears next to the parent page if the page family is currently sorted manually.

If you change your mind, you can use the **Undo Sorting** icon to revert back to the previous manual page order for that page family. This option is only available immediately after sorting the page (while you are still on the 'Reorder Pages' tab and have not performed any other action).

**Screenshot: Page tree showing the Sort Alphabetically and Undo Sorting icons.**

Sort Alphabetically only sorts the immediate children of the parent page. The grandchildren will not be re-ordered, sorting happens for one node at a time. If you want to re-order grandchildren, you need to click the **Sort Alphabetically** icon next to the parent of those pages.

Managing Orphaned Pages

An orphaned page is a page without any incoming links. This means that, unless you know that the page exists, you are not likely to come across it in the space during the natural course of navigation.

When you are working in a large space with a number of pages, it is difficult to keep track of all of them. An orphaned page may be redundant or may need to be referred to from another page. Confluence allows you to view all the orphaned pages in a space so you can tidy up the space by either deleting pages or reorganising them.

**To view the orphaned pages in a space:**

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose **Orphaned Pages**.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations** at the top of the screen.
2. Choose **Orphaned Pages** in the space operations options.

You can do the following:
Managing Undefined Pages

In Confluence, you can add links to pages that you intend to create later. These are links to 'undefined pages'. This is useful because it allows you to create links first and enter content for those pages later.

The link to an undefined page is shown in dark red. If someone clicks the link, Confluence will create a new page called 'link to new page'.

The 'Undefined Pages' view gives a consolidated report of all undefined pages so that you can manage your space better. The undefined page links are badged with this icon to remind you that those pages need to be created.

To view a list of the undefined links in a space:

1. Go to the space and choose Space tools > Content Tools on the sidebar.
2. Choose Undefined Pages

If your space uses the Documentation theme:

1. Choose Browse > Space Operations at the top of the screen.
2. Choose Undefined Pages in the space operations options.

You can choose the link for an undefined page to create the page and add content to it.

Using the Documentation Theme

The Documentation theme is one of the themes bundled with Confluence. It provides an inbuilt table of contents for your wiki space, a configurable header and footer, and text styles suited to documentation. You can also configure it to restrict the search results to the current space, rather than searching the entire Confluence site.

Advance warning of plans to merge Documentation theme with the default theme

This is an advance notice that we plan to merge the functionality of the Confluence Documentation theme with the Confluence default theme. We do not yet have a specific date for this plan, and we are interested in your feedback. The new default theme, introduced with Confluence 5.0, includes a sidebar with contextual navigation. Our plan is to include features from the Documentation theme in the default theme, and then remove the Documentation theme from Confluence.
This page tells you how to view pages in your Confluence space when your space uses the Documentation theme. For the full list of features and instructions on applying the theme to a space, see the guide to configuring the Documentation theme.

Quick guide to using the Documentation theme:

- The left-hand panel contains a page tree. This is a table of contents that shows the pages in the space.
- Click the arrow symbols in the page tree to show and hide child pages.
- Drag the thick vertical bar to change the width of the panels.
- Show/hide the left-hand panel: Click the sidebar icon at top right, next to the search box, to remove the left-hand panel altogether. Click the icon again to restore the panel.
- Alternatively, press '[' on your keyboard to show/hide the left-hand panel.
- Overriding a space-restricted search: If your theme is configured to restrict the search to the current space, you can enter 'all:' and your search term to search the entire site.

The rest of this page gives more details of the above guidelines.

Using the Documentation theme

By default in a space that uses the Documentation theme, the left-hand panel contains a search box and a table of contents (page tree) showing all the pages in your space. Specifically, it shows the pages that are children of the space’s home page.

Diagram: The Documentation theme with default settings
A space administrator can customise the Documentation theme as follows:

- Change the content in the left-hand panel and add a header and footer to the page. This means that your own pages may look different from the screenshot above.
- Restrict the search so that it will show results from the current space only, not from the entire Confluence site.

Diagram: The Documentation theme with space-restricted search

Here is a summary of the things you can do on a page that uses the Documentation theme:

- Click the plus signs to open and close the branches of the page tree (table of contents) in the left-hand panel.
- Drag the thick bar between the left-hand panel and the content, to increase or decrease the width of the panel.
- Click the sidebar icon at top right, next to the search box, to remove the left-hand panel. This will remove the panel for you only. Other people will still see it.
- Click the sidebar icon again to restore the left-hand panel.
- Alternatively, press '[' on your keyboard to show/hide the left-hand panel.
- Use the scroll bars to scroll the left-hand and right-hand panels independently of each other.
- Search the content of the space or the site. See below.

Searching the space or the site

When using the Documentation theme, the Confluence search offers a few options as described below.

Using the search box at the top right of the page:

- By default, the main Confluence search is configured to search the entire Confluence site.
  - You will see the words 'Search Confluence' in the search box at top right of the page.
  - The Confluence search will look for matches in the entire Confluence site. This is the default behaviour for other themes too.
- A space administrator can configure the Documentation theme to restrict the search to the current space.
  - You will see the words 'Search this space' in the search box at top right of the page.
  - The search will return results from the current space only.
  - You can override the search restriction. Enter 'all:' and your search term to search the entire site. For example, enter the following into the search box at top right of the page to search the entire site for 'technical writing':

""
Using the search box in the left-hand panel:

- By default, the Documentation theme's left-hand panel includes a search box. Enter your search term there, to restrict the search to the current space. Specifically, this will search only the pages that are children of the space's home page.
- If your administrator has restricted the main search to the current space, there will not be a search box in the left-hand panel.

**Hints and tips**

Below are some hints that you may find useful when using the Documentation theme. Where can I see a working example of the Documentation theme?

The Confluence documentation uses the Documentation theme. If you are reading this documentation online on the Atlassian documentation wiki, you are seeing a working version of the Documentation theme.

Which pages will appear in the Documentation theme's table of contents?

The theme constructs the page tree in the left-hand panel from all pages that are child pages of the space’s home page. Each space has a single page designated as the 'Home' page. You can specify the home page in the space administration section.

Help, my pages do not appear in the Documentation theme table of contents

**Cause 1: Your pages are not under the space's home page.** The most probable reason why your pages do not appear in the page tree in the left-hand panel is this: The theme constructs that table of contents from all pages that are child pages of the space's home page. If your pages are above the home page in the page tree, they will not appear in the left-hand panel.

There are two ways to fix the problem:

- You can change the designated space home page in the space administration section.
- Or you can drag and drop all your pages to make them children of the current home page. You can drag and drop pages in the 'Pages' section of the space 'Browse' screen. See Moving a Page.

**Cause 2: Problem with upgrade from Confluence 3.1, with Documentation theme as plugin, to Confluence 3.2 or later with Documentation theme bundled.** If your existing Confluence installation already has the Documentation theme plugin installed, you may find that after upgrading to Confluence 3.2 the left-hand navigation bar is empty in the spaces that use the theme. The fix is to enable all modules of the Documentation theme plugin. See the knowledge base article.

Help, my left-hand panel has disappeared

If your entire left-hand panel has disappeared when using the Documentation theme, this is probably because you have clicked the sidebar icon at top right, next to the search box. Click the icon again to restore the panel.

Can I change the default width of the left-hand navigation panel?

The Confluence user interface does not offer a way to change the default width of the left-hand navigation panel supplied by the Documentation theme. Users can change the width by dragging the middle bar, but the default width is not configurable. This post on Atlassian Answers gives a way to do it with CSS: Documentation Theme - Default Width (in px) of left panel.

**Notes**

- The Confluence default theme supplies a sidebar, which is different to the left-hand panel in the Documentation theme. For information about the sidebar, see Finding Content and Configuring a Sidebar.
- The Documentation theme supplies a Browse menu in the Confluence header, which gives access to the space administration and advanced options.

**Viewing Page Information**
The Page Information view for a page shows you useful information about the page.

**To see the information about the page:**

1. View the page.
2. Choose Tools > Page Information.

You will see the following information:

1. Page details: Title, author, date of creation, date of last modification and the tiny link of the page.
3. Incoming links: Lists other pages in your Confluence Site that have links to this page, or reference this page in an Include Page or Excerpt Include macro.
4. Labels: Any labels (tags) that have been applied to this page. See Working with Confluence Labels.
5. Page Permissions: Displays page-level security restrictions that apply to the page (if present). See Page Restrictions.
6. Hot Referrers: The external website pages which send the most viewers to the page. See Managing External Referrers.
7. Recent Changes: Links to the five most recent versions of the page along with the name of the editor and the date of modification. See Page History and Page Comparison Views. Choose View page history to see the page history view, all the versions of the page in reverse chronological order and allows you to compare versions or to restore a previous version.
8. Outgoing links: A summary of the links contained on this page, pointing to other pages on the Confluence site or to external websites.

Note: if there is no information to report (for example the page has no restrictions or no incoming links), that section of the Page Information will not appear.

**Screenshot: Page information for this page**
Viewing Recently Visited Content

Confluence keeps track of pages you have recently visited in Confluence. You can access your recently viewed pages and navigate back to them using the Recently Viewed list.

To view the full list of recently viewed pages:

1. Choose your profile picture at top right of the screen, then choose Recently Viewed.
2. Choose the title of the page you wish to revisit.

To filter the list type part of a page title or user’s name in the Filter field.

Your last ten recently viewed pages also appear when you select the ‘Search’ field anywhere in Confluence.

Related pages:
- Working with Pages
- Confluence User’s Guide

Screenshot: Recently viewed content

Page History and Page Comparison Views

Confluence tracks the history of changes to each page by creating a new version of the page each time it is modified. You can view the changes between different versions, and roll back to a previous version if required.

Accessing the page history

To view the history of a page:

Go to the page and choose Tools > Page History.

You can choose a version number to view the content of that version.
On this page:
- Accessing the page history
- Viewing an older version of a page
- Restoring an older version of a page
- Deleting a specific version of a page
- Viewing the changes made to a page
- Comparing two versions of a page

Related pages:
- Viewing Page Information
- Working with Pages
- Tracking Updates
- Confluence User’s Guide

Screenshot: Page history

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Changed By</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURRENT (v. 4)</td>
<td>Apr 26, 2013 13:53</td>
<td>Rach Admin [Administrator]: Fixed a typo</td>
<td></td>
</tr>
<tr>
<td>v. 3</td>
<td>Apr 26, 2013 13:53</td>
<td>Leah Admin</td>
<td>Restore this version  ·  Delete</td>
</tr>
<tr>
<td>v. 2</td>
<td>Apr 26, 2013 13:52</td>
<td>Josh User: (Added note about changes)</td>
<td>Restore this version  ·  Delete</td>
</tr>
<tr>
<td>v. 1</td>
<td>Apr 26, 2013 11:56</td>
<td>Rach Admin [Administrator]</td>
<td>Restore this version  ·  Delete</td>
</tr>
</tbody>
</table>

Viewing an older version of a page

To view a specific version of a page:

1. Go to the page and choose **Tools > Page History**.
2. Choose a version number to view the contents of that version of the page. You will see a header like this, at the top of the old version of the page:

   ![Header warning](image)

   You are viewing an old version of this page. View the current version.

   Compare with Current  ·  Restore this Version  ·  View Page History

   « Previous  Version 2  Next »

If you want to send this page version to someone, copy and paste the URL from your browser. The link will look something like this: http://confluence.atlassian.com/pages/viewpage.action?pageId=12345.

When you are viewing a specific version of the page, the following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>current version</td>
<td>View the latest version of the page.</td>
</tr>
<tr>
<td>Compare with Current</td>
<td>Compare the differences between the version of the page you are viewing and the current version.</td>
</tr>
</tbody>
</table>
### Restoring an older version of a page

You can roll back the content of the page to a specific version.

**To restore an older version of a page:**

1. Go to the page and choose **Tools > Page History**.
2. Choose **Restore this version** beside the version you want to restore.
3. Change the default comment if necessary, and choose **OK**.

**Notes**

- All page history is retained. Restoring an older version creates a copy of that version. For example, if you restore version 39, Confluence will create a copy of version 39. This copy will become the new, current version.
- If you are viewing a specific version of a page, you can restore that version of the page by choosing **Restore this Version** at the top of the page.

### Deleting a specific version of a page

Choose **Delete** next to a version, to remove that version. See [Deleting a Page](#).  

### Viewing the changes made to a page

Using the page history view or the page information view, you can see the recent changes made to a page.

**To view recent changes made to a page:**

1. Choose **Tools > Page Information**.
2. In the section titled ‘Recent Changes’ you will see the most recent versions of the page, along with the date of their modification and the name of the modifying author.
3. Choose **View Changes** beside the required version. The page comparison view is displayed, showing the differences between the selected and previous versions.

### Comparing two versions of a page

**To compare two versions of a page:**

1. Go to the page and choose **Tools > Page History**.
2. Choose the versions you want to compare by selecting the check boxes beside them.
3. Choose **Compare selected versions**. The page comparison view is displayed, showing the differences between the selected versions.

Changes are highlighted in different colours, as shown in this table:

<table>
<thead>
<tr>
<th>Highlighted colour</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Added content</td>
</tr>
<tr>
<td>Red</td>
<td>Deleted content</td>
</tr>
<tr>
<td>Blue</td>
<td>Changed formatting</td>
</tr>
</tbody>
</table>

_Screenshot: Comparing changes_
Using a WebDAV Client to Work with Pages

You can access Confluence content via a WebDAV client, such as ‘My Network Places’ in Microsoft Windows. Provided that you have permission, you will be able to read and write to spaces, pages and attachments in Confluence. You will be asked to log in and the standard Confluence content access permissions will apply to the equivalent content available through the WebDAV client.

Please refer to the page on configuring and setting up a WebDAV client.

**Working with Blog Posts**

You can publish a blog post from any space in Confluence, provided you have permission. Blog posts may be announcements, journal entries, status reports, or any other timely information.

**To view the blog posts within a space:** Go to a page in the space and choose Blog in the sidebar. Or, if you are using the Documentation theme, choose Browse > Blog at the top of the screen.

Confluence lists the latest blog posts. You can click through to earlier posts via the navigation area in the sidebar.

Creating and editing a blog post is just as easy as creating and editing any other page in Confluence. You can also let people know you care by liking a blog post.

Creating a blog post

To create a blog post, you need the ‘Add Blog’ permission. See Space Permissions, and Creating Content.

You can create attractive, engaging content in a blog post in the same way as in a page. See Creating Beautiful and Dynamic Pages.
To edit a blog post, you need the 'Add Blog' permission. See Space Permissions.

To edit a blog post:

1. Go to a page in the space and choose Blog in the sidebar.
   Or, if you are using the Documentation theme, choose Browse > Blog at the top of the screen. You will see the most recent blog posts within the space, and you can find earlier posts via the navigation area in the sidebar.
2. Go to the blog post and choose Edit.
3. Make changes to the blog post.
4. (optional) Add a comment, in the text box below the editing pane, to describe your changes.
5. Preview your changes if desired, and choose Publish.

Editing a blog post is similar to editing any other page in Confluence. However, there are a few things to keep in mind:

- You cannot change the date of an existing blog post. You can only backdate when adding a blog post.
- You cannot move a blog post to another space.
- A blog post has no parent.

Moving a blog post

If you create a blog post in the incorrect space, or want to reorganise your spaces, you can move an individual blog post to another space.

To move a blog post go to the post and choose Tools > Move and select the new destination space.

You will need the 'Delete blog' permission in the current space and 'Add blog' permission in the new (destination) space to do this.

Restricting a blog post

You can restrict a blog post so that it is only available to specific users or groups. Blog post restrictions work in the same way as page restrictions.

To restrict a blog post prior to publishing chose the Unrestricted button in the footer of the blog post and apply your restrictions.

To restrict a blog post after it has been published, navigate to the blog post and choose Tools > Restrictions and apply your restrictions.

Notes:

- Notifications are sent at the point a blog post is created - removing restrictions does not trigger a new notification.
- As a blog post has no parent, restrictions are not inherited.
By default, when you delete a blog post in Confluence, this will remove all versions of the post. To do that, you need the 'Delete Blog' permission. See Space permissions. If someone has applied page restrictions to the blog post, the restrictions may prevent you from deleting the post too. Deleted blog posts are stored in the space’s trash and can be recovered by a space administrator.

If you want to delete a specific version of a blog post, you need to be a space administrator. When you delete a version of a blog post, the version is not stored in the trash. The deletion of a version is therefore permanent and cannot be undone.

**To delete all versions of a blog post:**

Go to the page and choose Tools > Delete. Confirm the action as prompted.

*Note:* The 'Delete' option will only appear if you have permission to delete this page.

**To delete just one version of a blog post:**

1. Go to the page and choose Tools > Page History.
2. Choose Delete next to the version you want to delete, and confirm the action as prompted.

**Exporting a blog post**

You can export individual blog posts to PDF format. This is useful, for example, if you want to email an internal blog post to people outside your organisation.

See Exporting Confluence Pages and Spaces to PDF for more information on exporting blog pages to PDF.

**Working with Spaces**

In Confluence, content is organised into spaces. There are two main types of space:

- Site spaces, sometimes called 'global' spaces, are areas on your site where you can create content and collaborate with other users. For example, you might create a space for each team or project in your organisation.
- Personal spaces belong to specific users. You can keep your personal space private, or open it up for other users to view or edit. Personal spaces are listed in the People Directory.

**What is a Space?**

A space is an area within Confluence, containing your pages, blog posts and other content. You can think of each space as a sub-site, or mini-site, each with its own home page.

You can create a blank space or choose to use a space blueprint.

Each space:

- Has its own pages, blog posts, comments, and more.
- Has its own access control settings. You can set different levels of access for different spaces.
- Cannot be nested under another space, but can be grouped using space categories.
- Can be separately exported to PDF, HTML or XML. The XML export provides a way of backing up and restoring a space.

There is no limit to the number of site spaces you can create in Confluence.
What is a Space Blueprint?

Space Blueprints allow you to create common types of spaces, such as a team space or knowledge base, quickly and easily.

A space created using a space blueprint will have a customised homepage, sidebar and may contain page blueprints or sample content that is specific to that type of space.

When you create a space using a blueprint a wizard will prompt you to enter information to help set up your space. For example the Team Space blueprint asks for the members of your team, and displays them on the homepage.

Viewing the spaces in a Confluence site

Confluence displays a list of spaces in the following locations:

- The **dashboard** displays a list of all the spaces that you have permission to see. You can make a space a favourite, or categorise the space, to get easy access to the content that is most relevant to you. See [Cus toming your Personal Dashboard](https://confluence.atlassian.com/pages/viewpage.action?pageId=100000000).
- The **space directory** displays a list of all the site and personal spaces that you have permission to see. You can filter the list of spaces. See [Viewing All Confluence Spaces](https://confluence.atlassian.com/pages/viewpage.action?pageId=100000000).
- The **people directory** displays a list of all Confluence users, including those who have personal spaces. See [Searching the People Directory](https://confluence.atlassian.com/pages/viewpage.action?pageId=100000000).

Example: Favourite spaces as shown on the dashboard

The screenshot below shows the area of the Confluence dashboard that displays the spaces that you have marked as favourite:
Notes

A space key is a short, unique identifier for a space. For example, you might give your documentation space a key of "DOC". To find the key of an existing space, look at the Confluence URL for a page in the space. The standard Confluence URL has this format:

```
http://my.confluence.site.com/display/SPACEKEY/Page+Name
```

Viewing All Confluence Spaces

Quick guide to viewing spaces:

- The dashboard displays a list of all the spaces that you have permission to see. You can make a space a favourite, or categorise the space, to get easy access to the content that is most relevant to you. See Customising your Personal Dashboard.
- The space directory displays a list of all the site and personal spaces that you have permission to see. You can filter the list of spaces. See Viewing All Confluence Spaces.
- The people directory displays a list of all Confluence users, including those who have personal spaces. See Searching the People Directory.

On this page:

- Viewing spaces on the dashboard
- Viewing spaces in the space directory
- Viewing personal spaces in the people directory
- Notes

Related pages:

- Working with Spaces
- Archiving a Space
- Confluence User’s Guide

Viewing spaces on the dashboard

The Confluence dashboard displays a list of spaces that you have permission to view. Remember to log in, so that you can see the complete list of spaces based on your username’s permissions.

The Spaces tab displays all the global spaces on the site that you have permission to view, and the spaces you have marked as your favourites.
To see the spaces on the dashboard:

1. Choose the **site logo** at the top left of your Confluence screen.
2. Scroll down and choose the **Spaces** tab.

**Screenshot: Viewing spaces on the dashboard**

<table>
<thead>
<tr>
<th>Spaces</th>
<th>Pages</th>
<th>Network</th>
</tr>
</thead>
</table>

**Favourite Spaces**

- Angry Nerds
- Sample Space

**Site Spaces**

- Angry Nerds
- Demonstration Space
- Documentation
- Sample Space

**Viewing spaces in the space directory**

The space directory displays a list of site and personal spaces that you have permission to view. Remember to log in, so that you can see the complete list of spaces based on your permissions.

**To view all spaces:**

1. Choose **Spaces > Space directory** on the header.
2. All the spaces that you have permission to view will appear.

If you have a large number of spaces in your site, you can filter the list.

**To filter the list of spaces:**

- Enter part of the space name or description in the **Filter** field, or
- Choose a pre-defined filter or category.

Only those spaces that match your filter will appear.

The filters include:

- **All Spaces** – Shows all global and personal spaces. The list excludes spaces that you do not have permission to view and spaces that have been [archived](#).
- **Site Spaces** – Excludes personal spaces.
- **Personal Spaces** – Shows only personal spaces.
- **Favourite Spaces** – Shows the spaces that you have marked as your [favourites](#).
- **Archived Spaces** – Shows all global and personal spaces that have been [archived](#), and that you have permission to view.
- **Categories** – Shows spaces that have been labelled with the selected space category. See [Using Labels to Categorise Spaces](#).

**Screenshot: Viewing favourite spaces in the space directory**
Viewing personal spaces in the people directory

The people directory displays a list of Confluence users, including those who have personal spaces. See Searching the People Directory. It excludes spaces that have been archived.

To see the personal spaces in the people directory:

1. Choose People at the top of the screen.
2. Choose People with Personal Spaces.

Notes

- If you do not log in, you will be treated as an 'anonymous user'. Confluence will display only those spaces that anonymous users have permission to see.
- Permission to access a space is granted by a space administrator. See the overview of space permissions.
- You can use the Spaces List macro to display a list of spaces on a Confluence page.

Creating a Space

In Confluence pages and other content are stored in spaces. There are two main types of spaces - site spaces and personal spaces. Your Confluence site can contain many site spaces, and each user can have one personal space.

To create a site space you need the 'Create Space' global permission.

To create a personal space you need the 'Personal Space' global permission.

To create a space:
1. Choose **Create Space** on the dashboard or from the **Spaces** dropdown.
2. Choose the type of space you would like to create then choose **Next**.
3. Enter details of your space including **Name**, **Space Key**, and set any permissions - the wizard will prompt you.
4. Choose **Create**.

Once your new space has been created you will be taken to the space homepage, which will be customised depending on the type of space you selected.

You can now start creating content to your space.

**Choosing a space key**

The space key is the unique identifier for your space and is used in URLs and macros. Your space key must be unique, can contain any alphanumeric character (A-Z, a-z, 0-9), and be up to 255 characters long. Personal spaces use your username as the space key.

You cannot change the space key after your space has been created, so choose your space key carefully.

**Space permissions**

Spaces are created with a set of default permissions. The user who created a site space is automatically granted 'space admin' permissions for that space. They can then grant permissions to other users and groups. See **Space Administrators and their Permissions** for more information.

**Note:** System Administrators can edit the permissions of spaces in their Confluence site at any time.

**Using space blueprints to create a space**

Space blueprints help you create common types of spaces quickly and easily. Space blueprints vary widely, so here are some examples of the spaces you can create:

- **Team space**
  A great building block if you are using Confluence as an intranet or to manage teams. Team spaces highlight the members of the team, and grant permissions to those users accordingly.

- **Knowledge Base space**
  This space blueprint uses search and page labels to make content easier to find, right from the space homepage. It also contains two page blueprints for creating how-to and troubleshooting articles. The templates used in these page blueprints are completely customisable to meet your needs. The Knowledge Base space blueprint also integrates with **JIRA Service Desk**.

- **Documentation space**
  This space blueprint displays the full page tree in the sidebar and hides other sidebar features including blogs and shared links. The homepage uses search and page labels to make content easy to find. Add the 'featured' label to any page you want to highlight on the homepage. This space does not include any page blueprints but you can create and promote templates for your documentation authors to use.

**Notes:**

- If you have set a specific theme (such as the Documentation or other third party theme) for your whole site, spaces will be created with that theme. You may not see some of space blueprint specific sidebar customisation if you are not using the default theme.
- Administrators can disable individual space blueprints - see **Administering Site Templates**.

---

**Related pages:**

- Setting Up your Personal Space
- Configuring a Sidebar
- Editing Space Details
- Deleting a Space
- Confluence User's Guide
Setting Up your Personal Space

Your personal space is a place where you can publish your own pages and blog posts. Once you have set up your personal space, Confluence users can reach it by clicking your name in the People Directory. You can get to your personal space by clicking your name at the top of the page and choosing ‘Personal Space’.

Creating your personal space

To set up your personal space, you need the ‘Personal Space’ permission which is assigned by a Confluence administrator. See Giving People Access to Content and Global Permissions Overview.

To create your personal space:

1. Choose your profile picture at top right of the screen, then choose Add Personal Space.
2. Indicate whether your space should be private or not. A private space will be visible only to you. If you do not make it private, the space will have the default space permissions. Note that you can change these settings again later. You will have space administrator permissions on your space.
3. Choose Create.
4. The home page of your new space will appear. Your home page will contain any default space content as defined by your Confluence administrator. You can change this content at any time.

On this page:
- Creating your personal space
- Adding and changing content in your space
- Changing the look and feel of your space
- Granting access to your space
- Watching updates made in your space

Related pages:
- Configuring a Sidebar
- User Profile Overview
- Working with Spaces
- Confluence User's Guide

Screenshot: Adding a personal space

Add your personal space

Your personal space is your own private workspace within Confluence. You can optionally let other people view or contribute to it.

Make this space private

Adding and changing content in your space

Now you can start adding pages to your personal space. You may also want to upload your photo.

Changing the look and feel of your space

If you like, you can apply a different theme to your personal space, or modify its colour scheme. You can also add and arrange links in the sidebar.

Granting access to your space
When you created the space, you set the option to make your space private, or to allow other people to view and contribute content to your space. You can change the permissions on your space at any time.

Watching updates made in your space

By default, Confluence assigns you as a watcher of your space. This means that you will receive an email notification each time someone adds or updates content in your space. You can stop watching the space (see Watching Pages, Spaces and Blog Posts) and change your notification settings at any time.

Administering a Space

This page gives an overview of the administration functions available in site and personal spaces. You need to be a space administrator to perform space administration functions.

Space administrators can also add and remove links in the space sidebar. See Configuring a Sidebar.

Administering a space

To view the space tools page:

1. Go to the space and choose Space tools > Permissions on the sidebar.
2. The 'Space Permissions' page displays.

The administration options are divided into the following categories. Some options may not be applicable for personal spaces.

- **Overview**
  - Space Details - see Editing Space Details
  - Space Categories - see Using Labels to Categorise Spaces
  - Delete Space - see Deleting a Space

- **Permissions**
  - Permissions - see Assigning Space Permissions
  - Restricted Pages - see Page Restrictions

- **Content Tools**
  - Templates - see Working with Templates
  - Orphaned Pages - see Managing Orphaned Pages
  - Undefined Pages - see Managing Undefined Pages
  - Attachments - see Viewing Attachment Details
  - Trash - see Purging Deleted Pages and Restoring a Deleted Page
  - Export - see Exporting Confluence Pages and Spaces to Other Formats
  - RSS Feeds - see Using pre-specified RSS feeds
  - Import - see Importing Pages from Disk. Not available for personal spaces.

- **Look and Feel**
  - Themes – see Applying a Theme to a Space
  - Colour Scheme – see Editing a Space’s Colour Scheme
  - Layout - see Customising Space Layouts
  - Stylesheet - see Styling Confluence with CSS
  - PDF Layout – see Customising Exports to PDF
  - PDF Stylesheet – see Customising Exports to PDF

- **Integrations**
  - Application Links – see Linking to Another Application
  - Mail Accounts – see Working with Mail Archives. Not available for personal spaces.
  - Mailbox Import – see Importing Mail. Not available for personal spaces.
  - Mail – see Working with Mail Archives. Not available for personal spaces.
You can also customise the sidebar, including changing the space logo and adding shortcuts to other spaces - see Configuring a Sidebar for more information.

**Administering a space that uses the Documentation theme**

In this theme the standard Confluence sidebar is replaced by a page navigation sidebar. As a result the layout of the space administration options are slightly different.

**To view the space admin page:**

1. Go to the space you wish to manage.
2. Choose Browse > Space Admin at the top of the screen. *Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
3. The 'Space Details' page displays.

For spaces using the Documentation theme, the administration options are divided into the following categories:

- **General**
  - Space Details – see Editing Space Details.
  - Space Categories – see Using Labels to Categorise Spaces.
  - Templates – see Working with Templates.
  - Delete Space – see Deleting a Space.
  - Trash – see Purging Deleted Pages and Restoring a Deleted Page.

- **Security**
  - Permissions – see Assigning Space Permissions.
  - Restricted Pages – see Page Restrictions.
  - Application Links – see Linking to Another Application.

- **Mail**
  - Mail Accounts – see Working with Mail Archives
  - Mailbox Import – see Importing Mail

- **Look and Feel**
  - Themes – see Applying a Theme to a Space.
  - Colour Scheme – see Editing a Space's Colour Scheme.
  - PDF Layout – see Customising Exports to PDF.
  - PDF Stylesheet – see Customising Exports to PDF.
  - Change Space Logo – see Changing a Space's Logo.

**Import**

- Import Pages from Disk – see Importing Pages from Disk.

**Editing Space Details**

To edit the details of a space you need to be a space administrator for the space.

**To edit the details of a space:**

1. Go to the space and choose Space tools on the sidebar. *Note: The options available in 'Space tools' differ depending on your space permissions. All space tools options are available if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
2. Choose Overview > Edit Space Details
3. The 'Edit Space Details' page displays.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. *Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. The 'Edit Space Details' page displays.

On the 'Edit Space Details' page you can:

- Change the name of the space (you can also do this via the sidebar - see Configuring a Sidebar).
- Change the description of the space.
- Change the status of the space from 'Current' to 'Archived' or back again - see Archiving a Space.
- Select a new home page for the space. The home page is the default page that users see when they
navigate to the space.

*Note:* If you set this field to blank (no selection) the default home page will be the 'Pages' page.

### Related pages:
- Configuring a Sidebar
- Working with Spaces
- Archiving a Space
- Confluence User’s Guide

### Notes
- You cannot edit the space key or the space creator’s name.
- The space fields do not accept wiki markup. Any wiki markup entered in these fields will be displayed as plain text.

#### Deleting a Space

Deleting a space permanently removes the space and all of its contents. To delete a space you must be the space administrator for the space.

*Note:* Deleting a space is permanent. Always create an XML backup of the space before proceeding. Once you have deleted the space, there is no way to restore it unless you have made an XML space backup.

#### To delete a space:

1. Go to the space and choose **Space tools > Overview** on the sidebar.
2. Choose **Delete Space**.
3. Choose **OK**.

If your space is using the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen. *Note:* The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose **Delete Space** in the space administration options.
3. Choose **OK**.

### Related pages:
- Working with Spaces
- Archiving a Space
- Copying or Renaming a Space
- Confluence User’s Guide

*Note:* Users with System Administrator permission can also delete spaces, including personal spaces.

#### Backing Up and Restoring a Space

Confluence can back up all the content, comments and attachments for a space. The process involves converting the data in the space into XML format. The end product is a zip file that contains XML file(s) that define the content of the space, and optionally a folder containing the attachments in the space. To transfer this data to another Confluence site, you can upload the zip file.

**Creating a space backup**

See Exporting Confluence Pages and Spaces to XML.

**Restoring (importing) a space backup**

See Restoring a Space.

#### Archiving a Space

You can archive a space, so that its content is less visible but still available on your Confluence site. You need to be a space administrator to archive a space. You can change a space’s status from archived to current at any time.

**The effect of archiving a space**

If a space is archived:

- The pages and other content do not appear in the Confluence quick navigation aid, which drops down
when you enter text in the search box.

- By default, the pages and other content do not appear in the Confluence search results. If a Confluence site contains any archived spaces, the search screen will provide an option to include them in the search results.
- The space and its pages do not appear on the dashboard.
- Updates to the space's content do not appear in activity streams, such as the recent updates section of the dashboard.
- The space does not appear in the space-selection dropdown menus. Similarly, its pages and other content do not appear in any dropdown menus in the Confluence user interface.
- In the space directory, the archived space will no longer appear in the general space lists. Archived spaces will appear on the 'archived spaces' tab. They will also appear on the category tabs, as determined by their labels.

These functions remain available for archived spaces:

- People can view the content as usual, by following a link or typing in a URL belonging to the archived space.
- People can edit the content as usual, as determined by the space permissions.
- RSS feeds, watches and notifications remain active.

**Archiving a space**

To archive a space:

1. Go to the space and choose **Space tools > Overview** on the sidebar.
2. Choose **Edit Space Details**.
3. Select **Archived** in the **Status** dropdown menu.
4. Choose **Save**.

If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen. **Note**: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. The 'Edit Space Details' page displays. Select **Archived** in the **Status** dropdown menu.
3. Choose **Save**.

**Notes**

Archiving a space has no effect on search results of external search engines. For example, the space will still appear in Google search results.

**Screenshot: An archived space**
1. **Viewing Space Activity**

Space activity information is **disabled by default**. See notes below.

If enabled, the space activity screen displays statistics on the activity in each space. These include:

- How many pages and blog posts have been viewed, added or updated over a given period.
- Which content is the most popular (most frequently viewed).
- Which content is the most active (most frequently edited).
- Which people are the most active contributors/editors of content.

The 'Activity' tab will not be visible unless the Confluence Usage Stats plugin is enabled. See notes below.

**To view the activity in a space:**

1. Choose **Space Tools** in the space sidebar.
2. Choose **Activity**.

Confluence will show a graphic display of the number of pages and blog posts that have been viewed, added and edited, showing trends over a period of time.

**Screenshot 1: The Space Activity tab**

In addition to the graphical representation of Views and Edits, the top ten most popular and most active pages and/or blog posts will be listed, with a link to each.

**Screenshot: Popular content, active content and active contributors.**
Notes

To view Space Activity the Confluence Usage Stats system plugin must be enabled. This plugin is known to cause performance problems on large installations and in Confluence Cloud, and is disabled by default. System administrators can enable this plugin (go to add-ons, select System add-ons and search for Confluence Usage Stats).

• The plugin collects data only when it is activated.
• If your Confluence site is clustered, the space activity information will not be available.
• Page hits are not unique - the graph on the Space Activity screen includes all page hits, including multiple visits by the same user.

Viewing Recently Updated Content

The ‘Recently Updated’ view is a useful way of keeping track of the changes being made in a space. It displays links to the most recently added or modified content within the space including pages, blog posts, mail messages and comments.

Are you looking for a way to display a list of recently updated pages on a page? Try the Recently Updated Macro.

To view the recently updated content in a space:

1. Go to a page in the space and choose Pages in the sidebar.
   Or, if you are using the Documentation theme, choose Browse > Pages at the top of the screen.
2. Choose Recently Updated. A list of the most recently added or modified content in the space is displayed. Choose a link to open the corresponding document.

Related pages:

• Recently Updated Macro
• Viewing All Pages in a Space
• Viewing Space Activity
• Confluence User's Guide

Working with Mail Archives

Confluence allows you to collect and archive mail within each space. This is useful for storing the email messages that relate to a particular project – you can put them in the same Confluence space as the content for that project.

You can download mail from one or more POP or IMAP accounts. You can also import mail from mbox files either on your local system or on the Confluence server.

You need space administration permissions to manage the mail archives. See Space Permissions Overview.

Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled and will therefore not appear in the Confluence user interface. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, enable the plugin – choose General Configuration > Manage Add-ons. Then choose System in the drop down, and enable the Confluence Mail Archiving Plugin.
To see archived mail:

- Go to a space and choose Space Tools > Integration > Mail
  Or, if your space uses the Documentation theme, choose Browse > Mail at the top of the screen.
- Choose a message to see its contents, or choose Next, Previous and other options to navigate around the mail archives.

Managing mail archives:

- Adding a Mail Account
- Deleting Mail
- Fetching Mail
- Importing Mail
- Managing Mail Accounts

Related pages:

- Working with Spaces
- Confluence User’s Guide

⚠️ The information on this page does not apply to Confluence Cloud.

Screenshot: Viewing a message in the mail archive

Confluence Development / Browse Space / Mail Archive

Tom’s on annual leave today (Monday)

Add

Subject: Tom’s on annual leave today (Monday) (find more)
From: Tom Davies <tom.davies@example.com.au> (find more)
Date: Oct 22, 2006 16:12

I’ll see you all on Tuesday.

Tom

Notes

- Only site spaces can store mail archives. Personal spaces cannot. See Working with Spaces for an explanation of site spaces and personal spaces.
- You can also search the mail messages and their attachments. See Searching Confluence.
- Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled and will therefore not appear in the Confluence user interface. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, enable the plugin – choose General Configuration > Manage Add-ons. Then choose System in the drop down, and enable the Confluence Mail Archiving Plugin.

Adding a Mail Account

When you add a mail account, you are configuring Confluence to download mail from that account and archive the mail within the space.

You need space administration permissions to add a mail account. See Space Permissions Overview.

⚠️ Note: Confluence will remove email messages from an email account when it transfers them to the mail archive. You must therefore configure Confluence to poll a clone email account rather than the actual account. For example, to archive the actual account sales@company.com to your Confluence Sales space, you must first create a clone account such as conf-sales@company.com that contains the same email content.
Step 1. Create a clone email account on the mail server

1. Add a new email account on the mail server with the clone email address.
2. Copy all existing email messages from the actual account to the clone account.
3. Set up the actual account to bcc sent email messages to the clone account.
4. Set up the actual account to forward received email messages to the clone account.

Related pages:
- Working with Mail Archives
- Managing Mail Accounts
- How Do I Check Which Spaces Have Email Accounts?
- How Do I Disable Automatic Mail Polling?
- Confluence User's Guide

The information on this page does not apply to Confluence Cloud.

Step 2. Configure Confluence to archive the clone account

1. Go to the 'Mail Accounts' view:
   - Go to the space and choose Space tools > Integrations on the sidebar.
     Choose Mail Accounts.
   - If your space uses the Documentation theme:
     Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
     Choose Integration > Mail Accounts.
2. Choose Add mail account.
3. Enter configuration details for the account.
   - **Account Name:** Enter a name for this account by which it will be known in Confluence.
   - **Description:** Provide a description for this account (optional).
   - **Protocol:** Choose from POP, IMAP, POPS or IMAPS.
   - **Hostname:** Enter the host name of the mail server on which the account resides.
   - **Port:** Do not edit this field. The mail server's port number will be displayed by default.
   - **Username:** Enter a username that has permission to retrieve mail from this account.
   - **Password:** Enter the account's password.
4. Choose Test Connection to verify the details.
5. Choose Create to add the account to Confluence.

Notes

- Only site spaces can store mail archives. Personal spaces cannot. See Working with Spaces for an explanation of site spaces and personal spaces.
- Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled and will therefore not appear in the Confluence user interface. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, enable the plugin – choose Gear > General Configuration > Manage Add-ons. Then choose System in the drop down, and enable the Confluence Mail Archiving Plugin.

Deleting Mail

To delete mail from a space, you need 'Delete Mail' permission. See Space Permissions.

Only a space administrator can delete all email messages for the space simultaneously.

To delete mail from a space:

1. Go to a space and choose Space Tools > Integration > Mail
   Or, if your space uses the Documentation theme, choose Browse > Mail at the top of the screen. A list of email messages in the space is displayed in reverse chronological order.
2. Delete an individual email message by choosing the trash icon beside it.
3. If you are a space administrator, you can delete all email messages within a space at once by choosing D
Space administrators can restore deleted email messages, provided they were deleted individually.

**Note:** Email messages deleted using the 'Delete All' option cannot be restored.

**To restore mail that has been deleted:**

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose **Trash**.
3. You will see a list of email messages and other content deleted from the space. Choose Restore beside the email message you want to restore.

If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen. *Note:* The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose **Trash** in the left-hand panel.
3. You will see a list of email messages and other content deleted from the space. Choose **Restore** beside the email message you want to restore.

**Related pages:**
- Working with Mail Archives
- Confluence User's Guide

**The information on this page does not apply to Confluence Cloud.**

### Fetching Mail

Confluence fetches mail from the server once every 30 minutes. If necessary, you can manually retrieve new mail from the configured mail accounts.

You need to be a space administrator to manually retrieve mail. See **Space Permissions**.

**To manually retrieve mail:**

1. Go to a space and choose **Space Tools > Integration > Mail**
   Or, if your space uses the Documentation theme, choose **Browse > Mail** at the top of the screen.
2. Choose **Fetch new mail**. Any new messages will be displayed in order of most recent first.

**Notes**

- Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled and will therefore not appear in the Confluence user interface. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, enable the plugin – choose **Manage Add-ons**. Then choose **System** in the drop down, and enable the **Confluence Mail Archiving Plugin**.
- Once mail is fetched, it will be removed from the server.

**Related pages:**
- Adding a Mail Account
- Working with Mail Archives
- How Do I Disable Automatic Mail Polling?
- Confluence User's Guide

**The information on this page does not apply to Confluence Cloud.**

### Importing Mail

Confluence allows you to import mail from mbox files located either on your local system or in a specified location on the Confluence server. Confluence will store the imported email messages in the space’s mail archive.

You need to be a space administrator to import mail for a space. See **Space Permissions**.

**NB:** You may need to enable the **Confluence Mail Archiving Plugin** as it is disabled by default.
To import mail from an mbox file:

1. Go to the space and choose Space tools > Integrations on the sidebar.
2. Choose Mailbox Import.
   - To import from a location on your file system: Browse to the location of the mbox file, select the file and then choose Import.
   - To import from the Confluence server: Enter the location of the mbox file on the server, then choose Import.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose Mailbox Import in the space administration options.
   - To import from a location on your file system: Browse to the location of the mbox file, select the file and then choose Import.
   - To import from the Confluence server: Enter the location of the mbox file on the server, then choose Import.

Related pages:
- Working with Mail Archives
- Adding a Mail Account
- Confluence User's Guide

The information on this page does not apply to Confluence Cloud.

Notes

- Only site spaces can store mail archives. Personal spaces cannot. See Working with Spaces for an explanation of site spaces and personal spaces.
- Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled and will therefore not appear in the Confluence user interface. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, enable the plugin – choose General Configuration > Manage Add-ons. Then choose System in the drop down, and enable the Confluence Mail Archiving Plugin.
- For security reasons mail can only be imported from a specified location in the Confluence server's file system. We recommend administrators create a folder in their Confluence home directory, add the system property confluence.mbox.directory and specify the location for mailboxes to be imported from. Mail cannot be imported from the server until this system property is set. See Configuring System Properties.

Managing Mail Accounts

You need to be a space administrator to manage mail accounts for a space. See Space Permissions.

Confluence will import mail from these POP/IMAP mail accounts into the space's mail archive.

To manage mail accounts:

1. Go to the 'Mail Accounts' view:
   - Go to the space and choose Space tools > Integrations on the sidebar.
   - Choose Mail Accounts.
   - If your space uses the Documentation theme:
     Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
     Choose Integration > Mail Accounts.
2. Add an account if required. See Adding a Mail Account.
3. For each of the existing mail accounts listed, you can:
   - Edit: Change the configuration settings for the mail account.
   - Remove: Remove the account permanently.
   - Disable/Enable: Temporarily disable the account, or enable a disabled account.
Notes

Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled and will therefore not appear in the Confluence user interface. Mail archiving features are contained in a bundled plugin.

To activate mail archiving features in Confluence, enable the plugin – choose > General Configuration > Manage Add-ons. Then choose System in the drop down, and enable the Confluence Mail Archiving Plugin.

Working with Confluence Labels

Labels are key words or tags that you can add to pages, blog posts, attachments and spaces. You can define your own labels and use them to categorise, identify or bookmark content in Confluence.

For example, you could assign the label 'accounting' to all accounts-related pages on the site. You can then browse all pages with that label in a single space or across the site, or display a list of pages with that label. You can search based on the label, or use it to filter items when you subscribe to a Confluence RSS feed.

Because labels are user-defined, you can add any word that helps you identify the content in the site.

You can add or remove labels without affecting the page content.

Content labels

You can add labels to pages, blog posts and attachments. Any user with permission to view the page can also view its labels. See Adding Labels.

Space categories

You can also apply labels to spaces and use them to categorise your spaces. These are known as space categories. See Using Labels to Categorise Spaces.

Advantages of labels

Here are some of the advantages of using labels:

- Labels are user-defined which means that you decide what information is relevant to you and how you are going to label it.
- You can group pages and spaces without having to restructure the site.
- Labels are easy to add and edit, and do not affect the content of the page.
- You can add as many labels as you like to a page or space.

Using labels
Adding Labels

Using Labels to Categorise Spaces

Removing Labels

Using Label Macros to Categorise Wiki Content

Viewing Labels and Labelled Content

Viewing Personal Labels

Notes

**Note: Personal labels are deprecated:** Earlier versions of Confluence recognised a special type of label called a 'personal' label. A personal label starts with 'my:' and is only visible to the user who created it. We are removing personal labels from Confluence, as announced in the Confluence 4.1 Upgrade Notes. The functionality for personal labels is still in Confluence, but we recommend that you stop using them. In a future release, we plan to remove the functionality altogether.

Adding Labels

Labels are key words or tags that you can add to pages, blog posts, attachments and spaces. You can define your own labels and use them to categorise, identify or bookmark content.

**Labelling a page or blog post**

Any user with permission to edit a page can add a label to a page.

**To add a label to a page or blog post:**

1. Go to the page. If the page already has labels, these will be listed at the bottom of the page, below the page content.
2. Choose the edit icon beside the list of labels, or press L on your keyboard.
3. Type in a new label. Existing labels are suggested as you type.
4. Choose **Add**.

**On this page:**

- Labelling a page or blog post
- Labelling an attachment
- Notes

**Related pages:**

- Removing Labels
- Viewing Labels and Labelled Content
- Using Label Macros to Categorise Wiki Content
- Using Labels to Categorise Spaces
- Confluence User's Guide

**Screenshot: Labels as they are displayed on a page**

**Screenshot: Adding a label to a page or blog post**
Labelling an attachment

If you have permission to view or edit the page that contains the attachment, you can add a label to the attachment.

To add a label to an attachment:

1. Go to the page that contains the attachment. Choose Tools > Attachments.
2. Alternatively, go to the attachments view of the space:
   - Go to the space and choose Space tools > Content Tools on the sidebar.
   - Choose Attachments.
3. You will see a list of attachments, with columns for attachment name and other details. If the attachment already has labels, these will be listed in the Labels column.
4. Choose the edit icon beside the list of labels.
5. Type in a new label. Existing labels are suggested as you type.
6. Choose Add.

You can also add labels in a list of attachments displayed by the Attachments macro, by choosing the edit icon beside each label.

Screenshot 2: Adding a label to an attachment
Notes

- **Note: Personal labels are deprecated.** Earlier versions of Confluence recognised a special type of label called a 'personal' label. A personal label starts with 'my:' and is only visible to the user who created it. We are removing personal labels from Confluence, as announced in the Confluence 4.1 Upgrade Notes. The functionality for personal labels is still in Confluence, but we recommend that you stop using them. In a future release, we plan to remove the functionality altogether.
- If you add a label to a template, that label will be copied to the page when someone adds a page based on that template. See Adding a Template.

Using Labels to Categorise Spaces

A **space category** is a label that you can apply to a whole space for the purpose of categorising your spaces in the space directory, and in the recent activity area of the dashboard.

You need to be a space administrator to add space categories.

**Using space categories**

Here is an example of using space categories. Let's assume that you have one or more spaces that your Sales team may be interested in. You can use the category 'sales' to group those spaces together.

1. First add the 'sales' category to the relevant spaces, as described below.
2. Then, in the space directory, you can click the relevant tab to see only the spaces with the chosen label. See Viewing All Confluence Spaces.
3. And, you can see updated content in those spaces by choosing the 'sales' category under the Space Categories tab in the recent activity area of the dashboard. See Customising your Personal Dashboard.

---

**On this page:**

- Using space categories
- Categorising a space
- Removing a space from a category
- Removing an entire space category
- Notes

**Related pages:**

- Working with Confluence Labels
- Viewing All Confluence Spaces
- Confluence User's Guide

---

**Categorising a space**

When you categorise a space, you add a 'space category' to the space. A category does not exist if there are no spaces labelled with that category.

**To add a space category to a space:**

1. Go to the space and choose Space tools > Overview on the sidebar.
2. Choose Space Categories: Edit.
3. Under 'Space Categories', enter your category name and choose Add. Alternatively, choose a category in the list of 'Suggested Space Categories'
4. Choose Done.

If your space is using the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose Space Labels in the space administration options.
3. Under 'Space Categories', enter your category name and choose Add. Alternatively, choose a category in the list of 'Suggested Space Categories'.
4. Choose Done.
Removing a space from a category

Removing a space from a category is the same as removing the category from the space.

To remove a space category from a space:

1. Go to the space and choose **Space tools** > **Overview** on the sidebar.
2. Choose Space Categories: **Edit**.
3. Choose the x next to the space category.

If you are using the Documentation theme:

1. Go to the space and choose **Space tools** on the sidebar. 
   *Note:* The options available in 'Space tools' differ depending on your space permissions. All space tools options are available if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
2. Choose **Space Labels** in the space administration options.
3. Choose the x next to the space category.

Removing an entire space category

To remove a whole space category from Confluence, just remove that category from all spaces, as described above. A category cannot exist if there are no spaces labelled with that category. The space category will disappear from the dashboard and space directory.

To remove an entire space category from Confluence:

1. Choose **Spaces** > **Space directory** on the header.
2. Choose the space category that you want to remove.
3. You will see a list of all spaces in that category. Choose the spaces one by one, and remove the category from each space, as described above.

Screenshot: Space categories

---

Notes

The ability to add space labels has been removed in Confluence 5.0 in order to simplify the way labels are used in spaces. Existing space labels will be preserved, but you will be unable to add new space labels. Space categories are unaffected by this change.

Removing Labels

Labels are key words or tags that you can add to pages, blog posts and attachments. You can define your own labels and use them to categorise, identify or bookmark content in Confluence. You can see the existing labels, and the pages which contain the labels, by viewing labels and labelled content.

Removing labels in Confluence

To remove a label from a page or blog post:

1. Go to the page that contains the label. You will see the labels at the bottom of the page below the page content.
2. Choose the edit icon 🖐️ beside the list of labels, or press L on your keyboard.
3. In the 'Labels' dialog, choose the X next to a label to remove that label.
4. Choose Close.

Related pages:
- Working with Confluence Labels
- Confluence User's Guide

To remove a label from an attachment:
1. Go to the page that contains the attachment. Choose Tools > Attachments.
2. Alternatively, go to the attachments view of the space:
   - Go to the space and choose Space tools > Content Tools on the sidebar.
   - Choose Attachments.
3. You will see a list of attachments, with columns for the attachment name and other details. If the attachment already has labels, these will be listed in the Labels column.
4. Choose the edit icon 🖐️ beside the list of labels.
5. In the 'Labels' dialog, choose the X next to a label to remove that label.
6. Choose Close.

When you have removed the label from all content, the label will disappear from the labels view in the space too.

Notes
- Deleted pages containing labels: If you have deleted pages that contain a label, you may need to purge the deleted pages from the space's trash to ensure that the label disappears too.
- Bulk removal of labels: There is no way to remove a number of labels at once, via the Confluence user interface. Instead, we suggest that you use the Confluence Command Line Interface. See the 'removeLabels' action described in the CLI documentation. For an introduction to the CLI, see this blog post: Confluence CLI for bulk actions like deleting or publishing pages.

Using Label Macros to Categorise Wiki Content

Using labels, you can categorise pages and refer to content across multiple categories, pages and even spaces.

Example

For the purpose of this example, imagine we have a space with pages of content on various types of vehicles. Pages are shown in bold text, while the labels are in blue.

- **Cars**  vehicle-type
  - Toyota Prius  vehicle car
  - Honda Civic  vehicle car
  - Porsche Carrera  vehicle car
- **Motorbikes**  vehicle-type
  - Harley Davidson Sportster  vehicle motorbike
  - Suzuki GSX-R  vehicle motorbike

This page hierarchy can then be categorised using labels, with pages referenced using the Content by Label Macro.

<table>
<thead>
<tr>
<th>If you want to list...</th>
<th>You would use this label:</th>
<th>These would be the pages that you would get:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vehicle types</td>
<td>vehicle-type</td>
<td>Cars, Motorbikes</td>
</tr>
<tr>
<td>All vehicles</td>
<td>vehicle</td>
<td>Toyota Prius, Honda Civic, Porsche Carrera, Harley Davidson Sportster, Suzuki GSX-R</td>
</tr>
</tbody>
</table>
Label macros

Navmap macro
The Navigation Map macro renders the list of pages associated with a specified label as a navigation map.

Related Labels macro
The Related Labels macro lists labels commonly associated with the current page's labels.

Content by Label macro
The Content by Label macro displays a list of content marked with specified labels.

Content Report Table macro
The Content Report Table macro displays a set of pages and blog posts in tabular format, based on the specified labels.

Labels List macro
The Labels List macro lists all labels of a space, grouped alphabetically.

Recently Used Labels macro
The Recently Used Labels macro lists labels most recently used in a specified scope - global (site), space, or personal.

Popular Labels macro
The Popular Labels macro displays popular labels in a list or in a heatmap (also called a cloud).

Viewing Labels and Labelled Content
Labels are key words or tags that you can add to pages, blog posts, attachments and spaces. You can define your own labels and use them to categorise, identify or bookmark content in Confluence. This page describes a few ways of viewing labels and labelled content. The focus of this page is on labels that are visible to everyone. You may also be interested in viewing personal labels.

Finding the labels view
Global labels are visible to all users with 'view' permission on the page, and personal labels are visible only to the person who added them.

- Any page or blog post that has labels will have them listed together in a block at the bottom of the page.
- You will also see labels in the 'Attachments' view or in a listing of attachments provided by the Attachments macro. (See Displaying a List of Attachments.)

To find the labels view by choosing a label:
If you are in a page that has labels, choose a label.

- If it is a personal label (starts with 'my:') you will go to the personal labels page in your user profile. See Viewing Personal Labels.
- If it is a global label, you will go to the 'Labels' tab of the space. Choose Popular Labels or All Labels to see all labels in the space.

Screenshot: Labels as they are displayed on a page
To find the labels view via URL:

Visit the following URL:

```
<MYSITE>/labels/listlabels-alphaview.action?key=MYSPACEKEY
```

For example: https://confluence.atlassian.com/labels/listlabels-alphaview.action?key=DOC

To find the labels view from the menu (Documentation theme only):

If the space is using the Documentation theme, you can access the labels view directly via the menu:

- Go to a page in the space and choose **Browse > Labels**.
- Choose **Popular Labels** or **All Labels** to see all labels in the space.

**On this page:**
- Finding the labels view
- Using the labels view
- Searching for labels
- Navigating pages by URL and label

**Related pages:**
- Viewing Personal Labels
- Searching Confluence
- Confluence User’s Guide

**Using the labels view**

The labels view in a space offers the following options:

- **Popular Labels**: Choose this option to see a list of the most frequently used labels in that space. From here, you can also view the most popular labels across the site. The bigger the font size, the more popular the label.
- **All Labels**: View all labels in the space. From this view, you can choose a link to view an alphabetical listing of all labels across the site. Choosing a label will list all content in the space with that label. It will also display any related labels if they exist. **Related labels** are labels that frequently appear on pages together. For example, if pages labelled with 'sales' also tend to have the label 'marketing', these will be displayed as related labels.
- **See content from all spaces**: Expand the list of labels to include pages and other labelled content from all spaces.

**Screenshot: The labels view, showing all 'logo' labels**
Searching for labels

Use the 'labelText:' prefix to search specifically for content that has a specific label. The table below gives examples of search terms that you can enter into Confluence's search box, and the search results that you can expect.

<table>
<thead>
<tr>
<th>Searching for ...</th>
<th>Returns content that ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>recipe labelText:chocolate</td>
<td>contains the word 'recipe' or has the label 'chocolate'</td>
</tr>
<tr>
<td>recipe AND labelText:chocolate</td>
<td>contains the word 'recipe' and has the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake OR labelText:chocolate</td>
<td>has the label 'cake' or the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake AND labelText:chocolate</td>
<td>has both labels 'cake' and 'chocolate'</td>
</tr>
</tbody>
</table>

The 'labelText:' prefix is an example of a search field. See more about Confluence Search Fields.

Navigating pages by URL and label

This section describes how to move around your Confluence pages by adding and subtracting labels from the list of labels that you want to match. You can search for matching labels by entering a URL. You can also add and subtract labels from the search.

To search labelled pages by typing a URL:

1. Open a new web browser window.
2. In the address bar of your web browser, type an URL such as:
   
   http://CONFLUENCE_HOSTNAME/label/foo+bar
   
3. Press Enter.
4. The 'View Labels' page will load, showing search results for pages with the labels 'foo' and 'bar'.

Adding a label to your results:

- Choose a label from the Related Labels list (at the top left).
- A new page loads, showing pages that contain all of the labels selected so far. You can continue to add labels to the results in this way.
Subtracting a label from your search results:

When two labels are in use, links to subtract a label from the search appear at the end of the labels list. These are easily identified because these links have a preceding minus sign, like this:

- education

Viewing Personal Labels

Any page that has labels (global or personal) will have them listed at the bottom of the page. Personal labels start with 'my:', and are only visible to the user that created them.

**Note:** Personal labels are deprecated. The functionality for personal labels is still in Confluence, but we recommend that you stop using them. In a future release, we plan to remove the functionality altogether.

To view your personal labels:

- If you are on a page that has personal labels, click one of those labels to get to the screen showing all your personal labels.
- Alternatively, visit the URL: `<your Confluence site>/users/viewmylabels.action`. For example: `http://confluence.atlassian.com/users/viewmylabels.action`

You will see a list of your personal labels along with the pages that contain the label.

**Related pages:**
- Adding Labels
- Viewing Labels and Labelled Content
- Confluence User's Guide

Working with Favourites

You can mark pages and spaces as favourites and then access them quickly from the Confluence dashboard and from your user profile.

Adding favourites

**To add a page as a favourite:**

1. Go to the page.
2. Choose **Tools > Favourite**.
   The menu item will change to ‘Remove Favourite’ to indicate the page is a favourite.

**To add a space as a favourite:**

1. Choose **Spaces > Space directory** on the header.
2. Choose the star icon next to the space name in the list of spaces.
   The star icon will change colour to indicate that you have added this space as a favourite.

**To add someone’s personal space as a favourite:**

This option is only available for personal spaces. You cannot mark a person's profile as favourite, so this option is not available if the person has not yet created a personal space.

1. Choose **Spaces > Space directory** on the header.
2. Choose **Personal Spaces**.
3. Choose the star icon next to the space name in the list of spaces.
   The star icon will change colour to indicate that you have added this space as a favourite.
Removing favourites

**To remove a page as a favourite:**

1. Go to the page.
2. Choose **Tools > Remove Favourite**.
   This will change to 'Favourite' to indicate that you have removed this page from your favourites.

**To remove a space as a favourite:**

1. Go to the [dashboard](#) or choose Spaces in the header.
2. Choose the star icon beside the space in the list of spaces.
   The star icon will change colour to indicate that you have removed this space as a favourite.

**To remove a personal space as a favourite:**

1. Choose **Spaces** in the header.
2. Choose **Personal Spaces**.
3. Choose the star icon beside the space in the list of personal spaces.
   The star icon will change colour to indicate that you have removed this space as a favourite.

Viewing favourites

You can see your favourite pages via your user profile and on the dashboard.

**To view your favourites via your profile:**

1. Log in to Confluence, if you have not already done so.
2. Choose **your profile picture** at top right of the screen, then choose **Favourites**.

_Screenshot: Viewing your favourites in your profile_

Viewing your favourites via the dashboard

<table>
<thead>
<tr>
<th>People</th>
<th>Josh User</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile</strong></td>
<td><img src="#" alt="Profile" /></td>
</tr>
<tr>
<td><strong>Network</strong></td>
<td><img src="#" alt="Network" /></td>
</tr>
<tr>
<td><strong>Status Updates</strong></td>
<td><img src="#" alt="Status Updates" /></td>
</tr>
<tr>
<td><strong>Favourites</strong></td>
<td><img src="#" alt="Favourites" /></td>
</tr>
<tr>
<td><strong>Watches</strong></td>
<td><img src="#" alt="Watches" /></td>
</tr>
<tr>
<td><strong>Drafts</strong></td>
<td><img src="#" alt="Drafts" /></td>
</tr>
<tr>
<td><strong>Settings</strong></td>
<td><img src="#" alt="Settings" /></td>
</tr>
</tbody>
</table>

- **Step 3 - share your favourite nerd** by Rach Admin (08 Feb)
- **Overview** by Rach Admin (4 hours ago)
- **Angry Nerds** by Rach Admin (08 Feb)
- **Josh User** by Josh User (3 hours ago)
On the **dashboard**, you can see:

- your favourite spaces on the **Spaces** tab.
- your most recently added favourite pages on the **Pages** tab.

Recently updated content in your favourite spaces will be listed on the **Favourite Spaces** tab on the dashboard.

**Screenshot: Viewing your favourites on the dashboard**

---

### **Working with Attachments**

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format. You can attach files to any page or blog post, provided you have permission to do so.

When a page you are viewing contains attachments, a small paperclip icon appears next to the breadcrumbs. Clicking the paperclip icon will take you to the ‘Attachments’ view, where you will see the full list of attachments.

A quick guide to attachments

Choose **Tools > Attachments** to view and attach files to a Confluence page. (See **Attaching Files to a Page**.) If you attach a file with the same name as an existing attachment, Confluence will create a new version of the existing attachment.

Once you have attached the relevant files, you can display attached images and multimedia content on the page. If the attachment is an Office document, use the View File macro to display the content of the document on the Confluence page. If you have an Office application installed, you will also be able to launch your Office editor from within Confluence. See **Displaying Office Files in Confluence** and **Working with the Office Connector**.

Your page can display a list of attachments — these may be the files that are attached to the page or to any page in the space. You can also display a link to an attachment. When a user clicks the link, the attachment will open, provided that the user has the software application needed to open the attachment.

You can label an attachment, and then use labels to categorise your content.
Working with attachments

- Using Drag-and-Drop in Confluence
- Attaching Files to a Page
- Attachment Versions
- Deleting an Attachment
- Displaying a List of Attachments
- Downloading Attachments
- Editing Attachment Properties
- Embedding Multimedia Content
- Embedding PowerPoint Presentations in a Page
- Moving an Attachment
- Viewing Attachment Details

Notes

If you want an attachment to be displayed on more than one page, you may wish to consider creating a special page to hold such attachments. This special page could be part of an 'inclusions library'.

Using Drag-and-Drop in Confluence

This page describes the drag-and-drop functionality in Confluence, and the browser configurations needed to support that functionality.

**Overview of the drag-and-drop features**

Confluence supports these forms of drag-and-drop:

- **Drag-and-drop within the editor.** Working inside the editor panel, you can drag an image or a macro and drop it into a different location on the page.
- **Drag-and-drop for external images and files.** You can drag a file from a location outside Confluence, and drop it directly into the editor. For example, try it with images, video files, audio files, Office documents, and PDF files. The contents of the file will be embedded into the page or blog post.

**Drag-and-drop within the editor**

Working within the editor panel, you can drag an image or a macro from one location on the page and drop it into a different location on the page. Hover your cursor over the image or the macro placeholder. The cursor changes to a drag-and-drop icon and you can click the image or macro and drag it to a new location.

If you want to abandon the drag-and-drop action, press Escape. The image/macro will return to its original position.

**Requirements for internal drag-and-drop**

For the drag-and-drop of images and macros in the editor, Confluence supports the following browsers: Chrome, Firefox, and Internet Explorer 10 (desktop mode).
Drag-and-drop for external images and files

You can drag files from your computer or file system onto your browser and attach them to your Confluence pages or blog posts. You can drag and drop:

- multiple files at once.
- image, multimedia and PDF files, and Office documents.

When you drag and drop files onto the different Confluence views, you get the following results:

<table>
<thead>
<tr>
<th>Confluence View</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments</td>
<td>Files are attached</td>
</tr>
<tr>
<td>Page</td>
<td>Files are attached</td>
</tr>
<tr>
<td>Edit</td>
<td>Files are attached, and embedded at the cursor position</td>
</tr>
</tbody>
</table>

Requirements for external drag-and-drop

- For dragging files from your computer or file system onto your browser, your browser must support the drag-and-drop functionality of HTML5. Browsers such as Firefox 3.5, Safari 4 and Internet Explorer 9 offer limited HTML5 functionality and don't support drag-and-drop.

Note about supported web browsers: Please ensure that you are using one of the web browsers supported by Confluence. If you are using an unsupported browser or browser version, some features may not work correctly. Check the Supported Platforms page to find the list of supported web browsers and browser versions on this page.

- Some older Confluence themes do not support Confluence's drag-and-drop feature.

  - **Supported themes**: Confluence Default theme, Documentation theme.
  - **Themes that are not supported**: Left Navigation theme, Clickr theme. You cannot drag and drop attachments into spaces that use these themes.

Disabling drag-and-drop for external files

- If you wish to disable the drag-and-drop feature, you can disable the entire Confluence Drag and Drop Plugin. See Disabling and enabling add-ons.
- You can also disable the drop zone that appears on the 'Attachments' view or the image dialog box, by disabling the View Attachments Drop Zone or Image Dialog Drop Zone modules of the above plugin. This will remove these drop zones while retaining Confluence's drag-and-drop functionality.

Attaching Files to a Page

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files.
Attachments are useful when you want to share information that exists in another file format. Read more in Working with Attachments.

When you attach a file to a page, Confluence makes a copy of the file and stores it on the Confluence server. Page attachments in Confluence are managed using the 'Attachments' view of the page.

To attach a file, you need the 'Create Attachments' permission. See Space Permissions.

When a page you are viewing contains attachments, a small paperclip icon appears next to the breadcrumbs. Clicking the paperclip icon will take you to the 'Attachments' view, where you will see the full list of attachments.

### On this page:
- Attaching files
- Attachment versions
- Notes

### Related pages:
- Working with Attachments
- Configuring Attachment Size
- Displaying Images
- Attachment Versions
- Deleting an Attachment
- Confluence User's Guide

### Attaching files

This page describes the following ways of attaching files to a Confluence page:

- Drag and drop files on to a Confluence page.
- Browse to, and upload files from, your computer or network.

### To attach a file to a page using drag-and-drop:

1. View the page to which you want to attach files.
2. Drag one or more files from your computer onto the page. The 'Attach File(s)' message box appears, indicating the upload status of the files being attached to your page.

You can drag and drop more than one file at a time onto a page. You cannot drag a folder of files onto a page.

Expand this section to see other ways to drag-and-drop a file on to a page...

You can also drag and drop files:

- directly onto the 'Attachments' view for the page.
- directly onto the editor view of the page.
- onto any tab of the 'Insert Link' or 'Insert Image' dialogs, which are available from the Insert menu while editing.

### To attach a file to a page from the computer's (or network's) file system:

2. Choose Browse and navigate to the file.
3. Select the file and click Open.
4. Add a descriptive comment for the file (optional).
5. Choose Attach more files if required.
6. Choose Attach.

You can attach than one file at a time. You cannot attach a folder of files.

Expand this section to see other ways to upload a file to a page...

You can also browse for, and upload, a file from:

- the 'Attachments' tab of the 'Insert Link' dialog. (While editing the page, choose Insert > Link.)
- the 'Attached Images' tab of the 'Insert Image' dialog. (While editing the page, choose Insert > Image.)
Attachment versions

If you upload a file with the same name as an existing attachment, Confluence will rename the old file and keep it as a previous version. Read more about Attachment Versions and Viewing Attachment Details.

Notes

- **Reusing attachments**: If you want to display the same file on more than one page, the best way is to put the attachment on a page (say, page A) and then use the Include Page Macro to include page A into page B, page C, and all the pages where you want the diagram, presentation, or other file. Alternatively, you can display an image that is attached to another page.
- **Updating the original file**: Any changes you make to the source file do not affect the copy that was uploaded to Confluence. To update the Confluence copy, you need to upload the new version of the file.

Attachment Versions

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

When viewing a list of attachments, you can add a new version of an existing attachment by uploading an attachment with the same file name, as displayed on the attachment view. Existing files will be kept with the name 'Version x', where the value of 'x' increments with each upload of an attachment with the same file name.

To see all versions of an attachment: Choose the arrow next to an attachment name.

**Related pages:**
- Attaching Files to a Page
- Deleting an Attachment
- Moving an Attachment
- Viewing Attachment Details
- Working with Attachments
- Confluence User's Guide

**Screenshot: Attachment versions**

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Creator</th>
<th>Creation Date</th>
<th>Labels</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>penguin.png</td>
<td>5 kB</td>
<td>Rach Admin</td>
<td>Feb 15, 2013 15:33</td>
<td>penguin, chocolate</td>
<td>Updated colours, Properties</td>
</tr>
<tr>
<td>Version 2</td>
<td>5 kB</td>
<td>Rach Admin</td>
<td>Feb 15, 2013 15:33</td>
<td>Updated colours</td>
<td>Remove</td>
</tr>
<tr>
<td>Version 1</td>
<td>5 kB</td>
<td>Josh User</td>
<td>Feb 14, 2013 10:58</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bugs.gif</td>
<td>22 kB</td>
<td>Josh User</td>
<td>Feb 15, 2013 14:51</td>
<td>useful, logo</td>
<td>Properties</td>
</tr>
<tr>
<td>site-logo.png</td>
<td>38 kB</td>
<td>Josh User</td>
<td>Feb 15, 2013 14:51</td>
<td>logo, confulence</td>
<td>Properties</td>
</tr>
</tbody>
</table>

**Notes**

- You cannot revert to a previous version of an attachment. See feature request CONF-1943.
- Confluence does not track the history of attachments in the same way as it does for pages. See feature request CONF-13943.
- There is no limit to the number of attachments or attachment versions, provided that there is enough disk space.
- By default, attachments and their versions are stored in the `<confluence_home>/attachments` directory. (See Attachment Storage Configuration.)

Deleting an Attachment

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

By default, when you delete an attachment, this will delete all versions of the attachment. To do that, you need the 'Delete Attachments' permission. See Space permissions.
If you want to delete a specific version of an attachment, you need to be a **space administrator**.

**Related pages:**
- Working with Attachments
- Deleting an Image
- Displaying Images
- Confluence User’s Guide

To delete all versions of an attachment:

1. Go to the page that contains the attachment.
2. Choose **Tools > Attachments**. A list of the page’s attachments will appear.
3. Choose **Delete** next to the attachment you want to delete.
4. Choose **Delete** to confirm your action.

To delete a specific version of an attachment:

1. Go to the page that contains the attachment.
2. Choose **Tools > Attachments**. A list of the page’s attachments will appear.
3. Choose the arrow on the left next to the attachment you want to manage. A list of attachment versions will appear.
4. Choose **Delete** next to the version you want to delete.
5. Choose **Delete** to confirm your action.

**Screenshot: Attachments and attachment versions**

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Creator</th>
<th>Creation Date</th>
<th>Labels</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>penguin.png</td>
<td>5 KiB</td>
<td>Rach Admin</td>
<td>Feb 15, 2013 15:33</td>
<td>updated colours</td>
<td>Properties</td>
</tr>
<tr>
<td>Version 2</td>
<td>5 KiB</td>
<td>Rach Admin</td>
<td>Feb 15, 2013 15:33</td>
<td>updated colours</td>
<td></td>
</tr>
<tr>
<td>Version 1</td>
<td>5 KiB</td>
<td>Josh User</td>
<td>Feb 14, 2013 10:08</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bugs.gif</td>
<td>22 KiB</td>
<td>Josh User</td>
<td>Feb 15, 2013 14:51</td>
<td>useful</td>
<td></td>
</tr>
<tr>
<td>svglogo.png</td>
<td>2 KiB</td>
<td>Josh User</td>
<td>Feb 15, 2013 14:51</td>
<td>logos</td>
<td></td>
</tr>
</tbody>
</table>

**Displaying a List of Attachments**

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

You can display a list of attachments on your page – these may be the files that are attached to the current page or to any page in the space. Use the

- Use the **Attachments** macro to show a list of the attachments on the current page, or
- Use the **Space Attachments** macro to show a list of the attachments in the current space.

Both these macros generate a table of attachments which is clickable.

**Using the macros**

**To add the Attachments or Space Attachments macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.
Parameters of the Attachments macro

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Filename Patterns        | all     | A comma-separated list of regular expressions, used to filter the attachments by file name. Note that the parameter values must be regular expressions. For example:  
  - To match a file suffix of 'jpg', use .*jpg (not *.jpg).  
  - To match file names ending in 'jpg' or 'png', use .*jpg,.*png |
| Attachment Labels        | (none)  | A list of labels, used to filter the attachments to display. If you wish to enter more than one label, separate the labels with commas. Confluence will show only attachments that have **all** the labels specified. (The match is an AND, not an OR.) For information on labelling the attachments, see Adding Labels. |
| Include Old Attachment Versions | false  | A value of true will include previous attachment versions in the list. |
| Sort By                 | date    | The sort order for attachments. Note that people viewing the page can change the sort order by clicking the column headings. Valid values are:  
  - date – sorts by updated date in reverse chronological order (newest first)  
  - size – sorts largest to smallest  
  - name – sorts alphabetically  
  - created date - sorts by creation date in reverse chronological order (newest first) |
| Sort Order              | ascending | Used in combination with the Sort By parameter, to sort the attachments in ascending or descending order. |
| Allow Upload            | true    | If selected, the list of attachments will include options allowing users to browse for, and attach, new files. |
| Page Title              | (none)  | Used to display attachments from another page. If you do not enter a page title, the macro will display the files attached to the current page. |
| Show Previews           | true    | Used to display a preview of the attached file. If true, preview will be visible when the list item is expanded. |

Viewing files and changing file properties via the Attachments macro

The list of files displayed by the Attachments macro can be expanded to show options for viewing the files and other actions, provided you have the relevant permissions.
If you have specified the 'Allow Upload' parameter, users will be able to upload attachments directly from the list.

You can delete attachments. Note that you can only delete the entire attachment (including all versions). To delete a specific version of an attachment, you must go to the 'Attachments' view. See Deleting an Attachment.

You can edit attachment properties and labels. If an attachment is an Office or PDF file, they will see the appropriate options for Office Connector files.

You can choose not to display previews in the macro. This is useful if you have very large attachments.

Screenshot: The Attachments macro, showing details of an attachment

Parameters of the Space Attachments macro

The Space Attachments macro displays a list of all the attachments in a space. You can choose to show attachments from the current space, or another space.

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>(none)</td>
<td>Selects the Confluence space to display attachments for. If you do not specify a space, the current space will be used.</td>
</tr>
<tr>
<td>Show Filter Controls</td>
<td>true</td>
<td>Determines whether or not the filter panel is shown. If you select this option, people viewing the page will be able to filter the list of attachments by file type (extension) and by label.</td>
</tr>
</tbody>
</table>
### Downloading Attachments

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

#### To download a single attachment from a page:

1. View the page.
2. Choose **Tools > Attachments**.
3. Right-click the link on the attachment name, and select **Save Link As**, **Save Target As** or a similar option provided by your browser. This will open a 'Save' dialog.
4. Select the location into which you want to download the file and choose **Save**.

#### To download all the attachments from a page:

1. View the page.
2. Choose **Tools > Attachments**.
3. Choose the **Download All** button at the end of the page to download a zipped file of all the page’s attachments.

### Notes

- There is no permission that controls the downloading of attachments. See an article in our knowledge base about [disabling the download of attachments](#).
- Confluence does not supply an option to download all attachments from a space. See the closed feature request: [CONF-5669 - Download all attachments from a Space](#) **CLOSED**

### Editing Attachment Properties

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

To edit an attachment's properties, you need the 'Create Attachments' permission. See **Space Permissions**.

#### To edit the properties of an attachment:

1. View the page that contains the attachment.
2. Choose **Tools > Attachments**.
3. Choose **Properties** next to the attachment. The 'Properties' screen will appear.
4. Make your changes:
   - **File Name** — Rename or modify the name of the attachment.
   - **New Comment** — Update the existing comment or enter a new comment.
   - **New Content Type** — Change the content type of the attachment by entering a valid MIME type.
   - **Page** — Move the attachment to another page.
5. Choose **Save**.

**Related pages:**
- Attaching Files to a Page
- Moving an Attachment
- Viewing Attachment Details
- Working with Attachments
- Confluence User’s Guide

**Screenshot: Editing an attachment’s properties**

**Embedding Multimedia Content**
Using multimedia files you can display movies, animations and videos, and embed audio files on your Confluence page.

There are several methods for **attaching files to a page**. Once you have attached the multimedia file to a Confluence page, you then edit the page to set where the multimedia content should appear.

In the example below, we display a Flash file that is attached to this page.

```java
Error rendering macro 'multimedia' : null
```

Confluence supports the following multimedia formats:

- Adobe Flash (.swf)
- Apple QuickTime (.mov)
- Windows Media (.wma, .wmv)
- Real Media (.rm, .ram)
- MP3 and MP4 files (.mp3, .mp4)
- MPEG files (.mpeg, .mpg)
- AVI files (.avi) **You may need to enable an avi decoder within your browser.**
Displaying a multimedia file attached to the page

Once you have attached a multimedia file to a page, there are different methods for choosing where on the page the multimedia content should appear:

- **Add the macro yourself**: Attach the multimedia file to the page in the usual way. Add the Multimedia macro using the macro browser.
- **Autocomplete**: Attach the multimedia file to the page in the usual way. Type ‘!’ in the editor and choose the multimedia file from the list that appears.
- **Drag and drop**: Drop the video or other file into the editor. Confluence will attach the file and insert the Multimedia macro for you.
- **Adjust parameters if necessary**: Click on the Multimedia macro placeholder to set options for the macro, such as adjusting the width or height of the display, or setting autoplay on.

Quick guide to displaying multimedia content on a page

Choose one of these methods:

- **Add the macro yourself**: Attach the multimedia file to the page in the usual way. Add the Multimedia macro using the macro browser.
- **Autocomplete**: Attach the multimedia file to the page in the usual way. Type ‘!’ in the editor and choose the multimedia file from the list that appears.
- **Drag and drop**: Drop the video or other file into the editor. Confluence will attach the file and insert the Multimedia macro for you.
- **Adjust parameters if necessary**: Click on the Multimedia macro placeholder to set options for the macro, such as adjusting the width or height of the display, or setting autoplay on.

**Displaying a multimedia file attached to the page**

Once you have attached a multimedia file to a page, there are different methods for choosing where on the page the multimedia content should appear:

**Inserting the Multimedia macro yourself**

You can add the Multimedia macro to the page yourself using the Macro Browser. This allows you to display a multimedia file that is attached to either the current page or to another page in the Confluence site.

**To insert the Multimedia macro on the page at the current cursor position:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete**: Type '{' and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro**: Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Using autocomplete**

Once a multimedia file is attached to the page, you can use autocomplete, while editing the page, to choose where the multimedia content should appear.

**To position an attached multimedia file on the page using autocomplete:**

1. While editing the page, position the cursor where you want to place the multimedia content.
2. Trigger the autocomplete function by typing ‘!’.
3. Choose the multimedia file from the list that appears.
4. If necessary, click on the Multimedia macro placeholder and choose **Edit** to set various options such as the width, height or autoplay.

**Using drag-and-drop**

Depending on the browser you are using, you can attach and position a multimedia file in one step using drag-and-drop.

**To attach and position multimedia content using drag-and-drop:**
1. While you are editing a page, simply drag-and-drop the multimedia file on to the page. Confluence will attach the file to the page and insert the Multimedia macro at the current cursor position for you.
2. If necessary, click on the Multimedia macro placeholder and choose Edit to set various options such as the width, height or autoplay.

**Multimedia macro parameters**

Parameters are options that you can set to control the content or format of the macro output. Where the parameter name used in Confluence storage format or wikimarkup is different to the label used in the macro browser, it will be listed below in brackets (example).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Name</td>
<td>Current page</td>
<td>Name of the page to which the multimedia file is attached. If you are using the Macro Browser, just start typing the name of the page and then select it from the dropdown list that appears. The page can be in the same space or another space.</td>
</tr>
<tr>
<td>Attachment</td>
<td>None</td>
<td>File name of the multimedia file.</td>
</tr>
<tr>
<td>Width</td>
<td>If not specified, the browser will determine the width based on the file type.</td>
<td>Width of the movie window to be displayed on the page. By default, this value is specified in pixels. You can also choose to specify a percentage of the window's width, or any other value accepted by HTML.</td>
</tr>
<tr>
<td>Height</td>
<td>If not specified, the browser will determine the height based on the file type.</td>
<td>Height of the movie window to be displayed on the page. By default, this value is specified in pixels. You can also choose to specify a percentage of the window's height, or any other value accepted by HTML.</td>
</tr>
<tr>
<td>Autoplay</td>
<td>False</td>
<td>If this option is checked (that is, if the parameter is set to 'true') then the video or audio file will start playing as soon as the page is loaded. If this option is not checked (set to 'false') then the file will not play until the user clicks the icon or image on the page. See the note about autoplay below.</td>
</tr>
</tbody>
</table>

**Notes**

- **The multimedia file must be attached to a Confluence page.** For security reasons, files located on remote servers are not permitted. See the Widget Connector for displaying live content from external sites.

- **You will need the relevant multimedia plugin for your browser.** Your browser (Firefox, Internet Explorer, Safari and others) needs a plugin to play the video or audio file on a Confluence page. For example, to play a Flash movie you need the Flash plugin. Many plugins are shipped with the major browsers by default. If a user does not have the required plugin installed and enabled in their browser, they will not be able to view the multimedia files on the page.

- **Autoplay may not always work as expected.** You can set autoplay on, so that your video or audio file should start playing as soon as the page is loaded into the browser. (See parameters.) However, this setting may not always work as expected. Confluence will send an instruction to the browser plugin that plays the multimedia file. Different browsers and different media plugins behave in different ways, and not all of them respect such instructions.

- **Use the Office Connector to display Office documents.** Take a look at the Office Connector for embedding Word documents, presentations and other Office documents onto your Confluence page.

- **If you get the error, 'Unable to embed content of type application/octet-stream', this means the MIME type is not recognised.**

- **Advanced users can try styling via CSS.** By default, each embedded object is wrapped in a `div` tag. If you wish to style the `div` and its contents, override the `embeddedObject` CSS class. Specifying an ID...
as a property also allows you to style different embedded objects differently. CSS class names in the format `embeddedObject-ID` are used.

Embedding PowerPoint Presentations in a Page

Below are some ideas on how you can display a presentation on a Confluence page.

**Option 1 - Office Connector for Confluence**

The Office Connector provides the most straightforward way to display PowerPoint slides.

1. Attach your PowerPoint file to a Confluence page - see [Attaching Files to a Page](#).
2. Use the Office PowerPoint View File macro to display the presentation on the page.

Alternatively you can drag your PowerPoint file directly into the editor, and Confluence will attach the file and display it in the Office PowerPoint View File Macro for you.

**On this page:**
- Option 1 - Office Connector for Confluence
- Option 2 - PDF View File macro
- Option 3 - Gallery or Slide Show of JPEG or PNG Images

**Related pages:**
- Working with the Office Connector
- Working with Attachments
- Confluence User's Guide

**Option 2 - PDF View File macro**

1. Convert your presentation to PDF, using 'Save as > PDF' in PowerPoint (PowerPoint 2007 and later).
2. Attach the PDF file to your Confluence page.
3. Use the PDF View File macro to display the presentation on the page. The PDF View File macro contains `Next Slide`, `Previous Slide` and `Full Screen Mode` buttons for controlling your presentation.

Alternatively you can drag your PDF file directly into the editor, and Confluence will attach the file and display it in the PDF View File Macro for you.

This method is also useful for presentations created in other packages such as Keynote.

**Option 3 - Gallery or Slide Show of JPEG or PNG Images**

1. Convert your PowerPoint presentation into JPEG or PNG images, using 'save as' from PowerPoint (slide1.jpg, slide2.jpg...).
2. Upload the image files as attachments to your Confluence page.
3. Use the Gallery macro to display the images as a slide show in Confluence.

**Moving an Attachment**

You can move an attachment from its current location to any page within the site.

To move an attachment, you need the following permissions (see [Space Permissions](#)):

- 'Add Page' permissions on the page where the attachment currently exists.
- 'Remove Attachment' permissions for the space where the attachment currently exists.
- 'Add Attachment' permission on the space into which you are moving the attachment.

**To move an attachment:**

1. Go to the page that contains the attachment.
2. Choose **Tools > Attachments**.
3. Choose **Properties** next to the attachment.
4. Enter the name of the page where you want to move the attachment into the **Page** field, for example, `My Destination Page`.
5. Choose **Save**.

If you wish to move the attachment to a page in a different space, add the space key before the page name, for example, `DOC:My Destination Page`. 

---

*Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Viewing Attachment Details

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

You can view attachment details in the following places:

- The list of attachments in a space. This will show all files attached to all pages in the space. See below.
- The list of attachments for a specific page. See below.
- A list of attachments created by a macro and displayed on a page. See Displaying a List of Attachments.

**Viewing attachments in a space**

To view the attachments associated with a space:

1. Go to the space and choose Space tools > Content Tools on the sidebar.
2. Choose Attachments. You will see a list of all the attachments in the space, along with their details and the pages they are attached to.

To see only files of a particular type:
- Type the last part of the file name in the Filter By File Extension box. For example, enter 'gif' to see only image files of the GIF format.
- Choose Filter.

3. To see only files that have a particular label or labels:
   - Type the label or labels in the Filter by Label box. If you enter more than one label, separate the labels with commas or spaces. Confluence will show only attachments that have all the labels specified. (The match is an AND, not an OR.)
   - Choose Filter.

If your space uses the Documentation theme:

2. Choose Attachments from the left menu.

**On this page:**
- Viewing attachments in a space
- Viewing attachments on a page
- Attachment details

**Related pages:**
- Working with Attachments
- Displaying a List of Attachments
- Confluence User's Guide

**Screenshot: List of attachments for a space**

![List of attachments for a space](image)

**Viewing attachments on a page**

When a page you are viewing contains attachments, a small paperclip icon appears next to the breadcrumbs. Clicking the paperclip icon will take you to the 'Attachments' view, where you will see the full list of attachments.
To view the attachments associated with a page:

1. Go to the page.
2. Choose **Tools > Attachments**. You will see a list of the attachments in the page along with their details.
3. To see all versions of an attachment, choose the arrow on the left of the attachment name.

The list of attachments includes options for viewing the files, and other actions, provided the user has the relevant permissions. If you have specified the 'Allow Upload' parameter, users will be able to upload attachments directly from the list too. Users can also delete attachments or edit attachment properties and labels. If an attachment is an Office or PDF file, you will see the appropriate options for **Office Connector** files.

**Screenshot: List of attachments for a page**

### Attachments

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Creator</th>
<th>Creation Date</th>
<th>Labels</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>penguin.png</td>
<td>5 kB</td>
<td>Rach</td>
<td>Feb 15, 2013</td>
<td>penguin chocolate</td>
<td>Updated colours</td>
</tr>
<tr>
<td>Version 2</td>
<td>5 kB</td>
<td>Rach</td>
<td>Feb 15, 2013</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Version 1</td>
<td>5 kB</td>
<td>Josh</td>
<td>Feb 14, 2013</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bugs.gif</td>
<td>22 kB</td>
<td>Josh</td>
<td>Feb 15, 2013</td>
<td>useful logo</td>
<td></td>
</tr>
<tr>
<td>site.png</td>
<td>2 kB</td>
<td>Josh</td>
<td>Feb 15, 2013</td>
<td>logo confluence</td>
<td></td>
</tr>
</tbody>
</table>

**Attachment details**

Note that the page view shows a different subset of fields from the space view.

- **Name** is the name of the attached file.
- **Size** tells you how much space the attachment takes up. You can sort by size by clicking the column title.
- **Creator** is the person who attached the file. Clicking on the link takes you to the person's user profile.
- **Creation Date** is the date the file was attached. You can sort by date by clicking the column title.
- **Labels** are keywords, or tags, that you can enter to categorise the attachments. See how to add labels.
- **Last Mod. Date** (in the space view) is the date the file was last modified.
- **Attached To** (in the space view) tells you which page contains the attachment.
- **Comment** (in the page view) is a short description of the attachment.
- The **Properties** link (in the page view) lets you edit the attachment details. See how to edit attachment properties.
- The **Delete** link (in the page view) lets you delete the attachment, or a specific version of the attachment.
- The **Edit in Office** link (in the page view) appears next to Office files only, and lets you edit that attachment.
- The **Attach File** option lets you add another attachment or another version of an existing attachment. See how to upload attachments.

### Customising Confluence

You can customise or configure many aspects of Confluence:

- The **look and feel** of any Confluence space.
- **Personal aspects**, including your personal profile and homepage.
- Setting up your user profile.
- **User access**, including permissions and page restrictions.
- Add-ons such as gadgets and macros.
- Customisations for specific uses of Confluence.

**Related pages:**

- Configuring Confluence
- Configuring Confluence Security
- Confluence User's Guide
- Managing Add-ons or Plugins

### Personal Customisations

There are several ways that you can customise the way that Confluence works for you, including:
User Profile Overview

Each Confluence user has a user profile. In your own profile, you can access account management features and updated information about yourself. You can also view other users' profiles.

**To find your user profile:**

Choose your profile picture at top right of the screen, then choose Profile.

Or, choose the Profile link in the sidebar of your personal space.

**To find someone else's user profile:**

1. Open the user's hover profile popup:
   - Log in to Confluence, if you have not already done so.
   - Note: If a Confluence Administrator has granted the 'View User Profiles' permission to anonymous users, you can access people's hover profile popups without logging in. However, the hover profile features available to anonymous users are restricted.
   - Move your mouse pointer over a user's linked name or profile picture. The hover profile popup will appear.
2. Choose the user's linked name to open the user profile.

Alternatively, you can choose the Profile link in the sidebar of the user's personal space or go directly to this URL:

```
http://MY.CONFLUENCE.COM/users/viewuserprofile.action?username=USERNAME
```

**Screenshot: User profile screen for the current user**
Profile

- View and edit your personal details, such as your name and email address details and optionally, your photograph and other personal information. Note that as a security precaution, in order to change your email address, you will be required to re-enter your password.
- Upload a profile picture (optional).
- Change your password.

Network

- View the recent activity of users that you are following via the Network view.
- Follow other users from this view.

Status Updates

- View your history of status updates.

Favourites

- View a list of your favourite spaces.

Watches

- View a list of the pages and spaces you are currently watching.

Drafts

- Retrieve any pages you were in the process of editing. See Working with Drafts.

Settings

- Edit your General Settings (homepage, language and timezone).
- Subscribe to email notifications.
- View and revoke your OAuth access tokens.

Notes

The 'Administer User' link is visible to Confluence administrators only. The administrator can click this link to go directly to the user management screen in the Administration Console.

Changing Password

To change your Confluence password:

1. Choose your profile picture at top right of the screen, then choose Profile.
2. On your Profile tab, click Password in the left-hand column.
3. Enter your current password and your new password in the form displayed.
4. Click Submit.

Related Topics

Viewing User Profile
Editing Your User Profile
Choosing a Profile Picture
Setting Up your Personal Space
Updating Email Address
Email Address Privacy

Take me back to the Confluence User’s Guide.

Editing User Settings

You can set various Confluence preferences that affect your personal session:

- General preferences such as home page, language and time zone, as described below.
- Editor settings, as described below.
- Email settings for subscriptions to email reports. See Subscribing to Email Notifications of Updates to Confluence Content.
- OAuth access tokens that you have granted from your Confluence user account. See Viewing and Revoking OAuth Access Tokens.

General User Preferences

To edit your general user settings:

1. Choose **your profile picture** at top right of the screen, then choose **Settings**.
2. Click **Edit** and update the settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Homepage</td>
<td>Select the page that you would like to see whenever you log into Confluence.</td>
</tr>
<tr>
<td>Language</td>
<td>Select your language. See <strong>below</strong>.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Select your time zone.</td>
</tr>
<tr>
<td>Use Keyboard Shortcuts</td>
<td>Enable keyboard shortcuts, other than for the editor.</td>
</tr>
<tr>
<td>Text select</td>
<td>Turn off the popup options panel when highlighting text.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

On this page:
- General User Preferences
- More about Language
- Editor Preferences

Related pages:
- Editing Your User Profile
- Choosing a Profile Picture
- Setting Up your Personal Space
- Email Address Privacy
- Using Autocomplete
- Confluence User's Guide

Screenshot: Editing your user profile settings
More about Language

Setting your language preference in your user profile is described in the section above. This section gives more information about that setting and other settings that affect the language Confluence will use.

Individual users can choose the language that Confluence will use to display screen text and messages. Note that the list of supported languages depends on the language packs installed on your Confluence site.

The language used for your session will depend on the settings below, in the following order of priority from highest to lowest:

- The language preference defined in your user profile. Note that you need to be logged in for this setting to take effect.
- The language that you choose by clicking an option at the bottom of the Confluence login screen. Confluence stores this value in a cookie. When the cookie expires, the setting will expire too.
- The language set in your browser. The browser sends a header with a prioritised list of languages. Confluence will use the first supported language in that list. Your Confluence administrator can disable this option by setting a system property.
- The default language for your site, as defined by your Confluence site administrator.

Editor Preferences

You can set some options that determine the way the Confluence editor works. Note that these settings affect only you. Other people using Confluence can enable or disable the settings on their user profiles independently.

To change your editor preferences:

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Click Editor under 'Your Settings' in the left-hand panel.
3. Click Edit.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
4. Click **Submit**.

**Screenshot: User settings for the editor**

**Editing Your User Profile**

Your user profile contains basic information about you. If you do not have a personal space, your user profile will be displayed when anyone clicks your name in the People Directory.

**To edit your user profile:**

1. Choose **your profile picture** at top right of the screen, then choose **Profile**. Or, choose the **Profile** link in the sidebar of your personal space.
2. Choose **Edit Profile**.
3. Enter details about yourself in the form displayed.
4. Click **Save**.

**Related pages:**

- Viewing User Profile
- Choosing a Profile Picture
- Setting Up your Personal Space
- Email Address Privacy
- Confluence User's Guide

<table>
<thead>
<tr>
<th>Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Name</td>
<td>Your name as you would like it to appear in your profile.</td>
</tr>
<tr>
<td>Email</td>
<td>Your email address which will be used to send you mail notifications.</td>
</tr>
<tr>
<td>Phone</td>
<td>Your phone number.</td>
</tr>
</tbody>
</table>
| **IM**     | Your Instant Messenger (IM) details.  
|           | To suit a variety of IM applications, this option accepts any string value. For example, you can enter IM details in the form of an email address, such as ‘or a user ID, like ‘123456789’. |
| **Website** | Your website’s URL. |
| **About me** | Information about yourself that other users can view (such as your professional information, hobbies, and other interests). You can use Confluence wiki markup in this field. |
| **Position** | The title of your position within your organisation. |
| **Department** | The name of your department within your organisation. |
| **Location** | Your location. This could be a town, city, region or country. |

**Handy Hint**
Confluence administrators can configure Confluence to mask email addresses (e.g. 'example at atlassian dot com'), protecting your email address from search engine spiders and the like.

Email Address Privacy

Confluence can mask the email addresses of users to protect them from mail spammers.

This is done by a Confluence administrator and is configured through the Administration Console. The Confluence administrator has three options for email address privacy:

- **Public**: email addresses are displayed publicly.
- **Masked**: email addresses are still displayed publicly, but masked in such a way to make it harder for spam-bots to harvest them.
- **Private**: only Confluence administrators can see the email addresses.

For more information on setting these options, which are configured using the Administration Console, refer to User Email Visibility.

**Related pages:**
- Editing Your User Profile
- Viewing User Profile
- User Email Visibility
- Confluence User's Guide

Updating Email Address

The email address you specify in your profile settings is used for your mail notifications and is also displayed in your profile description.

**To update your email address:**

1. Choose your profile picture at top right of the screen, then choose Profile.
2. Click Edit in the ‘Personal’ section.
3. In the Email field, specify your new email address which will be used when sending you mail notifications.
4. Click Save.

Related Topics
- Changing Password
- Editing Your User Profile

Take me back to the Confluence User's Guide.

Choosing a Profile Picture

Your profile picture is used as the icon for your personal space, to represent you in the People Directory, and to illustrate your comments. It also appears in various other places next to your name, such as in the list of recent updates on the dashboard.

You can upload your own profile picture or use one of the images provided by Confluence. If you upload your own profile picture, you will have an opportunity to crop (trim) the picture.

**To choose a profile picture:**
1. Choose your profile picture at top right of the screen, then choose Profile.
2. Click Picture on the left.
3. Choose one of the following two options:
   - Upload a new picture: Click Browse to locate your picture, then click Upload to upload it from your computer or file server.
   - Or select one of the default icons provided.
4. Click Set Profile Picture.

On this page:

Related pages:
- Deleting a Profile Picture
- Editing Your User Profile
- Setting Up your Personal Space
- Confluence User's Guide

Screenshot: Choosing a profile picture

If you upload a profile picture that is larger than 48x48 pixels, the 'Edit My Profile Picture' screen will appear. You can select part of the picture or the entire picture, to be used as the final image for your profile. Note that the size of the final image will always be scaled down to 48x48 pixels.

To edit your profile picture:

1. Click and drag the centre of the superimposed square to select the centre of the new image.
2. Click the corners of the square to resize the area for your new image.
3. Click Save.
4. The image from your selected area will be cropped, resized to 48x48 pixels and saved.

Screenshot: Trimming a profile picture
Deleting a Profile Picture

You can delete the profile picture images that you have uploaded to Confluence.

To delete a profile picture:

1. Choose your profile picture at top right of the screen, then choose Profile.
2. Click Picture on the left.
3. Locate and select the picture file you wish to delete, then click Delete.
   - Note that you can only delete images that you have uploaded to Confluence. The standard icons cannot be deleted.
4. Click Delete to confirm the action. The picture is permanently removed from the server.

Related pages:
- Choosing a Profile Picture
- Editing Your User Profile
- Setting Up your Personal Space
- Confluence User’s Guide.

Screenshot: Deleting a Profile Picture
Viewing User Profile

Each Confluence user has a user profile. In your own profile, you can access account management features and update information about yourself. You can also view other users’ profiles, add them to your network, and add their personal spaces to your list of favourites.

To find your user profile:

Choose your profile picture at top right of the screen, then choose Profile.

Or, choose the Profile link in the sidebar of your personal space.

To find someone else's user profile:

1. Open the user's hover profile popup:
   - Log in to Confluence, if you have not already done so. Note: If a Confluence Administrator has granted the 'View User Profiles' permission to anonymous users, you can access people’s hover profile popups without logging in. However, the hover profile features available to anonymous users are restricted.
   - Move your mouse pointer over a user’s linked name or profile picture. The hover profile popup will appear.
2. Choose the user's linked name to open the user profile.

Alternatively, you can choose the Profile link in the sidebar of the user's personal space or go directly to this URL:

http://MY.CONFLUENCE.COM/users/viewuserprofile.action?username=USERNAME

Related pages:

- User Profile Overview
- Setting Up your Personal Space
- Confluence User's Guide

Screenshot: User profile for the current user.

Updating your profile

You can update the following aspects of your profile from this view:

- Information about yourself – see Editing Your User Profile.
- Your Profile picture – see Choosing a Profile Picture.
- Your login password – see Changing Password.
Viewing and Revoking OAuth Access Tokens

This page describes the purpose of OAuth access tokens which have been issued on behalf of your Confluence user account and provides instructions on how to revoke them.

On this page:
- OAuth Access Tokens
- Viewing your OAuth Access Tokens
  - OAuth Access Token Details
- Revoking your OAuth Access Tokens

OAuth Access Tokens

OAuth access tokens allow you to use a Confluence gadget on an external web application or website (also known as the ‘consumer’) and grant this gadget access to Confluence data which is restricted or privy to your Confluence user account.

OAuth access tokens will only appear in your user profile if the following conditions have been met:

1. Your Confluence Administrator has established an OAuth relationship between your Confluence site and the consumer. Confluence Administrators should refer to Configuring OAuth for more information about establishing these OAuth relationships.
2. You have accessed a Confluence gadget on the consumer and have conducted the following tasks:
   a. Logged in to your Confluence user account via the gadget and then,
   b. Clicked the ‘Approve Access’ button to allow the gadget access to data that is privy to your Confluence user account.

   Confluence will then send the consumer an OAuth ‘access token’, which is specific to this gadget. You can view the details of this access token from your Confluence site’s user account.

An OAuth access token acts as a type of ‘key’. As long as the consumer is in possession of this access token, the Confluence gadget on the consumer will be able to access Confluence data that is both publicly available and privy to your Confluence user account. As a Confluence user, you can revoke this access token at any time. Furthermore, all access tokens expire after seven days. Once the access token is revoked or has expired, the Confluence gadget will only have access to publicly available Confluence data.

Viewing your OAuth Access Tokens

To view all of your Confluence user account’s OAuth access tokens:

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Click View OAuth Access Tokens. A view similar to screenshot below is displayed. Refer to OAuth Access Token Details below for information on interpreting this table.

   If no access tokens have been set, then ‘None specified’ is shown.

Screenshot: Viewing your OAuth Access Tokens

<table>
<thead>
<tr>
<th>Consumer</th>
<th>Consumer Description</th>
<th>Issued on</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atlassian JIRA</td>
<td>Special Projects Atlassian JIRA at <a href="https://atlassian.com/jira">https://atlassian.com/jira</a></td>
<td>Jan 23, 2013 expires in 1,801 days</td>
<td>Revoke Access</td>
</tr>
</tbody>
</table>

OAuth Access Token Details

Your list of OAuth access tokens is presented in a tabular format, with each access token presented in separate rows and each property of these tokens presented in a separate columns:
### Column Name | Description
---|---
Consumer | The name of the Confluence gadget that was added on the consumer.
Consumer Description | A description of this consumer application. This information would have been obtained from the consumer's own OAuth settings when an OAuth relationship was established between Confluence and that consumer. If the consumer is another Atlassian application, this information is obtained from the Consumer Info tab's 'Description' field of the OAuth Administration settings. The application's administrator can customise this Consumer Info detail.
Issued On | The date on which the OAuth access token was issued to the consumer by Confluence. This would have occurred immediately after you approved this gadget access to your Confluence data (privy to your Confluence user account).
Expires On | The date when the OAuth access token expires. This is seven days after the 'Issued On' date. When this date is reached, the access token will be automatically removed from this list.
Actions | The functionality for revoking the access token.

#### Revoking your OAuth Access Tokens

**To revoke one of your OAuth access tokens:**

1. View your Confluence user account's OAuth access tokens (described above).
2. Locate the Confluence gadget whose OAuth access token you wish to revoke and click **Revoke OAuth Access Token** next to it.
   The gadget's access token is revoked and the Confluence gadget on the consumer will only have access to publicly available Confluence data.

#### Choosing your Home Page

By default, all users are directed to the dashboard after logging in. However, you can choose to be redirected to the home page of any space on the Confluence site after logging in.

**To set the home page:**

1. Choose your profile picture at top right of the screen, then choose **Settings**.
2. Choose **Edit**.
3. Choose a page from the **Site Homepage** drop down. Only spaces for which you have 'view' access display. You will be directed to the home page of the selected space when you next log in.
4. Click **Submit**.

**Related pages:**

- User Profile Overview
- Confluence User's Guide

**Screenshot: Profile Settings**
Customising your Personal Dashboard

You can customise the Confluence dashboard to provide access to the content on the site that is most relevant to you. The options described on this page will change your own personal dashboard, but will not affect the dashboard that other people see.

If you have System Administrator permissions, you can change the global dashboard, as seen by all Confluence users. See the administrator's guide to customising the dashboard.

Displaying your favourite spaces

Mark some spaces as favourites. You can now choose the Spaces tab on the dashboard to see a list of your favourite spaces. You can also choose the Favourite Spaces tab at the top right of the dashboard to see recently updated content from just your favourite spaces.

Categorising your spaces

To help keep Confluence spaces organised, you can label spaces with different space categories. See Using Labels to Categorise Spaces. Space categories are used to group related spaces.

For example, you might want to group spaces on your Confluence site by applying the following space categories to the relevant spaces:

- 'design' (for spaces relevant to a design team), and
- 'development' (for spaces relevant to a development team).

If a subset of these spaces is relevant to both teams, apply both the 'design' and 'development' categories to each of these spaces to make the spaces appear in both groups.

Once you have added space categories, you can choose the Space Categories tab at the top right of the dashboard and select a category from the drop-down menu to display only spaces belonging to that category.
Displaying your favourite pages

Mark some pages as favourites. You can now choose the **Pages** tab on the dashboard to see a list of your favourite pages.

Screenshot: The dashboard, showing favourite pages and space categories

Customising the Look and Feel of a Confluence Space

You can customise the 'look and feel' of a space on your Confluence site through options available in the **Space Administration** menu. By default, the look and feel of a space is based on site-wide settings configured from the **Administration Console**.

You need to be a **space administrator** to change the look and feel of a space.

- Applying a Theme to a Space
- Configuring a Sidebar
- Changing a Space's Logo
- Customising Space Layouts
- Editing a Space's Colour Scheme
- Styling Confluence with CSS
Applying a Theme to a Space

Themes allow you to personalise the 'look and feel' of Confluence. You can apply a theme to your entire Confluence site or to individual spaces. Choose a specific theme if you want to add new functionality or significantly alter the appearance of Confluence.

Confluence comes with a selection of themes. In addition, a site administrator can install new themes as plugins via the Confluence Administration Console. Provided that the theme is installed into your Confluence site, any space administrator can apply a theme to a space.

By default when you create a new space, the space will have the Confluence default theme.

To apply a theme to a space:

1. Go to the space and choose Space tools > Look and Feel on the sidebar. You'll need Space Admin permissions to do this.
2. Choose Themes and select a theme option.
3. Choose Confirm.

Want to customise Confluence or make it even more beautiful? Try a Confluence theme from the Atlassian Marketplace.
If your space is using the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen. **Note:** The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose **Themes** from the space administration options.
3. Select a theme option.
4. Choose **Confirm**.

**Configuring the Documentation Theme**

The Documentation theme is one of the themes bundled with Confluence.

**Advance warning of plans to merge Documentation theme with the default theme**

This is an advance notice that we plan to merge the functionality of the Confluence Documentation theme with the Confluence default theme. We do not yet have a specific date for this plan, and we are interested in your feedback. The new default theme, introduced with Confluence 5.0, includes a sidebar with contextual navigation. Our plan is to include features from the Documentation theme in the default theme, and then remove the Documentation theme from Confluence.

If you are interested in this change and would like to give us feedback, please add a comment on this blog post: Advance warning of plans to merge Documentation theme with the default theme. We are especially interested to know which features of the Documentation theme you use and value the most.

The Documentation theme is designed for spaces containing technical documentation, but you may find it useful for other types of structured content. It provides a table of contents for your space, a configurable header and footer, and text styles suited to documentation. (See features below.)

**Quick guide to applying and customising the Documentation theme:**

- Go to the space and choose **Space tools > Look and Feel** on the sidebar.
- Choose **Themes**.
- Select **Documentation Theme** and choose **Confirm**.
• If you want to customise the theme, choose Configure theme.
• Select or deselect the default page tree.
• Select or deselect the space-restricted search.
• Enter the text and wiki markup for your custom left-hand panel header and footer.
• Choose Save.

The rest of this page gives more details of the above procedure.

On this page:
• Applying the Documentation theme to your space
• Applying the Documentation theme to your site
• Customising the Documentation theme
  • Customising the theme at site level
• Features of the Documentation theme
• Hints and tips
• Notes

Related pages:
• Using the Documentation Theme
• Space Jump Macro
• Applying a Theme to a Space
• Applying a Theme to a Site
• Editing a Space's Colour Scheme
• Customising the Look and Feel of a Confluence Space
• Confluence User's Guide

Screenshot: The Documentation theme showing the space sidebar replaced by a navigation sidebar.

Applying the Documentation theme to your space

Follow the steps below to apply the Documentation theme to your space. All pages in the space will start using the theme immediately.

To apply a theme to a space:

1. Go to the space and choose Space tools > Look and Feel on the sidebar. You'll need Space Admin permissions to do this.
2. Choose Themes and select a theme option.
3. Choose **Confirm**.

**Screenshot: Applying a theme**

If your space is using the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen. **Note:** The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose **Themes** from the space administration options
3. Select a theme option.
4. Choose **Confirm**.

**Applying the Documentation theme to your site**

If you have **site administrator** permissions, you can apply the theme at site level. It will then be the default theme for all spaces in the site. See the administrator's guide to **applying a theme**.

**Customising the Documentation theme**

The theme works well without any customisation. If necessary, you can restrict the search to just one space, change the content of the left-hand navigation panel and add your own header and footer. The following instructions assume you have already applied the Documentation theme.

**To customise the Documentation theme:**

1. Choose **Browse > Space Admin** at the top of the screen. **Note:** The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose **Themes** in the left-hand panel under the heading 'Look and Feel'.
3. Choose **Configure theme** in the yellow area of the 'Current Theme' section at the top of the page. See screenshot below. The 'Documentation Theme Configuration' screen appears. See screenshot below.
4. Select or deselect the **Page Tree** check box. This determines whether your space will display the default search box and table of contents (page tree) in the left-hand panel.
5. Select or deselect the **Limit search results to the current space** check box.
   - If you select the check box:
     - The Confluence search will look for matches only in the current space by default. Users can override this restriction when entering their search term. See Using the Documentation Theme.
     - The default page tree in the left-hand panel will not include a search box.
   - If you do not select the check box:
     - The Confluence search will look for matches in the entire Confluence site. This is the default behaviour for other themes too.
     - The default page tree in the left-hand panel will include a search box, which restricts search results to the current space.

6. Enter text, images, macros and other wiki markup into any or all of the three text boxes.
   - You can use the **Include** or **Excerpt Include** to include re-usable content into your footer. See hint below.
     - 'Navigation' – This text box contains content for the left-hand panel.
       - If the **Page Tree** check box is selected, the navigation panel contains the default search box and page tree. Any content you enter into the 'Navigation' text box will appear above the page tree and search box.
       - You can include your own content *underneath* the page tree as well as above. See hint below. In summary: Deselect the Page Tree check box. Insert your own page tree using the Page Tree macro, then add your own content under the macro.
     - 'Header' – This text box contains content for a page header that will appear above the page title on all pages in the space. See example screenshot below.
     - 'Footer' – This text box contains content for a page footer that will appear after the comments and above the site footer, on all pages in the space. See example screenshot below.

7. Choose **Save**.

**Screenshot: The 'Configure theme' option**
Current Theme

The current theme controls the layout and colours of this space.

**Documentation Theme**

This theme is well suited for structured content, such as documentation. It features a table of contents (page tree) on the left, making it easier to see the structure of a space and move from page to page. You can customise the left-hand panel, page header and page footer.

*Configure theme* - further customise this theme's options

Choose New Theme

To change the theme of this space, select one below.

- **Global Look and Feel**
  The globally configured look and feel. You can customise colour-schemes and layouts manually.

Find more themes...

Confirm

Screenshot: Customising the Documentation theme
Customising the theme at site level

If you have site administrator permissions, you can apply and customise the theme at site level. The customisation options are the same as the space level options, as described above.

Features of the Documentation theme
The above screenshot shows a wiki space with a customised left-hand panel, header and footer.

Here is a summary of the features that the Documentation theme provides:

- By default, the left-hand panel contains a search box and a table of contents (page tree) showing all the pages in your space. Specifically, it shows the pages that are children of the space’s home page.
- The left-hand panel is fully customisable. You can choose to include or exclude the search box and page tree. You can enter your own text, images and wiki markup.
- People viewing the page can drag the thick bar between the left-hand panel and the content, to increase or decrease the width of the panel. They can also remove the panel altogether, by clicking the sidebar icon at top right, next to the search box.
- The left-hand and right-hand panels scroll independently of each other.
- The page title is neatly above the page content, and not uncomfortably above the navigation panel as tends to happen when you insert the navigation panel yourself.
- Because the left-hand panel is part of the theme, it will be upgraded whenever Confluence is upgraded. There is no need to remove and then re-apply your customisations on each upgrade, as you would do if you added your own left-hand navigation bar.
- The theme also provides a customisable header and footer, which will appear at the top and bottom of every page.
- The text and heading styles are designed to enhance the content typically found in a documentation space.
- You can use the Space Jump macro to link from a page in one wiki space to a page with the same name in another space, without knowing the name of the page when you create the link.
- You can limit the Confluence search results to the current space. If you choose this option, the Confluence search will look for matches only in the current space by default. Users can override the restriction. See Using the Documentation Theme.
Hints and tips

Below are some hints that you may find useful when using the Documentation theme. Where can I see a working example of the Documentation theme?

The Confluence documentation uses the Documentation theme. If you are reading this documentation online on the Atlassian documentation wiki, you are seeing a working version of the Documentation theme.

Which pages will appear in the Documentation theme’s table of contents?

The theme constructs the page tree in the left-hand panel from all pages that are child pages of the space’s home page. Each space has a single page designated as the ‘Home’ page. You can specify the home page in the space administration section.

Help, my pages do not appear in the Documentation theme table of contents

Cause 1: Your pages are not under the space’s home page. The most probable reason why your pages do not appear in the page tree in the left-hand panel is this: The theme constructs that table of contents from all pages that are child pages of the space’s home page. If your pages are above the home page in the page tree, they will not appear in the left-hand panel.

There are two ways to fix the problem:

- You can change the designated space home page in the space administration section.
- Or you can drag and drop all your pages to make them children of the current home page. You can drag and drop pages in the ‘Pages’ section of the space ‘Browse’ screen. See Moving a Page.

Cause 2: Problem with upgrade from Confluence 3.1, with Documentation theme as plugin, to Confluence 3.2 or later with Documentation theme bundled. If your existing Confluence installation already has the Documentation theme plugin installed, you may find that after upgrading to Confluence 3.2 the left-hand navigation bar is empty in the spaces that use the theme. The fix is to enable all modules of the Documentation theme plugin. See the knowledge base article.

Help, my left-hand panel has disappeared

If your entire left-hand panel has disappeared when using the Documentation theme, this is probably because you have clicked the sidebar icon at top right, next to the search box. Click the icon again to restore the panel.

Can I change the default width of the left-hand navigation panel?

The Confluence user interface does not offer a way to change the default width of the left-hand navigation panel supplied by the Documentation theme. Users can change the width by dragging the middle bar, but the default width is not configurable. This post on Atlassian Answers gives a way to do it with CSS: Documentation Theme - Default Width (in px) of left panel.

Hiding pages from the left-hand table of contents

You can 'hide' pages by putting them at the same level as or higher than the space home page.

Each space has a single page designated as the ‘Home’ page. You can specify the home page in the space administration section.

The theme constructs the page tree in the left-hand panel from all pages that are child pages of the space’s home page.

If your documentation pages are at the same level as the space home page, they will not appear in the left-hand navigation bar. So you can 'hide' pages by putting them at the same level as or higher than the space home page. The pages will show up in the search results and people can see the content if they open the page, but the pages will not appear in the left-hand panel.

More detail: The theme uses the Pagetree macro to produce the table of contents. When entering the Pagetree macro, you can choose the top page in the page tree. The Documentation theme chooses the space home page as the top page.

Using reusable content in your header, footer or sidebar

You can use any text or wiki markup in your theme header, footer or left-hand panel. One useful hint is to use the Include or Excerpt Include to include re-usable content into your footer.
The screenshot above shows the theme customisation options, with examples of the macros used to include content from other pages. And the example screenshot also above shows the resulting header, footer and left-hand panel.

Adding content below the page tree in your sidebar

If you want to include your own content underneath the page tree, you can deselect the 'Page Tree' check box, add your own page tree using the Pagetree macro in the 'Navigation' text box, and then add your own content under the macro.

The screenshot above shows the theme customisation options, with the default page tree deselected and a custom page tree inserted, along with additional content in the left-hand panel. The example screenshot also above shows the resulting left-hand panel.

Adding an expanding All Versions section to the sidebar

If you want to include a an expanding list of links to other spaces, as we have included in this space (see 'Docs for all Confluence releases' in the sidebar), you can use an Expand Macro and an Include Page Macro in the 'Navigation' text box.  For example:

```
*{Docs for all Confluence releases|_Latest Versions of Confluence Documentation}* 
{expand:Choose a version...} 
{include:_Latest Versions of Confluence Documentation} 
{expand}
```

If you would like this to display below the page tree, follow the steps above.

Adding underlines to your links

By default, the Documentation theme does not underline hyperlinks. If you prefer to have your links underlined, you can edit the CSS stylesheet for your space and add the following CSS code:

```
.wiki-content a:link, .wiki-content a:visited, .wiki-content a:active {
  text-decoration: underline;
}
```

To edit a space's CSS style sheets:

1. Go to the space and choose Space tools > Look and Feel on the sidebar.
2. Choose Stylesheet then Edit.
3. Paste your custom CSS into the text field.
4. Save your changes. The new CSS will be visible on all content pages in the space.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Click Stylesheet in the left-hand panel under the heading 'Look and Feel'.
3. Choose Edit.
4. Paste your custom CSS into the text field.
5. Save your changes. The new CSS will be visible on all content pages in the space.

Notes:

- You need system administrator permissions to edit the CSS for a space or for the site.
- This function is turned off by default. To turn it on, go to General Configuration > Security Configuration and choose Custom Stylesheets for Spaces.

Jumping to the same page in another space

The {spacejump} macro is provided along with the Documentation theme. You can use space jumping to link from a page in one wiki space to a page with the same name in another space, without knowing the name of the page when you create the link. When a reader is viewing a page and chooses the link provided by the macro,
they will go to a page with the same name, but in the space specified in the macro. See more about the Space Jump macro.

Hiding the left-hand panel completely

It's not possible to remove the left-hand panel entirely, using the user interface supplied by the theme. There is an improvement request here:

[CONF-25923 - Provide option to hide the left-hand panel entirely in the Documentation theme] RESOLVED

If you like, you can comment on and/or vote for that request. In the meantime, Atlassian Answers is a good place to ask the question and see if other people can help you with custom code to remove the panel.

Notes

- The Confluence default theme supplies a sidebar, which is different to the left-hand panel in the Documentation theme. For information about the sidebar, see Finding Content and Configuring a Sidebar.
- The Documentation theme supplies a Browse menu in the Confluence header, which gives access to the space administration and advanced options.

Configuring a Sidebar

The default theme and documentation theme in Confluence both feature a left sidebar.

This page outlines how to customise the sidebar in the default theme. To find out how to customise the sidebar in the Documentation theme, see Configuring the Documentation Theme.

You need space administrator permissions to configure the sidebar. See Space Permissions. Any changes you make to the sidebar will be visible to all Confluence users viewing that space.

To configure a space's sidebar:

1. Go to the space and from the bottom of the sidebar choose Space tools > Configure sidebar.
2. Change the space name and/or space logo:
   - Choose the edit icon next to the space name.
   - Type in a space Name.
   - Browse to find an image for the space Logo, and crop the image to the required size.
   - Choose Save.
3. Configure the Pages and Blog links:
   - Choose the icons to hide or show the 'Pages' or 'Blog' link. For example, you may want your space to be used primarily as a blog (hide the 'Pages' link) or you may not need a blog in your space (hide the 'Blog' link).
   - Drag the links to a different sequence within the section. Note that you cannot move a link from one section to another.
   - Note that add-ons may add other links in this section of the sidebar. For example, the Team Calendars add-on may put a link in this location.
4. Add or remove the shortcut links:
   - Choose Add link to add a shortcut link to the sidebar. This can be a link to an important page for your team, or to an external site, for example.
   - Choose the icon to remove a shortcut link.
   - Drag the links to a different sequence within the section. Note that you cannot move a link from one section to another.
   - Choose the hide or show icon beside the 'Space Shortcuts' heading to show or hide all shortcuts on the sidebar.
5. Change the navigation display options:
   - Choose Child pages to see the current page and its children in the sidebar.
   - Choose Page tree to see the page tree for the entire space, expanded to the current page.

Related pages:
- Finding Content
- Administering a Space
- Confluence User’s Guide

Screenshot: Configuring a space’s sidebar
Notes

The default theme and Documentation theme both feature a sidebar. If you are using a third party theme it may not feature a sidebar.

Changing a Space's Logo

In Confluence, you can replace the default logo for a space with an image of your choice. The instructions below apply to site spaces. For your personal space, your profile picture is used as the space icon.

You need to be a space administrator to replace a space's logo.

To change a space's logo, in spaces using the default theme:

1. Go to the space and from the bottom of the sidebar choose Space tools > Configure sidebar.
2. Choose the edit icon next to the space name.
3. Choose Choose File.
4. Browse to find and upload an image.
5. Adjust the size of the image to fit within the highlighted circle.
6. Choose Save.

To change a space's logo, in spaces using the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose Change Space Logo in the left-hand panel.
3. Use the browse option to locate the new logo and choose Upload.

Related pages:

- Configuring a Sidebar
- Customising the Look and Feel of a Confluence Space

Screenshot: Changing a space logo in the default theme
Notes

- **Minimum dimensions**: Space logos are set at 48 x 48px. Logos less than these dimensions will be centred with whitespace around them.
- **Space logos in the default theme are circular.**
- **Dimensions of image when using the Documentation theme**: The documentation theme does not provide an option to resize or crop your image. Uploading a square image will give the best results.

**Customising Space Layouts**

You can modify Confluence’s look and feel by editing the layout files. This page tells you how to customise the layout files for a space. You will require need space administrator permissions for that space.

Confluence system administrators can also customise the layout of their entire Confluence site as a whole. For more information, please refer to [Customising Site and Space Layouts](#). Site layout customisations modify the default layout of all spaces in the Confluence site.

Any space layout customisations will override the equivalent site customisations.

**Warning**

If you modify the look and feel of Confluence by following these instructions, you will need to update your customisations when Confluence is upgraded. The more dramatic the customisations are, the harder it will be to reapply your changes when upgrading. Please take this into account before proceeding with any customisations.

For more information on updating your customisations, please refer to [Upgrading Customised Site and Space Layouts](#).
Confluence is built on top of the Open Source SiteMesh library, a web-page layout system that provides a consistent look and feel across a site. SiteMesh works through ‘decorators’ that define a page’s layout and structure.

To edit the layout of Confluence, you will need to modify these decorator files. A decorator file is a .vmd file and is written in a very simple programming language called Velocity. Learn more about Velocity. Once you become familiar with Velocity, you can edit the decorator files to personalise the appearance of Confluence.

The decorator files in Confluence are grouped into the following categories:

- **Site layouts**: These are used to define the controls that surround each page in the site. For example, if you want to make changes to the header and the footer, you will need to modify these layouts.

- **Content layouts**: These control the appearance of content such as pages and blog posts. They do not change the way the pages themselves are displayed, but they allow you to alter the way the surrounding comments or attachments are shown.

- **Export layouts**: These control the appearance of spaces and pages when they are exported to HTML. If you are using Confluence to generate a static website, for example, you will need to modify these layouts.

Learn more about using decorators.

To edit a decorator file:

1. Go to the space and choose Space tools > Look and Feel on the sidebar.
2. Choose Layout (Layout is displayed only if you are a Confluence system administrator.)
3. You will see a list of the layouts for the space.
   - Click View Default to view the vmd file.
   - Click Create Custom to edit the default vmd file. This will open up the vmd file in edit mode.
     Make changes and click Update.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The ‘Space Admin’ option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose Layout in the left-hand panel (Layout is displayed only if you are a Confluence system administrator.)
3. You will see a list of the layouts for the space.
   - Click View Default to view the vmd file.
   - Click Create Custom to edit the default vmd file. This will open up the vmd file in edit mode.
     Make changes and click Update.

**Screenshot : Edit Layouts Example**

<table>
<thead>
<tr>
<th>Decorator</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Space Export Layout</strong></td>
<td>&lt; default &gt; - Create custom - View Default</td>
</tr>
<tr>
<td><strong>Page Export Layout</strong></td>
<td>&lt; default &gt; - Create custom - View Default</td>
</tr>
</tbody>
</table>
Editing a Space's Colour Scheme

Confluence allows you to customise the colour scheme of a space. By default, a space's colour scheme is based on global settings configured from the Administration Console.

You need to be a space administrator to edit a space's colour scheme.

To change the colour scheme for a space:

1. Go to the space and choose Space tools > Look and Feel on the sidebar.
2. Choose Colour Scheme.
3. Choose Select next to a scheme listed under Custom Colour Scheme (if not already selected).
4. Choose Edit.
5. Enter standard HTML/CSS2 colour codes, or use the colour-picker to choose a new colour from the palette provided. Any changes you make will immediately be reflected in this space.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose Colour Scheme under the heading Look and Feel.
3. Follow the steps above to select a custom colour scheme and edit the colours.

The colour scheme allows you to edit the colours of UI elements including the top bar, tabs and backgrounds.

Some UI elements below are for specific themes, and colour changes may not take effect for other themes.

- **Top Bar** - the top navigation bar background
- **Top Bar Text** - the text on the top navigation bar
- **Header Button Background** - buttons on the top navigation bar (e.g. Create button)
- **Header Button Text** - the text on buttons on the top navigation bar
- **Top Bar Menu Selected Background** - background colour of top navigation bar menu items when selected (e.g. spaces)
- **Top Bar Menu Selected Text** - text colour of top navigation bar menu items when selected
- **Top Bar Menu Item Text** - text on top navigation bar drop down menus (e.g. help or cog)
- **Menu Item Selected Background** - highlight colour on top navigation bar drop down menu items
- **Menu Item Selected Text** - text colour on highlighted top navigation bar drop down menu items
- **Page Menu Selected Background** - the background colour of the drop down page menu when selected
- **Page Menu Item Text** - the text of the menu items in the drop down page menu
- **Heading Text** - all heading tags throughout the space
• **Space Name Text** - the text of the current space name located above the page title
• **Links** - all links throughout the space
• **Borders and Dividers** - table borders and dividing lines
• **Tab Navigation Background** - the background colour of the tab navigation
• **Tab Navigation Text** - the text of the tab navigation when highlighted
• **Tab Navigation Background Highlight** - the background colour of the tab navigation when highlighted
• **Tab Navigation Text Highlight** - the text of the tab navigation elements when highlighted

*Screenshot: Editing the colour scheme*
Styling Confluence with CSS

**Handy Hint**
If you mess things up, just choose **Reset** then try again.
This page explains the facility for changing the look and feel of Confluence with CSS.

**Introduction**

Cascading Style Sheets (CSS) are an industry-standard way of styling a web page. The content of a page is rendered with HTML, and its look and feel is determined by CSS files. You can upload a CSS text file, or simply type in a stylesheet, and apply it to a space or even a whole Confluence site.

Notes:
- You need **system administrator** permissions to edit the CSS for a space or for the site.
- This function is turned off by default. To turn it on, go to > General Configuration > Security Configuration and choose **Custom Stylesheets for Spaces**.

Creating CSS styles that work seamlessly across different browsers is a delicate task for basic web sites, and reasonably challenging when customising web applications like Confluence. It is important to test each change that you make and ensure it works as expected in all areas of Confluence – for example, on the Confluence dashboard as well as on regular pages.

In order to get you started, we have compiled this introduction, a **basic styling tutorial**.

**Considerations for Using Custom CSS**

CSS Knowledge is Required

If you are not familiar with CSS, see the links in the CSS Resources section below. You should spend some time to become confident with Cascading Style Sheets before you start editing your Confluence style sheets.

Security

Custom CSS can be used to inject scripts into a page, opening the risk of cross-site scripting (XSS) attacks. With this feature enabled, space administrators could upload styles that steal other users’ login credentials, trick their browsers into performing actions on the wiki without their knowledge, or even obtain global administration privileges. As such, this feature is disabled by default. Confluence administrators should only enable custom CSS if they are comfortable with the risks listed in this paragraph.

Scaling

Each page needs to scale. Depending on the resolution of the user's screen, the content should render intelligently. Your designs needs to degrade gracefully. Try resizing each page that exists in Confluence. There are quite a few pages in the browse-space-section, like drafts, labels, page hierarchy, and so on. Your style has to work everywhere, not just in the first page you happen to be looking at.

Features Cannot Be Disabled

It is easy to turn off certain links, headers, or even menu items by simply setting their style to 'hidden'. This can help you to roll out Confluence to users that may not be very Wiki-savvy yet. The simpler the UI, the easier it may be for them to use. However, please remember that removing the link to a part of the application does not mean that the functionality is not available. Every user can still change their style from within their browsers, or access the URL directly. Don't rely on CSS to disable parts of Confluence.
Features Should Not Be Disabled

Users familiar with Confluence will expect to find the same controls that they are accustomed to. Removing buttons or controls from the interface is not advised as it may frustrate your users and cause them to circumvent your design by using direct URL access, as mentioned above.

Custom CSS does not apply to Admin screens

Any CSS styling applied to your site will not be applied to the Administration console. This is to ensure changes to CSS do not prevent administrators from accessing Admin functions in future.

Confluence Version Compatibility

Be aware of any plans to upgrade your Confluence instance. Future versions of Confluence may not be compatible with your custom CSS — this may cause your CSS to break, requiring maintenance when Confluence is upgraded. Ask your Confluence administrator for more information.

Test on Different Web Browsers

As a rule you should test your modifications on different web browsers. Internet Explorer, Firefox, Opera and Safari (on Mac OS X) are some of the more popular browsers.

Note about supported web browsers: Please ensure that you are using one of the web browsers supported by Confluence. If you are using an unsupported browser or browser version, some features may not work correctly. Check the Supported Platforms page to find the list of supported web browsers and browser versions on this page.

CSS Customisation is Not Supported

As creating custom CSS has potentially limitless possibilities, Atlassian will not support issues that are caused by or related to CSS customisation.

Getting Started

Editing the CSS

To edit a space's CSS style sheets:

1. Go to the space and choose Space tools > Look and Feel on the sidebar.
2. Choose Stylesheet then Edit.
3. Paste your custom CSS into the text field.
4. Save your changes. The new CSS will be visible on all content pages in the space.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Click Stylesheet in the left-hand panel under the heading 'Look and Feel'.
3. Choose Edit.
4. Paste your custom CSS into the text field.
5. Save your changes. The new CSS will be visible on all content pages in the space.

To edit your global CSS stylesheet:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Stylesheet.
3. Choose Edit.
4. Paste your custom CSS into the text field.
5. Choose Save.

Note:

- The new CSS will be visible across all spaces, provided they do not define their own custom stylesheet and are not using a theme. This CSS will also overwrite all styles defined in custom global themes.
- You may be able to add CSS to your site by choosing Custom HTML in the administration section, and adding your CSS definitions to the HEAD or BODY of the page. You should only use this option if you cannot achieve the desired results via the global stylesheet.

Follow the Tutorial

Follow the examples in the Basic Styling Tutorial to get started.
CSS Resources

- W3C CSS Standards
- W3schools CSS Introduction
- Mozilla Developer Network
- W3resource.com

Basic Styling Tutorial

This page contains instructions on how to get started with custom CSS styling in Confluence.

CSS Editing Quick-Start

To edit a space’s CSS style sheets:

1. Go to the space and choose Space tools > Look and Feel on the sidebar.
2. Choose Stylesheet then Edit.
3. Paste your custom CSS into the text field.
4. Save your changes. The new CSS will be visible on all content pages in the space.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Click Stylesheet in the left-hand panel under the heading 'Look and Feel'.
3. Choose Edit.
4. Paste your custom CSS into the text field.
5. Save your changes. The new CSS will be visible on all content pages in the space.

On this page:
- CSS Editing Quick-Start
- Tutorial: Changing the Header Background
- CSS Editing Tips
- Notes

Related pages:
- Styling Confluence with CSS
- Confluence User’s Guide

⚠️ The information on this page does not apply to Confluence Cloud.

Tutorial: Changing the Header Background

The header is the menu area at the top of a default Confluence page where the Breadcrumb Links, Browse menu, User menu and the Quick Search box reside. In this example, we are going to change the background of the header to include a custom graphic.

1. Create a custom graphic. For this example, we created a custom header graphic of 1046 x 61 pixels.
2. Upload the custom graphic to a page in the space that you are customising.
3. Note the page ID of the page where you uploaded the new graphic. (in this example, the page ID was '658833839'.
4. Compose your custom CSS for the header. The example below loads the new graphic (called 'header.png') from a specific page (denoted by page ID '658833839') in the same space.

```css
#header .aui-header {
    background-image: url('..download/attachments/658833839/header.png');
    background-repeat: no-repeat;
}
```

5. Log in as the Space Administrator.
6. Open the Space Admin page.
7. Click **Stylesheet**.
8. Click **Edit** to change the code in the text field.
9. Paste your custom CSS into the text field.
10. Click **Save** and then reload the page (you may have to shift-reload). The background of the header will change.
11. The custom header will be visible on all content pages in the space. To revert your change, simple delete the custom code from the 'Stylesheet' page and click **Save**.

**CSS Editing Tips**

**Begin With a Space Stylesheet**

A space stylesheet is a good starting point for CSS customisation, as it already includes all of the elements that can be changed. When you work on the space stylesheet it styles all content pages in the space. Build and test it at space-level, before considering applying the new stylesheet to your entire site. Once you are satisfied with your space design, test it thoroughly until you are confident that it has no problems. Then, you can look into advanced customisation of the Confluence CSS such as adjusting the Search page, the Dashboard and other integral pages.

**Use the Right Tools**

As the Confluence CSS is reasonably sophisticated, web development applications will help you to understand how the page styles have been created. In particular, you will need to view the existing source for the pages you're starting to work on. If you don't already have some, tools such as the following free applications will allow you to do this.

1. **Firebug**
   Firebug, a plugin for the Firefox web browser, allows you to take a look at the style of each element on your page. This is very useful to see what styles are currently applied, for example styles applied to the header only.

2. **Web Developer**
   The Web Developer plugin for Firefox allows you to edit CSS inline and create new page designs.

3. **CSS Edit**
   CSS Edit is a stand-alone CSS editor for Macintosh that extracts all existing styles from a given page and allows you to overwrite these.

**Edit Simple Elements First**

Begin by editing simple elements and checking that they work. By making changes, then checking that each one worked, you can easily isolate any CSS code that is causing problems. Be aware that some page elements are more suited to customisation than others. For example, adding a gradient to the toolbar is less likely to 'break' the page than changing the page width. Editing reasonably static elements such as background graphics will render more predictably than designs which attempt to completely change the user interface or the Javascript-powered drop-down menus (which we don't recommend editing).

**Notes**

Notes:

- You need **system administrator** permissions to edit the CSS for a space or for the site.
- This function is turned off by default. To turn it on, go to **General Configuration** > **Security Configuration** and choose **Custom Stylesheets for Spaces**.

**Styling Fonts in Confluence**

Confluence provides the ability to adjust its visual style via Cascading Style Sheets (CSS). This tutorial shows you to change the fonts and font sizes of a Confluence page, using a few lines of CSS.

**Screenshot 1: Default font in a Confluence page**
Changing the fonts

In order to customise the fonts in Confluence, you first need to set the body font to the font you want. Secondly, you may want to adjust the font size because different fonts have different relative sizes.

The relevant CSS is shown below. It changes Confluence's font from the default of Helvetica/Arial — sans serif to Times/Times New Roman — serif. To adjust for the fact that Times is a bit smaller than Helvetica, we increase the font size to 14 pixels. The many styles that 'wiki-content' in their definition are necessary to change the font size for all the tags in the wiki content.
Notes

Notes:

- You need system administrator permissions to edit the CSS for a space or for the site.
- This function is turned off by default. To turn it on, go to General Configuration > Security Configuration and choose Custom Stylesheets for Spaces.

Requesting Add-ons

The Atlassian Marketplace website offers hundreds of add-ons that the administrator of your Atlassian application can install to enhance and extend Confluence. If the add-on request feature is enabled for your Confluence instance, you can submit requests for add-ons from the Marketplace to your Confluence administrator.

The 'Atlassian Marketplace for Confluence' page provides an integrated view of the Atlassian Marketplace from within your Confluence instance. The page offers the same features as the Marketplace website, such as searching and category filtering, but tailors the browsing experience to Confluence.

This in-product view of the Marketplace gives day-to-day users of the Atlassian applications, not just administrators, an easy way to discover the add-ons that can help them work. When you find an add-on of interest, you can submit a request with just a few clicks.

Submitting an add-on request

To browse for add-ons in the Atlassian Marketplace, follow these steps:

1. Choose your profile picture at top right of the screen, then choose Atlassian Marketplace.
2. In the Atlassian Marketplace page, use the search box to find add-ons or use the category menus to browse or filter by add-ons by type, popularity, price or other criteria. You can see what your fellow users have requested by choosing the Most Requested filter.
3. When you find an add-on that interests you, click Request to generate a request for your administrator.
4. Optionally, type a personal message to your administrators in the text box. This message is visible to administrators in the details view for the add-on.
5. When ready, click **Submit Request**.
6. Click **Close** to dismiss the 'Success!' message dialog box.

At this point, a notification appears in the interface your administrators use to administer add-ons. Also your request message will appear in the add-on details view, visible from the administrator's 'Find New Add-ons' page. From there, your administrator can purchase the add-on, try it out or dismiss requests.

**Updating an add-on request**

After submitting the request, you can update your message at any time. Click the **Update Request** button next to the listing in the Atlassian Marketplace page to modify the message to your administrator.

The administrator is not notified of the update. However, your updated message will appear as you have modified it in the details view for the add-on immediately.

**Giving People Access to Content**

Confluence gives you the choice to make the site as open or as closed as you wish. Here are some points to consider:

- As a tool for communication and collaboration, Confluence is at its best when all your users can participate fully.
- So it is advisable not to restrict users unless you have a good reason for doing so.
- Confluence keeps a history of all changes to pages and other content. So it is easy to see who has changed what, and to reverse any edits if required.

**Levels of permission**

There are three levels of permissions in Confluence.

**Global permissions**

Global permissions are site-wide permissions, and are assigned by administrators:

- **System Administrator** - Users with this permission can perform all the Confluence administrative functions. These users can assign permissions to other users.
- **Confluence Administrator** - Users with this permission can perform most of the Confluence administrative functions, but excluding those functions which could compromise the security of the Confluence system. These users can assign permissions to other users.

For full details, please refer to the overview of global permissions in the **Administrator's Guide**.

**Space permissions**

The permission to create a new space or to administer one is granted by a Confluence Administrator from the global Administration Console.
Every space has its own independent set of permissions. These permissions determine the access settings for different users of the space. In order to assign these permissions to other users, a user must be a space administrator i.e. must have the 'Admin' permission for that space.

See Users and Groups to learn how these permissions are assigned.

Note: If you misconfigure a space so that nobody has access to administer it any more, a Confluence Administrator will need to fix the permissions for you.

Page restrictions

You can set page-level restrictions, if you have the 'Restrict Pages' permission within the space concerned.

Page restrictions allow you to control who can view or edit individual pages. To set page restrictions, edit the page and use the page restriction options below the text-entry box.

On this page:

- Levels of permission
  - Global permissions
  - Space permissions
  - Page restrictions

- More information
  - How do space permissions and page restrictions work together?
  - How do space permissions and page restrictions affect links?

Related pages:

- Users and Groups
- Global Permissions Overview
- Space Permissions Overview
- Page Restrictions
- Configuring Confluence Security
- Confluence User’s Guide
- Confluence Security Overview and Advisories

More information

How do space permissions and page restrictions work together?

Example: In the HR (Human Resources) space, everyone in the organisation has the 'View' space permission, but only the HR team has the 'Pages --> Create' space permission (i.e. the ability to create and edit pages in the space). A member of the HR team starts to create a new page called 'Annual Leave Policy'. Because the page is not yet finished, she sets the 'Viewing' page restriction so that only the HR team can view the page. When the page is finished, she will remove the 'Viewing' restriction so that everyone in the company can see the page.

How do space permissions and page restrictions affect links?

Space permissions and page restrictions affect how links between pages are displayed to a visitor:

- if the link points to a page in a space to which the visitor does not have 'View' space permission, the link will not be rendered at all.
- if the visitor has 'View' space permission, but page restrictions prohibit her from viewing the page, the link will be rendered but an 'Access Denied' message will be displayed when she clicks the link.
- if the visitor has 'View' space permission, and is not restricted from viewing the page, the link will display and behave as normal.

Links to attachments are also affected: If the visitor does not have permission to view the page to which the attachment is attached, the link will not be rendered.

Page Restrictions

Page restrictions allow you to control who can view or edit individual pages in a space.

To add or remove restrictions to a page you will need to have permissions to edit the page and 'Restrict' or
'Admin' permission in the space.

About page restrictions and space permissions

Confluence permissions are hierarchical, so page restrictions will not override any space permissions for the user or group.

For example, if you restrict viewing or editing a page to a user who does not have 'view' permissions for the space, they will not be able to see the page, as the page level restrictions cannot override their space permissions.

Some page restrictions are inherited. If you restrict viewing a page to a user or group, all children of that page will also be restricted to the user or group. Edit page restrictions are not inherited.

Adding restrictions to a page

You can restrict viewing a page or editing a page to a specific user or group.

To restrict viewing or editing a page to a user or group:

1. Go to the page and choose **Tools > Restrictions**.
2. Choose **Restrict viewing of this page** or **Restrict editing of this page**.
3. Enter part of user or group name, and then choose the appropriate user or group from the autocomplete drop down. You can add multiple users and groups.

The page restrictions have now been applied:

- Viewing the page is now restricted to the users and / or groups listed. All other users will not be able to view the page. Any children of this page will inherit the viewing restrictions.
- Editing the page is now restricted to the users and / or groups listed. All other users will be able to view, but not edit, the page.

On this page:

- About page restrictions and space permissions
- Adding restrictions to a page
- Viewing the current page restrictions
- Removing restrictions from a page
- Request and grant access to view a restricted page
- Viewing all restricted pages in a space
- Notes

Viewing the current page restrictions

Confluence displays a padlock icon on the byline when a page has current viewing or editing restrictions.

Screenshot: Byline showing page restrictions icon.

To view the restrictions:

1. Go to the page and:
   - choose **Tools > Restrictions**, or
   - choose the padlock icon on the byline, or
   - choose the **Restricted** button on the footer, if you are in the editor.
2. The Page Restrictions dialog appears, listing the users and / or groups that have restrictions applied.
Removing restrictions from a page

To remove restrictions from a page:

1. Go to the page and:
   - choose Tools > Restrictions, or
   - choose the padlock icon on the byline, or
   - choose the Restricted button on the footer, if you are in the editor.
2. Choose Remove next to each restriction you would like to remove.

Request and grant access to view a restricted page

If you navigate to a page that you are not able to view because it has page restrictions applied (for example from a link or page URL) you may be able to request access to the page.

To request access to a restricted page:

1. On the restricted page choose Request access.
2. Wait for an email confirming that access has been granted.

If the request access message does not appear, you are not able to request access for that particular page. This usually is because the page has inherited restrictions from a parent page, or you may not have adequate space permissions.

To grant access to a restricted page:

1. In the request access email, choose Grant access.
2. You will be taken to the restricted page, a dialog will appear with the access request.
3. Choose Grant access.

The user will receive an email confirming that access has been granted.
This process is the same as navigating to Tools > Restrictions and adding a 'View' restriction for the user.  

Screenshot: Grant access to the page.

Who can grant access?

To grant access to a restricted page you will need to have permission to edit that page, and have the 'Restrict' or 'Admin' permission for the space.

Confluence will send an email to the user who can grant permissions - this will be either the last user (with appropriate permissions) to edit the page, the page creator or a space admin. Confluence will try each of these roles in turn, emailing the first user that has appropriate permissions.

Viewing all restricted pages in a space

You need 'Admin' permissions to view the list of restricted pages in a space.

To view restricted pages:

1. Go to the space and choose Space tools > Permissions on the sidebar.
2. Choose Restricted Pages.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose Restricted Pages in the space administration options.

A list of all restricted pages in the space displays.

Space Administrators can remove restrictions from a page

Screenshot: Restricted pages in a space
Notes

- **Inherited restrictions**
  If a page has a 'View' restriction set, that restriction will be inherited by all its children (and their children, and so on). If a 'View' restriction is added to a child page that has already inherited page restrictions from its parent, users must satisfy both restrictions in order to see the page.

- **You cannot exclude yourself**
  As creator or editor of a page, you cannot use page restrictions to deny yourself access to the page. Confluence will automatically add your username into the list of users/groups allowed to view/edit the page. If you remove your username, Confluence will put it back again.

- **Space Admin and System Administrator access to restricted pages**
  Users with 'Admin' permissions in a space, or users with the System Administrator global permission can remove restrictions from pages, even if the page restriction prevents them from viewing the page. Go to Space Administration > Restricted Pages.

### Site Administrators and their Permissions

All site administrative functions are performed from the Administration Console. You need 'System Administrator' or 'Confluence Administrator' permissions to access the Administration Console.

The Confluence permission scheme allows the following levels of site administrator permissions:

- **Super user** – A 'super user' belongs to the confluence-administrators group, has full administrative access to Confluence, and can see all the content.
- **System Administrator** – A person with 'System Administrator' permission has full administrative access to Confluence.
- **Confluence Administrator** – A person with 'Confluence Administrator' permission has access to most of the Confluence administrative functions.

Please refer to the overview of global permissions for full details.

**Related Topics**

- Users and Groups
- Confluence User's Guide

### Contacting Confluence Administrators

If you receive an error message from Confluence, the error page may offer you a link to click in order to contact the administrators of the Confluence site.

When you click the link to contact the Confluence administrators, you will see an administrator contact page with the title 'Contact Site Administrators'. By default, the administrator contact page looks like the screenshot below.

**Related pages:**

- Configuring the Administrator Contact Page

**Screenshot:** The administrator contact screen
The screen may look different

In certain configurations of Confluence, you will not be able to use the form shown in the screenshot above. Instead, you will see a message telling you about one of the following conditions:

- If your Confluence administrator has not configured a mail server for Confluence, this means that Confluence will not be able to send an email message to the administrators.
- If none of the Confluence administrators has an email address, Confluence will not be able to send an email message to them.
- If there are no Confluence administrators defined to Confluence, Confluence will not be able to send an email message to them.
- The Confluence administrator can disable the form and specify a different message to be displayed on the above screen instead of the default message and form. See the administrator's guide.

Notes

You can also access this contact form using the following URL. Replace 'yoursite.com/wiki' with the correct path for your Confluence instance.

```
yoursite.com/wiki/contactadministrators.action
```

Space Administrators and their Permissions

A space administrator is a user with the 'Space Admin' permission for a space. This permission itself is
assigned from the Space Administration screens by a space administrator.

Who is a space administrator?

The person who creates a space is automatically the administrator of that space. That person can then assign other space administrators as required.

To find the space administrator for a specific space:

1. Choose Spaces > Space directory on the header.
2. Choose the Space Details icon beside a space.
3. The space administrators are listed.

On this page:
- Who is a space administrator?
- What can a space administrator do?

Related pages:
- Space Permissions Overview
- Confluence User's Guide

Confluence administrators are not necessarily space administrators.

- A user who has the 'Confluence Administrator' global permission is not automatically a space administrator for a particular space. In order for them to be a space administrator, they must belong to a group which has space administration rights on the space, or their username must be specifically granted space administration rights on the space.
- A user who has the 'System Administrator' global permission does automatically have space admin permissions for all spaces.

What can a space administrator do?

A space administrator has permission to do anything in the space regardless of any other setting. Space administrators are responsible for the management of a space and its contents. Note that page permissions affect space administrators differently from other users.

Space administrators can:

- view all content in the space. If there are page permissions that restrict the viewing of a page to a single user, or to a group to which the space administrator doesn't belong, a space administrator can still view the page by removing the restriction.
- edit all content on any page in the space.
- remove restrictions from any page in the space (using the Space Administration interface).
- manage the watchers for any page in the space (but not watchers of the space).
- grant themselves any other space permissions (e.g. permission to set restrictions on a particular page).

All space administration functions, with the exception of managing watchers, are performed from the Space menu (choose Browse > Space Admin in the Documentation theme). You need to be a space administrator to access the Space Administration screens.

Space Permissions Overview

Every space has its own independent set of permissions. Space permissions can only be granted by a space administrator.

Permissions can be assigned to individual users, groups or anonymous users.

These are the permissions that can be assigned at the space level:

- **View**: user can view this space’s content, including the space’s details, and its pages and news items (blog posts)
- **Pages**:
  - Add – user may create and edit pages in this space.
  - Restrict – user may apply page-level restrictions.
  - Delete – user may delete pages in this space.
- **Blog**:
  - Add – user may add and edit blog posts in this space.
  - Delete – user may delete blog posts in this space.
• Comments:
  • Add – user may make comments in this space.
  • Delete – user may delete comments from this space.

• Attachments:
  • Add – user may add attachments in this space.
  • Delete – user may delete attachments from this space.

• Mail:
  • Delete – user may delete individual mail items.

• Space:
  • Export – user may export content from this space via the space-level export screens. Note that this permission does not affect the exporting of a single page's content. Anyone who has permission to view the page also has permission to export its content.
  • Admin – user has administrative permissions over this space.

Related pages:
• Space Administrators and their Permissions
• Users and Groups
• Assigning Space Permissions
• Page Restrictions
• Confluence User’s Guide

Notes

Warning: If you deny all administrative access to a space by mistake, so that nobody has access to administer the space any more, you will need to ask someone with Confluence Administrator global permission to restore the permissions for you.

Assigning Space Permissions
You can assign space permissions to groups or to individual users. You need to be a space administrator to assign space permissions. In addition, Confluence administrators can set the default permissions that will be applied to new spaces as described below.

To access the permissions for a space:
1. Go to the space and choose Space tools > Permissions on the sidebar.
2. Choose Edit Permissions.

If your space is using the Documentation theme:
1. Go to the ‘Space Permissions’ page:
   • Choose Browse > Space Admin at the top of the screen. Note: The ‘Space Admin’ option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
   • Choose Permissions from the space administration options.
2. Choose Edit Permissions.

The ‘Edit Space Permissions’ page is divided into the following sections:
• Groups – a list of groups which already have permissions to access the site.
• Individual Users – a list of users who already have permissions to access the site.
• Anonymous Access – the space permissions granted to all anonymous users of the site.
### On this page:
- Assigning space permissions to groups
- Assigning space permissions to users
- Assigning space permissions to anonymous users
- Setting default space permissions
- Managing and Recovering Space Admin Permissions
- Notes

### Related pages:
- Space Permissions Overview
- Users and Groups
- Confluence User's Guide

---

**Screenshot: Space permissions**

### Groups

These are the permissions currently assigned to groups for this space.

<table>
<thead>
<tr>
<th>All</th>
<th>Pages</th>
<th>Blog</th>
<th>Comments</th>
<th>Attachments</th>
<th>Mail</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View</td>
<td>Add</td>
<td>Restrict</td>
<td>Delete</td>
<td>Add</td>
<td>Delete</td>
</tr>
<tr>
<td>confluence-users</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✗</td>
</tr>
</tbody>
</table>

**Edit Permissions**

### Individual Users

These are the permissions currently assigned to individual users for this space.

<table>
<thead>
<tr>
<th>All</th>
<th>Pages</th>
<th>Blog</th>
<th>Comments</th>
<th>Attachments</th>
<th>Mail</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View</td>
<td>Add</td>
<td>Restrict</td>
<td>Delete</td>
<td>Add</td>
<td>Delete</td>
</tr>
<tr>
<td>Rach Admin [Administrator]</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

**Edit Permissions**

### Anonymous Access

When a user is using Confluence while not logged in, they are using it anonymously. For example: Enabling anonymous 'commenting' permission, allows non-logged-in users to make comments in this space.

<table>
<thead>
<tr>
<th>All</th>
<th>Pages</th>
<th>Blog</th>
<th>Comments</th>
<th>Attachments</th>
<th>Mail</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View</td>
<td>Add</td>
<td>Restrict</td>
<td>Delete</td>
<td>Add</td>
<td>Delete</td>
</tr>
<tr>
<td>Anonymous</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✗</td>
</tr>
</tbody>
</table>
Assigning space permissions to groups

- To assign a permission, check the box next to the relevant group.
- To deny a permission, uncheck the relevant box.
- To add a new group to the list, type the group name into the text box in the 'Groups' section and choose **Add**. The group will appear in the list of groups. You can then assign the permissions.
- To search for a group:
  - Choose the **icon.
  - The **Group Search** window opens. Enter all or part of the group name. You can use an asterisk ‘*’ as a wild card.
  - Check the boxes to select the required group(s).
  - Choose **Select Groups**. The group name(s) will appear in the text box in the 'Groups' section.
  - Choose **Add**.
- To bulk assign or revoke group member permissions, choose either **Select All** or **Deselect All** from the **Actions** dropdown list.

Choose **Save All** to apply the changes.

Assigning space permissions to users

- To assign a permission, check the box next to the relevant user.
- To deny a permission, uncheck the relevant box.
- To add a new user to the list, type the username into the text box in the 'Individual Users' section and choose **Add**. The user will appear in the list of users, with 'View' permission assigned. You can then add more permissions if necessary.
- To search for a user:
  - Choose the **icon.
  - The **User Search** window opens. You can read more about searching for users.
  - Check the boxes to select the required user(s).
  - Choose **Select User(s)**. The username(s) will appear in the text box in the 'Individual Users' section.
  - Choose **Add**.
- To bulk assign or revoke individual user permissions, choose either **Select All** or **Deselect All** from the **Actions** dropdown list.

Choose **Save All** to apply the changes.

Assigning space permissions to anonymous users

- To assign a permission, check the box for the required permission.
- To deny a permission, uncheck the relevant box.
- To bulk assign or revoke anonymous user permissions, choose either **Select All** or **Deselect All** from the **Actions** dropdown list.

Choose **Save All** to apply the changes.

**Note:** You cannot grant space administration rights or page restriction rights to anonymous users.

Setting default space permissions

If you are a **Confluence Administrator**, you can set the default permissions that will be applied to new spaces. The default permissions are configurable for groups only, not for individual users or anonymous users.

**To set the default space permissions:**

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Choose **Space Permissions** under Security in the sidebar.
3. Choose **Edit Permissions**.

**Screenshot: Default space permissions**
Managing and Recovering Space Admin Permissions

Users with System Administrator permissions are able to manage permissions for spaces, including adding or removing Space Admin permissions for a space.

To manage space permissions:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Space Permissions under Users & Security in the sidebar.
3. Locate the space in the Individual Spaces list and choose Manage Permissions.

There may be some instances where a space administrator has removed Space Admin permissions from all other users and groups for a space, meaning that no other user can administer the space. Users with Confluence Administrator permissions can recover permissions for the space in this instance.

To recover Space Admin permissions:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Space Permissions under Users & Security in the sidebar.
3. Locate the space in the Individual Spaces list and choose Recover Permissions.

The user will then be able to choose Manage Permissions, and add any appropriate permissions to the space. Requests to recover permissions are recorded in the Confluence log files.

Notes

Assigning permissions in bulk. There is no way to change a number of space permissions at once, via the Confluence user interface. Instead, take a look at the Confluence Command Line Interface. Here is a link to the CLI documentation. For an introduction to the CLI, see this blog post: Confluence CLI for bulk actions like deleting or publishing pages.

Users and Groups

A ‘user’ is the account for an individual who accesses Confluence.

New users are created by an administrator via the Administration Console.

New users are created by administrators, who can also group users together into user groups for more convenient administration. This means that any permissions you assign at the site, space and page levels can be assigned to a whole group. A user in one of these groups will automatically be granted all permissions granted to the group.

There are two special groups in Confluence:
- **confluence-administrators** - these users have permissions to administer users and access the Confluence Admin console.
- **confluence-users** - this is the default group into which all new users are assigned. Permissions defined for this group will be assigned to all new Confluence users.

Your Confluence instance may include additional groups.

**Anonymous Users**

Confluence treats all users who do not log in when they access Confluence as being 'Anonymous'. Administrators can assign permissions to this group separately.

**Overlapping group and user permissions**

When a user is assigned more than one permission, the more powerful permission will prevail.

Further explanation:

- A user may be assigned a permission specifically to their username. They may also be assigned a permission by belonging to a group, or even several groups.
- The user will then be able to perform all functions assigned to them.
- So if a user is allowed to do something over and above what the group can do, the user will be able to do it. And if the group is allowed to do something over and above the specific permissions granted to the user, the user will still be able to do it.

**Searching for Users**

This page describes how to use the 'User Search' window, which appears when you click **Choose Users** or a user search icon on a Confluence page.

**Accessing the User Search**

To access the 'User Search' window:

1. Choose the user search icon when you are performing one of the following actions:
   - When assigning space permissions, choose the user search icon in the users section.
   - When adding members to a group, choose the user search icon.

2. The simple 'User Search' window will appear, as shown below.
Using the Simple User Search

To search via the simple user search:

1. Select the User tab on the 'User Search' screen. (See above for instructions on accessing the screen.)
2. Enter information about the user in the User Details field, such as all or part of a username, full name or email address.
3. Choose Search.
4. Confluence will return a list of matching users. See below for instructions on selecting one or more users.

Screenshot: Simple user search

Searching for Users in One or More Groups

You can also list the users who appear in a particular group or in a set of groups.

To search for users in a particular group:

1. Select the Membership tab on the 'User Search' screen. (See above for instructions on accessing the screen.)
2. Enter all or part of a group name into the Group Membership field.
3. Choose Search.
4. Confluence will return a list of users belonging to any groups which match your search term.

In the example screenshot below, we entered a group name of 'dev'. The search results show all users belonging to the group 'developers' and all users belonging to the group 'developers-mates'.
5. Now you can select one or more users, as described below.

Screenshot: Searching for users in a group
Selecting One or More Users

After searching for users and receiving a list of names from Confluence, as described above, you can now select the user(s) you need.

To select one or more users:

1. Click the box next to the username(s) to select or deselect one or more users.
   You can click Check All to select or deselect all users.
2. Click Select User(s).
3. The 'User Search' window will close and the selected users will appear on the screen which you were using before you accessed the user search.

Notes

- **Case sensitivity**: The search is not case sensitive. You can enter either upper- or lower-case text, and it will make no difference to the search results.
- **Wild cards**: The search allows the asterisk as a wild card, but you do not need to use it. The search results will be the same whether you use a wild card or not. The wildcard functionality remains available for compatibility with older versions of Confluence.
- **Multiple user directories**: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories.

- **Crowd and the user search**: If you are using Atlassian's Crowd for user management, you will need Crowd 1.5.1 or later to use the 'Simple' option in the user search. If your version of Crowd does not support the simple user search, you will see only the 'Advanced' search form.
Working with JIRA in Confluence

If you use JIRA and have your Confluence and JIRA instances connected using Application Links you can display and create JIRA issues and more from within Confluence. Some of these features require a specific version of JIRA.

This page provides some basics to get you stared working with JIRA issues in Confluence.

Displaying JIRA issues

You can display JIRA issues on a Confluence page using the JIRA Issues macro. You can display a single issue, a list of issues, or show the total number of issues.

One of the simplest ways to add a JIRA issue to a page is to paste a JIRA URL. For example:

- `<yourjirasite.com>/browse/CONF-1234` will insert the JIRA Issues macro and display a single issue.
- `<yourjirasite.com>/issues/?filter=56789` will insert the JIRA Issues macro and display a list of issues matching the saved filter.
- `<yourjirasite.com>/issues/?jql=project%20%3D%20CONF` will insert the JIRA Issues macro and display a list of issues matching the JIRA search.

Alternatively you can add the JIRA Issues macro to the page and use the macro browser to search for issues directly.

- In the editor choose Insert > JIRA Issue.
- Follow the prompts in the macro browser to choose a project and search for an issue - you can even use JIRA Query Language (JQL).

You can customise how the issue or list of issues appears on the page, including how much information to display, how many issues, and more.

Find out more about using the JIRA Issues Macro.

Creating JIRA Issues

You can create issues from a page, or from the editor. This is particularly useful if you use Confluence for requirements gathering.

To create an issue when viewing a page:

- Highlight some text on your page - a panel with appear near your selection.
- Choose Create JIRA Issue.
- Follow the prompts to enter information about your project and issue - your highlighted text will populate the issue summary.
- Choose Create - the issue will be created in JIRA, and added to your page.

If your text is in a table, you will have the option to create multiple issues using text from the same column.

If you do not see a popup when you highlight text, check that Text Select is enabled in your profile settings.

To create an issue in the editor:

- In the editor choose Insert > JIRA Issue > Create new issue.
- Follow the prompts to enter information about your project and issue.
- Choose Insert - the issue will be created in JIRA, and added to your page.

There are some limitations when creating JIRA Issues from Confluence. The JIRA Issues macro or Create JIRA Issue dialog will notify you if it is unable to create an issue in the selected project. You can find out more in the JIRA Issues Macro page.

Creating reports and charts

Reporting on information stored in JIRA couldn't be easier in Confluence. In addition to the JIRA Issues Macro, you can use the JIRA Report blueprint or JIRA Chart macro.

You can:
Use the JIRA Report blueprint to create a Change Log or Status report.
Use the JIRA Issues Macro to display a list of resolved issues, for example for use in release notes.
Use the JIRA Chart Macro to display data as a pie chart.

Prompting users to add JIRA Issues to a page

If you use templates (including templates provided by blueprints), you can add a JIRA Issue placeholder that, when clicked, opens the JIRA Issues macro and prompts users to search for or create a JIRA issue.

You can see the JIRA Issues placeholder in the Product Requirements blueprint.

See Adding a Template for more information on using instructional text and placeholders.

View connections between Confluence and JIRA

The JIRA Links button gives you quick access to issues connected to the Confluence page you are viewing.

Links are displayed when:
- you have created or added single issues to the page using the JIRA Issues macro in Confluence.
- you have added a link from the issue to the Confluence page in JIRA.

If you use JIRA Agile, sprints and epics will also appear on the JIRA Links button.

The number on the JIRA Links button indicates the total number of issues connected to that page, regardless of whether you have permissions to view the issues. The dropdown will only show issues, epics and sprints that you have JIRA permissions to view.

Note:
- The JIRA Links button only appears in the default theme. It is not visible in the Documentation theme.
- The button also does not detect links from issues displayed in the JIRA Issues macro in table format.

Working with JIRA Agile in Confluence

By using Confluence and JIRA Agile together, you can unleash the potential in your development team. This page provides some suggestions for how you can get the most of Confluence and JIRA Agile.

The features described on this page require JIRA 6.1.3 and JIRA Agile 6.3.5 and later.

Using Confluence and JIRA Agile to define requirements

Confluence is the perfect place to start defining your requirements. Here's how you can use Confluence features to support this process:
- Create a page using the Product Requirements Blueprint.
- Create an epic in JIRA - the blueprint template will prompt you.
- Collaborate with your team to define your stories.
- Highlight text on your requirements page to create stories in JIRA and automatically link them to your epic.
- Track the progress of the stories from the Confluence page or from within JIRA.

The tight integration between Confluence and JIRA mean that you can easily access JIRA issues from the Confluence page, and see their status at a glance, and from within JIRA you can see links to related Confluence pages. All the information you need is never more than a few clicks away.

Using Confluence and JIRA Agile during a sprint

Often there is a lot of material in Confluence that provides useful context for your team during a sprint. These might be requirements documents, designs, technical specifications, customer research and more. By linking these pages to epics, you make them easy for your team to access during the sprint.

Here's how you can use Confluence to support your sprint from within JIRA Agile:
- In JIRA Agile create a Confluence page to plan your sprint - this page is automatically linked to the sprint.
- In an epic link to useful Confluence pages, including requirements, designs, and more.
- Report on your progress to stakeholders using the JIRA Reports blueprint.
• Use the Retrospective blueprint at the end of your sprint to take stock of what went well, and areas for improvement.

For users who work primarily in JIRA, the integration means that useful Confluence pages are only a click away.

Viewing links between Confluence and JIRA

The **JIRA Links** button appears on your page when there are links back to JIRA or JIRA Agile. These might be:

- Links from a JIRA issue back to a Confluence Page.
- Links from a JIRA Agile epic or sprint back to a Confluence Page.
- Link from a Confluence page to a JIRA Issue or epic (created by adding a single issue in the JIRA Issues macro).

The number on the JIRA Links button indicates the total number of issues, epics and sprints connected to that page, regardless of whether you have permissions to view them. The dropdown will only show details of issues, epics and sprints that you have JIRA permissions to view.

**Note:**

- The JIRA Links button only appears in the default theme. It is not visible in the Documentation theme.
- The button does not detect links from issues displayed in the JIRA Issues macro in table format.

**Advanced and Special Uses of Confluence**

This section describes the more advanced features of Confluence, and gives guidelines on some specific uses of the wiki.

**Confluence markup formats**

The syntax and usage of Confluence wiki markup and the Confluence XHTML-based storage format – see *Working with Confluence Markup*.

**Gadgets**

How to add gadgets to a wiki page, or use Confluence gadgets on other sites – see *Working with Confluence Gadgets*.

**Using Confluence for technical documentation**

A technical communicator’s guide to using Confluence – see *Developing Technical Documentation on Confluence Wiki*.

**Setting up a knowledge base**

A support engineer’s guide to using Confluence as a knowledge base – see *Using Confluence as a Knowledge Base*.

**Setting up an intranet**

A quick guide to setting up an intranet wiki – see *Developing an Intranet on Confluence Wiki*.

**Related pages:**

- Confluence User’s Guide
- Confluence Administrator’s Guide

**Working with Confluence Markup**

This section describes two types of markup found in Confluence:

- **Confluence storage format.** Confluence stores the content of pages and blog posts in an XHTML-based format. Advanced users can view the storage format of a page and even edit it, provided their Confluence site is configured to allow that. See *Confluence Storage Format* for a description of the core elements of the storage format.
- **Wiki markup.** Confluence allows data entry via a shorthand code
Some parts of the Confluence administration interface also accept wiki markup for defining content. For a description of the wiki markup syntax, see Confluence Wiki Markup. Storage format and wikimarkup code examples for macros can be found in the documentation for each macro.

Confluence Storage Format

This page describes the XHTML-based format that Confluence uses to store the content of pages, page templates, blueprints, blog posts and comments. This information is intended for advanced users who need to interpret and edit the underlying markup of a Confluence page.

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

You can view the Confluence storage format for a given page by choosing Tools > View Storage Format. This option is only available if one of the following is true:

- You are a Confluence administrator.
- Your Confluence site has the Confluence Source Editor plugin installed and you have permission to use the source editor.
- If you would like to edit the storage format for a page, your Confluence system administrator will need to install the Confluence Source Editor plugin.
- Clarification of terminology: If you choose Tools > View Source, you will see the format used within the editor panel, not the storage format of the page.

### Headings

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading 1</td>
<td>h1. Heading 1</td>
<td>&lt;h1&gt;Heading 1&lt;/h1&gt;</td>
<td>Underlined in the Documentation Theme</td>
</tr>
<tr>
<td>Heading 2</td>
<td>h2. Heading 2</td>
<td>&lt;h2&gt;Heading 2&lt;/h2&gt;</td>
<td>Underlined in the Documentation Theme</td>
</tr>
<tr>
<td>Heading 3</td>
<td>h3. Heading 3</td>
<td>&lt;h3&gt;Heading 3&lt;/h3&gt;</td>
<td></td>
</tr>
</tbody>
</table>

Headings 4 to 6 are also available and follow the same pattern.
### Text effects

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>strong/bold</td>
<td><em>strong</em></td>
<td>&lt;strong&gt;strong text&lt;/strong&gt;</td>
<td>strong</td>
</tr>
<tr>
<td>emphasis</td>
<td><em>emphasis</em></td>
<td>&lt;em&gt;Italics Text&lt;/em&gt;</td>
<td>emphasis</td>
</tr>
<tr>
<td>strikethrough</td>
<td>-strikethrough-</td>
<td>&lt;span style=&quot;text-decoration: line-through;&quot;&gt;strikethrough&lt;/span&gt;</td>
<td>strikethrough</td>
</tr>
<tr>
<td>underline</td>
<td>+underline+</td>
<td>&lt;u&gt;underline&lt;/u&gt;</td>
<td>underline</td>
</tr>
<tr>
<td>superscript</td>
<td>^superscript^</td>
<td>&lt;sup&gt;superscript&lt;/sup&gt;</td>
<td>superscript</td>
</tr>
<tr>
<td>subscript</td>
<td><del>subscript</del></td>
<td>&lt;sub&gt;subscript&lt;/sub&gt;</td>
<td>subscript</td>
</tr>
<tr>
<td>monospace</td>
<td>{{monospaced}}</td>
<td>&lt;code&gt;monospaced&lt;/code&gt;</td>
<td>monospaced</td>
</tr>
<tr>
<td>preformatted</td>
<td>n/a</td>
<td>&lt;pre&gt;preformatted text&lt;/pre&gt;</td>
<td>preformatted text</td>
</tr>
</tbody>
</table>
| **block quotes** | bq. block quote  
or  
{quote}  
block quote  
{quote} | <blockquote><p>block quote</p></blockquote> |
| **text colour** | {color:red}red text{color} | <span style="color:rgb(255,0,0);">red text</span> |
| **small** | n/a | <small>small text</small> |
| **big** | n/a | <big>big text</big> |
| **center-align** | n/a | <p style="text-align: center;">centered text</p> |
| **right-align** | n/a | <p style="text-align: right;">right aligned text</p> |

**Text breaks**

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
</table>
| **New paragraph** | Paragraph 1  
(EMPTY line)  
Paragraph 2 | <p>Paragraph 1</p>  
<p>Paragraph 2</p> | Paragraph 1  
Paragraph 2 |
| **Line break** | Line 1 \ Line 2 | Line 1 <br /> Line 2 | Line 1  
Line 2  
Note: Created in the editor using Shift + Return/Enter |
### Lists

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unordered list – round bullets</td>
<td>* Round bullet list item</td>
<td>&lt;ul&gt; &lt;li&gt;round bullet list item&lt;/li&gt; &lt;/ul&gt;</td>
<td>• Round bullet list</td>
</tr>
<tr>
<td>Ordered list (numbered list)</td>
<td># Ordered list item</td>
<td>&lt;ol&gt; &lt;li&gt;numbered list item&lt;/li&gt; &lt;/ol&gt;</td>
<td>1. Ordered list</td>
</tr>
<tr>
<td>Task Lists</td>
<td>[] Task list item</td>
<td><a href="">ac:task-list</a> <a href="">ac:task</a> <a href="">ac:task-status</a>incomplete&lt;/ac:task-status&gt; <a href="">ac:task-body</a>task list item&lt;/ac:task-body&gt; &lt;/ac:task&gt; &lt;/ac:task-list&gt;</td>
<td>task list item</td>
</tr>
</tbody>
</table>

### Links

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to another Confluence page</td>
<td>[Link to another Confluence page</td>
<td>Page Title]</td>
</tr>
<tr>
<td>Link to an attachment</td>
<td>![Link to an attachment^atlassian_logo.gif]</td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Link to an external site</td>
<td>![Link to an attachment^atlassian_logo.gif]</td>
<td></td>
</tr>
<tr>
<td>Anchor link (same page)</td>
<td>![Anchor Link</td>
<td>^#anchor]</td>
</tr>
<tr>
<td>Anchor link (another page)</td>
<td>![Anchor Link</td>
<td>^#anchor]</td>
</tr>
<tr>
<td>Link with an embedded image for the body</td>
<td>![Link with an embedded image for the body^pagetitle#anchor]</td>
<td></td>
</tr>
</tbody>
</table>

### A note about link bodies

All links received from the editor will be stored as plain text by default, unless they are detected to contain the limited set of mark up that we allow in link bodies. Here are some examples of markup we support in link bodies.
An example of different link bodies

```xml
<ac:link>
  <!-- Any resource identifier -->
  <ri:page ri:content-title="Home" ri:space-key="SANDBOX" />
  <ac:link-body>Some <strong>Rich</strong> Text</ac:link-body>
</ac:link>

<ac:link>
  <ri:page ri:content-title="Plugin developer tutorial stuff" ri:space-key="TECHWRITING" />
  <!-- A link body isn't necessary. Auto-generated from the resource identifier for display. -->
</ac:link>

The markup tags permitted within the `<ac:link-body>` are `<b>`, `<strong>`, `<em>`, `<i>`, `<code>`, `<tt>`, `<sub>`, `<sup>`, `<br>` and `<span>`.

**Images**

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attached image</td>
<td><img src="attachment" alt="atlassian_logo.gif!" /></td>
<td><img src="attachment" alt="atlassian_logo.gif!" /></td>
</tr>
</tbody>
</table>

Supported image attributes (some of these attributes mirror the equivalent HTML 4 IMG element):

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ac:align</td>
<td>image alignment</td>
</tr>
<tr>
<td>ac:border</td>
<td>Set to &quot;true&quot; to set a border</td>
</tr>
<tr>
<td>ac:class</td>
<td>css class attribute.</td>
</tr>
<tr>
<td>ac:title</td>
<td>image tool tip.</td>
</tr>
<tr>
<td>ac:style</td>
<td>css style</td>
</tr>
</tbody>
</table>
ac:thumbnail | Set to "true" to designate this image as a thumbnail.
ac:alt | alt text
ac:height | image height
ac:width | image width
ac:vspace | the white space on the top and bottom of an image
ac:hspace | the white space on the left and right of an image

### Tables

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two column, two row (top header row)</td>
<td></td>
<td></td>
<td>Table Heading Cell 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Two column, three rows, 2nd and third with merged cells in first row</td>
<td>N/A</td>
<td>&lt;table&gt;&lt;tbody&gt;&lt;tr&gt;&lt;td rowspan=&quot;2&quot;&gt;Merged Cell&lt;/td&gt;&lt;td&gt;Normal Cell 1&lt;/td&gt;&lt;/tr&gt;&lt;tr&gt;&lt;td colspan=&quot;1&quot;&gt;Normal Cell 2&lt;/td&gt;&lt;/tr&gt;&lt;/tbody&gt;&lt;/table&gt;</td>
<td>Table Heading Cell 1</td>
</tr>
</tbody>
</table>
Page layouts

Confluence supports page layouts directly, as an alternative to macro-based layouts (using, for example, the section and column macros). This section documents the storage format XML created when these layouts are used in a page.

Notes:

- Page layouts were originally introduced in Confluence 4.2, and are not available in earlier versions of Confluence. If you are using Confluence 4.2 - 5.1 you should refer to the documentation for your version of Confluence:
  - Confluence Storage Format (Confluence 4.2)
  - Confluence Storage Format (Confluence 4.3)
  - Confluence Storage Format (Confluence 5.0)
  - Confluence Storage Format (Confluence 5.1)
- Pages with a layout created in the old format will be converted to 5.2 format.
- Confluence 5.2 provides more flexible layouts with a more concise storage format.

<table>
<thead>
<tr>
<th>Element name</th>
<th>In Confluence 5.2 and later</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ac:layout</td>
<td>Indicates that the page has a layout. It should be the top level element in the page.</td>
<td>None</td>
</tr>
<tr>
<td>ac:layout-section</td>
<td>Represents a row in the layout. It must be directly within the ac:layout tag. The type of the section indicates the appropriate number of cells and their relative widths.</td>
<td>ac:type</td>
</tr>
<tr>
<td>ac:layout-cell</td>
<td>Represents a column in a layout. It must be directly within the ac:layout-section tag. There should be an appropriate number of cells within the layout-section to match the ac:type.</td>
<td>None</td>
</tr>
</tbody>
</table>

The recognised values of ac:type for ac:layout-section are:

<table>
<thead>
<tr>
<th>ac:type</th>
<th>Expected number of cells</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>single</td>
<td>1</td>
<td>One cell occupies the entire section.</td>
</tr>
<tr>
<td>two_equal</td>
<td>2</td>
<td>Two cells of equal width.</td>
</tr>
<tr>
<td>two_left_sidebar</td>
<td>2</td>
<td>A narrow (~30%) cell followed by a wide cell.</td>
</tr>
<tr>
<td>two_right_sidebar</td>
<td>2</td>
<td>A wide cell followed by a narrow (~30%) cell.</td>
</tr>
<tr>
<td>three_equal</td>
<td>3</td>
<td>Three cells of equal width.</td>
</tr>
<tr>
<td>three_with_sidebars</td>
<td>3</td>
<td>A narrow (~20%) cell at each end with a wide cell in the middle.</td>
</tr>
</tbody>
</table>

The following example shows one of the more complicated layouts from the old format built in the new. The word (content) indicates where further XHTML or Confluence storage format block content would be entered, such as <p> or <table> tags.
### Emoticons

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emoticons :)</td>
<td></td>
<td>&lt;ac:emoticon ac:name=&quot;smile&quot; /&gt;</td>
<td>😊</td>
</tr>
<tr>
<td>:</td>
<td></td>
<td>&lt;ac:emoticon ac:name=&quot;sad&quot; /&gt;</td>
<td>😞</td>
</tr>
<tr>
<td>:P</td>
<td></td>
<td>&lt;ac:emoticon ac:name=&quot;cheeky&quot; /&gt;</td>
<td>😊</td>
</tr>
<tr>
<td>:D</td>
<td></td>
<td>&lt;ac:emoticon ac:name=&quot;laugh&quot; /&gt;</td>
<td>😄</td>
</tr>
<tr>
<td>:)</td>
<td></td>
<td>&lt;ac:emoticon ac:name=&quot;wink&quot; /&gt;</td>
<td>😘</td>
</tr>
</tbody>
</table>
### Resource identifiers

Resource identifiers are used to describe "links" or "references" to resources in the storage format. Examples of resources include pages, blog posts, comments, shortcuts, images and so forth.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Resource identifier format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td><code>&lt;ri:page ri:space-key=&quot;FOO&quot; ri:content-title=&quot;Test Page&quot;/&gt;</code></td>
</tr>
</tbody>
</table>
| Notes:     | • `ri:space-key` (optional) denotes the space key. This can be omitted to create a relative reference.  
            • `ri:content-title` (required) denotes the title of the page. |
| Blog Post  | `<ri:blog-post ri:space-key="FOO" ri:content-title="First Post" 
ri:posting-day="2012/01/30" />`                                                      |
| Notes:     | • `ri:space-key` (optional) denotes the space key. This can be omitted to create a relative reference.  
            • `ri:content-title` (required) denotes the title of the page.  
            • `ri:posting-day` (required) denotes the posting day. The format is YYYY/MM/DD. |
### Attachment

<ri:attachment ri:filename/>

... resource identifier for the container of the attachment ...

</ri:attachment>

**Notes:**
- `ri:filename`: (required) denotes the name of the attachment.
- the body of the `ri:attachment` element should be a resource identifier denoting the container of the attachment. This can be omitted to create a relative attachment reference (similar to `[foo.png]` in wiki markup).

**Examples:**

#### Relative Attachment Reference

<ri:attachment ri:filename="happy.gif"/>

#### Absolute Attachment Reference

<ri:attachment ri:filename="happy.gif">
<ri:page ri:space-key="TST" ri:content-title="Test Page"/>
</ri:attachment>

### URL

<ri:url ri:value="http://example.org/sample.gif"/>

**Notes:**
- `ri:value`: (required) denotes the actual URL value.

### Shortcut

<ri:shortcut ri:key="jira" ri:parameter="ABC-123"/>

**Notes:**
- `ri:key`: (required) represents the key of the Confluence shortcut.
- `ri:parameter`: (required) represents the parameter to pass into the Confluence shortcut.
- The example above is equivalent to `[ABC-123@jira]` in wiki markup.

### User

<ri:user ri:userkey="2c9680f7405147ee0140514c26120003"/>

**Notes:**
- `ri:userkey`: (required) denotes the unique identifier of the user.

### Space

<ri:space ri:space-key="TST"/>

**Notes:**
- `ri:space-key`: (required) denotes the key of the space.
Template variables

This screenshot shows a simple template:

This is Sarah's template

A single-line text variable: $MyText

A multi-line text variable: $MyMulti

A selection list: $MyList

End of page.

The template contains the following variables:

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>$MyText</td>
<td>Single-line text</td>
<td></td>
</tr>
<tr>
<td>$MyMulti</td>
<td>Multi-line text</td>
<td>Size: 5 x 100</td>
</tr>
<tr>
<td>$MyList</td>
<td>List</td>
<td>List items: Apples, Pears, Peaches</td>
</tr>
</tbody>
</table>

The XML export produces the following code for the template:

```xml
<ri:content-entity ri:content-id="123"/>
```
Instructional Text

Instructional text allows you to include information on how to fill out a template for an end-user (the person using creating a page from the template). Instructional text will:

- automatically clear all instructional text as the user types in a specific text block, and
- automatically trigger a @mention prompt for user selection (for 'mention' type instructional text).

Screenshot: Example of instructional text.

Confluence Wiki Markup

This page describes the wiki markup used on some administration screens in Confluence.

Wiki markup is useful when you want to do one of the following:

- Configure the Documentation theme.
- Type wiki markup directly into the editor. Confluence will convert it to the rich text editor format as you type.
- Create links using the Advanced tab of the Links Browser.
- Insert a block of wiki markup (or markdown) into the Confluence editor. (Choose Insert > Markup.)

Note: You cannot edit content in wiki markup. Confluence does not store page content in wiki markup.
Although you can enter wiki markup into the editor, Confluence will convert it to the rich text editor format immediately. You will not be able to edit the wiki markup after initial entry.

**Can I type wiki markup into the editor?**

Yes. You can type wiki markup directly into the editor, and Confluence will convert it as you type. (You cannot edit the wiki markup after conversion.) See it in action in this video:

Read this blog post for more examples: 12 Things You Didn’t Know About the Confluence Editor.

**Can I insert markdown?**

Confluence supports inserting content in markdown. This is often used in ReadMe files. See Markdown syntax guide for some examples of markdown syntax.

To insert markdown in the editor:

1. Choose Insert > Markup
2. Select Markdown
3. Type or paste your text - the preview will show you how it will appear on your page
4. Choose Insert.

As with wiki markup, Confluence will convert your markdown to the rich text editor format. You will not be able to edit your content using markdown.

**On this page:**

- Can I type wiki markup into the editor?
- Can I insert markdown?
- Headings
- Lists
- Tables
- Text Effects
- Text Breaks
- Links
- Images
- Page Layouts
- Macros

**Headings**

To format a line as a heading, type "hn." at the start of your line, where n can be a number from 1 to 6.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>h1. Biggest heading</td>
<td>Biggest heading</td>
</tr>
<tr>
<td>h3. Big heading</td>
<td>Big heading</td>
</tr>
<tr>
<td>h5. Small heading</td>
<td>Small heading</td>
</tr>
</tbody>
</table>

**Lists**

Wiki markup allows you to create bulleted or numbered lists, and is flexible enough to allow a combination of the two list types.

If you need to separate the text within lists using line breaks, make sure you do so using a double slash (/).

Empty lines may disrupt the list.
Simple lists
Use the hyphen (-) to create simple lists. Make sure there is a space between the hyphen and your text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>- some</td>
<td>• some</td>
</tr>
<tr>
<td>- bullet</td>
<td>• bullet</td>
</tr>
<tr>
<td>- points</td>
<td>• points</td>
</tr>
</tbody>
</table>

Bulleted lists
Use the asterisk (*) to create bullets. For each subsequent level, add an extra asterisk. Make sure there is a space between the asterisk and your text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>* some</td>
<td>• some</td>
</tr>
<tr>
<td>* bullet</td>
<td>• bullet</td>
</tr>
<tr>
<td>** indented</td>
<td>• indented</td>
</tr>
<tr>
<td>** bullets</td>
<td>• bullets</td>
</tr>
<tr>
<td>* points</td>
<td>• points</td>
</tr>
</tbody>
</table>

Numbered lists
Use the hash (#) to create numbered lists. Make sure there is a space between the hash and your text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td># a</td>
<td>1. a</td>
</tr>
<tr>
<td># numbered</td>
<td>2. numbered</td>
</tr>
<tr>
<td># list</td>
<td>3. list</td>
</tr>
</tbody>
</table>

A second level of hashes will produce a sub-list, such as the alphabetical sub-list shown below.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td># Here's a sentence.</td>
<td>1. Here's a sentence.</td>
</tr>
<tr>
<td>## This is a sub-list point.</td>
<td>a. This is a sub-list point.</td>
</tr>
<tr>
<td>## And a second sub-list point.</td>
<td>b. And a second sub-list point.</td>
</tr>
<tr>
<td># Here's another sentence.</td>
<td>2. Here's another sentence.</td>
</tr>
</tbody>
</table>

You can use a third level of hashes to produce a sub-sub-list.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
</table>
# Here's a sentence.
## This is a sub-list point.
### Third list level.
### Another point at the third level.
### And a second sub-list point.
# Here's another sentence.

1. Here's a sentence.
   a. This is a sub-list point.
      i. Third list level.
      ii. Another point at the third level.
   b. And a second sub-list point.
2. Here's another sentence.

**Note:** In numbered lists as described above, the format of the ‘number’ displayed at each list level may be different, depending upon your browser and the style sheets installed on your Confluence instance. So in some cases, you may see letters (A, B, C, etc; or a, b, c, etc) or Roman numerals (i, ii, iii, etc) at different list levels.

### Mixed lists

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
</table>
| # Here
| * is
| * an
| # example
| * of
| * a
| # mixed
| # list | 1. Here
| • is
| • an
| 2. example
| • of
| • a
| 3. mixed
| 4. list |

### Tables

You can create two types of tables.

**Table Type 1**

Allows you to create a simple table with an optional header row. You cannot set the width of the columns in this table.

Use double bars for a table heading row.

**What you need to type:**

```
<table>
<thead>
<tr>
<th>heading 1</th>
<th>heading 2</th>
<th>heading 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>cell A1</td>
<td>cell A2</td>
<td>cell A3</td>
</tr>
<tr>
<td>cell B1</td>
<td>cell B2</td>
<td>cell B3</td>
</tr>
</tbody>
</table>
```

**What you will get:**

<table>
<thead>
<tr>
<th>heading 1</th>
<th>heading 2</th>
<th>heading 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>cell A1</td>
<td>cell A2</td>
<td>cell A3</td>
</tr>
<tr>
<td>cell B1</td>
<td>cell B2</td>
<td>cell B3</td>
</tr>
</tbody>
</table>

You can also use a vertical header.

**What you need to type:**

```
||heading 1||heading 2||heading 3||
|cell A1|cell A2|cell A3|
|cell B1|cell B2|cell B3|
```
Table Type 2
This method allows you to specify the width of the columns in the table.

What you will get:

| heading 1 | col A1 | col A2 | col A3 |
| heading 2 | col B1 | col B2 | col B3 |

What you need to type

```plaintext
{section:border=true}
{column:width=30%}
Text for this column goes here. This is the smaller column with a width of only 30%.
{column}
{column:width=70%}
Text for this column goes here. This is the larger column with a width of 70%.
{section}

For more details please see the Column Macro and the Section Macro.
```

Advanced Formatting
Colour and Other Formatting
To add colour and other formatting to your tables, you can use the Panel Macro within columns. More table-formatting options may be available if your Confluence administrator has installed additional macros.

Lists
Here's an example of how to embed lists in a table:

What you need to type

| Heading 1 | Heading 2 |
| * Item 1 |
| * Item 2 |
| * Item 3 | # Item 1 |
| # Item 2 |
| # Item 3 |

What you will get

| Heading 1 | Heading 2 |
Text Effects

Use the markup shown in the examples below to format text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>strong</em></td>
<td>strong</td>
</tr>
<tr>
<td><em>bold text</em></td>
<td>bold text</td>
</tr>
<tr>
<td><em>emphasis</em></td>
<td>emphasis</td>
</tr>
<tr>
<td><em>italics</em></td>
<td>italics</td>
</tr>
<tr>
<td></td>
<td>*Hint: To italicise parts of a word, add braces (curly brackets) around the underscore. For example, Thing{<em>.}x</em> gives you this: Thingx</td>
</tr>
<tr>
<td>??citation??</td>
<td>—citation</td>
</tr>
<tr>
<td>-deleted-</td>
<td>deleted</td>
</tr>
<tr>
<td>+inserted+</td>
<td>inserted</td>
</tr>
<tr>
<td>Text with^{superscript}^</td>
<td>Text with^{superscript}</td>
</tr>
</tbody>
</table>
|                       | *Hint: There are two ways to make superscripts work, when used directly after another word or character:  
  - Add a space before the superscript. For example, kg/m \(^3\) gives you this: kg/m \(^3\)  
  - Add braces (curly brackets) around the superscript markup. For example, kg/m\(^3\) gives you this: kg/m\(^3\) |
| Text with{\~subscript\}~ | Text with{\~subscript\}~ |
| {{monospaced}}        | monospaced        |
| bq. Here's how you make a paragraph appear as a block quotation. | Here's how you make a paragraph appear as a block quotation. |
| {color:red}look ma, red text!{color} | look ma, red text! |

Text Breaks

Paragraph Break

In wiki markup, a paragraph is a continuous line of text ending in two carriage returns. This is equivalent to a continuous line of text followed by a blank line.
When rendered into HTML, the result is a line of text wrapped in a set of `<p></p>` tags.

**Line Break**

Confluence provides two options for forcing a line break within a paragraph of text:

- Implicitly, by entering a single carriage return at its end.
- Explicitly, by entering two consecutive backslashes: `\`

When rendered into HTML, the result is a paragraph of text that is split into separate lines by `<br>` tags, wherever a forced line break appears.

*For most purposes, explicit line breaks are not required because a single carriage return is enough.*

The examples below show how to use explicit line breaks.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>here is some text</td>
<td>here is some text</td>
</tr>
<tr>
<td><code>\</code></td>
<td>divided</td>
</tr>
<tr>
<td><code>\ </code></td>
<td>using line</td>
</tr>
<tr>
<td><code>\ </code></td>
<td>breaks</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>This is a short list:</td>
<td>This is a short list:</td>
</tr>
<tr>
<td>* Point 1</td>
<td>* Point 1</td>
</tr>
<tr>
<td>Text to go with point 1</td>
<td>Text to go with point 1</td>
</tr>
<tr>
<td>* Point 2</td>
<td>* Point 2</td>
</tr>
<tr>
<td><code>\ </code></td>
<td>Text to go with point 2 with a break</td>
</tr>
<tr>
<td><code>\ </code></td>
<td><code>\ </code></td>
</tr>
</tbody>
</table>

If you wish to use multiple consecutive line breaks, each should be separated by a space character. For example, use this for two consecutive line breaks: `\ `

**Horizontal Rule**

To create a horizontal line across the width of your page or content block, type four dashes (like this: `----`) at the beginning of a line, then press Enter or space.

Make sure that the dashes are on a separate line from the rest of the text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>here is some text</td>
<td>here is some text</td>
</tr>
<tr>
<td><code>----</code></td>
<td>divided by a horizontal rule</td>
</tr>
<tr>
<td>divided by a horizontal rule</td>
<td></td>
</tr>
</tbody>
</table>

**Links**

You can use wiki markup to add hyperlinks to your text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>[#anchor]</td>
<td>A link to an anchor on the same page.</td>
</tr>
<tr>
<td>[Confluence Wiki Markup^attachment.ext]</td>
<td>A link to a file attached to the page.</td>
</tr>
<tr>
<td>Link Pattern</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="http://www.host.com/image.gif!" alt="http://www.host.com/image.gif!" /></td>
<td>An image from a remote source is displayed on the page. Uses a fully qualified URL.</td>
</tr>
<tr>
<td><img src="" alt="attached-image.gif!" /></td>
<td>An image file attached to the page is displayed.</td>
</tr>
<tr>
<td><img src="" alt="pageTitle^image.gif" /></td>
<td>An image file attached to a different page is displayed.</td>
</tr>
<tr>
<td><img src="" alt="spaceKey:pageTitle^image.gif" /></td>
<td>An image file attached to a page in a different space is displayed.</td>
</tr>
<tr>
<td><img src="" alt="/2010/05/23/My Blog Post^image.gif" /></td>
<td>An image file attached to a blog post is displayed.</td>
</tr>
</tbody>
</table>

Note that Confluence treats headings as anchors, so you can link to headings using this pattern: `[spacekey:pagename#headingname]`, where headingname is case-sensitive and must be entered without spaces.

For each of these link forms:

- You can prepend a link alias, so that alternate text is displayed on the page. Example: `[link alias|pagetitle#anchor]`
- You can append a link tip, which appears as a tooltip. Example: `[pagetitle#anchor|link tip]`

### Images

You can display images from attached files or remote sources.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="http://www.host.com/image.gif!" alt="http://www.host.com/image.gif!" /></td>
<td>An image from a remote source is displayed on the page. Uses a fully qualified URL.</td>
</tr>
<tr>
<td><img src="" alt="attached-image.gif!" /></td>
<td>An image file attached to the page is displayed.</td>
</tr>
<tr>
<td><img src="" alt="pageTitle^image.gif" /></td>
<td>An image file attached to a different page is displayed.</td>
</tr>
<tr>
<td><img src="" alt="spaceKey:pageTitle^image.gif" /></td>
<td>An image file attached to a page in a different space is displayed.</td>
</tr>
<tr>
<td><img src="" alt="/2010/05/23/My Blog Post^image.gif" /></td>
<td>An image file attached to a blog post is displayed.</td>
</tr>
</tbody>
</table>
Image tags include:

<table>
<thead>
<tr>
<th>Image tag</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>align</td>
<td>Available values are 'left', 'right', 'bottom', 'center', 'top'.</td>
</tr>
<tr>
<td>border</td>
<td>Specifies the width of the border (in pixels).</td>
</tr>
<tr>
<td>bordercolor</td>
<td>Use with the 'border' tag. Specify colours by name or hex value.</td>
</tr>
<tr>
<td>hspace</td>
<td>Specifies the amount of whitespace to be inserted to the left and right of the image (in pixels).</td>
</tr>
<tr>
<td>vspace</td>
<td>Specifies the amount of whitespace to be inserted above and below the image (in pixels).</td>
</tr>
<tr>
<td>width</td>
<td>Specifies the width of the image (in pixels). This will override the natural width of the image.</td>
</tr>
<tr>
<td>height</td>
<td>Specifies the height of the image (in pixels). This will override the natural height of the image.</td>
</tr>
<tr>
<td>title</td>
<td>Specifies alternate text for the image, which is displayed when the pointer hovers over the image.</td>
</tr>
<tr>
<td>alt</td>
<td>Specifies alternate text for the image. This text is retrievable via search, and contributes to accessibility of the page for text-only viewing.</td>
</tr>
</tbody>
</table>

**Page Layouts**

There is no wiki markup representation for page layouts.

**Macros**

Storage format and wiki markup examples have been included in the documentation for each macro.

**Working with Confluence Gadgets**

This section introduces the concept of gadgets in Confluence and provides an outline on how to use gadgets in Confluence and other web applications.

**Introduction to Gadgets in Confluence**

A gadget is a small object (i.e. a piece of functionality) offering dynamic content that can be placed into the page of:

- An Atlassian application's website, such as a Confluence page or blog post or a JIRA 4.0+ dashboard.
- A third-party application's website, such as iGoogle or Gmail. (But see the limitations on using Confluence gadgets in other applications.)

Gadgets allow interactions between Confluence and other compatible websites. Confluence interacts with gadgets that support the OpenSocial specification.

For more information about Atlassian gadgets, please refer to the introduction to Atlassian gadgets and the big list of Atlassian gadgets.

**Using Gadgets in Confluence**

You can place any gadget that complies with the OpenSocial specification from an external source, such as iGoogle or other Atlassian applications such as JIRA 4.0+, onto a Confluence page or blog post. To add a gadget to a page, use the Confluence macro browser to add a Gadget macro.
Adding Confluence Gadgets in Other Applications

You can add a Confluence gadget to a JIRA dashboard or another Confluence site. In principle, you can also put a Confluence gadget on any other OpenSocial-compliant website such as iGoogle or Gmail. See the limitations on using Confluence gadgets in other applications.

Adding a Confluence Gadget to JIRA

See Adding a Confluence Gadget to a JIRA Dashboard.

Adding a Confluence Gadget to Non-Atlassian Web Applications

For instructions on how to add Confluence gadgets in another compatible non-Atlassian web application or container, refer to Configuring Confluence Gadgets for Use in Other Applications.

Confluence Gadgets

The Confluence Gadgets topic explains the purpose of the 'Confluence Gadgets' window and provides information about the gadgets which are bundled with Confluence.

Adding a Confluence Gadget to a JIRA Dashboard

JIRA 4.0 is the first major Atlassian application that can incorporate OpenSocial-compliant gadgets, such as Confluence gadgets onto its dashboard. This page explains how to add a Confluence gadget to the dashboard of a JIRA 4.0+ installation.

To add a Confluence gadget to a JIRA dashboard, complete the steps below.

Creating an Application Link between Confluence and JIRA

If your Confluence gadgets need to access user-restricted Confluence data, then your Confluence administrator must first establish an Application Link between your Confluence site and the JIRA site.

If you only need to access anonymously accessible Confluence data, then you can skip the section about adding an Application Link, and go directly to Finding a Confluence Gadget's URL, below.
On this page:
- Creating an Application Link between Confluence and JIRA
- Finding a Confluence Gadget's URL
- Adding a Confluence gadget to JIRA’s gadget directory
- Adding a Confluence gadget to the JIRA dashboard

Related pages:
- All Atlassian gadgets
- Working with Confluence Gadgets
- Confluence User's Guide

Finding a Confluence Gadget's URL

A gadget’s URL points to the gadget’s XML specification file. These URLs look something like this:

http://example.com/my-gadget-location/my-gadget.xml

To find a Confluence gadget's URL:

1. Choose the help icon at top right of the screen, then choose Available Gadgets.
2. Find the gadget you want.
3. Copy the Gadget URL link to your clipboard.

Adding a Confluence gadget to JIRA’s gadget directory

To add a Confluence gadget to the gadget directory in JIRA:
1. Go to the dashboard by clicking **Dashboard** at the top left of the screen.
2. The dashboard will appear. Click **Add Gadget**.
3. The 'Add Gadget' screen appears, showing the list of gadgets in your directory. See **screenshot 1** below. Click **Add Gadget to Directory**.
   
   Note: You will only see this button if you have system administrator permissions in JIRA.
4. The 'Add Gadget to Directory' screen appears. See **screenshot 2** below. Paste the gadget URL (which you copied to your clipboard above) into the text box.
5. Click **Add Gadget**.
6. The gadget appears in your gadget directory. (It will be highlighted for a short time, so that you can see it easily.)

**Screenshot 1: Gadget directory with 'Add Gadget to Directory' button**
Adding a Confluence gadget to the JIRA dashboard

In the procedure below, 'your Atlassian dashboard' and 'your Atlassian application' refers to the JIRA dashboard and application, respectively.

You can add a gadget from the directory of gadgets that are available to your Atlassian application.

**To add a gadget to your Atlassian dashboard,**

1. Go to the dashboard by clicking the 'Dashboard' link or the 'Home' link at the top left of the screen.
2. The dashboard will appear, looking something like screenshot 1 below. Click 'Add Gadget'.
3. The 'Add Gadget' screen will display a list of available gadgets in your gadget directory, as shown in screenshot 2 below. Find the gadget you want, using one or more of the following tools:
   - Use the scroll bar on the right to move up and down the list of gadgets.
   - Select a category in the left-hand panel to display only gadgets in that category.
   - Start typing a key word for your gadget in the 'Search' textbox. The list of gadgets will change as you type, showing only gadgets that match your search term.
4. When you have found the gadget you want, click the 'Add it Now' button to add the gadget to your dashboard.

*Screenshot 1: An Atlassian dashboard*
Note:

- You need administrator privileges to add a gadget to the list of available gadgets. If you have permission to add gadgets to and remove gadgets from the directory itself, you will see the 'Add Gadget to Directory' and 'Remove' buttons on the 'Add Gadget' screen, as shown in the screenshot about. Please refer to the Gadgets and Dashboards Administration Guide.
- In Atlassian OnDemand products, it is not possible for administrators to add gadgets to the directory. If you would like to add an Atlassian gadget to a directory, please contact Atlassian Support.

Configuring Confluence Gadgets for Use in Other Applications

This page tells you how to add a Confluence gadget to another (external) application. The instructions and examples given in this topic focus on adding and using Confluence Gadgets in other web applications.

**Atlassian support does not cover gadgets on external sites like iGoogle and Gmail**

In principle, you should be able to add Atlassian gadgets to iGoogle, Gmail and other external sites that support OpenSocial gadgets. However, these external integrations are experimental at this stage and we have encountered problems with them. Please do have fun playing around with them, but be aware that Atlassian does not support the use of Atlassian gadgets on iGoogle, Gmail or other external web sites. See the detailed section on gadget limitations.

Gadgets that display information from Atlassian applications, such as Confluence, should be able to run on iGoogle, Gmail and other web applications that provide OpenSocial containers. Below are specific instructions for iGoogle and Gmail. You can experiment by adding a Confluence gadget to other web sites and applications, such as a Ning community like The Content Wrangler.

On this page:

- Overview of Adding a Confluence Gadget to Another Web Application
- Finding a Confluence Gadget's URL
- Adding an Atlassian Gadget to iGoogle
- Adding an Atlassian Gadget to Gmail
- Limitations and Support
- Related Topics
Overview of Adding a Confluence Gadget to Another Web Application

The exact procedure for adding a Confluence gadget depends on the application where you want to add the gadget. The basic steps are the same:

1. Find the Confluence gadget's URL, i.e. the URL for the gadget's XML specification file.
2. Ensure one of the following two mandatory (typically one-off) procedures have been conducted:
   - An OAuth relationship between Confluence (as the 'service provider') and the other web application (as the 'consumer') has been established. Refer to Configuring Authentication for an Application Link for more information about OAuth and instructions on establishing these relationships.
   - A Trusted Applications relationship between Confluence and JIRA has been established. Refer to Configuring Trusted Applications in the JIRA documentation for more information about establishing these relationships.
3. Follow the procedure provided by the external web application where you want to add the Confluence gadget.

Finding a Confluence Gadget's URL

A gadget's URL points to the gadget's XML specification file. These URLs look something like this:

http://example.com/my-gadget-location/my-gadget.xml

To find a Confluence gadget's URL:

1. Choose the help icon at top right of the screen, then choose Available Gadgets.
2. Find the gadget you want.
3. Copy the Gadget URL link to your clipboard.

Adding an Atlassian Gadget to iGoogle
You can customise your iGoogle home page by adding gadgets and moving them around on the page.

**To add an Atlassian gadget to your iGoogle page:**

1. First find the gadget's URL as described above.
2. Go to iGoogle and log in if you have a username and password.
3. Click Add stuff near the top right of the iGoogle page.
4. The Google gadget directory will appear, showing a list of available gadgets. Click Add feed or gadget in the right-hand panel.

   ![Add feed or gadget](image)

   **Information for Feed owners - Developers**

5. A text box will open, as shown above. Enter or paste the gadget's URL from your clipboard into the textbox and click Add.
6. Go back to your iGoogle home page. The gadget will appear on your iGoogle page.

**Adding an Atlassian Gadget to Gmail**

You can add gadgets to the left-hand panel of your Gmail page.

**To add an Atlassian gadget to your Gmail page:**

1. First find the gadget's URL as described above.
2. Log in to Gmail.
3. Click Settings near the top right of the Gmail page. The Gmail settings page will appear.
4. Click the Labs tab. The Gmail Labs page will appear. This is a laboratory area or testing ground where Google allows you to use experimental features in Gmail.
5. Scroll down to find the feature called 'Add any gadget by URL'.
6. Select the Enable option, as shown here:

   ![Enable Disable](image)

   **Add any gadget by URL**

   Adds a "Gadgets" tab to Settings, where you'll be able to specify the URL of any gadget. This gadget will show in a box in the left column.

7. Click Save Changes.
8. A new Gadgets tab will appear on your 'Settings' page. Click the Gadgets tab. The 'Gadgets' page will appear, as shown in the screenshot below.
9. Enter or paste your gadget's URL into the Add a gadget by its URL box, then click Add.
10. The gadget will appear in the left-hand panel of your Gmail page, as shown in the screenshot below.

![Screenshot: Adding a gadget to Gmail](image)
Limitations and Support

⚠️ Atlassian support does not cover gadgets on external sites like iGoogle and Gmail

In principle, you should be able to add Atlassian gadgets to iGoogle, Gmail and other external sites that support OpenSocial gadgets. However, these external integrations are experimental at this stage and we have encountered problems with them. Please do have fun playing around with them, but be aware that Atlassian does not support the use of Atlassian gadgets on iGoogle, Gmail or other external web sites. See the detailed section on gadget limitations.

Related Topics

The big list of Atlassian gadgets
Confluence Gadgets

This page describes the purpose of the 'Confluence Gadgets' dialog and how to access it, and provides information about the gadgets that are bundled with Confluence.

Gadgets:

- Interact with and provide access to data in your Confluence installation.
- Can be used externally such as on a JIRA dashboard, a page or blog post of another Confluence site, or any compatible page on a website that accepts gadgets, such as iGoogle. (But see the limitations on using Confluence gadgets in other applications.)

The gadgets dialog

The 'Confluence Gadgets' dialog displays a list of all the Confluence gadgets available in your Confluence installation. The Confluence gadgets bundled with Confluence are described below. Any additional Confluence gadgets installed by your Confluence administrator (typically as Confluence plugins), will also appear in this list.
To access the Confluence Gadgets dialog: Choose the help icon at top right of the screen, then choose Available Gadgets.

You can use a Confluence gadget within the same Confluence site, by adding it to a page or blog post using the gadget macro.

You can also add Confluence gadgets to external applications. See Adding a Confluence Gadget to a JIRA Dashboard and Configuring Confluence Gadgets for Use in Other Applications.

**On this page:**
- The gadgets dialog
- Confluence gadgets

**Related pages:**
- Adding a Confluence Gadget to a JIRA Dashboard
- Configuring Confluence Gadgets for Use in Other Applications
- Gadget Macro
- The big list of Atlassian gadgets
- Confluence User's Guide

**Screenshot: The 'Confluence Gadgets' dialog**

**Confluence gadgets**

This following table lists the gadgets which are bundled with Confluence. Click the name of the gadget for more information.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Confluence Page Gadget
The Confluence page gadget allows you to show content from a page on your Confluence site in a gadget. You can optionally configure the gadget to display links to view and/or edit the page on your Confluence site. The page gadget can also be displayed in canvas view, so that it takes up all of the space provided by your dashboard.

Activity Stream Gadget
The activity stream gadget is similar to the recently updated macro and shows a list of the most recently changed content within your Confluence site.

Confluence News Gadget
The Confluence news gadget is an example of a 'news feed' gadget that shows a list of recent Confluence Product Blogs and events at Atlassian.

Confluence Quicknav Gadget
The Confluence QuickNav gadget provides the Quick Navigation Aid functionality for searching the Confluence site. For more information on how to use this feature, refer to the Quick Navigation Aid section of Searching Confluence.

Activity Stream Gadget
The activity stream gadget is similar to the recently updated macro and shows a list of the most recently changed content within your Confluence site.

For instructions on how to use Confluence gadgets in your applications, please see Confluence Gadgets.

In addition to showing a list of most recently changed content, the activity stream gadget also groups activities by separate date, and provides an RSS feed link to its content in the top-right corner.

Activity Stream Gadget Properties
Properties are settings for Confluence gadgets that allow the user to control the content or presentation of data retrieved by the gadget. These are similar to a Confluence macro's parameters. The table below lists relevant properties for this gadget.

<table>
<thead>
<tr>
<th>Property</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Yes</td>
<td>None</td>
<td>Adds a title to the top of the Activity Stream.</td>
</tr>
<tr>
<td>Spaces</td>
<td>No</td>
<td>None specified (i.e. display content in all spaces)</td>
<td>Filters the content by space. This gadget will display only the pages etc. which belong to the space(s) you specify here.</td>
</tr>
<tr>
<td>Username</td>
<td>No</td>
<td>None specified (i.e. display content by all users)</td>
<td>Filters the results by user. The macro will display only the pages etc. which were last modified by the user(s) you specify here. You can specify one or more user, separated by a comma or a space.</td>
</tr>
<tr>
<td>Number of Entries</td>
<td>No</td>
<td>10</td>
<td>Specify the maximum number of results to be displayed. A maximum of 10 results will be displayed by default. The maximum value that this property can accept is 100.</td>
</tr>
<tr>
<td>Refresh Interval</td>
<td>No</td>
<td>Never/false</td>
<td>Specify the time interval between each 'refresh' action undertaken by the activity stream gadget. A refresh makes the activity stream gadget reflect any new activity that has been conducted on the Confluence site.</td>
</tr>
</tbody>
</table>

Confluence News Gadget
The Confluence news gadget is an example of a 'news feed' gadget that shows a list of recent Confluence Product Blogs and events at Atlassian.

For instructions on how to use Confluence gadgets in your applications, please see Confluence Gadgets.

Clicking an item in the Confluence news gadget takes you directly to the selected blog post of the Confluence
Product Blogs feed or event details on the events at Atlassian page.

Clicking More news takes you to the Confluence Product Blogs feed page and clicking More events takes you to the events at Atlassian page.

Screenshot: The News Gadget

<table>
<thead>
<tr>
<th>Property</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show News?</td>
<td>No</td>
<td>True</td>
<td>Shows a short list of the most recent Confluence Product Blogs.</td>
</tr>
<tr>
<td>Show Events?</td>
<td>No</td>
<td>True</td>
<td>Shows a short list of the most recent events at Atlassian.</td>
</tr>
<tr>
<td>Show Banners?</td>
<td>No</td>
<td>True</td>
<td>Shows any banner advertisements (if available).</td>
</tr>
</tbody>
</table>

Confluence Page Gadget

The Confluence page gadget allows you to show content from a page on your Confluence site in a gadget. You can optionally configure the gadget to display links to view and/or edit the page on your Confluence site. The page gadget can also be displayed in canvas view, so that it takes up all of the space provided by your dashboard.

For instructions on how to use Confluence gadgets in your applications, please see Confluence Gadgets.

Macros that work with the page gadget

Please note, not all macros work with the page gadget. Please refer to the Working Macros section below for more information.
On this page:
- Confluence Page Gadget Properties
- Working Macros

Related pages:
- Confluence Gadgets
- Confluence User’s Guide

Screenshot: The Confluence page gadget displaying a sample page

Sample Page

Two penguins find themselves together on an ice floe, drifting helplessly into warmer waters. The penguins are very fond of each other. Suddenly, the ice floe splits in half, right between the penguins. As they drift apart, one penguin sadly waves a flipper and calls out "Chocolate milk!"

Confluence Page Gadget Properties

Properties are settings for Confluence gadgets that allow the user to control the content or presentation of data retrieved by the gadget. These are similar to a Confluence macro’s parameters. The table below lists relevant properties for this gadget.

<table>
<thead>
<tr>
<th>Property</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>No</td>
<td>None</td>
<td>Specify the space that your desired page is located in. Suggestions will display in a dropdown when you start typing. (Note, this property is only used to make searching for pages easier. It is not required.)</td>
</tr>
<tr>
<td>Page</td>
<td>Yes</td>
<td>None</td>
<td>Specify the page that you want to display in your gadget. Suggestions will display in a dropdown when you start typing.</td>
</tr>
<tr>
<td>Show View Link</td>
<td>No</td>
<td>Yes</td>
<td>Select whether to display a link to view the page on your Confluence site. Clicking the link will open the page in Confluence.</td>
</tr>
<tr>
<td>Show Edit Link</td>
<td>No</td>
<td>No</td>
<td>Select whether to display a link to edit the page on your Confluence site. Clicking the link will open the page for editing in Confluence.</td>
</tr>
<tr>
<td>Refresh Interval</td>
<td>No</td>
<td>Never/true</td>
<td>Specify the time interval between each 'refresh' action undertaken by the page gadget. A refresh makes the activity stream gadget reflect any new activity that has been conducted on the Confluence site.</td>
</tr>
</tbody>
</table>

Working Macros

The Confluence page gadget will only render a subset of the macros that are used in Confluence correctly. Refer to the table below for the list of macros that work and do not work with the page gadget and known limitations.

- Some of the issues with macros in the page gadget can be worked around, if you are comfortable...
developing in Confluence. Please see Troubleshooting Macros in the Page Gadget for more information.

Key:
- ✔ Works with the page gadget
- * Partially works with the page gadget
- ✗ Does not work with the page gadget

<table>
<thead>
<tr>
<th>Macro</th>
<th>Works with page gadget?</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Stream</td>
<td>✗</td>
<td>You cannot have another gadget embedded within the Confluence Page Gadget</td>
</tr>
<tr>
<td>Anchor (within a page)</td>
<td>✔ *</td>
<td>Opens in a new page</td>
</tr>
<tr>
<td>Attachments</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Blog Posts</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Chart</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Children Display</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Content By Label</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Content By User</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Excerpt</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Gallery</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Include Page</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Info</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Labels List</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Livesearch</td>
<td>✗</td>
<td>N/A</td>
</tr>
<tr>
<td>Note</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Metadata</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Metadata Summary</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Pagetree Search</td>
<td>✗</td>
<td>N/A</td>
</tr>
<tr>
<td>Pagetree</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Panel</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Quick Nav</td>
<td>✗</td>
<td>You cannot have another gadget embedded within the Confluence Page Gadget</td>
</tr>
<tr>
<td>Recently Updated</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>------------------</td>
<td>---</td>
<td>-----</td>
</tr>
<tr>
<td>RSS Feed</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Section &amp; Column</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Spaces List</td>
<td>✔</td>
<td>N/A</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>✔</td>
<td>Works, however links will be opened in a new browser window when clicked.</td>
</tr>
<tr>
<td>Team Calendars</td>
<td>❌</td>
<td>See here for the Improvement Request: &lt;a href=&quot;TEAMCAL-862&quot;&gt;TEAMCAL-862&lt;/a&gt;- Make Team Calendars display in a Confluence Page Gadget, for use on a JIRA Dashboard REOPENED</td>
</tr>
<tr>
<td>View File (PDF or PPT)</td>
<td>✔</td>
<td>Works, but you may need to refresh the gadget the first time (see CONF-19932).</td>
</tr>
<tr>
<td>Widget Connector</td>
<td>✔</td>
<td>Only works for some content:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Works</strong>: blip.tv, Episodic, Flickr, Google Calendar, presentations on Google Docs, MySpace Video, Scribd, Skitch.com, SlideRocket, SlideShare, Viddler, Vimeo, YouTube, Dailymotion, Metacafe, FriendFeed, Yahoo Video, Wufoo HTML Form Builder</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Does not work</strong>: FriendFeed, Google Gadgets, Google Video (consumer service discontinued), Twitter, Widgetbox, DabbleDB, BackType</td>
</tr>
</tbody>
</table>

Confluence Quicknav Gadget

The Confluence QuickNav gadget provides the Quick Navigation Aid functionality for searching the Confluence site. For more information on how to use this feature, refer to the Quick Navigation Aid section of Searching Confluence.

ℹ️ For instructions on how to use Confluence gadgets in your applications, please see Confluence Gadgets.

**Screenshot: Using the QuickNav Gadget**

Confluence QuickNav Gadget Properties

This gadget has no properties and cannot be customised.

**Adding JIRA Gadgets to a Confluence Page**
The Confluence Gadget macro is a specific type of macro which is used to display gadgets, including JIRA gadgets, in a Confluence page. Once you have configured external gadgets in the Confluence Administration Console, they will appear in the Macro Browser.

Before you can start adding JIRA Gadgets:

- Your JIRA administrator will need to configure JIRA to trust Confluence via Application Links. (Not required if your JIRA site allows anonymous access)
- Your Confluence administrator will need to add the JIRA gadget URL to the list of authorised external gadgets in Confluence.

To add a JIRA Gadget to a Confluence page:

- Choose Insert > Other Macros.
- Navigate to the gadget you wish to add to the page and choose Insert.

Refer to the Gadget Macro page for more information on adding the macro to your page.

Developing Technical Documentation on Confluence Wiki

Confluence now ships with a space blueprint for creating documentation spaces. It has a homepage that can be customised to suit your needs and the sidebar displays all pages in the space in a page tree.

Go to Create Space > Documentation Space to try it out for yourself.

Welcome! This is a guide to using Confluence wiki for technical documentation. You will find this guide useful if you want to write a technical manual such as a user's guide, administrator's guide, installation guide, and so on.

- Creating your Technical Documentation Space
- Using Templates in Technical Documentation
- Re-using Content in Technical Documentation
- Managing the Life Cycle of your Technical Documentation
- Providing PDF Versions of your Technical Documentation
- Exporting and Printing Technical Documentation
- Essential Confluence Features for Technical Documentation
- Confluence Add-ons for Technical Documentation
- Further Reading about Developing Technical Documentation on Confluence

Creating your Technical Documentation Space

This guide is for people who want to develop and publish technical documentation on Confluence wiki. You will find it useful if you want to write a technical manual such as a user's guide, administrator's guide, installation guide, and so on. This page is a quick-start guide to creating a wiki space for technical documentation.

Quick guide to creating a technical documentation space:

- Add a space and select the Documentation theme.
- Set the space permissions.
- Change the title and content of the space home page.
- Customise the Documentation theme.
- Create an inclusions library to manage your re-usable content.
- Create the table of contents for your manual or manuals, by adding top-level pages for all the usual sections (user's guide, administrator's guide, and so on).
- Customise your PDF layout and stylesheet, if required.
- Hint: Now that you have a good skeleton for a documentation space, save the space as a template space.

The rest of this page gives more details of the above procedure.
On this page:
- Step 1. Add your space
- Step 2. Set the space permissions
- Step 3. Customise the title and content of the space home page
- Step 4. Customise the Documentation theme
- Step 5. Create an inclusions library
- Step 6. Create the table of contents
- Step 7. (Optional) Customise the PDF layout and stylesheet
- Step 8. Save your new space as a template

**Step 1. Add your space**

Below is a quick guide to adding a space. See [Creating a Space](#) for a full description.

1. Go to the Confluence dashboard and choose **Create Space** > **Blank Space**. *Hint:* If you cannot see **Create Space**, this means that you do not have permission to add spaces. Please contact your Confluence administrator.
2. Choose **Next** then enter a **space name** and a short, unique **space key**.
3. Leave the **permission** settings as default, or choose to allow only yourself to view or contribute content to this space. You can change these settings later and with more flexible options.
4. Choose **Create**.
5. Your new space appears. Choose **Space Tools** in the sidebar.
6. Choose **Look and Feel** > **Themes** and select the **Documentation** theme.
7. Choose **OK**.

The home page of your new space will appear. Because you created the space, you are the space administrator. Now you can do some basic configuration, as described in the sections below. From this point on, instructions will refer to navigating in the Documentation theme, which is slightly different to the default theme.

**Step 2. Set the space permissions**

Define the space permissions to determine who can do what in your new space.

1. Choose **Browse** > **Space Admin** at the top of the screen. *Note:* The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose **Permissions**.
3. Choose **Edit Permissions**.
4. Set the permissions to suit your needs then choose **Save All**.
   - You can add **groups** and/or individual **users** to the list, then select the permissions for each group or user.
   - You can also set the permissions for **anonymous** users – these are people who have not logged in to the wiki. Anonymous access is available only if enabled for the entire Confluence site.
   - Note that you can change these permissions at any time. You may want to restrict the permissions to specific groups now, and later open the space to more people.

A bit more about permissions

Confluence has a robust and granular permissions scheme that you can use to determine who can view, comment on and even update the documentation. There are three levels of permissions in Confluence:

- Global permissions apply across the entire site.
- Space permissions apply to a space.
- Page restrictions allow you to restrict the editing and/or viewing of a specific page. Below we discuss a way of using these in the draft, review and publishing workflow.

**Space permissions** in Confluence are simple yet granular enough to be useful for technical documentation. You can:

- Use the permission levels to control who can create pages in the space, delete pages, create comments, delete comments, administer the space, and so on.
- Grant a permission level to one or more users, and/or to one or more groups, and/or to anonymous users.

Terminology:
• ‘Anonymous’ means people who have not logged in to the wiki.
• The ‘confluence-users’ group is the default group into which all new users are assigned (this group may also be called ‘users’). Everyone who can log in to Confluence is a member of this group.

For example, you might allow your team full edit and administration rights while others can only add comments. Or you might grant the general public access to your documentation, while only staff members can update it.

<table>
<thead>
<tr>
<th>Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>These are the permissions currently assigned to groups for this space.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>All</th>
<th>Pages</th>
<th>Blog</th>
<th>Comments</th>
<th>Attachments</th>
<th>Mail</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View</td>
<td>Add</td>
<td>Restrict</td>
<td>Remove</td>
<td>Add</td>
<td>Remove</td>
<td>Add</td>
</tr>
<tr>
<td>confluence-users</td>
<td>✔️</td>
<td>✗️</td>
<td>✗️</td>
<td>✗️</td>
<td>✔️</td>
<td>✗️</td>
<td>✗️</td>
</tr>
<tr>
<td>my-team</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

[Edit Permissions]

<table>
<thead>
<tr>
<th>Individual Users</th>
</tr>
</thead>
<tbody>
<tr>
<td>These are the permissions currently assigned to individual users for this space.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>All</th>
<th>Pages</th>
<th>Blog</th>
<th>Comments</th>
<th>Attachments</th>
<th>Mail</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View</td>
<td>Add</td>
<td>Restrict</td>
<td>Remove</td>
<td>Add</td>
<td>Remove</td>
<td>Add</td>
</tr>
<tr>
<td>jake admin (admin)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

[Edit Permissions]

<table>
<thead>
<tr>
<th>Anonymous Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>When a user is using Confluence while not logged in, they are using it anonymously. For example: Enabling anonymous ‘commenting’ permission, allows non-logged-in users to make comments in this space.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>All</th>
<th>Pages</th>
<th>Blog</th>
<th>Comments</th>
<th>Attachments</th>
<th>Mail</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View</td>
<td>Add</td>
<td>Restrict</td>
<td>Remove</td>
<td>Add</td>
<td>Remove</td>
<td>Add</td>
</tr>
<tr>
<td>Anonymous</td>
<td>✗️</td>
<td>✗️</td>
<td>✗️</td>
<td>✗️</td>
<td>✗️</td>
<td>✗️</td>
<td>✗️</td>
</tr>
</tbody>
</table>

[Edit Permissions]

For detailed information, see the documentation on:

- Global permissions
- Space permissions
- Page restrictions
- Users and groups

**Step 3. Customise the title and content of the space home page**

When you created your space, Confluence created a home page with default content and a default title. You will want to change the title and content.

1. Go to your space home page.
2. By default, the page title is ‘X Home’, where ‘X’ is the name you gave the space.
3. Choose Edit.
4. The page opens in the editor. Change the title to suit your needs.
5. Update the content to suit your needs. 
   *Hint:* If you do not know what to add yet, just add a short description. You can refine the content of the page later. Take a look at an example of a home page.

6. Choose Save.

**Step 4. Customise the Documentation theme**

When you added the space you chose the Documentation theme, which provides a left-hand navigation bar and a good look and feel for technical documentation. If necessary, you can configure the Documentation theme to add your own page header and footer or to customise the default left-hand navigation bar. These customisations affect the online look and feel of your documentation. See Configuring the Documentation Theme for the full description.

1. Choose Browse > Space Admin. (If you have not yet applied the Documentation theme choose Space Tools > Look and Feel > Themes.)
2. Choose Themes in the left menu.
3. If the space is not yet using the Documentation theme, apply the theme now.
4. Choose Configure theme.

5. The ‘Documentation Theme Configuration’ screen appears. Customise the left-hand navigation bar, header and footer to suit your needs. Details are in the documentation. Here are some hints:
   - The Page Tree check box determines whether your space will display the default search box and table of contents (page tree) in the left-hand panel.
   - The Limit search results to the current space check box determines whether Confluence will search only the current space or the whole Confluence site. This setting affects the default search. Viewers can override it each time they do a search.
   - Enter text, images, macros and other wiki markup into any or all of the three text boxes for the the left-hand navigation bar, header and footer. You can use the Include macro and the Excerpt Include macro to include re-usable content.
   - Any content you add to the navigation panel will appear above the default page tree.
   - If you like, you can remove the default page tree (by unticking the box) and add your own, customised version of the Pagetree macro instead.

6. Choose Save.
**Example of a customised footer**

Take a look at the footer of a page in the Crowd documentation space.

To produce the above footer, we have the following content in the footer panel in the Documentation theme configuration screen:

```
Footer
{include:_Documentation Footer|nopanel=true}
{include:ALLDOC:_Copyright Notice|nopanel=true}
```

Here it is in text form:

```
{include:_Documentation Footer|nopanel=true}
{include:ALLDOC:_Copyright Notice|nopanel=true}
```

The above content consists of two *Include macros*.

- The first macro includes a page called _Documentation Footer. This page contains the big blue buttons and hyperlinked text.
- The second macro includes a page from a different space, the ALLDOC space, called _Copyright Notice. This page includes our standard copyright notice, used in all our documentation spaces.

**Step 5. Create an inclusions library**

In Confluence, you can dynamically include content from one page into another page. You can include a whole page into another one, using the *Include macro*. You can also define an ‘excerpt’ on a page, and then include that excerpted text into another page using the *Excerpt Include macro*.

To organise your re-usable content, we recommend that you create a set of pages called an 'inclusions library'.

1. Choose Create and create a new page in your space.
2. Enter a suitable title. We use '_InclusionsLibrary'. The unusual format of the title helps to let people know this page is special.
3. Enter some content and save the page. We enter text explaining the purpose of the inclusions library and how to re-use the content. You can copy our text by clicking through to one of the example pages listed below.
4. Choose Browse > Pages and drag your new page above the space homepage.
5. Go to your new inclusions page and choose Create to add child pages containing your re-usable content. See the examples of our own inclusions libraries listed in the examples below.
Some notes about inclusions libraries:

- The inclusions library is not a specific feature of Confluence. The pages in the inclusions library are just like any other Confluence page.
- The pages are located at the root of the wiki space, not under the home page. This means that they will not appear in the table of contents on the left and they will not be picked up by the search in the left-hand navigation bar either.
- The pages will be picked up by other searches, because they are just normal wiki pages.
- We have decided to start the page name with an underscore. For example, '_My Page Name'. This indicates that the page is slightly unusual, and will help prevent people from changing the page name or updating the content without realising that the content is re-used in various pages.

Examples of inclusions libraries

Here are some examples in our documentation:

- Crowd inclusions library
- Confluence inclusions library

**Step 6. Create the table of contents**

Create the table of contents for your documentation, by adding the top-level pages for all the usual sections:

- User's guide
- Administrator's guide
- Installation guide
- Configuration guide
- Release notes
- FAQ
- Whatever else you need

Follow these steps to create the table of contents:

1. Go to your space home page.
2. Choose Create to add a page as a child of the homepage.
3. Type the page title, 'User's Guide'.
4. Type the content of the page.
   *Hint: If you do not know what to add yet, just add a short description then refine the content of the page later. If you like, you can add the Children macro. That will act as a table of contents on the page once you have added child pages.*
5. Choose Save.

Now do the same for all the sections of your technical document.

**Step 7. (Optional) Customise the PDF layout and stylesheet**

If you are planning to provide PDF versions of your documentation, you may want to customise the PDF layout and styles for your space. You can skip this step for now and do it later, if you prefer. The instructions are in a separate section of this guide, dedicated to PDF. See Providing PDF Versions of your Technical Documentation.

**Step 8. Save your new space as a template**

This is a useful suggestion. Once you have set up your first documentation space and are more-or-less happy with it, use the Copy Space add-on (see notes below) to copy the space while it still has very little content. From this point on, you can copy it each time you want to create a new documentation space.

1. Choose Browse > Space Admin
2. Choose Copy Space in the left menu
   *Hint: If you cannot see the 'Copy Space' option, this means that the add-on is not installed on your Confluence site. Refer to the documentation on installing add-ons. (Not applicable to Confluence Cloud.)*
3. The 'Copy Space' screen will appear. Enter the details as prompted, to copy your space to another new space.
4. Choose **Save**.

You now have a template space. From this point on, you can use the Copy Space add-on to copy the template space each time you want to create a new documentation space.

Notes:

- The Copy Space add-on is not covered by Atlassian support. However, the Atlassian technical writers use it for all our documentation. If you like, you can vote for an comment on the request for Atlassian support to cover this add-on: CONF-14198.
- Your site administrator will need to install the Copy Space add-on into Confluence. Refer to the documentation on installing add-ons. **Not applicable to Confluence Cloud.**

Next Steps

You now have the basic structure and configuration for your technical documentation space. You have also created a handy template to use next time you need a space. What next? Take a look at **Using Templates in Technical Documentation**.

Using Templates in Technical Documentation

This page is part of the guide to developing technical documentation on Confluence Wiki. We have already shown you how to create your technical documentation space. Now we offer an introduction to the templates that Confluence provides.

**Quick guide to templates in Confluence:**

- A template is a page with predefined content that can be used as a prototype when creating other pages.
- Templates are available across the Confluence site (global templates) or per space (space templates).
- Both 'global templates' and 'space templates', as described on this page, define the content of a page. They do not define the content of an entire space.
- To create a template for an entire space, see our guide to creating your documentation space.
- Confluence blueprints provide predefined templates and added functionality.
- You can import predefined templates from the Atlassian Marketplace.
Deciding where to put your templates

Decide whether your template is useful across more than one space.

- If yes, create a global template. You will need Confluence administrator permissions.
- If no, create a space template.
  - You will need space administrator permissions for the relevant space(s).
  - You may have already saved your documentation space as a template, as described in our guide to creating your documentation space. In that case, it may be useful to save your template page in your template space. When you later copy the space, the template pages will be copied too.

Creating a global template

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Global Templates and Blueprints in the left-hand panel.
3. Choose Add New Global Template.

See Administering Site Templates for more information.

Creating a space template

1. Choose Browse > Space Admin at the top of the screen. *Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose Templates from the space administration options.
3. Choose Create new template.

See Adding a Template for more information.

Importing templates

If you have System Administrator permissions, you can download pre-defined templates from the Atlassian Marketplace in the form of a template bundle. Each template bundle contains one or more templates, created by Atlassian or third parties. See Importing Templates.

Using templates provided by blueprints

A blueprint is a page template with added functionality to help you create, manage and organise content in Confluence.

Confluence ships with some predefined blueprints. You can also download additional blueprints from the Atlassian Marketplace. You can customise the blueprint templates to suit your individual needs and even develop your own blueprints.

See Working with Blueprints.

Using a template to create a page

When people create a page on your Confluence site, they can choose to base their new page on a template.

1. Go to the page that will be the parent of your new page, and choose Create.
2. You will see a list of all available templates. Select a template then choose Next.

Next Steps

You now have a good idea of how Confluence templates work. What next? Take a look at Re-using Content in Technical Documentation.

Re-using Content in Technical Documentation
This page is part of the guide to developing technical documentation on Confluence Wiki. In the page about creating your technical documentation space, we showed you how to set up an 'inclusions library' to contain content that you can re-use on more than one page. Now we offer further guidelines on re-using content in your documentation space.

Your documentation may be about using a software application, or it may be a technical manual for your product range. On this page, we use the term 'widget' to describe the things that you are documenting, such as the screen, form, document, product or object.

**Quick guide to re-using content:**

- Create an 'inclusions library' to manage your re-usable content. See our guide to creating your technical documentation space.
- Use the excerpt macro to define a re-usable section ('excerpt') on a page, or just decide to re-use the entire content of the page.
- Use the excerpt-include macro to include the excerpt from one page onto another page.
- Use the include macro to include the entire content of a page onto another page.
- Consider installing the Multi Excerpt add-on if you need to define multiple excerpts per page.

The rest of this page gives an overview and more details of the above procedures.

**On this page:**
- Reasons for re-using content
- Defining an inclusions library
- Working with excerpts and inclusions
  - Using the Include Page macro
  - Using the Excerpt Include macro
  - Using the Multi Excerpt add-on
- An example of content re-use: a glossary
  - Creating a one-page glossary
  - Creating a glossary with child pages
  - Referring to glossary terms
- Further reading

**Reasons for re-using content**

A golden rule for technical documentation is to write the content only once but allow that content to be used in many places and in many forms.

For example, you may have the following types of content:

- A technical manual that describes each widget in detail.
- Tips and tricks on how to get the most out of the widget.
- A step-by-step user guide for first-time users on how to use the most common widgets.
- A training manual with exercises or videos that people can follow in their own time.
- A one-page cheat sheet for users to stick up on their workstation.
- Text for a sales brochure that is sent out to a print house for production.

Each of these types of content will share common information, such as a glossary entry, a technical or marketing description of the widget, or a step-by-step guide on how to use the widget.

Some initial planning of your technical documentation will allow you to re-use any or all of the content you write, so there is only ever one place to update the content, and those changes flow through to all of your other documentation.

**Defining an inclusions library**

We recommend that you create an 'inclusions library' to manage your re-usable content. If you have not already done this, see our guide to creating your technical documentation space.

**Working with excerpts and inclusions**

Excerpts and inclusions (sometimes called 'includes') are very useful for re-using content:

- Use the Excerpt macro (excerpt) to define a re-usable section ('excerpt') on a page.
- Use the Excerpt Include macro (excerpt-include) to include the excerpt on another page.
- Use the Include Page macro (include) to include the entire content of a page onto another page.
A simple use case for an inclusion is a note or warning that is used in many places in your documentation. Here is an example:

![Example note -- "Draft in progress"
This document is still in draft status. Please treat the content with caution.]

Tip: Keep your re-usable pages short and sweet. Do not worry if you find that you need hundreds of pages to hold your inclusions. It helps to keep things separate and organised.

Using the Include Page macro

In this example, we use the Include Page macro to create a note that you can re-use on your documentation pages. The Include Page macro will include the entire content of one page into another page.

1. Create a page in your inclusions library called _Draft Note._
2. Add the content of the page. In this example, we use the Note macro with some text in the title and body:

   {note:title=Draft in progress}This document is still in draft status. Please treat the content with caution.{note}

3. Use the Include Page macro to include that note in any page in your documentation. For example:

   {include:_Draft Note|nopanel=true}

See the documentation on the Include Page macro for more details.

Using the Excerpt Include macro

An excerpt is a section of a page that you can include into another page.

1. Use the `excerpt` macro to define any content in your page that you want to be able to use elsewhere. This content can be as short as a word or as long as the entire page. For example, let's assume we have a page called 'My Short Poem':

   I really love this poem:
   {excerpt}
   Mary had a little lamb
   Its fleece was white as snow
   {excerpt}
   And I'm going to use it all over the place.

2. Use the Excerpt Include macro to include the excerpt into another page. For example:

   {excerpt-include:My Short Poem|nopanel=true}

You can only define one excerpt on a page. See the documentation on the Excerpt Include macro for more details.

To have multiple excerpts on a page, see the 'Multi Excerpt add-on' below.

Using the Multi Excerpt add-on

The Multi Excerpt add-on provides additional macros that enable you to have multiple excerpts on a page. A good example of where you would find this useful is in the glossary page discussed below. If you want to include a single glossary entry or a subset of the glossary entries in another page, then the named excerpts provided by the Multi Excerpt add-on are very useful.

Notes:
The Multi Excerpt add-on is a commercial add-on and is not free.
Your Confluence system administrator will need to download and install the add-on into your Confluence site before you can use the macros described below. Refer to the documentation on installing add-ons.
Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support. Please refer to the Multi Excerpt add-on page for support details.

To have multiple excerpts on a page:

1. Use the following code on the base page containing the content you want to use elsewhere:

```plaintext
{multi-excerpt:name=ExcerptName1}
Excerpt text 1
{multi-excerpt}
Any other text
{multi-excerpt:name=ExcerptName2}
Excerpt text 2
{multi-excerpt}
```

2. Use the following code on the page where you want to include the named excerpt:

```plaintext
{multi-excerpt-include:pageTitle=PageName|name=ExcerptName1|nopanel=true}
```

3. You can also include excerpts from other spaces using the following syntax:

```plaintext
{multi-excerpt-include:spaceKey:pageName|name=excerptName|nopanel=true}
```

See the Multi Excerpt add-on page for more details.

**An example of content re-use: a glossary**

A glossary is something that most technical documentation will require. There are a few ways to set up glossaries in Confluence. These are the most popular:

- All glossary entries on one page.
- Each glossary entry on separate child pages with a main page showing excerpts of the glossary.

Once you have defined the glossary entry, you can refer to it from the main pages of your technical documentation.

**Creating a one-page glossary**

This style of glossary is useful if the glossary entries tend to be short and there are not too many of them. The code blocks below use wiki markup. To insert wiki markup onto your page, open the editor and chose Insert > Wiki Markup.

1. Create a page named **Glossary**.
2. Add an alphabetical index at the top of the page and a heading for each letter of the alphabet:

```plaintext
[A|#A]  [B|#B]  [C|#C]  ...
{anchor:A}
h2. A
{anchor:B}
h2. B
{anchor:C}
h2. C  ...
```

3. Enter each glossary entry under the relevant alphabetical heading. Each glossary entry (term) should
include:
- An anchor tag, so that you can link to it from other pages.
- The term itself.
- A definition of the term.
- A link to the page in your technical documentation that explains the term in greater detail, where relevant.

```{anchor:MyGlossaryTerm}

h4. MyGlossaryTerm
This is the definition of MyGlossaryTerm. See [Page Name] for more information.
```

4. Optionally, include a horizontal line between the terms. This depends on how long each entry is. If your glossary tends to have short entries, it may look too cluttered with horizontal lines.

---

See the glossary in the Confluence documentation for an example of this style of glossary (without the alphabetical index).

Creating a glossary with child pages

This style of glossary is useful if the glossary entries tend to be quite long or have additional information over and above the definition of the term. The code blocks below use wiki markup. To insert wiki markup onto your page, open the editor and chose Insert > Wiki Markup.

1. Create a page named Glossary.
2. Create a child page for each glossary entry (term). Each child page should contain:
   - The term as the title of the page.
   - The definition of the term in the body of the page.
   - Excerpt tags (excerpt) tags surrounding the definition.
   - Any additional information after the excerpt tags.

```{excerpt}
This is the definition of MyGlossaryTerm
{excerpt}
More information to describe MyGlossaryTerm
```

3. On the 'Glossary' page, use the children macro to show the excerpts from each child page in a list, with the page name displayed in 'h4' style.

```{children:excerpt=true|style=h4}
```

See the glossary in the Crowd documentation for an example of this style of glossary.

Referring to glossary terms

In the main pages of your technical documentation, create a link to the glossary page for each glossary term.

```
_[MyGlossary Term|Glossary#MyGlossaryTerm]_
```

Note that this is a standard page link with an anchor. We have formatted the link as italics, because it helps to have the glossary links looking different to other page links. Readers can just skip over the glossary link if they are already familiar with the term.
Further reading

A blog post about content re-use: Technical Writing in a Wiki - Content Re-use and Structure (November 2010).

Next Steps

You now have a good idea of how to re-use content in a Confluence documentation space. What next? Take a look at Managing the Life Cycle of your Technical Documentation.

Managing the Life Cycle of your Technical Documentation

This page is part of the guide to developing technical documentation on Confluence Wiki. We have already shown you how to create your technical documentation space, including how to set permissions for your space. Now we offer a quick-start guide to managing the life cycle of your technical documentation in Confluence. The life cycle includes drafting, reviewing and publishing a document, as well as managing documentation that is release-specific.

Quick guide to managing the technical documentation life cycle:

- Create draft pages with restricted permissions, to hide them until they are ready for publication.
- Set the permissions to allow reviewers to comment on and/or update the pages.
- When ready, publish the page by removing the permission restrictions.
- Monitor updates to your draft and published pages by watching your space and/or subscribing to RSS feeds.
- Use spaces as a mechanism for matching your documentation version to product releases: one space per major release number.
- Consider installing add-ons for extended workflow and publication management.

The rest of this page gives more details of the above procedures.

Using the built-in Confluence functionality to manage workflow and release cycle

This section describes how to use the built-in Confluence functionality to manage your workflow (draft, review, publish) and to align your documentation version control to the product release cycle.

In this scenario we also assume that you want a live space that always has the same space key and always contains the latest version of your documentation. This scenario suits the requirements of an organisation that wants their technical documentation to be 'live'. Various groups of people can refine the content as and when required. People can also subscribe to the space, knowing that they will always get the latest version of the documentation and comments.

This is the way we manage our documentation at Atlassian. The content of the wiki is dynamic, continuously updated, commented on, subscribed to and watched by thousands of people all over the world.

Drafting, reviewing and publishing a page

The workflow is as follows.

1. Create a page with restricted permissions. For example, you might restrict viewing to a group of people such as your team. On a public wiki, you might restrict viewing to staff members, so that the general
1. Public cannot see the page. 
2. Write the page content. 
3. Ask other people to review the page. They can add comments to the page or simply edit the page content directly. 
4. Publish the page when ready, by doing the following:
   - Delete the comments on the page. 
   - Remove the permission restrictions on the page. The page has now been published. The space permissions and site permissions now determine who can see and/or update the page.

The screenshot below shows a page under review. Notice the lock icon at top left, indicating that restricted permissions apply to this page.
On the page history view, you can:

- View the content of a specific version of the page.
- Revert to (restore) a specific version.
- Select any two versions and ask for a comparison, to see what has changed between those two versions.

See Page History and Page Comparison Views for detailed information.

It is all very well to go to a specific page and see what has happened to it, but how do you know when to go and look at the page? You need a notification of any changes made to your documentation space.

In Confluence, you can monitor updates to your documentation via email notifications and via RSS feeds.

Receiving email notification of updates

You can ‘watch’ a page or an entire space. Whenever anyone updates the page or space, you will receive an email notification.

1. Log in to Confluence, if you have not already done so.
2. Go to the page or blog post.
3. Choose Watch and select the relevant check box.

See Subscribing to Email Notifications of Updates to Confluence Content for details of the various notifications Confluence will send, and how to configure your notification settings.

Monitoring updates via RSS feeds

RSS feeds provide another way to keep track of updates. The simplest way to build an RSS feed is to use Confluence’s feed builder. This will give you a URL that you can ping to get the latest updates.

Below we describe how to set up a useful feed for your technical documentation space. Remember that you can adjust the settings to suit your own needs.

2. Check the boxes to select all the content types. (Even if you are not expecting comments, blog posts or mail in your documentation space, it does no harm to receive notifications if they do arrive.)
   - Pages and the comments and attachments on pages.
   - Blog posts and their comments and attachments.
   - Mail.
3. Select your documentation space from the list. Press Ctrl and click to select multiple spaces.
4. Choose Create RSS Feed.
5. This will take you to a new screen. Drag or copy the link into your RSS reader. The feed URL is linked to the words Drag or copy this link to your RSS reader.

Now that you have set up your RSS feed, you need to decide how to read it. There are various options to choose from. For example:

- Use an RSS reader, such as the Sage add-on for Firefox.
- Use an email client, such as Thunderbird.

See Subscribing to RSS Feeds within Confluence for details.
Release management

Let’s assume that your product goes through a regular release cycle, and that you need to retain separate documentation for each major version of the product.

At Atlassian, we use spaces as our version-control mechanism.

- **Archive spaces.** At each release, we create a new archive space to house the previous version of the documentation.
- **The live space.** The documentation for the latest version of the product resides in the live space. The live space always retains the same space key and is always available for viewing and updating.

**Space keys**

The live space has just the product name as its space key. For example, for the Bamboo product the space key is ‘BAMBOO’. (See the Bamboo documentation space.)

For the archived versions, we use a combination of the product name plus version number as the space key. For example, we use ‘BAMBOO040’ for the Bamboo 4.0 documentation, ‘BAMBOO041’ for the Bamboo 4.1 documentation, and so on.

**The release management process**

Here is an overview of the process we follow at Atlassian.

1. **Leading up to release date.** Work with hidden draft pages in the live space. A ‘hidden draft’ is simply a page that has restricted permissions applied:
   - For each new feature, create a new page with restricted permissions.
   - If you need to update existing pages, create a hidden copy of the existing page and apply the updates to the copy.
   - Follow the usual draft and review procedure for each page.

2. **A few days before release date.** Use the Copy Space add-on to copy the live space to a new space. This creates a snapshot of the current documentation, and will act as an archive for the current release which is soon to become the previous release. (We described the use of the Copy Space add-on in the earlier section of this guide: Creating your Technical Documentation Space.)

3. **On release date.** Publish the updated documentation for the new version of the product:
   - Rebrand the live documentation space to reflect the new release number. In other words, change the space name and any other descriptions that include the product release number.
   - Unhide all the new pages, by removing the permission restrictions on each hidden page.
   - Copy the content of the updated pages to the proper pages, then delete the copies.
   - Export the newly updated space to PDF, HTML and XML, for those customers who prefer offline versions of the documentation.

Note that the above process is applicable to major releases of the product. For minor bug-fix releases, we simply update the documentation in the live space. We do not create archive spaces for every minor release.

The example below shows an extract from the dashboard of our documentation wiki, listing the spaces for different versions of the Bamboo documentation. (Bamboo is one of our products.) Each space holds the documentation for a specific major release of Bamboo.

*Screenshot: Archive Bamboo spaces and Bamboo Latest for the current version of the documentation.*
Other scenarios using the built-in Confluence functionality

It is easy to design other ways of managing your documentation spaces using the built-in Confluence functionality. For example, the simplest scenario is to publish a new space for every new release of your product, using the same Copy Space add-on as described above.

Using add-ons for extended workflow, publication and version management

For advanced workflow features, consider installing the Ad Hoc Workflows add-on onto your Confluence site.

For advanced publication and concurrent version management consider using the Scroll Versions add-on. With Scroll Versions, you can set up and manage concurrent versions of your documentation in a single space. You can manage multiple versions of software, different product variants, and even multiple languages of documentation. Plan your page updates for a specified version and then publish them all at once.

See the documentation of Scroll Versions for more information.

Similarly, consider using the Content Publishing add-on to publish content from a master space to a published space. In this scenario, you will create a master space that contains your drafts in progress and new releases. The master space is visible only to the authors and reviewers. You will periodically publish the master space to a published space. This suits the requirements of an organisation that needs a ‘published’ or ‘official’ set of documentation, published only when a new version of the product is released. There is no requirement for continual updating of the documentation.

Automatic publishing. The Content Publishing add-on can work together with the Ad Hoc Workflows add-on to publish pages automatically when the page reaches a specified state in the workflow.

Notes

- Installing add-ons. If you decide to use additional add-ons, your system administrator will need to install them into your Confluence site. Refer to the documentation on Installing add-ons.

- Add-on support. Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Next steps

Now you know about managing your workflow and documentation release process on Confluence. What next? Take a look at Providing PDF Versions of your Technical Documentation.
Confluence is a platform for publishing online documentation. It also provides functionality for producing PDF versions of your documentation, allowing you to print the documentation, or to provide a copy to customers who are unable to access the online version. This guide describes how to export your technical documentation to PDF using Confluence's built-in PDF export. We also introduce a third-party add-on that provides additional PDF layout and style functionality.

Quick guide to PDF exports:

- Customise the PDF layout (title page, header and footer) and style, for use each time you export your documentation.
- Export a single page to PDF.
- Export a selection of pages or an entire space to PDF.
- Consider installing a third-party add-on for advanced PDF export functionality.

The rest of this page gives more details of the above procedures.

On this page:
- Customising the PDF layout and style
  - Editing the PDF layout
  - Setting a global PDF layout
  - Setting the PDF layout at space level
  - Setting the PDF stylesheet
  - Setting a global PDF Stylesheet
  - Setting a space PDF stylesheet
  - Examples of PDF customisation
- Exporting to PDF
  - Exporting a single page to PDF
  - Exporting a selection of pages or a space to PDF
  - Using the Scroll PDF Exporter add-on (Not applicable to Confluence Cloud.)
- Notes

Customising the PDF layout and style

If you plan to create PDF versions of your documentation, you may want to customise the PDF layout and styles for your space. These customisations will be applied every time you export documentation to PDF.

Under PDF layout you can add HTML to customise the PDF title page, and the page headers and footers. Under PDF stylesheet, you can adjust the appearance of the PDF pages.

Editing the PDF layout

Setting a global PDF layout

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose PDF Layout. You can enter HTML and CSS that will be rendered on the PDF title page, as well as page headers and footers.

Setting the PDF layout at space level

1. Go to the space and choose Space tools > Look and Feel on the sidebar. You'll need Space Admin permissions to do this.
2. Choose PDF Layout.
3. Choose Edit.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. Note: The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose PDF Layout in space administration options.
3. Choose Edit.
You can customise the HTML that is generated for the following areas when the space is exported to PDF:

- **PDF Space Export Title Page** – title page.
- **PDF Space Export Header** – page headers.
- **PDF Space Export Footer** – page footers.

Enter your customisations into each text box as required. The PDF layout section accepts HTML code. You can include inline CSS in the HTML too.

### Editing the PDF stylesheet

#### Setting a global PDF Stylesheet

1. Choose the cog icon then choose General Configuration under Confluence Administration.
2. Choose Look and Feel > PDF Stylesheet. The following screen allows you to enter and save CSS code that will render content on each page.

#### Setting a space PDF stylesheet

1. Go to the space and choose Space tools > Look and Feel on the sidebar. You'll need Space Admin permissions to do this.
2. Choose PDF Stylesheet.
3. Choose Edit.
4. Enter your customisations.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen. **Note:** The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
2. Choose PDF Stylesheet in the space administration options.
3. Choose Edit.
4. Enter your customisations.

The PDF Export Stylesheet field accepts Cascading Style Sheets (CSS) rules. The 'PDF Export Stylesheet' page shows the current (e.g. customised) contents of your PDF stylesheet.

### Examples of PDF customisation

Below are typical customisations you may want to make for your technical documentation. For more examples, see Customising Exports to PDF.

#### Adding a title page

You can create a title or cover page to your PDF document using HTML. Use the PDF Space Export Title Page section of the PDF layout to do this. Adding a New Title Page

The following example uses HTML with an inline CSS rule to generate a title page.

```html
<div class="fsTitlePage" style="margin-left:auto;margin-top:75mm;margin-right:auto;page-break-after:always">
<img src="/download/attachments/12345/titlepage.png"/>
</div>
```

Including Content Above Table of Contents in Default Title Page

The following example includes content above the automatically-generated table of contents that appears on the default title page, so that your title page includes your own content plus the table of contents.
Adding an Image to your Title Page

In the examples above, the title page includes an image called ‘titlepage.png’, centred in the middle of the page. The image is attached to a Confluence page and is referenced via its relative URL (that is, we use only the last part of the URL, excluding the Confluence site's base URL).

Follow these instructions to include an image on your title page:

1. Attach the image to a Confluence page.
2. View the list of attachments on that page.
3. Right-click the image and copy its location.
4. Paste the link into the appropriate src="" attribute within your PDF stylesheet, as shown above.
5. Remove the first part of the URL before /download/....

Adding headers and footers

You can add headers and footers to your PDF pages using HTML. Use the 'PDF Space Export Header' and 'PDF Space Export Footer' sections of the PDF layout to do this. For simple headers and footers, plain text is enough. The following example adds a simple copyright notice.

Copyright © 2010, Atlassian Pty Ltd.

Adding page numbers to a header or footer

To add page numbering, you need to combine customised HTML in the PDF Layout with customised CSS in the PDF Stylesheet.

1. PDF Layout HTML: In the Footer section (or the Header section), use an empty span element with a unique ID, for example pageNum, to act as a place holder for the page number.

   HTML - PDF Layout: Footer Section
   <span id="pageNum"/>

2. PDF Stylesheet CSS: Create the following CSS selector rule for the empty span:

   CSS - PDF Stylesheet
   #pageNum:before  
   content: counter(page);

Analysing the above CSS selector rule in more detail:

- The #pageNum rule selects the HTML element with the specified ID of "pageNum", which is the span element we created for the header or footer.
- The :before part of the selector is a pseudo class that allows the insertion of content before the span element is processed.
- The counter(page) is a function that returns the current page number as its content.
• The `content` property tells the CSS processor that dynamic content (that is, an incrementing page number) is to be inserted at the span tag.

**Exporting to PDF**

You can use the built-in Confluence PDF export to export a single page, a selection of pages or an entire space to a single PDF file.

**Exporting a single page to PDF**

You can export a Confluence page to PDF. This option exports a single page and is available to all users who have permission to view the page.

• Go to a page in the space and choose **Tools > Export to PDF**. Follow the prompts to export the page.

**Exporting a selection of pages or a space to PDF**

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose **Export**. This option will only be visible if you have the 'Export Space' permission.
3. Select **PDF** then choose **Next**
4. Decide whether you need to customise the export:
   • Select **Normal Export** to produce a PDF file containing all the pages that you have permission to view.
   • Select **Custom Export** if you want to export a subset of pages.
5. Select the pages you want to export.
   • You have the option to **Select All** or **Deselect All** pages.
   • When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.
6. Choose **Export**.
7. When the export process has finished, download and save the PDF file as prompted.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**
2. Choose **PDF Export** from the left menu.
3. Follow the steps above to export the Space.
Using the Scroll PDF Exporter add-on (Not applicable to Confluence Cloud.)

The Scroll PDF Exporter provides flexible themes for configuring PDF layout and styles. You can select one of Scroll PDF Exporter's built-in themes and configure your table of contents, header and title pages. For even more flexibility, see the section How Tos in the Scroll PDF Exporter documentation.

For this advanced PDF export functionality, you will need to install the Scroll PDF Exporter add-on into your Confluence site.

Notes

- **Permissions required to export a space**: To use the space export functionality, you need the 'Export Space' permission. See the guide to space permissions.

  - **Installing add-ons**: If you decide to use additional add-ons, your site administrator will need to install the add-ons into your Confluence site. Refer to the documentation on installing add-ons. (Not applicable to Confluence Cloud.)

  - **Add-on support**: Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Next Steps

Now you know all about providing PDF versions of your documentation. What next? See other ways of Exporting and Printing Technical Documentation.

Exporting and Printing Technical Documentation

This page is part of the guide to developing technical documentation on Confluence Wiki. Confluence is a great
tool for writing and maintaining technical documentation. There are times when we need to export the content out of Confluence into other forms, such as PDF, HTML, Microsoft Word and paper.

Confluence itself provides an export to both PDF and HTML. Add-ons provide additional functionality. Below are guidelines on exporting your technical documentation to various formats, including printed output.

Quick guide to printing and exporting content:

- Use the browser’s print option to print a single page.
- To print more than one page and for more advanced printing options, export your documentation to PDF.
- Confluence can export your pages to PDF, HTML, Confluence-specific XML and Word.
- Consider installing add-ons to export your pages to PDF (enhanced functionality), Word (enhanced functionality), DocBook XML, Eclipse Help and JavaHelp.
- Make your exports available to your customers for download by attaching the exported file to a Confluence page.

The rest of this page gives more details of the above procedures.

On this page:
- Printing
- Exporting to PDF
- Exporting to HTML
- Exporting to Confluence-specific XML
- Exporting to DocBook XML via an add-on
- Exporting to Microsoft Word
- Exporting to Microsoft Word via an add-on
- Exporting to Eclipse Help via an add-on
- Exporting to EPUB via an add-on
- Exporting to HTML via an add-on
- Making the PDF and other exported files available to your readers
- Notes
- Further reading

Printing

To print a single Confluence page, just use the browser’s print option. This option is available to all users who have permission to view the page.

To print more than one page and for more advanced printing options, export your documentation to PDF. See Providing PDF Versions of your Technical Documentation.

Exporting to PDF

Because this is such an important topic, we have a section of this guide dedicated to PDF. See Providing PDF Versions of your Technical Documentation.

Exporting to HTML

Using the built-in Confluence HTML export, you can export a single page, a selection of pages or an entire space to HTML. Confluence supplies the HTML and associated files in a zip file.

1. Go to the space and choose Space tools > Content Tools on the sidebar.
2. Choose Export. This option will only be visible if you have the ‘Export Space’ permission.
3. Select HTML then choose Next.
4. Decide whether you need to customise the export:
   - Select Normal Export to produce an HTML file containing all the pages that you have permission to view.
   - Select Custom Export if you want to export a subset of pages, or to exclude comments from the export.
5. Select the Include Comments check box if you want to include comments for the pages you are exporting.
6. Select the pages you want to export.
   - You have the option to Select All or Deselect All pages.
   - When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.
7. Choose **Export**. This will create a zipped archive of HTML files.
8. When the export process has finished, download the zipped archive as prompted, and extract the files into a folder.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**.
2. Choose **HTML Export** from the left menu.
3. Follow the steps above to export the Space.

---

**Exporting to Confluence-specific XML**

Confluence provides an XML export. The XML produced is a proprietary format and is intended for backups or for transferring a space from one Confluence site to another. If you write your documentation on Confluence and your customers have Confluence too, then you can export your manuals to XML and customers can upload them onto their own Confluence site.

**Exporting to DocBook XML via an add-on**

Scroll DocBook Exporter converts Confluence pages to DocBook XML. Your Confluence system administrator will need install the add-on onto your Confluence site.
Exporting to Microsoft Word

Confluence can export a page to Word. (Choose Tools > Export to Word.) This option performs a basic conversion of wiki content to HTML and applies some Word CSS stylesheets. It processes just one page at a time.

Exporting to Microsoft Word via an add-on

Scroll Office is a Confluence add-on. Once installed, Scroll Office replaces Confluence's built-in 'Export to Word' functionality. You can export a single page or a hierarchy of pages.

You can define your templates in Word in the usual way, and upload them to Confluence as global templates or space templates. When you export your Confluence pages to Word, Scroll Office will use those templates to build native Word documents from the wiki pages.

Scroll Office provides additional features such as enforcing page-breaks, setting the page orientation to landscape or portrait, and ignoring content. The latest version offers a REST-style API for automated export.

Exporting to Eclipse Help via an add-on

Scroll EclipseHelp Exporter provides an export to Eclipse Help format.

You can produce embeddable online help for Eclipse-based applications. Scroll EclipseHelp Exporter converts the Confluence content into EclipseHelp-compatible JAR files to create a standalone online help or a context-sensitive help.

A hint about the Eclipse Help platform: You can use a cut-down version of the Eclipse Help platform to provide online documentation for any system. It doesn't have to be an Eclipse tool that you are documenting. For some ideas, take a look at a couple of articles about documenting your project using the Eclipse help system.

Exporting to EPUB via an add-on

The Scroll EPUB Exporter outputs an ebook in the common EPUB format that can be read on iPads, iPhones and any other ebook reader.

Exporting to HTML via an add-on

The Scroll HTML Exporter enables the delivery of Confluence content from a web server. It converts the pages into static HTML pages that can be uploaded to a web server. The output of the Scroll HTML exporter can also be used as an input to produce other HTML-based help formats such as WinHelp and HTML Help.

Making the PDF and other exported files available to your readers

There are a number of ways to make your exported files available to your readers, such as putting the files on a disc and shipping them with your product.

One of the simplest ways is to attach the files to a Confluence page. (See Attaching Files to a Page.)

Atlassian uses the out-of-the-box Confluence export functionality to provide PDF, HTML and XML versions of our documentation. People can download the files from our documentation wiki. For example, here are the JIRA documentation downloads and the Confluence documentation downloads.

Notes

- Permissions required to export a space. To use the space export functionality, you need the 'Export Space' permission. See the guide to space permissions.
- Installing add-ons. If you decide to use additional add-ons, your site administrator will need to install the add-ons into your Confluence site. Refer to the documentation on installing add-ons.
- Add-on support. Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Further reading

- A blog post about exporting and importing content from/to Confluence: Technical Writing in a Wiki - Single
Now you know about a number of ways to get your technical documentation out of Confluence into various formats, for printing or for input into another system or process flow. What next? Take a look at Essential Confluence Features for Technical Documentation.

Essential Confluence Features for Technical Documentation

This page is part of the guide to developing technical documentation on Confluence. In this section we highlight the built-in Confluence macros that are most useful in technical documentation. For more information about Confluence macros, see Working with Macros.

On this page:
- Auto-generating a table of contents for page content
- Drawing attention to elements of a page
- Putting content inside customisable Panels
- Inserting anchor links on pages
- Structuring content using sections and columns
- Making your documentation more engaging by embedding videos

Auto-generating a table of contents for page content

It is important to make it easy for viewers to jump to the section of a Confluence page that they are most interested in. The Table of Contents macro helps people navigate lengthy pages by summarising the content structure and providing links to headings used on the page.

Click here to see a common example >>

2. Each feature in the release is a heading on the page.
3. You can generate a list of hyperlinks to each of the features in the release notes by inserting the Table of Contents macro:

4. The image below shows the Table of Contents macro inserted at the top of the 'Release Notes' page. Note that we have excluded the 'Highlights of Confluence 4.0' heading from the table of contents by modifying the macro’s parameters.
5. The image below shows the macro parameters specified in the macro browser. Note the 'Minimum Heading Level' and 'Maximum Heading Level' parameters.
Often when creating documentation there are elements of a page that you want to highlight, or draw the the viewers' attention to. Confluence ships with the following macros that help you focus a viewer's attention to a note, information, tip or warning.

> Click here to see a common example >>

### Note macro

**What is it?**

The Note macro allows you to highlight a note on a Confluence page.

It creates a yellow coloured box surrounding your text, as shown to the right.

See [Note Macro](#) for more examples and instructions.

### Info macro

**What is it?**

The Info macro allows you to highlight helpful information on a Confluence page.

It creates a blue coloured box surrounding your text, as shown to the right.

See [Info Macro](#) for more examples and instructions.

### Tip macro

**What is it?**

The Tip macro allows you to highlight a helpful tip on a Confluence page.

It creates a green coloured box surrounding your text, as shown to the right.

See [Tip Macro](#) for more examples and instructions.

### Warning macro

**What is it?**

The Warning macro allows you to highlight a warning note on a Confluence page.

It creates a red coloured box surrounding your text, as shown to the right.

See [Warning Macro](#) for more examples and instructions.

---

**Putting content inside customisable Panels**

Using the Panel macro, you can place content inside a customisable coloured panel. This is particularly useful when you want to clearly separate elements on a page.

> Click here to see a common example >>

1. You are documenting a procedure which involves a number of steps.
2. You want to call out the steps of the procedure from the rest of the page by placing it inside a coloured
3. You can create a coloured panel using the Panel macro.
4. The image below shows the parameters set for the panel using the macro browser.

![Edit 'Panel' Macro](image)

Return to top of page

**Inserting anchor links on pages**

Anchor links can be especially useful when navigating between sections of a long document or when you want to link to a segment of a page from another page. The Anchor macro allows you to link to specific parts of a page.

Click here to see a common example >>

1. You are documenting part of a user guide.
2. The page is split into multiple sections.
3. After each section you want to provide a link for viewers to click, taking them back to the top of the page.
4. To achieve this you first must create an anchor at the top of the page using the Anchor macro. You can give the anchor any name you like. In the image below, the anchor at the top of the page will be named 'top'.
5. The anchor placeholder will appear to indicate where your anchor link is located on the page:

![Anchor Macro](image)

5. Create a link to the anchor, anywhere on the page, using the Link Browser. The image below shows a link to the anchor called 'top' by using the hash '#' followed by the name of the anchor you created earlier, with an alias of 'Return to Top'.

![Link Browser](image)
Structuring content using sections and columns

Sometimes it is necessary to structure content into sections and columns. The details are in Working with Page Layouts and Columns and Sections.

- Page layouts allow you to add sections to your page and then apply pre-defined column layouts to each section (for example, 2 column, three column). You can add multiple sections to a page.
- The Section and Column macros allow more flexibility. You can set the width of the columns, and put the sections and columns in any part of the page. Each section can contain any number of columns, created using the Column macro.
- Columns can either have a fixed width, specified in pixels, or a dynamic width, specified as a percentage of the page width.
- Note: whether you are using page layouts or macros, a column is always created inside a section.

The images below show part of a Confluence page with two sections (outlined in red), each with two columns (blue) of different widths.
1. Section 1:

1. Put a name to your face
2. Learn how content is organised
3. Get familiar with the Confluence screens
4. Start creating content
5. Add a panel to your page

2. Columns in section 1 – left column has a fixed width of 400 pixels:

1. Put a name to your face
2. Learn how content is organised
3. Get familiar with the Confluence screens
4. Start creating content
5. Add a panel to your page
3. Section 2:

1. Put a name to your face
2. Learn how content is organised
3. Get familiar with the Confluence screens
4. Start creating content
5. Add a panel to your page

Put a face to your name
Your profile picture is used to identify you across Confluence. Upload your own picture via your Profile.

Dashboard > People > Fred Flintstone > Profile Picture

Fred Flintstone

Profile: Your profile picture is used as the icon for your personal space, and to represent you in Confluence. You can upload your own profile picture, or you can choose from one of our standard icons.

Upload a Profile Picture: Upload your own profile picture. Profile pictures will be resized to 48 x 48 pixels.

Upload

4. Columns in section 2 – left column has a fixed width of 10 pixels:

Put a face to your name
Your profile picture is used to identify you across Confluence. Upload your own picture via your Profile.

Dashboard > People > Fred Flintstone > Profile Picture

Fred Flintstone

Profile: Your profile picture is used as the icon for your personal space, and to represent you in Confluence. You can upload your own profile picture, or you can choose from one of our standard icons.

Upload a Profile Picture: Upload your own profile picture. Profile pictures will be resized to 48 x 48 pixels.

Upload

Return to top of page

Making your documentation more engaging by embedding videos

Pictures can be worth a thousand words. The same can be said for videos. Often, it's easy to explain a concept or demonstrate a procedure using a video. The Widget macro allows you to embed web content, including YouTube and Vimeo videos, in a Confluence page.

Click here to see a common example >>

1. You release a new version of your product.
2. You document the release notes on a Confluence page.
3. The marketing team creates a video demonstrating the new features of the release and uploads it to YouTube.
4. You can embed the video in your release notes using the Widget macro, for playback on your Confluence page.
a. Edit the page and choose **Insert > Other Macros** in the editor toolbar.

b. Search for the 'Widget Connector'.

c. Insert the URL of your YouTube video into the **Web Sites Widget URL** field.
Take a look at Confluence Add-ons for Technical Documentation.

This page is part of the guide to developing technical documentation on Confluence. In this section we highlight some of the Confluence add-ons that are useful for technical writers in designing and developing documentation.

An add-on is an extension module that you can add to your Confluence site to extend the wiki’s core functionality. It is similar to an add-on for your browser.

An add-on that specifically plugs into an Atlassian application such as Confluence is sometimes called a plugin. The terms ‘plugin’ and ‘add-on’ are often used interchangeably. Confluence add-ons may be developed by Atlassian or by third parties. To find an add-on featured on this page, and other add-ons too, visit the Atlassian Marketplace.

**Drawing tools**

Below are some popular tools. Search the Atlassian Marketplace to see a full list of drawing and diagram add-ons for Confluence.

**Gliffy**

The Gliffy add-on provides an embedded diagram editor. With Gliffy you can create and edit diagrams directly on a Confluence page. Gliffy supports various diagram types (UML, business process, and so on).

**Commercial or free?** Commercial.

**Alternatives:** As an alternative you can use the standalone version of Gliffy available at [http://www.gliffy.com/](http://www.gliffy.com/). Gliffy online has a free basic version.

**More information:** See the Gliffy add-on page.

**Lucidchart**

Using Lucidchart, you can draw flowcharts, wireframes, UML diagrams, mind maps, and more, inside the web editor, then integrate the diagram with Confluence. Include interactivity such as linking to pages within Confluence or other pages inside the diagram.

**Commercial or free?** Commercial.

**More information:** See the Lucidchart add-on page.

**Creately**

Use Creately to draw flowcharts, UML diagrams, database diagrams, wireframes, mindmaps, UI mockups, workflow diagrams, network diagrams, org charts, and Gantt charts.

See Widget Connector Macro for information on the supported services and for more examples.
Commercial or free? Commercial.

More information: See the Creately add-on page.

yWorks Diagrams

Use yWorks Diagrams to create and edit diagrams directly inside Confluence.

Commercial or free? Commercial.

More information: See the yWorks Diagrams add-on page.

Add-ons for enhanced content manipulation

All content extensions are provided by macros in Confluence. Some macros are built in to Confluence. Other macros are supplied by add-ons.

Quick overview of macros

Before looking at add-ons, let's take a quick look at macros in general. There are two ways to add a macro to your page:

- Use the macro browser. This is the simplest and recommended way.
- Or insert the macro's name in curly brackets into the text of your page and specify the parameters.

Click here to see an example of a macro >>

The following code uses the {include} macro to insert the text from the page called 'My Page'.

Some content on my page.
{include:My Page}
Some more content on my page.

Let's assume 'My Page' contains just two lines:

<table>
<thead>
<tr>
<th>I love chocolate.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chocolate loves me.</td>
</tr>
</tbody>
</table>

The resulting page will look like this:

<table>
<thead>
<tr>
<th>Some content on my page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>I love chocolate.</td>
</tr>
</tbody>
</table>
Chocolate loves me.
Some more content on my page.

A number of macros are shipped with your Confluence installation by default. See Working with Macros. Below we describe some add-ons that provide additional useful macros for Confluence:

Composition add-on

The Composition add-on provides macros which allow finer control over the layout (composition) of a page. Using these macros, you can:

- Outline your text blocks.
- Add tabs to a page.
- Flow your text around the images or diagrams on the page.

**Commercial or free:** Commercial.

**Using the Composition add-on to outline text blocks**

Use the {cloak} macro to outline a text block.

**Usage:** The following code creates a text block named ‘SeeAlso’ for the outlined 'See Also' section within a page. The text block with id='SeeAlso' will be hidden after the 'See Also' title:

```
{composition-setup}
{cloak:id=SeeAlso}
{toggle-cloak:id=SeeAlso}
{cloak:id=SeeAlso}
```

**Alternatives:** You can also use the {expand} macro available in Confluence by default, but this macro can outline only text of the same level and cannot hide headings within the text. The {expand} macro does not require parameters and just hides the text placed between the {expand} tags.

**Note:** If you need to outline a text block containing nested headings, consider the text structure. Maybe the block is too big. You could create a child page from this block to decompose the whole text. Then you can include and outline the text block using the {include} macro within {expand}.

**Using the Composition add-on to add tabs to a page**

Use the {deck} and {card} macros to separate content between tabs on the same page.

**Usage:** The following code creates two tabs with client information:

```
{composition-setup}
{deck:id=ClientName}
{card:label=Basic}
Client Company Name: Company
[Client Web Site|http://url.com]
Our projects: [Project1|Project1 Home]
{card}
{card:label=Contacts}
Company CEO: John Brown, e_mail: brown@company.com
{card}
{deck}
```
Using the Composition add-on to flow your text around images

Use the {float} macro to make your text flow around images or diagrams.

**Usage:** The following code demonstrates how a picture can be surrounded by the description, as often shown in printed publications:

```markdown
{composition-setup}
{float}
!shakespeare.jpg!
{float}
William Shakespeare (baptised 26 April 1564; died 23 April 1616) was an English poet and playwright, widely regarded as the greatest writer in the English language and the world's pre-eminent dramatist.
```

The page will look like this:

**Floating Text demo**

William Shakespeare (baptised 26 April 1564; died 23 April 1616) was an English poet and playwright, widely regarded as the greatest writer in the English language and the world's pre-eminent dramatist. His surviving works, including some collaborations, consist of about 39 plays, 154 sonnets, two long narrative poems, and several other poems. His plays have been translated into every major living language and are performed more often than those of any other playwright.

Shakespeare was born and raised in Stratford-upon-Avon. At the age of 19, he married Anne Hathaway, with whom he had three children: Susanna, and twins Hamnet and Judith. Between 1585 and 1592, he began a successful career in London as an actor, writer, and part owner of a playing company called the Lord Chamberlain's Men, later known as the King's Men. He appears to have retired to Stratford around 1613, where he died three years later. Few records of Shakespeare's private life survive, and there has been considerable speculation about such matters as his physical appearance, sexuality, religious beliefs, and whether the works attributed to him were written by others.

Shakespeare produced most of his known work between 1598 and 1613. His early plays were mainly comedies and histories, genres he raised to the peak of sophistication and artistry by the end of the 16th century. He then wrote mainly tragedies until about 1606, including Hamlet, King Lear, and Macbeth, considered some of the finest works in the English language. In his last phase, he wrote tragicomedies, also known as romances, and collaborated with other playwrights.

For more macros, see the Composition add-on page.

**Scaffolding add-on**

The Scaffolding add-on provides macros for creating 'permanent templates' and editable forms. You can create sophisticated page templates in order to add content easily and fast. Scaffolding templates are suitable for dynamically-filled data and allow people to create pages by completing form fields and selecting values from...
drop-down lists.

The Scaffolding templates are useful for creating pages with a well-determined structure, such as:

- API methods or property descriptions.
- Constant list.
- Feature description.
- Software requirement specifications.

**Commercial or free:** Commercial.

**Example:** The following Scaffolding template creates a description of an API method:

```
h3. Method Name
{text-data:methodName|required=true}{text-data}

h3. Method Description
{text-data:methodDescription|type=area|required=true|width=100%}description{text-data}

h3. Parameters
{table-data:parameters}
|| Name || Type || Mandatory || Description ||
| {text-data:paramName}ParamName{text-data} |
| (list-data:paramType)({list-option:Number}Number{list-option}){list-option:String}String{list-option:DateTime}DateTime{list-option:MACaddress}MACaddress{list-option:IPaddress}IPaddress{list-option} |
| (list-data:paramMandatory)({list-option:Required}Required{list-option}){list-data} |
| (text-data:paramDescription|type=area)param description{text-data} |
{table-data}

h3. Return Value
The returned value is an XML structure of the following format:
\{code:xml\}
\{code\}
```

Where elements mean:
```
{table-data:returnValues}
|| Name || Type || Description ||
| {text-data:paramName}ParamName{text-data} |
| (list-data:paramType)({list-option:Number}Number{list-option}){list-option:String}String{list-option:DateTime}DateTime{list-option:MACaddress}MACaddress{list-option:IPaddress}IPaddress{list-option} |
| (text-data:paramDescription)param description{text-data} |
{table-data}
```

h3. Remarks
{text-data:remarks}remarks{text-data}

h3. See Also

This template will look like this:
For more information on how to create templates in Confluence, see Adding a Template.

**Alternatives:** Confluence includes built-in templates which are useful for static data and simple text. For more information, see Working with Templates.

**Notes:** The Scaffolding (and any) template changes will affect only new pages created from the modified template. In order to change the existing pages, you need to edit each individual page and add or modify the formatting manually.

For more information on Scaffolding, see the Scaffolding add-on page.

**Extended version control**

**Scroll Versions**

Scroll Versions adds functionality for sophisticated version management, enhanced content reuse, support for context-sensitive help, permalinks, and duplicate page titles. You can set up and manage concurrent versions of your documentation in a single space. Multiple versions of software, different product variants, and even multiple translations of documentation can be managed. Changes to pages are scheduled for a specified version and then published all at once. See the Scroll Versions documentation for an overview of the key features.

**Commercial or free:** Commercial.

**Video:** Scroll Versions - Version Management for Confluence (4:20)
Attachment Checkout add-on


**Commercial or free:** Free for up to 50 users, then commercial.

**More information:**

- Please visit the Attachments Checkout add-on page for an overview, including a video,
- See the Attachments Checkout documentation for further reference,
- For information on working with attachments in Confluence, see Working with Attachments.
- For information on attachment versioning, see Attachment Versions.

**Add-ons featured in other parts of this guide**

- **Copy Space add-on** – Provides an easy way of copying a space within a Confluence site. Free. See Creating your Technical Documentation Space.
- **Multi Excerpt add-on** – Enables you to have more than one excerpt (re-usable chunk) on a page. Commercial. See Re-using Content in Technical Documentation.
- **Ad Hoc Workflows add-on** – Provides advanced workflow features. Commercial. See Managing the Life Cycle of your Technical Documentation.
- **Content Publishing add-on** – Publishes content from a master space to a published space. Commercial no charge. See Managing the Life Cycle of your Technical Documentation.
- **Scroll PDF Exporter** – Provides advanced PDF export features. Commercial. See Providing PDF Versions of your Technical Documentation and Exporting and Printing Technical Documentation.
- **Scroll EPUB Exporter** – Outputs an ebook in the common EPUB format that can be read on iPads, iPhones and any other ebook reader. Commercial.
- **Scroll HTML Exporter** – Enables the delivery of Confluence content from a web server. It converts the pages into static HTML pages that can be uploaded to a web server. The output of the Scroll HTML exporter can also be used as an input to produce other HTML-based help formats such as WinHelp and HTML Help. Commercial.
- **Scroll EclipseHelp Exporter** – Enables you to collaborate and author all your content in your wiki, and generate embeddable online help for Eclipse-based applications. Commercial.

**Notes**

- **Add-on support.** *Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.*
- **Installing add-ons.** If you decide to use additional add-ons, your site administrator will need to install the add-ons into your Confluence site. Refer to the documentation on installing add-ons.

**Further reading**

- A blog post about useful add-ons and tools for exporting and importing content from/to Confluence: Technical Writing in a Wiki - Single Source Publishing (November 2010).
- Website for exploring and downloading the available add-ons: Atlassian Marketplace.
- Documentation on installing and configuring add-ons: Universal Plugin Manager documentation.
- Documentation on using macros: Working with Macros.
- Further Reading about Developing Technical Documentation on Confluence

Further Reading about Developing Technical Documentation on Confluence

This page is part of the guide to developing technical documentation on Confluence. Once you have absorbed all the information in this guide, you may be ready for more reading. 😊
the wiki to engage your readers and embed content from other social sites. Here is a blog post and presentation slides on engaging readers in the documentation.


**Let us know about more links**

We plan to add more links to this page or to the 'Tips of the Trade' page. Let us know of any we have missed.

### Using Confluence as a Knowledge Base

A knowledge base is a repository for how-to and troubleshooting information. Knowledge Bases are commonly used by IT Support teams, but can be useful for procedural and troubleshooting information in any organisation or team.

What do people want out of a knowledge base? Using an IT Support team as an example:

- Customers want fast access to a solution, and relevant search results.
- Help desk staff want to be able to create new articles quickly.
- Help Desk team leads wants the space to be self curating, and do not want to spend a lot of time manually organising content.
- Everyone wants a way to be notified when articles they are interested in have been updated or important notices are added.

#### Creating a knowledge base space

⚠️ You'll need the Create Space global permission to do this.

To create your knowledge base space:

1. Create a space using the knowledge base space blueprint (Choose Spaces > Create space > Knowledge base space).
2. Set permissions for the space, including anonymous access (Choose Space Tools > Permissions).
3. Create your first knowledge base article (Choose Create > How-to or Troubleshooting and follow the prompts).

The knowledge base space blueprint includes everything you need to get started, including article templates, and a pre-configured homepage with Livesearch and Content By Label macros.

Page labels are essential in knowledge base spaces. These are used to add topics to your articles, and allows your knowledge base to become self organising over time.

Users will generally find articles by searching, and using the topic navigation on the homepage and end of each article, rather than navigating through a tree-like page hierarchy.

When starting off your knowledge base space, it is a good idea to brainstorm a few topics to get started.

#### Customising your knowledge base space

⚠️ You'll need Space Admin permissions to do this.

To make it easy for your users to create knowledge base articles (such as your help desk or support team) we recommend customising the how-to and troubleshooting article templates to make them relevant for your organisation. The more guidance and structure you can put in your template, the faster it will be for your team to create great articles.

To edit the article templates:

1. Go to Space Admin > Content Tools > Templates.
2. Edit the How-to or Troubleshooting article templates.
3. Add headings and instructional text (choose Template > Instructional Text).
You can also add additional templates, such as a policy or procedure page templates.

We also recommend customising the look and feel of your space. Simple changes like a space logo and welcome message can make a huge difference.

To change the look and feel:

- Add a space logo and useful shortcuts to the sidebar (choose Space Tools > Configure Sidebar).
- Edit the homepage to add a custom welcome message.
- Edit the colour scheme (choose Space Tools > Look and Feel > Colour Scheme).

Providing communication and notification options

Channels of communication with your audience, internal or external, is essential in a good knowledge base. Here are some out of the box options:

- **Blog** - blog updates and important notices, and encourage people to watch for new blogs in your space.
- **Watch** - encourage people to watch pages that interest them, or watch the entire space.
- **Comments** - allow logged in users (or even anonymous users) to comment on knowledge base articles. This is a simple way to connect with your end users.
- **RSS** - create an RSS feed and add the link to your knowledge base homepage (choose Help > Feed Builder). Alternatively encourage users to create their own feed - useful if they want to keep up with particular topics (labels), rather than receive notifications for the whole space.

Integrating your knowledge base with other Atlassian products

If your Confluence site is connected to another Atlassian product (via an application link), you can make use of these great integration features:

- **If you use JIRA** - add a JIRA Issues macro to your troubleshooting article to provide quick access to known issues. This has the added advantage of automatically updating when an issue is resolved or its status changes. One simple way to do this would be to add some labels to JIRA to indicate the issue should appear in the knowledge base (for example 'printer-kb'), and then add a JIRA Issues macro with a query like 'label = 'printer-kb and status <> resolved'' on all articles with the printer topic.
- **If you use JIRA Service Desk** - specify your Confluence space to be used as a knowledge base. Users can search your knowledge base directly from within the Service Desk customer portal.
- **If you use Confluence Questions** - add a Questions list macro to troubleshooting articles, to highlight the top questions with the same topic as the article, and an Ask a Question button to the knowledge base homepage.

Extending your knowledge base with third party add-ons

The Atlassian Marketplace has a large number of add-ons for Confluence. A common addition to Knowledge Base spaces is a survey or form tool, which enables you to get feedback on the usefulness or usability of your knowledge base articles.

Search for 'knowledge base' on Marketplace and see if there is an add-on that's right for your knowledge base.

Developing an Intranet on Confluence Wiki

Confluence now ships with a space blueprint for creating Team spaces, which is useful if you use Confluence as an intranet.

Go to Create Space > Team Space to try it out for yourself.

This guide is for people who are using Confluence as a platform for an intranet. You will find this guide useful if you want to create a space where your team can collaborate and share information.

**Step 1. Create a space**

Below is a quick guide to adding a space for your team.

1. Go to the Confluence dashboard and choose Create Space > Blank Space.
2. The Create Space screen appears. Enter a space name and a short, unique space key.
3. Choose **Create**.

The home page of your new space will appear. Because you created the space, you are the space administrator. Now you can do some basic configuration, as described in the sections below.

**On this page:**
- Step 1. Create a space
- Step 2. Set the space permissions
- Step 3. Customise the title and content of the home page
- Step 4. Subscribe to email notifications for updates made to the space
- Step 5. Attach or import Office documents, if applicable
- Step 6. Import page templates and blueprints
- Step 8. Publish a blog post

**Related pages:**
- Creating a Space
- Global Permissions Overview
- Assigning Space Permissions
- Page Restrictions
- Users and Groups

**Step 2. Set the space permissions**

Define the space permissions to determine who can do what in your new space.

1. Go to the space and choose **Space tools > Permissions** on the sidebar.
2. Choose **Edit Permissions**.
3. Set the permissions to suit your needs then choose **Save All**.
   - You can add **groups** and/or individual **users** to the list, then select the permissions for each group or user.
   - You can also set the permissions for **anonymous** users – these are people who have not logged in to Confluence and will not count towards the number allocated by your license. Anonymous access is only available if enabled for your entire Confluence site. It is unlikely you will need anonymous users for your intranet.
   - You can change these permissions at any time. You may want to restrict the permissions to specific groups now, and later open the space to more people.

**More about permissions**

Confluence has a robust and granular permissions scheme that you can use to determine who can view, create content and comment within your intranet. There are three levels of permissions in Confluence:

- Global permissions apply across the entire site.
- Space permissions apply to a space.
- Page restrictions allow you to restrict the editing and/or viewing of a specific page.

**Space permissions** in Confluence are simple yet granular enough to be useful for an intranet. You can:

- Use the permission levels to control who can create pages, delete pages, create comments, delete comments, administer the space, and so on.
- Grant a permission level to one or more users, and/or to one or more groups, and/or to anonymous users. A space administrator has complete control.

**Terminology:**

- **Anonymous** means people who have not logged in to Confluence
- The `confluence-users` (or `users`) group is the default group into which all new users are assigned. Everyone who can log in to Confluence is a member of this group.

For example, you might allow the `confluence-users` group permission to create and edit comments, but reserve full editing rights for your team members. Let's assume your team members are all members of the `developers` group. The example below shows that members of the `developers` group have all permissions except space administration, but, members of the `confluence-users` group and the individual `Josh User` only have a
few editing rights.

### Groups

These are the permissions currently assigned to groups for this space.

<table>
<thead>
<tr>
<th></th>
<th>All</th>
<th>Pages</th>
<th>Blog</th>
<th>Comments</th>
<th>Attachments</th>
<th>Mail</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View</td>
<td>Add</td>
<td>Restrict Remove</td>
<td>Add</td>
<td>Remove</td>
<td>Add</td>
<td>Remove</td>
</tr>
<tr>
<td>confluence-users</td>
<td>✔</td>
<td>✔</td>
<td>x</td>
<td>✔</td>
<td>x</td>
<td>✔</td>
<td>x</td>
</tr>
<tr>
<td>developers</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>x</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>View</th>
<th>Add</th>
<th>Restrict Remove</th>
<th>Add</th>
<th>Remove</th>
<th>Add</th>
<th>Remove</th>
<th>Remove</th>
<th>Export</th>
<th>Admin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rach Admin (admin)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Josh User (josh)</td>
<td>✔</td>
<td>✔</td>
<td>x</td>
<td>✔</td>
<td>x</td>
<td>✔</td>
<td>x</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

[Edit Permissions]

### Individual Users

These are the permissions currently assigned to individual users for this space.

<table>
<thead>
<tr>
<th></th>
<th>All</th>
<th>Pages</th>
<th>Blog</th>
<th>Comments</th>
<th>Attachments</th>
<th>Mail</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View</td>
<td>Add</td>
<td>Restrict Remove</td>
<td>Add</td>
<td>Remove</td>
<td>Add</td>
<td>Remove</td>
</tr>
<tr>
<td>Rach Admin (admin)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Josh User (josh)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

[Edit Permissions]

For detailed information, see the documentation on:

- Global permissions
- Space permissions
- Page restrictions
- Users and groups

### Step 3. Customise the title and content of the home page

When you created your space, Confluence created a home page with default content and a default title. You will want to change the title and content to suit your team.

1. Go to your space home page
2. By default, the page title is ‘X Home’ (where ‘X’ is the name you gave your space).
3. Choose **Edit**.
4. The page opens in the editor.
5. Change the title and update the content to suit your needs.  
   *Hint:* If you do not know what to add yet, add a short description. You can refine the content of the page at any time.
6. Choose **Save** to save your home page.

### Step 4. Subscribe to email notifications for updates made to the space

You can configure your email notifications to suit your needs: You can choose to be notified about all pages in a space, blog posts in a space, or both. Below is a quick guide to monitoring a space's content. See Watching Pages, Spaces and Blog Posts for a full description.

1. Go to your space homepage.
2. Choose **Pages** in the sidebar.
3. Choose **Watch this space**.
4. Choose **Blog** in the sidebar.
5. Choose **Watch this blog**.

If at any time you wish to stop watching activity in the space, choose **Stop watching this space** or **stop watching this blog**.

*Example of an email notification*
Here is an example of the email notification you will receive when someone adds a comment to a page or blog post:

More about notifications

You can specify the notifications you want to receive at a global, space, and page level. The quick guide above demonstrated how to set up notifications for a space. Now we will show you how to configure your notifications at the global and page levels.

Global notifications

Global notification settings determine the overall behaviour of the notifications you receive from Confluence.

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Choose Email.
3. Choose Edit.
4. Change the default settings to suit your needs. You can alter these email settings at any time.
5. Choose Submit to save your changes.

Page and blog post notifications

Follow the quick guide below to receive notifications from Confluence about changes to and comments on a specific page or blog post. See Watching Pages, Spaces and Blogs for a full description.

You can watch any given page or blog post that you have permission to view. We will use your space's home page as an example.

1. Go to the home page of your space.
2. Choose Watch.

You can choose to watch just that page, or all pages in the space.

You are now watching the current page and Confluence will notify you about any updates made or comments added.

Note that Confluence will not notify you about content changes that are due to the output of a macro. For example: The output of the Children macro will change if someone adds a child page. The page containing the Children macro will show the new child page. But the page content itself has not been edited, so no notifications will be sent.

You can stop watching a page or blog post at any time. Choose Watch and deselect the Watch Page or Watch all content in this space checkboxes.

Step 5. Attach or import Office documents, if applicable

Below are some guidelines on managing your existing Microsoft Office documents in Confluence. You can choose to attach them to a Confluence page, so that team members can view and access them in Confluence, and edit them in Office. Or you can import the documents into Confluence, converting the content to Confluence pages.

Attaching Office documents to a page
You can use Confluence as a central repository for your team’s Office documents. This means that you can share your Office documents without having to email them to your teammates. People can view the Office documents even if they do not have Office installed on their computers.

1. Go to a page in your space.
2. Choose **Tools > Attachments**.
3. Use one of the following methods for attaching files to the page:
   - Choose **Browse** and to locate the file on your computer, enter a **comment** then choose **Attach**
   - Alternatively, **drag and drop** one or more file(s) directly onto the ‘Drop files here’ region of the attachments screen. The ‘Attach File(s)’ message box appears, indicating the upload status of the file(s) being attached to your page.

---

**Importing Word documents into Confluence**

You can also import content from Microsoft Word into Confluence, so that it becomes a Confluence page. See [Importing a Word Document into Confluence](#) for a full description.

1. Go to your space home page.
3. Choose **Browse** and locate the Office document on your local drive or network.
4. Choose **Next**. The import document options screen will display.
5. Choose how you would like the Office Connector to import the file:
   - **Root page title** – This will be the title of the page.
   - **Import as a new page in the current space** – This option specifies that a new page will be created with the title specified.
   - **Rename imported pages if page name already exists** – This is what Confluence will do if there is a conflict.
   - **Split by heading** – If your document contains headings, Confluence can use the heading information to split the document into multiple wiki pages. If you do not want to split your document, leave the default ‘Don't split’ option selected.

6. Choose **Import**.

When the upload has finished, the content of the Office document will have been transformed into Confluence page content. You can now view and edit this page in the normal way, using the Confluence editor. There is now no connection between the original Office document and this page.

Step 6. Import page templates and blueprints

In order for an intranet to be effective, people need to use it. One way to spur new user adoption is to provide your team with templates so that they can focus more on content creation and less on page format. You can create your own templates or download some from the Atlassian Marketplace. See Importing Templates and Adding a Template for more information.

A blueprint is a page template with added functionality to help you create, manage and organise content in Confluence. Confluence ships with some predefined blueprints. You can also download additional blueprints from the Atlassian Marketplace. You can customise the blueprint templates to suit your individual needs and even develop your own blueprints. See Working with Blueprints.

**Creating a page from a template**

Now that you have made some templates available to your site or space, other Confluence users will be able to choose a template when they want to create a page. Templates appear in the Create dialog for users to select when creating a new page.

1. Go to your Intranet space.
2. Choose **Create** on the header. Available templates will be listed in the Create dialog.
3. Select a template and choose **Next**.
4. If the template contains variables, a form will appear. Type the relevant information into the form fields, and choose **Next**.
5. Enter a title for the page, update the content and choose **Save**.

### Step 7. Set up your personal space

Now that you have created a space for your team, let's create your **personal space**. This is a place where you can publish your own pages and blog posts. Once you have created it, Confluence users can reach your personal space by clicking your name in the **People Directory** or by searching for your name via the **quick navigation search box**.

1. Choose **your profile picture** at top right of the screen, then choose **Add Personal Space**.
2. Enter a few details about your space:
   - Choose who can **view** content.
   - Choose who can **contribute** (create and edit) content.
   - Choose the ‘**Global Look and Feel**’ for your personal space.
3. Choose **Create**.
4. The ‘Home’ page for your new space is displayed.

### Step 8. Publish a blog post

Blog posts are a good way of letting your team mates and the company know your news. People can blog about product and strategic ideas, team updates, and things they want to get ideas about. New employees can write blog posts introducing themselves. People write about getting married or the birth of a child. Blog posts are a great way for people to share their visions, get to know their c-oworkers and start lively discussions.

Remember to set your email notifications to alert you about the blog posts published within Confluence, as described in an earlier step.

See **Working with Blog Posts** for a full description of adding, editing, viewing and linking to blog posts.

1. Go to a page in your space.
2. Choose **Create** in the header.
3. Select **Blog** then choose **Next**.
4. Add a title and some content.
5. Choose **Save** to publish your blog post.

## Confluence Administrator's Guide

**About the Confluence Administrator's Guide**
This guide covers features and functions that are only available to administrators.

For information on using creating and administering space refer to the Confluence User's Guide.

This guide assumes that you are using the Confluence default theme. If your Confluence site has been customised the header may look different, and menu items appear in different locations to the examples given in this guide.

- Getting Started as Confluence Administrator
- Managing Confluence Users
  - Adding and Inviting Users
  - Deleting or Deactivating Users
  - Searching For and Administering Users
  - Managing Site-Wide Permissions and Groups
  - Configuring User Directories
- Managing Add-ons or Plugins
- Writing User Macros
  - User Macro Template Syntax
  - Example User Macro - Hello World
  - Example User Macro - Colour and Size
  - Example User Macro - NoPrint
  - Example User Macro - Formatted Panel
- Customising your Confluence Site
  - Changing the Look and Feel of Confluence
  - Changing the Default Behaviour and Content in Confluence
- Integrating Confluence with Other Applications
  - Linking to Another Application
  - Configuring Workbox Notifications
  - Integrating JIRA and Confluence
  - Registering External Gadgets
  - Configuring the Office Connector
- Managing your Confluence License
- Managing Confluence Data
  - Database Configuration
  - Site Backup and Restore
  - Attachment Storage Configuration
  - Confluence Data Model
  - Finding Unused Spaces
  - Data Import and Export
- Configuring a Confluence Environment
  - Confluence Home and other important directories
  - Application Server Configuration
  - Web Server Configuration
  - Starting Confluence Automatically on System Startup
- Configuring Confluence
  - Viewing System Information
  - Configuring the Server Base URL
  - Configuring the Confluence Search and Index
  - Configuring Mail
  - Configuring Character Encoding
  - Other Settings
  - Configuring System Properties
  - Working with Confluence Logs

Downloads

Download the Confluence documentation in PDF format.

Other Resources

Confluence User’s Guide
Confluence Installation and Upgrade Guide
Confluence Knowledge Base
Atlassian Answers
Getting Started as Confluence Administrator

This page is an introduction for people just starting out as Confluence administrators. You will find this page useful if your Confluence site is brand new, or you are learning to administer an existing site.

Confluence is a Java-based web application. For supported environments, there is an installer that will set up an application server and copy the application files to the designated directories on your server machine. If you prefer, you can install Confluence from a zip file. See the Confluence Installation Guide for details.

On this page:
- Quick access to administrative functions via Confluence search
- How to administer and configure Confluence
- Getting started on a new Confluence site
- Getting to know an existing Confluence site

Diagram: A Confluence installation

Quick access to administrative functions via Confluence search

Quick tip for getting to administration screens: Start typing what you want to do into the Confluence search box at top right of the screen. The matching administrative functions will appear with a cog icon at the top of the
dropdown search results.

**Even faster via 'GG':** Press 'G' twice on your keyboard then continue typing the action you want.

Notes about finding administrative options via the search box:
- Pressing 'GG' puts your cursor into the search box.
- The 'GG' combination is familiar to JIRA users, because the same shortcut opens the JIRA administration search dialog.
- System administration, Confluence administration and space administration options may appear in the search results.
- Confluence permissions determine the administrative options that appear in the search results. You will only see the options that you have permission to perform.

---

How to administer and configure Confluence

After installing Confluence, you will perform the initial configuration via a web interface called the Confluence Setup Wizard.

**Introducing the Confluence Administration Console:** From this point onwards, many of the administrative functions are available from the Confluence Administration Console, which is part of the Confluence web interface. If you have **administrative permissions**, you will have access to the Confluence Administration Console via your web browser, using the standard Confluence URL for your site.

**To access the Confluence Administration Console:**

1. Open your Confluence URL in your web browser.
2. Choose the cog icon, then choose **General Configuration** under Confluence Administration.

**For further configuration options,** you can edit the XML and properties files that are part of your Confluence installation directory. To get started, take a look at the Confluence Home and other important directories. The
Confluence administration guide will lead you through tasks such as configuring the log files and configuring system properties.

Getting started on a new Confluence site

Is this a new Confluence site? Here are some things to get started with:

- Decide whether you want to allow public (anonymous) access to your site. See Setting Up Public Access.
- Add a space and some content. See Creating a Space.
- Invite some users to your site. See Adding and Inviting Users.

- Decide whether you will manage your users in Confluence or hook up an external LDAP directory. See Configuring User Directories.
- Make sure you have set up an email server. The above task list will include this step, but it is worth mentioning it here again. Email notifications are an important part of collaborating on Confluence. See Configuring a Server for Outgoing Mail.

Now you can continue getting to know your site, as described in the next section.

Getting to know an existing Confluence site

Has the site been around a while, but you are new to Confluence administration? Take a look at these topics:

- Understand the Confluence permission scheme. See Giving People Access to Content.
- Get to know the power of add-ons (also called plugins), for extending and customising your Confluence site. See Managing Add-ons or Plugins.
- Investigate more ways of customising Confluence. See Customising your Confluence Site.

Managing Confluence Users

A Confluence user is a person who can read or update a Confluence site. You can choose whether your Confluence site is accessible to anonymous users (people who have not logged in) or only to logged-in users. See Setting Up Public Access.

Confluence user management

You can add users to Confluence, and then assign them permissions that determine their access to the content and administrative functions in your Confluence site. You can also collect users into groups, and assign the permissions to groups for easier management. See the following topics:

- Adding and Inviting Users
- Deleting or Deactivating Users
- Searching For and Administering Users
- Managing Site-Wide Permissions and Groups

By default, Confluence stores its users and groups in the Confluence database. This is called the internal directory. You can choose to connect Confluence to an external userbase instead, such as Microsoft Active Directory or another LDAP server. You can also use Atlassian Crowd and JIRA as directory managers. When you add a user or group to Confluence, it will be added to the external directory too, based on your configuration options. See Configuring User Directories. Not applicable to Confluence Cloud.

On this page:

- Confluence user management
- Authentication
  - Seraph
  - XML-RPC and SOAP authentication
  - Password authentication
- Earlier user management frameworks

Related pages:

- Configuring Confluence Security
- Confluence Administrator's Guide
Authentication

Seraph

Almost all authentication in Confluence (and JIRA) is performed through Seraph, Atlassian's open source web authentication framework. The goal of Seraph is to provide a simple, extensible authentication system that we can use on any application server.

Seraph is implemented as a servlet filter. Its sole job is, given a web request, to associate that request with a particular user (or no user if the request is anonymous). It supports several methods of authentication, including HTTP Basic Authentication, form-based authentication, and looking up credentials already stored in the user's session.

Seraph itself performs no user management functions. It merely checks the credentials of the incoming request and delegates any user management functions (looking up a user, checking a user's password) to Confluence's user management system.

If you want to integrate Confluence with your own single sign-on (SSO) infrastructure, you would do so by installing Atlassian Crowd or by writing a custom Seraph authenticator. See our developer documentation on HT TP authentication with Seraph.

XML-RPC and SOAP authentication

Normally, requests for Confluence's remote API will include an authentication token as the first argument. With this method of authentication, XML-RPC and SOAP authentication requests are checked directly against the user management framework, and tokens are assigned directly by the remote API subsystem. These requests do not pass through Seraph authenticators.

However, if the token argument is blank, Seraph will be used as a fallback authentication method for remote API requests. So, to use a custom Seraph authenticator with XML-RPC or SOAP requests, ensure that you pass an empty string as the authentication token to remote API methods.

Password authentication

By default, password authentication is delegated from Seraph to the user management system. This is not necessary, however. Single sign-on systems may have no password authentication at all, and get all the necessary credentials from the SSO provider.

Earlier user management frameworks

- **Atlassian-User – now behind the scenes.** Atlassian-User is a user and group management framework developed by Atlassian. It provides user, group and profile management services to Confluence. In earlier versions of Confluence, you needed to configure your user directories by editing the atlassian-user. xml file directly. In Confluence 3.5 and later this is no longer necessary, nor is it possible. Please refer to the documentation for Confluence 3.4 or earlier, if you need details of this framework. Refer to the Confluence 3.5 Upgrade Notes for details of the automatic migration that will occur during the upgrade process. Not applicable to Confluence Cloud.
- **OSUser – obsolete.** OpenSymphony User was Confluence's core user management framework before Atlassian-User. Please refer to the documentation for Confluence 3.4 or earlier, if you need details of this framework.

Adding and Inviting Users

There are a number of ways to add users to Confluence:

- **By user signup:** If user signup is enabled on your Confluence site, people can add themselves as users of the site. See below.
- **Via an invitation link:** You can invite people to sign up, by sending them an invitation link.
You can copy and paste the link, or prompt Confluence to send the link in an email message. See below.

- **By adding users manually:** Administrators with Confluence Administrator or System Administrator permissions can add new users. See below.
- **Via an external user directory:** See Configuring User Directories.

You may also be interested in information about allowing anonymous users access to your site. Anonymous users do not count against your Confluence license totals. See Setting Up Public Access.

**Allowing user signup**

If you enable user signup, a ‘Sign Up’ option will appear on the Confluence screens. The option will be on the login screen, and also in the header on public sites. People can choose the option to create their own usernames on Confluence.

You can restrict the signup to people whose email addresses are within a given domain or domains. This is useful if you want to ensure that only people within your organisation can add their own usernames.

You will still be able to add or invite users manually, whether user signup is enabled or not.

You need Confluence Administrator or System Administrator permissions to change the signup options.

**To set the user signup options:**

1. Choose Invite Users on the dashboard, then choose User Signup Options.
   Or take the longer route: Choose the cog icon, then choose General Configuration under Confluence Administration. Then choose Users > User Signup Options.
2. Choose Allow people to sign up to create their account.
3. Choose one of the following options:
   - **Restricted by domain(s)** – Note: You need to set up a mail server for Confluence before you can configure domain restricted signup. When you choose this option, a text box will appear. Enter one or more domains, separated by commas. People will only be able to sign up if their email address belongs to one of the domains specified here. Confluence will send the person an email message, asking them to click a link to confirm their email address. For example: mydomain.com, mydomain.net
   - **No restrictions** – Anyone will be able to sign up to Confluence. Confluence will not send any email message requesting confirmation.
4. Choose Notify administrators by email when an account is created if you want Confluence to send an email message to all administrators (people with Confluence Administrator or System Administrator permissions) every time someone signs up to Confluence.

**Enabling and disabling notifications about user signup**

By default, Confluence will send an email notification to all Confluence administrators whenever someone signs up to the Confluence site. The administrators (people with Confluence Administrator or System Administrator permissions) will receive this message when someone signs up either by clicking the ‘Sign Up’ link or by clicking the invitation URL sent by an administrator.

**To disable this notification:**

1. Choose Invite Users on the dashboard, then choose User Signup Options.
   Or take the longer route: Choose the cog icon, then choose General Configuration under Confluence Administration. Then choose Users > User Signup Options.
2. Remove the tick from Notify administrators by email when an account is created.
3. Choose Save.
Inviting people to sign up

You can invite new users to the site by sending them a signup URL, called an 'invitation link'. You can copy the invitation link and paste it onto a page or into an email message, or you can prompt Confluence to send an email message containing the same link.

The option to send invitations is independent of the signup options. You can send invitations if signup is open to all, restricted by domain, or disabled entirely. Even if signup is restricted or disabled, a person who has received an invitation will be able to sign up.

When someone visits the invitation link in a browser, a Confluence signup screen will appear.

To invite people to sign up:

1. Choose **Invite Users** on the dashboard.
   
   Or take the longer route: Choose the cog icon, then choose **General Configuration** under Confluence Administration. Then choose **Users > Invite Users**.

2. Copy the **Invitation Link** and paste it into an email message, or onto a page on your intranet, for example.

3. Alternatively, prompt Confluence to send an email message for you:
   - Enter one or more email addresses in the field labelled **Email To**. Separate the addresses with commas. For example: john@example.com, sarah@example.com
   - Optional: Change the **Message** if you want to.
   - Choose **Send**.

Resetting the invitation link

The invitation link includes a security token, like this:

```
http://confluence.example.com/signup.action?token=d513a04456312c47
```

This security token is a shared token – individual invitations do not have unique tokens. Anyone who obtains
this token will be able to sign up to Confluence.

You can change the token at any time, by choosing **Reset**. The previous invitation link will become unusable. People will no longer be able to use the previous link to sign up. If they try, they will see an error message that the signup token has expired.

*Screenshot: Inviting users*

### Inviting users

Inviting users is the easiest way to get your team collaborating on Confluence. Just share the link below with your team, either by copying and pasting it, or by using the email option below.

**Invitation Link**

http://localhost:8090/signup.action?token=25bee249fe9fe7e1

**Reset**

Resetting the invitation URL will stop people from signing up via a previously-sent URL.

**Email To**

Enter one or more email addresses, separated by commas

**Message**

Hi,

Join me and the rest of the team on Sample Site!

It's the one place to create, share, discuss and store our ideas, projects and documents.

You will send less email, have fewer meetings and get more done.

Please accept this invitation to get started!

**Send**

*Screenshot: Adding users*

### Adding users manually

**To add a new user:**

1. Choose **Invite Users** on the dashboard, then choose **Add Users**.

   Or take the longer route: Choose the cog icon, then choose **General Configuration** under Confluence Administration. Then choose **Users > Add Users**.

2. Enter the user's details: username, name, password, and email address.

3. Choose whether Confluence should send an email message informing the person of their new username. The email message will contain a link that the person can use to reset their password.

4. Choose **Create**.
Notes

- **Multiple directories.** You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

  Here is a summary of how the directory order affects the processing:
  - The order of the directories is the order in which they will be searched for users and groups.
  - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

  See Managing Multiple Directories.

- **Email server required for domain restricted signup and for invitations.** You need to set up a mail server for Confluence, before you can configure domain restricted signup or send email invitations to users.

- **Are the user management options not visible?** If you have external user management turned on, internal user management is disabled. To configure external user management, go to General Configuration > Security Configuration. See Disabling the Built-In User Management.

---

Deleting or Deactivating Users

If you are a Confluence Administrator, you can delete and deactivate users.

You can **delete** a user from Confluence if they have not yet added or edited any content on the site. Such content includes pages and blog posts, and edits and comments on existing pages.

You can **deactivate**, or disable, a user, including one who has contributed content.
- Deactivated users can no longer log in to Confluence.
- Deactivating a user will not remove the content created by them.
- Deactivated users do not count towards your license count. (See the notes below.)

**To remove a user:**

1. Go to the user's profile and choose **Administer User**.
2. Choose **Delete**.

**To deactivate a user:**

1. Go to the user's profile and choose **Administer User**.
2. Choose **Disable**.

**Screenshot: Administering a user**

```
View User: ewan

« Back to Users

User    ewan
Full Name Ewan User
Email    sample@email.com.au
Directory Crowd Repository
Created    Apr 24, 2013 10:36
Last Updated Apr 24, 2013 10:36
Login    Last Login: Apr 26, 2013 15:21
          Current Failed Login Count: 0
Groups    confluence-users

View Profile Edit Groups Edit Details Set Password Delete Disable
```

**Notes**

- The **Administer User** link is only visible if you are logged in as an administrator.
- You can also delete or disable users using the **Administration Console**.
- You can edit the groups that a user belongs to, to change their permissions without completely preventing their access to Confluence.
- **Multiple user directories:** You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an **LDAP** directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has
permission to make changes.

See Managing Multiple Directories.

- **Number of users and your license:** The Confluence 'License Details' screen tells you how many users your Confluence instance is licensed to support, and how many are currently registered. See Managing your Confluence License. The number of registered users includes only users who have the 'Can Use' global permission. Deactivated users, as described above, are not included. Choose Refresh to make sure you see the latest count.

### Searching For and Administering Users

If you have Confluence Administrator permissions, you can view users, edit their user details, reset their passwords, and assign them to groups.

#### Accessing the user management screen

There are two ways to do this.

**Option 1:** Administer a known user:
- Go to a user's profile
- Choose Administer User.

**Option 2:** Find the user first:
- Choose the cog icon, then choose General Configuration under Confluence Administration.
- Choose Users in the left-hand panel.
- The 'Users' screen appears. You can now list all users or search for a specific user.

#### Listing all users

**To list all users:**

1. Choose Show all users. All members of the 'confluence-users' or 'users' group are listed in alphabetical order, by username. If there are more users than can fit on one page, the results will be divided into multiple pages.
2. To move to another page of results, choose the numbered links, Next or Previous near the top or bottom of the page.
3. To specify how many results should be shown per page, choose a number 10, 20, 50 or 100 near the top of the page.

---

**Using the simple user search**

**To search for a user via the simple user search:**

1. If the Simple link is showing, choose it. (If you see the 'Advanced' link and no 'Simple' link, then the simple search is already active.)
2. Type some information about the user into the 'Find User' text box. You can type all or part of their username, full name or email address.
3. Choose **Search**.
4. Confluence will display a list of matching users. Click the link on a username to see and edit the details for that user.

**Using the advanced user search**

The advanced user search allows you to specify the field in which your search term appears: username, full name or email address. This is useful if you need to limit the number of users appearing in the search results.

**To search via the advanced user search:**

1. If the **Advanced** link is showing, choose it. (If you see the 'Simple' link and no 'Advanced' link, then the advanced search is already active.)
2. Complete one or more of the following fields:
   - **Username** — Enter all or part of the person's username. This is their login ID, such as 'joe', or 'bloggs'.
   - **Full Name** — Enter all or part of the person's name. For example, 'joe bloggs', or 'bloggs', or 'joe'.
   - **Email** — Enter all or part of the person's email address. For example, 'acme'.
3. Choose **Search**.
4. Confluence will display a list of matching users. Click the link on a username to see and edit the details for that user.

**Notes**

- **Multiple user directories**: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See [Managing Multiple Directories](#).

- **Crowd and the user search**: If you are using Atlassian's Crowd for user management, you will need Crowd 1.5.1 or later to use the 'Simple' option in the user search. If your version of Crowd does not support the simple user search, you will see only the 'Advanced' search form.

*Screenshot: The user management screen*
1. Editing User Details

You need Confluence administrator permissions to be able to edit the details of a user. The details include the person's name, password, email address, group membership, and ability to access Confluence.

To update a user's details:

1. First, go to the user management screen for the user concerned. There are two ways to do this:
   - Either,
     - Go to the user's Profile and click the 'Administer User' link on the user's profile screen.
   - Or, Choose the cog icon, then choose General Configuration under Confluence Administration.
     - Select the link 'Manage Users' in the left-hand panel.
     - Locate the user by doing a search on the username or the groups to which they belong.
     - Click the user link.

2. Now you should be able to see the user's current details and links allowing you to edit them.
   - View Profile — View the user’s profile.
   - Edit Groups — Add or remove this user from a group.
   - Edit Details — Change details such as the user's name, email address, contact details and team or department information. In some instances you may be able to change usernames as well - see Changing Usernames for information.
   - Set Password — Edit the user's password details.
   - Delete — You can delete a user permanently if the user has not added or edited any content on the site.
   - Disable — You can disable (i.e. deactivate) access for a user who has already added or edited any content on the site.

Screenshot: User details
Multiple user directories: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories.

Resetting the Login Count for a User

Confluence records the number of failed logins attempts made against each user account. When the login attempts exceed a preset number, the user will prompted to authenticate using CAPTCHA until they successfully log in.

If you are a Confluence Administrator, you can manually set the failed login count for a user back to zero.

To reset the failed login count for a user:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose **Manage Users** in the left-hand panel.
3. Search for the required user and click the user in the search results. The ‘View User’ screen will appear.
4. Choose **Reset Failed Login Count** for the user. The ‘Current Failed Login Count’ will be reset to 0.

**Related pages:**
- Configuring Captcha for Failed Logins (Not applicable to Confluence Cloud.)
- Confluence Administrator’s Guide

⚠️ The information on this page does not apply if you have multiple Cloud apps. If you are only using Confluence Cloud, the information does apply.

**Screenshot: Resetting the failed login count for a user**

---

### Changing Usernames

A username is the name used to log in to Confluence, for example jsmith. If you are a Confluence administrator you can change a user's username, for example if they change their name.

All active users must have a unique username. This means that two active users cannot have the same username. You can however assign the username of a disabled user to another active user.

The procedure for changing a username depends on where you manage your users. Refer to Configuring User Directories for more information.

#### Changing the username of a user managed in Confluence

If you manage your users in the Confluence internal directory you can rename your user in Confluence. You will need Confluence Administrator permissions to change a username.

**To change a username:**

1. Navigate to the user's record:
   a. go to the user's profile and choose **Administer User**, or
   b. go to **Confluence Admin > Users** and search for the user
2. Choose **Edit Details**.
3. Enter the new username and choose **Submit**.
The user's username has been changed. The user will need to use their new username to log in to Confluence from now on. The new username will also be reflected throughout Confluence, including in user mentions.

**Changing the username of a user managed in an external directory**

If you do not manage your users in the Confluence internal directory, you may still be able to change a user's username. Confluence cannot update external users but it will detect changes in usernames that are coming from some external directories.

The following table indicates the instances where you may be able to change a username in your external directory and have the change detected in Confluence.

<table>
<thead>
<tr>
<th>User directory</th>
<th>Where to rename the user</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal directory with LDAP</td>
<td>Rename the user in the LDAP directory, Confluence will detect the renamed user.</td>
</tr>
<tr>
<td></td>
<td>Note: you must have 'Copy User on Login' enabled. See Copying Users on Login for more information.</td>
</tr>
<tr>
<td>JIRA 6.1 or later</td>
<td>Rename the user in JIRA, Confluence will automatically detect the renamed user.</td>
</tr>
<tr>
<td>Atlassian Crowd 2.7 or later</td>
<td>Rename the user in Crowd, Confluence will automatically detect the renamed user.</td>
</tr>
<tr>
<td>LDAP</td>
<td>Rename the user in your LDAP directory, Confluence will automatically detect the renamed user.</td>
</tr>
</tbody>
</table>

**Notes**

Some important things to note about changing usernames:

- **Mentions and page history**
  Any user mentions in current pages will automatically reflect the user's new username, but any mentions in page versions created prior to Confluence 5.3 will include the user's old username.

- **Personal Spaces**
  If a Confluence Administrator renames a user who has a personal space, the space key for that space will remain the user's original username. For example if jsmith's username is changed to jbrown, their personal space key will remain ~jsmith.

**Restoring Passwords To Recover Admin User Rights**

Use this document if you are unable to log in to Confluence as administrator. The most common reason for using these instructions is if you have lost the administration password for your Confluence site.

**Before you Start**

Please note the following before you start:

- The following instructions include example SQL that should work on MySQL and PostgreSQL. You may need to customise the queries for other databases or for your installation.
- We strongly recommend testing the queries on a test database before modifying your production database.

New user management in Confluence 3.5 and later

- Confluence now uses the CWD_USER table in the database to store and refer to its users.
- During an upgrade from Confluence 3.4.9 or earlier, the upgrade process copied the users from the OS_USER table (for upgrades from versions older than 2.7) or the USERS table (for versions 2.7 to 3.4) into the CWD_USER table.
- The new user management framework also introduced user directories. Making modifications to users in the database will only fully work for users in Confluence's Internal Directory. The instructions below include extra steps for instances in which the user management has been delegated to external sources (via LDAP, Crowd or JIRA).
Please refer to the older documentation if you are still using OSUser or AtlassianUser.

**Using Crowd for SSO**

- If Confluence is configured for SSO through Crowd, you will only be able to authenticate as users from the Crowd server.
- This document covers how to recover administration rights from the local 'Confluence Internal Directory' only. However, you will not be able to authenticate as a local Confluence administrator while Crowd SSO is enabled. Please refer to Integrating Crowd with Atlassian Confluence for details on how to configure or disable Crowd SSO.

### On this page:

- Before you Start
- Step 0. Get access to the database
- Step 1. Identify Administrator
- Step 2. Replace Administrator Password
- Step 3. Put the Internal Directory in First Position
- Step 4. Clean Up
- Notes

**Step 0. Get access to the database**

If you are using the embedded HSQL database, you can find the files containing your database in `<confluence-home-directory>/database`. When you shut down Confluence, the SQL will be written to a '.script' or '.log' file in that directory to which you can append the SQL described below.

If you are using a proper production database, connect to the database with your normal tools. You will need to have permission to run queries and update data in the database.

**Step 1. Identify Administrator**

To find out which usernames have admin privileges, connect to your database using a database admin tool such as DBVisualiser. Please download a database admin tool now if you do not have one installed already. Then connect to your database and retrieve the list of administrator usernames and IDs with:

```sql
SELECT u.id, u.user_name, u.active FROM cwd_user u
JOIN cwd_membership m ON u.id=m.child_user_id
JOIN cwd_group g ON m.parent_id=g.id
JOIN cwd_directory d ON d.id=g.directory_id
WHERE g.group_name = 'confluence-administrators' AND d.directory_name='Confluence Internal Directory';
```

If there are multiple results, choose one ID/username combination to use for the following steps.

If there are no results, skip down to **If No Local Administrator Exists**.

**Notes**

It is important to make sure that the "active" field contains a value of "T". Without this flag trying to authenticate with this user is a non starter.

To set active to true run the following query replacing "<user_name>" with the user name from the previous query:

```sql
UPDATE cwd_user
SET active = 'T'
WHERE user_name = '<user_name>';
```

**If No Local Administrator Exists**

There may be no administrators in your Internal Directory. If this is the case, you need to add one:

1. Add a new admin user by running:
Confluence 5.6 Documentation

Step 1. Create a new user by running:

```sql
insert into cwd_user(id, user_name, lower_user_name, active, created_date, updated_date, first_name, lower_first_name, last_name, lower_last_name, display_name, lower_display_name, email_address, lower_email_address, directory_id, credential) values (1212121, 'admin', 'admin', 'T', '2009-11-26 17:42:08', '2009-11-26 17:42:08', 'A. D.', 'a. d.', 'Ministrator', 'a. d. ministrator', 'admin@example.com', 'admin@example.com', (select id from cwd_directory where directory_name='Confluence Internal Directory'), 'x61Ey612Kl2gpFL56FT9weDnpSo4AV8j8+qx2AuTHdRyY036xxzTTrw10Wq3+4qQyB+XURPWx1ONxp3Y3pB37A==');
```

```sql
insert into user_mapping values ('2c9681954172cf560000000000000001', 'admin', 'admin');
```

2. Add new groups by running:

```sql
insert into cwd_group(id, group_name, lower_group_name, active, local, created_date, updated_date, description, group_type, directory_id) values ('888888','confluence-administrators','confluence-administrators','T','F','2011-03-21 12:20:29','2011-03-21 12:20:29',NULL,'GROUP',(select id from cwd_directory where directory_name='Confluence Internal Directory'));
```

```sql
insert into cwd_group(id, group_name, lower_group_name, active, local, created_date, updated_date, description, group_type, directory_id) values ('999999','confluence-users','confluence-users','T','F','2011-03-21 12:20:29','2011-03-21 12:20:29',NULL,'GROUP',(select id from cwd_directory where directory_name='Confluence Internal Directory'));
```

3. Add group memberships into cwd_membership:

```sql
insert into cwd_membership (id, parent_id, child_user_id) values (888888, (select id from cwd_group where group_name='confluence-users' and directory_id=(select id from cwd_directory where directory_name='Confluence Internal Directory')), 1212121);
```

```sql
insert into cwd_membership (id, parent_id, child_user_id) values (999999, (select id from cwd_group where group_name='confluence-administrators' and directory_id=(select id from cwd_directory where directory_name='Confluence Internal Directory')), 1212121);
```

⚠️ If using an Oracle database, use `sysdate` instead of a string for the `created_date` column.

Step 2. Replace Administrator Password

Confluence does not store passwords in plain text in the database, but uses hashes computed from the original password. You will need to insert a hash, rather than the plain password, over the existing password in the database. Below is the hash for the password `admin`:

```
x61Ey612Kl2gpFL56FT9weDnpSo4AV8j8+qx2AuTHdRyY036xxzTTrw10Wq3+4qQyB+XURPWx1ONxp3Y3pB37A==
```

For an External Database

To change the password to `admin` for a given username:

1. Shut down Confluence.
2. Connect to your database.
3. Run the following SQL:

```sql
update cwd_user set credential = 'x61Ey612Kl2gpFL56FT9weDnpSo4AV8j8+qx2AuTHdRyY036xxzTTrw10Wq3+4qQyB+XURPWX10Nxp3Y3pB37A=='
where id=<id from Stage 1>;
```

For the Evaluation Embedded HSQL Database

**To change the password to admin for a given username:**

1. Shut down Confluence.
2. Open `<confluence-home>/database/confluencedb.script`, or confluencedb.log if the .script file looks empty.
3. Search for:

   ```sql
   INSERT INTO CWD_USER VALUES(
   ...)
   ```

4. Keep searching until you find the appropriate user, then replace their password with the hash value above.
5. Save the file.

**Step 3. Put the Internal Directory in First Position**

Start Confluence, and try logging in with the username of the user you updated/created and the password 'admin'. If this works, skip to Step 4. Otherwise, your Internal Directory does not have high enough priority.

**To put your Internal Directory in first position:**

1. Find the directory names and their order:

   ```sql
   select d.id, d.directory_name, m.list_index from cwd_directory d join cwd_app_dir_mapping m on d.id=m.directory_id;
   ```

2. Take note of the ID with list_index 0, and the list_index and ID of the Confluence Internal Directory.
3. Switch the order of the directories:

   ```sql
   update cwd_app_dir_mapping set list_index = 0 where directory_id = <Internal Directory id>;
   update cwd_app_dir_mapping set list_index = <Noted Internal Directory list_index> where directory_id = <Directory id that had list_index 0>;
   ```

4. Check to see if the directory is active (the ‘active’ column should be set to ‘T’):

   ```sql
   select id, directory_name, active from cwd_directory where id = <Internal Directory id>;
   ```

5. If necessary, activate the directory:

   ```sql
   update cwd_directory set active = 'T' where id = <Internal Directory id>;
   ```

**Step 4. Clean Up**
To tidy up:

1. Start Confluence.
2. Log in with your modified/created username and use password `admin`.
3. Change your password. **Do not leave your password as admin, or your instance will not be secure.**
4. If you created a new user in Stage 2, create a new admin via the UI and delete the admin you created in Stage 2.
5. If you followed Stage Three, go to Confluence Administration > User Directories and rearrange your directories so they are correctly configured again.

Notes

- Learn more about the password hash algorithm Confluence is using.

**Managing Site-Wide Permissions and Groups**

Permissions determine what people can do on your Confluence site. Confluence recognises permissions at **site level** and at **space level**, as well as **page-level restrictions**.

You can create **groups** and allocate people to them, so that you can assign permissions to a number of people at once. For example, it is quicker to give group 'X' access to Confluence, rather than giving every team member access individually. You can also set the access levels for **anonymous users**.

**Related pages:**

- Confluence Administrator's Guide
- Confluence Security Overview and Advisories

**Global Groups Overview**

A group is a collection of users. Administrators create groups so that the administrator can assign permissions to a number of people at once. For example, it is quicker to give group 'X' access to Confluence, rather than giving every team member access individually. You need **Confluence Administrator permissions** to view and update groups.

Groups are available at the space and page levels to allow for flexible access control. A user in a group will automatically be granted all permissions granted to the group.

**Special groups**

There are two special default groups in Confluence:

1. **confluence-administrators**: This is a group of ‘super-users’ who can access the Confluence administration screens (‘administration console’) and perform site-wide administration. Members of this group can also see all spaces in the Confluence site. Any user who is a member of this group has site-wide administration powers, regardless of any other setting. The settings on the global permissions screen do **not** affect the powers allowed to members of this group.
2. **confluence-users**: This is the default group for all new users. Permissions you assign to this group will be assigned to all newly signed-up users of Confluence.

**The Confluence Administrator permission and the ‘confluence-administrators’ group are not related.** Going by the names, you would think the 'confluence-administrators' group and the 'Confluence Administrator' permission are related – but they are not. Granting a user or a group 'Confluence Administrator' permission is **not** the same as granting them membership of the 'confluence-administrators' group. Granting the 'Confluence Administrator' permission enables access to only a subset of the administrative functions. Granting membership to the 'confluence-administrators' group gives complete access.
Anonymous users

Confluence treats all users who do not log in when they access Confluence as being 'anonymous'. You can grant anonymous 'Use Confluence' permission via the Global Permissions screen. See Setting Up Public Access. This will allow non-registered users to access pages and spaces in Confluence. A space administrator can further control anonymous access per space via the space permissions.

Updating groups

To add a new group:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Groups in the left-hand panel.
3. Choose Add Group.
4. Enter a name for your group and choose Save.

You are now ready to start adding users to the group.

To delete a group:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Groups in the left-hand panel. You will see a list of all existing groups along with links to remove them.
3. Choose Delete next to the group you want to remove.

Notes

- **Multiple user directories**: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

   Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

   See Managing Multiple Directories.

Adding or Removing Users in Groups

If you are a Confluence Administrator, you can add users and groups, and assign users to groups, in order to determine their permissions.

This page tells you how to add a user to a group or remove a user from a group. For an overview of users and groups, please refer to Users and Groups and Managing Confluence Users.
You can edit group membership in two places:

- From the group management screen.
- From the user management screen for a particular user.

Both methods are described below.

**Adding and removing members via the group management screen**

This is the recommended method. It allows you to manage the group membership for a number of users at the same time.

**To add members to a group:**

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Groups in the left-hand panel.
3. The 'Groups' screen appears, showing a list of groups. Choose the group to which you want to add users.
4. The 'Group Members' screen appears, showing the users who belong to the selected group. Choose Add Members.
5. Type the username(s) of the people you want to add to the group.
   - If you want to add more than one member, separate the usernames with commas.
   - You can also search for and select users by choosing the search icon, as described in Searching for Users.
6. Choose Add to add the member(s) to the group.

**To remove members from a group:**

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Groups in the left-hand panel.
3. The 'Manage Groups' screen appears, showing a list of groups. Choose the group from which you want to remove the user.
4. The 'Group Members' screen appears, showing the users who belong to the selected group. Choose the 'Delete user from group' icon next to the user whose group membership you want to remove.

---

**On this page:**

- Adding and removing members via the group management screen
- Editing group membership from the user management screen
- Notes

**Related pages:**

- Managing Confluence Users
- Global Permissions Overview
- Confluence Administrator's Guide

---

The information on this page does not apply if you have multiple Cloud apps. If you are only using Confluence Cloud, the information does apply.

---

Screenshot: Adding members
Editing group membership from the user management screen

You can update a user's group membership from the user management screen. This functionality allows you to update one user at a time.

To add a user to a group or remove a user from a group:

1. Go to the user management screen for the user concerned. There are two ways to do this:
   - Either, go to the user's Profile and choose Administer User on the user's profile screen.
   - Or, Choose the cog icon, then choose General Configuration under Confluence Administration.
     - Choose Users in the left-hand panel.
     - The 'Users' screen appears. You can now choose to 'Show all users' or you can search for a specific user by entering all or part of the person's username, full name or email address. For more details about the user search, see Searching For and Administering Users.
     - Choose the username you want to edit.
2. The 'View User' screen appears. Choose Edit Groups.
3. Select the group(s) for this user. To remove a user from a group, remove the tick mark in the relevant check box.

Screenshot: Editing a user's groups

Notes

You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories.
Global Permissions Overview

Global Permissions determine the actions which a user is allowed to perform in Confluence at a site level. To assign global permissions to a user or group you need Confluence Administrator or greater permissions.

Note: The first system administrator is defined during initial setup. During the initial configuration of Confluence, the Setup Wizard asks for the username of the System Administrator. This user will have the ‘System Administrator’ permission and will be a member of the ‘confluence-administrators’ group.

Overview of the global permissions

The following global permissions can be applied to groups and individuals.

<table>
<thead>
<tr>
<th>Global Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can Use</td>
<td>This is the most basic permission that allows users to access the site. Users with this permission count towards the number of users allowed by your license.</td>
</tr>
<tr>
<td>Attach Files to User Profile</td>
<td>This allows the user to upload files to be stored in their user profile. This feature was made obsolete by the introduction of personal spaces in Confluence 2.2. Hence, this permission is no longer relevant. Attachments can be accessed from a user profile view (for example, an image within the ‘About Me’ field of a profile view) by attaching these files to a page within that user’s personal space and referencing them using appropriate wiki markup code.</td>
</tr>
<tr>
<td>Update User Status</td>
<td>This allows the user to update their user status message, which can be seen on the user’s profile, pages in their personal space and on various activity streams accessible to other Confluence users.</td>
</tr>
<tr>
<td>Personal Space</td>
<td>This permission allows the user to create a personal space.</td>
</tr>
<tr>
<td>Create Space(s)</td>
<td>This permission allows users to create new spaces within your Confluence site. When a space is created, the creator automatically has the ‘Admin’ permission for that space and can perform space-wide administrative functions.</td>
</tr>
<tr>
<td>Confluence Administrator</td>
<td>This permission allows users to access the ‘Administration Console’ that controls site-wide administrative functions. Users with this permission can perform most, but not all, of the Confluence administrative functions. See the comparison of ‘System Administrator’ and ‘Confluence Administrator’ below.</td>
</tr>
<tr>
<td>System Administrator</td>
<td>This permission allows users to access the ‘Administration Console’ that controls site-wide administrative functions. Users with this permission can perform all the Confluence administrative functions, including the ones which the ‘Confluence Administrator’ permission does not allow. See the comparison of ‘System Administrator’ and ‘Confluence Administrator’ below. Refer also to the note about the ‘confluence-administrators’ group below.</td>
</tr>
</tbody>
</table>

Comparing the System Administrator permission with the Confluence Administrator permission

Confluence recognises two levels of administrator:

- **System Administrator** – Users with this permission can perform all the Confluence administrative functions, including the ones which the ‘Confluence Administrator’ permission does not allow.
- **Confluence Administrator** – Users with this permission can perform most, but not all, of the Confluence administrative functions.

The two-tier administration is useful when you want to delegate some administrator privileges to project managers or team leaders. You can give ‘Confluence Administrator’ permission to users who should be able to perform most administrative functions, but should not be able to perform functions that can compromise the
security of the Confluence system.

The following functions are granted to the 'System Administrator' permission but excluded from the 'Confluence Administrator' permission:

<table>
<thead>
<tr>
<th>Administration Screen</th>
<th>Excluded from Confluence Administrator permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Configuration</td>
<td>The following functionality is disallowed:</td>
</tr>
<tr>
<td></td>
<td>• Server Base URL</td>
</tr>
<tr>
<td></td>
<td>• Public Signup</td>
</tr>
<tr>
<td></td>
<td>• Connection Timeouts</td>
</tr>
<tr>
<td>Further Configuration</td>
<td>The following functionality is disallowed:</td>
</tr>
<tr>
<td></td>
<td>• Remote API plugin</td>
</tr>
<tr>
<td>Security Configuration</td>
<td>The following functionality is disallowed:</td>
</tr>
<tr>
<td></td>
<td>• External user management</td>
</tr>
<tr>
<td></td>
<td>• Append wildcards to user and group searches</td>
</tr>
<tr>
<td></td>
<td>• Anti XSS Mode</td>
</tr>
<tr>
<td></td>
<td>• Enable Custom Stylesheets for Spaces</td>
</tr>
<tr>
<td></td>
<td>• Show system information on the 500 page</td>
</tr>
<tr>
<td></td>
<td>• Maximum RSS Items</td>
</tr>
<tr>
<td></td>
<td>• XSRF Protection</td>
</tr>
<tr>
<td>Plugins</td>
<td>The following functionality is disallowed:</td>
</tr>
<tr>
<td></td>
<td>• Upgrade</td>
</tr>
<tr>
<td></td>
<td>• Install</td>
</tr>
<tr>
<td></td>
<td>• Confluence Upgrade Check</td>
</tr>
<tr>
<td>Daily Backup Admin</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Mail Servers</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>User Macros</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Attachment Storage</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Layouts</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Custom HTML</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Backup &amp; Restore</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Logging and Profiling</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Cluster Configuration</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Application Links</td>
<td>People with the 'Confluence Administrator' permission can add, modify and remove application links and project links. For example, they can link Confluence to JIRA. However, Confluence administrators can configure only OAuth authentication for application links.</td>
</tr>
</tbody>
</table>
Office Connector configuration

This function is disallowed entirely.

Comparing the confluence-administrators group with the administrator permissions

The 'confluence-administrators' group defines a set of 'super-users' who can access the Confluence administration console and perform site-wide administration. Members of this group can also see the content of all pages and spaces in the Confluence instance, regardless of space permissions. They cannot immediately see the pages that exclude them via page restrictions without knowing the direct URL to the page. They can remove the page restrictions via the Space Administration screen if need be. For example, they will not see restricted pages displayed by the children macro. But they are able to access restricted pages directly using the page URL.

The settings on the 'Global Permissions' screen do not affect the powers allowed to members of the 'confluence-administrators' group.

Granting the 'System Administrator' or 'Confluence Administrator' permission to a user will not automatically grant the user access to all spaces in the site. These permissions will only give access to the administration console.

Be aware, however, that users with 'System Administrator' can add themselves to the 'confluence-administrators' group and become a super-user.

The Confluence Administrator permission and the 'confluence-administrators' group are not related. Going by the names, you would think the 'confluence-administrators' group and the 'Confluence Administrator' permission are related – but they are not. Granting a user or a group 'Confluence Administrator' permission is not the same as granting them membership of the 'confluence-administrators' group. Granting the 'Confluence Administrator' permission enables access to only a subset of the administrative functions. Granting membership to the 'confluence-administrators' group gives complete access.

Updating global permissions

To view the global permissions for a group or user:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Global Permissions in the left-hand panel. The 'View Global Permissions' screen appears.

Add or edit group and user permissions as follows:

To add permissions for a group:

1. First add the group to Confluence, if you have not already done so.
2. Choose Edit Permissions. The 'Edit Global Permissions' screen appears.
3. Enter the group name in the Grant browse permission to box in the 'Groups' section. You can search for the group name.
4. Choose Add.
5. The group will appear in the list and you can now edit its permissions.

To add permissions for a specific user:

(Consider adding the user to a group and then assigning the permissions to the group, as described above, instead of assigning permissions to the specific user.)

1. First add the user to Confluence, if you have not already done so.
2. Choose Edit Permissions. The 'Edit Global Permissions' screen appears.
3. Enter the username in the Grant browse permission to box in the 'Individual Users' section. You can search for the username.
4. Choose Add.
5. The username will appear in the list and you can now edit its permissions.

To add or edit the permissions for a user or group:

1. Select, or clear, the check box under the relevant permission in the row for the relevant user/group. A selected check box indicates that the permission is granted.
2. To allow anonymous access to your Confluence site, select the 'Use Confluence' and 'View User Profile'
options in the 'Anonymous Access' section. For more information about these permissions, refer to Setting Up Public Access.

3. Choose **Save All** to save your changes.

**Screenshot: Editing global permissions**

---

**Error messages you may see**

Confluence will let you know if there is a problem with some permissions. In rare situations, you may see the following error messages below a permission:

- 'User/Group not found' - This message may appear if your LDAP repository is unavailable, or if the user/group has been deleted after the permission was created.
- 'Case incorrect. Correct case is: xxxxxx' - This message may appear if the upper/lower case in the permission does not match the case of the username or group name. If you see a number of occurrences of this message, you should consider running the routine supplied to fix the problem.

**Setting Up Public Access**

You can enable anonymous access (also known as public access) to your Confluence site by granting the 'Use Confluence' permission to 'anonymous' users. An 'anonymous' user is someone who has not logged in to the
Confluence site. The 'Use Confluence' permission is also called 'can use'.

This user category gives you an easy way to administer users who have not logged into the site. Permissions assigned to this category apply to all anonymous users of the site.

Enabling anonymous access to the site

If you want to make your site visible to everyone, including people who have not logged in, you must enable anonymous access at site level.

To enable anonymous access to your site:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Global Permissions in the left-hand panel.
3. Choose Edit Permissions.
4. In the 'Anonymous Access' section, select the can use check box to enable anonymous access to the content on your site.
5. If you want to allow anonymous users to see user profiles, select the check box in the View User Profiles section.
   Note: You must grant the 'can use' permission as well, if you want to grant the 'View User Profiles' permission.
6. Choose Save All.

Disabling anonymous access to the site

To disable anonymous access to your site, deselect the can use check box, then choose Save All. People will not be able to see the content on the site until they have logged in.

Granting public access to a space

To enable public access to a Confluence space, you must grant the following permissions to anonymous users:

- The site-wide 'can use' permission, as described above.
- The relevant space permissions. If you want a space to be publicly accessible, the anonymous user must have at least the 'View Space' permission. To set space permissions, choose Browse > Space Admin > Permissions.

Notes

- We severely warn against giving anonymous users any administrative privileges, either within a space, or especially over the Confluence site. Giving administrative privileges to untrusted users may lead to a serious security compromise of your site.
- You can allow people to sign up for usernames themselves, and choose other options for user signup and invitations. See Adding and Inviting Users.

Configuring User Directories

A user directory is a place where you store information about users and groups. User information includes the person's full name, username, password, email address and other personal information. Group information
includes the name of the group, the users that belong to the group, and possibly groups that belong to other groups.

The internal directory stores user and group information in the Confluence database. You can also connect to external user directories, and to Atlassian Crowd and JIRA as directory managers.

On this page:
- Configuring User Directories in Confluence
- Connecting to a Directory
- Updating Directories

⚠️ The information on this page does not apply to Confluence Cloud.

Configuring User Directories in Confluence

To configure your Confluence user directories:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Click ‘User Directories’ in the left-hand panel.

Connecting to a Directory

You can add the following types of directory servers and directory managers:
- Confluence's internal directory. See Configuring the Internal Directory.
- Various other LDAP directory servers. See Connecting to an LDAP Directory.
- An LDAP directory for delegated authentication. See Connecting to an Internal Directory with LDAP Authentication.
- Atlassian Crowd. See Connecting to Crowd or JIRA for User Management.
- Atlassian JIRA 4.3 or later. See Connecting Confluence to JIRA for User Management.
- Atlassian JIRA 4.2 or earlier, using the legacy database connection. See Connecting to JIRA 4.2 or Earlier for User Management.

You can add as many external user directories as you need. Note that you can define the order of the directories. This determines which directory Confluence will search first, when looking for user and group information. See Managing Multiple Directories.

Updating Directories

Limitations when Editing Directories

You cannot edit, disable or remove the directory your user belongs to. This precaution is designed to prevent administrators from locking themselves out of the application by changing the directory configuration in a way that prevents them logging in or removes their administration permissions.

This limitation applies to all directory types. For example:
- You cannot disable the internal directory if your user is an internal user.
- You cannot disable or remove an LDAP or a Crowd directory if your user comes from that directory.

In some situations, reordering the directories will change the directory that the current user comes from, if a user with the same username happens to exist in both. This behaviour can be used in some cases to create a copy of the existing configuration, move it to the top, then remove the old one. Note, however, that duplicate usernames are not a supported configuration.

You cannot remove the internal directory. This precaution aligns with the recommendation below that you always keep an administrator account active in the internal directory.

Recommendations
The recommended way to edit directory configurations is to log in as an internal user when making changes to external directory configuration.

⚠️ We recommend that you keep either an administrator or system administrator user active in your internal directory for troubleshooting problems with your user directories.

**Enabling, Disabling and Removing Directories**

You can enable or disable a directory at any time. If you disable a directory, your configuration details will remain but the application will not recognise the users and groups in that directory.

You have to disable a directory before you can remove it. Removing a directory will remove the details from the database.

**Screenshot above: Configuring user directories**

**RELATED TOPICS**

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management
- Adding and Inviting Users
- Managing Site-Wide Permissions and Groups

**Configuring the Internal Directory**

The internal directory stores user and group information in the Confluence database.

**Overview**

The internal directory is enabled by default at installation. When you create the first administrator during the setup procedure, that administrator’s username and other details are stored in the internal directory.

If needed, you can configure one or more additional user directories. This is useful if you want to grant access to users and groups that are stored in a corporate directory or other directory server.
Diagram above: Confluence using its internal directory for user management.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management

How to Reenable the Internal Directory (Knowledge base article)

Connecting to an LDAP Directory

You can connect your Confluence application to an LDAP directory for authentication, user and group management.

Overview

An LDAP directory is a collection of data about users and groups. LDAP (Lightweight Directory Access Protocol) is an Internet protocol that web applications can use to look up information about those users and groups from...
the LDAP server.

We provide built-in connectors for the most popular LDAP directory servers:

- Microsoft Active Directory
- Apache Directory Server (ApacheDS)
- Apple Open Directory
- Fedora Directory Server
- Novell eDirectory
- OpenDS
- OpenLDAP
- OpenLDAP Using Posix Schema
- Posix Schema for LDAP
- Sun Directory Server Enterprise Edition (DSEE)
- A generic LDAP directory server

**When to use this option:** Connecting to an LDAP directory server is useful if your users and groups are stored in a corporate directory. When configuring the directory, you can choose to make it read only, read only with local groups, or read/write. If you choose read/write, any changes made to user and group information in the application will also update the LDAP directory.

*Connecting to an LDAP Directory in Confluence*

*To connect Confluence to an LDAP directory:*

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Click **User Directories** in the left-hand panel.
3. Add a directory and select one of these types:
   - **Microsoft Active Directory** – This option provides a quick way to select AD, because it is the most popular LDAP directory type.
   - **LDAP** – You will be able to choose a specific LDAP directory type on the next screen.
4. Enter the values for the settings, as described below.
5. Save the directory settings.
6. Define the **directory order** by clicking the blue up- and down-arrows next to each directory on the ‘User Directories’ screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

For details see **Managing Multiple Directories**.
On this page:
- Overview
- Connecting to an LDAP Directory in Confluence
- Server Settings
- Schema Settings
- Permission Settings
  - Adding Users to Groups Automatically
- Advanced Settings
- User Schema Settings
- Group Schema Settings
- Membership Schema Settings
- Diagrams of Some Possible Configurations
- Notes

Related pages:
Configuring User Directories
- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management

⚠️ The information on this page does not apply to Confluence Cloud.

## Server Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a meaningful name to help you identify the LDAP directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>- Example Company Staff Directory</td>
</tr>
<tr>
<td></td>
<td>- Example Company Corporate LDAP</td>
</tr>
<tr>
<td>Directory Type</td>
<td>Select the type of LDAP directory that you will connect to. If you are adding a new LDAP connection, the value you select here will determine the default values for many of the options on the rest of screen. Examples:</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Active Directory</td>
</tr>
<tr>
<td></td>
<td>- OpenDS</td>
</tr>
<tr>
<td></td>
<td>- And more.</td>
</tr>
<tr>
<td>Hostname</td>
<td>The host name of your directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>- ad.example.com</td>
</tr>
<tr>
<td></td>
<td>- ldap.example.com</td>
</tr>
<tr>
<td></td>
<td>- opends.example.com</td>
</tr>
</tbody>
</table>
Port | The port on which your directory server is listening. Examples:

- 389
- 10389
- 636 (for example, for SSL)

Use SSL | Check this if the connection to the directory server is an SSL (Secure Sockets Layer) connection. Note that you will need to configure an SSL certificate in order to use this setting.

Username | The distinguished name of the user that the application will use when connecting to the directory server. Examples:

- cn=administrator,cn=users,dc=ad,dc=example,dc=com
- cn=user,dc=domain,dc=name
- user@domain.name

Ensure that this is an administrator user for the LDAP engine. For example, in Active Directory the user will need to be a member of the built-in Administrators group.

Password | The password of the user specified above.

Note: Connecting to an LDAP server requires that this application log in to the server with the username and password configured here. As a result, this password cannot be one-way hashed - it must be recoverable in the context of this application. The password is currently stored in the database in plain text without obfuscation. To guarantee its security, you need to ensure that other processes do not have OS-level read permissions for this application's database or configuration files.

Schema Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Base DN   | The root distinguished name (DN) to use when running queries against the directory server. Examples:

- o=example,c=com
- cn=users,dc=ad,dc=example,dc=com
- For Microsoft Active Directory, specify the base DN in the following format: dc=domain1,dc=local. You will need to replace the domain1 and local for your specific configuration. Microsoft Server provides a tool called ldp.exe which is useful for finding out and configuring the the LDAP structure of your server. |

Additional User DN | This value is used in addition to the base DN when searching and loading users. If no value is supplied, the subtree search will start from the base DN. Example:

- ou=Users |

Additional Group DN | This value is used in addition to the base DN when searching and loading groups. If no value is supplied, the subtree search will start from the base DN. Example:

- ou=Groups |

Permission Settings

Note: You can only assign LDAP users to local groups when 'External Management User Management' is not selected.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>LDAP users, groups and memberships are retrieved from your directory server and can only be modified via your directory server. You cannot modify LDAP users, groups or memberships via the application administration screens.</td>
</tr>
</tbody>
</table>
LDAP users, groups and memberships are retrieved from your directory server and can only be modified via your directory server. You cannot modify LDAP users, groups or memberships via the application administration screens. However, you can add groups to the internal directory and add LDAP users to those groups.

Note for Confluence users: Users from LDAP are added to groups maintained in Confluence's internal directory the first time they log in. This is only done once per user. There is a known issue with Read Only, with Local Groups in Confluence that may apply to you. See CONF-28621 - User Loses all Local Group Memberships If LDAP Sync is Unable to find the User, but the User appears again in subsequent syncs.

Read/Write LDAP users, groups and memberships are retrieved from your directory server. When you modify a user, group or membership via the application administration screens, the changes will be applied directly to your LDAP directory server. Please ensure that the LDAP user specified for the application has modification permissions on your LDAP directory server.

Adding Users to Groups Automatically

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default Group Memberships | Option available in Confluence 3.5 and later, and JIRA 4.3.3 and later. This field appears if you select the 'Read Only, with Local Groups' permission. If you would like users to be automatically added to a group or groups, enter the group name(s) here. To specify more than one group, separate the group names with commas. In Confluence 3.5 to Confluence 3.5.1: Each time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added locally. In Confluence 3.5.2 and later, and JIRA 4.3.3 and later: The first time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added locally. On subsequent logins, the username will not be added automatically to any groups. This change in behaviour allows users to be removed from automatically-added groups. In Confluence 3.5 and 3.5.1, they would be re-added upon next login. Please note that there is no validation of the group names. If you mis-type the group name, authorisation failures will result – users will not be able to access the applications or functionality based on the intended group name. Examples:  
- confluence-users  
- confluence-users, jira-users, jira-developers |

Advanced Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. Some directory servers allow you to define a group as a member of another group. Groups in such a structure are called 'nested groups'. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
<tr>
<td>Use Paged Results</td>
<td>Enable or disable the use of the LDAP control extension for simple paging of search results. If paging is enabled, the search will retrieve sets of data rather than all of the search results at once. Enter the desired page size – that is, the maximum number of search results to be returned per page when paged results are enabled. The default is 1000 results.</td>
</tr>
</tbody>
</table>
Follow Referrals

Choose whether to allow the directory server to redirect requests to other servers. This option uses the node referral (JNDI lookup `java.naming.referral`) configuration setting. It is generally needed for Active Directory servers configured without proper DNS, to prevent a 'javax.naming.PartialResultException: Unprocessed Continuation Reference(s)' error.

Naive DN Matching

If your directory server will always return a consistent string representation of a DN, you can enable naive DN matching. Using naive DN matching will result in a significant performance improvement, so we recommend enabling it where possible.

This setting determines how your application will compare DNs to determine if they are equal.

- If this checkbox is selected, the application will do a direct, case-insensitive, string comparison. This is the default and recommended setting for Active Directory, because Active Directory guarantees the format of DNs.
- If this checkbox is not selected, the application will parse the DN and then check the parsed version.

Enable Incremental Synchronisation

Enable incremental synchronisation if you only want changes since the last synchronisation to be queried when synchronising a directory.

⚠️ Please be aware that when using this option, the user account configured for synchronisation must have read access to:

- The `uSNChanged` attribute of all users and groups in the directory that need to be synchronised.
- The objects and attributes in the Active Directory deleted objects container (see Microsoft's Knowledge Base Article No. 892806 for details).

If at least one of these conditions is not met, you may end up with users who are added to (or deleted from) the Active Directory not being respectively added (or deleted) in the application.

This setting is only available if the directory type is set to "Microsoft Active Directory".

Synchronisation Interval (minutes)

Synchronisation is the process by which the application updates its internal store of user data to agree with the data on the directory server. The application will send a request to your directory server every x minutes, where 'x' is the number specified here. The default value is 60 minutes.

Read Timeout (seconds)

The time, in seconds, to wait for a response to be received. If there is no response within the specified time period, the read attempt will be aborted. A value of 0 (zero) means there is no limit. The default value is 120 seconds.

Search Timeout (seconds)

The time, in seconds, to wait for a response from a search operation. A value of 0 (zero) means there is no limit. The default value is 60 seconds.

Connection Timeout (seconds)

This setting affects two actions. The default value is 0.

- The time to wait when getting a connection from the connection pool. A value of 0 (zero) means there is no limit, so wait indefinitely.
- The time, in seconds, to wait when opening new server connections. A value of 0 (zero) means that the TCP network timeout will be used, which may be several minutes.

User Schema Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Object Class</td>
<td>This is the name of the class used for the LDAP user object. Example:</td>
</tr>
<tr>
<td></td>
<td>- <code>user</code></td>
</tr>
</tbody>
</table>
| User Object Filter | The filter to use when searching user objects. Example:  
|                   | \( (\&(\text{objectCategory}=\text{Person})(\text{sAMAccountName}=*)) \)  
|                   | More examples can be found [here](#) and [here](#). |
| User Name Attribute | The attribute field to use when loading the username. Examples:  
|                   | \( \text{cn} \)  
|                   | \( \text{sAMAccountName} \)  
|                   | NB: In Active Directory, the 'sAMAccountName' is the 'User Logon Name (pre-Windows 2000)' field. The User Logon Name field is referenced by 'cn'. |
| User Name RDN Attribute | The RDN (relative distinguished name) to use when loading the username. The DN for each LDAP entry is composed of two parts: the RDN and the location within the LDAP directory where the record resides. The RDN is the portion of your DN that is not related to the directory tree structure. Example:  
|                   | \( \text{cn} \) |
| User First Name Attribute | The attribute field to use when loading the user's first name. Example:  
|                   | \( \text{givenName} \) |
| User Last Name Attribute | The attribute field to use when loading the user's last name. Example:  
|                   | \( \text{sn} \) |
| User Display Name Attribute | The attribute field to use when loading the user's full name. Example:  
|                   | \( \text{displayName} \) |
| User Email Attribute | The attribute field to use when loading the user's email address. Example:  
|                   | \( \text{mail} \) |
| User Password Attribute | The attribute field to use when loading a user's password. Example:  
|                   | \( \text{unicodePwd} \) |
| User Unique ID Attribute | The attribute used as a unique immutable identifier for user objects. This is used to track username changes and is optional. If this attribute is not set (or is set to an invalid value), user renames will not be detected — they will be interpreted as a user deletion then a new user addition.  
|                   | This should normally point to a UUID value. Standards-compliant LDAP servers will implement this as 'entryUUID' according to [RFC 4530](https://tools.ietf.org/html/rfc4530). This setting exists because it is known under different names on some servers, e.g. 'objectGUID' in Microsoft Active Directory.  

**Group Schema Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Group Object Class       | This is the name of the class used for the LDAP group object. Examples:  
| Group Of Unique Names    | \( \text{groupOfUniqueNames} \)  
<p>| Group                    | ( \text{group} ) |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Object Filter</td>
<td>The filter to use when searching group objects. Example:</td>
</tr>
<tr>
<td></td>
<td>• (&amp;(objectClass=group)(cn=*))</td>
</tr>
<tr>
<td>Group Name Attribute</td>
<td>The attribute field to use when loading the group's name. Example:</td>
</tr>
<tr>
<td></td>
<td>• cn</td>
</tr>
<tr>
<td>Group Description Attribute</td>
<td>The attribute field to use when loading the group's description. Example:</td>
</tr>
<tr>
<td></td>
<td>• description</td>
</tr>
</tbody>
</table>

**Membership Schema Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Members Attribute</td>
<td>The attribute field to use when loading the group's members. Example:</td>
</tr>
<tr>
<td></td>
<td>• member</td>
</tr>
<tr>
<td>User Membership Attribute</td>
<td>The attribute field to use when loading the user's groups. Example:</td>
</tr>
<tr>
<td></td>
<td>• memberOf</td>
</tr>
<tr>
<td>Use the User Membership Attribute, when finding the user's group membership</td>
<td>Check this if your directory server supports the group membership attribute on the user. (By default, this is the ‘memberOf’ attribute.)</td>
</tr>
<tr>
<td></td>
<td>• If this checkbox is selected, your application will use the group membership attribute on the user when retrieving the list of groups to which a given user belongs. This will result in a more efficient retrieval.</td>
</tr>
<tr>
<td></td>
<td>• If this checkbox is not selected, your application will use the members attribute on the group (‘member’ by default) for the search.</td>
</tr>
<tr>
<td></td>
<td>• If the Enable Nested Groups checkbox is selected, your application will ignore the Use the User Membership Attribute option and will use the members attribute on the group for the search.</td>
</tr>
<tr>
<td>Use the User Membership Attribute, when finding the members of a group</td>
<td>Check this if your directory server supports the user membership attribute on the group. (By default, this is the ‘member’ attribute.)</td>
</tr>
<tr>
<td></td>
<td>• If this checkbox is selected, your application will use the group membership attribute on the user when retrieving the members of a given group. This will result in a more efficient search.</td>
</tr>
<tr>
<td></td>
<td>• If this checkbox is not selected, your application will use the members attribute on the group (‘member’ by default) for the search.</td>
</tr>
</tbody>
</table>

**Diagrams of Some Possible Configurations**
Diagram above: Confluence connecting to an LDAP directory.

Notes

Currently there is a bug which causes a system error if the username and password are not correct. This also
happens if you are accessing anonymously, but the directory server does not support anonymous access. If you get a system error message, try checking the username and password credentials. You can watch this issue to see updates on this bug: [CONF-25961 - NPE when defining LDAP directory and having wrong password](CONF-25961)  

**Configuring the LDAP Connection Pool**

When connection pooling is enabled, the LDAP directory server maintains a pool of connections and assigns them as needed. When a connection is closed, the directory server returns the connection to the pool for future use. This can improve performance significantly.

**To configure your LDAP connection pool:**

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Click 'User Directories' in the left-hand panel.
3. Click 'LDAP Connection Pool Configuration' in the 'Additional Configuration' section.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Pool Size</td>
<td>The number of LDAP connections created when initially connecting to the pool.</td>
<td>1</td>
</tr>
<tr>
<td>Preferred Pool Size</td>
<td>The optimal pool size. LDAP will remove idle connections when the number of connections grows larger than this value. A value of 0 (zero) means that there is no preferred size, so the number of idle connections is unlimited.</td>
<td>10</td>
</tr>
<tr>
<td>Maximum Pool Size</td>
<td>The maximum number of connections. When the number of connections reaches this value, LDAP will refuse further connections. As a result, requests made by an application to the LDAP directory server will be blocked. A value of 0 (zero) means that the number of connections is unlimited.</td>
<td>0</td>
</tr>
<tr>
<td>Pool Timeout (seconds)</td>
<td>The length of time, in seconds, that a connection may remain idle before being removed from the pool. When the application is finished with a pooled connection, the connection is marked as idle, waiting to be reused. A value of 0 (zero) means that the idle time is unlimited, so connections will never be timed out.</td>
<td>30</td>
</tr>
<tr>
<td>Pool Protocol</td>
<td>Only these protocol types will be allowed to connect to the LDAP directory server. If you want to allow multiple protocols, enter the values separated by a space. Valid values are:</td>
<td>plain ssl (Both plain and ssl)</td>
</tr>
</tbody>
</table>
|                    | • plain
|                    | • ssl
| Pool Authentication| Only these authentication types will be allowed to connect to the LDAP directory server. If you want to allow multiple authentication types, enter the values separated by a space. See RFC 2829 for details of LDAP authentication methods. Valid values are: | simple |
|                    | • none
|                    | • simple
|                    | • DIGEST-MD5

**Notes:**

- The connection pool settings are system wide and will be used to create a new connection pool for every configured LDAP directory server.
- You must restart your application server for these settings to take effect.

**RELATED TOPICS**

- Connecting to an LDAP Directory
- Configuring User Directories
- Administrators Guide Home
- Confluence Documentation Home
- Configuring an SSL Connection to Active Directory

Created in 2014 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](http://creativecommons.org/licenses/by/2.5/au/).
If you want to configure a read/write connection with Microsoft Active Directory, you will need to install an SSL certificate, generated by your Active Directory server, onto your Confluence server and then install the certificate into your JVM keystore.

On this page:
- Prerequisites
- Step 1. Install the Active Directory Certificate Services
- Step 2. Obtain the Server Certificate
- Step 3. Import the Server Certificate

There's a Confluence SSL plugin that facilitates this process.

Updating user, group, and membership details in Active Directory requires that your Atlassian application be running in a JVM that trusts the AD server. To do this, we generate a certificate on the Active Directory server, then import it into Java's keystore.

Prerequisites

To generate a certificate, you need the following components installed on the Windows Domain Controller to which you're connecting.

<table>
<thead>
<tr>
<th>Required Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Information Services (IIS)</td>
<td>This is required before you can install Windows Certificate Services.</td>
</tr>
<tr>
<td>Windows Certificate Services</td>
<td>This installs a certification authority (CA) which is used to issue certificates. Step 1, below, explains this process.</td>
</tr>
<tr>
<td>Windows 2000 Service Pack 2</td>
<td>Required if you are using Windows 2000</td>
</tr>
</tbody>
</table>

Step 1. Install the Active Directory Certificate Services

If Certificate Services are already installed, skip to step 2, below. The screenshots below are from Server 2008, but the process is similar for Server 2000 and 2003.

1. Log in to your Active Directory server as an administrator.
2. Click **Start**, point to **Administrative Tools**, and then click **Server Manager**.
3. In the **Roles Summary** section, click **Add Roles**.
5. On the **Select Role Services** page, select the **Certification Authority** check box, and then click **Next**.

6. On the **Specify Setup Type** page, click **Enterprise**, and then click **Next**.
7. On the **Specify CA Type** page, click **Root CA**, and then click **Next**.
8. On the Set Up Private Key and Configure Cryptography for CA pages, you can configure optional configuration settings, including cryptographic service providers. However, the default values should be fine. Click Next twice.

9. In the Common name for this CA box, type the common name of the CA, and then click Next.
10. On the **Set Validity Period** page, accept the default values or specify other storage locations for the certificate database and the certificate database log, and then click **Next**.
11. After verifying the information on the **Confirm Installation Selections** page, click **Install**.
12. Review the information on the results screen to verify that the installation was successful.
Step 2. Obtain the Server Certificate

The steps above describe how to install the certification authority (CA) on your Microsoft Active Directory server. Next, you will need to add the Microsoft Active Directory server’s SSL certificate to the list of accepted certificates used by the JDK that runs your application server.

The Active Directory certificate is automatically generated and placed in root of the C:\ drive, matching a file format similar to the tree structure of your Active Directory server. For example: c:\ad2008.ad01.atlassian.com_ad01.crt.

You can also export the certificate by executing this command on the Active Directory server:

```
certutil -ca.cert client.crt
```

Step 3. Import the Server Certificate

For an application server to trust your directory's certificate, the certificate must be imported into your Java runtime environment. The JDK stores trusted certificates in a file called a keystore. The default keystore file is called cacerts and it lives in the jre\lib\security sub-directory of your Java installation.

In the following examples, we use server-certificate.crt to represent the certificate file exported by your directory server. You will need to alter the instructions below to match the name actually generated.

Once the certificate has been imported as per the below instructions, you will need to restart the application to pick up the changes.

**Windows**

1. Navigate to the directory in which Java is installed. It's probably called something like C:\Program Files\Java\jdk1.5.0_12.

   ```
   cd /d C:\Program Files\Java\jdk1.5.0_12
   ```

2. Run the command below, where server-certificate.crt is the name of the file from your directory server:

   ```
   keytool -import -keystore .\jre\lib\security\cacerts -file server-certificate.crt
   ```

3. keytool will prompt you for a password. The default keystore password is changeit.

4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:

   ```
   Enter keystore password:  changeit
   Owner: CN=ad01, C=US
   Issuer: CN=ad01, C=US
   Serial number: 15563d6677a4e9e4582d8a84be683f9
   Certificate fingerprints:
   SHA1:
   Trust this certificate? [no]: yes
   Certificate was added to keystore
   ```

You may now use the ‘Secure SSL’ option when connecting your application to your directory server.

**UNIX**
1. Navigate to the directory in which the Java used by JIRA is installed. If the default JAVA installation is used, then it would be

```
   cd $JAVA_HOME
```

2. Run the command below, where `server-certificate.crt` is the name of the file from your directory server:

```
   sudo keytool -import -keystore ./jre/lib/security/cacerts -file server-certificate.crt
```

3. `keytool` will prompt you for a password. The default keystore password is `changeit`.

4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:

```
   Password:
   Enter keystore password: changeit
   Owner: CN=ad01, C=US
   Issuer: CN=ad01, C=US
   Serial number: 15563d6677a4e9e4582d8a84be683f9
   Certificate fingerprints:
   Trust this certificate? [no]: yes
   Certificate was added to keystore
```

You may now use the `Secure SSL` option when connecting your application to your directory server.

**Mac OS X**

1. Navigate to the directory in which Java is installed. This is usually

```
   cd /Library/Java/Home
```

2. Run the command below, where `server-certificate.crt` is the name of the file from your directory server:

```
   sudo keytool -import -keystore ./jre/lib/security/cacerts -file server-certificate.crt
```

3. `keytool` will prompt you for a password. The default keystore password is `changeit`.

4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:
You may now use the 'Secure SSL' option when connecting your application to your directory server.

RELATED TOPICS

Connecting to an LDAP Directory
Configuring User Directories
Connecting to an Internal Directory with LDAP Authentication

You can connect your Confluence application to an LDAP directory for delegated authentication. This means that Confluence will have an internal directory that uses LDAP for authentication only. There is an option to create users in the internal directory automatically when they attempt to log in, as described in the settings section.

Overview

An internal directory with LDAP authentication offers the features of an internal directory while allowing you to store and check users' passwords in LDAP only. Note that the 'internal directory with LDAP authentication' is separate from the default 'internal directory'. On LDAP, all that the application does is to check the password. The LDAP connection is read only. Every user in the internal directory with LDAP authentication must map to a user on LDAP, otherwise they cannot log in.

When to use this option: Choose this option if you want to set up a user and group configuration within your application that suits your needs, while checking your users' passwords against the corporate LDAP directory. This option also helps to avoid the performance issues that may result from downloading large numbers of groups from LDAP.

On this page:
- Overview
- Connecting Confluence to an Internal Directory with LDAP Authentication
- Server Settings
  - Copying Users on Login
- Schema Settings
- Advanced Settings
- User Schema Settings
- Group Schema Settings
- Membership Schema Settings
- Diagrams of Possible Configurations

Connecting Confluence to an Internal Directory with LDAP Authentication

To connect to an internal directory but check logins via LDAP:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Click ‘User Directories’ in the left-hand panel.
3. Add a directory and select type 'Internal with LDAP Authentication'.
4. Enter the values for the settings, as described below.
5. Save the directory settings.
6. If you want LDAP users to be used in place of existing internal users, move the 'Internal with LDAP Authentication' directory to the top of the list. You can define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.
   - For details see Managing Multiple Directories.
7. Add your users and groups in Confluence. See Adding and Inviting Users and Managing Site-Wide Permissions and Groups.

### Server Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name that will help you to identify the directory. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Internal directory with LDAP Authentication</td>
</tr>
<tr>
<td></td>
<td>• Corporate LDAP for Authentication Only</td>
</tr>
<tr>
<td>Directory Type</td>
<td>Select the type of LDAP directory that you will connect to. If you are adding a new LDAP connection, the value you select here will determine the default values for some of the options on the rest of the screen. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Active Directory</td>
</tr>
<tr>
<td></td>
<td>• OpenDS</td>
</tr>
<tr>
<td></td>
<td>• And more.</td>
</tr>
<tr>
<td>Hostname</td>
<td>The host name of your directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• ad.example.com</td>
</tr>
<tr>
<td></td>
<td>• ldap.example.com</td>
</tr>
<tr>
<td></td>
<td>• opends.example.com</td>
</tr>
<tr>
<td>Port</td>
<td>The port on which your directory server is listening. Examples:</td>
</tr>
<tr>
<td></td>
<td>• 389</td>
</tr>
<tr>
<td></td>
<td>• 10389</td>
</tr>
<tr>
<td></td>
<td>• 636 (for example, for SSL)</td>
</tr>
<tr>
<td>Use SSL</td>
<td>Check this box if the connection to the directory server is an SSL (Secure Sockets Layer) connection. Note that you will need to configure an SSL certificate in order to use this setting.</td>
</tr>
<tr>
<td>Username</td>
<td>The distinguished name of the user that the application will use when connecting to the directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• cn=administrator,cn=users,dc=ad,dc=example,dc=com</td>
</tr>
<tr>
<td></td>
<td>• cn=user, dc=domain, dc=name</td>
</tr>
<tr>
<td></td>
<td>• <a href="mailto:user@domain.name">user@domain.name</a></td>
</tr>
<tr>
<td>Password</td>
<td>The password of the user specified above.</td>
</tr>
</tbody>
</table>

### Copying Users on Login

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>

---

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### Copy User on Login

This option affects what will happen when a user attempts to log in. If this box is checked, the user will be created automatically in the internal directory that is using LDAP for authentication when the user first logs in and their details will be synchronised on each subsequent log in. If this box is not checked, the user's login will fail if the user wasn't already manually created in the directory.

If you check this box the following additional fields will appear on the screen, which are described in more detail below:

- Default Group Memberships
- Synchronise Group Memberships
- User Schema Settings (described in a separate section below)

### Default Group Memberships

This field appears if you check the **Copy User on Login** box. If you would like users to be automatically added to a group or groups, enter the group name(s) here. To specify more than one group, separate the group names with commas. Each time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added to the internal directory that is using LDAP for authentication.

Please note that there is no validation of the group names. If you mis-type the group name, authorisation failures will result – users will not be able to access the applications or functionality based on the intended group name.

Examples:

- confluence-users
- bamboo-users,jira-users,jira-developers

### Synchronise Group Memberships

This field appears if you select the **Copy User on Login** checkbox. If this box is checked, group memberships specified on your LDAP server will be synchronised with the internal directory each time the user logs in.

If you check this box the following additional fields will appear on the screen, both described in more detail below:

- Group Schema Settings (described in a separate section below)
- Membership Schema Settings (described in a separate section below)

### Note

‘Copy Users on Login’ must be enabled if you want to be able to change usernames.

### Schema Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base DN</td>
<td>The root distinguished name (DN) to use when running queries against the directory server.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>- o=example,c=com</td>
</tr>
<tr>
<td></td>
<td>- cn=users,dc=ad,dc=example,dc=com</td>
</tr>
<tr>
<td></td>
<td>- For Microsoft Active Directory, specify the base DN in the following format: dc=domain1,dc=local. You will need to replace the domain1 and local for your specific configuration.</td>
</tr>
<tr>
<td></td>
<td>Microsoft Server provides a tool called ldp.exe which is useful for finding out and configuring the the LDAP structure of your server.</td>
</tr>
<tr>
<td>User Name Attribute</td>
<td>The attribute field to use when loading the username.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>- cn</td>
</tr>
<tr>
<td></td>
<td>- sAMAccountName</td>
</tr>
</tbody>
</table>

### Advanced Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
### Enable Nested Groups
Enable or disable support for nested groups. Some directory servers allow you to define a group as a member of another group. Groups in such a structure are called 'nested groups'. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.

### Use Paged Results
Enable or disable the use of the LDAP control extension for simple paging of search results. If paging is enabled, the search will retrieve sets of data rather than all of the search results at once. Enter the desired page size – that is, the maximum number of search results to be returned per page when paged results are enabled. The default is 1000 results.

### Follow Referrals
Choose whether to allow the directory server to redirect requests to other servers. This option uses the node referral (JNDI lookup `java.naming.referral`) configuration setting. It is generally needed for Active Directory servers configured without proper DNS, to prevent a `javax.naming.PartialResultException: Unprocessed Continuation Reference(s)` error.

## User Schema Settings
Note: this section is only visible when **Copy User on Login** is enabled.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional User DN</td>
<td>This value is used in addition to the base DN when searching and loading users. If no value is supplied, the subtree search will start from the base DN. Example:</td>
</tr>
<tr>
<td></td>
<td>- ou=Users</td>
</tr>
<tr>
<td>User Object Class</td>
<td>This is the name of the class used for the LDAP user object. Example:</td>
</tr>
<tr>
<td></td>
<td>- user</td>
</tr>
<tr>
<td>User Object Filter</td>
<td>The filter to use when searching user objects. Example:</td>
</tr>
<tr>
<td></td>
<td>- (&amp;(objectCategory=Person)(sAMAccountName=*))</td>
</tr>
<tr>
<td>User Name RDN Attribute</td>
<td>The RDN (relative distinguished name) to use when loading the username. The DN for each LDAP entry is composed of two parts: the RDN and the location within the LDAP directory where the record resides. The RDN is the portion of your DN that is not related to the directory tree structure. Example:</td>
</tr>
<tr>
<td></td>
<td>- cn</td>
</tr>
<tr>
<td>User First Name Attribute</td>
<td>The attribute field to use when loading the user's first name. Example:</td>
</tr>
<tr>
<td></td>
<td>- givenName</td>
</tr>
<tr>
<td>User Last Name Attribute</td>
<td>The attribute field to use when loading the user's last name. Example:</td>
</tr>
<tr>
<td></td>
<td>- sn</td>
</tr>
<tr>
<td>User Display Name Attribute</td>
<td>The attribute field to use when loading the user's full name. Example:</td>
</tr>
<tr>
<td></td>
<td>- displayName</td>
</tr>
<tr>
<td>User Email Attribute</td>
<td>The attribute field to use when loading the user's email address. Example:</td>
</tr>
<tr>
<td></td>
<td>- mail</td>
</tr>
</tbody>
</table>

## Group Schema Settings
Note: this section is only visible when both **Copy User on Login** and **Synchronise Group Memberships** are enabled.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Group DN</td>
<td>This value is used in addition to the base DN when searching and loading groups. If no value is supplied, the subtree search will start from the base DN. Example:</td>
</tr>
<tr>
<td></td>
<td>• ou=Groups</td>
</tr>
<tr>
<td>Group Object Class</td>
<td>This is the name of the class used for the LDAP group object. Examples:</td>
</tr>
<tr>
<td></td>
<td>• groupOfUniqueNames</td>
</tr>
<tr>
<td></td>
<td>• group</td>
</tr>
<tr>
<td>Group Object Filter</td>
<td>The filter to use when searching group objects. Example:</td>
</tr>
<tr>
<td></td>
<td>• (objectCategory=Group)</td>
</tr>
<tr>
<td>Group Name Attribute</td>
<td>The attribute field to use when loading the group's name. Example:</td>
</tr>
<tr>
<td></td>
<td>• cn</td>
</tr>
<tr>
<td>Group Description Attribute</td>
<td>The attribute field to use when loading the group's description. Example:</td>
</tr>
<tr>
<td></td>
<td>• description</td>
</tr>
</tbody>
</table>

**Membership Schema Settings**

Note: this section is only visible when both Copy User on Login and Synchronise Group Memberships are enabled.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Members Attribute</td>
<td>The attribute field to use when loading the group's members. Example:</td>
</tr>
<tr>
<td></td>
<td>• member</td>
</tr>
<tr>
<td>User Membership Attribute</td>
<td>The attribute field to use when loading the user's groups. Example:</td>
</tr>
<tr>
<td></td>
<td>• memberOf</td>
</tr>
<tr>
<td>Use the User Membership Attribute, when finding the user's group membership</td>
<td>Check this box if your directory server supports the group membership attribute on the user. (By default, this is the 'memberOf' attribute.)</td>
</tr>
<tr>
<td></td>
<td>• If this box is checked, your application will use the group membership attribute on the user when retrieving the members of a given group. This will result in a more efficient retrieval.</td>
</tr>
<tr>
<td></td>
<td>• If this box is not checked, your application will use the members attribute on the group ('member' by default) for the search.</td>
</tr>
</tbody>
</table>

**Diagrams of Possible Configurations**
Diagram above: Confluence connecting to an LDAP directory for authentication only.

Diagram above: Confluence connecting to an LDAP directory for authentication only, with each user synchronised with the internal directory that is using LDAP authentication when they log in to Confluence.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
Connecting to Crowd or JIRA for User Management

You can connect your Confluence application to Atlassian Crowd or to JIRA (version 4.3 or later) for management of users and groups, and for authentication (verification of a user’s login).

On this page:
- Connecting Confluence to Crowd for User Management
- Connecting Confluence to JIRA for User Management
- Diagrams of Some Possible Configurations
- Troubleshooting

The information on this page does not apply to Confluence Cloud.

Connecting Confluence to Crowd for User Management

Atlassian Crowd is an application security framework that handles authentication and authorisation for your web-based applications. With Crowd you can integrate multiple web applications and user directories, with support for single sign-on (SSO) and centralised identity management. The Crowd Administration Console provides a web interface for managing directories, users and their permissions. See the Crowd Administration Guide.

When to use this option: Connect to Crowd if you want to use the full Crowd functionality to manage your directories, users and groups. You can connect your Crowd server to a number of directories of all types that Crowd supports, including custom directory connectors.

To connect Confluence to Crowd:

1. Go to your Crowd Administration Console and define the Confluence application to Crowd. See the Crowd documentation: Adding an Application.
2. Choose the cog icon, then choose General Configuration under Confluence Administration.
3. Click ‘User Directories’ in the left-hand panel.
4. Add a directory and select type ‘Atlassian Crowd’. Enter the settings as described below.
5. Save the directory settings.
6. Define the directory order by clicking the blue up- and down-arrows next to each directory on the ‘User Directories’ screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.
   For details see Managing Multiple Directories.
7. If required, configure Confluence to use Crowd for single sign-on (SSO) too. See the Crowd documentation: Integrating Crowd with Atlassian Confluence.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Name

A meaningful name that will help you to identify this Crowd server amongst your list of directory servers. Examples:

- Crowd Server
- Example Company Crowd

Server URL

The web address of your Crowd console server. Examples:

- http://www.example.com:8095/crowd/
- http://crowd.example.com

Application Name

The name of your application, as recognised by your Crowd server. Note that you will need to define the application in Crowd too, using the Crowd administration Console. See the Crowd documentation on adding an application.

Application Password

The password which the application will use when it authenticates against the Crowd framework as a client. This must be the same as the password you have registered in Crowd for this application. See the Crowd documentation on adding an application.

Crowd Permissions

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>The users, groups and memberships in this directory are retrieved from Crowd and can only be modified via Crowd. You cannot modify Crowd users, groups or memberships via the application administration screens.</td>
</tr>
<tr>
<td>Read/Write</td>
<td>The users, groups and memberships in this directory are retrieved from Crowd. When you modify a user, group or membership via the application administration screens, the changes will be applied directly to Crowd. Please ensure that the application has modification permissions for the relevant directories in Crowd. See the Crowd documentation: Specifying an Application's Directory Permissions.</td>
</tr>
</tbody>
</table>

Advanced Crowd Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. Before enabling nested groups, please check to see if the user directory or directories in Crowd support nested groups. When nested groups are enabled, you can define a group as a member of another group. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
<tr>
<td>Synchronisation Interval (minutes)</td>
<td>Synchronisation is the process by which the application updates its internal store of user data to agree with the data on the directory server. The application will send a request to your directory server every x minutes, where ‘x’ is the number specified here. The default value is 60 minutes.</td>
</tr>
</tbody>
</table>

Connecting Confluence to JIRA for User Management

- Note that the license tiers for JIRA and Confluence do not need to match to use this feature. For example, you can manage a Confluence 50 user license with JIRA, even if JIRA only has a 25 user license.

Subject to certain limitations, you can connect a number of Atlassian web applications to a single JIRA server for centralised user management.

When to use this option: You can only connect to a server running JIRA 4.3 or later. Choose this option as an alternative to Atlassian Crowd, for simple configurations with a limited number of users.
If you are running JIRA 4.2 or earlier, please see Connecting to JIRA 4.2 or Earlier for User Management.

To connect Confluence to JIRA 4.3 or later:

1. Go to your JIRA administration screen and define the Confluence application to JIRA:
   - For JIRA 4.3.x, select 'Other Applications' from the 'Users, Groups & Roles' section of the 'Administration' menu.
   - For JIRA 4.4 or later, select 'Users' > 'JIRA User Server' in Administration mode.
   - Click 'Add Application'.
   - Enter the application name and password that Confluence will use when accessing JIRA.
   - Enter the IP address or addresses of your Confluence server. Valid values are:
     - A full IP address, e.g. 192.168.10.12.
     - A wildcard IP range, using CIDR notation, e.g. 192.168.10.1/16. For more information, see the introduction to CIDR notation on Wikipedia and RFC 4632.
   - Save the new application.

2. Set up the JIRA user directory in Confluence:
   - Choose the cog icon, then choose General Configuration under Confluence Administration.
   - Click 'User Directories' in the left-hand panel.
   - Add a directory and select type 'Atlassian JIRA'.
   - Enter the settings as described below. When asked for the application name and password, enter the values that you defined for your Confluence application in the settings on JIRA.
   - Save the directory settings.
   - Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. Here is a summary of how the directory order affects the processing:
     - The order of the directories is the order in which they will be searched for users and groups.
     - Changes to users and groups will be made only in the first directory where the application has permission to make changes.
   - For details see Managing Multiple Directories.

3. In order to use Confluence, users must be a member of the confluence-users group or have Confluence 'can use' permission. Follow these steps to configure your Confluence groups in JIRA:
   a. Add the confluence-users and confluence-administrators groups in JIRA.
   b. Add your own username as a member of both of the above groups.
   c. Choose one of the following methods to give your existing JIRA users access to Confluence:
      - Option 1: In JIRA, find the groups that the relevant users belong to. Add the groups as members of one or both of the above Confluence groups.
      - Option 2: Log in to Confluence using your JIRA account and go to the Confluence Administration Console. Click 'Global Permissions' and assign the 'can use' permission to the relevant JIRA groups.

⚠ Ensure that you have added Confluence URL into JIRA Whitelist in JIRA Administration >> System >> Security >> Whitelist. For example: https://confluence.atlassian.com/ or refer to this guide: Configuring the Whitelist

### JIRA Settings in Confluence

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A meaningful name that will help you to identify this JIRA server amongst your list of directory servers. Examples:</td>
</tr>
<tr>
<td>Server URL</td>
<td>The web address of your JIRA server. Examples:</td>
</tr>
<tr>
<td></td>
<td><a href="http://www.example.com:8080">http://www.example.com:8080</a></td>
</tr>
<tr>
<td></td>
<td><a href="http://jira.example.com">http://jira.example.com</a></td>
</tr>
</tbody>
</table>
Application Name | The name used by your application when accessing the JIRA server that acts as user manager. Note that you will also need to define your application to that JIRA server, via the 'Other Applications' option in the 'Users, Groups & Roles' section of the 'Administration' menu.

Application Password | The password used by your application when accessing the JIRA server that acts as user manager.

**JIRA Permissions**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>The users, groups and memberships in this directory are retrieved from the JIRA server that is acting as user manager. They can only be modified via that JIRA server.</td>
</tr>
</tbody>
</table>

**Advanced JIRA Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. Before enabling nested groups, please check to see if nested groups are enabled on the JIRA server that is acting as user manager. When nested groups are enabled, you can define a group as a member of another group. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
<tr>
<td>Synchronisation Interval (minutes)</td>
<td>Synchronisation is the process by which the application updates its internal store of user data to agree with the data on the directory server. The application will send a request to your directory server every x minutes, where 'x' is the number specified here. The default value is 60 minutes.</td>
</tr>
</tbody>
</table>

**Diagrams of Some Possible Configurations**
Diagram above: Confluence, JIRA and other applications connecting to Crowd for user management.
Diagram above: Confluence connecting to JIRA for user management.
Diagram above: Confluence connecting to JIRA for user management, with JIRA in turn connecting to LDAP.

**Troubleshooting**

Below are some error messages you may encounter. If you run into problems, you should turn on WARN logging for the relevant class. See Configuring Logging.
<table>
<thead>
<tr>
<th>Error</th>
<th>Message</th>
<th>Cause</th>
</tr>
</thead>
</table>
| error.jirabaseurl.connection.refused     | Connection refused. Check if an instance of JIRA 4.3 or later is running on the given url | This may be because:  
  • JIRA url is incorrect  
  • JIRA instance is not running on the specified url  
  • JIRA instance running on the specified url is not 4.3 or later. |
| error.applicationlink.connection.refused  | Failed to establish application link between JIRA server and Confluence server. | Unable to create an application link between JIRA and Confluence. This may be because:  
  • Confluence or JIRA url is incorrect  
  • the instance is not running on the specified url  
  • credentials are incorrect.  
Refer to the Confluence log files for further troubleshooting information. |
| error.jirabaseurl.not.valid              | This is not a valid url for JIRA 4.3 or later.                          | A runtime exception has occurred. Refer to the Confluence log files for further troubleshooting information. |

**RELATED TOPICS**

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management

If your Confluence site currently uses JIRA or Crowd for user management, you can revert to internal user management as described below. If your Confluence instance has only a few users, it is easier to recreate the users and groups in Confluence manually. If you have a large number of users and groups, it is more efficient to migrate the relevant users and groups into the Confluence Internal directory.

Both options provided below will reset the affected users’ passwords. When done, be sure to notify them to use the ‘Reset My Password’ link on the Confluence log in page before they attempt to log in.

**On this page:**

- Option 1 – Manually Recreate Users and Groups in Confluence
- Option 2 – Transfer Crowd/JIRA Users and Groups to the Confluence Database

Option 1 – Manually Recreate Users and Groups in Confluence
Use this option if you have only a few users and groups.

1. Log in to Confluence as a Confluence system administrator.
2. Go to the user directories administration screen and move the *internal* directory to the top of the list of directories, by clicking the arrows in the ‘Order’ column.
3. Make sure that you have at least one user from the internal directory in each of the confluence-users and confluence-administrators groups.
4. Make sure that you have a username in the internal directory with Confluence system administrator permissions.
   - If you do not have such a user, add a new one now, and log out of Confluence.
   - Log back in as the user you just added, and go back to the user directories administration screen.
5. Disable the ‘Atlassian Crowd’ directory.
6. Manually add the required users and groups in Confluence. They will be added to the internal directory, because you have moved it to the top of the list of directories.
   - If you have assigned Confluence permissions to a group which exists in JIRA, you must create a group in Confluence with the same name.
   - If a user who exists in JIRA has created content or has had permissions assigned to them in Confluence, you must also create that user in Confluence.
7. Add the users to the required groups.

Option 2 – Transfer Crowd/JIRA Users and Groups to the Confluence Database

Use this option to migrate External Application (Crowd or JIRA) users into the Confluence database. You need a knowledge of SQL to perform this task.

The SQL commands given below are tailored for MySQL. If you are using a database other than MySQL, you will need to modify the SQL to work in your database.

**Step 1. Create Backups**

Creating backups is the only way to restore your data if something goes wrong.

1. From Confluence, create a full XML site backup including attachments.
2. Stop Confluence.
3. Make a backup copy of the Confluence home and installation directories.
4. Repeat the above steps for your External Application.
5. From your MySQL administration tool, create a database backup for the Crowd/JIRA and Confluence databases.

**Step 2. Replace Confluence User Management**

Use the SQL below to move groups and users from your External Application to Confluence by transferring table content. The SQL provided is specific to MySQL and must be modified for other databases.

Find the IDs for your Directories

1. Run the following command and take note of the resulting number. It will be referenced throughout the following instructions as `<Confluence Internal ID>`.

   ```sql
   select id from cwd_directory where directory_name='Confluence Internal Directory';
   ```

2. From the User Directories administration page, find the name of the directory who’s users/groups you want to move. Run the following command and take note of the resulting number. It will be referenced throughout the following instructions as `<External Application ID>`.

   ```sql
   select id from cwd_directory where directory_name='<External Directory Name>';
   ```

Move Groups to Confluence

1. It is possible that you have several groups in your Internal Directory that have the same name as groups in your External Application. To find these, run:
select distinct a.id, a.directory_id, a.group_name, d.directory_name from cwd_group a join cwd_group b on a.group_name=b.group_name join cwd_directory d on d.id=a.directory_id where a.directory_id != b.directory_id;

a. If you have results from the previous query, for each of the group names that have duplicates, find the id for the group in the Confluence Internal Directory (<internal group id>) and the External Application (<external group id>). Run the following:

update cwd_group_attribute set group_id=<internal group id>, directory_id=<Confluence Internal Id> where group_id=<external group id>;
update cwd_membership set child_group_id=<internal group id> where child_group_id=<external group id>;
update cwd_membership set parent_id=<internal group id> where parent_id=<external group id>;
delete from cwd_group where id=<external group id>;

2. Move all the groups in the External Application to the Confluence Internal Directory.

update cwd_group set directory_id=<Confluence Internal ID> where directory_id=<External Application ID>;

Move Users to Confluence

1. It is possible that you have several users in your Internal Directory that have the same name as users in your External Application. To find these, run:

select distinct a.id, a.directory_id, a.user_name, d.directory_name from cwd_user a join cwd_user b on a.user_name=b.user_name join cwd_directory d on d.id=a.directory_id where a.directory_id != b.directory_id;

a. If you have results from the previous query, for each of the user names that have duplicates, find the id for the user in the Confluence Internal Directory (<internal user id>) and the External Application (<external user id>). Run the following:

update cwd_membership set child_user_id=<internal user id> where child_user_id=<external user id>;
update cwd_user_credential_record set user_id=<internal user id> where user_id=<external user id>;
update.cwd_user_attribute set user_id=<internal user id>, directory_id=<Confluence Internal ID> where user_id=<external user id>;
delete from cwd_user where id=<external user id>;


update cwd_user set directory_id=<Confluence Internal ID> where directory_id=<External Application ID>;

Delete the External Application directory

1. You need to change the order of your directories so that the Internal directory is at the top, and active.
1. If you have only two directories - the Internal and the External Application directory you are deleting, then do the following:

   update cwd_app_dir_mapping set list_index = 0 where directory_id = <Confluence Internal ID>;

b. If you have more than two directories, you need to rearrange them so the Internal Directory is at the top (list_index 0) and the External Application directory you are deleting is at the bottom.
   - List the directories and their order using

   
   select d.id, d.directory_name, m.list_index from cwd_directory d join cwd_app_dir_mapping m on d.id=m.directory_id order by m.list_index;

   - Change the list indexes so that they are in the order you want. Directory order can be rearranged using

   
   update cwd_app_dir_mapping set list_index = <position> where directory_id = <directory id>;

c. Check that the internal directory is enabled.
   - List the internal directory. An enabled directory will have its ‘active’ column set to 'T'

   
   select id, directory_name, active from cwd_directory where id = <Internal Directory id>;

   - If the internal directory is not active, activate it by

   
   update cwd_directory set active = 'T' where id = <Internal Directory id>;

2. When the directories are ordered correctly, delete the External Application directory from the directory order:

   
   delete from cwd_app_dir_operation where app_dir_mapping_id = (select id from cwd_app_dir_mapping where directory_id = <External Application ID>);
   delete from cwd_app_dir_mapping where directory_id = <External Application ID>;

3. The External Application directory is referenced in several other tables in the database. You need to remove the remaining references to it:

   
   delete from cwd_directory_attribute where directory_id=<External Application ID>;
   delete from cwd_directory_operation where directory_id=<External Application ID>;

4. All references to the External Directory should now have been removed. Delete the directory using:

   
   delete from cwd_directory where id = <External Application ID>;
Reset passwords

1. All users who were in the External Directory you deleted, including admins, will be unable to log in. Their passwords need to be reset by choosing the 'Forgot your password?' link on the login page. Alternatively, use the instructions at Restoring Passwords To Recover Admin User Rights to reset the administrator password, then set the users' passwords for them via the Manage Users page in the administration screen.

RELATED TOPICS

Configuring User Directories
Connecting to JIRA 4.2 or Earlier for User Management

Atlassian JIRA is an issue and project tracking tool. Like Confluence, JIRA offers the ability to store its users and groups in its database. You can configure Confluence to look for its users and groups in the JIRA database. This page describes the legacy JIRA database connector, which provides a direct connection to the JIRA database.

**When to use this option:** Choose the legacy JIRA database connector if your JIRA server is **JIRA 4.2 or earlier**, for backwards compatibility with the already-existing option for Confluence to use JIRA for user management.

**If you are using JIRA 4.3 or later, you cannot use the legacy JIRA database connector. Instead, choose the 'Atlassian JIRA' directory type.**

On this page:
- Connecting Confluence to JIRA
- JIRA Settings in Confluence

**Connecting Confluence to JIRA**

**To connect Confluence to JIRA 4.2 or earlier:**

1. Edit the Confluence server.xml file, to construct the datasource location, as described below.
2. Restart Confluence.
3. Choose the cog icon, then choose General Configuration under Confluence Administration.
4. Click User Directories in the left-hand panel.
5. Add a directory and select type Legacy Atlassian JIRA (4.2 and earlier). Enter the settings as described below.
6. Save the directory settings.
7. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.
   - For details see Managing Multiple Directories.
8. In order to use Confluence, users must be a member of the confluence-users group or have Confluence 'can use' permission. Follow these steps to configure your Confluence groups in JIRA:
   a. Add the confluence-users and confluence-administrators groups in JIRA.
   b. Add your own username as a member of both of the above groups.
   c. Choose one of the following methods to give your existing JIRA users access to Confluence:
      - Option 1: In JIRA, find the groups that the relevant users belong to. Add the groups as members of one or both of the above Confluence groups.
      - Option 2: Log in to Confluence using your JIRA account and go to the Confluence Administration Console. Click 'Global Permissions' and assign the 'can use' permission to the relevant JIRA groups.

**JIRA Settings in Confluence**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2014 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/au/).
### Name
A meaningful name that will help you to identify this JIRA server amongst your list of directory servers.

**Examples:**
- JIRA
- Example Company JIRA

### Datasource Location
The JNDI name of the JIRA datasource configured in your application server. Example: java:comp/env/jdbc/YourJiraDatasource

In JIRA standalone distributions (using the default application server, Tomcat 6) you can construct datasource location as follows:

1. Open your `<jira_install>/conf/server.xml` file in a text editor.
2. Look for the database setup section in that file. It looks something like this:

   ```xml
   <Resource auth="Container"
   driverClassName="com.mysql.jdbc.Driver"
   maxActive="20"
   name="*jdbc/JiraDS*
   password="jirauser"
   type="javax.sql.DataSource"
   url="jdbc:mysql://localhost/jiradb?useUnicode=true&characterEncoding=UTF8"
   username="jirauser"
   validationQuery="select 1"/>
   ```

3. Copy the above lines (the 'Resource' section) and paste it to your Confluence's `server.xml` (located at `<confluence_install>/conf/server.xml`), under the Context path. This then expose the value of the name attribute as the JNDI resource locator.

4. Copy the JNDI name from the `name` parameter. In this example, the datasource location is: java:comp/env/jdbc/JiraDS

### RELATED TOPICS
- Configuring User Directories
  - Configuring the Internal Directory
  - Connecting to an LDAP Directory
  - Connecting to an Internal Directory with LDAP Authentication
  - Connecting to Crowd or JIRA for User Management
  - Connecting to JIRA 4.2 or Earlier for User Management
  - Managing Multiple Directories
  - Managing Nested Groups
  - Synchronising Data from External Directories
  - Diagrams of Possible Configurations for User Management
  - User Management Limitations and Recommendations
  - Requesting Support for External User Management
  - Disabling the Built-In User Management

### Managing Multiple Directories
This page describes what happens when you have defined more than one user directory in Confluence. For example, you may have an internal directory and you may also connect to an LDAP directory server and/or other types of user directories. When you connect to a new directory server, you also need to define the directory order.

**Avoid duplicate usernames across directories.** If you are connecting to more than one user directory, we recommend that you ensure the usernames are unique to one directory. For example, we do not recommend that you have a user `jsmith` in both 'Directory1' and 'Directory2'. The reason is the potential for confusion, especially if you swap the order of the directories. Changing the directory order can change the user that a given username refers to.
Overview
Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

On this page:
- Overview
- Configuring the Directory Order
- Effect of Directory Order
  - Login
  - Permissions
  - Updating Users and groups

Configuring the Directory Order
You can change the order of your directories as defined to Confluence. Select 'User Directories' from the Confluence Administration Console and click the blue up- and down-arrows next to each directory.

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Type</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confluence Internal Directory</td>
<td>Internal</td>
<td></td>
</tr>
<tr>
<td>OpenLDAP</td>
<td>OpenLDAP (Read-Write)</td>
<td></td>
</tr>
</tbody>
</table>

Notes:
- Please read the rest of this page to understand what effect the directory order will have on authentication (login) and permissions in Confluence, and what happens when you update users and groups in Confluence.

Effect of Directory Order
This section summarises the effect the order of the directories will have on login and permissions, and on the updating of users and groups.

Login
The directory order is significant during the authentication of the user, in cases where the same user exists in multiple directories. When a user attempts to log in, the application will search the directories in the order specified, and will use the credentials (password) of the first occurrence of the user to validate the login attempt.

Permissions
The directory order is significant when granting the user permissions based on group membership. If the same username exists in more than one directory, the application will look for group membership only in the first directory where the username appears, based on the directory order.

Example:
- You have connected two directories: The Customers directory and the Partners directory.
- The Customers directory is first in the directory order.
- A username jsmith exists in both the Customers directory and the Partners directory.
- The user jsmith is a member of group G1 in the Customers directory and group G2 in the Partners directory.
- The user jsmith will have permissions based on membership of G1 only, not G2.

Updating Users and groups
If you update a user or group via the application's administration screens, the update will be made in the first directory where the application has write permissions.
Example 1:

- You have connected two directories: The Customers directory and the Partners directory.
- The application has permission to update both directories.
- The Customers directory is first in the directory order.
- A username `jsmith` exists in both the Customers directory and the Partners directory.
- You update the email address of user `jsmith` via the application's administration screens.
- The email address will be updated in the Customers directory only, not the Partners directory.

Example 2:

- You have connected two directories: A read/write LDAP directory and the internal directory.
- The LDAP directory is first in the directory order.
- All new users will be added to the LDAP directory. It is not possible to add a new user to the internal directory.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management

Managing Nested Groups

Some directory servers allow you to define a group as a member of another group. Groups in such a structure are called 'nested groups'. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.

This page describes how Confluence handles nested groups that exist in one or more of your directory servers.

**Enabling Nested Groups**

You can enable or disable support for nested groups on each directory individually. Go to the 'User Directories' section of the Confluence Administration Console, edit the directory and select 'Enable Nested Groups'. See Configuring User Directories.

Notes:

- Before enabling nested groups for a specific directory type in Confluence, please make sure that your directory server supports nested groups.
- Please read the rest of this page to understand what effect nested groups will have on authentication (login) and permissions in Confluence, and what happens when you update users and groups in Confluence.
Effect of Nested Groups

This section summarises the effect nested groups will have on login and permissions, and on the viewing and updating of users and groups.

Login

When a user logs in, they will be allowed access to the application if they belong to an authorised group or any of its sub-groups.

Permissions

The user will be allowed access to a function if they belong to a group that has the necessary permissions, or if they belong to any of its sub-groups.

Viewing Lists of Group Members

If you ask to view the members of a group, you will see all users who are members of the group and all users belonging its sub-groups, consolidated into one list. We call this a ‘flattened’ list.

You cannot view or edit the nested groups themselves. You will not be able to see that one group is a member of another group.

Adding and Updating Group Memberships

If you add a user to a group, the user is added to the named group and not to any other groups.

If you try to remove a user from a flattened list, the following will happen:

- If the user is a member of the top group in the hierarchy (tree) of groups contained in the flattened list, the user will be removed from the group.
- Otherwise, you will see an error message stating that the user is not a direct member of the group.

Examples

Example 1: User is Member of Sub-Group

Let's assume that the following two groups exist in your directory server:

- staff
- marketing

Memberships:

- The marketing group is a member of the staff group.
- User jsmith is a member of marketing.

You will see that jsmith is a member of both marketing and staff. You will not see that the two groups are
nested. If you assign permissions to the staff group, then jsmith will get those permissions.

Example 2: Sub-Groups as Members of the 'jira-developers' group

In an LDAP directory server, we have groups 'engineering-group' and 'techwriters-group'. We want to grant both groups developer-level access to our JIRA site.

- Add a group called 'jira-developers'.
- Add the 'engineering-group' as a sub-group of 'jira-developers'.
- Add the 'techwriters-group' as a sub-group of 'jira-developers'.

Group memberships are now:

- jira-developers — sub-groups: engineering-group, techwriters-group
- engineering-group — sub-groups: dev-a, dev-b; users: pblack
- dev-a — users: jsmith, sbrown
- dev-b — users: jsmith, dblue
- techwriters-group — users: rgreen

When JIRA requests a list of users in the 'jira-developers' group, it will receive the following list:

- pblack
- jsmith
- sbrown
- dblue
- rgreen

Example 3: Sub-Groups as Members of the 'confluence-users' group

In an LDAP directory server, we have groups 'engineering-group' and 'payroll-group'. We want to grant both
groups access to our Confluence site.

- Add a group called 'confluence-users'.
- Add the 'engineering-group' as a sub-group of 'confluence-users'.
- Add the 'payroll-group' as a sub-group of 'confluence-users'.

Group memberships are now:

- **confluence-users** — sub-groups: engineering-group, payroll-group
- **engineering-group** — sub-groups: dev-a, dev-b; users: pblack
- **dev-a** — users: jsmith, sbrown
- **dev-b** — users: jsmith, dblue
- **payroll-group** — users: rgreen

When Confluence requests a list of users in the 'confluence-users' group, it will receive the following list:

- pblack
- jsmith
- sbrown
- dblue
- rgreen

**Diagram: Sub-groups as members of the 'confluence-users' group**

**Notes**

- **Possible impact on performance.** Enabling nested groups may result in slower user searches.
- **Definition of nested groups in LDAP.** In an LDAP directory, a nested group is defined as a child group entry whose DN (Distinguished Name) is referenced by an attribute contained within a parent group entry.
For example, a parent group 'Group One' might have an objectClass=group attribute and one or more member=DN attributes, where the DN can be that of a user or that of a group elsewhere in the LDAP tree:

```
member=CN=John Smith,OU=Users,OU=OrgUnitA,DC=sub,DC=domain
member=CN=Group Two,OU=OrgUnitBGroups,OU=OrgUnitB,DC=sub,DC=domain
```

RELATED TOPICS

Configuring User Directories
- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management

Synchronising Data from External Directories

For certain directory types, Confluence stores a cache of directory information (users and groups) in the application database, to ensure fast recurrent access to user and group data. A synchronisation task runs periodically to update the internal cache with changes from the external directory.

On this page:
- Affected Directory Types
- How it Works
- Finding the Time Taken to Synchronise
- Manually Synchronising the Cache
- Configuring the Synchronisation Interval

Affected Directory Types

Data caching and synchronisation apply to the following user directory types:

- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to read only.
- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to read only, with local groups.
- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to read/write.
- Atlassian Crowd.
- Atlassian JIRA.

Data caching and synchronisation do not occur for the following user directory types:

- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to authentication only, with local groups.
- Internal Directory with LDAP Authentication.
- Internal Directory.

How it Works

Here is a summary of the caching functionality:

- The caches are held in the application database.
When you connect a new external user directory to the application, a synchronisation task will start running in the background to copy all the required users, groups and membership information from the external directory to the application database. This task may take a while to complete, depending on the size and complexity of your user base.

Note that a user will not be able to log in until the synchronisation task has copied that user's details into the cache.

A periodic synchronisation task will run to update the database with any changes made to the external directory. The default synchronisation interval, or polling interval, is one hour (60 minutes). You can change the synchronisation interval on the directory configuration screen.

You can manually synchronise the cache if necessary.

If the external directory permissions are set to read/write: Whenever an update is made to the users, groups or membership information via the application, the update will also be applied to the cache and the external directory immediately.

All authentication happens via calls to the external directory. When caching information from an external directory, the application database does not store user passwords.

All other queries run against the internal cache.

**Finding the Time Taken to Synchronise**

The 'User Directories' screen shows information about the last synchronisation operation, including the length of time it took.

**Manually Synchronising the Cache**

You can manually synchronise the cache by clicking 'Synchronise' on the 'User Directories' screen. If a synchronisation operation is already in progress, you cannot start another until the first has finished.

**Configuring the Synchronisation Interval**

Note: The option to configure the synchronisation interval for Crowd and JIRA directories is available in Confluence 3.5.3 and later. Earlier versions of Confluence allow you to configure the interval for LDAP directories only.

You can set the 'Synchronisation Interval' on the directory configuration screen. The synchronisation interval is the period of time to wait between requests for updates from the directory server.

The length you choose for your synchronisation interval depends on:

- The length of time you can tolerate stale data.
- The amount of load you want to put on the application and the directory server.
- The size of your user base.

If you synchronise more frequently, then your data will be more up to date. The downside of synchronising more frequently is that you may overload your server with requests.

If you are not sure what to do, we recommend that you start with an interval of 60 minutes (this is the default setting) and reduce the value incrementally. You will need to experiment with your setup.

**RELATED TOPICS**

- Configuring User Directories
- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
Diagrams of Possible Configurations for User Management

The aim of these diagrams is to help people understand each directory type at a glance. We have kept the diagrams simple and conceptual, with just enough information to be correct.

Some things that we do not attempt to show:

- In most cases, we do not attempt to show that you can have multiple directory types mapped to Confluence at the same time. We illustrate that fact in just the first two LDAP diagrams.
- We have not included a diagram for Confluence's legacy connection to JIRA database.
- We do not attempt to show all of the possible configurations and layered connections that are available now that you can use JIRA as a directory manager.

On this page:
- Confluence Internal Directory
- Confluence with Read/Write Connection to LDAP
- Confluence with Read-Only Connection to LDAP, with Local Groups
- Confluence Internal Directory with LDAP Authentication
- Confluence with LDAP Authentication, Copy Users on First Login
- Confluence Connecting to JIRA
- Confluence Connecting to JIRA and JIRA Connecting to LDAP
- Confluence and JIRA Connecting to Crowd

Confluence Internal Directory

Diagram above: Confluence using its internal directory for user management.
Diagram above: Confluence connecting to an LDAP directory.

**Confluence with Read-Only Connection to LDAP, with Local Groups**

Diagram above: Confluence connecting to an LDAP directory with permissions set to read only and local groups.
Confluence Internal Directory with LDAP Authentication

Diagram above: Confluence connecting to an LDAP directory for authentication only.

Confluence with LDAP Authentication, Copy Users on First Login

Diagram above: Confluence connecting to an LDAP directory for authentication only, with each user synchronised with the internal directory that is using LDAP authentication when they log in to Confluence.

Confluence Connecting to JIRA
Diagram above: Confluence connecting to JIRA for user management.

Confluence Connecting to JIRA and JIRA Connecting to LDAP
Diagram above: Confluence connecting to JIRA for user management, with JIRA in turn connecting to LDAP.

Confluence and JIRA Connecting to Crowd
Diagram above: Confluence, JIRA and other applications connecting to Crowd for user management.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management

User Management Limitations and Recommendations

This page describes the optimal configurations and limitations that apply to user management in Confluence.
General Recommendations

- **Avoid duplicate usernames across directories.** If you are connecting to more than one user directory, we recommend that you ensure the usernames are unique to one directory. For example, we do not recommend that you have a user `jsmith` in both 'Directory1' and 'Directory2'. The reason is the potential for confusion, especially if you swap the order of the directories. Changing the directory order can change the user that a given username refers to.

- **Be careful when deleting users in remote directories.** If you are connecting to an LDAP directory, a Crowd directory or a JIRA directory, please take care when deleting users from the remote directory. If you delete a user that is associated with data in Confluence, this will cause problems in Confluence.

Recommendations for Connecting to LDAP

Please consider the following limitations and recommendations when connecting to an LDAP user directory.

**Optimal Number of Users and Groups in your LDAP Directory**

The connection to your LDAP directory provides powerful and flexible support for connecting to, configuring and managing LDAP directory servers. To achieve optimal performance, a background synchronisation task loads the required users and groups from the LDAP server into the application's database, and periodically fetches updates from the LDAP server to keep the data in step. The amount of time needed to copy the users and groups rises with the number of users, groups, and group memberships. For that reason, we recommended a maximum number of users and groups as described below.

This recommendation affects connections to LDAP directories:

- Microsoft Active Directory
- All other LDAP directory servers

The following LDAP configurations are **not** affected:

- Internal directories with LDAP authentication
- LDAP directories configured for 'Authentication Only, Copy User On First Login'

Please choose one of the following solutions, depending on the number of users, groups and memberships in your LDAP directory.

<table>
<thead>
<tr>
<th>Your environment</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 10 000 (ten thousand) users, 1000 (one thousand) groups, and 20 (twenty) groups per user</td>
<td>Choose the 'LDAP' or 'Microsoft Active Directory' directory type. You can make use of the full synchronisation option. Your application's database will contain all the users and groups that are in your LDAP server.</td>
</tr>
<tr>
<td>More than the above</td>
<td>Use LDAP filters to reduce the number of users and groups visible to the synchronisation task.</td>
</tr>
</tbody>
</table>

Our Test Results
We performed internal testing of synchronisation with an AD server on our local network consisting of 10 000 users, 1000 groups and 200 000 memberships.

We found that the initial synchronisation took about 5 minutes. Subsequent synchronisations with 100 modifications on the AD server took a couple of seconds to complete.

Please keep in mind that a number of factors come into play when trying to tune the performance of the synchronisation process, including:

- **Size of userbase.** Use LDAP filters to keep this to the minimum that suits your requirements.
- **Type of LDAP server.** We currently support change detection in AD, so subsequent synchronisations are much faster for AD than for other LDAP servers.
- **Network topology.** The further away your LDAP server is from your application server, the more latent LDAP queries will be.
- **Database performance.** As the synchronisation process caches data in the database, the performance of your database will affect the performance of the synchronisation.
- **JVM heap size.** If your heap size is too small for your userbase, you may experience heavy garbage collection during the synchronisation process which could in turn slow down the synchronisation.

**Redundant LDAP is Not Supported**

The LDAP connections do not support the configuration of two or more LDAP servers for redundancy (automated failover if one of the servers goes down).

**Specific Notes for Connecting to Active Directory**

When the application synchronises with Active Directory (AD), the synchronisation task requests only the changes from the LDAP server rather than the entire user base. This optimises the synchronisation process and gives much faster performance on the second and subsequent requests.

On the other hand, this synchronisation method results in a few limitations:

1. **Externally moving objects out of scope or renaming objects causes problems in AD.** If you move objects out of scope in AD, this will result in an inconsistent cache. We recommend that you do not use the external LDAP directory interface to move objects out of the scope of the sub-tree, as defined on the application's directory configuration screen. If you do need to make structural changes to your LDAP directory, manually synchronise the directory cache after you have made the changes to ensure cache consistency.

2. **Synchronising between AD servers is not supported.** Microsoft Active Directory does not replicate the uSNChanged attribute across instances. For that reason, we do not support connecting to different AD servers for synchronisation. (You can of course define multiple different directories, each pointing to its own respective AD server.)

3. **Synchronising with AD servers behind a load balancer is not supported.** As with synchronising between two different AD servers, Microsoft Active Directory does not replicate the uSNChanged attribute across instances. For that reason, we do not support connecting to different AD servers even when they are load balanced. You will need to select one server (preferably one that is local) to synchronise with instead of using the load balancer.

4. **You must restart the application after restoring AD from backup.** On restoring from backup of an AD server, the uSNChanged timestamps are reverted to the backup time. To avoid the resulting confusion, you will need to flush the directory cache after a Active Directory restore operation.

5. **Obtaining AD object deletions requires administrator access.** Active Directory stores deleted objects in a special container called cn=Deleted Objects. By default, to access this container you need to connect as an administrator and so, for the synchronisation task to be aware of deletions, you must use administrator credentials. Alternatively, it is possible to change the permissions on the cn=Deleted Objects container. If you wish to do so, please see [this Microsoft KB Article](#).

6. **The User DN used to connect to AD must be able to see the uSNChanged attribute.** The synchronisation task relies on the uSNChanged attribute to detect changes, and so must be in the appropriate AD security groups to see this attribute for all LDAP objects in the subtree.

**Recommendations for Connecting to JIRA for User Management**

Please consider the following limitations and recommendations when connecting to a JIRA server for user management.

**Single Sign-On Across Multiple Applications is Not Supported**
When you connect to JIRA for user management, you will not have single sign-on across the applications connected in this way. JIRA, when acting as a directory manager, does not support SSO.

**Custom Application Connectors are Not Supported**

JIRA, Confluence, FishEye, Crucible and Bamboo can connect to a JIRA server for user management. Custom application connectors will need to use the new REST API.

**Custom Directories are Not Supported**

Earlier versions of JIRA supported OSUser Providers. It was therefore possible write a special provider to obtain user information from any external user directory. This is no longer the case.

**Load on JIRA instance**

If your JIRA instance is already under high load, then using it as a User Server will increase that load.

**JIRA OnDemand not supported**

You cannot use JIRA OnDemand to manage standalone users. OnDemand users and users within your self-hosted Atlassian applications need to be managed separately.

**Recommendations**

<table>
<thead>
<tr>
<th>Your environment</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If all</strong> the following are true:</td>
<td></td>
</tr>
<tr>
<td>• If your JIRA instance is not under high load.</td>
<td></td>
</tr>
<tr>
<td>• You want to share user and group management across just a few applications, such as one JIRA server and one Confluence server, or two JIRA servers.</td>
<td></td>
</tr>
<tr>
<td>• You do not need single sign-on (SSO) between JIRA and Confluence, or between two JIRA servers.</td>
<td></td>
</tr>
<tr>
<td>• You do not have custom application connectors. Or, if you do have them, you are happy to convert them to use the new REST API.</td>
<td></td>
</tr>
<tr>
<td>• You are happy to shut down all your servers when you need to upgrade JIRA.</td>
<td></td>
</tr>
<tr>
<td>Your environment meets the optimal requirements for using JIRA for user management.</td>
<td></td>
</tr>
<tr>
<td><strong>If one or more</strong> of the following are true:</td>
<td></td>
</tr>
<tr>
<td>• If your JIRA instance is already under high load.</td>
<td></td>
</tr>
<tr>
<td>• You want to share user and group management across more than 5 applications.</td>
<td></td>
</tr>
<tr>
<td>• You need single sign-on (SSO) across multiple applications.</td>
<td></td>
</tr>
<tr>
<td>• You have custom applications integrated via the Crowd SOAP API, and you cannot convert them to use the new REST API.</td>
<td></td>
</tr>
<tr>
<td>• You are not happy to shut down all your servers when you need to upgrade JIRA.</td>
<td></td>
</tr>
<tr>
<td>We recommend that you install Atlassian Crowd for user management and SSO.</td>
<td></td>
</tr>
</tbody>
</table>
If you are considering creating a custom directory connector to define your own storage for users and groups...

Please see if one of the following solutions will work for you:

- If you have written a custom provider to support a specific LDAP schema, please check the supported LDAP schemas to see if you can use one of them instead.
- If you have written a custom provider to support nested groups, please consider enabling nested groups in the supported directory connectors instead.
- If you have written a custom provider to connect to your own database, please consider loading the data into the application's database instead.
- If you need to keep the custom directory connection, please consider whether Atlassian Crowd meets your requirements. See the documentation on Creating a Custom Directory Connector.

RELATED TOPICS

Connecting to an LDAP Directory
Connecting to Crowd or JIRA for User Management
Configuring User Directories
Requesting Support for External User Management

This page gives guidelines on how to request help from the Atlassian support team if you are having problems with external user management. External user management includes connections to Active Directory, other LDAP servers, Atlassian Crowd or Atlassian JIRA for user management. The information on this page is provided in addition to the more general page on Troubleshooting Problems and Requesting Technical Support.

The cause of such problems may be:

- The LDAP server is not responding.
- The application password is incorrectly configured, causing the LDAP server or other directory to return an authentication error.
- Other LDAP settings are incorrectly configured.

Troubleshooting the Connection to your External User Directory

The configuration screen for external directories in Confluence has a 'Test Settings' button. This will help you to diagnose problems with user management in Active Directory and other LDAP servers.

To test your directory connection:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Click 'User Directories' in the left-hand panel.
3. Edit the relevant directory.
4. Click 'Test Settings'.
5. The results of the test will appear at the top of the screen.

Please refer to our knowledge base articles for troubleshooting user management and login issues.

If the above resources do not help, continue below.

Problems During Initial Setup

Raise a support request and include the following information.

- Download an LDAP browser to make sure you have the right settings in your LDAP directory. Atlassian
Confluence 5.6 Documentation

recommends LDAP Studio. Include screenshots of your user and group DNs.

- If you can start up Confluence and access the Administration Console, review your directory settings. See Connecting to an LDAP Directory. Attach screenshots of all your settings.

### Complex Authentication or Performance Problems

Raise a support request and include the following information.

#### Confluence Server

Log in to Confluence and access the Administration Console.

- Take a screenshot of the **System Information** screen, or save the page as HTML.
- Take a screenshot of the **Global Permissions** screen, if people are having problems with logging in.
- Go to **Space Admin** for the relevant space and take a screenshot of the **Permissions** page, if you are having problems with space or page permissions.

#### Confluence Configuration Files

- If you have implemented a custom authenticator or in any way modified seraph-config.xml or seraph-paths.xml, please provide the modified file.

#### User Management System

- Include the name and version of your LDAP server.
- Does your LDAP server use dynamic or static groups?
- Review your directory settings. See Connecting to an LDAP Directory. Attach screenshots of all your settings.

#### Diagnostics

- Enable profiling. See Performance Tuning.
- Enable detailed user management logging, by editing confluence/WEB-INF/classes/log4j.properties.

Change this section:

```plaintext
###
# Atlassian User
###
#log4j.logger.com.atlassian.user=DEBUG
#log4j.logger.com.atlassian.confluence.user=DEBUG
#log4j.logger.bucket.user=DEBUG
#log4j.logger.com.atlassian.seraph=DEBUG
#log4j.logger.com.opensymphony.user=DEBUG

```

Remove the '#' signs at the beginning of the lines, so that it looks like this:

```plaintext
###
# Atlassian User
###
log4j.logger.com.atlassian.user=DEBUG
log4j.logger.com.atlassian.confluence.user=DEBUG
log4j.logger.bucket.user=DEBUG
log4j.logger.com.atlassian.seraph=DEBUG
log4j.logger.com.opensymphony.user=DEBUG
```

- After enabling both the above, please attempt a Confluence LDAP account login and attach a copy of the log files that are produced when the problem occurs. To do this, locate your install directory or exploded WAR directory, then zip the full /logs subdirectory into a single file for us to examine. The logs subdirectory is located in your Confluence Home directory.

RELATED TOPICS
Troubleshooting Problems and Requesting Technical Support

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management

Disabling the Built-In User Management

By selecting the 'External user management' option in Confluence, you can disable the group and user management screens in Confluence. You need system administrator permissions to set this option.

You will find it useful to select external user management under the following circumstances:

- When Crowd's directory permissions are configured so that Confluence cannot update the Crowd directories, then Confluence's external user management setting must be turned on. Otherwise, a 'System Error' will occur when Confluence attempts to write data into Crowd. For more information about integrating Crowd with Confluence, see Connecting to Crowd or JIRA for User Management.
- If you are using JIRA for user management, we recommend that you turn on Confluence's external user management setting. This centralises user management in JIRA. See Connecting to Crowd or JIRA for User Management and Connecting to JIRA 4.2 or Earlier for User Management.

To disable management of users and groups within Confluence:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Click 'Security Configuration' in the left-hand panel.
3. The 'Edit Security Configuration' screen will appear. Click 'Edit'.
4. Tick the 'External user management' check box.
5. Click 'Save'.

Notes

- Please refer to the following bugs and improvement requests:
  - CONF-16709 – When the External User Management check box is ticked, the group and user management screens are still functional.
  - CONF-21158 – Enabling both public signup and external user management renders a blank screen during signup.
  - CONF-9830 – This is a request to rename this feature to better reflect its functionality.

RELATED TOPICS

Content by label

There is no content with the specified labels.
Managing Add-ons or Plugins

An add-on is a separately installed component that provides Confluence functionality. The terms ‘plugin’ and ‘add-on’ are often used interchangeably.

There are two main types of add-ons:

- System add-ons - these are bundled with Confluence and provide core functionality
- User installed add-ons - these are usually downloaded from The Marketplace and may have been created by Atlassian or by a third party developer.

For information about developing your own add-ons for Confluence, see the Confluence Developer documentation.

About the Universal Plugin Manager

Add-ons are managed via the Universal Plugin Manager (known as the UPM). The UPM can be found in most Atlassian applications, and provides a consistent experience for administering add-ons.

The UPM allows you to:

- Discover and install new add-ons from the Atlassian Marketplace.
- Install or remove add-ons.
- Configure add-on settings.
- Enable or disable add-ons and their component modules.
- Confirm add-on compatibility before upgrading Confluence.

You'll need Confluence Administrator permissions to access the UPM. See Requesting Add-ons for information on how users can find and request add-ons.

See the Universal Plugin Manager documentation for more information on using the UPM.

Writing User Macros

User macros are useful if you want to create your own custom macros. These can be to perform specific actions, apply custom formatting and much more.

User macros are created and managed within Confluence itself, you do not need to develop an add-on. You will need some coding skills though.

You'll need System Administrator permissions to create and manage user macros.

Creating a User Macro

To add a new user macro:

1. Go to > General Configuration > User Macros.
2. Choose Create a User Macro.
3. Enter the macro details (see table below)
4. Click Add.

<table>
<thead>
<tr>
<th>Macro details field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro name</td>
<td>This is the name of the macro, as it appears in the code.</td>
</tr>
</tbody>
</table>
| **Visibility** | This controls who can see this macro in the macro browser or auto-complete. Options are:
| | • Visible to all users
| | • Visible only to system administrators
| | Note that if you select Visible only to system administrators, users will still see the output of the macro on a page, and the macro placeholder will still be visible when a user edits a page. It is only hidden in the macro browser and autocomplete.
| | All macro information is discoverable, including the macro title, description, parameter names and other metadata. Do not include confidential data anywhere in the definition of a user macro, even if it is marked as visible only to system administrators. |
| **Macro Title** | This is the title that will appear in the macro browser and auto-complete. |
| **Description** | This is the description that will appear in the macro browser. The macro browser's search will pick up matches in both the title and description. |
| **Categories** | Select one or more macro browser categories for your macro to appear in. |
| **Icon URL** | Enter an absolute URL (for example http://mysite.com/mypath/status.png) or path relative to the Confluence base URL (for example /images/icons/macrobrows er/status.png) if you want the macro browser to display an icon for your macro. |
| **Documentation URL** | If you have documentation for your macro, enter the URL here. |
| **Macro Body Processing** | Specify how Confluence should process the body before passing it to your macro. The macro body is the content that is displayed on a Confluence page. If your macro has a body, any body content that the user enters will be available to the macro in the $body$ variable. Options for processing the macro body include:
| | • **No macro body**
| | Select this option if your macro does not have a body.
| | • **Escaped**
| | Confluence will add escape characters to the HTML markup in the macro body. Use this if you want to show actual HTML markup in the rendered page. For example, if the body is `<b>Hello World</b>` it will render as `<b>Hello World</b>`.  
| | • **Unrendered**
| | HTML in the body will be processed within the template before being output. Ensure that HTML is ultimately output by the template.
| | • **Rendered**
| | Confluence will recognise HTML in the macro body, and render it appropriately. For example, if the body is `<b>Hello World</b>` it will render as **Hello World**. |
This is where you write the code that determines what the macro should do.

- Use HTML and Confluence-specific XML elements in the macro template. Details of Confluence's storage format are in Confluence Storage Format.
- You can use the Velocity templating language. Here is more information on the Velocity project.
- If your macro has a body, your template can refer to the macro body text by specifying '$body'.
- Each parameter variable you use must have a matching metadata definition. Use `@param` to define metadata for your macro parameters.
- When using the information passed using parameters, refer to your parameters as `$paramXXX` where 'XXX' is the parameter name that you specified in the `@param` metadata definition.
- Use `@nparams` if your macro does not accept parameters.

See User Macro Template Syntax for more information and examples.

Do you need a plugin instead?
If you want to distribute your user macro as a plugin, please refer to the developer's guide to the User Macro plugin module. If you want to create more complex, programmatic macros in Confluence, you may need to write a Macro plugin.

Editing a user macro

**To edit a user macro:**

1. Go to > General Configuration > User Macros.
2. Click Edit next to the relevant macro.
3. Update the macro details as explained in the guide to writing user macros.
4. Click Save.

Deleting a user macro

**To delete a user macro:**

1. Go to > General Configuration > User Macros.
2. The currently configured user macros will appear.
3. Click Delete next to the relevant macro.

Before deleting a user macro, you should search for all occurrences of the macro in pages and blog posts. Users will see an 'unknown macro' error if you delete a user macro that is still in use on a page.

Best practices

This section contains tips and suggestions for best practices when creating your own user macros.

Add a descriptive header to your macro template

We recommend that you include a short description as a comment at the top of the Template field as shown below.
## Macro title: My macro name
## Macro has a body: Y or N
## Body processing: Selected body processing option
## Output: Selected output option
##
## Developed by: My Name
## Date created: dd/mm/yyyy
## Installed by: My Name
##
## Short description of what the macro does

### Expose your parameters in the macro browser

The macro browser is the easiest way for users to configure your macro. You can specify the macro category, link to an icon, define the parameters that the macro browser will use to prompt the user for information, and more.

### Supply default values for macro parameters

As you can't guarantee that a user has supplied parameters, one of the first things to do in the macro is check that you have received some value if you expect to rely on it later on in the macro code.

In the example below, the macro expects three parameters, and substitutes sensible defaults if they are not supplied.

```java
#set($spacekey= $paramspacekey)
#set($numthreads= $paramnumthreads)
#set($numchars= $paramnumchars)

## Check for valid space key, otherwise use current
#if (!$spacekey)
    #set ($spacekey=$space.key)
#end

## Check for valid number of threads, otherwise use default of 5
#if (!$numthreads)
    #set ($numthreads=5)
#end

## Check for valid excerpt size, otherwise use default of 35
#if (!$numchars)
    #set ($numchars=35)
#end
```

### User Macro Template Syntax

See [Writing User Macros](#) for an introduction to writing a user macro.

This page provides information about the code you can enter in a user macro template.

#### Accessing your macro’s body

Use the `$body` object within your user macro template to access the content passed to your macro in the macro body.

The `$body` object is available if you have specified

---

On this page:

- Accessing your macro’s body
- Using parameters in your user macro
- Objects available to your macro
- Controlling parameter appearance in the editor placeholder

Related pages:

- Writing User Macros
that your macro has a body (in other words, if you have *not* selected **No macro body**).

**Example:** Let’s assume your macro is called `hello world`. Enter the following code in your template:

```plaintext
Hello World: $body
```

A user, when editing a Confluence page, chooses your macro in the macro browser and then enters the following in the macro placeholder that is displayed in the edit view:

```plaintext
From Matthew
```

The wiki page will display the following:

```plaintext
Hello World: From Matthew
```

**Using parameters in your user macro**

You can specify parameters for your macro, so that users can pass it information to determine its behaviour on a Confluence page.

**How your macro parameters are used on a Confluence page**

When adding a macro to a Confluence page, the macro browser will display an input field for each macro parameter. The field type is determined by the parameter type you specify.

**Defining the parameters**

A parameter definition in the template contains:

- `@param`
- The parameter name
- A number of attributes (optional).

Format:

```plaintext
## @param MYNAME:title=MY TITLE|type=MY TYPE|desc=MY DESCRIPTION|required=true|multiple=true|default=MY DEFAULT VALUE
```

Additional notes:

- The order of the parameters in the template determines the order in which the macro browser displays the parameters.
- We recommend that you define the parameters at the top of the template.
- There may be additional attributes, depending on the parameter type you specify.

The sections below describe each of the attributes in detail.

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Description</th>
<th>Required / Recommended / Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>(an unnamed, first attribute)</em></td>
<td>A unique name for the parameter. The parameter name is the first attribute in the list. The name attribute itself does not have a name. See the section on <code>name</code> below.</td>
<td>Required</td>
</tr>
<tr>
<td>Parameter name</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>The parameter title will appear in the macro browser. If you do not specify a title, Confluence will use the parameter name.</td>
<td>Recommended</td>
<td></td>
</tr>
<tr>
<td>The field type for the parameter. See the section on <em>type</em> below.</td>
<td>Recommended</td>
<td></td>
</tr>
<tr>
<td>The parameter description will appear in the macro browser.</td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Specifies whether the user must enter information for this parameter. Defaults to false.</td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Specifies whether the parameter accepts multiple values. Defaults to false.</td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>The default value for the parameter.</td>
<td>Optional</td>
<td></td>
</tr>
</tbody>
</table>

**Parameter name**

The parameter name is the first attribute in the list. The name attribute itself does not have a name.

**Example:** The following code defines 2 parameters, named 'foo' and 'bar':

```markdown
## @param foo
## @param bar
```

**Parameter type**

The field type for the parameter. If you do not specify a type, the default is *string*.

<table>
<thead>
<tr>
<th>Parameter type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>boolean</td>
<td>Displays a checkbox to the user and passes the value 'true' or 'false' to the macro as a string.</td>
</tr>
</tbody>
</table>
| enum | Offers a list of values for selection. You can specify the values to appear in a dropdown in the macro browser. Example of specifying the enum values:

```markdown
## @param
colour:title=Colour|type=enum|enumValues=Grey,Red,Yellow,Green
```

*Note about i18n: Confluence does not support internationalisation of the enum values. The value the user sees is the one passed to the macro as the parameter value, with the capitalisation given. In this case 'Grey', 'Red', etc.*

<table>
<thead>
<tr>
<th>string</th>
<th>A text field. This is the default type. Example with a required field:</th>
</tr>
</thead>
</table>
|        | ```markdown
|        | ## @param
|        | status:title=Status|type=string|required=true|desc=Status to display
|        | ```

*Note about i18n: Confluence does not support internationalisation of the enum values. The value the user sees is the one passed to the macro as the parameter value, with the capitalisation given. In this case 'Grey', 'Red', etc.*
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| confluence-content | Offers a control allowing the user to search for a page or blog post. Example: | ```
## @param page:title=Page|type=confluence-content|required=true|desc=$a page do use
``` |
| username | Search for user. | ```
## @param user:title=Username|type=username|desc=Select user to display
``` |
| spacekey | Offers a list of spaces for selection. Passes the space key to the macro. Example: | ```
## @param space:title=Space|type=spacekey
``` |
| date | Confluence accepts this type, but currently treats it in the same way as 'string'. Example: | ```
## @param fromDate:title=From Date|type=date|desc=Date to start from. Format: dd/mm/YYYY
``` **Note about dates**: A user can enter a date in any format, you should validate the date format in your user macro. |
| int | Confluence accepts this type, but treats it in the same way as 'string'. Example with a default: | ```
## @param numPosts:title=Number of Posts|type=int|default=15|desc=Number of posts to display
``` |
| percentage | Confluence accepts this type, but treats it in the same way as 'string'. Example: | ```
## @param pcent:title=Percentage|type=percentage|desc=Number of posts to display
``` |

**Using the parameters in your macro code**

The parameters are available in your template as `$paramfoo`, `@parambar` for parameters named "foo" and "bar".

Normally, a parameter like `$paramfoo` that is missing will appear as `$paramfoo` in the output. To display nothing when a parameter is not set, use an exclamation mark after the dollar sign like this: `@$paramfoo`

**Using no parameters**

If your macro does not accept parameters, you should use `@noparams` in your template.

If the user macro contains no parameters and does not specify `@noparams`, then the macro browser will display a free-format text box allowing users to enter undefined parameters. This can be confusing if the...
macro does not accept parameters.

**Example:** Add the following line at the top of your template:

```text
## @noparams
```

Objects available to your macro

Including the macro body and parameters, the following Confluence objects are available to the macro:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Class Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>$body</td>
<td>The body of the macro (if the macro has a body)</td>
<td>String</td>
</tr>
<tr>
<td>$paramfoo, $parambar, ... $param&lt;name&gt;</td>
<td>Named parameters (&quot;foo&quot;, &quot;bar&quot;) passed to your macro.</td>
<td>String</td>
</tr>
<tr>
<td>$config</td>
<td>The BootstrapManager object, useful for retrieving Confluence properties.</td>
<td>BootstrapManager</td>
</tr>
<tr>
<td>$renderContext</td>
<td>The PageContext object, useful for (among other things) checking $renderContext.outputType</td>
<td>PageContext</td>
</tr>
<tr>
<td>$space</td>
<td>The Space object that this content object (page, blog post, etc) is located in (if relevant).</td>
<td>Space</td>
</tr>
<tr>
<td>$content</td>
<td>The current ContentEntity object that this macro is included in (if available).</td>
<td>ContentEntityObject</td>
</tr>
</tbody>
</table>

Macros can also access objects available in the default Velocity context, as described in the developer documentation.

Controlling parameter appearance in the editor placeholder

You can determine which macro parameters should appear in the placeholder in the Confluence editor.

By default as many parameters as can fit will be displayed in the placeholder, as shown here:

You can control which parameters you want to display here, to ensure the most relevant information is visible to the author.

For example, the Confluence Warning macro has two parameters, `title` and `icon`. We consider `title` to be the most interesting parameter, so we have configured the Warning macro to show only the value of the `title` parameter.

Let's assume an author adds the Warning macro to a page, and gives it a title of 'The title of the warning'. The macro configuration leads to a placeholder as shown here:
To configure the macro placeholder for a user macro, you will add attributes to the @param entry in the template.

For example, if our Warning macro is a user macro, the configuration for the title parameter is as follows:

```
## @param
   title:type=string|option-showNameInPlaceholder=false|option-showValueInPlaceholder=true
```

The attribute showNameInPlaceholder specifies that the title parameter’s name should not be shown.

The attribute showValueInPlaceholder specifies that the title parameter’s value should be shown.

If none of the parameters in a macro include any of the above attributes, then the default behaviour is to show all the parameters that fit in the placeholder: full title and value.

If one or more parameters has either attribute set, then all parameters that do not include the attributes will default to false (that is, they will not be shown).

**Example User Macro - Hello World**

This example demonstrates how to create a user macro that displays the text 'Hello World!' and any text that the user places in the body of the macro.

Before you start, see [Writing user macros](#) for an introduction to creating your own user macros.

Defining the 'Hello World' user macro

To create the 'Hello World' user macro:

1. Go to ![General Configuration > User Macros](#).
2. Choose Create a User Macro.
3. Enter the macro details (see table below)
4. Choose Add.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro name</td>
<td>helloworld</td>
</tr>
<tr>
<td>Visibility</td>
<td>Visible to all users in the Macro Browser</td>
</tr>
<tr>
<td>Macro Title</td>
<td>Hello World</td>
</tr>
<tr>
<td>Description</td>
<td>Displays &quot;Hello World&quot; and the macro body.</td>
</tr>
<tr>
<td>Categories</td>
<td>Confluence Content</td>
</tr>
<tr>
<td>Icon URL</td>
<td>You can leave this field blank</td>
</tr>
<tr>
<td>Documentation URL</td>
<td>You can leave this field blank</td>
</tr>
<tr>
<td><strong>Macro body processing</strong></td>
<td><strong>Rendered</strong></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Template</strong></td>
<td><strong>Enter the code below in the template field - this example will print the text straight onto the page.</strong></td>
</tr>
</tbody>
</table>
|                          | `## @noparams
Hello World!
$body` |

If you wanted the text to appear in a panel you could include the relevant AUI message class as shown here.

```
## @noparams
<div class="aui-message closeable">
Hello World!
$body
</div>
```

Using the 'Hello World' macro on a page

Now you can add the macro to your Confluence page using the Macro Browser, or by typing `hello` in the editor and selecting the macro from the list of suggestions.

![Hello World]

The result is:

![Introducing workflow]

If you chose to include a panel, the result would be:

![Hello World! What a beautiful day!]

**Example User Macro - Colour and Size**

This example demonstrates how you can pass parameters to your macro. We'll create a font style macro which has two parameters to allows the user to specify the colour and size of the text contained in the macro body.

Before you start, see [Writing user macros](#) for an introduction to creating your own user macros.

2. Choose Create a User Macro.
3. Enter the macro details (see table below)
4. Choose Add.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro name</td>
<td>stylish</td>
</tr>
<tr>
<td>Visibility</td>
<td>Visible to all users in the Macro Browser</td>
</tr>
<tr>
<td>Macro Title</td>
<td>Stylish</td>
</tr>
<tr>
<td>Description</td>
<td>Applies colour and size to text.</td>
</tr>
<tr>
<td>Categories</td>
<td>Confluence Content</td>
</tr>
<tr>
<td>Icon URL</td>
<td>You can leave this field blank</td>
</tr>
<tr>
<td>Documentation URL</td>
<td>You can leave this field blank</td>
</tr>
<tr>
<td>Macro body</td>
<td>Rendered</td>
</tr>
<tr>
<td>processing</td>
<td></td>
</tr>
<tr>
<td>Template</td>
<td>Enter the code below in the template field. If your macro requires more than one parameter, you can use variables $param0 to $param9 to represent them. Alternatively, you can also use explicitly-named parameters in your macro. These macro parameters will appear as variables with the name $param&lt;x&gt; where &lt;x&gt; is the name of your parameter.</td>
</tr>
</tbody>
</table>

```javascript
## @param 0:title=colour|type=string
## @param 1:title=size|type=string
<span style="color: $param0; font-size: $param1">$body</span>
```

```javascript
## @param Colour:title=colour|type=string
## @param Size:title=size|type=string
<span style="color: $paramColour; font-size: $paramSize">$body</span>
```

Example User Macro - NoPrint

This example demonstrates how to create a user macro that can contain text that is visible when viewing a page, but does not print.

Before you start, see Writing user macros for an introduction to creating your own user macros.

Defining the 'NoPrint' user macro

To create the 'Hello World' user macro:

1. Go to > General Configuration > User Macros.
2. Choose Create a User Macro.
3. Enter the macro details (see table below)
4. Choose Add.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro name</td>
<td>noprint</td>
</tr>
</tbody>
</table>
Using the 'NoPrint' Macro on a page

Now you can add the macro to your Confluence page using the Macro Browser. Text entered into the body of the macro placeholder will not be printed, but will appear when the page is viewed online.

```
## @noparams
<div class="NoPrint">$body</div>
```

Using the 'NoPrint' Macro on a page

Now you can add the macro to your Confluence page using the Macro Browser. Text entered into the body of the macro placeholder will not be printed, but will appear when the page is viewed online.

[NoPrint]

This text will not be printed.

Making the PDF export recognise the NoPrint macro

See Advanced PDF Export Customisations.

**Example User Macro - Formatted Panel**

This example demonstrates how to write a user macro that creates a panel that is preformatted with specific colours. It will create a panel that looks like this:

```
| (Title) |
```

**Note:** The panel's title will be empty if the user does not give a value for the title parameter.

Before you start, see Writing user macros for an introduction to creating your own user macros.

Defining the 'Formatted Panel' user macro

**To create the 'Formatted Panel' user macro:**

1. Go to > General Configuration > User Macros.
2. Choose Create a User Macro.
3. Enter the macro details (see table below)
4. Choose Add.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro name</td>
<td>formpanel</td>
</tr>
</tbody>
</table>
## @param Title:title=Title|type=string|desc=Title
<ac:structured-macro ac:name="panel">
    <ac:parameter ac:name="titleBGColor">#ccc</ac:parameter>
    <ac:parameter ac:name="borderStyle">solid</ac:parameter>
    <ac:parameter ac:name="borderColor">#6699CC</ac:parameter>
    <ac:parameter ac:name="borderWidth">2</ac:parameter>
    <ac:parameter ac:name="titleColor">#000000</ac:parameter>
    <ac:parameter ac:name="title">$!paramTitle</ac:parameter>
    <ac:rich-text-body>$body</ac:rich-text-body>
</ac:structured-macro>

### Explanation of the code in the macro template

Below is a breakdown of the user macro template code.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| ## @param Title:title=Title|type=string|desc=Title | @param defines the metadata for your macro parameters.  
| | @param Title | This parameter is called "Title".  
| | title=Title | defines the parameter title that will appear in the macro browser as "Title".  
| | type=string | defines the field type for the parameter as a text field.  
| | desc=Title | defines the description of the parameter in the macro browser.  |
### Customising your Confluence Site

This page is an introduction to customising Confluence at site level. This is of interest to Confluence administrators – people with System Administrator or Confluence Administrator permissions.

For guidelines on customisations at a personal and space level, see [Customising Confluence](#).

We have documented the customisations under two broad headings:

- You can change the **appearance** of Confluence by customising the dashboard, adjusting the colours, adding a site logo, and more. See [Changing the Look and Feel of Confluence](#).
- You can determine the **default behaviour** by setting various options, or define the **default content** that appears in new spaces, on the dashboard, and in other Confluence locations. See [Changing the Default Behaviour and Content in Confluence](#).
Changing the Look and Feel of Confluence

You can customise the 'look and feel' of Confluence at both the site (global) and space levels.

Any changes you make to the look and feel at site level will be applied as the default look and feel for all the spaces in the site. This means that any customisations will only be reflected in the "Default" theme. No other theme will have an impact from this change. An individual space can be configured to have its own look and feel through the space administration screens.

Ways to customise the look and feel of your site:

- Add your own site logo. See Changing the Site Logo.
- Change the colour scheme of the user interface. See Customising Colour Schemes.
- Use themes for advanced layout customisation. See Working with Themes.
- Change the appearance of the dashboard. See Customising the Confluence Dashboard.
- Change the site or space layouts, which determine how the controls are laid out in the site. This does not change the actual page layouts, but it does change the way the surrounding controls appear in the page. See Customising Site and Space Layouts.

Customising the Confluence Dashboard

If you are a Confluence Administrator, you can customise the site dashboard, affecting the way all users will see the dashboard. Some of the actions below require Confluence Administrator permissions, whereas others require System Administrator permissions.

Confluence users can customise their own view of the dashboard too. See the user's guide.

Sending users to a space home page instead of the dashboard

See Configuring the Site Home Page.

Editing the top left-hand section of the dashboard

See Editing the Site Welcome Message.

Disabling the 'Popular' tab on the dashboard

In some environments, you may prefer not to display the 'Popular' tab on the dashboard. For example, if your wiki allows only a small group of people to log in and contribute content or comments, then the tab may not be relevant to you.

To prevent the tab from appearing, you can disable the relevant plugin module. You need System Administrator permissions to do this. Go to the Dashboard Macros plugin (See Configuring a Plugin), choose Manage plugin modules and disable the Popular Tab module.
On this page:
- Sending users to a space home page instead of the dashboard
- Editing the top left-hand section of the dashboard
- Disabling the ‘Popular’ tab on the dashboard
- Advanced customisations
  - Editing the bottom left-hand section of the dashboard
  - Editing the top right-hand action bar
  - Modifying the global template or layout

Related pages:
- Customising your Personal Dashboard
- Changing the Look and Feel of Confluence

⚠️ The information on this page does not apply to Confluence Cloud.

Advanced customisations

These configurations require knowledge of plugin development and/or the Velocity template language. See our guide to the Atlassian Plugin SDK and our introduction to Velocity.

Editing the bottom left-hand section of the dashboard

This section can be updated using Confluence web panels. You can add items to the dashboard by including a web panel with the key `atl.dashboard.left`:

```xml
<web-panel key="{key}" location="atl.dashboard.left">
  <resource name="view" type="velocity" location="{location}"/>
</web-panel>
```

You can remove the existing entities panel by disabling the global-entities-panel plugin from the dashboard macros plugin.

Editing the top right-hand action bar

You can add more links to the top right navigation bar by adding web items to `system.dashboard.button`:

```xml
<web-item key="{key}" name="{name}" section="system.dashboard.button">
  <label key="{label}"/>
  <link/>
  <styleClass/>
</web-item>
```

Modifying the global template or layout

You can also modify files to add content to the global dashboard.

To make modifications to the dashboard, modify the global template `/confluence/decorators/global.vm` or the layout at 🏗️ > General Configuration > Layouts > Global Layout.

For example, search the global layout for these macros:
To modify the bundled plugin macros used in the Confluence dashboard:

1. **Modify the** [atlassian-bundled-plugins.zip file](<Confluence install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup) **located at** <Confluence install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup.
2. **Update the** confluence-dashboard-macros-x.x.jar **file**, rezip it and then put it back to <Confluence install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup. Refer to [How to Edit Files in Confluence JAR Files](<Confluence install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup).
3. **Delete the JAR from** <confluence-home>/bundled-plugins.
4. **Restart Confluence.**

To customise the space list, you can work with spacelist.vm.

**Changing the Site Logo**

You can customise the look and feel of your Confluence site by changing the logos.

You can change:

- the **site logo**
- the **default space logo** for all spaces
- the **space logo** for individual spaces.

**Screenshot: Location of the Site Logo and Space Logo in Confluence.**

---

**Changing the site logo**

The Site Logo appears in the header and is visible throughout Confluence. You need Confluence Administrator permissions to change the site logo.

**To change the site logo:**

1. Choose the [cog icon](<Confluence install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup), then choose **General Configuration** under Confluence Administration.
2. Choose Site Logo and Favicon.
3. Choose Browse to upload a new logo.
4. Choose Show Logo Only or Show Logo and Title depending on whether you wish the Site Title to display in the header.
5. Choose Save.

Confluence’s Auto Look and Feel will detect the colours in your new logo, and change the site colour scheme to match.

If you would prefer to use the default colour scheme with your custom logo go to General Configuration > Colour Scheme > Edit and then choose Reset to revert back to the default scheme.

Screenshot: Header showing Site Logo, Site Title and auto look and feel changes to the colour of the header

Choosing the site icon (favicon)

You can also change the site favicon (the icon that appears in your browser tab). You need Confluence Administrator permissions to do this.

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Site Logo and Favicon
3. Locate your image file and choose Upload.

You can upload PNG, GIF, JPEG, or ICO files. For best results images should be square, and at least 48x48 pixels.

Changing the default space logo

The Space Logo appears in the sidebar and as an icon in the Sites Directory. If you are using the Documentation theme the Space Logo displays beside the Space Title.

The default space logo applies to all spaces that do not have a custom space logo applied - see Changing a Space’s Logo.

You need to be a Confluence Administrator to change the default space logo.

To change the default space logo:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Default Space Logo in the left-hand panel.
3. Choose Logo:ON
4. Choose Browse to upload a new logo
5. Choose Upload Logo
6. Choose Save.

Screenshot: Confluence spaces showing the default logo, and a space with a customised logo
Changing a specific space logo

Space Administrators can change the logo for their space. This overrides the default space logo and any changes to the default space logo will not appear in these spaces. See example above - 'Sample Space' has a custom logo.

See Changing a Space's Logo to find out how to change the logo in a specific space.

Customising Colour Schemes

Confluence administrators can configure a new colour scheme for the site. The default colour scheme for the site will also become the default for all spaces within it. Space administrators can configure a different colour scheme for spaces. The space colour scheme will override the site-wide colour scheme.

To change the site's colour scheme:

1. Choose the cog icon \( \text{cog icon} \) then choose General Configuration under Confluence Administration.
2. Choose Colour Scheme in the left-hand panel.
3. Choose Edit.
4. Enter standard HTML/CSS2 colour codes, or use the colour-picker \( \text{colour-picker} \) to choose a new colour from the palette provided.
5. Choose Save. Any changes you make will immediately be reflected across the Confluence site.
- Tab Navigation Background - the background colour of the tab navigation
- Tab Navigation Text - the text of the tab navigation
- Tab Navigation Background Highlight - the background colour of the tab navigation when highlighted
- Tab Navigation Text Highlight - the text of the tab navigation elements when highlighted

Screenshot: Editing the colour scheme
**Reset your colour scheme after uploading a site logo**

When you upload a site logo, Confluence automatically detects the colours in your logo and customises the colour scheme for you.

You can change the colour scheme as above, or reset your colour scheme back to the default (and still keep your new site logo).

To reset the colour scheme:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Colour Scheme in the left-hand panel.
3. Choose Edit.
4. Choose Reset.

**Notes**

- If you make a mistake, just choose Reset and then try again.
- Some UI elements are specific to the default theme and may not take effect for other themes.

**Working with Themes**

Themes are pre-defined style sets that you can apply to Confluence, to alter the appearance of your site. This is a way of personalising the 'look and feel' of Confluence. You can apply a theme to your entire Confluence site and to individual spaces. Choose a specific theme if you want to add new functionality or significantly alter the appearance of Confluence.

Confluence comes with a selection of themes. After a theme is installed on your Confluence site, any space administrator can apply a theme to a space.

A site administrator can install new themes as add-ons via the Confluence Administration Console.

By default when you create a new space, the space will have the Confluence default theme.

**To look at the themes installed on your Confluence site:**

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Themes in the left-hand panel.
3. You will see a list of all installed themes.

**Useful add-ons**

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Visit the Atlassian Marketplace to search for additional themes you can add to your site.

**Related pages:**

- Applying a Theme to a Space
- Applying a Theme to a Site
- Configuring the Documentation Theme
- Confluence Administrator's Guide
- Creating a Theme

**Applying a Theme to a Site**

You can use a theme to personalise the 'look and feel' of Confluence. Some themes simply change the basic styling, others add new functionality or significantly alter the appearance of Confluence. You can apply a theme to your entire Confluence site and to individual spaces.

Confluence comes with a selection of themes.

In addition, a site administrator can install new themes as plugins via the Confluence Administration Console.

Provided that the theme is available in your Confluence site, any space administrator can apply a theme to a
space. By default when you create a new space, the space will have the Confluence default theme.

To apply a theme across the site:

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Choose **Themes** in the left-hand panel.
3. The screen will display all available themes. Select a radio button to choose a theme.
4. Choose **Confirm**.

**Related pages:**
- Applying a Theme to a Space
- Configuring the Documentation Theme
- Confluence Administrator’s Guide
- Creating a Theme

**Screenshot: Applying a theme**

<table>
<thead>
<tr>
<th>Site Theme</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Current Theme</strong></td>
</tr>
<tr>
<td>The current theme controls the layout and colours of this space.</td>
</tr>
<tr>
<td><img src="image" alt="Default Theme" /></td>
</tr>
<tr>
<td>Default Theme</td>
</tr>
<tr>
<td>This is the original Confluence look and feel. Page content spans the full width of the screen.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Choose New Theme</th>
</tr>
</thead>
<tbody>
<tr>
<td>To change the theme of this space, select one below.</td>
</tr>
<tr>
<td><img src="image" alt="Documentation Theme" /></td>
</tr>
<tr>
<td>Documentation Theme</td>
</tr>
<tr>
<td>This theme is well suited for structured content, such as documentation. It features a table of contents (page tree) on the left, making it easier to see the structure of a space and move from page to page. You can customise the left-hand panel, page header and page footer.</td>
</tr>
</tbody>
</table>

**Creating a Theme**

If you want to create your own theme, you will need to write a Confluence plugin. Please refer to the following pages in our developer documentation:

- Get started with **plugin development**.
- Follow the developer’s tutorial for **writing a Confluence theme**.
- Create a theme using the **theme plugin module**.
Customising Site and Space Layouts

You can modify Confluence’s look and feel by editing the ‘decorator’ (layout) files. Modifying these files allows you to change the look and feel of:

- The Confluence site as a whole, which includes all spaces within the Confluence site.
- An individual space within the Confluence site.

This page tells you how to customise the layout files for your Confluence site as a whole. These customisations:

- Modify the default ‘decorator’ files of each space in your site.
- Are reflected in every space unless the space’s own equivalent layout files have been customised.

You need System Administrator permissions to perform these customisations.

You can also customise the layout files for a given space. For more information, refer to Customising Space Layouts. Space layout customisations override the equivalent site customisations.

**Note:** If you modify the look and feel of Confluence by following these instructions, you will need to update your customisations when upgrading Confluence. The more dramatic the customisations are, the harder it will be to reapply your changes when upgrading. Please take this into account before proceeding with your customisation. For more information on updating your customisations, please refer to Upgrading Customised Site and Space Layouts.

On this page:

- Editing a site decorator file
- Using Velocity macros
- Advanced customisations

Related pages:

- Velocity Template Overview
- Basic Introduction to Velocity
- Customising your Confluence Site
- Confluence Administrator’s Guide

Confluence is built on top of the open source SiteMesh library, a web-page layout system. Read more on the SiteMesh website. To edit the layout of Confluence, you will need to modify these decorator files. A decorator file is a .vmd file and is written in a simple programming language called Velocity. You can learn more from the Velocity User Guide.

Once you are familiar with Velocity, you can edit the decorator files to personalise the appearance of Confluence.

The decorator files in Confluence are grouped into the following categories:

- **Site layouts**: These are used to define the controls that surround each page in the site. For example, the header and the footer.

- **Content layouts**: These control the appearance of content such as pages and blog posts. They do not change the way the pages themselves are displayed, but allow you to alter the way the surrounding comments or attachments are displayed.

- **Export layouts**: These control the appearance of spaces and pages when they are exported to HTML. If you are using Confluence to generate a static website, for example, you will need to modify these layouts.
1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Select Layouts under Look and Feel in the left-hand navigation panel.
   - Click View Default to view the .vmd file.
   - Click Create Custom to edit the default .vmd file. This will open the .vmd file in edit mode.
3. Make changes and click Update.

If something goes wrong: Click Reset Default to revert to the original layouts.

Using Velocity macros

When editing Custom Decorator Templates, there are a number of macros available to define complex or variable parts of the page such as menus and breadcrumbs. You may insert these macros anywhere in your templates. More information on Working With Decorator Macros.

Advanced customisations

Overriding Velocity templates

The velocity directory is at the front of Confluence's Velocity template search path. As such, you can override any of Confluence's Velocity templates by placing an identically named file in the right place. While we don't recommend you do this unless you know exactly what you're doing, it does give you complete control over the look of every aspect of Confluence. It also means that you can edit your templates in a text-editor if you wish, rather than through the web interface.

Caching

Velocity is configured to cache templates in memory. When you edit a page from within Confluence, it knows to reload that page from disk. If you are editing the pages on disk, you will either have to turn off velocity's caching temporarily in WEB-INF/classes/velocity.properties, or restart the server to make your changes visible.

Location of Velocity files

You will find the Velocity files in your Confluence installation directory. The primary Velocity files are located in the <CONFLUENCE-INSTALLATION>/confluence/decorators directory. For example, you will find the following files in that directory: main.vmd, space.vmd, form-aui.vmd, global.vmd, and more.

Finding the layout via the URL

If the layout has changed so extensively as to not be visible, you can browse to the URL directly:

```
http://<confluence base url>/admin/resetdecorator.action?decoratorName=decorators/main.vmd
```

Substitute the base URL and the appropriate .vmd file.

Upgrading Customised Site and Space Layouts

As Confluence evolves, so do the default site and space layouts that drive the rendering of every page. As new functionality is added or current functionality is changed, the default layouts are modified to support these changes.

If you are using custom layouts based on defaults from a previous Confluence version, you run the risk of breaking functionality, or worse, missing out on great new features!

Take care on each new release of Confluence to reapply your changes to the new default templates.

To reapply your custom layouts, you need to:

1. Obtain the source of your custom layouts from your current version of Confluence.
2. Reapply your customisations to the new default layouts.
Step 1. Obtain your Custom Layouts

Ideally, you should keep a record of each customisation you have applied to each of your Confluence site or space layouts.

If not, you should be able to find your customisations using the following method. This method extracts all site- and space-level layouts from your Confluence site as a single output. From this output, you should be able to identify your customisations.

Custom layouts are stored in the DECORATOR table within your Confluence database. You can SELECT for the source of the layout using SQL like this:

```
mysql> select SPACEKEY,DECORATORNAME,BODY from DECORATOR;
+----------+---------------------+------+
| SPACEKEY | DECORATORNAME       | BODY |
| NULL     | decorators/main.vmd  | ...  |
+----------+---------------------+------+
1 row in set (0.03 sec)
```

This example was tested on MySQL, but should be applicable to all SQL databases.

Step 2. Reapply your Customisations

When you upgrade Confluence to another major release of Confluence, you will need to manually reapply any customisations you made to any site-wide or space-specific layouts. Unless otherwise stated, you should not need to reapply customisations after conducting a minor release upgrade of Confluence.

What are 'major' and 'minor' releases? Major release upgrades are ones where the 1st digit of Confluence's version number or the 1st digit after the 1st decimal place differ after the upgrade, for example, when upgrading from Confluence 3.0 to 3.1, or 2.8 to 3.0. Minor release upgrades are ones where the 1st digit of Confluence’s version number and the 1st digit after the 1st decimal place remain the same after the upgrade, for example, when upgrading Confluence 3.0 to 3.0.1.

If you have made Confluence site-wide layout customisations:

1. Choose the cog icon under Confluence Administration.
2. Select Layouts in the left-hand navigation panel. The decorators are grouped under Site, Content and Export layouts.
3. Ensure you have all your customisations available (preferably in a form which can be copied and pasted).
4. Click Reset Default next to the layout whose customisations need to be reapplied.
5. Click Create Custom next to the same layout and reapply your customisations (by copying and pasting them) into the appropriate locations within the new default layout.
6. Click the Save button.
7. Repeat this procedure from step 4 for each layout whose customisations need to be reapplied.

If you have made space-specific layout customisations:

1. Go to the space and choose Space tools > Look and Feel on the sidebar.
2. Choose Layout. The decorators are grouped under Site, Content and Export layouts.
3. Ensure you have all your customisations available (preferably in a form which can be copied and pasted).
4. Click **Reset Default** next to the layout whose customisations need to be reapplied.
5. Click **Create Custom** next to the same layout and reapply your customisations (by copying and pasting them) into the appropriate locations within the new default layout.
6. Click the **Save** button.
7. Repeat this procedure from step 5 for each layout whose customisations need to be reapplied.

If your space is using the Documentation theme:

1. Go to a page in the space.
2. Choose **Browse > Space Admin** at the top of the screen. *Note:* The 'Space Admin' option appears only if you have space admin permissions for the space or you have System Administrator global permissions.
3. Choose **Layout** from the left hand panel.
4. Follow the steps above.

**Step 3. Test your Modifications Carefully**

Changes may interact unpredictably with future versions of Confluence. When upgrading, you should always test your custom modifications thoroughly before deploying them on a live site. It’s beyond the scope of Atlassian Support to test and deploy these changes.

**Turning Off Caching**

Velocity is configured to cache templates in memory. When you edit a page from within Confluence, it knows to reload that page from disk. If you are editing the pages on disk, you will either have to turn off Velocity's caching temporarily in `WEB-INF/classes/velocity.properties`, or restart the server to make your changes visible.

The `velocity.properties` file is available in the `confluence-x.x.x.jar` file, where `x.x.x` is the Confluence version number. The JAR file is located in the `WEB-INF/lib` directory. If you wish to make modification to the files in the JAR, we recommend the following steps:

1. Stop Confluence.
2. Make a backup copy of the JAR file.
3. Un-jar the file.
4. Locate and edit the appropriate file that you wish to modify.
5. Re-jar the `confluence-x.x.x.jar` file.
6. Relocate the JAR file to the appropriate directory.
7. Restart Confluence.

**RELATED TOPICS**

Customising Site and Space Layouts

**Working With Decorator Macros**

Decorator Macros are **Velocity** macros which are used to draw complex or variable parts of the page such as menus and breadcrumbs when editing **Custom decorators**. Decorator macros can be inserted anywhere in your templates.

The macro is called by inserting a string of the form: `#macroName("argument1" "argument2" "argument3")`. There are no commas between the arguments. Unless otherwise noted, these macros take no arguments.

**NOTE:** These macros will only work reliably when customising `main.vmd`. They may not work in other Velocity decorators. Decorator macros will not work inside normal confluence pages.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>#breadcrumbs()</code></td>
<td>Draws the &quot;You are here&quot; breadcrumbs list, like the one found above the page name in the default template.</td>
</tr>
<tr>
<td>Macro</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>#includePage(pageTitle)</code></td>
<td>Includes a confluence page with the specified title. If you have 2 or more pages with the same title across multiple spaces, this macro will include the page belonging to the space you are currently viewing.</td>
</tr>
<tr>
<td><code>#searchbox()</code></td>
<td>Inserts a search box into the page, like the one to the far right of the breadcrumbs in the default template.</td>
</tr>
<tr>
<td><code>#globalnavbar(type)</code></td>
<td>Draws the global navigation bar, as found in the top right-hand corner of the default template. The navigation bar can be displayed in two modes:</td>
</tr>
<tr>
<td><code>#globalnavbar(&quot;table&quot;)</code></td>
<td>Displays the navigation bar in its default mode: drawn as a table of links with coloured backgrounds and mouse-over effects.</td>
</tr>
<tr>
<td><code>#globalnavbar(&quot;text&quot;)</code></td>
<td>Displays the navigation bar as series of text links separated by</td>
</tr>
<tr>
<td><code>#usernavbar()</code></td>
<td>Draws the user-specific navigation-bar. This bar contains the links to the user's profile and history, or to the login and signup pages if the user is not logged in.</td>
</tr>
<tr>
<td><code>#helpicon()</code></td>
<td>Draws the help icon, and link to the Confluence help page.</td>
</tr>
<tr>
<td><code>#printableicon()</code></td>
<td>On pages where a printable version is available, draws the printable page icon, linking to the printable version of the page. Otherwise, draws nothing.</td>
</tr>
<tr>
<td><code>#pagetitle(class)</code></td>
<td>When you are viewing a page in a Confluence space, draws the name of the space that page is in. Otherwise, writes the word &quot;CONFLUENCE&quot;. The &quot;class&quot; argument is the CSS class that the title should be drawn in. Unless you have customised your Confluence installation's CSS file, you should call this with &quot;spacenametitle&quot; as the class: <code>#pagetitle(&quot;spacenametitle&quot;)</code></td>
</tr>
<tr>
<td><code>#poweredby()</code></td>
<td>Writes out the &quot;Powered by Confluence&quot; and Confluence version-number boilerplate found at the bottom of the default template.</td>
</tr>
<tr>
<td><code>#bottomshadow()</code></td>
<td>Draws the fading shadow-effect found at the bottom of the content area in the default template.</td>
</tr>
<tr>
<td><code>#dashboardlink()</code></td>
<td>Inserts a link to the dashboard page.</td>
</tr>
</tbody>
</table>

**RELATED TOPICS**

**Content by label**

There is no content with the specified labels

**Custom Decorator Templates**

**About Decorators**

Confluence is built on top of the Open Source SiteMesh library, a web-page layout system that provides a consistent look and feel across a site. SiteMesh works through "decorators" that define a page's layout and structure, and into which the specific content of the page is placed. If you are interested, you can read more on the SiteMesh website.
What this means for Confluence is that you can customise the look and feel of parts of your Confluence site through editing decorators, for example:

- The "Main" decorator defines the generic header and footer
- The "Page" decorator defines how a page is displayed
- The "Printable" decorator defines the look and feel of the printable versions of pages.

You can view and edit these decorators from within Confluence. Changes to the decorators will affect all spaces in that Confluence installation.

The decorator that is used to draw Confluence's administrative pages cannot be edited from within Confluence. This means that if you make a mistake that renders the rest of the site unusable, the administrative pages should still be available for you to fix the template.

**Browsing the Default Decorators**

At any time, you can browse the default decorators that come packaged with Confluence by following the "View Default" links on the "Site Layouts" page. The template browser also allows you to view the "#parsed" templates that are included within the template when it is compiled. While you can't edit these included templates, you will probably have to copy some or all of them into your custom template as you do your customisation.

**Editing Custom Decorators**

To edit Confluence decorators you will need a good knowledge of HTML, and some understanding of the Velocity templating language.

To edit a decorator:

1. Go to **Confluence Admin > Layouts**.
2. Choose **Create Custom** beside the decorator you wish to edit.
3. Save your changes.

If you make a mistake or want to undo your changes, choose **Reset Default** beside the edited decorator.

Alternatively, the custom templates are stored in the DECORATOR table in the database. If you have somehow managed to render Confluence completely unusable through editing your templates, delete the relevant entries from the DECORATOR table.

**Macros**

Some parts of the page are drawn using Velocity macros, including the navigation bar. The macros you should know about when editing decorators are described in **Working With Decorator Macros**.

**For Advanced Users**

The `velocity` directory is at the front of Confluence's velocity template search path. As such, you can override any of Confluence's velocity templates by placing an identically named file in the right place.

While we don't recommend you do this, it does give you complete control over the look of every aspect of Confluence. It also means that you can edit your templates in a text-editor if you wish, rather than through your browser.

There are, however, two important caveats:

1. Velocity is configured to cache templates in memory. When you edit a page from within Confluence, it knows to reload that page from disk. If you are editing the pages on disk, you will either have to turn off velocity's caching temporarily in WEB-INF/classes/velocity.properties, or restart the server to make your changes visible.
2. Changes may interact unpredictably with future versions of Confluence. When upgrading, you should always test your custom modifications thoroughly before deploying them on a live site.

**Customising a Specific Page**

If you'd like to change the appearance of a specific page, you can modify the corresponding Velocity template. Here's how to find out which one:

1. Access the page. Note the name of the action. For example, the "Contact Administrators" page is `<baseUrl>/administrators.action`.
To change the login page:

1. Shut down your Confluence server.
2. In the Confluence installation directory, find the file `confluence/login.vm`.
3. Make a copy of this file as a backup.
4. Edit the file with a text editor to make the required changes. The content contains a mixture of HTML and Velocity. See Velocity Template Overview (in our developer documentation).
5. Start Confluence and test your changes.

The same process can be applied to modify most of the templates in the Confluence web application. Be careful to test your changes before applying them to a live site. The templates contain code that is vital for Confluence to function, and it is easy to accidentally make a change that prevents use of your site.

Modify Confluence Interface Text

All Confluence UI text is contained in a single Java properties file. This file can be modified to change the default text, and also to translate Confluence into languages other than English.

The UI text file is `ConfluenceActionSupport.properties`. From your Confluence install directory:
Replace "x.x.x" with your Confluence version, for example for 4.3.2, it will be named "confluence-4.3.2.jar". Within this File, the relevant file to edit is :
\com\atlassian\confluence\core\ConfluenceActionSupport.properties.

Refer to Editing jar files for reference.

The file contains parameters with name=value pairs, in the format:

```
parameter.name=Parameter value
```

Parameter names are any text before the '=' character and should never be modified. Any text after the '=' character is the parameter value, which can be modified freely and can also contain variables. An example involving variables is:

```
popular.labels=The three most popular labels are {0}, {1} and {2}.
```

For more information on replacing values, check out Translating ConfluenceActionSupport Content. Note that plugins store their text internally, so you must modify plugin text individually.

Steps For Modification

1. Stop Confluence
2. Under your install directory, open \confluence\WEB-INF\lib\confluence-x.x.x.jar\com\atlassian\confluence\core\ConfluenceActionSupport.properties
3. Search for the text you wish to modify, replace it and save the file in <Confluence-Install>\confluence\WEB-INF\classes\com\atlassian\confluence\core. Please create this folder structure, if it does not exist already.

If you re-bundle the JAR file, rather than re-deploy the class in the WEB-INF\classes directory, make sure to move the backup JAR file out of the /lib directory, or the backup may be deployed by mistake.

4. Restart Confluence

Common Modifications

- Rename 'Dashboard' by searching for Dashboard. To change "Dashboard" to "My Portal", change dashboard.name=Dashboard to dashboard.name=My Portal

<table>
<thead>
<tr>
<th>Task</th>
<th>Search For</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename 'Dashboard'</td>
<td>Dashboard</td>
<td>The dashboard.name parameter has the name. To change 'Dashboard' to 'My Portal', change dashboard.name=Dashboard to dashboard.name=My Portal and update any other occurrences of the word 'Dashboard' in the instance</td>
</tr>
<tr>
<td>Modify login page text</td>
<td>login.</td>
<td>The login.instructions parameter has the &quot;Enter your account details below to login to Confluence&quot; text</td>
</tr>
</tbody>
</table>
Modify Keyboard Shortcuts

Confluence provides a set of keyboard shortcuts. You could customise the shortcuts by making modifications inside the ConfluenceActionSupport.properties file.

- To disable a particular shortcut, you can simply just comment out a respective line of code. One may like to disable the shortcut to one of the navigation links: View, Edit, Attachments, Info. For instance, to disable shortcut to Attachments one would comment out the following line:

```
#navlink.attachments.accesskey=a
```

- To modify an access key, one could simply just change the letter, bearing in mind the fact that the letter must be unique.

Customising the eMail Templates

Customising the Confluence email templates is not supported. If you do decide to edit the templates we strongly recommend you use a test instance of Confluence.

Any customisations you make to the Confluence email notification templates will need to be reapplied after upgrading Confluence.

Email notification templates are contained within the confluence-email-notifications plugin, which is a bundled plugin (add-on) that is installed automatically when you install Confluence.

Only administrators with access to the Confluence installation directory can modify the Confluence email templates.

Confluence uses Soy templates (also known as Closure templates) for email notifications. You can find out more in the Google Developer docs or see our developer tutorial which contains a short introduction to using Soy templates.

To change the email notification templates:

1. In the Confluence web application folder, find the file /confluence/WEB-INF/atlassian-bundled-plugins/confluence-email-notifications-plugin-x.x.jar

   Note: This plugin is independently versioned, the version number will not necessarily match Confluence's version number.

2. Copy this file to a working location and extract the jar file. Find out more about how to edit files within .jar archives.

3. Within the jar file, templates are stored in the /templates/ folder. Edit the Soy templates to make your changes.

4. Zip all the files and change the file extension to .jar (or refer to the guide on editing files within .jar archives for other methods).

5. In your Confluence test instance go to > Add-ons and upload your new jar file.

6. Test your changes carefully before installing the updated plugin in production.

We strongly recommend you use a test instance for editing the templates contained within the plugin. If you are unable to enable the plugin, check the Confluence logs for information, it may be that there are problems with your edits to the Soy templates.

RELATED TOPICS

- Customising Site and Space Layouts
- Changing the Look and Feel of Confluence
- Modify Confluence Interface Text

Changing the Default Behaviour and Content in Confluence

Confluence comes with some handy default settings that determine what people see when they first enter the Confluence site, and the default content that is put into new spaces and other areas of Confluence.

Confluence administrators can change the settings to customise the behaviour and the default content of their Confluence site:

- Administering Site Templates
1. Importing Templates
2. Changing the Site Title
3. Choosing a Default Language
4. Configuring the Administrator Contact Page
5. Configuring the Site Home Page
6. Configuring the What's New Dialog
7. Customising Default Space Content
8. Customising the Getting Started Guide on the Dashboard
9. Editing the Site Welcome Message

Related pages:
- Changing the Look and Feel of Confluence
- Customising your Confluence Site
- Confluence Administrator's Guide

Administering Site Templates

A template is a predefined page that can be used as a prototype when creating new pages. Templates can be created by users, or provided by a blueprints. See Working with Templates and Working with Blueprints.

Administrators can import templates, to make them available to other people using Confluence. See Importing Templates.

Confluence also provides 'system templates' which contain default content for the site welcome message (see Editing the Site Welcome Message) and default space content (see Customising Default Space Content).

Administrators can also disable templates and blueprints, to stop them appearing in the Create and Create Space dialogs anywhere in their Confluence site.

To disable a template or blueprint across the entire Confluence site:

- Choose the cog icon, then choose General Configuration under Confluence Administration.
- Choose Global Templates and Blueprints.
- Choose Disable next to the template, page blueprint or space blueprint you wish to disable.

Administrators can re-enable these templates and blueprints at any time.

Importing Templates

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format.

You can create your own templates within Confluence. See Adding a Template.

In addition, you can download pre-defined templates from the Atlassian Marketplace in the form of a template bundle. Each template bundle contains one or more templates, created by Atlassian or third parties. Here is a summary of the steps required:

- Download the template bundle from the Atlassian Marketplace.
- Install the template bundle into your Confluence site.
- Make the templates available by importing them into the site or into an individual space.

You need 'System Administrator' permission to install template bundles into your Confluence site. You need 'Confluence Administrator' permission to manage the existing template bundles on your Confluence site. See Global Permissions Overview.

**Step 1. Check the template bundles installed on your Confluence site**

To see the template bundles that are currently available for import on your Confluence site:

1. Log in to Confluence as a System Administrator or Confluence Administrator.
2. Choose the cog icon, then choose General Configuration under Confluence Administration.
3. Choose Import Templates in the left-hand panel. You will see a list of the template bundles installed on your Confluence site, and the templates included in each bundle.
Step 2. (Optional) Download and install additional template bundles from the Atlassian Marketplace

Follow the steps below if you want to add more template bundles to your site.

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

To upload more templates:

1. Go to the Atlassian Marketplace and download the template bundle that you need. It will be in the form of a JAR file. Save the JAR file somewhere in your file system.
2. Log in to Confluence as a System Administrator.
3. Choose the cog icon, then choose General Configuration under Confluence Administration.
4. Choose Manage Add-ons in the left-hand panel.
5. Choose Upload Add-on.
6. Browse to find the template bundle that you downloaded, and upload it to Confluence. The template bundle will appear in the list under 'User-installed Add-ons'.

Step 3. Import the templates to make them available to users

You now have one or more template bundles on your site. The templates are not available until you have 'imported' them.

To import a template:

1. Log in to Confluence as a System Administrator or Confluence Administrator.
2. Choose the cog icon, then choose General Configuration under Confluence Administration.
3. Choose Import Templates in the left-hand panel. You will see the template bundles installed on your Confluence site and the templates included in each bundle.
   Note: You can see a preview of the template by choosing the template name.
4. Select the templates to be imported by ticking the check boxes next to the relevant template names.
5. Choose the import destination for the templates in the Import To dropdown menu. If you want the templates to be available to only a specific space, choose the name of the space, otherwise choose Global Templates to make the templates available to all spaces.
6. Choose Import.

Screenshot: Importing a template
**Import Templates**

The following template package plugins were found. To import templates, tick the checkboxes for the desired templates, select where to import the templates to, and click the import button.

**Human Resources Templates (8)**

<table>
<thead>
<tr>
<th>Check All</th>
<th>Uncheck All</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOW-TO Guide</td>
<td></td>
</tr>
<tr>
<td>Induction Tasks</td>
<td></td>
</tr>
<tr>
<td>Job Description</td>
<td></td>
</tr>
<tr>
<td>Meeting Minutes</td>
<td></td>
</tr>
<tr>
<td>Recruitment Dashboard</td>
<td></td>
</tr>
<tr>
<td>Space Home Page</td>
<td></td>
</tr>
<tr>
<td>Time Sheet</td>
<td></td>
</tr>
<tr>
<td>Wiki Induction</td>
<td></td>
</tr>
</tbody>
</table>

**Import To:** Global Templates

- Global Templates
- Spaces
  - Demonstration Space
  - Documentation

**Notes**

- **Building your own template bundles.** You can build a template bundle as an add-on (also called a 'plugin') and then upload it to your Confluence site. You can then import the templates from your custom template bundle, as described above. You will need some programming knowledge to develop a template bundle. See Creating A Template Bundle.

- **Duplicate template names.** If a template with the same name already exists on import, a duplicate template of the same name will be created. You will need to check the templates and rename them manually.

- **Removing the template.** Removing the add-on that contains a template will not remove the template from your Confluence site if you have already imported it. You will need to remove the template manually via the administration console or space administration screen.

**Changing the Site Title**

The site title appears in your browser's title bar. By default, it is set to 'Confluence'.

**To change the title of your Confluence site:**

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose 'General Configuration' in the left-hand panel.
3. Choose 'Edit' at the top of the 'Site Configuration' screen.
4. Enter a new title for your site in the input field next to 'Site Title'.
5. Choose 'Save'.

**Related pages:**

- Changing the Site Logo
- Editing the Site Welcome Message
- Customising your Confluence Site
- Confluence Administrator's Guide

**Choosing a Default Language**
Administrators can define a default language to be applied to all spaces in your Confluence site. Note that individual users can select a language preference for their session.

**Related pages:**
- Editing User Settings
- Recognised System Properties
- Configuring Indexing Language
- Installing a Language Pack

---

### Setting the Default Language

To change the default language for the Confluence site:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Select 'Languages' in the 'Configuration' section of the left-hand panel.
3. The 'Language Configuration' screen will appear. Select the language that you want to use as the default language for your Confluence site.

### Other Settings that Affect the Language

Individual users can choose the language that Confluence will use to display screen text and messages. Note that the list of supported languages depends on the language packs installed on your Confluence site.

The language used for your session will depend on the settings below, in the following order of priority from highest to lowest:

- The language preference defined in your user profile. Note that you need to be logged in for this setting to take effect.
- The language that you choose by clicking an option at the bottom of the Confluence login screen. Confluence stores this value in a cookie. When the cookie expires, the setting will expire too.
- The language set in your browser. The browser sends a header with a prioritised list of languages. Confluence will use the first supported language in that list. Your Confluence administrator can disable this option by setting a system property.
- The default language for your site, as defined by your Confluence site administrator.

### Showing User Interface Key Names for Translation

This feature is useful if you are working on creating translations of the Confluence user interface. After opening the Confluence dashboard, you can add this text to the end of your Confluence URL:

```
?i18ntranslate=on
```

Then press Enter.

This will cause each element of the user interface to display its special key name. This makes it easier to find the context for each key within the user interface. You can then search for the key on [http://translations.atlassian.com](http://translations.atlassian.com) where you can enter an appropriate translation for your custom language pack.

The key names are displayed with a 'lightning bolt' graphic. For example:

```
Dashboard\title.dashboard
```

To turn off the translation view, add this code to the end of the Confluence URL:

```
?i18ntranslate=off
```

### Configuring the Administrator Contact Page
The administrator contact page is a form that allows a user of Confluence to send a message to the administrators of their Confluence site. (In this context, administrators are the members of the default administrators group.) See the explanation of site administrators.

The title of the administrator contact page is 'Contact Site Administrators'. Typically, Confluence users may get to this page by clicking a link on an error screen such as the '500 error' page.

**Customising the Administrator Contact Message**

You can customise the message that is presented to the user on the 'Contact Site Administrators' page.

**To edit the administrator contact message:**

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit at the top of the 'Site Configuration' section.
4. Enter your text in the Custom Contact Administrators Message box. You can enter any text or Confluence wiki markup.
5. Choose Save.

**On this page:**
- Customising the Administrator Contact Message
- Disabling the Administrator Contact Form
- Configuring Spam Prevention

**Related pages:**
- Contacting Confluence Administrators
- Configuring Captcha for Spam Prevention

**The Default Administrator Contact Message**

By default, the 'contact administrators message' looks much like the highlighted area in the screenshot below, starting with 'Please enter information...'.

**Screenshot: The default 'Contact Site Administrators' message**

```
Contact Site Administrators

Please enter information about your request for the site administrators. If you are reporting an error please be sure you include information on what you were doing and the time the problem occurred.

To: Confluence Administrators
From: user@email.com
Subject: Administrator Request
Request Details:
```

To restore the message to its default simply remove the custom message you entered when following the instructions above, so that the 'Custom Contact Administrators Message' field is empty.

**Disabling the Administrator Contact Form**

If you prefer to disable the ability for users to send an email message to the site administrators, you can disable the form portion of this screen. You can only disable the form if you first provide a 'Custom Contact
Administrators Message' as described above.

To enable or disable the administrator contact form:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit at the top of the 'Site Configuration' section.
4. Select on or off for the 'Contact Administrators Form'.
5. Choose Save.

Configuring Spam Prevention

You can configure Confluence to use Captcha to help prevent spam, including the spamming of Confluence administrators. The administrator contact form is covered by the site-wide Captcha settings as documented in Configuring Captcha for Spam Prevention.

Configuring the Site Home Page

You can configure Confluence to send people to any space home page when they log in or click the site logo, rather than to the dashboard.

The spaces available to set as the site home page will depend on the access permissions of the space and the site.

- The site home page must be accessible to the 'confluence-users' or 'users' group.
- If the site allows anonymous access, the site home page must also be accessible to anonymous users, that is, people who have not logged in to Confluence.

To configure the site-wide home page:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Further Configuration in the left-hand panel.
3. Choose Edit.
4. Select a space from the Site Homepage dropdown menu.
   When users log in or click the site logo, Confluence will go to the home page of the space you choose here.
5. Choose Save.

Related pages:

- Editing the Site Welcome Message
- Changing the Site Title
- Customising Default Space Content
- Changing the Site Logo
- Confluence Administrator’s Guide

Accessing the dashboard with a site homepage set

If you choose to set a space homepage as your site homepage but would like your users to still be able to access the Confluence dashboard, you can add a link to the Application Navigator.

To add the Confluence Dashboard to the Application Navigator:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Application Navigator.
3. Enter the name for your link, for example, 'Dashboard'.
4. Enter the URL for your site dashboard, for example, https://yoursite.com/wiki/dashboard.action.
5. Choose Add.

A link to the dashboard will now appear in the Application Navigator.
Notes

- The user's personal settings will override the global setting.
- If you allow anonymous access to the dashboard, but not anonymous access to the site home page, then when logging on to the site, users will be redirected to the original dashboard instead of the site home page. To avoid this, either make the site home page accessible anonymously, or make the dashboard not accessible anonymously.

Configuring the What's New Dialog

The 'What's New' dialog pops up automatically when a user logs in for the first time after a major Confluence upgrade. The dialog displays a summary of the new features for the release, sourced from the Atlassian website (by default).

Confluence administrators can configure the behaviour of the 'What's New' dialog, as follows:

- Change the URL that the 'What's New' dialog retrieves information from.
- Disable the dialog.

On this page:
- Changing the 'What's New' Dialog URL
- Disabling the 'What's New' Dialog

Related pages:
- Disabling and enabling add-ons
Changing the 'What's New' Dialog URL

The 'What's New' dialog URL is stored in your Confluence help-paths.properties file. This URL is a concatenation of the help.prefix property with the help.whats.new.iframe.link.

**Note:** The help.prefix property also defines the base URL for Confluence help links, i.e. help links in the Confluence application.

**To change the 'What's New' Dialog URL:**

Follow the instructions in the 'Changing the Links for Individual Help Pages' section on Local Confluence Documentation. You will need to update the 'help.prefix' and 'help.whats.new.iframe.link' properties, as desired.

For example, you may have installed your Confluence documentation behind a firewall at http://www.example.com/ and created a page http://www.example.com/whatsnew that you use for change management. In this case, you would do the following:

- Set help.prefix to http://www.example.com/
- Set help.whats.new.iframe.link to whatsnew

There is an additional property 'help.whats.new.full.link'. This is only used if the content pointed to by the updated URL isn't loaded in 10 seconds, in which case a 'timeout' screen is displayed with a link to the full 'What's New' content. For locally-hosted pages you can just set this property to the same value as help.whats.new.iframe.link.

Disabling the 'What's New' Dialog

The 'What's New' dialogue is enabled via a plugin. To disable the 'What's New' dialogue, you need to disable the 'Confluence What's New' plugin in Confluence.

**To disable the 'Confluence What's New' plugin:**

Follow the instructions on Disabling and enabling add-ons. Please note, the 'Confluence What's New' plugin is a 'System Plugin'. Click 'Show System Plugins' on the Manage Add-ons administration page to display the system plugins.

Customising Default Space Content

Confluence Administrators can edit the template that is used to create the home page for new sites. This default content appears on the home page when a new space is created. There is a different template for site spaces, personal spaces and space blueprints.

The default content in the template only appears for new spaces (those that are created after you have defined the content). Changes to the template do not affect existing home pages.

**Edit the default home page for a blank space**

To edit the default (blank) space content template:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Global Templates and Blueprints in the left-hand panel.
3. Choose Edit next to 'Default Space Content' or 'Default Personal Space Content' depending on whether you want to customise the content for new site space or personal space home pages.
4. Enter the content that you want to appear on the home page for new blank spaces. you can add variables, macros and other content in the saw way as edited a page template.
5. Choose Save.

**On this page:**

- Edit the default home page for a blank space
- Reset the original default content

**Related pages:**

- Working with Spaces
- Working with Templates
- Confluence Administrator's Guide
The following variables are available to be added to the default space content templates.

- `$spaceKey` - inserts the space key into the site space homepage
- `$spaceName` - inserts the space name into the site space homepage
- `$userFullName` - inserts the user (owner of the personal space) into the personal space homepage
- `$userEmail` - inserts the email address of the user (owner of the personal space) into the personal space homepage.

Default space templates differ from ordinary page templates in that they do not present the user with a form to complete, so variables should be limited to those listed in the **Variables** menu.

Some macros, such as the Table of Contents macro, may not display correctly when you preview the template as they are designed to work on a page. The macros will display correctly on the home page when you create a new space. For more information on editing a template, including adding macros see - [Adding Content to a Template](#).

**Reset the original default content**

**To reset the original default content:**

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Choose **Global Templates and Blueprints** in the left-hand panel.
3. Choose **Reset to default** next to the template you wish to reset.

From this point on, all new space home pages will be created with the original default content.

**Customising the Getting Started Guide on the Dashboard**

By default, the Confluence dashboard displays a quick-start guide for administrators under the site welcome message on the left. This section of the dashboard is visible to Confluence administrators and system administrators only. It is not configurable via the web interface, but you can update or remove it by editing the site layout as described below.

You need **System Administrator** permissions to perform this customisation.

**Editing or removing the getting-started section**

**To customise the getting-started guide on the dashboard:**

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Choose **Layouts** in the left-hand panel.
3. Choose **Create custom** (or **Edit**) next to **Global Layout**.

   **Note:** If the global layout has already been customised, the ‘Edit’ option will be available. Otherwise, you will need to create the custom layout now, by choosing ‘Create custom’.
4. Find the following code:
5. Update the code as required:
   - To remove the 'get started' section, delete the entire block of text shown above.
   - Alternatively, edit the code to suit your requirements. See Customising Site and Space Layouts for guidelines.

6. Choose Save.

The default getting-started section

By default, the getting-started guide looks more or less like the screenshot below, starting with the heading 'Get started'.

To restore the default getting-started guide:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Layouts in the left-hand panel.
3. Choose Reset Default next to Global Layout.
   Note: This will reset any other customisations applied to this layout too.

On this page:
- Editing or removing the getting-started section
- The default getting-started section
- Notes

Related pages:
- Customising Site and Space Layouts
- Editing the Site Welcome Message
- Configuring the Site Home Page
- Changing the Site Title
- Changing the Site Logo
- Confluence Administrator's Guide
The information on this page does not apply to Confluence Cloud.

Screenshot: The getting-started guide on the dashboard

Dashboard

Welcome to Confluence

Confluence is where your team collaborates and shares knowledge — create, share and discuss your files, ideas, minutes, specs, mockups, diagrams, and projects.

Get started

Create a new space
and start creating content.

Invite your colleagues
to join you in Confluence.

Upload your picture
and edit your profile.

Notes

If you modify the look and feel of Confluence by following these instructions, you will need to update your customisations when upgrading Confluence. The more dramatic the customisations are, the harder it will be to reapply your changes when upgrading. Please take this into account before proceeding with your customisation. For more information on updating your customisations, please refer to Upgrading Customised Site and Space Layouts.

Editing the Site Welcome Message

The site welcome message appears at the top left of the Confluence dashboard. You can change the default message by editing the appropriate system template. For example, you may want the welcome message to display an introduction to your site or a message of the day.

To edit the site welcome message:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Global Templates and Blueprints in the left-hand panel.
3. Choose Edit next to Default Welcome Message.
4. Type your message into the template editor.
5. Choose Save.

The default site welcome message

By default, the site welcome message looks more or less like the screenshot below, starting with the heading 'Welcome to Confluence' and ending with '...diagrams, and projects'.

To restore the default site welcome message:
1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Global Templates and Blueprints in the left-hand panel.
3. Choose Reset to default next to Default Welcome Message.

On this page:
- The default site welcome message
- Using the template editor
- Including content from another page

Related pages:
- Configuring the Site Home Page
- Changing the Site Title
- Changing the Site Logo
- Customising Default Space Content
- Confluence Administrator's Guide

Using the template editor

Enter text into the body of the template, and use the editor toolbar to apply styles, layout and formatting. You can add links and macros. In general, you can use the Confluence editor in the same way as on a page.

Notes:
- You cannot use template variables in the welcome message template.
- You can't attach an image or other file to a template. Instead, attach the file to another page, and insert it into the body of the template.

    For example:
    - You can attach an image to a page and then choose Insert > Image to embed the image into the template.
    - You can attach a PDF to a page and then choose Insert > Other Macros > PDF to embed the PDF into the template.

Including content from another page

It may be useful to write your welcome message on a normal Confluence page and include the page into the welcome message template. Using a normal page means that you can allow other people, who are not Confluence administrators, to change the welcome message.

To include content from another page:

1. Create a Confluence page as usual and add your welcome message as the page content. Remember to limit the size of the content, because it must fit nicely onto the dashboard. For this example, let's assume the title of your page is 'Dashboard Message'. You can put it in any space you like.
2. Add page restrictions or space permissions to the 'Dashboard Message' page or space, to suit your requirements. You may want to restrict the editing of the page to a group of people, or you may want to
allow any employee to edit the page. This will determine who can update the welcome message on the dashboard.

3. Edit the welcome message template, and add the Include Page macro to display the content from your 'Dashboard Message' page.

4. Save the welcome message template. The dashboard will display the content of the template immediately, including the content of your 'Dashboard Message' page. Similarly, if you or anyone else edits the page, the welcome message on the dashboard will change as soon as the page is saved.

Integrating Confluence with Other Applications

You can integrate Confluence with other applications using Application Links. The Application Links feature allows you to link Confluence to applications like JIRA. Linking two applications allows you to share information and access one application's functions from within the other. For example, you could use the JIRA Issues Macro to display JIRA issues on a Confluence page.

Related Topics

- Linking to Another Application
- Configuring Workbox Notifications
- Integrating JIRA and Confluence
- Registering External Gadgets
- Configuring the Office Connector

Linking to Another Application

Application Links (sometimes called "AppLinks") is a bundled plugin that allows you to link Atlassian applications to each other. Linking two applications allows you to share information and access one application's functions and resources from within the other.

Linking Confluence to other applications allows you to include information from those applications in pages or blogs that you create in Confluence. For example, you could link Confluence to your JIRA server and view JIRA issues in a Confluence page using the JIRA Issues Macro.

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Application Links in the left-hand panel. The Application Links configuration page appears and lists any links you already have set up.
3. In the Application URL box, supply the URL of the application you want to link to and then select Create new link.
4. Use the wizard to finish configuring the link. If the application you are linking to does not have the Application Links plugin, you must supply additional information so the link can be set up. This information is required to set up a link with OAuth authentication.

When you complete the wizard, the Application Links plugin will create the link between your applications using the most secure authentication method that is supported between the two application types. After the link has been set up, it will appear on the "Configure Application Links" page. You can use this page to change the configuration of application links to make them more secure or to change the link settings:

- To edit the settings of the application link (for example, to change the authentication type of the link), select Edit.
- If you've set up multiple links to the same type of application (for example, multiple JIRA servers), you can use the Make Primary link to specify which application is the default instance. See Making a Primary Link for Links to the Same Application Type for more information.
- After you've linked applications, you also connect the areas of those applications that contain information relating to your project or team (for example, you can connect a project's Confluence space with a JIRA project). These types of links are called project links.

Configuring Workbox Notifications

People can view and manage in-app notifications and tasks in their Confluence workbox. This page tells you how to enable in-app notifications and configure some related settings.

In addition, people can receive notifications from JIRA and other Confluence servers in their
Confluence workbox. To make this possible, your Confluence server must be linked to the other server(s) via application links.

Possible configurations:

- Your Confluence server provides in-app notifications and displays them in its own workbox. There are two sub-configurations here:
  - This Confluence server is the only server involved.
  - Alternatively, this Confluence server displays its own in-app notifications, and also displays notifications from JIRA and/or other Confluence servers.
- Your Confluence server does not provide or display in-app notifications.
- Your Confluence server sends in-app notifications to another Confluence server.

Notes:

- **Workbox includes notifications and tasks**: When you enable in-app notifications, personal tasks are also enabled in the workbox. When you disable in-app notifications, the workbox no longer appears and personal tasks are therefore not available on this server.

Which notifications are included?

The workbox displays a notification when someone does one of the following in Confluence:

- Shares a page or blog post with you.
- Mentions you in a page, blog post, comment or task.
- Comments on a page or blog post that you are watching.
- Likes a page or blog post that you are watching.

The workbox does not show notifications triggered because you are watching a space. Only watches on pages and blog posts are relevant here.

The notification in your workbox appears as 'read' if you have already viewed the page or blog post.

If your Confluence site is linked to JIRA, you will also see the following JIRA notifications in your workbox:

- Comments on issues that you are watching.
- Mentions.
- Shares of issues, filters and searches.

Enabling Confluence workbox and in-app notifications

Confluence workbox and in-app notifications are disabled by default.

**To enable workbox and in-app notifications:**

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose In-app Notifications in the left-hand panel.
3. Choose displays in-app notifications (or displays in-app notifications from other servers). The workbox icon will appear in the Confluence top menu bar and will be visible to all users.

Screenshot: Simple configuration with Confluence workbox and in-app notifications enabled for this server only
Configuring the polling intervals

The polling intervals are used by the Confluence server that displays in-app notifications and tasks in its workbox.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active polling interval</td>
<td>This is the number of seconds that Confluence will wait before checking (polling) for new notifications relevant to the page that the user is currently viewing. This setting applies to the page open in the browser tab that currently has focus. It does not matter whether the user has the workbox open or not.</td>
</tr>
<tr>
<td>Inactive polling interval</td>
<td>This is the number of seconds that Confluence will wait before checking (polling) for new notifications relevant to all pages that are not currently in focus. These pages may be on the Confluence server that displays the workbox, or on other Confluence or JIRA servers that send their notifications to this server. This setting defines an upper limit. For inactive pages, Confluence starts with a polling interval equal to the active polling interval, then gradually increases the interval between polls until it reaches the limit defined here.</td>
</tr>
</tbody>
</table>

Including notifications from JIRA

Confluence workbox can include notifications from your JIRA issue tracker. In Confluence Cloud, you can do this if you have JIRA Cloud too.

**To include notifications from JIRA:**

JIRA and Confluence must be connected via an application link to do this. See [Linking to Another Application](#).

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose In-app Notifications in the left-hand panel of the Confluence administration console.
3. Choose displays in-app notifications from other servers.

   - Your JIRA server will appear in the list of linked applications below this option.
   - People will see JIRA notifications in their workbox, as described in [Managing Notifications in Confluence](#).

**Notes:**

- JIRA sends its notifications to the Confluence server that is configured as the primary application link.
- Your JIRA server must be running JIRA 5.2 or later.
- The following plugins must be present and enabled in JIRA. The plugins are shipped with JIRA 5.2 and later:
  - "Workbox – Common Plugin"
'Workbox – JIRA Provider Plugin'
- You do not need to configure JIRA. The plugins are enabled by default in JIRA, and JIRA will automatically send notifications to Confluence.
- Confluence can display notifications from more than one server.

Screenshot: This Confluence server displays in-app notifications from itself and from JIRA

Stopping JIRA from sending notifications to Confluence

You may wish to configure Confluence to display its own notifications in its workbox, but prevent notifications from JIRA from appearing in the workbox, even when JIRA and Confluence are linked via application links.

The JIRA administration interface does not offer a way of disabling notifications sent to Confluence.

To stop JIRA from sending notifications to Confluence: Disable the following plugins in JIRA. (See the Universal Plugin Manager guide to disabling plugins.)
- 'Workbox – Common Plugin'
- 'Workbox – JIRA Provider Plugin'

Including notifications from another Confluence server

Confluence workbox can include notifications from another Confluence server.

Let's assume that you have two Confluence servers, ConfluenceChatty and ConfluenceQuiet. Let's also assume that you want ConfluenceChatty to display a workbox, and to include notifications from ConfluenceQuiet.

To include notifications from other Confluence servers:

1. Connect ConfluenceChatty and ConfluenceQuiet via application links. In ConfluenceChatty:
   - Choose the cog icon, then choose General Configuration under Confluence Administration.
   - Choose Application Links in the left-hand panel.
   - Set up the link as described in Linking to Another Application.

2. Configure the notification settings in ConfluenceChatty:
   - Choose In-app Notifications in the left-hand panel of the Confluence administration console.
   - Choose displays in-app notifications from other servers.

3. Configure the notification settings in ConfluenceQuiet:
   - Choose In-app Notifications in the left-hand panel of the Confluence administration console.
   - Choose sends in-app notifications to another server.
   - Select the Confluence server that will display the workbox – in our example, this is Confluence.
Notes:

- Your Confluence servers must be running Confluence 4.3.3 or later.
- Confluence can display notifications from more than one server.
- Confluence can send notifications to only one server.
- Only one of the linked Confluence servers can display the in-app notifications.

Screenshot: This Confluence server displays in-app notifications from itself, from JIRA, and from another Confluence server

Sending Confluence notifications to another Confluence server

You can configure Confluence to send all notifications to a different Confluence server. In this case, the current Confluence server will not display the workbox.

To send notifications to another Confluence server: Follow the instructions in our example for ConfluenceChatty above.

Screenshot: This Confluence server sends its in-app notifications to another Confluence server
Disabling workbox and in-app notifications in Confluence

If you choose **does not provide in-app notifications**:

- The Confluence workbox icon will no longer be visible and people will be unable to access their workboxes on this server.
- This Confluence server will no longer send notifications to its workbox, and will not send notifications to any other Confluence server.

**Integrating JIRA and Confluence**

Please refer to the guide to [Installing Confluence and JIRA Together](#).

**JIRA** and **Confluence** are designed to complement each other. Collect your team’s thoughts, plans and knowledge in Confluence, track your issues in JIRA, and let the two applications work together to help you get your job done.

Below are some ways you can get JIRA and Confluence working together.

**Setting Up Trusted Communication between JIRA and Confluence**

An administrator can configure JIRA (3.12.0 or later) and Confluence to communicate in a trusted way, so that Confluence can request information from JIRA on behalf of the currently logged-in user. JIRA will not ask the user to log in again or to supply a password.

Trusted communication is used when embedding information from one application (for example, a list of JIRA issues) into another application (for example, a Confluence page).

Read more about trusted communication.

**Inserting JIRA issues**

You can insert issues from a JIRA site onto your Confluence page using the 'Insert JIRA Issue' dialogue box. You can also use this dialogue box to create a new issue on the JIRA site. See the JIRA Issues Macro.

---

**On this page:**

- Setting Up Trusted Communication between JIRA and Confluence
- Inserting JIRA issues
- Viewing Confluence Content in JIRA or JIRA Content in Confluence
- Integrating JIRA and Confluence User Management
- Useful Plugins

**Related pages:**

- Integrating Confluence with Other Applications
- Confluence Administrator’s Guide
Viewing Confluence Content in JIRA or JIRA Content in Confluence

Using Gadgets
You can embed a Confluence activity stream or a Confluence page in JIRA’s dashboard. Likewise, JIRA gadgets can be rendered on a Confluence page. See Adding a Confluence Gadget to a JIRA Dashboard and Gadget Macro for information on how to set up gadgets.

Using the JIRA Issues macro
For versions earlier than Confluence 3.1 and JIRA 4.0, use the (jiraissues) macros to embed JIRA reports and portlets into your Confluence site

Any JIRA search result can be embedded in a Confluence page using the JIRA Issues macro with your choice of included fields and field ordering, and any JIRA gadgets can be embedded in a Confluence page by Registering External Gadgets.

Integrating JIRA and Confluence User Management
To save you having to enter users into both JIRA and Confluence, you may benefit from using Atlassian Crowd as the user repository for both applications. Alternatively you can configure Confluence to use JIRA’s user database. See Connecting to Crowd or JIRA for User Management.

Useful Plugins
Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

The JIRA Linker plugin provides a custom field that helps you find an URL, particularly a Confluence page, so you can add a page link into a JIRA issue.

Installing Confluence and JIRA Together
This page describes Atlassian’s recommendation for installing JIRA and Confluence on the same server. Refer to Here Be Dragons for instructions on integrating all Atlassian applications.

Do not deploy multiple Atlassian applications in a single Tomcat container —
Deploying multiple Atlassian applications in a single Tomcat container is not supported. We do not test this configuration and upgrading any of the applications (even for point releases) is likely to break it. There are also a number of known issues with this configuration (see this FAQ for more information).

We also do not support deploying multiple Atlassian applications to a single Tomcat container for a number of practical reasons. Firstly, you must shut down Tomcat to upgrade any application and secondly, if one application crashes, the other applications running in that Tomcat container will be inaccessible.

Finally, we recommend not deploying any other applications to the same Tomcat container that runs Confluence, especially if these other applications have large memory requirements or require additional libraries in Tomcat’s lib subdirectory.

Recommended Setup - Separate Stand-Alone Installations
Atlassian recommends running JIRA and Confluence in separate stand-alone instances running behind an Apache Web Server. See the guides for:

- Installing Confluence
- Running Confluence behind Apache
- Installing JIRA
• Integrating JIRA with Apache

Advantages

• Each application can be restarted without affecting the other.
• If one webapp hangs for any reason (eg. running out of memory), it doesn't affect the other.
• Any problems can be debugged more easily. Logs are separate and product-specific, rather than everything going to catalina.out. Thread and heap dumps are smaller and more relevant.
• It reduces the likelihood of jar conflicts (eg. jars that must be installed in common/lib or lib for Confluence running off Apache Tomcat version 6 or above), particularly if you later want to install a third webapp not from Atlassian.
• Apache HTTP Web Server is well suited for running publicly available sites, with extensive modules for security and efficiency. It also allows for flexibility with URLs (ie http://confluence.atlassian.com, http://confluence, and so on).

Apache Web Server is recommended and reliable. It is also a third-party product, and therefore not developed nor supported by Atlassian. See Atlassian Support Offerings for details.

Setting Up Trusted Communication between JIRA and Confluence

An administrator can configure JIRA and Confluence to communicate in a trusted way, so that Confluence can request information from JIRA on behalf of the currently logged-in user. JIRA will not ask the user to log in again or to supply a password.

Trusted communication is used when embedding information from one application (for example, a list of JIRA issues) into another application (for example, a Confluence page).

Potential security risk

Do not configure a trusted application unless you trust all code in that application to behave itself at all times. Trusted communication uses public/private key cryptography to establish the identity of the trusted server, so you must also be sure that the trusted application will maintain the security of its private key. Read the details of the security risks below.

Prerequisites

The following setup is required:

• JIRA 4.2.0 or later.
• Confluence 3.5.0 or later.
• In order to authenticate successfully against JIRA, the Confluence user must also be registered as a JIRA user with the same username.

Note: It is highly recommended that your JIRA and Confluence instances share a common user base, rather than two separate user bases with duplicated usernames. You will receive an error if Confluence passes JIRA a username which JIRA cannot recognise. Also, with separate user bases you run the risk that the same username may be used by two different people. The trusted application does not supply the user's password, so the trusting application will assume the username belongs to the user registered in the trusting application's own user base.

Tip: Try Atlassian Crowd for a tidy user management solution.
Why do we need Trusted Communication?

The JIRA Issues macro allows you to embed a list of JIRA issues into a Confluence page. Prior to Confluence 2.7, if you wanted to display JIRA issues that had restricted viewing, then you needed to store the JIRA user's credentials (username and password) in the macro code directly on the Confluence page. This was not very secure.

The reasons we require the user credentials are:

- Your JIRA instance might not be public, and you might not want to allow anonymous access to your issues.
- You might have security restrictions on some of your issues. You many not want to allow someone to leak data from your JIRA project by using the JIRA Issues Macro on a Confluence page.

Overview

Here is a summary of the integration points in a trusted communications relationship. Each of the following points is described in more detail in the sections below.

- A JIRA or Confluence system administrator configures JIRA to trust Confluence.
- A Confluence user adds one of the macros to a Confluence page.
- A Confluence user or anonymous user views the Confluence page.

Configuring JIRA to trust Confluence

Trust only has to be established once between the two applications. Once trust has been established, it is entirely transparent to the Confluence users.

You can use Application Links to enable trust relationships between two applications. Linking two applications allows you to share information and access one application's functions from within the other.

You can configure an application link to use Trusted Applications as the authentication mechanism. For instructions, see Linking to Another Application.

Adding the macro to a Confluence page

The Confluence user can add and edit the macros as described on the following page: JIRA Issues macro.

The following options are available for determining the issues which will be retrieved from JIRA and displayed on
the Confluence page:

<table>
<thead>
<tr>
<th>What you want to do</th>
<th>Macro parameter</th>
<th>URL parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the JIRA issues which the logged-in user is authorised to see. And if the user is not logged in, display only issues which allow unrestricted viewing.</td>
<td></td>
<td></td>
<td>Do not specify any authentication parameters. In this case, the behaviour depends on the way your administrator has set up trusted communication between JIRA and Confluence. Here is a summary of the behaviour. If trusted communication is enabled, the authorisation will work seamlessly. When a logged-in user views your page, they will see only the JIRA issues they are allowed to see. And if they are not logged in, they will see only the issues which allow unrestricted viewing. If trusted communication is disabled, the Confluence page will show only the JIRA issues which allow unrestricted viewing.</td>
</tr>
<tr>
<td>Ensure that Confluence will display only the JIRA issues which allow unrestricted viewing.</td>
<td>anonymous</td>
<td></td>
<td>Regardless of who the user is (logged in or not), the Confluence page will show only anonymously-visible issues. Confluence will not attempt to set up a trusted communication link with JIRA in this case.</td>
</tr>
</tbody>
</table>
Use a pre-determined username and password to access the JIRA issues.

&os_username=MYNAME&os_password=MYPASSWORD

Not recommended

Prior to Confluence 2.7, this was the only way of displaying issues with restricted viewing. For Confluence 2.7 and later, this method will still work. Confluence will not attempt to set up a trusted communication link with JIRA in this case.

Viewing the Confluence page

When a user views a Confluence page which contains a JIRA Issues macro, this is what happens:

- If the macro markup contains an explicit username and password in the URL parameter, Confluence will not request trusted communication with JIRA. Confluence will retrieve the JIRA issues which the specified username is authorised to see. This behaviour is the same as Confluence versions prior to 2.7.
- If the macro markup contains the anonymous parameter, Confluence will retrieve only the JIRA issues which allow unrestricted viewing. Confluence will not attempt to set up a trusted communication link with JIRA in this case.
- If the user is anonymous (not logged in), Confluence will retrieve only the JIRA issues which allow unrestricted viewing. Confluence will not attempt to set up a trusted communication link with JIRA in this case.
- If the user is logged in, then Confluence attempts trusted communication with JIRA. Confluence sends the username to JIRA. JIRA returns a set of issues which that username is authorised to access, based on the JIRA user base and the JIRA groups and permissions. Confluence displays those issues on the page.
- If JIRA or Confluence encounters a problem during the trusted communication process, an error message may appear on the Confluence page above the macro output – see troubleshooting below.

Security Risks

Please take the following considerations into account when setting up trusted communication:

- When you configure JIRA to trust an application, you are allowing the application to access JIRA in the name of a particular user. The trusted application passes JIRA the user's login name, but no other authentication information. JIRA does not request the user's password. By doing this, you are bypassing JIRA's authentication mechanism.
- Do not configure a trusted application unless you trust all code in that application to behave itself at all times.
- Trusted communication uses public/private key cryptography to establish the identity of the trusted server. The trusted application needs to maintain the security of its private key. Confluence stores its private key in the database. So you must be sure that the Confluence database is secure, and also any full backups of the database.
- Ensure that you specify an IP address for your Confluence site when configuring trusted applications in JIRA. Do not use the wild card `*.*.*.*` as the IP address. Failure to configure IP address restrictions is a security vulnerability, allowing an unknown site to log into your JIRA site under a user's login ID.
- Be aware of the risks associated with using separate user bases, as explained above. We strongly recommend a common user base between the trusted and trusting applications.
- When configuring an application to trust another application, you should use a trusted network or SSL to protect the sensitive information passed between the applications during the configuration procedure. This will help to prevent man-in-the-middle attacks.
**Troubleshooting**

Below are the warning messages which may appear on your Confluence page, above the output of the JIRA Issues macro.

<table>
<thead>
<tr>
<th>Warning Message</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>javax.net.ssl.SSLHandshakeException:</td>
<td>JIRA is running over SSL</td>
</tr>
<tr>
<td>sun.security.validator.ValidatorException:</td>
<td></td>
</tr>
<tr>
<td>PKIX path building failed:</td>
<td></td>
</tr>
<tr>
<td>sun.security.provider.certpath.SunCertPathBuilderException:</td>
<td></td>
</tr>
<tr>
<td>unable to find valid certification path to requested target</td>
<td></td>
</tr>
<tr>
<td>The JIRA server does not recognise your user name. Issues have been retrieved</td>
<td>The logged-in Confluence user is not registered in the JIRA user base.</td>
</tr>
<tr>
<td>anonymously.</td>
<td></td>
</tr>
<tr>
<td>The JIRA server does not trust this Confluence instance for user authentication.</td>
<td>Your JIRA instance has not been configured to trust your Confluence instance.</td>
</tr>
<tr>
<td>Issues have been retrieved anonymously. You can set the macro to always use a</td>
<td></td>
</tr>
<tr>
<td>anonymous request by setting the 'anonymous' parameter to 'true'.</td>
<td></td>
</tr>
<tr>
<td>The JIRA server does not support trust requests. Issues have been retrieved</td>
<td>Your JIRA instance is not able to handle trusted communications</td>
</tr>
<tr>
<td>anonymously. You can set the macro to always use an anonymous request by</td>
<td>(i.e. the JIRA version is earlier than 3.12.0).</td>
</tr>
<tr>
<td>setting the 'anonymous' parameter to 'true'.</td>
<td></td>
</tr>
</tbody>
</table>

There is a date/time difference between the JIRA server and Confluence server.

Consult Troubleshooting the JIRA Issues Macro and Trusted Applications for further troubleshooting.

### Registering External Gadgets

You can register gadgets from external web sites (such as JIRA, iGoogle or Gmail) with your Confluence installation, so that the gadgets appear in the macro browser and people can add them to Confluence pages via a gadget macro.

Choose one of the following ways to register the external gadgets on Confluence:

- **Subscribe to all of the external application's gadgets**: You can add all the gadgets from your JIRA, Bamboo, FishEye or Crucible site – or from another Confluence site – to your Confluence gadget directory. People can then pick and choose the gadgets to add to their Confluence pages.
- **Register the external gadgets one by one**: If you cannot subscribe to an application’s gadgets, you will need to add the gadgets one by one. This is necessary for applications and websites that do not support gadget subscription, and for applications where you cannot establish a trusted relationship via Application Links.

Both methods are described below. First, consider whether you need to set up a trust relationship between Confluence and the other application.

#### Setting up a trust relationship with the other application

In addition to registering the external gadgets, we recommend that you set up an OAuth or Trusted Application relationship between the application that serves the gadget (the service provider) and Confluence (the consumer). The trust relationship is required for gadgets that access restricted data from the external web application.

See how to configure OAuth or Trusted Applications Authentication, using Application Links.

If the external web application provides anonymous access to all the data you need in the gadgets, then you do not need a trust relationship.

For example, if your gadgets will retrieve data from JIRA and your JIRA server includes projects and issues that are restricted to logged-in users, then you will need a trust relationship between Confluence and JIRA. If you do not set up the trust relationship, then the gadgets will show only the information that JIRA makes visible to anonymous users.

#### Subscribing to all of the application’s gadgets

You can add all the gadgets from your JIRA, Bamboo, FishEye or Crucible site – or from another Confluence site – to your Confluence gadget directory. People can then pick and choose the gadgets to add to their Confluence pages.

To subscribe to another site’s gadgets:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose External Gadgets in the left-hand panel.
3. Click the Gadget Feeds tab.
4. Enter the base URL of the application you want to subscribe to, in the text box labelled Gadget Feed URL. For example, http://example.com/jira or http://example.com/confluence.
5. Choose Add. Confluence will convert the URL to a gadget feed and place it in the list of 'Added Gadget Feeds'.
On this page:
- Setting up a trust relationship with the other application
- Subscribing to all of the application's gadgets
- Registering individual gadgets
- Removing access to external gadgets

Related pages:
- Configuring the Whitelist
- The big list of Atlassian gadgets
- Adding JIRA Gadgets to a Confluence Page
- Linking to Another Application

Screenshot: Subscribing to a gadget feed

External Gadgets

Only add gadgets that you trust! Gadgets can allow unwanted or malicious code onto your web page.

Gadget Specifications  |  Gadget Feeds  |  Gadget Whitelist

Add a new Gadget Feed

Gadget Feed URL

Add

Added Gadget Feeds

<table>
<thead>
<tr>
<th>Gadget Feed URL</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="https://pug.jira.com/rest/gadgets/1.0/g/feed/">https://pug.jira.com/rest/gadgets/1.0/g/feed/</a></td>
<td>Delete</td>
</tr>
<tr>
<td><a href="https://pug.jira.com/rest/gadgets/1.0/g/feed/">https://pug.jira.com/rest/gadgets/1.0/g/feed/</a></td>
<td>Delete</td>
</tr>
</tbody>
</table>

Registering individual gadgets

If you cannot subscribe to an application's gadgets, you will need to register the gadgets one by one. This is necessary for applications and websites that do not support gadget subscription, and for applications where you cannot establish a trusted relationship via Application Links.

First you will need to obtain that gadget's URL and copy it to your clipboard.

Getting a gadget's URL from an Atlassian application

If your web application is another Atlassian application such as Confluence or JIRA:

A gadget's URL points to the gadget's XML specification file. In general, a gadget's URL looks something like this:

http://example.com/my-gadget-location/my-gadget.xml

If the gadget is supplied by a plugin, the URL will have this format:
http://my-app.my-server.com:port/rest/gadgets/1.0/g/my-plugin.key:my-gadget/my-path/my-gadget.xml

For example:
http://mycompany.com/jira/rest/gadgets/1.0/g/com.atlassian.streams.streams-jira-plugin:activitystream-gadget/gadgets/activitystream-gadget.xml
To find a gadget's URL in JIRA:

- Go to your dashboard by clicking the **Dashboards** link at the top left of the screen.
- Click **Add Gadget** to see the list of gadgets in the directory.
- Find the gadget you want, using one or more of the following tools:
  - Use the scroll bar on the right to move up and down the list of gadgets.
  - Select a category in the left-hand panel to display only gadgets in that category.
  - Start typing a key word for your gadget in the **Search** textbox. The list of gadgets will change as you type, showing only gadgets that match your search term.
- Right-click the **Gadget URL** link for that gadget and copy the gadget's URL into your clipboard.

To find a gadget's URL in Confluence:

- Choose **Help > Confluence Gadgets** to see the list of available Confluence gadgets.
- Find the gadget you want.
- Right-click the **Gadget URL** link for that gadget and copy the gadget's URL into your clipboard.

Getting a gadget's URL from another application

If the gadget comes from a non-Atlassian web application or web site, please consult the relevant documentation for that application to obtain the gadget's URL.

Registering the gadget for use in Confluence

Now that you have the gadget's URL, you can register it in Confluence, so that people can add it to their pages. You need system administrator permissions to register a gadget.

To register the gadget in Confluence:

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Choose **External Gadgets** in the left-hand panel.
3. Paste your gadget's URL into the **Gadget Specification URL** field in the 'Add a new Gadget’ section.
4. Choose **Add**. Your gadget will be shown in the list of registered gadgets below and it will also become available in the **macro browser**.

*Screenshot: Registering external gadgets one by one*
Removing access to external gadgets

To remove a single gadget from Confluence, click the **Delete** button next to the gadget URL.

If you have subscribed to an application's gadgets, you will need to remove the entire subscription. You cannot unregister a single gadget. Click the **Delete** button next to the gadget feed URL.

The gadget(s) will no longer be available in the macro browser, and people will not be able to add them using the Gadget macro. Any pages that already use the gadget will show a broken gadget link.

**Configuring the Office Connector**

The Office Connector is a Confluence add-on that allows Confluence users to interact with Microsoft Office and Open Office in various ways. You can display content from Office documents on a wiki page and import content from an Office document into Confluence. Please refer to the [User Guide](#) for details of these interactions.

The Office Connector add-on is shipped with Confluence. A **System Administrator** can enable or disable parts of the Office Connector and can configure options as described below.

Enabling and Disabling the Office Connector and its Modules

The Office Connector is bundled with Confluence, so you should not need to install it. But you may wish to enable or disable some of its modules.

**To enable or disable the Office Connector and its modules:**

1. Select **Manage Add-ons** in the left-hand panel of the Confluence Administration Console.
2. Click **Show system add-ons** under 'System Add-ons'.
3. Enter ‘Office Connector’ in the **Filter Visible add-ons** field to quickly find the Office Connector add-on.
4. Open the details view of the add-on by clicking on the Office Connector add-on in the system add-ons list.
5. From the details view, you can:
• Click **Configure** to specify preferences for the Office Connector. This open the configuration screen described below.
• Click **Disable** to disable all modules of the add-on.
• View the **modules** that make up the add-on by expanding the modules list. You can enable or disable certain Office Connector modules.

---

### On this page:
- Enabling and Disabling the Office Connector and its Modules
- Configuring the Office Connector Options

### Related pages:
- Office Connector Prerequisites
- Office Connector Limitations and Known Issues
- Working with the Office Connector
- Managing Add-ons or Plugins

---

⚠️ **The information on this page does not apply to Confluence Cloud.**

---

### To disable or enable a module:

1. Open the details view for the Office Connector add-on in the 'Manage Add-ons' page.
2. Expand the active modules link. The text of this link indicates the number of enabled modules out of the total modules in the add-on.

---

#### Screenshot: Enabling the Office Connector add-on and its modules

3. Hover over the module in the list to make the **Enable** or **Disable** button visible, and click the button to apply the action.

Only certain Office Connector modules can be disabled. Modules that are integral to the operation of the add-on cannot be disabled, and do not have an **Enable** or **Disable** button. Modules that can be disabled include the button and provide a brief, on-screen description of the module.

---

Configuring the Office Connector Options
Confluence administrators can configure settings that control the behaviour of the Office Connector on your Confluence site.

To set the configuration options for the Office Connector:

1. Select **Office Connector** under 'Configuration' in the left-hand panel of the 'Confluence Administration Console'. The 'Configure Office Connector plugin' screen appears.

   **Screenshot: Configuring the Office Connector options**

   ![Configuration of the Office Connector](image)

   - **User Interface**
     - Edit in word button location: Page action icon, View page tab

   - **Importing From Word**
     - Warnings: Show a warning before allowing a user to perform an import
     - Advanced Formatting Options: Use the footnote macro for Word footnotes
     - Maximum imported image size: 1200 height (pixels), 900 width (pixels)

   - **System Resource Usage**
     - Temporary storage for viewfile macro: Confluence home directory, C:\Program Files\Atlassian\Application Data\Confluence\viewfile
     - No directory specified in the properties file. Please set a correct value in resources/directories.properties.
     - Cache in-memory
     - Maximum file space for cache (MB): 500
     - Number of Conversion Queues: 6

   - **Security**
     - Authentication: Allow authentication tokens in the URL path

2. Set the configuration options as described in the table below.

The configuration options are described in the table below:
<table>
<thead>
<tr>
<th>Option</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit in word button location</td>
<td>Page action icon</td>
<td>Where the button for editing the content in Word is located. You can configure the button to appear in the page action icon or from the view page tab.</td>
</tr>
<tr>
<td>Warnings: Show a warning before allowing a user to perform an import</td>
<td>Disabled</td>
<td>If this option is enabled, the user will receive a warning when importing a Word document. The warning will tell the user when they are about to overwrite existing content.</td>
</tr>
<tr>
<td>Advanced Formatting Options: Use the footnote macro for Word footnotes</td>
<td>Disabled</td>
<td>If this option is enabled, a Confluence page created from an imported Word document from Adaptavist to render any footnotes contained in the document. Note that you will need to install the Footnotes add-on onto your Confluence site. For more information about this add-on and more information about this add-on.</td>
</tr>
<tr>
<td>Authentication: Allow authentication tokens in the URL path</td>
<td>Disabled</td>
<td>If this option is enabled, the Office Connector will use authentication tokens in the URL.</td>
</tr>
</tbody>
</table>
### Temporary storage for viewfile macro

The {viewfile} macro will cache data temporarily. This option allows you to set the settings are:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Confluence home directory</strong></td>
<td>The temporary file will be stored in your Confluence Home directory.</td>
</tr>
<tr>
<td><strong>A directory specified in the directories.properties file</strong></td>
<td>You can specify a location by editing the directories.properties file:</td>
</tr>
<tr>
<td>1. Go to the bundled-plugins directory in your Confluence Home directory.</td>
<td></td>
</tr>
<tr>
<td>2. Copy the Office Connector JAR file to a temporary location: OfficeConnector-x.xx.jar, where 'x.xx' is the version number.</td>
<td></td>
</tr>
<tr>
<td>3. Unzip the JAR file and find the directories.properties file in the resources directory. The content of the file looks like this:</td>
<td></td>
</tr>
<tr>
<td><code>com.benryan.confluence.word.edit.cacheDir=</code></td>
<td></td>
</tr>
<tr>
<td>4. Edit the last line, adding the path to your required temporary location directly after the '=' character. For example:</td>
<td></td>
</tr>
<tr>
<td>On Windows: <code>com.benryan.confluence.word.edit.cacheDir=c:\n</code></td>
<td></td>
</tr>
<tr>
<td>On Linux: <code>com.benryan.confluence.word.edit.cacheDir=/home/myusername/my/path</code></td>
<td></td>
</tr>
<tr>
<td>5. Save the file, recreate the JAR and put it in the bundled-plugins directory, overwriting the original JAR.</td>
<td></td>
</tr>
<tr>
<td><strong>Cache in-memory</strong></td>
<td>The temporary file will be held in memory. We recommend this option if you are running in a clustered environment.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum file space for cache (MB)</th>
<th>500</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is the maximum size of the cache used by the {viewfile} macro. (See above.)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Number of Conversion Queues</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is the maximum number of threads used to convert PowerPoint, Excel files, set this setting to manage Confluence performance, by limiting the number of thread does not consume too many resources. Click Manage Queues to view attachment conversion.</td>
<td></td>
</tr>
</tbody>
</table>

### Managing your Confluence License

Your license entitles you to run Confluence and be eligible for support and upgrades for a specified period. It also defines the number of users who are entitled to use Confluence.

To quickly check the status of your license you can go to General Configuration > Atlassian Support Tools > Health Check.

You'll need need Confluence Administrator or System Administrator permissions to view and edit your license.

Viewing your license details
To view your Confluence license:

1. Go to > General Configuration.
2. Choose License Details in the left-hand panel.

The License Details page tells you:

- The type of license (for example: Commercial, Academic, Community, or Evaluation).
- Number of users you are licensed for, and how many are currently in use.
- Your license expiry date, for support and upgrade eligibility.
- Your server ID which is generated when you install Confluence for the first time and remains the same for the life of the installation (including after upgrades or changes to your license).
- Your support entitlement number (SEN).

Updating your license

If you change your license (for example to a license with more users), or migrate from Confluence Cloud and you will need to update your license.

To update your Confluence license:

1. Go to > General Configuration > License Details
2. Enter your new license in the License field.
3. Choose Save.

Understanding the user count for your license

The number of registered users allowed on your Confluence site may be limited, depending on your license type.

The License Details page will indicate the number of users currently signed up (your registered user count). It:

- includes only users who have the 'can use' global permissions for the Confluence site.
- does not include anonymous users, who may access your Confluence site if you have allowed anonymous access.
- does not include deactivated users.

Exceeding your licensed user count

If you exceed the number of users included in your license, your Confluence instance will become read-only, that means no users will be able to create or edit content until you reduce the number of users.

Reducing your user count

On this page:

- Viewing your license details
- Updating your license
- Understanding the user count for your license
- Exceeding your licensed user count
- Reducing your user count
- Downgrading your license
- Finding your Support Entitlement Number (SEN)

Related pages:

- Upgrading Beyond Current Licensed Period
- Confluence Installation and Upgrade Guide
- Confluence Administrator’s Guide

Screenshot: License details
You can reduce your user count by removing or deactivating users who do not require access to Confluence. See Deleting or Deactivating Users.

If you have connected Confluence to an LDAP directory, you may want configure Confluence to only synchronise a subset of users from LDAP rather than all users. See Changing the Number of Users Synchronized from LDAP to Confluence in the Knowledge Base. This can be a complicated process and we recommend that you only use this method if necessary.

**Downgrading your license**

If you decide to downgrade your Confluence license to pay for fewer users you need to ensure that the number of users currently signed up (as shown on the License Details page) is lower that the number allowed by your new license before you apply the new license.

If you have more users than your new license allows you will need to reduce your user count before applying the new license.

**Finding your Support Entitlement Number (SEN)**

You can find your Support Entitlement Number (SEN) in three places:

- In Confluence - go to ![General Configuration > License Details](#
- At [my.atlassian.com](my.atlassian.com)
- On your Atlassian invoice.

See Finding Your Support Entitlement Number for more general information about how Atlassian Support uses this number.

**Managing Confluence Data**

This page is an overview of recommended techniques for managing the data on your Confluence site. This is of interest to Confluence administrators – people with System Administrator or Confluence Administrator permissions.

- **Database Configuration**
- **Site Backup and Restore**
- **Attachment Storage Configuration**
- **Confluence Data Model**
- **Finding Unused Spaces**
- **Data Import and Export**

**Related pages:**

- Managing Add-ons or Plugins
- Integrating Confluence with Other Applications
- Getting Started as Confluence Administrator
- Confluence Administrator’s Guide

**Database Configuration**

This document provides information on connecting Confluence to an external database.

The embedded HSQLDB database for evaluation purposes

The Confluence installation includes an embedded HSQLDB database, supplied for the purpose of evaluating Confluence.

If you are using the embedded database, the database files are stored in the `database` directory under your `C: \confluence` Home and other important directories.

**Note:** The embedded HSQLDB database is not suitable for production Confluence sites.

Production sites should use an external database. See our guide to database configuration. When using the default HSQLDB database, you run the risk of irrecoverable data loss because HSQLDB is not transaction safe.

- Corruption is occasionally encountered after sudden power loss. It can usually be corrected using the data recovery procedure documented in our knowledge base.
- HSQLDB is suitable for evaluation purposes, but the risk can only be eliminated by switching databases.
This is essential when you move from an evaluation to a production site. External databases may also provide superior speed and scalability.

To find out if you are still using the embedded database, go to > General Configuration > Atlassian Support Tools > Health Check.

On this page:
- The embedded HSQLDB database for evaluation purposes
- Selecting an external database
- Database setup
- Optimising database performance
- Database troubleshooting
- Notes

Related pages:
- Database JDBC Drivers
- Supported Platforms
- Embedded HSQLDB Database
- Managing Confluence Data
- Confluence Administrator's Guide

Selecting an external database

**Note:** Take time to choose your database wisely. The XML backup built into Confluence is not suited for migration or backup of large data sets. If you need to migrate later, you will need to use a third party database migration tool.

Below is more information on selecting and migrating to an external database:

- Migrating to a Different Database
- List Of Supported Databases
- Database Troubleshooting

Database setup

Here are the setup instructions for the supported databases:

- Database Setup for Oracle
- Database Setup For MySQL
- Database Setup for PostgreSQL
- Database Setup for SQL Server

Optimising database performance

To improve database responsiveness:

- Improving Database Performance
- Database Troubleshooting

Database troubleshooting

For solving database-related problems:

- Troubleshooting External Database Connections
- Troubleshooting the Embedded HSQLDB Database
- Interpreting DB2 error codes
- Database Troubleshooting

Obtain technical support from Troubleshooting Problems and Requesting Technical Support.

Notes

Issue CONF-12599 requests a more robust strategy for migrating large Confluence sites.

Database JDBC Drivers
This page provides the download links for the JDBC drivers for all databases currently supported for Confluence. You will need to make the driver available to your application server, as described in the appropriate setup guide.

**Note:** We bundle some JDBC drivers with Confluence, as shown below. If you are using a direct JDBC connection, you do not need to download or install the drivers that are bundled. If you are connecting via a datasource, or if you are using a database whose driver is not bundled, you will need to download and install the drivers manually.

<table>
<thead>
<tr>
<th>Database</th>
<th>JDBC driver bundled with Confluence?</th>
<th>JDBC drivers</th>
<th>Notes</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL</td>
<td>✅</td>
<td>9.2-1004 JDBC 4 driver download</td>
<td>The JDBC 4 driver will work under the 1.7 JVM. If you want to use other drivers, you can download it from the PostgreSQL website. However, we recommend that you use the bundled JDBC 4 driver.</td>
<td>Database Setup for PostgreSQL</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>✅</td>
<td>jTDS 1.2.2 driver download</td>
<td>The above version is the version bundled with Confluence. All our testing is done on that version. We do not know of any issues with later versions, so you are free to use them if you have tested them and find there are no issues in your environment. However, later versions are technically not supported. That means that if you do run into any problems, Atlassian Support may require you to move back to the above fully-tested version for troubleshooting.</td>
<td>Database setup for Microsoft SQL Server</td>
</tr>
<tr>
<td>MySQL</td>
<td>✗</td>
<td>ConnectorJ 5.1.30 driver download</td>
<td>Note: In Confluence 5.1 and later, the MySQL drivers are no longer included in the Confluence distribution. For more information please refer to the Confluence 5.1 Upgrade Notes.</td>
<td>Database setup for MySQL</td>
</tr>
<tr>
<td>Oracle</td>
<td>✗</td>
<td>JDBC driver downloads</td>
<td>• For Oracle 11.1, use the 10.2.0.4 or 11.1.0.7.0 driver (Java 6 ojdbc6.jar).&lt;br&gt;• For Oracle 11.2, use the 11.2.0.1.0 driver (Java 6 ojdbc6.jar).&lt;br&gt;We recommend using the thin drivers only.&lt;br&gt;Tip: Search for the JAR file name on the download site.&lt;br&gt;See the Oracle JDBC driver FAQ.</td>
<td>Database setup for Oracle</td>
</tr>
</tbody>
</table>

⚠️ Above versions are listed as of 5.5

**Database Setup for Oracle**

This page provides instructions for configuring Confluence to use an Oracle database. The setup process involves configuration of your Oracle server and your Confluence site.
Step 1. Check the prerequisites

Check the following before you start:

- Make sure your version of Oracle is supported. See Supported Platforms. If your version of Oracle is not supported, please upgrade to a supported version before installing Confluence.
- If you have been evaluating Confluence and wish to transfer your data to a new database, consult the following guide first: Migrating to Another Database.
- If you are migrating from another database, consult the following guide first: Migrating to Another Database.
- Note: This database can only be set up by an Oracle database administrator (DBA). Oracle is difficult to set up. If you are not a DBA, and you do not have access to an experienced Oracle DBA, we recommend that you choose an alternative database. For a list of supported databases, see Supported Platforms. If you are evaluating Confluence, we recommend that you start with an alternative database and only consider migrating to Oracle after approval from your DBA. If you request Atlassian's technical support for difficulties with Oracle setup, we will assume you have the high level of skill required for an Oracle setup.

On this page:
- Step 1. Check the prerequisites
- Step 2. Install your Oracle server
- Step 3. Set up your Oracle user with schema-creation privileges
- Step 4. Install Confluence
- Step 5. Determine your JDBC URL
- Step 6. Download and install the Oracle database driver
- Step 7. Set up your database connection in the Confluence Setup Wizard
- Troubleshooting

Related pages:
- Database Configuration
- Known Issues for Oracle
- Confluence Installation and Upgrade Guide

Step 2. Install your Oracle server

If you do not already have an operational Oracle database server, download the installation package from the Oracle download page and follow the instructions in the Oracle documentation.

Then follow the steps below, to deploy Confluence to a schema in your Oracle server.

Note: Your database should be configured to use the same character encoding as Confluence. The recommended encoding is AL32UTF8 (the Oracle equivalent of Unicode UTF-8). See Configuring Database Character Encoding.

Step 3. Set up your Oracle user with schema-creation privileges

In this step you will create a Confluence user in Oracle and grant the appropriate roles to the user, so that the user can set up a connection, can create objects in its own schema, and can configure the schema.

To create the user and assign its privileges:

1. Access the command line interface to Oracle via the 'sqlplus' command.

   sqlplus user/password <as sysdba|as sysoper>

You must add the 'as sysdba' or 'as sysoper' option if you are logging in with the user 'sys'. This determines which sys role you are using.

Once logged in, you can type arbitrary SQL commands.

2. Create a Confluence user (<user>) in Oracle, and grant the appropriate roles only to the user:
   - connect role is required to set up a connection.
   - resource role is required to allow the user to create objects in its own schema.
Create table, sequence and trigger are required to configure the schema.

```sql
create user <user> identified by <password> default tablespace <tablespace_name> quota unlimited on <tablespace_name>;
grant connect to <user>;
grant resource to <user>;
grant create table to <user>;
grant create sequence to <user>;
grant create trigger to <user>;
```

Notes:
- Do not grant the user the select any table permission. That permission can cause problems with other schemas. See the bug report CONF-3613.
- When you create a user, specify the tablespace for the table objects as shown above.

3. Add a local all_objects view to the user's schema, to prevent a conflict that can occur when a table exists in another schema with the same name as one of the Confluence tables. This is a workaround for the bug CONF-3613:

```sql
create view <user>.all_objects as
    select *
    from sys.all_objects
    where owner = upper(''<user>'');
```

Step 4. Install Confluence

Install Confluence if you have not done so already. See the Confluence Installation Guide. Stop immediately after the installation, before opening the Confluence Setup Wizard in your browser, and follow the steps below.

If you have already got part-way through the Confluence Setup Wizard, stop at the database setup step and follow the steps below. You will be able to restart the setup wizard at the same step later.

Step 5. Determine your JDBC URL

The JDBC thin driver for Oracle use three different styles of URL:

- New style:

  ```sql
  jdbc:oracle:thin:@//[HOST][:PORT]/SERVICE
  ```

- Old style:

  ```sql
  jdbc:oracle:thin:@[HOST][:PORT]:SID
  ```

- 'tnsnames' style:
### tnsnames

```sql
jdbc:oracle:thin:@(DESCRIPTION=
  (SDU=32768)
  (enable=broken)
  (LOAD_BALANCE=yes)
  (FAILOVER=yes)
  (ADDRESS=
    (PROTOCOL=TCP)
    (HOST=dbserver1.example.com)
    (PORT=1525))
  (ADDRESS=
    (PROTOCOL=TCP)
    (HOST=dbserver2.example.com)
    (PORT=1525))
  (CONNECT_DATA=
    (SERVICE_NAME=CONFDB)))
```

**Notes:**

- The `tnsnames` style is required for connecting to an Oracle RAC cluster. For easy reading, we have split the example above over multiple lines, but you should compact it into a single line. These values may need more analysis than documented here, so you should seek the assistance of an experienced DBA.
- If you use the new style URL, then SERVICE can be either an SID or Service Name.
- If you use the old style URL, then SERVICE can only be the SID.

To determine the host, port, service name, and/or SID, execute the following command as the user running Oracle. (By default, the user is "oracle"):

```bash
lsnrctl status
```

For reference, here is a sample output:
SNRCTL for Linux: Version 11.2.0.2.0 - Beta on 29-JUN-2012 15:20:59
Copyright (c) 1991, 2010, Oracle. All rights reserved.
Connecting to (DESCRIPTION=(ADDRESS=(PROTOCOL=IPC)(KEY=EXTPROC_FOR_XE)))
STATUS of the LISTENER

------------------------
Alias                     LISTENER
Version                   TNSLSNR for Linux: Version 11.2.0.2.0 - Beta
Start Date                06-JUN-2012 08:36:34
Uptime                    23 days 6 hr. 44 min. 25 sec
Trace Level               off
Security                  ON: Local OS Authentication
SNMP                      OFF
Default Service           XE

Listener Parameter File:
/u01/app/oracle/product/11.2.0/xe/network/admin/listener.ora

Listener Log File:
/u01/app/oracle/diag/tnslsnr/<HOSTNAME>/listener/alert/log.xml

Listening Endpoints Summary...
  (DESCRIPTION=(ADDRESS=(PROTOCOL=ipc)(KEY=EXTPROC_FOR_XE)))
  (DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<HOSTNAME>)(PORT=1521)))

  (DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<HOSTNAME>)(PORT=8080))(Presentation=HTTP )(Session=RAW))

Service Summary...
  Service "PLSExtProc" has 1 instance(s).
  Instance "PLSExtProc", status UNKNOWN, has 1 handler(s) for this service...
  Service "XE" has 1 instance(s).
  Instance "XE", status READY, has 1 handler(s) for this service...
  Service "XEXDB" has 1 instance(s).
  Instance "XE", status READY, has 1 handler(s) for this service...

The command completed successfully.

Notes:

- The host and port are determined by the line containing PROTOCOL=tcp, without Presentation=HTTP.
- Under Services Summary, each service which has an instance with READY status is a connectable service. The name following Service is a service name for connecting to the database name following Instance on the next line.
- The SID is the name of the database instance, as defined by the $ORACLE_SID variable when you have sourced the Oracle environment to your shell.

For example, assuming that you are running Confluence on the same server as the Oracle database, with the above lsnrctl status output, you would use one of the following URLs:

```
jdbc:oracle:thin:@//localhost:1521/XE
jdbc:oracle:thin:@localhost:1521:XE
```

The URL can be used in either a direct JDBC connection or using a Tomcat datasource.

For further information on Oracle JDBC URLs, see the Oracle JDBC FAQ.

**Step 6. Download and install the Oracle database driver**

Decide whether you will set up a direct JDBC connection or a datasource connection to Oracle, to suit your environment. If unsure, choose direct JDBC.
To set up a direct JDBC connection:

If you plan to set up a direct JDBC connection to Oracle, you will need to copy the Oracle JDBC driver to your Confluence installation.

1. Download the latest compatible database driver. Links to the appropriate database drivers are available on this page: Database JDBC Drivers.
2. Copy the driver JAR file to the `<Confluence installation>/confluence/WEB-INF/lib` folder in your new Confluence installation.

To set up a datasource connection:

If you plan to set up a datasource connection to Oracle, follow the steps described in Configuring an Oracle Datasource in Apache Tomcat.

**Step 7. Set up your database connection in the Confluence Setup Wizard**

Start Confluence, and go to the Confluence Setup Wizard in your browser. Follow these steps to set up the new configuration:

1. Follow the initial steps in the Confluence Setup Guide.
2. When prompted to choose an evaluation or production installation, choose production installation.
3. When prompted to choose an embedded or external database, select Oracle xx from the dropdown list, where 'xx' is your Oracle version, and choose External Database.
4. Choose either the direct JDBC or the datasource connection, to suit the choice you made earlier when setting up the Oracle database driver.
   - For the JDBC connection: Enter the database URL to match the JDBC URL you determined in the previous section. Enter the user name (for example, confluenceuser) and password you chose when adding the Confluence database to Oracle.
   - For a datasource connection: Set the JNDI name to `java:comp/env/jdbc/confluence`.
5. Wait a while, as Confluence will create the schema in Oracle.

Congratulations! Confluence is now using your Oracle database to store its data.

**Troubleshooting**

- The following page contains common issues encountered when setting up your Oracle database to work with Confluence: Known Issues for Oracle.
- If Confluence complains that it is missing a class file, you may have placed the JDBC driver in the wrong folder.
- If none of the above describes your issue, please create a support ticket at [http://support.atlassian.com](http://support.atlassian.com) and be sure to include your logs (found in `<CONFLUENCE-INSTALLATION>/logs` and `<CONFLUENCE-HOME>/logs`).

Configuring an Oracle Datasource in Apache Tomcat

This page tells you how to set up an Oracle datasource connection for Confluence.

**Step 1. Shut down Tomcat**

1. Run `bin/shutdown.sh` or `bin/shutdown.bat` to bring Tomcat down while you are making these changes.
2. Make a backup of your `<CONFLUENCE_HOME>/confluence.cfg.xml` file and your `<CONFLUENCE-INSTALLATION>/conf/server.xml` file, so that you can easily revert if you have a problem.

**Step 2. Install the Oracle database driver**

1. Download the Oracle JDBC driver. Links are available on this page: Database JDBC Drivers.
2. Copy the driver JAR file into the `lib` folder of your Tomcat installation: `<TOMCAT-INSTALLATION>/lib`. 

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Step 3. Configure Tomcat

1. If you are using the Confluence distribution, edit the conf/server.xml file in your Tomcat installation. If you are running your own Tomcat instance, edit the XML file where you declared the Confluence Context descriptor.

2. Find the Context element in the Host element:

```xml
<Host name="localhost" debug="0" appBase="webapps" unpackWARs="true" autoDeploy="false">
  <Context path="" docBase="../confluence" debug="0" reloadable="true">
    <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for
     Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
    <Manager pathname="" />
  </Context>
</Host>
```

3. Insert the DataSource Resource element into the Context element, directly after the opening Context line, before Manager, as shown here:

```xml
<Host name="localhost" debug="0" appBase="webapps" unpackWARs="true" autoDeploy="false">
  <Context path="" docBase="../confluence" debug="0" reloadable="true">
    <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for
     Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
    <Resource name="jdbc/confluence" auth="Container"
      type="javax.sql.DataSource"
      driverClassName="oracle.jdbc.OracleDriver"
      url="jdbc:oracle:thin:@hostname:port:sid"
      username="<username>"
      password="<password>"
      connectionProperties="SetBigStringTryClob=true"
      maxActive="25"
      maxIdle="5"
      maxWait="10000"
    />
    <Manager pathname="" />
  </Context>
</Host>
```

4. Change the username and password to match your Oracle login.

5. Change the url to match the URL for your Oracle database. See how to find your Oracle URL. For example:
jdbc:oracle:thin:@example.atlassian.com:1521:confluencedb

6. If required, choose different maxActive and maxIdle values. These define the number of database connections that will be allowed at one time, and the number that will be kept open even when there is no database activity.

Step 4. Configure the Confluence web application

Configure Confluence to use this datasource:

1. Edit this file in your Confluence installation: `<CONFLUENCE_INSTALLATION>/confluence/WEB-INF/web.xml`.
2. Insert the following element just before </web-app> near the end of the file:

```xml
<resource-ref>
   <description>Connection Pool</description>
   <res-ref-name>jdbc/confluence</res-ref-name>
   <res-type>javax.sql.DataSource</res-type>
   <res-auth>Container</res-auth>
</resource-ref>
```

Step 5. Restart Tomcat

Run `bin/startup.sh` or `bin/startup.bat` to start Tomcat with the new settings.

Database Setup for SQL Server

This page provides instructions for configuring Confluence to use the Microsoft SQL Server database.

**Step 1. Check the prerequisites**

Check the following before you start:

- Check that your version of SQL Server is supported. See Supported Platforms. If your version is not supported, please upgrade to a supported version of SQL Server before installing Confluence.
- If you have been evaluating Confluence and wish to transfer your data to a new database, consult the following guide first: Migrating to Another Database.
- If you are migrating from another database, consult the following guide first: Migrating to Another Database.

**Step 2. Install SQL Server**

If you do not already have an operational SQL Server database, download the installation package from the Microsoft SQL Server download page and follow the instructions on MSDN.
**Step 3. Set up your SQL Server database and user**

In this step you will create a database within SQL Server to hold your Confluence data, and a database user with authority to access that database.

1. Identify which character encoding to use. To do this, check the encoding currently used by your application server and Confluence. All three must use compatible encoding. For example, the default SQL Server encoding of UCS-2 is compatible with UTF-8.
2. Using your SQL administrator permissions, create a new database in SQL Server.
3. If you set your application server and Confluence to use an encoding incompatible with UCS-2, specify that character encoding for the database.
4. Set the default collation for the database to be 'SQL_Latin1_General_CP1_CS_AS' (case sensitive). You can do this by issuing the following SQL query:

   ```sql
   ALTER DATABASE <database_name> COLLATE SQL_Latin1_General_CP1_CS_AS
   ```

   Note: if you receive an error stating 'The database could not be exclusively locked to perform the operation', you may need to prevent other connections by setting the mode to single user for the transaction:

   ```sql
   ALTER DATABASE <database_name> SET SINGLE_USER WITH ROLLBACK IMMEDIATE;
   ALTER DATABASE <database_name> SET MULTI_USER;
   ```

5. Configure the database to use the isolation level, 'Read Committed with Row Versioning'. You can do this by issuing the following SQL query:

   ```sql
   SELECT is_read_committed_snapshot_on FROM sys.databases WHERE name= 'YourDatabase'
   ```

   Return value:
   1 = READ_COMMITTED_SNAPSHOT option is ON. Read operations under the read-committed isolation level are based on snapshot scans and do not acquire locks.
   0 = READ_COMMITTED_SNAPSHOT option is OFF (default). Read operations under the read-committed isolation level use share locks.

   ```sql
   ALTER DATABASE <database_name> SET READ_COMMITTED_SNAPSHOT ON WITH ROLLBACK IMMEDIATE;
   ```

6. Using your SQL administrator permissions, create a new SQL user account for Confluence (for example, `confluenceuser`). Give this user full create, read and write permissions for the database tables. Note that Confluence must be able to create its own schema.

**Step 4. Install Confluence and the SQL Server database driver**

Decide whether you will set up a direct JDBC connection or a datasource connection to SQL Server, to suit your environment. If unsure, choose direct JDBC.

Install Confluence if you have not done so already. See the Confluence Installation Guide.

- If you plan to set up a direct JDBC connection to SQL Server, you can run the Confluence installation and move directly on to the Confluence Setup Wizard, as described below. The SQL Server JDBC driver
is bundled with Confluence, as documented on this page: Database JDBC Drivers.

- If you plan to set up a datasource connection to SQL Server:
  - Stop immediately after the Confluence installation, before opening the Confluence Setup Wizard in your browser. If you have already got part-way through the Confluence Setup Wizard, stop at the database setup step. You will be able to restart the setup wizard at the same step later.
  - Follow the steps described in Configuring a SQL Server Datasource in Apache Tomcat.

**Step 5. Set up your database connection in the Confluence Setup Wizard**

Start Confluence, and go to the Confluence Setup Wizard in your browser. Follow these steps to set up the new configuration:

1. Follow the initial steps in the Confluence Setup Guide.
2. When prompted to choose an evaluation or production installation, choose production installation.
3. When prompted to choose an embedded or external database, select Microsoft SQL Server from the dropdown list and choose External Database.
4. Choose either the direct JDBC or the datasource connection, to suit the choice you made earlier when setting up the SQL Server database driver.
   - For the JDBC connection:
     - When prompted for a **Driver Class Name**, enter the following:
       ```
       net.sourceforge.jtds.jdbc.Driver
       ```
     - When prompted for the **Database URL**, use this format:
       ```
       jdbc:jtds:sqlserver://<server>:<port>/<database>
       ```
       - If MS SQL is clustered, use this format:
       ```
       jdbc:jtds:sqlserver://<server>:<port>/<database>;instance=<instance>
       ```
     - Enter the username (for example, confluenceuser) and password you chose earlier.
     - For a datasource connection: Set the **Datasource Name** to `java:comp/env/jdbc/confluence`

Congratulations! Confluence is now using your SQL Server database to store its data.

**Troubleshooting**

- If you get the following error message, verify that you have given the confluenceuser user all the required database permissions when connecting from localhost.

```
Could not successfully test your database: : Server connection failure during transaction. Due to underlying exception:
'java.sql.SQLException: Access denied for user 'confluenceuser'@'localhost' (using password: YES)'
```

- The following page contains common issues encountered when setting up your SQL Server database to work with Confluence: Known Issues for SQL Server.
- If Confluence complains that it is missing a class file, you may have placed the JDBC driver in the wrong folder.
- If none of the above describes your issue, please create a support ticket at http://support.atlassian.com and be sure to include your logs (found in `<CONFLUENCE-INSTALLATION>/logs` and `<CONFLUENCE-HO`
Configuring a SQL Server Datasource in Apache Tomcat

This page tells you how to set up a SQL Server datasource connection for Confluence.

**Step 1. Shut down Tomcat**

1. Run `bin/shutdown.sh` or `bin/shutdown.bat` to bring Tomcat down while you are making these changes.
2. Make a backup of your `<CONFLUENCE_HOME>/confluence.cfg.xml` file and your `<CONFLUENCE_INSTALLATION>/conf/server.xml` file, so that you can easily revert if you have a problem.

**Step 2. Install the SQL Server database driver**

1. Download the SQL Server JDBC driver:
   - Links are available on this page: [Database JDBC Drivers](#).
   - Unpack the archive file you have downloaded, and find the JAR file called something like this: `jtds-x.x.x.jar`, where `x.x.x` is a version number.
2. Alternatively, you can get the driver from your Confluence installation: `/confluence/WEB-INF/lib/jtds-x.x.x.jar`.
3. Put the JAR file into the `lib` folder of your Tomcat installation: `<TOMCAT-INSTALLATION>/lib`.

**On this page:**
- Step 1. Shut down Tomcat
- Step 2. Install the SQL Server database driver
- Step 3. Configure Tomcat
- Step 4. Configure the Confluence web application
- Step 5. Restart Tomcat

**Related pages:**
- Database Setup for SQL Server
- Confluence Home and other important directories
- Confluence Installation and Upgrade Guide

**Step 3. Configure Tomcat**

1. Edit the `conf/server.xml` file in your Tomcat installation.
2. Find the following lines:

   ```xml
   <Context path="" docBase="../confluence" debug="0" reloadable="true">
     <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
   </Context>
   ```

3. Insert the `DataSource` **Resource** element inside the `Context` element, directly after the opening `<Context` line, before `Manager`:

   ```xml
   <Resource name="jdbc/confluence" auth="Container" type="javax.sql.DataSource"
             username="yourDatabaseUser"
             password="yourDatabasePassword"
             driverClassName="net.sourceforge.jtds.jdbc.Driver"
             url="jdbc:jtds:sqlserver://localhost:1433/yourDatabaseName"
             maxActive="20"
             maxIdle="10"
             validationQuery="select 1" />
   ```

   - Replace the `username` and `password` parameters with the correct values for your database
   - In the `url` parameter, replace the word 'yourDatabaseName' with the name of the database your Confluence data will be stored in.

**Notes:**
• If switching from a direct JDBC connection to datasource, you can find the above details in your `<CONFLUENCE_HOME>/confluence.cfg.xml` file.

• Here are the configuration properties for Tomcat's standard data source resource factory (org.apache.tomcat.dbcp.dbcp.BasicDataSourceFactory):
  - driverClassName — Fully qualified Java class name of the JDBC driver to be used.
  - maxActive — The maximum number of active instances that can be allocated from this pool at the same time.
  - maxIdle — The maximum number of connections that can sit idle in this pool at the same time.
  - maxWait — The maximum number of milliseconds that the pool will wait (when there are no available connections) for a connection to be returned before throwing an exception.
  - password — Database password to be passed to our JDBC driver.
  - url — Connection URL to be passed to our JDBC driver. (For backwards compatibility, the property driverName is also recognized.)
  - user — Database username to be passed to our JDBC driver.
  - validationQuery — SQL query that can be used by the pool to validate connections before they are returned to the application. If specified, this query MUST be an SQL SELECT statement that returns at least one row.

• Why is the `validationQuery` element needed? When a database server reboots, or there is a network failure, all the connections in the connection pool are broken and this normally requires a Application Server reboot. However, the Commons DBCP (Database Connection Pool) which is used by the Tomcat application server can validate connections before issuing them by running a simple SQL query, and if a broken connection is detected, a new one is created to replace it. To do this, you will need to set the “validationQuery” option on the database connection pool.

Step 4. Configure the Confluence web application

1. Edit this file in your Confluence installation: `<CONFLUENCE_INSTALLATION>/confluence/WEB-INF/web.xml.
2. Insert the following element just before `</web-app>` near the end of the file:

   `<resource-ref>
   <description>Connection Pool</description>
   <res-ref-name>jdbc/confluence</res-ref-name>
   <res-type>javax.sql.DataSource</res-type>
   <res-auth>Container</res-auth>
   </resource-ref>`

If you are changing an existing Confluence installation over to using a Tomcat datasource:

1. Edit the `<CONFLUENCE_HOME>/confluence.cfg.xml` file.
2. Delete any line that contains a property that begins with `hibernate`.
3. Insert the following at the start of the `<properties>` section.

   `<property name="hibernate.setup">true</property>
   <property name="hibernate.dialect">net.sf.hibernate.dialect.SQLServerIntelDialect</property>
   <property name="hibernate.connection.datasource">java:comp/env/jdbc/confluence</property>`

Step 5. Restart Tomcat

Run `bin/startup.sh` or `bin/startup.bat` to start Tomcat with the new settings.

Database Setup For MySQL

This page provides instructions for configuring Confluence to use the MySQL database.

Step 1. Check the prerequisites
Check the following before you start:

- Check that your version of MySQL is supported. See Supported Platforms.
- If you have been evaluating Confluence and wish to transfer your data to a new database, consult the following guide first: Migrating to Another Database.
- If you are migrating from another database, consult the following guide first: Migrating to Another Database.

### Step 2. Install MySQL Server

If you do not already have an operational MySQL database server, install 'MySQL Community Edition'. Download the installation package from the MySQL download page and follow the instructions in the MySQL documentation.

**On this page:**
- Step 1. Check the prerequisites
- Step 2. Install MySQL Server
- Step 3. Configure MySQL Server
- Step 4. Set up your MySQL database and user
- Step 5. Install Confluence
- Step 6. Download and install the MySQL database driver
- Step 7. Check settings for internationalisation
- Step 8. Set up your database connection in the Confluence Setup Wizard
- Troubleshooting

**Related pages:**
- Configuring Database Character Encoding
- Database Configuration
- Known Issues for MySQL
- Confluence Installation and Upgrade Guide

### Step 3. Configure MySQL Server

In this step, you will configure your MySQL database server.

**Note:** If you intend to connect Confluence to an existing MySQL database server, we strongly recommend that you reconfigure this database server by running through the configuration steps in the MySQL installation wizard as described below.

**To configure MySQL Server:**

1. Run the MySQL installation wizard:
   a. If you are connecting Confluence to your existing MySQL server, choose Reconfigure Instance.
   b. Choose Advanced Configuration.
   c. Choose the type of MySQL Server that best suits your hardware requirements. This will affect the MySQL Server's usage of memory, disk and CPU resources. Refer to the MySQL documentation for further information.
   d. Choose Transactional Database Only to ensure that your MySQL database will use InnoDB as its default storage engine.
      It is highly recommended that you only use the InnoDB storage engine with Confluence. Avoid using the MyISAM storage engine as this can lead to data corruption.
   e. Set the InnoDB Tablespace settings to your requirements. (The default settings are acceptable.)
   f. Set the approximate number of concurrent connections permitted to suit your Confluence usage requirements. You can use one of the presets or enter a number manually. Refer to the MySQL documentation for further information.
   g. For the networking options, ensure the Enable TCP/IP Networking and Enable Strict Mode options are selected (default). Refer to the MySQL documentation on setting the networking and server SQL modes for further information.
   h. For the MySQL server's default character set, choose Best Support For Multilingualism (in other words, UTF-8). This will ensure Confluence's support for internationalisation. For more information, see Configuring Database Character Encoding.
   i. For the Windows configuration option, choose whether or not to install the MySQL Server as a...
Windows service. If your hardware is going to be used as a dedicated MySQL Server, you may wish to choose the options to Install As Windows Service (and Launch the MySQL Server automatically). Refer to the MySQL documentation for further information.

**Note:** If you choose not to install the MySQL Server as a Windows Service, you will need to ensure that the database service has been started before running Confluence.

1. Select **Modify Security Settings** to enter and set your MySQL Server (root) access password.
2. Edit the my.cnf file (often named my.ini on Windows operating systems) in your MySQL server. Locate the [mysqld] section in the file, and add or modify the following parameters:
   - Specify the default character set to be UTF-8:
     
     ```
     [mysqld]
     ...
     character-set-server=utf8
     collation-server=utf8_bin
     ...
     ```
   - Set the default storage engine to InnoDB:
     
     ```
     [mysqld]
     ...
     default-storage-engine=INNODB
     ...
     ```
   - Specify the value of max_allowed_packet to be at least 40M:
     
     ```
     [mysqld]
     ...
     max_allowed_packet=40M
     ...
     ```
   - Ensure the sql_mode parameter does not specify NO_AUTO_VALUE_ON_ZERO
     
     ```
     // remove this if it exists
     sql_mode = NO_AUTO_VALUE_ON_ZERO
     ```

     (Refer to MySQL Option Files for detailed instructions on editing my.cnf and my.ini.)

3. Restart your MySQL server for the changes to take effect:
   - On Windows, use the Windows Services manager to restart the service.
   - On Linux:
     - Run one of the following commands, depending on your setup: `/etc/init.d/mysqld stop` or `/etc/init.d/mysql stop` or `service mysqld stop`.
     - Then run the same command again, replacing 'stop' with 'start'.
   - On Mac OS X, run `sudo /Library/StartupItems/MySQLCOM/MySQLCOM restart`.

**Step 4. Set up your MySQL database and user**

In this step you will create a database within MySQL to hold your Confluence data, and a database user with authority to access that database.

**To create the database and user privileges:**

1. Run the `mysql` command as a MySQL super user. The default user is 'root' with a blank password.
2. Create an empty Confluence database schema by running this command:
CREATE DATABASE confluence CHARACTER SET utf8 COLLATE utf8_bin;

3. Create the Confluence database user by running this command. Replace 'confluenceuser' and 'confluencepass' with a username and password of your choice. If Confluence is not running on the same server as your MySQL database server, replace 'localhost' with the hostname or IP address of the Confluence server:

```
GRANT ALL PRIVILEGES ON confluence.* TO 'confluenceuser'@'localhost'
IDENTIFIED BY 'confluencepass';
```

Step 5. Install Confluence

Install Confluence if you have not done so already. See the Confluence Installation Guide. Stop immediately after the installation, before opening the Confluence Setup Wizard in your browser, and follow the steps below.

If you have already got part-way through the Confluence Setup Wizard, stop at the database setup step and follow the steps below. You will be able to restart the setup wizard at the same step later.

Step 6. Download and install the MySQL database driver

If you are upgrading Confluence to a later version, and you are already using the recommended MySQL driver (JDBC Connector/J 5.1), you can skip the instructions in this section. The Confluence upgrade task will automatically copy over your existing driver to the upgraded installation.

If you are installing Confluence, or you are upgrading Confluence and not using the recommended MySQL driver (JDBC Connector/J 5.1), follow the steps below.

Choose whether you will set up a direct JDBC connection or a datasource connection to MySQL, to suit your environment. If unsure, choose direct JDBC.

To set up a direct JDBC connection:

If you plan to set up a direct JDBC connection to MySQL, you will need to copy the MySQL JDBC driver to your Confluence installation.

1. Get the MySQL driver:
   - If you are installing Confluence, download the recommended MySQL driver. Links to the appropriate database drivers are available on this page: [Database JDBC Drivers](#). You can download either the .tar.gz or the .zip archive. Extract the driver JAR file (for example, mysql-connector-java-x.x.x-bin.jar, where x.x.x is a version number) from the archive.
   - If you are upgrading Confluence to a later version, and you are not using the recommended MySQL driver (JDBC Connector/J 5.1), copy the driver JAR file from your existing Confluence installation before you upgrade. The driver will be in the `<Confluence installation>/conf`/confluence/WEB-INF/lib` folder.

2. Copy the driver JAR file to the `<Confluence installation>/confluence/WEB-INF/lib` folder in your new or upgraded Confluence installation.

To set up a datasource connection:

If you plan to set up a datasource connection to MySQL, follow the steps described in Configuring a MySQL Datasource in Apache Tomcat.

Step 7. Check settings for internationalisation

If you are using a existing database, use the `status` command to verify database character encoding information. The results should be UTF-8. See Configuring Database Character Encoding.

Step 8. Set up your database connection in the Confluence Setup Wizard
Start Confluence, and go to the Confluence Setup Wizard in your browser. Follow these steps to set up the new configuration:

1. Follow the initial steps in the Confluence Setup Guide.
2. When prompted to choose an evaluation or production installation, choose **production installation**.
3. When prompted to choose an embedded or external database, select **MySQL** from the dropdown list and choose **External Database**.  
   *(Note: you’ll see a warning that a driver is required. You downloaded or copied the driver in step 6 so you can ignore this warning)*
   Choose either the direct JDBC or the datasource connection, to suit the choice you made earlier when setting up the MySQL database driver.
   - For the JDBC connection: Enter the username (for example, `confluenceuser`) and password you chose earlier.
   - For a datasource connection: Set the JNDI name to `java:comp/env/jdbc/confluence`

Congratulations! Confluence is now using your MySQL database to store its data.

**Troubleshooting**

- If you get the following error message, verify that you have given the `confluenceuser` user all the required database permissions when connecting from localhost.

```
Could not successfully test your database: : Server connection failure during transaction. Due to underlying exception:  
'java.sql.SQLException: Access denied for user 'confluenceuser'@'localhost' (using password: YES)'
```

- The following page contains common issues encountered when setting up your MySQL database to work with Confluence: Known Issues for MySQL
- If Confluence complains that it is missing a class file, you may have placed the JDBC driver in the wrong folder.
- If none of the above describes your issue, please create a support ticket at [http://support.atlassian.com](http://support.atlassian.com) and be sure to include your logs (found in `<CONFLUENCE-INSTALLATION>/logs` and `<CONFLUENCE-INSTALLATION>/conf/server.xml`).

**Configuring a MySQL Datasource in Apache Tomcat**

This page tells you how to set up a MySQL datasource connection for Confluence.

**Step 1. Shut down Tomcat**

1. Run `bin/shutdown.sh` or `bin/shutdown.bat` to bring Tomcat down while you are making these changes.
2. Make a backup of your `<CONFLUENCE_HOME>/confluence.cfg.xml` file and your `<CONFLUENCE-INSTALLATION>/conf/server.xml` file, so that you can easily revert if you have a problem.

**Step 2. Install the MySQL database driver**

1. Download the MySQL JDBC driver. Links are available on this page: [Database JDBC Drivers](http://support.atlassian.com).
2. Unpack the archive file you have downloaded, and find the JAR file called something like this: `mysql-connector-java-x.x.x-bin.jar`, where `x.x.x` is a version number.
3. Copy the JAR file into the `lib` folder of your Tomcat installation: `<TOMCAT-INSTALLATION>/lib`. 

*Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Step 3. Configure Tomcat

1. Edit the `conf/server.xml` file in your Tomcat installation.
2. Find the following lines:

```
<context path="" docBase="../confluence" debug="0" reloadable="true">
  <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
</context>
```

3. Insert the `DataSource` resource element within the `Context` element, directly after the opening `<Context>` line, before `</Manager>`:

```
<resource name="jdbc/confluence" auth="Container" type="javax.sql.DataSource"
  username="yourusername"
  password="yourpassword"
  driverClassName="com.mysql.jdbc.Driver"
  url="jdbc:mysql://localhost:3306/confluence?useUnicode=true&characterEncoding=utf8"
  maxActive="15"
  maxIdle="7"
  defaultTransactionIsolation="READ_COMMITTED"
  validationQuery="Select 1" />
```

- Replace the `username` and `password` parameters with the correct values for your database.
- In the `url` parameter, replace the word 'confluence' with the name of the database your Confluence data will be stored in.
- If you plan to use non-Latin characters, add `&useUnicode=true&characterEncoding=utf8` on the end of the above URL.

Notes

- If switching from a direct JDBC connection to a datasource connection, you can find the above details in your `<CONFLUENCE_HOME>/confluence.cfg.xml` file.
- The configuration properties for Tomcat’s standard datasource resource factory (`org.apache.tomcat.dbcp.dbcp.BasicDataSourceFactory`) are as follows:
  - `driverClassName` – Fully qualified Java class name of the JDBC driver to be used.
  - `maxActive` – The maximum number of active instances that can be allocated from this pool at the same time.
  - `maxIdle` – The maximum number of connections that can sit idle in this pool at the same time.
  - `maxWait` – The maximum number of milliseconds that the pool will wait (when there are no available connections) for a connection to be returned before throwing an exception.
  - `password` – Database password to be passed to your JDBC driver.
  - `url` – Connection URL to be passed to your JDBC driver. (For backwards compatibility, the `driverName` property is also recognised.)
  - `user` – Database username to be passed to your JDBC driver.
• validationQuery – SQL query that can be used by the pool to validate connections before they are returned to the application. If specified, this query must be an SQL SELECT statement that returns at least one row.

• Why is the validationQuery element needed? When a database server reboots, or there is a network failure, all the connections in the connection pool are broken and this normally requires an application server reboot. However, the Commons DBCP (Database Connection Pool) which is used by the Tomcat application server can validate connections before issuing them by running a simple SQL query, and if a broken connection is detected, a new one is created to replace it. To do this, you will need to set the validationQuery option on the database connection pool.

Step 4. Configure the Confluence web application

1. Edit this file in your Confluence installation: <CONFLUENCE_INSTALLATION>/confluence/WEB-INF/web.xml.
2. Insert the following element just before </web-app> near the end of the file:

   ```xml
   <resource-ref>
     <description>Connection Pool</description>
     <res-ref-name>jdbc/confluence</res-ref-name>
     <res-type>javax.sql.DataSource</res-type>
     <res-auth>Container</res-auth>
   </resource-ref>
   ```

If you are changing an existing Confluence installation over to using a Tomcat datasource:

1. Edit the <CONFLUENCE_HOME>/confluence.cfg.xml file.
2. Delete any line that contains a property that begins with hibernate.
3. Insert the following at the start of the <properties> section.

   ```xml
   <property name="hibernate.setup"><![CDATA[true]]></property>
   <property name="hibernate.dialect"><![CDATA[net.sf.hibernate.dialect.MySQLDialect]]></property>
   <property name="hibernate.connection.datasource"><![CDATA[java:comp/env/jdbc/confluence]]></property>
   ```

Step 5. Restart Tomcat

Run `bin/startup.sh` or `bin/startup.bat` to start Tomcat with the new settings.

Database Setup for PostgreSQL

This page provides instructions for configuring Confluence to use a PostgreSQL database.

Step 1. Check the prerequisites

Check the following before you start:

- Check that your version of PostgreSQL is supported. See Supported Platforms. If your version is not supported, please upgrade to a supported version of PostgreSQL before installing Confluence.
- If you have been evaluating Confluence and wish to transfer your data to a new database, consult the following guide first: Migrating to Another Database.
- If you are migrating from another database, consult the following guide first: Migrating to Another Database.

Step 2. Install PostgreSQL

If you do not already have an operational PostgreSQL database, install it now.
1. Download and install PostgreSQL. Please note the following information when installing PostgreSQL:
   - The password that you are prompted to provide during the installation process is for the 'postgres' account, which is the database root-level account, sometimes called the super user ('postgres'). Remember this username and password. You will need it each time you log in to the database.
   - The default port for PostgreSQL is 5432. If you decide to change the default port, please ensure that your new port number does not conflict with any services running on that port. You will also need to remember to update all further mentions of the database port.
   - Choose the locale that best fits your geographic location.
   - Do not launch Stack Builder at the completion of the installer.

**Step 3. Set up your PostgreSQL database and user**

Next you need to create a database within PostgreSQL to hold your Confluence data, and a database user with authority to access that database.

1. Create a database user (for example `confluenceuser`)
   - Your new user must be able to create database objects and create roles.
2. Create a database (for example `confluence`)
   - Owner is your new database user (for example `confluenceuser`)
   - Character encoding should be `utf8` encoding.

You can use pgAdmin as an alternative to the command line to complete this step. If you used the graphical installer when installing PostgreSQL, pgAdmin will be already installed on your computer.

**Step 4. Install Confluence and the PostgreSQL database driver**

Decide whether you will set up a direct JDBC connection or a datasource connection to PostgreSQL, to suit your environment. If unsure, choose direct JDBC.

Install Confluence if you have not done so already. See the Confluence Installation Guide.

- If you plan to set up a direct JDBC connection to PostgreSQL, you can run the Confluence installation and move directly on to the Confluence Setup Wizard, as described below. The PostgreSQL JDBC driver is bundled with Confluence, as documented on this page: Database JDBC Drivers.
- If you plan to set up a datasource connection to PostgreSQL:
  - Stop immediately after the Confluence installation, before opening the Confluence Setup Wizard in your browser. If you have already got part-way through the Confluence Setup Wizard, stop at the database setup step. You will be able to restart the setup wizard at the same step later.
  - Follow the steps described in Configuring a PostgreSQL Datasource in Apache Tomcat.

**Step 5. Set up your database connection in the Confluence Setup Wizard**

Start Confluence, go to the Confluence Setup Wizard in your browser, and follow these steps:

1. When prompted to choose an evaluation or production installation, choose production installation.
2. When prompted to choose an embedded or external database, select PostgreSQL from the dropdown
list and choose External Database.

3. Choose either the direct JDBC or the datasource connection, to suit the choice you made earlier.
   - For the JDBC connection:
     - When prompted for a **Driver Class Name**, enter:
       ```
       org.postgresql.Driver
       ```
     - When prompted for the **Database URL**, use this format:
       ```
       jdbc:postgresql://<server>:<port>/<database>
       ```
       For example: `jdbc:postgresql://localhost:5432/confluence`

     **Note:** If you need to connect to an SSL database, add the `ssl=true` parameter in the database URL. For example: `jdbc:postgresql://localhost:5432/confluence?ssl=true`

     - Enter the username (for example `confluenceuser`) and password you chose earlier when setting up your Confluence database.

   - For a **datasource connection**: Set the **Datasource Name** to the following: `java:comp/env/jdbc/confluence`

That's it - Confluence is now using your PostgreSQL database to store its data.

**Screenshot: Setting up the PostgreSQL JDBC connection in the Confluence Setup Wizard**

---

**Notes**

- If the server that is hosting the PostgreSQL database is not the same server as Confluence, then please ensure that the Confluence server can contact the database server. Please also refer to the *PostgreSQL documentation* on how to set up `pg_hba.conf`. If the `pg_hba.conf` file is not set properly, remote communication to the PostgreSQL server will fail.
- Running SQL queries: For ongoing maintenance of your server, you can continue to use PGAdmin III as
Troubleshooting

- If you get the following error message, verify that you have given the `confluenceuser` user all the required database permissions when connecting from `localhost`.

```
Could not successfully test your database: : Server connection failure during transaction. Due to underlying exception: 'java.sql.SQLException: Access denied for user 'confluenceuser'@'localhost' (using password: YES)'
```

- If Confluence complains that it is missing a class file, you may have placed the JDBC driver in the wrong folder.
- If you are unable to connect to the database from Confluence and they are on different machines, most likely you have a firewall in between the two machines or your `pg_hba.conf` file is misconfigured. Verify that your firewall is set to allow connections through 5432 or double check your `hba configuration`.
- The following page contains common issues encountered when setting up your PostgreSQL database to work with Confluence: Known issues for PostgreSQL.
- If none of the above describes your issue, please create a support ticket at http://support.atlassian.com and be sure to include your logs (found in `<CONFLUENCE-INSTALLATION>/logs` and `<CONFLUENCE-HOME>/logs`).

Configuring a PostgreSQL Datasource in Apache Tomcat

This page tells you how to set up a PostgreSQL datasource connection for Confluence.

Step 1. Shut down Tomcat

1. Run `bin/shutdown.sh` or `bin/shutdown.bat` to bring Tomcat down while you are making these changes.
2. Make a backup of your `<CONFLUENCE_HOME>/confluence.cfg.xml` file and your `<CONFLUENCE-INSTALLATION>/conf/server.xml`, so that you can easily revert if you have a problem.

Step 2. Install the PostgreSQL Server database driver

1. Download the PostgreSQL Server JDBC driver JAR file.
   - Links are available on this page: Database JDBC Drivers.
   - Alternatively, you can get the driver from your Confluence installation: `/confluence/WEB-INF/lib/postgresql-x.x-x.jdbcx.jar`, where 'x' represents a version number.
2. Copy the JAR file into the `lib` folder of your Tomcat installation: `<TOMCAT-INSTALLATION>/lib`.

On this page:

- Step 1. Shut down Tomcat
- Step 2. Install the PostgreSQL Server database driver
- Step 3. Configure Tomcat
- Step 4. Configure the Confluence web application
- Step 5. Restart Tomcat

Related pages:

- Database Setup for PostgreSQL

Step 3. Configure Tomcat

1. Edit the `conf/server.xml` file in your Tomcat installation.
2. Find the following lines:

```
<Context path="" docBase="..:/confluence" debug="0" reloadable="true">
  <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
```

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
3. Insert the DataSource Resource element inside the Context element, directly after the opening <Context> line, before Manager:

```xml
<Resource name="jdbc/confluence" auth="Container" type="javax.sql.DataSource" username="postgres" password="postgres" driverClassName="org.postgresql.Driver" url="jdbc:postgresql://localhost:5432/yourDatabaseName" maxActive="20" maxIdle="10" validationQuery="select 1" />
```

- Replace the username and password parameters with the correct values for your database
- In the url parameter, replace the word 'yourDatabaseName' with the name of the database your Confluence data will be stored in.

Notes:

- If switching from a direct JDBC connection to datasource, you can find the above details in your `<CONFLUENCE_HOME>/confluence.cfg.xml` file.
- Here are the configuration properties for Tomcat's standard data source resource factory (org.apache.tomcat.dbcp.dbcp.BasicDataSourceFactory):
  - driverClassName — Fully qualified Java class name of the JDBC driver to be used.
  - maxActive — The maximum number of active instances that can be allocated from this pool at the same time.
  - maxIdle — The maximum number of connections that can sit idle in this pool at the same time.
  - maxWait — The maximum number of milliseconds that the pool will wait (when there are no available connections) for a connection to be returned before throwing an exception.
  - password — Database password to be passed to our JDBC driver.
  - url — Connection URL to be passed to our JDBC driver. (For backwards compatibility, the property driverName is also recognized.)
  - user — Database username to be passed to our JDBC driver.
  - validationQuery — SQL query that can be used by the pool to validate connections before they are returned to the application. If specified, this query MUST be an SQL SELECT statement that returns at least one row.

- Why is the validationQuery element needed? When a database server reboots, or there is a network failure, all the connections in the connection pool are broken and this normally requires a Application Server reboot. However, the Commons DBCP (Database Connection Pool) which is used by the Tomcat application server can validate connections before issuing them by running a simple SQL query, and if a broken connection is detected, a new one is created to replace it. To do this, you will need to set the "validationQuery" option on the database connection pool.

Step 4. Configure the Confluence web application

1. Edit this file in your Confluence installation: `<CONFLUENCE_INSTALLATION>/confluence/WEB-INF/` `web.xml`
2. Insert the following element just before `</web-app>` near the end of the file:

```xml
<resource-ref>
  <description>Connection Pool</description>
  <res-ref-name>jdbc/confluence</res-ref-name>
  <res-type>javax.sql.Datasource</res-type>
  <res-auth>Container</res-auth>
</resource-ref>
```

If you are changing an existing Confluence installation over to using a Tomcat datasource:

1. Edit the `<CONFLUENCE_HOME>/confluence.cfg.xml` file.
2. Delete any line that contains a property that begins with `hibernate`. 

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
3. Insert the following at the start of the <properties> section:

```xml
<property name="hibernate.setup"><![CDATA[true]]></property>
<property name="hibernate.dialect"><![CDATA[net.sf.hibernate.dialect.PostgreSQLDialect]]></property>
<property name="hibernate.connection.datasource"><![CDATA[java:comp/env/jdbc/confluence]]></property>
```

Step 5. Restart Tomcat

Run `bin/startup.sh` or `bin/startup.bat` to start Tomcat with the new settings.

Embedded HSQLDB Database

The Confluence installation includes an embedded HSQLDB database, supplied for the purpose of evaluating Confluence.

If you are using the embedded database, the database files are stored in the \database directory under your Confluence Home and other important directories.

**Note:** The embedded HSQLDB database is not suitable for production Confluence sites.

Production sites should use an external database. See our [guide to database configuration](#). When using the default HSQLDB database, you run the risk of irrecoverable data loss because HSQLDB is not transaction safe.

- Corruption is occasionally encountered after sudden power loss. It can usually be corrected using the data recovery procedure documented in our [knowledge base](#).
- HSQLDB is suitable for evaluation purposes, but the risk can only be eliminated by switching databases. This is essential when you move from an evaluation to a production site. External databases may also provide superior speed and scalability.

To find out if you are still using the embedded database, go to [General Configuration > Atlassian Support Tools > Health Check](#).

**Related pages:**
- Confluence Home and other important directories
- Database Configuration

Connecting to HSQLDB using DBVisualizer or HSQL database manager

The purpose of this guide is to walk you through connecting to Confluence’s embedded Hypersonic SQL Database using the Database Administration tool DBVisualizer or HSQLDB’s database manager.

Below are step by step instructions on how to Configure DBVisualizer or HSQLDB Database Manager and connect it to HSQLDB.

**Connecting using DB Visualizer**

**Prerequisites**

1. Download and install the latest copy of DBVisualizer.
2. You will also need to download a copy (preferably the latest version) of HSQLDB
3. Extract the contents of the HSQLDB archive
4. Ensure that Confluence is not running.

**Connection Procedure**

Please ensure that you read and follow the instructions below carefully.

**On this page:**
- Connecting using DB Visualizer
- Connecting using HSQL Database Manager

**Remember to backup your `<confluence-home>/database` folder before attempting any**
1. Enter Connection Name

   1. Click on the icon highlighted in Red
   2. Enter an identifiable name for the connection. e.g. conf2.5.4-std

2. Select JDBC Driver

   1. From the drop down list select **HSQLDB Embedded**
   2. Click on **Load Driver Files**
   3. Browse to directory where the HSQLDB.jar file is located. Confluence bundles this and it can be found at `<confluence-installation>/confluence/WEB-INF/lib/hsqldb-*`.jar.

3. Select Database Path

   1. **Browse to your** `<Confluence-Home>` **directory**
   2. **Open the Database folder**
   3. **Select the confluencedb.properties file**

4. Enter Connection Details
1. Remove the ".properties" from the end of confluencedb
2. Type in sa for the username
3. Leave the password field blank

*refer to the example screenshot above if you are unsure*

5. Connect to embedded Database

1. Click on Test Connection to verify that the details are correct.
2. Click on "Finish" to complete the setup
3. Select the connection from the list on the left hand side.
4. You can now click on "Connect" to connect to the embedded database.

**Connecting using HSQL Database Manager**

Alternatively, you can use HSQLDB's database manager. Just copy the value of hibernate.connection.url in confluence.cfg.xml as the URL and you're good to go.

Below are step by step instructions on how to Configure HSQL DB Manager and connect it to HSQLDB:
1. Download and extract the latest copy of HSQL DB
2. Navigate to hsqldb-x-x-x/hsqldb/bin, and run runManager.bat
3. Copy the URL value in your hibernate.connection.url parameter in ConfluenceHomeDirectory/confluence.cfg.xml. Example:

   ```xml
   <property name="hibernate.connection.url">jdbc:hsqldb:C:\reproduce\atlassian-confluence-5.4.4\c544homeHSQL/database/confluencedb;hsqldb.tx=MVCC</property>
   ``

   For the example above, you should copy: jdbc:hsqldb:C:\reproduce\atlassian-confluence-5.4.4\c544homeHSQL/database/confluencedb;hsqldb.tx=MVCC

4. In HSQLDB Manager's Connect dialog, paste the URL

   ![HSQLDB Manager Connect dialog](image)

   Leave the Password empty, and User as "SA"

5. Click OK

You can now run queries in the query window. For example:
Troubleshooting the Embedded HSQLDB Database

**Note:** HSQLDB should not be used as a production database. It is included for evaluation purposes only. For more information, see [Embedded HSQLDB Database](#).

Resolving the error: "User not found: SA"

Please refer to our [knowledge base article](#).

Hibernate logging

You may find it useful to [enable detailed Hibernate logging](#) when debugging problems with HSQLDB.

Connecting to HSQLDB

You may need to connect to the database to retrieve information, or for troubleshooting purposes. Please follow the instructions on [Connecting to HSQLDB using DBVisualizer or HSQL database manager](#).

**Related pages:**
- Database Configuration
- Confluence Administrator's Guide

Migrating to Another Database

This document describes how to migrate your Confluence data from your existing database to another database. The instructions are designed primarily for migrating from an evaluation to a production database. Large data sets will require third party database migration tools.

This page covers the following scenarios:

- You should use this page when moving from the embedded database to an external database.
- Provided your dataset is not large, you may use this method to move from one type of external database to another. For example, from Oracle to PostgreSQL.
- Similarly, if the dataset is not large, you can use this method to . Note: You do not need to migrate your upgrade your database to a new version of the same databasedata if you are upgrading the database in place.

**Note:** If you are simply moving your database from one server to another you can just change the JDBC URL in `<confluence.home>/confluence.cfg.xml` (if you are using a direct JDBC connection) or in the definition of your datasource (if you are connecting via a datasource).

**Limitations of database migration**

**Note:** The XML export built into Confluence is not suited for the backup or migration of large data sets. There are a number of third party tools that may be able to assist you with the data migration. If you would like help in selecting the right tool, or help with the migration itself, we can put you in touch with one of the [Atlassian Experts](#).
Database migration

There are two ways you can perform the migration, both described on this page:

1. **Method one** is the standard procedure.
2. **Use method two** if the total size of attachments in your installation exceeds 500MB.

<table>
<thead>
<tr>
<th>On this page:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Limitations of database migration</strong></td>
</tr>
<tr>
<td><strong>Database migration</strong></td>
</tr>
<tr>
<td><strong>Method one – standard procedure</strong></td>
</tr>
<tr>
<td>• Step 1: Take note of your add-ons</td>
</tr>
<tr>
<td>• Step 2: Back up your data</td>
</tr>
<tr>
<td>• Step 3: Set up the new database</td>
</tr>
<tr>
<td>• Step 4. Install Confluence (same version number) in a new location</td>
</tr>
<tr>
<td>• Step 5. Download and install the database driver if necessary</td>
</tr>
<tr>
<td>• Step 6. Run the Confluence setup wizard and copy your data to your new database</td>
</tr>
<tr>
<td>• Step 7. Re-install your add-ons</td>
</tr>
<tr>
<td>• Step 8. Check settings for new machine</td>
</tr>
<tr>
<td><strong>Method two – for installations with a large volume of attachments</strong></td>
</tr>
<tr>
<td>• Before you start</td>
</tr>
<tr>
<td>• Step 1: Take note of your add-ons</td>
</tr>
<tr>
<td>• Step 2: Back up your data</td>
</tr>
<tr>
<td>• Step 3: Set up the new database</td>
</tr>
<tr>
<td>• Step 4. Install Confluence (same version number) in a new location</td>
</tr>
<tr>
<td>• Step 5. Download and install the database driver if necessary</td>
</tr>
<tr>
<td>• Step 6. Run the Confluence setup wizard and copy your data to your new database</td>
</tr>
<tr>
<td>• Step 7: Copy your attachments across</td>
</tr>
<tr>
<td>• Step 8. Re-install your add-ons</td>
</tr>
<tr>
<td>• Step 9. Check settings for new machine</td>
</tr>
<tr>
<td>• A note about case sensitivity in your database</td>
</tr>
<tr>
<td><strong>Troubleshooting</strong></td>
</tr>
</tbody>
</table>

**Related pages:**
- Database Configuration
- Confluence Installation Guide
- Confluence Home and other important directories

**Method one – standard procedure**

**Step 1: Take note of your add-ons**

Take note of the add-ons (plugins) currently installed and enabled in Confluence, so that you can reinstate them later. Make a note of the following for each add-on:
- Add-on name
- Version
- Enabled or disabled status. This is useful if you have enabled or disabled modules yourself, making your configuration differ from the default.

**Step 2: Back up your data**

1. Create an XML backup of your existing data, via the **Confluence administration console**. See Manually Backing Up the Site. Make a note of the location where you put the XML file. You will need it later to import your Confluence data into your new database.
2. Shut down Confluence.
3. Make a copy of the Confluence Home and other important directories. This is a precautionary measure, to ensure you can recover your data if it is mistakenly overwritten.

4. If you are using an external database, make a separate backup using the utilities that were installed with that database. This also is a precautionary measure.

**Step 3: Set up the new database**

Choose the database setup instructions for your new database, and follow those instructions to do the following:

- Install the database server.
- Perform any required configuration of the database server, as instructed.
- Add the Confluence database and user. Make a note of the username and password that you define in this step. You will need them later, when running the Confluence Setup Wizard.

**Step 4. Install Confluence (same version number) in a new location**

Now you will install Confluence again, with a different home directory path and installation path.

**Note:** You must use the same version of Confluence as the existing installation. (If you want to upgrade Confluence, you must do it as a separate step.) For example, if your current site is running Confluence 5.1.2, your new installation must also be Confluence 5.1.2.

When running the Confluence installer:

- Choose Custom Install. (Do not choose to upgrade your existing installation.)
- Choose a new destination directory. This is the installation directory for your new Confluence. It must not be the same as the existing Confluence installation.
- Choose a new home directory. This is the data directory for your new Confluence. It must not be the same as the existing Confluence installation.

**Step 5. Download and install the database driver if necessary**

Note that Confluence bundles some database drivers, but you'll need to install the driver yourself if it is not bundled. Follow the database setup instructions for your new database, to download and install the database driver if necessary.

**Step 6. Run the Confluence setup wizard and copy your data to your new database**

When running the Confluence setup wizard:

- Enter your license key, as usual.
- Choose Production Installation as the installation type.
- In the database configuration step, choose your new database type from the dropdown menu, then choose External Database.
- Choose the connection type: Direct JDBC or Datasource. If you are not sure which, choose 'Direct JDBC'. This is the most common connection type.
- When prompted for the database user and password, supply the credentials you defined earlier when adding the Confluence database to your database server.
- On the load content step, choose Restore From Backup. This is where you will import the data from your XML backup. There are two options for accessing the XML file:
  - Browse to the location of your XML backup on your network, and choose Upload and Restore.
  - Alternatively, put the XML file in the Confluence home directory of the new site (<CONFLUENCE-HOME-DIRECTORY>/restore) then choose Restore.

**Note:** If you choose not to restore during the Confluence setup wizard, you can do the import later. Go to the Confluence administration console and choose to restore an XML backup. See Site Backup and Restore.

Re-install any add-ons (plugins) that are not bundled with Confluence.

Use the same version of the add-on as on your old Confluence site. **Step 8. Check settings for new machine**

The data created by the add-ons will already exist in your new Confluence site, because it is included in the XML backup.

you are moving Confluence to a different machine, you need to check the following settings:

- Configure your new base URL. See Configuring the Server Base URL.
- Check your application links. See Linking to Another Application.
- Update any gadget subscriptions from external sites pointing to this Confluence site. For example, if your JIRA site subscribes to Confluence gadgets, you will need to update your JIRA site. See Adding JIRA
Gadgets to a Confluence Page.
• Review any other resources that other systems are consuming from Confluence.

Method two – for installations with a large volume of attachments

Before you start
Before proceeding with these instructions please check the following.
• Your existing installation must be Confluence 2.2 or later.
• Your attachments must be stored in the file system, not in your database. (To migrate between attachment storage systems, see Attachment Storage Configuration.)

The instructions below will only work if both of the above are true.

Step 1: Take note of your add-ons
Take note of the add-ons (plugins) currently installed and enabled in Confluence, so that you can reinstate them later. Make a note of the following for each add-on:
• Add-on name
• Version
• Enabled or disabled status. This is useful if you have enabled or disabled modules yourself, making your configuration differ from the default.

Step 2: Back up your data
1. Create an XML backup of your existing data, via the Confluence administration console. See Manually Backing Up the Site. Make a note of the location where you put the XML file. You will need it later to import your Confluence data into your new database.
2. Shut down Confluence.
3. Make a copy of the attachments directory (<CONFLUENCE-HOME-DIRECTORY>\attachments) in your Confluence Home directory. You will need it later to copy your Confluence attachments data into your new Confluence installation.
4. If you are using an external database, make a separate backup using the utilities that were installed with that database. This also is a precautionary measure.

Step 3: Set up the new database
Choose the database setup instructions for your new database, and follow those instructions to do the following:
• Install the database server.
• Perform any required configuration of the database server, as instructed.
• Add the Confluence database and user. Make a note of the username and password that you define in this step. You will need them later, when running the Confluence Setup Wizard.

Step 4. Install Confluence (same version number) in a new location
Now you will install Confluence again, with a different home directory path and installation path.

Note: You must use the same version of Confluence as the existing installation. (If you want to upgrade Confluence, you must do it as a separate step.) For example, if your current site is running Confluence 5.1.2, your new installation must also be Confluence 5.1.2.

When running the Confluence installer:
• Choose Custom Install. (Do not choose to upgrade your existing installation.)
• Choose a new destination directory. This is the installation directory for your new Confluence. It must not be the same as the existing Confluence installation.
• Choose a new home directory. This is the data directory for your new Confluence. It must not be the same as the existing Confluence installation.

Step 5. Download and install the database driver if necessary
Note that Confluence bundles some database drivers, but you’ll need to install the driver yourself if it is not bundled. Follow the database setup instructions for your new database, to download and install the database driver if necessary.
Step 6. Run the Confluence setup wizard and copy your data to your new database

When running the Confluence setup wizard:

- Enter your license key, as usual.
- Choose Production installation as the installation type.
- In the database configuration step, choose your new database type from the dropdown menu, then choose External Database.
- Choose the connection type: Direct JDBC or DataSource. If you are not sure which, choose ‘Direct JDBC’. This is the most common connection type.
- When prompted for the database user and password, supply the credentials you defined earlier when adding the Confluence database to your database server.
- On the load content step, choose Restore From Backup. This is where you will import the data from your XML backup. There are two options for accessing the XML file:
  - Browse to the location of your XML backup on your network, and choose Upload and Restore.
  - Alternatively, put the XML file in the Confluence home directory of the new site (<CONFLUENCE-HOME-DIRECTORY>\restore) then choose Restore.

Note: If you choose not to restore during the Confluence setup wizard, you can do the import later. Go to the Confluence administration console and choose to restore an XML backup. See Site Backup and Restore.

Copy the contents of the attachments directory (<CONFLUENCE-HOME-DIRECTORY>\attachments) from your old Confluence Home directory to your new Confluence Home directory.

Step 8. Re-install your add-ons

Re-install any add-ons (plugins) that are not bundled with Confluence.

Use the same version of the add-on as on your old Confluence site. The data created by the add-ons will already exist in your new Confluence site, because it is included in the XML backup.

you are moving Confluence to a different machine, you need to check the following settings:

- Configure your new base URL. See Configuring the Server Base URL.
- Check your application links. See Linking to Another Application.
- Update any gadget subscriptions from external sites pointing to this Confluence site. For example, if your JIRA site subscribes to Confluence gadgets, you will need to update your JIRA site. See Adding JIRA Gadgets to a Confluence Page.
- Review any other resources that other systems are consuming from Confluence.

A note about case sensitivity in your database

‘Collation’ refers to a set of rules that determine how data is sorted and compared. Case sensitivity is one aspect of collation. Other aspects include sensitivity to kana (Japanese script) and to width (single versus double byte characters).

Case sensitive or case insensitive collation – how should you create your Confluence database? What about when you are migrating your existing Confluence instance from one database to another?

Setting up a New Confluence Instance

For new Confluence instances, we recommend using case sensitive collation for your Confluence database. This is the default collation type used by many database systems.

Note: Even if the database is configured for case sensitive collation, Confluence reduces all usernames to lower case characters before storing them in the database. For example, this means that 'joebloggs', 'joeBloggs' and 'JoeBloggs' will be treated as the same username.

Migrating an Existing Confluence Instance to a Different Database

The default Confluence configuration uses case sensitive database collation. This is typical of databases created under default conditions. If you are migrating from this type of configuration to a new database, we recommend that the new database uses case sensitive collation. If you use case insensitive collation, you may encounter data integrity problems after migration (for example, via an XML import) if data stored within your original Confluence site required case sensitive distinctions.

Troubleshooting

If you are unable to restore your XML backup, consult our troubleshooting guide.
Configuring Database Character Encoding

The database used with Confluence should be configured to use the same character encoding as Confluence. The recommended encoding is Unicode UTF-8 (the equivalent for Oracle databases is AL32UTF8).

There are two places where character encoding may need to be configured:

- when creating the database
- when connecting to the database (JDBC connection URL or properties).

The configuration details for each type of database are different. Some examples are below.

On this page:
- JDBC connection settings
- Creating a UTF-8 database
- Updating existing database to UTF-8

⚠️ The information on this page does not apply to Confluence Cloud.

JDBC connection settings

MySQL

Append "useUnicode=true to your JDBC URL:

```
jdbc:mysql://hostname:port/database?useUnicode=true&characterEncoding=utf8
```

⚠️ If you are modifying confluence.cfg.xml directly rather than via the Confluence Installation GUI, you'll need to escape out the & in the URL string as this is a reserved XML token and will break the syntax when the XML is parsed. An effective URL could be similar to:

```
<property name="hibernate.connection.url">jdbc:mysql://hostname:port/database?useUnicode=true&amp;characterEncoding=utf8</property>
```

Creating a UTF-8 database

MySQL

1. Create a UTF-8 database with binary UTF-8 collation.
   - Binary UTF-8 provides case-sensitive collation.

   ```
   CREATE DATABASE confluence CHARACTER SET utf8 COLLATE utf8_bin;
   ```

2. You will also need to set the Server Character set to utf8. This can be done by adding the following in my.ini for Windows or my.cnf for other OS. It has to be declared in the Server section, which is the section after [mysqld]:

   ```
   Server Character Set = utf8
   ```
If the above option does not work, try using `character_set_server=utf8` in lieu of `default-character-set=utf8`.

3. Use the `status` command to verify database character encoding information.

**Screenshot: Using the Status Command to Verify Database Character Encoding**

```sql
mysql> CREATE DATABASE confluence CHARACTER SET utf8 COLLATE utf8_bin;
Query OK, 1 row affected (0.02 sec)

mysql> show databases;
+--------------------+
| Database           |
+--------------------+
| information_schema |
| confluence         |
| confluencedb       |
| mysql              |
| test               |
+--------------------+
5 rows in set (0.02 sec)

mysql> use confluence;
Database changed

mysql> status;
```

In some cases, the individual tables collation and character encoding may differ from the one that the database as a whole has been configured to use. Please use the command below to ensure all tables within your Confluence database are correctly configured to use UTF-8 character encoding and binary UTF-8 collation:

```sql
use confluence;
show table status;
```

Check for the value listed under the **Collation** column, to ensure it has been set to `utf8_bin` (that is, case-sensitive) collation for all tables.

If not, then this can be changed by the following command, executed for each table in the Confluence database:

```sql
ALTER TABLE tablename CONVERT TO CHARACTER SET utf8 COLLATE utf8_bin;
```

Please substitute the `<tablename>` above, with each table within the confluence database.

Relevant MySQL manual for more detailed explanation:

- **Specifying Character Sets and Collations documentation.**
- **Connection Character Sets and Collations.**
• **SHOW TABLE STATUS Syntax.**
• **ALTER TABLE Syntax.**

**PostgreSQL**

```sql
CREATE DATABASE confluence WITH ENCODING 'UNICODE';
```

Or from the command-line:

```bash
$ createdb -E UNICODE confluence
```

For more information see the [PostgreSQL documentation](https://www.postgresql.org/docs/).

**For PostgreSQL running under Windows**

Please note that international characters sets are only fully supported and functional when using PostgreSQL 8.1 and above under Microsoft Windows.

**For PostgreSQL running under Linux**

> **Please make sure you check the following to ensure proper handling of international characters in your database**

When PostgreSQL creates an initial database cluster, it sets certain important configuration options based on the host environment. The command responsible for creating the PostgreSQL environment `initdb` will check environment variables such as `LC_CTYPE` and `LC_COLLATE` (or the more general `LC_ALL`) for settings to use as database defaults related to international string handling. As such it is important to make sure that your PostgreSQL environment is configured correctly before you install Confluence.

To do this, connect to your PostgreSQL instance using `psql` and issue the following command:

```sql
SHOW LC_CTYPE;
```

If `LC_CTYPE` is set to either "C" or "POSIX" then certain string functions such as converting to and from upper and lower case will not work correctly with international characters. Correct settings for this value take the form `<LOCAL>.<ENCODING>` (for example).

If your `LC_CTYPE` is incorrect please check the PostgreSQL documentation for information on configuring database localisation. It is not easy to change these settings with a database that already contains data.

### Updating existing database to UTF-8

**MySQL database with existing data**

> **For an existing database**

If you're using a existing database, confirm the Character Encoding by executing the query:

```sql
SHOW VARIABLES LIKE 'character%'; and SHOW VARIABLES LIKE 'collation%';
```

The results should be UTF-8.

> **Before proceeding with the following changes, please backup your database.**

This example shows how to change your database from latin1 to utf8, where your database is named "confluence".

1. Dump the database (except the plugindata table) to a text file using the `mysqldump` tool from the command-line:
mysqldump -p --default-character-set=latin1 -u <username> --skip-set-charset --ignore-table="\`confluence`.plugindata" --ignore-table="\`confluence`.attachmentdata" confluence > confluence_database.sql

2. Dump the plugindata and attachmentdata tables to a text file using mysqldump separately. This is done separately as the recode step below can corrupt the binary data in these tables:

```
mysqldump -p --default-character-set=latin1 -u <username> --skip-set-charset confluence attachmentdata plugindata > confluence_blobtables.sql
```

3. Copy `confluence_database.sql` to `confluence_utf8.sql`

4. Open `confluence_utf8.sql` in a text editor and change all character sets from 'latin1' to 'utf8'

5. Encode all the latin1 characters as UTF-8:

```
(recode latin1..utf8 confluence_utf8.sql (the recode utility is described at http://directory.fsf.org/recode.html; it can actually be downloaded from http://recode.progiciels-bpi.ca/, and is available for Ubuntu via apt-get)
```

In MySQL:

```
1. DROP DATABASE confluence;
2. CREATE DATABASE confluence CHARACTER SET utf8 COLLATE utf8_bin;
```

Reimport the UTF-8 text file, and also the plugindata and attachmentdata dumps:

```
1. mysql -u <username> -p --default-character-set=utf8 --max_allowed_packet=64M confluence < /home/confluence/confluence_utf8.sql
2. mysql -u <username> -p --default-character-set=latin1 --max_allowed_packet=64M confluence < /home/confluence/confluence_blobtables.sql
```

To support large imports, the parameter `--max_allowed_packet=64M` used above sets the maximum size of an SQL statement to be very large. In some circumstances, you may need to increase it further, especially if attachments are stored in the database.

Finally, since the plugindata and attachmentdata tables were not actually converted before, you need to instruct MySQL to convert all the text fields manually:

```
1. ALTER TABLE plugindata CONVERT TO CHARACTER SET utf8;
2. ALTER TABLE attachmentdata CONVERT TO CHARACTER SET utf8;
```

Testing database encoding

See Troubleshooting Character Encodings for a number of tests you can run to ensure your database encoding is correct.

RELATED TOPICS:

Configuring Character Encoding
Known Issues for MySQL
Configuring database query timeout

If database queries are taking too long to perform, and your application is becoming unresponsive, you can configure a timeout for database queries. There is no default timeout in Confluence.

To configure a database query timeout, do the following on your test server:

1. Shut down Confluence.

2. Extract `databaseSubsystemContext.xml` from the `confluence-x.x.x.jar` that is in `confluence/WEB-INF/lib/`, and put a copy in `confluence/WEB-INF/classes/`.

3. Edit `confluence/WEB-INF/classes/databaseSubsystemContext.xml` to add the `defaultTimeout` property to the "transactionManager" bean:
<bean id="transactionManager"
class="org.springframework.orm.hibernate.HibernateTransactionManager">
  <property name="sessionFactory">
    <ref bean="sessionFactory"/>
  </property>
  <property name="defaultTimeout" value="120"/>
</bean>

The timeout is measured in seconds and will forcibly abort queries that take longer than this. In some cases, these errors are not handled gracefully by Confluence and will result in the user seeing the Confluence error page.

4. Start Confluence.

Once the timeout is working properly in your test environment, migration the configuration change to Confluence.

⚠️ You will need to reapply these changes when upgrading Confluence, as the original databaseSubsystemContext.xml file changes from version to version.

Troubleshooting External Database Connections

A common administration issue when configuring Confluence is identifying database connectivity problems. This page tells you about a helper utility, in the form of a JSP page, that can help you to isolate database connectivity issues. It checks whether you can connect to a database with your application server. If your application server cannot connect to the database, Confluence will not be able to connect to the database either.

Introduction to the Atlassian Database Check Utility

You can use this utility to:

- Check that your application server can successfully query your database, either via immediate JDBC connectivity or a datasource in the context of your application server.
- Pinpoint problems in your configuration which may occur if the above is failing.

This is what the utility does:

- Check that a JDBC driver can be loaded into memory and view what is already loaded.
- Connect to a JDBC URL and do a 'select 1' from the database.
- Find a DataSource in the JNDI environment and do the above.
- View the System classpath (to ensure that the JDBC JAR file is there).

Using the Utility

If you have already set up Confluence completely

1. Download the attached testdatabase.jsp to your <confluence-install>\confluence directory.
2. Restart Confluence
4. Check that your database driver is loaded into memory. If not, check the system classpath for the JDBC driver file, and that the driver is in the <confluence-install>\lib directory (for Confluence version 2.10 onwards) or <confluence-install>\common\lib (for earlier versions). Here are some instructions.
5. Enter the DB settings Confluence is using and test the database. If an error appears, check that the db service is running, the location matches, and that any users specified actually exist with the right login and permissions. You may be able to find a workaround by Googling the error.

If you cannot set up Confluence because of an error in 'Configuring Database'

1. Record the DB settings you are using for your direct JDBC or datasource connection in the 'Configure Database’ step of your setup.
2. Download the attached testdatabase.jsp to your <confluence-install>\confluence directory.
3. Rename your <confluence-install>\confluence\WEB-INF\web.xml file to backup web.xml.
This disables redirection.

4. Restart Confluence.


6. Check that your database driver is loaded into memory. If not, check the system classpath for the JDBC driver file, and that the driver is in the `<confluence-install>`\common\lib directory as described in these instructions.

7. Enter the DB settings you recorded and test the database. If an error appears, check that the db service is running, the location matches, and that any users specified actually exist with the right login and permissions. You may be able to find a workaround by Googling the error.

8. After correcting the error, rename `<confluence-install>`\confluence\WEB-INF\backup web.xml back to web.xml.

Notes

If you use this utility, please let us know ways in which we could improve it or leave helpful hints for others here. For a comprehensive set of database instructions that might be helpful for troubleshooting, please refer to the following links:

- PostgreSQL
- MySQL

Requesting Technical Support

If you are still stuck after attempting the suggestions above, lodge a free technical support request with information on your database setup.

Improving Database Performance

Diagnosis

Use native database tools to assess the impact of your database. If you’d like to check what Confluence is doing from its side, you can enable SQL logging. If you analyze thread dumps, as this is done in general Troubleshooting Confluence Hanging or Crashing guide, you may find the kinds of threads like this:

```
"http-8080-Processor150" daemon prio=1 tid=0x08543368 nid=0x11aa in
Object.wait() [0x665a4000..0x665a51b0]
   at java.lang.Object.wait(Native Method)
   - waiting on <0x83140488> (a com.mchange.v2.resourcepool.BasicResourcePool)
   - locked <0x83140488> (a com.mchange.v2.resourcepool.BasicResourcePool)
```

These threads are waiting for a database connection. It could be that the database is not performing optimally, or it may just need tuning for allowing more connection threads. Both are discussed below.

Upgrade your Database and Drivers

SQL Server 2000, Oracle 9i, and MySQL with 3.1 drivers are among some of the issues with database performance. Ensure you are using updated versions of databases and their drivers.

Upgrade your hardware

Atlassian does not offer specific recommendations on hardware for database performance. Use good judgment and native OS and database tools for your assessment.

Ensure you have the Latest Database Indices

Confluence has improved database performance over time. You’ll want to make sure you have all the latest, if
you're getting hung threads waiting for db connections.

Confluence 2.10 or Manual .ddl Indices

With 2.10 and later, Confluence includes database indices bundled. Confluence 2.10 automatically creates the necessary database indexes when you upgrade. If you are not on 2.10, you may have run the .ddl manually during the upgrade process. To check, you can look against these.

Additional Indices not Included in 2.10

- One import db index is the **lower case page title index**. Prior to Confluence 3.0, querying for a page by title and space key can take a long time due to table scans necessary on a lowercase where clause. On most databases it is possible to add a lowercase index on these columns that helps with performance. See Creating a Lowercase Page Title Index for instructions on how to do this. Prior to 2.10, apply lowercase title indexes (all Confluence versions).
- The compound database index for the ATTACHMENTDATA table is described in CONF-13819.
- A composite index on some of the columns in SpacePermissions table is described in CONF-14488.

Tuning the Database Connection Pool

This is described in the knowledge base article Confluence Slows and Times out During Periods of High Load due to DB Connection Pool.

Configure a Database Query Timeout

If a database is getting overloaded, you can prevent it from crashing Confluence by Configuring a Database Query Timeout.

Related Articles

Troubleshooting Database Issues.

Creating a Lowercase Page Title Index

**Diagnosis**

Confluence sometimes has performance problems retrieving pages by title because the query uses the lower() function. For example, the query looks something like this:

```sql
select * from CONTENT where lower(TITLE) = :title and SPACEID = :spaceid
```

Database profiling might show a query like the following taking a long time to execute (emphasis added):

```sql
select ... from CONTENT page0_, SPACES space1_
where page0_.CONTENTTYPE='PAGE'
and (lower(space1_.SPACEKEY)= @P0 and page0_.SPACEID=space1_.SPACEID)
and(lower(page0_.TITLE)= @P1 )
and(page0_.PREVVER is null )and(page0_.CONTENT_STATUS='current' ))
```

Typically, databases don't use indexes when you use a function in a where clause; they do a table scan instead. This makes the performance of this query not ideal (CONF-11577).

**Generic solution**

On many databases (e.g. Oracle, PostgreSQL, DB2 for z/OS), it is possible to create the index using the normal "create index" syntax, just using the function instead of the column name.

```sql
create index CONFTITLE_LOWER on CONTENT(lower(TITLE));
```

Sources:

- http://www.postgresql.org/docs/current/static/sql-createindex.html
- http://asktom.oracle.com/tkyte/article1/
On SQL Server, you can add a computed column to the database table and then add an index on this column.

```sql
alter table CONTENT add TITLE_LOWER as lower(TITLE);
create index CONFTITLE_LOWER on CONTENT(TITLE_LOWER);
```

Sources:

MySQL

It is not currently possible to create a lowercase index on MySQL. Confluence 3.0 includes some caching improvements which should alleviate this performance problem on this database.

Source:

Workaround for MySQL databases, using a case-insensitive collation:

Please check whether your MySQL database has been set to use case-sensitive or case-insensitive collation. The queries to check whether your database is set to case-insensitive collation are:

- `show full columns from content where field = 'title';`
- `show full columns from spaces where field = 'spacekey';`

If the `collation_name` is returned as `<encoding>_ci`, the `ci` indicates case-insensitive collation.

If the database has been set to use case-insensitive collation, you can try removing `lower` from the following queries, in your `ContentEntityObject.hbm.xml` file residing in your <Confluence-Install>/confluence/WEB-INF/lib/confluence-2.x.x.jar/com/atlassian/confluence/core/:

```xml
<query name="confluence.page_findLatestBySpaceKeyTitle"><![CDATA[
  from Page page
  where lower(page.space.key) = :spaceKey and
  lower(page.title) = :pageTitle and
  page.originalVersion is null and
  page.contentStatus = 'current'
]]></query>

<query name="confluence.page_findLatestBySpaceKeyTitleOptimisedForComments"><![CDATA[
  from Page page
  left join fetch page.comments as theComments
  left join fetch theComments.children
  where lower(page.space.key) = :spaceKey and
  lower(page.title) = :pageTitle and
  page.originalVersion is null and
  page.contentStatus = 'current'
]]></query>
```

DB2 for Linux or Windows

DB2 supports indexes on generated columns which are used for queries with a matching predicate. You can implement it like this:
ALTER TABLE CONTENT ADD COLUMN TITLE_LOWER GENERATED ALWAYS AS (LOWER(TITLE));
CREATE INDEX CONFTITLE_LOWER ON CONTENT(TITLE_LOWER)

Related pages
- Improving Database Performance
- CONF-10030: Queries that use 'lower' do not use index because of case sensitivity

Surviving Database Connection Closures

When a database server reboots or a network failure has occurred, all connections in the database connection pool are broken. To overcome this issue, Confluence would normally need restarting (or for Confluence WAR distributions, the application server running Confluence would need restarting).

However, database connections in the database connection pool can be validated by running a simple SQL query. If a broken database connection is detected in the pool, a new one is created to replace it.

To do this, you can specify an optional validation query for your database connection. Depending on whether you are using a direct JDBC URL, or a data source, this is configured differently.

Determining the validation query SQL for your database type

Different database types have slightly different SQL syntax requirements for their validation query. The validation query should be as simple as possible, as this is run every time a connection is retrieved from the pool.

The following validation queries are recommended for the following types of databases:

<table>
<thead>
<tr>
<th>Database Type</th>
<th>Validation Query</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL</td>
<td>select 1</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>select 1</td>
</tr>
<tr>
<td>Oracle</td>
<td>select 1 from dual</td>
</tr>
<tr>
<td>PostgreSQL</td>
<td>select 1</td>
</tr>
</tbody>
</table>

Enabling validation query using direct JDBC

To ensure Confluence validates database connections in the database connection pool:

1. Shut down Confluence
2. Edit the confluence.cfg.xml file at the root of your Confluence Home and other important directories
3. Add the property "hibernate.c3p0.validate" and set it to "true", and add the property "hibernate.c3p0.preferredTestQuery" and set it to the value of the query you determined above for your database type. See this excerpt of the file with the two added properties for details:

confluence.cfg.xml (excerpt)

```xml
...  
<property name="hibernate.c3p0.acquire_increment">1</property>
<property name="hibernate.c3p0.idle_test_period">100</property>
<property name="hibernate.c3p0.max_size">30</property>
<property name="hibernate.c3p0.max_statements">0</property>
<property name="hibernate.c3p0.min_size">0</property>
<property name="hibernate.c3p0.timeout">30</property>
<property name="hibernate.c3p0.validate">true</property>
<property name="hibernate.c3p0.preferredTestQuery">select 1</property>
...  
```
Ensuring validation query using a data source

To ensure Confluence validates database connections in the database connection pool:

1. Shut down Confluence (or the Tomcat installation running Confluence).
2. Edit the `conf/server.xml` file in your Confluence Install Directory, or in the Tomcat installation's CATALINA_HOME directory.
3. Find the Resource element for your data source, and add the "validationQuery" field, with the value of the query you determined above for your database type. See this excerpt of the file with this added for details:

```xml
...<Resource name="jdbc/confluence" auth="Container" type="javax.sql.DataSource"
    username="postgres"
    password="postgres"
    driverClassName="org.postgresql.Driver"
    url="jdbc:postgresql://localhost:5432/yourDatabaseName"
    maxActive="20"
    maxIdle="10"
    validationQuery="select 1" />
...```

4. Save `conf/server.xml`
5. Restart Confluence (or the Tomcat installation running Confluence).

Results and Considerations

You should now be able to recover from a complete loss of all connections in the database connection pool without the need to restart Confluence or the application server running Confluence.

⚠️ Performance Considerations:

- Setting this option has a performance impact. The overall decrease in performance should be minimal, as the query itself is quick to run. In addition, the query will only execute when you make a connection. Thus, if the connection is kept for the duration of a request, the query will only occur once per request.
- If you are running a large Confluence installation, you may wish to assess the performance impact of this change before implementing it.

Site Backup and Restore

⚠️ Atlassian recommends establishing a backup strategy using a native database tool for production installations of Confluence.

By default, Confluence backs up all data and attachments once a day to an XML backup file. These files are called XML site backups, and are stored in the backups directory of Confluence home. You can also create XML site backups manually. This mechanism is intended for small to medium-sized deployments of Confluence. It is not intended for use with large deployments with lots of pages and attachments (see below).

- Restore your site from an XML site backup
- Manually create an XML site backup
- Configuring Backups
- User Submitted Backup & Restore Scripts

XML site backups are fine for most small to medium-sized instances of Confluence, containing a few thousand pages and attachments. However, large instances of Confluence may find that backups become slow to create and use large amounts of disk space.

**Note:** Plugins are not included in the XML backup. After importing your backup into a new Confluence site, you will need to re-install all plugins (add-ons) that are not bundled with Confluence. (The plugindata table is not
backed up in a manual backup.)

The information on this page does not apply to Confluence Cloud.

Backups for large installations

XML site backups are unsuitable for installations of Confluence that contain thousands of pages, as XML backups take progressively longer to complete as the amount of text increases. Another issue with XML site backups is that Confluence instances with gigabytes of attachments will consume disk space rapidly. This is because each site backup contains all content needed for a site restore. For example, if a 1 GB instance of Confluence is backed up daily, it will create 30 GB of backups per month if left unattended. When administering a large instance, you can reduce disk space by setting XML site backups to exclude attachments, then manually scheduling a backup of your attachments from the Confluence home directory or database. The backup manager can save space by saving changed files instead of all content.

<table>
<thead>
<tr>
<th>Creation Delay</th>
<th>Disk Usage</th>
<th>Recommended Backup Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceptable</td>
<td>Acceptable</td>
<td>XML site backup with attachments</td>
</tr>
<tr>
<td>Acceptable</td>
<td>Unacceptable</td>
<td>XML site backup minus attachments, plus manual backup of attachments</td>
</tr>
<tr>
<td>Unacceptable</td>
<td>Unacceptable</td>
<td>Manual backup of database and attachments</td>
</tr>
</tbody>
</table>

Creation Delay is the time it takes to create an XML site backup minus attachments. Disk Usage can be estimated by multiplying the frequency of your XML site backups by their current size.

Manual backups

Confluence’s Attachment Storage Configuration can be set to store attachments in the Confluence home directory, or in the database.

Database backup

Use your Database Administration Tool to create a backup of your Confluence database. If your database is storing your attachments, importing this later will restore all content. For instances with big attachments, please note that currently Confluence migrate attachments in a single transaction: CONF-9888.

Attachment backup

If stored on the filesystem, attachments are placed under the attachments directory of your Confluence home directory. Copy this directory to create a backup of all attachments.

To restore from these backups, please refer to Restoring Data from other Backups.

Production Backup Strategy

Confluence automatic daily XML backup is suitable if you:

- are evaluating Confluence
- do not have database administration familiarity, and your Confluence installation is small

Once your Confluence installation reaches more than a few thousand pages, the XML backup facility can be inefficient compared to your database’s own backup tools. The built in backup functionality requires a lot of memory to run and is less reliable when restoring data.

Establishing a production system backup solution

Atlassian recommends establishing an alternative database backup strategy:

- Create a backup or dump of your database using tools provided by your database
To avoid any data inconsistency and corruption, it is recommended to shut down Confluence before creating a database backup or dump.

- Create a file system backup of your Confluence home directory
- Create a file system backup of your shared home directory (Clustered instances only)

Once this is in place, disable the daily backups through the scheduled jobs feature via 'Administration Console > Administration > Scheduled Jobs'.

We want to stress that creating these two backups is better than having a Confluence XML backup. It is more robust and far more reliable for large production instances. You will be able to restore your whole site, including all data, attachments and configuration information intact with these two backups. See Restoring Data from other Backups.

Which files need to be backed up?

Backing up the whole home directory is the safest option, however most files and directories are populated on startup and can be ignored. At minimum, these files/directories must be backed up:

- `<conf-home>/confluence.cfg.xml`
- `<conf-home>/attachments`

The rest of the directories will be auto-populated on start up. You may also like to backup these directories:

- `<conf-home>/config` – if you have modified your ehcache.xml file.
- `<conf-home>/index` – if your site is large or reindexing takes a long time – this will avoid the need for a full reindex when restoring.

The location of the home directory is configured on installation and is specified in the `confluence.init.properties` file. For installation created with the automatic installer the default locations are:

- **Windows**  
  `C:\Program Files\Atlassian\Application Data\Confluence`
- **Linux**  
  `/var/atlassian/application-data/confluence`

For **Clustered instances only**: Backing up the whole shared home directory is the safest option, however some files and directories are populated at runtime and can be ignored:

- `<conf-home>/thumbnails`
- `<conf-home>/viewfile`

How do I back up?

The commands to back up your database will vary depending on your database vendor, for example the command for PostgreSQL is `pg_dump dbname > outfile`. 

Related pages:

- Site Backup and Restore

The information on this page does not apply to Confluence Cloud.
You should refer to the documentation for your particular database to find out more.

**How do I restore?**

Our guide on Migrating Confluence Between Servers has instructions on restoring a backup using this technique.

**Other processes**

XML backups are described and used for other processes in Confluence, like upgrading and moving servers. Using the backup strategy described above will work for those processes too.

- Our upgrade guide does not require the use of an XML backup (although the earlier Confluence upgrade procedure, and the JIRA upgrade guide, do use XML backups).
- Our migrate server procedure—used to set up a test server—can use a SQL dump as well.
- The database migration procedure uses the XML backup for small data sets. Large data sets will require third party database migration tools.

**Note:** The XML export built into Confluence is not suited for the backup or migration of large data sets. There are a number of third party tools that may be able to assist you with the data migration. If you would like help in selecting the right tool, or help with the migration itself, we can put you in touch with one of the Atlassian Experts.

### Configuring Backups

Confluence backs up your data regularly into a zipped XML file. By default, this backup is performed at 2.00 a.m. each day and the backup files are stored in the `backups` folder under the Confluence Home directory. The default naming convention for the backup files is `backup-yyyy_MM_dd`. Confluence can write backups to both local and mapped network drives.

From the **Backup Administration** section of Confluence's administration console, you can:

- Include or exclude attachments in backups.
- Configure a different path to store backup files. (By default, this option is not available. See below for information about enabling the configuration option.)
- Change the naming format used for the files.

You can also change the schedule of this backup using Confluence's **scheduled jobs** feature.

You need to have **System Administrator** permissions in order to configure these options.

---

### Configuring Confluence Backups

To configure Confluence backups:

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Click 'Backup Administration' in the 'Configuration' section.
3. Click the 'Edit' button on the 'Backup Administration' screen.
4. Now you can do the following:
   - To use a different naming prefix format — Enter the new format in the 'Backup File Prefix' input field.
• To use a different date format — Enter the date format in the 'Backup File Date Pattern' input field using the syntax described in this document from Sun.
• To exclude attachments from backups — Deselect 'Backup Attachments'. By default, this feature is 'On'.
• To specify an alternate path to store backup files (if enabled) — Select 'Custom' and then enter the path. The directory must be on either a local drive or a mounted network drive.

Notes:
• By default, this option is not available. See below for information about enabling the configuration option.
• Please ensure the mapped drive is on a physical server, not a Virtual Machine image.

5. 'Save' your changes.

You can disable Confluence backups through the scheduled jobs feature.

---

**Backup Administration**

Perform a backup of your site daily to a chosen directory on your filesystem.

**Backup Settings**

- **Backup File Prefix**: backup-
- **Backup File Date Pattern**: yyyy_MM_dd
- **Backup Path**: 

  Custom backup paths are not enabled. More about custom backup paths

  - **Backup Attachments**: 

    - **Submit** 
    - **Cancel**

Screenshot above: Editing the Backup Configuration

---

**Enabling Backup Path Configuration**

By default, it is not possible to specify a backup path via the Confluence Administration Console. This feature is disabled by default for security reasons. Administrators can restore this functionality by updating the relevant configuration property as described below. However, we recommend that you turn the feature off in production environments. For production environments, please review our Production Backup Strategy.

To enable the configuration option:

1. Edit the `confluence.cfg.xml` file found in the Confluence Home and other important directories.
2. Set the value of property `admin.ui.allow.daily.backup.custom.location` to 'true' (without the quotation marks).

```xml
<property name="admin.ui.allow.daily.backup.custom.location">true</property>
```

3. Restart Confluence.

If the value of the above configuration property is 'true', it will be possible to specify a backup path via the Confluence Administration Console. If the value of this property is 'false' or the property is not present in the configuration file, the backup path is not configurable.

**Notes**
Time is derived from the Confluence server

The time zone is taken from the server on which Confluence is running.

To check the time according to the server, do the following:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Click 'System Information' in the left-hand panel and look at the 'System Time'.

Backup strategy for large Confluence sites

Consider using the production backup strategy if your Confluence site is large or you are encountering problems with your automated backup.

User Submitted Backup & Restore Scripts

These scripts are user-submitted and should be used with caution as they are not covered by Atlassian technical support. If you have questions on how to use or modify these scripts, please post them to Atlassian Answers. Feel free to submit new scripts or post updates by logging in and adding them to the page as a comment.

The information on this page does not apply to Confluence Cloud.

Delete Old Backups - Wscript Script On Windows

This script examines backup filename and deletes them if necessary, it may need to be edited.

```
"If you want 3 day old files to be deleted then insert 3 next to Date = "your number here"
"This script will search out and delete files with this string in them
".2005-12-04=" This of course depends on the number you enter.
"You can always do a wscript.echo strYesterday or strFileName to see what the
script thinks you are searching for.

dtmYesterday = Date - 3
strYear = Year(dtmYesterday)
strMonth = Month(dtmYesterday)
If Len(strMonth) = 1 Then
    strMonth = "0" & strMonth
End If
strDay = Day(dtmYesterday)
If Len(strDay) = 1 Then
    strDay = "0" & strDay
End If
strYesterday = strYear & "-" & strMonth & "-" & strDay
strFileName = "C:\test*." & strYesterday & "*"
Set objFSO = CreateObject("Scripting.FileSystemObject")
objFSO.DeleteFile(strFileName)
```

Delete Old Backups - Basic Bash Script For Linux

Old XML backups can be deleted automatically by inserting a nightly or weekly automation script or cron similar to the following:

```
ls -t <path to your backup dir>/* | tail -n +6 | xargs -1 rm {}```
Or, using the older form of the `tail` command if your system does not support the standard form:

```
ls -t <path to your backup dir>/* | tail +6 | xargs -i rm {}
```

**Delete Old Backups - Advanced Bash Script For Linux**

Old XML backups can be deleted automatically by inserting a nightly or weekly automation script or cron similar to the following. Set the `BACKUP_DIR` and `DAYS_TO_RETAIN` variables to appropriate values for your site. Between runs, more files than `DAYS_TO_RETAIN` builds up.

```
#!/bin/sh

# Script to remove the older Confluence backup files.
# Currently we retain at least the last two weeks worth
# of backup files in order to restore if needed.

BACKUP_DIR="/data/web/confluence/backups"
DAYS_TO_RETAIN=14

find $BACKUP_DIR -maxdepth 1 -type f -ctime +$DAYS_TO_RETAIN -delete
```

**Manual Database & Home Backup - Bash Script For Linux**

This backs up a MySQL database and the Confluence home directory.

```
#!/bin/bash

CNFL=/var/confluence
CNFL_BACKUP=/backup/cnflBackup/`date +%Y%m%d-%H%M%S`

rm -rf $CNFL/temp/*
mkdir $CNFL_BACKUP
mysqldump -uroot -p<password> confluence|gzip > $CNFL_BACKUP/confluence.mysql.data.gz
tar -cjvf $CNFL_BACKUP/data.bzip $CNFL > $CNFL_BACKUP/homedir.status
```

**Backup by Date - Postgres**

```
export d=`date +%u`
mkdir -p /home/backup/postgres/$d

sudo -u postgres pg_dumpall | bzip2 > /home/backup/postgres/$d/sql.bz2
```

**Related Topics**

- Site Backup and Restore
- Backup FAQ

**Manually Backing Up the Site**

Confluence is configured to back up its data automatically, as a zipped XML file. You can also manually perform this backup from the Administration Console.

You need to have System Administrator permissions in order to perform this function.

**Note:**

- Atlassian recommends that you follow the Production backup strategy if your Confluence site is large or you are encountering problems with your automated backup.
- Plugins are not included in the XML backup. After importing your backup into a new Confluence site, you
will need to re-install all plugins (add-ons) that are not bundled with Confluence. (The plugindata table is not backed up in a manual backup.)

Creating the site backup

To manually back up your site:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Backup & Restore in the left-hand panel.
3. Choose Archive to backups folder to store a copy of the backup in the same folder as Confluence’s backups.
   If you do not archive the backup it will be made available for you to download, and then deleted from the server after 24 hours.
4. Choose Backup attachments to include attachments in your backup.
5. Choose Backup.
   The process will take a few minutes.

Related pages:

- Restoring a Site
- Configuring Backups
- Production Backup Strategy
- Confluence Administrator's Guide

Retrieving the Backup File

Confluence stores the backup as a zipped XML file in the ‘backups’ directory under the Confluence Home directory on your Confluence server. To find your Confluence Home directory, see the documentation. You will need access to the Confluence server in order to retrieve this file.

Enabling the download of the backup file via the administration console

By default, it is not possible to retrieve the backup file via the Confluence Administration Console. This feature is disabled for security reasons.

Administrators can enable this functionality by updating the relevant configuration property as described below. If this functionality is enabled, Confluence will prompt you to download the backup file when the backup process finished. However, we recommend that you turn the feature off in production environments.

To enable download of the backup file from the Administration Console:

1. Edit the confluence.cfg.xml file found in the Confluence Home and other important directories.
2. Set the value of property admin.ui.allow.manual.backup.download to 'true' (without the quotation marks).
3. Restart Confluence.

If the value of the above configuration property is 'true', it will be possible to download the backup file after manually backing up the site via the Confluence Administration Console. If the value of this property is 'false' or the property is not present in the configuration file, you will need to retrieve the backup file from the file system on the Confluence server. By default, the value is 'false'.

Notes

If you experience timeout errors, please consider bypassing Apache and creating the export directly from Tomcat. This will speed up the process and prevent timeouts. For example, your URL might be something like http://<domain>.com. To bypass this and access Tomcat directly, use this URL: http://localhost:8080/confluence/admin/backup.action.

Restoring a Site

⚠️ CAUTION: Restoring a backup of an entire confluence site will:
This page describes how to restore data from an XML backup file into an existing Confluence installation. If you want to restore data into a new site, follow the instructions on restoring from backup during setup.

You need System Administrator permissions in order to perform this function.

**Related pages:**
- Production Backup Strategy
- Manually Backing Up the Site
- Confluence Administrator’s Guide

The information on this page does not apply to Confluence Cloud.

### Notes before you start:

- **All content replaced.** Restoring a site from backup will replace all your content, as described in the warning above.
- **Selective space restoration not possible.** You cannot select a single space to restore from the entire site backup when the backup contains more than one space.
- **Backward version compatibility.** Confluence supports backward compatibility for site backups (but not or **space backups**). You can successfully restore backups of a site from an older version of Confluence to a newer version of Confluence. You cannot restore backups from a newer version to an older version or across major versions. For example, if you create a site backup in Confluence 2.4.3, it cannot be restored into a Confluence 2.2.2 site. It can however, be restored into 2.4.5 or 2.5.x, because 2.4.5 and 2.5.x are newer versions of Confluence. Importing an old XML backup file to a new major version (for example, Confluence 3.5 to Confluence 4.0) is not supported.
- **XML backups should not be used to upgrade Confluence.** Upgrade Confluence by following: Upgrading Confluence.

### Restoring data from an XML backup

You can restore data from an XML backup file located somewhere on your local computer or a shared drive, or you can copy the XML file into the Confluence installation and restore it from there. The second option is recommended for large backup files. Both options are described below.

#### To restore data from an XML backup located outside Confluence:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Backup and Restore in the left-hand panel.
3. Choose Choose File and browse for the backup file.
4. Uncheck Build Index if you want to create the index at a later stage.
5. Choose Upload and Restore.

#### To restore data from an XML backup located in your Confluence installation:

1. Copy your XML backup zip file into the restore directory in your Confluence home directory. For example:
   - On UNIX: /opt/java/src/confluence/deployments/conf.atlassian.com/home/restore
   - On Windows: C:\Program Files\Atlassian\Application Data\Confluence x.x\restore
2. Choose the cog icon, then choose General Configuration under Confluence Administration.
3. Choose Backup and Restore in the left-hand panel.
4. The zip file that you copied in step 1 will appear in the list of files under the heading Restore a backup from the Confluence Home Directory on your Confluence Administration Console. Select the zip file.
5. Uncheck Build Index if you want to create the index at a later stage.
6. Choose Restore.
Notes

- **Production backup strategy preferred.** Atlassian recommends that you follow the Production Backup Strategy for your production Confluence site, because Confluence XML backups are not recommended for non-evaluation sites.

- **Restoring from other backups.** If your daily backup zip files cannot be restored for some reason, but you have backups of both your database and your Confluence home directory, then it is still possible to restore from these backups.

Restoring a Space

This page tells you how to import the contents of a Confluence space into another Confluence site, via an XML backup file.

You can export the content of a space, including pages, comments and attachments. The process involves converting the data in the space into XML format. The end product is a zip file that contains XML file(s) and optionally, all the attachments in the space. To transfer this data to another Confluence site, restore this zip file as described below.

You need to have **System Administrator** permissions in order to restore a space from an XML zip file.

**Before you start**

Before you start, please check the following important notes.

**Note 1: You cannot restore to a previous version**

Let’s assume you are importing a space from site A to site B. In this case, site B must be running the same version of Confluence as site A, or a later version than site A. The space import is not backwards compatible.

**Note 2: You cannot restore to a different major Confluence version**

Confluence only supports compatibility for space import and export when executed within the same major version of Confluence. (This issue is logged as CONF-26111.)

Clarifying our terminology: By **major version**, we mean the version defined in the first two sections of the release number. For example, Confluence 2.2 and Confluence 2.3 are different major versions. Confluence 2.2.1 and Confluence 2.2.6 are the same major version.

**Restoration data must share the same major version number.** This means that a space export created in one major version of Confluence cannot be imported into a different major version of Confluence. For example, if you create a space export in Confluence 2.3.5, it cannot be imported into a Confluence 2.4.1 site. It can be however imported into 2.3.7. Similarly, a space export created in 5.0 can not be imported into 5.1.2. However, it can be restored into a Confluence 5.0.2 site.

If you need to import a space from a different major version, see the workaround described below.

---

**On this page:**
- **Before you start**
  - Note 1: You cannot restore to a previous version
  - Note 2: You cannot restore to a different major Confluence version
  - Note 3: Make sure the space does not already exist
- Restoring a space from an XML backup
- Workaround for restoring spaces between major releases

**Related pages:**
- Restoring a Site
- Confluence Administrator’s Guide

⚠️ The information on this page does not apply to Confluence Cloud.
If you try to restore a space from a different major version of Confluence, you will see an error message similar to the one below and the import action will stop.

**Screenshot: Clash of major versions on space restore**

```
- The following error(s) occurred:
  - Restore denied. You can only restore space backups exported from the same major version (e.g. 2.2.x or 2.3.x).
```

**Note 3: Make sure the space does not already exist**

Confluence will only allow you to restore a space if there is not already a space with that key on the site. If you already have a space with the same key, you will need to delete or rename the existing space before restoring the new one.

**Restoring a space from an XML backup**

You can restore data from an XML backup file located somewhere on your local computer or a shared drive, or you can copy the XML file into the Confluence installation and restore it from there. The second option is recommended for large backup files. Both options are described below.

**To restore data from an XML backup located outside Confluence:**

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Backup and Restore in the left-hand panel.
3. Choose Choose File and browse for the backup file.
4. Uncheck Build Index if you want to create the index at a later stage.
5. Choose Upload and Restore.

**To restore data from an XML backup located in your Confluence installation:**

1. Copy your XML backup zip file into the restore directory in your Confluence home directory. For example:
   - On UNIX: `/opt/java/src/confluence/deployments/conf.atlassian.com/home/restore`
   - On Windows: `C:\Program Files\Atlassian\Application Data\Confluence x.x\restore`
2. Choose the cog icon, then choose General Configuration under Confluence Administration.
3. Choose Backup and Restore in the left-hand panel.
4. The zip file that you copied in step 1 will appear in the list of files under the heading Restore a backup from the Confluence Home Directory on your Confluence Administration Console. Select the zip file.
5. Uncheck Build Index if you want to create the index at a later stage.
6. Choose Restore.

**Workaround for restoring spaces between major releases**

If you need to import a space from an earlier major version, you can use a temporary Confluence installation to upgrade the space export to the right version number:

1. Download the same version of Confluence as the version you exported the space from. You can get older versions of Confluence at the Confluence Downloads Archive.
2. Install that version of Confluence on a temporary server.
3. Import the space into this temporary Confluence site.
4. Upgrade Confluence on your temporary site to same version as the site where you want to import the space. See Upgrading Confluence.
5. Export the space from your temporary Confluence site. It will now have the correct version number.
6. Import the space into your production Confluence site.

**Restoring a Test Instance from Production**

Many Confluence administrators will have a production instance running the "live" version of Confluence, as well as a test instance for testing upgrades and so on. In this situation, it's quite common that the two instances are...
running different versions of Confluence. This document describes how to copy the data from a production instance to a test instance, where the production version may be different to the test version.

Before proceeding with this guide, ensure you have read and understood the normal procedure for upgrading Confluence.

The information on this page does not apply to Confluence Cloud.

Upgrading a test Confluence instance with production data

Essentially, we are copying both the production home directory and database to the test instance. We then update the database details on the test instance to point to the test database, leaving all other instance metadata (most importantly the Confluence build number) the same as production.

1. Shut down your test instance.
2. Restore the production database to the test database server.
3. Create a backup of the confluence.cfg.xml file found in the home directory of the test instance.
4. Copy the production confluence-home directory to the test application server.
5. Open the confluence.cfg.xml which has been copied in a text editor. Change the database settings to match the test database server. Ensure you do not point to your production database. (You can compare with the backup you made in Step 3 if you need to get the database settings. Don’t just copy this file – you need the build number unchanged from production to indicate the database is from an older version of Confluence.)

Before starting your test instance, you need to do the following steps to ensure no contact with production systems.

Ensuring no contact with production systems

To ensure no contact with external systems, you will need to disable both inbound and outbound mail services.

1. Disable global outbound mail by running the following database query:

   ```sql
   SELECT * FROM BANDANA WHERE BANDANAKEY = 'atlassian.confluence.smtp.mail.accounts';
   ```

2. Disable space-level mail archiving by running the following database query:

   ```sql
   SELECT * FROM BANDANA WHERE BANDANAKEY = 'atlassian.confluence.space.mailaccounts';
   ```

Change the 'SELECT *' to a 'DELETE' in the above queries once you are sure you want to remove the specified accounts.

Once this is done, you can start your test instance without any mails being sent or retrieved. Think carefully about other plugins which may access production systems (SQL macro, etc.). These should be disabled promptly after starting the test instance.

You can create a developer license for this server and update the License Details after starting up.

See also

Upgrading Confluence
Migrating Confluence Between Servers
Restoring to a Test Instance of Confluence from Production
Restoring Data from other Backups

Typically, Confluence data is restored from the Administration Console or from the Confluence Setup Wizard.

If you are experiencing problems restoring from an zipped XML backup file, it is still possible to restore provided...
you have:

1. A backup of your home directory.
2. A backup of your database (if you're using an external database).

Instructions for this method of restoring differ depending on whether you are using the embedded database or an external database (like Oracle, MS SQL Server, MySQL or Postgres).

**Embedded Database**

If you are running against the embedded database, the database is located inside the `database` folder of your Confluence Home Directory. Hence, all you need to do is:

1. Retrieve the most recent backup of your home directory.
2. Unpack the Confluence distribution and point the `confluence-init.properties` file to this directory.

**External Database**

If you're using an external database, you need to do the following.

1. Prepare backups of your home directory and database (preferably backups that are dated the same). That is, make sure the home directory is accessible on the filesystem and the database available to be connected to.
2. If this database happens to have a different name, or is on a different server, you need to modify the `jdbc url` in the `confluence.cfg.xml` file inside the Confluence Home Directory. The value of this property is specified as `hibernate.connection.url`.
3. Unpack the Confluence distribution and point the `confluence-init.properties` file to the home directory.

### Retrieving File Attachments from a Backup

File attachments on pages can be retrieved from a backup without needing to import the backup into Confluence. This is useful for recovering attachments that have been deleted by users.

Both automated and manual backups allow this, as long as the 'Include attachments' property was set. If you want to restore pages, spaces or sites, see the Confluence Administrator's Guide instead.

Before following the instructions for recovering attachments below, we will review how backups store file and page information.

---

### How Backups Store File and Page Information

The backup zip file contains `entities.xml`, an XML file containing the Confluence content, and a directory for storing attachments.

**Backup Zip File Structure**

Page attachments are stored under the `attachments` directory by page and attachment id. Here is an example listing:

```xml
<progression/>
<file_attachment id="100001"/>
```
Inside the attachment directory, each numbered directory inside is one page, and the numbered file inside is one attachment. The directory number is the page id, and the file number is the attachment id. For example, the file \attachments\98\10001 is an attachment with page id 98 and attachment id 10001. You can read entities.xml to link those numbers to the original filename. Entities.xml also links each page id to the page title.

**Entities.xml Attachment Object**

Inside the entities.xml is an Attachment object written in XML. In this example, the page id is 98, the attachment id is 10001 and the filename is myimportantfile.doc. The rest of the XML can be ignored:

```
<object class="Attachment" package="com.atlassian.confluence.pages">
  <id name="id">98</id>
  <property name="fileName"><![CDATA[myimportantfile.doc]]></property>
  ...
  <property name="content" class="Page" package="com.atlassian.confluence.pages"><id name="id">10001</id>
    ...
</object>
```

**Entities.xml Page Object**

This XML describes a page. In this example, the page id is 98 and the title is Editing Your Files. The rest of the XML can be ignored:

```
<object class="Page" package="com.atlassian.confluence.pages">
  <id name="id">98</id>
  <property name="title"><![CDATA[Editing Your Files]]></property>
  ...
</object>
```

**Instructions for Recovering Attachments**

Each file must be individually renamed and re-uploaded back into Confluence by following the instructions below. Choose one of the three methods:

**Choice A - Recover Attachments By Filename**

Best if you know each filename you need to restore, especially if you want just a few files:

1. Unzip the backup directory and open entities.xml.
2. Search entities.xml for the filename and find the attachment object with that filename. Locate its page and attachment id.
3. Using the page and attachment id from entities.xml, go to the attachments directory and open that directory with that page id. Locate the file with the attachment id.
4. Rename the file to the original filename and test it.
5. Repeat for each file.
6. To import each file back into Confluence, upload to the original page by attaching the file from within Confluence.

**Choice B - Restore Files By Page**
Best if you only want to restore attachments for certain pages:

1. Unzip the backup directory and open entities.xml.
2. Search entities.xml for the page title and find the page object with that title. Locate its page id.
3. Go to the attachments directory and open that directory with that page id. Each of the files in the directory is an attachment that must be renamed.
4. Search entities.xml for attachment objects with that page id. Every attachment object for the page will have an attachment id and filename.
5. Rename the file with that attachment id to the original filename and test it.
6. Repeat for each page.
7. To import each file back into Confluence, upload to the original page by attaching the file from within Confluence.

Choice C - Restore All Files

Best if you have a small backup but want to restore many or all the attachments inside:

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception while creating backup</td>
<td>Follow instructions below</td>
</tr>
<tr>
<td>Exception while importing backup</td>
<td>Follow Troubleshooting XML backups that fail on restore instead</td>
</tr>
</tbody>
</table>

Troubleshooting failed XML site backups

XML site backups are only necessary for migrating to a new database. Setting up a test server or Establishing a reliable backup strategy is better done with an SQL dump.

Seeing an error when creating or importing a backup?

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception while creating backup</td>
<td>Follow instructions below</td>
</tr>
<tr>
<td>Exception while importing backup</td>
<td>Follow Troubleshooting XML backups that fail on restore instead</td>
</tr>
</tbody>
</table>

Troubleshooting XML backups that fail on restore

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception while creating backup</td>
<td>Follow instructions below</td>
</tr>
<tr>
<td>Exception while importing backup</td>
<td>Follow Troubleshooting XML backups that fail on restore instead</td>
</tr>
</tbody>
</table>

Resolve Errors With Creating An XML Backup

The errors may be caused by a slightly corrupt database. If you're seeing errors such as 'Couldn't backup database data' in your logs, this guide will help you correct the error on your own. We strongly recommend that you backup your database and your Confluence home directory beforehand, so that you can restore your site from those if required. If you are unfamiliar with SQL, we suggest you contact your database administrator for assistance.

Preferable solution

The Production Backup Strategy is a very reliable and more efficient way to do backups. If you are running into
problems with XML backups - whether memory related or because of problems like the one described here - use the native backup tool as an alternate solution.

**To Identify And Correct The Problem**

To work out where the data corruption or problems are, increase the status information reported during backup, then edit the invalid database entry:

1. Stop Confluence.
2. If you have an external database, use a database administration tool to create a manual database backup.
3. Backup your Confluence home directory. You will be able to **restore your whole site** using this and the database backup.
4. Open the `my_confluence_install/confluence/WEB-INF/classes/log4j.properties` and add this to the bottom and save:

   ```
   log4j.logger.com.atlassian.confluence.importexport.impl.XMLDatabinder=DEBUG,confluencelog
   log4j.additivity.com.atlassian.confluence.importexport.impl.XMLDatabinder=false
   ```

5. Find your `atlassian-confluence.log`. Move or delete all existing Confluence logs to make it easier to find the relevant logging output.
6. Restart Confluence and login.
7. Begin a backup so that the error reoccurs.
8. You must now check your log files to find out what object could not be converted into XML format. Open the `confluence-home/logs/atlassian-confluence.log`. Scroll to the bottom of the file.
9. Do a search for 'ObjectNotFoundException'. You should see an error similar to this:
10. Open a DBA tool such as DbVisualizer and connect to your database instance. Scan the table names in the schema. You will have to modify a row in one of these tables.

11. To work out which table, open catalina.out, check the first line of the exception. This says there was
Troubleshooting "Duplicate Key" related problems

If you are encountering an error message such as:

could not insert:
{bucket.user.propertyset.BucketPropertySetItem#bucket.user.propertyset.BucketPropertySetItem@a70067d3}; SQL []; Violation of PRIMARY KEY constraint 'PK_OS_PROPERTYENTRY314D4EA8'. Cannot insert duplicate key in object 'OS_PROPERTYENTRY'; nested exception is java.sql.SQLException: Violation of PRIMARY KEY constraint 'PKOS_PROPERTYENTRY_314D4EA8'. Cannot insert duplicate key in object 'OS_PROPERTYENTRY'.

this indicates that the Primary Key constraint 'PK_OS_PROPERTYENTRY_314D4EA8' has duplicate entries in table 'OS_PROPERTYENTRY'. You can locate the constraint key referring to 'PK_OS_PROPERTYENTRY_314D4EA8' in your table 'OS_PROPERTYENTRY' and locate any duplicate values in it and remove them, to ensure the "PRIMARY KEY" remains unique. An example query to list duplicate entries in the 'OS.PropertyEntry' table is:

```
SELECT ENTITY_NAME,ENTITY_ID,ENTITY_KEY,COUNT(*) FROM OS_PROPERTYENTRY
GROUP BY ENTITY_NAME,ENTITY_ID,ENTITY_KEY HAVING COUNT(*)>1
```

To Help Prevent This Issue From Reoccurring

1. If you are using the embedded database, be aware that it is bundled for evaluation purposes and does not offer full transactional integrity in the event of sudden power loss, which is why an external database is recommended for production use. You should migrate to an external database.
2. If you are using an older version of Confluence than the latest, you should consider upgrading at this point.

RELATED TOPICS

Enabling detailed SQL logging

Migrating from HSQLDB to MySQL

If you've gone through Migrating to Another Database and cannot migrate because of a failed xml backup, this page might help.

Disclaimer
MySQL Migration Toolkit is released by the makers of MySQL and as such, problems with the software should be directed to them. Atlassian Support does not offer support for the Migration Toolkit, nor do we provide support for this migration path. These instructions are offered for strictly informational purposes, and your mileage may vary.

**Backup Reminder**
Please backup your database and your home folder before attempting this.

The information on this page does not apply to Confluence Cloud.

Resources needed

- Empty MySQL DB with appropriate credentials to allow creation, deletion, and insertion of tables and rows.
- A Windows machine that can both communicate to the Confluence server and the destination DB.
- MySQL Migration Toolkit
- HSQL Database Engine

Preparation for migrating to MySQL from HSQLDB

1. Shutdown Confluence
2. Make a copy of the confluence home folder for backup purposes
3. Install the Migration Toolkit
4. Unzip the hsqldb package.
5. Copy the hsqldb.jar from hsqldb/lib into C:\Program Files\MySQL\MySQL Tools for 5.0\java\lib
6. Start the MySQL Migration Toolkit

Running the Migration Toolkit

You should be presented with the following screen.
### Source Database

Select the source database you want to migrate from.

#### Source Database Connection

- **Database System:** Generic JDBC
- **Driver:** Generic JDBC

#### Connection Parameters

- **Stored Connection:**
- **Class Name:** org.hsqldb.jdbcDriver
- **Connection String:** `jdbc:hsqldb:file:PATHTODATABASEFOLDER\confluencedb\`
- **Username:** sa
- **Password:** No password. Leave this field blank
Destination Database

Please make sure that the computer that is running MySQL Toolkit is able to access the MySQL server and that the user listed has the ability to create, drop, insert, and update tables.

If your MySQL user has a $ character in the password (such as 'pa$sword'), please change the password or create a temporary account with full permissions. If you do not, the toolkit will throw an "Illegal group reference" error and you will not be able to proceed with the migration.

Target Database
Select the destination database.

Connecting to Servers

Please enter the connection parameters to connect to the database.

- **Hostname**: Hostname of the server machine - TCP/IP port
- **Username**: Name of the user to connect with
- **Password**: The user's password

Advanced Settings

Connection String: Jdbc Connection String
You should see the toolkit trying to connect. If you have problems, please click on the advanced options and sql will show you debugging information. Click Advanced to see the log. If you see "Java Heap Space: Out of Memory", you can start the MySQL Migration Toolkit with a -Xmx flag to allocate more memory to the JVM.

After this screen you should come to reverse engineering. Click next.

Source Schemata Selection

You should see 2 databases, INFORMATION_SCHEMA and PUBLIC. Choose PUBLIC.

Object Type Selection
Migration

In this step the selected object will be migrated.

Migration of Meta Data

Tasks to execute

The following tasks will now be executed. Please monitor the execution progress. Press [Advanced >>] to see the log.

- Execute Migration Process
- Generate SQL Create Statements

Execution completed successfully.

Click Next.

Object Type Mapping

Object Creation Options

Please define how the object creation should be performed.

Object Creation Options

Database Object Creation Parameters

Select the desired options for the object creation. Click Next > to start the creation process.

- Create Objects Online
- Create Script File for Create Statements

If you want to store the object creation in a script file enable this option. You can use this option in parallel to creating the objects online option if you want to have a backup of the SQL commands.

Click Show Details on both sections. For Migration Method for Type Schema, choose Multilanguage. For Migration Method for Type Table, choose Data Consistency/Multilanguage.

Click Advanced. Check Enabled Detailed Mappings in Next Step

Detailed Object Mapping

Click to rename the destination database to be the one set aside to migrate to.

From this point on, you should be able to click next all the way through to finish the migration.

Troubleshooting XML backups that fail on restore

XML site backups are only necessary for migrating to a new database. Upgrading Confluence, Setting up a test server or Production Backup Strategy is better done with an SQL dump.

However, if migrating from HSQLDB to MySQL, you might have a better experience using the MySQL Migration Toolkit.

Seeing an error when creating or importing a site or space backup?

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception while creating backup</td>
<td>Follow Troubleshooting failed XML site backups instead</td>
</tr>
</tbody>
</table>
Exception while importing backup | Follow instructions below

On this page:

- Resolve Errors When Attempting To Restore An XML Backup
- Troubleshooting "Duplicate Entry" for key "cp_" or "cps_"
- Troubleshooting "Duplicate Key" related problems
- Troubleshooting "net.sf.hibernate.PropertyValueException: not-null" related problems
- To Help Prevent this Issue from Recurring

Related Topics:

Troubleshooting failed XML site backups
Confluence Administrator's Guide

Resolve Errors When Attempting To Restore An XML Backup

The errors may be caused by a slightly corrupt database. You will need to find the XML backup file entry that is violating the DB rules, modify the entry and recreate the XML backup:

1. On the instance being restored, follow the instructions to disable batched updates (for simpler debugging), log SQL queries and log SQL queries with parameters at Enabling Detailed SQL Logging.
2. Once all three changes have been made, restart Confluence.
3. Attempt another restore.
4. Once the restore fails, check your log files to find out what object could not be converted into XML format. For Confluence distribution users, check your Confluence install directory under the /logs/ and check both atlassian-confluence.log and catalina.out file. The correct file will contain SQL debug output.
5. Scroll to the bottom of the file and identify the last error relating to a violation of the database constraint. For example:
This example indicates a row in your attachment table with ID = 38 that has a null title.

6. Go to the server that the backup was created on. You must have a copy of the database from which the backup was created. If you do not have this, use a DBA tool to restore a manual backup of the database.

7. Open a DBA tool and connect to the original database instance and scan the table names in the schema. You will have to modify a row in one of these tables.

8. To work out which table, open catalina.out, check the first line of the exception. To work out what table an object maps to in the database, here's a rough guide:
   - Pages, blogposts, comments -> CONTENT table.
   - attachments -> ATTACHMENTS table.

9. To correct the example error, go to the attachment table and find that attachment object with id 38. This will have a a null title. Give a title using the other attachments titles as a guide. You may have a different error and should modify the database accordingly.

10. Once the entry has been corrected, create the XML backup again.

11. Import the backup into the new version.

12. If the import succeeds, revert the changes made in your SQL logging to re-enable disable batched updates and turn off log SQL queries and log SQL queries with parameters.


Troubleshooting "Duplicate Entry" for key "cp_" or "cps_"

If you are encountering an error message such as:

```
com.atlassian.confluence.importexport.ImportExportException: Unable to complete import because the data does not match the constraints in the Confluence schema. Cause: MySQLIntegrityConstraintViolationException: Duplicate entry '1475804-Edit' for key 'cps_unique_type'
```

This indicates that the XML export came from a version of Confluence with a corrupt permissions database, caused by some 3rd party plugin. This is an issue that was fixed when CONF-22123 was implemented in Confluence 3.5.2. The simplest workaround is to export the space again after upgrading the instance to 3.5.2 or above. If that is not an option, then either the export will need to be edited manually to remove the duplicate permission entries or the source instance will need to have the offending entries removed. The following SQL queries can be used to look for such entries:
SELECT * FROM CONTENT_PERM WHERE USERNAME IS NULL AND GROUPNAME IS NULL;

SELECT cp.ID, cp.CP_TYPE, cp.USERNAME, cp.GROUPNAME, cp.CPS_ID, cp.CREATOR,
cp.CREATIONDATE, cp.LASTMODIFIER, cp.LASTMODDATE
FROM CONTENT_PERM cp
WHERE cp.USERNAME IS NOT NULL AND cp.GROUPNAME IS NOT NULL;

SELECT cps1.ID, cps1.CONTENT_ID, cps1.CONT_PERM_TYPE FROM CONTENT_PERM_SET cps1,
CONTENT_PERM_SET cps2
WHERE cps1.ID <> cps2.ID AND
cps1.CONTENT_ID = cps2.CONTENT_ID AND
cps1.CONT_PERM_TYPE = cps2.CONT_PERM_TYPE
ORDER BY cps1.CONTENT_ID, cps1.CONT_PERM_TYPE, cps1.CREATIONDATE ASC;

SELECT cp.ID, cp.CP_TYPE, cps.CONTENT_ID,
(SELECT scps.ID FROM CONTENT_PERM_SET scps WHERE scps.CONTENT_ID = cps.CONTENT_ID
AND scps.CONT_PERM_TYPE = cp.CP_TYPE) AS suggested_cps_id
FROM CONTENT_PERM cp, CONTENT_PERM_SET cps
WHERE cp.CPS_ID = cps.ID AND
cp.CP_TYPE <> cps.CONT_PERM_TYPE;

SELECT DISTINCT cp1.ID, cp1.CP_TYPE, cp1.USERNAME, cp1.GROUPNAME, cp1.CPS_ID,
cp1.CREATOR, cp1.CREATIONDATE, cp1.LASTMODIFIER, cp1.LASTMODDATE
FROM CONTENT_PERM cp1, CONTENT_PERM_SET cps1, CONTENT_PERM cp2, CONTENT_PERM_SET
cps2
WHERE
cp1.CPS_ID = cps1.ID AND
cp2.CPS_ID = cps2.ID AND
cp1.ID <> cp2.ID AND
cps1.CONTENT_ID = cps2.CONTENT_ID AND
cp1.CP_TYPE = cp2.CP_TYPE AND
cp1.USERNAME = cp2.USERNAME
ORDER BY cp1.CPS_ID, cp1.CP_TYPE, cp1.USERNAME, cp1.CREATIONDATE;

SELECT DISTINCT cp1.ID, cp1.CP_TYPE, cp1.USERNAME, cp1.GROUPNAME, cp1.CPS_ID,
cp1.CREATOR, cp1.CREATIONDATE, cp1.LASTMODIFIER, cp1.LASTMODDATE
FROM CONTENT_PERM cp1, CONTENT_PERM_SET cps1, CONTENT_PERM cp2, CONTENT_PERM_SET
cps2
WHERE
cp1.CPS_ID = cps1.ID AND
cp2.CPS_ID = cps2.ID AND
cp1.ID <> cp2.ID AND
cps1.CONTENT_ID = cps2.CONTENT_ID AND
cp1.CP_TYPE = cp2.CP_TYPE AND
cp1.GROUPNAME = cp2.GROUPNAME
ORDER BY cp1.CPS_ID, cp1.CP_TYPE, cp1.GROUPNAME, cp1.CREATIONDATE;

SELECT * FROM CONTENT_PERM_SET
WHERE ID NOT IN (SELECT DISTINCT CPS_ID FROM CONTENT_PERM);

Troubleshooting “Duplicate Key” related problems

If you are encountering an error message such as:

Remove all matching entries and perform the export again.
This indicates that the Primary Key constraint 'PK_OSPROPERTYENTRY_314D4EA8' has duplicate entries in table 'OSPROPERTYENTRY'.
You can locate the constraint key referring to 'PK_OSPROPERTYENTRY_314D4EA8' in your table 'OSPROPERTYENTRY' and locate any duplicate values in it and remove them, to ensure the "PRIMARY KEY" remains unique. An example query to list duplicate entries in the 'OSPROPERTYENTRY' table is:

```
SELECT ENTITY_NAME,ENTITY_ID,ENTITY_KEY,COUNT(*) FROM OS_PROPERTYENTRY
GROUP BY ENTITY_NAME,ENTITY_ID,ENTITY_KEY HAVING COUNT(*)>1
```

Troubleshooting "net.sf.hibernate.PropertyValueException: not-null" related problems

If you’re receiving a message like:

```
ERROR [Importing data task]
[confluence.importexport.impl.ReverseDatabinder] endElement
net.sf.hibernate.PropertyValueException: not-null property references a
null or transient value:
com.atlassian.user.impl.hibernate.DefaultHibernateUser.name
```

This means there’s an unexpected null value in a table. In the above example, the error is in the name column in the USERS table. We’ve also seen them in the ATTACHMENTS table.
Remove the row with the null value, redo the xml export, and reimport.

To Help Prevent this Issue from Recurring

1. If you are using the embedded database, be aware that it is bundled for evaluation purposes and does not offer full transactional integrity in the event of sudden power loss, which is why an external database is recommended for production use. You should migrate to an external database.
2. If you are using an older version of Confluence than the latest, you should consider upgrading at this point.

The problem with different settings for case sensitivity varies between databases. The case sensitivity of the database is usually set through the collation that it uses. Please vote on the existing issue

Attachment Storage Configuration

Database attachment storage was deprecated in Confluence 5.5. If you currently store attachments in the database you will be able to continue to do so, but you will be unable to switch to storing attachments in the database in Confluence 5.5 or later.

System Administrators can configure where Confluence stores attachments. Attachments can be stored in a:

- File system - locally in the Confluence home directory, or
- Database - in Confluence’s configured database (deprecated)

To configure Confluence attachment storage:
• Choose the cog icon, then choose General Configuration under Confluence Administration.
• Choose Attachment Storage.

On this page:
• Attachment Storage Options
  • Local File System
  • Database (deprecated)
• Migrating between Attachment Storage Systems

Related pages:
• Working with Confluence Logs

Attachment Storage Options

Local File System

By default, Confluence stores attachments in the attachments directory within the configured Confluence home folder.

Database (deprecated)

Confluence 5.4 and earlier gives administrators the option to store attachments in the database that Confluence is configured to use.

⚠️ While storing attachments in the database can offer some advantages (such as ease of backup, and avoiding issues with some characters in attachment filenames), please be aware that the amount of space used by the database will increase because of greater storage requirements.

Migrating between Attachment Storage Systems

You can ‘migrate’ your attachments from one storage system to another. All existing attachments will be moved over to the new attachment storage system.

⚠️ When the migration occurs, all other users will be locked out of the Confluence instance. This is to prevent modification of attachments while the migration occurs. Access will be restored as soon as the migration is complete.

⚠️ When migrating attachments from your database to a filesystem, the attachments are removed from the database after migration. However, when migrating attachments from a filesystem to your database, the attachments remain on the filesystem after migration.

To perform a migration, follow the steps below:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Click ‘Attachment Storage’ in the left-hand panel. The current configuration will be displayed.

Screenshot: Attachment storage configuration
3. Click the 'Edit' button to modify the configuration.
4. Select the storage system you desire.  
   
   **Screenshot: Edit attachment storage**

5. Click the 'Save' button to save the changes.
6. A screen will appear, asking you to confirm your changes. Clicking 'Migrate' will take you to a screen that displays the progress of the migration.  
   
   **Screenshot: migration warning**

The following external website provides further information on migrating attachments from database to file system storage that you might find helpful - [http://www.scandio.de/2013/05/confluence-attachment-migration-the-safe-way-2/](http://www.scandio.de/2013/05/confluence-attachment-migration-the-safe-way-2/).

**Configuring Attachment Size**

Confluence gives you the option of limiting the maximum size of a single file attachment. Confluence administrators should keep in mind that the amount of disk space used by Confluence is directly proportional to the number and size of attachments put into the system.

**To configure the maximum size allowed for an attachment:**

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Choose **General Configuration** in the left-hand panel.
3. Choose **Edit**.
4. Enter the maximum size next to **Attachment Maximum Size**.
   The default is 10mb.
5. Choose **Save**.

**To configure the maximum 'index-able size of attachments':**

By default, large attachment is defined as greater than 1 MB.
The threshold for attachments that won't get excerpts can be modified using the system property `atlthrow.indexing.contentbody.maxsize`, which takes a size in bytes.

**Example**

To specify 250 kb you would use the following JVM parameter:

```
-Datlassian.indexing.contentbody.maxsize=256000
```

**Related pages:**
- Recognised System Properties
- Working with Attachments
- Confluence Administrator’s Guide

**Outcomes of Limiting Attachment Indexing Size**

Limiting the size of attachment indexing has the following effects:

- Decreases the size of the index when large attachments are present.
- Decreases the memory used in indexing large attachments.
- Prevent excerpts of large attachments being displayed in search results.

For more details, please refer to the following issue in our issue tracker: CONF-10512.

**Confluence Data Model**

This document provides a diagram of the Confluence schema and a conceptual overview of the data model.

**Notes:**

- The Hibernate mapping files are the authoritative reference for the Confluence data model. These are the `*.hbm.xml` files which you will find in the main Confluence JAR file (`<CONFLUENCE-INSTALLATION>/confluence/WEB-INF/lib/confluence-5.1.1.jar`).
- The tables, columns and other attributes are likely to change with each major release of Confluence. To find the exact DDL of your Confluence site, please run a query after installation.

**Database diagrams**

**Detailed diagrams**

The following SVG images (Scalable Vector Graphics) include all the tables in the Confluence database. Click the links below to open the images in your browser, or download the SVG files for later use. You can use the browser’s zoom (Ctrl++ or Cmd++) to see more detail in the diagrams:

- [ConfluenceTables-KeysOnly.svg](#) – Shows all tables, with primary keys only for each table.
- [ConfluenceTables-AllColumns.svg](#) – Shows all tables, and all columns for each table.
Overview diagram

This image shows the core tables. Note that the image is very large. You may need to download it (right-click on the image) and view it in an image viewer. Alternatively, use the SVG images linked in the previous section.

Click here to show/hide the image...
Expand the link below to see a table of the primary and foreign keys for each table.

[Click here to show/hide the table...](#)

<table>
<thead>
<tr>
<th>Primary key table name</th>
<th>Primary key column name</th>
<th>Foreign key table name</th>
<th>Foreign key column name</th>
<th>Foreign key name</th>
</tr>
</thead>
<tbody>
<tr>
<td>AO_9412A1_AOUSER</td>
<td>ID</td>
<td>AO_9412A1_USER_APP_LINK</td>
<td>USER_ID</td>
<td>fk_ao_941</td>
</tr>
<tr>
<td>attachments</td>
<td>attachmentid</td>
<td>attachmentdata</td>
<td>attachmentid</td>
<td>fk9dc3e34</td>
</tr>
<tr>
<td>attachments</td>
<td>attachmentid</td>
<td>attachments</td>
<td>prevver</td>
<td>fk54475f9</td>
</tr>
<tr>
<td>attachments</td>
<td>attachmentid</td>
<td>content_label</td>
<td>attachmentid</td>
<td>fk0e7436c</td>
</tr>
<tr>
<td>attachments</td>
<td>attachmentid</td>
<td>imagedetails</td>
<td>attachmentid</td>
<td>fka768048</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>attachments</td>
<td>pageid</td>
<td>fk54475f9</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>bodycontent</td>
<td>contentid</td>
<td>fka898d47</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>confancestors</td>
<td>ancestorid</td>
<td>fk9494e23</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>confancestors</td>
<td>descendendid</td>
<td>fk9494e23</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>content</td>
<td>parentid</td>
<td>fk6382c05</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>content</td>
<td>parentcommentid</td>
<td>fk6382c05</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>content</td>
<td>pageid</td>
<td>fk6382c05</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>content</td>
<td>content_label</td>
<td>fk0e7436c</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>content_perm_set</td>
<td>content_id</td>
<td>fkbf45a7f</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>contentproperties</td>
<td>contentid</td>
<td>fk984c5e4</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>extrnlnks</td>
<td>contentid</td>
<td>fk97c10fe</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>likes</td>
<td>contentid</td>
<td>fk4514b9c</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>links</td>
<td>contentid</td>
<td>fk4515799</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>notifications</td>
<td>pageid</td>
<td>fk594acc8</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>spaces</td>
<td>homepage</td>
<td>fk9228242</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>spaces</td>
<td>spacedescid</td>
<td>fk9228242</td>
</tr>
<tr>
<td>content</td>
<td>contentid</td>
<td>trackbacklinks</td>
<td>contentid</td>
<td>fk6977a4</td>
</tr>
<tr>
<td>content_perm_set</td>
<td>id</td>
<td>content_perm</td>
<td>cps_id</td>
<td>fkbd74b31</td>
</tr>
<tr>
<td>cwd_app_dir_mapping</td>
<td>id</td>
<td>cwd_app_dir_group_mapping</td>
<td>app_dir_mapping_id</td>
<td>fk_app_dir</td>
</tr>
<tr>
<td>cwd_app_dir_mapping</td>
<td>id</td>
<td>cwd_app_dir_operation</td>
<td>app_dir_mapping_id</td>
<td>fk_app_dir</td>
</tr>
<tr>
<td>cwd_application</td>
<td>id</td>
<td>cwd_app_dir_group_mapping</td>
<td>application_id</td>
<td>fk_app_dir</td>
</tr>
<tr>
<td>cwd_application</td>
<td>id</td>
<td>cwd_app_dir_mapping</td>
<td>application_id</td>
<td>fk52050e2</td>
</tr>
<tr>
<td>cwd_application</td>
<td>id</td>
<td>cwd_application_address</td>
<td>application_id</td>
<td>fk_applic</td>
</tr>
<tr>
<td>cwd_application</td>
<td>id</td>
<td>cwd_application_attribute</td>
<td>application_id</td>
<td>fk_applica</td>
</tr>
</tbody>
</table>
The following sections describe the principal tables involved in each logical area of Confluence – authentication, content, system information, and so on.

### Authentication

<table>
<thead>
<tr>
<th>Table</th>
<th>Column 1</th>
<th>Column 2</th>
<th>Column 3</th>
<th>Column 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>cwd_directory</td>
<td>id</td>
<td>cwd_app_dir_group_mapping</td>
<td>directory_id</td>
<td>fk_app_dir</td>
</tr>
<tr>
<td>cwd_directory</td>
<td>id</td>
<td>cwd_app_dir_mapping</td>
<td>directory_id</td>
<td>fk_app_dir</td>
</tr>
<tr>
<td>cwd_directory</td>
<td>id</td>
<td>cwd_directory_attribute</td>
<td>directory_id</td>
<td>fk_director</td>
</tr>
<tr>
<td>cwd_directory</td>
<td>id</td>
<td>cwd_directory_operation</td>
<td>directory_id</td>
<td>fk_director</td>
</tr>
<tr>
<td>cwd_directory</td>
<td>id</td>
<td>cwd_group</td>
<td>directory_id</td>
<td>fk_director</td>
</tr>
<tr>
<td>cwd_directory</td>
<td>id</td>
<td>cwd_group_attribute</td>
<td>directory_id</td>
<td>fk_group</td>
</tr>
<tr>
<td>cwd_directory</td>
<td>id</td>
<td>cwd_user</td>
<td>directory_id</td>
<td>fk_user</td>
</tr>
<tr>
<td>cwd_directory</td>
<td>id</td>
<td>cwd_user_attribute</td>
<td>directory_id</td>
<td>fk_user_at</td>
</tr>
<tr>
<td>cwd_group</td>
<td>id</td>
<td>cwd_group_attribute</td>
<td>group_id</td>
<td>fk_group</td>
</tr>
<tr>
<td>cwd_group</td>
<td>id</td>
<td>cwd_membership</td>
<td>parent_id</td>
<td>fk_parent</td>
</tr>
<tr>
<td>cwd_group</td>
<td>id</td>
<td>cwd_membership</td>
<td>child_group_id</td>
<td>fk_child_gi</td>
</tr>
<tr>
<td>cwd_user</td>
<td>id</td>
<td>cwd_membership</td>
<td>child_user_id</td>
<td>fk_child_u</td>
</tr>
<tr>
<td>cwd_user</td>
<td>id</td>
<td>cwd_user_attribute</td>
<td>user_id</td>
<td>fk_user_at</td>
</tr>
<tr>
<td>external_entities</td>
<td>id</td>
<td>external_members</td>
<td>extentityid</td>
<td>fkd8c8d8a</td>
</tr>
<tr>
<td>groups</td>
<td>id</td>
<td>external_members</td>
<td>groupid</td>
<td>fkd8c8d8a</td>
</tr>
<tr>
<td>groups</td>
<td>id</td>
<td>local_members</td>
<td>groupid</td>
<td>fk6b8fb44f</td>
</tr>
<tr>
<td>keystore</td>
<td>keyid</td>
<td>trustedapp</td>
<td>public_key_id</td>
<td>fkddb119c</td>
</tr>
<tr>
<td>label</td>
<td>labelid</td>
<td>content_label</td>
<td>labelid</td>
<td>fkf0e7436e</td>
</tr>
<tr>
<td>os_group</td>
<td>id</td>
<td>os_user_group</td>
<td>group_id</td>
<td>fk9324724</td>
</tr>
<tr>
<td>os_user</td>
<td>id</td>
<td>os_user_group</td>
<td>user_id</td>
<td>fk9324724</td>
</tr>
<tr>
<td>pagetemplates</td>
<td>templateid</td>
<td>content_label</td>
<td>pagetemplateid</td>
<td>fkf0e7436e</td>
</tr>
<tr>
<td>pagetemplates</td>
<td>templateid</td>
<td>pagetemplates</td>
<td>prevver</td>
<td>fkbc7ce96</td>
</tr>
<tr>
<td>spacegroups</td>
<td>spacegroupid</td>
<td>spacegrouppermissions</td>
<td>spacegroupid</td>
<td>fk487d958</td>
</tr>
<tr>
<td>spacegroups</td>
<td>spacegroupid</td>
<td>spaces</td>
<td>spacegroupid</td>
<td>fk9228242</td>
</tr>
<tr>
<td>spaces</td>
<td>spaceid</td>
<td>content</td>
<td>spaceid</td>
<td>fk6382c05</td>
</tr>
<tr>
<td>spaces</td>
<td>spaceid</td>
<td>notifications</td>
<td>spaceid</td>
<td>fk594acc8</td>
</tr>
<tr>
<td>spaces</td>
<td>spaceid</td>
<td>pagetemplates</td>
<td>spaceid</td>
<td>fkbc7ce96</td>
</tr>
<tr>
<td>spaces</td>
<td>spaceid</td>
<td>spacepermissions</td>
<td>spaceid</td>
<td>fkd33f23b</td>
</tr>
<tr>
<td>trustedapp</td>
<td>trustedappid</td>
<td>trustedapprestriction</td>
<td>trustedappid</td>
<td>fe8496ba</td>
</tr>
<tr>
<td>users</td>
<td>id</td>
<td>local_members</td>
<td>userid</td>
<td>fk6b8fb44f</td>
</tr>
</tbody>
</table>

*The following sections describe the principal tables involved in each logical area of Confluence – authentication, content, system information, and so on.*
This section describes the tables involved in user authentication, which is implemented via the Atlassian Crowd framework embedded in Confluence.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cwd_user</td>
<td>Information for each user in Confluence.</td>
</tr>
<tr>
<td>cwd_group</td>
<td>The groups to which users can belong.</td>
</tr>
<tr>
<td>cwd_membership</td>
<td>Mapping the membership of users to groups.</td>
</tr>
<tr>
<td>cwd_directory</td>
<td>The user directories in your Confluence site. Examples of directories are the Confluence internal directory, or an LDAP directory.</td>
</tr>
<tr>
<td>cwd_application</td>
<td>The applications (JIRA, Confluence, and so on) defined in the authentication framework.</td>
</tr>
</tbody>
</table>

Content

This section describes the tables involved in storing content. Content is the information that Confluence users are storing and sharing.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>attachmentdata</td>
<td>The binary data for attached files. This table is only used when Confluence is configured to store attachments in the database. Otherwise, attachments are stored in the local file system.</td>
</tr>
<tr>
<td>attachments</td>
<td>Metadata for the files attached to Confluence pages.</td>
</tr>
<tr>
<td>bodycontent</td>
<td>The content of Confluence pages. No version information or other metadata is stored here. That is all in the content table.</td>
</tr>
<tr>
<td>content</td>
<td>A persistence table for the ContentEntityObject class of objects. The subclass is indicated by the contenttype column.</td>
</tr>
<tr>
<td>content_label</td>
<td>Arbitrary text labels for content.</td>
</tr>
<tr>
<td>label</td>
<td>The other half of the content_label system.</td>
</tr>
<tr>
<td>content_perm</td>
<td>Content-level permissions objects.</td>
</tr>
<tr>
<td>content_perm_set</td>
<td>A one-to-many mapping for content items and their permissions, with added metadata.</td>
</tr>
<tr>
<td>pagetemplates</td>
<td>The back end of the templates feature.</td>
</tr>
<tr>
<td>likes</td>
<td>The pages and other content liked by a particular user.</td>
</tr>
<tr>
<td>follow_connections</td>
<td>A mapping of users who are following other users.</td>
</tr>
</tbody>
</table>

Clustering

The following table contains information about clustered Confluence sites.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clustersafety</td>
<td>Normally, this table only contains one row. The value of the safetynumber is what Confluence uses to find out whether another Confluence site is sharing its database without being part of the cluster.</td>
</tr>
</tbody>
</table>

System information
These tables store data related to the status and configuration of the Confluence site.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>confversion</td>
<td>Used by the upgrade system to determine what to expect from the database, so as to negotiate upgrades.</td>
</tr>
<tr>
<td>plugindata</td>
<td>A record of the plugins that have been installed, and when.</td>
</tr>
<tr>
<td></td>
<td>data is a blob of the actual plugin JAR file. This is principally cluster-related.</td>
</tr>
</tbody>
</table>

Spaces

This table is related to the management of spaces.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>spaces</td>
<td>Information about the spaces themselves: key, human-friendly name and numeric ID.</td>
</tr>
</tbody>
</table>

Appearance

The following table contains information about the look and feel of your Confluence site.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>decorator</td>
<td>The custom display templates used to customise Velocity layouts.</td>
</tr>
</tbody>
</table>

Miscellaneous

This section includes other tables worth commenting on.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>os_propertyentry</td>
<td>Arbitrary association of entities and properties.</td>
</tr>
<tr>
<td>bandana</td>
<td>A catch-all persistence layer. This table contains things like user settings and space- and global-level configuration data, and is used as storage by plugins such as the Dynamic Task List plugin. Essentially, for storing arbitrary data that doesn't fit anywhere else.</td>
</tr>
<tr>
<td>extrnlnks</td>
<td>Referral links.</td>
</tr>
<tr>
<td>hibernate_unique_key</td>
<td>Used by the high/low ID generator – the subsystem which generates our primary keys. If you interfere with this table, you may not be able to create objects in Confluence.</td>
</tr>
<tr>
<td>indexqueueentries</td>
<td>Manages full-content indexing across the system. The table generally contains the last 12 hours (approximately) of updates, to allow re-syncing of cluster nodes after restarts.</td>
</tr>
<tr>
<td>keystore</td>
<td>Used by the trusted apps framework to store the server's private key, and other servers' public keys.</td>
</tr>
<tr>
<td>links</td>
<td>Tracks links within the server (that is, across and within spaces).</td>
</tr>
<tr>
<td>notifications</td>
<td>Stores page- and space-level watches.</td>
</tr>
<tr>
<td>trackbacklinks</td>
<td>Trackback links.</td>
</tr>
<tr>
<td>confancestors</td>
<td>Used to speed up permissions checks, by allowing quick lookup of all a page's ancestors.</td>
</tr>
</tbody>
</table>
Finding Unused Spaces

Sometimes, you want to know what is not being used. It's great to know what's getting most attention, but what about stagnant pages, or even entire spaces that are no longer active?

While viewing space activity can provide hints, it doesn't always provide enough detail. The simple way is to go directly to the database. We recommend DbVisualizer, and have basic instructions for connecting it to HSQLDB.

The following query identifies the last date on which content was modified in each space within a single Confluence instance:

```
SELECT spaces.spacename, MAX(content.lastmoddate)
FROM content, spaces
WHERE content.spaceid = spaces.spaceid
GROUP BY spaces.spacename;
```

It returns a list of spacenames, and the last date and time at which any content was added or changed.

The information on this page does not apply to Confluence Cloud.

Alternatively, this one simply identifies spaces whose content hasn't changed since a specified date:

```
SELECT spaces.spacename
FROM content, spaces
WHERE content.spaceid = spaces.spaceid
GROUP BY spaces.spacename
HAVING MAX(content.lastmoddate) < '2006-10-10';
```

The result is a simple list of space names.

It's also possible to present the information in a wiki page, using the SQL plugin, which can be installed using the Plugin Exchange. You'll also need to define a database resource in conf/server.xml and confluence/WEB-INF/web.xml, as described here. Having done so, you can use wiki markup code like the following, replacing confluenceDS with the name of your own local datasource:

```
{sql: dataSource=confluenceDS|output=wiki}
SELECT spaces.spacename AS Space, MAX(content.lastmoddate) AS LastModified
FROM content, spaces
WHERE content.spaceid = spaces.spaceid
GROUP BY Space;
{sql}
```

The result will be something like this:

<table>
<thead>
<tr>
<th>Space activity:</th>
</tr>
</thead>
<tbody>
<tr>
<td>space</td>
</tr>
<tr>
<td>Private Space</td>
</tr>
</tbody>
</table>

You can try the Chart plugin in combination with the SQL plugin to give more visually attractive results.
**Data Import and Export**

Confluence administrators and users can import data into Confluence from a number of sources. The permissions required differ, depending on the scope of the import. See *Importing Content Into Confluence*.

You can also export Confluence content to various formats. See *Exporting Confluence Pages and Spaces to Other Formats*.

**Configuring a Confluence Environment**

This section describes the external setup of your Confluence installation. It includes information on configuring the web server, application server, directories and files – everything to do with the environment that Confluence runs in. For guidelines on modifying settings inside the application, see *Configuring Confluence* instead.

Confluence is a J2EE web application. On the client side, users access Confluence primarily via a web browser.

This section contains the following guidelines:

- Confluence Home and other important directories
- Application Server Configuration
- Web Server Configuration
- Starting Confluence Automatically on System Startup

**Diagram: A Confluence installation**

**Confluence Home and other important directories**

Confluence installation directory
The 'Confluence Installation directory' is the directory where Confluence was installed. This directory is also sometimes called the 'Confluence Install directory'. Confluence does not modify or store any data in this directory.

Important files in the installation directory:

- `bin/setenv.bat` or `bin/setenv.sh`
  This file is used to edit `CATALINA_OPTS` memory and garbage collection settings and define system properties.
- `confluence/WEB-INF/classes/confluence-init.properties`
  This file contains the location of the Confluence Home directory.

Confluence home directory

The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. Another term for 'Home directory' would be 'data directory'.

Finding the home directory

The location of the Confluence home directory is defined when you install Confluence. This location is stored in the `confluence-init.properties` file, which is located in the `confluence/WEB-INF/classes` directory of your Confluence Installation directory.

When Confluence is running you can find the location of the home directory in `Configuration > System Information > Confluence Information - Confluence Home`.

If your Confluence instance is clustered, you will also have a shared home directory which will contain some data (such as attachments and backups) that would otherwise reside in the home directory.

Contents of the home directory

The Confluence home directory contains some of the configuration data used by Confluence. This section outlines the purpose of the files and directories in the Confluence home directory.

<table>
<thead>
<tr>
<th>File or directory</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>confluence.cfg.xml</td>
<td>This file contains all of the information necessary for Confluence to start up, such as:</td>
</tr>
<tr>
<td></td>
<td>- Product license</td>
</tr>
<tr>
<td></td>
<td>- Context path</td>
</tr>
<tr>
<td></td>
<td>- Database details, such as location and connection pool settings</td>
</tr>
<tr>
<td></td>
<td>- Paths to important directories</td>
</tr>
<tr>
<td>attachments/</td>
<td>This directory contains every version of each attachment stored in Confluence. You can specify an alternative directory for attachment storage by setting the <code>attachments.dir</code> property in <code>confluence.cfg.xml</code>.</td>
</tr>
<tr>
<td>backups/</td>
<td>Confluence will place its daily backup archives in this directory, as well as any manually generated backups. Backup files in this directory take the following form <code>daily-backup-YYYY_MM_DD.zip</code>. You can specify an alternative directory for backups by setting the <code>daily.backup.dir</code> property in <code>confluence.cfg.xml</code>.</td>
</tr>
<tr>
<td>Directory</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>bundled-plugins/</td>
<td>Confluence includes a set of bundled plugins. The bundled-plugins directory is where Confluence will unpack its bundled plugins when it starts up. This directory is refreshed on every restart, so removing a plugin from this directory will not uninstall the plugin, as it will be replaced the next time Confluence starts up.</td>
</tr>
<tr>
<td>database/</td>
<td>This is where Confluence stores its database when configured to run with the embedded HSQL database. In such cases this directory contains all Confluence runtime data. Installations configured to run using an external database such as MySQL will not use this directory. The HSQL database is provided for evaluating Confluence and is not supported as a production database.</td>
</tr>
<tr>
<td>index/</td>
<td>The Confluence index is heavily used by the application for content searching and recently updated lists and is critical for a running Confluence instance. If data in this directory is lost or corrupted, it can be restored by running a full reindex from within Confluence. This process can take a long time depending on how much data is stored Confluence's database. An alternative directory may be specified for the index by setting the lucene.index.dir property in confluence.cfg.xml.</td>
</tr>
<tr>
<td>plugin-cache/</td>
<td>All Confluence plugins are stored in the database. To allow for quicker access to classes contained within the plugin JARs, Confluence will cache these plugins in the plugin-cache directory. This directory is updated as plugins are installed and uninstalled from the system and is completely repopulated from the database every time Confluence is restarted. Removing plugins from this directory does not uninstall them.</td>
</tr>
<tr>
<td>resources/</td>
<td>The resources directory stores any space logos used in your Confluence instance. Space logos are stored in directories named with the spacekey.</td>
</tr>
<tr>
<td>temp/</td>
<td>The temp directory is used for runtime functions such as exporting, importing, file upload and indexing. Files in this directory are temporary and can be safely removed when Confluence is offline. A daily job within Confluence deletes files that are no longer needed. An alternative directory may be specified for temporary data by setting the webwork.multipart.saveDir property in confluence.cfg.xml.</td>
</tr>
<tr>
<td>thumbnails/</td>
<td>Stores temporary files for image thumbnails. This directory is essentially a thumbnail cache, and files deleted from this directory will be regenerated the next time the image is accessed.</td>
</tr>
</tbody>
</table>

**Changing the location of the home directory**

When Confluence first starts up, it reads the confluence-init.properties file to determine where to look for the Home directory.

To change the location of the home directory, edit the confluence.home property in the confluence-init.properties file as follows:

- **Windows**
  In Windows, the path `C:\confluence\data` would be written as:
  ```properties```
  ```
  confluence.home=C:/confluence/data
  ```
  Note that all backslashes (`\`) are written as forward slashes (`/`)

- **Linux / Solaris**
  On any Linux-based system, the property is defined using the normal directory syntax:
  ```properties```
  ```
  confluence.home=/var/confluence/
  ```
Symbolic links

There can be no symbolic links within the Confluence home directory. You must define an absolute path. If disk space is an issue, place the entire `confluence.home` directory on a disk partition where there is enough space. The absolute path of generated files (such as exports) is compared with the absolute path of the `confluence.home` directory when constructing URLs. When a sub-directory has a different path, the URL will be incorrect, and you may receive "Page not found" errors. These measures are in place to prevent "directory traversal" attacks.

Fixing the Confluence Configuration

The Confluence configuration file: `confluence-cfg.xml` inside the home directory may contain references to the original location of your Confluence home. You will need to edit this file to update these references to also point to the new location. The two properties in this file that need to change are:

- `daily.backup.dir` if you have not configured your backups to be placed elsewhere already
- `hibernate.connection.url` if you are using the embedded HSQL database.

Database

All other data, including page content, is kept in the database. If you have configured Confluence to use the embedded HSQL database, the database will store its files under `database/` in the Confluence Home Directory. Otherwise, the database management system you are connecting to is responsible for where and how your remaining data is stored.

Temp directory

The temp directory is configured in the Java runtime and some Confluence components write temporary files or lockfiles into this directory.

For EAR/WAR installations typically, this directory is `/tmp` on Linux systems, or `C:\Temp` on Windows.

For Standalone installations the temp directory is located in the installation directory as `/temp`.

To change the location of this directory, start the Java Virtual Machine in which confluence is running with the argument:

```
-Djava.io.tmpdir=/path/to/your/own/temp/directory.
```

Application Server Configuration

The following pages contain information about configuring your application server for Confluence:

- Configuring URL Encoding on Tomcat Application Server
- Managing Application Server Memory Settings
- Switching to Apache Tomcat
- Java Policy Settings for Enterprise or Webhosting Environments

Configuring URL Encoding on Tomcat Application Server

Application servers may have different settings for character encodings. We strongly recommend UTF-8 where possible.

By default, Tomcat uses ISO-8859-1 character encoding when decoding URLs received from a browser. This can cause problems when Confluence’s encoding is UTF-8, and you are using international characters in the names of attachments or pages.

To configure the URL encoding in Tomcat:

1. Edit `conf/server.xml` and find the line where the Coyote HTTP Connector is defined. It will look something like this, possibly with more parameters:

   ```xml
   <Connector port="8090"/>
   ```

2. Add a `URIEncoding="UTF-8"` property to the connector:
3. Restart Tomcat

*If you are using mod_jk*

You should apply the same URIEncoding parameter as above to the AJP connector if you are using mod_jk, and add the following option to your Apache mod_jk configuration:

```xml
<Connector port="8009" protocol="AJP/1.3" URIEncoding="UTF-8"/>

JkOptions +ForwardURICompatUnparsed
```

**More information using Apache with Tomcat**

For comprehensive examples of how to use Tomcat and Apache with Confluence, see [Running Confluence behind Apache](#).

**Managing Application Server Memory Settings**

The minimum and maximum JVM heap space allocated to the application server affects performance. Confluence administrators may wish to modify this value from the defaults depending on their server load. This document only provides guidelines rather than rules, so administrators optimising for performance should use this document as a starting point only.

⚠️ For a comprehensive overview of memory management, and memory tuning in Confluence under Sun JRE, please read [Garbage Collector Performance Issues](#).

**Testing For Optimum Memory Settings**

In the general case, both JIRA & Confluence users will benefit from setting the minimum and maximum values identical. In larger installations, there is benefit to memory tuning, if there is a perceived performance issue. If you are experiencing Out of Memory Heap errors, try increasing the -Xmx and -Xms values for your installation to see if this resolves or helps resolve your issue. It's best to increase in small increments (eg 512mb at a time), to avoid having too large a heap, which can cause different problems. If increasing the memory does not help, please lodge a support ticket as there may be other factors contributing.

Memory usage is most likely to be maximised under peak load, and when creating a site XML backup. In many cases, the backup can be the cause of the OOM, so increase -Xmx values and verify if a backup was occurring at the time of OOM. A quick rule of thumb for gauging the success of a memory adjustment is using simple anecdotal evidence from users. Is it snappier? The same? How does it handle while a backup is occurring?

⚠️ Atlassian recommends in normal use, to disable the XML backup and use a [Production Backup Strategy](#).

- If you normally perform manual XML site backups on your server, test your maximum memory requirements by performing a site XML backup while the server is under maximum load
- If you do not create manual XML site backups, simply monitor the server while under maximum load

**Applying Memory Settings**

See [How to Fix Out of Memory Errors by Increasing Available Memory](#).

**Related Topics**

- Garbage Collector Performance Issues
- How to Fix Out of Memory Errors by Increasing Available Memory
Switching to Apache Tomcat

Apache Tomcat is the only application server supported for Confluence. To move Confluence from an application server (e.g. WebSphere) to Tomcat using the same database, follow the instructions below.

Please note, you cannot simply copy the WAR file or expanded WAR directory from an old Confluence EAR/WAR version in the old application server to Tomcat. This will not work.

Follow these instructions:

1. Before You Start
2. Backing Up
3. Switching Application Servers
4. Applying Customisations
   - Confluence Server
   - Plugins
   - Look and Feel
   - Performance
   - Advanced Customisations
5. Testing Confluence

1. Before You Start

1. The following instructions will only work if you are running the same major version of Confluence on both application servers. If you are running different major versions of Confluence, you will need to upgrade Confluence before you can switch to Tomcat.
2. Note that you need current software maintenance, as the process for changing application servers involves installing Confluence or Confluence EAR-WAR.
3. If the environment (e.g. the database system, the operating system and so on) that you are running Confluence in has changed, please ensure it still complies with the Confluence System Requirements.
4. If you are using an external database, familiarise yourself with all known issues for your specific database. Also make sure the Confluence database connector principal (the database user login) has sufficient permissions to modify the database schema.
5. Note any customisations that you have made to Confluence, e.g. enabled/installed plugins, modified layouts, custom themes, etc. You will need to reapply these after you have switched to Tomcat. You can view the list of customisations in the Reapplying Customisations section below.
6. We recommend that you do not run any other applications in your Tomcat application server that is running Confluence, to prevent performance issues.

2. Backing Up

Before you switching to Tomcat, you must back up the following:

1. Back up your Confluence Home directory. The location of the Home directory is stored in a configuration file called confluence-init.properties, which is located inside the confluence/WEB-INF/classes directory in your Confluence Installation directory.
2. Back up your database. Perform a manual backup of your external database before proceeding with the upgrade and check that the backup was created properly. If you are not a database expert or unfamiliar with the backup-restore facilities of your database, you should try to restore the backup to a different system to ensure that the backup worked before proceeding. This recommendation is not specific to Confluence usage, but it is good practice to ensure that your database backup is not broken.
   - The 'embedded database' is the HSQLDB database supplied with Confluence for evaluation purposes, you don't need to back it up since it is stored in the home directory. But you should not use this database for production systems anyway, so if you happen to accidentally still use HSQLDB in a production system, please migrate to a proper database before the upgrade.
3. Back up your Confluence Installation directory (if you are using Confluence) or your Confluence webapp (if you are using Confluence EAR-WAR edition).

3. Switching Application Servers
1. Install Confluence on your new application server. We recommend that you install Confluence (from the zip file) as it is preconfigured with Tomcat. If you want more control over the installation process, you can install Confluence EAR-WAR on Tomcat however this requires more manual configuration.

Regardless of which method you choose, as part of the installation process:

- If you are connecting to your database via a standard JDBC connection, enter the URL, username and password for your existing database.
- If you are connecting to your database via datasource, use the settings for your existing database when you configure the JDBC datasource in your new server. Refer to the appropriate guide below:
  - Configuring a MySQL Datasource in Apache Tomcat
  - Configuring a SQL Server Datasource in Apache Tomcat
  - Configuring a PostgreSQL Datasource in Apache Tomcat

2. Copy the following files from your old Confluence installation to your new one:

   - \{CONFLUENCE_INSTALL}\confluence\WEB-INF\classes\confluence-init.properties
   - \{CONFLUENCE_INSTALL}\confluence\WEB-INF\classes\atlassian-user.xml
   - \{CONFLUENCE_INSTALL}\confluence\WEB-INF\classes\osuser.xml (copy this over if you are using JIRA user management)
   - \{CONFLUENCE_INSTALL}\confluence\WEB-INF\classes\seraph-config.xml (copy this over if you using custom SSO)
   - \{CONFLUENCE_INSTALL}\confluence\WEB-INF\web.xml (copy this over if you have previously modified it, e.g. to configure a datasource)

3. Make sure you shutdown the old server before you startup the new one.

4. If you are running the new application server on a different machine to the old one, carry out the following actions as soon as you start the new server:
   - Re-index your data.
   - Make sure that the attachments location is valid for the new server.

5. If you have applied special settings to their Confluence server and/or Confluence look and feel, you will need to reapply these customisations as described in below.

4. Applying Customisations

After switching to Tomcat, you need to review any customisations and other special configurations you previously used for your Confluence instance, and re-apply if necessary. This section also contains some Tomcat-specific customisations that you may wish to considering applying, if you haven't used Confluence with Tomcat before.

Before you apply customisations

Please ensure that your Confluence installation works correctly on Tomcat without any customisations before you apply any of customisations listed below. This will make it easier to identify problems, if you run into trouble during the switch to Tomcat.

Confluence Server

- For long-term use, we recommend that you configure Confluence to start automatically when the operating system restarts. For Windows servers, this means configuring Confluence to run as a Windows service.
- If you are using the Confluence edition and you have previously defined a CATALINA_HOME environment variable, please check that it points to the correct path for the new Confluence Tomcat server.
- If you were previously running Confluence on a non-standard port, edit your new \<Installation-Directory>\conf\server.xml file as described in Change listen port for Confluence.

Plugins

- If you were previously using any plugins, install the latest compatible version and disable any plugins that are incompatible with your new instance of Confluence. The easiest way to do this is to use the Universal Plugin Manager in the Confluence Administration Console.
Look and Feel

- If you are using any customised themes, please check that they are displaying as expected. Some further customisation may be required to ensure compatibility with your new version of Confluence.
- If you had previously customised the default site or space layouts, you will need to reapply your changes to the new defaults as described here. Please do not just copy your VM (velocity) files across. Ensure that Confluence works without your custom layouts then apply the layout via the Confluence Administration console.

Performance

- If the load on your Confluence instance is high, you may need more simultaneous connections to the database. Read more about this in the Performance Tuning guide.
- If you had previously modified the memory flags (Xms and Xmx) in either the <Installation-Directory>\bin\setenv.sh or the setenv.bat file, you may want to make the modifications in your new installation. The parameters are specified in the CATALINA_OPTS variable. See How to Fix Out of Memory Errors by Increasing Available Memory for more information.

Advanced Customisations

- If you were previously running Confluence over SSL, you will need to reapply your configuration as described in Running Confluence Over SSL or HTTPS.
- If you were using a custom SSO authenticator, change seraph-config.xml to the correct authenticator.
- If you had changed the Confluence interface text, you will need to copy over the ConfluenceActionSupport.properties file.
- If you had previously modified the Confluence source code, you will need to reapply your changes to the new version.

5. Testing Confluence

Make sure you test Confluence on the new server before deploying it in production.

The Working with Confluence Logs document contains the locations for the application logs, if you need to refer to them.

Java Policy Settings for Enterprise or Webhosting Environments

Confluence relies on a number of Java libraries. Some of these libraries make use of features of the Java language that may be restricted by Java security policies.

This does not normally cause any problems. The default security configuration of most application servers will happily run Confluence. However, in some shared-hosting or enterprise environments, security settings may be such that Confluence cannot function.

The permissions required by Confluence to run are detailed in the sample policy file below. You may need to give this information to your systems administrator so that they can be deployed with the Confluence application.
Web Server Configuration

- Configuring Web Proxy Support for Confluence
- Running Confluence behind Apache
  - General Apache Configuration Notes
  - Using Apache with mod_proxy
  - Using Apache with virtual hosts and mod_proxy
  - Using Apache with mod_jk
  - Using mod_rewrite to Modify Confluence URLs
  - Configuring Apache to Cache Static Content via mod_disk_cache

Configuring Web Proxy Support for Confluence

Some of Confluence's macros, such as {rss} and {jiraissues} need to make web requests to remote servers in order to retrieve data. If Confluence is deployed within a data centre or DMZ, it may not be able to access the Internet directly to make these requests. If you find that the {rss} macro does not work, ask your network administrator if Confluence needs to access the Internet through a web proxy.

Configuring an outbound HTTP proxy in Confluence

Proxy support is configured by passing certain system properties to the Java Virtual Machine on startup. These properties follow the conventions defined by Oracle:

- http.proxyHost
- http.proxyPort (default: 80)
- http.nonProxyHosts (default: <none>)
- https.proxyHost
- https.proxyPort

At a minimum, you need to define http.proxyHost to configure an HTTP proxy, and https.proxyHost to configure an HTTPS proxy. System property configuration is described in the Configuring System Properties.

Properties http.proxyHost and http.proxyPort indicate the proxy server and port that the http protocol handler will use, and https.proxyHost and https.proxyPort indicate the same for the https protocol handler.

```
-Dhttp.proxyHost=proxy.example.org -Dhttp.proxyPort=8080
-Dhttps.proxyHost=proxy.example.org -Dhttps.proxyPort=8080
```

Property http.nonProxyHosts indicates the hosts which should be connected to directly and not through the proxy server. The value can be a list of hosts, each separated by a pipe character |. In addition, a wildcard character (asterisk) * can be used for matching. For example:

```
-Dhttp.nonProxyHosts=*.foo.com|localhost
```

Note: You may need to escape the pipe character | in some command-line environments.
If the `http.nonProxyHosts` property is not configured, all web requests will be sent to the proxy.

Please note that any command line parameters set are visible from the process list, and thus anyone who has the appropriate access to view the process list will see the proxy information in the clear. To avoid this, you can set these properties in the `catalina.properties` file, located in `confluence-install/conf/`. Add this to the end of the file:

```text
http.proxyHost=yourProxyURL
http.proxyPort=yourProxyPort
http.proxyUser=yourUserName
http.proxyPassword=yourPassword
https.proxyHost=yourProxyURL
https.proxyPort=yourProxyPort
https.proxyUser=yourUserName
https.proxyPassword=yourPassword
```

Configuring HTTP proxy authentication

Proxy authentication is also configured by providing system properties to Java in your application server’s configuration file. Specifically, the following two properties:

- `http.proxyUser` – username
- `http.proxyPassword` – secret

HTTP proxy (Microsoft ISA) NTLM authentication

Confluence supports NTLM authentication for outbound HTTP proxies when Confluence is running on a Windows server.

This means that the `{rss}` and `{jiraissues}` macro will be able to contact external websites if requests have to go through a proxy that requires Windows authentication. This support is not related to logging in Confluence users automatically with NTLM, for which there is a user-contributed authenticator available.

To configure NTLM authentication for your HTTP proxy, you need to define a domain system property, `http.auth.ntlm.domain`, in addition to the properties for host, port and username mentioned above:

```text
-Dhttp.auth.ntlm.domain=MYDOMAIN
```

Configuring authentication order

Sometimes multiple authentication mechanisms are provided by an HTTP proxy. If you have proxy authentication failure messages, you should first check your username and password, then you can check for this problem by examining the HTTP headers in the proxy failure with a packet sniffer on the Confluence server. (Describing this is outside the scope of this document.)

To set the order for multiple authentication methods, you can set the system property `http.proxyAuth` to a comma-separated list of authentication methods. The available methods are: ntlm, digest and basic; this is also the default order for these methods.

For example, to attempt Basic authentication before NTLM authentication, and avoid Digest authentication entirely, you can set the `http.proxyAuth` property to this value:

```text
-Dhttp.proxyAuth=basic,ntlm -Dhttps.proxyAuth=basic,ntlm
```

Troubleshooting

1. There’s a diagnostic jsp file in CONF-9719 for assessing the connection parameters.
2. “Status Code [407]” errors are described in APR-160.
3. Autoproxies are not supported. See CONF-16941.

Running Confluence behind Apache

---

**Introduction**

For improved performance in high-load environments, you should run Confluence behind a web server. In general, web server caching and thread management is far superior to that provided by your application server's HTTP interface.

To run Confluence behind the Apache httpd web server, there are two main configuration options: mod_jk or mod_proxy.

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Unique features</th>
<th>Common features to both mod_proxy and mod_jk</th>
</tr>
</thead>
<tbody>
<tr>
<td>mod_proxy (also known as reverse proxy)</td>
<td>• recommended connection method</td>
<td>• application paths must be consistent to avoid complex and slow URL rewriting</td>
</tr>
<tr>
<td></td>
<td>• simple HTTP proxy to application server</td>
<td>• works with all application servers</td>
</tr>
<tr>
<td></td>
<td>• works with all application servers</td>
<td>• if application paths are consistent, there is minimal load on the web server</td>
</tr>
<tr>
<td></td>
<td>• if application paths are consistent, there is minimal load on the web server</td>
<td></td>
</tr>
<tr>
<td>mod_jk (also known as AJP)</td>
<td>• uses the AJP binary protocol</td>
<td>• only works with some application servers (typically Tomcat)</td>
</tr>
<tr>
<td></td>
<td>• provides failover (and load balancing, which Confluence supports only with a clustered license)</td>
<td>• if application paths are consistent, there is some load on the web server to translate requests to AJP</td>
</tr>
</tbody>
</table>

---

**Configuration Guides**

Please choose one configuration. Trying to configure for both mod_proxy and mod_jk will only lead to confusion and tears.

- Using Apache with mod_proxy
- Using Apache with mod_jk
- Using Apache with virtual hosts and mod_proxy

**Mod_jk2 not supported**

The misleadingly-named mod_jk2 is an older method of connecting to Tomcat from Apache. Since mod_jk2 is no longer supported by the Apache Foundation, we do not support this configuration, and are not updating our mod_jk2 documentation. Mod_jk2 also has unresolved problems with Unicode URLs; you need to use either mod_proxy or mod_jk for international characters to work correctly in Confluence.

**Caching static content via mod_disk_cache**

To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content. See Configuring Apache to Cache Static Content via mod_disk_cache.

---

Other related documentation
• Configuring Tomcat's URI encoding
• Running Confluence Over SSL or HTTPS

General Apache Configuration Notes

On this page:
• Prefer Apache mod_deflate to Confluence's built-in gzip implementation
• Ensure keepalive is enabled
• Enable keepalive for recent MSIE user agents

Prefer Apache mod_deflate to Confluence's built-in gzip implementation

1. Disable gzip in Confluence. See Compressing an HTTP Response within Confluence.
2. Enable gzip compression in Apache. For RedHat distributions this can be achieved by adding the following lines:

   AddOutputFilterByType DEFLATE text/html text/plain text/xml text/css application/x-javascript
   
   # ensure sensible defaults
   DeflateBufferSize 8192
   DeflateCompressionLevel 4
   DeflateMemLevel 9
   DeflateWindowSize 15

Ensure keepalive is enabled

   KeepAlive On

Enable keepalive for recent MSIE user agents

The standard Apache SSL configuration is very conservative when it comes to MSIE and SSL. By default all keepalives are disabled when using HTTPS with MSIE. While MSIE will always be special, the issues with SSL and MSIE have been solved since Service Pack 2 for Windows XP, released over 4 years ago. For anyone using an XP machine SP2 or above, it is safe to allow keepalive for MSIE 6 and above.

Remove the following lines:

   SetEnvIf User-Agent ".*MSIE.*" \  
   nokeepalive ssl-unclean-shutdown \  
   downgrade-1.0 force-response-1.0

Add these in their place:

   BrowserMatch "MSIE [1-5]*" nokeepalive ssl-unclean-shutdown downgrade-1.0 force-response-1.0
   BrowserMatch "MSIE [6-9]*" ssl-unclean-shutdown

RELATED TOPICS

Running Confluence behind Apache
Configuring Tomcat's URI encoding
Running Confluence Over SSL or HTTPS
Using Apache with mod_proxy

This page describes how to integrate Confluence into an Apache website using mod_proxy.
There are some common situations where you might use the configuration:

- You have an existing Apache-based website, and want to add Confluence to the mix (for example, http://www.example.com/confluence).
- You have two or more Java applications, each running in their own application server on different ports, for example, http://example:8090/confluence and http://example:8080/jira. By setting up Apache with mod_proxy, you can have both available on the regular HTTP port (80) – for example, at http://www.example.com/confluence and http://www.example.com/jira. This allows each application to be restarted, managed and debugged separately.

**Note:** This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

**Base configuration**

In these examples, we use the following:

- **http://www.example.com/confluence** - your intended URL
- **http://example:8090** - the hostname and port Confluence is currently installed to
- **/confluence** - the intended context path (the part after hostname and port)

Please substitute the examples below with your intended URL’s in your own server. Copy/pasting these suggestions will not work on your server.

**Set the context path**

Set your Confluence application path (the part after hostname and port). To do this in Tomcat (bundled with Confluence), edit conf/server.xml, locate the "Context" definition:

```
<Context path="" docBase="../confluence" debug="0" reloadable="true">
```

and change it to:

```
<Context path="/confluence" docBase="../confluence" debug="0" reloadable="true">
```

Then restart Confluence, and ensure you can access it at http://example:8090/confluence

**Set the URL for redirection**

Set the URL for redirection. In the same conf/server.xml file, locate this code segment:

```
<Connector port="8090" maxHttpHeaderSize="8192"
    maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
    enableLookups="false" redirectPort="8443" acceptCount="100"
    connectionTimeout="20000" disableUploadTimeout="true" />
```

And append the last line:

```
<Connector port="8090" maxHttpHeaderSize="8192"
    maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
    enableLookups="false" redirectPort="8443" acceptCount="100"
    connectionTimeout="20000" disableUploadTimeout="true"
    proxyName="www.example.com" proxyPort="80" />
```
If this isn't working for you and you're using SSL, try adding a scheme attribute to your Connector tag: `scheme= "https"`.

Now we have two options:

- If you want a URL like `http://www.example.com/confluence`, follow the simple configuration.
- If you want a URL like `http://confluence.example.com`, go to the complex configuration.

**Simple Configuration**

Configure `mod_proxy`

Now enable `mod_proxy` in Apache, and proxy requests to the application server by adding the example below to your Apache `httpd.conf` (note: the files may be different on your system; the JIRA docs describe the process for Ubuntu/Debian layout):

```conf
# Put this after the other LoadModule directives
LoadModule proxy_module /usr/lib/apache2/modules/mod_proxy.so
LoadModule proxy_http_module /usr/lib/apache2/modules/mod_proxy_http.so

# Put this in the main section of your configuration (or desired virtual host, if using Apache virtual hosts)
ProxyRequests Off
ProxyPreserveHost On

<Proxy *>
    Order deny,allow
    Allow from all
</Proxy>

ProxyPass /confluence http://app-server.internal.example.com:8090/confluence
ProxyPassReverse /confluence http://app-server.internal.example.com:8090/confluence

<Location /confluence>
    Order allow,deny
    Allow from all
</Location>
```

**Note to Windows Users**

It is recommended that you specify the absolute path to the `mod_proxy.so` and `mod_proxy_http.so` files.

**Complex configuration**

Complex configuration involves using the `mod_proxy_html` filter to modify the proxied content en-route. This is required if the Confluence path differs between Apache and the application server. For example:

<table>
<thead>
<tr>
<th>Externally accessible (Apache) URL</th>
<th><a href="http://confluence.example.com/">http://confluence.example.com/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Application server URL</td>
<td><a href="http://app-server.internal.example.com:8090/confluence/">http://app-server.internal.example.com:8090/confluence/</a></td>
</tr>
</tbody>
</table>

Notice that the application path in the URL is different in each. On Apache, the path is `/`, and on the application server the path is `/confluence`.

For this configuration, you need to install the `mod_proxy_html` module, which is not included in the standard Apache distribution.

Alternative solutions are discussed below.
# Put this after the other LoadModule directives
LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_http_module modules/mod_proxy_http.so
LoadModule proxy_html_module modules/mod_proxy_html.so

<VirtualHost *>
    ServerName confluence.example.com

    # Put this in the main section of your configuration (or desired virtual host, if using Apache virtual hosts)
    ProxyRequests Off
    ProxyPreserveHost On

    <Proxy>*</Proxy>
    Order deny,allow
    Allow from all
</Proxy>

    ProxyPass / http://app-server.internal.example.com:8090/confluence
    ProxyPassReverse / http://app-server.internal.example.com:8090/confluence

    ProxyHTMLURLMap / /confluence/

    <Location />
    Order allow,deny
    Allow from all
</Location>
</VirtualHost>

The ProxyHTMLURLMap configuration can become more complex if you have multiple applications running under this configuration. The mapping should also be placed in a Location block if the web server URL is a subdirectory and not on a virtual host. The Apache Week tutorial has more information how to do this.

Final Configuration Steps

**Restart your Apache server**

This is needed to pick up on the new configuration. This can be done by running the following on your command line/terminal/shell:

```
sudo apachectl graceful
```

**Disable HTTP Compression**

Having compression run on both the proxy and Tomcat can cause problems integrating with other Atlassian applications, such as JIRA. Please disable HTTP compression as per our Compressing an HTTP Response within Confluence docs.

**Set the Confluence Base URL**

The last stage is to set the Base URL to the address you're using within the proxy. In this example, it would be http://www.example.com/confluence

**Adding SSL**

If you're running Apache in front of Tomcat, it's a good idea to terminate your SSL configuration at Apache, then forward the requests to Tomcat over HTTP. You can set up Apache to terminate the SSL connection and use the ProxyPass and ProxyPassReverse directives to pass the connection through to Tomcat (or the appropriate application server) which is running Confluence.

1. Create a new SSL host by creating a virtual host on 443
2. The standard http connection on apache could be used to redirect to https if you want or it could just be firewalled.

3. Within the VirtualHost definition:
   a. define the SSL options (SSLEngin and SSLCertificateFile)
   b. define the ProxyPass and ProxyPassReverse directives to pass through to Tomcat.

Most of the relevant Apache Config:

```
Listen 443
NameVirtualHost *:443
<VirtualHost *:443>
  SSLEngine On
  SSLCertificateFile /etc/apache2/ssl/apache.pem
  ProxyPass / http://localhost:8090/
  ProxyPassReverse / http://localhost:8090/
</VirtualHost>
```

Apart from the Apache configuration there are a couple of things you will need to do before you get your server working:

1. You will have to change your base URL to point to https addresses. See the documentation on configuring the server base URL.
2. We need to set up the connector to use https. In your installation directory, edit the file server.xml and add this attributes to your connector:

```
proxyName="proxy.example.com" proxyPort="443" scheme="https" secure="true"
```

More information

- The mod_proxy_html site has documentation and examples on the use of this module in the complex configuration.
- Apache Week has a tutorial that deals with a complex situation involving two applications and ProxyHTMLURLMap.
- Using Apache with virtual hosts and mod_proxy shows how to configure the special case where you want JIRA and Confluence running on separate application servers on virtual host subdomains.

Alternatives

If Tomcat is your application server, you have two options:

- use mod_jk to send the requests to Tomcat
- use Tomcat's virtual hosts to make your Confluence application directory the same on the app server and the web server, removing the need for the URL mapping.

If your application server has an AJP connector, you can:

- use mod_jk to send the requests to your application server.

Using Apache with virtual hosts and mod_proxy

Note: This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

Introduction

The Apache web server is often used in front of an application server to improve performance in high-load environments. Mod_proxy simply redirects requests for certain URLs to another web server, so it typically requires no additional configuration on the application server.

This page documents a very common configuration request: configuring JIRA and Confluence on two Apache virtual hosts, running on different application servers. This is just a special case of mod_proxy configuration.
You can use virtual hosts in your application server if you want to run JIRA and Confluence on the same application server.

**Apache configuration**

For this configuration to work properly, the application paths must be the same on both the application servers and the web server. For both JIRA and Confluence below, this is `/`.

<table>
<thead>
<tr>
<th>Component</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA external URL</td>
<td><a href="http://jira.example.com/">http://jira.example.com/</a></td>
</tr>
<tr>
<td>JIRA application server URL</td>
<td><a href="http://jira-app-server.internal.example.com:8080/">http://jira-app-server.internal.example.com:8080/</a></td>
</tr>
<tr>
<td>Confluence external URL</td>
<td><a href="http://confluence.example.com/">http://confluence.example.com/</a></td>
</tr>
<tr>
<td>Confluence application server URL</td>
<td><a href="http://confluence-app-server.internal.example.com:8090/">http://confluence-app-server.internal.example.com:8090/</a></td>
</tr>
</tbody>
</table>

Add the following to your Apache httpd.conf:

```conf
# Put this after the other LoadModule directives
LoadModule proxy_module /usr/lib/apache2/modules/mod_proxy.so
LoadModule proxy_http_module /usr/lib/apache2/modules/mod_proxy_http.so

# Put this with your other VirtualHosts, or at the bottom of the file
NameVirtualHost *
<VirtualHost *>
  ServerName confluence.example.com
  ProxyRequests Off
  <Proxy>*</Proxy>
  Order deny,allow
  Allow from all
</VirtualHost>

ProxyPass / http://confluence-app-server.internal.example.com:8090/
ProxyPassReverse / http://confluence-app-server.internal.example.com:8090/
<Location>
  Order allow,deny
  Allow from all
</Location>
</VirtualHost>

<VirtualHost *
  ServerName jira.example.com
  ProxyRequests Off
  <Proxy>*</Proxy>
  Order deny,allow
  Allow from all
</VirtualHost>

ProxyPass / http://jira-app-server.internal.example.com:8080/
ProxyPassReverse / http://jira-app-server.internal.example.com:8080/
<Location>
  Order allow,deny
  Allow from all
</Location>
</VirtualHost>
```

Points to note:

- ProxyPass and ProxyPassReverse directives send traffic from the web server to your application server.
- The application path is the same on the application server and on the web server (both are `/`).
- Because the above configuration uses name-based virtual hosting, you must configure your DNS server...
to point both names (jira.example.com, confluence.example.com) to your web server.

More information

For different ways to configure mod_proxy, see Using Apache with mod_proxy.

If you use Tomcat, mod_jk provides a different way of connecting Apache via AJP. You can also use the above configuration with just one application server if you use Tomcat's virtual hosts.

Using Apache with mod_jk

- The preferred configuration is Using Apache with mod_proxy. This works with any application server, and together with mod_proxy_html allows complex URL rewriting to deal with different application paths on the web server and the application server.
- This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

Introduction

The Apache web server is often used in front of an application server to improve performance in high-load environments. Mod_jk allows request forwarding to an application via a protocol called AJP. Configuration of this involves enabling mod_jk in Apache, configuring a AJP connector in your application server, and directing Apache to forward certain paths to the application server via mod_jk.

Mod_jk is sometimes preferred to mod_proxy because AJP is a binary protocol, and because some site administrators are more familiar with it than with mod_proxy.

The scope of this documentation is limited to configuring the AJP connector in Tomcat 5.x. Other application servers may support AJP connectors; please consult your application server documentation for instructions on how to configure it.

The configuration below assumes your Confluence instance is accessible on the same path on the application server and the web server. For example:

<table>
<thead>
<tr>
<th>Externally accessible (web server) URL</th>
<th><a href="http://www.example.com/confluence/">http://www.example.com/confluence/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Application server URL (HTTP)</td>
<td><a href="http://app-server.internal.example.com:8090/confluence/">http://app-server.internal.example.com:8090/confluence/</a></td>
</tr>
</tbody>
</table>

The AJP connection of the application server is set to: app-server.internal.example.com:8009.

Configuring mod_jk in Apache

The standard distribution of Apache does not include mod_jk. You need to download it from the JK homepage and put the mod_jk.so file in your Apache modules directory.

Next, add the following in httpd.conf directly or included from another file:

```
# Put this after the other LoadModule directives
LoadModule jk_module modules/mod_jk.so

# Put this in the main section of your configuration (or desired virtual host, if using Apache virtual hosts)
JkWorkersFile conf/workers.properties
JkLogFile logs/mod_jk.log
JkLogLevel info

JkMount /confluence worker1
JkMount /confluence/* worker1
```

Configuring workers.properties

This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.
Create a new file called 'workers.properties', and put it in your Apache conf directory. (The path for workers.properties was one of the configuration settings above.)

```properties
worker.list=worker1
worker.worker1.host=app-server.internal.example.com
worker.worker1.port=8009
worker.worker1.type=ajp13
```

**Tomcat 5.x configuration**

In Tomcat 5, the AJP connector is enabled by default on port 8009. An absolutely minimal Tomcat server.xml is below for comparison. The relevant line is the Connector with port 8009 – make sure this is uncommented in your server.xml.

```xml
<Server port="8000" shutdown="SHUTDOWN">
    <Service name="Catalina">
        <!-- Define a HTTP/1.1 Connector on port 8090 -->
        <Connector port="8090" />
        <!-- Define an AJP 1.3 Connector on port 8009 -->
        <Connector port="8009" protocol="AJP/1.3" />
        <Engine name="Catalina" defaultHost="localhost">
            <Host name="localhost" appBase="webapps">
                <Context path="/confluence" docBase="/opt/webapps/confluence-2.2/confluence"/>
                <Logger className="org.apache.catalina.logger.FileLogger"/>
            </Host>
        </Engine>
    </Service>
</Server>
```

Points to note:

- the Connector on port 8009 has protocol of "AJP/1.3". This is critical.
- the Context path of the Confluence application is "/confluence". This must match the path used to access Confluence on the web server.
- we recommend keeping your application Contexts outside the server.xml in Tomcat 5.x. The above example includes them for demonstration only.

**Improving the performance of the mod_jk connector**

The most important setting in high-load environments is the number of processor threads used by the Tomcat AJP connector. By default, this is 200, but you should increase it to match Apache's maxThreads setting (256 by default):

```xml
<Connector port="8009" minSpareThreads="5" maxThreads="256" protocol="AJP/1.3" />
```

All the configuration parameters for the AJP connector are covered in the Tomcat documentation.

**Ensuring UTF-8 compatibility**

If you have problems downloading attachments with non-ASCII characters in the filename, add the following to your Apache configuration:

```
JkOptions +ForwardURICompatUnparsed
```
And specify UTF-8 as the URIEncoding in the AJP connector configuration:

```xml
<Connector port="8009" protocol="AJP/1.3" URIEncoding="UTF-8" />
```

These settings are discussed further on Configuring Tomcat’s URI encoding.

**More information**

The Tomcat JK website has complete documentation on workers.properties and Apache configuration. You can also find information there on how to use mod_jk with IIS.

**Note:** In IIS proxy server the maximum file upload is 30mb by default. Contact your server administrator if you need to upload a bigger file.

Using mod_rewrite to Modify Confluence URLs

**Note:** This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

Confluence requires URL rewriting for proper functionality, if Confluence is accessible via different domain names. If Confluence is configured for multiple domains without URL rewriting, you will experience an array of problems. See Various Issues Caused when Server Base URL Does Not Match the URL Used to Access Confluence.

An example of why you may want to access Confluence from different domains:

- From an internal network:  
  http://wiki
- The externally visible domain:  
  http://wiki.domain.com

Using URL rewriting to access Confluence over multiple domains

**To configure Confluence over multiple domains:**

1. Add a DNS entry mapping http://wiki to the externally visible IP address of the Confluence server.
3. Add Apache HTTP proxy, using the instructions from Running Confluence behind Apache.
4. Add the mod_rewrite module to change the URL.

**Further information**

You may be interested in the UrlRewriteFilter that is Java web filter that works in a similar way of the Apache’s mod_rewrite.

Configuring Apache to Cache Static Content via mod_disk_cache

To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content.

Static content in Confluence includes most JavaScript, CSS and image files which are included with the application or an installed plugin. This content will be cached by Apache in this configuration. User-provided content like space logos, attachments or embedded images are not considered static content and will not be cached.

**Note:** This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

**Configuring Apache mod_disk_cache**

**To configure Apache to cache static Confluence content:**

1. Add a `mod_disk_cache` stanza to the virtual host configuration:
2. Configure Apache to load mod_disk_cache. For example, in our server configuration this is done in /etc/httpd/conf/httpd.conf:

```conf
LoadModule disk_cache_module modules/mod_disk_cache.so
```

3. Restart Apache after both modifications are complete.

Notes

- Please refer to the Apache documentation for mod_disk_cache.
- If you encounter problems where users are served stale content, you may need to purge the Apache cache directory (/var/cache/mod_proxy in the above configuration) after a Confluence or plugin upgrade. This is a simple 3 step process:
  - Shut down Apache.
  - Clear the cache directory. For example: `sudo rm -r /var/cache/mod_proxy/*`
  - Restart Apache.
- Ensure that you are running the htcacheclean daemon in order to prevent excessive use of disk space. In our situation we ran it like this:

```bash
sudo htcacheclean -d30 -n -t -p /var/cache/mod_proxy -l 512M
```

This will purge content once the cache reaches 512M every 30 minutes. See the Apache documentation for htcacheclean for details of the options.

Starting Confluence Automatically on System Startup

You can configure Confluence to start automatically on system startup, allowing it to recover automatically after a reboot.

Content by label

There is no content with the specified labels

Start Confluence Automatically on Linux

On Linux/Solaris, the best practice is to install, configure and run each service (including Confluence) as a dedicated user with only the permissions they require.

To install, configure and run Confluence automatically on Linux/Solaris:

1. Create a confluence user for instance, using the following command:
Confluence 5.6 Documentation

829

Create a directory to install Confluence into:

```
sudo mkdir /usr/local/confluence
sudo chown confluence: /usr/local/confluence
```

Log in as the confluence user to install Confluence:

```
sudo su - confluence
cd /usr/local/confluence/
tar zxvf /tmp/confluence-3.0.1-std.tar.gz
ln -s confluence-3.0.1-std/ current
```

Edit `<<CONFLUENCE_INSTALL_DIRECTORY>>/confluence/WEB-INF/classes/confluence-init.properties` file, and set `confluence.home=/usr/local/confluence/<Confluence_Data_Home>` (ensure you have removed the comment `#`)

Then back as root, create the file `/etc/init.d/confluence` (code shown below), which will be responsible for starting up Confluence after a reboot (or when manually invoked).

⚠️ If you are running Ubuntu Jaunty (or later) do not perform this step. Please use the instructions further down this page.
#!/bin/sh -e
# Confluence startup script
#chkconfig: 2345 80 05
#description: Confluence

# Define some variables
# Name of app ( JIRA, Confluence, etc )
APP=confluence
# Name of the user to run as
USER=confluence
# Location of application's bin directory
CATALINA_HOME=/usr/local/confluence/current
# Location of Java JDK
export JAVA_HOME=/usr/lib/jvm/java-6-sun

case "$1" in
  start)
    echo "Starting $APP"
    /bin/su -m $USER -c "$CATALINA_HOME/bin/startup.sh &> /dev/null"
    ;;
  stop)
    echo "Stopping $APP"
    /bin/su -m $USER -c "$CATALINA_HOME/bin/shutdown.sh &> /dev/null"
    echo "$APP stopped successfully"
    ;;
  restart)
    $0 stop
    sleep 5
    $0 start
    ;;
  *)
    echo "Usage: /etc/init.d/$APP {start|restart|stop}";
    exit 1
    ;;
esac

exit 0

6. Make this file executable:

    sudo chmod +x /etc/init.d/confluence

7. Set this file to run at the appropriate runlevel. For example, use sudo chkconfig --add confluence on Redhat-based systems, sudo update-rc.d confluence defaults or rcconf on Debian-based systems.

8. You should now be able to start Confluence with the init script. A successful startup output typically looks like this:
$ sudo /etc/init.d/confluence start
Starting Confluence:
If you encounter issues starting up Confluence, please see the
Installation guide at
http://confluence.atlassian.com/display/DOC/Confluence+Installation+Guide
Using CATALINA_BASE: /usr/local/confluence/current
Using CATALINA_HOME: /usr/local/confluence/current
Using CATALINA_TMPDIR: /usr/local/confluence/current/temp
Using JRE_HOME: /usr/lib/jvm/java-1.5.0-sun
done.

You should then see this running at http://<server>:8090/
* The port for this will be whatever is defined in your Confluence server.xml file.

Adding Confluence as a service for Ubuntu Jaunty (or later)
To continue configuring Confluence to start automatically as a service on Ubuntu Jaunty (or later):

1. After logging in as the confluence user to install Confluence, create start and stop scripts in /usr/local/confluence:

   Example start script:

   ```bash
   #!/bin/bash
   export JAVA_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
   export JDK_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
   cd /usr/local/confluence/current/bin
   ./startup.sh
   ```

   Example stop script:

   ```bash
   #!/bin/bash
   export JAVA_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
   export JDK_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
   cd /usr/local/confluence/current/bin
   ./shutdown.sh
   ```

2. Make both of these scripts executable. For example, by issuing the command: sudo chmod a+x /usr/local/confluence/start /usr/local/confluence/stop.

3. Karmic and later: Create two text files in /etc/init/ called confluence-up.conf and confluence-down.conf:

   confluence-up:
start on runlevel [2345]

script
date >> /tmp/confluence-startup.out
exec sudo -u confluence /usr/local/confluence/start >>
/tmp/confluence-startup.out 2>&1

date

confluence-down:

start on runlevel [16]

expect fork
respsawn

exec sudo -u confluence /usr/local/confluence/stop >>
/tmp/confluence-shutdown.out 2>&1

... and make them readable to all users:
sudo chmod a+r /etc/init/confluence-up.conf /etc/init/confluence-down.conf

1. Jaunty, Intrepid: Create two text files in /etc/event.d/ called confluence-up and confluence-down:

confluence-up:

start on runlevel 2
start on runlevel 3
start on runlevel 4
start on runlevel 5

exec sudo -u confluence /usr/local/confluence/start >>
/tmp/confluence-startup.out 2>&1

confluence-down:

start on runlevel 1
start on runlevel 6

exec sudo -u confluence /usr/local/confluence/stop >>
/tmp/confluence-shutdown.out 2>&1

... and make them readable to all users:
sudo chmod a+r /etc/event.d/confluence-up /etc/event.d/confluence-down

RELATED TOPICS
Starting Confluence Automatically on System Startup

Start Confluence Automatically on Windows as a Service

For long-term use, we recommend that you configure Confluence to start automatically when the operating system restarts. For Windows servers, this means configuring Confluence to run as a Windows service.

There are two ways to install the Confluence distribution as a service: using the Confluence installer or manually as described below.

On this page:

- Reasons for Starting Confluence as a Service
- Changing the User Running the Service
- Manually Installing the Confluence Distribution as a Service
- Managing Confluence as a Service
- Upgrading Confluence
- Troubleshooting Confluence while Running as a Windows Service
- Requesting Support

Problem with 64-bit Windows

If you are running 64-bit Windows, please note that you may encounter problems with Apache Tomcat running as a Windows service if you are using a 64-bit JDK. Refer to our knowledge base article for more information.

Reasons for Starting Confluence as a Service

Installation as a Windows service offers these advantages:

- Reduced risk of shutting down Confluence by accident (If you start Confluence manually, a console window opens and there is a risk of someone accidentally shutting down Confluence by closing the window).
- Automated Confluence recovery after server restart.
- Improved troubleshooting through logging server output to file.

You can read more about Windows services in the Microsoft Developer Network.

Changing the User Running the Service

If you wish to run the service as a non-administrator user for security, or if you are using network drives for backups, attachments or indexes, you can run the service as another user. To change users, open the Apache Tomcat Confluence properties, go to the 'Log On' tab and enter the required username and password. Go to your Windows Control Panel -> User Accounts and confirm that the user has write permissions for the `<CONFLUENCE-INSTALL>` and `<CONFLUENCE-HOME>` directories, and all subfolders. Note that any network drives must be specified by UNC and not letter mappings (eg. \backupserver\confluence not z:\confluence).

For more detail, see Creating a Dedicated User Account on the Operating System to Run Confluence.

Manually Installing the Confluence Distribution as a Service

From your Windows-based server:

1. Open a command prompt in the `<CONFLUENCE-INSTALL>/bin` directory.
2. Confirm that the JAVA_HOME variable is set to the JDK base directory with the command:

   ```bash
   echo %JAVA_HOME%
   ```

   Note that any directory in the path with spaces (eg. C:\Program Files must be converted to its eight-character equivalent (e.g. C:\Progra~1).
3. If you are installing Confluence on a Windows 2008 server, be sure to run the command prompt using 'run as administrator'. (Otherwise running 'service.bat', as described in the next step, will fail.)
4. Use the following command to install the service with default settings:
Confluence 5.6 Documentation

service.bat install Confluence

NB: This will create a service called **Apache Tomcat Confluence**.
5. Now, to have the service start automatically when the server starts, run:

```bash
tomcat7 //US//Confluence --Startup auto
```

(if you are using a different version of tomcat, specify your tomcat version, e.g. `tomcat6`)
6. If you have a less than a 512 megabytes of memory, skip this step. For users with large Confluence installations, you can increase the maximum memory Confluence can use. (The default is 256MB). For example, you can set the maximum memory to 512 megs using:

```bash
tomcat7 //US//Confluence --JvmMx 512
```

7. If you do not have any JVM parameters that you pass to your distribution of Confluence, you can skip this step. If you do, add them to the service using:

```bash
tomcat7 //US//Confluence ++JvmOptions="-Djust.an.example=True"
```

8. For further configuration options, please refer to the [Tomcat Windows Service How-To guide](#).
9. Go to your Windows Control Panel -> Administrative Tools -> Services -> Apache Tomcat Confluence and right-click on Properties to verify the settings are correct.

Confluence is now installed as a service, but will not automatically start up until the next server reboot
10. Start the Confluence service with the command:

```bash
net start Confluence
```

**Managing Confluence as a Service**

You can manage the Confluence service from the command prompt.

- Stop Confluence with:

```bash
net stop Confluence
```

- Uninstall the Confluence service with:

```bash
service.bat remove Confluence
```

**Upgrading Confluence**

After upgrading Confluence, you can either uninstall and reinstall the Windows service or change the StartPath parameter to your new folder. Refer to the [Tomcat documentation](#) for help.

**Troubleshooting Confluence while Running as a Windows Service**

- Check the Knowledge Base articles:
  - [Getting 'The image file tomcat6.exe is valid, but is for a machine type other than the current machine'](#)
  - [Unable to Install Service on Windows Vista](#)
Unable to Start Confluence Windows Service After Allocating JVM Memory
Confluence Does Not Start Due to Windows Firewall
Unable to Configure Confluence to Run as a Service on Tomcat 5

• If none of the above solves your problem, please refer to the complete list of known issues in our Knowledge Base.

• When investigating memory issues or bugs, it may be useful to view information from Confluence's garbage collection. To turn on the verbose garbage collection, use the command:

```bash
tomcat6 //US//Confluence
++JvmOptions="-Xloggc:<CONFLUENCE-INSTALL>\logs\atlassian-gc.log"
```

• The Confluence 2.9 installer does not work when installed as service, due to a missing semi-colon in service.bat. Please refer to reported issue CONF-12785.

• You can use a Sysinternals tool called Procmon.exe from the The Microsoft Windows Sysinternals Team, to check that the error occurred at the specific time when the Confluence service started. You need to match the time when Tomcat failed, as captured by this tool, against the time in the Windows Event Viewer.

**Note**
We do not recommend that you run this tool for too long as it may disrupt other Atlassian applications. Once you have captured the required information you will need to press Ctrl + E to stop capturing.

**Requesting Support**

If, after following the troubleshooting guide above, you still cannot make Confluence run as a Windows Service or if there is an error when setting the JVM configuration for the service, you can create a support request.

Please provide the following information when creating your support request, because we will need it to assist you:

• Are you running a 32 bit or 64 bit Windows?
• Give us the result of running java -version from Windows command line console.
• A screen shot of your Windows Registry setting for Tomcat.
• If you have modified service.bat, please give us a copy of this file for review.
• What application server are you using? eg. Are you using the Confluence distribution?
• Your atlassian-confluence.log file.

**RELATED TOPICS**
Starting Confluence Automatically on System Startup
How to Fix Out of Memory Errors by Increasing Available Memory

**Configuring Confluence**

This section focuses on settings and configurations within the Confluence application.

For guidelines on external configuration, see Configuring a Confluence Environment.

• Viewing System Information
• Configuring the Server Base URL
• Configuring the Confluence Search and Index
• Configuring Mail
• Configuring Character Encoding
• Other Settings
• Configuring System Properties
• Working with Confluence Logs
• Configuring Confluence Security
Viewing System Information

The System Information screen provides information about Confluence's configuration, and the environment in which Confluence has been deployed.

To view your system information:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose System Information in the left-hand panel.

Notes:

- The handy memory graph helps you keep track of Confluence's memory usage.
- Your system configuration information is helpful to Atlassian Support when diagnosing errors you may face using Confluence. When logging a support request or bug report, please provide as much detail as possible about your installation and environment.

Live Monitoring Using the JMX Interface

With the JMX interface (introduced in Confluence 2.8), you can monitor the status of your Confluence instance in real time. This will provide you with useful data such as the resource usage of your instance and its database latency, allowing you to diagnose problems or performance issues. To read the JMX data, you will need to use a JMX client.

Disable JMX

If you experience any problems during Confluence startup that are related to JMX, it is possible to disable the JMX registration process. Please place jmxContext.xml in your <confluence-install>/confluence/WEB-INF/classes folder to do so.

What is JMX?

JMX (Java Management eXtensions) is a technology for monitoring and managing Java applications. JMX uses objects called MBeans (Managed Beans) to expose data and resources from your application.

1. Enabling JMX Remote with Tomcat

By default, Confluence uses the Apache Tomcat web server. To use JMX, you must enable it on your Tomcat server, by carrying out the steps under the Apache Tomcat documentation, entitled Enabling JMX Remote. With those steps completed, restart your Tomcat server.

For the stand-alone, add the startup parameter -Dcom.sun.management.jmxremote to setenv.sh or setenv.bat. See instructions for the Windows Service - enter it in the same place as PermGen Memory.

2. Selecting your JMX Client

You need to use a JMX client in order to view the JMX output from Confluence. JConsole is a readily available JMX client that is included with the supported Java Developer Kit (version 5 onwards). The full name is the 'Java
Monitoring and Management Console, but we will refer to it as JConsole for the purposes of this document.

3. Adding the JMX Client to your Path

You must add the location of the JConsole binary file to your path environment variable. As JConsole resides in the 'bin' (binaries) folder under your Java directory, the path should resemble something like this:

```
JDK_HOME/bin/
```

In this example, replace ‘JDK_HOME’ with the full system path to your Java directory.

4. Configuring JConsole

To configure JConsole:

1. Run the JConsole application.
2. You will be prompted to create a new connection. Choose remote process and enter the hostname of your Confluence instance and a port of your choosing.

To connect easily, add the startup parameters to setenv.bat or setenv.sh:

```
-Dcom.sun.management.jmxremote
-Dcom.sun.management.jmxremote.port=8086
-Dcom.sun.management.jmxremote.authenticate=false
```

Port 8086 is unlikely to be used. Then, connect remotely using port 8086.

JConsole, or any JMX client, will not see applications which are not owned by the same user. For example under Windows, if an application is started as a service, it is the System User which owns the process, and not the Current User.

3. Click Connect.

Note: Other JMX clients besides JConsole can read JMX information from Confluence.

What can I monitor with JMX?

The JMX interface allows you to see live internal information from your Confluence instance, via the following MBeans:

**IndexingStatistics**

This MBean shows information related to search indexing.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flushing</td>
<td>Shows state of cache (i.e. flushing, or not).</td>
<td>True/False</td>
</tr>
<tr>
<td>LastElapsedMilliseconds</td>
<td>Time taken during last indexing.</td>
<td>Milliseconds</td>
</tr>
<tr>
<td>LastElapsedReindexing</td>
<td>Time taken during last re-indexing.</td>
<td>Milliseconds</td>
</tr>
<tr>
<td>TaskQueueLength</td>
<td>Shows number of tasks in the queue.</td>
<td>Integer</td>
</tr>
</tbody>
</table>

**SystemInformation**

This MBean shows information related to database latency. It also contains most of the information presented on the System Information page.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DatabaseExampleLatency</td>
<td>Shows the latency of an example query performed against the database.</td>
<td>Milliseconds</td>
</tr>
</tbody>
</table>

**RequestMetrics**
This MBean shows information related to system load and error pages served.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>AverageExecutionTimeForLastTenRequests</td>
<td>Average execution time for the last ten requests.</td>
<td>Milliseconds</td>
</tr>
<tr>
<td>CurrentNumberOfRequestsBeingServed</td>
<td>Number of requests being served at this instant.</td>
<td>Integer</td>
</tr>
<tr>
<td>ErrorCount</td>
<td>Number of times the Confluence error page was served.</td>
<td>Integer</td>
</tr>
<tr>
<td>NumberOfRequestsInLastTenSeconds</td>
<td>Obviously, the Number Of Requests In the Last Ten Seconds.</td>
<td>Integer</td>
</tr>
</tbody>
</table>

**MailServer-SMTPServer**

This MBean shows information related to email dispatch attempts and failures. There will be an MBean for every SMTP Mailserver that has been configured in the Confluence instance.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>EmailsAttempted</td>
<td>The number of email messages Confluence has tried to send.</td>
<td>Integer</td>
</tr>
<tr>
<td>EmailsSent</td>
<td>The number of email messages sent successfully.</td>
<td>Integer</td>
</tr>
</tbody>
</table>

**MailTaskQueue**

This MBean shows information related to the email workload.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ErrorQueueSize</td>
<td>Number of errors in the queue.</td>
<td>Integer</td>
</tr>
<tr>
<td>Flushing</td>
<td>Shows state (i.e. flushing, or not)</td>
<td>True/False</td>
</tr>
<tr>
<td>FlushStarted</td>
<td>Time that operation began.</td>
<td>Time</td>
</tr>
<tr>
<td>RetryCount</td>
<td>The number of retries that were performed.</td>
<td>Integer</td>
</tr>
<tr>
<td>TaskSize</td>
<td>Number of email messages queued for dispatch.</td>
<td>Integer</td>
</tr>
</tbody>
</table>

**SchedulingStatistics**

This MBean shows information related to current jobs, scheduled tasks and the time that they were last run.

**High CPU consuming threads**

For Java 1.6, add the Top Threads Plugin to monitor whether CPU is spiking. Download it to a directory and run JConsole like this:

JConsole -pluginpath /path/to/topthreads.jar

This works only with JDK 1.6, but that can be on the remote machine if the server is running a lower version.

Please note, adding live monitoring to a production instance may itself have an impact on performance.

Tracking Customisations Made to your Confluence Installation

The 'Modification' section of the Confluence 'System Information' screen lists the files that have been changed since your Confluence application was installed. You will find this information particularly useful when upgrading Confluence to a new version, because you will need to re-apply all customisations after the upgrade.

The information on this page does not apply to Confluence Cloud.
To see the modifications made to files in your Confluence installation,

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Select 'System Information' in the 'Administration' section of the left-hand panel.
3. Scroll down to the section titled 'Modification'.

Screenshot: Modifications tracker on the Confluence System Information screen

<table>
<thead>
<tr>
<th>Modified</th>
<th>Removed</th>
</tr>
</thead>
<tbody>
<tr>
<td>decorators/main.vmd, pages/page-breadcrumbs.vmd, template/includes/macros.vmd, decorators/mail.vmd, decorators/space.vmd, template/includes/personal-sidebar.vmd</td>
<td>No files removed</td>
</tr>
</tbody>
</table>

Notes

- The modification tracker does not detect changes to class files from the confluence.jar or other JAR files. If you modify classes, the Confluence modification detection does not report the modification. See issue CONF-20993.

RELATED TOPICS

Viewing Site Statistics

Note that the site activity information is disabled by default. See notes below.

If enabled, the global activity screen displays statistics on the activity in your Confluence site. These include:

- How many pages and blog posts have been viewed, added or updated over a given period.
- Which spaces are the most popular (most frequently viewed).
- Which spaces are the most active (most frequently edited).
- Which people are the most active contributors/editors of content.

To view the activity on your site:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose 'Global Activity' in the 'Administration' section of the left-hand panel (only appears if enabled - see below).

Related pages:

- How Do I Get More Statistics from Confluence?
- Cache Statistics
- Viewing Space Activity
- Live Monitoring Using the JMX Interface

The information on this page does not apply to Confluence Cloud.

Screenshot: Global Activity
The top ten most popular and most active pages and/or blog posts will be listed, with a link to each.
Notes

- The Confluence Usage Stats plugin, which provides the 'Global Activity' screen, is known to cause performance problems on large installations. This plugin is disabled by default. A status report on the progress of the performance issues with this plugin is available in this issue: USGTRK-15.
- Your Confluence system administrator can enable the plugin, but please be aware of the possible impact upon your site's performance.
- The plugin is sometimes called 'Confluence Usage Tracking'.
- If your Confluence site is clustered, the global activity information will not be available.

Viewing System Properties

After adding memory, setting a proxy, or changing other Java options, it can be difficult to diagnose whether the system has picked them up. This page tells you how to view the system properties that your Confluence site is using.

You can see the expanded system properties on the 'System Information' screen of the Confluence Administration Console. You do not need to restart Confluence before viewing the information.

To see the system properties recognised by your Confluence installation:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose System Information in the left-hand panel.
3. Scroll down to the section titled System Properties.

![The information on this page does not apply to Confluence Cloud.]

Configuring the Server Base URL

The Server Base URL is the URL via which users access Confluence. The base URL must be set to the same URL by which browsers will be viewing your Confluence site.

Confluence will automatically detect the base URL during setup, but you may need to set it manually if your site's URL changes or if you set up Confluence from a different URL to the one that will be used to access it publicly.

You need to have System Administrator permissions in order to perform this function.

![The information on this page does not apply to Confluence Cloud.]

To configure the Server Base URL:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose General Configuration in the left-hand panel.
3. Enter the new URL in the Server Base URL text box.
4. Choose Save.

Example

If Confluence is installed to run in a non-root context path (that is, it has a context path), then the server base URL should include this context path. For example, if Confluence is running at:

http://www.foobar.com/confluence

then the server base URL should be:

http://www.foobar.com/confluence
• **Using different URLs.** If you configure a different base URL or if visitors use some other URL to access Confluence, it is possible that you may encounter errors while viewing some pages.

• **Changing the context path.** If you change the context path of your base URL, you may also need to edit the web server's `server.xml` file to reflect the new path:
  1. Stop the Confluence server.
  2. Go to your Confluence 'destination directory'. This is the directory where the Confluence installation files are stored. For example, C:\Program Files\Atlassian\Confluence. Let's call this directory `{CONFLUENCE_INSTALLATION}`.
  3. Edit the configuration file at `{CONFLUENCE_INSTALLATION}\conf\server.xml`.
  4. Change the value of the `path` attribute in the `Context` element to reflect the context path. For example, if Confluence is running at `http://www.foobar.com/confluence`, then your `path` attribute should look like this:

    ```xml
    <Context path="/confluence" docBase="../confluence" debug="0" reloadable="false"/>
    ```

  5. Save the file.

• **Proxies.** If you are running behind a proxy, ensure that the proxy name matches the base URL. For example: `proxyName="foobar.com" proxyPort="443" scheme="https"`. This will make sure we are passing the information correctly.

  > This information needs to be added in the `Connector` element at `{CONFLUENCE_INSTALLATION}\conf\server.xml`.

**Related Topics**

### Content by label

There is no content with the specified labels

### Configuring the Confluence Search and Index

Confluence administrators can adjust the behaviour of the Confluence search, and manage the index used by the search.

- Configuring Indexing Language
- Configuring Quick Navigation
- Content Index Administration
- Enabling OpenSearch
- Rebuilding the Ancestor Table
- Setting Up Confluence to Index External Sites
- Setting Up an External Search Tool to Index Confluence

**Related pages:**

- Searching Confluence
- Confluence Administrator's Guide

### Configuring Indexing Language

Changing the indexing language defined in Confluence may improve the accuracy of Confluence search results, if the majority of the content of your site is in some language other than English. Confluence supports content indexing in English (default), German, Russian, Chinese, CJK, Custom Japanese, French, Brazilian, Czech and Greek.
To configure the indexing language:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit.
4. Select the Indexing Language from the dropdown list in the Formatting and International Settings section.
5. Choose Save.

Related pages:
- Choosing a Default Language
- Installing a Language Pack
- Content Index Administration
- Creating a Lowercase Page Title Index
- Rebuild the Content Indices from Scratch
- Confluence Administrator’s Guide

Configuring Quick Navigation

When a user is searching Confluence (see Searching Confluence) the quick navigation aid automatically offers a dropdown list of pages and other items, matched by title to the search query. By default, this feature is enabled, with the maximum number of simultaneous quick navigation requests set to 40. These options can be modified as described below.

The maximum number of simultaneous quick navigation requests defines the maximum number of individuals who can use this feature simultaneously on the same Confluence server. If your Confluence server serves a large number of individuals who use this feature regularly, some of whom are being denied access to it, you may wish to increase this value.

Related pages:
- Searching Confluence
- Confluence Administrator’s Guide

⚠️ The information on this page does not apply to Confluence Cloud.

To configure the quick navigation feature:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Further Configuration in the left-hand panel.
3. Choose Edit.
4. To disable Quick Navigation, deselect the Quick Navigation checkbox.
5. To modify the maximum number of simultaneous quick navigation requests, enter the appropriate number in the field beside Max Simultaneous Requests.
6. Choose Save.

Content Index Administration

The content index, also called the search index, supports Confluence’s search functionality. It is also used for a number of related functions such as building email threads in the mail archive, the space activity feature, and lists of recently-updated content. The Gliffy plugin also uses the index for some of its functionality.

For reasons of efficiency, Confluence does not immediately add content to the index. New and modified Confluence content is first placed in a queue and the queue is processed once every five seconds (by default).

Viewing the content index summary

To see information about your Confluence site's content indexing:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose ‘Content Indexing’ under the heading ‘Administration’ in the left-hand panel.
Rebuilding the search index

The search index is maintained automatically, but you may need to rebuild it manually under circumstances such as these:

- Your searching and mail threading are malfunctioning.
- After an upgrade. If a re-index is required after an upgrade, it will be noted in an upgrade subsection of the relevant Confluence Release Notes.

To rebuild the search index:
1. Choose the **cog icon** ☰, then choose **General Configuration** under Confluence Administration.
2. Choose 'Content Indexing' under the heading 'Administration' in the left-hand panel.
3. Choose the 'Rebuild' button in either the 'Search Index' section.
   (If the indexes has never been built, its button will indicate 'Build' instead of 'Rebuild."

**Screenshot: Content indexing**

---

**The 'Did You Mean' index is no longer relevant**

The 'Did You Mean' feature is no longer available in Confluence. This index is therefore redundant, and will be removed at some time in the future.

**Slow reindexing**

Does the reindexing take a long time to complete? The length of time depends on the following factors:

- Number of pages in your Confluence instance.
- Number, type and size of attachments.
- Amount of memory allocated to Confluence.
- Disk throughput.

It may help to increase the heap memory allocation of Confluence by following the instructions in the JIRA documentation.

If you are running an older version of Confluence and find that the index rebuild is not progressing, you may need to shut down Confluence, and restart it with the following **Java system property** set: `bucket.indexing.threads.fixed=1`. This will cause the re-indexing to happen in a single thread and be much more stable (but slower).

**Viewing the index browser**

Confluence uses a search engine called Lucene. If you need to see more details of the indexed pages in your Confluence site, you can download and run **Luke**. Luke is a development and diagnostic tool that accesses existing Lucene indexes and allows you to display and modify their content in several ways.

Start Luke and use it to open the index directory, located in your **Confluence Home directory**. For example: `c:\confluence\data\confluence-home\index`.

**Note:** Confluence 5.2 (and later) use Lucene 4.3 (or later). If the Luke library has not been updated to support the latest version of Lucene, you can compile Luke yourself, from the fork on Github – please read the warnings.
and notes in the README file of that repository.

More hints and tips

- If you are still experiencing problems after performing the above rebuild, the next step might be to remove the index and rebuild it from scratch.
- The space activity feature uses the index to store data. If you remove the index file, the existing activity data will disappear.
- A tip for the development community: If you have the Confluence source, you can look for references to the SmartListManager to find the screens and lists that rely on the content index.

Enabling OpenSearch

With OpenSearch autodiscovery, you can add Confluence search to your Firefox or IE7 search box (see Searching Confluence from your Browser’s Search Box). By default, OpenSearch autodiscovery is enabled. This feature can be enabled or disabled as described below.

To enable or disable OpenSearch autodiscovery:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Further Configuration in the left-hand panel.
3. Choose Edit.
4. Select the Open Search checkbox to enable this feature (deselect to disable).
5. Choose Save.

Rebuilding the Ancestor Table

In Confluence, the ancestor table defines what pages are ancestors or descendants of other pages (which can be used by search restrictions with the ancestorids restriction). Occasionally, the ancestor table will become out of sync. When this happens, you can rebuild the table to restore everything to normal.

Access this URL:

http://yoursite/admin/permissions/pagepermsadmin.action

After rebuilding the ancestor table, you'll need to flush the "Inherited Content Permissions" cache in Cache Statistics, otherwise the inherited permissions may not be applied immediately to all pages. You may also need to rebuild the content index so that the permissions take effect in search results.

Screenshot: Page level permissions

Page Level Permissions

Rebuild Ancestor Table

Setting Up Confluence to Index External Sites

Confluence cannot easily index external sites due to technical reasons, but there are two alternatives:

1. Embed External Pages Into Confluence
2. Replace Confluence Search

Technical reasons

Confluence indexes pages using a customised Lucene search engine that returns matching pages, mail and
blog posts for which the searcher has view permission. It would require significant source code modifications to enable Confluence to process search results from external pages, as the indexing process has been customised to utilise internal Confluence metadata. Note that users can still index content from new attachment filetypes.

Embedding external pages into Confluence

If you only have a small number of external sites to index, you may prefer to enable the HTML-include Macro and use it embed the external content inside normal Confluence pages.

Replacing the Confluence search

Use your own programmer resources to replace Confluence's internal search with a crawler that indexes both Confluence and external sites. This advanced option is easier than modifying the internal search engine. It requires removing Confluence internal search from all pages and replacing the internal results page with your own crawler front-end.

1. Setup a replacement federated search engine to index the Confluence site, as well as your other sites, and provide the results that way. You would need to host a web crawler, such as these open-source crawlers. Note that you can perform a search in Confluence via the remote API.
2. Replace references to the internal search by modifying the site layout so that it links to your search front-end.
3. Host another site containing the search front-end. You may wish to insert it into a suitable context path in your application server so that it appears to be from a path under Confluence. Tomcat sets Confluence's paths from the Confluence install/confluence/WEBINF/web.xml file.

Setting Up a Replacement Search Engine to Index Confluence

Any web crawler can be configured to index Confluence content, for example the Google Search Appliance or similar. If a login is required to view content that will be indexed, you should create a Confluence user specifically for the search crawler to use. Grant this user view rights to all content you wish to index, but deny that user all delete and administration rights. This ensures that an aggressive crawler will not be able to perform actions that could modify the site.

External applications can also use the search function in the Confluence remote API.

Configuring Mail

- Configuring a Server for Outgoing Mail
- Setting Up a Mail Session for the Confluence Distribution
- Configuring the Recommended Updates Email Notification
- The Mail Queue
- Customising the eMail Templates

Configuring a Server for Outgoing Mail

Configuring your Confluence server to send email messages allows your Confluence users to:
Receive emailed notifications and daily reports of updates.
Send a page via email.

You can personalise email notifications by configuring the 'From' field to include the name and email address of the Confluence user who made the change.

You need System Administrator permissions in order to configure Confluence's email server settings.

To configure Confluence to send outgoing mail:
1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Select Mail Servers under Configuration in the left-hand panel. This will list all currently configured SMTP servers.
3. Click Add New SMTP Server (or edit an existing server).
4. Edit the following fields as required:
   - Name: By default, this is simply 'SMTP Server'.
   - From Address: Enter the email address that will be displayed in the 'from' field for email messages originating from this server. This field is mandatory. You will not be able to complete the Confluence mail server configuration until this field has been specified.
   - From Name: Enter the name that will be displayed in the 'from' field for email messages originating from this server. This is the text which appears before the user's registered email address (in square brackets). This field accepts the following variables, which reference specific details defined in the relevant Confluence user's profile:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>${fullname}</td>
<td>The user's full name.</td>
</tr>
<tr>
<td>${email}</td>
<td>The user's email address.</td>
</tr>
<tr>
<td>${email.hostname}</td>
<td>The domain/host name component of the user’s email address.</td>
</tr>
</tbody>
</table>

The default is '${fullname} (Confluence)'. Hence, if Joe Bloggs made a change to a page he was watching and the Confluence site's 'From Address' was set to confluence-administrator@example-company.com, then the 'From' field in his email notification would be: Joe Bloggs (Confluence) <confluence-administrator@example-company.com>.

- Subject Prefix: Enter some text to appear at the beginning of the subject line.

5. Enter your Hostname, Port, User name and Password details.
   OR
   Specify the JNDI location of a mail session configured in your application server. For more information on how to set up a JNDI mail session, see Setting Up a Mail Session for the Confluence Distribution.

Testing the email settings
A Confluence administrator can test the email server as follows:
1. Set up a mail server as described above.
2. Click Send Test Email to check that the server is working. Check that you get the test email in your
inbox.
3. You can flush the email queue to send the email message immediately. Go to Mail Queue, and click Flush Mail Queue. See The Mail Queue.

A user can test that notifications are working as follows:

1. Go to your user profile (using the Settings link) and edit your email preferences. See Subscribing to Email Notifications of Updates to Confluence Content.
2. Enable Notify On My Actions. (By default, Confluence does not send you notifications for your own changes.)
3. Go to a page you wish to get notifications about.
4. Choose Tools > Watch. See Watching Pages, Spaces and Blogs.
5. Edit the page, make a change, and save the page.
6. Check your email inbox. You may need to wait a while for the email message to arrive.

Setting Up a Mail Session for the Confluence Distribution

The simplest way to set up a mail server through the Confluence Administration console. See Configuring a Server for Outgoing Mail.

If you want to add different options or parameters you can also set up a mail session for the Confluence distribution. In the example below we'll set up Gmail.

To set up a mail session for the Confluence distribution:

1. Stop Confluence.
2. Move (don't copy) mail-x.x.x.jar from <confluence-install>/confluence/WEB-INF/lib to <confluence-install>/lib.
   
   Note: where x.x.x. represents the version numbers on the jar files in your installation. Do not leave a renamed backup of the jar files in /confluence/WEB-INF/lib. Even with a different file name, the files will still be loaded as long as it remains in the directory
3. Add the following to your server.xml file found in <confluence-install>/conf/ (add it just before the </Context> tag):

   ```
   For Confluence 3.5.x
   <Resource name="mail/GmailSMTPServer"
     auth="Container"
     type="javax.mail.Session"
     mail.smtp.host="smtp.gmail.com"
     mail.smtp.port="465"
     mail.smtp.auth="true"
     mail.smtp.user="yourEmailAddress@gmail.com"
     password="yourPassword"
     mail.smtp.starttls.enable="true"
     mail.transport.protocol="smtps"
     mail.smtp.socketFactory.class="javax.net.ssl.SSLSocketFactory"
   />
   ```

4. Restart Confluence.
5. Choose the cog icon, then choose General Configuration under Confluence Administration.
6. Choose Mail Servers.
7. Choose either Edit an existing configuration. or Add a new SMTP mail server.
8. Edit the server settings as necessary, and set the JNDI Location as:

   ```java:comp/env/mail/GmailSMTPServer```

   Note that the JNDI Location is case sensitive and must match the resource name specified in server.xml.
9. Save your changes and send a test email.

Configuring the Recommended Updates Email Notification

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Confluence sends a regular email report to subscribers, containing the top content that is relevant to the person receiving the message, from spaces they have permission to view. This is called the 'Recommended Updates' notification.

If you have Confluence Administrator or System Administrator permissions, you can configure the default settings that determine how often the Recommended Updates notification is sent. When new users are added to Confluence, the default settings will be applied to their user profiles.

Confluence users can choose their personal settings, which will override the defaults. See Subscribing to Email Notifications of Updates to Confluence Content.

Initial settings of the defaults

When you install Confluence, the initial values of the default settings are as follows:

- The default frequency is weekly.
- If your Confluence site has public signup enabled, the Recommended Updates notification is disabled by default. If public signup is not enabled, the notification is enabled by default.

You can change the above settings, specifying a different default value for the site.

Notes:

- The Recommended Updates notification is sent only to people who have a user profile in Confluence. If your Confluence site uses external user management, such as LDAP, then people will receive the report only after they have logged in for the first time. (The first login creates their user profile.)
- The daily email message is sent at 1 p.m. in the user's configured time zone.
- The weekly email message is sent at 1 p.m. on Thursdays in the user's configured time zone.

On this page:

- Initial settings of the defaults
- Configuring the Recommended Updates notification
- Disabling the Recommended Updates notification for the entire site

Related pages:

- Subscribing to Email Notifications of Updates to Confluence Content
- Confluence Administrator's Guide

Configuring the Recommended Updates notification

You can set the the default send option (send / do not send) and the default schedule (daily or weekly).

To configure the Recommended Updates email notification:

1. Choose the cog icon , then choose General Configuration under Confluence Administration.
2. Click Recommended Updates Email in the left-hand panel.

Disabling the Recommended Updates notification for the entire site

You can also turn off the recommended updates notification for the entire site, by disabling the 'Confluence daily summary email' plugin. See Disabling and enabling add-ons.

The Mail Queue

Email messages waiting to be sent are queued in a mail queue and periodically flushed from Confluence once a minute. A Confluence administrator can also manually flush messages from the mail queue.

If there is an error sending messages, the failed email messages are sent to an error queue from which you can either try to resend them or delete them.

To view the mail queue:

1. Choose the cog icon , then choose General Configuration under Confluence Administration.
2. Choose Mail Queue in the left-hand panel. This will display the email messages currently in the queue.
3. Choose **Flush Mail Queue** to send all email messages immediately.
4. Choose **Error Queue** to view failed email messages. You can try to **Resend** the messages, which will flush the mails back to the mail queue, or you can **Delete** them from here.

**Related pages:**
- Configuring a Server for Outgoing Mail
- Setting Up a Mail Session for the Confluence Distribution

⚠️ The information on this page does not apply to Confluence Cloud.

**Configuring Character Encoding**

This page explains the encoding settings that are applicable in Confluence and how they relate to application behaviour.

To avoid problems with character encoding, make sure the encoding used across the different components of your system are the same. In general, **always set all character encodings to UTF-8**:

- Confluence character encoding – described below.
- Database – see [Configuring Database Character Encoding](#).
- Application server – see [Configuring URL Encoding on Tomcat Application Server](#).

**Configuring the Confluence character encoding**

By default, Confluence uses UTF-8 character encoding to deliver its pages.

**Note:** While it is possible to change the character encoding, we recommend that you leave this as it is unless you are certain of what you are doing.

In summary: Changing the Confluence character encoding will change your HTTP request and response encoding and your filesystem encoding as used by exports and Velocity templates.

**To change the Confluence character encoding via the UI:**

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Choose **General Configuration** in the left-hand panel.
3. Choose **Edit**.
4. Enter the new character encoding of your choice in the text box next to **Encoding**.
5. Choose **Save**.

**Note:** At runtime, the character encoding is available in `Settings.defaultEncoding`.

**More details about character encoding**

There are three places where character encoding matters to Confluence:

1. **Database encoding** - usually the most important; it is where almost all user data is stored.
2. **Filesystem encoding** - important for attachment storage (pre-2.2), reading Velocity templates and writing exported files.
3. **HTTP request and response encoding** - important for form parsing, correct rendering by the browser and browser interpretation of encoded URLs.

Problems generally arise when Confluence thinks one of the above encoding is different to what it actually is. For example, Confluence might believe the database is using ISO-8859-1 encoding, when in fact it is UTF-8 encoded.

In certain cases (for example, Microsoft Windows), it might not be possible to use a fully Unicode filesystem (that is, a default Windows installation does not support Unicode filenames properly). If so, keep UTF-8 for the other two and be aware that your operating system might have limitations around international attachments (pre-2.2), backup and restore of international data, etc.
Java character encoding

Java always uses the multibyte UTF-16 character encoding for all String data*. This means that each of the encodings above defines how, at that particular point, characters are converted to and from Java's native UTF-16 format into some other format that the browser, filesystem or database might understand.

So when a request comes in to Confluence, we convert it from the request encoding to UTF-16. Then we store that data into the database, converting from UTF-16 to the database's encoding. Retrieving information from the database and sending it back to the browser is the same process in the opposite direction.

*A char represents single Unicode code point from the Base Multilingual Plane (BMP), encoded as UTF-16. Multiple chars are used as surrogate pairs for characters beyond U+FFFF.

Confluence character encoding

The Confluence character encoding is used in the following parts of the system:

- ConfluenceWebWorkConfiguration sets webwork.i18n.encoding to the this encoding, which WebWork uses in the response Content-Type header.
- AbstractEncodingFilter sets the HTTP request encoding to this encoding. This seems unnecessary, since the Content-Type header from the client should include the encoding used. This affects form submissions and file uploads.
- VelocityUtils reads in Velocity templates using this encoding when reading templates from disk.
- AbstractXmlExporter creates its output using this encoding.
- GeneralUtil uses this encoding when doing URLEncode and URLDecode. Different browsers have different support for character sets in URLs, so it's uncertain how much benefit this provides.

See Configuring Confluence Character Encoding (described above.)

Database encoding

The database encoding is the responsibility of your JDBC drivers. The drivers are responsible for reading and writing from the database in its native encoding and translating this data to and from Java Strings (which are UTF-16). For some drivers, such as MySQL, you must set Unicode encoding explicitly in the JDBC URL. For others, the driver is smart enough to determine the database encoding automatically.

Ideally, your database itself should be in a Unicode encoding (and we recommend doing this for the simplest configuration), but that is not necessary as long as:

- the database encoding supports all the characters you want to store in Confluence
- your JDBC drivers can properly convert from the database encoding to UTF-16 and vice-versa.

See Configuring Database Character Encoding.

Filesystem encoding

The filesystem encoding is mostly ignored by Confluence, except for the cases where the above configuration
setting above plays a part (exports, velocity). When attachments are uploaded, they are written as a stream of bytes directly to the filesystem. It is the same when they are downloaded: the bytes from the file InputStream are written directly to the HTTP response.

In some places in Confluence, we use the default filesystem encoding as determined by the JVM and stored in the file.encoding system property (it can be overridden by setting this property at startup). This encoding is used by the Java InputStreamReader and InputStreamWriter classes by default. This encoding should probably never be used; for consistent results across all filesystem access we should be using the encoding set in the General Configuration.

In certain cases we explicitly hard-code the encoding used to read or write data to the filesystem. Two important examples are:

- importing Mbox mailboxes which are known to be ISO-8859-1
- Confluence Bandana config files are always stored as UTF-8.

Some application servers, Tomcat for example, have an encoding setting that modifies Confluence URLs before they reach the application. This can prevent access to international pages and attachments (really anything with international characters in the URL). See configuring your Application Server URL encoding.

Problems with character encodings

If Confluence has the wrong idea about encoding for one of the above, it manifests itself in different ways:

1. Incorrect database encoding - user data is corrupted between saving and restoring from the database. This often happens after a delay, as we cache data as it is written to the database and only later retrieve the corrupted copy from the database.
2. Incorrect/non-Unicode filesystem encoding - international filenames break attachment download/upload/removal (pre-2.2); exports break with international content or attachments.
3. Incorrect HTTP encoding - incorrect encoding selected by browser, resulting in incorrect rendering of characters. Changing browser encoding causes page to render properly. Broken URLs when linking to pages or attachments with non-ASCII characters.

See Troubleshooting Character Encodings.

Notes

- Mac users please note that MacRoman encoding is compatible with UTF-8. You do not need to change your encoding settings if you are already using MacRoman.
- This is a good article by Joel Spolsky: The Absolute Minimum Every Software Developer Absolutely, Positively Must Know About Unicode and Character Sets (No Excuses!)

Troubleshooting Character Encodings

Often users may have problems with certain characters in a Confluence instance. Symptoms may include:

- Non-ASCII characters appearing as question marks (?)
- Page links with non-ASCII characters not working
- Single characters being displayed as two characters
- Garbled text appearing

In most cases, it is due to a mis-configuration in one of the components that Confluence uses.

Follow these steps to diagnose the problem.

1. Run the encoding test

Confluence includes an encoding test that can reveal problems with your configuration.

To perform the test, access the Encoding Test page via the <confluence base-url>/admin/encodingtest.action page on your Confluence instance. You will be required to copy and paste a line of text and submit a form. The test will take the text and pass it through Confluence, the application server and the database, and return the results.
You should also test pasting some sample text (Japanese for example) if you are experiencing problems with a specific language.

Example:

```
http://confluence.atlassian.com/admin/encodingtest.action
```

or

```
http://<host address>:<port>/admin/encodingtest.action
```

If the text displayed in the encoding test is different to what was entered, then there are problems with your character encoding settings.

A successful test looks like the following:

Screenshot: Successful encoding test

---

**Character Encoding Test Results**

The encoding test has now been run. Below, you can compare the raw text delivered from Confluence against the text returned by your browser in web forms, and the text as it appears after a round-trip through the database. All the test results should appear identical.

**Internationale**

This image is how the sample text below should appear. If it does not, please file a support request at [http://support.atlassian.com](http://support.atlassian.com), including a screenshot of this page, and all of your System Information.

**Test 1: Raw text**

This is the test string generated in Confluence

**Internationale**

**Test 2: Form submission**

This is the test string pasted by you into the web form and submitted back to Confluence

**Internationale**

**Test 3: Database round-trip (select as lower-case)**

This is the string from Test 2 after being stored in the database and then retrieved as lower-case

**internationale**

**Test 4: Database round-trip (select as upper-case)**

This is the string from Test 2 after being stored in the database and then retrieved as upper-case

**INTERNATIONALISATION**

**Expected result (converting Java string to lowercase)**

**Internationale**

**Test 5: International file name support**

Try to write a file to the Confluence home directory with the test string as the file name

* File was written successfully

**Test 6: Detect international file name mangling**

Detect whether the file system is mangling the file name when it is saved

* The file name has been preserved

MySQL 3.x

MySQL 3.x is known to have some problems with the upper- and lower-casing of some characters, and
2. Ensure the same encoding is used across all components

As mentioned in the Configuring Encoding document, the same character encoding should be used across the database, application server and web application (Confluence).

- To change the character encoding used in Confluence, see Configuring Character Encoding.
- To change the character encoding used in the application server, please ensure you set the Application Server URL encoding and view your application server’s documentation on any other settings required to enable your encoding.
- To change the character encoding used in the database, see Configuring Database Character Encoding.

3. Requesting support

If there are still problems with character encoding after following the above steps, create a support request, and our support staff will aid in solving your problem.

Entering in the following details will help us to identify your problem:

- Attach screenshots of the problem
- Attach the results of the encoding test (above)
- Select which application server (and version) you are using
- Select which database (and version) you are using
- Copy the contents of the System Information page into the 'Description' field

"€" Euro character not displaying properly

The € (euro) symbol is a three byte character, with byte values in file (UTF-8) of 0xE2, 0x82, 0xAC.

Sometimes, if the character encoding is not set consistently among all participating entities of the system, Confluence, server and the database, one may experience strange behaviour.

... I write a page with a Euro sign in it (€). All is well, the Euro sign shows up in the wiki markup text-box, and the preview, and the display of the saved page.
One day later, the Euro sign has changed into a question mark upside down!
... What is going on? Why does the Euro sign mysteriously change? How do I prevent it?

Interestingly enough the character encoding test passes with no problems, demonstrating that Confluence and the connected Database both recognise the € symbol.

The information on this page does not apply to Confluence Cloud.

There are two potential reasons for this behaviour:

Database and Confluence is using utf-8 encoding. The connection is not.

When data transferred to it via the connection which does not use utf-8 encoding gets encoded incorrectly. Hence, updating the connection encoding may resolve this problem from now on, yet it probably would not affect already existing data.

Database is not using utf-8. Confluence and your connection are.

If your Database encoding is not set to UTF-8, yet is using some other encoding such as latin1, it could be one of the potential reasons why you lose the "€" characters at some stage. It could be occurring due to caching. When Confluence saves data to the database, it may also keep a local cached copy. If the database encoding is set incorrectly, the Euro character may not be correctly recorded in the database, but Confluence will continue to use its cached copy of that data (which is encoded correctly). The encoding error will only be noticed when the cache expires, and the incorrectly encoded data is fetched from the database.

For instance the latin1 encoding would store and display all 2-byte UTF8 characters correctly except for the euro character which is replaced by '?' before being stored. As Confluence’s encoding was set to UTF-8, the 2-byte UTF-8 characters were stored in latin1 database assuming that they were two latin1 different characters, instead of one utf8 character. Nevertheless, this is not the case for 3-byte utf8 characters, such as the Euro symbol.
Please ensure that you set the character encoding to UTF-8 for all the entities of your system as advised in this guide.

MySQL 3.x Character Encoding Problems

MySQL 3.x is known to have some problems upper- and lower-casing certain (non-ASCII) characters.

**Diagnosing the problem**

1. Follow the instructions for Troubleshooting Character Encodings.
2. If the upper- and lower-cased strings displayed on the Encoding Test are different, then your database is probably affected.

An example (faulty) output of the Encoding Test is shown below:

---

**Solution**

Upgrade to a newer version of MySQL. (4.1 is confirmed to work.)

**Other Settings**

- Configuring a WebDAV client for Confluence
- Configuring HTTP Timeout Settings
- Configuring Number Formats
- Configuring Shortcut Links
- Configuring Time and Date Formats
- Enabling the Remote API
- Enabling Threaded Comments
- Enabling Trackback
- Installing a Language Pack
- Installing Patched Class Files

---

Configuring a WebDAV client for Confluence

WebDAV allows users to access Confluence content via a WebDAV client, such as 'My Network Places' in Microsoft Windows. Provided that the user has permission, they will be able to read and write to spaces, pages and attachments in Confluence. Users will be asked to log in and the standard Confluence content access permissions will apply to the equivalent content available through the WebDAV client.

**Introduction to Confluence's WebDAV Client Integration**

By default, all WebDAV clients have permission to write to Confluence. Write permissions include the ability for a WebDAV client to create, edit, move or delete content associated with spaces, pages and attachments in a Confluence installation.

On the 'WebDAV Configuration' screen in the Confluence Administration Console, you can:
Deny a WebDAV client write permissions to a Confluence installation using a regular expression (regex). Disable or enable strict path checking. Enable or disable access to specific virtual files/folders.

Note:
- The 'WebDav Configuration' page is only be available if the WebDAV plugin has been enabled. Note that this plugin is bundled with Confluence, and can be enabled or disabled by the System Administrator.
- The settings on the 'WebDav Configuration' page do not apply to external attachment storage configuration.

Restricting WebDAV Client Write Access to Confluence

In earlier versions of the WebDAV plugin, separate options for restricting a WebDAV client's write permissions (that is, create/move, edit and delete actions), were available. However, in the current version of this plugin, they have been simplified and combined into a general write permission restriction that covers all of these actions.

WebDAV clients are now denied write permission to your Confluence installation by setting a regex that matches specific content within the WebDAV client's user agent header. Upon setting a regex, it will be added to a list of restricted WebDAV clients. Any WebDAV clients whose user agent header matches a regex in this list will be denied write permission to your Confluence installation.

Example: A PROPFIND method header generated by a Microsoft Web Folder WebDAV client, showing the user agent header field:

```
PROPFIND /plugins/servlet/confluence/default HTTP/1.1
Content-Language: en-us
Accept-Language: en-us
Content-Type: text/xml
Translate: f
Depth: 1
Content-Length: 489
User-Agent: Microsoft Data Access Internet Publishing Provider DAV
Host: 127.0.0.1:8082
Connection: Keep-Alive
```

Note: Unlike earlier versions of the WebDAV plugin which could only restrict write permissions for all WebDAV clients, the current version of this plugin allows you to restrict write permissions to specific WebDAV clients selectively.

To restrict a WebDAV client's write access permissions to your Confluence installation:

1. Choose the cog icon then choose General Configuration under Confluence Administration.
2. Choose 'WebDav Configuration' in the left panel. The 'WebDav Configuration' page is displayed.
3. Enter a regex that matches a specific component of the user agent header sent by the WebDAV client you want to restrict.
4. Click the 'Add new regex' button. The regex is added to the list of restricted WebDAV clients. You can repeat steps 3 and 4 to add a regex for each additional WebDAV client you want to restrict.
5. Click the 'Save' button to save the configuration changes.

To restore one or more restricted WebDAV client's write access permissions to your Confluence installation:

1. Choose the cog icon  , then choose General Configuration under Confluence Administration.
2. Click 'WebDav Configuration' under 'Configuration' in the left panel. The 'WebDAV Configuration' page is displayed.
3. Select the regex(es) from the list that match(es) the user agent header sent by the restricted WebDAV client(s) you want to restore.
4. Click the 'Remove selected regexes' button. The regexes you had selected are removed from the list of restricted WebDAV clients.
5. Click the 'Save' button to save the configuration changes.

Screenshot: WebDAV configuration

Disabling Strict Path Checking

If you observe any idiosyncrasies with your WebDAV client, such as a folder that does exist on your Confluence site but is missing from the client, you can disable the WebDAV plugin's strict path checking option, which may minimise these problems.

To disable the WebDAV plugin's strict path checking option:

1. Choose the cog icon  , then choose General Configuration under Confluence Administration.
2. Click 'WebDav Configuration' under 'Configuration' in the left panel. The 'WebDAV Configuration' page is displayed.
3. Clear the 'Disable strict path check' check box.
   - You can re-enable this option at a later point in time by simply selecting this check box.
4. Click the 'Save' button to save this configuration change.

Virtual Files and Folders
In the unlikely event that you observe any problems with the WebDAV client's performance or stability, you can enable access to automatically generated (that is, virtual) files and folders.

**Note:**

By default, these options are hidden on the 'WebDAV Configuration' page. To make them visible, you must append the parameter ?hiddenOptionsEnabled=true to the end of your URL and reload the page. For example:

```
<Confluence base URL>/admin/plugins/webdav/config.action?hiddenOptionsEnabled=true
```

**Screenshot: The Hidden Virtual Files and Folders Option**

```
Virtual Files and Folders
You can choose to either hide or show generated files or folders.

<table>
<thead>
<tr>
<th>.url</th>
<th>@exports</th>
<th>@versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Save
```

To enable or disable access to virtual files and folders:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Click 'WebDav Configuration' under 'Configuration' in the left panel. The 'WebDAV Configuration' page is displayed.
3. Amend your URL as described in the note above and reload the 'WebDav Configuration' page.
4. Select or clear the check box options in the 'Virtual Files and Folders' section as required.
5. Click the 'Save' button to save the configuration changes.

**Using a WebDAV Client to Work with Pages**

The following sections tell you how to set up a WebDAV client natively for a range of different operating systems. WebDAV clients typically appear as drives in your operating system's file browser application, such as Windows Explorer in Microsoft Windows, or Konqueror in Linux.

**Setting Up a WebDAV Client in Microsoft Windows**

This section covers the two methods for configuring a WebDAV client natively in Microsoft Windows:

- As a network drive
- As a web folder

If possible, use the network drive method as this will enable more comprehensive WebDAV client interaction with Confluence than that provided by a web folder. However, your Confluence instance must meet several environmental constraints if you use this method. If you cannot configure your instance to meet these requirements, then use the web folder method or third-party WebDAV client software.

If you run into any problems with the procedures in this section, please refer to the Troubleshooting WebDAV page.

**Windows Network Drive**

To map a Confluence WebDAV client network drive, your Confluence instance must be configured so that all of the following criteria is met:

- Uses HTTP (not HTTPS)
- Listens on port 80 (not 8080, which is the default port value used by the popular application server Apache Tomcat that runs many Confluence EAR / WAR installations, or 8090, the default for Confluence
distributions)
  - Has no context root
  - There is an issue (WBDV-208) that can prevent Network Drives from being mapped. Please use the Network Folders steps below as a workaround.

The reason for these restrictions results from limitations in Microsoft's Mini-Redirector component. For more information, please refer to Microsoft's server discovery issue.

To map a Confluence WebDAV client network drive in Microsoft Windows:

1. In Windows XP, go to My Computer -> Tools menu -> Map Network Drive.
   In Windows Vista, go to Computer -> Map Network Drive.
   The 'Map Network Drive' dialog box opens.
2. Specify the following input to map the WebDAV client as a network drive:
   - Drive: <Any drive letter> (for example, Z:)
   - Folder: \\<hostname>\webdav (for example, \localhost\webdav)
3. Click 'Finish'.
   When prompted for login credentials, specify your Confluence username and password.

Windows Web Folder

To map a Confluence WebDAV client web folder in Windows XP:

1. Go to My Network Places and choose 'Add a network place'. The 'Add Network Place Wizard' opens.
2. Click 'Next', ensure that 'Choose another network location' is selected and then click 'Next' again.
3. In the 'Internet or network address' field, enter the URL for the Confluence WebDAV location (for example, http://<confluence server url>/confluence/plugins/servlet/confluence/default or http://<confluence server url>/plugins/servlet/confluence/default) and then click 'Next'.
   When prompted for login credentials, specify your Confluence username and password.
4. Provide a meaningful name for your web folder and proceed with the remainder of the wizard.
5. Click 'Finish'.

Screenshot: A Confluence WebDAV Client Web Folder in Windows XP

To map a Confluence WebDAV client web folder in Windows Vista:
This procedure is very similar to the one for Windows XP. However, the following procedure includes the slight interface differences that are specific to Windows Vista.

1. Open the 'Map Network Drive' dialog box (refer to first step of the procedure above for mapping a network drive) and choose 'Connect to a Web site that you can use to store your documents and pictures'.
The 'Add Network Location' wizard opens.
2. Click 'Next', ensure that 'Choose a custom network location' is selected and then click 'Next' again.
3. In the 'Internet or network address' field, enter the URL for the Confluence WebDAV location (for example, http://<confluence server url>/confluence/plugins/servlet/confluence/default or http://<confluence server url>/plugins/servlet/confluence/default) and then click 'Next'.
   When prompted for login credentials, specify your Confluence username and password.
4. Provide a meaningful name for your network location/web folder and proceed with the remainder of the wizard.
5. Click 'Finish'.

Setting up a WebDAV client in Linux or Solaris

There are many tools and mechanisms available for configuring WebDAV clients in these operating systems. Therefore, we have chosen to demonstrate this using the file manager Konqueror, which is part of the Linux K Desktop Environment.

To set up a Confluence WebDAV client in Konqueror:

1. Open Konqueror.
2. In the 'Location' field, enter the URL for the Confluence WebDAV location using the 'protocol' webdavs (for example, webdavs://<confluence server url>/confluence/plugins/servlet/confluence/default or webdavs://<confluence server url>/plugins/servlet/confluence/default) and press Enter.
   If prompted for login credentials, specify your Confluence username and password.
   You should be able to click to load many, but not all files. In practice, you would normally save a modified file locally, then drag it to the Konqueror window to upload it to Confluence.

Known Issues

Please refer to the WebDAV plugin documentation for a description of the known issues and suggested workarounds.

Configuring HTTP Timeout Settings

When macros such as the RSS Macro make HTTP requests to servers which are down, a long timeout value is used. You can set this timeout value through a system parameter to avoid this.

To configure the HTTP Timeout Settings:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Select 'General Configuration' under the 'Configuration' heading in the left-hand panel.
3. Find the 'Connection Timeouts' section in the lower portion of the screen.
4. Click 'Edit' to adjust the settings:
   • Adjust External connections enabled: This setting allows system administrators to disable external connections so macros like the RSS Macro won't be allowed to make connections to an external server. It's provides protection against external servers providing insecure HTML, timing out or causing performance problems. The default setting is 'true'.
   • Connection Timeout (milliseconds): Sets the maximum time for a connection to be established. A value of zero means the timeout is not used. The default setting is ten seconds (10000).
   • Socket Timeout (milliseconds): Sets the default socket timeout (SO_TIMEOUT) in milliseconds, which is the maximum time Confluence will wait for data. A timeout value of zero is interpreted as an infinite timeout. The default setting is ten seconds (10000).

Configuring Number Formats

There are two number format settings in Confluence:

• Long number format. For example: """"""""""
   Decimal number format. For example: """"""""""""""""""""

Confluence uses the guidelines in this Java document from Oracle: Class NumberFormat.

To change the number formats in Confluence:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose **General Configuration** in the left-hand panel.
3. Choose **Edit**.
4. Update the **Long Number Format** and **Decimal Number Format** to suit your requirements.
5. Choose **Save**.

**Configuring Shortcut Links**

Shortcut links provide a quick way of linking to resources that are frequently referenced from Confluence. When you create a shortcut link, you assign a key to an URL so that, when editing, a user can type just the key instead of the complete URL.

**Example: Creating a shortcut to Google**

Most Google searches look like this: `http://www.google.com/search?q= `. If you create a shortcut for this search with the key 'google', every time a user needs to use `http://www.google.com/search?q=`, they can just type `{searchterms@google}` instead.

Here is a screenshot showing the shortcuts currently defined on http://confluence.atlassian.com:

<table>
<thead>
<tr>
<th>Key</th>
<th>Expanded Value</th>
<th>Default Alias</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>cache</td>
<td><code>http://www.google.com/search?q=cache:</code></td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>imdb</td>
<td><code>http://us.imdb.com/T16?</code></td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>jira</td>
<td><code>http://jira.atlassian.com/secure/QuickSearch.jspa?searchString=</code></td>
<td>JIRA Issue %s</td>
<td>Remove</td>
</tr>
<tr>
<td>googlegroups</td>
<td><code>http://groups.google.com/groups?q=</code></td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>google</td>
<td><code>http://www.google.com/search?q=</code></td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>dictionary</td>
<td><code>http://www.dictionary.org/bin/Dict?Database=*&amp;Form=Dict1&amp;Strategy=*&amp;Query=</code></td>
<td></td>
<td>Remove</td>
</tr>
</tbody>
</table>

Shortcut links are added and maintained by Confluence administrators from the **Administration Console**.

**On this page:**
- Creating shortcut links
- Using shortcut links
- Deleting shortcut links

**Related pages:**
- Working with Links
- Confluence Administrator's Guide

**Creating shortcut links**

To create a shortcut link:

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Choose **Shortcut Links** in the left-hand panel.
3. Enter a **Key** for your shortcut. This is the shortcut name a user will use to reference the URL.
4. Enter the **Expanded Value**. This is the URL for the link. You can use `%s` in the URL to specify where the user's input is inserted. If there is no `%s` in the URL, the user's input will be put at the end.
5. *(Optional. Available in Confluence version 2.3 and later.)* Enter a **Default Alias**. This is the text of the link which will be displayed on the page where the shortcut is used, with the user's text being substituted for `%s`.
6. Choose **Submit**.

**Using shortcut links**

Enter a shortcut link on the **Advanced** tab of the Insert Link dialog. See **Working with Links** for details.

Specify in the link what should be appended to the end of the shortcut URL, followed by an at-sign (@) and the key of the shortcut. Shortcut names are case-insensitive. So, for example, using the keys shown in the above screenshot:

<table>
<thead>
<tr>
<th>To link to...</th>
<th>Type this</th>
<th>Resulting URL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Deleting shortcut links

Shortcut links are listed on the Shortcut Links tab of the Administration Console. Click Remove to delete the shortcut.

Configuring Time and Date Formats

You can localise the formats that Confluence uses to display dates and times within the web interface. The settings use the syntax of Java's SimpleDateFormat class, as described in this document: Java SimpleDateFormat.

There are three time and date format settings:

- **Time format**: Used when displaying only the time of day. For example, when a blog post is published. Example of configuration: `h:mm a`
- **Date time format**: Used when displaying both the date and the time of day. For example, in historical versions of pages. Example of configuration: `MMM dd, yyyy HH:mm`
- **Date format**: Used when displaying only the date. For example, the creation and most recent modification dates of pages. Example of configuration: `MMM dd, yyyy`

To change the time and date formats:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit.
4. Enter the values for Time Format, Date Time Format and Date Format, to suit your requirements.
5. Choose Save.

Related pages:
- Choosing a Default Language
- Installing a Language Pack
- Confluence Administrator's Guide

Enabling the Remote API

Confluence provides XML-RPC and SOAP remote APIs (application programming interfaces). You need to enable the APIs from the Administration Console before you can access Confluence remotely.

You need System Administrator permissions in order to perform this function.

To enable the remote API:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Click Further Configuration in the left-hand panel.
3. Click Edit.
4. Click the check box next to Remote API (XML-RPC & SOAP).
5. Click Save.
Comments on pages or blog posts are displayed in one of two views:

- **Threaded**: Shows the comments in a hierarchy of responses. Each reply to a comment is indented to indicate the relationships between the comments.
- **Flat**: Displays all the comments in one single list and does not indicate the relationships between comments.

By default, comments are displayed in **threaded** mode. A Confluence Administrator (see Global Permissions Overview) can enable or disable the threaded view for the entire Confluence site.

**To enable or disable the threaded view:**

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Select Further Configuration in the left-hand panel.
3. Choose Edit.
4. Select the Threaded Comments checkbox to enable threaded mode. Deselect the check box to disable threaded mode and display all comments in flat mode.
5. Choose Save.

**Enabling Trackback**

When Trackback is enabled, any time you link to an external webpage that supports Trackback Autodiscovery, Confluence will send a trackback ping to that page to inform it that it has been linked to.

Confluence pages also support Trackback Autodiscovery and when Trackback is enabled, can receive trackback pings sent by other sites.

**To enable trackback:**

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Select Further Configuration in the left panel.
3. Choose Edit.
4. Select the Trackback checkbox then Save.

**Installing a Language Pack**

Confluence ships with a number of bundled language packs. These languages appear as options on the 'Language Configuration' screen in the Administration Console when choosing a default language and as 'Language' options for users in their user settings. You can make additional languages available for selection by installing language packs. Please note, you must be a Confluence administrator to install a language pack.

Language packs are plugins. The process of installing a language pack is the same as installing a new plugin.

**To install a language pack using the Universal Plugin Manager:**

*The information on this page does not apply to Confluence Cloud.*
1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Find New Add-ons in the left-hand panel.
3. Find the language pack on the Atlassian Marketplace.
4. Choose Install to install the language pack.

**Installing a Language Pack Manually**

To install a language pack manually, you will need to upload the language pack plugin as described below. The language pack plugin will be enabled by default once you have installed it.

Plugins are distributed as JAR or OBR (OSGi Bundle Repository) files. To install a plugin:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Manage Add-ons.
3. Choose Upload Plugin.
4. Choose Browse to find the plugin file you wish to install from your hard drive and select it, or enter a network location by URL.
5. Choose Upload.
   - The plugin will be uploaded to Confluence and will be automatically installed.
6. Check the list of user-installed plugins to ensure that the add-on is available.
7. Enable the plugin if necessary. (Some plugins will be enabled by default when they are installed. Others will have to be manually enabled from the 'Manage Add-ons' page.)

**Finding more Language Packs**

- You can download official language packs from the Atlassian Marketplace. You can also download language packs developed by the Confluence user community from the Language Pack Translations page.

**Showing User Interface Key Names for Translation**

This feature is useful if you are working on creating translations of the Confluence user interface. After opening the Confluence dashboard, you can add this text to the end of your Confluence URL:

?i18ntranslate=on

Then press Enter.

This will cause each element of the user interface to display its special key name. This makes it easier to find the context for each key within the user interface. You can then search for the key on http://translations.atlassian.com where you can enter an appropriate translation for your custom language pack.

The key names are displayed with a 'lightning bolt' graphic. For example:

| Dashboard/title.dashboard | Invite Users/easyuser.add users.button | Create Space/dashboard.button.add space |

To turn off the translation view, add this code to the end of the Confluence URL:

?i18ntranslate=off

**Installing Patched Class Files**

Atlassian support or the Atlassian bug-fixing team may occasionally provide patches for critical issues that have been resolved but have not yet made it into a release. Those patches will be class files which are attached to the relevant issue in our JIRA bug-tracking system.

⚠️ The information on this page does not apply to Confluence Cloud.
Installation Instructions for the Confluence Distribution

Follow these steps to install a patched class file:

1. Shut down your confluence instance.
2. Copy the supplied class files to `<installation-directory>/confluence/WEB-INF/classes/<subdirectories>`, where:
   - `<installation-directory>` must be replaced with your Confluence Installation directory. (If you need more information, read about the Confluence Installation Directory.)
   - `<subdirectories>` must be replaced by the value specified in the relevant JIRA issue. This value will be different for different issues. In some cases, the subdirectories will not exist and you will need to create them before copying the class files. Some issues will contain the patch in the form of a ZIP file which will contain the desired directory structure.
3. Restart your Confluence instance for the changes to become effective.

Class files in the `/WEB-INF/classes` directory of a web application will be loaded before classes located in JAR files in the `/WEB-INF/lib` directory. Therefore, classes in the first directory will effectively replace classes of the same name and package which would otherwise be loaded from the JAR files.

Reverting the patch

To revert the patch, simply remove the class files from the `<installation-directory>/confluence/WEB-INF/classes/` folder (taking care to only remove those that apply to the patch you wish to revert), then restart the instance.

Once the issue that the patch relates to is resolved, you should upgrade to the version of Confluence that contains the fix, and revert the patch. Patches are often naive and untested and may not solve the problem in the most efficient way. As such, an official fix should be preferred in all cases.

Configuring System Properties

This page describes how to set Java properties and options on startup for Confluence Stand-alone and EAR/WAR versions.

See How to Fix Out of Memory Errors by Increasing Available Memory for specific instructions for OutOfMemory Errors.

On this page:
- Linux
- Windows (starting from .bat file)
- Related pages:
  - Recognised System Properties
  - How to Fix Out of Memory Errors by Increasing Available Memory

### Linux

To configure System Properties in Linux installations:

1. From `<confluence-install>/bin` (Stand-alone) or `<Tomcat-home>/bin` (EAR-WAR installation), open `setenv.sh`.
2. Find the section `CATALINA_OPTS=`
3. Refer to the list of parameters below.

Add all parameters in a space-separated list, inside the quotations.

### Windows (starting from .bat file)

To Configure System Properties in Windows Installations When Starting from the .bat File:

1. From `<confluence-install>/bin` (Stand-alone) or `<Tomcat-home>/bin` (EAR-WAR installation), open `setenv.bat`.
2. Find the section `set CATALINA_OPTS=%CATALINA_OPTS%`
3. Refer to the list of parameters below.
Add all parameters in a space-separated list. Make sure to keep the string `%CATALINA_OPTS%` in place.

Windows Service

There are two ways to configure system properties when you Start Confluence Automatically on Windows as a Service, either via command line or in the Windows Registry

**Setting Properties for Windows Services via Command Line**

To set properties for Windows Services via a command line:

1. Identify the name of the service that Confluence is installed as in Windows (Go to Control Panel > Administrative Tools > Services):

   ![Service Configuration](image)

   i In the above example, the service name is *Confluence12123135538*.

2. Open the command window (Choose Start > cmd.exe)
3. cd to the bin directory of your Confluence instance (or the bin directory of your Tomcat installation if you are running Confluence EAR/WAR).
4. Run the following command:

   ```
   tomcat7w //ES//<SERVICENAME>
   ```

   i In the above example, it would be *tomcat7w //ES//Confluence12123135538*

   The Tomcat version number may be different if you are using an earlier version of Confluence.

5. Click on the Java tab to see the list of current start-up options:

   ![Java Options](image)

   6. Append any new option on its own new line by adding to the end of the existing Java Options. Refer to the list of parameters below.

**Setting Properties for Windows Services via the Windows Registry**
In some versions of Windows, there is no option to add Java variables to the service. In these cases, you must add the properties by viewing the option list in the registry.

1. Go to the Registry Editor (Start > regedit.exe).
2. Find the Services entry:
   - **32-bit**: HKEY_LOCAL_MACHINE >> SOFTWARE >> Apache Software Foundation >> Procrun 2.0 >> Confluence
   - **64-bit**: HKEY_LOCAL_MACHINE >> SOFTWARE >> Wow6432Node >> Apache Software Foundation >> Procrun 2.0 >> Confluence service name

3. To change existing properties double-click the appropriate value.
4. To change additional properties, double-click options.
5. Refer to the list of parameters below. Enter each on a separate line.

### Verifying Your Settings

To see what Confluence is using, check Viewing System Properties.

### Recognised System Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Since</th>
<th>Default Value</th>
<th>Module...</th>
</tr>
</thead>
<tbody>
<tr>
<td>atlassian.forceSchemaUpdate</td>
<td>1.0</td>
<td>false</td>
<td>atlassian-config</td>
</tr>
<tr>
<td>confluence.home</td>
<td>1.0</td>
<td>Any filesystem path</td>
<td>Confluence and atlassian-config</td>
</tr>
<tr>
<td>confluence.dev.mode</td>
<td>1.0</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.disable.mailpolling</td>
<td>2.4</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>Configuration</td>
<td>Value</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>-------</td>
<td>--------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>confluence.i18n.reloadbundles</td>
<td>1.0</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>confluence.ignore.debug.logging</td>
<td>1.0</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>confluence.jmx.disabled</td>
<td>3.0</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>confluence.optimize.index.modulo</td>
<td>2.2</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>confluence.plugins.bundled.disable</td>
<td>2.9</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>atlassian.mail.fetchdisabled</td>
<td>3.5</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>atlassian.mail.senddisabled</td>
<td>3.5</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>atlassian.disable.caches</td>
<td>2.4</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>confluence.html.encode.automatic</td>
<td>2.9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>org.osgi.framework.bootdelegation</td>
<td>2.10</td>
<td>empty</td>
<td></td>
</tr>
</tbody>
</table>

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Settings</th>
<th>Confluence</th>
<th>Version</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>confluence.diff.pool.size</td>
<td></td>
<td>3.1</td>
<td>20</td>
</tr>
<tr>
<td>confluence.diff.timeout</td>
<td></td>
<td>3.1</td>
<td>1000</td>
</tr>
<tr>
<td>confluence.html.diff.timeout</td>
<td></td>
<td>4.0</td>
<td>10000</td>
</tr>
<tr>
<td>atlassian.user.experimentalMapping</td>
<td></td>
<td>2.10</td>
<td>false</td>
</tr>
<tr>
<td>confluence.import.use-experimental-importer</td>
<td></td>
<td>3.2</td>
<td>false</td>
</tr>
<tr>
<td>atlassian.webresource.disable.minification</td>
<td></td>
<td>3.3</td>
<td>false</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------</td>
<td>----------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>index.queue.thread.count</td>
<td>3.3</td>
<td>See &quot;Effect&quot;</td>
<td>Confluence</td>
</tr>
<tr>
<td>index.queue.batch.size</td>
<td>3.3</td>
<td>1500</td>
<td>Confluence</td>
</tr>
<tr>
<td>password.confirmation.disabled</td>
<td>3.4</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.browser.language.enabled</td>
<td>3.5</td>
<td>true</td>
<td>Confluence</td>
</tr>
<tr>
<td>upm.pac.disable</td>
<td>1.5</td>
<td>false</td>
<td>Universal Plugin Manager (UPM)</td>
</tr>
<tr>
<td>Setting</td>
<td>Version</td>
<td>Value</td>
<td>Package</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>---------</td>
<td>---------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>confluence.reindex.documents.to.pop</td>
<td>3.5.9</td>
<td>20</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.reindex.attachments.to.pop</td>
<td>3.5.9</td>
<td>10</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.upgrade.active.directory</td>
<td>3.5.11</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.context.batching.disable</td>
<td>4.0</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>com.atlassian.logout.disable.session.invalidation</td>
<td>4.0</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>officeconnector.spreadsheet.xlsxmaxsize</td>
<td>4.0.5</td>
<td>2097152</td>
<td>Office Connector</td>
</tr>
<tr>
<td>com.atlassian.confluence.extra.calendar3.display.events.calendar.maxpercalendar</td>
<td></td>
<td>200</td>
<td>Team Calendars</td>
</tr>
<tr>
<td>com.atlassian.confluence.allow.downgrade</td>
<td>4.3.2, 5.0-OD-10</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Module</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------</td>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td>confluence.mbox.directory</td>
<td>5.4.1</td>
<td></td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.upgrade.recovery.file.enabled</td>
<td>5.5</td>
<td>true</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.junit.report.directory</td>
<td>5.5</td>
<td></td>
<td>Confluence</td>
</tr>
<tr>
<td>officeconnector.textextract.word.docmaxsize</td>
<td>5.5.3</td>
<td>16777216</td>
<td>Confluence</td>
</tr>
<tr>
<td>cluster.login.rememberme.enabled</td>
<td>5.6</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>confluence.cluster.hazelcast.listenPort</td>
<td>5.6</td>
<td>5801</td>
<td></td>
</tr>
</tbody>
</table>

**Recognised System Properties**

Confluence supports some configuration and debugging settings that can be enabled through Java system properties. System properties are usually set by passing the `-D` flag to the Java virtual machine in which
Confluence is running. See the full instructions: [Configuring System Properties](#).

<table>
<thead>
<tr>
<th>Property</th>
<th>Since</th>
<th>Default Value</th>
<th>Module...</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>atlassian.forceSchemaUpdate</code></td>
<td>1.0</td>
<td>false</td>
<td>atlassian-config</td>
</tr>
<tr>
<td><code>confluence.home</code></td>
<td>1.0</td>
<td>Any filesystem path</td>
<td>Confluence and atlassian-config</td>
</tr>
<tr>
<td><code>confluence.dev.mode</code></td>
<td>1.0</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td><code>confluence.disable.mailpolling</code></td>
<td>2.4</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td><code>confluence.i18n.reloadbundles</code></td>
<td>1.0</td>
<td>true</td>
<td>Confluence</td>
</tr>
<tr>
<td><code>confluence.ignore.debug.logging</code></td>
<td>1.0</td>
<td>true</td>
<td>Confluence</td>
</tr>
<tr>
<td><code>confluence.jmx.disabled</code></td>
<td>3.0</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td><code>confluence.optimize.index.modulo</code></td>
<td>2.2</td>
<td>20</td>
<td>Confluence</td>
</tr>
<tr>
<td><code>confluence.plugins.bundled.disable</code></td>
<td>2.9</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td>atlassian.mail.fetchdisabled</td>
<td>3.5</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>atlassian.mail.senddisabled</td>
<td>3.5</td>
<td>false</td>
<td>Confluence and atlassian-mail</td>
</tr>
<tr>
<td>atlassian.disable.caches</td>
<td>2.4</td>
<td>true</td>
<td>atlassian-plugins, atlassian-cache-servlet</td>
</tr>
<tr>
<td>confluence.html.encode.automatic</td>
<td>2.9</td>
<td></td>
<td>Confluence</td>
</tr>
<tr>
<td>org.osgi.framework.bootdelegation</td>
<td>2.10</td>
<td>empty</td>
<td>atlassian-plugins</td>
</tr>
<tr>
<td>confluence.diff.pool.size</td>
<td>3.1</td>
<td>20</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.diff.timeout</td>
<td>3.1</td>
<td>1000</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.html.diff.timeout</td>
<td>4.0</td>
<td>10000</td>
<td>Confluence</td>
</tr>
<tr>
<td>atlassian.user.experimentalMapping</td>
<td>2.10</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.import.use-experimental-importer</td>
<td>3.2</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Release</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------</td>
<td>--------</td>
<td>------------------</td>
</tr>
<tr>
<td>atlassian.webresource.disable.minification</td>
<td>3.3</td>
<td>false</td>
<td>atlassian-plugins</td>
</tr>
<tr>
<td>index.queue.thread.count</td>
<td>3.3</td>
<td>See &quot;Effect&quot;</td>
<td>Confluence</td>
</tr>
<tr>
<td>index.queue.batch.size</td>
<td>3.3</td>
<td>1500</td>
<td>Confluence</td>
</tr>
<tr>
<td>password.confirmation.disabled</td>
<td>3.4</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.browser.language.enabled</td>
<td>3.5</td>
<td>true</td>
<td>Confluence</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Component</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>--------</td>
<td>-------------------------</td>
</tr>
<tr>
<td><code>upm.pac.disable</code></td>
<td></td>
<td>false</td>
<td>Universal Plugin Manager (UPM)</td>
</tr>
<tr>
<td><code>confluence.reindex.documents.to.pop</code></td>
<td>3.5.9</td>
<td>20</td>
<td>Confluence</td>
</tr>
<tr>
<td><code>confluence.reindex.attachments.to.pop</code></td>
<td>3.5.9</td>
<td>10</td>
<td>Confluence</td>
</tr>
<tr>
<td><code>confluence.upgrade.active.directory</code></td>
<td>3.5.11</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td><code>confluence.context.batching.disable</code></td>
<td>4.0</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td><code>com.atlassian.logout.disable.session.invalidation</code></td>
<td>4.0</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td><code>officeconnector.spreadsheet.xlsxmaxsize</code></td>
<td>4.0.5</td>
<td>2097152</td>
<td>Office Connector</td>
</tr>
<tr>
<td><code>com.atlassian.confluence.extra.calendar3.display.events.calendar.maxpercalendar</code></td>
<td></td>
<td>200</td>
<td>Team Calendars</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Type</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>com.atlassian.confluence.allow.downgrade</td>
<td>4.3.2, 5.0-OD-10</td>
<td>false</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.mbox.directory</td>
<td>5.4.1</td>
<td></td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.upgrade.recovery.file.enabled</td>
<td>5.5</td>
<td>true</td>
<td>Confluence</td>
</tr>
<tr>
<td>confluence.junit.report.directory</td>
<td>5.5</td>
<td></td>
<td>Confluence</td>
</tr>
<tr>
<td>officeconnector.textextract.word.docxmax</td>
<td>5.5.3</td>
<td>16777216</td>
<td>Confluence</td>
</tr>
<tr>
<td>cluster.login.rememberme.enabled</td>
<td>5.6</td>
<td>False</td>
<td></td>
</tr>
</tbody>
</table>
Working with Confluence Logs

Confluence uses Apache's log4j logging service. This allows a developer or administrator to control the logging behavior and the log output file by editing a configuration file, without touching the application binary. There are six known log4j logging levels.

If you request help from Atlassian Support, we will almost always ask for the atlassian-confluence.log from the confluence-home/logs directory. You can access the logs from the Confluence Administration Console, via the support tool. If you cannot access the Confluence Administration Console, check the properties file at <confluence-installation>/confluence/WEB-INF/classes/confluence-init.properties, look for the confluence.home setting in that file, then find the logs in the Confluence home directory.

Finding the Confluence Log Files

This section describes Confluence's default logging behaviour, assuming that you have not changed the destination of the logs. In order to unify logging across different application servers, Confluence uses the atlassian-confluence.log as its primary log, not the application server log.

Both the Confluence and Confluence EAR/WAR distributions follow the same default behaviour:

- When you start Confluence, log entries will be sent to the application server logs until Confluence has completed its initial bootstrap. Any log entries written to the console will be repeated into the log in the Confluence home directory as described below.
- Once the initial startup sequence is complete, all logging will be to <confluence-home>/logs/atlassian-confluence.log. For example: c:/confluence/data/logs/atlassian-confluence.log.

Note that the default location is the Confluence home directory, not the application server's log file. The home directory is specified in <confluence-installation>/confluence/WEB-INF/classes/confluence-init.properties.

Finding the Log Configuration File

Confluence's logging behaviour is defined in the following properties file:

<CONFLUENCE-INSTALL>/confluence/WEB-INF/classes/log4j.properties

This file is a standard log4j configuration file, as described in the Apache log4j documentation.

Changing the Destination of the Log Files

Terminology: In log4j, an output destination is called an 'appender'.
To change the destination of the log files, you need to stop Confluence and then change the settings in the 'Logging Location and Appender' section of the log4j.properties file. The location of this file is described above.

In the standard properties file, you will find entries for two appenders:

- com.atlassian.confluence.logging.ConfluenceHomeLogAppender – This is a custom appender which controls the default logging destination described above. This appender allows the following settings:
  - MaxFileSize
  - MaxBackupIndex

- org.apache.log4j.RollingFileAppender – If you want to log to a different location, uncomment the RollingFileAppender line and change the destination file in the line below it. Comment out the previous lines referring to the ConfluenceHomeLogAppender.

Confluence ships with the full suite of appenders offered by log4j. Read more about appenders in the log4j documentation.

Changing the Logging Levels

See Configuring Logging for instructions on how to change the logging configuration of Confluence.

Using Some Specific Confluence Logging Options

This section contains some pointers to specific log configurations you may need.

Log the Details of SQL Requests made to the Database

You may want to increase Confluence's logging so that it records individual SQL requests sent to the database. This is useful for troubleshooting specific problems.

You can enable detailed SQL logging in two ways:

- At runtime – see instructions above.
- Via the logging properties file – see the detailed instructions.

Log the Details of Users Viewing/Accessing each Confluence Page

You can configure the log to show which users are accessing which pages in Confluence. This can only be done via the logging properties file – see the detailed instructions.

Scanning Log Files for Known Problems

Confluence provides an inbuilt log scanner that will check your Confluence logs for errors and attempt to match them against known issues in our knowledge base and bug tracker. See Troubleshooting Problems and Requesting Technical Support.

Notes

- Finding the thread dumps. Thread dumps are logged to the application server log file.

RELATED TOPICS

- Enabling Detailed SQL Logging
- Enabling user access logging
- Generating a Thread Dump
- Enabling Page Request Profiling
- Troubleshooting Problems and Requesting Technical Support

Configuring Logging

We recommend that you configure Confluence's logging to your own requirements. You can change the log settings in two ways:

- Configure logging in Confluence Administration – Your changes will be in effect only until you next restart
Confluence.

- Edit the properties file – Your changes will take effect next time you start Confluence, and for all subsequent sessions.

Both methods are described below. In some rare circumstances you may also need to configure the `logging.properties` file.

**Terminology:** In log4j, a 'logger' is a named entity. Logger names are case-sensitive and they follow a hierarchical naming standard. For example, the logger named `com.foo` is a parent of the logger named `com.foo.Bar`.

⚠️ The information on this page does not apply to Confluence Cloud.

Configure logging in Confluence Administration

You can change some of Confluence's logging behaviour via the Administration Console while Confluence is running. Any changes made in this way will apply only to the currently-running Confluence lifetime. The changes are not written to the `log4j.properties` file and are therefore discarded when you next stop Confluence.

Not all logging behaviour can be changed via the Administration Console. For logging configuration not mentioned below, you will need to stop Confluence and then edit the logging properties file instead.

The 'Logging and Profiling' screen shows a list of all currently defined loggers. On this screen you can:

- Turn page profiling on or off.
- Turn detailed SQL logging on or off.
- Add a new logger for a class/package name.
- Remove a logger for a class/package name.
- Set the logging level (INFO, WARN, FATAL, ERROR or DEBUG) for each class or package name.
- Reset all logging levels to a predefined profile.

Changing the logging configuration

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Select 'Logging and Profiling' in the 'Administration' section of the left-hand panel. You need to have System Administrator permissions in order to perform this function.
3. The 'Logging and Profiling' screen appears, as shown below. Use the following guidelines to change the logging behaviour while Confluence is running:
   - 'Performance Profiling' — See Page Request Profiling.
   - 'SQL Logging' — Click the 'Enable SQL Logging' button to log the details of SQL requests made to the database. If you need to enable logging of SQL parameter values, you will need to change the setting in the `properties` file. This option is not available via the Administration Console.
   - 'Log4j Logging' — Click one of the profile buttons to reset all your loggers to the predefined profiles:
     - The 'Production' profile is a fairly standard profile, recommended for normal production conditions.
     - The 'Diagnostic' profile gives more information, useful for troubleshooting and debugging. It results in slower performance and fills the log files more quickly.
   - 'Add New Entry' — Type a class or package name into the text box and click the 'Add Entry' button. The new logger will appear in the list of 'Existing Levels' in the lower part of the screen.
   - 'Existing Levels' - These are the loggers currently in action for your Confluence instance.
     - You can change the logging level by selecting a value from the 'New Level' dropdown list. Read the Apache documentation for a definition of each level.
     - Click the 'Remove' link to stop logging for the selected class/package name.
4. Click the 'Save' button to save any changes you have made in the 'Existing Levels' section.

Screenshot: Changing Log Levels and Profiling

---

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Editing the Properties File

To configure the logging levels and other settings on a permanent basis, you need to stop Confluence and then change the settings in the *log4j.properties* file, described above.

The properties file contains a number of entries for different loggers that can be uncommented if you are interested in logging from particular components. Read more in the Apache *log4j* documentation.

See Working with Confluence Logs for some guidelines on specific configuration options you may find useful.

Configuring Levels for *java.util.logging* in *logging.properties*

A few libraries used by Confluence use *java.util.logging* rather than *log4j* or *slf4j*. These libraries include:

- com.sun.jersey
- org.apache.shindig
- net.sf.ehcache

Confluence’s *logging.properties* file is set to redirect *java.util.logging* at specific levels to *log4j* via *slf4j*.

To increase logging levels for these libraries you must first configure the *logging.properties* file in `<CONFLUENCE-INSTALL>/confluence/WEB-INF/classes/`. The logging levels are different from *log4j* and are listed here.

For example, to increase logging for shindig change the following line in the *logging.properties* file:

```
org.apache.shindig.level = INFO
```

to
And then use one of the methods above as well to configure the log4j level.

log4j Logging Levels

- **DEBUG** - designates fine-grained informational events that are most useful to debug an application (what is going on)
- **INFO** - announcements about the normal operation of the system - scheduled jobs running, services starting and stopping, user-triggered processes and actions
- **WARN** - any condition that, while not an error in itself, may indicate that the system is running sub-optimally
- **ERROR** - a condition that indicates something has gone wrong with the system
- **FATAL** - a condition that indicates something has gone wrong so badly that the system can not recover
- **TRACE** - n/a within Confluence

There are two ways to modify the logging levels, as described in Working with Confluence Logs.

1. Modifying the runtime log levels via the **Administration Console**.
2. Manually modifying the `<Confluence-Install>\confluence\WEB-INF\classes\log4j.properties` file.

**Default Log Level**

The standard Confluence log level **WARN** is a way for Confluence to communicate with the server administrator. Logging at WARN level and higher should be reserved for situations that require some kind of attention from the server administrator, and for which corrective action is possible.

**Reference**: log4j manual

**Troubleshooting SQL Exceptions**

If you get an exception similar to those shown below, it is a good idea to increase the logging levels of your Confluence instance. If you request Atlassian support, this additional logging will help us work out the cause of the error.

Increased logging levels will enable us to diagnose errors like these:

```
org.springframework.dao.DataIntegrityViolationException: (HibernateTemplate): data integrity violated by SQL ''; nested exception is java.sql.BatchUpdateException: Duplicate entry '1234' for key 1
at org.springframework.jdbc.support.SQLStateSQLExceptionTranslator.translate(SQLStateSQLExceptionTranslator.java:88)
caused by: java.sql.BatchUpdateException: Duplicate entry '1234' for key 1
```

or

```
org.springframework.dao.DataIntegrityViolationException: (HibernateTemplate): data integrity violated by SQL ''; nested exception is java.sql.BatchUpdateException: Duplicate entry '1234' for key 1
at org.springframework.jdbc.support.SQLStateSQLExceptionTranslator.translate(SQLStateSQLExceptionTranslator.java:88)
caused by: java.sql.BatchUpdateException: Duplicate entry '1234' for key 1
```

The information on this page does not apply to Confluence Cloud.
This document outlines the steps to take to increasing logging on your system.

1. Open `confluence/WEB-INF/classes/log4j.properties` and uncomment the following lines. The double `##` lines are comments, leave them intact.

   ```
   ## log hibernate prepared statements/SQL queries (equivalent to setting 'hibernate.show_sql' to 'true')
   #log4j.logger.net.sf.hibernate.SQL=DEBUG
   ## log hibernate prepared statement parameter values
   #log4j.logger.net.sf.hibernate.type=DEBUG
   ```

   If you can not locate these lines in your `log4j.properties` file, please add them to the end of it.

2. Restart Confluence.
3. Redo the steps that led to the error.
4. Zip up your logs directory and attach it your support ticket.
5. If you are using Oracle and received a constraint error, please ask your database administrator which table and column the constraint (that is, `CONFLUENCE.SYS_C0012345`) refers to and add that information to your support ticket.
6. Open `confluence/WEB-INF/classes/log4j.properties` again and remove the 4 lines you added in step 1. (The additional logging will impact performance and should be disabled once you have completed this procedure.)

RELATED TOPICS

- Enabling Detailed SQL Logging
- Working with Confluence Logs
- Troubleshooting failed XML site backups

**Configuring Confluence Security**

This section gives guidelines on configuring the security of your Confluence site:

- Confluence Security Overview and Advisories
- Confluence Cookies
- Configuring Secure Administrator Sessions
- Using Fail2Ban to limit login attempts
- Securing Confluence with Apache
- Managing External Referrers
- Best Practices for Configuring Confluence Security
- Hiding the People Directory
- Configuring Captcha for Spam Prevention
- Hiding External Links From Search Engines
- Configuring Captcha for Failed Logins
- Configuring XSRF Protection
- User Email Visibility
- Anonymous Access to Remote API
- Running Confluence Over SSL or HTTPS
- Connecting to LDAP or JIRA or Other Services via SSL
- Configuring RSS Feeds
Confluence Security Overview and Advisories

This document is for system administrators who want to evaluate the security of the Confluence web application. The page addresses overall application security and lists the security advisories issued for Confluence. As a public-facing web application, Confluence's application-level security is important. This document answers a number of questions that commonly arise when customers ask us about the security of our product.

Other topics that you may be looking for:

- For information about user management, groups and permissions, please refer to the internal security overview.
- For guidelines on configuring the security of your Confluence site, see the administrator's guide to configuring Confluence security.

Application Security Overview

Password Storage

When Confluence's internal user management is used, passwords are hashed through SHA1 before being stored in the database. There is no mechanism within Confluence to retrieve a user's password – when password recovery is performed, a reset password link is generated and mailed to the user's registered address.

When external user management is enabled, password storage is delegated to the external system.

Buffer Overflows

Confluence is a 100% pure Java application with no native components. As such it is highly resistant to buffer overflow vulnerabilities – possible buffer overruns are limited to those that are bugs in the Java Runtime Environment itself.

SQL Injection

Confluence interacts with the database through the Hibernate Object-Relational mapper. Database queries are generated using standard APIs for parameter replacement rather than string concatenation. As such, Confluence is highly resistant to SQL injection attacks.

Script Injection

Confluence is a self-contained Java application and does not launch external processes. As such, it is highly resistant to script injection attacks.

Cross-Site Scripting

As a content-management system that allows user-generated content to be posted on the web, precautions have been taken within the application to prevent cross-site scripting attacks:

- The wiki markup language in Confluence does not support dangerous HTML markup
- Macros allowing the insertion of raw HTML are disabled by default
- HTML uploaded as a file attachment is served with a content-type requesting the file be downloaded, rather than being displayed inline
- Only system administrators can make HTML-level customisations of the application
When cross-site scripting vulnerabilities are found in the Confluence web application, we endeavour to fix them as quickly as possible.

**Transport Layer Security**

Confluence does not directly support SSL/TLS. Administrators who are concerned about transport-layer security should set up SSL/TLS at the level of the Java web application server, or the HTTP proxy in front of the Confluence application.

For more information on configuring Confluence for SSL, see: Running Confluence Over SSL or HTTPS

**Session Management**

Confluence delegates session management to the Java application server in which it is deployed. We are not aware of any viable session-hijacking attacks against the Tomcat application server shipped with Confluence. If you are deploying Confluence in some other application server, you should ensure that it is not vulnerable to session hijacking.

**Plugin Security**

Administrators install third party plugins **at their own risk**. Plugins run in the same virtual machine as the Confluence server, and have access to the Java runtime environment, and the Confluence server API.

Administrators should always be aware of the source of the plugins they are installing, and whether they trust those plugins.

**Administrator Trust Model**

Confluence is written under the assumption that anyone given **System Administrator privileges** is trusted. System administrators are able, either directly or by installing plugins, to perform any operation that the Confluence application is capable of.

As with any application, you should not run Confluence as the root/Administrator user. If you want Confluence to listen on a privileged network port, you should set up port forwarding or proxying rather than run Confluence with additional privileges. The extra-careful may consider running Confluence inside a **chroot jail**.

**Stack Traces**

To help debug support cases and provide legendary support, Confluence provides stack traces through the web interface when an error occurs. These stack traces include information about what Confluence was doing at the time, and some information about your deployment server.

Only non-personal information is supplied such as operating system and version and Java version. With proper network security, this is not enough information to be considered dangerous. No usernames or passwords are included.

**Finding and Reporting a Security Vulnerability**

Atlassian's approach to reporting security vulnerabilities is detailed in How to Report a Security Issue.

**Publication of Confluence Security Advisories**

Atlassian's approach to releasing security advisories is detailed in Security Advisory Publishing Policy.

**Severity Levels**

Atlassian's approach to ranking security issues is detailed in Severity Levels for Security Issues.

**Our Patch Policy**

Atlassian's approach to releasing patches for security issues is detailed in Security Patch Policy.

**Published Security Advisories**

Confluence Cookies

This page lists cookies stored in Confluence users' browsers which are generated by Confluence itself. This
page does not list cookies that may originate from 3rd-party Confluence plugins.

**Authentication cookies**

Confluence uses Seraph, an open source framework, for HTTP cookie authentication. Confluence uses two types of cookies for user authentication:

- The JSESSIONID cookie is created by the application server and used for session tracking purposes. This cookie contains a random string and the cookie expires at the end of every session or when the browser is closed.
- The 'remember me' cookie, seraph.confluence, is generated by Confluence when the user selects the **Remember me** check box on the login page.

You can read about cookies on the [Wikipedia page about HTTP cookies](https://en.wikipedia.org/wiki/HTTP_cookie).

---

**The 'remember me' cookie**

The 'remember me' cookie, seraph.confluence, is a long-lived HTTP cookie. This cookie can be used to authenticate an unauthenticated session. Confluence generates this cookie when the user selects the **Remember me** check box on the login page.

**Cookie key and contents**

By default, the cookie key is seraph.confluence, which is defined by the login.cookie.key parameter in the `CONFLUENCE-INSTALLATION/confluence/WEB-INF/classes/seraph-config.xml` file.

The cookie contains a unique identifier plus a securely-generated random string (i.e. token). This token is generated by Confluence and is also stored for the user in the Confluence database.

Use of cookie for authentication

When a user requests a web page, if the request is not already authenticated via session-based authentication or otherwise, Confluence will match the 'remember me' cookie (if present) against the token (also if present), which is stored for the user in the Confluence database.
If the token in the cookie matches the token stored in the database and the cookie has not expired, the user is authenticated.

Life of 'remember me' cookies

You can configure the maximum age of the cookie. To do that you will need to modify the `CONFLUENCE-INSTALLATION/confluence/WEB-INF/classes/seraph-config.xml` file and insert the following lines below the other `init-param` elements:

```
<init-param>
  <param-name>autologin.cookie.age</param-name>
  <param-value>2592000</param-value><!-- 30 days in seconds -->
</init-param>
```

Automatic cleanup of 'remember me' tokens

Every cookie issued by Confluence has a corresponding record in the database. A scheduled job runs on the 20th of every month to clean up expired tokens. The name of the trigger is `clearExpiredRememberMeTokensTrigger`.

Note: The only purpose of this job is to prevent the database table from growing too big. For authentication purposes, Confluence will ignore expired tokens even if they still exist in the database.

Is it possible to disable the 'remember me' feature?

Confluence does not offer an option for disabling the 'Remember Me' feature. See the workaround.

Other Confluence cookies

There are several cookies that Confluence uses to store basic 'product presentation' states. Confluence users' authentication details are not stored by these cookies.

<table>
<thead>
<tr>
<th>Cookie Key</th>
<th>Purpose</th>
<th>Cookie Contents</th>
<th>Expiry</th>
</tr>
</thead>
<tbody>
<tr>
<td>doc-sidebar</td>
<td>Remembers the user's preference for the width of the navigation sidebar in the Confluence documentation theme.</td>
<td>The width of the sidebar in pixels. For example, 300px</td>
<td>One year from the date it was set or was last updated.</td>
</tr>
<tr>
<td>confluence.list.pages.cookie</td>
<td>Remembers the user's last chosen tab in the &quot;list pages&quot; section.</td>
<td>The name of the last selected tab. For example, list-content-tree</td>
<td>One year from the date it was set or was last updated.</td>
</tr>
<tr>
<td>confluence.browse.space.cookie</td>
<td>Remembers the user's last chosen tab in the &quot;browse space&quot; section</td>
<td>The name of the last selected tab. For example, space-pages</td>
<td>One year from the date it was set or was last updated.</td>
</tr>
</tbody>
</table>
### Notes

- The *autocomplete* feature in browser text fields (which are typically noticeable when a user logs in to Confluence) is a browser-specific feature, not a Confluence one. Confluence cannot enable or disable this autocompletion, which is typically set through a browser's settings.

### Configuring Secure Administrator Sessions

Confluence protects access to its administrative functions by requiring a secure administration session to use the Confluence administration console or administer a space. When a Confluence administrator (who is logged into Confluence) attempts to access an administration function, they are prompted to log in again. This logs the administrator into a temporary secure session that grants access to the Confluence/space administration console.

The temporary secure session has a rolling timeout (defaulted to 10 minutes). If there is no activity by the administrator in the Confluence/space administration console for a period of time that exceeds the timeout, then the administrator will be logged out of the secure administrator session (note, they will remain logged into Confluence). If the administrator does click an administration function, the timeout will reset.

⚠️ The information on this page does not apply to Confluence Cloud.

#### To configure secure administrator sessions:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Security Configuration in the left-hand panel.
3. Choose Edit.
4. Configure the setting as follows:
   - To disable secure administrator sessions, uncheck the Enable check box next to Secure administrator sessions. When this setting is disabled, administrators will no longer be required to log into a secure session to access the administration console.
   - To change the timeout for secure administrator sessions, update the value next to minutes before invalidation. The default timeout for a secure administration session is 10 minutes.
5. Choose Save.

### Notes

- **Disabling password confirmation.** Confluence installations that use a custom authentication mechanism may run into problems with the Confluence security measure that requires password confirmation. If necessary, you can set the `password.confirmation.disabled` system property to disable the password confirmation functionality. See Recognised System Properties. See issue CONF-20 958 "Confluence features that require password confirmation (websudo, captcha) do not work with custom authentication".
- **WebSudo.** The feature that provides secure administrator sessions is also called 'WebSudo'.

### confluence-language

Remembers the user's language chosen on the login page. This cookie relates to a feature that allows a user to change Confluence's language from (and including) the login page, when the language presented to the user prior to logging in is not appropriate.

- A locale relating to the chosen language. For example, de_DE
- 360 days from the date it was set or was last updated.

### AJS.conglomerate.cookie

Tracks which general tabs were last used or expansion elements were last opened or closed.

- One or more key-value strings which indicate the states of your last general tab views or expansion elements.
- One year from the date it is set or was last updated.
Manually ending a secure session. An administrator can choose to manually end their secure session by clicking the 'drop access' link in the banner displayed at the top of their screen. For example:

Note for developers. Secure administrator sessions can cause exceptions when developing against Confluence or deploying a plugin. Please read this FAQ: How do I develop against Confluence with Secure Administrator Sessions? Note: The Confluence XML-RPC and REST APIs are not affected by secure administration sessions.

Using Fail2Ban to limit login attempts

What is Fail2Ban?

We need a means of defending sites against brute-force login attempts. Fail2Ban is a Python application which trails logfiles, looks for regular expressions and works with Shorewall (or directly with iptables) to apply temporary blacklists against addresses that match a pattern too often. This can be used to limit the rate at which a given machine hits login URLs for Confluence.

Prerequisites

- Requires Python 2.4 or higher to be installed
- Needs a specific file to follow, which means your Apache instance needs to log your Confluence access to a known logfile. You should adjust the configuration below appropriately.

How to set it up

This list is a skeletal version of the instructions

- There's an RPM available for RHEL on the download page, but you can also download the source and set it up manually
- Its configuration files go into /etc/fail2ban
- The generic, default configuration goes into .conf files (fail2ban.conf and jail.conf). Don't change these, as it makes upgrading difficult.
- Overrides to the generic configuration go into .local files corresponding to the .conf files. These only need to contain the specific settings you want overridden, which helps maintainability.
- Filters go into filter.d — this is where you define regexps, each going into its own file
- Actions go into action.d — you probably won't need to add one, but it's handy to know what's available
- "jails" are a configuration unit that specify one regexp to check, and one or more actions to trigger when the threshold is reached, plus the threshold settings (e.g. more than 3 matches in 60 seconds causes that address to be blocked for 600 seconds)
- Jails are defined in jail.conf and jail.local. Don't forget the enabled setting for each one — it can be as bad to have the wrong ones enabled as to have the right ones disabled.

Running Fail2Ban

- Use /etc/init.d/fail2ban {start|stop|status} for the obvious operations
- Use fail2ban-client -d to get it to dump its current configuration to STDOUT. Very useful for troubleshooting.
- Mind the CPU usage; it can soak up resources pretty quickly on a busy site, even with simple regexp
- It can log either to syslog or a file, whichever suits your needs better

Common Configuration

jail.local
The DEFAULT allows a global definition of the options. They can be override in each jail afterwards.

[DEFAULT]

# "ignoreip" can be an IP address, a CIDR mask or a DNS host. Fail2ban will not ban a host which matches an address in this list. Several addresses can be defined using space separator.
# ignoreip = <space-separated list of IPs>

# "bantime" is the number of seconds that a host is banned.
bantime = 600

# A host is banned if it has generated "maxretry" during the last "findtime" seconds.
findtime = 60

# "maxretry" is the number of failures before a host get banned.
maxretry = 3

[ssh-iptables]

enabled = false

[apache-shorewall]

enabled = true
filter = cac-login
action = shorewall
logpath = /var/log/httpd/confluence-access.log
bantime = 600
maxretry = 3
findtime = 60
backend = polling

Configuring for Confluence

The following is an example only, and you should adjust it for your site.

filter.d/confluence-login.conf

[Definition]

failregex = <HOST>.*"GET /login.action

ignoreregex =
Securing Confluence with Apache

The following outlines some basic techniques to secure a Confluence instance using Apache. These instructions are basic to-do lists and should not be considered comprehensive. For more advanced security topics see the “Further Information” section below.

- Using Apache to limit access to the Confluence administration interface
- Using Fail2Ban to limit login attempts

Further Information

Running Confluence behind Apache

The information on this page does not apply to Confluence Cloud.

Using Apache to limit access to the Confluence administration interface

Limiting administration to specific IP addresses

The Confluence administration interface is a critical part of the application; anyone with access to it can potentially compromise not only the Confluence instance but the entire machine. As well as limiting access to users who really need it, and using strong passwords, you should consider limiting access to it to certain machines on the network or internet. If you are using an Apache web server, this can be done with Apache’s Location functionality as follows:

1. Create a file that defines permission settings

This file can be in the Apache configuration directory or in a system-wide directory. For this example we'll call it "sysadmin_ips_only.conf". The file should contain the following:

```
Order Deny,Allow
Deny from All
# Mark the Sysadmin's workstation
Allow from 192.168.12.42
```

2. Add the file to your Virtual Host

In your Apache Virtual Host, add the following lines to restrict the administration actions to the Systems Administrator:

```
<Location /confluence/admin>
    Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/consumers/list>
    Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/view-consumer-info>
    Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/service-providers/list>
    Include sysadmin_ips_only.conf
</Location>
```

This configuration assumes you've installed Confluence under '/confluence'. If you have installed under '/' or elsewhere, adjust the paths accordingly.
<Location /confluence/plugins/servlet/oauth/service-providers/add>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/plugins/servlet/oauth/consumers/add>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/plugins/servlet/oauth/consumers/add-manually>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/plugins/servlet/oauth/update-consumer-info>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/pages/templates/listpagetemplates.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/pages/templates/createpagetemplate.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/spaces/spacepermissions.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/spaces/listpermissionpages.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/spaces/removespace.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/spaces/importmbox.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/spaces/viewmailaccounts.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/spaces/addmailaccount.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/spaces/importpages.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/spaces/flyingpdf/flyingpdf.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/spaces/exportspacehtml.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/spaces/exportspacexml.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/plugins/servlet/embedded-crowd>
  Include sysadmin_ips_only.conf
</Location>
Managing External Referrers

An external referrer is any site that links to your Confluence instance. Each time someone clicks on the external link, your Confluence site can record the click as a referral.

By default, external referrers for a page are listed under 'Hot Referrers' on the 'Info' screen of the page. Confluence shows a maximum of 10 referrers. If there are more than 10, Confluence shows the 10 with the highest number of hits.

Note that you do not need to enable trackback in order to have external referrers enabled.

Screenshot: hot referrers on the page information screen.

To manage your external referrers:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose 'Manage Referrers'.

The following actions will be available:

- Record or ignore all external referrers: By default, Confluence records the number of hits made to a page from the link on the external site. If you turn this option off, Confluence will not record the hits.
- Show or hide all external referrers: By default, Confluence lists the external referrers as 'Hot Referrers' on the 'Info' screen of a page, as shown below. If you turn this option off, external referrers will not be listed on the page.
- Specify which external referrers to exclude: You can decide which referrers you want to exclude from being displayed on your site.

Screenshot: Manage external referrers
Excluding external referrers

An external referrer is any site that links to your Confluence instance. Each time someone clicks on the external link, your Confluence site can record the click as a referral.

You can exclude external referrers to prevent them from being recorded or displayed anywhere on your site. Once you have specified your list of blocked URLs, any incoming links from URLs that match the list will no longer be recorded. Referrer URLs are blocked if they start with any of the URLs in the exclusion list. So http://evilspsamsite.blogspot.com will also match http://evilspsamsite.blogspot.com/nastypage.html

There are two instances where you may want to do this:

1. If you are running a Confluence installation that is open to public:
   In a site that is open to public, one unfortunate problem is that malicious sites can spam the display of a page's incoming links statistics. This is usually done to get the site's URL to appear in the sidebar. By adding these sites to the 'excluded referrers' list, you can prevent them from being listed on your site.

2. If Confluence is installed on a server with multiple domain names or IP addresses:
   Confluence will consider any URL originating from the domain name where Confluence is installed as an internal link. However, if Confluence is installed on a server with multiple domain names or IP addresses, you will need to add the other domain name prefixes to this list to let Confluence know that any links from these domains should not be considered external links.

   You need to be a Confluence administrator and to know the URL of the site to add it to the excluded referrers list.

To add a URL to the excluded referrers list:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose **Manage Referrers**
3. Enter the URL in the **Referrer URL Prefix** field (you must include `http://`)
4. Choose **Add**.

You can add multiple URLs to the list.

Choose **Exclude External Referrers**

Enter the URL in the **Referrer URL Prefix** field (you must include `http://`)

Choose **Add**.

### Excluded Referrer URL Prefixes

<table>
<thead>
<tr>
<th>URL Prefix</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>http://cvispamsite.blogspot.com</code></td>
<td>Purge All</td>
</tr>
<tr>
<td></td>
<td>Delete • Purge</td>
</tr>
</tbody>
</table>

### Hiding external referrers

By default, Confluence lists the external referrers as ‘**Hot Referrers**’ on the page information screen for a page. If you turn this option off, external referrers will not be listed on the page.

**To hide external referrers:**

1. Choose the cog icon ![cog icon](image), then choose **General Configuration** under Confluence Administration.
2. Choose ‘**Manage Referrers**’.
3. Deselect ‘**Show Referrers in Page Info**’.

### Screenshot: Managing external referrers

**External Referrer Settings**

- **Record External Referrers**
  - Allow Confluence to record the external URLs that link to Confluence pages.
  - More about External Referrers
- **Show Referrers in Page Info**
  - Show the top 10 external links pointing to that page on the 'Info' screen.

### Ignoring External Referrers

An external referrer is any site that links to your Confluence instance. Each time someone clicks on the external link, your Confluence site can record the click as a referral. By default, Confluence records the number of hits made to a page from any link on an external site. If you turn this option off, Confluence will not record the hits.

**To ignore external referrers:**

1. Choose the cog icon ![cog icon](image), then choose **General Configuration** under Confluence Administration.
2. Choose ‘**Manage Referrers**’ in the left-hand panel.
3. Deselect 'Record External Referrers'.

Screenshot: Managing external referrers

Best Practices for Configuring Confluence Security

The best way to harden a system is to look at each of the involved systems individually. Contact your company's security officer or department to find out what security policies you should be using. There are many things to consider, such as the configuration of your underlying operating systems, application servers, database servers, network, firewall, routers, etc. It would be impossible to outline all of them here.

This page contains guidelines on good security practices, to the best of our knowledge.

⚠️ The information on this page does not apply to Confluence Cloud.

**Configuring the Web Server**

Please refer to the following guides for system administrators:

- How to configure Apache to lock down the administration interface to those people who really need it: Using Apache to limit access to the Confluence administration interface.
- How to reduce the risk of brute force attacks: Using Fail2Ban to limit login attempts.

**Configuring the Application Server**

See the following system administrator guide for general hints on the application server level:

- Tomcat security best practices

**Configuring the Application**

The way you set up Confluence roles, permissions and processes makes a big difference in the security of your Confluence site.

Below are some more Confluence-specific items to consider. None of these provides 100% security. They are measures to reduce impact and to slow down an intruder in case your system does become compromised.

- Keep the number of Confluence administrators extremely low. For example, 3 system administrator accounts should be the maximum.
- Similarly, restrict the number of users with powerful roles or group memberships. If only one department should have access to particularly sensitive data, then do restrict access to the data to those users. Do not let convenience over-rule security. Do not give all staff access to sensitive data when there is no need.
- The administrators should have separate Confluence accounts for their administrative roles and for their day to day roles. If John Doe is an administrator, he should have a regular user account without administrator access to do his day to day work (such as writing pages in the wiki). This could be a 'john.doe' account. In addition, he should have an entirely separate account (that cannot be guessed by an outsider and that does not even use his proper name) for administrative work. This account could be 'jane smith' – using a username that is so obscure or fake that no outsider could guess it. This way, even if an attacker singles out the actual person John Doe and gets hold of his password, the stolen account...
would most likely be John’s regular user account, and the attacker cannot perform administrative actions with that account.

- Lock down administrative actions as much as you can. If there is no need for your administrators to perform administrative actions from outside the office, then lock down access to those actions to known IP addresses, for example. See Using Apache to limit access to the Confluence administration interface.
- Put documented procedures in place for the case of employees leaving the company.
- Perform security audits regularly. Know who can help in case a security breach occurs. Perform ‘what if’ planning exercises. (‘What is the worst thing that could happen if a privileged user’s password were stolen while he’s on vacation? What can we do to minimise damage?’).
- Make sure the Confluence database user (and all datasource database users) only has the amount of database privileges it really needs.
- Monitor your binaries. If an attacker compromises an account on your system, he will usually try to gain access to more accounts. This is sometimes done by adding malicious code, such as by modifying files on the system. Run routine scripts that regularly verify that no malicious change has been made.

As another precaution:

- Regularly monitor the above requirements. There are many things that could start out well, but deteriorate over time:
  - A system may start out with just 3 administrators, but over the course of a year this could grow to 30 administrators if no one prevents expansion.
  - Apache administration restrictions may be in place at the start of the year, but when the application server is migrated after a few months, people may forget to apply the rules to the new system.

Again, keep in mind that the above steps may only be a fraction of what could apply to you, depending on your security requirements. Also, keep in mind that none of the above rules can guarantee anything. They just make it harder for an intruder to move quickly.

Hiding the People Directory

The People Directory provides a list of all users in your Confluence system.

If you need to disable the People Directory set the following system properties on your application server command line:

- To disable the People Directory for anonymous users:

  ```
  -Dconfluence.disable.peopledirectory.anonymous=true
  ```

- To disable the People Directory entirely:

  ```
  -Dconfluence.disable.peopledirectory.all=true
  ```

⚠️ The information on this page does not apply to Confluence Cloud.

This workaround will prevent the People directory from appearing on the dashboard, but if you navigate to the profile of a user, and then click on the “People” in the breadcrumb link (Dashboard >> People >> FullName >> Profile) or you go to the URL directly `<CONFLUENCE_INSTALL>/browsepeople.action`, you will be able to access the people directory.

To workaround this, set up your Apache webserver in front of Confluence and redirect requests to this URL.

Related Topics

**Content by label**

There is no content with the specified labels
Configuring Captcha for Spam Prevention

If your Confluence site is open to the public (you allow anonymous users to add comments, create pages etc) you may find that automated spam is being added, in the form of comments or new pages.

You can configure Confluence to deter automated spam by asking users to prove that they are human before they are allowed to:

- Sign up for an account.
- Add a comment.
- Create a page.
- Edit a page.
- Send a request to the Confluence administrators.

Captcha is a test that can distinguish a human being from an automated agent such as a web spider or robot. When Captcha is switched on, users will see a distorted picture of a word, and must enter it in a text field before they can proceed.

Screenshot: Example of a Captcha test

By default, Captcha is disabled. When enabled, the default is that only anonymous users will have to perform the Captcha test when creating comments or editing pages. You can also choose to enforce Captcha for all users or members of particular groups.

You need System Administrator permissions to configure Captcha for spam prevention in Confluence.

To enable Captcha for spam prevention in Confluence:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Spam Prevention in the left-hand panel.
3. Choose ON to turn on Captcha.
4. If you want to disable Captcha for certain groups:
   - Select No one if you want everyone to see Captchas.
   - Select Signed in users if you want only anonymous users to see Captchas.
   - If you want everyone to see Captchas except members of specific groups, select Members of the following groups and enter the group names in the text box.
     You can click the magnifying-glass icon to search for groups. Search for all or part of a group name and click the Select Groups button to add one or more groups to the list.
     To remove a group from the list, delete the group name.
5. Choose Save.

Hiding External Links From Search Engines

Hiding external links from search engines helps to discourage spammers from posting links on your site. If you turn this option on, any URLs inserted in pages and comments will be given the 'nofollow' attribute, which prevents search engines from following them.

- Shortcut links (e.g. CONF-2622@JIRA) and internal links to other pages within Confluence are not tagged.
To hide external links from search engines:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Click 'Security Configuration' in the left panel.
3. This will display the 'Security Configuration' screen. Click 'Edit'.
4. Check the 'Hide External Links From Search Engines' checkbox.
5. Click the 'Save' button.

Background to the nofollow attribute
As part of the effort to combat the spamming of wikis and blogs (Confluence being both), Google came up with some markup which instructs search engines not to follow links. By removing the main benefit of wiki-spamming it's hoped that the practice will stop being cost-effective and eventually die out.

Related Topics

Content by label
There is no content with the specified labels

Configuring Captcha for Failed Logins
If you have confluence administrator permissions, you can configure Confluence to impose a maximum number of repeated login attempts. After a given number of failed login attempts (the default is three) Confluence will display a Captcha form asking the user to enter a given word when attempting to log in again. This will prevent brute force attacks on the Confluence login screen.

Similarly, after three failed login attempts via the XML-RPC or SOAP API, an error message will be returned instructing the user to log in via the web interface. Captcha will automatically be activated when they attempt this login.

'Captcha' is the technical term for a test that can distinguish a human being from an automated agent such as a web spider or robot. You can read more about Captcha on Wikipedia.

When Captcha is activated, users will need to recognise a distorted picture of a word, and must type the word into a text field. This is easy for humans to do, but very difficult for computers.

Screenshot: example of a Captcha test
Enabling, Disabling and Configuring Captcha for Failed Logins

By default, Captcha for failed logins is enabled and the number of failed login attempts is set to three.

To enable, disable and configure Captcha for failed logins:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose ‘Security Configuration’ from the left menu.
3. Choose ‘Edit’.
4. To enable Captcha:
   - Select the ‘Enable’ checkbox next to ‘CAPTCHA on login’.
   - Set the maximum number of failed logins next to ‘Maximum Authentication Attempts Allowed’.
     You must enter a number greater than zero.
5. To disable Captcha, deselect the ‘Enable’ checkbox.
6. Choose ‘Save’.

Screenshot: Configuring Captcha for failed logins
Notes

- **Disabling all password confirmation requests, including Captcha on login.** Confluence installations that use a custom authentication mechanism may run into problems with the Confluence security measure that requires password confirmation. If necessary, you can set the `password.confirmation.disabled` system property to disable the password confirmation functionality on administrative actions, change of email address and Captcha for failed logins. See Recognised System Properties.

Configuring XSRF Protection

Confluence requires an XSRF token to be present on comment creation, to prevent users being tricked into unintentionally submitting malicious data. All the themes bundled with Confluence have been designed to use this feature. However, if you are using a custom theme that does not support this security feature, you can disable it.

⚠️ **Please carefully consider the security risks before you disable XSRF protection for comments in your Confluence installation.**

Read more about XSRF (Cross Site Request Forgery) at cgisecurity.com.
To configure XSRF protection for comments:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose Security Configuration in the left-hand panel.
3. Choose Edit.
4. Uncheck the Adding Comments checkbox in the XSRF Protection section, to disable XSRF protection.
5. Choose Save.

Related pages:
- Configuring Confluence Security
- Confluence Administrator's Guide
- Developer documentation on XSRF protection in Confluence

User Email Visibility

Confluence provides three options for email address privacy which can be configured by a Confluence administrator from the Administration Console:

- **Public**: email addresses are displayed publicly.
- **Masked**: email addresses are still displayed publicly, but masked in such a way to make it harder for spam-bots to harvest them.
- **Only visible to site administrators**: only Confluence administrators can see the email addresses. Note that, if you select this option, email addresses will not be available in the ‘User Search’ popup (e.g. when setting Page Restrictions).

To configure user email visibility:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose 'Security Configuration'.
3. Choose 'Edit'. The fields on the 'Security Configuration' screen will be editable.
4. Select one of the options from the 'User email visibility' dropdown: 'public', 'masked', or 'only visible to site administrators'.
5. Choose 'Save'.

Screenshot: Email Visibility

Anonymous Access to Remote API

Administrators may wish to disable anonymous access to the Confluence remote API to make it harder for malicious users to write 'bots' that perform bulk changes to the site.

To disable anonymous access to the remote API:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
3. Choose Edit.
4. Uncheck the Anonymous Access to API check box.
5. Choose Save.
Notes

This page is about access to the remote API. If you are looking for information about preventing anonymous users from accessing Confluence, see [Global Permissions Overview](#).

Running Confluence Over SSL or HTTPS

This page documents configuration of SSL, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with SSL. Please be aware that this material is provided for your information only, and that you use it at your own risk.

This document tells you how to configure Confluence to enable access via HTTPS (HTTP over SSL), so that your Confluence logins and data are encrypted during transport to and from Confluence. SSL encryption is a good way to safeguard your Confluence data and user logins from being intercepted and read by outsiders.

These instructions apply to the following platforms:

- **Confluence or Confluence WAR distribution using Tomcat.** Apache Tomcat is the application server shipped with Confluence, and is the only supported application server. If you are using a different application server or Apache HTTP Server (“httpd”), see the page on [Apache with mod_proxy](#) for instructions on how to terminate an SSL connection at the Apache web server.

- **Java 7.** JDK 1.7 is the supported Java version for Confluence. Note that you need the JDK, since it includes the `keytool` utility used in the instructions below. The JRE is not enough. If you are using JDK 1.6 or older, please refer to the [Java SE documentation](#) to see the differences in the `keytool` utility from your JDK to JDK 1.7.

The default connector port for Confluence is 8090, while a plain Tomcat installation (used for EAR / WAR distribution) will default to 8080.

On this page:

- **Step 1. Create or Request a New SSL Certificate**
- **Step 2. Modify the Server Configuration File in your Confluence Installation**
- **Step 3. Specify the Location of your Certificate**
- **Step 4. Change your Confluence Base URL to HTTPS**
- **Step 5. Add a Security Constraint to Redirect All URLs to HTTPS**
- **Notes**
- **Troubleshooting**

! The information on this page does not apply to Confluence Cloud.

### Step 1. Create or Request a New SSL Certificate

You will need a valid SSL certificate before you can enable HTTPS. If you already have a certificate prepared, skip to step 2 below.

You can choose to create a self-signed certificate or to use a certificate issued by a certificate authority (CA, sometimes also called a 'certification authority'). We described both options below.

**Certificate Option 1 – Create a Self-Signed Certificate**

Self-signed certificates are useful if you require encryption but do not need to verify the identity of the requesting website. In general, you might use a self-signed certificate on a test environment and on internal corporate networks (intranets).

Because the certificate is not signed by a certificate authority (CA), users may receive a message that the site is not trusted and may have to perform several steps to accept the certificate before they can access the site. This
usually will only occur the first time they access the site.

Follow the steps below to generate a certificate using Java's keytool utility. This tool is included in the JDK.

1. Use Java's keytool utility to generate the certificate:

   Many SSL issuers (including but not limited to GoDaddy and RapidSSL) are now requiring a 2048-bit key size. To generate a key with 2048-bit encryption, add `-keysize 2048` to these queries.

   - On Windows, run the following command at the command prompt:
     ```
     "%JAVA_HOME%\bin\keytool" -genkeypair -alias tomcat -keyalg RSA
     ```
   - On OS X or UNIX-based systems, run the following command at the command prompt:
     ```
     $JAVA_HOME/bin/keytool -genkeypair -alias tomcat -keyalg RSA
     ```

2. When asked for a password:
   - Specify the password you want to use for the certificate (private key). Note that the password text will not appear as you type it.
   - Make a note of the password you choose, because you will need it in the next step when editing the configuration file.
   - The default password is 'changeit'.

3. Follow the prompts to specify your name, organisation and location. This information is used to construct the X.500 Distinguished Name (DN) of the entity. The CN ("What is your first and last name?") must match the fully-qualified hostname of the server running Confluence, otherwise Tomcat will not be able to use the certificate for SSL. For example for a Confluence running on a server named "confluence.example.com":
   ```
   CN=confluence.example.com, OU=Java Software Division, O=Sun Microsystems Inc, C=US
   ```
   Enter 'y' to confirm the details.

4. When asked for the password for 'tomcat' (the alias you entered in the keytool command above), press the 'Enter' key. This specifies that your keystore entry will have the same password as your private key. You MUST use the same password here as was used for the keystore password itself. This is a restriction of the Tomcat implementation.

5. You certificate is now ready. Go to step 2 below.

Certificate Option 2 – Use a Certificate Issued by a Certificate Authority

When running Confluence in a production environment, you will need a certificate issued by a certificate authority (CA, sometimes also called a 'certification authority') such as VeriSign, Thawte or TrustCenter. The instructions below are adapted from the Tomcat documentation.

First you will generate a local certificate and create a 'certificate signing request' (CSR) based on that certificate. You will submit the CSR to your chosen certificate authority. The CA will use that CSR to generate a certificate for you.

1. Use Java's keytool utility to generate a local certificate, as described in the previous section.
2. Use the keytool utility to generate a CSR, replacing the text <MY_KEYSTORE_FILENAME> with the path to and file name of the .keystore file generated for your local certificate:
   ```
   keytool -certreq -keyalg RSA -alias tomcat -file certreq.csr -keystore <MY_KEYSTORE_FILENAME>
   ```
3. Submit the generated file called certreq.csr to your chosen certificate authority. Refer to the documentation on the CA's website to find out how to do this.
4. The CA will send you a certificate.
5. Import the new certificate into your local keystore:
Step 2. Modify the Server Configuration File in your Confluence Installation

1. Edit the server configuration file at this location: {CONFLUENCE-INSTALLATION}/conf/server.xml.
2. Uncomment the following lines:

```xml
<Connector port="8443" maxHttpHeaderSize="8192"
    maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
    enableLookups="false" disableUploadTimeout="true"
    acceptCount="100" scheme="https" secure="true"
    clientAuth="false" sslProtocol="TLS" SSLEnabled="true"
    URIEncoding="UTF-8"
    keystorePass="<MY_CERTIFICATE_PASSWORD>"/>
```

3. Replace the text `<MY_CERTIFICATE_PASSWORD>` with the password you specified for your certificate.
4. Make sure that the attribute-value pair `SSLEnabled="true"` is part of the `Connector` element, as shown above. If this attribute is not present, attempts to access Confluence will time out.
5. Save the server configuration file.

Step 3. Specify the Location of your Certificate

If you receive an error, and you use Verisign or GoDaddy, you may need to export the certificate to PKCS12 format along with the private key.

1. First, remove the certificate added above from the keystore:

```
keytool -delete -alias tomcat -keystore <MY_KEYSTORE_FILENAME>
```

2. Then export to PKCS12 format:

```
openssl pkcs12 -export -in <MY_CERTIFICATE_NAME> -inkey <MY_PRIVATEKEY_NAME> -out <MY_PKC12_KEYSTORE_NAME> -name tomcat -CAfile <MY_ROOTCERTIFICATE_NAME-alsoCalledBundleCertificateInGoDaddy> -caname root
```

3. Then import from PKCS12 to jks:

```
keytool -importkeystore -deststorepass <MY_DESTINATIONSTORE_PASSWORD>
    -destkeypass <MY_DESTINATIONKEY_PASSWORD> -destkeystore <MY_KEYSTORE_FILENAME>
    -srckeystore <MY_PKC12_KEYSTORE_NAME>
    -srcstoretype PKCS12 -srcstorepass <MY_PKC12_KEYSTORE_PASSWORD> -alias tomcat
```
By default, Tomcat expects the keystore file to be named .keystore and to be located in the user home directory under which Tomcat is running (which may or may not be the same as your own home directory). This means that, by default, Tomcat will look for your SSL certificates in the following location:

- On Windows: C:\Documents and Settings\#CURRENT_USER#.keystore
- On OS X and UNIX-based systems: ~/.keystore

You may decide to move the certificate to a custom location. If your certificate is not in the default location, you will need to update your server configuration file as outlined below, so that Tomcat can find the certificate.

1. Edit the server configuration file at this location: {CONFLUENCE-INSTALLATION}>/conf/server.xml
2. Add the attribute keystoreFile="<MY_CERTIFICATE_LOCATION>" to the Connector element, so that the element looks like this:

```xml
<Connector port="8443" maxHttpHeaderSize="8192"
    maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
    enableLookups="false" disableUploadTimeout="true"
    acceptCount="100" scheme="https" secure="true"
    clientAuth="false" sslProtocol="TLS" SSLEnabled="true"
    keystorePass="<MY_CERTIFICATE_PASSWORD>"
    keystoreFile="<MY_CERTIFICATE_LOCATION>"/>
```

3. Replace the text <MY_CERTIFICATE_LOCATION> with the path to your certificate, including the path and the name of the .keystore file.
4. Save the server configuration file.

**Step 4. Change your Confluence Base URL to HTTPS**

1. In your browser, go to the Confluence Administration Console.
2. Change the Server Base URL to HTTPS. See the documentation on configuring the server base URL.

**Step 5. Add a Security Constraint to Redirect All URLs to HTTPS**

Although HTTPS is now activated and available, the old HTTP URLs (http://localhost:8090) are still available. Now you need to redirect the URLs to their HTTPS equivalent. You will do this by adding a security constraint in web.xml. This will cause Tomcat to redirect requests that come in on a non-SSL port.

1. Check whether your Confluence site uses the RSS macro. If your site has the RSS macro enabled, you may need to configure the URL redirection with a firewall rule, rather than by editing the web.xml file. Skip the steps below and follow the steps on the RSS Feed Macro page instead.
2. Otherwise, Edit the file at <CONFLUENCE_INSTALLATION>/confluence/WEB-INF/web.xml.
3. Add the following declaration to the end of the file, before the </web-app> tag:

```xml
<security-constraint>
    <web-resource-collection>
        <web-resource-name>Restricted URLs</web-resource-name>
        <url-pattern>/</url-pattern>
    </web-resource-collection>
    <user-data-constraint>
        <transport-guarantee>CONFIDENTIAL</transport-guarantee>
    </user-data-constraint>
</security-constraint>
```


Confluence has two web.xml files. The other one is at <CONFLUENCE_INSTALLATION>/conf/web.xml. Please only add the security constraints to <CONFLUENCE_INSTALLATION>/confluence/WEB-INF/web.xml.
Notes

- **Background information on generating a certificate**: The `keytool -genkeypair` command generates a key pair consisting of a public key and the associated private key, and stores them in a keystore. The command packages the public key into an X.509 v3 self-signed certificate, which is stored as a single-element certificate chain. This certificate chain and the private key are stored in a new keystore entry, identified by the alias that you specify in the command. The Java SE documentation has a good overview of the utility.

- **Custom SSL port**: If you have changed the port that the SSL connector is running on from the default value of 8443, you must update the `redirectPort` attribute of the standard HTTP connector to reflect the new SSL port. Tomcat needs this information to know which port to redirect to when an incoming request needs to be secure.

- **Multiple instances on the same host**: When running more than one instance on the same host, it is important to specify the `address` attribute in the `<CONFLUENCE_INSTALLATION>/conf/server.xml` file because by default the connector will listen on all available network interfaces, so specifying the address will prevent conflicts with connectors running on the same default port. See the Tomcat Connector documentation for more about setting the address attribute: [http://tomcat.apache.org/tomcat-5.5-doc/config/http.html](http://tomcat.apache.org/tomcat-5.5-doc/config/http.html)

```xml
<Connector port="8443" address="your.confluence.url.com"
  maxHttpHeaderSize="8192"
  maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
  enableLookups="false" disableUploadTimeout="true"
  acceptCount="100" scheme="https" secure="true"
  clientAuth="false" sslProtocol="TLS" SSLEnabled="true"
  URIEncoding="UTF-8"
  keystorePass="<MY_CERTIFICATE_PASSWORD>"
  keystoreFile="<MY_CERTIFICATE_LOCATION>"/>
```

- **Protection for logins only or for individual spaces**: As of Confluence 3.0, Atlassian does not support HTTPS for logins only or for specific pages. We support only site-wide HTTPS. To see the reasoning behind this decision, please see CONF-18120 and CONF-4116.

Troubleshooting

- Check the Confluence knowledge base articles on troubleshooting SSL.

- If any of your users will access Confluence from **Internet Explorer 7 on Vista**, please note the following additional points when using Java's `keytool` utility:
  - Make sure that you specify the `-keyalg RSA` option, as shown in the example of the `keytool` command above. The default is the SHA1 algorithm, which results in an error 'Internet Explorer cannot display the webpage' on IE7 on Vista.
  - You may also need to specify the `-sigalg MD5withRSA` option. Otherwise, SHA1 will be used even if you specify the `-keyalg RSA` option. See [this Atlassian blogpost](http://www.atlassian.com) for more information.

- Problems with **Internet Explorer being unable to download attachments**: Applying SSL site wide can prevent IE from downloading attachments correctly. To fix this problem, edit `<CONFLUENCE_INSTALLATION>/conf/server.xml` and add the following line within the `<Context ... />` element:

```xml
<Valve className="org.apache.catalina.authenticator.NonLoginAuthenticator" 
  disableProxyCaching="true" securePagesWithPragma="false"/>
```

Related Topics

- **SSL Configuration HOW-TO** in the Apache Tomcat 6.0 documentation
- **SSL Configuration HOW-TO** in the Apache Tomcat 7.0 documentation
This page describes how to get Confluence connecting to external servers over SSL, via the various SSL-wrapped protocols.

Here are some examples of when you may need to connect to an external server over SSL/HTTPS:

- You need to connect to an LDAP server, such as Active Directory, if the LDAP server is running over SSL. 
  
  For specific instructions for Active Directory, see Configuring an SSL Connection to Active Directory.

- You want to set up JIRA as a trusted application in Confluence, when JIRA is running over SSL.

- You want to refer to an https://... URL in a Confluence macro.

If you want to run Confluence itself over SSL, see Running Confluence Over SSL or HTTPS.

The following commands apply to JDK 1.5. For commands/syntax relevant to JDK 1.6, please refer to this document from Oracle.

1. Add the root certificate to your default Java keystore with the following command. This is the certificate that was used to authorise the LDAP server's certificate. It will be either the one that was used for signing it, or will come from further up in the trust chain, possibly the root certificate. This is often a self-signed certificate, when both ends of the SSL connection are within the same network. Again, the exact alias is not important.

   ```sh
   keytool -import -alias serverCert -file RootCert.crt -keystore %JAVA_HOME%/jre/lib/security/cacerts (Windows)
   keytool -import -alias serverCert -file RootCert.crt -keystore $JAVA_HOME/jre/lib/security/cacerts (Linux/Unix/Mac)
   ```

2. Import your LDAP or JIRA server's public certificate into the JVM Keystore. This is the certificate that the LDAP server will use to set up the SSL encryption. You can use any alias of your choosing in place of "JIRAorLDAPServer.crt".

   ```sh
   keytool -import -alias ldapCert -file JIRAorLDAPServer.crt -keystore %JAVA_HOME%/jre/lib/security/cacerts (Windows)
   keytool -import -alias ldapCert -file JIRAorLDAPServer.crt -keystore $JAVA_HOME/jre/lib/security/cacerts (Linux/Unix/Mac)
   ```

3. Verify that the certificate has been added successfully by entering the following command:

   ```sh
   keytool -list -v -keystore %JAVA_HOME%/jre/lib/security/cacerts (Windows)
   keytool -list -v -keystore $JAVA_HOME/jre/lib/security/cacerts (Linux/Unix/Mac)
   ```

There's a Confluence SSL plugin that facilitates this process.
4. Ensure that you have updated JAVA_OPTS to specify the path to the keystore, as specified in Connecting to SSL services, before restarting Tomcat/Confluence.

There is no need to specify an alias for Confluence to use. On connecting to the LDAP server, it will search through the keystore to find a certificate to match the key being presented by the server.

**Troubleshooting**

Check the following knowledge base articles:

- Unable to Connect to SSL Services due to PKIX Path Building Failed
- SSL troubleshooting articles

**Related Topics**

Configuring an SSL Connection to Active Directory
Configuring Web Proxy Support for Confluence
Running Confluence Over SSL or HTTPS
Configuring RSS Feeds

A Confluence System Administrator can configure the following aspects of RSS feeds:

- The maximum number of items that Confluence returns to an RSS feed request.
- The maximum time period that Confluence allows to respond to an RSS feed request.

Both of these are set in the 'Edit Security Configuration' screen.

**To configure RSS feeds:**

1. Choose the cog icon then choose General Configuration under Confluence Administration.
2. Choose Security Configuration.
3. Choose Edit.
4. Enter a value for Maximum RSS Items. The default value is 200.
5. Enter a value for RSS timeout.
6. Choose Save.
Notes

- When using the RSS Feed Builder, a user could potentially enter such a large value for the number of feed items returned that Confluence would eventually run out of memory.
- When using the Feed Builder, if a user enters a value greater than this setting (or less than 0) they will get a validation error.
- If any pre-existing feeds are set to request more than the configured maximum, they will be supplied with only the configured maximum number of items. This is done silently - there is no logging and no message is returned to the RSS reader.
- If Confluence times out when responding to an RSS feed request, any items already rendered are returned.

Preventing and Cleaning Up Spam

If you have a public-facing Confluence site, your site may be affected by spammers.

Stopping Spammers

To prevent spammers:

2. Run Confluence behind an Apache webserver and create rules to block the spammer's IP address.

Blocking Spam at Apache or System Level

If a spam bot is attacking your Confluence site, they are probably coming from one IP address or a small range of IP addresses. To find the attacker’s IP address, follow the Apache access logs in real time and filter for a page that they are attacking.

For example, if the spammers are creating users, you can look for signup.action:

```bash
$ tail -f confluence.atlassian.com.log | grep signup.action
1.2.3.4 - - [13/Jan/2010:00:14:51 -0600] "GET /signup.action HTTP/1.1"
200 9956 "-" "Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; SV1)"
37750
```

Compare the actual spam users being created with the log entries to make sure you do not block legitimate users. By default, Apache logs the client's IP address in the first field of the log line.

Once you have the offender's IP address or IP range, you can add it to your firewall's blacklist. For example, using the popular Shorewall firewall for Linux you can simply do this:

```bash
# echo "1.2.3.4" >> /etc/shorewall/blacklist
# /etc/init.d/shorewall reload
```

To block an IP address at the Apache level, add this line to your Apache vhost config:

```apache
Deny from 1.2.3.4
```
You can restart Apache with a "graceful" command which will apply the changes without dropping any current sessions.

If this still does not stop the spam, then consider turning off public signup.

**Deleting Spam**

**Profile Spam**

By 'profile spam', we mean spammers who create accounts on Confluence and post links to their profile page. If you have had many such spam profiles created, it is easier to delete them via SQL, as described below.

**To delete a spam profile:**

1. Shut down Confluence and back up your database. **Note:** This step is essential before you run any SQL commands on your Confluence database.
2. Find the last real profile:

   ```sql
   SELECT bodycontentid, body FROM bodycontent WHERE contentid IN (SELECT contentid FROM content WHERE contenttype='USERINFO') ORDER BY bodycontentid DESC;
   ```

3. Look through the bodies of the profile pages until you find where the spammer starts. You may have to identify an number of ranges.
4. Find the killset:

   ```sql
   CREATE TEMP TABLE killset AS SELECT bc.bodycontentid, c.contentid, c.username FROM bodycontent bc JOIN content c ON bc.contentid=c.contentid WHERE bodycontentid >= BOTTOM_OF_SPAM_RANGE AND bodycontentID <= TOP_OF_SPAM_RANGE AND c.contenttype='USERINFO';
   
   DELETE FROM bodycontent WHERE bodycontentid IN (SELECT bodycontentid FROM killset);
   
   DELETE FROM links WHERE contentid IN (SELECT contentid FROM killset);
   
   DELETE FROM content WHERE prevver IN (SELECT contentid FROM killset);
   
   DELETE FROM attachments WHERE pageid IN (SELECT contentid FROM killset);
   
   DELETE FROM content WHERE contentid IN (SELECT contentid FROM killset);
   
   DELETE FROM os_user_group WHERE user_id IN (SELECT id FROM killset k JOIN os_user o ON o.username=k.username);
   
   DELETE FROM os_user WHERE username IN (SELECT username FROM killset);
   ```

5. Once the spam has been deleted, restart Confluence and rebuild the index. This will remove any references to the spam from the search index.
Notes

- See CONF-1469. Your comments that issue are very much appreciated.

Scheduled Jobs

The administration console allows you to schedule various administrative jobs in Confluence, so that they are executed at regular time intervals. The types of jobs which can be scheduled cover:

- Confluence site backups
- Storage optimisation jobs to clear Confluence's temporary files and caches
- Index optimisation jobs to ensure Confluence's search index is up to date
- Mail queue optimisation jobs to ensure Confluence's mail queue is maintained and notifications have been sent.

You need to have System Administrator permissions in order to configure and execute jobs.

Accessing Confluence's Scheduled Jobs Configuration

To access Confluence's Scheduled Jobs configuration page:

1. Choose the cog icon and then choose General Configuration under Confluence Administration.
2. Choose 'Scheduled Jobs' to open the 'Scheduled Jobs' page. For each job listed down this page, the following information is shown:
   - **Job** — the name of a job.
   - **Status** — the job's status, which is either 'Scheduled' (it it is currently enabled) or 'Disabled'. See below for details on disabling or re-enabling a job.
   - **Last Execution** — the date and time when the job was last executed. This field will be empty of the job was never executed.
   - **Next Execution** — the date and time when the job is next scheduled to be executed. This field will contain dash symbol ('-') if the job is disabled.
   - **Avg. Duration** — the length of time (in milliseconds) that it took to complete the job's last execution.
   - **Actions** — allows you to configure the job, execute it manually, view a history of previous executions or disable the job.

On this page:

- Accessing Confluence's Scheduled Jobs Configuration
- Executing a Job Manually
- Configuring a Job's Schedule
- Disabling/Re-enabling a Job
- Viewing a Job's Execution History
- Types of Jobs
- Cron Expressions

Related pages:

- Trigger Module
- Configuring Backups

⚠️ The information on this page does not apply to Confluence Cloud.

Screenshot: Scheduled Jobs
Executing a Job Manually

1. Access the 'Scheduled Jobs' configuration page (above).
2. Locate the job you wish to execute manually and click its 'Run' link in the 'Actions' column. The job will be run immediately.
   - Refer to 'Types of Jobs' (below) for detailed descriptions about each job.
3. Not all jobs can be run manually.

Configuring a Job’s Schedule

1. Access the 'Scheduled Jobs' configuration page (above).
2. Locate the job whose schedule you wish to configure and click its 'Edit' link in the 'Actions' column. The job's 'Edit Schedule for job' dialog box opens.
   - Refer to 'Types of Jobs' (below) for detailed descriptions about each job.
3. Enter an appropriate cron expression to define the frequency with which the job is executed.
   - Refer to 'Cron Expressions' (below) for more details about their syntax. To revert the job’s schedule back to its default settings, click the 'Default' button.
4. Click 'Save' to record your job’s new schedule.
   - Not all jobs' schedules are configurable.

Screenshot: Configuring a Job Schedule
Disabling/Re-enabling a Job

By default, all jobs in Confluence are enabled.

1. Access the 'Scheduled Jobs' configuration page (above).
2. Locate the job you wish to disable/re-enable.
   - Refer to 'Types of Jobs' (below) for detailed descriptions about each job.
   - If a job is enabled, click its 'Disable' link in the 'Actions' column to disable the job.
   - If a job is disabled, click its 'Enable' link in the 'Actions' column to enable the job.

   Not all jobs in Confluence can be disabled.

Viewing a Job's Execution History

1. Access the 'Scheduled Jobs' configuration page (above).
2. Locate the job whose execution history you wish to view and click the 'History' link.
   - If a job has not completed at least one execution, its 'History' link will not be available.
   - Refer to 'Types of Jobs' (below) for detailed descriptions about each job.

The 'History for job' dialog box opens, showing a list of previous executions of the job in reverse chronological order, including the:

- Start date and time
- End date and time
- The length of time (in milliseconds) that it took to complete the job

Screenshot: Job Execution History
<table>
<thead>
<tr>
<th>Job Name</th>
<th>Description</th>
<th>Execution Behaviour</th>
<th>Default Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back Up Confluence</td>
<td>Performs a <strong>backup</strong> of your entire Confluence site.</td>
<td>Per cluster</td>
<td>At 2am every day</td>
</tr>
<tr>
<td>Check Cluster Safety</td>
<td>For clustered Confluence installations, this job ensures that only one Confluence instance in the cluster writes to the database at a time. For standard (non-clustered) editions of Confluence, this job is useful for alerting customers who have accidentally connected a second Confluence instance to a Confluence database which is already in use.</td>
<td>Per cluster</td>
<td>Every 30 seconds</td>
</tr>
<tr>
<td>Clean Index Queue</td>
<td>Triggers a periodical clean of the <strong>index queue</strong> to ensure that its size does NOT grow indefinitely.</td>
<td>Per cluster</td>
<td>At 2am every day</td>
</tr>
<tr>
<td>Clean Temporary Directory</td>
<td>Cleans up temporary files generated in the 'temp' subdirectory of the Confluence home directory. This temp directory may be created by exports etc. <strong>Note:</strong> This does not include the <strong>temp directory</strong> located in the confluence install directory.</td>
<td>Per node</td>
<td>At 4am every day</td>
</tr>
<tr>
<td>Clear Expired Mail Errors</td>
<td>Clears notification errors in the <strong>mail error queue</strong>. A notification error is sent to the mail error queue whenever the notification fails to be sent due to an error.</td>
<td>Per cluster</td>
<td>At 3am every day</td>
</tr>
<tr>
<td>Clear Expired Remember Me Tokens</td>
<td>Clears all expired 'Remember Me' tokens from the Confluence site. Remember Me tokens expire after two weeks.</td>
<td>Per cluster</td>
<td>On the 20th of each month</td>
</tr>
<tr>
<td>Email Daily Reports</td>
<td>Emails a daily summary report of all Confluence changes to all subscribers. <strong>Note:</strong> Since each email report only records changes from the last 24-hour period, it is recommended that you only change the time of this job whilst keeping the job's frequency to 24 hours.</td>
<td>Per cluster</td>
<td>At 12am every day</td>
</tr>
<tr>
<td>Flush Did You Mean Index</td>
<td><strong>Note:</strong> The 'Did You Mean' feature is no longer available in Confluence. This job is therefore redundant, and will be removed at some time in the future. Flushes changes to the 'Did You Mean' index, which keeps the 'Did You Mean' feature up to date. Confluence records each content update in the 'Did You Mean' index.</td>
<td>Per node</td>
<td>Every 2 hours from 12 am</td>
</tr>
</tbody>
</table>
Flush Index Queue | Flushes changes to Confluence's index so that Confluence’s search results are up to date. Confluence records each content update in its search index. | Per node | Every minute
Flush Local Task Queue | Flushes the local task queue. (These are internal Confluence tasks that are typically flushed at a high frequency.) | Per node | Every minute
Flush Mail Queue | Sends notifications that have been queued up in the mail queue. | Per cluster | Every minute
Flush Task Queue | Flushes the task queue. (These are internal Confluence tasks that are typically flushed at a high frequency.) | Per node | Every minute
Optimise Indexing | Compacts the confluence indexes to maintain searching performance. This task is demanding on system resources and does not need to be performed too regularly. If you see Confluence performance deteriorate around 3pm, try scheduling this job for 3am only and check if search performance remains reasonable. | Per node | At 3am and 3pm every day
Poll Mail | Polls POP accounts on all spaces that have them configured. | Per cluster | Every minute

**Cron Expressions**

A cron expression is a string of 6-7 'time interval' fields that defines the frequency with which a job is executed. Each of these fields can be expressed as either a numerical value or a special character and each field is separated by at least one space or tab character.

The table below is shows the order of time interval fields in a cron expression and each field's permitted numerical values.

You can specify a special character instead of a numerical value for any field in the cron expression to provide flexibility in defining a job's frequency. Common special characters include:

- '*' — a 'wild card' that indicates 'all permitted values'.
- '?' — indicates 'ignore this time interval' in the cron expression. That is, the cron expression will not be bound by the time interval (such as 'Month', 'Day of week' or 'Year') to which this character is specified.

For more information about cron expressions, please refer to the [Cron Trigger tutorial on the Quartz website](#).

<table>
<thead>
<tr>
<th>Order in cron expression</th>
<th>Time interval field</th>
<th>Permitted values*</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Seconds</td>
<td>0-59</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Minutes</td>
<td>0-59</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Hours</td>
<td>0-23</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Day of month</td>
<td>1-31</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>Month</td>
<td>1-12 or JAN-DEC</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>Day of week</td>
<td>1-7 or SUN-SAT</td>
<td>Yes</td>
</tr>
<tr>
<td>7</td>
<td>Year</td>
<td>1970-2099</td>
<td>No</td>
</tr>
</tbody>
</table>

* Excluding special characters.

**Configuring the Whitelist**

Confluence administrators can choose to allow incoming and outgoing connections and content from specified sources for use in the RSS macro, HTML Include macro and gadgets, by adding URLs to the whitelist.
Confluence will display an error if content has been added that is not from an allowed source, and prompt the user to add the URL to the whitelist.

**Application links** are automatically added to the whitelist. You do need to manually add them.

Note: The **HTML Include macro** is disabled by default.

Add allowed URLs to the whitelist

To add a URL to the whitelist:

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Choose **Whitelist**.
3. Enter the URL or expression you want to allow.
4. Choose the **Type** of expression (see below for examples of the types available).
5. Choose **Allow Incoming** if you need to allow CORS requests (see below).
6. Choose **Add**.

Your URL or expression appears in the whitelist.

To test that your whitelisted URL is working as expected you can enter a URL in the **Test a URL** field. Icons will indicate whether incoming and / or outgoing traffic is allowed for that URL.

**Expression Types**

When adding a URL to the whitelist, you can choose from a number of expression types.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain name</td>
<td>Allows all URLs from the specified domain.</td>
<td><a href="http://www.example.com">http://www.example.com</a></td>
</tr>
<tr>
<td>Exact match</td>
<td>Allows only the specified URL.</td>
<td><a href="http://www.example.com/thispage">http://www.example.com/thispage</a></td>
</tr>
<tr>
<td>Wildcard Expression</td>
<td>Allows all matching URLs. Use the wildcard * character to replace one or more characters.</td>
<td>http://*example.com</td>
</tr>
<tr>
<td>Regular Expression</td>
<td>Allows all URLs matching the regular expression.</td>
<td>http(s)?://www.example.com</td>
</tr>
</tbody>
</table>

**Allow Incoming**

**Allow Incoming** enables CORS requests from the specified origin. The URL must match the format `scheme://host[:port]`, with no trailing slashes (`:port` is optional). So `http://example.com/` would not allow CORS requests from the domain `example.com`.

**Disabling the whitelist**

The whitelist is enabled by default. You can choose to disable the whitelist however this will allow all URLs, including malicious content, and is not recommended.

To disable the whitelist:

1. Choose the cog icon, then choose **General Configuration** under Confluence Administration.
2. Choose **Whitelist**.
3. Choose **Turn off whitelist**.
4. Choose **Confirm**.

All URLs will now be allowed. Unless your instance is running in an environment without internet access, we do not recommend disabling the whitelist.

**Performance Tuning**

This document describes tuning your application for improved performance. It is not a guide to troubleshooting Confluence outages. Check **Troubleshooting Confluence Hanging or Crashing** for help if Confluence is crashing.
Like any server application, Confluence may require some tuning as it is put under heavier use. We do our best to make sure Confluence performs well under a wide variety of circumstances, but there's no single configuration that is best for everyone's environment and usage patterns.

If you are having problems with the performance of Confluence and need our help resolving them, you should read Requesting Performance Support.

Use the latest version of your tools

Use the latest versions of your application servers and Java runtime environments. Newer versions are usually better optimized for performance.

Avoid swapping due to not enough RAM

Always watch the swapping activity of your server. If there is not enough RAM available, your server may start swapping out some of Confluence's heap data to your hard disk. This will slow down the JVM's garbage collection considerably and affect Confluence's performance. In clustered installations, swapping can lead to a Cluster Panic due to Performance Problems. This is because swapping causes the JVM to pause during Garbage Collection, which in turn can break the inter-node communication required to keep the clustered nodes in sync.

On this page:
- Use the latest version of your tools
- Avoid swapping due to not enough RAM
- Being aware of other systems using the same infrastructure
- Choice of database
- Database connection pool
- Database in general
- Database indexes
- Database statistics and query analysers
- Cache tuning in Confluence and Apache
- Antivirus software
- Enabling HTTP compression
- Virtual operating systems
- Performance testing
- Access logs
- Built-in profiler
- Application server memory settings
- Web server configuration
- Troubleshooting possible memory leaks

Being aware of other systems using the same infrastructure

It may sound tempting: Just have one powerful server hosting your database and/or application server, and run all your crucial programs on that server. If the system is set up perfectly, then you might be fine. Chances are however that you are missing something, and then one application's bug might start affecting other applications. So if Confluence is slow every day around noon, then maybe this is because another application is using the shared database to generate complicated reports at that time? Either make sure applications can't harm each other despite sharing the same infrastructure, or get these systems untangled, for example by moving them to separate instances that can be controlled better.

Choice of database

The embedded database that is provided with Confluence is meant only to be used for evaluation, not for production Confluence sites. After the evaluation finishes, you will certainly need to switch to an external relational database management system. Beyond this, we do not recommend any particular RDBMS over another. We recommend using what you are familiar with, because your ability to maintain the database will probably make far more difference to what you get out of it than the choice of database itself.

Database connection pool
If load on Confluence is high, you may need more simultaneous connections to the database.

- If you are using JNDI data-sources, you will do this in your application server's configuration files.
- If you have configured Confluence to access the database directly, you will need to manually edit the hibernate.c3p0.max_size property in the confluence.cfg.xml file in your confluence.home directory. After you have changed the URL in this file, restart Confluence.

To assess whether you need to tune your database connection pool, take thread dumps during different times (including peak usage). Inspect how many threads have concurrent database connections.

Database in general

If Confluence is running slowly, one of the most likely cause is that there is some kind of bottleneck in (or around) the database.

The first item you should check is the "Database Latency" field in the System Information tab in the admin console.

<table>
<thead>
<tr>
<th>Database Connection Transaction isolation</th>
<th>Confluence Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Latency</td>
<td>0</td>
</tr>
</tbody>
</table>

The latency is calculated by sending a trivial request to the database, querying a table which is known to have only one column and one row. ("select * from CLUSTERSAFETY"). Obviously this query should be blazing fast, and return within 1 or 2 milliseconds. If the value displayed is between 3 and 5 milliseconds, you might already have an issue. If the value is above 10ms, then you **definitely** need to investigate and improve something! A few milliseconds may not sound so bad, but consider that Confluence sends quite a few database queries per page request, and those queries are a lot more complex too! High latency might stem from all sorts of problems (slow network, slow database, connection-pool contention, etc), so it's up to you to investigate. Don't stop improving until latency is below 2ms on average.

Obviously, latency is just the very first thing to look at. You may get zero latency and still have massive database problems, e.g. if your tables are poorly indexed. **So don't let a low latency fool you either.**

Database indexes

Especially if you have more than a few thousand active users, and all most obvious measures have been tried out but the database still seems to be under high load, you should consider engaging a database administrator (DBA) to tune the database specifically to the demands that your particular Confluence installation is placing on it. If you do not have a full-time DBA and can't even get one for temporary consulting, you may want to consult the database indexing advice that we have been gathering from customer reports and our own experience running and developing Confluence. The instructions on that page are for Oracle, but most of the indexes can be applied to (and will help with) any database.

(These database indexes are now created automatically when Confluence is installed, but existing installations upgrading to a more recent version may still need to add them manually)

Database statistics and query analysers

Modern databases have query optimisers based on collecting statistics on the current data. Using the SQL EXPLAIN statement will provide you information on how well the query optimiser is performing. If the cost estimate is wildly inaccurate then you will need to run statistics collection on the database. The exact command will depend on your database and version. In most cases you can run statistics collection while Confluence is running, but due to the increased load on the database it's best to do this after normal hours or on a week-end.

Cache tuning in Confluence and Apache

To reduce the load on the database, and speed up many operations, Confluence keeps its own cache of data. Tuning the size of this cache may speed up Confluence (if the caches are too small), or reduce memory (if the caches are too big).

Please have a look at our documentation on Cache Performance Tuning for information on how to tune Confluence caches.

To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up
static content. See Configuring Apache to Cache Static Content via mod_disk_cache.

Antivirus software

Antivirus software greatly decreases the performance of Confluence. Antivirus software that intercepts access to the hard disk is particularly detrimental, and may even cause errors with Confluence. You should configure your antivirus software to ignore the Confluence home directory, its index directory and any database-related directories.

Enabling HTTP compression

If bandwidth is responsible for bottlenealing in your Confluence installation, you should consider enabling HTTP compression. This may also be useful when running an external facing instance to reduce your bandwidth costs.

Take note of the known issues with HTTP compression in versions of Confluence prior to 2.8, which may result in high memory consumption.

Virtual operating systems

Virtual Environments such as VMWare can cause Confluence CPU to spike. Run Confluence on a native OS. Refer to the list of supported operating systems for Confluence in the Supported Platforms topic.

**Note:** In some situation the VMTools can crash, cause a excessive context switches and interrupts causing the JVM to run slowly and Confluence to start up very slowly.

Performance testing

You should try out all configuration changes on a demo system. Ideally, you should run and customize loadtests that simulate user behaviour.

Access logs

You can find out which pages are slow and which users are accessing them by enabling Confluence's built-in access logging.

Built-in profiler

You can identify the cause of page delays using Confluence's built-in profiler according to Troubleshooting Slow Performance Using Page Request Profiling.

Application server memory settings

See How to Fix Out of Memory Errors by Increasing Available Memory.

Web server configuration

For high-load environments, performance can be improved by using a web server such as Apache in front of the application server. There is a configuration guide to Running Confluence behind Apache.

When configuring your new web server, make sure you configure sufficient threads/processes to handle the load. This applies to both the web server and the application server connector, which are typically configured separately. If possible, you should enable connection pooling in your web server connections to the application server.

Troubleshooting possible memory leaks

Some external plugins, usually ones that have been written a long time ago and that are not actively maintained anymore, have been reported to consume memory and never return it. Ultimately this can lead to a crash, but first this manifests as reduced performance. The Troubleshooting Confluence Hanging or Crashing guide is a good place to start. Some of the known causes listed there could result in performance issues short of a crash or hang.

**Cache Performance Tuning**

Confluence performance can be significantly affected by the performance of its caches. It is
essential for the administrator of a large production installation of Confluence to tune the caches to suit its environment.

There are several configurable parameters for each of the cache regions, most notably cache size, cache expiry delay and eviction policy. In most cases, cache size is the parameter you would want to change.

To change the size of a cache:

1. Go to General Configuration > Cache Management.
2. Choose Show Advanced View.
3. Choose Adjust Size next to the cache you want to change.

To modify other parameters you can modify the cache configuration files manually.

Cache tuning example

As an example of how to tune Confluence's caches, let's have a look at the following table:

<table>
<thead>
<tr>
<th>Caches</th>
<th>% Used</th>
<th>% Effectiveness</th>
<th>Objects/Size</th>
<th>Hit/Miss/Expiry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments</td>
<td>87%</td>
<td>29%</td>
<td>874/1000</td>
<td>78226/189715/187530</td>
</tr>
<tr>
<td>Content Attachments</td>
<td>29%</td>
<td>9%</td>
<td>292/1000</td>
<td>4289/41012/20569</td>
</tr>
<tr>
<td>Content Bodies</td>
<td>98%</td>
<td>81%</td>
<td>987/1000</td>
<td>28717/6671/5522</td>
</tr>
<tr>
<td>Content Label Mappings</td>
<td>29%</td>
<td>20%</td>
<td>294/1000</td>
<td>4693/18185/9150</td>
</tr>
<tr>
<td>Database Queries</td>
<td>96%</td>
<td>54%</td>
<td>968/1000</td>
<td>105949/86889/83334</td>
</tr>
<tr>
<td>Object Properties</td>
<td>27%</td>
<td>18%</td>
<td>279/1000</td>
<td>5746/25386/8102</td>
</tr>
<tr>
<td>Page Comments</td>
<td>26%</td>
<td>11%</td>
<td>261/1000</td>
<td>2304/17178/8606</td>
</tr>
<tr>
<td>Users</td>
<td>98%</td>
<td>5%</td>
<td>982/1000</td>
<td>6561/115330/114279</td>
</tr>
</tbody>
</table>

The maximum size of the caches above is 1000 (meaning that it can contain up to 1000 objects). You can tell when a cache size needs to be increased because the cache has both:

- a high usage percentage (above 75%)
- a low effectiveness percentage.

Check the 'effectiveness' versus the 'percent used'. A cache with a low percent used need not have its size lowered; it does not use more memory until the cache is filled.

Based on this, the sizes of the "Attachments", "Database Queries", and "Users" caches should be increased to improve their effectiveness.

As the stored information gets older or unused it will expire and be eliminated from the cache. Cache expiry may be based on time or on frequency of use.

There is not much that you can do with a cache that has both a low percentage of usage and effectiveness. Over time, as the cache is populated with more objects and repeat requests for them are made, the cache's effectiveness will increase.

Finding the configuration file

Cache configurations are stored in `<confluence-home>/shared-home/config/cache-settings-ov`
errides.properties

For Confluence Data Center (clustered) it can be found in `<confluence-shared-home>/config/cache-settings-overrides.properties` (in the shared home directory for the cluster).

Cache key mappings

The cache configuration file configures caches by their keys. To find out a cache key hover your mouse over the cache name in the Cache Management screen.

Caching in Confluence Data Center

In Confluence Data Center (clustered) you have a distributed cache and a cluster node-local cache. The Cluster Management page will indicate cluster distributed cache and cluster node-local cache.

The cache configuration file is stored in the shared home directory for the cluster.

Important caches

The following suggestions are general guidelines. In cases of large databases, 20-30% of the size of the table may be unnecessarily large. Check the effectiveness and percent used categories in the cache for more specific assessments.

- **Content Objects cache** (com.atlassian.confluence.core.ContentEntityObject)
  should be set to at least 20-30% of the number of content entity objects (pages, comments, emails, news items) in your system. To find the number of content entity objects, use the query `select count(*) from CONTENT where prevver is null`.

- **Content Body Mappings cache** (com.atlassian.confluence.core.ContentEntityObject.bodyContents)
  should be set to at least 20% of the number of content entity objects (pages, comments, emails, news items) in your system. To find the number of content entity objects, use the query `select count(*) from CONTENT where prevver is null`.

- **Embedded Crowd Internal User cache** (com.atlassian.crowd.model.user.InternalUser)
  should be set to the number of users you have in the internal directory. You can discover this number by using the following SQL:

  ```sql
  SELECT COUNT(*)
  FROM cwd_user u
  JOIN cwd_directory d ON u.directory_id = d.id
  AND d.directory_name = 'Confluence Internal Directory';
  ```

- **Embedded Crowd Users cache** (com.atlassian.confluence.user.crowd.CachedCrowdUserDao.USER_CACHE)
  should be set to the number of rows in the cwd_user table.
Space permissions by ID cache (com.atlassian.confluence.security.SpacePermission) should be set to the number of space permissions in your deployment (a good rule of thumb is 20 times the number of spaces). You can find the number of space permissions using the query `SELECT count(*)` from `SPACEPERMISSIONS`.

Monitoring the contents of a cache

To monitor what is in a cache:

1. In your browser go to `<confluence-URL>/admin/cachecontents.jsp`
2. Select a cache from the list.

Notes

- To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content. See Configuring Apache to Cache Static Content via `mod_disk_cache`.

Cache Statistics

Confluence provides statistics about its internal caches that allow you to track the size and hit ratio of each cache and tune it for better performance (if necessary). See Performance Tuning for more information.

Configurable Caches

System administrators can change the sizes of Confluence's internal caches through the Administration Console and these changes will take effect without the need to first shut down and then restart Confluence. The maximum number of units for any of the defined cache regions can be adjusted individually.

Note that larger cache sizes will require more memory at runtime, so you should review the memory allocation of the Confluence Java process and the physical memory available on your server.

Viewing Cache Statistics and Modifying Cache Sizes

To view the cache statistics:

1. Go to > General Configuration > Cache Management.
2. Choose Show Advanced View.

Here is an example for one of the most frequently used caches, the 'Content Object' cache.

<table>
<thead>
<tr>
<th>Cache Name</th>
<th>Capacity Utilisation</th>
<th>Effectiveness</th>
<th>Current / Max Entries</th>
<th>Current Heap Size (MB)</th>
<th>Hit / Miss / Evicted</th>
<th>Adjust Max Entries</th>
<th>Flush Entries</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Objects</td>
<td>36%</td>
<td>73%</td>
<td>3653 / 10000</td>
<td>Unknown</td>
<td>307745 / 112509 / 37051</td>
<td>Adjust Size</td>
<td>Flush</td>
</tr>
</tbody>
</table>

About the generated numbers:
<table>
<thead>
<tr>
<th><strong>Capacity Utilisation</strong></th>
<th>=(\frac{\text{Objects}}{\text{Size}})</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>For example Percent Used = 4023 / 5000 = 80%</td>
</tr>
<tr>
<td><strong>Effectiveness</strong>:</td>
<td>=(\frac{\text{Hits}}{\text{Hits + Misses}})</td>
</tr>
<tr>
<td></td>
<td>For example Effectiveness = 374550 / (374550 + 140460) = 73%</td>
</tr>
<tr>
<td><strong>Current / Max Entries</strong></td>
<td>The number of entries in the cache / the number of total possible entries allowed (this is the size of the cache).</td>
</tr>
<tr>
<td><strong>Current Heap Size</strong></td>
<td>Heap memory (in MB) allocated to this cache (if applicable)</td>
</tr>
<tr>
<td><strong>Hit / Miss / Evicted</strong></td>
<td>The number of reads accessing cache where required content was found / the number of reads accessing cache where required content was not found / the number of objects evicted from the cache.</td>
</tr>
<tr>
<td><strong>Adjust Size</strong></td>
<td>Use this option to specify a different maximum cache size.</td>
</tr>
<tr>
<td><strong>Flush</strong></td>
<td>Flushes the cache.</td>
</tr>
</tbody>
</table>

Changes to cache size configurations are saved in the `config/cache-settings-overrides.properties` file in your home directory (or shared home directory in a Confluence Data Center cluster).

**Memory Usage and Requirements**

Managing Confluence's performance and memory usage really depends on what resources are available. Confluence will run faster if you give it lots of memory for its caches, but it should still be able to run quite well in low-memory environments, with the right tuning. Below are some tips on getting the most out of your Confluence site.

**Increasing the amount of memory available to Confluence**

See Increasing JIRA Memory for details on how to increase the memory available to web application servers typically used to run Confluence.

**Embedded database**

The embedded HSQL database that comes with Confluence essentially holds all your data in memory while the Confluence server is running. If you are running out of memory, you should consider migrating Confluence to an external database.

**Caching**

By default, Confluence keeps large in-memory caches of data to improve its responsiveness and the user experience. The trade off is an increase in memory requirements to support the cache. Administrators of larger Confluence sites may need to configure the size of their caches to improve performance.

To customise Confluence's cache to meet your needs, see cache tuning.

To increase the amount of memory available to Confluence, see How to Fix Out of Memory Errors by Increasing Available Memory.
On this page:
- Increasing the amount of memory available to Confluence
- Embedded database
- Caching
- Mail error queue
- Attachments
- System backup and restore
- Known issues that we do not have control over
- Confluence is taking long periods of time to respond to some actions

Related pages:
- Performance Tuning
- Requesting Performance Support
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Confluence Cloud.

Mail error queue

Confluence keeps a copy of all emails that it failed to send within an internal error queue. In the event of intermittent failures such as network connectivity issues, the emails in this queue can be manually resent when the problem is fixed. Under certain circumstances, the mail queue can fill up with large objects. The queue is regularly flushed, but if you get a lot of mail errors, you might get a spike in memory usage.

Attachments

The indexing of large attachments requires that the attachment be loaded into memory. In the case of large attachments, this can cause a temporary strain on the systems resources, and may result in indexing failing because the attachment could not be fully loaded into memory.

System backup and restore

The Confluence backup and restore process scales linearly with the size of data. This can have a significant impact on large Confluence instances where the amount of data exceeds the amount of available memory. If you are experiencing an OutOfMemoryError during either a backup or restore processes, then we strongly recommend that you choose and Production Backup Strategy.

If you encounter an OutOfMemoryError while restoring a backup and wish to overcome this issue by increasing memory, how much more will you need to make this process work? A good rule of thumb is to have a look at the size of the entities.xml file in your backup. This file contains all of the data Confluence will be loading, so at least that much is required. Add another 64-128Mb to ensure that Confluence has enough memory to load and function and that should be enough. To increase the amount of memory available to Confluence, see How to Fix Out of Memory Errors by Increasing Available Memory.

Known issues that we do not have control over

There are also some memory issues we don’t have any control over. For example,
- There’s a memory leak in the Oracle 10g JDBC drivers. Not much we can do about that.
- One customer found a rather nasty memory leak that appeared to originate inside Tomcat 5, but only using the IBM JDK on PowerPC.

If you are having problems that appear to result from a memory leak, log an issue on http://support.atlassian.com. Our memory profiler of choice is YourKit. It would be helpful to us if you can provide us with a memory dump from that tool showing the leak.

Confluence is taking long periods of time to respond to some actions

A common cause of random pauses in Confluence is the JVM running garbage collection. To determine if this is what is happening, enable verbose garbage collection and look at how long Java is taking to free up memory. If
the random pauses match when Java is running its garbage collection, garbage collection is the cause of the pause.

Verbose garbage collection will generate log statements that indicate when Java is collecting garbage, how long it takes, and how much memory has been freed.


For example, with a Windows service, run:

```
tomcat5 //US//Confluence ++JvmOptions="-XX:+PrintGCDetails -XX:+PrintGCTimeStamps -verbose:gc -Xloggc:c:\confluence\logs\gc.log"
```

or in `bin/setenv.sh`, set:

```
export CATALINA_OPTS="$CATALINA_OPTS -XX:+PrintGCDetails -XX:+PrintGCTimeStamps -verbose:gc -Xloggc:${CATALINA_BASE}/logs/gc.log"
```

If you modify `bin/setenv.sh`, you will need to restart Confluence for the changes to take effect.

What can you do to minimise the time taken to handle the garbage collection? See [http://java.sun.com/docs/hotpot/gc1.4.2/](http://java.sun.com/docs/hotpot/gc1.4.2/) for details on tuning the JVM to minimise the impact that garbage collection has on the running application.

**Requesting Performance Support**

**Basic performance troubleshooting steps**

Begin with the following procedures:

1. Go through the [Troubleshooting Confluence Hanging or Crashing](#) page to identify the major known performance problems.
2. Proceed with the [Performance Tuning](#) tips to help optimise performance.

**Requesting basic performance support**

If the above tips don't help or you're not sure where to start, open a support ticket starting with at least the basic information:

1. The `atlassian-confluence.log`
2. The `catalina.out` log (or your application server log), with a series of three thread dumps separated by 10 seconds
3. A description with as much detail as possible regarding:
   a. What changes have been made to the system?
   b. When did performance problems begin?
   c. When in the day do performance issues occur?
   d. What pages or operations experience performance issues?
   e. Is there a pattern?

Continue with as much of the advanced performance troubleshooting information as you can.
Advanced performance troubleshooting

Please gather all of the information listed below and include it in your support request, even if you think you have a good idea what's causing the problem. That way we don't have to ask for it later.

System information

Confluence server

- Take a screenshot of Confluence's Administration System Information (or save the page as HTML)
- Take a screenshot of Confluence's Administration Cache Statistics (or save the page as HTML)
- Find out the exact hardware Confluence is running on
  - How many CPUs? What make and model? What MHz?
  - How much memory is installed on the machine?
  - How much memory is assigned to Confluence's JVM? (i.e. what are the -Xmx and -Xms settings for the JVM?)
  - What other applications are being hosted on the same box?

Confluence content

- How many users are registered in Confluence?
- On average, to how many groups does each user belong?
- How many spaces (global and personal) are there in your Confluence server?
- How many of those spaces would be viewable by the average user?
- Approximately how many pages? (Connect to your database and perform 'select count(*) from content where prevver is null and contenttype = 'PAGE')
- How much data is being stored in Bandana (where plugins usually store data)? (Connect to your database and perform 'select count(*), sum(length(bandanavalue)) from bandana')

The database

- What is the exact version number of Confluence's database server?
- What is the exact version number of the JDBC drivers being used to access it? (For some databases, the full filename of the driver JAR file will suffice)
- Is the database being hosted on the same server as Confluence?
- If it is on a different server, what is the network latency between Confluence and the database?
- What are the database connection details? How big is the connection pool? If you are using the standard configuration this information will be in your confluence_cfg.xml file. Collect this file. If you are using a Data source this information will be stored in your application server's configuration file, collect this data.

User management

- Are you using external user management or authentication? (i.e. JIRA or LDAP user delegation, or single sign-on)
- If you are using external JIRA user management, what is the latency between Confluence and JIRA's database server?
- If you are using LDAP user management:
  - What version of which LDAP server are you using?
  - What is the latency between Confluence and the LDAP server?

Diagnostics

Observed problems

- Which pages are slow to load?
  - If it is a specific wiki page, attach the wiki source-code for that page
  - Are they always slow to load, or is the slowness intermittent?
Monitoring data

Before drilling down into individual problems, helps a lot to understand the nature of the performance problem. Do we deal with sudden spikes of load, or is it a slowly growing load, or maybe a load that follows a certain pattern (daily, weekly, maybe even monthly) that only on certain occasions exceeds critical thresholds? It helps a lot to have access to continuous monitoring data available to get a rough overview.

Here are sample graphs from the confluence.atlassian.com system, showing

Load

This graph shows the load for two consecutive days. The obvious pattern is that the machine is under decent load, which corresponds to the user activity, and there is no major problem.

Resin threads and database connections

These two charts show the active threads in the application server (first chart) and the size database connection pool (second chart). As you can see, there was a sudden spike of server threads and a corresponding spike of db-connections.
The database connection pool size

The database connection pool size peaked over 112, which happened to be more than the maximum number of connections the database was configured for (100). So it was no surprise that some requests to Confluence failed and many users thought it had crashed, since many requests could not obtain the crucial database connections.

We were able to identify this configuration problem quite easily just by looking at those charts. The next spikes were uncritical because more database connections were enabled.

The bottom line being: it helps a lot to monitor your Confluence systems continuously (we use Hyperic, for example), and it helps even more if you are able to send us graphs when you encounter problems.

Access logs

- How to Enable User Access Logging, including redirecting the logs to a separate file
  - You can run this file through a log file analyser such as AWStats, or manually look through for pages which are slow to load.

Profiling and logs

- Enable Confluence's built-in profiling for long enough to demonstrate the performance problem using Troubleshooting Slow Performance Using Page Request Profiling.
  - If a single page is reliably slow, you should make several requests to that page
  - If the performance problem is intermittent, or is just a general slowness, leave profiling enabled for thirty minutes to an hour to get a good sample of profiling times
- Find Confluence's standard output logs (which will include the profiling data above). Take a zip of the entire logs directory.
- Take a thread dump during times of poor performance

CPU load

- If you are experiencing high CPU load, please install the YourKit profile and attach two profiler dumps taken during a CPU spike. If the CPU spikes are long enough, please take the profiles 30-60 seconds apart. The most common cause for CPU spikes is a virtual machine operating system.
- If the CPU is spiking to 100%, try Live Monitoring Using the JMX Interface, in particular with the Top threads plugin.

Site metrics and scripts

- It is essential to understand the user access and usage of your instance. Please use the access log scripts and sql scripts to generate Usage statistics for your instance.

Next step

Open a ticket on https://support.atlassian.com and attach all the data you have collected. This should give us the information we need to track down the source of your performance problems and suggest a solution. Please
follow the progress of your enquiry on the support ticket you have created.

Access Log Scripts

The access log scripts are attached to this page. To use the scripts:

1. Unzip the 7z file.
2. Copy all the daily access logs to a folder called logs.
3. Run Atlassian-processDailyLog.rb. This will generate a csv file called summary.csv and several directories which contain the access logs of each defined user action.
4. Run the appropriate script Atlassian-processDailyLog-hourly.rb <admin/comment/create/edit/search/rss>. Each script will generate a different csv file. For example, Atlassian-processDailyLog-hourly.rb admin will process the admin logs extracted in step 3.
5. Import the csv files to www-log-Analysis.xls (summary.csv to 'raw stats - daily' sheet and admin.csv to 'admin -hours' sheet, etc) to generate the load profiles and graphs. You may need to modify the number of rows in each sheet depending on the number of logs.

⚠️ The information on this page does not apply to Confluence Cloud.

Note

All scripts are written in Ruby and assume the log file name contains the string 'confluence.atlassian.com-access.log'. Scripts need to be changed if another name is used. Modify the line: filenameRegexp = Regexp.new('confluence.atlassian.com-access.log')

Troubleshooting Slow Performance Using Page Request Profiling

This page tells you how to enable page-request profiling. With profiling turned on, you will see a record of the time it takes (in milliseconds) to complete each action made on any Confluence page. If Confluence is responding slowly, an internal timing trace of the slow page request can help to identify the cause of the delay.

You will need access to the Confluence server to view a profile.

Enabling Page-Request Profiling

To see just the slow performing macros, see Identifying Slow Performing Macros.

From Confluence 2.7, you can use the 'Logging and Profiling' option to enable or disable profiling.

You need to have System Administrator permissions in order to perform this function.

To enable page profiling:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose 'Logging and Profiling' in the left-hand panel.
3. The 'Logging and Profiling' screen appears. Choose 'Enable Profiling'.
   - If profiling is already enabled, the button will be labelled 'Disable Profiling'.

To disable page profiling:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Choose 'Logging and Profiling' in the left-hand panel.
3. The 'Logging and Profiling' screen appears. Choose 'Disable Profiling'.
   - If profiling is already disabled, the button will be labelled 'Enable Profiling'.
Profiling an Activity

1. Enable profiling, using either of the methods described above.
   Profiles for every page hit, for all users, will now be logged to your application server's default logs until Confluence is restarted. Note that each time a user visits a link, a single profile is printed.
2. Confirm that profiles are being written to the Confluence log file — see Working with Confluence Logs for location of the log files and other details.
3. Perform the activity that is resulting in unusually slow response time.
4. Copy the profile for that action. When deciding which profiles to copy, look for the links that took a long time to respond. If a single page is slow, only that profile is necessary. If Confluence is generally or intermittently slow, copy all profiles logged during the slowdown until a reasonable sample has been collected.
5. If you were instructed to profile your instance by Atlassian technical support, attach all relevant profiles to your support ticket.

6. Turn profiling off again, using either of the methods described above.

7. Confirm that profiles are no longer being printed to the Confluence log file.

**Example of a Profile**

Below are the first few lines of a normal profile for accessing a page called Confluence Overview.

```plaintext
[344ms] - /display/ds/Confluence+Overview
[313ms] - SiteMesh: parsePage:
http://localhost:8080/display/ds/Confluence+Overview
[313ms] - XW Interceptor: Before defaultStack:
/pages/viewpage.action (ViewPageAction.execute())

[0ms] - SpaceAwareInterceptor.intercept()
[16ms] - PageAwareInterceptor.intercept()

[0ms] - AOP: PageManager.getPage()
[16ms] - AOP: PermissionManager.hasPermission()

[0ms] - AOP: SpacePermissionManager.hasPermission()
[16ms] - AOP: SpacePermissionManager.hasPermission()

[0ms] - AOP: SpacePermissionManager.hasPermission()

[0ms] - AOP: SpacePermissionManager.hasPermission()

[281ms] - XW Interceptor: After defaultStack:
/pages/viewpage.action (ViewPageAction.execute())

[281ms] - XW Interceptor: After validatingStack:
/pages/viewpage.action (ViewPageAction.execute())...
```

Notice that each indented line is a recursive call that rolls up into the parent line. In the example above, the Confluence Overview page takes 344ms. Part of that, 313ms, is spent in sitemesh.

**Start Confluence with Profiling Enabled**

There may be some situations where you may wish to have Confluence profiling enabled during startup. This may be useful if you restart often and may forget to enable profiling for Support/Trouble-shooting purposes.

Edit the file `CONFLUENCE_HOME/confluence/WEB-INF/web.xml`. You should see a stanza similar to the one below. Set the parameter value for `autostart` to `true`:

```xml
<Parameter name="com.atlassian.wb.autostart" value="true" />
```
Remember to turn it back to **false** or your logs will grow very large.

**Identifying Slow Performing Macros**

**Page Profiling** gives good detail on what operations are slow in a page load. In addition, you can add debug level logging:

**Version 3.1 and Later**

Set the package name `com.atlassian.renderer.v2.components.MacroRendererComponent` to `DEBUG` in Administration >> Logging and Profiling.

Prior to version 3.1

Download WikiMarkupParser.class, available from the attachments to this page. This will result in logs like:
To add the class:

1. Add this line to the file `<confluence-install>/confluence/WEB-INF/classes/log4j.properties`:
   
   ```
   log4j.logger.com.atlassian.renderer=DEBUG
   ```

2. Add the appropriate `WikiMarkupParser.class` to `/confluence/WEB-INF/classes/com/atlassian/renderer/v2`. You'll have to make the renderer and v2 folders.

In combination with page profiling, this should give good specifics on the amount of time various plugins take. You can also use this utility to Search Confluence for Uses of a Macro.

**Resolution**

Experiment with the tips from the performance tuning page, or open an enhancement request about the specific macro. In some instances there is no resolution - you'll just be aware of the overhead of various macros.

**Compressing an HTTP Response within Confluence**

Confluence supports HTTP GZip transfer encoding. This means that Confluence will compress the data it sends to the user, which can speed up Confluence over slow or congested Internet links, and reduce the amount of bandwidth consumed by a Confluence server.

Turn on Confluence’s GZip encoding if:

- Users are accessing Confluence over the Internet, or a WAN connection with limited bandwidth.
- You wish to reduce the amount of data transfer between the Confluence server and client.

If you are accessing Confluence over a Local Area Network or over a particularly fast WAN, you may wish to leave GZip encoding disabled. If the network is fast enough that transferring data from Confluence to the user isn’t a limiting factor, the additional CPU load caused by compressing each HTTP response may slow Confluence down.

**Enabling HTTP Compression**

1. Choose the cog icon and then choose General Configuration under Confluence Administration.
2. Select ‘General Configuration’ in the left-hand panel.
3. Enable **Compress HTTP Responses**.

It is possible to configure which types of content are compressed within Confluence. By default, the following mime types will be compressed:

- text/html
- text/javascript
- text/css
- text/plain
- application/x-javascript
- application/javascript

If you wish to change the types of content to be compressed, add a replacement `urlrewrite-gzip-default.xml` file within the `WEB-INF/classes/com/atlassian/gzipfilter/` directory in your Confluence Installation Directory. A sample file is provided as an attachment. It is unlikely that you will need to alter this file.

**Garbage Collector Performance Issues**

- **Use a small heap**

  Keep your heap as small as possible, without the instance experiencing OutOfMemory errors. If you experience OutOfMemory errors and need to increase this, we recommend you do it in 512mb or 1gb allotments, and monitor the instance. If you continue to receive OutOfMemory errors, increase the heap by another 512mb or 1gb, and continue this process until you are operating stably with no OutOfMemory errors. Do not increase the heap further than required, as this will result in longer garbage collections.

- **Remove any old tuning parameters**

  On every full GC, the JVM will resize the allocations of Eden, Survivor etc based on the throughput it is actually seeing. It will tune itself based on the real world data of the objects that are being created and collected. Most of the time simply allowing JVM to tune itself will give you better performance.

  If you have added JVM parameters in the past and are experiencing difficulties with GC now, we'd recommend you remove all GC related parameters, unless you added them to solve a specific problem, and they did in fact solve that problem. You should also consider re-benchmarking now to ensure that they are still solving that problem, and are not causing you any other issues.

- **Check your VM resources**

  If you run Confluence on a VM, check that is it not using the swap file. If it does, when the JVM garbage collects it has to load the objects from the swap file into memory to clean them, and this can cause significantly longer GC pauses. Instead of using swapping, ballooning and bursting, allocate adequate memory to the VM.

- **Manual Tuning**

  If you find you are still experiencing difficulties with GC after following these recommendations and you would like to see if you can tune the JVM better to improve performance, we recommend following the instructions in our Garbage Collection (GC) Tuning Guide. This document will take you through the process of choosing performance goals (throughput/footprint/latency), and how to tune for those goals.

- **Viewing your GC logs**

  Enable Garbage Collection Logging, and use a tool like Chewiebug's GCViewer to view the resulting logs.

**Cluster Troubleshooting**

This page covers troubleshooting for a clustered installation of Confluence.
Symptoms

Below is a list of potential problems with a Confluence cluster, and their likely solutions. The solutions are listed below.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Likely solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database is being updated by an instance which is not part of the current cluster errors on a stand-alone</td>
<td>‘Database is being updated by an instance which is not part of the current cluster’ Error Message</td>
</tr>
<tr>
<td>Database is being updated by an instance which is not part of the current cluster errors on a cluster</td>
<td>Add multicast route, Check firewall, Cluster Panic due to Multiple Deployments</td>
</tr>
<tr>
<td>Cannot assign requested address on startup, featuring an IPv6 address</td>
<td>Prefer IPv4</td>
</tr>
<tr>
<td>Error in log: The interface is not suitable for multicast communication</td>
<td>Change multicast interface, Add multicast route</td>
</tr>
<tr>
<td>Multicast being sent, but not received</td>
<td>Check firewall, Check intermediate routers, Increase multicast TTL</td>
</tr>
<tr>
<td>Add-on is unlicensed on some nodes after updating the license on one node.</td>
<td>Disable and re-enable the add-on in the Universal Plugin Manager.</td>
</tr>
<tr>
<td>After a add-on update, strings appear in the UI instead of buttons and icons on some nodes.</td>
<td>Restart the affected node.</td>
</tr>
<tr>
<td>Any issue not covered here</td>
<td>Contact support</td>
</tr>
</tbody>
</table>

Multicast

- Which multicast address?

The multicast address and port used by Confluence can be found on the Cluster Configuration page, or in confluence.cfg.xml in the Confluence home directory.

- Multicast address generation.

Confluence uses a hashing algorithm to take the inputted name during setup and it is then turned into a multicast address stored in the config file. Thus, once the initial setup is completed, Confluence will use the address this is the reason why user can change the address if needed, without actually changing the name. Consequently the additional nodes using the same multicast address specified in the config file are able to join the cluster.

Each node has a multicast address configured in the confluence-cfg.xml file

```xml
name="confluence.cluster.address">xxx.xx.xxx.xxx</property>
```

A warning message is displayed when an user changes the address from the one that Confluence has generated by the hashing of the name. There is no way of eliminating the message any other way other than by returning the address to the one that matches the cluster name. Purpose of the warning message is to remind...
the user that the address has been changed - as it is not the hashed version any longer - consequently the node can not join the cluster just by using the name. It is also necessary to provide the correct address as well.

Mapping interface to IP address.

To ensure that the interface name is mapped correctly, the following tool can be used. It shows the mapping of the interface name to the IP address.

```csharp
C:\>java -jar list-interfaces.jar
interfaces.size() = 4
  networkInterface[0] = name:lo (MS TCP Loopback interface) index: 1
    addresses: /127.0.0.1;
  networkInterface[1] = name:eth0 (VMware Virtual Ethernet Adapter for VMnet8) index: 2
    addresses: /192.168.133.1;
  networkInterface[2] = name:eth1 (VMware Virtual Ethernet Adapter for VMnet1) index: 3
    addresses: /192.168.68.1;
  networkInterface[3] = name:eth2 (Broadcom NetXtreme 57xx Gigabit Controller - Packet Scheduler Miniport) index: 4
    addresses: /192.168.0.101;
```

Debugging tools

Listed below are some debugging tools that help determine what the status of the multicast traffic is:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Information provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>netstat -gn</td>
<td>Lists multicast groups. Does not work on Mac OS X.</td>
</tr>
<tr>
<td>netstat -rn</td>
<td>Lists system routing table.</td>
</tr>
<tr>
<td>tcpdump -i interface</td>
<td>Captures network traffic on the given interface. Most useful on an interface that only receives cluster traffic.</td>
</tr>
</tbody>
</table>

Add multicast route

Multicast networking requirements vary across operating systems. Some operating systems require little configuration, while some require the multicast address to be explicitly added to a network interface before Confluence can use it. If multicast traffic can't be sent or received correctly, adding a route for multicast traffic on the correct interface will often fix the problem. The example below is for a Ubuntu Linux system:

```shell
route add -net 224.0.0.0 netmask 240.0.0.0 dev eth0
```

To support multiple applications using multicast on different interfaces, you may need to specify a route specific to the Confluence multicast address.

Check firewall

Ensure your firewall allows UDP traffic on the multicast address and port used by Confluence.

Prefer IPv4

There are known issues relating to IPv6. You should configure your JVM to try binding to an IPv4 address first.
Change multicast interface

Confluence might have selected the incorrect interface for multicast traffic, which means it cannot connect to other nodes in the cluster. To override the interface used for multicast traffic after initial setup, edit the `confluence.cluster.interface` property in `<local-home>/confluence.cfg.xml` and specify the network interface. For example to tell Confluence to use `eth1`:

```
<property name="confluence.cluster.interface">eth1</property>
```

Overriding Hazelcast Configuration

If the solution to your problem involves changes to the Hazelcast configuration, these changes should not be made to the Confluence configuration files. Instead, to ensure your configuration survives upgrades, make your changes by creating a Hazelcast override file.

Increase multicast TTL

The multicast time-to-live (TTL) specifies how many hops a multicast packet should be allowed to travel before it is discarded by a router. It should be set to the number of routers in between your clustered nodes: 0 if both are on the same machine, 1 if on two different machines linked by a switch or cable, 2 if on two different machines with one intermediate router, and so on.

To increase the multicast TTL by edit the `confluence.cluster.ttl` property in the `<local home>/confluence.cfg.xml` file on each node. For example to set the TTL to 3:

```
<property name="confluence.cluster.ttl">3</property>
```

Check intermediate routers

Advanced switches and routers have the ability to understand multicast traffic, and route it appropriately. Unfortunately sometimes this functionality doesn't work correctly with the multicast management information (IGMP) published by the operating system running Confluence.

If multicast traffic is problematic, try disabling advanced multicast features on switches and routers in between the clustered nodes. These features can prevent multicast traffic being transmitted by certain operating systems.

Didn't find a solution?

Check Related Articles from the Confluence Knowledge Base

- "Exception bootstrapping cluster:Shared home directory is not configured correctly" Error during Confluence Data Center startup
- Hazelcast CANNOT start on this node. No matching network interface found.
- Recovering from a Data Center cluster split-brain
- Cluster Panic due to Multicast Traffic Communication Problem
- Cannot find "external_id" column when trying to upgrade to a Confluence CDC license after upgrading from a pre-5.5 Confluence Clustered installation
- How to Supress Cluster Warning Message in The Confluence Log Files
- Configuration of Confluence Cluster Fails with 'Cannot assign requested address'

Contact Atlassian support

We have dedicated staff on hand to support your installation of Confluence. Please follow the instructions for raising a support request and mention that you're having trouble setting up your Confluence cluster.

Data Collection Policy
Why does Confluence collect usage data?

We’re proud that Confluence is one of the most versatile collaboration tools on the planet, and we will continue to deliver innovative new features as quickly as we can. In order to prioritize the features we deliver, we need to understand how our customers use Confluence, what's important, what's not, and what doesn't work well. The collection of usage data allows us to measure the user experience across many thousands of users and deliver features that matter.

What data is collected?

The type of data we collect is covered in our Privacy Policy. Please read it - we've tried to avoid legal jargon and made it as straightforward as possible.

To view a sample of data that might be collected from your specific installation, go to General Configuration > Analytics.

Data is always collected in Confluence Cloud.

How is data collected from Confluence?

Older versions of Confluence (prior to Confluence 5.6 or Confluence Questions 1.0.618) didn’t collect usage data. Analytics are collected using the Atlassian Analytics add-on. The add-on collects analytics events in a log file which is located in <confluence-home>/analytics-logs. The logs are periodically uploaded using an encrypted session and then deleted. If Confluence is unable to connect to the Internet, no logs are ever uploaded.

Enabling/disabling data collection in Confluence

You can turn off analytics collection at any time. Go to General Configuration > Analytics.

Confluence Installation and Upgrade Guide

About the Installation and Upgrade Guide

This guide covers how to install and upgrade Confluence.

Information on the features and changes in specific Confluence releases can be found in the Confluence Release Notes.

For information on using and administering Confluence refer to the Confluence User’s Guide and Confluence Administrator’s Guide.

• System Requirements
  • Server Hardware Requirements Guide
  • Example Size and Hardware Specifications From Customer Survey
  • Running Confluence in a Virtualised Environment
• Confluence Installation Guide
  • Installing Confluence
  • Installing the Confluence EAR-WAR Edition
  • Installing Confluence Data Center
  • Creating a Dedicated User Account on the Operating System to Run Confluence
• Confluence Setup Guide
  • Configuring JIRA Integration in the Setup Wizard
• Upgrading Confluence
  • Upgrading Beyond Current Licensed Period
  • Confluence Post-Upgrade Checks
  • Upgrading Confluence EAR-WAR

Downloads

Download the Confluence documentation in PDF format.

Other Resources

Confluence Release Notes
Confluence User’s Guide
Confluence Administrator’s Guide
Confluence Knowledge Base
Atlassian Answers
System Requirements

Confluence works with a broad range of operating systems, database systems and application servers. Provided you have the technical knowledge, it is very likely that you will be able to run Confluence with an 8-year-old database or even on some 8-year-old hardware. Realistically, it is not technically feasible for us to provide our legendary support service on all environments available. There can only be a finite number of platforms and release versions of those that we support.

Our rule of thumb when releasing a new version of Confluence is that we will officially support platforms that have been released within the last one to two years (or the latest version of that platform if no new version of it was released in that period). This does not necessarily mean that you will need to upgrade your database or application server every time you upgrade Confluence. However, if you do run into problems with an unsupported version of a database or application server, we may have to ask you to upgrade to something newer.

Please refer to our Supported Platforms topic for details on platforms that we currently support in this version of Confluence and our Supported Platforms FAQ topic for details on our support handling procedures.

Confluence Software Requirements

Please read the Supported Platforms page for Confluence. That page contains a list of specific software that Confluence will work with.

Operating Systems

Atlassian supports the operating systems listed on the Supported Platforms page.

If you would like to run Confluence on virtualised hardware, please read our Running Confluence in a Virtualised Environment document first.

Application Servers

An application server is required to run Confluence. Apache Tomcat is bundled with the distribution. Atlassian only supports the application servers listed on the Supported Platforms page, provided they are running on Windows, Linux, or Solaris. If you are using a different application server or earlier version, we may ask you to migrate to one of the supported application servers before we can provide you with further
Databases

A database is required to run Confluence. Atlassian supports the databases listed on the Supported Platforms page.

When evaluating Confluence, you can use the embedded database included in the Confluence installation.

When moving to a production installation, you must set up an external database server. If you have no preference for a particular database, we highly recommend using PostgreSQL. This is a scalable, robust and free database server that is also easy to set up. For database setup information, please refer to Database Configuration.

Java

Confluence requires the Java Runtime Environment (JRE) installed.

If using the zip or archive distribution of Confluence, you will need to install a supported JRE. The automated installer bundles Java and will install this for you.

For instructions on installing the JRE for Windows and Linux/Solaris, please refer to Installing Java for Confluence.

Please Note: Impact of Antivirus Software

The presence of antivirus software on your operating system running Confluence greatly decreases the performance of Confluence. Antivirus software that intercepts access to the hard disk is particularly detrimental and may even cause errors in Confluence.

You should configure your antivirus software to ignore the following directories:

- Confluence home directory
- Confluence's index directory
- All database-related directories

⚠️ This recommendation above is particularly important if you are running Confluence on Windows. No matter how fast your hardware is, antivirus software will almost always have a negative impact on Confluence's performance and may render Confluence impossible to use.

Confluence Hardware Requirements

Please be aware that while some of our customers run Confluence on SPARC-based hardware, Atlassian only officially supports Confluence running on x86 hardware and 64-bit derivatives of x86 hardware.

See Server Hardware Requirements Guide for details.

Refer also to the tips on reducing out of memory errors, in particular the section on Permanent Generation Size.

Hosted Solutions – Confluence Cloud

If you do not have the resources to set up and maintain a Confluence installation locally, consider Confluence Cloud. Atlassian can run and maintain your installation of Confluence, handling all the testing, monitoring and upgrading processes for you.

Server Hardware Requirements Guide

Server administrators can use this guide in combination with the free Confluence trial period to evaluate their server hardware requirements. Because server load is difficult to predict, live testing is the best way to determine what hardware a Confluence instance will require in production.

Peak visitors are the maximum number of browsers simultaneously making requests to access or update pages in Confluence. Visitors are counted from their first page request until the connection is closed and if public access is enabled, this includes internet visitors as well as logged in users. Storage requirements will vary depending on how many pages and attachments you wish to store inside Confluence.
Minimum hardware requirements

The values below refer to the minimum available hardware required to run Confluence only, eg the minimum heap size to allocate to Confluence is 512mb. You will need additional physical hardware, of at least the minimum amount required by your Operating System, and any other applications that run on the server. Also please note that these are a guide only, and your configuration may require more.

On small instances, server load is primarily driven by peak visitors.

5 Concurrent Users
- 2GHz+ CPU
- 512MB RAM
- 5GB database space

25 Concurrent Users
- Quad 2GHz+ CPU
- 2GB+ RAM
- 10GB database space

Note: Please be aware that while some of our customers run Confluence on SPARC-based hardware, Atlassian only officially supports Confluence running on x86 hardware and 64-bit derivatives of x86 hardware. Confluence typically will not perform well in a tightly constrained, shared environment - examples include an AWS micro.t1 instance. Please be careful to ensure that your choice of hosting platform is capable of supplying sustained processing and memory capacity for the server, particularly the processing-intense startup process.

Example hardware specifications

These are example of hardware specifications for non-clustered Confluence instances used by our customers. The amount of RAM refers to the total memory allocated to the JVM, while blank settings indicate that the information was not provided.

<table>
<thead>
<tr>
<th>Accounts</th>
<th>Spaces</th>
<th>Pages</th>
<th>CPUs</th>
<th>CPU (GHz)</th>
<th>RAM (MB)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>150</td>
<td>30</td>
<td>1,000</td>
<td>1</td>
<td>2.6</td>
<td>1,024</td>
<td></td>
</tr>
<tr>
<td>350</td>
<td>100</td>
<td>15,000</td>
<td>2</td>
<td>2.8</td>
<td>1,536</td>
<td></td>
</tr>
<tr>
<td>5,000</td>
<td>500</td>
<td>16,000</td>
<td>4</td>
<td>3</td>
<td>2,048</td>
<td></td>
</tr>
<tr>
<td>10,000</td>
<td>350</td>
<td>16,000</td>
<td>2</td>
<td>3.8</td>
<td>2,048</td>
<td></td>
</tr>
<tr>
<td>10,000</td>
<td>60</td>
<td>3,500</td>
<td>2</td>
<td>3.6</td>
<td>4,096</td>
<td></td>
</tr>
<tr>
<td>21,000</td>
<td>950</td>
<td></td>
<td>2</td>
<td>3.6</td>
<td>4,096</td>
<td></td>
</tr>
<tr>
<td>85,000</td>
<td>100</td>
<td>12,500</td>
<td>4</td>
<td>2.6</td>
<td>4,096</td>
<td>3 machines total: application server, database server, Apache HTTPD + LDAP tunnel server. See Accenture's slides and video for full details (That link isn't working, but the slides can be found here)</td>
</tr>
</tbody>
</table>
**Server load and scalability**

When planning server hardware requirements for your Confluence deployment, you will need to estimate the server scalability based on peak visitors, the editor to viewer ratio and total content.

- The editor to viewer ratio is how many visitors are performing updates versus those only viewing content
- Total content is best estimated by a count of total spaces

Confluence scales best with a steady flow of visitors rather than defined peak visitor times, few editors and few spaces. Users should also take into account:

- Total pages is not a major consideration for performance. For example, instances hosting 80K of pages can consume under 512MB of memory
- Always use an external database, and check out the performance tuning guides.

**Maximum reported usages**

These values are largest customer instances reported to Atlassian or used for performance testing. Clustering, database tuning and other performance tuning is recommended for instances exceeding these values.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Most Spaces</td>
<td>1700</td>
</tr>
<tr>
<td>Most Internal Users</td>
<td>15K</td>
</tr>
<tr>
<td>Most LDAP Users</td>
<td>100K</td>
</tr>
<tr>
<td>Most Pages</td>
<td>80K</td>
</tr>
</tbody>
</table>

**Hard disk requirements**

All page content is stored in the database, while attachments use either the database or file system. For example, the wiki instance you are reading now uses approximately 2.8 GB of database space and 116 GB of disk space. The more attachments you have, the more disk space you will require.

**Private and public comparison**

Private instances manage their users either internally or through a user repository such as LDAP, while online instances have public signup enabled and must handle the additional load of anonymous internet visitors.

Please keep in mind that these are examples only, not recommendations:

<table>
<thead>
<tr>
<th>Use Case</th>
<th>Spaces</th>
<th>User Accounts</th>
<th>Editors</th>
<th>Editor To Viewer Ratio</th>
<th>Pages</th>
<th>Page Revisions</th>
<th>Attachments</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Documentation</td>
<td>140</td>
<td>11,500</td>
<td>1,000</td>
<td>9%</td>
<td>8,800</td>
<td>65,000</td>
<td>7,300</td>
<td>11,500</td>
</tr>
<tr>
<td>Private Intranet</td>
<td>130</td>
<td>180</td>
<td>140</td>
<td>78%</td>
<td>8,000</td>
<td>84,000</td>
<td>3,800</td>
<td>500</td>
</tr>
</tbody>
</table>
Professional assistance

For large instances, it may be worthwhile contacting an Atlassian Expert for expertise on hardware sizing, testing and performance tuning. Simply contact a local Expert directly or email our Experts team for a recommendation.

Example - https://confluence.atlassian.com/

Here is a breakdown of the disk usage and memory requirements for this wiki, as at April 2013:

<table>
<thead>
<tr>
<th>Data</th>
<th>Relevant Table</th>
<th>Rows</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment metadata</td>
<td>attachments</td>
<td>193903</td>
<td>60 MB</td>
</tr>
<tr>
<td>Content and user properties</td>
<td>os_propertyentry (?)</td>
<td>639737</td>
<td>255 MB</td>
</tr>
<tr>
<td>Content bodies (incl. all versions of blogs, pages and comments)</td>
<td>bodycontent</td>
<td>517520</td>
<td>1354 MB</td>
</tr>
<tr>
<td>Content metadata (incl. title, author)</td>
<td>content</td>
<td>623155</td>
<td>459 MB</td>
</tr>
<tr>
<td>Labels</td>
<td>label (5982, 1264 kB), content_label (134151, 46 MB)</td>
<td>140133</td>
<td>47.2 MB</td>
</tr>
<tr>
<td>Users</td>
<td>users</td>
<td>38766</td>
<td>6200 kB</td>
</tr>
</tbody>
</table>

Note: not all database tables or indexes are shown, and average row size may vary between instances.

Size of selected home directory components

<table>
<thead>
<tr>
<th>Data</th>
<th>Files</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments (incl. all versions)</td>
<td>207659</td>
<td>105 GB</td>
</tr>
</tbody>
</table>

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### Example Size and Hardware Specifications From Customer Survey

Below are the results of a survey conducted by Atlassian in July 2007, showing some capacity statistics for Confluence users. The figures are broken down by industry and number of users.

<table>
<thead>
<tr>
<th>Num Users</th>
<th>Length of time in production</th>
<th>Database</th>
<th>Application Server</th>
<th>Num CPUs/Cores</th>
<th>Physical Memory/RAI</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Banking/Finance</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26 - 50</td>
<td>3-6 Months Ago</td>
<td>Microsoft SQL Server</td>
<td>Confluence distribution/Apache Tomcat</td>
<td>2</td>
<td>2G</td>
</tr>
<tr>
<td>26 - 50</td>
<td>2 Years Ago</td>
<td>Sybase ASE</td>
<td>Weblogic</td>
<td>&gt;8</td>
<td>&gt;16G</td>
</tr>
<tr>
<td>51 - 250</td>
<td>3-6 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution/Apache Tomcat</td>
<td>2</td>
<td>4G</td>
</tr>
<tr>
<td>501 - 1,000</td>
<td>3-6 Months Ago</td>
<td>Microsoft SQL Server</td>
<td>Websphere</td>
<td>2</td>
<td>2G</td>
</tr>
<tr>
<td>1,001 - 5,000</td>
<td>3-6 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution/Apache Tomcat</td>
<td>2</td>
<td>4G</td>
</tr>
<tr>
<td>1,001 - 5,000</td>
<td>2 Years Ago</td>
<td>Oracle</td>
<td>Websphere</td>
<td>4</td>
<td>&gt;16G</td>
</tr>
<tr>
<td>5,001 - 10,000</td>
<td>10-12 Months Ago</td>
<td>Microsoft SQL Server</td>
<td>Confluence distribution/Apache Tomcat</td>
<td>4</td>
<td>16G</td>
</tr>
<tr>
<td><strong>Education</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-25</td>
<td>2 Years Ago</td>
<td>DB2</td>
<td>Confluence distribution/Apache Tomcat</td>
<td>2</td>
<td>2G</td>
</tr>
<tr>
<td>26 - 50</td>
<td>10-12 Months Ago</td>
<td>MySQL</td>
<td>Confluence distribution/Apache Tomcat</td>
<td>2</td>
<td>2G</td>
</tr>
<tr>
<td>51 - 250</td>
<td>&lt;3 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution/Apache Tomcat</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
Running Confluence in a Virtualised Environment
This page provides pointers for things to look at when running Confluence on virtualised hardware.

Summary
Running Confluence in a virtual machine (VM) requires specialised skills to set up and manage the virtualised environment. In particular, the performance of Confluence can be affected by the activity of other VMs running on the same infrastructure, as well as how you configure the Confluence VM itself.

Atlassian supports running Confluence and Confluence Data Center in a virtualised environment, but we cannot offer support for problems which are related to the environment itself.
Recommendations

The following recommendations come from our experience in running and testing Confluence in virtualised environments like VMWare and KVM, and our experience in working with customers running on these platforms.

- **Know your platform.** Consult the documentation for your operating system and your chosen virtualisation technology, for details on setting up a reliable VM (virtual machine) image.
- **Allocate enough memory.** As a Java web application, Confluence requires a relatively large memory allocation, compared to some other web technologies. Ensure that your VM images have enough physical memory allocated to run Confluence without swapping.
- **Handle high I/O.** Under normal usage, Confluence requires a significant number of input/output (I/O) operations to the database and home directory for each web request. Ensure that you use the correct drivers and consider how you make storage available to your VMs to optimise this access.
- **Handle peak CPU and memory usage.** For certain operations (including PDF export, Office document processing, and displaying large pages) Confluence requires a significant amount of CPU and memory. Ensure that your virtualisation infrastructure has the flexibility and capacity to deal with peak load, not just idle load.
- **Synchronise time correctly.** Some customers have had problems with time synchronisation between the VM and the host system. This causes problems in Confluence due to irregularities in the execution of scheduled tasks. We strongly recommend checking your VM time sync if you have issues with scheduled tasks in a virtualised environment.

Further help

For further assistance in setting up a virtualised environment for running Confluence, you may want to consult an **Atlassian Expert.** Several experts have experience with installation and performance tuning, and can help you with your Confluence configuration.

**Confluence Installation Guide**

Prerequisites

Before beginning to install Confluence, please check that:

- Your system meets the [minimum system requirements](#) to run Confluence.
- This version of the Confluence documentation matches the version of Confluence that you are installing. The Confluence documentation version you are currently viewing is indicated toward the top of the page tree on the left or in the 'breadcrumb trail' in the top banner of this page. If you need to access a different version of the Confluence documentation, use the control at the top of the page tree on the left or you can access it from the [documentation home page](#).

If you have chosen a package that includes add-ons such as Team Calendars or the SharePoint Connector you will need to install these from within Confluence after your setup is complete. See [Finding new add-ons](#) for information on how to find and install the add-ons.

Choose the Confluence Installation Type

Choose the type of Confluence installation you'd like from the table below, and follow the link(s) to the installation instructions.

<table>
<thead>
<tr>
<th>Installation Type</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2014 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](#).
• Installing Confluence on Windows
• Installing Confluence on Linux

Install Confluence via the Atlassian installer. This is the easiest method of installing Confluence.

This is the best option for evaluators.

• Installing from a Zip File on Windows
• Installing From an Archive File on Linux

This option requires you to manually carry out installing the files and configuring system properties.

Use this option if there is no specific installer for your operating system.

<table>
<thead>
<tr>
<th>EAR/WAR distribution (Zip Archive)</th>
<th>This distribution allows you to deploy Confluence onto your own existing application server, instead of the Apache Tomcat server bundled with the regular distribution.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confluence Clusters (Zip Archive)</td>
<td>Confluence Data Center is a clustered solution for large enterprises. Please read the Confluence Data Center Technical Overview to find out if Confluence Data Center is right for your organisation.</td>
</tr>
</tbody>
</table>

Please read Running Confluence in a Virtualised Environment if you are interested in running Confluence in a virtual machine.

If you wish to upgrade Confluence, see Upgrading Confluence.

Installing Confluence

Choose the type of Confluence installation you'd like from the table below and follow the link to the installation instructions. When you have finished the installation phase, you will be prompted to start the setup phase.

<table>
<thead>
<tr>
<th>Installation Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| • Installing Confluence on Windows
• Installing Confluence on Linux | Install Confluence via the Atlassian installer. This is the easiest method of installing Confluence. 

This is the best option for evaluators. |

• Installing from a Zip File on Windows
• Installing From an Archive File on Linux | This option requires you to manually carry out installing the files and configuring system properties. 

Use this option if there is no specific installer for your operating system. |

If you have not already done so, please verify that this version of the Confluence documentation matches that of the Confluence version you are installing. The Confluence documentation version you are currently viewing is indicated toward the top of the page tree on the left or in the 'breadcrumb trail' in the top banner of this page. If you need to access a different version of the Confluence documentation, use the control at the top of the page tree on the left or you can access it from the documentation home page.

Take me back to the Confluence Installation Guide.

Installing Confluence on Windows

This guide describes how to install a new Confluence installation on Windows using the automated 'Windows Installer'. You can also install Confluence from a 'zip' archive — see Installing Confluence on Windows from Zip File for details.

If you are upgrading Confluence, please refer to the Upgrading Confluence guide.

⚠️ Please Note:

• Some anti-virus or other Internet security tools may interfere with the Confluence installation process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence installation.

• Before you begin installing Confluence, please read the System Requirements page and check the Database Configuration documentation for any specific requirements related to your chosen database.
Using the Installation Wizard

Use the installation wizard if you are installing Confluence on your server for the first time or you wish to specify your installation options.

If you have previously installed Confluence using the installation wizard and wish to re-install Confluence again with the same installation options, you can re-install Confluence in ‘unattended mode’ without any user input required (see below for details).

1. Download and Run the Confluence 'Windows Installer'

To install Confluence as a service, the Windows Installer must be run using a Windows administrator account. While you can run the Windows Installer with a non-administrator account, your installation options will be much more limited.

1. Download the Confluence 'Windows Installer' (.exe) file from the Confluence Download page.
2. Run the installer file to start the installation wizard.

   If a Windows 7 (or Vista) ‘User Account Control’ dialog box requests if you want to allow the installation wizard to make changes to your computer, click ‘Yes’. If you do not, the installation wizard will have restricted access to your operating system and any subsequent installation options will be limited.
3. Choose between the ‘Express Install’ or ‘Custom Install’ options:
   a. Express Install — If you choose this option, Confluence will be installed with default settings which are shown in the next step of the installation wizard. If you want to customise any of these options, click the ‘Back’ button and choose the ‘Custom Install’ option instead.
   b. Custom Install — If you choose this option, Confluence will prompt you to specify the following options (which are presented during subsequent steps of the installation wizard and pre-populated with default values):
      • The ‘Destination Directory’ in which to install Confluence.
      • The Confluence Home and other important directories (which must be unique for each Confluence installation).
      • The Windows ‘Start’ menu folder options.
      • The TCP ports (i.e. an HTTP connector port and a control port) that Confluence will operate on.
      • If you are running the installer using an administrator account, you will be prompted to ‘Install Confluence as a service’ (recommended). You can also do this manually later, as described in Start Confluence Automatically on Windows as a Service.

    If you installed Confluence as a service, you must start Confluence through the Windows ‘Start’ menu, since Confluence will not start if you run start-confluence.bat at the Windows Command Prompt.
4. The installation wizard will install Confluence onto your operating system and will start Confluence automatically when the wizard finishes. Confluence will also be launched automatically in your browser window if you chose this option.

Please Note:

- If you chose to install Confluence as a service, the Confluence service will be run as the Windows 'SYSTEM' user account. To change this user account, see Changing the Windows user that the
Confluence service uses.

- If you do not install Confluence as a service, then once started, Confluence will be run as the Windows user account under which Confluence was installed.
- If you use Confluence running on a Windows Server in production, we strongly recommend creating a dedicated user account (e.g. with username 'confluence') for running Confluence.
  - For more information about creating a dedicated user account and defining which directories this account should have write access to, refer to our guidelines.
  - If your Windows Server is operating under Microsoft Active Directory, ask your Active Directory administrator to create a dedicated user account that you can use to run Confluence (with no prior privileges).
- If Confluence is installed as a service, do not forget to change the user account that runs the Confluence service to your dedicated user account for running Confluence.

2. Starting Confluence

If Confluence is not already started, you can start Confluence using the appropriate Windows 'Start' menu shortcut or command prompt option.

Once Confluence is started, you can access Confluence from the appropriate Windows 'Start' menu shortcut or a browser on any computer with network access to your Confluence server.

2.1 Windows 'Start' Menu Shortcuts

The Installer will have created the following Windows 'Start' menu shortcuts:

- **Access Confluence** — opens a web browser window to access your Confluence application.
  - Your Confluence server must have been started for this shortcut to work.

- **Start Confluence Service** — starts up the Apache Tomcat application server which runs your Confluence installation, so that you can access Confluence through your web browser.

- **Stop Confluence Service** — stops the Apache Tomcat application server which runs your Confluence installation. You will not be able to access Confluence through your web browser after choosing this shortcut.

- **Uninstall Confluence** — uninstalls Confluence from your Windows operating system.

2.2 Starting and Stopping Confluence from a Command Prompt

Enter the bin subdirectory of your Confluence installation directory and run the appropriate file:

- **start-confluence.bat** (to start Confluence)
- **stop-confluence.bat** (to stop Confluence)

If you followed our guidelines for running Confluence with a dedicated user account, then to run Confluence as this user account (e.g. 'confluence'), use the runas command to execute start-confluence.bat. For example:

```
> runas /env /user:<DOMAIN>\confluence start-confluence.bat
```

(where <DOMAIN> is your Windows domain or computer name.)

2.3 Accessing Confluence from a Browser

You can access Confluence from any computer with network access to your Confluence server by opening a supported web browser on the computer and visiting this URL:

```
http://<computer_name_or_IP_address>:<HTTP_port_number>
```

where:

- `<computer_name_or_IP_address>` is the name or IP address of the computer on which Confluence is installed and
- `<HTTP_port_number>` is the HTTP port number specified when you installed Confluence (above).

If Confluence does not appear in your web browser, you may need to change the port that Confluence runs on.

3. Run the Setup Wizard

See the Confluence Setup Guide.
4. Next Steps

- See Confluence 101.
- If you did not install Confluence as a service, you will need to start Confluence manually every time you restart your computer. To change your Confluence installation to run as a service, please see Start Confluence Automatically on Windows as a Service.
- To get the most out of Confluence, please see Performance Tuning.

Performing an Unattended Installation

If you have previously installed Confluence using the installation wizard (above), you can use a configuration file from this Confluence installation (called response.varfile) to re-install 'unattended mode' without any user input required.

Installing Confluence in unattended mode saves you time if your previous Confluence installation was used for testing purposes and you need to install Confluence on multiple server machines based on the same configuration.

⚠️ Please Note:

- The response.varfile file contains the options specified during the installation wizard steps of your previous Confluence installation. Hence, do not uninstall your previous Confluence installation just yet.
- If you intend to modify the response.varfile file, please ensure all directory paths specified are absolute, for example, sys.installationDir=C:\\Program Files\\Atlassian\\Confluence

Unattended installations will fail if any relative directory paths have been specified in this file.

Download and Run the Confluence 'Windows Installer' in Unattended Mode

1. Download the Confluence 'Windows Installer' (.exe) file from the Confluence Download Center to a suitable location.
2. Open the Windows command prompt and perform the remaining steps in the command prompt.
3. copy the response.varfile file located in the .install4j subdirectory of your previous Confluence installation directory, to the same location as the downloaded 'Windows Installer' file.
   You can uninstall your previous Confluence installation after this step. Save your response.varfile if you need to install Confluence on multiple machines.
4. Change directory (cd) to the location of the 'Windows Installer' file and run the following command:

   atlassian-confluence-X.Y.exe -q -varfile response.varfile

Where:
- X.Y — refers to the version of Confluence you are about to install.
- -q — instructs the installer to operate in unattended mode (i.e. 'quietly').
- -varfile response.varfile — specifies the configuration file containing the configuration options used by the installer. The location and name of the configuration file should be specified after the -varfile option.
5. Confluence will start automatically when the silent installation finishes. Continue from step 2 Starting Confluence (above).

Installing Confluence on Windows from Zip File

These instructions apply to:
- Confluence distributed as an archive file. This distribution includes Apache Tomcat as the application server.
- Windows systems. For other operating systems please refer to the Confluence Installation Guide.
- Manual installation and configuration using a zipped download file. For a simpler installation process, please use the Confluence Installer instead.

Also, please check that the version of Confluence which you are installing coincides with the version that this documentation is written for.
1. Before you Start

Please check the following points:

1. Ensure that your system meets the minimum requirements to run Confluence. For more information, please refer to our Supported Platforms topic and for further details, our System Requirements topic.
2. Have your Confluence license key ready. You can obtain a trial, free or commercial license, or retrieve your existing license key at my.atlassian.com.

2. Install Java

Please refer to Installing Java for Confluence. If you are certain that this has already been installed and that the JAVA_HOME environment variable has been correctly configured, then proceed to the next step.

3. Download the Confluence Installation File

1. If you have not downloaded Confluence already, download the zip file.
2. Please check your unzip program before extracting the downloaded zip file. You should use a third-party unzip program like 7Zip or Winzip. If you do not have one, please download and install one of these before continuing:
   • 7Zip (recommended). If in doubt, download the ‘32-bit.exe’ version.
   • Winzip.
3. Use your unzip program to unzip the installation file to a directory such as c:\confluence.
   • Do not use spaces in your directory path.

The directory into which you unzipped the Confluence installation is called the Confluence Installation directory. Next, you will define the Confluence Home directory.

4. Define your Confluence Home Directory

Now you need to define the Confluence Home directory. This is where Confluence will store its configuration information, indexes and attachments.

Tip: Another term for ‘home directory’ would be ‘data directory’.

We suggest using different paths for your installation and home directories. This will facilitate easier upgrades.

**Examples of Installation and Home Directories**

<table>
<thead>
<tr>
<th>Installation directory</th>
<th>Home directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>c:\confluence\confluence-vX.X</td>
<td>c:\confluence\data</td>
</tr>
</tbody>
</table>

1. Open your Confluence Installation directory (created when you unzipped Confluence — see above).
2. Under the Installation directory, open this file: confluence\WEB-INF\classes\confluence-init.properties in a text editor such as Notepad.
3. Scroll to the bottom of the text and find this line:

```
# confluence.home=c:/confluence/data
```

4. Remove the ‘#’ and the space at the beginning of this line, so that Confluence no longer regards the line as a comment. The line should now begin with confluence.home
5. If you decide to change the Confluence Home directory from the default, please note the following:
   • Avoid spaces in the directory path or file name.
   • Use forward slashes ‘/’ to define the path.

For example:

```
confluence.home=c:/data/confluence-home
```
5. Check the Ports

If you have another application running on your machine which is using the same ports that Confluence uses by default, you may need to change the port which Confluence will use. For example, if you have an installation of JIRA running on this machine, JIRA might be already using the port which Confluence requests by default.

By default, Confluence listens on port '8090'. If this port is already in use in your installation, follow these instructions to change the ports:

- To change the ports for Confluence, open the file `conf/server.xml` under your Confluence Installation directory. The first four lines of the file look like this:

```
<Server port="8000" shutdown="SHUTDOWN" debug="0">
 <Service name="Tomcat-Standalone">
   <Connector className="org.apache.coyote.tomcat4.CoyoteConnector"
   port="8090" minProcessors="5" maxProcessors="75"
   enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
   ...
```

You need to modify both the `server` port (default is 8000) and the `connector` port (default is 8090) to ports that are free on your machine. The server port is required by Tomcat but is not user facing in any way. The connector port is what your users will use to access Confluence, e.g. in the snippet above, the URL would be `http://example.com:8090`.

✅ Hint: You can use netstat to identify free ports on your machine. See more information on using netstat on Windows or on Linux.

For example, here are the first four lines of a modified `server.xml` file, using ports '8020' and '8099':

```
<Server debug="0" shutdown="SHUTDOWN" port="8020">
 <Service name="Tomcat-Standalone">
   <Connector className="org.apache.coyote.tomcat4.CoyoteConnector"
   port="8099" minProcessors="5" maxProcessors="75"
   enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
   ...
```

To access Confluence in this configuration, point your web browser to `http://localhost:8099/`.

⚠️ You should also ensure at this point that if you are using a firewall, it is configured to allow http/https traffic over the port you have chosen.

Once this is working, if this is the URL your users will use, remember to update your Base URL to point to the new URL.

You will find more information on this page.

6. Select an External Database

This step is optional for users evaluating Confluence. However, if you are installing Confluence for production purposes, this step is mandatory. Please refer to the database requirements listed on our System Requirements topic for help in choosing an external database.
External databases are those listed on our Supported Platforms topic, excluding HSQLDB, which is bundled with Confluence and should not be used in production.

When you have chosen your external database, follow the the appropriate database setup guide to set up your database to work with Confluence.

You can learn more about migration from an existing installation or use of the evaluation database here. You will continue to use the database setup guide during the Confluence Setup Wizard. (See step 8 below.)

7. Start Confluence

1. Go to your Confluence Installation directory (created when you unzipped Confluence — see above).
2. Under your Confluence Installation directory, open the bin directory and run the startup script: startup.bat. A command prompt window should appear.
   Please do not close this command prompt window. If you do so, Confluence will stop running.

3. Once Confluence is running, open a web browser and visit http://localhost:8090/.
   If you changed the port earlier, use the port you specified in step 5 above.
   If your web browser window shows an error, try waiting for 30 seconds or so and then refresh the browser page.

8. Next Step is the Confluence Setup Wizard

The Confluence Setup Wizard should appear in your web browser, prompting you to enter your license key. Follow the instructions on the screens, and read more guidelines on the Confluence Setup Wizard.

9. Start Confluence automatically on Windows as a Service

Confluence should be run as a service.
Related Topics
Change listen port for Confluence
Running Confluence Over SSL or HTTPS
Confluence Setup Guide
Configuring Confluence
Uninstalling Confluence from Windows

This page describes the procedure for uninstalling an instance of Confluence which has been installed using the Windows Installer.

To uninstall Confluence from Windows:

1. Log in to Windows as the same user that was used to install Confluence with the Windows Installer.
2. Start the uninstaller by doing either of the following:
   - Click the Windows Start Menu > All Programs > Confluence > Uninstall Confluence
   OR
   - Open the Windows Control Panel, choose Add or Remove Programs (on Windows XP) or Programs and Features on (Windows 7, Vista) and then select Confluence X.Y from the list of applications and click Uninstall/Change.
Open the Windows command prompt and do the following:
   a. Change directory to your Confluence installation directory
   b. Run the `uninstall.exe` file

3. Follow the prompts to uninstall Confluence from your computer.

**Please note:**
- The uninstaller will not delete the Confluence Home Directory.
- All log files that were generated while Confluence was running will not be deleted.
- All files within the Confluence Installation Directory will be deleted (with the exception of the Tomcat log folder located in the Confluence Installation Directory).
- The uninstaller can be made to operate in unattended mode by specifying the `--q` option at the Windows command prompt — i.e. `uninstall --q`
- If you wish to re-install Confluence in 'unattended mode', do not uninstall your previous installation of Confluence just yet. See Using the Silent Installation Feature for more information.

Installing Confluence on Linux

This guide describes how to install a new Confluence installation on Linux using the automated 'Linux Installer'. You can also install from a 'zip' archive — see Installing Confluence on Linux from Archive File for details.

If you are upgrading Confluence, please see Upgrading Confluence.

**Please Note:**
- It is possible that any anti-virus or other Internet security tools installed on your Linux operating system may interfere with the Confluence installation process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence installation.
- You may also wish to consider disabling the Linux OutOfMemory Killer (OOM Killer). This is a Linux function that can kill processes when memory on the server becomes low, and sometimes targets Confluence.
- Before you begin installing Confluence, please read the System Requirements page and check the Database Configuration documentation for any specific requirements related to your chosen database.

Using the Console Wizard

Use the console wizard if you are installing Confluence on your server for the first time or you wish to specify your installation options.

If you have previously installed Confluence using the installation wizard and wish to re-install Confluence again with the same installation options, you can re-install Confluence in 'unattended mode' without any user input required (see below for details).

1. Download and Install the Confluence 'Linux Installer'

   If you execute the Linux Installer with 'root' user privileges, the installer will create and run Confluence using a dedicated user account. You can also execute the Linux Installer without 'root' user privileges, although your installation options will be much more limited and a dedicated user account (to run Confluence) will not be created. To run Confluence as a service, the Linux Installer must be executed with 'root' user privileges.

   **Please Note:**
   - To access the 32-bit installer, you may need to click the 'Show all' link on the 'Confluence Download' page to access the other installation packages.
   - The difference between the 64-bit / 32-bit .bin installers relates to their bundled Java platforms that run Confluence. Bear in mind that a Confluence installation installed using the 64-bit installer may require additional memory (to run at a similar level of performance) to a Confluence installation installed using the 32-bit installer. This is because a 64-bit Java platform's object references are twice the size as those for a 32-bit Java platform.

1. Download the appropriate Confluence 'Linux 64-bit / 32-bit Installer' (.bin) file from the Confluence Download page.

   **Please Note:**
   - If you execute the Linux Installer with 'root' user privileges, the installer will create and run Confluence using a dedicated user account. You can also execute the Linux Installer without 'root' user privileges, although your installation options will be much more limited and a dedicated user account (to run Confluence) will not be created. To run Confluence as a service, the Linux Installer must be executed with 'root' user privileges.

2. Open a Linux console and change directory (cd) to the `.bin` file's directory.

   **Please Note:**
   - If the `.bin` file is not executable after downloading it, make it executable, for example:
     ```bash
     chmod a+x atlassian-confluence-X.Y.bin
     ```
Confluence 5.6 Documentation

(when X.Y represents your version of Confluence)

3. Execute the *.bin* file to start the console wizard.

4. When prompted to choose between ‘Express Install’, ‘Custom Install’ or ‘Upgrade an existing Confluence installation’, choose either the ‘Express Install’ or ‘Custom Install’ options:

   - **Express Install** — If you choose this option, Confluence will be installed with default settings which are shown in the next step of the console wizard.

     **Please Note:**
     - If you are running the installer with ‘root’ user privileges, Confluence will be installed as a service.
     - If you want to customise any of these options:
       1. Enter ‘e’ to exit the console wizard.
       2. Execute the console wizard again (step 3 above).
       3. Choose the ‘Custom Install’ option instead.

   - **Custom Install** — If you choose this option, Confluence will prompt you to specify the following options (which are presented during subsequent steps of the console wizard and pre-populated with default values):
     - The ‘Destination Directory’ in which to install Confluence.
     - The Confluence Home directory (which must be unique for each Confluence installation).
     - The TCP ports (i.e. an HTTP and a Control port) that Confluence will run through.
     - If you are running the installer with ‘root’ user privileges, you will be prompted to ‘Run Confluence as a service’ (recommended). You can also do this manually later, as described in Start Confluence Automatically on Linux.

5. The console wizard will install Confluence onto your operating system and will start Confluence automatically when the wizard finishes.

**Please Note:**

If you executed the Linux Installer with ‘root’ user privileges, the Linux Installer creates a dedicated Linux user account with username ‘confluence’, which is used to run Confluence. This account has only:

- Full write access to your Confluence Home and other important directories.
- Limited write access to your Confluence Installation Directory.

If you executed the Linux Installer without ‘root’ user privileges, be aware that Confluence can still be run with ‘root’ privileges. However, to protect the security of your operating system, **this is not recommended**.

2. Start Confluence

If Confluence is not already started, you can start Confluence using the appropriate command at the Linux console.

Once Confluence is started, you can access Confluence from a browser on any computer with network access to your Confluence server.

2.1 Starting and Stopping Confluence manually

In the Linux console, enter the bin subdirectory of your Confluence installation directory and execute the appropriate file:

- `start-confluence.sh` (to start Confluence)
- `stop-confluence.sh` (to stop Confluence)

Confluence will be ready to access (from a browser window) when the following message appears in the application's log file:

```
*******************************************************
... You can now access Confluence through your web browser.
*******************************************************
```

2.2 Accessing Confluence from a Browser

You can access Confluence from any computer with network access to your Confluence server by opening a supported web browser on the computer and visiting this URL:
1. http://<computer_name_or_IP_address>:<HTTP_port_number>

   where:
   * `<computer_name_or_IP_address>` is the name or IP address of the computer on which Confluence is installed and
   * `<HTTP_port_number>` is the HTTP port number specified when you installed Confluence (above).

   If Confluence does not appear, you may need to change the port that Confluence runs on.

   Note: Application server logs (i.e. for Apache Tomcat) will be written to `logs/catalina.out`.

3. Run the Setup Wizard

   See the Confluence Setup Guide.

4. Next Steps

   * See Confluence 101.
   * If you did not install Confluence to run as a service, you will need to start Confluence manually every time you restart your computer. To change your Confluence installation to run as a service, please see Start Confluence Automatically on Linux.
   * To get the most out of Confluence, please see Performance Tuning.

Performing an Unattended Installation

If you have previously installed Confluence using the console wizard (above), you can use a configuration file from this Confluence installation (called `response.varfile`) to re-install Confluence in 'unattended mode' without any user input required.

Installing Confluence in unattended mode saves you time if your previous Confluence installation was used for testing purposes and you need to install Confluence on multiple server machines based on the same configuration.

Please Note:

* The `response.varfile` file contains the options specified during the installation wizard steps of your previous Confluence installation. Hence, do not uninstall your previous Confluence installation just yet.
* If you intend to modify the `response.varfile` file, please ensure all directory paths specified are absolute, for example, `sys.installationDir=/opt/atlassian/confluence`
* Unattended installations will fail if any relative directory paths have been specified in this file.

Download and Run the Confluence 'Linux Installer' in Unattended Mode

1. Download the Confluence 'Linux Installer' (.bin) file from the Confluence Download Center to a suitable location.
2. Open a Linux console.
3. Copy (`cp`) the file `.install4j/response.varfile` located in your previous Confluence installation directory, to the same location as the downloaded 'Linux Installer' file.
   You can uninstall your previous Confluence installation after this step. Save your `response.varfile` if you need to install Confluence on multiple machines.
4. Change directory (`cd`) to the location of the 'Linux Installer' file and execute the following command:
   
   ```bash
   atlassian-confluence-X.Y.bin -q -varfile response.varfile
   ```

   Where:
   * `X.Y` — refers to the version of Confluence you are about to install.
   * `-q` — instructs the installer to operate in unattended mode (i.e. ‘quietly’).
   * `-varfile response.varfile` — specifies the configuration file containing the configuration options used by the installer. The location and name of the configuration file should be specified after the `-varfile` option.

5. Confluence will start automatically when the silent installation finishes. Continue from the step above, Star
Installing Confluence on Linux from Archive File

These instructions apply to:
- Confluence distributed as an archive file. The distribution includes Apache Tomcat as the application server.
- Linux or Solaris systems. If you are installing Confluence on a different system, please refer to Installing Confluence.

Also, please check the version of Confluence which you are installing. Refer to the documentation home page to verify the latest Confluence version and to find documentation for older versions.

Hint: If you are evaluating Confluence on Solaris or you are unsure which version to install, this is the one to use.

On this page:
- 1. Before you Start
- 2. Install Java
- 3. Download and Extract the Confluence Installation File
- 4. Define your Confluence Home Directory
- 5. Check the Ports
- 6. Select an External Database
- 7. Start Confluence
- 8. Confluence Setup Wizard

1. Before you Start

Please check the following points:

1. Ensure that your system meets the minimum requirements to run Confluence. For more information, please read the detailed System Requirements.
2. Have your Confluence license key ready. You can obtain a trial, free or commercial license, or retrieve your existing license key at my.atlassian.com.
3. You must be able to use a command prompt and install Java to continue. If not, please contact your system administrator to assist you or consider the Confluence Hosted evaluation option.
4. Make sure that you use a Gnu version of zip application - Solaris and AIX are known to have problems with zip, because they use their own (old) versions instead of the Gnu version.

2. Install Java

Please refer to the Supported Platforms for the required version of Java. (OpenJDK is currently not supported. A JIRA issue to request support for this JDK has been created.)

1. If you are not sure whether you have Java installed correctly, please confirm by doing the following:
   a. Open a shell console.
   b. Type echo $JAVA_HOME in the shell console and then press Enter
   c. View the result:
      - If a line is displayed such as /opt/jdk1.6.0_12 or /usr/lib/jvm/java-6-sun, then Java is installed and properly configured.
      - If nothing is displayed, then you either need to install Java or set the $JAVA_HOME environment variable. You can set this environment variable in your user account's 'profile' file. Alternatively, you can set this after installing Confluence (in step 4 below) by defining this path in your Confluence installation's setenv.sh file, usually located in the Confluence bin directory.
      - If you have installed an unsupported JDK and you want to use SSL then you need to install the Sun JSSE package.
2. If you need to install Java, follow these instructions:
   - Go to the Java download page.
   - Download the latest JRE or JDK that is listed on the Confluence Supported Platforms page. (Confluence works with either the JDK or the JRE.)
When the download has finished, run the Java installer. Detailed installation instructions are provided on Oracle's website.

**Note:** you will be asked to choose an installation directory. Make a note of this directory for use later.

### 3. Download and Extract the Confluence Installation File

1. If you have not downloaded Confluence already, **download the TAR.GZ file**.

Use your unzip program to unzip the installation file to a directory such as `/home/jsmith/confluence-2.7.0-std/`.

Most Linux/Solaris users can use any unzip program (such as GNU Tar) to extract the Confluence installer. However, Solaris users should not use the Solaris Tar program due to a known issue associated with its use in extracting Confluence. Use another application such as GNU Tar instead.

For example, change directory to your home directory in Linux and enter the following commands in the shell console:

- `gunzip confluence-<version>-std.tar.gz`
- `tar -xf confluence-<version>-std.tar`

(where `<version>` refers to the Confluence version you downloaded.)

As usual on Linux/Solaris-based operating systems, avoid using spaces in your directory path. The directory into which you unzipped the Confluence installation is called the Confluence Installation directory. Next you will define the Confluence Home directory.

### 4. Define your Confluence Home Directory

Now you need to define the **Confluence Home directory**. This is where Confluence will store its configuration information, indexes and attachments.

**Tip:** Another term for ‘Home directory’ would be ‘data directory’.

We suggest using different paths for your installation and home directories. This will facilitate upgrades.

Examples of Installation and Home Directories:

- **Installation directory:** `/usr/local/confluence/`
  - If you wish to install or maintain multiple versions of Confluence, you can add a version number to the Confluence installation directory name like `/usr/local/confluence-3.1-std/` and optionally, create the symbolic link `/usr/local/confluence/` that points to `/usr/local/confluence-3.1-std/`.

- **Home directory:** `/usr/local/confluence-data/`
  - Open your Confluence Installation directory (created when you unzipped Confluence — see above).
  - Under the Installation directory, find this file: `confluence/WEB-INF/classes/confluence-init.properties`
  - Open the `confluence-init.properties` file in a text editor.
  - Scroll to the bottom and find this line:

    ```
    # confluence.home=c:/confluence/data
    ```

  - Remove the `#` and the space at the beginning of this line, so that Confluence no longer regards the line as a comment. The line should now begin with `confluence.home`
  - If you decide to change the Confluence Home directory from the default, use an absolute path rather than a symbolic link to specify the path and file name. For example:

    ```
    confluence.home=/home/jsmith/confluence-data/
    ```

### 5. Check the Ports
If you have another application running on your machine which is using the same ports that Confluence uses by default, you may need to change the port which Confluence will use. For example, if you have a installation of JIRA running on this machine, JIRA might be already using the port which Confluence requests by default.

By default, Confluence listens on port ‘8090’. If this port is already in use in your installation, follow these instructions to change the ports:

- To change the ports for Confluence, open the file `conf/server.xml` under your Confluence Installation directory. The first four lines of the file look like this:

```
<Server port="8000" shutdown="SHUTDOWN" debug="0">
  <Service name="Tomcat-Standalone">
    <Connector className="org.apache.coyote.tomcat4.CoyoteConnector"
      port="8090" minProcessors="5" maxProcessors="75"
      enableLookups="true" redirectPort="8443" acceptCount="10"
      debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
    ...
  </Service>
</Server>
```

You need to modify both the `server` port (default is 8000) and the `connector` port (default is 8090) to ports that are free on your machine. The server port is required by Tomcat but is not user facing in any way. The connector port is what your users will use to access Confluence, eg in the snippet above, the URL would be `http://example.com:8090`.

✔️ **Hint:** You can use `netstat` to identify free ports on your machine. See more information on using `netstat` on Windows or on Linux.

For example, here are the first four lines of a modified `server.xml` file, using ports ‘8020’ and ‘8099’:

```
<Server debug="0" shutdown="SHUTDOWN" port="8020">
  <Service name="Tomcat-Standalone">
    <Connector className="org.apache.coyote.tomcat4.CoyoteConnector"
      port="8099" minProcessors="5" maxProcessors="75"
      enableLookups="true" redirectPort="8443" acceptCount="10"
      debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
    ...
  </Service>
</Server>
```

To access Confluence in this configuration, point your web browser to `http://localhost:8099/`.

⚠️ You should also ensure at this point that if you are using a firewall, it is configured to allow `http/https` traffic over the port you have chosen.

Once this is working, if this is the URL your users will use, remember to update your Base URL to point to the new URL.

You will find more information on this page.

6. **Select an External Database**

This step is optional for users evaluating Confluence. However, if you are installing Confluence for production purposes, this step is mandatory. Please refer to the database requirements listed on our System Requirements topic for help in choosing an external database.

External databases are those listed on our Supported Platforms topic, excluding HSQLDB, which is bundled with Confluence and should not be used in production.
When you have chosen your external database, follow the appropriate database setup guide to set up your database to work with Confluence.

You can learn more about migration from an existing installation or use of the evaluation database here. You will continue to use the Database Setup Guide during the Confluence Setup Wizard. (See step 8 below.)

7. Start Confluence

1. Go to your Confluence Installation directory (created when you unzipped Confluence — see above).
2. Under your Confluence Installation directory, open the bin directory and run the startup script: start-confluence.sh.
3. Once Confluence is running, open a web browser and visit http://localhost:8090/.
   
   Hint: If you changed the port earlier, use the port you specified in step 6 above.

8. Confluence Setup Wizard

The Confluence Setup Wizard should appear in your web browser, prompting you to enter your license key. Follow the instructions on the screens, and read more guidelines on the Confluence Setup Wizard.

Related Topics
Change listen port for Confluence
Running Confluence Over SSL or HTTPS
Confluence Setup Guide
Configuring Confluence
Documentation Home
Uninstalling Confluence from Linux

This page describes the procedure for uninstalling Confluence, which had been installed using the Linux Installer.

To uninstall Confluence from Linux:

1. Open a Linux console.
2. Change directory (cd) to your Confluence installation directory.
3. Execute the command uninstall. This command must be executed as the same user account that was used to install Confluence with the Linux Installer.
4. Follow the prompts to uninstall Confluence from your computer.

Please note:
- The uninstaller will not delete the Confluence Home Directory.
- All log files that were generated while Confluence was running will not be deleted.
- All files within the Confluence Installation Directory will be deleted (with the exception of the Tomcat log folder located in the Confluence Installation Directory).
- The uninstaller can be made to operate in unattended mode by specifying the -q option — i.e. uninstall -q
- If you wish to re-install Confluence in 'unattended mode', do not uninstall your previous installation of Confluence just yet. See Using the Silent Installation Feature for more information.

Change listen port for Confluence

Problem
This page tells you what to do if you get errors like the following when starting Confluence, when you can't access Confluence on port 8090.

If you see this error:

```
java.net.BindException: Address already in use: JVM_Bind:8090
```

This means you are running other software on Confluence's default port of 8090. This may be another other process running on the same port. It may also be a previous instance of Confluence that hasn't been shut down cleanly.
To find out what process is listening on that port, load a command prompt and type: `netstat -an`

- `-a`: Displays all active TCP connections and the TCP and UDP ports on which the computer is listening.
- `-n`: Displays active TCP connections, however, addresses and port numbers are expressed numerically and no attempt is made to determine names.

There is also Process Explorer tool available to determine what is binding port 8090.

**Solution: Change the Ports which Confluence Listens On**

To change the ports for Confluence, open the file `conf/server.xml` under your Confluence Installation directory. The first four lines of the file look like this:

```
<Server port="8000" shutdown="SHUTDOWN" debug="0">
    <Service name="Tomcat-Standalone">
        <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8090" minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
```

You need to modify both the server port (default is 8000) and the connector port (default is 8090) to ports that are free on your machine. The server port is required by Tomcat but is not user facing in any way. The connector port is what your users will use to access Confluence, eg in the snippet above, the URL would be `http://example.com:8090`.

☑️ Hint: You can use netstat to identify free ports on your machine. See more information on using netstat on Windows or on Linux.

For example, here are the first four lines of a modified `server.xml` file, using ports '8020' and '8099':

```
<Server debug="0" shutdown="SHUTDOWN" port="8020">
    <Service name="Tomcat-Standalone">
        <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8099" minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
```

To access Confluence in this configuration, point your web browser to `http://localhost:8099/`.

⚠️ You should also ensure at this point that if you are using a firewall, it is configured to allow http/https traffic over the port you have chosen.

Once this is working, if this is the URL your users will use, remember to update your Base URL to point to the new URL.

**NOTES**

[1] For more information on netstat, see using netstat on Windows, or netstat man page (Linux).

[2] The JIRA distribution runs on port 8080 by default. If you're looking to change the port of the JIRA distribution, see Changing JIRA Standalone's port.
Installing the Confluence EAR-WAR Edition

Confluence 5.6 will be the last release to provide an EAR/WAR edition. Read more.

The Confluence EAR-WAR distribution is intended for deployment into an existing J2EE application server. To use this method of installation, you need to know how to deploy a web application on an existing application server. If not, please use the Confluence distribution instead.

On this page:

- Step 1. Check the System Requirements and Known Issues
- Step 2. Download and Extract EAR-WAR Installation File
- Step 3. Review Application Server Memory Allocation
- Step 4. Configure confluence-init.properties
- Step 5. Edit Tomcat Context Descriptors
- Step 6. Add UTF-8 Encoding
- Step 7. (Optional) Configure Tomcat to Run on a Different Port
- Step 8. (Optional) Configure Confluence to Run as a Windows Service
- Step 8. Run the Confluence Setup Wizard
- Notes

Step 1. Check the System Requirements and Known Issues

1. Please check the Confluence system requirements.
2. In addition to the above requirements, the EAR-WAR distribution requires the Apache Tomcat application server. For more information on Confluence's supported application servers, please refer to our Supported Platforms page.
3. If deploying as an unexploded WAR, Ant 1.3 or later is required. This is bundled with the WAR download.
4. Confluence, the database and application server must use the same character encoding. UTF-8 is recommended.
5. Deploying multiple Atlassian applications in a single Tomcat container is not supported. We do not test this configuration and upgrading any of the applications (even for point releases) is likely to break it. There are also a number of known issues with this configuration (see this FAQ for more information).

   We also do not support deploying multiple Atlassian applications to a single Tomcat container for a number of practical reasons. Firstly, you must shut down Tomcat to upgrade any application and secondly, if one application crashes, the other applications running in that Tomcat container will be inaccessible.

   Finally, we recommend not deploying any other applications to the same Tomcat container that runs Confluence, especially if these other applications have large memory requirements or require additional libraries in Tomcat's lib subdirectory.
6. Read through the Known Issues for Apache Tomcat.

Step 2. Download and Extract EAR-WAR Installation File

This section gives detailed instructions for installing Confluence EAR-WAR edition on an Apache Tomcat 5.5, or 6 server.

1. Download the Confluence EAR/WAR zip file. (You need to click the 'Show all' link to see the EAR/WAR zip file.)
2. Please check your unzip program before extracting the downloaded zip file. Some archive-extract programs cause errors when unzipping the Confluence zip file:
   - Windows users must avoid the Windows built-in unzip utility, as it doesn't extract all the files. Use a third-party unzip program like 7Zip or Winzip.
   - Solaris users will need to use GNU tar to handle the long file names.
3. Extract the downloaded zip file.
4. You have now unzipped your Confluence installation directory, which should contain the version number e.g. confluence-4.0.1 or confluence-4.0.2. This directory will be later referred to as the Confluence installation directory. Inside is a confluence subdirectory, referred to later as the Exploded Confluence WAR directory. Record the absolute path to the Confluence WAR directory.
Step 3. Review Application Server Memory Allocation

Confluence requires a maximum heap allocation (Xmx) of at least 256 MB for normal operation. Also, remember to set the maximum PermGen memory allocation (XX:MaxPermSize). See Increasing Application Server Memory.

⚠️ Do not configure a heap allocation so large that it does not allow enough remaining physical memory for your operating system and other applications on the server. The heap allocation should be large enough for Confluence, but not so large that the memory would be paged to disk during normal operation.

Step 4. Configure confluence-init.properties

1. Inside the Confluence installation directory, edit ...confluence/WEB-INF/classes/confluence-init.properties in a text editor.
2. Now define your Confluence Home directory, by setting the confluence.home property to a directory of your choosing.
   We suggest using different paths for your installation and home directories. This will facilitate upgrades. This is the directory that will contain all of Confluence's configuration, backup and attachment files.
   🔄 Tip: Another term for 'Home directory' would be 'data directory'.
   Make sure the user that runs Tomcat has full write access to the Confluence Home directory.

Step 5. Edit Tomcat Context Descriptors

1. Create a file called confluence.xml and save in the conf/Catalina/localhost sub-directory of Tomcat. If these directories don't exist you can create them manually.
2. Open your new confluence.xml file and add these lines:

   ```xml
   <Context path="/confluence" docBase="<CONFLUENCE_INSTALLATION_DIRECTORY_PATH>/confluence" debug="0" reloadable="true"/>
   </Context>
   ```

More on Context Path

To run Confluence without a context path, change the path in the Context tag to an empty string ("/"). If not using a context path, your config will need to be saved as ROOT.xml rather than confluence.xml.

In Tomcat, a context path name follows the name of its xml file (except for ROOT.xml where no context path is used. Hence if you wish to change the context path to a different name, change both the context path and the name of the xml file. eg. "/wiki" context path should be saved in file wiki.xml.

3. For docBase, specify the value you noted down earlier.
4. Restart Tomcat, and Confluence should be accessible under /confluence/ on your Tomcat server.
5. Follow the link below to proceed with the setup wizard.

Step 6. Add UTF-8 Encoding

1. Edit conf/server.xml and find the line where the Coyote HTTP Connector is defined. It will look something like this, possibly with more parameters:

   ```xml
   <Connector port="8080"/>
   ```

2. Add a URIEncoding="UTF-8" property to the connector:

   ```xml
   <Connector port="8080" URIEncoding="UTF-8"/>
   ```

Step 7. (Optional) Configure Tomcat to Run on a Different Port

More on Context Path

To run Confluence without a context path, change the path in the Context tag to an empty string ("/"). If not using a context path, your config will need to be saved as ROOT.xml rather than confluence.xml.

In Tomcat, a context path name follows the name of its xml file (except for ROOT.xml where no context path is used. Hence if you wish to change the context path to a different name, change both the context path and the name of the xml file. eg. "/wiki" context path should be saved in file wiki.xml.

3. For docBase, specify the value you noted down earlier.
4. Restart Tomcat, and Confluence should be accessible under /confluence/ on your Tomcat server.
5. Follow the link below to proceed with the setup wizard.

Step 6. Add UTF-8 Encoding

1. Edit conf/server.xml and find the line where the Coyote HTTP Connector is defined. It will look something like this, possibly with more parameters:

   ```xml
   <Connector port="8080"/>
   ```

2. Add a URIEncoding="UTF-8" property to the connector:

   ```xml
   <Connector port="8080" URIEncoding="UTF-8"/>
   ```

Step 7. (Optional) Configure Tomcat to Run on a Different Port
See **Switching to Apache Tomcat**.

**Step 8. (Optional) Configure Confluence to Run as a Windows Service**

Confluence can be **run as a service**.

**Step 8. Run the Confluence Setup Wizard**

Once Confluence is running, open a web browser and visit [http://localhost:8080/](http://localhost:8080/) (Tomcat default port).

If you changed the port earlier, use the port you specified. **Note** that the Confluence installer normally uses port 8090 as the default, to avoid conflicts with JIRA (using port 8080).

The Confluence Setup Wizard should appear in your web browser, prompting you to enter your license key. Follow the instructions on screen, and read more guidelines on the **Confluence Setup Wizard**.

**Notes**

- Tomcat users, take care not to unzip the Confluence installation into your **webapps** folder, as this may cause Confluence to be deployed more than once. It may cause a **Cluster Panic** error.
- If you deploy Confluence on an unsupported server, server-related issues cannot be covered by Atlassian technical support. You can try **Atlassian Answers** for assistance instead.

**Known Issues for Apache Tomcat**

**On this page:**

- **Supported Application Servers**
- **Tomcat Documentation**
- **Known Issues**

**Supported Application Servers**

Check the list of supported application servers on the **Supported Platforms** topic.

**Tomcat Documentation**

An excellent resource for Tomcat configuration is the **Apache documentation**.

**Known Issues**

- **Unable to Install Service on Windows Vista**
- **SSL Connector Fails to Initialize During Tomcat Startup**
- **Confluence Does Not Start due to Error deploying configuration descriptor**
- **Installing UPM 2.7.2 or later on versions of Tomcat prior to 6 fails**
- **Tomcat 6.0.26 or higher Shutdown Reports 'A web application created a ThreadLocal .... ThreadLocal has been forcibly removed’**
- **Fix 'Not supported by BasicDataSource' Setup or Startup Error**
- **Setup Fails Creating MySQL Schema Due to Tomcat Incompatibility**
- **Unable to Start Tomcat after Confluence User Management Delegation to JIRA**
- **'All threads (150) are currently busy, waiting. Increase maxThreads (150) or check the servlet status’ Due to High Volume Transactions**
- **Confluence will not update or install add-ons**
- **NotSerializableException on Shutdown**
- **Confluence Can't Start and Doesn't Create Logfiles due to CATALINA_HOME Being Set**
- **Login Fails After Upgrade**
- **Unable to Enable Workbox's Notifications and Tasks - Host Plugin Due to NoClassDefFoundError**
- **Confluence Deadlocks when Running under Tomcat 6.0.24-6.0.32**
- **Confluence Startup Referencing a Different Tomcat**
Tomcat fails to start with "The system could not find the environment option that was entered."
Universal Plugin Manager stops working after upgrade to v4.3.5 or v4.3.6
Confluence Does Not Start Due to NullPointerException in FelixOsgiContainerManager
HTML Macros Fail after Upgrading to 3.4 or Later Due to External URL References to Local Resources
"NoSuchMethodError: javax.servlet.ServletContext.getContextPath()" when starting Confluence
How to Determine Your Version of Tomcat and Java
Unable to Configure Confluence to Run as a Service on Tomcat 5
Confluence Menus Do Not Work, or Confluence Fails to Start when Running in the Same Application Server as JIRA 4.0, 4.0.1 or Crowd 2.0.x
Application Servers Troubleshooting
Slow Page Rendering of Large Pages Due to HTTP POST Limitations
Installation or Upgrade of Confluence 4.0 EAR-WAR Fails on Red Hat or CentOS

RELATED TOPICS
Running Confluence behind Apache
Configuring a MySQL Datasource in Apache Tomcat
Installing Java for Confluence

This page contains instructions for installing a Java Development Kit (JDK). This is a manual step that is only required for Confluence installations where you are installing from a zip or archive file.

If you are using the automated installer, the required Java files are bundled and will be automatically put in place, hence you will not need to follow the instructions on this page.

Please refer to our Supported Platforms topic for details of the Java versions that are supported for Confluence.

Installing the JDK

A JDK (Java Development Kit) needs to be installed on the same server machine that will have Confluence installed.

Installing the JDK on Windows

1. If you are not sure whether you have a JDK installed, please confirm by doing the following:
   - Check Control Panel > Programs and Features in Windows 7 (just Programs on older version of Windows).
   - Java should appear as a line item in the list. If not, you do not have Java installed.
2. To install the JDK, follow these instructions:
   - Go to the Java download page.
   - Download the version entitled 'Java SE Update XX (JDK)', where 'XX' stands for some number (you should choose the version listed on our Supported Platforms page).
   - When the download has finished, run the Java installer. At one point, you will be asked to choose a directory to install to. Copy or write this directory down for use later.
3. Check that the JAVA_HOME environment variable has been set correctly.
   - Open the Start menu, choose Run, type cmd in the Run dialog box and click OK.
   - In the command prompt window, type echo %JAVA_HOME% and then press Enter.
   - View the result:
     - If a directory path is displayed that looks similar to one of the following examples, with the letters 'JDK' immediately preceding a series of version numbers, and this path matches the location where you installed the JDK in step 2, then your JDK has been successfully installed and your JAVA_HOME environment variable has been set correctly.

Examples of typical JAVA_HOME environment variable values:

- C:\Program Files\Java\JDK7
- C:\Program Files\java\jre7
- C:\Java\JDK7
- C:\JDK7
- If nothing is displayed or you do not see 'JDK' immediately followed by a series of
version numbers (like one of the examples above), then you need to set the JAVA_HOME environment variable. Please follow these instructions to set your JAVA_HOME environment variable to the directory you where you have just installed the JDK. By default, this directory is under C:\Program Files\Java.

Note: Any Java or JDK version numbers on this page are examples only. Please refer to the Supported Platforms page for the supported versions of Java.

For Linux: (click to expand)

Installing the JDK on Linux

1. If you are not sure whether you have JDK installed correctly, please confirm by doing the following:
   a. Open a shell console.
   b. Type echo $JAVA_HOME in the shell console and then press Enter
   c. View the result:
      - If a line is displayed such as /opt/JDK7 or /usr/lib/jvm/java-7, then your JDK is installed and properly configured.
      - If nothing is displayed, then you either need to install the JDK or set the $JAVA_HOME environment variable. You can set this environment variable in your user account's 'profile' file. Alternatively, you can set this after installing Confluence, by defining this path in your Confluence installation's setenv.sh file, usually located in the Confluence bin directory.
      - If you have installed an unsupported JDK and you want to use SSL then you need to install the Sun JSSE package.

2. If you need to install the JDK, follow these instructions:
   - Go to the Java download page.
   - Download the version entitled 'Java SE Update XX (JDK)', where 'XX' stands for some number (you should choose the version listed on our Supported Platforms page).
   - When the download has finished, run the Java installer. Detailed installation instructions are provided on Oracle's website.

Note: Any Java or JDK version numbers on this page are examples only. Please refer to the Supported Platforms page for the supported versions of Java.

Setting the JAVA_HOME Variable in Windows

This information is only relevant if you are installing Confluence on a Windows server.

After you have installed the Java Runtime Environment (JRE) in Windows, you must set the JAVA_HOME environment variable to point to the JRE installation directory.

Stage 1. Locate the JRE Installation Directory

If you already know the installation path for the Java Runtime Environment, go to Stage 2 below. Otherwise, find the installation path by following these instructions:

1. If you didn't change the installation path for the Java Runtime Environment during installation, it will be in a directory under C:\Program Files\Java. Using Explorer, open the directory C:\Program Files\Java.
2. Inside that path will be one or more subdirectories such as C:\Program Files\Java\jre6.

Stage 2. Set the JAVA_HOME Variable

Once you have identified the JRE installation path:

1. Right-click the My Computer icon on your desktop and select Properties.
2. Click the Advanced tab.
3. Click the Environment Variables button.
5. Enter the variable name as JAVA_HOME.
6. Enter the variable value as the installation path for the Java Development Kit.
   - If your Java installation directory has a space in its path name, you should use the shortened path name (e.g. C:\Progra~1\Java\jre6) in the environment variable instead.
7. Click OK.
8. Click Apply Changes.
9. Close any command window which was open before you made these changes, and open a new command window. There is no way to reload environment variables from an active command prompt. If the changes do not take effect even after reopening the command window, restart Windows.
10. If you are running the Confluence EAR/WAR distribution, rather than the regular Confluence distribution, you may need to restart your application server.

Related Topics
- Starting Tomcat as a Windows Service
- Installing Confluence in Linux
- Installing Confluence Data Center

This guide covers installing Confluence Data Center, which is a clustered solution, for the first time (with no existing data).

If you have an existing Confluence instance, see Moving to Confluence Data Center.

1. Clustering requirements and terminology

To run Confluence in a cluster you must:

- have a clustered license.
- use an external database.
- use a load balancer with session affinity in front of the cluster.
- have a shared directory accessible to all cluster nodes in the same path (this will be your shared home directory)
- use OAuth authentication if you have application links to other Atlassian products (such as JIRA).

If you need a Data Center evaluation license please contact us.

In this guide we'll use the following terminology:

- installation directory - this is the directory where you installed Confluence on a node.
- local home directory - this is the home or data directory on each node (in non-clustered Confluence this is simply known as the home directory).
- shared home directory - is is the directory you created that is accessible to all nodes in the cluster via the same path.

At the end of the installation process you will have an installation and local home directory on each node, and a single shared home directory (5 directories total in a two node cluster).

2. Install Confluence on the first node

1. Install Confluence on node 1.
   See Installing Confluence on Windows from Zip File or Installing Confluence on Linux from Archive File for more information.

2. Start Confluence on Node 1. The setup wizard will guide you through setting up the first node. You'll be prompted to enter:
   - your cluster license
   - a name for your cluster
   - the path to the shared home directory you created earlier.
   - a multicast address (this is automatically generated, or you can choose to enter your own)
   - the network interface Confluence will use to communicate between nodes.

3. Load test the single node
Most Confluence installations do not need to be clustered. You might want to test your single node installation with the number of users and load you expect before going ahead with the additional complexity of clustering.

4. Copy Confluence to second node

To copy Confluence to the second node:

1. Shut down Confluence on node 1.
2. Shut down your application server on node 2, or stop it automatically loading web applications.
3. Copy the installation directory from node 1 to node 2.
4. Copy the local home directory from node 1 to node 2.
   - If the file path of the local home directory is not the same on nodes 1 and 2 you'll need to update the `confluence/WEB-INF/classes/confluence-init.properties` file on node 2 to point to the correct location.

Copying the local home directory ensures the Confluence search index, the database and cluster configuration, and any other settings are copied to node 2.

5. Start Confluence on the first node, wait, then start Confluence on second node

It's best to start Confluence one server at a time.

1. Start Confluence on node 1.
2. Wait for Confluence to become available on node 1.
3. Start Confluence on node 2.
4. Wait for Confluence to become available on node 2.

6. Test cluster connectivity

The Cluster Administration page (icon > General Configuration > Cluster Configuration) includes information about the active cluster. When the cluster is running properly, this page displays:

1. a correct count of the nodes in the cluster
2. a status display for each node in the cluster
3. uptime for each node.

Screenshot: Cluster Administration page
A simple process to ensure your cluster is working correctly is:

1. Create a new document on node 1.
2. Ensure the new document is visible by accessing it directly on node 2.
3. Search for the new document on node 1, ensure it appears.
4. Search for the new document on node 2, ensure it appears.

If Confluence detects more than one instance accessing the database but not in a working cluster, it will shut itself down in a cluster panic. This can be fixed by troubleshooting the network connectivity of the cluster.

7. Configure load balancer

Install and configure your load balancer. You can use the load balancer of your choice, but it needs to support ‘cookie based session affinity’.

You can verify that your load balancer is sending requests correctly to your existing Confluence server by simply accessing Confluence through the load balancer and creating a page then checking that this page can be viewed/edited by another machine through the load balancer.

Troubleshooting

If you have problems with the above procedure, please see our Cluster Troubleshooting guide.

If you are testing Confluence Data Center by running the cluster on a single machine, please refer to our developer instructions on Starting a Confluence cluster on a single machine.

Upgrading a cluster

It is important that upgrades follow the procedure for Upgrading Confluence Data Center.

Moving to Confluence Data Center

This guide covers the process of migrating from Confluence Server to Confluence Data Center, which is a clustered solution.

If you are installing Confluence for the first time (you do not have any existing Confluence data to migrate), see Installing Confluence Data Center.

Clustering requirements and terminology

To run Confluence in a cluster you must:

- have a clustered license
- use an external database
- use a load balancer with session affinity in front of the cluster
- have a shared directory that is accessible by the same path to all cluster nodes (this will be your shared home directory)
- use OAuth authentication if you have application links to other Atlassian products (such as JIRA).

If you need a Confluence Data Center evaluation license please contact us.

In this guide we'll use the following terminology:

- **installation directory** - this is the directory where Confluence is installed.
- **local home directory** - this is the home or data directory on each node (in non-clustered Confluence this is simply known as the home directory).
- **shared home directory** - is is the directory you created that is accessible to all nodes in the cluster via the same path.

At the end of the installation process you will have an installation directory and local home directory on each node and a single shared home directory (for example in a two node cluster you would have a total of 5 directories).

1. Upgrade Confluence Server

You cannot upgrade your version of Confluence and switch Confluence Data Center at the same time. For
example if you have Confluence 5.4 you'll need to upgrade to Confluence Server 5.6 before you migrate to Confluence Data Center 5.6.

If you are upgrading from an older version of Confluence as part of your migration to Confluence Data Center you will need to follow the normal procedure for backing up and upgrading Confluence to the same version first. See upgrading Confluence for information on upgrading and choosing the best upgrade path.

Once you have ensured the upgrade was successful and your instance is working correctly, shut down Confluence.

2. Create a shared home directory

1. Create a directory that is accessible to all cluster nodes via the same path. This will be your shared home directory.
2. In your existing Confluence home directory move contents of <confluence home>/shared-home to the new shared home directory you just created.
   To prevent confusion, we recommend deleting the empty <confluence home>/shared-home directory once you’ve moved its contents.
3. Move your attachments directory to the new shared home directory (skip this step if you currently store attachments in the database).

3. Upgrade to Data Center

1. Download the Clustered edition of Confluence (for the version you just upgraded to).
2. Upgrade to the Data Center version of Confluence.
   Note: your home directory (configured in confluence\WEB-INF\classes\confluence-init.properties) should still be pointing to your existing (local) home directory.
3. Start Confluence Data Center (run start-confluence.sh or start-confluence.bat)
4. The setup wizard will guide you through setting up the first node. You'll be prompted to enter:
   • your cluster license
   • a name for your cluster
   • the path to the shared home directory you created earlier.
   • a multicast address (this is automatically generated, or you can choose to enter your own).
   • the network interface Confluence will use to communicate between nodes.

Your first node is now up and running.

4. Copy Confluence to second node

To copy Confluence to the second node:

1. Shut down Confluence on node 1.
2. Shut down your application server on node 2, or stop it automatically loading web applications.
3. Copy the installation directory from node 1 to node 2.
4. Copy the local home directory from node 1 to node 2.
   If the file path of the local home directory is not the same on nodes 1 and 2 you'll need to update the <installation directory>/confluence/WEB-INF/classes/confluence-init.properties file on node 2 to point to the correct location.

Copying the local home directory ensures the Confluence search index, the database and cluster configuration, and any other settings are copied to node 2.

5. Start Confluence on the first node, wait, then start Confluence on second node

It's best to start Confluence one server at a time.

1. Start Confluence on node 1.
2. Wait for Confluence to become available on node 1.
3. Start Confluence on node 2.
4. Wait for Confluence to become available on node 2.

6. Test cluster connectivity

The Cluster Administration page ( > General Configuration > Cluster Configuration) includes information about the active cluster. When the cluster is running properly, this page displays:
A correct count of the nodes in the cluster
2. A status display for each node in the cluster
3. Uptime for each node.

Screenshot: Cluster Administration page

A simple process to ensure your cluster is working correctly is:

1. Create a new document on node 1.
2. Ensure the new document is visible by accessing it directly on node 2.
3. Search for the new document on node 1, ensure it appears.
4. Search for the new document on node 2, ensure it appears.

If Confluence detects more than one instance accessing the database but not in a working cluster, it will shut itself down in a *cluster panic*. This can be fixed by troubleshooting the network connectivity of the cluster.

7. Configure load balancer

Install and configure your load balancer. You can use the load balancer of your choice, but it needs to support ‘cookie based session affinity’.

You can verify that your load balancer is sending requests correctly to your existing Confluence server by simply accessing Confluence through the load balancer and creating a page then checking that this page can be viewed/edited by another machine through the load balancer.

Troubleshooting

If you have problems with the above procedure, please see our Cluster Troubleshooting guide.

If you are testing Confluence Data Center by running the cluster on a single machine, please refer to our developer instructions on Starting a Confluence cluster on a single machine.

Upgrading Confluence Data Center

This page contains instructions for upgrading an existing Confluence cluster.

If you are not yet running a clustered instance of
Confluence, see Moving to Confluence Data Center.

In this guide we'll use the following terminology:

- installation directory - this is the directory where you installed Confluence on each node.
- local home directory - this is the home or data directory on each node (in non-clustered Confluence this is simply known as the home directory).
- shared home directory - this is a directory that is accessible to all nodes in the cluster via the same path. If you're upgrading from Confluence 5.4 or earlier you'll create this directory as part of the upgrade.

### Before you start

- Check your Confluence licence is valid.
  
  To check go to ![Confluence](https://confluence.org) > General Configuration > Atlassian Support Tools > Health Check and make sure the license support period has not expired. If your support period has expired renew your licence and reapply it before proceeding with the upgrade.

- Read the Release Notes and Upgrade Notes for both the version you are upgrading to, and any versions you are skipping.

- Check that your Java version, application server, operating system, database and browsers are supported.
  
  See Supported Platforms and End of Support Announcements for Confluence to confirm latest requirements.

- Check the latest database setup guide for your database and ensure that the database is configured correctly. There may be new configuration requirements. See Database Configuration.

- Check the compatibility of any add-ons.
  
  Some add-ons may not yet be compatible with the latest version of Confluence. See Checking add-on compatibility with application updates to find out how to check this in the Universal Plugin Manager.

- Check for any known issues that might affect your instance.
  
  See the Confluence Knowledge Base for known issues for the version you are upgrading to and Database Troubleshooting for known issues related to supported external databases.

- Make a note of any modifications to your Confluence instance (for example layouts or a custom theme).
  
  Any customisation you wish to maintain will need to be reapplied after upgrading. See Additional steps where customisations are present.

### Step 1 Back up

We strongly recommend that you backup your Confluence home and install directories and your database before proceeding.

More information on specific files and directories to backup can be found in Upgrading Confluence.

### Step 2 Stop the cluster

You must stop all the nodes in the cluster before upgrading.

We recommend configuring your load balancer to redirect traffic away from Confluence until the upgrade is complete on all nodes.

### Step 3 Create a shared home directory

⚠️ If you are upgrading an existing Confluence Data Center instance (Confluence 5.6 or later), you can skip this step, as you already have a Shared Home directory.
To set up your Shared Home directory:

1. Create a directory that is accessible to all cluster nodes via the same path. This will be your **shared home** directory.

2. Edit `confluence.cfg.xml` in the home directory on the first node and add a new property called `confluence.cluster.home` with the path of the shared home directory as the value. Example:

   ```xml
   <property
     name="confluence.cluster.home">/mnt/confluence-shared-home</property>
   ```

3. Move all the files/directories from the local home directory the first node to the new shared home directory **except** for the following:
   - `config`
   - `confluence.cfg.xml`
   - `index`
   - `temp`
   - `bundled-plugins`
   - `plugin-cache-*`
   - `plugins-cache`
   - `plugins-osgi-cache`
   - `plugins-temp`

   Remove the moved files/directories from the local home directories on all other nodes.

**Step 4 Upgrade the first node**

To upgrade the first node:

1. Extract (unzip) the files to a directory (this will be your new installation directory, and must be different to your existing installation directory)

2. Update the following line in the `<Installation-Directory>\confluence\WEB-INF\classes\confluence-init.properties` file to point to the **existing local home** directory on that node.

3. Copy the jdbc driver jar file from your existing Confluence installation directory to `confluence/WEB-INF/lib` in your new installation directory.
   The jdbc driver will be located in either the `<Install-Directory>/common/lib` or `<Installation-Directory>/confluence/WEB-INF/lib` directories.

4. Copy any other immediately required customisations from the old version to the new one (for example if you are not running Confluence on the default ports or if you manage users externally, you'll need to update / copy the relevant files - find out more in [Upgrading Confluence Manually](#))

5. Start Confluence, and and confirm that you can log in and view pages before continuing to the next step.

   You should now reapply any additional customisations from the old version to the new version, before upgrading the remaining nodes.

**Step 5 Upgrade the other nodes**

To upgrade the next node in your cluster:

1. Stop Confluence on the first node.

2. Copy the installation directory and home directory from the first node to the next node.
   If the path to the local home directory is different on this node, edit the `confluence-init.properties` to point to the correct location.

3. Start Confluence, and and confirm that you can log in and view pages before continuing with the next node.

   Repeat this process for each remaining node.

**Step 6 Start Confluence and check cluster connectivity**

Once all nodes have been upgraded you can start Confluence Data Center on each node, one at a time.
The Cluster Administration page (🔧 > General Configuration > Cluster Configuration) includes information about the active cluster. When the cluster is running properly, this page displays:

1. a correct count of the nodes in the cluster
2. a status display for each node in the cluster
3. uptime for each node.

Adding and Removing Data Center Nodes

Your Data Center license is based on the number of users in your cluster, rather than the number of nodes. This means you can add and remove nodes from your Data Center cluster at any time.

Adding a node

To add a node:

1. Stop Confluence on one node.
2. Copy the installation directory and local home directory from the stopped node to your new node.
   
   As the local home directory contains indexes, it is important that you copy a node that has been stopped.
3. Start Confluence on your new node.
4. Go to 🔄 > General Configuration > Cluster Configuration and check that the new node is visible.
5. Restart the stopped node.

Removing a node

To remove a node, stop Confluence on that node. You can then remove the installation and local home directory as required.

To see the number of nodes remaining go to 🔄 > General Configuration > Cluster Configuration.

Creating a Dedicated User Account on the Operating System to Run Confluence

This step is optional if you are evaluating Confluence, but should be mandatory for Confluence installations used in production. If you have used the Confluence installer on Linux, this user will be created automatically.

A dedicated user should be created to run Confluence, because Confluence runs as the user it is invoked under and therefore can potentially be abused. For example:

- If your operating system is *nix-based (for example, Linux or Solaris), type the following in a console:
  ```
  $ sudo /usr/sbin/useradd --create-home --comment "Account for running Confluence" --shell /bin/bash confluence
  ```

- If your operating system is Windows:
  1. Create the dedicated user account by either:
     - Typing the following at the Windows command line:
       ```
       > net user confluence mypassword /add /comment:"Account for running Confluence"
       ```
       (This creates a user account with user name 'confluence' and password 'mypassword'. You should choose your own password.)
     - Opening the Windows 'Computer Management' console to add your 'confluence' user with its own password.
  2. (Optional) Use the Windows 'Computer Management' console to remove the 'confluence' user's membership of all unnecessary Windows groups, such as the default 'Users' group.

Ensure that only the following directories can be written to by this dedicated user account (e.g. 'confluence'):

- The following subdirectories of your Confluence Installation Directory:
1. Start the Setup Wizard

1. If Confluence is not already running, start it now:
   - If you are running the Confluence distribution on Windows, click **Start > Programs > Confluence > Start Confluence Server**.
   - Or, run the start-up script found in the `bin` folder of your installation directory:
     - `start-confluence.bat` for Windows.
     - `start-confluence.sh` for Linux-based systems.

2. Go to the following web address in your web browser: **http://localhost:8090**
   The above web address uses port '8090'. If you chose a different port during installation, change '8090' to the number you chose. If an error message appears, check that you are using the port which you specified during installation.

On this page:
- 1. Start the Setup Wizard
- 2. Choose your Installation Type
- 3. Enter your License Key
- 4. Production Installation: Database Configuration
- 5. Production Installation: External Database
- 6. Production Installation: Load Content
- 7. Production Installation: Restore Data from Backup
- 8. Set Up User Management
- 9. Connect to JIRA
- 10. Set Up System Administrator
- 11. Setup is Complete
- 12. Install add-ons (optional)

2. Choose your Installation Type

In this step, you will choose whether you want a trial or a production installation.

**Option 1: Trial Installation** - Set up Confluence with the embedded **HSQLDB database** and default settings. This option will also generate an evaluation license and install a Demonstration space with some example content. You can upgrade to another type of database later on.

Choose this option if:
- You want to evaluate Confluence or if you are new to Confluence.
- You do not have a Confluence licence.

For production use, we strongly recommend that you connect to an external database rather than using the embedded database. The evaluation installation is therefore not suitable for production environments.

**Option 2: Production Installation** - Customise your Confluence instance to use your own database and your
own data.

The production installation offers the following options:

- Connect Confluence to an external database. Recommended for Confluence used in production environments.
- Restore data from an existing Confluence database.
- Install Confluence without the demonstration content.

3. Enter your License Key

**Trial installation:** Follow the prompts in the setup wizard to generate an evaluation license. Once your license has been generated go to [step 8 below](#).

**Production installation:** Find your Confluence license key and paste it into the License Key field, shown on the screenshot above.

If you already have a license key, you can retrieve it from the Atlassian website.

If you do not already have a Confluence license, you can obtain one now:

- To get a free evaluation license:
  1. Click **generate an evaluation license online** on the setup wizard, shown on the screenshot above.
  2. Follow the prompts to generate your license key and insert it into the setup wizard's licensing screen automatically.
- To get a commercial, academic, non-profit or open source license:
  1. Copy your **Server ID** from the setup wizard's licensing screen, shown on the screenshot above.
  2. Choose the license type you need from the list on the Atlassian website.
  3. Complete the [online order form](#).

4. Production Installation: Database Configuration
Confluence 5.6 Documentation

The above screen appears if you have chosen a production installation of Confluence. You can choose to use the embedded database supplied with your Confluence installation, or to connect to an external database.

- **Option 1: Embedded Database** — If you select this option, Confluence will use an embedded HSQLDB database. You should only select this option for the purposes of evaluating or demonstrating Confluence. You can migrate to an external database later on if you wish.

- **Option 2: External Database** — If you wish Confluence to use an external database, select your database type from the dropdown list and then click the 'External Database' button.
  - For production purposes, you should use an external database to ensure your data is kept safe and consistent.
  - If you choose PostgreSQL, please make sure that the version you install is supported by Atlassian. It is possible that we do not yet support the latest version of PostgreSQL.
  - Read the page about supported platforms for more information about which databases are supported. For details about choosing an external database, refer to the page on system requirements. For information about configuring an external database, see Database Configuration.

5. Production Installation: External Database

- **Before you Start**
  - **Character encoding:**
    - We strongly recommend that character encoding is consistent across your database, application server and web application, and that you use UTF-8 encoding.
You can choose how you wish Confluence to connect to your database - via a direct JDBC connection or via a server-managed datasource connection. Choose one of the two options below.

**Option 1: Direct JDBC** — This uses a standard JDBC database connection. Connection pooling is handled within Confluence.

Supply the following information:

- **Driver Class Name** — The Java class name for the appropriate database driver. This will depend on the JDBC driver, and will be found in the documentation for your database. Note that Confluence bundles some database drivers, but you'll need to install the driver yourself if it is not bundled. See Database JDBC Drivers for details.
- **Database URL** — The JDBC URL for the database you will be connecting to. This will depend on the JDBC driver, and will be found in the documentation for your database.
- **User Name** — A valid username which Confluence will use to access your database.
- **Password** — The password corresponding to the above username.

You will also need to know:

- The size of the connection pool Confluence should maintain. If in doubt, just go with the default provided.
- What kind of database you're connecting to, so you can tell Confluence which dialect it needs to use.

**Option 2: Datasource** — This asks the Java application server for a database connection. You will need to have configured a datasource in your application server. For information about configuring an external database, see Database Configuration.

Supply the following information:

- **Datasource Name** — The JNDI name of the datasource, as configured in the application server. Note: Some servers will have JNDI names like `jdbc/datasourcename`; others will be of the form `java:comp/env/jdbc/datasourcename`. Consult your application-server documentation.

You will also need to know:

- What kind of database you're connecting to, so you can tell Confluence which dialect it needs to use.

6. Production Installation: Load Content
Select one of the following options:

- **Example Site** - This option will load Confluence’s ‘Demonstration Space’. Select this if you are using Confluence for the first time, or if you want the Demonstration Space for your other Confluence users. The Demonstration Space helps to familiarise you with Confluence and what it can do for you. You can then continue using your Confluence deployment as normal - there’s no need to reinstall later.

- **Empty Site** - Select this option if you are already familiar with Confluence. You will need to create at least one space before you can start adding content to the site.

- **Restore from Backup** - Select this option if you want to use Confluence data from a previous installation.

### 7. Production Installation: Restore Data from Backup

This option allows you to reload your data from an existing Confluence installation into your new Confluence site during the initial setup procedure. You can choose to upload data from a zipped backup file, or to restore from a backup file on your file system.

**Option 1: Upload a zipped backup to Confluence** - This option will load the data from a zipped backup file. (To create a backup file from your existing version of Confluence, go to the 'Backup & Restore' section of your Administration Console.)

To restore from a zipped backup:

1. Browse for the relevant daily backup file or a file you have created via a manual backup.
2. Check ‘Build Index’ to build the data index, used for the search.
3. Click the ‘Upload and Restore’ button.

**Option 2: Restore a backup from the filesystem** - This option is recommended if you have a very large daily backup file (greater than 100MB), or a daily backup file that is already on the server and doesn't require uploading.

1. Copy the XML backup file into the restore directory inside your confluence Home directory and then refresh the page. You should now see your backup file appear on the 'Restore Data' screen (pictured above), in the box beneath the heading ‘Restore a backup from the filesystem’.
2. Check ‘Build Index’ to build the data index, used for the search.
3. Click the 'Restore' button.

When the restore process has finished, you are ready to log in to Confluence. The system administrator account and all other information has been transferred from your previous Confluence installation.

8. Set Up User Management

**Screenshot above: User management**

You can choose to manage Confluence's users and groups inside Confluence or in JIRA.

- If you do not have Atlassian JIRA installed, or if you would prefer to set up external user management later, choose **Manage users and groups within Confluence**.
- If you have JIRA installed, the setup wizard gives you the opportunity to configure the JIRA connection automatically. This is a quick way of setting up your JIRA integration with the most common options. It will configure a JIRA user directory for Confluence, and set up application links between JIRA and Confluence for easy sharing of data. Choose **Connect to JIRA**.

9. Connect to JIRA
Enter the following information:

- **JIRA Base URL** – The web address of your JIRA server. Examples:
  
  ```text
  http://www.example.com:8080/jira/
  http://jira.example.com
  ```

- **JIRA Administrator Login: Username** – Enter the username of a user with the ‘JIRA System Administrators’ global permission in JIRA.
- **JIRA Administrator Login: Password** – Enter the password that the above user uses to sign in to JIRA.
- **Confluence Base URL** – JIRA will use this URL to access your Confluence server. The URL you give here will override the base URL specified in your Confluence administration console, for the purposes of the JIRA connection.
- **User Groups** – Specify one or more JIRA groups whose members should be able to use Confluence. The default group is `jira-users`. (These groups will receive the ‘can use’ permission in Confluence.)
- **Admin Groups** – Specify one or more JIRA groups whose members should have administrative access to Confluence. The default group is `jira-administrators`. (These groups will receive the ‘Confluence system administrator’ and ‘Confluence administrator’ permissions in Confluence.)

For full details and a troubleshooting guide, see Configuring JIRA Integration in the Setup Wizard.

10. Set Up System Administrator
The system administrator has full administrative power over your Confluence instance. This person will be able to add more users, create spaces, and set further Confluence options. Please refer to the overview of global permissions for more information.

**Hint:** If you are evaluating Confluence, set yourself as the administrator.

1. Enter the following information to set up your system administrator's user account:
   - **Username** — The username under which the system administrator will log in to Confluence, e.g. 'jsmith'.
   - **Password** — The password which the system administrator will use to log in.
   - **Confirm** — Enter the same password again.
   - **Name** — The system administrator's full name, e.g. 'John Smith'.
   - **Email** — The system administrator's email address, e.g. 'jsmith@example.com'.

2. Click 'Next'.

### 11. Setup is Complete

Congratulations! You have installed and set up Confluence. Click **Start using Confluence** to open the Demonstration space in your Confluence wiki. This space contains some sample content and ideas, to help you get started quickly.

Click **Further Configuration** if you want to go directly to the Administration Console and complete administrator's tasks including configuring a mail server, adding users, changing the base URL and more. Refer to the Confluence Administrator’s Guide for more information.

### 12. Install add-ons (optional)

If you have chosen a package that includes add-ons such as Team Calendars or the SharePoint Connector you can now install these from within Confluence.

In the Administration Console go to **Find New Add-ons** and search for your add-on. Follow the prompts to install the add-on.

See **Finding new add-ons** for more information on how to find and install the add-ons.

**Configuring JIRA Integration in the Setup Wizard**

This page describes the **Connect to JIRA** step in the Confluence setup wizard.

**Overview**

You can connect your application to a JIRA server, to manage your users via JIRA and share information with JIRA. When you are installing the application, the setup wizard gives you the opportunity to configure the JIRA connection automatically. This is a quick way of setting up your JIRA integration with the most common options.

You can also configure the JIRA connections via the application administration screens. In that case, you will need to set up connections individually. There are two parts to the integration process:

- A peer-to-peer link between JIRA and the application for sharing information and facilitating integration features. This link is set up via Application Links.
- A client-server link between the application and JIRA for delegating user and group management to your JIRA server.

**Requirements:** You need JIRA 4.3 or later.
Enter the following information:

- **JIRA Base URL** – The web address of your JIRA server. Examples:
  
  - http://www.example.com:8080/jira/
  - http://jira.example.com

- **JIRA Administrator Login: Username** – Enter the username of a user with the ‘JIRA System Administrators’ global permission in JIRA.
- **JIRA Administrator Login: Password** – Enter the password that the above user uses to sign in to JIRA.
- **Confluence Base URL** – JIRA will use this URL to access your Confluence server. The URL you give here will override the base URL specified in your Confluence administration console, for the purposes of the JIRA connection.
- **User Groups** – Specify one or more JIRA groups whose members should be able to use Confluence. The default group is jira-users. (These groups will receive the ‘can use’ permission in Confluence.)
- **Admin Groups** – Specify one or more JIRA groups whose members should have administrative access to Confluence. The default group is jira-administrators. (These groups will receive the ‘Confluence system administrator’ and ‘Confluence administrator’ permissions in Confluence.)

Troubleshooting

This section describes the possible problems that may occur when integrating your application with JIRA via the
The setup wizard, and the solutions for each problem.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The setup wizard displays one of the following error messages:</td>
<td>The setup wizard failed to complete registration of the</td>
<td>Remove the partial configuration if it exists, try the 'Connect to</td>
</tr>
<tr>
<td></td>
<td>peer-to-peer application link with JIRA. JIRA integration is only</td>
<td>JIRA' step again, and then continue with the setup. Detailed</td>
</tr>
<tr>
<td></td>
<td>partially configured.</td>
<td>instructions are below.</td>
</tr>
<tr>
<td></td>
<td>The setup wizard failed to complete registration of the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>client-server link with JIRA for user management. The</td>
<td></td>
</tr>
<tr>
<td></td>
<td>peer-to-peer link was successfully created, but integration is only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>partially configured.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The setup wizard successfully established the peer-to-peer link</td>
<td>Please investigate and fix the</td>
</tr>
<tr>
<td></td>
<td>with JIRA, but could not persist the client-server link for user</td>
<td>problem that prevented the</td>
</tr>
<tr>
<td></td>
<td>management in your config.xml file. This may be caused by a problem</td>
<td>application from saving the</td>
</tr>
<tr>
<td></td>
<td>in your environment, such as a full disk.</td>
<td>configuration file to disk. Then</td>
</tr>
<tr>
<td></td>
<td></td>
<td>remove the partial configuration if it</td>
</tr>
<tr>
<td></td>
<td></td>
<td>exists, try the 'Connect to JIRA' step again, and then continue with</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the setup. Detailed instructions are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>below.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The setup wizard has completed the integration of your application</td>
<td>Restart your application. You should</td>
</tr>
<tr>
<td></td>
<td>with JIRA, but is unable to start synchronizing the JIRA users</td>
<td>then be able to continue with</td>
</tr>
<tr>
<td></td>
<td>with your application.</td>
<td>the setup wizard. If this solution does not work, please contact</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Atlassian Support.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The setup wizard has not completed the integration of your</td>
<td>Remove the partial configuration if it exists, try the 'Connect to</td>
</tr>
<tr>
<td></td>
<td>application with JIRA. The links are only partially configured.</td>
<td>JIRA' step again, and then continue with the setup. Detailed</td>
</tr>
<tr>
<td></td>
<td>The problem occurred because there is already a user management</td>
<td>instructions are below.</td>
</tr>
<tr>
<td></td>
<td>configuration in JIRA for this &lt;application&gt; URL.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
No users can log in after you have set up the application with JIRA integration.

Possible causes:
- There are no users in the group that you specified on the 'Connect to JIRA' screen.
- For FishEye: There are no groups specified in the 'groups to synchronize' section of your administration console.
- For Stash: You may not have granted any JIRA groups or users permissions to log in to Stash.

Go to JIRA and add some usernames to the group.
- For FishEye: Go to the FishEye administration screens and specify at least one group to synchronize. The default is 'jira-users'.
- For Stash: Grant the Stash User permission to the relevant JIRA groups on the Stash Global permissions page.

If this solution does not work, please contact Atlassian Support.

Solution 1: Removing a Partial Configuration – The Easiest Way

If the application's setup wizard fails part-way through setting up the JIRA integration, you may need to remove the partial configuration from JIRA before continuing with your application setup. Please follow the steps below.

Remove the partial configuration if it exists, try the 'Connect to JIRA' step again, and then continue with the setup wizard:

1. Log in to JIRA as a user with the 'JIRA System Administrators' global permission.
2. Click the 'Administration' link on the JIRA top navigation bar.
3. Remove the application link from JIRA, if it exists:
   a. Click Application Links in the JIRA administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
   b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For example:
      - If you want to remove a link between JIRA and FishEye, look for the one where the Application URL matches the base URL of your FishEye server.
      - If you want to remove a link between JIRA and Confluence, look for the one where the Application URL matches the base URL of your Confluence server.
      - If you want to remove a link between JIRA and Stash, look for the one where the Application URL matches the base URL of your Stash server.
   c. Click Delete next to the application link that you want to delete.
   d. A confirmation screen will appear. Click Confirm to delete the application link.
4. Remove the user management configuration from JIRA, if it exists:
   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      - In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the JIRA administration screen.
      - In JIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.
   b. Look for a link to your application. It will have a name matching this format:

   ```
   <Type> - <HostName> - <Application ID>
   ```

   For example:

   ```
   FishEye / Crucible - localhost - 92004b08-5657-3048-b5dc-f886e662ba15
   ```

   Or:

   ```
   Confluence - localhost - 92004b08-5657-3048-b5dc-f886e662ba15
   ```
If you have multiple servers of the same type running on the same host, you will need to match the application ID of your application with the one shown in JIRA. To find the application ID:

- Go to the following URL in your browser:

  `<baseUrl>/rest/applinks/1.0/manifest`

Replace `<baseUrl>` with the base URL of your application.
For example:

  `http://localhost:8060/rest/applinks/1.0/manifest`

- The application links manifest will appear. Check the application ID in the `<id>` element.

5. Go back to the setup wizard and try the 'Connect to JIRA' step again.

**Solution 2: Removing a Partial Configuration – The Longer Way**

If solution 1 above does not work, you may need to remove the partial configuration and then add the full integration manually. Please follow these steps:

1. Skip the 'Connect to JIRA' step and continue with the setup wizard, to complete the initial configuration of the application.
2. Log in to JIRA as a user with the 'JIRA System Administrators' global permission.
3. Click the 'Administration' link on the JIRA top navigation bar.
4. Remove the application link from JIRA, if it exists:
   a. Click Application Links in the JIRA administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
   b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For example:
      - If you want to remove a link between JIRA and FishEye, look for the one where the Application URL matches the base URL of your FishEye server.
      - If you want to remove a link between JIRA and Confluence, look for the one where the Application URL matches the base URL of your Confluence server.
      - If you want to remove a link between JIRA and Stash, look for the one where the Application URL matches the base URL of your Stash server.
   c. Click Delete next to the application link that you want to delete.
   d. A confirmation screen will appear. Click Confirm to delete the application link.
5. Remove the user management configuration from JIRA, if it exists:
   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      - In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the JIRA administration screen.
      - In JIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.
   b. Look for a link to your application. It will have a name matching this format:

     `<Type> - <HostName> - <Application ID>`

   For example:

   `FishEye / Crucible - localhost - 92004b08-5657-3048-b5dc-f886e662ba15`

   Or:
If you have multiple servers of the same type running on the same host, you will need to match the application ID of your application with the one shown in JIRA. To find the application ID:

- Go to the following URL in your browser:

  `<baseUrl>/rest/applinks/1.0/manifest`

Replace `<baseUrl>` with the base URL of your application.
For example:

  `http://localhost:8060/rest/applinks/1.0/manifest`

- The application links manifest will appear. Check the application ID in the `<id>` element.
- In JIRA, click 'Delete' next to the application that you want to remove.

6. Add the application link in JIRA again, so that you now have a two-way trusted link between JIRA and your application:

   a. Click 'Add Application Link'. Step 1 of the link wizard will appear.
   b. Enter the server URL of the application that you want to link to (the 'remote application').
   c. Click 'Next'.
   d. Enter the following information:
      - **Create a link back to this server** – Check to add a two-way link between the two applications.
      - **Username** and **Password** – Enter the credentials for a username that has administrator access to the remote application.
        Note: These credentials are only used to authenticate you to the remote application, so that Application Links can make the changes required for the new link. The credentials are not saved.
      - **Reciprocal Link URL** – The URL you give here will override the base URL specified in your remote application's administration console, for the purposes of the application links connection. Application Links will use this URL to access the remote application.
   e. Click 'Next'.
   f. Enter the information required to configure authentication for your application link:
      - **The servers have the same set of users** – Check this box, because the users are the same in both applications.
      - **These servers fully trust each other** – Check this box, because you trust the code in both applications and are sure both applications will maintain the security of their private keys.
        For more information about configuring authentication, see Configuring Authentication for an Application Link.
   g. Click 'Create'.

7. Configure a new connection for user management in JIRA:

   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      - In JIRA 4.3: Click ‘Other Applications’ in the ‘Users, Groups & Roles’ section of the JIRA administration screen.
      - In JIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.
   b. **Add** an application.
   c. Enter the **application name** and **password** that your application will use when accessing JIRA.
   d. Enter the **IP address** or addresses of your application. Valid values are:
      - A full IP address, e.g. 192.168.10.12.
      - A wildcard IP range, using CIDR notation, e.g. 192.168.10.1/16. For more information, see the introduction to CIDR notation on Wikipedia and RFC 4632.
      - **Save** the new application.

8. Set up the JIRA user directory in the application.

   - For Confluence:
      a. Go to the Confluence Administration Console.
b. Click ‘User Directories’ in the left-hand panel.

c. Add a directory and select type ‘Atlassian JIRA’.

d. Enter the following information:
   - **Name** – Enter the name of your JIRA server.
   - **Server URL** – Enter web address of your JIRA server. Examples:

   
   ```
   http://www.example.com:8080/jira/
   http://jira.example.com
   ```

   - **Application name** and **Application password** – Enter the values that you defined for Confluence in the settings on JIRA.

e. Save the directory settings.

f. Define the **directory order** by clicking the blue up- and down-arrows next to each directory on the ‘User Directories’ screen.

For details see Connecting to Crowd or JIRA for User Management.

- For FishEye/Crucible:
   a. Click **Authentication** (under ‘Security Settings’).

   b. Click **Setup JIRA/Crowd authentication**. Note, if LDAP authentication has already been set up, you will need to remove that before connecting to JIRA for user management.

   c. Make the following settings:

<table>
<thead>
<tr>
<th>Authenticate against</th>
<th>Select a JIRA instance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application name and password</td>
<td>Enter the values that you defined for your application in the settings on JIRA.</td>
</tr>
<tr>
<td>JIRA URL</td>
<td>The web address of your JIRA server. Examples:</td>
</tr>
<tr>
<td>Auto-add</td>
<td>Select <strong>Create a FishEye user on successful login</strong> so that your JIRA users will be automatically added as a FishEye user when they first log in.</td>
</tr>
<tr>
<td>Periodically synchronise users with JIRA</td>
<td>Select <strong>Yes</strong> to ensure that JIRA will synchronize all changes in the user information on a regular basis. Change the value for <strong>Synchronise Period</strong> if required.</td>
</tr>
<tr>
<td>When Synchronisation Happens</td>
<td>Select an option depending on whether you want to allow changes to user attributes from within FishEye.</td>
</tr>
<tr>
<td>Single Sign On</td>
<td>Select <strong>Disabled</strong>. SSO is not available when using JIRA for user management and if enabled will make the integration fail.</td>
</tr>
</tbody>
</table>

d. Click **Next** and select at least one user group to be synchronised from JIRA. If necessary, you could create a new group in JIRA, such as ‘fisheye-users’, and select this group here.

e. Click **Save**.

- For Stash:
   a. Go to the Stash administration area.

   b. Click **User Directories** in the left-hand panel.

   c. Add a directory and select type **Atlassian JIRA**.

   d. Enter the following information:

   - **Name** – Enter the name of your JIRA server.
- **Server URL** – Enter web address of your JIRA server. Examples:

  http://www.example.com:8080/jira/
  http://jira.example.com

- **Application name** and **Application password** – Enter the values that you defined for Stash in the settings on JIRA.

e. Save the directory settings.
f. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen.
   For details see Connecting Stash to JIRA for user management.

**Notes**

- When you connect to JIRA in the setup wizard, the setup procedure will configure **Trusted Applications authentication** for your application. Please be aware of the following security implications:
  - Trusted applications are a **potential security risk**. When you configure Trusted Applications authentication, you are allowing one application to access another as any user. This allows all of the built-in security measures to be bypassed. Do not configure a trusted application unless you know that all code in the application you are trusting will behave itself at all times, and you are sure that the application will maintain the security of its private key.

- In the next step, you will specify the username and password of your **Confluence system administrator**. If you have connected to JIRA, the setup wizard will add the Confluence administrator's username and password to both JIRA and Confluence. This is done so that you can still access Confluence even if JIRA is down. Please note that the password in Confluence is not linked to the password in JIRA. If you subsequently change the administrator's password, only the password in JIRA will change. This is because the JIRA user directory is placed first in the list of user directories. See Managing Multiple Directories.

Related Topics

User Management Limitations and Recommendations
Confluence Setup Guide
Upgrading Confluence

This document describes the procedure for upgrading to the latest version of Confluence on Windows or Linux.

Before you start

- Check your Confluence **licence is valid**.
  
  To check go to ⚙ > General Configuration > Atlassian Support Tools > Health Check and make sure the license support period has not expired. If your support period has expired renew your licence and reapply it before proceeding with the upgrade.

- Read the **Release Notes** and **Upgrade Notes** for both the version you are upgrading to, and any versions you are skipping.

- Check that your **Java version, application server, operating system, database and browsers** are supported.
  
  See Supported Platforms and End of Support Announcements for Confluence to confirm latest requirements.

- Check the latest **database setup guide** for your database and ensure that the database is configured correctly. There may be new configuration requirements. See Database Configuration.

- Check the **compatibility of any add-ons**.
  
  Some add-ons may not yet be compatible with the latest version of Confluence. See Checking add-on compatibility with application updates to find out how to check this in the Universal Plugin Manager.

- Check for any **known issues** that might affect your instance.
  
  See the Confluence Knowledge Base for known issues for the version you are upgrading to and Databases Troubleshooting for known issues related to supported external databases.
• Make a note of any **modifications** to your Confluence instance (for example layouts or a custom theme). Any customisation you wish to maintain will need to be reapplied after upgrading. See Additional steps where customisations are present.

**Step 1 Determine your upgrade path and method**

Find the upgrade path that works for your current version of Confluence and the version you plan to upgrade to.

The following table will help you to determine the most efficient upgrade path from your current version to the latest versions of Confluence. To use the table find your current installed version of Confluence in the left column and follow the suggested path.

<table>
<thead>
<tr>
<th>Your Version</th>
<th>Recommended upgrade path to Confluence 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.7 or earlier</td>
<td>Upgrade to <strong>2.7.4</strong> then upgrade to <strong>3.5.17</strong>, and follow paths below.</td>
</tr>
<tr>
<td>2.8 to 3.4</td>
<td>Upgrade to <strong>3.5.17</strong>, and follow paths below.</td>
</tr>
<tr>
<td>3.5</td>
<td>Upgrade to <strong>5.0.3</strong> then upgrade to the latest version of Confluence 5.</td>
</tr>
<tr>
<td>4.0 to 4.3</td>
<td>Upgrade directly to the latest version of Confluence 5.</td>
</tr>
<tr>
<td>5.0 to 5.6</td>
<td>Upgrade directly to the latest version of Confluence 5.</td>
</tr>
</tbody>
</table>

There are several factors that will determine the upgrade method you should use. If you:

• Are upgrading from a version earlier than Confluence **3.5** you will need to **upgrade manually**. You can contact Support for help determining an appropriate upgrade path.
• Are moving to a different operating system or file location you should **upgrade manually**.
• Are moving to a different database you should upgrade using the installer first and then follow the procedure outlined in migrating to a different database.
• Have a **clustered** instance of Confluence you should follow the procedure outlined in Upgrading Confluence Data Center.
• Are running the **EAR-WAR edition** you should check Installing the Confluence EAR-WAR Edition to see if any additional steps are required.
• Are using the **embedded HSQLDB database** you should **migrate to a different database before** upgrading. This database is supplied for evaluation purposes only and is not recommended for production environments. See embedded HSQLDB database for more information.

 Otherwise you should follow the instructions below and use the Windows or Linux installer to upgrade Confluence.

**Step 2 Upgrade Confluence in a test environment**

We strongly recommend you recreate your production instance and test the upgrade in this cloned environment.

1. Create a snapshot of your current production Confluence environment on a test server - see Moving Confluence Between Servers for how to do this.
2. Follow the steps below to perform the upgrade on your cloned environment.
3. Test all your unsupported add-ons (plugins) and any customisation (for example custom themes and layouts) with the new version before proceeding with the upgrade in your production environment.

**Step 3 Back up**

Before you begin the Confluence upgrade you must back up:

• **your external database**
  You must perform a manual backup of your external database and confirm that the backup was created properly. If you are unfamiliar with the backup-restore facilities of your database, you can simply restore the backup to a different system to ensure the backup worked before proceeding.
• **your Confluence Home directory**
  The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. The location of the Home directory is stored in a configuration file called **confluence-init.properties**, which is located inside the **confluence/WEB-INF/classes**
directory in your Confluence Installation directory.
If you store attachments outside the Confluence Home directory, you should also backup your
attachments directory.
- **the Confluence installation directory** or Confluence webapp (if you are using the EAR-WAR edition)
  This is where the Confluence application files and libraries were unpacked (unzipped) when Confluence
  was originally installed. Confluence does not modify or store any data in this directory.

The installation wizard will back up your Confluence directories as part of the installation process, but you should
also back these directions up manually before starting the upgrade.

**Step 4 Upgrade Confluence in your production environment**

1. Download the appropriate Windows or Linux installer from the Confluence Download Center.
2. Start the installer:
   - **Windows Users:** run the .exe file.
     If prompted to allow the upgrade wizard to make changes to your computer, choose 'Yes'. If you do not,
     the installation wizard will have restricted access to your operating system and any
     subsequent installation options will be limited.
   - **Linux users:** open a Linux console and change directory (cd) to the '.bin' file directory and execute
     the '.bin' file.
     If the '.bin' file is not executable after downloading it, make it executable, for example chmod
     a+x atlassian-confluence-5.6.1-x64.bin (specify the exact filename of the installer you
downloaded).
3. The installation wizard will guide you through the upgrade process. Some things to note:
   a. When prompted choose **Upgrade an existing Confluence installation** (for Linux users this is
      option 3).
   b. Verify that the **Existing Confluence installation directory** suggested by the wizard is correct.
      This is especially important if you have multiple Confluence installations running on the same
      machine.
   c. At the 'Back up Confluence directories' step, ensure 'Back up Confluence home' is selected. This
      will create a .zip backup of the Confluence home and installation directories. **This is strongly
      recommended**.
   d. The installation wizard will notify you of customisations in the Confluence Installation directory.
      Make a note of these before proceeding as you will need to manually reapply these customisations
      after the upgrade is complete.
   e. If you have not already done so, the wizard will prompt you to backup your external database and
      check plugin compatibility. If your database does not support online backups you will need to stop
      the installation wizard at this point.
4. The wizard will shut down your Confluence instance and proceed with the upgrade. Once complete, it will
   restart Confluence and you can then launch Confluence in your browser to confirm the upgrade was
   successful.

During the upgrade the wizard will migrate following from your existing Confluence installation:
- **TCP port values** in your **server.xml** file.
- **Custom values** in your **confluence-init.properties** (confluence.home property) and **setenv.sh** /
  **setenv.bat** files (CATALINA_OPTS or JAVA_OPTS parameters)

If you are using an Oracle or MySQL database, you'll need to copy the jdbc driver jar file from your existing
Confluence installation directory to **confluence/WEB-INF/lib** in your new installation directory.

⚠️ Other configurations or customisations (including any other modifications in the server.xml file) are not
migrated during the upgrade and need to be reapplied manually. See below for more information.

**Additional steps when customisations are present**

The installation wizard's ability to notify you about customisations will depend on how your existing Confluence instance was installed:
- If your current Confluence instance was installed using the installer, the wizard will check the entire
  Confluence Installation directory.
- If your current Confluence instance was installed manually it will only check the **confluence subdirectory**
  of the Confluence Installation directory. The installation wizard will **not** notify you of modifications in any
  other directory, for example modifications to start-up scripts under the **bin** directory or modifications to
the `server.xml` file (such as an SSL configuration).

If customisations are present you will need to perform the following steps after the upgrade is complete:

1. Stop the upgraded Confluence instance.
2. Reapply the customisations to the relevant files in the upgraded Confluence Installation directory.
3. Restart the upgraded Confluence instance.

We strongly recommend you test your customisations in a test instance prior to upgrading your production instance as changes may have been made to Confluence that make your customisations unsuable.

Troubleshooting

Did something go wrong?

If you need to retry the upgrade, you must restore your pre-upgrade backups first. Do not attempt to run an upgrade again, or start the older version of Confluence again after an upgrade has failed.

Some common issues encountered while upgrading:

- **Cannot proceed with upgrade because license has expired**
  If your licence has expired and was not renewed and reapplied before upgrading you will receive errors during the upgrade process. See upgrading beyond current license period for information on how to resolve this problem.

- **Unable to proceed with upgrade because of a conflict with anti virus**
  Some anti-virus or other Internet security tools may interfere with the Confluence upgrade process and prevent the process from completing successfully, particularly if you run Confluence as a Windows service. If you experience or anticipate experiencing such an issue with your anti-virus / Internet security tool, disable this tool first before proceeding with the Confluence upgrade.

- **Database does not support online backups**
  The upgrade wizard will prompt you to backup your database using your database's backup utilities. If your database does not support online backups, stop the upgrade process, shut down Confluence, perform your database backup and then run the installer again to continue with the upgrade.

- **Upgrade is taking a very long time**
  If you have a very large database (i.e. database backups take a very long time to complete), setting the `confluence.upgrade.recovery.file.enabled` system property to false will speed up the upgrade process. It should be used only when there is a process to back up database and verify the backup before performing an upgrade.

You can also refer to the Upgrade Troubleshooting guide in the Confluence Knowledge Base, or check for answers from the community at Atlassian Answers.

Upgrading Beyond Current Licensed Period

This page explains the recovery process should you mistakenly try to upgrade your Confluence installation to a version beyond your current license entitlement.

**License warnings**

During an upgrade an obvious indication that your license has expired can be found in your log file. You will see a 'WARN' level entry similar to this:

```java
[confluence.upgrade.impl.DefaultUpgradeManager] isUpgradeAllowed
Your license is now outside of its support period.
You need to renew the license before you can upgrade to this version of Confluence.
```

When you try to access the Confluence site in your browser, you will see the following warning screen:
### Updating the Confluence license

1. Contact Atlassian Sales to arrange for a new license to be issued, as instructed on the warning screen illustrated above.
2. Once you have received a suitable license, supply the license key to Confluence:
   - Click link given on the license warning screen, illustrated above.
   - You will first be asked to log in as a Confluence administrator.
   - Then you will be presented with a simplified license administration screen. Enter the credentials of a Confluence system administrator.
   - Copy the license key into the License field and choose Save.

3. Restart Confluence to continue the upgrade.

### Confluence Post-Upgrade Checks

This article provides a list of items for Confluence Administrators to check after a Confluence upgrade to ensure that it has completed successfully. This list is not exhaustive, but it does cover common upgrade mistakes.

#### Before You Begin

After you have completed an upgrade, you should see the following message in the `atlassian-confluence.log` file:

```
2010-03-08 08:03:58,899 INFO [main] [atlassian.confluence.upgrade.AbstractUpgradeManager] upgradeFinished Upgrade completed successfully
```

If you do not see the line in your log similar to the one above, this means that your upgrade has not completed successfully. Please check our Upgrade Troubleshooting documentation to check for a suitable recommendation or fix. If there are no errors logged or if none of the errors are referenced in the Troubleshooting Updates documentation, please contact Atlassian Support.

#### Upgrade Checklist

Below is a recommended list of items to check after completing an upgrade.
1. Layout and Menu

Visit the Confluence dashboard and check that it is accessible and displays as expected. Test the different Internet browsers that you have in use in your environment. In addition, confirm that the layout appears as expected and that the menus are clickable and functioning.

2. Search

Try searching for content, for example pages, attachments or user names. Check that the expected results are returned.

3. Permissions

Confirm that you can visit a page that has view restrictions, but you have permission to view. Confirm that you can edit a page that has edit restrictions but you have permission to edit. Make sure that the permissions of child pages are functioning as well. Involve as many space administrators as possible to confirm they are working. Confirm that anonymous or forbidden users cannot access or modify restricted pages.

4. Attachments

Confirm that attachments are accessible and searchable.

5. Plugins

Outdated third-party plugins can cause upgrade failure. Quite often, they will just be incompatible and simply do not work anymore. If you discover that your plugin is no longer working, please check for the latest version for your plugin in the Atlassian Plugin Exchange or check for compatibility in the Universal Plugin Manager.

Upgrading Confluence EAR-WAR Distribution

This document tells you how to upgrade from one version of Confluence to a later version. These instructions apply to the EAR-WAR Distribution of Confluence, deployed on your own existing application server.

If you want to upgrade the regular Confluence distribution, which includes Apache Tomcat as the application server, please refer to Upgrading Confluence instead.

Please also check the following before you start using this guide:

- The version of Confluence that you will be upgrading to. Refer to the documentation home page to verify the latest Confluence version and to find documentation for older versions.
- The supported platforms for the version that you will be upgrading to. Please see the Supported Platforms page for the version of Confluence that you will be upgrading to, as well as the End of Support Announcements for Confluence.
- If you are running Confluence on a cluster, please see Upgrading Confluence Data Center instead of this document.

Upgrading to Confluence 5.6?

If so, please review the Confluence 5.6 Release Notes for important information about this version of Confluence. Ensure that you have read the Confluence 5.6 Known Issues in the Confluence Knowledge Base.

Also, we strongly recommend that you check the upgrade notes for every major version of Confluence that you are skipping, since there might be specific changes between Confluence versions that could affect your Confluence installation. The upgrade notes for recent major versions of Confluence are accessible from the Upgrade Notes Overview page.

Finally, please check the Supported Platforms page to ensure that your Java version, operating system, application server, database and browser are supported for this release of Confluence. The End of Support Announcements for Confluence page has important information regarding supported platforms.

On this page:

- Before you Start
- Backing Up
- Testing the Upgrade in a Test Environment
- Performing the Upgrade
• Reapplying Customisations to your New Confluence
• Checking for Known Issues and Troubleshooting the Confluence Upgrade

Before you Start

1. If you are planning to change to a different database, we recommend that you complete the Confluence upgrade first. Then follow the instructions on migrating to a different database.
2. Note that you need current software maintenance to perform the upgrade.
3. Confirm that your license support period is still valid before you try to upgrade.
4. If your current license has expired but you have a new license with you, please update your license in Confluence before performing the upgrade.
   ❗ If you forget to do this and your license has expired, you will receive errors during the upgrade process. Refer to the instructions on upgrading beyond current license period.
5. Check the release notes for the new version of Confluence you are installing, plus the upgrade notes for any major versions you are skipping. It is important to read these upgrade notes as there might be specific changes between Confluence versions that could affect your Confluence instance. The upgrade notes pages for recent major versions of Confluence are accessible from the Upgrade Notes Overview page. (Each upgrade notes page is a 'child' of its respective release notes page.)
6. Make sure that your environment (e.g. the database system, the operating system, the application server and so on) still complies with the Confluence System Requirements. A newer version of Confluence may have different requirements than the previous version.
7. If you are using Confluence EAR-WAR edition, check Installing the Confluence EAR-WAR Edition to see if there is anything extra you will need to do to get Confluence running.
8. If you are using an external database, familiarise yourself with all known issues for your specific database. Also make sure the Confluence database connector principal (the database user account) has sufficient permissions to modify the database schema.
9. Note which plugins (add-ons) are installed and enabled on your current Confluence site. Please verify whether a compatible version of the plugin is available in the version of Confluence you are upgrading to. This information is available via the Confluence Upgrade Check in the plugin administration section of Confluence. See the documentation: Checking add-on compatibility with application updates. You can also check the respective home pages for these plugins on the Atlassian Plugin Exchange. Once you have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading Confluence. Please test these first by applying them to the latest Confluence version in a test environment.
10. If you have made any customisations to Confluence, please verify their compatibility in the latest version. For example, if you have modified any layouts or are using your own custom theme, please test these first by applying them to the latest Confluence version in a test environment. You can see the customisations applied to your Confluence installation.
11. Some anti-virus or other Internet security tools may interfere with the Confluence upgrade process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence upgrade.
12. After upgrading, Confluence may need to rebuild its indexes. If this happens, there may be some extra load placed on the server following the upgrade. Make sure to schedule any upgrade of production Confluence outside of hours where people need to use it.

Backing Up

Before you begin the Confluence upgrade, you must back up the following:

1. **Back up your Confluence Home directory.** The location of the Home directory is stored in a configuration file called `confluence-init.properties`, which is located inside the `confluence/WEB-INF/classes` directory in your Confluence Installation directory. The Confluence installer will automatically prompt you to run a backup, storing the files in a .zip archive at the same level as your Confluence Home directory.
2. **Back up your database.** Perform a manual backup of your external database before proceeding with the upgrade, and double check that the backup was actually created properly. If you are not a database expert, or unfamiliar with the backup-restore facilities of your database, simply restore the backup to a different system to ensure the backup worked before proceeding. This recommendation is generally a good best practice. Surprisingly, many companies get in trouble for broken database backups because they skip this basic but vital "smoke test" of the operation. 

The ‘embedded database’ is the HSQLDB database supplied with Confluence for evaluation purposes.
You don't need to back it up since it is stored in the Confluence home directory. You should not be using this database for production systems at all, so if you happen to be using HSQLDB in a production system, please migrate to a proper database before the upgrade. Read about the various shortcomings of HSQLDB.

3. **Back up your Confluence Installation directory or your Confluence webapp** (if you are using Confluence EAR-WAR edition). The Confluence installer will automatically back up these files, storing the files in a .zip archive at the same level as your Confluence installation directory.

**Testing the Upgrade in a Test Environment**

> Be sure to test the upgrade in a test environment before proceeding on your production server.

1. Create a snapshot of your current production Confluence environment on a test server, as described in the page on Moving Confluence Between Servers.

**XML imports**

- Importing an old XML backup file to a new major version (for example, Confluence 3.5 to Confluence 4.0) is not recommended. Please recreate your production instance in a test environment first.

2. Perform the upgrade on your cloned environment.

3. Test all your unsupported plugins (add-ons) and any customisations with the new version before proceeding on your production server. You can read more about supported and unsupported plugins.

**Performing the Upgrade**

> If you are migrating servers or migrating databases, perform those operations in separate steps.

The upgrade process allows you to unzip the new Confluence installation into a directory of your choice and then edit the configuration files to point your new installation to your existing data files. Follow these instructions:

1. Shut down your existing Confluence instance.
2. Download the Confluence EAR-WAR zip file: Go to the Download Center, and click 'Show all' to find the EAR-WAR zip file.
3. If you are on Windows, please check your unzip program before extracting the downloaded zip file. Some archive-extract programs cause errors when unzipping the Confluence zip file. You should use a third-party unzip program like 7Zip or Winzip. If you do not have one, please download and install one before continuing:
   - 7Zip — Recommended. If in doubt, download the '32-bit.exe' version
   - Winzip
4. Use your unzip program to unzip the installation file. You should now have a new directory called confluence-<version>.
   - In the rest of this document, we will refer to this as the <Installation-Directory>.
   - Do not use spaces in your directory path.
   - You can read more about the Confluence Installation directory.
5. Edit the confluence-init.properties file found at: <Installation-Directory>
WEB-INF/classes/confluence-init.properties
and update 'confluence.home' to point to your existing Confluence Home directory.
   - Make sure you have first backed up your Home directory.
   - Open the confluence-init.properties file in a text editor such as Notepad.
   - Scroll to the bottom and find this line:

```
# confluence.home=c:/confluence/data
```
   - Remove the '#' and the space at the beginning of this line, so that Confluence no longer regards
the line as a comment. The line should now begin with `confluence.home`.

- Update the directory name after the `=` sign, to point to your existing Confluence Home directory.

6. If you are using Tomcat, you need to update either your `confluence.xml` or `server.xml` (depending on where you have defined the Confluence context descriptor) to point to the location of the new Confluence installation (also remember to copy over any customisations such as a tomcat datasource if you have one).

7. If you have delegated your user management to JIRA, LDAP or any other external user management system, copy the following files from your old Confluence installation to your new Confluence installation:
   - `<Installation-Directory>/confluence/WEB-INF/classes/osuser.xml`
   - `<Installation-Directory>/confluence/WEB-INF/classes/atlassian-user.xml` (if you are upgrading from Confluence 2.2 or later).

8. If you have delegated your user management to Crowd, you will also need to copy the Crowd client library and configuration files from your old Confluence installation to your new Confluence installation: `<Installation-Directory>/confluence/WEB-INF/lib/crowd-integration-client-X.X.X.jar` and `<Installation-Directory>/confluence/WEB-INF/classes/crowd.properties`. If you need more information, please refer to the Crowd documentation.

9. Restart your application server and start Confluence. **Please note** that Confluence will need to re-index attachments and this can take 5-10 minutes. Please wait until Confluence has finished indexing the attachments before trying to access Confluence via your web browser. (There is no easy and quick way to determine if the indexing process is completed. Please wait for approximately 10 minutes after the server start up before accessing Confluence via a web browser.)

10. During the startup process Confluence will create any missing database indexes. If you created any database indexes on your own, please check those afterwards and remove those that duplicate the indexes added by Confluence. Just in case you run into any errors which prevent Confluence from starting up, you can set the system property `hibernate.hbm2ddl.skip_creating_missing_index` to `true` to skip automatic index creation.

11. Visit Confluence in your web browser and log in using a username from your previous Confluence installation. You should be able to log in immediately, without seeing the Setup Wizard.

12. Take a quick look around your Confluence site to confirm that all your spaces and pages are present and everything looks normal. You should see the new Confluence version number in the page footer.

13. Consider any adjustments you need to make to customisations and special configurations, as described below.

### Reapplying Customisations to your New Confluence

**Hint: The steps below are for advanced Confluence users, who have applied special settings to their Confluence server and/or Confluence look and feel**

After upgrading your Confluence installation to a later version of Confluence, you need to consider any...
customisations you have applied to your system and other special configurations:

- If you had previously installed **Confluence/Tomcat as a Windows service**, uninstall the service (to ensure that the old Confluence cannot start automatically when the server restarts) and reinstall the new one. For details please see [Start Confluence Automatically on Windows as a Service](#).
- If you are using the Confluence distribution and you have previously defined a **CATALINA_HOME environment variable**, please check that it points to the correct path for the new Confluence Tomcat server.
- If you had previously connected your Confluence installation to an external database via a JNDI datasource or you implemented **SSL**, edit your new `<Installation-Directory>/conf/server.xml` file and copy over any relevant modifications from your old `web.xml` file, which relate to these customisations.
- If you were previously running **Confluence on a non-standard port**, edit your new `<Installation-Directory>/conf/server.xml` file as described in [Change listen port for Confluence](#).
- If you had previously defined a **Tomcat datasource**, edit your new `<Installation-Directory>/conf/server.xml` and copy over the datasource definition from your old server.xml.
- If you were previously using any **plugins**, install the latest compatible version and disable any plugins that are incompatible with your new version of Confluence. The easiest way to do this is to use the Universal Plugin Manager in the Confluence Administration Console.
- If you are using any **customised themes**, please check that they are displaying as expected. Some further customisation may be required to ensure compatibility with your new version of Confluence.
- If you had previously customised the **default site or space layouts**, you will need to reapply your changes to the new defaults as described here.
- If you had previously modified the Confluence **source code**, you will need to reapply your changes to the new version.
- If you were previously running **Confluence over SSL**, you will need to reapply your configuration as described in [Running Confluence Over SSL or HTTPS](#).
- If you had previously modified the **memory flags** (`Xms` and `Xmx`) in either the `<Installation-Directory>/bin/setenv.sh` or the `<Installation-Directory>/bin/setenv.bat` file, you may want to make the modifications in your new installation. The parameters are specified in the `CATALINA_OPTS` variable.
- If you had changed the **Confluence interface text**, you will need to pull over the `ConfluenceActionSupport.properties` file.
- If you were using a custom SSO authenticator, change `seraph-config.xml` to the correct authenticator.

### Checking for Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the **Confluence post-upgrade checklist** to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.
- **Check for answers from the community.** Other users may have encountered the same issue. You can check for answers from the community at [Atlassian Answers](#).
- **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to [troubleshooting upgrades](#) in the Confluence Knowledge Base.

### Migration from Wiki Markup to XHTML-Based Storage Format

If you are upgrading **to Confluence 4.0 or later** from an older version (From Confluence 3.5.x or earlier) then as part of the upgrade an automatic migration of your content will take place. This is a non-destructive process. Your existing content is not overwritten. Instead, the migration process will create a new version of each wiki markup page. The new version will use the new XHTML-based storage format, so that you can edit the page in the Confluence rich text editor.

In addition, if you are **upgrading to Confluence 4.3 or later** from an older version then as part of the upgrade an automatic migration of your page templates will take place. See [Migration of Templates from Wiki Markup to XHTML-Based Storage Format](#).

**Note:** Even though the process is non-destructive, you must be sure to perform a backup of your database and home directory prior to starting the new version of Confluence, as we recommend for any **Confluence upgrade.**
Migration process

Depending on the size of your Confluence installation, the migration from wiki markup to the new XHTML-based storage format could prove time consuming. The duration of the migration is difficult to estimate; this is due to a number of site specific factors. As a rough guide, a test dataset we migrated was 130,000 pages, totalling approximately 700Mb, which took six minutes.

On this page:
- Migration process
- Watching the migration logs during the upgrade
- Re-running the migration – for content that completely failed the migration
- Re-attempting the migration – for content in 'unmigrated-wiki-markup' macro
- Notes

Related pages:
- Migration of Templates from Wiki Markup to XHTML-Based Storage Format
- Upgrading Confluence

The following properties that can be modified to allow finer control over the migration process:

<table>
<thead>
<tr>
<th>Property</th>
<th>Purpose</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>confluence.wiki.migration.threads</td>
<td>The number of concurrent worker threads migrating content</td>
<td>4</td>
</tr>
<tr>
<td>confluence.wiki.migration.batch.size</td>
<td>The number of items migrated in each batch of work</td>
<td>500</td>
</tr>
<tr>
<td>confluence.wiki.migration.versioncomment</td>
<td>The comment associated with the newly migrated version of each piece of content</td>
<td>&quot;Migrated to Confluence 4.0&quot;</td>
</tr>
</tbody>
</table>

(For instructions on setting Confluence system properties see this document.)

Again, due to the large variability in Confluence installations it is hard to give specific recommendations for the above settings. One point to note though that both increasing batch size and the number of threads (or both) will increase the peak memory required for migration. If memory is an issue then as you increase one of these settings consider decreasing the other.

Another factor to be aware of if modifying these defaults is that of the cache settings employed in your site. The migration will quickly populate certain Confluence caches so be sure that if you have customised caches as described here that there is enough memory on the server for these caches should they reach maximum capacity.

Watching the migration logs during the upgrade

To monitor the progress of a site migration you should watch the output in the application log.

Typical logging progress will be shown by multiple log entries at the INFO level of the following format:

```
WikiToXhtmlMigrationThread-n - Migrated 2500 of 158432 pages, this batch migrated 500/500 without error
```

There may be a wide array of messages logged from each individual page but any errors are also collected for display in a single migration report once all content has been processed. Here is a typical example of such a report:
Wiki to XHTML Exception Report:

Summary:
0 settings values failed.
0 PageTemplates failed.
2 ContentEntityObjects failed.

Content Exceptions:
1) Type: page, Id: 332, Title: Release Notes 1.0b3, Space: DOC - Confluence 4.0 Beta. Cause: com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro link is unknown. Message: The macro link is unknown.
2) Type: comment, Id: 6919, Title: null, Global Scope. Cause: com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro mymacro is unknown. Message: The macro mymacro is unknown.

Each entry in the report will identify the content that caused migration exceptions as well as displaying the exceptions themselves.

In almost all cases any content reported as errored will have been migrated to the new XHTML-based storage format, but will actually consist of wiki markup content wrapped within an XML 'unmigrated-wiki-markup' macro. This content will still be viewable in Confluence and editable within the new Confluence Editor.

However, in some cases a batch of content may actually have completely failed to migrated. This is most typically due to an unhandled exception causing a database transaction rollback. This would be reported in the log with a message like this:

Unable to start up Confluence. Fatal error during startup sequence: confluence.lifecycle.core:pluginframeworkdependentupgrades (Run all the upgrades that require the plugin framework to be available) - com.atlassian.confluence.content.render.xhtml.migration.exceptions.MigrationException: java.util.concurrent.ExecutionException: org.springframework.transaction.UnexpectedRollbackException: Transaction rolled back because it has been marked as rollback-only

Confluence provides no further report about this scenario and will also allow Confluence to restart as normal without retrying a migration. If a user tries to view any such unmigrated content they will see an exception similar to this:

java.lang.UnsupportedOperationException: The body of this ContentEntityObject ('Page Title') was 'WIKI' but was expected to be 'XHTML'

The solution is to ensure you manually re-run the site migration after the restart.

Re-running the migration – for content that completely failed the migration

A Confluence Administrator can restart the site migration if there was any content that failed migration (see previous section). Only the content that is still formatted in wiki markup will be migrated, so typically a re-migration will take less time than the original migration.

To manually re-run migration:
1. Open this URL in your browser: <Confluence Address>/admin/force-upgrade.action
2. Select wikiToXhtmlMigrationUpgradeTask in the Upgrade task to run dropdown list.
3. Choose Force Upgrade.
Re-attempting the migration – for content in 'unmigrated-wiki-markup' macro

The previous section was about dealing with the exceptional circumstance where certain content was left completely unmigrated. The most common migration problem is that the content was migrated but remains formatted as wiki markup on the page, within the body of an 'unmigrated-wiki-markup' macro. Any content which is referenced in the migration report will be found in this state. This content is still viewable and editable but since it is wiki markup it cannot be edited using the full feature set of the rich text editor.

The most common reason for content to be in this state is that the page contains an unknown macro, or a macro that is not compatible with Confluence 4.x.

There are two possible fixes for this situation:

1. Install a version of the macro that is compatible with Confluence 4.x. See Plugin Development Upgrade FAQ for 4.0.
2. Edit the page and remove the problematic macro.

Regardless of the solution you choose, you can then force a re-migration of all the content (including content in templates) that was left wrapped in an 'unmigrated-wiki-markup' macro. This feature is found at <Confluence Address>/admin/unmigratedcontent.action

Notes
We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the
Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

Migration of Templates from Wiki Markup to XHTML-Based Storage Format

If you are upgrading to Confluence 4.3 or later from an older version (from Confluence 4.2.x or earlier) then as part of the upgrade an automatic migration of your page templates will take place. This is a non-destructive process. Your existing content is not overwritten. Instead, the migration process will create a new version of each space template and each global template on your Confluence site. The new version will use the new XHTML-based storage format, so that you can edit the template in the Confluence rich text editor.

Note: Nevertheless, you must be sure to perform a backup of your database and home directory prior to starting the new version of Confluence, as we recommend for any Confluence upgrade.

Watching the migration logs during the upgrade

To monitor the progress of a site migration you should watch the output in the application log.

A typical logging progress will be shown by multiple log entries at the INFO level of the following format:

```
WikiToXhtmlMigrationThread-n - Migrated 22 of 29 PageTemplates.
```

There may be a wide array of messages logged from each individual template, but any errors are also collected for display in a single migration report once all content has been processed. Here is a typical example of such a report:

```
Wiki to XHTML Exception Report:
Summary:
  0 settings values failed.
  2 PageTemplates failed.
  0 ContentEntityObjects failed.
Content Exceptions:
  1) Type: page, Id: 332, Title: Release Notes 1.0b3, Space: DOC - Confluence 4.0 Beta. Cause: com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro link is unknown.. Message: The macro link is unknown.
  2) Type: comment, Id: 6919, Title: null, Global Scope. Cause: com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro mymacro is unknown.. Message: The macro mymacro is unknown.
```

Each entry in the report will identify the content that caused migration exceptions as well as displaying the exceptions themselves.

In almost all cases any content reported as errored will have been migrated to the new XHTML-based storage format, but will actually consist of wiki markup content wrapped within an XML ‘unmigrated-wiki-markup’ macro. This content will still be viewable in Confluence and editable within the Confluence rich text editor.
However, in some cases a batch of content may actually have completely failed to migrate. This is most typically due to an unhandled exception causing a database transaction rollback. This would be reported in the log with a message like this:

```
Unable to start up Confluence. Fatal error during startup sequence:
confluence.lifecycle.core:pluginframeworkdependentupgrades (Run all the
upgrades that require the plugin framework to be available) -
com.atlassian.confluence.content.render.xhtml.migration.exceptions.MigrationException: java.util.concurrent.ExecutionException: org.springframework.transaction.UnexpectedRollbackException: Transaction rolled back because it has been marked as rollback-only
```

Confluence provides no further report about this scenario and will also allow Confluence to restart as normal without retrying a migration. If a user tries to view or edit an unmigrated template, the wiki template editor will be used.

The solution is to manually re-run the site migration after the restart, as described below.

**Re-running the migration**

A Confluence administrator can restart the template migration if any templates have failed the migration (see previous section). Only the templates that are still formatted in wiki markup will be migrated again. Typically, a re-migration will take less time than the original migration.

**To manually re-run the migration:**

1. Open this URL in your browser: <Confluence Address>/admin/force-upgrade.action
2. Select `pageTemplateWikiToXhtmlMigrationUpgradeTask` in the Upgrade task to run dropdown list.
3. Choose Force Upgrade.

**Screenshot: The 'Force Upgrade' screen in the Confluence administration console**

```
Force Upgrade

This will run the selected upgrade task. You should only run any of these tasks if you were directed here by support documentation.

Upgrade task to run: pageTemplateWikiToXhtmlMigrationUpgradeTask

Migrate all wiki formatted page templates in this Confluence instance to XHTML

[Force Upgrade] [Cancel]
```

**Notes**

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

**Upgrading Confluence Manually**

This document tells you how to upgrade from one version of Confluence to a later version. This document refers to the Confluence distribution that includes Apache Tomcat as the bundled application server. If you want to upgrade an EAR/WAR distribution deployed on your own existing application server, please refer to Upgrading Confluence EAR-WAR Distribution instead.

Please also check the following before you start using this guide:
- The **version of Confluence** that you will be upgrading to. Refer to the documentation home page to verify the latest Confluence version and to find documentation for older versions.
- The **supported platforms** for the version that you will be upgrading to. Please see the Supported Platforms page for the version of Confluence that you will be upgrading to, as well as the End of Support Announcements for Confluence.
- If you are running **Confluence on a cluster**, please see Upgrading Confluence Data Center instead of this document.

### Upgrading to Confluence 5.6?

If so, please review the Confluence 5.6 Release Notes for important information about this version of Confluence. Ensure that you have read the Confluence 5.6 Known Issues in the Confluence Knowledge Base.

Also, we strongly recommend that you check the upgrade notes for every major version of Confluence that you are skipping, since there might be specific changes between Confluence versions that could affect your Confluence installation. The upgrade notes for recent major versions of Confluence are accessible from the Upgrade Notes Overview page.

Finally, please check the Supported Platforms page to ensure that your Java version, operating system, application server, database and browser are supported for this release of Confluence. The End of Support Announcements for Confluence page has important information regarding supported platforms.

### On this page:

- Before you Start
- Backing Up
- Testing the Upgrade in a Test Environment
- Performing the Upgrade
- Reapplying Customisations to your New Confluence
- Checking for Known Issues and Troubleshooting the Confluence Upgrade
- Useful Plugins

### Before you Start

1. If you are planning to change to a different database, we recommend that you complete the Confluence upgrade first. Then follow the instructions on migrating to a different database.
2. Note that you need current software maintenance to perform the upgrade.
3. Confirm that your license support period is still valid before you try to upgrade.
4. If your current license has expired but you have a new license with you, please upgrade your license in Confluence before performing the upgrade. If you forget to do this and your license has expired, you will receive errors during the upgrade process. Refer to the instructions on upgrading beyond current license period.
5. Check the release notes for the new version of Confluence you are installing, plus the upgrade notes for any major versions you are skipping. It is important to read these upgrade notes as there might be specific changes between Confluence versions that could affect your Confluence instance. The upgrade notes pages for recent major versions of Confluence are accessible from the Upgrade Notes Overview page. (Each upgrade notes page is a 'child' of its respective release notes page.)
6. Make sure that your environment (e.g. the database system, the operating system, the application server and so on) still complies with the Confluence System Requirements. A newer version of Confluence may have different requirements than the previous version.
7. If you are using Confluence EAR-WAR edition, check Installing the Confluence EAR-WAR Edition to see if there is anything extra you will need to do to get Confluence running.
8. If you are using an external database, familiarise yourself with all known issues for your specific database. Also make sure the Confluence database connector principal (the database user account) has sufficient permissions to modify the database schema.
9. Note which plugins (add-ons) are installed and enabled on your current Confluence site. Please verify whether a compatible version of the plugin is available in the version of Confluence you are upgrading to. This information is available via the Confluence Upgrade Check in the plugin administration section of Confluence. See the documentation: Checking add-on compatibility with application updates. You can also check the respective home pages for these plugins on the Atlassian Plugin Exchange. Once you
have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading Confluence. Please test these first by applying them to the latest Confluence version in a test environment.

10. If you have made any customisations to Confluence, please verify their compatibility in the latest version. For example, if you have modified any layouts or are using your own custom theme, please test these first by applying them to the latest Confluence version in a test environment. You can see the customisations applied to your Confluence installation.

11. Some anti-virus or other Internet security tools may interfere with the Confluence upgrade process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence upgrade.

12. After upgrading, Confluence may need to rebuild its indexes. If this happens, there may be some extra load placed on the server following the upgrade. Make sure to schedule any upgrade of production Confluence outside of hours where people need to use it.

Back Up

Before you begin the Confluence upgrade, you must back up the following:

1. **Back up your Confluence Home directory.** The location of the Home directory is stored in a configuration file called `confluence-init.properties`, which is located inside the `confluence/WEB-INF/classes` directory in your Confluence Installation directory. The Confluence installer will automatically prompt you to run a backup, storing the files in a .zip archive at the same level as your Confluence Home directory.

2. **Back up your database.** Perform a manual backup of your external database before proceeding with the upgrade, and double check that the backup was actually created properly. If you are not a database expert, or unfamiliar with the backup-restore facilities of your database, simply restore the backup to a different system to ensure the backup worked before proceeding. This recommendation is generally a good best practice. Surprisingly, many companies get in trouble for broken database backups because they skip this basic but vital “smoke test” of the operation. The ‘embedded database’ is the HSQLDB database supplied with Confluence for evaluation purposes. You don’t need to back it up since it is stored in the Confluence home directory. You should not be using this database for production systems at all, so if you happen to be using HSQLDB in a production system, please migrate to a proper database before the upgrade. Read about the various shortcomings of HSQLDB.

3. **Back up your Confluence Installation directory or your Confluence webapp** (if you are using Confluence EAR-WAR edition). The Confluence installer will automatically back up these files, storing the files in a .zip archive at the same level as your Confluence installation directory.

Testing the Upgrade in a Test Environment

Be sure to test the upgrade in a test environment before proceeding on your production server.

1. Create a snapshot of your current production Confluence environment on a test server, as described in the page on Moving Confluence Between Servers.

**XML imports**

Importing an old XML backup file to a new major version (for example, Confluence 3.5 to Confluence 4.0) is not recommended. Please recreate your production instance in a test environment first.

2. Perform the upgrade on your cloned environment.

3. Test all your unsupported plugins (add-ons) and any customisations with the new version before proceeding on your production server. You can read more about supported and unsupported plugins.

Performing the Upgrade

If you are migrating servers or migrating databases, perform those operations in separate steps.
To install Confluence, unzip the new Confluence installation zip file into a directory of your choice and then edit the configuration files to point your new installation to your existing data files. Follow these instructions:

1. Shut down your existing Confluence instance.
2. Download the Confluence zip file.
3. If you are on Windows, please check your unzip program before extracting the downloaded zip file. Some archive-extract programs cause errors when unzipping the Confluence zip file. You should use a third-party unzip program like 7Zip or Winzip. If you do not have one, please download and install one before continuing:
   - 7Zip — Recommended. If in doubt, download the ‘32-bit.exe’ version
   - Winzip
4. Use your unzip program to unzip the installation file. You should now have a new directory called `confluence-<version>`, e.g. `confluence-4.0.0-std`.
   - In the rest of this document, we will refer to this as the `<Installation-Directory>`.
   - If you decide to change the location from the default, make sure that you choose a different location from your existing Confluence installation, because legacy files may cause problems if you install the new Confluence version into an existing directory.
   - Do not use spaces in your directory path.
   - You can read more about the Confluence Installation directory.
5. Edit the `confluence-init.properties` file found at: `<Installation-Directory>/confluence\WEB-INF\classes\confluence-init.properties` and update 'confluence.home' to point to your existing Confluence Home directory.
   - You can read more about the Confluence Home directory.
   - Make sure you have first backed up this directory, as instructed above.
   - Open the `confluence-init.properties` file in a text editor such as Notepad.
   - Scroll to the bottom and find this line:
     ```
     # confluence.home=c:/confluence/data
     ```
   - Remove the '#' and the space at the beginning of this line, so that Confluence no longer regards the line as a comment. The line should now begin with `confluence.home`.
   - Update the directory name after the '=' sign, to point to your existing Confluence Home directory.
6. If you are running Confluence as a Windows service, use the command prompt and type `<Installation-Directory>\bin\service.bat remove Confluence`.

   It is vital that you stop and remove the existing service prior to uninstalling the old instance of Confluence! For more information on running Confluence as Windows service, please refer to the Start Confluence Automatically on Windows as a Service topic.

   To remove the service installed by the Confluence installer, you need to run the `<confluence auto installer installation folder>\UninstallService.bat`.
7. If you are using an external database (i.e. not the embedded HSQLDB database supplied for evaluation purposes), copy the jdbc driver jar file from your old Confluence installation to the new Confluence installation. The jdbc driver jar file in the old Confluence installation should be located in either the `<Installation-Directory>/common/lib` or `<Installation-Directory>/confluence/WEB-INF/lib` directories. Once you have identified this file, copy it to either the `<Installation-Directory>/lib` or `<Installation-Directory>/confluence/WEB-INF/lib` directories of your Confluence installation.
8. If you have delegated your user management to JIRA, LDAP, Crowd, or any other external user management system, copy the following files from your old Confluence installation to your new Confluence installation:
   - `<Installation-Directory>/confluence/WEB-INF/classes/osuser.xml`
   - `<Installation-Directory>/confluence/WEB-INF/classes/atlassian-user.xml` (if you are upgrading from Confluence 2.2 or later).

   If you are upgrading from an earlier version of Confluence (2.5.5 and earlier) and are copying your existing atlassian-user.xml file from your previous instance, please
9. If you have delegated your user management to Crowd, you will also need to copy the Crowd configuration file from your old Confluence installation to your new Confluence installation: `<Installation-Directory>/confluence/WEB-INF/classes/crowd.properties`. If you need more information, please refer to the Crowd documentation.

10. Consider any adjustments you need to make to customisations and special configurations, as described below.

    Your new version of Confluence may not function correctly or could encounter problems or errors if these are not implemented.

11. Start your new version of Confluence.

    Please note that Confluence will need to re-index attachments and this can take 5-10 minutes. Please wait until Confluence has finished indexing the attachments before trying to access Confluence via your web browser.

12. During the startup process Confluence will create any missing database indexes. If you created any database indexes on your own, please check those afterwards and remove those that duplicate the indexes added by Confluence. Just in case you run into any errors which prevent Confluence from starting up, you can set the system property `hibernate.hbm2ddl.skip_creating_missing_indexes` to `true` to skip automatic index creation.

13. Visit Confluence in your web browser and log in using a username from your previous Confluence installation. You should be able to log in immediately, without seeing the Setup Wizard.

14. Take a quick look around your Confluence site to confirm that all your spaces and pages are present and everything looks normal. You should see the new Confluence version number in the page footer.

Reapplying Customisations to your New Confluence

**Hint: The steps below are for advanced Confluence users, who have applied special settings to their Confluence server and/or Confluence look and feel**

After upgrading your Confluence installation to a later version of Confluence, you need to consider any customisations you have applied to your system and other special configurations:

- If you had previously installed **Confluence/Tomcat as a Windows service**, uninstall the service (to ensure that the old Confluence cannot start automatically when the server restarts) and reinstall the new one. For details please see Start Confluence Automatically on Windows as a Service.
- If you are using the Confluence distribution and you have previously defined a **CATALINA_HOME environment variable**, please check that it points to the correct path for the new Confluence Tomcat server.
- If you had previously connected your Confluence installation to an external database via a JNDI datasource or you implemented **SSL**, edit your new **web.xml** file and and copy over any relevant modifications from your old **web.xml** file, which relate to these customisations.
- If you were previously running **Confluence on a non-standard port**, edit your new `<Installation-Directory>/conf\server.xml` file as described in Change listen port for Confluence.
- If you had previously defined a **Tomcat datasource**, edit your new `<Installation-Directory>/conf\server.xml` and copy over the datasource definition from your old **server.xml**.
- If you were previously using any **plugins**, install the latest compatible version and disable any plugins that are incompatible with your new version of Confluence. The easiest way to do this is to use the Universal Plugin Manager in the Confluence Administration Console.
- If you are using any **customised themes**, please check that they are displaying as expected. Some further customisation may be required to ensure compatibility with your new version of Confluence.

```xml
<hibernate name="Hibernate Repository" key="hibernateRepository" description="Hibernate Repository" cache="true" />
```
• If you had previously customised the **default site or space layouts**, you will need to reapply your changes to the new defaults as described here.

• If you had previously modified the Confluence **source code**, you will need to reapply your changes to the new version.

• If you were previously running **Confluence over SSL**, you will need to reapply your configuration as described in Running Confluence Over SSL or HTTPS.

• If you had previously modified the **memory flags** (Xms and Xmx) in either the `<Installation-Directory>/bin/setenv.sh` or the `<Installation-Directory>/bin/setenv.bat` file, you may want to make the modifications in your new installation. The parameters are specified in the `CATALINA_OPTS` variable.

• If you had changed the **Confluence interface text**, you will need to pull over the ConfluenceActionSupport.properties file.

• If you were using a custom SSO authenticator, change seraph-config.xml to the correct authenticator.

### Checking for Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the **Confluence post-upgrade checklist** to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- **Check for answers from the community.** Other users may have encountered the same issue. You can check for answers from the community at [Atlassian Answers](https://answers.atlassian.com/).

- **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

### Useful Plugins

*Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.*

- Appfire’s **Upgrade Assistant for Confluence (UAC)** is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

### RELATED TOPICS

- Upgrading Confluence
- Upgrading Confluence EAR-WAR Distribution
- Confluence Installation Guide
- Site Backup and Restore
- Database Configuration

### Supported Platforms

This page describes the supported platforms for Confluence. Please review them before installing Confluence. The information on this page applies to **Confluence 5.6**.

Further information:

- **End of support for various platforms and browsers when used with Confluence:** [End of Support Announcements for Confluence](https://confluence.atlassian.com/display/DOC/End+of+Support+Announcements+for+Confluence).
- **More information about these supported platforms and hardware requirements:** [System Requirements](https://confluence.atlassian.com/display/DOC/System+Requirements).
- **Go to** ![Settings](https://confluence.atlassian.com/display/DOC/Settings) > General Configuration > Atlassian Support Tools > Health Check to run the health check, which looks at things like your licence validity, Tomcat version, basic database setup and more.
### Confluence 5.6 Documentation

**Related pages:**
- Confluence Installation Guide
- Confluence Setup Guide
- Installing Confluence and JIRA Together
- Server Hardware Requirements Guide
- Supported Platforms FAQ

**Key:** ✔ = Supported. ❌ = Not Supported

<table>
<thead>
<tr>
<th>Java version</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle JRE / JDK</td>
<td>✔ 1.7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operating systems for Confluence server installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows (including 64-bit) (1)</td>
</tr>
<tr>
<td>Linux / Solaris (1, 2)</td>
</tr>
<tr>
<td>Apple Mac OS X</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Application servers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apache Tomcat</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Databases</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL</td>
</tr>
<tr>
<td>MySQL (3)</td>
</tr>
<tr>
<td>Oracle</td>
</tr>
<tr>
<td>HSQLDB (4)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Web browsers – desktop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer (Windows) (5, 6)</td>
</tr>
<tr>
<td>Mozilla Firefox (all platforms)</td>
</tr>
<tr>
<td>Google Chrome (Windows and Mac) (7)</td>
</tr>
<tr>
<td>Safari (Mac)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Web browsers – mobile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile Safari (iOS) (8)</td>
</tr>
<tr>
<td>Android (Android) (9)</td>
</tr>
</tbody>
</table>

---

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
1. Confluence is a pure Java application and should run on this platform provided the JRE or JDK requirement is satisfied.
2. While some of our customers run Confluence on SPARC-based hardware, Atlassian only officially supports Confluence running on x86 hardware and 64-bit derivatives of x86 hardware.
3. Ensure that you configure your Confluence MySQL database to use the InnoDB storage engine as the MyISAM storage engine could lead to data corruption.
4. Confluence ships with a built-in HSQL database. While this database is fine for evaluation purposes, it is somewhat susceptible to data loss during system crashes. Hence, for production environments, we recommend that you configure Confluence to use an external database.
5. Internet Explorer 9 does not support the drag-and-drop functionality of HTML5. As Confluence relies on this functionality, the drag-and-drop experience in Internet Explorer 9 is not complete. Internet Explorer 10 in ‘desktop’ mode does support the drag-and-drop functionality, and the implementation of drag-and-drop in Confluence works as expected with Internet Explorer 10 ‘desktop’ mode. The ‘modern’ mode of Internet Explorer 10 does not support drag-and-drop.
6. Confluence is tested with these versions of Internet Explorer in standards-compliant rendering mode, not compatibility mode. Enabling compatibility mode may cause problems because it emulates older, unsupported rendering modes.
7. Chrome does not have WEBDAV / plugin support so features such as Edit in Word for attachments will not work. Please refer to CONF-23322 for information on the progress of this issue.
8. Confluence does not support editing in Mobile Safari on iOS devices (such as iPhone and iPad). Please refer to CONF-19523 for information on the progress of this issue.
9. Confluence does not support editing on Android devices.

End of Support Announcements for Confluence

This page contains announcements of the end of support for various platforms and browsers when used with Confluence. This is summarised in the table below. Please see the sections following for the full announcements.

End of Support Matrix for Confluence

The table below summarises information regarding the end of support announcements for upcoming Confluence releases. If a platform (version) has already reached its end of support date, it is not listed in the table.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Confluence End of Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apache Tomcat 6</td>
<td>With the release of Confluence 5.6 (announcement)</td>
</tr>
<tr>
<td>Internet Explorer 8</td>
<td>With the release of Confluence 5.6 (announcement)</td>
</tr>
<tr>
<td>PostgreSQL 8.4, 9.0 and 9.1</td>
<td>With the release of Confluence 5.7 (announcement)</td>
</tr>
<tr>
<td>MySQL 5.1</td>
<td>With the release of Confluence 5.7 (announcement)</td>
</tr>
<tr>
<td>EAR/WAR distribution</td>
<td>With the release of Confluence 5.7 (announcement)</td>
</tr>
</tbody>
</table>

Why is Atlassian ending support for these platforms?

Atlassian is committed to delivering improvements and bug fixes as fast as possible. We are also committed to providing world class support for all the platforms our customers run our software on. However, as the complexity of our applications grows, the cost of supporting multiple platforms increases exponentially. Each new feature has to be tested on several combinations of application servers, databases, web browsers, etc, with setup and ongoing maintenance of automated tests. Moving forward, we want to reduce the time spent there to increase Confluence development speed significantly.

On this page (most recent announcements first):

- Deprecated distribution for Confluence (2 September 2014)
- Deprecated databases for Confluence (12 June 2014)
- Deprecated Tomcat platform for Confluence (22 April 2014)
- Deprecated Databases for Confluence (2 December 2013)
Deprecated distribution for Confluence (2 September 2014)

To help us to make Confluence a more robust and scalable application, we have decided to stop providing an EAR/WAR distribution. This means that the only supported application server will be the version of Tomcat that is bundled with each release.

Confluence 5.6 will be the last Confluence release to provide an EAR/WAR edition.

If you have questions or concerns regarding this announcement, please contact us at eol-announcement at atlassian dot com.

Deprecated databases for Confluence (12 June 2014)

This section announces the end of Atlassian support for certain databases for Confluence. End of support means that Atlassian will not fix bugs related to the specified database past the support end date for your version of Confluence.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL 8.4</td>
<td></td>
</tr>
<tr>
<td>PostgreSQL 9.0</td>
<td></td>
</tr>
<tr>
<td>PostgreSQL 9.1</td>
<td>When Confluence 5.7 is released, due in late 2014</td>
</tr>
<tr>
<td>MySQL 5.1</td>
<td></td>
</tr>
</tbody>
</table>

Notes:

- Confluence 5.6 is the last version that will support the database versions listed above.
- Confluence 5.6 and previously-released versions will continue to work with the database versions listed above, however we will not fix bugs affecting these databases after the end-of-life date for your version of Confluence.
- Confluence 5.7 will not be tested with the databases listed above.

Deprecated Tomcat platform for Confluence (22 April 2014)
This section announces the end of Atlassian support for Tomcat 6.0.x for Confluence.

End of support means that Atlassian will not fix bugs related to the specified version of Tomcat, past the support end date for your version of Confluence. The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Tomcat 6.0.x Support

<table>
<thead>
<tr>
<th>Platform</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tomcat 6.0.x</td>
<td>When Confluence 5.6 is released, due in mid 2014</td>
</tr>
</tbody>
</table>

**Tomcat 6.0.x notes:**

- Confluence 5.5 is the last major version that will support Tomcat 6.0.x. The Confluence 5.5.x bug-fix releases will also continue to support Tomcat 6.0.x.
- Confluence 5.5.x and previously-released versions will continue to work with Tomcat 6.0.x. However, we will not fix bugs affecting Tomcat 6.0.x after the end-of-life date for your version of Confluence.
- Confluence 5.6 will not be tested with Tomcat 6.0.x.

### Deprecated Databases for Confluence (2 December 2013)

This section announces the end of Atlassian support for certain databases for Confluence. End of support means that Atlassian will not fix bugs related to the specified database past the support end date for your version of Confluence.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL 8.3</td>
<td>When Confluence 5.5 is released, due in early 2014</td>
</tr>
</tbody>
</table>

**PostgreSQL 8.3 notes:**

- Confluence 5.4 is the last version that will support PostgreSQL 8.3.
- Confluence 5.4 and previously-released versions will continue to work with PostgreSQL 8.3. However, we will not fix bugs affecting PostgreSQL 8.3 after the end-of-life date for your version of Confluence.
- Confluence 5.5 will not be tested with PostgreSQL 8.3.

### Deprecated Web Browsers for Confluence (24 September 2013)

To allow us to dedicate resources to providing the best experience on modern browsers, Confluence 5.5 will be the last release that supports Internet Explorer 8 (IE8). The reasons behind this decision are to enable us to provide the best user experience to our customers, accelerate our pace of innovation and give us the ability to utilise modern browser technologies.

*End of support* means that Atlassian will not perform any maintenance on Confluence related to IE8 after the final release of Confluence 5.5.x, except for security related issues. In order to minimise the impact on you and the way your company uses Confluence, we have provided this announcement as early as possible, and hope that the subsequent 6 month period will give you adequate time to prepare for this change without disruption.

Atlassian will continue to support Internet Explorer 9 (IE9) and Internet Explorer 10 (IE10) as well as the latest versions of Chrome, Firefox and Safari. For further information, please refer to the Supported Platforms page. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.
This section announces the end of Atlassian support for certain databases for Confluence. End of support means that Atlassian will not fix bugs related to the specified database past the support end date for your version of Confluence.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS SQL 2005</td>
<td>When Confluence 5.3 is released, due in late 2013</td>
</tr>
</tbody>
</table>

**MS SQL 2005 notes:**
- Confluence 5.2 is the last version that will support MS SQL 2005.
- Confluence 5.2 and previously-released versions will continue to work with MS SQL 2005. However, we will not fix bugs affecting MS SQL 2005 after the end-of-life date for your version of Confluence.
- Confluence 5.3 will not be tested with MS SQL 2005.

### Deprecated Tomcat platform for Confluence (29 August 2012)

This section announces the end of Atlassian support for Tomcat 5.5.x for Confluence. Please note: Apache have announced that support for Apache Tomcat 5.5.x will end on 30 September 2012: End of life for Apache Tomcat 5.5.x.

End of support means that Atlassian will not fix bugs related to the specified version of Tomcat, past the support end date for your version of Confluence. The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Tomcat 5.5.x Support

<table>
<thead>
<tr>
<th>Platform</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tomcat 5.5.x</td>
<td>When Confluence 5.0 is released, due in early 2013</td>
</tr>
</tbody>
</table>

**Tomcat 5.5.x notes:**
- Confluence 4.3 is the last major version that will support Tomcat 5.5.x. The Confluence 4.3.x bug-fix releases will also continue to support Tomcat 5.5.x.
- Tomcat 6.0.x will still be supported in Confluence 5.0.
- Confluence 4.3.x and previously-released versions will continue to work with Tomcat 5.5.x. However, we will not fix bugs affecting Tomcat 5.5.x after the end-of-life date for your version of Confluence.
- Confluence 5.0 will not be tested with Tomcat 5.5.x.

### Deprecated Java platform for Confluence (6 August 2012)

This section announces the end of Atlassian support for Java 6 for Confluence. Please note that Oracle has announced the end of public updates for Java 6: Java SE 6 End of Public Updates Notice.

End of support means that Atlassian will not fix bugs related to the specified version of Java, past the support end date for your version of Confluence. The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Java 6 Support
<table>
<thead>
<tr>
<th>Platform</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java 6 (JRE and JDK 1.6)</td>
<td>When Confluence 5.0 is released, due in early 2013</td>
</tr>
</tbody>
</table>

Java 6 notes:

- Confluence 4.3 is the last major version that will support Java 6. The Confluence 4.3.x bug-fix releases will also continue to support Java 6.
- Java 7 (JRE and JDK 1.7) will still be supported in Confluence 5.0.
- Confluence 4.3.x and previously-released versions will continue to work with Java 6. However, we will not fix bugs affecting Java 6 after the end-of-life date for your version of Confluence.
- Confluence 5.0 will not be tested with Java 6.

Deprecated Databases for Confluence (1 May 2012)

This section announces the end of Atlassian support for certain databases for Confluence. End of support means that Atlassian will not fix bugs related to the specified database past the support end date for your version of Confluence.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL 8.2</td>
<td>When Confluence 4.3 is released, due in mid 2012</td>
</tr>
</tbody>
</table>

PostgreSQL 8.2 notes:

- Confluence 4.2 is the last version that will support version 8.2 of PostgreSQL.
- Versions 8.3, 8.4 and 9.0 will still be supported in Confluence 4.3.
- Confluence 4.2 and previously-released versions will continue to work with PostgreSQL 8.2. However, we will not fix bugs affecting PostgreSQL 8.2 after the end-of-life date for your version of Confluence.
- Confluence 4.3 will not be tested with PostgreSQL 8.2.

Deprecated Databases for Confluence (13 March 2012)

This section announces the end of Atlassian support for certain databases for Confluence. End of support means that Atlassian will not fix bugs related to the specified database past the support end date for your version of Confluence.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>When Confluence 4.3 is released, due in mid 2012</td>
</tr>
</tbody>
</table>

DB2 notes:

- Confluence 4.2 is the last version that will support DB2.
- From Confluence 4.3, no versions of DB2 will be supported.
- Confluence 4.2 and previously-released versions will continue to work with DB2. However, we will not fix bugs affecting DB2 after the end-of-life date for your version of Confluence.
• Confluence 4.3 will not be tested with DB2.
• For help moving from DB2 to a supported database, please refer to the list of supported databases and the guide to migrating to another database.

Deprecated Operating Systems for Confluence (21 July 2011)

This section announces the end of Atlassian support for certain operating systems for Confluence. End of support means that Atlassian will not fix bugs related to running Confluence server on that operating system past the support end date.

We will stop supporting the following operating systems from Confluence 4.0, due in late 2011:

• Mac OS X (as a Confluence server platform).

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Operating System Support

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X</td>
<td>When Confluence 4.0 releases, due in late 2011</td>
</tr>
</tbody>
</table>

• Mac OS X Notes:
  • Atlassian intends to end support for Mac OS X (as a server platform) in Confluence 4.0 (due for release in late 2011). Confluence 3.5 is the last version that will support Mac OS X.
  • The Sun/Oracle JDK/JRE 1.6 is the only JDK platform officially supported by Atlassian. This means that Apple Mac OS X is not a supported operating system for the Confluence server, as the Sun/Oracle JDK does not run on Mac OS X.
  • Accessing Confluence as a user from Mac OS X via a compatible web browser will still be supported for the foreseeable future.

Deprecated Databases for Confluence (7 January 2011)

This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will stop supporting the following database versions from Confluence 4.0, due in late 2011:

• MySQL 5.0.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL (version 5.0 only)</td>
<td>When Confluence 4.0 releases, due in late 2011</td>
</tr>
</tbody>
</table>

• MySQL Notes:
  • Atlassian intends to end support for MySQL 5.0 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support MySQL 5.0.
  • MySQL 5.1 will still be supported.
  • ‘Support End Date’ means that Confluence 3.5 and previously released versions will continue to work with MySQL 5.0. However, we will not fix bugs affecting MySQL 5.0 past the support end date.
  • Confluence 4.0 will not be tested with MySQL 5.0.
Deprecation Web Browsers for Confluence (7 January 2011)

This section announces the end of Atlassian support for certain web browser versions for Confluence. End of support means that Atlassian will not fix bugs related to certain web browser versions past the support end date.

We will stop supporting the following web browser versions from Confluence 4.0, late middle of 2011:

- Microsoft Internet Explorer 7 (IE7).
- Safari 4.
- Firefox 3.5.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer (version 7 only)</td>
<td>When Confluence 4.0 releases, late the middle of 2011</td>
</tr>
<tr>
<td>Safari (version 4 only)</td>
<td>When Confluence 4.0 releases, due in late of 2011</td>
</tr>
<tr>
<td>Firefox (version 3.5 only)</td>
<td>When Confluence 4.0 releases, due in late of 2011</td>
</tr>
</tbody>
</table>

- Internet Explorer Notes:
  - Atlassian intends to end support for IE7 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support IE7.
  - IE8 will still be supported.
  - 'Support End Date' means that Confluence 3.5 and previously released versions will continue to work with IE7. However, we will not fix bugs affecting IE7 past the support end date.
  - Confluence 4.0 will not be tested with IE7.

- Safari Notes:
  - Atlassian will introduce support for Safari 5 in Confluence 3.5.
  - We intend to end support for Safari 4 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support Safari 4.
  - 'Support End Date' means that Confluence 3.5 and previously released versions will continue to work with Safari 4. However, we will not fix bugs affecting Safari 4 past the support end date.
  - Confluence 4.0 will not be tested with Safari 4.

- Firefox Notes:
  - Atlassian will end support for Firefox 3.0 in Confluence 3.5, as previously announced.
  - We intend to end support for Firefox 3.5 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support Firefox 3.5.
  - Firefox 3.6 will still be supported.
  - 'Support End Date' means that Confluence 3.5 and previously released versions will continue to work with Firefox 3.5. However, we will not fix bugs affecting Firefox 3.5 past the support end date.
  - Confluence 4.0 will not be tested with Firefox 3.5.

Deprecation Databases for Confluence (12 October 2010)

This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will stop supporting the following database versions:

- From Confluence 3.5, due in the first half of 2011, Confluence will no longer support PostgreSQL 8.1. Note, PostgreSQL 8.2 and PostgreSQL 8.4 will still be supported.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for
Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL (version 8.1 only)</td>
<td>When Confluence 3.5 releases, due in the first half of 2011</td>
</tr>
</tbody>
</table>

- **PostgreSQL (version 8.1 only) End of Support Notes:**
  - Atlassian intends to end support for PostgreSQL 8.1 in Confluence 3.5 (due to release in the first half of 2011), with the final support for these platforms in Confluence 3.4. PostgreSQL 8.2 and PostgreSQL 8.4 will still be supported.
  - 'Support End Date' means that Confluence 3.4 and previous released versions will continue to work with the PostgreSQL 8.1 However, we will not fix bugs affecting PostgreSQL 8.1 past the support end date.
  - Confluence 3.5 (due to release in the first half of 2011) will not be tested with PostgreSQL 8.1.

Deprecated Web Browsers for Confluence (12 October 2010)

This section announces the end of Atlassian support for certain web browser versions for Confluence. End of support means that Atlassian will not fix bugs related to certain web browser versions past the support end date.

We will stop supporting the following web browser versions:

- From Confluence 3.5, due in the first half of 2011, Confluence will no longer support Firefox 3.0.
  Note, Firefox 3.5 and Firefox 3.6 will still be supported.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firefox (version 3.0 only)</td>
<td>When Confluence 3.5 releases, due in the first half of 2011</td>
</tr>
</tbody>
</table>

- **Firefox (version 3.0 only) End of Support Notes:**
  - Atlassian intends to end support for Firefox 3.0 in Confluence 3.5 (due to release in the first half of 2011), with the final support for these platforms in Confluence 3.4. Firefox 3.5 and Firefox 3.6 will still be supported.
  - 'Support End Date' means that Confluence 3.4 and previous released versions will continue to work with Firefox 3.0. However, we will not fix bugs affecting Firefox 3.0 past the support end date.
  - Confluence 3.5 (due to release in the first half of 2011) will not be tested with Firefox 3.0.

Deprecated Databases for Confluence (6 July 2010)

This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will stop supporting the following database versions:

- From Confluence 3.4, due in the second half of 2010, Confluence will no longer support Oracle 10g (i.e. Oracle 10.1 and Oracle 10.2).
  Note, Oracle 11g (i.e. Oracle 11.1 and Oracle 11.2) will still be supported.

We have made these decisions in line with Oracle's decision to stop support for Oracle 10g, as per the "Oracle Database (RDBMS) Releases Support Status Summary [ID 161818.1]" article on the Oracle Support site (note, you will need an Oracle Support account to find and view the article). This also will reduce the testing time.
required for each release and help us speed up our ability to deliver market-driven features. We are committed to helping our customers understand this decision and assist them in upgrading to Oracle 11g if needed.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle (version 10.1 and 10.2 only)</td>
<td>When Confluence 3.4 releases, due in the second half of 2010</td>
</tr>
</tbody>
</table>

- **Oracle (version 10.1 and 10.2 only) End of Support Notes:**
  - Atlassian intends to end support for Oracle 10.1 and Oracle 10.2 in Confluence 3.4 (due to release in the second half of 2010), with the final support for these platforms in Confluence 3.3. Oracle 11.1 and Oracle 11.2 will still be supported.
  - 'Support End Date' means that Confluence 3.3 and previous released versions will continue to work with the Oracle 10.1 and Oracle 10.2. However, we will not fix bugs affecting Oracle 10.1 or Oracle 10.2 past the support end date.
  - Confluence 3.4 (due to release in the second half of 2010) will not be tested with Oracle 10.1 and Oracle 10.2.

Deprecated Web Browsers for Confluence (6 July 2010)

This section announces the end of Atlassian support for certain web browser versions for Confluence. End of support means that Atlassian will not fix bugs related to certain web browser versions past the support end date.

We will **stop supporting the following web browser versions:**

- From Confluence 3.4, due in the second half of 2010, Confluence will no longer support Safari 3 or Safari 3.1.
  - Note, Safari 4 will still be supported.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safari (version 3 and 3.1 only)</td>
<td>When Confluence 3.4 releases, due in the second half of 2010</td>
</tr>
</tbody>
</table>

- **Safari (version 3 and 3.1 only) End of Support Notes:**
  - Atlassian intends to end support for Safari 3 and Safari 3.1 in Confluence 3.4 (due to release in the second half of 2010), with the final support for these platforms in Confluence 3.3. Safari 4 will still be supported.
  - 'Support End Date' means that Confluence 3.3 and previous released versions will continue to work with the Safari 3 and Safari 3.1. However, we will not fix bugs affecting Safari 3 and Safari 3.1 past the support end date.
  - Confluence 3.4 (due to release in the second half of 2010) will not be tested with Safari 3 and Safari 3.1.

Deprecated Databases for Confluence (24 March 2010)

This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will **stop supporting the following database versions:**

---

Created in 2014 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
From Confluence 3.3, due in Q3 2010, Confluence will no longer support DB2 8.2. Note, DB2 9.7 will still be supported.

We are reducing our database support to reduce the amount of testing time and help us speed up our ability to deliver market-driven features. We are committed to helping our customers understand this decision and assist them in upgrading to DB2 9.7 if needed.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 (version 8.2 only)</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
</tbody>
</table>

**DB2 (version 8.2 only) End of Support Notes:**
- Atlassian intends to end support for DB2 8.2 in Q3 2010, with the final support for these platforms in Confluence 3.2. DB2 9.7 will still be supported.
- ‘Support End Date’ means that Confluence 3.2 and previous released versions will continue to work with the DB2 8.2. However, we will not fix bugs affecting DB2 8.2 past the support end date.
- Confluence 3.3 (due to release in Q3 2010) will not be tested with DB2 8.2.

Deprecated Application Servers for Confluence (27 January 2010)

This section announces the end of Atlassian support for certain application servers for Confluence. End of support means that Atlassian will not fix bugs related to certain application servers past the support end date.

We will stop supporting the following application servers:
- From Confluence 3.2, due late Q1 2010, Confluence will no longer support JBoss application servers.
- From Confluence 3.3, due in Q3 2010, Confluence will no longer support Oracle WebLogic, IBM WebSphere or Caucho Resin.

We are reducing our application server platform support to reduce the amount of testing time and help us speed up our ability to deliver market-driven features. We are committed to helping our customers understand this decision and assist them in migrating to Tomcat, our supported application server.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Application Server Support

<table>
<thead>
<tr>
<th>Application Servers</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>JBoss 4.2.2</td>
<td>When Confluence 3.2 releases, due late Q1 2010</td>
</tr>
<tr>
<td>Oracle WebLogic 9.2</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
<tr>
<td>IBM WebSphere 6.1</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
<tr>
<td>Caucho Resin 3.0, 3.1.6, 3.1.7</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
</tbody>
</table>

**JBoss End of Support Notes:**
- ‘Support End Date’ means that Confluence 3.1 and previous released versions will continue to work with stated application servers. However, we will not fix bugs affecting JBoss application servers.
- Confluence 3.2 will not support JBoss application servers.

**WebLogic, WebSphere and Resin End of Support Notes:**
- Atlassian intends to end support for Oracle WebLogic, IBM WebSphere, and Caucho Resin in Q3 2010, with the final support for these platforms in Confluence 3.2.
'Support End Date' means that Confluence 3.2 and previous released versions will continue to work with the stated application servers. However, we will not fix bugs affecting Oracle WebLogic, IBM WebSphere, and Caucho Resin application servers past the support end date.

Confluence 3.3 (due to release in Q3 2010) will only be tested with and support Tomcat 5.2.20+ and 6.0.

If you have concerns with this end of support announcement, please email eol-announcement at atlassian dot com.

Why is Atlassian doing this?

We have chosen to standardise on Tomcat, because it is the most widely used application server in our user population. It is fast, robust, secure, well-documented, easy to operate, open source, and has a huge community driving improvements. It is the de facto industry standard, with several companies available that specialise in providing enterprise grade support contracts for it, ranging from customisations to 24/7 support.

Deprecated Java Platforms for Confluence (27 January 2010)

This section announces the end of Atlassian support for certain Java Platforms for Confluence.

We will stop supporting the following Java Platforms:

- From Confluence 3.3, due Q3 2010, support for Java Platform 5 (JDK/JRE 1.5) will end.

We are ending support for Java Platform 5, in line with the [Java SE Support Roadmap](i.e. "End of Service Life" for Java Platform 5 dated October 30, 2009). We are committed to helping our customers understand this decision and assist them in updating to Java Platform 6, our supported Java Platform.

The details are below. Please refer to the [Supported Platforms](atlassian dot com) for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Java Platform Support

<table>
<thead>
<tr>
<th>Java Platform</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Platform 5 (JDK/JRE 1.5)</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
</tbody>
</table>

Java Platform 5 End of Support Notes:

- Atlassian intends to end support for Java Platform 5 in Q3 2010.
- 'Support End Date' means that Confluence 3.2.x and previous released versions will continue to work with Java Platform 5 (JDK/JRE 1.5), however we will not fix bugs related to Java Platform 5 past the support end date.
- Confluence 3.3 will only be tested with and support Java Platform 6 (JDK/JRE 1.6).
- If you have concerns with this end of support announcement, please email eol-announcement at atlassian dot com.

Deprecated Web Browsers for Confluence (14 December 2009)

This section announces the end of Atlassian support for certain web browsers for Confluence.

We will stop supporting older versions of web browsers as follows:

- From Confluence 3.2, due late Q1 2010, support for Firefox 2 and Safari 2 will end.
- From 13 July 2010, in line with Microsoft's Support Lifecycle policy, support for IE6 will end.

The details are below. Please refer to the [Supported Platforms](atlassian dot com) for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browsers</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Firefox 2 and Safari 2 Notes:
- Confluence 3.1 is the last version to officially support Firefox 2 and Safari 2.
- You may be able to use these older browser for the most common use cases like viewing and editing content, but official support for these browsers will end once you upgrade to Confluence 3.2.
- Confluence 3.2 is currently targeted to release late Q1 2010 and will not be tested with Firefox 2 and Safari 2. After the Confluence 3.2 release, Atlassian will not provide fixes in older versions of Confluence for bugs affecting Firefox 2 and Safari 2.

### Internet Explorer 6 Notes:
- Confluence 3.2 (due late Q1 2010) will be the last version to officially support Internet Explorer 6.
- Confluence 3.3 is currently targeted to release Q3 2010 and will not support IE6.
- Atlassian will support IE6 in Confluence until the 13th of July 2010, in line with Microsoft's Support Lifecycle policy. Beyond that date, released versions of Confluence will continue working with IE6 just as they did before, but we will not fix bugs affecting Internet Explorer 6.
- You may be able to use Internet Explorer 6 for the most common use cases like viewing and editing content, but official support for this browser will end once you upgrade to Confluence 3.3.

### Supported Platforms FAQ

**Q:** How does Atlassian choose which JRE versions, application servers and databases to support?

For application servers and databases, we try to pick a good cross-section of open source options and popular commercial platforms. We then choose which JRE versions to support based on the recommended environments for these servers.

**Q:** What is a supported platform?

A supported platform is one that:

- Confluence is regularly tested on during the development cycle
- One that is available within Atlassian for support technicians and developers to reproduce problems
- Bugs raised against it will be given a high priority

Supporting a platform means we know how to get Confluence running in that environment and can troubleshoot Confluence issues within it. It does not mean we have any particular expertise beyond that. As such, we may not be able to provide assistance with customising or tuning that application server or database. (Atlassian support is not a substitute for a good database administrator.)

**Q:** Can I get assistance with running Confluence on a platform that is *not* supported?

If you are running Confluence on an unsupported platform, then we can not guarantee providing any support for it. Furthermore, we will recommend that you switch to a platform which is supported.

**Q:** If you write your application to standards like J2EE, JDBC and SQL, doesn’t that mean it should run on any compliant server?

Confluence is a complicated application and we commonly encounter interesting edge-cases where different servers have interpreted the specifications differently. Then again, each server has its own different collection of bugs.

**Q:** How can I get Atlassian to support Confluence on a new platform?

Supporting a new platform involves a significant investment of time by Atlassian, both up-front costs to set up new testing environments and fix any issues we might encounter and the ongoing costs involved in maintaining the application against this new environment in the future. As such, supporting a new platform is not something we will do unless we know there is significant demand for it.

Please be aware that your interest alone will not be enough for us to add support for your application server or database. We would need to see a significant number of votes on the issue raised in our public JIRA site or a significant level of interest in our forums, before considering supporting that platform.
Q: My organisation has standardised on an operating environment that Confluence does not support. What can I do?

In this situation, you have the following two options:

1. Run Confluence in the unsupported environment, with the caveats mentioned above.
2. Make an exception to your standardised operating environment and set up Confluence based on its supported platforms.

Migrating Confluence Between Servers

This page describes how to move Confluence between physical servers. It is distinct from other functions. It does not cover database migration, application server migration, or upgrading. Atlassian suggests doing each of these steps separately. See also:

- Upgrading Confluence
- Migrating to Another Database
- Switching to Apache Tomcat

How to Create a Test or Development Site

Administrators may need to move a Confluence site from one server to another for upgrades or downtime. This page tells you how to copy a Confluence site from one server to another. For example, you may want to transfer your current production snapshot to a test server as permitted in the licence agreement.

Avoid upgrades while migrating. If you are planning to switch databases, application servers or Confluence versions, firstly perform the application transfer in isolation, and test that it was successful before making other changes.

Development licenses are available for any Commercial or Academic license. Create one or contact Atlassian for help.

On this page:

- How to Create a Test or Development Site
- Transferring Confluence To Another Server Using The Same Operating System
- Transferring Confluence To Another Server Using a Different Operating System
- Ensuring no contact with production systems
- Migrating from HTTPS to HTTP
- Notes

Transferring Confluence To Another Server Using The Same Operating System

If the operating systems on both servers are the same, then the home and install folders can be copied straight into an identical external database and user management setup.

1. On the original server, create zips of the Confluence install and home directories. Copy the zips to the new server.
2. On the new server, unzip the install and home directories. Windows users should avoid unzipping with the Windows built-in extractor, instead use Winzip or the free 7Zip.

If you are changing the location of the home directory, open the Confluence install/confluence/WEB-INF/classes directory and edit confluence-init.properties by changing the line starting with 'confluence.home='. If you are using the EAR/WAR distribution, modify the location of your war file if need be. If using Tomcat, this is likely in /Conf/Catalina/localhost. You'll want to make sure the docbase attribute is pointing to the right location.

3. If you are using the EAR/WAR distribution, modify the location of your war file if need be. If using Tomcat, this is likely in /Conf/Catalina/localhost. You'll want to make sure the docbase attribute is pointing to the right location.
4. This next step is dependent on your database:
   - For users of the internal database, the database content is stored inside the home directory. You should switch to an external database after the transfer is successful. The internal database is for evaluation only and is not recommended for use in Production systems.
   - For external databases stored on another server: change the user account or datasource
permissions so that the new server has the same network access permissions as the original.
Then confirm from the new server that the hostname can be resolved and is listening for database
connections on the expected port.
- For external databases hosted locally (ie. localhost): on the original server, create a manual
database backup using a native db dump backup tool. Copy the database backup to the new
server.

5. On the new server, install or upgrade the database version to match the original server.
6. Import the database backup.
7. Add a database user account with the same username and password as the original.
8. Provide the database user with the full access to the imported database.
9. Use a database administration tool to confirm that the user can login from the localhost.
10. This step depends on your database connection:
    a. If you use JDBC (the default option) to connect to the database, to modify any database
       connection information, go to the Confluence home directory and edit confluence.cfg.xml. The
       connection URL is set under hibernate.connection.url. Ensure it does not point to your
       production database server.
    b. If you use a data source, follow the instructions for your database type and ensure the data source
       points to the new database: PostgreSQL, MySQL, SQL Server or Oracle.
11. If you are using internal user management, skip this step. For users who have JIRA or LDAP integration,
    provide the new server with network or local access to the same hosts as the original. If this is a true test
    site, set up a test of your JIRA site or LDAP server so as not to disrupt production systems and change
    the server.xml or atlassian-user.xml files (Confluence 3.4 and below), or modify the directory settings in
    Confluence Admin > User Directories (Confluence 3.5 and above) to point to the appropriate test servers.
    Note that it might be acceptable to use a production connection here, as users won't be logging on to the
    test system in high volume.
12. If appropriate, make sure no emails are sent out from the test system.
13. If you have previously installed Confluence using the guided installer and plan on starting Confluence
    using the startup or start-confluence scripts in the Confluence install/bin/directory, check setenv.sh (Unix/Linux)
    or setenv.bat (Windows) in the same directory. If there is a JRE_HOME set, ensure that the path to the JRE is up to date in regards to the new environment.
15. Go to Administration > License Details and add your development license key. You can generate one at http://my.atlassian.com.
    There are more details in How to get a Confluence developer license.
16. If you configured Confluence as a Windows service, repeat those instructions.
17. Add your development license key.
18. Some customers have experienced problems with Confluence’s search functions after performing a
    migration, or that the content of their {recently-updated} macro is not being updated correctly. Errors
    in the atlassian-confluence.log file corroborate such problems. Hence, to avoid these issues, it is
    strongly recommended that you perform a rebuild of your content indices after performing a migration.

Transferring Confluence To Another Server Using a Different Operating System

Migrating from Windows to Linux

You will need to replace the backslash with forward slash in the following lines in confluence.cfg.xml:

```xml
<property name="attachments.dir">${confluenceHome}/attachments</property>
<property name="lucene.index.dir">${confluenceHome}/index</property>
<property name="webwork.multipart.saveDir">${confluenceHome}/temp</property>
```

Using database tools (preferred option)

If you are using the Production backup strategy, follow these steps:

1. Download the proper distribution (the same one you have from your original site) from the Download
   Archive.
2. Copy your Confluence home (not install) directory from your original server (even if it was a different OS).
3. If you are changing the location of the home directory, open the Confluence
install\confluence\WEB-INF\classes directory and edit confluence-init.properties by changing the line starting with 'confluence.home='.
4. For external databases stored locally, on the original server, create a manual database backup using a native db dump backup tool.
5. Copy the database backup to the new server.
6. On the new server, install or upgrade the database version to match the original server.
7. Import the database backup.
8. Add a database user account with the same username and password as the original.
9. Provide the user with the full access to the imported database.
10. Use a database administration tool to confirm that the user can login from the localhost.
11. To modify any database connection information, go to the Confluence home directory and edit confluence.cfg.xml. The connection URL is set under hibernate.connection.url. **Ensure it does not point to your production database server.**
12. If you are using internal user management, skip this step. For users who have JIRA or LDAP integration, provide the new server with network or local access to the same hosts as the original.
13. Copy server.xml, atlassian-user.xml, osuser.xml, any patches, and any other customized files velocity or properties files. If this is a true test site, set up a test of your JIRA site or LDAP server so as not to disrupt production systems and change the server.xml or atlassian-user.xml files to point to the appropriate test servers. Note that it might be acceptable to use a production connection here, as users won't be logging on to the test system in high volume.
14. If appropriate, make sure no emails are sent out from the test system.
15. If you have previously installed Confluence using the guided installer and plan on starting Confluence using the startup of start-confluence scripts in the Confluence install/bin/ directory, check setenv.sh (Unix/Linux) of setenv.bat (Windows) in the same directory. If there is a JRE_HOME set, ensure that the path to the JRE is up to date in regards to the new environment.
17. Go to Administration > License Details and add your development license key. You can generate one at http://my.atlassian.com. There are more details in How to get a Confluence developer license.
18. If you configured Confluence as a Windows service, repeat those instructions.
19. Add your development license key.
20. Some customers have experienced problems with Confluence's search functions after performing a migration, or that the content of their \{recently-updated\} macro is not being updated correctly. Errors in the atlassian-confluence.log file corroborate such problems. Hence, to avoid these issues, it is strongly recommended that you perform a **rebuild of your content indices** after performing a migration.

**Using XML data backups (only for small to medium sized installations)**

**Note:** The XML export built into Confluence is not suited for the backup or migration of large data sets. There are a number of third party tools that may be able to assist you with the data migration. If you would like help in selecting the right tool, or help with the migration itself, we can put you in touch with one of the Atlassian Experts.

If you're not yet using the Production backup strategy, you can migrate Confluence to a different server machine by creating an XML data backup as usual, and then importing that to Confluence on the new server.

1. Create an XML data backup from Confluence as follows:
   a. Choose the cog icon, then choose General Configuration under Confluence Administration.
   b. Select Backup & Restore.
   c. Check the Backup Attachments option and click Backup.
2. Identify the version of Confluence that you are currently using. This is displayed at the bottom of each Confluence page.
3. Download Confluence to the new server. Get the version of Confluence that you identified above, but for the operating system of the new server. You may be using either the latest Confluence version, or an older version.
4. Install Confluence on the new server.
5. Go to Administration > License Details and add your development license key. You can generate a license at http://my.atlassian.com. You can find more details in How to get a Confluence developer license.
6. Restore your XML data backup from Administration > Backup and Restore.
7. If appropriate, make sure that no email contact can be made with the test system.
8. Some customers have experienced problems with Confluence's search functions after performing a
migration, or that the content of their \{recently-updated\} macro is not being updated correctly. Errors in the `atlassian-confluence.log` file corroborate such problems. Hence, to avoid these issues, it is strongly recommended that you rebuild your content indices after performing a migration.

Ensuring no contact with production systems

To ensure no contact with external systems, you will need to disable both inbound and outbound mail services.

1. Disable global outbound mail by running the following database query:

   ```sql
   SELECT * FROM BANDANA WHERE BANDANKEY = 'atlassian.confluence.smtp.mail.accounts';
   ```

2. Disable space-level mail archiving by running the following database query:

   ```sql
   SELECT * FROM BANDANA WHERE BANDANKEY = 'atlassian.confluence.space.mailaccounts';
   ```

   Change 'SELECT * FROM' to 'DELETE FROM' in the above queries once you are sure you want to remove the specified accounts.

   Once this is done, you can start your test site without any mails being sent or retrieved. Think carefully about other plugins which may access production systems (SQL macro, JIRA macro, etc.). If these write content, or create unwanted load on external systems, they should be disabled promptly after starting the test site.

Migrating from HTTPS to HTTP

You may want to migrate from a server secured by SSL to one which is not secured by SSL. For example, this may be useful if you are copying a Confluence site from a production to a test site.

To migrate from HTTPS to HTTP, undo the HTTPS-specific settings that are described on this page: Adding SSL for Secure Logins and Page Security.

Notes

- If you wish to merge two Confluence sites, you can consider using the remote import plugin. This plugin is currently not supported. The supported method would be to export a space and then import each space one by one. The two Confluence sites must be running the same version of Confluence.

From Confluence Evaluation through to Production Installation

So, you want to try Confluence on an evaluation installation, then move to a production installation when you are ready? This page gives an overview of the steps to follow.

Assumptions:

- This page starts with telling you how to install an evaluation Confluence site. If you have already finished evaluating Confluence, you can safely skip steps 1 to 3.
- Your production installation will be an installed version of Confluence, not a Confluence Cloud site.
- You will evaluate Confluence on an installed version too, not a Confluence Cloud site.

If you are using Confluence Cloud to evaluate Confluence, please refer to the following guide when you want to move to an installed version: Migrating from Confluence Cloud to Confluence Server.

On this page:

- Step 1. Set up your evaluation Confluence site
- Step 2. Add users and content to your evaluation site
- Step 3. Look for interesting add-ons as part of your evaluation
- Step 4. Set up your production Confluence site

Related pages:

- Supported Platforms
- Embedded HSQLDB Database
- Adding and Inviting Users
- About Add-ons
- Getting Started as Confluence Administrator
- Confluence Installation and Upgrade Guide
Step 1. Set up your evaluation Confluence site

If you have already set up an evaluation Confluence site, you can skip this step.

Below is a summary of the installation and setup procedure, focusing on the choice of database.

To install Confluence:

1. Download the automatic installer from the Confluence download site.
   Note: If you are using a Mac or another unsupported platform for your evaluation, you will need to install from a zip file. Details are in the full installation guide.
2. Run the installer and choose the express or custom installation. If you are not sure, choose Express Install.
   - The express option will install Confluence with default settings.
   - The custom option allows you to choose the Confluence installation directory, home (data) directory, ports and other options.
3. When prompted, choose the option to open Confluence in your browser, where you can complete the setup.

To set up Confluence, including the database:

1. Follow the prompts in the browser-based setup wizard, to get your Confluence license.
2. Choose the evaluation or production installation type. If you are not sure, choose Evaluation Installation.
   - The evaluation option will install Confluence with default settings, including the embedded database.
   - If you decide to do a production installation for increased flexibility during evaluation, the setup wizard will prompt you for various options. When choosing a database, we recommend the embedded database for evaluation purposes, because it is simpler and faster to set up.
   - When you move to a production installation, you will be able to move your Confluence data to a production-ready database, as described below.

Step 2. Add users and content to your evaluation site

If you have finished evaluating Confluence, you can skip this step.

Depending on your choices during the Confluence setup, your evaluation site may include sample content. The example pages, blog posts and attachments are in the ‘Demonstration space’. This space is present if:

- You chose the ‘Evaluation Installation’ during setup.
- Or you chose the ‘Production Installation’, then chose to include the ‘Example Site’.

You can update the sample content, and create more of your own. You can also invite people to join you on the site.

When you move to a production site, you can choose to copy the content and users to the new site.

To create content in your evaluation site:

- Choose Spaces > Create Space to add a space, which is like a library of pages.
- Choose Create to add pages and blog posts.

To add users: Choose the cog icon then choose User Management.

For more tips about getting started, see Confluence 101.

Step 3. Look for interesting add-ons as part of your evaluation

If you have finished evaluating Confluence, you can skip this step.

Add-ons, also called plugins, provide additional features that you can install into your Confluence site. Some of them are provided free of charge. Many of the commercial add-ons are available free for an evaluation period.

You can browse and download add-ons on the Atlassian Marketplace. You can also find add-ons via the Confluence user interface, which interacts with the Atlassian Marketplace for you.

To find useful add-ons via the Confluence user interface:
1. Choose the cog icon \(\text{cog}\) then choose Add-ons.
2. Choose Find new add-ons.

Step 4. Set up your production Confluence site

When you are ready to move from an evaluation site to a production site, you need to migrate to a production-ready database. This involves installing a new Confluence site with a new database, and instructing Confluence to copy the data from your evaluation site to the new site. You will also need to check some important configuration settings, and define your backup strategy. The instructions below lead you through all the steps required.

**Migrating your data to a production database:**

1. Choose a database carefully, with a focus on reliability and backups. See our list of supported databases. If you are unsure which one to choose, we recommend PostgreSQL.
2. Install a new database and a new Confluence site, by following our guide to migrating to another database. The guide will lead you through the following steps:
   - Setting up your database server.
   - Adding a Confluence database (schema) to your database server.
   - Installing a new, production-ready Confluence site.
   - Copying your Confluence data from your evaluation site to your new production site.

**Setting important configuration options on your production site:**

- Set the base URL. See Configuring the Server Base URL.
- Make sure you have configured an email server. See Configuring a Server for Outgoing Mail.
- Decide on proxy setup and other settings that determine where Confluence fits into your network. See Web Server Configuration.
- Consider setting up a secure connection via SSL. See Running Confluence Over SSL or HTTPS.
- Read our guidelines on security. See Best Practices for Configuring Confluence Security.
- Decide whether you will manage your users in Confluence or connect to an external LDAP directory. See Configuring User Directories.
- Decide whether you want to allow public (anonymous) access to your site. See Setting Up Public Access.
- Set up your permission scheme. See Giving People Access to Content.
- Connect Confluence to JIRA and other applications. See Linking to Another Application.

**Defining your backup strategy:**

By default, Confluence will create daily XML backups of your content and user data. This is suitable when you are evaluating Confluence. When you move to a production site, you need more robust backup procedures and technologies. See Production Backup Strategy.

**Migrating from Confluence Cloud to Confluence Server**

This page is for people who are currently using Confluence Cloud, and wish to move to Confluence Server (a Confluence installation hosted on your own servers).

To migrate from Confluence Cloud to Server you’ll need to download and install a special Confluence Cloud release and then move your data from your Confluence Cloud site to your newly installed site.

Confluence Cloud is typically ahead of Confluence Server, which means you can’t move your data from Confluence Cloud to a site installed from the standard Confluence Server download because backups taken from Confluence Cloud are only compatible with the current Cloud release (for example, ‘Confluence 5.5-OD-23’).

**Note:** It is important that you export your data and download Confluence on the same day to ensure that your data and your Confluence installation use the same version.

---

For migrating from Confluence Server to Confluence Cloud, see Importing wiki data.

---

On this page:
- Migration steps
- Support, limitations, and recommendations
  - Upgrading to a standard Confluence Server release
  - Third-party add-ons
  - Database considerations
  - Confluence license
Migration steps

To migrate from Confluence Cloud to Confluence Server:

1. Export the data from your Confluence Cloud site, using the Confluence backup manager.
   - For detailed instructions, see Exporting wiki data.
   - You now have an XML export of your Confluence data.
2. Download the current Confluence Cloud release.
   Go to the Confluence Cloud download page and get the release for your operating system:
   - For Windows 64-bit: Get '5.x-OD-x - Windows Installer (64 bit)'
   - For Windows 32-bit: Get '5.x-OD-x - Windows Installer (32 bit)'
   - For Linux 64-bit: Get '5.x-OD-x - Linux Installer (64 bit)'
   - For Linux 32-bit: Get '5.x-OD-x - Linux Installer (32 bit)'
   - To install Confluence from an archive on UNIX or Mac OS X: Get '5.x-OD-x - Standalone (TAR.GZ Archive)'
   - To install Confluence from an archive on Windows: Get '5.x-OD-x - Standalone (ZIP Archive)'.
3. Follow the Confluence Installation Guide to install Confluence.
4. Import the data from your backup file (XML export) into your new Confluence installation - see Restoring a Site.
5. Log in to your new Confluence site, using the following credentials:
   - Username: sysadmin
   - Password: sysadmin
6. Change the password immediately after logging in.

Support, limitations, and recommendations

Please note the following points about your Confluence site installed from an Cloud release.

Upgrading to a standard Confluence Server release

⚠️ You must upgrade to a standard Confluence Server release as soon as one is available. For example if you installed 5.5 OD-23, you must upgrade to 5.6 when it is released. Cloud ('OD') releases are supported, but only until the next Confluence Server release is available.

Third-party add-ons

Because Confluence Cloud is typically ahead of Confluence Server, some third-party add-ons may not be compatible with the Cloud release. You may have to wait until you upgrade to the next full Confluence Server release before installing incompatible add-ons. Any add-ons that you were already using in Confluence Cloud will be compatible.

Database considerations

If you are uncertain about which database to choose for your new Confluence installation, we recommend PostgreSQL - see Database Setup for PostgreSQL. The Confluence Cloud site runs on PostgreSQL, so there should be no compatibility issues.

If you choose another supported database, Contact Support if you encounter any compatibility issues with other supported databases.

Confluence license

You will need a new license to migrate to Confluence Server. Your existing Cloud license cannot be used. You can get a new license at https://my.atlassian.com.

Confluence Release Notes

Confluence release notes provide information on the features and improvements in each release. This page includes release notes for major releases and minor (bugfix) releases. If you are upgrading from an earlier version of Confluence, you will find essential information in the upgrade notes associated with the relevant release notes.
Release notes are maintained in the Confluence Latest space. All links below will take you to the Confluence Latest where you can browse all release notes and upgrade notes.

---

**Confluence 5 release notes**

**Confluence 5.6**
- Confluence 5.6 Release Notes

**Confluence 5.5**
- Confluence 5.5.6 Release Notes
- (Confluence 5.5.5 was an internal release)
- (Confluence 5.5.4 was withdrawn)
- Confluence 5.5.3 Release Notes
- Confluence 5.5.2 Release Notes
- Confluence 5.5.1 Release Notes
- Confluence 5.5 Release Notes

**Confluence 5.4**
- Confluence 5.4.4 Release Notes
- Confluence 5.4.3 Release Notes
- Confluence 5.4.2 Release Notes
- Confluence 5.4.1 Release Notes
- Confluence 5.4 Release Notes

**Confluence 5.3**
- Confluence 5.3.4 Release Notes
- Confluence 5.3.1 Release Notes
- Confluence 5.3 Release Notes

---

**Confluence 4 release notes**

**Confluence 4.3**
- Confluence 4.3.7 Release Notes
- Confluence 4.3.6 Release Notes
- Confluence 4.3.5 Release Notes
- (Confluence 4.3.4 was an internal release)
- Confluence 4.3.3 Release Notes
- Confluence 4.3.2 Release Notes
- Confluence 4.3.1 Release Notes
- Confluence 4.3 Release Notes

**Confluence 4.2**

---

**Confluence 5.2**
- Confluence 5.2.5 Release Notes
- Confluence 5.2.4 Release Notes
- Confluence 5.2.3 Release Notes
- (Confluence 5.2.0 - 5.2.2 were internal releases)

**Confluence 5.1**
- Confluence 5.1.5 Release Notes
- Confluence 5.1.4 Release Notes
- Confluence 5.1.3 Release Notes
- Confluence 5.1.2 Release Notes
- Confluence 5.1.1 Release Notes
- Confluence 5.1 Release Notes

**Confluence 5.0**
- Confluence 5.0.3 Release Notes
- Confluence 5.0.2 Release Notes
- Confluence 5.0.1 Release Notes
- Confluence 5.0 Release Notes

---

**Confluence 4.1**
- Confluence 4.1.9 Release Notes
- (Confluence 4.1.8 was an internal release)
- Confluence 4.1.7 Release Notes
- Confluence 4.1.6 Release Notes
- Confluence 4.1.5 Release Notes
- Confluence 4.1.4 Release Notes
- Confluence 4.1.3 Release Notes
- Confluence 4.1.2 Release Notes
- (Confluence 4.1.1 was an internal release)
- Confluence 4.1 Release Notes
• Confluence 4.2.13 Release Notes
• Confluence 4.2.12 Release Notes
• Confluence 4.2.11 Release Notes
• (Confluence 4.2.9 and 4.2.10 were internal releases)
• Confluence 4.2.8 Release Notes
• Confluence 4.2.7 Release Notes
• Confluence 4.2.6 Release Notes
• Confluence 4.2.5 Release Notes
• Confluence 4.2.4 Release Notes
• Confluence 4.2.3 Release Notes
• Confluence 4.2.2 Release Notes
• Confluence 4.2.1 Release Notes
• Confluence 4.2 Release Notes

Confluence 3 release notes

Confluence 3.5
• Confluence 3.5.17 Release Notes
• Confluence 3.5.16 Release Notes
• Confluence 3.5.13 Release Notes
• (Confluence 3.5.12 was an internal release)
• Confluence 3.5.11 Release Notes
• (Confluence 3.5.10 was an internal release)
• Confluence 3.5.9 Release Notes
• (Confluence 3.5.8 was an internal release)
• Confluence 3.5.7 Release Notes
• Confluence 3.5.6 Release Notes
• Confluence 3.5.5 Release Notes
• Confluence 3.5.4 Release Notes
• Confluence 3.5.3 Release Notes
• Confluence 3.5.2 Release Notes
• Confluence 3.5.1 Release Notes
• Confluence 3.5 Release Notes

Confluence 3.4
• Confluence 3.4.10 Release Notes
• Confluence 3.4.8 Release Notes
• Confluence 3.4.7 Release Notes
• Confluence 3.4.6 Release Notes
• Confluence 3.4.5 Release Notes
• (Confluence 3.4.4 was an internal release)
• Confluence 3.4.3 Release Notes
• Confluence 3.4.2 Release Notes
• Confluence 3.4.1 Release Notes
• Confluence 3.4 Release Notes

Confluence 3.3
• Confluence 3.3.17 Release Notes
• Confluence 3.3.16 Release Notes
• Confluence 3.3.12 Release Notes
• (Confluence 3.3.11 was an internal release)
• Confluence 3.3.9 Release Notes
• (Confluence 3.3.8 was an internal release)
• Confluence 3.3.7 Release Notes
• Confluence 3.3.6 Release Notes
• Confluence 3.3.5 Release Notes
• Confluence 3.3.4 Release Notes
• Confluence 3.3.3 Release Notes
• (Confluence 3.3.2 was an internal release)

Confluence 3.2
• Confluence 3.2.1 Release Notes
• Confluence 3.2 Release Notes

Confluence 3.1
• Confluence 3.1.2 Release Notes
• Confluence 3.1.1 Release Notes
• Confluence 3.1 Release Notes

Confluence 3.0
• Confluence 3.0.2 Release Notes
• Confluence 3.0.1 Release Notes
• Confluence 3.0 Release Notes

Confluence 2 release notes

Confluence 2.10
• Confluence 2.10.1 Release Notes

Confluence 2.9
• Confluence 2.9.3 Release Notes
• Confluence 2.9.2 Release Notes

Confluence 2.4
• Release Notes 2.4.5
• Release Notes 2.4.4
• Release Notes 2.4.3
• Release Notes 2.4.2

Confluence 2.3
• Release Notes 2.3.3
• Release Notes 2.3.2
• Release Notes 2.3.1
Confluence Release Summary

This page shows the highlights of the major Confluence releases.

Current Release
For information about the latest release, please go to the Confluence Release Notes.

Confluence 5.6 - September 2014

- Introducing Confluence Data Center
- Keep track of your JIRA issues visually
- Restrict blog posts
- Collaborate faster with quicker comments
- Recently viewed pages on the go
- Tasks sorting improvements
- Insert date lozenges with ease
- Sidebar improvements
- PDF Export improvements
- Support for Office 2013

Confluence 5.5 - 30 April 2014

- Tasks that fit the way you work
- Move blog posts
- Disable space blueprints
- Add a custom favicon
- Improved JIRA integration
- Extended Page Properties and Page Properties Report macros
- Confluence Health Check
- New REST API

Confluence 5.4 - 3 December 2013

- Confluence and JIRA: better together for agile teams
- Create JIRA issues from Confluence
- Give feedback fast with Quote in Comment
- Communicate your releases with new JIRA Reports
- Reflect and improve on your sprints with Retrospectives
- Complete JIRA traceability
- Manage your docs with the Documentation space blueprint
- Macro and blueprint improvements including a new JIRA chart macro, and improvements to the JIRA Issues macro, Page Properties Report macro and Product Requirements blueprint

Confluence 5.3 - 1 October 2013

- Space Blueprints including Knowledge Base space and Team space
- Shared Links blueprint
- Ability to change usernames
- Display page tree in the sidebar
- Request access to a restricted page
- Improved macros including Livesearch, Include Page, Labels List and Code Block

Confluence 5.2 - 13 August 2013

- Faster and cleaner search
- Introducing the Decisions blueprint
- Blueprints keep getting better
- Add multiple layout sections to your pages
- Distraction free editing
- A single, smarter way of adding JIRA issues
- Collaborate with your team on the go
- Speedier interactions

Confluence 5.1 – 27 March 2013

- Introducing blueprints
- Meeting Notes blueprint
- File List blueprint
- Product Requirements blueprint
- New template features
- HTML5 viewers for PDF and PowerPoint files
- Page Properties Report macro
- Improved macros

Confluence 5.0 – 26 February 2013
- A visual refresh
- Updated global navigation
- Content creation made simple
- New sidebar for content discovery
- Editor improvements
- Quick access to recently viewed pages
- Redesigned space administration and space tools
- Improved theming and branding
- Improved user and group management for large sites

Confluence 4.3 – 4 September 2012
- Workbox notifications
- Personal tasks
- Tasks on pages
- Confluence mobile
- Table sorting and highlighting
- Draggable images and macros
- Rich text templates
- Space archiving
- Improved user invitations and signup options
- Default space permissions

Confluence 4.2 – 10 April 2012
- Page layouts
- Likes
- Quick comments
- Popular content on the dashboard
- Recommended content by email
- Labels on attachments
- Signup invitations via URL
- Easy upgrade, try and buy for plugins

Confluence 4.1 – 13 December 2011
- Autoconvert for Pasted Links
- Image effects
- Quick find and replace
- Follow Your Network On the Dashboard
- Space attachments macro
- Global PDF stylesheets
- Use any character in page titles
- New translation feature

Confluence 4.0 – 19 September 2011
- Brand New Editor
- Simplified Editing Experience
- New Macros
- Faster Editing Experience
- Introducing @mentions
- Improved Page Comparison Functionality
- Email Notification Improvements
- New Confluence Installer and Guided Upgrades
- New Editor Plugin Points for Developers

Confluence 3.5 – 16 March 2011
- Easy, Powerful Connections to Active Directory, LDAP and Crowd
- Improved JIRA Integration
- Drag-and-Drop for HTML5 Browsers
- Autowatch and Improved Notification Settings
- Sharing Pages and Blog Posts
- Enhanced Code Macro
- More Administrative Improvements
- "What's New" Feature Tour
- Categories, a New Way of Organising Spaces
- Embedding Audio and Video with the Multimedia Macro
- Infrastructure Changes

Confluence 3.4 – 12 October 2010
- New Keyboard Shortcuts, Mac-Friendly Too
- Keyboard Shortcut Dialog
- User Macros in Macro Browser and Autocomplete
- New Plugin Manager
- Improved Performance
- Infrastructure Changes

Confluence 3.3 – 7 July 2010
- Confluence Page Gadget
- Autocomplete for Inserting Macros
- Property Panels for Links
- Property Panels for Images
- Manage Watchers
- Email Notifications for Network Activity and Blogs
- Blog Improvements
- Context-Sensitive Help Links
- Security Features
- Infrastructure Changes

Confluence 3.2 – 24 March 2010
- Autocomplete for Inserting Links
- Autocomplete for Embedding Images and Documents
- A Link Browser that's Smarter, Smoother, Faster
- New Documentation Theme
- New Easy Reader Theme
- Template Bundles
- Reordering while Moving a Page
- New Keyboard Shortcuts and Editor Hints
- User Interface Enhancements

Confluence 3.1 – 8 December 2009
- Introducing Gadgets
- Drag-and-Drop
- Office 2007 Support
- New 'Move Page' Feature
- Enhanced Image Browser
- Draft Comparisons
- Page Restrictions Dialog Box
- Other Editor Enhancements
- New Web Browser Versions Supported

Confluence 3.0 – 1 June 2009
- Introducing the Macro Browser
- Enhanced User Profiles
- Introducing Your Network
• New User Status  
• New Hover Profile Feature  
• Customisable Enhanced PDF Exports  
• Improved Rich Text Editor  
• Performance Improvements  
• Engine Room and Developer Community  
• Administration Improvements  

Confluence 2.10 – 3 December 2008  
• Introducing the Widget Connector  
• Improved Office Connector Now Bundled  
• Introducing Quick Navigation  
• 'Did You Mean', OpenSearch and More  
• Custom Stylesheets for Confluence Spaces  
• Updated JIRA Issues Macro with Custom Fields and Dynamic Display  
• Enhanced User and Group Management  
• Upgraded Rich Text Editor  
• Universal Wiki Converter now with SharePoint Import and More  
• Improved Activity Macros  
• Plugin Framework 2  

Confluence 2.9 – 7 August 2008  
• Streamlined Search  
• Auto Save  
• Charts  
• Page Tree  
• Gallery  
• New Tutorial  
• More in the Menus  
• Alphabetical Page Ordering  
• Better Spam Prevention  
• Plugin Repository  
• Engine Room and Developers' Community  

Confluence 2.8 – 10 April 2008  
• Dynamic menus and simplified screen design  
• Page ordering  
• Collapsible comments  
• Multiple-label filter  
• Confluence installer  
• Task list  
• Performance enhancements  
• Administration, management and monitoring  

Confluence 2.7 – 12 December 2007  
• JIRA Issues and Portlet macros use new trusted authentication  
• Two-tier administrator permissions  
• Inserting images and attaching files during page creation  
• Sorting of images in Gallery macro  
• Simplified and improved logging  
• Performance, maintainability and administration  

Confluence 2.6 – 27 September 2007  
• Fresh look for the Default theme  
• Personalised comments and Dashboard  
• Space description on Dashboard  
• Labels on templates  
• Default content for space home pages
- Social Bookmarking plugin now bundled with Confluence
- Back-dating and renaming news items

Confluence 2.5 – 29 April 2007
- Introducing flexible page restrictions
- Dynamic task list JRE incompatibilities
- contentbylabel macro supports AND condition

Confluence 2.4 – 14 March 2007
- Editable comments
- Page mailing

Confluence 2.3 – 5 January 2007
- Confluence Massive – cluster support
- People directory
- Activity plugin – usage statistics
- Blogging RPC plugin – manage news in Confluence using blogger-compatible desktop clients
- WebDAV client support via WebDAV plugin – create, edit, move pages, attachments, etc via WebDAV

Confluence 2.2 – 27 April 2006
- Personal spaces
- Localisation/internationalisation – drop-in language packs (similar to JIRA)
- CAPTCHA support – spam protection
- Improved searching
- Improved LDAP performance
- Confluence ships with Tomcat 5.5

Confluence 2.1 – 20 December 2005
- Autosave
- Concurrent edit warnings
- LDAP integration with Atlassian User/POLIS

Confluence 2.0 – 17 November 2005
- Rich Text Editing – WYSIWYG editor
- Labels
- Dashboard tabs – All, My, Team, New
- RSS builder
- Export pages as Word documents
- Copy pages

Confluence 1.4 – 23 May 2005
- New user interface
- Enhanced editing – doing more in the edit interface
- Page permissions
- New plugin types
- Configurable themes
- Completely rewritten Wiki to HTML conversion engine

Confluence 1.3 – 30 November 2004
- Mail archiving
- Themes
- Trash can
- More granular space permissions

Confluence 1.2 – 23 August 2004
- Page list views – alphabetical, directory view and search view of all pages in a space
• Image thumbnails and thumbnail galleries
• Threaded comments
• Enhanced Search - indexing attachment comments and file names and contextual searching
• New permissions interface

Upgrade Notes Overview

Typically, each major release of Confluence comes with upgrade notes, which are specific recommendations for upgrading from the previous major version. If you plan to upgrade and skip a few Confluence versions, you must read the upgrade notes for all major versions between your current version and the version to which you are upgrading, to make sure you do not miss something important.

Please read our general information about upgrading Confluence.

For example:
When upgrading from Confluence 5.3 to Confluence 5.5, read the upgrade notes for Confluence 5.4, as well as those for Confluence 5.5.

Also, we strongly recommend that you read the upgrade notes for any minor releases in-between, since they contain important information that will affect your Confluence upgrade.

Below is a list of upgrade notes for previous major releases of Confluence, as well as the upgrade notes for important minor releases:

- Confluence 5.6 Upgrade Notes
- Confluence 5.5 Upgrade Notes
- Confluence 5.4 Upgrade Notes
- Confluence 5.3 Upgrade Notes
- Confluence 5.2 Upgrade Notes
- Confluence 5.1 Upgrade Notes
- Confluence 5.0 Upgrade Notes
- Confluence 4.3 Upgrade Notes
- Confluence 4.2 Upgrade Notes
- Confluence 4.1 Upgrade Notes
- Confluence 4.0 Upgrade Notes
- Confluence 3.5 Upgrade Notes
- Confluence 3.4 Upgrade Notes
- Confluence 3.3 Upgrade Notes
- Confluence 3.2 Upgrade Notes
- Confluence 3.1 Upgrade Notes
- Confluence 3.0.1 Upgrade Notes
- Confluence 3.0 Upgrade Notes
- Confluence 2.10 Upgrade Notes
- Confluence 2.9 Upgrade Notes
- Confluence 2.8 Upgrade Notes
- Confluence 2.7 Upgrade Notes
- Confluence 2.6 Upgrade Notes

You will find the upgrade notes attached to the release notes for the relevant version.

Useful plugins

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

RELATED TOPICS

Confluence Release Summary
Confluence Release Notes

Getting Help and Support

Find an answer to your question. Looking for a real person to solve a problem? We're here too!
Online help
Read the online documentation for detailed information about using and administering Confluence.

Online community
If you cannot find what you need in the documentation, try asking in our question and answers forum, Atlassian Answers.

Features and bugs
We love to hear your requests for new features and improvements! You can add a request in the Confluence (CONF) project in our JIRA issue tracker.
Alas, bugs do happen. If you find one, we will do our best to fix it. Please raise a bug report in the issue tracker.

Support tools in Confluence
Administrators can access a range of Support tools within Confluence. Go to > General Configuration > Atlassian Support Tools to run a health check, scan your logs, or send a support zip to our Support team.

Support articles
Refer to the Confluence Knowledge Base for troubleshooting, technical announcements, known issues and workarounds.

Support team
For one-on-one help from our support team, create a support request in the Confluence Support (CSP) project at Atlassian Support. A support engineer will follow up with you quickly.
If you do not have an account yet, you can create one before adding the support request – follow the prompts on the Atlassian Support screen. When creating your support request, please provide as much detail as possible. This will help us resolve your issue faster. See Troubleshooting Problems and Requesting Technical Support.

Confluence Resources

Resources for evaluators

- Free trial
Feature tour

Resources for administrators

- Confluence knowledge base
- Guide to installing an Atlassian integrated suite
- The big list of Atlassian gadgets

Resources for developers

- Atlassian Developers site
- Developer topics on Atlassian Answers

Downloadable documentation

- Confluence documentation in PDF format

Add-ons and plugins

- Documentation for the Confluence SharePoint Connector
- Atlassian Marketplace

Support

- Atlassian Support
- Support policies

Training

- Atlassian training

Answers

- Confluence at Atlassian Answers

Mailing lists

- Visit http://my.atlassian.com to sign up for mailing lists relating to Atlassian products, such as technical alerts, product announcements and developer updates.

Feature requests and bug reports

- Issue tracker for Confluence

Confluence SharePoint Connector

Latest version of the Confluence SharePoint Connector

Confluence SharePoint Connector 1.9.0 has now been released. See the SharePoint Connector 1.9.0 Release Notes.

With the Confluence SharePoint Connector you can combine Confluence's free-form, easy to edit wiki with the document management and workflow strengths of SharePoint.

- Display SharePoint document libraries, calendars, links, discussions and more on your Confluence wiki pages. Edit SharePoint's Office documents directly from Confluence and save them back to SharePoint.
- Embed Confluence pages and Confluence page trees into a SharePoint page. Click through from SharePoint to Confluence.
- Enjoy automatic login (single sign-on) between Confluence and SharePoint.
- Search Confluence and SharePoint content together, retrieving a unified set of results

Please refer to the SharePoint Connector documentation for more information.

Support Policies

Welcome to the support policies index page. Here, you'll find information about how Atlassian Support can help you and how to get in touch with our helpful support engineers. Please choose the relevant page below to find out more.
Bug Fixing Policy

Summary

- Atlassian Support will help with workarounds and bug reporting.
- Critical bugs will generally be fixed in the next maintenance release.
- Non critical bugs will be scheduled according to a variety of considerations.

Raising a Bug Report

Atlassian Support is eager and happy to help verify bugs — we take pride in it! Please open a support request in our support system providing as much information as possible about how to replicate the problem you are experiencing. We will replicate the bug to verify, then lodge the report for you. We'll also try to construct workarounds if they're possible.

Customers and plugin developers are also welcome to open bug reports on our issue tracking systems directly. Use the appropriate project on http://jira.atlassian.com to report bugs for Atlassian products.

When raising a new bug, you should rate the priority of a bug according to our JIRA usage guidelines. Customers should watch a filed bug in order to receive e-mail notification when a "Fix Version" is scheduled for release.

How Atlassian Approaches Bug Fixing

Maintenance (bug fix) releases come out more frequently than major releases and attempt to target the most critical bugs affecting our customers. The notation for a maintenance release is the final number in the version (i.e. the 1 in 3.0.1).

If a bug is critical (production application down or major malfunction causing business revenue loss or high numbers of staff unable to perform their normal functions) then it will be fixed in the next maintenance release provided that:

- The fix is technically feasible (i.e. it doesn't require a major architectural change).
- It does not impact the quality or integrity of a product.

For non-critical bugs, the developer assigned to fixing bugs prioritises the non-critical bug according to these factors:

- How many of our supported configurations are affected by the problem.
- Whether there is an effective workaround or patch.
- How difficult the issue is to fix.
- Whether many bugs in one area can be fixed at one time.

The developers responsible for bug fixing also monitor comments on existing bugs and new bugs submitted in JIRA, so you can provide feedback in this way. We give high priority consideration to security issues.

When considering the priority of a non-critical bug we try to determine a ‘value’ score for a bug which takes into account the severity of the bug from the customer’s perspective, how prevalent the bug is and whether roadmap features may render the bug obsolete. We combine this with a complexity score (i.e. how difficult the bug is). These two dimensions are used when developers self serve from the bug pile.

Further reading

See Atlassian Support Offerings for more support-related information.

New Features Policy
Summary

- We encourage and display customer comments and votes openly in our issue tracking system, http://jira.atlassian.com.
- We do not publish roadmaps.
- Product Managers review our most popular voted issues on a regular basis.
- We schedule features based on a variety of factors.
- Our Atlassian Bug Fixing Policy is distinct from this process.
- Atlassian provides consistent updates on the top 20 issues.

How to Track what Features are Being Implemented

When a new feature or improvement is scheduled, the ‘fix-for’ version will be indicated in the JIRA issue. This happens for the upcoming release only. We maintain roadmaps for more distant releases internally, but because these roadmaps are often pre-empted by changing customer demands, we do not publish them.

How Atlassian Chooses What to Implement

In every major release we aim to implement highly requested features, but it is not the only determining factor. Other factors include:

- Customer contact: We get the chance to meet customers and hear their successes and challenges at Atlassian Summit, Atlassian Unite, developer conferences, and road shows.
- Customer interviews: All product managers at Atlassian do customer interviews. Our interviews are not simply to capture a list of features, but to understand our customers' goals and plans.
- Community forums: There are large volumes of posts on answers, of votes and comments on jira.atlassian.com, and of conversations on community forums like groups on LinkedIn.
- Customer Support: Our support team provides clear insights into the issues that are challenging for customers, and which are generating the most calls to support.
- Atlassian Experts: Our Experts provide insights into real-world customer deployments, especially for customers at scale.
- Evaluator Feedback: When someone new tries our products, we want to know what they liked and disliked and often reach out to them for more detail.
- In product feedback: The JIRA Issue Collectors that we embed our products for evaluators and our Early Access Program give us a constant pulse on how users are experiencing our product.
- Usage data: Are customers using the features we have developed?
- Product strategy: Our long-term strategic vision for the product.
- Please read our post on Atlassian Answers for a more detailed explanation.

How to Contribute to Feature Development

Influencing Atlassian's release cycle

We encourage our customers to vote on issues that have been raised in our public JIRA instance, http://jira.atlassian.com. Please find out if your request already exists - if it does, vote for it. If you do not find it you may wish to create a new one.

Extending Atlassian Products

Atlassian products have powerful and flexible extension APIs. If you would like to see a particular feature implemented, it may be possible to develop the feature as a plugin. Documentation regarding the plugin APIs is available. Advice on extending either product may be available on the user mailing-lists, or at Atlassian Answers.

If you require significant customisations, you may wish to get in touch with our partners. They specialise in extending Atlassian products and can do this work for you. If you are interested, please contact us.

Further reading

See Atlassian Support Offerings for more support-related information.

Patch Policy

Atlassian will only provide software patches in extremely unusual circumstances. If a problem has been fixed in a newer release of the product, Atlassian will request that you upgrade your instance to fix the issue. If it is
deemed necessary to provide a patch, a patch will be provided for the current release and the last maintenance release of the last major version only.

Patches are issued under the following conditions:

- The bug is critical (production application down or major malfunction causing business revenue loss or high numbers of staff unable to perform their normal functions) AND a patch is technically feasible (i.e., it doesn't require a major architectural change)
- The issue is a security issue, and falls under our Security Patch Policy.

Atlassian does not provide patches for non-critical bugs.

Provided that a patch does not impact the quality or integrity of a product, Atlassian will ensure that patches supplied to customers are added to the next maintenance release. Customers should watch a filed bug in order to receive e-mail notification when a "Fix Version" is scheduled for release.

Patches are generally attached to the relevant http://jira.atlassian.com issue.

Further reading

See Atlassian Support Offerings for more support-related information.

Troubleshooting Problems and Requesting Technical Support

This document tells you how to troubleshoot problems in Confluence and how to obtain technical support from Atlassian.

Troubleshooting a Problem

If you have a problem with Confluence, please follow the steps below.

To diagnose a problem and search for a solution:

1. If you are not a Confluence administrator, report your problem to the person in charge of your Confluence site and ask them to follow up on the issue.
2. Use the health check and log scanner (see below) to check your Confluence logs for errors and attempt to match them against known issues in our knowledge base and bug tracker.
3. Check our knowledge base for solutions to known issues.
4. Check our issue tracker for known bugs.
5. If your problem may be related to a plugin, you can enter plugin safe mode by temporarily disabling any third party plugins.
6. If you are having problems configuring a feature, please take a look at the appropriate guides:
   - Confluence Installation Guide
   - Confluence Setup Guide
   - Confluence Administrator's Guide
   - Configuring Confluence
   - Database Configuration
7. Check the following guides for troubleshooting specific problems:
   - Issues related to your database server: Database Troubleshooting.
   - Issues related to user management: Requesting Support for External User Management.
8. If the above tools and documentation do not solve your problem, please create a support request and attach your support zip file. If you believe you have found a bug, you may wish to create a bug report instead. Instructions for both are given below.
On this page:

- Troubleshooting a Problem
- Using the Health Check
- Scanning your Confluence Logs to Match Known Issues
- Raising a Support Request with a Plugin Author
- Raising a Support Request with Atlassian
  - Method 1: Using the Support Request Form via the Confluence Administration Console
  - Method 2: Raising a Support Request via the Internet
- Creating a Support Zip File via the Confluence Administration Console
- Logging a Bug Report

Related pages:

- Requesting Support for External User Management
- Requesting Performance Support
- Confluence Knowledge Base
- Confluence Administrator’s Guide

Using the Health Check

The Confluence Health Check provides a simple way to check the set up of your Confluence instance. The health check looks at things like your licence validity, basic database setup and more.

To access the health check:

- Choose the cog icon, then choose General Configuration under Confluence Administration.
- Choose Atlassian Support Tools > Health Check.

Scanning your Confluence Logs to Match Known Issues

Confluence provides an inbuilt log scanner that will check your Confluence logs for errors and attempt to match them against known issues in our knowledge base and bug tracker.

The log scanner is known as Hercules, or the Atlassian support bot. It uses a set of patterns that we have discovered in our knowledge base and issue tracker.

To use the Confluence log scanner:

1. Log in as a user with Confluence Administrator or System Administrator permissions.
2. Choose the cog icon, then choose General Configuration under Confluence Administration.
3. Choose ‘Atlassian Support Tools’ in the left-hand panel.
5. Choose ‘Scan’ to scan the Confluence log file in its default location, or change the location if necessary then choose ‘Scan’.
6. The log scanner will return a list of links, pointing to articles in our knowledge base and/or bug reports in our issue tracker.
   - The latest-reported problems are displayed first. By default only the most recent 10 matches are displayed. If you have more than 10 matches and want to display all results, click the ‘Show All’ link that appears on the top of the results page.
   - Choose a link to read the reported problem and possible solutions or workarounds.

Screenshot: The log scanner
Raising a Support Request with a Plugin Author

If you have a plugin-related issue, please check whether the plugin is supported by Atlassian or by the plugin developer.

- Visit the plugin's home page in the Atlassian Marketplace.
- Check the ‘Supported By’ entry under the version information on the right side.
- If the plugin is not supported by Atlassian, you need to contact the plugin author directly.

You can read more about Atlassian support for plugins.

Raising a Support Request with Atlassian

There are two ways to raise a support request with Atlassian:

- **Method 1:** (Recommended) Complete the support request form via your Confluence Administration Console, as described below. A possible problem with this method is that your mail may not be forwarded correctly due to restrictions imposed by your mail server. For example, the zip of your log files might be too large for your mail server to forward.
- **Method 2:** Raise a support request via our support site on the Internet, as described below. Create a support zip file via your Confluence Administration Console, as described below, and attach the zip file to the support request.

Method 1: Using the Support Request Form via the Confluence Administration Console

The advantage of this method is that it is convenient. The disadvantage is that your mail may not be forwarded correctly due to a problem (for example, the zip file is too large) or due to a security restriction on your mail server.

You can also use this method to append system information to an existing support request.

**To submit a support request via the Confluence Administration Console:**

1. Log in as a user with Confluence Administrator or System Administrator permissions.
2. Choose the cog icon then choose General Configuration under Confluence Administration.
3. Make sure that SMTP email is set up on your Confluence site and your mail server allows zip files.
5. Choose the ‘Support Request’ tab.
6. Provide as much information as possible, following these guidelines:
   - ‘Contact Email’ – This will default to the email address of the logged-in user.
   - **Note:** This email address will be used to find your support account on the Atlassian Support
System. If no matching account is found, a new account will be created. Confluence will also send all further notifications and updates to this address.

- **Summary** – Enter a short and meaningful description of the problem.
- **Description** – Enter as much information as possible, including any error messages that are appearing and any steps the support team can take to reproduce the problem.

7. In the section titled **Support Data to Attach**, select the types of additional information you would like to be included in a zip file that will be attached to your support request.

8. Choose the **Send** button.

9. Confluence will submit your request via email to the Atlassian support site. If you do not already have a support account, Confluence will automatically request one for you. The submitted request will include all the system and environment information which you see on the support request form. It will also include a zipped copy of your Confluence log file. Refer to Working with Confluence Logs for information about the log files.

   Log files can be very big. It is possible that your email server may bounce the message if it is too large. With the default log4j configuration, the log file could be up to 20Mb in size. If you have customised the log settings, the maximum size could be even larger. Please check whether the email message has been successfully sent, and consult your email administrator if you need special provisions for this email message.

10. Once you have submitted your support request, you will receive email updates about its progress. These emails will give you the support request number.

You can view the status of your support request and add any additional information required by visiting the Atlassian Support System at any time.

**Screenshot: The support request form on the Confluence Administration Console**
Method 2 Raising a Support Request via the Internet

If your Confluence instance is not configured with SMTP mail or your Confluence instance is not running, you can raise a support request via the Atlassian Support System on the Internet.

To raise a support request via the Internet:

1. If you do not already have a free Atlassian support account, create one here.
2. Log in to https://support.atlassian.com and select 'Create New Issue'.
3. Lodge a detailed description of your problem in the new support request.
4. Fill in all applicable information about your system, such as application server, database, etc.
5. If Confluence is running, go to the 'System Information' screen in your Administration Console and copy the text of your system information into the request.
6. Create a support zip file, as described below to attach to the request. If your instance does not start up, refer to Working with Confluence Logs for information about the log files.

7. If your problem concerns user management or performance, please take a look at the additional requirements in Requesting Support for External User Management or Requesting Performance Support.

8. Once your request is lodged, wait to be notified by email of updates.

Creating a Support Zip File via the Confluence Administration Console

We recommend that you attach a support zip file to every interaction with the Atlassian support team. You can use this method to append system information to an existing support request. The tool described below will also dump your system information to the logs before zipping them.

**To create a support zip file via the Confluence Administration Console:**

1. Log in as a user with System Administrator or Confluence Administrator permissions.
2. Go to the Administration Console and choose 'Atlassian Support Tools' under 'Administration' in the left-hand panel. Choose 'Support Zip'. Ensure that everything is checked, then choose the 'Create' button.
3. Confluence will create the support zip file and display its location on the screen. Log in to the Confluence server to retrieve the file.
4. Attach the zip file to the support case you raised on our support system, as described above.

**Screenshot: Creating a support zip file**

Logging a Bug Report

If you have found a bug, the easiest way to report it is to:

- Create numbered instructions on how to reproduce the bug.
- Log it as a support request, as described above.
- The Atlassian support team will confirm your bug and lodge a bug report.

Alternatively, you can check to see if anyone else has reported the bug, then log a bug report yourself.
To log a bug report:

1. Go to the Confluence issue tracker.
2. Type keywords for your problem into the search box on the left under 'Query'.
3. Choose 'Search' to find any existing bug reports that match your problem.
4. Read through the summaries of the bugs shown. If any summary describes your problem, you may wish to set a watch to be notified of updates.
5. If there are no existing bug reports that match your problem, log the new bug in the issue tracker. Include information on how to duplicate the problem.
6. Sometimes it may be useful to include the result of the 500 error page, which you will find at this location:

   https://<domain><host>:<port>/500page.jsp

7. Once your issue is lodged, wait to be notified by email of updates.

Content Anonymiser for Data Backups

Atlassian may request a copy of the entities.xml file from a customer’s exported zip file (backup file), in order to diagnose database corruption or to find a bug in Confluence.

If your data is confidential, you can run an anonymiser program over your entities.xml file to remove all your data and leaving only the structure of the export.

Usage

To run the Content Anonymiser on your backup file:

1. Download the anonymiser JAR (attached to this page).
2. Extract the entities.xml file from your zipped backup file to the same directory as the JAR.
3. Use the command prompt to go to the directory where all three files are located.
4. To create cleaned.xml, run the command

   java -jar confluence-export-cleaner-1.1-jar-with-dependencies.jar entities.xml cleaned.xml

5. Re-ZIP cleaned.xml with its exportDescriptor.properties to ensure we (eg. Atlassian Support) knows exactly which version of Confluence does the XML backup exported from.

How it works

The Content Anonymiser program replaces all the text content in file entities.xml with ‘x’ characters. For example, the word “Atlassian” will be transformed to “xxxxxxxxxx”. The resulting cleaned.xml file is expected to have the same size as the original file.

This release of the Content Anonymiser uses STX, a fast and efficient XML transformation technology. It should not require a lot of memory to run, even for a large backup.

Development

For Atlassian developers:

- Source code.
- Maven repository.

Enabling Detailed SQL Logging

Confluence uses the open source persistence framework Hibernate. This page tells you how to configure Confluence’s logging to report individual SQL requests that are sent to the database by Hibernate. It is useful for troubleshooting the following events:

- XML site backups that fail to import.
- Exceptions caused by an illegal database operation.
To enable detailed SQL logging in Confluence, you need to modify `log4j.properties`, located in `confluence/WEB-INF/classes`.

After you have enabled hibernate logging, please replicate the action that is causing the error in the first place. This is the best way to ensure that the Confluence log file contains relevant SQL logging.

If you require support assistance with a database related problem, it is advisable to enable detailed SQL logging before sending us the log files. This will assist us in determining what SQL queries were running during the reported problem.

If the entries mentioned below are not defined in the `log4j.properties` file, you can manually add the entries to the file in the 'Hibernate Logging' section.

### To Log SQL Queries with Parameters

1. Stop Confluence
2. Change the following lines in `log4j.properties` from **ERROR** to **DEBUG**:

   ```
   ## log hibernate prepared statements/SQL queries (equivalent to setting 'hibernate.show_sql' to 'true')
   ## DEBUG, TRACE or ALL is required to see query strings
   log4j.logger.net.sf.hibernate.SQL=DEBUG
   ```

3. Uncomment the following lines in `log4j.properties`:

   ```
   ## log hibernate prepared statement parameter values. Note: due to caching in net.sf.hibernate.type.NullableType, requires restart to take effect
   ## TRACE or ALL is required to see parameter values
   ## Note that log4j.appender.confluencelog Threshold (or other appenders) also must be TRACE or ALL to see any trace messages in the logs
   log4j.logger.net.sf.hibernate.type=TRACE
   ```

4. Change the following lines in `log4j.properties` from **DEBUG** to **TRACE**:

   ```
   log4j.appender.confluencelog.Threshold=TRACE
   ```

5. Start Confluence

### To Disable Batched Updates for Simpler Debugging

Stop Confluence, then edit `databaseSubsystemContext.xml`:

- In Confluence 2.5.x and earlier, the `databaseSubsystemContext.xml` file is at `confluence/WEB-INF/classes/databaseSubsystemContext.xml`
- From Confluence 2.6.x, the `databaseSubsystemContext.xml` file is available in the `confluence-2.6.0.jar` file located in the `<confluence-install>/WEB-INF/lib` directory.

Uncomment the `<prop>` line in the following location:
Troubleshooting SQL exceptions
Working with Confluence Logs

Generating a Heap Dump

Sometimes you may see that Confluence is holding onto a chunk of memory over a period of time (for example, tenured space is increasing close to Xmx). In such a situation, it is useful to find out what is stacking up in the memory by analysing the heap dump.

On this page:

- Automatically Generating a Heap Dump when Confluence Hits OutOfMemory Error
- Manually Generating a Heap Dump when Confluence Stops Responding
- Submitting a Heap Dump to Atlassian Support

Tips when getting a heap dump

If you have a large Xmx size, please limit your Xmx size to 1024m. This will help to keep Confluence heap dump smaller while still containing sufficient information to analyse it.

Automatically Generating a Heap Dump when Confluence Hits OutOfMemory Error

Typically, we would like to analyse the heap dump produced when Confluence died from an OutOfMemory Error. For this, you can add additional JVM parameters like below:

```
-XX:+HeapDumpOnOutOfMemoryError -XX:HeapDumpPath=<path to this heap dump file>
```

If you do not set the HeapDumpPath parameter, by default the heap dump will be saved in the folder where Tomcat is run from.

If you are setting these parameters in the Windows registry (when running Confluence on Windows as a service), be sure that each parameter is on its own line.

Manually Generating a Heap Dump when Confluence Stops Responding

It is also possible to get a heap dump manually using a JDK bundled tool called jmap, although we recommend that you use the automatic method above for best result.

For Linux/Solaris-based Operating Systems:
Please execute the following command on Linux OS:

```
$JAVA_HOME/bin/jmap -dump:format=b,file=heap.bin <pid>
```

For Windows:
Please find your Confluence process ID (see below) and then execute the command below on a Windows command line:

```
%JAVA_HOME%\bin\jmap -dump:format=b,file=heap.bin <pid>
```

To find out the process ID for your Java process in Windows, you can use Process Explorer from Microsoft. This is what it looks like:
Using Process Explorer to find your Tomcat process ID

Tomcat run from startup.bat script

Tomcat run as Windows Service

Submitting a Heap Dump to Atlassian Support

Please zip the file and then send it to Atlassian Support.

RELATED TOPICS

- Getting Java Crash Log File
- Memory Usage and Requirements
- Garbage Collector Performance Issues
- Generating a Thread Dump
- How to Fix Out of Memory Errors by Increasing Available Memory

Generating a Thread Dump

- Stack Traces and Security
- Method 1: Generating a Thread Dump Externally
- Method 2: Generating a Thread Dump via the Administration Console

If Confluence is performing poorly, behaving unexpectedly or stops responding and you can generate a thread dump to help diagnose the cause of the problem. Furthermore, if you wish to contact Atlassian Support for assistance about it, you should include a thread dump in your support enquiry to help the Support team determine the cause of the problem.

A thread dump will show the state of each thread in the JVM, including a stack trace. Thread dumps are only useful if they are taken at the appropriate time. They normally need to be taken at or close to the time when the application is experiencing problems.

Information about what locks are being held and waited upon by a thread are not produced by Confluence's Thread Dump tool. If you require this information, then generate a thread dump externally.

Stack Traces and Security

To help debug support cases and provide legendary support, Confluence provides stack traces through the web interface when an error occurs. These stack traces include information about what Confluence was doing at the time, and some information about your deployment server.

Only non-personal information is supplied such as operating system and version and Java version. With proper network security, this is not enough information to be considered dangerous. No usernames or passwords are included.

Method 1: Generating a Thread Dump Externally

If Confluence stops responding or you require information on locks being held and waited upon by threads, then use one of methods described in Generating a Thread Dump Externally.

Atlassian support may ask you to use this method if a thread dump generated using method 2 does not include enough information to diagnose the problem.

Method 2: Generating a Thread Dump via the Administration Console
To generate a Thread Dump from the Administration Console:

1. Choose the cog icon, then choose General Configuration under Confluence Administration.
2. Select 'Thread Dump' in the left-hand panel.
3. Click the 'Generate Now' button in the centre of the page. The output is displayed in a new text box that appears just below the button.
4. Copy the contents of the thread dump in the text box and save it to a text file.

Screenshot: Example of a generated thread dump from the Confluence administration console

Scheduling Thread Dumps via the Administration Console

If you were asked by Atlassian Technical Support to generate regular thread dumps, please set the Thread Dump Scheduler to take 2 to 3 thread dumps with a 30 seconds time interval in between so the Support team can observe any important patterns that may assist with the diagnosis of the problem. Attach the log file to the support ticket.

Example: Scheduling thread dumps from the Confluence administration console
Generating a Thread Dump Externally

If Confluence stops responding and you cannot access its integrated Generate Thread Dump feature, it is possible to create thread dumps outside the application. External thread dumps are also useful if you require information on locks being held or waited upon by threads.

### Generating a Thread Dump on Linux, including Solaris and other Unixes

1. Identify the **Java** process that Confluence is running in.: This can be achieved by running a command similar to:

   ```bash
   ps -ef | grep java.
   ```

2. Find the process ID of the JVM and use the **ps** command to get list of all processes:

   ```bash
   kill -3 <pid>
   ```

   **This will not kill your server (so long as you included the "-3" option, no space in between).**

   **Output**

   Standard logging for Confluence Stand-alone is sent to the **atlassian-confluence.log**, in the confluence-home directory, not in the confluence-install directory. Thread dumps are an exception since they dump the threads of the entire application server - they'll appear in the catalina.out file in the application directory's logs folder. You can search for the term "thread dump" in the log file for the beginning of the dump. Submit this along with the atlassian-confluence.log in your support ticket.

### Generating Thread Dumps on Windows

**From the console**

If you are running Confluence through a console, rather than as a service, you can click on the console and press `<CTRL>`+`BREAK`

**Using jstack**

The JDK ships with a tool named **jstack** for generating thread dumps.

1. Identify the process. Launch the task manager by, pressing **Ctrl + Shift + Esc** and find the Process ID of the Java (Confluence) process. You may need to add the PID column using **View -> Select Columns ...**

2. Run **jstack <pid>** to Capture a Single Thread Dump. This command will take one thread dump of the
process id <pid>, in this case the pid is 22668:

```
adam@track:~$ jstack -l 22668 > threaddump.txt
```

This will output a file called threaddump.txt to your current directory.

**Common issues with jstack:**

- You must run jstack as the same user that is running Confluence
- If the jstack executable is not in your $PATH, then please look for it in your <JDK_HOME>/bin directory
- If you receive `java.lang.NoClassDefFoundError: sun/tools/jstack/JStack` check that tools.jar is present in your JDK's lib directory. If it is not, download a full version of the JDK.
- If you see the following message: 'Not enough storage is available to process this command,' see this article.

**Output**

Standard logging for Confluence Stand-alone is sent to the `atlassian-confluence.log`, in the confluence-home directory, not in the confluence-install directory. Thread dumps are an exception since they dump the threads of the entire application server - they'll appear in the catalina.out file in the application directory's logs folder. You can search for the term "thread dump" in the log file for the beginning of the dump. Submit this along with the `atlassian-confluence.log` in your support ticket.

**Thread Dump Analysis Tools**

- Thread Dump Analyzer TDA
- Samurai

**Getting Java Crash Log File**

If you discovered that Confluence died without manual intervention, there may be something goes wrong during a local Java session. Java will produce a log file that looks like the following: `hs_err_pid20929.log`.

The location of this log file is usually in the directory where Tomcat is run eg. /bin folder. For Windows Services, it should be located in where Windows Services are run, eg. c:\Windows\System32 if you are on 32 bit.

**Useful VM Option**

If using Java 6 or above, it's possible to define the path to the `hs_err_pid` file.

Add the following JVM Parameter to your existing ones:

```
-XX:ErrorFile=./hs_err_pid<pid>.log
```

**RELEVANT TOPICS**

- Generating a Heap Dump
- Java Crashes
- Profiling using the YourKit Plugin

There is a plugin for Confluence 2.2 and later which allows easy profiling using the YourKit profiler. No license is required to generate a memory or CPU snapshot, but you will need at least an evaluation license to analyse the results.

**On this page:**

- Configuring YourKit in your JVM
  - Windows Configuration
  - Linux/Mac OS X Configuration
- Performance Impact
Installing the YourKit Plugin

**Configuring YourKit in your JVM**

Download YourKit 6.0 for your platform and follow the installation instructions to install it.

*Note: YourKit version 7 is not compatible with the Confluence yourkit plugin.*

The following instructions apply to Confluence and Tomcat installations with the Oracle (previously Sun) JDK. They should be easily applicable to other application servers and JVMs, however. The YourKit documentation covers this in more detail.

**Windows Configuration**

On Windows, add to your PATH environment variable the bin/win32/ directory underneath the YourKit installation directory. For example, you might add "C:\Program Files\YourKit Java Profiler 6.0.12\bin\win32" to your PATH, via Control Panel, System, Advanced, Environment Variables.

To configure Confluence’s JVM to use the YourKit agent, you need to add a parameter to CATALINA_OPTS in the file in your Confluence application directory. This file controls the startup parameters for Tomcat, so you’ll need to restart it after making the changes.

Add the 'agentlib' parameter to the end like this:

```
set CATALINA_OPTS=%CATALINA_OPTS% -Xms1024m -Xmx1024m
-XX:MaxPermSize=256m -XX:+UseG1GC -agentlib:yjpagent
```

**Linux/Mac OS X Configuration**

On Unix-based systems, include the installation directory in the library path environment variable, as shown below:

- For the Mac: `export DYLD_LIBRARY_PATH=$DYLD_LIBRARY_PATH:/path/to/yourKitAgent`
- For other Unix-based systems: `export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/path/to/yourKitAgent`

In general, to configure the JDK, you add the `agentlib` parameter:

```
java -agentlib:yjpagent ...
```

You can add this to Tomcat’s bin/setenv.sh like this:

```
CATALINA_OPTS="$CATALINA_OPTS -Djava.awt.headless=true"
-agentlib:yjpagent "
```

**Performance Impact**

Running YourKit can have detrimental effects on performance.

To minimize performance problems use the following modifications to the agentlib parameter:

```
-agentlib:yjpagent=disablecounts,disablealloc,disablej2ee
```

See also Profiling overhead: how to reduce or avoid in the YourKit documentation.

**Installing the YourKit Plugin**

Download the plugin and upload it into Confluence through the Administration, Plugins page.
A new menu option, "YourKit Profiling' will appear under the 'Administration' heading. Click it and you should see the options to take a memory or CPU snapshot.

This profiler dump will be saved to a local temp directory, and the path shown once it is complete. For the CPU snapshot, this will take at least 30 seconds. For the memory snapshot, 10-15 seconds.

**Screenshot: You can take a memory or CPU snapshot**

### Why would I do this?

Analysing a profiler dump enables Atlassian Support (or you, if you are interested) to see exactly what is happening in your application: what classes are using the memory, what is using CPU and so on. This can help us debug tricky performance problems which would otherwise be impossible to analyse remotely.

Take a CPU snapshot if:

- Confluence is sometimes unresponsive
- Pages take a long time to load
- Confluence's CPU usage is peaking.

Take a memory snapshot if:

- Confluence's memory usage is higher than you expect
- You are getting OutOfMemoryError's in your logs.

If you run into situations where Confluence is unresponsive and you are not able to trigger a memory snapshot, please ensure that you start Confluence with the `onexit=memory` parameter in the JVM options (as in the example below) and simply shut down Confluence. Before shutting down a memory snapshot will be created.

```
-agentlib:yjpagent=onexit=memory
```

### Plugin Source Code

The source code for this Confluence plugin is available from Subversion and browseable in Fisheye. The JAR produced by `mvn package` includes a copy of the YJP redistributable bundled in META-INF/lib/.

### Contributing to the Confluence Documentation

Would you like to share your Confluence hints, tips and techniques with us and with other Confluence users? We welcome your contributions.

**On this page:**

- Tweeting your Hints and Tips – Tips via Twitter
- Contributing Documentation in Other Languages
- Updating the Documentation Itself
  - Getting Permission to Update the Documentation
  - Our Style Guide
  - How we Manage Community Updates

**Tweeting your Hints and Tips – Tips via Twitter**

Do you have hints and tips about Confluence wiki to share with the world? Just tweet with the hash tag "#ConfluenceTips" and share your tips with
Contributing Documentation in Other Languages

Have you written a guide to Confluence in a language other than English, or translated one of our guides? Let us know, and we will link to your guide from our documentation. More....

Updating the Documentation Itself

Have you found a mistake in the documentation, or do you have a small addition that would be so easy to add yourself rather than asking us to do it? You can update the documentation page directly.

Getting Permission to Update the Documentation

Please submit the Atlassian Contributor License Agreement.

Our Style Guide

Please read our short guidelines for authors.

How we Manage Community Updates

Here is a quick guide to how we manage community contributions to our documentation and the copyright that applies to the documentation:

- **Monitoring by technical writers.** The Atlassian technical writers monitor the updates to the documentation spaces, using RSS feeds and watching the spaces. If someone makes an update that needs some attention from us, we will make the necessary changes.
- **Wiki permissions.** We use wiki permissions to determine who can edit the documentation spaces. We ask people to sign the Atlassian Contributor License Agreement (ACLA) and submit it to us. That allows us to verify that the applicant is a real person. Then we give them permission to update the documentation.
- **Copyright.** The Atlassian documentation is published under a Creative Commons CC BY license. Specifically, we use a Creative Commons Attribution 2.5 Australia License. This means that anyone can copy, distribute and adapt our documentation provided they acknowledge the source of the documentation. The CC BY license is shown in the footer of every page, so that anyone who contributes to our documentation knows that their contribution falls under the same copyright.

Confluence Documentation in Other Languages

Below are some links to Confluence documentation written in other languages. In some cases, the documentation may be a translation of the English documentation. In other cases, the documentation is an alternative guide written from scratch in another language. This page presents an opportunity for customers and community authors to share documentation that they have written in other languages.

Please be aware that these are external guides.

Most of the links point to external sites, and some of the information is relevant to a specific release of Confluence. Atlassian provides these links because the information is useful and relevant at the time it was written. Please check carefully whether the information is still relevant when you read it, and whether it is relevant to your version of Confluence. The information in the linked guides has not been tested or reviewed by Atlassian.

On this page:

- Tutoriel – Travailler avec des images dans Confluence
- Deutsches Handbuch für Confluence
- Confluence
Adding Your Own Guide to this Page

Have you written a guide for Confluence in another language? Add a comment to this page, linking to your guide. We will include it if the content fits the requirements of this page.

Giving Feedback about One of the Guides

If you have feedback on one of the guides listed above, please give the feedback to the author of the linked guide.

If you want to let us know how useful (or otherwise) one of these guides is, please add a comment to this page.

Other Sources of Information

Confluence documentation
Atlassian website
Atlassian blog
Confluence plugins